How to Contact MathWorks

Latest news: www.mathworks.com
Sales and services: www.mathworks.com/sales_and_services
User community: www.mathworks.com/matlabcentral
Technical support: www.mathworks.com/support/contact_us

Phone: 508-647-7000

The MathWorks, Inc.
3 Apple Hill Drive
Natick, MA 01760-2098

Simulink® Coder™ User's Guide

© COPYRIGHT 2011–2018 by The MathWorks, Inc.

The software described in this document is furnished under a license agreement. The software may be used or copied only under the terms of the license agreement. No part of this manual may be photocopied or reproduced in any form without prior written consent from The MathWorks, Inc.

FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation by, for, or through the federal government of the United States. By accepting delivery of the Program or Documentation, the government hereby agrees that this software or documentation qualifies as commercial computer software or commercial computer software documentation as such terms are used or defined in FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014. Accordingly, the terms and conditions of this Agreement and only those rights specified in this Agreement, shall pertain to and govern the use, modification, reproduction, release, performance, display, and disclosure of the Program and Documentation by the federal government (or other entity acquiring for or through the federal government) and shall supersede any conflicting contractual terms or conditions. If this License fails to meet the government's needs or is inconsistent in any respect with federal procurement law, the government agrees to return the Program and Documentation, unused, to The MathWorks, Inc.

Trademarks

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See www.mathworks.com/trademarks for a list of additional trademarks. Other product or brand names may be trademarks or registered trademarks of their respective holders.

Patents

MathWorks products are protected by one or more U.S. patents. Please see www.mathworks.com/patents for more information.
### Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Status</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>April 2011</td>
<td>Online only</td>
<td>New for Version 8.0 (Release 2011a)</td>
</tr>
<tr>
<td>September 2011</td>
<td>Online only</td>
<td>Revised for Version 8.1 (Release 2011b)</td>
</tr>
<tr>
<td>March 2012</td>
<td>Online only</td>
<td>Revised for Version 8.2 (Release 2012a)</td>
</tr>
<tr>
<td>September 2012</td>
<td>Online only</td>
<td>Revised for Version 8.3 (Release 2012b)</td>
</tr>
<tr>
<td>March 2013</td>
<td>Online only</td>
<td>Revised for Version 8.4 (Release 2013a)</td>
</tr>
<tr>
<td>September 2013</td>
<td>Online only</td>
<td>Revised for Version 8.5 (Release 2013b)</td>
</tr>
<tr>
<td>March 2014</td>
<td>Online only</td>
<td>Revised for Version 8.6 (Release 2014a)</td>
</tr>
<tr>
<td>October 2014</td>
<td>Online only</td>
<td>Revised for Version 8.7 (Release 2014b)</td>
</tr>
<tr>
<td>March 2015</td>
<td>Online only</td>
<td>Revised for Version 8.8 (Release 2015a)</td>
</tr>
<tr>
<td>September 2015</td>
<td>Online only</td>
<td>Revised for Version 8.9 (Release 2015b)</td>
</tr>
<tr>
<td>October 2015</td>
<td>Online only</td>
<td>Rereleased for Version 8.8.1 (Release 2015aSP1)</td>
</tr>
<tr>
<td>March 2016</td>
<td>Online only</td>
<td>Revised for Version 8.10 (Release 2016a)</td>
</tr>
<tr>
<td>September 2016</td>
<td>Online only</td>
<td>Revised for Version 8.11 (Release 2016b)</td>
</tr>
<tr>
<td>March 2017</td>
<td>Online only</td>
<td>Revised for Version 8.12 (Release 2017a)</td>
</tr>
<tr>
<td>September 2017</td>
<td>Online only</td>
<td>Revised for Version 8.13 (Release 2017b)</td>
</tr>
<tr>
<td>March 2018</td>
<td>Online only</td>
<td>Revised for Version 8.14 (Release 2018a)</td>
</tr>
<tr>
<td>September 2018</td>
<td>Online only</td>
<td>Revised for Version 9.0 (Release 2018b)</td>
</tr>
</tbody>
</table>
Check Bug Reports for Issues and Fixes

Software is inherently complex and is not free of errors. The output of a code generator might contain bugs, some of which are not detected by a compiler. MathWorks reports critical known bugs brought to its attention on its Bug Report system at www.mathworks.com/support/bugreports/. Use the Saved Searches and Watched Bugs tool with the search phrase "Incorrect Code Generation" to obtain a report of known bugs that produce code that might compile and execute, but still produce wrong answers.

The bug reports are an integral part of the documentation for each release. Examine periodically all bug reports for a release, as such reports may identify inconsistencies between the actual behavior of a release you are using and the behavior described in this documentation.

In addition to reviewing bug reports, you should implement a verification and validation strategy to identify potential bugs in your design, code, and tools.
Model Architecture and Design

Modeling Environment for Simulink Coder

1

Design Models for Rapid Prototyping Deployment ........ 1-2
Application Algorithms and Run-Time Environments .... 1-2
Software Execution Framework for Generated Code .... 1-3
Map Embedded System Architecture to Simulink Modeling
Environment ........................................ 1-5
Model Templates for Code Generation .................. 1-12

Modeling in Simulink Coder

2

Configure a Model for Code Generation ............... 2-2

Blocks and Products Supported for C Code

Generation .......................................... 2-4
Related Products .................................... 2-4
Simulink Built-In Blocks That Support Code
Generation ............................................. 2-6
Simulink Block Data Type Support Table ............ 2-29
Block Set Support for Code Generation ............... 2-29

Modeling Semantic Considerations .................... 2-30
Data Propagation .................................... 2-30
Sample Time Propagation ............................. 2-32
Latches for Subsystem Blocks ........................ 2-33
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Execution Order</td>
<td>2-34</td>
</tr>
<tr>
<td>Algebraic Loops</td>
<td>2-35</td>
</tr>
<tr>
<td>Modeling Guidelines for Blocks</td>
<td>2-38</td>
</tr>
<tr>
<td>Modeling Guidelines for Subsystems</td>
<td>2-39</td>
</tr>
<tr>
<td>Modeling Guidelines for Charts</td>
<td>2-42</td>
</tr>
<tr>
<td>Modeling Guidelines for MATLAB Functions</td>
<td>2-44</td>
</tr>
<tr>
<td>Modeling Guidelines for Model Configuration</td>
<td>2-45</td>
</tr>
</tbody>
</table>

**Timers in Simulink Coder**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute and Elapsed Time Computation</td>
<td>3-2</td>
</tr>
<tr>
<td>About Timers</td>
<td>3-2</td>
</tr>
<tr>
<td>Timers for Periodic and Asynchronous Tasks</td>
<td>3-3</td>
</tr>
<tr>
<td>Allocation of Timers</td>
<td>3-3</td>
</tr>
<tr>
<td>Integer Timers in Generated Code</td>
<td>3-3</td>
</tr>
<tr>
<td>Elapsed Time Counters in Triggered Subsystems</td>
<td>3-4</td>
</tr>
<tr>
<td>Access Timers Programmatically</td>
<td>3-5</td>
</tr>
<tr>
<td>About Timer APIs</td>
<td>3-5</td>
</tr>
<tr>
<td>C API for S-Functions</td>
<td>3-5</td>
</tr>
<tr>
<td>TLC API for Code Generation</td>
<td>3-7</td>
</tr>
<tr>
<td>Generate Code for an Elapsed Time Counter</td>
<td>3-9</td>
</tr>
<tr>
<td>Absolute Time Limitations</td>
<td>3-12</td>
</tr>
</tbody>
</table>

**Time-Based Scheduling in Simulink Coder**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time-Based Scheduling and Code Generation</td>
<td>4-2</td>
</tr>
<tr>
<td>Sample Time Considerations</td>
<td>4-2</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Tasking Modes</td>
<td>4-2</td>
</tr>
<tr>
<td>Model Execution and Rate Transitions</td>
<td>4-4</td>
</tr>
<tr>
<td>Execution During Simulink Model Simulation</td>
<td>4-5</td>
</tr>
<tr>
<td>Model Execution in Real Time</td>
<td>4-5</td>
</tr>
<tr>
<td>Single-Tasking Versus Multitasking Operation</td>
<td>4-6</td>
</tr>
<tr>
<td><strong>Modeling for Single-Tasking Execution</strong></td>
<td>4-8</td>
</tr>
<tr>
<td>Single-Tasking Mode</td>
<td>4-8</td>
</tr>
<tr>
<td>Build a Program for Single-Tasking Execution</td>
<td>4-8</td>
</tr>
<tr>
<td>Single-Tasking Execution</td>
<td>4-8</td>
</tr>
<tr>
<td><strong>Modeling for Multitasking Execution</strong></td>
<td>4-12</td>
</tr>
<tr>
<td>Multitasking and Pseudomultitasking Modes</td>
<td>4-12</td>
</tr>
<tr>
<td>Build a Program for Multitasking Execution</td>
<td>4-14</td>
</tr>
<tr>
<td>Execute Multitasking Models</td>
<td>4-14</td>
</tr>
<tr>
<td>Multitasking Execution</td>
<td>4-16</td>
</tr>
<tr>
<td><strong>Handle Rate Transitions</strong></td>
<td>4-21</td>
</tr>
<tr>
<td>Rate Transitions</td>
<td>4-21</td>
</tr>
<tr>
<td>Data Transfer Problems</td>
<td>4-22</td>
</tr>
<tr>
<td>Data Transfer Assumptions</td>
<td>4-23</td>
</tr>
<tr>
<td>Rate Transition Block Options</td>
<td>4-23</td>
</tr>
<tr>
<td>Automatic Rate Transition</td>
<td>4-26</td>
</tr>
<tr>
<td>Visualize Inserted Rate Transition Blocks</td>
<td>4-27</td>
</tr>
<tr>
<td>Periodic Sample Rate Transitions</td>
<td>4-29</td>
</tr>
<tr>
<td>Protect Data Integrity with volatile Keyword</td>
<td>4-35</td>
</tr>
<tr>
<td>Separate Rate Transition Block Code and Data from Algorithm Code and Data</td>
<td>4-35</td>
</tr>
<tr>
<td><strong>Configure Time-Based Scheduling</strong></td>
<td>4-37</td>
</tr>
<tr>
<td>Configure Start and Stop Times</td>
<td>4-37</td>
</tr>
<tr>
<td>Configure the Solver Type</td>
<td>4-37</td>
</tr>
<tr>
<td>Configure the Tasking Mode</td>
<td>4-38</td>
</tr>
<tr>
<td><strong>Time-Based Scheduling Example Models</strong></td>
<td>4-39</td>
</tr>
<tr>
<td>Optimize Memory Usage for Time Counters</td>
<td>4-39</td>
</tr>
<tr>
<td>Single-Rate Modeling (Bare Board, No OS)</td>
<td>4-45</td>
</tr>
<tr>
<td>Multirate Modeling in Single-Tasking Mode (Bare Board, no OS)</td>
<td>4-47</td>
</tr>
<tr>
<td>Multirate Modeling in Multitasking Mode (Bare Board, no OS)</td>
<td>4-49</td>
</tr>
<tr>
<td>Trade Determinism and Data Integrity to Improve System Performance</td>
<td>4-51</td>
</tr>
</tbody>
</table>
Event-Based Scheduling in Simulink Coder

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Asynchronous Events</strong></td>
<td>5-2</td>
</tr>
<tr>
<td>Asynchronous Support</td>
<td>5-2</td>
</tr>
<tr>
<td>Block Library for Calls to an Example Real-Time Operating System</td>
<td>5-2</td>
</tr>
<tr>
<td>Access the Block Library for RTOS Integration</td>
<td>5-4</td>
</tr>
<tr>
<td>Generate Code Using Library Blocks for RTOS Integration</td>
<td>5-4</td>
</tr>
<tr>
<td>Examples and Additional Information</td>
<td>5-4</td>
</tr>
<tr>
<td><strong>Generate Interrupt Service Routines</strong></td>
<td>5-6</td>
</tr>
<tr>
<td>Connecting the Async Interrupt Block</td>
<td>5-6</td>
</tr>
<tr>
<td>Requirements and Restrictions</td>
<td>5-7</td>
</tr>
<tr>
<td>Performance Considerations</td>
<td>5-7</td>
</tr>
<tr>
<td>Using the Async Interrupt Block in Simulation and Code Generation</td>
<td>5-8</td>
</tr>
<tr>
<td>Dual-Model Approach: Simulation</td>
<td>5-9</td>
</tr>
<tr>
<td>Dual-Model Approach: Code Generation</td>
<td>5-9</td>
</tr>
<tr>
<td><strong>Spawn and Synchronize Execution of RTOS Task</strong></td>
<td>5-15</td>
</tr>
<tr>
<td><strong>Pass Asynchronous Events in RTOS as Input To a Referenced Model</strong></td>
<td>5-32</td>
</tr>
<tr>
<td><strong>Rate Transitions and Asynchronous Blocks</strong></td>
<td>5-36</td>
</tr>
<tr>
<td>About Rate Transitions and Asynchronous Blocks</td>
<td>5-36</td>
</tr>
<tr>
<td>Handle Rate Transitions for Asynchronous Tasks</td>
<td>5-37</td>
</tr>
<tr>
<td>Handle Multiple Asynchronous Interrupts</td>
<td>5-38</td>
</tr>
<tr>
<td>Protect Data Integrity with volatile Keyword</td>
<td>5-40</td>
</tr>
<tr>
<td><strong>Timers in Asynchronous Tasks</strong></td>
<td>5-42</td>
</tr>
<tr>
<td><strong>Create a Customized Asynchronous Library</strong></td>
<td>5-45</td>
</tr>
<tr>
<td>About Implementing Asynchronous Blocks</td>
<td>5-45</td>
</tr>
<tr>
<td>Async Interrupt Block Implementation</td>
<td>5-46</td>
</tr>
<tr>
<td>Task Sync Block Implementation</td>
<td>5-50</td>
</tr>
<tr>
<td>asynclib.tlc Support Library</td>
<td>5-52</td>
</tr>
<tr>
<td><strong>Import Asynchronous Event Data for Simulation</strong></td>
<td>5-54</td>
</tr>
<tr>
<td>Capabilities</td>
<td>5-54</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Generate Reentrant Code from Top Models</td>
<td>9-25</td>
</tr>
<tr>
<td>Generate Reentrant, Multi-Instance Code</td>
<td>9-26</td>
</tr>
<tr>
<td>Share Data Between Instances</td>
<td>9-29</td>
</tr>
<tr>
<td>Generate Reentrant Code from Simulink Function Blocks</td>
<td>9-31</td>
</tr>
<tr>
<td>Identify Requirements</td>
<td>9-31</td>
</tr>
<tr>
<td>Create Model</td>
<td>9-32</td>
</tr>
<tr>
<td>Configure Model and Model Elements</td>
<td>9-34</td>
</tr>
<tr>
<td>Generate and Inspect C Code</td>
<td>9-36</td>
</tr>
<tr>
<td>Generate and Inspect C++ Code</td>
<td>9-38</td>
</tr>
<tr>
<td>Limitations</td>
<td>9-42</td>
</tr>
<tr>
<td>Generate Reentrant Code from Subsystems</td>
<td>9-43</td>
</tr>
<tr>
<td>Limitations</td>
<td>9-44</td>
</tr>
<tr>
<td>Determine Why Subsystem Code Is Not Reused</td>
<td>9-47</td>
</tr>
<tr>
<td>Generate Reusable Code From Referenced Models</td>
<td>9-52</td>
</tr>
<tr>
<td>Considerations for Subsystems that Contain Referenced Models</td>
<td>9-52</td>
</tr>
<tr>
<td>Code Reuse and Model Blocks with Root Inport or Outport Blocks</td>
<td>9-52</td>
</tr>
<tr>
<td>Generate Reusable Code from Library Subsystems Shared Across Models</td>
<td>9-55</td>
</tr>
<tr>
<td>What Is a Reusable Library Subsystem?</td>
<td>9-55</td>
</tr>
<tr>
<td>Reusable Library Subsystem Code Placement and Naming</td>
<td>9-56</td>
</tr>
<tr>
<td>Configure Reusable Library Subsystem</td>
<td>9-56</td>
</tr>
<tr>
<td>Configure Models That Include Reusable Library Subsystems</td>
<td>9-57</td>
</tr>
<tr>
<td>Generate Reusable Code for Subsystems Shared Across Models</td>
<td>9-57</td>
</tr>
<tr>
<td>Generate Reusable Code from Stateflow Atomic Subcharts</td>
<td>9-66</td>
</tr>
<tr>
<td>Generate Reusable Code for Linked Atomic Subcharts</td>
<td>9-66</td>
</tr>
<tr>
<td>Generate Reusable Code for Unlinked Atomic Subcharts</td>
<td>9-67</td>
</tr>
<tr>
<td>Generate Reusable Code for Unit Testing</td>
<td>9-67</td>
</tr>
<tr>
<td>Generate Shared Utility Code</td>
<td>9-72</td>
</tr>
<tr>
<td>When to Generate Shared Utility Code</td>
<td>9-72</td>
</tr>
</tbody>
</table>
Configure Naming of Generated Functions .............. 9-72
Control Placement of Shared Utility Code ............... 9-73
Control Placement of rtwtypes.h for Shared Utility Code .................................................. 9-74
Avoid Duplicate Header Files for Exported Data ....... 9-75
Reduce Shared Utility Code Generation with Incremental Builds ........................................ 9-75
Manage the Shared Utility Code Checksum .............. 9-76

Generate Shared Utility Code for Fixed-Point Functions ......................................................... 9-82

Generate Shared Utility Code for Custom Data Types ......................................................... 9-84

Shared Constant Parameters for Code Reuse ............ 9-86
Suppress Shared Constants in the Generated Code .... 9-87

Configure Model Parameters for Simulink Coder

10

Configure Run-Time Environment Options ............... 10-2
Configure Production and Test Hardware ............... 10-3
Production Hardware Considerations .................. 10-13
Test Hardware Considerations ......................... 10-14
Example Production Hardware Setting That Affects Normal Mode Simulation ..................... 10-14

Model Protection in Simulink Coder

11

Protect Models for Third-Party Use ...................... 11-2
Requirements for Protecting a Model .................... 11-3
Harness Model ........................................... 11-5
Protected Model Report .................................. 11-6
Code Generation Support in Protected Models ........ 11-7
  Protected Model Requirements to Support Code
  Generation ...................................... 11-7

Protected Model File .................................. 11-10

Create a Protected Model ............................. 11-12

Protected Model Creation Settings ................. 11-17
  Open Read-Only View of Model .................... 11-18
  Simulate ....................................... 11-18
  Use Generated Code .............................. 11-18

Create a Protected Model with Multiple Targets .... 11-20

Use a Protected Model with Multiple Targets ....... 11-22

Test the Protected Model ............................ 11-23

Save Base Workspace Definitions .................... 11-25

Package a Protected Model ......................... 11-26

Specify Custom Obfuscator for Protected Model .... 11-27

Define Callbacks for Protected Models ............. 11-29
  Creating Callbacks ................................ 11-29
  Defining Callback Code ........................... 11-29
  Create a Protected Model with Callbacks ......... 11-30

Component Initialization, Reset, and Termination
  in Simulink Coder

  Generate Code That Responds to Initialize, Reset, and
  Terminate Events ................................ 12-2
    Generate Code for Initialize and Terminate Events .... 12-2
    Generate Code for Reset Events .................... 12-7
    Event Names and Code Aggregation .................. 12-9
    Limitation ..................................... 12-12
## Import Calls to External Code into Generated Code with Legacy Code Tool

- Legacy Code Tool and Code Generation ................................. 14-7
- Generate Inlined S-Function Files for Code Generation .................. 14-8
- Apply Code Style Settings to Legacy Functions ....................... 14-9
- Address Dependencies on Files in Different Locations ................. 14-9
- Deploy S-Functions for Simulation and Code Generation .................. 14-10
- Integrate External C++ Object Methods .................................. 14-11
- Integrate External C++ Objects .......................................... 14-14
- Legacy Code Tool Examples ................................................. 14-16

## Integrate External C Functions That Pass Input and Output Arguments as Parameters with a Fixed-Point Data Type

................................................................. 14-51

## Integrate External C Functions That Implement N-Dimensional Table Lookups

................................................................. 14-55

## Integrate External C++ Object Methods

................................................................. 14-59

## External Code Integration Examples

- Insert External C and C++ Code Into Stateflow Charts for Code Generation .................................................. 14-63
- Integrate External C Code Into Generated Code By Using Custom Code Blocks and Model Configuration Parameters .................................................. 14-65
- Integrate External C Code Into Generated Code By Using Custom Code Blocks and Model Configuration Parameters .................................................. 14-68
- Insert External C and C++ Code Into Stateflow Charts for Code Generation .................................................. 14-71

## Generate S-Function from Subsystem

- Macro Parameters .................................................. 14-77

## S-Functions That Support Expression Folding

- Categories of Output Expressions ........................................ 14-79
- Acceptance or Denial of Requests for Input Expressions ................. 14-84
- Expression Folding in a TLC Block Implementation ..................... 14-86
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>S-Functions That Specify Port Scope and Reusability</td>
<td>14-91</td>
</tr>
<tr>
<td>S-Functions That Specify Sample Time Inheritance Rules</td>
<td>14-96</td>
</tr>
<tr>
<td>S-Functions That Support Code Reuse</td>
<td>14-99</td>
</tr>
<tr>
<td>S-Functions for Multirate Multitasking Environments</td>
<td>14-100</td>
</tr>
<tr>
<td>About S-Functions for Multirate Multitasking Environments</td>
<td>14-100</td>
</tr>
<tr>
<td>Rate Grouping Support in S-Functions</td>
<td>14-100</td>
</tr>
<tr>
<td>Create Multitasking, Multirate, Port-Based Sample Time S-Functions</td>
<td>14-101</td>
</tr>
<tr>
<td>Write Noninlined S-Function</td>
<td>14-107</td>
</tr>
<tr>
<td>Guidelines for Writing Noninlined S-Functions</td>
<td>14-107</td>
</tr>
<tr>
<td>Noninlined S-Function Parameter Type Limitations</td>
<td>14-108</td>
</tr>
<tr>
<td>Write Wrapper S-Function and TLC Files</td>
<td>14-110</td>
</tr>
<tr>
<td>MEX S-Function Wrapper</td>
<td>14-110</td>
</tr>
<tr>
<td>TLC S-Function Wrapper</td>
<td>14-114</td>
</tr>
<tr>
<td>Code Overhead for Noninlined S-Functions</td>
<td>14-114</td>
</tr>
<tr>
<td>Inline a Wrapper S-Function</td>
<td>14-116</td>
</tr>
<tr>
<td>The Inlined Code</td>
<td>14-117</td>
</tr>
<tr>
<td>Write Fully Inlined S-Functions</td>
<td>14-119</td>
</tr>
<tr>
<td>Multiport S-Function</td>
<td>14-119</td>
</tr>
<tr>
<td>Guidelines for Writing Inlined S-Functions</td>
<td>14-120</td>
</tr>
<tr>
<td>Write Fully Inlined S-Functions with mdlRTW Routine</td>
<td>14-121</td>
</tr>
<tr>
<td>S-Function RTWdata</td>
<td>14-121</td>
</tr>
<tr>
<td>Direct-Index Lookup Table Algorithm</td>
<td>14-122</td>
</tr>
<tr>
<td>Direct-Index Lookup Table Example</td>
<td>14-123</td>
</tr>
<tr>
<td>Error Handling</td>
<td>14-124</td>
</tr>
<tr>
<td>User Data Caching</td>
<td>14-124</td>
</tr>
<tr>
<td>mdlRTW Usage</td>
<td>14-125</td>
</tr>
</tbody>
</table>
# Data, Function, and File Definition

## Data Representation in Simulink Coder

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configure Data Accessibility for Rapid Prototyping</strong></td>
<td>15-3</td>
</tr>
<tr>
<td>Access Signal, State, and Parameter Data During Execution</td>
<td>15-3</td>
</tr>
<tr>
<td>Configure Data Accessibility</td>
<td>15-4</td>
</tr>
<tr>
<td>Limitations</td>
<td>15-5</td>
</tr>
<tr>
<td><strong>Access Signal, State, and Parameter Data During Execution</strong></td>
<td>15-7</td>
</tr>
<tr>
<td><strong>Standard Data Structures in the Generated Code</strong></td>
<td>15-26</td>
</tr>
<tr>
<td>Control Characteristics of Data Structures (Embedded Coder)</td>
<td>15-27</td>
</tr>
<tr>
<td><strong>Use the Real-Time Model Data Structure</strong></td>
<td>15-29</td>
</tr>
<tr>
<td><strong>How Generated Code Exchanges Data with an Environment</strong></td>
<td>15-33</td>
</tr>
<tr>
<td>Data Interfaces in the Generated Code</td>
<td>15-33</td>
</tr>
<tr>
<td>Configure Data Interface</td>
<td>15-41</td>
</tr>
<tr>
<td><strong>Control Data and Function Interface in Generated Code</strong></td>
<td>15-42</td>
</tr>
<tr>
<td>Control Type Names, Field Names, and Variable Names of Standard I/O Structures (Embedded Coder)</td>
<td>15-42</td>
</tr>
<tr>
<td>Control Names of Generated Entry-Point Functions (Embedded Coder)</td>
<td>15-42</td>
</tr>
<tr>
<td>Control Data Interface for Nonreentrant Code</td>
<td>15-43</td>
</tr>
<tr>
<td>Control Data Interface for Reentrant Code</td>
<td>15-45</td>
</tr>
<tr>
<td>Prevent Unintended Changes to the Interface</td>
<td>15-46</td>
</tr>
<tr>
<td>Reduce Number of Arguments by Using Structures</td>
<td>15-47</td>
</tr>
<tr>
<td>Control Data Types of Arguments</td>
<td>15-48</td>
</tr>
<tr>
<td>Promote Data Item to the Interface</td>
<td>15-48</td>
</tr>
</tbody>
</table>
How Generated Code Stores Internal Signal, State, and Parameter Data

- Internal Data in the Generated Code
- Local Variables in the Generated Code
- Appearance of Test Points in the Generated Code
- Appearance of Workspace Variables in the Generated Code
- Promote Internal Data to the Interface
- Control Default Representation of Internal Data (Embedded Coder)

Choose Storage Class for Controlling Data Representation in Generated Code

- Specify File Names and Other Data Attributes With Storage Class (Embedded Coder)
- Specify Default #include Syntax for Header Files That Declare Data (Embedded Coder)
- Storage Class Limitations

Use Storage Classes in Reentrant, Multi-Instance Models and Components

- Directly Applied Storage Classes
- Storage Classes Applied by Default

Apply Storage Classes to Individual Signal, State, and Parameter Data Elements

- Apply Storage Classes to Data Items
- Built-In Storage Classes You Can Choose
- Decide Where to Store Storage Class Specification
- Techniques to Apply Storage Classes Interactively
- Techniques to Apply Storage Classes Programmatically
- Parameter Object Configuration Quick Reference Diagram

Use Enumerated Data in Generated Code

- Enumerated Data Types
- Specify Integer Data Type for Enumeration
- Customize Enumerated Data Type
- Control Enumerated Type Implementation in Generated Code
- Type Casting for Enumerations
- Enumerated Type Limitations
Data Stores in Generated Code ........................................ 15-101
  About Data Stores .................................................. 15-101
  Generate Code for Data Store Memory Blocks ............. 15-101
  Storage Classes for Data Store Memory Blocks .......... 15-102
  Data Store Buffering in Generated Code ..................... 15-104
  Data Stores Shared by Instances of a Reusable
  Model ............................................................. 15-107
  Structures in Generated Code Using Data Stores ...... 15-108

Specify Single-Precision Data Type for Embedded
Application ............................................................ 15-112
  Use single Data Type as Default for Underspecified
  Types ............................................................. 15-112

Tune Phase Parameter of Sine Wave Block During Code
Execution .............................................................. 15-116

Switch Between Output Waveforms During Code
Execution for Waveform Generator Block ................. 15-118

Create Tunable Calibration Parameter in the Generated
Code ................................................................. 15-122
  Represent Block Parameter as Tunable Global
  Variable .......................................................... 15-122
  Apply Storage Class When Block Parameter Refers to
  Numeric MATLAB Variable ................................... 15-125
  Create Storage Class That Represents Calibration
  Parameters (Embedded Coder) ............................... 15-126
  Initialize Parameter Value From System Constant or Other
  Macro (Embedded Coder) ...................................... 15-130
  Code Generation Impact of Storage Location for Parameter
  Objects ............................................................ 15-131
  Configure Accessibility of Signal Data .................... 15-132
  Programmatic Interfaces for Tuning Parameters .......... 15-132
  Set Tunable Parameter Minimum and Maximum
  Values ............................................................ 15-133
  Considerations for Other Modeling Goals ................ 15-133

Limitations for Block Parameter Tunability in the
Generated Code ...................................................... 15-136
  Tunable Expression Limitations ............................... 15-136
  Linear Block Parameter Tunability ......................... 15-138
  Parameter Structures ........................................... 15-138
Code Generation of Parameter Objects With Expression Values ........................................ 15-140
Considerations and Limitations .................. 15-140
Expression Preservation ......................... 15-141

Specify Instance-Specific Parameter Values for Reusable Referenced Model .................. 15-143
Pass Parameter Data to Referenced Model Entry-Point Functions as Arguments ............... 15-143
Control Data Types of Model Arguments and Argument Values .................................. 15-154

Parameter Data Types in the Generated Code ........ 15-157
Significance of Parameter Data Types .......... 15-157
Typecasts Due to Parameter Data Type Mismatches ............................................. 15-158
Considerations for Other Modeling Patterns ........ 15-159

Generate Efficient Code by Specifying Data Types for Block Parameters ..................... 15-163
Eliminate Unnecessary Typecasts and Shifts by Matching Data Types ............................. 15-163
Reduce Memory Consumption by Storing Parameter Value in Small Data Type ................ 15-166

Reuse Parameter Data in Different Data Type Contexts ........................................... 15-173

Organize Data into Structures in Generated Code .................................................. 15-177
Techniques to Create Structures .................. 15-182
Default Application of Structured Storage Class ............................................. 15-183
Direct Application of Structured Storage Class ............................................. 15-184
Nonvirtual Buses and Parameter Structures ............................................. 15-184
Combine Techniques to Work Around Limitations ............................................. 15-195
Arrays of Structures ................................ 15-195
Structure Padding ................................ 15-195
Limitations .................................... 15-196

Switch Between Sets of Parameter Values During Simulation and Code Execution .......... 15-197

Design Data Interface by Configuring Inport and Outport Blocks ................................ 15-207
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate Efficient Code for Bus Signals</td>
<td>15-213</td>
</tr>
<tr>
<td>Code Efficiency for Bus Signals</td>
<td>15-213</td>
</tr>
<tr>
<td>Set Bus Diagnostics</td>
<td>15-214</td>
</tr>
<tr>
<td>Optimize Virtual and Nonvirtual Buses</td>
<td>15-214</td>
</tr>
<tr>
<td>Control Signal and State Initialization in the Generated Code</td>
<td>15-217</td>
</tr>
<tr>
<td>Signal and State Initialization in the Generated Code</td>
<td>15-217</td>
</tr>
<tr>
<td>Generate Tunable Initial Conditions</td>
<td>15-219</td>
</tr>
<tr>
<td>Generate Tunable Initial Condition Structure for Bus Signal</td>
<td>15-222</td>
</tr>
<tr>
<td>Initialization of Signal, State, and Parameter Data in the Generated Code</td>
<td>15-229</td>
</tr>
<tr>
<td>Static Initialization and Dynamic Initialization</td>
<td>15-229</td>
</tr>
<tr>
<td>Real-World Ground Initialization Requiring Nonzero Bit Pattern</td>
<td>15-230</td>
</tr>
<tr>
<td>Initialization of Signal and State Data</td>
<td>15-230</td>
</tr>
<tr>
<td>Initialization of Parameter Data</td>
<td>15-232</td>
</tr>
<tr>
<td>Data Initialization in the Generated Code</td>
<td>15-233</td>
</tr>
<tr>
<td>Modeling Goals</td>
<td>15-238</td>
</tr>
<tr>
<td>Optimize Speed and Size of Signal Processing Algorithm by Using Fixed-Point Data</td>
<td>15-240</td>
</tr>
<tr>
<td>Optimize Generated Code Using Fixed-Point Data with Simulink®, Stateflow®, and MATLAB®</td>
<td>15-242</td>
</tr>
<tr>
<td>Declare Workspace Variables as Tunable Parameters Using the Model Parameter Configuration Dialog Box</td>
<td>15-244</td>
</tr>
<tr>
<td>Declare Existing Workspace Variables as Tunable Parameters</td>
<td>15-244</td>
</tr>
<tr>
<td>Declare New Tunable Parameters</td>
<td>15-245</td>
</tr>
<tr>
<td>Set Tunable Parameter Code Generation Options</td>
<td>15-245</td>
</tr>
<tr>
<td>Programmatically Declare Workspace Variables as Tunable Parameters</td>
<td>15-246</td>
</tr>
<tr>
<td>Share Data Between Code Generated from Simulink, Stateflow, and MATLAB</td>
<td>15-248</td>
</tr>
</tbody>
</table>
# Entry-Point Functions and Scheduling in Simulink Coder

## Configure Code Generation for Model Entry-Point Functions

- What Is an Entry-Point Function? ........................................... 16-2
- Categories and Types of Generated Entry-Point Functions ............ 16-2
- Configure Whether Entry-Point Functions Are Reusable .............. 16-3
- Configure Generated Entry-Point Function Declarations ............. 16-6
- Configure Placement of Entry-Point Functions in Memory .......... 16-7
- How to Interface with Generated Entry-Point Functions ............. 16-7

## Generate C++ Class Interface to Model or Subsystem Code

- Generate C++ Class Interface to Model Code .......................... 16-9
- Generate C++ Class Interface to Nonvirtual Subsystem Code .......... 16-10
- C++ Class Interface Limitations ......................................... 16-11

## Execution of Code Generated from a Model

- Program Execution .......................................................... 16-14
- Program Timing .............................................................. 16-14
- External Mode Communication ............................................. 16-15
- Data Logging in Single-Tasking and Multitasking Model Execution .... 16-16
- Non-Real-Time Single-Tasking Systems .................................. 16-17
- Non-Real-Time Multitasking Systems ................................. 16-17
- Real-Time Single-Tasking Systems ...................................... 16-19
- Real-Time Multitasking Systems ....................................... 16-20
- Multitasking Systems Using Real-Time Tasking Primitives ............ 16-22
- Rapid Prototyping and Embedded Model Execution Differences ........ 16-23

## Rapid Prototyping Model Functions

.......................................................... 16-25
Array Layout

17

Column-Major Layout to Row-Major Layout Conversion of Models with Lookup Table Blocks .......................... 17-2

Interpolation Algorithm for Row-Major Array Layout ............. 17-12

Interpolation with Subtable Selection Algorithm for Row-Major Array Layout ............................................ 17-18

Direct Lookup Table Algorithm for Row-Major Array Layout ........................................................................ 17-27

Generate Row-Major Code for S-Functions .......................... 17-36

Code Generation

Configuration for Simulink Coder

18

Code Generation Configuration ........................................... 18-2

Open the Model Configuration for Code Generation .......... 18-2

Configuration Tools ......................................................... 18-3

Configure Code Generation Parameters for Model Programmatically ......................................................... 18-5

Modify Parameters to Support Execution efficiency ........ 18-5

Configure Model from Command Line ............................... 18-7

Use Configuration Reference to Select Code Generation Target .................................................. 18-13
Check Model and Configuration for Code Generation ................................................... 18-19
  Check Mode for Code Efficiency with Model Advisor ........................................ 18-19
  Check Model During Code Generation with Code Generation Advisor ................... 18-20

Application Objectives Using Code Generation Advisor ............................................. 18-22
  High-Level Code Generation Objectives ............................................................ 18-23
  Configure Model for Code Generation Objectives Using Code Generation Advisor .... 18-23
  Configure Model for Code Generation Objectives by Using Configuration Parameters Dialog Box .................................................. 18-25

Simulink Coder Model Advisor Checks for Standards and Code Efficiency .................... 18-26

Configure Code Comments ........................................................................................... 18-28

Include MATLAB Code as Comments in Generated Code ............................................ 18-30
  How to Include MATLAB Code as Comments in the Generated Code .................. 18-30
  Location of Comments in Generated Code ......................................................... 18-31
  Including MATLAB user comments in Generated Code .................................... 18-33
  Limitations of MATLAB Source Code as Comments .......................................... 18-34

Construction of Generated Identifiers .......................................................................... 18-35

Identifier Name Collisions and Mangling .................................................................. 18-36
  Identifier Name Collisions with Referenced Models ........................................... 18-36

Specify Identifier Length to Avoid Naming Collisions .............................................. 18-37

Specify Reserved Names for Generated Identifiers .................................................. 18-38

Reserved Keywords ..................................................................................................... 18-39
  C Reserved Keywords ......................................................................................... 18-39
  C++ Reserved Keywords ..................................................................................... 18-40
  Reserved Keywords for Code Generation ............................................................ 18-40
  Code Generation Code Replacement Library Keywords .................................... 18-41
Debug .......................................................... 18-43

System Target File Configuration

Configure a System Target File ......................... 19-2
Select a Solver That Supports Code Generation ...... 19-2
Select a System Target File from STF Browser ...... 19-3
Select a System Target File Programmatically ...... 19-4
Develop Custom System Target Files ................. 19-5

Configure STF-Related Code Generation Parameters . . . 19-7
Specify Generated Code Interfaces.................. 19-7
Configure Numeric Data Support ..................... 19-12
Configure Time Value Support ....................... 19-12
Configure Noninlined S-Function Support ............ 19-13
Configure Model Function Generation and
Argument Passing ..................................... 19-13
Configure Code Reuse Support ....................... 19-15

Configure a Code Replacement Library ............... 19-17

Configure Standard Math Library for Target System .. 19-18

Compare System Target File Support Across
Products ...................................................... 19-21
Compare Product System Target Files ............... 19-22
Compare Code Styles and STF Support ............... 19-26
Compare Generated Code Features by Product ...... 19-26
Compare Generated Code Features by STF .......... 19-30

Internationalization Support in Simulink Coder

Internationalization and Code Generation .......... 20-2
Locale Settings ........................................... 20-2
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepare to Generate Code for Mixed Languages and Locales</td>
<td>20-2</td>
</tr>
<tr>
<td>Character Set Limitations</td>
<td>20-3</td>
</tr>
<tr>
<td>XML Escape Sequence Replacements</td>
<td>20-3</td>
</tr>
<tr>
<td>Generate and Review Code with Mixed Languages and Mixed Locales</td>
<td>20-3</td>
</tr>
<tr>
<td><strong>Source Code Generation in Simulink Coder</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Configure Model, Generate Code, and Simulate</strong></td>
<td>21-2</td>
</tr>
<tr>
<td>About This Example</td>
<td>21-2</td>
</tr>
<tr>
<td>Functional Design of the Model</td>
<td>21-3</td>
</tr>
<tr>
<td>View the Top Model</td>
<td>21-3</td>
</tr>
<tr>
<td>View the Subsystems</td>
<td>21-4</td>
</tr>
<tr>
<td>Simulation Test Environment</td>
<td>21-5</td>
</tr>
<tr>
<td>Run Simulation Tests</td>
<td>21-10</td>
</tr>
<tr>
<td>Key Points</td>
<td>21-11</td>
</tr>
<tr>
<td>Learn More</td>
<td>21-12</td>
</tr>
<tr>
<td><strong>Configure Model and Generate Code</strong></td>
<td>21-13</td>
</tr>
<tr>
<td>About This Example</td>
<td>21-13</td>
</tr>
<tr>
<td>Configure the Model for Code Generation</td>
<td>21-14</td>
</tr>
<tr>
<td>Save Your Model Configuration as a MATLAB Function</td>
<td>21-15</td>
</tr>
<tr>
<td>Check Model Conditions and Configuration Settings</td>
<td>21-16</td>
</tr>
<tr>
<td>Generate Code for the Model</td>
<td>21-16</td>
</tr>
<tr>
<td>Review the Generated Code</td>
<td>21-17</td>
</tr>
<tr>
<td>Generate an Executable</td>
<td>21-18</td>
</tr>
<tr>
<td>Key Points</td>
<td>21-18</td>
</tr>
<tr>
<td><strong>Configure Data Interface</strong></td>
<td>21-20</td>
</tr>
<tr>
<td>About This Example</td>
<td>21-20</td>
</tr>
<tr>
<td>Declare Data</td>
<td>21-20</td>
</tr>
<tr>
<td>Use Data Objects</td>
<td>21-21</td>
</tr>
<tr>
<td>Add New Data Objects</td>
<td>21-24</td>
</tr>
<tr>
<td>Enable Data Objects for Generated Code</td>
<td>21-25</td>
</tr>
<tr>
<td>Effects of Simulation on Data Typing</td>
<td>21-25</td>
</tr>
<tr>
<td>Manage Data</td>
<td>21-27</td>
</tr>
<tr>
<td>Key Points</td>
<td>21-28</td>
</tr>
</tbody>
</table>
Contents

Call External C Functions .................................. 21-29
  About This Example .................................. 21-29
  Include External C Functions in a Model .......... 21-30
  Create a Block That Calls a C Function .......... 21-30
  Validate External Code in the Simulink Environment . 21-32
  Validate C Code as Part of a Model ............ 21-33
  Call a C Function from Generated Code .......... 21-35
  Key Points .................................. 21-35

Reload Generated Code .................................. 21-36

Manage Build Process Folders .......................... 21-37
  File Generation Control Parameters .......... 21-37
  Build Process Folders ......................... 21-40

Manage Build Process Files .......................... 21-43
  model.bat .................................. 21-49
  model.h ................................... 21-49
  rtwtypes.h .................................. 21-50

Manage Build Process File Dependencies ............. 21-53
  System Header Files .......................... 21-54
  Code Generator Header Files ............... 21-57

Add Build Process Dependencies ....................... 21-64
  File Dependency Information for the Build Process .. 21-65
  Folder Dependency Information for the Build Process ........ 21-67

Enable Build Process for Folder Names with Spaces . 21-70
  Build Process Folder Support on Windows .......... 21-72
  Troubleshooting Errors When Folder Names Have Spaces .................................. 21-73

Code Generation of Matrices and Arrays ............. 21-76
  Array Storage in Computer Memory .......... 21-76
  Code Generator Matrix Parameters .......... 21-78
  Internal Data Storage for Complex Number Arrays .. 21-81
  Unsupported Blocks for Row-Major Code Generation . 21-81

Cross-Release Shared Utility Code Reuse ............. 21-84
  Workflow to Reuse Shared Utility Code .......... 21-84
  Required Editing for Shared Utility Code Reuse .... 21-85
Cross-Release Code Integration ........................................... 21-87
  Workflow ........................................................................... 21-87
  Limitations ......................................................................... 21-90
  Simulink.Bus Support .......................................................... 21-91
  Root-Level I/O Through Global Variables in Generated Code ................................................... 21-94
  Communicate Between Current and Previous Release Components Through Global Data Stores .......... 21-97
  Parameter Tuning ............................................................... 21-98
  Use Multiple Instances of Code Generated from Reusable Referenced Model .................................. 21-99
  Compare Simulation Behavior of Model Component in Current Release and Generated Code from Previous Release .......................................................................... 21-101
  Import AUTOSAR Code from Previous Releases ......................................................................... 21-102

Generate Code Using Simulink® Coder™ ........................................ 21-103

Report Generation in Simulink Coder

Reports for Code Generation .................................................... 22-2
  HTML Code Generation Report Location .................................. 22-2
  HTML Code Generation Report for Referenced Models .............................................................. 22-3
  HTML Code Generation Report Extensions ........................................................................... 22-3

Generate a Code Generation Report .......................................... 22-6

Generate Code Generation Report After Build Process ............. 22-7

Open Code Generation Report .................................................. 22-9
  Limitation ............................................................................ 22-9

Generate Code Generation Report Programmatically ............... 22-11

View Code Generation Report in Model Explorer .................. 22-12
Package and Share the Code Generation Report ........................ 22-14
  Package the Code Generation Report .......................... 22-14
  View the Code Generation Report ............................ 22-15

Document Generated Code with Simulink Report
  Generator .................................................. 22-16
  Generate Code for the Model ............................. 22-17
  Open the Report Generator ............................... 22-17
  Set Report Name, Location, and Format .................. 22-19
  Include Models and Subsystems in a Report ............... 22-20
  Customize the Report .................................... 22-21
  Generate the Report ..................................... 22-22

Document Generated Code ...................................... 22-23

Get Code Description of Generated Code .................... 22-25
  Get Data Interface Information .......................... 22-25
  Get Function Interface Information ..................... 22-27
  Get Model Hierarchy Information ......................... 22-29

Code Replacement in Simulink Coder

23

  Code Replacement Libraries .............................. 23-2
  Code Replacement Terminology ........................... 23-4
  Code Replacement Limitations ............................ 23-7

Choose a Code Replacement Library .......................... 23-8
  About Choosing a Code Replacement Library ............ 23-8
  Explore Available Code Replacement Libraries .......... 23-8
  Explore Code Replacement Library Contents ............ 23-8

Replace Code Generated from Simulink Models .............. 23-10
Deployment

24

Desksops in Simulink Coder

Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by Using RSim System Target File ................................. 24-2
  About Rapid Simulation ........................................... 24-2
  Rapid Simulation Advantage ....................................... 24-2
  General Rapid Simulation Workflow ................................ 24-3
  Identify Rapid Simulation Requirements .......................... 24-4
  Configure Inports to Provide Simulation Source Data ............. 24-6
  Configure and Build Model for Rapid Simulation ................. 24-6
  Set Up Rapid Simulation Input Data ............................... 24-8
  Scripts for Batch and Monte Carlo Simulations .................. 24-19
  Run Rapid Simulations ............................................. 24-19
  Tune Parameters Interactively During Rapid Simulation .......... 24-30
  Rapid Simulation ....................................................... 24-33

Run Rapid Simulations Over Range of Parameter Values .................. 24-35

Run Batch Simulations Without Recompiling Generated Code ................. 24-43

Use MAT-Files to Feed Data to Inport Blocks for Rapid Simulations .............. 24-51

Accelerate Simulation, Reuse Code, or Protect Intellectual Property by Using S-Function Target .................................... 24-59
  About the S-Function Target ....................................... 24-59
  Create S-Function Blocks from a Subsystem ........................ 24-62
  Tunable Parameters in Generated S-Functions .................... 24-66
  System Target File ...................................................... 24-68
  Checksums and the S-Function Target ................................ 24-68
  Generated S-Function Compatibility ................................ 24-69
  S-Function Target Limitations ...................................... 24-69

xxxiii
# Real-Time Systems in Simulink Coder

## Deploy Algorithm Model for Real-Time Rapid Prototyping
- About Real-Time Rapid Prototyping .................................. 25-2
- Goals of Real-Time Rapid Prototyping .............................. 25-2
- Refine Code With Real-Time Rapid Prototyping ................. 25-3

## Deploy Environment Model for Real-Time Hardware-In-the-Loop (HIL) Simulation
- About Hardware-In-the-Loop Simulation .......................... 25-5
- Set Up and Run HIL Simulations .................................... 25-6

## External Code Integration in Simulink Coder


## Choose an External Code Integration Workflow .............. 26-4
- Choose a Software Execution Framework for Scheduling Code Execution .......................... 26-5
- Evaluate Characteristics of External Code ......................... 26-7
- Identify Integration Requirements ................................. 26-8
- Choose a Workflow .................................................. 26-10

## Configure Target Hardware Characteristics .................. 26-13

## Check Code Generation Assumptions ............................ 26-15
- Check Code Generator Assumptions for Development Computer ........................................ 26-15
- Coder Assumptions List ............................................. 26-17

## Call Reusable External Algorithm Code for Simulation and Code Generation .......................... 26-19
- Workflow .............................................................. 26-19
- Choose an Integration Approach .................................... 26-20
- Insert External Code into Stateflow Charts ..................... 26-30
### Place External C/C++ Code in Generated Code

26-39

- Workflow ........................................ 26-39
- Choose an Integration Approach .............. 26-40
- Integrate External Code by Using Custom Code Blocks ........................................ 26-42
- Integrate External Code by Using Model Configuration Parameters ............................ 26-45
- Integrate External C Code Into Generated Code By Using Custom Code Blocks and Model Configuration Parameters ......................... 26-47

### Call External Device Drivers

26-51

### Apply Function and Operator Code Replacements

26-53

### Build Integrated Code Within the Simulink Environment

26-54

- Workflow ........................................ 26-54
- Configure Parameters for Integrated Code Build Process ........................................ 26-55
- Preserve External Code Files in Build Folder ........................................ 26-57
- Build Support for S-Functions .................. 26-57

### Generate Component Source Code for Export to External Code Base

26-64

- Modeling Options ................................ 26-64
- Requirements ...................................... 26-65
- Limitations for Export-Function Subsystems ........................................ 26-66
- Workflow ........................................ 26-67
- Choose an Integration Approach .............. 26-68
- Generate C Function Code for Export-Function Model ........................................ 26-71
- Generate C++ Function and Class Code for Export-Function Model ............................ 26-76
- Generate Code for Export-Function Subsystems ........................................ 26-81

### Generate Shared Library for Export to External Code Base

26-85

- About Generated Shared Libraries ............ 26-85
- Workflow ........................................ 26-85
- Generate Shared Libraries ............................ 26-87
- Create Application Code That Uses Generated Shared Libraries .............................. 26-87
Limitations ............................................. 26-90

Interface to a Development Computer Simulator By Using a Shared Library ............................................. 26-92

Build Integrated Code Outside the Simulink Environment ................................................................. 26-95

Exchange Data Between External C/C++ Code and Simulink Model or Generated Code ................. 26-102
  Import External Code into Model .................................. 26-102
  Export Generated Code to External Environment ............. 26-104
  Simulink Representations of C Data Types and Constructs ............................................................... 26-104
  Considerations for Other Modeling Goals ...................... 26-112

Exchange Data Between External Calling Code and Generated Code ................................................. 26-114
  Data Exchange for Reentrant Generated Code ................. 26-114
  Data Exchange for Nonreentrant Generated Code ............. 26-115

Generate Code That Matches Appearance of External Code ................................................................. 26-118

Program Building, Interaction, and Debugging in Simulink Coder

27

Select C or C++ Programming Language .................. 27-2

Select and Configure C or C++ Compiler or IDE .......... 27-3
  Language Standards Compliance ................................. 27-3
  Programming Language Considerations .......................... 27-4
  C++ Language Support Limitations .............................. 27-5
  Code Generator Assumes Wrap on Signed Integer Overflows ................................................................. 27-5

Choose and Configure Compiler .................................. 27-6
Include S-Function Source Code ................................. 27-7
Troubleshoot Compiler Issues ........................................ 27-9
  Compiler Version Mismatch Errors .............................. 27-9
  Results for Model Simulation and Program Execution Differ ... 27-9
  Generates Expected Code and Produces Unexpected Results ... 27-10
Compile-Time Issues ...................................................... 27-10
  LCC Compiler Does Not Support Ampersands in Source Folder Paths ........................................ 27-12
  LCC Compiler Might Not Support Line Lengths of Rapid Accelerator Code ........................................ 27-13

Choose Build Approach and Configure Build Process ... 27-14
  Toolchain Approach .................................................... 27-14
  Upgrade Model to Use Toolchain Approach ...................... 27-16
  Template Makefile Approach ........................................ 27-20
  Specify TLC for Code Generation ................................... 27-24

Template Makefiles and Make Options ................................ 27-26
  Types of Template Makefiles ........................................ 27-26
  Specify Template Makefile Options ................................ 27-26
  Template Makefiles for UNIX Platforms ......................... 27-27
  Template Makefiles for the Microsoft Visual C++ Compiler ........................................ 27-28
  Template Makefiles for the LCC Compiler ....................... 27-30

  Working Folder ......................................................... 27-32
  Build Folder and Code Generation Folders ....................... 27-32
  Set Model Parameters for Code Generation ....................... 27-33
  Configure Build Process ............................................. 27-34
  Set Code Generation Parameters ................................... 27-35
  Build and Run a Program ............................................. 27-36
  Contents of the Build Folder ....................................... 27-38
  Customized Makefile Generation .................................... 27-39

Build Models from a Windows Command Prompt Window .......... 27-41

Rebuild a Model .......................................................... 27-44

Control Regeneration of Top Model Code .......................... 27-46
  Regeneration of Top Model Code .................................... 27-46
Force Regeneration of Top Model Code .................. 27-47

Reduce Build Time for Referenced Models ............. 27-48
Parallel Building for Large Model Reference
Hierarchies ............................................ 27-48
Parallel Building Configuration Requirements ......... 27-49
Build Models in a Parallel Computing Environment ... 27-49
Locate Parallel Build Logs ............................... 27-51
View Build Process Status ............................... 27-53
Apply Build Process Status to Improve Parallel
Builds .................................................. 27-54

Relocate Code to Another Development Environment .................................. 27-60
Code Relocation ........................................... 27-60
Package Code Using the User Interface ................. 27-60
Package Code Using the Command-Line Interface ... 27-61
Build Integrated Code Outside the Simulink
Environment ........................................... 27-65
packNGo Function Limitations ............................ 27-71

Compile and Debug Generated C Code with Microsoft®
Visual Studio® .......................................... 27-72

Executable Program Generation .......................... 27-74

Profile Code Performance ................................ 27-77
Use the Profile Hook Function Interface ................ 27-77
Profile Hook Function Interface Limitation ............ 27-79

Host/Target Communication in Simulink Coder

Host-Target Communication with External Mode
Simulation .............................................. 28-2

External Mode Simulation with XCP Communication ... 28-8
Run XCP External Mode Simulation From Simulink
Editor .................................................... 28-8
Target Application Arguments ............................ 28-12
Graphical Controls for XCP External Mode Simulations ........................................ 28-13
Run XCP External Mode Simulation From Command Line .................................... 28-16
XCP External Mode Limitations ................................................................. 28-17

Customize XCP Slave Software ............................................................. 28-22
External Mode Abstraction Layer ....................................................... 28-23
XCP Slave Protocol Layer ................................................................. 28-27
XCP Slave Transport Layer ................................................................. 28-27
XCP Platform Abstraction Layer ......................................................... 28-27

External Mode Simulation with TCP/IP or Serial Communication .................. 28-36
Create and Configure Model ................................................................. 28-36
Build Target Executable ........................................................................ 28-38
Run Target Application ........................................................................ 28-40
Tune Parameters ..................................................................................... 28-44
Control Memory Allocation for Communication Buffers in Target ................ 28-46
Control External Mode Simulation Through Editor Toolbar ......................... 28-46
Control External Mode Simulation Through External Mode Control Panel .... 28-47
Configure Host Monitoring of Target Application Signal Data ..................... 28-51
Configure Host Archiving of Target Application Signal Data ....................... 28-59
Blocks and Subsystems Compatible with External Mode .............................. 28-62
External Mode Mechanism for Downloading Tunable Parameters ............... 28-65
Choose Communication Protocol for Client and Server .............................. 28-68
Use External Mode Programmatically .................................................. 28-76
Animate Stateflow Charts in External Mode ........................................... 28-83
TCP/IP and Serial External Mode Limitations ........................................ 28-85

Create a Transport Layer for TCP/IP or Serial External Mode Communication 28-90
Design of External Mode ......................................................................... 28-90
External Mode Communications Overview ............................................. 28-93
External Mode Source Files ..................................................................... 28-94
Implement a Custom Transport Layer .................................................... 28-98
### 29 Logging in Simulink Coder

**Log Program Execution Results** ........................................ 29-2
  - Log Data for Analysis ........................................ 29-2
  - Configure State, Time, and Output Logging .................... 29-9
  - Log Data with Scope and To Workspace Blocks ............... 29-11
  - Log Data with To File Blocks ................................ 29-11
  - Data Logging Differences Between Single- and Multitasking ......................................................... 29-12

### 30 Data Interchange Using the C API in Simulink Coder

**Exchange Data Between Generated and External Code Using C API** ........................................ 30-2
  - Generated C API Files ........................................ 30-2
  - Generate C API Files .......................................... 30-3
  - Description of C API Files .................................... 30-5
  - Generate C API Data Definition File for Exchanging Data with a Target System ........................................ 30-20
  - C API Limitations ............................................. 30-22

**Use C API to Access Model Signals and States** .............. 30-24

**Use C API to Access Model Parameters** ......................... 30-30

### 31 ASAP2 Data Measurement and Calibration in Simulink Coder

**Export ASAP2 File for Data Measurement and Calibration** ........................................ 31-2
  - What You Should Know ........................................ 31-3
  - Targets Supporting ASAP2 ...................................... 31-3
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define ASAP2 Information</td>
<td>31-3</td>
</tr>
<tr>
<td>Generate an ASAP2 File</td>
<td>31-9</td>
</tr>
<tr>
<td>Structure of the ASAP2 File</td>
<td>31-12</td>
</tr>
<tr>
<td>Create a Host-Based ASAM-ASAP2 Data Definition File for</td>
<td></td>
</tr>
<tr>
<td>Data Measurement and Calibration</td>
<td>31-13</td>
</tr>
<tr>
<td>Direct Memory Access to Generated Code for</td>
<td></td>
</tr>
<tr>
<td>Simulink Coder</td>
<td></td>
</tr>
<tr>
<td>Access Memory in Generated Code Using Global Data Map</td>
<td>32-2</td>
</tr>
<tr>
<td>Performance</td>
<td></td>
</tr>
<tr>
<td>Optimizations for Generated Code in Simulink Coder</td>
<td></td>
</tr>
<tr>
<td>Increase Code Generation Speed</td>
<td>33-3</td>
</tr>
<tr>
<td>Build a Model in Increments</td>
<td>33-3</td>
</tr>
<tr>
<td>Build Large Model Reference Hierarchies in Parallel</td>
<td>33-3</td>
</tr>
<tr>
<td>Minimize Memory Requirements During Code Generation</td>
<td>33-4</td>
</tr>
<tr>
<td>Generate Only Code</td>
<td>33-5</td>
</tr>
<tr>
<td>No Creation of a Code Generation Report</td>
<td>33-5</td>
</tr>
<tr>
<td>Control Compiler Optimizations</td>
<td>33-6</td>
</tr>
<tr>
<td>Optimization Tools and Techniques</td>
<td>33-7</td>
</tr>
<tr>
<td>Use the Model Advisor to Optimize a Model for Code</td>
<td>33-7</td>
</tr>
<tr>
<td>Generation</td>
<td></td>
</tr>
<tr>
<td>Design Tips for Optimizing Generated Code for Stateflow</td>
<td></td>
</tr>
<tr>
<td>Objects</td>
<td></td>
</tr>
<tr>
<td>Design Tips for Optimizing Generated Code for Stateflow</td>
<td></td>
</tr>
<tr>
<td>Objects</td>
<td></td>
</tr>
</tbody>
</table>
Additional Optimization Techniques ................. 33-8

Control Memory Allocation for Time Counters .... 33-11

Execution Profiling for Generated Code ............. 33-12

Optimize Generated Code by Combining Multiple for
Constructs ..................................... 33-14

Subnormal Number Performance ..................... 33-18
   Simulation Time With and Without Subnormal
   Numbers ..................................... 33-19
   Flush Subnormal Numbers to Zero ............. 33-20

Remove Code From Floating-Point to Integer Conversions
   That Wraps Out-of-Range Values ................. 33-23
      Example Model .......................... 33-23
      Generate Code Without Optimization ... 33-24
      Generate Code with Optimization ...... 33-25

Remove Code That Maps NaN to Integer Zero ....... 33-26
      Example Model .......................... 33-26
      Generate Code ........................... 33-27
      Generate Code with Optimization ...... 33-28

Disable Nonfinite Checks or Inlining for Math
Functions ..................................... 33-30

Fold Expressions ................................ 33-36

Minimize Computations and Storage for Intermediate
Results at Block Outputs ........................ 33-41
      Expression Folding ..................... 33-41
      Example Model .......................... 33-41
      Generate Code ........................... 33-42
      Enable Optimization .................... 33-42
      Generate Code with Optimization ...... 33-43

Inline Invariant Signals .......................... 33-44
      Optimize Generated Code Using Inline Invariant
      Signals .................................. 33-44

Inline Numeric Values of Block Parameters .......... 33-48
Configure Loop Unrolling Threshold ........................................... 33-54

Use memcpy Function to Optimize Generated Code for Vector Assignments ........................................... 33-57
  Example Model ........................................................................ 33-58
  Generate Code ........................................................................ 33-59
  Generate Code with Optimization ........................................... 33-59

Generate Target Optimizations Within Algorithm Code ............................................................... 33-61

Remove Code for Blocks That Have No Effect on Computational Results ........................................... 33-63

Eliminate Dead Code Paths in Generated Code ........................................................... 33-66

Floating-Point Multiplication to Handle a Net Slope Correction ......................................................... 33-69

Use Conditional Input Branch Execution ............................................................... 33-72

Optimize Generated Code for Complex Signals ............................................................... 33-78

Speed Up Linear Algebra in Code Generated from a MATLAB Function Block ........................................... 33-81
  Specify LAPACK Library .............................................................. 33-81
  Write LAPACK Callback Class .................................................... 33-81
  Generate LAPACK Calls by Specifying a LAPACK Callback Class ....................................................... 33-82
  Locate LAPACK Library in Execution Environment .......................................................... 33-83

Speed Up Matrix Operations in Code Generated from a MATLAB Function Block ...................................... 33-85
  Specify BLAS Library ................................................................. 33-85
  Write BLAS Callback Class ......................................................... 33-85
  Generate BLAS Calls by Specifying a BLAS Callback Class ......................................................... 33-87
  Locate BLAS Library in Execution Environment ........................................................ 33-88
  Usage Notes and Limitations for OpenBLAS Library .......................................................... 33-89

Speed Up Fast Fourier Transforms in Code Generated from a MATLAB Function Block .................................. 33-90
  Install an FFTW Library .............................................................. 33-90
Write FFT Callback Class .......................... 33-91
Generate FFTW Calls by Specifying an FFT Callback
Class .............................................. 33-92

Synchronize Multithreaded FFTW Planning in Code
Generated from a MATLAB Function Block ........... 33-94
Prerequisites ......................................... 33-94
Create a Model with a MATLAB Function Block That Calls
an FFT Function ..................................... 33-95
Write Supporting C Code .............................. 33-95
Create an FFT Library Callback Class ................. 33-96
Configure Code Generation Parameters and Build
the Model ............................................ 33-97

Control Memory Allocation for Variable-Size Arrays in a
MATLAB Function Block ............................. 33-99
Provide Upper Bounds for Variable-Size Arrays ...... 33-99
Disable Dynamic Memory Allocation for MATLAB Function
Blocks .................................................. 33-100
Modify the Dynamic Memory Allocation Threshold ... 33-100

Optimize Memory Usage for Time Counters .......... 33-102

Optimize Generated Code Using Boolean Data for Logical
Signals .................................................. 33-109

Reduce Memory Usage for Boolean and State
Configuration Variables .............................. 33-112

Customize Stack Space Allocation ...................... 33-113

Optimize Generated Code Using memset Function ... 33-115

Vector Operation Optimization ........................ 33-119

Enable and Reuse Local Block Outputs in Generated
Code ................................................... 33-122
Example Model ........................................ 33-122
Generate Code Without Optimization .................... 33-123
Enable Local Block Outputs and Generate Code ....... 33-123
Reuse Local Block Outputs and Generate Code ......... 33-124
Verification

Simulation and Code Comparison in Simulink Coder

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulation and Code Comparison</td>
<td>34-2</td>
</tr>
<tr>
<td>Configure Signal Data for Logging</td>
<td>34-2</td>
</tr>
<tr>
<td>Log Simulation Data</td>
<td>34-3</td>
</tr>
<tr>
<td>Run Executable and Load Data</td>
<td>34-5</td>
</tr>
<tr>
<td>Visualize and Compare Results</td>
<td>34-6</td>
</tr>
<tr>
<td>Compare States for Simulation and Code Generation</td>
<td>34-8</td>
</tr>
</tbody>
</table>

Numerical Consistency between Model and Generated Code

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numerical Consistency of Model and Generated Code</td>
<td>35-2</td>
</tr>
<tr>
<td>Simulation Results</td>
<td>35-2</td>
</tr>
<tr>
<td>Numerical Consistency</td>
<td>35-2</td>
</tr>
<tr>
<td>Numerical Consistency in Complex Systems</td>
<td>35-3</td>
</tr>
<tr>
<td>Reasons for Block-Level Numerical Differences</td>
<td>35-5</td>
</tr>
</tbody>
</table>

Supported Hardware

Embedded Targets

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulink Coder Supported Hardware</td>
<td>36-2</td>
</tr>
</tbody>
</table>
Customization

Build Process Integration in Simulink Coder

Control Build Process Compiling and Linking ........ 37-2

Cross-Compile Code Generated on Microsoft Windows .................................... 37-4

Control Library Location and Naming During Build .... 37-7
- Library Control Parameters .......................... 37-7
- Specify the Location of Precompiled Libraries ... 37-8
- Control the Location of Model Reference Libraries ... 37-10
- Control the Suffix Applied to Library File Names .... 37-10

Recompile Precompiled Libraries ....................... 37-13

Customize Post-Code-Generation Build Processing ... 37-14
- Workflow for Setting Up Customizations ............ 37-14
- Build Information Object ............................. 37-15
- Program a Post Code Generation Command .......... 37-15
- Define a Post Code Generation Command .......... 37-16
- Customize Build Process with PostCodeGenCommand and Relocate Generated Code to an External Environment ........................................ 37-17
- Suppress Makefile Generation .................... 37-20

Configure Generated Code with TLC ................. 37-21
- Assigning Target Language Compiler Variables ...... 37-21
- Set Target Language Compiler Options ............. 37-23

Use makecfg to Customize Generated Makefiles for S-Functions ........................................ 37-24

Use rtwmakecfg.m API to Customize Generated Makefiles ........................................ 37-26
- About the rtwmakecfg Function ..................... 37-26
- Create the rtwmakecfg Function ..................... 37-26
- Modify the Template Makefile for rtwmakecfg .... 37-29
Register Custom Toolchain and Build Executable .......................... 37-31

Customize Build Process with STF_make_rtw_hook File .......................................................... 37-50
  STF_make_rtw_hook File .................................................. 37-50
  Conventions for Using the STF_make_rtw_hook File .................. 37-50
  STF_make_rtw_hook.m Function Prototype and Arguments .................. 37-50
  Applications for STF_make_rtw_hook.m ................................ 37-53
  Control Code Regeneration Using
    STF_make_rtw_hook.m .................................................. 37-53
  Use STF_make_rtw_hook.m for Your Build
    Procedure ............................................................. 37-54

Customize Build Process with sl_customization.m .......................... 37-55
  The sl_customization.m File ........................................... 37-55
  Register Build Process Hook Functions Using
    sl_customization.m .................................................. 37-57
  Variables Available for sl_customization.m Hook
    Functions ............................................................. 37-57
  Example of Build Process Customization with
    sl_customization.m .................................................. 37-58

Replace STF_rtw_info_hook Supplied Target Data .......................... 37-60

Run-Time Data Interface Extensions in Simulink Coder

Customize Generated ASAP2 File .......................................... 38-2
  About ASAP2 File Customization ..................................... 38-2
  ASAP2 File Structure on the MATLAB Path .......................... 38-2
  Customize the Contents of the ASAP2 File ....................... 38-3
  ASAP2 Templates ....................................................... 38-4
  Customize Computation Method Names ............................... 38-6
  Suppress Computation Methods for FIX_AXIS ...................... 38-7
Custom Target Development in Simulink Coder

About Embedded Target Development ........................................ 39-2
  Custom Targets ............................................................ 39-2
  Types of Targets .......................................................... 39-2
  Recommended Features for Embedded Targets ....................... 39-4

Sample Custom Targets ....................................................... 39-9

Target Development Folders, Files, and Builds ......................... 39-11
  Folder and File Naming Conventions ................................ 39-11
  Components of a Custom Target ...................................... 39-11
  Key Folders Under Target Root (mytarget) ......................... 39-16
  Key Files in Target Folder (mytarget/mytarget) ................. 39-19
  Additional Files for Externally Developed Targets ............. 39-22
  Target Development and the Build Process ....................... 39-23

Customize System Target Files ........................................... 39-28
  Control Code Generation With the System Target File ........ 39-28
  System Target File Naming and Location Conventions .......... 39-28
  System Target File Structure ...................................... 39-29
  Define and Display Custom Target Options ..................... 39-36
  Tips and Techniques for Customizing Your STF ................. 39-45
  Create a Custom Target Configuration ........................... 39-48

Customize Template Makefiles ........................................... 39-62
  Template Makefiles and Tokens .................................... 39-62
  Invoke the make Utility .............................................. 39-70
  Structure of the Template Makefile ................................ 39-71
  Customize and Create Template Makefiles ...................... 39-74

Custom Target Optional Features ....................................... 39-80

Support Toolchain Approach with Custom Target ................. 39-82

Support Model Referencing ............................................. 39-84
  About Model Referencing with a Custom Target ............... 39-84
  Declaring Model Referencing Compliance ....................... 39-85
  Providing Model Referencing Support in the TMF ............. 39-85
Controlling Configuration Option Value Agreement . . . 39-89
Supporting the Shared Utilities Folder ................. 39-89
Verifying Worker Configuration for Parallel Builds of Model
Reference Hierarchies (Optional) ....................... 39-93
Preventing Resource Conflicts (Optional) ............. 39-95

Support Compiler Optimization Level Control ........ 39-96
About Compiler Optimization Level Control and Custom
Targets .................................................. 39-96
Declaring Compiler Optimization Level Control
Compliance .............................................. 39-96
Providing Compiler Optimization Level Control Support in
the Target Makefile ................................. 39-97

Support C Function Prototype Control .................. 39-98
About C Function Prototype Control and Custom
Targets .................................................. 39-98
Declaring C Function Prototype Control Compliance . 39-98
Providing C Function Prototype Control Support in the
Custom Static Main Program ....................... 39-99

Support C++ Class Interface Control .................... 39-100
About C++ Class Interface Control and Custom
Targets .................................................. 39-100
Declaring C++ Class Interface Control Compliance . 39-100
Providing C++ Class Interface Control Support in the
Custom Static Main Program ....................... 39-101

Support Concurrent Execution of Multiple Tasks .... 39-102

Interface to Development Tools ......................... 39-104
About Interfacing to Development Tools ............... 39-104
Template Makefile Approach .......................... 39-104
Interface to an Integrated Development
Environment .............................................. 39-105

Device Drivers ........................................ 39-114
Model Architecture and Design
Modeling Environment for Simulink Coder
Design Models for Rapid Prototyping Deployment

When using Simulink Coder to generate code for rapid prototyping, it is important to design your Simulink models with code generation in mind from the very beginning of the design process.

Application Algorithms and Run-Time Environments

Use Simulink to design models that represent application algorithms and run-time environments from which you intend to generate deployable code. Depending on your application, you might deploy code to an execution environment that consists of a combination of:

<table>
<thead>
<tr>
<th>Execution Environment Components</th>
<th>Choices</th>
</tr>
</thead>
</table>
| Hardware                         | • Development computer  
                                    | • Rapid-prototyping board  
                                    | • Microprocessor  
                                    | • Microcontroller  
                                    | • FPGA  
                                    | • ASIC |
| Cores                            | • Single  
                                    | • Multiple |
| Operating system                 | • General-purpose  
                                    | • Real-time  
                                    | • None (bare metal) |
| Scheduling                       | • Single-tasking  
                                    | • Multitasking  
                                    | • Interrupt driven  
                                    | • Concurrency  
                                    | • Provided by operating system  
                                    | • Generated from model |
As you design models to generate C or C++ code for rapid prototyping or production deployment, keep in mind the execution environment. Generate code that meets implementation requirements and avoids potential design rework. As the preceding table reflects, the execution environment for code that you generate can range from relatively simple to complex. For example, a simple case is code that you generate from a single, single-tasking model that runs on a single-core microprocessor. A complex case is code that generate from a model partitioned to run as a distributed system on a multicore microprocessor and an FPGA.

### Software Execution Framework for Generated Code

Part of an application execution environment is the software execution framework that is responsible for scheduling and running the generated code. That software can preexist, as in the case of an operating system and its scheduler, or you can code the software manually. The level of complexity varies depending on which of the following modeling and code generation scenarios applies:

- Generate code from a single top model, which represents the algorithms intended to run in the execution environment.
- Generate code from a model, which represents part of an overall algorithm. You can mix the generated code with code written manually and code generated from other sources or releases of MathWorks® products.

### Single Top Model

For a single top model, the software execution framework is responsible for running generated code the same way that Simulink simulates the model. Functions in the generated code are highly coordinated and optimized because Simulink is aware of dependencies. The framework interfaces with code generated for the top model only. Code generated for a top model handles interfacing with code for referenced Model blocks.

Consider the following example, where a single top model is mapped to tasks that run on a single-core CPU.
For this system, you map model clock rates to tasks that run on the hardware. You can choose for Simulink to map the rates implicitly or you can map them explicitly in your model. You can model latency effects resulting from how you map rates in a model to single-tasking or multitasking execution environments. Simulink schedules the tasks properly based on rates in the model and data dependencies between tasks. The code generator implements the same dependencies in the code that it generates. The software execution framework invokes generated entry-point functions at rates based on system timers and interrupts. The generated code executes in the same manner that Simulink simulates the model, and contains code dedicated to communicating data between functions running at different rates.

**Multiple Top-Level Models**

When you generate code from multiple top models separately and mix that code with code acquired in other ways, the execution environment of the application takes on more software execution framework responsibility. For this modeling scenario, you generate code for standalone, atomic reusable components.

With this scenario, Simulink is not aware of model dependencies. Functions in code generated from the different models are minimally coordinated and optimized. For example, the models might share generated utility functions. Potential optimizations that cross model boundaries are not possible. You must design the software execution
framework taking into account dependencies between units of code, including execution order. For an application that requires concurrent execution across multiple cores, you must consider data latency effects across the cores.

The code generator helps you address software execution framework challenges, such as sharing global data and avoiding identifier conflicts. The code generated for a each model handles the interfacing for referenced Model blocks.

**Map Embedded System Architecture to Simulink Modeling Environment**

When designing models for rapid-prototyping deployment, think about these design factors.

<table>
<thead>
<tr>
<th>“Modeling Algorithms” on page 1-6</th>
<th>Given initial state and input, a set of tasks or instructions that efficiently produce a correct result that you want.</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Modeling Interfaces” on page 1-7</td>
<td>Mechanisms that enable algorithm components to communicate and exchange information across component boundaries.</td>
</tr>
<tr>
<td>“Modeling Systems” on page 1-8</td>
<td>Collection of algorithm components that achieve a higher-level, domain-specific goal or result. Components often share resources.</td>
</tr>
<tr>
<td>“Modeling Run-Time Environments” on page 1-10</td>
<td>Framework that handles scheduling of system algorithm resources and execution.</td>
</tr>
</tbody>
</table>

Consider the following questions concerning modeling capabilities. Use the information listed with the questions as a guide as you design models. Designing a model with a specific run-time execution environment in mind can help you avoid rework and future conversion and maintenance costs.
## Modeling Algorithms

<table>
<thead>
<tr>
<th>Architecture Considerations</th>
<th>Modeling Considerations</th>
<th>Related Information</th>
</tr>
</thead>
</table>
| What is the system domain?  | Product prerequisites (based on domains of components) | • “Blocks and Products Supported for C Code Generation” on page 2-4  
• “Simulink Control Design”  
• “Model Signal Processing Systems” (Simulink)  
• “Signal Generation, Manipulation, and Analysis” (DSP System Toolbox) |
| Does the system involve physical domains, such as mechanical, electrical, or hydraulic domains? | Physical systems | • “Model Physical Systems” (Simulink)  
• “Basic Principles of Modeling Physical Networks” (Simscape)  
• “Essential Physical Modeling Techniques” (Simscape) |
| What aspects of your algorithm can you represent with blocks provided by MathWorks products? | Block usage, creation, and customization | • “Blocks and Products Supported for C Code Generation” on page 2-4  
• “External Code Integration” |
| Does the architecture include state machine components? | Event-driven system | “Basic Approach for Modeling Event-Driven Systems” (Stateflow) |
### Modeling Interfaces

<table>
<thead>
<tr>
<th>Architecture Considerations</th>
<th>Modeling Considerations</th>
<th>Related Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>• What data must you represent in the generated code?</td>
<td>Data representation</td>
<td>• “Interface Design” (Simulink)</td>
</tr>
<tr>
<td>• How do you need to represent input and output—data type, dimension, complexity?</td>
<td></td>
<td>• “Data Access for Prototyping and Debugging”</td>
</tr>
<tr>
<td>• How will the data change?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Where and how is data pulled into the system and pulled within the system?</td>
<td>Input</td>
<td>• “Comparison of Signal Loading Techniques” (Simulink)</td>
</tr>
<tr>
<td>• Where and how is data pushed within the system and out of the system?</td>
<td>Output</td>
<td>• <strong>Simulation Data Inspector</strong></td>
</tr>
<tr>
<td>• What external triggers are needed?</td>
<td></td>
<td>• “Apply Custom Storage Classes to Individual Signal, State, and Parameter Data Elements” (Embedded Coder)</td>
</tr>
<tr>
<td>• What functions do you need to define for each component?</td>
<td>Functions and function calls</td>
<td>• “Function and Class Interfaces”</td>
</tr>
<tr>
<td>• What is the prototype for each entry-point function?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Do you need to export functions that are invoked by controlling logic that is outside the model?</td>
<td>Function export</td>
<td>• “Export-Function Models” (Simulink)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Generate Component Source Code for Export to External Code Base” on page 26-64</td>
</tr>
<tr>
<td>Does the system monitor signals or log data (for example, for calibration)?</td>
<td>C API and ASAP2 data exchange interfaces</td>
<td>• “Exchange Data Between Generated and External Code Using C API” on page 30-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Export ASAP2 File for Data Measurement and Calibration” on page 31-2</td>
</tr>
</tbody>
</table>
## Architecture Considerations

<table>
<thead>
<tr>
<th>Model</th>
<th>Considerations</th>
<th>Related Information</th>
</tr>
</thead>
</table>
| Do you need to replace code generated for functions or operators, for example, to optimize the code for specific hardware? | Code replacement | “What Is Code Replacement?” on page 23-2  
“What Is Code Replacement Customization?” (Embedded Coder) |
| Is there a requirement for elaboration and future considerations? | Elaboration and future considerations | “Interface Design” (Simulink) |

## Modeling Systems

<table>
<thead>
<tr>
<th>Model</th>
<th>Considerations</th>
<th>Related Information</th>
</tr>
</thead>
</table>
| • What is the scope of the system? Controller? External environment or plant? Test harness?  
• How is the system partitioned into algorithm components (chunks of logic)?  
• Which components can you represent in Simulink?  
• Can you design components for reuse? What is the motivation for reuse (for example, division of labor or plug-n-play)? | Componentization | “Interface Design” (Simulink)  
“Componentization Guidelines” (Simulink)  
“Design Partitioning” (Simulink)  
“Custom Libraries and Linked Blocks” (Simulink)  
“Implement New Algorithm” (Simulink)  
“Control Generation of Subsystem Functions” on page 6-2  
“Code Generation of Referenced Models” on page 7-2  
“Code Generation of Stateflow Blocks” on page 13-2 |
<table>
<thead>
<tr>
<th>Architecture Considerations</th>
<th>Modeling Considerations</th>
<th>Related Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Do aspects of the system require unit testing?</td>
<td>Model referencing</td>
<td>• “Model Reference Basics” (Simulink)</td>
</tr>
<tr>
<td>• Is a team of people collaborating on the project?</td>
<td></td>
<td>• “Componentization Guidelines” (Simulink)</td>
</tr>
<tr>
<td>• Do you need to protect intellectual property?</td>
<td></td>
<td>• “Code Generation of Referenced Models” on page 7-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Generate Reusable Code for Unit Testing” on page 13-8</td>
</tr>
<tr>
<td>Are you modeling a client-server architecture?</td>
<td>Simulink Function and</td>
<td>• “Client-Server Architecture” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>Caller blocks</td>
<td>• “Simulink Functions” (Simulink)</td>
</tr>
<tr>
<td>Is relevant legacy or custom code available?</td>
<td>External code</td>
<td>“What Is External Code Integration?” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>integration</td>
<td></td>
</tr>
<tr>
<td>Can you apply a reference architecture or reference components?</td>
<td>Model and project</td>
<td>• “Create a Template from a Model” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>templates</td>
<td>• “Create a New Project Using Templates” (Simulink)</td>
</tr>
<tr>
<td>Can you reuse functions?</td>
<td>Function reuse</td>
<td>• “Generate Reusable Code for Subsystems Shared Across Models” on page 9-57</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Generate Reusable Code from Library Subsystems Shared Across Models” on page 9-55</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Generate Reentrant Code from Top Models” on page 9-25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Generate Reentrant Code from Subsystems” on page 9-43</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Generate Reusable Code for Atomic Subcharts” on page 13-6</td>
</tr>
</tbody>
</table>
### Architecture Considerations

<table>
<thead>
<tr>
<th>Architecture Considerations</th>
<th>Modeling Considerations</th>
<th>Related Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Do components need to share access to global data?</td>
<td>Shared data</td>
<td>• “Local and Global Data Stores” (Simulink)</td>
</tr>
<tr>
<td>• Within the system, do state changes occur? In each case, how does the result get communicated?</td>
<td></td>
<td>• “Standard Data Structures in the Generated Code” on page 15-26</td>
</tr>
<tr>
<td>• Are there identifier (naming) issues to consider?</td>
<td></td>
<td>• “Storage Classes for Signals Used with Model Blocks” on page 7-21</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Code Generation of Constant Parameters” on page 6-13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Data Stores in Generated Code” on page 15-101</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Customize Generated Identifier Naming Rules” (Embedded Coder)</td>
</tr>
</tbody>
</table>

### Modeling Run-Time Environments

<table>
<thead>
<tr>
<th>Architecture Considerations</th>
<th>Modeling Considerations</th>
<th>Related Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>• What level of control over run-time interfacing does your application require?</td>
<td>Runtime interfacing</td>
<td>• “Execution of Code Generated from a Model” on page 16-13</td>
</tr>
<tr>
<td>• How much of your system can you represent in a model?</td>
<td></td>
<td>• See Modeling Interfaces.</td>
</tr>
<tr>
<td>Is the system partitioned into concurrent components to maximize parallelism? Which components?</td>
<td>Concurrency</td>
<td>“Multicore Processor Targets” (Simulink)</td>
</tr>
<tr>
<td>• Are components driven by an external clock?</td>
<td>Clocks and clock rates</td>
<td>“Interface Design” (Simulink)</td>
</tr>
<tr>
<td>• What clock rates do system components use?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Do components use a single rate or multiple rates?</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Architecture Considerations</strong></td>
<td><strong>Modeling Considerations</strong></td>
<td><strong>Related Information</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------</td>
<td>------------------------</td>
</tr>
</tbody>
</table>
| • Are components in the system driven by clocks?  
  • What clock rates do system components use?  
  • Do components use a single rate or multiple rates?  
  • What are the priorities of system tasks and functions? | Time-based scheduling | • “Absolute and Elapsed Time Computation” on page 3-2  
  • “Time-Based Scheduling” |
| • Are components in the system driven by events (interrupts)?  
  • What are the priorities of system tasks and functions? | Event-based scheduling | • “Absolute and Elapsed Time Computation” on page 3-2  
  • “Event-Based Scheduling”  
  • “Basic Approach for Modeling Event-Driven Systems” (Stateflow) |
| Does the system need to handle initialization, reset, or terminate events? | Initialization, reset, termination | • “Customize Initialize, Reset, and Terminate Functions” (Simulink)  
  • “Generate Code That Responds to Initialize, Reset, and Terminate Events” on page 12-2 |
| • Is the system a single-tasking or multitasking system?  
  • Are components required to execute in real time?  
  • What are the execution order dependencies (sequencing) between components?  
  • What are the time constraints for task and function execution? | Task execution | • “Execution of Code Generated from a Model” on page 16-13  
  • “Modeling for Single-Tasking Execution” on page 4-8  
  • “Modeling for Multitasking Execution” on page 4-12 |
### Architecture Considerations

- If you know the processing platform, what is it?
- Will the system run on a single-core or multicore processor?
- Is the system a distributed system?
- Is the processing platform hybrid or heterogeneous?
- Does the architecture employ symmetric or asymmetric multiprocessing? If asymmetric, how is the platform software partitioned across CPUs?

### Related Information

“Multicore Processor Targets” (Simulink)

### Model Templates for Code Generation

The code generator provides a set of built-in templates to use as a starting point to create models for common application designs. Use the templates to create models that are preconfigured to generate code for rapid-prototyping or embedded system applications.

<table>
<thead>
<tr>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code Generation System</td>
<td>Basic model consisting of an Inport block and Output block.</td>
</tr>
<tr>
<td>Exported functions</td>
<td>Model for generating code from function-call subsystems. You can export each</td>
</tr>
<tr>
<td></td>
<td>function-call subsystem separately by right-clicking a subsystem, selecting</td>
</tr>
<tr>
<td></td>
<td>C/C++ Code &gt; Export Functions, and clicking Build.</td>
</tr>
<tr>
<td>Fixed-step, multirate</td>
<td>Fixed-step model that uses multiple rates and consists of Inport blocks, an</td>
</tr>
<tr>
<td></td>
<td>Outport block, and a Sum block. The model is configured to use a fixed-step</td>
</tr>
<tr>
<td></td>
<td>discrete solver and to use two rates with Periodic sample time constraint set</td>
</tr>
<tr>
<td></td>
<td>to Unconstrained and the Treat each discrete rate as a separate task option</td>
</tr>
<tr>
<td></td>
<td>selected. Simulink inserts a Rate Transition block to handle the two sample</td>
</tr>
<tr>
<td></td>
<td>rates.</td>
</tr>
</tbody>
</table>
### Template and Description

<table>
<thead>
<tr>
<th>Template</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed-step, single rate</td>
<td>Fixed-step model that uses a single rate and consists of Inport blocks, an Outport block, and a Sum block. The model is configured to use a fixed-step discrete solver.</td>
</tr>
</tbody>
</table>

To create a model from a template:

1. On the MATLAB® home tab, click **Simulink**.
2. In the Simulink start page, expand **Embedded Coder**.
3. Select a template.
4. Click **Create**. A new model that uses the template contents and settings appears in the Simulink Editor window.

For more information, for example to create and use a template as a reference design, see “Create a Template from a Model” (Simulink).

### See Also

**Related Examples**

- “Blocks and Products Supported for C Code Generation” on page 2-4
- “Modeling Semantic Considerations” on page 2-30
Modeling in Simulink Coder

- “Configure a Model for Code Generation” on page 2-2
- “Blocks and Products Supported for C Code Generation” on page 2-4
- “Modeling Semantic Considerations” on page 2-30
- “Modeling Guidelines for Blocks” on page 2-38
- “Modeling Guidelines for Subsystems” on page 2-39
- “Modeling Guidelines for Charts” on page 2-42
- “Modeling Guidelines for MATLAB Functions” on page 2-44
- “Modeling Guidelines for Model Configuration” on page 2-45
Configure a Model for Code Generation

Model configuration parameters determine the method for generating the code and the resulting format.

1. Open `rtwdemo_throttlecntrl` and save a copy as `throttlecntrl` in a writable location on your MATLAB path.

   **Note** This model uses Stateflow® software.

2. Open the Configuration Parameters dialog box Solver pane. To generate code for a model, you must configure the model to use a fixed-step solver. For this example, set the parameters as noted in the following table.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
<th>Effect on Generated Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Fixed-step</td>
<td>Maintains a constant (fixed) step size, which is required for code generation</td>
</tr>
<tr>
<td>Solver</td>
<td>discrete (no continuous states)</td>
<td>Applies a fixed-step integration technique for computing the state derivative of the model</td>
</tr>
<tr>
<td>Fixed-step size</td>
<td>.001</td>
<td>Sets the base rate; must be the lowest common multiple of all rates in the system</td>
</tr>
</tbody>
</table>

3. Open the Code Generation pane and make sure that System target file is set to grt.tlc.
Note  The GRT (Generic Real-Time Target) configuration requires a fixed-step solver. However, the rsim.tlc system target file supports variable step code generation.

The system target file (STF) defines a target, which is an environment for generating and building code for execution on a certain hardware or operating system platform. For example, one property of a target is code format. The grt configuration requires a fixed step solver and the rsim.tlc supports variable step code generation.

4 Open the Code Generation > Custom Code pane, and under Include list of additional, select Include directories. In the Include directories text field, enter:

"$matlabroot$\toolbox\rtw\rtwdemos\EmbeddedCoderOverview"  
This directory includes files that are required to build an executable for the model.

5 Apply your changes and close the dialog box.
Blocks and Products Supported for C Code Generation

<table>
<thead>
<tr>
<th>Product</th>
<th>Extends Code Generation Capabilities for ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aerospace Blockset™</td>
<td>Aircraft, spacecraft, rocket, propulsion systems, and unmanned airborne vehicles</td>
</tr>
<tr>
<td>Audio System Toolbox™</td>
<td>Audio processing systems</td>
</tr>
<tr>
<td>Automated Driving System Toolbox™</td>
<td>Designing, simulating, and testing ADAS and autonomous driving systems</td>
</tr>
<tr>
<td>Communications Toolbox™</td>
<td>Physical layer of communication systems</td>
</tr>
<tr>
<td>Computer Vision System Toolbox™</td>
<td>Video processing, image processing, and computer vision systems</td>
</tr>
<tr>
<td>Control System Toolbox™</td>
<td>Linear control systems</td>
</tr>
<tr>
<td>DSP System Toolbox™</td>
<td>Signal processing systems</td>
</tr>
<tr>
<td>Embedded Coder</td>
<td>Embedded systems, rapid prototyping boards, and microprocessors in mass production</td>
</tr>
<tr>
<td>Fixed-Point Designer™</td>
<td>Fixed-point systems</td>
</tr>
<tr>
<td>Fuzzy Logic Toolbox™</td>
<td>System designs based on fuzzy logic</td>
</tr>
<tr>
<td>Product</td>
<td>Extends Code Generation Capabilities for ...</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HDL Verifier™</td>
<td>Direct programming interface (DPI) component and transaction-level model (TLM) generation from Simulink</td>
</tr>
<tr>
<td>IEC Certification Kit</td>
<td>ISO 26262 and IEC 61508 certification</td>
</tr>
<tr>
<td>Model-Based Calibration Toolbox™</td>
<td>Developing processes for systematically identifying optimal balance of engine performance, emissions, and fuel economy, and reusing statistical models for control design, hardware-in-the-loop (HIL) testing, or powertrain simulation</td>
</tr>
<tr>
<td>Model Predictive Control Toolbox™</td>
<td>Controllers that optimize performance of multi-input and multi-output systems that are subject to input and output constraints</td>
</tr>
<tr>
<td>Deep Learning Toolbox™</td>
<td>Neural networks</td>
</tr>
<tr>
<td>Parallel Computing Toolbox™</td>
<td>Parallel builds for large Simulink models</td>
</tr>
<tr>
<td>Phased Array System Toolbox™</td>
<td>Sensor array systems in radar, sonar, wireless communications, and medical imaging applications</td>
</tr>
<tr>
<td>Polyspace® Bug Finder™</td>
<td>MISRA-C compliance and static analysis of generated code</td>
</tr>
<tr>
<td>Polyspace Code Prover™</td>
<td>Formal analysis of generated code</td>
</tr>
<tr>
<td>Powertrain Blockset™</td>
<td>Real-time testing of powertrain applications</td>
</tr>
<tr>
<td>Robotics System Toolbox™</td>
<td>Robot Operating System (ROS) node generation</td>
</tr>
<tr>
<td>Simscape™</td>
<td>Systems spanning mechanical, electrical, hydraulic, and other physical domains as physical networks</td>
</tr>
<tr>
<td>Simscape Driveline™</td>
<td>Driveline (drivetrain) systems</td>
</tr>
<tr>
<td>Simscape Electrical™</td>
<td>Electronic, electromechanical, and electrical power systems</td>
</tr>
<tr>
<td>Simscape Fluids™</td>
<td>Hydraulic power and control systems</td>
</tr>
<tr>
<td>Simscape Multibody™</td>
<td>Three-dimensional mechanical systems</td>
</tr>
<tr>
<td>Simulink 3D Animation™</td>
<td>Systems with 3D visualizations</td>
</tr>
<tr>
<td>Product</td>
<td>Extends Code Generation Capabilities for …</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Simulink Check™</td>
<td>Model standards compliance checking and metrics</td>
</tr>
<tr>
<td>Simulink Code Inspector™</td>
<td>Automated reviews of generated code</td>
</tr>
<tr>
<td>Simulink Control Design™</td>
<td>Autotuning of PID controllers</td>
</tr>
<tr>
<td>Simulink Coverage™</td>
<td>Model and code structural coverage analysis</td>
</tr>
<tr>
<td>Simulink Design Optimization™</td>
<td>Systems requiring maximum overall system performance</td>
</tr>
<tr>
<td>Simulink Desktop Real-Time™</td>
<td>Rapid prototyping or hardware-in-the-loop (HIL) simulation of control system and signal processing algorithms</td>
</tr>
<tr>
<td>Simulink Real-Time™</td>
<td>Rapid control prototyping, hardware-in-the-loop (HIL) simulation, and other real-time testing applications</td>
</tr>
<tr>
<td>Simulink Report Generator™</td>
<td>Automatically generating project documentation in a standard format</td>
</tr>
<tr>
<td>Simulink Requirements™</td>
<td>Authoring and tracing requirements to design and code</td>
</tr>
<tr>
<td>Simulink Test™</td>
<td>Software-in-the-loop (SIL), processor-in-the-loop (PIL), and real-time hardware-in-the-loop (HIL) testing of generated code</td>
</tr>
<tr>
<td>Stateflow</td>
<td>State machines and flow charts</td>
</tr>
<tr>
<td>System Identification Toolbox™</td>
<td>Systems constructed from measured input-output data</td>
</tr>
<tr>
<td>Vehicle Dynamics Blockset™</td>
<td>Modeling and simulation of vehicle dynamics in 3D environment</td>
</tr>
<tr>
<td>Vehicle Network Toolbox™</td>
<td>CAN blocks for Accelerator and Rapid Accelerator simulations and code deployment on Windows®</td>
</tr>
</tbody>
</table>

**Simulink Built-In Blocks That Support Code Generation**

The following tables summarize code generator support for Simulink blocks. There is a table for each block library. For more detail, including data types each block supports, in
the MATLAB Command Window, type `showblockdatatypetable`, or consult the block reference pages. For some blocks, the generated code might rely on `memcpy` or `memset` (string.h).

- Additional Math and Discrete: Additional Discrete
- Additional Math and Discrete: Increment/Decrement
- Continuous
- Discontinuities
- Discrete
- Logic and Bit Operations
- Lookup Tables
- Math Operations
- Model Verification
- Model-Wide Utilities
- Ports & Subsystems
- Signal Attributes
- Signal Routing
- Sinks
- Sources
- User-Defined

### Additional Math and Discrete: Additional Discrete

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed-Point State-Space</td>
<td>The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code.</td>
</tr>
<tr>
<td>Transfer Fcn Direct Form II</td>
<td>This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the <strong>Treat as atomic unit</strong> option.</td>
</tr>
<tr>
<td>Transfer Fcn Direct Form II Time Varying</td>
<td></td>
</tr>
</tbody>
</table>
### Additional Math and Discrete: Increment/Decrement

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decrement Real World</td>
<td>The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the Treat as atomic unit option.</td>
</tr>
<tr>
<td>Decrement Stored Integer</td>
<td></td>
</tr>
<tr>
<td>Decrement Time To Zero</td>
<td>Supports code generation.</td>
</tr>
<tr>
<td>Decrement To Zero</td>
<td>The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the Treat as atomic unit option.</td>
</tr>
<tr>
<td>Increment Real World</td>
<td></td>
</tr>
<tr>
<td>Increment Stored Integer</td>
<td></td>
</tr>
</tbody>
</table>

### Continuous

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Derivative</td>
<td>Not recommended for production-quality code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. The code generated can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code.</td>
</tr>
<tr>
<td>Integrator</td>
<td></td>
</tr>
<tr>
<td>Integrator, Integrator Limited</td>
<td></td>
</tr>
<tr>
<td>PID Controller</td>
<td></td>
</tr>
<tr>
<td>PID Controller (2DOF)</td>
<td></td>
</tr>
<tr>
<td>Second-Order Integrator,</td>
<td>In general, consider using the Simulink Model Discretizer to map continuous blocks into discrete equivalents that support production code generation. To start the Model Discretizer, select Analysis &gt; Control Design &gt; Model Discretizer. One exception is the Second-Order Integrator block because, for this block, the Model Discretizer produces an approximate discretization.</td>
</tr>
<tr>
<td>Second-Order Integrator Limited</td>
<td></td>
</tr>
<tr>
<td>State-Space</td>
<td></td>
</tr>
<tr>
<td>Transfer Fcn</td>
<td></td>
</tr>
<tr>
<td>Transport Delay</td>
<td></td>
</tr>
<tr>
<td>Variable Time Delay, Variable Transport Delay</td>
<td></td>
</tr>
<tr>
<td>Zero-Pole</td>
<td></td>
</tr>
</tbody>
</table>
### Discontinuities

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backlash</td>
<td>Supports code generation.</td>
</tr>
<tr>
<td>Coulomb and Viscous Friction</td>
<td>The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the <strong>Treat as atomic unit</strong> option.</td>
</tr>
<tr>
<td>Dead Zone</td>
<td>Supports code generation.</td>
</tr>
<tr>
<td>Dead Zone Dynamic</td>
<td>The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the <strong>Treat as atomic unit</strong> option.</td>
</tr>
<tr>
<td>Hit Crossing</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
<tr>
<td>Quantizer</td>
<td>Supports code generation.</td>
</tr>
<tr>
<td>Rate Limiter</td>
<td>Cannot use inside a triggered subsystem hierarchy.</td>
</tr>
<tr>
<td>Rate Limiter Dynamic</td>
<td>The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the <strong>Treat as atomic unit</strong> option.</td>
</tr>
<tr>
<td>Relay</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Saturation</td>
<td></td>
</tr>
<tr>
<td>Block</td>
<td>Support Notes</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Saturation Dynamic</td>
<td>The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the <strong>Treat as atomic unit</strong> option.</td>
</tr>
</tbody>
</table>
**Discrete**

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delay</td>
<td>Supports code generation.</td>
</tr>
</tbody>
</table>
| Difference                    | • The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the **Treat as atomic unit** option.  
• Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable. |
| Discrete Derivative           | • Depends on absolute time when used inside a triggered subsystem hierarchy.  
• Supports code generation. |
| Discrete Filter               | Support code generation.                                                   |
| Discrete FIR Filter           |                                                                             |
| Discrete PID Controller       | • Depends on absolute time when used inside a triggered subsystem hierarchy.  
• Support code generation. |
<p>| Discrete PID Controller (2DOF)|                                                                             |
| Discrete State-Space          | Support code generation.                                                   |
| Discrete Transfer Fcn         |                                                                             |
| Discrete Zero-Pole            |                                                                             |
| Discrete-Time Integrator      | Depends on absolute time when used inside a triggered subsystem hierarchy.  |
| Enabled Delay                 | Supports code generation.                                                  |</p>
<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>First-Order Hold</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
<tr>
<td>Memory</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Resettable Delay</td>
<td></td>
</tr>
<tr>
<td>Tapped Delay</td>
<td></td>
</tr>
<tr>
<td>Transfer Fcn First Order</td>
<td>The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the <strong>Treat as atomic unit</strong> option.</td>
</tr>
<tr>
<td>Transfer Fcn Lead or Lag</td>
<td></td>
</tr>
<tr>
<td>Transfer Fcn Real Zero</td>
<td></td>
</tr>
<tr>
<td>Unit Delay</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Variable Integer Delay</td>
<td></td>
</tr>
<tr>
<td>Zero-Order Hold</td>
<td></td>
</tr>
</tbody>
</table>
## Logic and Bit Operations

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit Clear</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Bit Set</td>
<td></td>
</tr>
<tr>
<td>Bitwise Operator</td>
<td></td>
</tr>
<tr>
<td>Combinatorial Logic</td>
<td></td>
</tr>
<tr>
<td>Compare to Constant</td>
<td></td>
</tr>
<tr>
<td>Compare to Zero</td>
<td></td>
</tr>
<tr>
<td>Detect Change</td>
<td></td>
</tr>
<tr>
<td>Detect Decrease</td>
<td></td>
</tr>
<tr>
<td>Detect Fall Negative</td>
<td></td>
</tr>
<tr>
<td>Detect Fall Nonpositive</td>
<td></td>
</tr>
<tr>
<td>Detect Increase</td>
<td></td>
</tr>
<tr>
<td>Detect Rise Nonnegative</td>
<td></td>
</tr>
<tr>
<td>Detect Rise Positive</td>
<td></td>
</tr>
<tr>
<td>Extract Bits</td>
<td></td>
</tr>
<tr>
<td>Interval Test</td>
<td></td>
</tr>
<tr>
<td>Interval Test Dynamic</td>
<td></td>
</tr>
<tr>
<td>Logical Operator</td>
<td></td>
</tr>
<tr>
<td>Relational Operator</td>
<td></td>
</tr>
<tr>
<td>Shift Arithmetic</td>
<td></td>
</tr>
</tbody>
</table>
## Lookup Tables

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cosine</td>
<td>The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the <strong>Treat as atomic unit</strong> check box.</td>
</tr>
<tr>
<td>Direct Lookup Table (n-D)</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Interpolation Using Prelookup</td>
<td></td>
</tr>
<tr>
<td>1-D Lookup Table</td>
<td></td>
</tr>
<tr>
<td>2-D Lookup Table</td>
<td></td>
</tr>
<tr>
<td>n-D Lookup Table</td>
<td></td>
</tr>
<tr>
<td>Lookup Table Dynamic</td>
<td></td>
</tr>
<tr>
<td>Prelookup</td>
<td></td>
</tr>
<tr>
<td>Sine</td>
<td>The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the <strong>Treat as atomic unit</strong> option.</td>
</tr>
</tbody>
</table>
**Math Operations**

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abs</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Add</td>
<td></td>
</tr>
<tr>
<td>Algebraic Constraint</td>
<td>Ignored during code generation.</td>
</tr>
<tr>
<td>Assignment</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Bias</td>
<td></td>
</tr>
<tr>
<td>Complex to Magnitude-Angle</td>
<td></td>
</tr>
<tr>
<td>Complex to Real-Imag</td>
<td></td>
</tr>
<tr>
<td>Divide</td>
<td></td>
</tr>
<tr>
<td>Dot Product</td>
<td></td>
</tr>
<tr>
<td>Find Nonzero Elements</td>
<td></td>
</tr>
<tr>
<td>Gain</td>
<td></td>
</tr>
<tr>
<td>Magnitude-Angle to Complex</td>
<td></td>
</tr>
<tr>
<td>Math Function ($10^u$)</td>
<td></td>
</tr>
<tr>
<td>Math Function (conj)</td>
<td></td>
</tr>
<tr>
<td>Math Function (exp)</td>
<td></td>
</tr>
<tr>
<td>Math Function (hermitian)</td>
<td></td>
</tr>
<tr>
<td>Math Function (hypot)</td>
<td></td>
</tr>
<tr>
<td>Math Function (log)</td>
<td></td>
</tr>
<tr>
<td>Math Function (log10)</td>
<td></td>
</tr>
<tr>
<td>Math Function (magnitude^2)</td>
<td></td>
</tr>
<tr>
<td>Math Function (mod)</td>
<td></td>
</tr>
<tr>
<td>Math Function (pow)</td>
<td></td>
</tr>
<tr>
<td>Math Function (reciprocal)</td>
<td></td>
</tr>
<tr>
<td>Math Function (rem)</td>
<td></td>
</tr>
<tr>
<td>Math Function (square)</td>
<td></td>
</tr>
<tr>
<td>Math Function (transpose)</td>
<td></td>
</tr>
<tr>
<td>Block</td>
<td>Support Notes</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vector Concatenate, Matrix Concatenate</td>
<td></td>
</tr>
<tr>
<td>MinMax</td>
<td></td>
</tr>
<tr>
<td>MinMax Running Resettable</td>
<td></td>
</tr>
<tr>
<td>Permute Dimensions</td>
<td></td>
</tr>
<tr>
<td>Polynomial</td>
<td></td>
</tr>
<tr>
<td>Product</td>
<td></td>
</tr>
<tr>
<td>Product of Elements</td>
<td></td>
</tr>
<tr>
<td>Real-Imag to Complex</td>
<td></td>
</tr>
<tr>
<td>Sqrt, Signed Sqrt, Reciprocal Sqrt</td>
<td></td>
</tr>
<tr>
<td>Reshape</td>
<td></td>
</tr>
<tr>
<td>Rounding Function</td>
<td></td>
</tr>
<tr>
<td>Sign</td>
<td></td>
</tr>
<tr>
<td>Sqrt, Signed Sqrt, Reciprocal Sqrt</td>
<td></td>
</tr>
<tr>
<td>Sine Wave Function</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Does not refer to absolute time when configured for sample-based operation. Depends on absolute time when in time-based operation.</td>
</tr>
<tr>
<td></td>
<td>• Depends on absolute time when used inside a triggered subsystem hierarchy.</td>
</tr>
<tr>
<td>Slider Gain</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Sqrt</td>
<td></td>
</tr>
<tr>
<td>Squeeze</td>
<td></td>
</tr>
<tr>
<td>Subtract</td>
<td></td>
</tr>
<tr>
<td>Sum</td>
<td></td>
</tr>
<tr>
<td>Sum of Elements</td>
<td></td>
</tr>
<tr>
<td>Block</td>
<td>Support Notes</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Trigonometric Function</td>
<td>Functions $\text{asinh}$, $\text{acosh}$, and $\text{atanh}$ are not supported by all compilers. If you use a compiler that does not support those functions, the software issues a warning for the block and the generated code fails to link.</td>
</tr>
<tr>
<td>Unary Minus</td>
<td>Support code generation.modeling Gui</td>
</tr>
<tr>
<td>Vector Concatenate, Matrix Concatenate</td>
<td></td>
</tr>
<tr>
<td>Weighted Sample Time Math</td>
<td></td>
</tr>
</tbody>
</table>
# Model Verification

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assertion</td>
<td>Supports code generation.</td>
</tr>
<tr>
<td>Check Discrete Gradient</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
<tr>
<td>Check Dynamic Gap</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Check Dynamic Lower Bound</td>
<td></td>
</tr>
<tr>
<td>Check Dynamic Range</td>
<td></td>
</tr>
<tr>
<td>Check Dynamic Upper Bound</td>
<td></td>
</tr>
<tr>
<td>Check Input Resolution</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
<tr>
<td>Check Static Gap</td>
<td></td>
</tr>
<tr>
<td>Check Static Lower Bound</td>
<td></td>
</tr>
<tr>
<td>Check Static Range</td>
<td></td>
</tr>
<tr>
<td>Check Static Upper Bound</td>
<td></td>
</tr>
</tbody>
</table>
## Model-Wide Utilities

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block Support Table</td>
<td>Ignored during code generation.</td>
</tr>
<tr>
<td>DocBlock</td>
<td>Uses the template symbol you specify for the <strong>Embedded Coder</strong> Flag block parameter to add comments to generated code. Requires an Embedded Coder license. For more information, see “Use a Simulink DocBlock to Add a Comment” (Embedded Coder).</td>
</tr>
<tr>
<td>Model Info</td>
<td>Ignored during code generation.</td>
</tr>
<tr>
<td>Timed-Based Linearization</td>
<td></td>
</tr>
<tr>
<td>Trigger-Based Linearization</td>
<td></td>
</tr>
</tbody>
</table>
## Ports & Subsystems

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subsystem, Atomic</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Subsystem, Nonvirtual</td>
<td></td>
</tr>
<tr>
<td>Subsystem, CodeReuse</td>
<td></td>
</tr>
<tr>
<td>Subsystem</td>
<td></td>
</tr>
<tr>
<td>Configurable Subsystem</td>
<td></td>
</tr>
<tr>
<td>Enable</td>
<td></td>
</tr>
<tr>
<td>Enabled Subsystem</td>
<td></td>
</tr>
<tr>
<td>Enabled and Triggered Subsystem</td>
<td></td>
</tr>
<tr>
<td>For Each Subsystem</td>
<td></td>
</tr>
<tr>
<td>For Iterator Subsystem</td>
<td></td>
</tr>
<tr>
<td>Function-Call Feedback</td>
<td></td>
</tr>
<tr>
<td>Latch</td>
<td></td>
</tr>
<tr>
<td>Function-Call Generator</td>
<td></td>
</tr>
<tr>
<td>Function-Call Split</td>
<td></td>
</tr>
<tr>
<td>Function-Call Subsystem</td>
<td></td>
</tr>
<tr>
<td>If</td>
<td></td>
</tr>
<tr>
<td>If Action Subsystem</td>
<td></td>
</tr>
<tr>
<td>Inport (In1)</td>
<td></td>
</tr>
<tr>
<td>Model</td>
<td></td>
</tr>
<tr>
<td>Outport (Out1)</td>
<td></td>
</tr>
<tr>
<td>Resettable Subsystem</td>
<td></td>
</tr>
<tr>
<td>Subsystem</td>
<td></td>
</tr>
<tr>
<td>Switch Case</td>
<td></td>
</tr>
<tr>
<td>Switch Case Action Subsystem</td>
<td></td>
</tr>
<tr>
<td>Trigger</td>
<td></td>
</tr>
<tr>
<td>Triggered Subsystem</td>
<td></td>
</tr>
<tr>
<td>Block</td>
<td>Support Notes</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Unit System Configuration</td>
<td></td>
</tr>
<tr>
<td>Variant Subsystem</td>
<td></td>
</tr>
<tr>
<td>While Iterator Subsystem</td>
<td></td>
</tr>
</tbody>
</table>

### Signal Attributes

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus to Vector</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Data Type Conversion</td>
<td></td>
</tr>
<tr>
<td>Data Type Conversion Inherited</td>
<td></td>
</tr>
<tr>
<td>Data Type Duplicate</td>
<td></td>
</tr>
<tr>
<td>Data Type Propagation</td>
<td></td>
</tr>
<tr>
<td>Data Type Scaling Strip</td>
<td></td>
</tr>
<tr>
<td>IC</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
<tr>
<td>Probe</td>
<td>Supports code generation.</td>
</tr>
<tr>
<td>Rate Transition</td>
<td>• Supports code generation.</td>
</tr>
<tr>
<td></td>
<td>• Cannot use inside a triggered subsystem hierarchy.</td>
</tr>
<tr>
<td>Signal Conversion</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Signal Specification</td>
<td></td>
</tr>
<tr>
<td>Unit Conversion</td>
<td></td>
</tr>
<tr>
<td>Weighted Sample Time</td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td></td>
</tr>
</tbody>
</table>
## Signal Routing

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus Assignment</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Bus Creator</td>
<td></td>
</tr>
<tr>
<td>Bus Selector</td>
<td></td>
</tr>
<tr>
<td>Data Store Memory</td>
<td></td>
</tr>
<tr>
<td>Data Store Read</td>
<td></td>
</tr>
<tr>
<td>Data Store Write</td>
<td></td>
</tr>
<tr>
<td>Demux</td>
<td></td>
</tr>
<tr>
<td>Environment Controller</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
<tr>
<td>From</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Goto</td>
<td></td>
</tr>
<tr>
<td>Goto Tag Visibility</td>
<td></td>
</tr>
<tr>
<td>Index Vector</td>
<td></td>
</tr>
<tr>
<td>Manual Switch</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
<tr>
<td>Manual Variant Sink</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Manual Variant Source</td>
<td></td>
</tr>
<tr>
<td>Block</td>
<td>Support Notes</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Merge</td>
<td>When multiple signals connected to a Merge block have a non-Auto storage class, all non-Auto signals connected to that block must be <strong>identically labeled</strong> and <strong>have the same storage class</strong>. When Merge blocks connect directly to one another, these rules apply to all signals connected to Merge blocks in the group.</td>
</tr>
<tr>
<td>Multiport Switch</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Mux</td>
<td></td>
</tr>
<tr>
<td>Selector</td>
<td></td>
</tr>
<tr>
<td>State Reader</td>
<td></td>
</tr>
<tr>
<td>State Writer</td>
<td></td>
</tr>
<tr>
<td>Switch</td>
<td></td>
</tr>
<tr>
<td>Variant Sink</td>
<td></td>
</tr>
<tr>
<td>Variant Source</td>
<td></td>
</tr>
<tr>
<td>Vector Concatenate</td>
<td></td>
</tr>
</tbody>
</table>
## Sinks

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display</td>
<td>Ignored for code generation.</td>
</tr>
<tr>
<td>Floating Scope and Scope Viewer</td>
<td></td>
</tr>
<tr>
<td>Outport (Out1)</td>
<td>Supports code generation.</td>
</tr>
<tr>
<td>Scope</td>
<td>Ignored for code generation.</td>
</tr>
</tbody>
</table>
| Stop Simulation              | • Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.  
• Generated code stops executing when the stop condition is true. |
| Terminator                   | Supports code generation.                                                                                                                     |
| To File                      | Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable. |
| To Workspace                 | Ignored for code generation.                                                                                                                   |
| XY Graph                     |                                                                                                                                               |
### Sources

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Band-Limited White Noise</td>
<td>Cannot use inside a triggered subsystem hierarchy.</td>
</tr>
<tr>
<td>Chirp Signal</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
<tr>
<td>Clock</td>
<td>Supports code generation.</td>
</tr>
<tr>
<td>Counter Free-Running</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
</tbody>
</table>
| Counter Limited               | • The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the **Treat as atomic unit** option.  
• Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable. |
<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Clock</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
<tr>
<td>Enumerated Constant</td>
<td>Supports code generation.</td>
</tr>
<tr>
<td>From File</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
<tr>
<td>From Spreadsheet</td>
<td>Ignored for code generation.</td>
</tr>
<tr>
<td>From Workspace</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Ground</td>
<td>Cannot use inside a triggered subsystem hierarchy. Does not refer to absolute time when configured for sample-based operation. Depends on absolute time when in time-based operation.</td>
</tr>
<tr>
<td>Inport (In1)</td>
<td>Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.</td>
</tr>
<tr>
<td>Random Number</td>
<td>Supports code generation.</td>
</tr>
<tr>
<td><strong>Block</strong></td>
<td><strong>Support Notes</strong></td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Repeating Sequence        | • Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable.  
  • Consider using the Repeating Sequence Stair or Repeating Sequence Interpolated block instead. |
| Repeating Sequence Interpolated | • The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the **Treat as atomic unit** option.  
  • Cannot use inside a triggered subsystem hierarchy. |
<p>| Repeating Sequence Stair  | The code generator does not explicitly group primitive blocks that constitute a nonatomic masked subsystem block in the generated code. This flexibility allows for more efficient code generation. In certain cases, you can achieve grouping by configuring the masked subsystem block to execute as an atomic unit by selecting the <strong>Treat as atomic unit</strong> option. |
| Signal Builder            | Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable. |
| Signal Generator          |                                                                                                                                                  |</p>
<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
</table>
| Sine Wave             | • Depends on absolute time when used inside a triggered subsystem hierarchy.  
                        | • Does not refer to absolute time when configured for sample-based operation. Depends on absolute time when in time-based operation.            |
| Step                  | Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable. |
| Uniform Random Number | Supports code generation.                                                                                                                                 |
| Waveform Generator    | Not recommended for production code. Relates to resource limits and restrictions on speed and memory often found in embedded systems. Generated code can contain dynamic allocation and freeing of memory, recursion, additional memory overhead, and widely-varying execution times. While the code is functionally valid and generally acceptable in resource-rich environments, smaller embedded targets often cannot support such code. Usually, blocks evolve toward being suitable for production code. Thus, blocks suitable for production code remain suitable. |
User-Defined

<table>
<thead>
<tr>
<th>Block</th>
<th>Support Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fcn</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Function Caller</td>
<td></td>
</tr>
<tr>
<td>Initialize Function</td>
<td></td>
</tr>
<tr>
<td>Interpreted MATLAB Function</td>
<td>Consider using the MATLAB Function block instead.</td>
</tr>
<tr>
<td>Level-2 MATLAB S-Function</td>
<td>If a corresponding TLC file is available, the Level-2 MATLAB S-Function block uses the TLC file to generate code, otherwise code generation throws an error.</td>
</tr>
<tr>
<td>MATLAB Function</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>MATLAB System</td>
<td></td>
</tr>
<tr>
<td>S-Function</td>
<td>S-functions that call into MATLAB are not supported for code generation.</td>
</tr>
<tr>
<td>S-Function Builder</td>
<td></td>
</tr>
<tr>
<td>Simulink Function</td>
<td>Support code generation.</td>
</tr>
<tr>
<td>Terminate Function</td>
<td></td>
</tr>
</tbody>
</table>

Simulink Block Data Type Support Table

The Simulink Block Data Type Support table summarizes characteristics of blocks in the Simulink and Fixed-Point Designer block libraries, including whether or not they are recommended for use in production code generation. To view this table, in the MATLAB Command Window, type `showblockdatatypetable`, or consult the block reference pages.

Block Set Support for Code Generation

Several products that include blocks are available for you to consider for code generation. However, before using the blocks for one of these products, consult the documentation for that product to confirm which blocks support code generation.
Modeling Semantic Considerations

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Data Propagation” on page 2-30</td>
</tr>
<tr>
<td>“Sample Time Propagation” on page 2-32</td>
</tr>
<tr>
<td>“Latches for Subsystem Blocks” on page 2-33</td>
</tr>
<tr>
<td>“Block Execution Order” on page 2-34</td>
</tr>
<tr>
<td>“Algebraic Loops” on page 2-35</td>
</tr>
</tbody>
</table>

Data Propagation

The first stage of code generation is compilation of the block diagram. This stage is analogous to that of a C or C++ program. The compiler carries out type checking and preprocessing. Similarly, the Simulink engine verifies that input/output data types of block ports are consistent, line widths between blocks are of expected thickness, and the sample times of connecting blocks are consistent.

The Simulink engine propagates data from one block to the next along signal lines. The data propagated consists of

- Data type
- Line widths
- Sample times

You can verify what data types a Simulink block supports by typing

```
showblockdatatypetable
```

at the MATLAB prompt, or (from the Help browser) clicking the command above.

The Simulink engine typically derives signal attributes from a source block. For example, the Inport block's parameters dialog box specifies the signal attributes for the block.
In this example, the Inport block has a port width of 3, a sample time of .01 seconds, the data type is double, and the signal is complex.

This figure shows the propagation of the signal attributes associated with the Inport block through a simple block diagram.

![Diagram showing signal attributes propagation](image-url)
In this example, the Gain and Outport blocks inherit the attributes specified for the Inport block.

**Sample Time Propagation**

Inherited sample times in source blocks (for example, a root inport) can sometimes lead to unexpected and unintended sample time assignments. Since a block may specify an inherited sample time, information available at the outset is often insufficient to compile a block diagram completely.

In such cases, the Simulink engine propagates the known or assigned sample times to those blocks that have inherited sample times but that have not yet been assigned a sample time. Thus, the engine continues to fill in the blanks (the unknown sample times) until sample times have been assigned to as many blocks as possible. Blocks that still do not have a sample time are assigned a default sample time.

For a completely deterministic model (one where no sample times are set using the above rules), you should explicitly specify the sample times of your source blocks. Source blocks include root inport blocks and blocks without input ports. You do not have to set subsystem input port sample times. You might want to do so, however, when creating modular systems.

An unconnected input implicitly connects to ground. For ground blocks and ground connections, the sample time is always constant ($\text{inf}$).

All blocks have an inherited sample time ($T_s = -1$). They are assigned a sample time of $(T_f - T_i)/50$.

**Blocks Whose Outputs Have Constant Values**

When you display sample time colors, by default, Constant blocks appear magenta in color to indicate that the block outputs have constant values during simulation. Downstream blocks whose output values are also constant during simulation, such as Gain blocks, similarly appear magenta if they use an inherited sample time. The code generated for these blocks depends in part on the tunability of the block parameters.

If you set **Configuration Parameters > Optimization > Default parameter behavior** to **Inlined**, the block parameters are not tunable in the generated code. Because the block outputs are constant, the code generator eliminates the block code due to constant folding. If the code generator cannot fold the code, or if you select settings to disable constant folding, the block code appears in the model initialization function. The
generated code is more efficient because it does not compute the outputs of these blocks during execution.

However, if you configure a block or model so that the block parameters appear in the generated code as tunable variables, the code generator represents the blocks in a different way. Block parameters are tunable if, for example:

- You set **Default parameter behavior** to Tunable. By default, numeric block parameters appear as tunable fields of a global parameter structure.
- You use a tunable parameter, such as a Simulink.Parameter object that uses a storage class other than Auto, as the value of one or more numeric block parameters. These block parameters are tunable regardless of the setting that you choose for **Default parameter behavior**.

If a block parameter is tunable, the generated code must compute the block outputs during execution. Therefore, the block code appears in the model *step* function. If the model uses multiple discrete rates, the block code appears in the output function for the fastest downstream rate that uses the block outputs.

### Latches for Subsystem Blocks

When an Inport block is the signal source for a triggered or function-call subsystem, you can use latch options to preserve input values while the subsystem executes. The Inport block latch options include:

<table>
<thead>
<tr>
<th>For</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Triggered subsystems</td>
<td><strong>Latch input by delaying outside signal</strong></td>
</tr>
<tr>
<td>Function-call subsystems</td>
<td><strong>Latch input for feedback signals of function-call subsystem outputs</strong></td>
</tr>
</tbody>
</table>

When you use **Latch input for feedback signals of function-call subsystem outputs** for a function-call subsystem, the code generator

- Preserves latches in generated code regardless of optimizations that might be set
- Places the code for latches at the start of a subsystem's output/update function

For more information on these options, see the block description of Inport.
Block Execution Order

Once the Simulink engine compiles the block diagram, it creates a `model.rtw` file (analogous to an object file generated from a C or C++ file). The `model.rtw` file contains the connection information of the model, as well as the signal attributes. Thus, the timing engine in can determine when blocks with different rates should be executed.

You cannot override this execution order by directly calling a block (in handwritten code) in a model. For example, in the next figure the `disconnected_trigger` model on the left has its trigger port connected to ground, which can lead to the blocks inheriting a constant sample time. Calling the trigger function, \( f() \), directly from user code does not work. Instead, you should use a function-call generator to specify the rate at which \( f() \) should be executed, as shown in the `connected_trigger` model on the right.

Instead of the function-call generator, you could use another block that can drive the trigger port. Then, you should call the model's main entry point to execute the trigger function.

For multirate models, a common use of the code generator is to generate code for individual models separately and then manually code the I/O between the generated code modules. This approach places the burden of data consistency between models on the developer of the models. Another approach is to let Simulink and the code generator maintain data consistency between rates and generate multirate code for use in a multitasking environment. The Rate Transition block is able to interface periodic and asynchronous signals. For a description of the Simulink Coder block libraries, see
Algebraic Loops

Algebraic loops are circular dependencies between variables. This prevents the straightforward direct computation of their values. For example, in the case of a system of equations

- \( x = y + 2 \)
- \( y = -x \)

the values of \( x \) and \( y \) cannot be directly computed.

To solve this, either repeatedly try potential solutions for \( x \) and \( y \) (in an intelligent manner, for example, using gradient based search) or “solve” the system of equations. In the previous example, solving the system into an explicit form leads to

- \( 2x = 2 \)
- \( y = -x \)
- \( x = 1 \)
- \( y = -1 \)

An algebraic loop exists whenever the output of a block having direct feedthrough (such as Gain, Sum, Product, and Transfer Fcn) is fed back as an input to the same block. The Simulink engine is often able to solve models that contain algebraic loops, such as the next diagram.
The code generator does not produce code that solves algebraic loops. This restriction includes models that use Algebraic Constraint blocks in feedback paths. However, the Simulink engine can often eliminate algebraic loops that arise, by grouping equations in certain ways in models that contain them. It does this by separating the update and output functions to avoid circular dependencies. For details, see “Algebraic Loops” (Simulink).

**Algebraic Loops in Triggered Subsystems**

While the Simulink engine can minimize algebraic loops involving atomic and enabled subsystems, a special consideration applies to some triggered subsystems. An example for which code can be generated is shown in the following model and triggered subsystem.

![Triggered Subsystem Diagram]

The default Simulink behavior is to combine output and update methods for the subsystem, which creates an apparent algebraic loop, even though the Unit Delay block in the subsystem has no direct feedthrough.

You can allow the Simulink engine to solve the problem by splitting the output and update methods of triggered and enabled-triggered subsystems when feasible. If you want the code generator to take advantage of this feature, select the **Minimize algebraic loop occurrences** check box in the Subsystem Parameters dialog box. Select this option to avoid algebraic loop warnings in triggered subsystems involved in loops.

**Note** If you check this box, the generated code for the subsystem might contain split output and update methods, even if the subsystem is not actually involved in a loop. Also, if a direct feedthrough block (such as a Gain block) is connected to the inport in the above...
triggered subsystem, the Simulink engine cannot solve the problem, and the code generator is unable to generate code.

A similar **Minimize algebraic loop occurrences** option appears on the **Model Referencing** pane of the Configuration Parameters dialog box. Selecting it enables the Simulink Coder software to generate code for models containing Model blocks that are involved in algebraic loops.
Modeling Guidelines for Blocks

Code generation modeling guidelines include recommended model settings, block usage, and block parameters. When you develop models for code generation, use these guidelines.

For more information, see “Modeling Guidelines” (Simulink).

<table>
<thead>
<tr>
<th>Code Generation Modeling Guidelines</th>
<th>“cgsl_0101: Zero-based indexing” (Simulink)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“cgsl_0102: Evenly spaced breakpoints in lookup tables” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“cgsl_0103: Precalculated signals and parameters” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“cgsl_0104: Modeling global shared memory using data stores” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“cgsl_0105: Modeling local shared memory using data stores” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“cgsl_0201: Redundant Unit Delay and Memory blocks” (Simulink)</td>
</tr>
</tbody>
</table>

See Also

## Modeling Guidelines for Subsystems

When you develop models and generate code for subsystems, use the modeling guideline recommendations.

For more information, see "Modeling Guidelines" (Simulink).

<table>
<thead>
<tr>
<th>Code Generation Modeling Guidelines</th>
<th>“cgsl_0204: Vector and bus signals crossing into atomic subsystems or Model blocks” (Simulink)</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-Integrity Systems Modeling Guidelines</td>
<td>hisl_0007: Usage of For Iterator or While Iterator subsystems (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0010: Usage of If blocks and If Action Subsystem blocks” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0011: Usage of Switch Case blocks and Action Subsystem blocks” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0023: Verification of model and subsystem variants” (Simulink)</td>
</tr>
</tbody>
</table>
| MathWorks Automotive Advisory Board (MAAB) Control Algorithm Guidelines | db_0040: Model hierarchy  
| | db_0042: Port block in Simulink models  
| | db_0081: Unconnected signals, block inputs and block outputs  
| | db_0143: Similar block types on the model levels  
| | db_0144: Use of Subsystems  
| | db_0146: Triggered, enabled, conditional Subsystems  
| | jc_0111: Direction of Subsystem  
| | jc_0201: Usable characters for Subsystem names  
| | jc_0231: Usable characters for block names  
| | jc_0281: Naming of Trigger Port block and Enable Port block  
| | jc_0321: Trigger layer  
| | jc_0331: Structure layer  
| | jc_0351: Methods of initialization  
| | jm_0002: Block resizing  
| | na_0005: Port block name visibility in Simulink models  
| | na_0006: Guidelines for mixed use of Simulink and Stateflow  
| | na_0008: Display of labels on signals  
| | na_0009: Entry versus propagation of signal labels  
| | na_0012: Use of Switch vs. If-Then-Else Action Subsystem |
See Also

Modeling Guidelines for Charts

When you develop models and generate code for charts, use the modeling guideline recommendations.

For more information, see “Modeling Guidelines” (Simulink).

<table>
<thead>
<tr>
<th>High-Integrity Systems Modeling Guidelines</th>
<th>“hisf_0001: State Machine Type” (Simulink)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“hisf_0002: User-specified state/transition execution order” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisf_0009: Strong data typing (Simulink and Stateflow boundary)” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisf_0011: Stateflow debugging settings” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisf_0003: Usage of bitwise operations” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisf_0004: Usage of recursive behavior” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisf_0007: Usage of junction conditions (maintaining mutual exclusion)” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisf_0013: Usage of transition paths (crossing parallel state boundaries)” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisf_0014: Usage of transition paths (passing through states)” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisf_0015: Strong data typing (casting variables and parameters in expressions)” (Simulink)</td>
</tr>
</tbody>
</table>
MathWorks Automotive Advisory Board (MAAB) Control Algorithm Guidelines

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>db_0127</td>
<td>MATLAB commands in Stateflow</td>
</tr>
<tr>
<td>db_0151</td>
<td>State machine patterns for transition actions</td>
</tr>
<tr>
<td>jc_0451</td>
<td>Use of unary minus on unsigned integers in Stateflow</td>
</tr>
<tr>
<td>jc_0481</td>
<td>Use of hard equality comparisons for floating point numbers in Stateflow</td>
</tr>
<tr>
<td>jc_0501</td>
<td>Format of entries in a State block</td>
</tr>
<tr>
<td>jc_0511</td>
<td>Setting the return value from a graphical function</td>
</tr>
<tr>
<td>jc_0521</td>
<td>Use of the return value from graphical functions</td>
</tr>
<tr>
<td>jc_0531</td>
<td>Placement of the default transition</td>
</tr>
<tr>
<td>jc_0541</td>
<td>Use of tunable parameters in Stateflow</td>
</tr>
<tr>
<td>jm_0011</td>
<td>Pointers in Stateflow</td>
</tr>
<tr>
<td>na_0001</td>
<td>Bitwise Stateflow operators</td>
</tr>
<tr>
<td>na_0013</td>
<td>Comparison operation in Stateflow</td>
</tr>
</tbody>
</table>

**See Also**

Modeling Guidelines for MATLAB Functions

When you develop models and generate code for MATLAB Functions, use the modeling guideline recommendations.

For more information, see “Modeling Guidelines” (Simulink).

<table>
<thead>
<tr>
<th>High-Integrity Systems Modeling Guidelines</th>
<th>“himl_0001: Usage of standardized MATLAB function headers” (Simulink)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“himl_0002: Strong data typing at MATLAB function boundaries” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“himl_0003: Limitation of MATLAB function complexity” (Simulink)</td>
</tr>
</tbody>
</table>

See Also

Modeling Guidelines for Model Configuration

When you develop models and generate code, use the modeling guideline configuration recommendations.

For more information, see “Modeling Guidelines” (Simulink).

<table>
<thead>
<tr>
<th>Code Generation Modeling Guidelines</th>
<th>“cgsl_0301: Prioritization of code generation objectives for code efficiency” (Simulink)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>“cgsl_0302: Diagnostic settings for multirate and multitasking models” (Simulink)</td>
</tr>
<tr>
<td>High-Integrity Systems Modeling Guidelines</td>
<td>“hisl_0043: Configuration Parameters &gt; Diagnostics &gt; Solver” (Simulink)</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>“hisl_0044: Configuration Parameters &gt; Diagnostics &gt; Sample Time” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0301: Configuration Parameters &gt; Diagnostics &gt; Compatibility” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0302: Configuration Parameters &gt; Diagnostics &gt; Data Validity &gt; Parameters” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0303: Configuration Parameters &gt; Diagnostics &gt; Merge block” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0304: Configuration Parameters &gt; Diagnostics &gt; Model initialization” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0305: Configuration Parameters &gt; Diagnostics &gt; Debugging” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0306: Configuration Parameters &gt; Diagnostics &gt; Connectivity &gt; Signals” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0307: Configuration Parameters &gt; Diagnostics &gt; Connectivity &gt; Buses” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0308: Configuration Parameters &gt; Diagnostics &gt; Connectivity &gt; Function calls” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0309: Configuration Parameters &gt; Diagnostics &gt; Type Conversion” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0310: Configuration Parameters &gt; Diagnostics &gt; Model Referencing” (Simulink)</td>
</tr>
<tr>
<td></td>
<td>“hisl_0311: Configuration Parameters &gt; Diagnostics &gt; Stateflow” (Simulink)</td>
</tr>
</tbody>
</table>
See Also

Timers in Simulink Coder

- “Absolute and Elapsed Time Computation” on page 3-2
- “Access Timers Programmatically” on page 3-5
- “Generate Code for an Elapsed Time Counter” on page 3-9
- “Absolute Time Limitations” on page 3-12
Absolute and Elapsed Time Computation

In this section...

| “About Timers” on page 3-2 |
| “Timers for Periodic and Asynchronous Tasks” on page 3-3 |
| “Allocation of Timers” on page 3-3 |
| “Integer Timers in Generated Code” on page 3-3 |
| “Elapsed Time Counters in Triggered Subsystems” on page 3-4 |

About Timers

Certain blocks require the value of either absolute time (that is, the time from the start of program execution to the present time) or elapsed time (for example, the time elapsed between two trigger events). Targets that support the real-time model (rtModel) data structure provide efficient time computation services to blocks that request absolute or elapsed time. Absolute and elapsed timer features include

- Timers are implemented as unsigned integers in generated code.
- In multirate models, at most one timer is allocated per rate. If no blocks executing at a given rate require a timer, a timer is not allocated to that rate. This minimizes memory allocated for timers and significantly reduces overhead involved in maintaining timers.
- Allocation of elapsed time counters for use of blocks within triggered subsystems is minimized, further reducing memory usage and overhead.
- S-function and TLC APIs let your S-functions access timers, in simulation and code generation.
- The word size of the timers is determined by a user-specified maximum counter value, Application lifespan (days) (Simulink). If you specify this value, timers will not overflow. For more information, see “Control Memory Allocation for Time Counters” on page 33-11.

See “Absolute Time Limitations” on page 3-12 for more information about absolute time and the restrictions that it imposes.
Timers for Periodic and Asynchronous Tasks

Timing services provided for blocks execute within periodic tasks (that is, tasks running at the model base rate or subrates).

The code generator also provides timer support for blocks whose execution is asynchronous with respect to the periodic timing source of the model. See the following topics:

- “Timers in Asynchronous Tasks” on page 5-42
- “Create a Customized Asynchronous Library” on page 5-45

Allocation of Timers

If you create or maintain an S-Function block that requires absolute or elapsed time data, it must register the requirement (see “Access Timers Programmatically” on page 3-5). In multirate models, timers are allocated on a per-rate basis. For example, consider a model structured as follows:

- There are three rates, A, B, and C, in the model.
- No blocks running at rate B require absolute or elapsed time.
- Two blocks running at rate C register a requirement for absolute time.
- One block running at rate A registers a requirement for absolute time.

In this case, two timers are generated, running at rates A and C respectively. The timing engine updates the timers as the tasks associated with rates A and C execute. Blocks executing at rates A and C obtain time data from the timers associated with rates A and C.

Integer Timers in Generated Code

In the generated code, timers for absolute and elapsed time are implemented as unsigned integers. The default size is 64 bits. This is the amount of memory allocated for a timer if you specify a value of inf for the Application lifespan (days) (Simulink) parameter. For an application with a sample rate of 1000 MHz, a 64-bit counter will not overflow for more than 500 years. See “Timers in Asynchronous Tasks” on page 5-42 and “Control Memory Allocation for Time Counters” on page 33-11 for more information.
Elapsed Time Counters in Triggered Subsystems

Some blocks, such as the Discrete-Time Integrator block, perform computations requiring the elapsed time (delta T) since the previous block execution. Blocks requiring elapsed time data must register the requirement (see “Access Timers Programmatically” on page 3-5). A triggered subsystem then allocates and maintains a single elapsed time counter if required. This timer functions at the subsystem level, not at the individual block level. The timer is generated if the triggered subsystem (or a unconditionally executed subsystem within the triggered subsystem) contains one or more blocks requiring elapsed time data.

**Note** If you are using simplified initialization mode, elapsed time is reset on first execution after becoming enabled, whether or not the subsystem is configured to reset on enable. For more information, see “Underspecified initialization detection” (Simulink).

See Also

More About

- “Access Timers Programmatically“ on page 3-5
- “Generate Code for an Elapsed Time Counter“ on page 3-9
- “Optimize Memory Usage for Time Counters“ on page 33-102
- “Absolute Time Limitations“ on page 3-12
About Timer APIs

This topic describes APIs that let your S-functions take advantage of the efficiencies offered by absolute and elapsed timers. SimStruct macros are provided for use in simulation, and TLC functions are provided for inlined code generation. Note that

- To generate and use the new timers as described above, your S-functions must register the need to use an absolute or elapsed timer by calling `ssSetNeedAbsoluteTime` or `ssSetNeedElapsedTime` in `mdlInitializeSampleTime`.
- Existing S-functions that read absolute time but do not register by using these macros continue to operate as expected, but generate less efficient code.

C API for S-Functions

The SimStruct macros described in this topic provide access to absolute and elapsed timers for S-functions during simulation.

In the functions below, the `SimStruct *S` argument is a pointer to the `simstruct` of the calling S-function.

- `void ssSetNeedAbsoluteTime(SimStruct *S, boolean b)` : if `b` is TRUE, registers that the calling S-function requires absolute time data, and allocates an absolute time counter for the rate at which the S-function executes (if such a counter has not already been allocated).

- `int ssGetNeedAbsoluteTime(SimStruct *S)` : returns 1 if the S-function has registered that it requires absolute time.

- `double ssGetTaskTime(SimStruct *S, tid)` : read absolute time for a given task with task identifier `tid`. `ssGetTaskTime` operates transparently, regardless of whether or not you use the new timer features. `ssGetTaskTime` is documented in the SimStruct Functions chapter of the Simulink documentation.
• `void ssSetNeedElapseTime(SimStruct *S, boolean b)` if `b` is TRUE, registers that the calling S-function requires elapsed time data, and allocates an elapsed time counter for the triggered subsystem in which the S-function executes (if such a counter has not already been allocated). See also “Elapsed Time Counters in Triggered Subsystems” on page 3-4.

• `int ssGetNeedElapseTime(SimStruct *S)` returns 1 if the S-function has registered that it requires elapsed time.

• `void ssGetElapseTime(SimStruct *S, (double *)elapseTime)` returns, to the location pointed to by `elapseTime`, the value (as a double) of the elapsed time counter associated with the S-function.

• `void ssGetElapseTimeCounterDtype(SimStruct *S, (int *)dtype)` returns the data type of the elapsed time counter associated with the S-function to the location pointed to by `dtype`. This function is intended for use with the `ssGetElapseTimeCounter` function (see below).

• `void ssGetElapseResolution(SimStruct *S, (double *)resolution)` returns the resolution (that is, the sample time) of the elapsed time counter associated with the S-function to the location pointed to by `resolution`. This function is intended for use with the `ssGetElapseTimeCounter` function (see below).

• `void ssGetElapseTimeCounter(SimStruct *S, (void *)elapseTime)` This function is provided for the use of blocks that require the elapsed time values for fixed-point computations. `ssGetElapseTimeCounter` returns, to the location pointed to by `elapseTime`, the integer value of the elapsed time counter associated with the S-function. If the counter size is 64 bits, the value is returned as an array of two 32-bit words, with the low-order word stored at the lower address.

To determine how to access the returned counter value, obtain the data type of the counter by calling `ssGetElapseTimeCounterDtype`, as in the following code:

```c
int  *y_dtype;
ssGetElapseTimeCounterDtype(S, y_dtype);

switch(*y_dtype) {
    case SS_DOUBLE_UINT32:
        { /* code for double-uint32 counter */ }
    break;
    case SS_UINT32:
        { /* code for int-counter */ }
    break;
    default:
        /* handle unexpected data type */
    break;
}
```
uint32_T dataPtr[1];
ssGetElapseTimeCounter(S, dataPtr);
}
break;
case SS_UINT16:
{
    uint16_T dataPtr[1];
    ssGetElapseTimeCounter(S, dataPtr);
}
break;
case SS_UINT8:
{
    uint8_T dataPtr[1];
    ssGetElapseTimeCounter(S, dataPtr);
}
break;
case SS_DOUBLE:
{
    real_T dataPtr[1];
    ssGetElapseTimeCounter(S, dataPtr);
}
break;
default:
    ssSetErrorStatus(S, "Invalid data type for elaspe time counter");
    break;
}

If you want to use the actual elapsed time, issue a call to the ssGetElapseTime function to access the elapsed time directly. You do not need to get the counter value and then calculate the elapsed time.

double *y_elapseTime;
.
.
ssGetElapseTime(S, elapseTime)

**TLC API for Code Generation**

The following TLC functions support elapsed time counters in generated code when you inline S-functions by writing TLC scripts for them.
• **LibGetTaskTimeFromTID(block)**: Generates code to read the absolute time for the task in which block executes.

LibGetTaskTimeFromTID is documented with other sample time functions in the TLC Function Library Reference pages of the Target Language Compiler documentation.

**Note** Do not use LibGetT for this purpose. LibGetT always reads the base rate (tid 0) timer. If LibGetT is called for a block executing at a subrate, the wrong timer is read, causing serious errors.

• **LibGetElapseTime(system)**: Generates code to read the elapsed time counter for system. (system is the parent system of the calling block.) See “Generate Code for an Elapsed Time Counter” on page 3-9 for an example of code generated by this function.

• **LibGetElapseTimeCounter(system)**: Generates code to read the integer value of the elapsed time counter for system. (system is the parent system of the calling block.) This function should be used in conjunction with LibGetElapseTimeCounterDtypeId and LibGetElapseTimeResolution. (See the discussion of ssGetElapseTimeCounter above.)

• **LibGetElapseTimeCounterDtypeId(system)**: Generates code that returns the data type of the elapsed time counter for system. (system is the parent system of the calling block.)

• **LibGetElapseTimeResolution(system)**: Generates code that returns the resolution of the elapsed time counter for system. (system is the parent system of the calling block.)

**See Also**

**More About**

• “Absolute and Elapsed Time Computation” on page 3-2
• “Generate Code for an Elapsed Time Counter” on page 3-9
• “Absolute Time Limitations” on page 3-12
Generate Code for an Elapsed Time Counter

This example shows a model that includes a triggered subsystem, Amplifier, consisting of a Discrete-Time Integrator block that uses an elapsed time counter. The model ex_elapseTime is in the folder matlab/help/toolbox/rtw/examples.

ex_elapseTime Model

Amplifier Subsystem

Code in the generated header file ex_elapseTime.h for the model uses 64 bits to implement the timer for the base rate (clockTick0 and clockTickH0).

```c
/*
 * Timing:
 * The following substructure contains information regarding
 * the timing information for the model.
 */
struct {
    time_T taskTime0;
    uint32_T clockTick0;
```
The code generator allocates storage for the previous-time value and elapsed-time value of the Amplifier subsystem (Amplifier_PREV_T) in the D_Work(states) structure in ex_elapsedTime.h.

The elapsed time computation is performed as follows within the ex_elapsedTime_step function:

```c
/* ---
Outputs for Triggered SubSystem:
'Root'/Amplifier' incorporates:
   TriggerPort: '<S1>/Trigger'
--- */
zcEvent = rt_ZCFcn(RISING_ZERO_CROSSING,
   &ex_elapsedTime_PrevZCX.Amplifier_Trig_ZCE, ((real_T)rtb_PulseGenerator));
if (zcEvent != NO_ZCEVENT) {
   elapseT_H = ex_elapsedTime_M->Timing.clockTickH0 - 
   ex_elapsedTime_DW.Amplifier_PREV_T[1];
   if (ex_elapsedTime_DW.Amplifier_PREV_T[0] > 
   ex_elapsedTime_M->Timing.clockTick0) {
      elapseT_H--;
   }

   ex_elapsedTime_DW.Amplifier_ELAPS_T[0] = 
   ex_elapsedTime_M->Timing.clockTick0 
   - ex_elapsedTime_DW.Amplifier_PREV_T[0];
   ex_elapsedTime_DW.Amplifier_PREV_T[0] = 
```

...
As shown above, the elapsed time is maintained as a state of the triggered subsystem. The Discrete-Time Integrator block finally performs its output and update computations using the elapsed time.

```c
/* ---
DiscreteIntegrator: '<S1>/Discrete-Time Integrator'
--- */
OUTPUT = ex_elapseTime_DW.DiscreteTimeIntegrator_DSTATE;

/* ---
Update for DiscreteIntegrator:
  '<S1>/Discrete-Time Integrator' incorporates:
  Constant: '<Root>/Constant'
--- */
ex_elapseTime_DW.DiscreteTimeIntegrator_DSTATE += 0.3 * (real_T)
  ex_elapseTime_DW.Amplifier_ELAPS_T[0] * 1.5;
```

**See Also**

**More About**
- “Absolute and Elapsed Time Computation” on page 3-2
- “Absolute Time Limitations” on page 3-12
Absolute Time Limitations

*Absolute time* is the time that has elapsed from the beginning of program execution to the present time, as distinct from *elapsed time*, the interval between two events. See “Absolute and Elapsed Time Computation” on page 3-2 for more information.

When you design an application that is intended to run indefinitely, you must take care when logging time values, or using charts or blocks that depend on absolute time. If the value of time reaches the largest value that can be represented by the data type used by the timer to store time, the timer overflows and the logged time or block output is incorrect.

If your target uses `rtModel`, you can avoid timer overflow by specifying a value for the *Application life span* parameter. See “Integer Timers in Generated Code” on page 3-3 for more information.

The following limitations apply to absolute time:

- If you log time values by opening the Configuration Parameters dialog box and enabling *Data Import/Export > Time* parameter, your model uses absolute time.
- Every Stateflow chart that uses time is dependent on absolute time. The only way to eliminate the dependency is to change the Stateflow chart to not use time.
- The following Simulink blocks depend on absolute time:
  - Backlash
  - Chirp Signal
  - Clock
  - Derivative
  - Digital Clock
  - Discrete-Time Integrator (only when used in triggered subsystems)
  - From File
  - From Workspace
  - Pulse Generator
  - Ramp
  - Rate Limiter
  - Repeating Sequence
• Signal Generator
• Sine Wave (only when the Sine type parameter is set to Time-based)
• Step
• To File
• To Workspace (only when logging to StructureWithTime format)
• Transport Delay
• Variable Time Delay
• Variable Transport Delay

In addition to the Simulink blocks above, blocks in other blocksets may depend on absolute time. See the documentation for the blocksets that you use.

See Also

More About
• “Absolute and Elapsed Time Computation” on page 3-2
Time-Based Scheduling in Simulink Coder
Time-Based Scheduling and Code Generation

In this section...

| “Sample Time Considerations” on page 4-2 |
| “Tasking Modes” on page 4-2 |
| “Model Execution and Rate Transitions” on page 4-4 |
| “Execution During Simulink Model Simulation” on page 4-5 |
| “Model Execution in Real Time” on page 4-5 |
| “Single-Tasking Versus Multitasking Operation” on page 4-6 |

Sample Time Considerations

Simulink models run at one or more sample times. The Simulink product provides considerable flexibility in building multirate systems, that is, systems with more than one sample time. However, this same flexibility also allows you to construct models for which the code generator cannot generate real-time code for execution in a multitasking environment. To make multirate models operate as expected in real time (that is, to give the right answers), you sometimes must modify your model or instruct the Simulink engine to modify the model for you. In general, the modifications involve placing Rate Transition blocks between blocks that have unequal sample times. The following sections discuss issues you must address to use a multirate model in a multitasking environment. For a comprehensive discussion of sample times, including rate transitions, see “What Is Sample Time?” (Simulink), “Sample Times in Subsystems” (Simulink), “Sample Times in Systems” (Simulink), “Resolve Rate Transitions” (Simulink), and associated topics.

Tasking Modes

There are two execution modes for a fixed-step Simulink model: single-tasking and multitasking. These modes are available only for fixed-step solvers. To select an execution mode, use the **Treat each discrete rate as a separate task** checkbox on the **Solver** pane of the Configuration Parameters dialog box. When this parameter is selected, multitasking execution is applied for a multirate model. When this option is cleared, single-tasking execution is applied.

**Note** A model that is multirate and uses multitasking cannot reference a multirate model that uses single-tasking.
Execution of models in a real-time system can be done with the aid of a real-time operating system, or it can be done on *bare-metal* target hardware, where the model runs in the context of an interrupt service routine (ISR).

The fact that a system (such as The Open Group UNIX® or Microsoft® Windows systems) is multitasking does not imply that your program can execute in real time. This is because the program might not preempt other processes when required.

In operating systems (such as PC-DOS) where only one process can exist at a given time, an interrupt service routine (ISR) must perform the steps of saving the processor context, executing the model code, collecting data, and restoring the processor context.

Other operating systems, such as POSIX-compliant ones, provide automatic context switching and task scheduling. This simplifies the operations performed by the ISR. In this case, the ISR simply enables the model execution task, which is normally blocked. The next figure illustrates this difference.
Model Execution and Rate Transitions

To generate code that executes as expected in real time, you (or the Simulink engine) might need to identify and handle sample rate transitions within the model. In multitasking mode, by default the Simulink engine flags errors during simulation if the model contains invalid rate transitions, although you can use the Multitask rate transition diagnostic to alter this behavior. A similar diagnostic, called Single task rate transition, exists for single-tasking mode.
To avoid raising rate transition errors, insert Rate Transition blocks between tasks. You can request that the Simulink engine handle rate transitions automatically by inserting hidden Rate Transition blocks. See “Automatic Rate Transition” on page 4-26 for an explanation of this option.

To understand such problems, first consider how Simulink simulations differ from real-time programs.

**Execution During Simulink Model Simulation**

Before the Simulink engine simulates a model, it orders the blocks based upon their topological dependencies. This includes expanding virtual subsystems into the individual blocks they contain and flattening the entire model into a single list. Once this step is complete, each block is executed in order.

The key to this process is the ordering of blocks. A block whose output is directly dependent on its input (that is, a block with direct feedthrough) cannot execute until the block driving its input executes.

Some blocks set their outputs based on values acquired in a previous time step or from initial conditions specified as a block parameter. The output of such a block is determined by a value stored in memory, which can be updated independently of its input. During simulation, computations are performed prior to advancing the variable corresponding to time. This results in computations occurring instantaneously (that is, no computational delay).

**Model Execution in Real Time**

A real-time program differs from a Simulink simulation in that the program must execute the model code synchronously with real time. Every calculation results in some computational delay. This means the sample intervals cannot be shortened or lengthened (as they can be in a Simulink simulation), which leads to less efficient execution.

Consider the following timing figure.
Note the processing inefficiency in the sample interval $t_1$. That interval cannot be compressed to increase execution speed because, by definition, sample times are clocked in real time.

You can circumvent this potential inefficiency by using the multitasking mode. The multitasking mode defines tasks with different priorities to execute parts of the model code that have different sample rates.

See “Multitasking and Pseudomultitasking Modes” on page 4-12 for a description of how this works. It is important to understand that section before proceeding here.

**Single-Tasking Versus Multitasking Operation**

Single-tasking programs require longer sample intervals, because all computations must be executed within each clock period. This can result in inefficient use of available CPU time, as shown in the previous figure.

Multitasking mode can improve the efficiency of your program if the model is large and has many blocks executing at each rate.

However, if your model is dominated by a single rate, and only a few blocks execute at a slower rate, multitasking can actually degrade performance. In such a model, the overhead incurred in task switching can be greater than the time required to execute the slower blocks. In this case, it is more efficient to execute all blocks at the dominant rate.

If you have a model that can benefit from multitasking execution, you might need to modify your model by adding Rate Transition blocks (or instruct the Simulink engine to do so) to generate expected results.

For more information about the two modes of execution and examples, see “Modeling for Single-Tasking Execution” on page 4-8 and “Modeling for Multitasking Execution” on page 4-12.
See Also

More About

• “What Is Sample Time?” (Simulink)
• “Sample Times in Subsystems” (Simulink)
• “Sample Times in Systems” (Simulink)
• “Configure Time-Based Scheduling” on page 4-37
• “Sample Times in Subsystems” (Simulink)
• “Sample Times in Systems” (Simulink)
• “Resolve Rate Transitions” (Simulink)
• “Handle Rate Transitions” on page 4-21
• “Time-Based Scheduling and Code Generation” on page 4-2
• “Modeling for Single-Tasking Execution” on page 4-8
• “Modeling for Multitasking Execution” on page 4-12
• “Time-Based Scheduling Example Models” on page 4-39
Modeling for Single-Tasking Execution

Single-Tasking Mode

You can execute model code in a strictly single-tasking manner. While this mode is less efficient with regard to execution speed, in certain situations, it can simplify your model.

In single-tasking mode, the base sample rate must define a time interval that is long enough to allow the execution of all blocks within that interval.

The next figure illustrates the inefficiency inherent in single-tasking execution.

![Single-tasking figure]

Single-tasking system execution requires a base sample rate that is long enough to execute one step through the entire model.

Build a Program for Single-Tasking Execution

To use single-tasking execution, clear the **Treat each discrete rate as a separate task** checkbox on the **Solver** pane of the Configuration Parameters dialog box. If you select the checkbox, single-tasking mode is used in the following cases:

- If your model contains one sample time
- If your model contains a continuous and a discrete sample time and the fixed step size is equal to the discrete sample time

Single-Tasking Execution

This example examines how a simple multirate model executes in both real time and simulation, using a fixed-step solver. It considers operation in both single-tasking and multitasking modes, as determined by setting of the **Treat each discrete rate as a separate task** parameter on the **Solver** pane.

The example model is shown in the next figure. The discussion refers to the six blocks of the model as A through F, as labeled in the block diagram.
The execution order of the blocks (indicated in the upper right of each block) has been forced into the order shown by assigning higher priorities to blocks F, E, and D. The ordering shown is one possible valid execution ordering for this model. For more information, see “Simulation Phases in Dynamic Systems” (Simulink).

The execution order is determined by data dependencies between blocks. In a real-time system, the execution order determines the order in which blocks execute within a given time interval or task. This discussion treats the model's execution order as a given, because it is concerned with the allocation of block computations to tasks, and the scheduling of task execution.

Note The discussion and timing diagrams in this section are based on the assumption that the Rate Transition blocks are used in the default (protected/deterministic) mode, with the Ensure data integrity during data transfer and Ensure deterministic data transfer (maximum delay) options on.

This example considers the execution of the above model when the Treat each discrete rate as a separate task checkbox is cleared, which indicates the single-tasking mode.

In a single-tasking system, if the Configuration Parameters > Optimization > Advanced parameters > Block reduction option is selected, fast-to-slow Rate Transition blocks are optimized out of the model. The default case is shown (Block reduction selected), so block B does not appear in the timing diagrams in this section. For more information, see “Block reduction” (Simulink).

The following table shows, for each block in the model, the execution order, sample time, and whether the block has an output or update computation. Block A does not have discrete states, and accordingly does not have an update computation.
Execution Order and Sample Times (Single-Tasking)

<table>
<thead>
<tr>
<th>Blocks (in Execution Order)</th>
<th>Sample Time (in Seconds)</th>
<th>Output</th>
<th>Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0.1</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>F</td>
<td>0.1</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>D</td>
<td>1</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>A</td>
<td>0.1</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>C</td>
<td>1</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

Real-Time Single-Tasking Execution

The next figure shows the scheduling of computations when the generated code is deployed in a real-time system. The generated program is shown running in real time, under control of interrupts from a 10 Hz timer.

At time 0.0, 1.0, and every second thereafter, both the slow and fast blocks execute their output computations; this is followed by update computations for blocks that have states. Within a given time interval, output and update computations are sequenced in block execution order.

The fast blocks execute on every tick, at intervals of 0.1 second. Output computations are followed by update computations.

The system spends some portion of each time interval (labeled “wait”) idling. During the intervals when only the fast blocks execute, a larger portion of the interval is spent idling. This illustrates an inherent inefficiency of single-tasking mode.
Simulated Single-Tasking Execution

The next figure shows the execution of the model during the Simulink simulation loop.

Because time is simulated, the placement of ticks represents the iterations of the simulation loop. Blocks execute in exactly the same order as in the previous figure, but without the constraint of a real-time clock. Therefore there is no idle time between simulated sample periods.

See Also

More About

- “Time-Based Scheduling and Code Generation” on page 4-2
- “Configure Time-Based Scheduling” on page 4-37
- “Time-Based Scheduling Example Models” on page 4-39
Modeling for Multitasking Execution

Multitasking and Pseudomultitasking Modes

When periodic tasks execute in a multitasking mode, by default the blocks with the fastest sample rates are executed by the task with the highest priority, the next fastest blocks are executed by a task with the next higher priority, and so on. Time available in between the processing of high-priority tasks is used for processing lower priority tasks. This results in efficient program execution.

Where tasks are asynchronous rather than periodic, there may not necessarily be a relationship between sample rates and task priorities; the task with the highest priority need not have the fastest sample rate. You specify asynchronous task priorities using Async Interrupt and Task Sync blocks. You can switch the sense of what priority numbers mean by selecting or deselecting the Solver option Higher priority value indicates higher task priority.

In multitasking environments (that is, under a real-time operating system), you can define separate tasks and assign them priorities. For bare-metal target hardware (that is, no real-time operating system present), you cannot create separate tasks. However, generated application modules implement what is effectively a multitasking execution scheme using overlapped interrupts, accompanied by programmatic context switching.

This means an interrupt can occur while another interrupt is currently in progress. When this happens, the current interrupt is preempted, the floating-point unit (FPU) context is saved, and the higher priority interrupt executes its higher priority (that is, faster sample rate) code. Once complete, control is returned to the preempted ISR.

The next figures illustrate how timing of tasks in multirate systems are handled by the code generator in multitasking, pseudomultitasking, and single-tasking environments.
The next figure shows how overlapped interrupts are used to implement pseudomultitasking. In this case, Interrupt 0 does not return until after Interrupts 1, 2, and 3.
Build a Program for Multitasking Execution

To use multitasking execution, select the **Treat each discrete rate as a separate task** check box on the **Solver** pane of the Configuration Parameters dialog box. This menu is active only if you select **Fixed-step** as the solver type. **Auto** mode results in a multitasking environment if your model has two or more different sample times. A model with a continuous and a discrete sample time runs in single-tasking mode if the fixed-step size is equal to the discrete sample time.

Execute Multitasking Models

In cases where the continuous part of a model executes at a rate that is different from the discrete part, or a model has blocks with different sample rates, the Simulink engine assigns each block a **task identifier** (tid) to associate the block with the task that executes at the block's sample rate.
You set sample rates and their constraints on the **Solver** pane of the Configuration Parameters dialog box. To generate code, select **Fixed-step** for the solver type. Certain restrictions apply to the sample rates that you can use:

- The sample rate of a block must be an integer multiple of the base (that is, the fastest) sample period.

- When **Periodic sample time constraint** is unconstrained, the base sample period is determined by the **Fixed step size** specified on the **Solvers** pane of the Configuration parameters dialog box.

- When **Periodic sample time constraint** is Specified, the base rate fixed-step size is the first element of the sample time matrix that you specify in the companion option **Sample time properties**. The **Solver** pane from the example model `rtwdemo_mrmrmtbb` shows an example.
- Continuous blocks execute by using an integration algorithm that runs at the base sample rate. The base sample period is the greatest common denominator of all rates in the model only when **Periodic sample time constraint** is set to **Unconstrained** and **Fixed step size** is **Auto**.

- The continuous and discrete parts of the model can execute at different rates only if the discrete part is executed at the same or a slower rate than the continuous part and is an integer multiple of the base sample rate.

**Multitasking Execution**

This example examines how a simple multirate model executes in both real time and simulation, using a fixed-step solver. It considers operation in both single-tasking and multitasking modes, as determined by setting of the **Treat each discrete rate as a separate task** parameter on the **Solver** pane.

The example model is shown in the next figure. The discussion refers to the six blocks of the model as A through F, as labeled in the block diagram.

The execution order of the blocks (indicated in the upper right of each block) has been forced into the order shown by assigning higher priorities to blocks F, E, and D. The ordering shown is one possible valid execution ordering for this model. For more information, see “Simulation Phases in Dynamic Systems” (Simulink).

The execution order is determined by data dependencies between blocks. In a real-time system, the execution order determines the order in which blocks execute within a given time interval or task. This discussion treats the model's execution order as a given, because it is concerned with the allocation of block computations to tasks, and the scheduling of task execution.

![Block Diagram](image)

**Note** The discussion and timing diagrams in this section are based on the assumption that the Rate Transition blocks are used in the default (protected/deterministic) mode,
with the **Ensure data integrity during data transfer** and **Ensure deterministic data transfer (maximum delay)** options on.

This example considers the execution of the above model when the solver **Tasking mode** is **MultiTasking**. Block computations are executed under two tasks, prioritized by rate:

- The slower task, which gets the lower priority, is scheduled to run every second. This is called the **1 second task**.
- The faster task, which gets higher priority, is scheduled to run 10 times per second. This is called the **0.1 second task**. The 0.1 second task can preempt the 1 second task.

The following table shows, for each block in the model, the execution order, the task under which the block runs, and whether the block has an output or update computation. Blocks A and B do not have discrete states, and accordingly do not have an update computation.
### Task Allocation of Blocks in Multitasking Execution

<table>
<thead>
<tr>
<th>Blocks (in Execution Order)</th>
<th>Task</th>
<th>Output</th>
<th>Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>E</td>
<td>0.1 second task</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>F</td>
<td>0.1 second task</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>D</td>
<td>The Rate Transition block uses port-based sample times. Output runs at the output port sample time under 0.1 second task. Update runs at input port sample time under 1 second task. For more information on port-based sample times, see “Referenced Model Sample Times” (Simulink).</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>A</td>
<td>0.1 second task</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>B</td>
<td>The Rate Transition block uses port-based sample times. Output runs at the output port sample time under 0.1 second task. For more information on port-based sample times, see “Referenced Model Sample Times” (Simulink).</td>
<td>Y</td>
<td>N</td>
</tr>
<tr>
<td>C</td>
<td>1 second task</td>
<td>Y</td>
<td>Y</td>
</tr>
</tbody>
</table>

### Real-Time Multitasking Execution

The next figure shows the scheduling of computations in MultiTasking solver mode when the generated code is deployed in a real-time system. The generated program is shown running in real time, as two tasks under control of interrupts from a 10 Hz timer.
Simulated Multitasking Execution

The next figure shows the Simulink execution of the same model, in MultiTasking solver mode. In this case, the Simulink engine runs the blocks in one thread of execution, simulating multitasking. No preemption occurs.
See Also

More About

- “Time-Based Scheduling and Code Generation” on page 4-2
- “Sample Times in Subsystems” (Simulink)
- “Sample Times in Systems” (Simulink)
- “Configure Time-Based Scheduling” on page 4-37
- “Resolve Rate Transitions” (Simulink)
- “Handle Rate Transitions” on page 4-21
- “Time-Based Scheduling Example Models” on page 4-39
Handle Rate Transitions

Rate Transitions

Two periodic sample rate transitions can exist within a model:

- A faster block driving a slower block
- A slower block driving a faster block

The following sections concern models with periodic sample times with zero offset only. Other considerations apply to multirate models that involve asynchronous tasks. For details on how to generate code for asynchronous multitasking, see “Asynchronous Support” on page 5-2.

In multitasking and pseudomultitasking systems, differing sample rates can cause blocks to be executed in the wrong order. To prevent possible errors in calculated data, you must control model execution at these transitions. When connecting faster and slower blocks, you or the Simulink engine must add Rate Transition blocks between them. Fast-to-slow transitions are illustrated in the next figure.

![Fast-to-Slow Transition Diagram](image)

Slow-to-fast transitions are illustrated in the next figure.
Note Although the Rate Transition block offers a superset of the capabilities of the Unit Delay block (for slow-to-fast transitions) and the Zero-Order Hold block (for fast-to-slow transitions), you should use the Rate Transition block instead of these blocks.

Data Transfer Problems

Rate Transition blocks deal with issues of data integrity and determinism associated with data transfer between blocks running at different rates.

- Data integrity: A problem of data integrity exists when the input to a block changes during the execution of that block. Data integrity problems can be caused by preemption.

Consider the following scenario:

- A faster block supplies the input to a slower block.
- The slower block reads an input value $V_1$ from the faster block and begins computations using that value.
- The computations are preempted by another execution of the faster block, which computes a new output value $V_2$.
- A data integrity problem now arises: when the slower block resumes execution, it continues its computations, now using the “new” input value $V_2$.
Such a data transfer is called *unprotected*. “Faster to Slower Transitions in Real Time” on page 4-30 shows an unprotected data transfer.

In a *protected* data transfer, the output $V_1$ of the faster block is held until the slower block finishes executing.

- **Deterministic versus nondeterministic data transfer:** In a *deterministic* data transfer, the timing of the data transfer is completely predictable, as determined by the sample rates of the blocks.

  The timing of a *nondeterministic* data transfer depends on the availability of data, the sample rates of the blocks, and the time at which the receiving block begins to execute relative to the driving block.

You can use the Rate Transition block to protect data transfers in your application and make them deterministic. These characteristics are considered desirable in most applications. However, the Rate Transition block supports flexible options that allow you to compromise data integrity and determinism in favor of lower latency. The next section summarizes these options.

**Data Transfer Assumptions**

When processing data transfers between tasks, the code generator makes these assumptions:

- Data transitions occur between a single reading task and a single writing task.
- A read or write of a byte-sized variable is atomic.
- When two tasks interact through a data transition, only one of them can preempt the other.
- For periodic tasks, the faster rate task has higher priority than the slower rate task; the faster rate task preempts the slower rate task.
- All tasks run on a single processor. Time slicing is not allowed.
- Processes do not crash or restart (especially while data is transferred between tasks).

**Rate Transition Block Options**

Several parameters of the Rate Transition block are relevant to its use in code generation for real-time execution, as discussed below. For a complete block description, see Rate Transition.
The Rate Transition block handles periodic (fast to slow and slow to fast) and asynchronous transitions. When inserted between two blocks of differing sample rates, the Rate Transition block automatically configures its input and output sample rates for the type of transition; you do not need to specify whether a transition is slow-to-fast or fast-to-slow (low-to-high or high-to-low priorities for asynchronous tasks).

The critical decision you must make in configuring a Rate Transition block is the choice of data transfer mechanism to be used between the two rates. Your choice is dictated by considerations of safety, memory usage, and performance. As the Rate Transition block parameter dialog box in the next figure shows, the data transfer mechanism is controlled by two options.

- **Ensure data integrity during data transfer**: When this option is on, data transferred between rates maintains its integrity (the data transfer is protected).
When this option is off, the data might not maintain its integrity (the data transfer is unprotected). By default, **Ensure data integrity during data transfer** is on.

- **Ensure deterministic data transfer (maximum delay):** This option is supported for periodic tasks with an offset of zero and fast and slow rates that are multiples of each other. Enable this option for protected data transfers (when **Ensure data integrity during data transfer** is on). When this option is on, the Rate Transition block behaves like a Zero-Order Hold block (for fast to slow transitions) or a Unit Delay block (for slow to fast transitions). The Rate Transition block controls the timing of data transfer in a completely predictable way. When this option is off, the data transfer is nondeterministic. By default, **Ensure deterministic data transfer (maximum delay)** is on for transitions between periodic rates with an offset of zero; for asynchronous transitions, it cannot be selected.

Thus the Rate Transition block offers three modes of operation with respect to data transfer. In order of level of safety:

- **Protected/Deterministic (default):** This is the safest mode. The drawback of this mode is that it introduces deterministic latency into the system for the case of slow-to-fast periodic rate transitions. For that case, the latency introduced by the Rate Transition block is one sample period of the slower task. For the case of fast-to-slow periodic rate transitions, the Rate Transition block introduces no additional latency.

- **Protected/NonDeterministic:** In this mode, for slow-to-fast periodic rate transitions, data integrity is protected by double-buffering data transferred between rates. For fast-to-slow periodic rate transitions, a semaphore flag is used. The blocks downstream from the Rate Transition block use the latest available data from the block that drives the Rate Transition block. Maximum latency is less than or equal to one sample period of the faster task.

The drawbacks of this mode are its nondeterministic timing. The advantage of this mode is its low latency.

- **Unprotected/NonDeterministic:** This mode is not recommended for mission-critical applications. The latency of this mode is the same as for Protected/NonDeterministic mode, but memory requirements are reduced since neither double-buffering nor semaphores are required. That is, the Rate Transition block does nothing in this mode other than to pass signals through; it simply exists to notify you that a rate transition exists (and can cause generated code to compute incorrect answers). Selecting this mode, however, generates the least amount of code.
In unprotected mode (Ensure data integrity during data transfer option off), the Rate Transition block does nothing other than allow the rate transition to exist in the model.

**Rate Transition Blocks and Continuous Time**

The sample time at the output port of a Rate Transition block can only be discrete or fixed in minor time step. This means that when a Rate Transition block inherits continuous sample time from its destination block, it treats the inherited sample time as Fixed in Minor Time Step. Therefore, the output function of the Rate Transition block runs only at major time steps. If the destination block sample time is continuous, Rate Transition block output sample time is the base rate sample time (if solver is fixed-step), or zero-order-hold-continuous sample time (if solver is variable-step).

**Automatic Rate Transition**

The Simulink engine can detect mismatched rate transitions in a multitasking model during an update diagram and automatically insert Rate Transition blocks to handle them. To enable this, in the **Solver** pane of model configuration parameters, select **Automatically handle rate transition for data transfer**. The default setting for this option is off. When you select this option:

- Simulink handles transitions between periodic sample times and asynchronous tasks.
- Simulink inserts hidden Rate Transition blocks in the block diagram.
- The code generator produces code for the Rate Transition blocks that were automatically inserted. This code is identical to the code generated for Rate Transition blocks that were inserted manually.
- Automatically inserted Rate Transition blocks operate in protected mode for periodic tasks and asynchronous tasks. You cannot alter this behavior. For periodic tasks, automatically inserted Rate Transition blocks operate with the level of determinism specified by the **Deterministic data transfer** parameter in the **Solver** pane. The default setting is Whenever possible, which enables determinism for data transfers between periodic sample-times that are related by an integer multiple. For more information, see “Deterministic data transfer” (Simulink). To use other modes, you must insert Rate Transition blocks and set their modes manually.

For example, in this model, SineWave2 has a sample time of 2, and SineWave3 has a sample time of 3.
When you select **Automatically handle rate transition for data transfer**, Simulink inserts a Rate Transition block between each Sine Wave block and the Product block. The inserted blocks have the parameter values to reconcile the Sine Wave block sample times.

If the input port and output port data sample rates in a model are not multiples of each other, Simulink inserts a Rate Transition block whose sample rate is the greatest common divisor (GCD) of the two rates. If no other block in the model contains this new rate, an error occurs during simulation. In this case, you must insert a Rate Transition block manually.

**Visualize Inserted Rate Transition Blocks**

When you select the **Automatically handle rate transition for data transfer** option, Simulink inserts Rate Transition blocks in the paths that have mismatched transition rates. These blocks are hidden by default. To visualize the inserted blocks, update the diagram. Badge labels appear in the model and indicate where Simulink inserted Rate Transition blocks during the compilation phase. For example, in this model, three Rate Transition blocks were inserted between the two Sine Wave blocks and the Multiplexer and Integrator when the model compiled. The ZOH and DbBuf badge labels indicate these blocks.
You can show or hide badge labels using the **Display > Signals and Ports > Hidden Rate Transition Block Indicators** setting.

To configure the hidden Rate Transition blocks, right click on a badge label and click on **Insert rate transition block** to make the block visible.

When you make hidden Rate Transition blocks visible:

- You can see the type of Rate Transition block inserted as well as the location in the model.
• You can set the **Initial Conditions** of these blocks.
• You can change block parameters for rate transfer.

Validate the changes to your model by updating your diagram.

Displaying inserted Rate Transition blocks is not compatible with:

• Concurrent execution environment
• Export-function models

To learn more about the types of Rate Transition blocks, see Rate Transition.

**Periodic Sample Rate Transitions**

These sections describe cases in which Rate Transition blocks are required for periodic sample rate transitions. The discussion and timing diagrams in these sections are based on the assumption that the Rate Transition block is used in its default (protected/deterministic) mode; that is, the **Ensure data integrity during data transfer** and **Ensure deterministic data transfer (maximum delay)** options are both on. These are the settings used for automatically inserted Rate Transition blocks.

**Faster to Slower Transitions in a Simulink Model**

In a model where a faster block drives a slower block having direct feedthrough, the outputs of the faster block are computed first. In simulation intervals where the slower
A Simulink simulation does not execute in real time, which means that it is not bound by real-time constraints. The simulation waits for, or moves ahead to, whatever tasks are required to complete simulation flow. The actual time interval between sample time steps can vary.

**Faster to Slower Transitions in Real Time**

In models where a faster block drives a slower block, you must compensate for the fact that execution of the slower block might span more than one execution period of the faster block. This means that the outputs of the faster block can change before the slower block has finished computing its outputs. The next figure shows a situation in which this problem arises ($T = \text{sample time}$). Note that lower priority tasks are preempted by higher priority tasks before completion.

1. The faster task ($T=1s$) completes.
2. Higher priority preemption occurs.
3. The slower task ($T=2s$) resumes and its inputs have changed. This leads to unpredictable results.
In the above figure, the faster block executes a second time before the slower block has completed execution. This can cause unpredictable results because the input data to the slow task is changing. Data might not maintain its integrity in this situation.

To avoid this situation, the Simulink engine must hold the outputs of the 1 second (faster) block until the 2 second (slower) block finishes executing. The way to accomplish this is by inserting a Rate Transition block between the 1 second and 2 second blocks. The input to the slower block does not change during its execution, maintaining data integrity.

It is assumed that the Rate Transition block is used in its default (protected/deterministic) mode.

The Rate Transition block executes at the sample rate of the slower block, but with the priority of the faster block.

When you add a Rate Transition block, the block executes before the 2 second block (its priority is higher) and its output value is held constant while the 2 second block executes (it executes at the slower sample rate).
**Slower to Faster Transitions in a Simulink Model**

In a model where a slower block drives a faster block, the Simulink engine again computes the output of the driving block first. During sample intervals where only the faster block executes, the simulation progresses more rapidly.

The next figure shows the execution sequence.

As you can see from the preceding figures, the Simulink engine can simulate models with multiple sample rates in an efficient manner. However, a Simulink simulation does not operate in real time.

**Slower to Faster Transitions in Real Time**

In models where a slower block drives a faster block, the generated code assigns the faster block a higher priority than the slower block. This means the faster block is executed before the slower block, which requires special care to avoid incorrect results.

1. The faster block executes a second time prior to the completion of the slower block.
2. The faster block executes before the slower block.
This timing diagram illustrates two problems:

- Execution of the slower block is split over more than one faster block interval. In this case the faster task executes a second time before the slower task has completed execution. This means the inputs to the faster task can have incorrect values some of the time.
- The faster block executes before the slower block (which is backward from the way a Simulink simulation operates). In this case, the 1 second block executes first; but the inputs to the faster task have not been computed. This can cause unpredictable results.

To eliminate these problems, you must insert a Rate Transition block between the slower and faster blocks.

It is assumed that the Rate Transition block is used in its default (protected/deterministic) mode.

The next figure shows the timing sequence that results with the added Rate Transition block.
Three key points about transitions in this diagram (refer to circled numbers):

1. The Rate Transition block output runs in the 1 second task, but at a slower rate (2 seconds). The output of the Rate Transition block feeds the 1 second task blocks.

2. The Rate Transition update uses the output of the 2 second task to update its internal state.

3. The Rate Transition output in the 1 second task uses the state of the Rate Transition that was updated in the 2 second task.

The first problem is alleviated because the Rate Transition block is updating at a slower rate and at the priority of the slower block. The input to the Rate Transition block (which is the output of the slower block) is read after the slower block completes executing.

The second problem is alleviated because the Rate Transition block executes at a slower rate and its output does not change during the computation of the faster block it is driving. The output portion of a Rate Transition block is executed at the sample rate of the slower block, but with the priority of the faster block. Since the Rate Transition block drives the faster block and has effectively the same priority, it is executed before the faster block.
**Note** This use of the Rate Transition block changes the model. The output of the slower block is now delayed by one time step compared to the output without a Rate Transition block.

### Protect Data Integrity with volatile Keyword

When you select **Ensure data integrity during data transfer**, the code generated for a Rate Transition block defines global buffers and semaphores and uses them to protect the integrity of the transferred data.

Particularly for a multitasking application, the tasks (rates) involved in a data transfer can write to the transferred data, buffers, and semaphores at times that your compiler cannot anticipate. To prevent your compiler from optimizing the assembly code in a manner that compromises the integrity of the transferred data, the code generator applies the keyword `volatile` to the buffers and semaphores. The code generator does not apply `volatile` to the global variable that represents the transferred data because the `volatile` buffers and semaphores typically offer enough protection.

If necessary, with Embedded Coder, you can explicitly apply `volatile` to the transferred data by applying the built-in custom storage class `Volatile` to the input of the Rate Transition block. For example, you can use this technique to help protect the integrity of data that your external code shares with the generated code.

Alternatively, to protect data that your external code shares with the generated code, you can write your own C functions that read and write the data in a protected manner. Then, you can apply the custom storage class `GetSet` to the data in the model, which causes the generated code to call your functions instead of directly accessing the data.

For more information about applying `volatile`, see “Protect Global Data with const and volatile Type Qualifiers” (Embedded Coder). For more information about `GetSet`, see “Access Data Through Functions with Custom Storage Class GetSet” (Embedded Coder).

### Separate Rate Transition Block Code and Data from Algorithm Code and Data

By default, Rate Transition block code is set inline with algorithm code and data. If you have Embedded Coder, you can separate the code and data, so that the generated code contains separate `get` and `set` functions that the `model_step` functions call and a dedicated structure for state data. The generated code also contains separate `start` and
initialize functions that the model_initialize function calls. To separate Rate Transition block code and data from algorithm code and data, in the Configuration Parameters dialog box, set the Rate Transition block code parameter to Function.

Separating Rate Transition block code and data from algorithm code and data enables you to analyze, optimize, and test Rate Transition block and algorithm code independently from each other.

See Also

More About

- “Time-Based Scheduling and Code Generation” on page 4-2
- “Sample Times in Subsystems” (Simulink)
- “Sample Times in Systems” (Simulink)
- “Modeling for Multitasking Execution” on page 4-12
- “Configure Time-Based Scheduling” on page 4-37
- “Resolve Rate Transitions” (Simulink)
- “Time-Based Scheduling Example Models” on page 4-39
Configure Time-Based Scheduling

For details about solver options, see “Solver Pane” (Simulink).

Configure Start and Stop Times

The Stop time (Simulink) must be greater than or equal to the Start time (Simulink). If the stop time is zero, or if the total simulation time (Stop minus Start) is less than zero, the generated program runs for one step. If the stop time is set to inf, the generated program runs indefinitely.

When using the GRT or ERT targets, you can override the stop time when running a generated program from the Microsoft Windows command prompt or UNIX command line. To override the stop time that was set during code generation, use the -tf switch.

model -tf n

The program runs for n seconds. If n = inf, the program runs indefinitely.

Certain blocks have a dependency on absolute time. If you are designing a program that is intended to run indefinitely (Stop time = inf), and your generated code does not use the rtModel data structure (that is, it uses simstructs instead), you must not use these blocks. See “Absolute Time Limitations” on page 3-12 for a list of blocks that can potentially overflow timers.

If you know how long an application that depends on absolute time needs to run, you can prevent the timers from overflowing and force the use of optimal word sizes by specifying the Application lifespan (days) (Simulink) parameter on the Math and Data Types pane. See “Control Memory Allocation for Time Counters” on page 33-11 for details.

Configure the Solver Type

For code generation, you must configure a model to use a fixed-step solver for all targets except the S-function and RSIm targets. You can configure the S-function and RSIm targets with a fixed-step or variable-step solver.

---

1. UNIX is a registered trademark of The Open Group in the United States and other countries.
Configure the Tasking Mode

The code generator supports both single-tasking and multitasking modes for periodic sample times. See “Time-Based Scheduling and Code Generation” on page 4-2 for details.

See Also

More About

• “Time-Based Scheduling and Code Generation” on page 4-2
• “Sample Times in Subsystems” (Simulink)
• “Sample Times in Systems” (Simulink)
• “Time-Based Scheduling Example Models” on page 4-39
Time-Based Scheduling Example Models

Optimize Memory Usage for Time Counters

This example shows how to optimize the amount of memory that the code generator allocates for time counters. The example optimizes the memory that stores elapsed time, the interval of time between two events.

The code generator represents time counters as unsigned integers. The word size of time counters is based on the setting of the model configuration parameter `Application lifespan (days)`, which specifies the expected maximum duration of time the application runs. You can use this parameter to prevent time counter overflows. The default size is 64 bits.

The number of bits that a time counter uses depends on the setting of the `Application lifespan (days)` parameter. For example, if a time counter increments at a rate of 1 kHz, to avoid an overflow, the counter has the following number of bits:

- Lifespan < 0.25 sec: 8 bits
- Lifespan < 1 min: 16 bits
- Lifespan < 49 days: 32 bits
- Lifespan > 50 days: 64 bits

A 64-bit time counter does not overflow for 590 million years.

Open Example Model

Open the example model `rtwdemo_abstime`. 
The model consists of three subsystems SS1, SS2, and SS3. On the Math and Data Types pane, the Application lifespan (days) parameter is set to the default, which is inf.
The three subsystems contain a discrete-time integrator that requires elapsed time as input to compute its output value. The subsystems vary as follows:

- **SS1** - Clocked at 1 kHz. Does not require a time counter. **Sample time type** parameter for trigger port is set to periodic. Elapsed time is inlined as 0.001.
- **SS2** - Clocked at 100 Hz. Requires a time counter. Based on a lifespan of 1 day, a 32-bit counter stores the elapsed time.
- **SS3** - Clocked at 0.5 Hz. Requires a time counter. Based on a lifespan of 1 day, a 16-bit counter stores the elapsed time.

**Simulate the Model**

Simulate the model. By default, the model is configured to show sample times in different colors. Discrete sample times for the three subsystems appear red, green, and blue. Triggered subsystems are blue-green.

**Generate Code and Report**

1. Create a temporary folder for the build and inspection process.

2. Configure the model for the code generator to use the GRT system target file and a lifespan of inf days.

3. Build the model.

```plaintext
### Starting build procedure for model: rtwdemo_abstime
### Successful completion of build procedure for model: rtwdemo_abstime
```

**Review Generated Code**

Open the generated source file `rtwdemo_abstime.c`.

```c
struct tag_RTM_rtwdemo_abstime_T {
    const char_T *errorStatus;

    /*
     * Timing:
     * The following substructure contains information regarding
     * the timing information for the model.
     */
    struct {
        uint32_T clockTick1;
```
```c
uint32_T clockTickH1;
uint32_T clockTick2;
uint32_T clockTickH2;
struct {
    uint16_T TID[3];
    uint16_T cLimit[3];
} TaskCounters;
};

/* Block states (default storage) */
extern DW_rtwdemo_abstime_T rtwdemo_abstime_DW;

/* External inputs (root inport signals with default storage) */
extern ExtU_rtwdemo_abstime_T rtwdemo_abstime_U;

/* External outputs (root outports fed by signals with default storage) */
extern ExtY_rtwdemo_abstime_T rtwdemo_abstime_Y;

/* Model entry point functions */
extern void rtwdemo_abstime_initialize(void);
extern void rtwdemo_abstime_step(int_T tid);
extern void rtwdemo_abstime_terminate(void);

/* Real-time Model object */
extern RT_MODEL_rtwdemo_abstime_T *const rtwdemo_abstime_M;

/* The generated code includes comments that allow you to trace directly
back to the appropriate location in the model. The basic format
is <system>/block_name, where system is the system number (uniquely
assigned by Simulink) and block_name is the name of the block.

Use the MATLAB hilite_system command to trace the generated code back
to the model. For example,

hilite_system('<S3>')    - opens system 3
hilite_system('<S3>/Kp') - opens and selects block Kp which resides in S3

Here is the system hierarchy for this model

'<Root>' : 'rtwdemo_abstime'
'<S1>' : 'rtwdemo_abstime/SS1'
'(<S2>' : 'rtwdemo_abstime/SS2'
```

4-42
Four 32-bit unsigned integers, `clockTick1`, `clockTickH1`, `clockTick2`, and `clockTickH2` are counters for storing the elapsed time of subsystems SS2 and SS3.

**Enable Optimization and Regenerate Code**

1. Reconfigure the model to set the lifespan to 1 day.

2. Build the model.

```bash
### Starting build procedure for model: rtwdemo_abstime
### Successful completion of build procedure for model: rtwdemo_abstime
```

**Review the Regenerated Code**

```c
struct tag_RTM_rtwdemo_abstime_T {
    const char_T *errorStatus;

    /*
     * Timing:
     * The following substructure contains information regarding
     * the timing information for the model.
     */
    struct {
        uint32_T clockTick1;
        uint16_T clockTick2;
        struct {
            uint16_T TID[3];
            uint16_T cLimit[3];
        } TaskCounters;
    } Timing;

    /* Block states (default storage) */
    extern DW_rtwdemo_abstime_T rtwdemo_abstime_DW;

    /* External inputs (root inport signals with default storage) */
    extern ExtU_rtwdemo_abstime_T rtwdemo_abstime_U;

    /* External outputs (root outports fed by signals with default storage) */
    extern ExtY_rtwdemo_abstime_T rtwdemo_abstime_Y;
```
/* Model entry point functions */
extern void rtwdemo_abstime_initialize(void);
extern void rtwdemo_abstime_step(int_T tid);
extern void rtwdemo_abstime_terminate(void);

/* Real-time Model object */
extern RT_MODEL_rtwdemo_abstime_T *const rtwdemo_abstime_M;

/*-
* The generated code includes comments that allow you to trace directly
* back to the appropriate location in the model. The basic format
* is <system>/block_name, where system is the system number (uniquely
* assigned by Simulink) and block_name is the name of the block.
*
* Use the MATLAB hilite_system command to trace the generated code back
* to the model. For example,
*
* hilite_system('<S3>') - opens system 3
* hilite_system('<S3>/Kp') - opens and selects block Kp which resides in S3
*
* Here is the system hierarchy for this model
*
* '<Root>' : 'rtwdemo_abstime'
* '<S1>'   : 'rtwdemo_abstime/SS1'
* '<S2>'   : 'rtwdemo_abstime/SS2'
* '<S3>'   : 'rtwdemo_abstime/SS3'
*/
#endif                                 /* RTW_HEADER_rtwdemo_abstime_h_ */

The new setting for the Application lifespan (days) parameter instructs the code
generator to set aside less memory for the time counters. The regenerated code includes:

- 32-bit unsigned integer, clockTick1, for storing the elapsed time of the task for SS2
- 16-bit unsigned integer, clockTick2, for storing the elapsed time of the task for SS3

Related Information

- “Model Configuration Parameters: Code Generation Optimization”
- “Timers in Asynchronous Tasks” on page 5-42
• “Time-Based Scheduling and Code Generation” on page 4-2

**Single-Rate Modeling (Bare Board, No OS)**

This model shows code generation for a single-rate discrete-time model configured for a bare-board target (one with no operating system).

**Open Example Model**

Open the example model `rtwdemo_srbb`.

```matlab
open_system('rtwdemo_srbb')
```
The model uses one sample time and is configured to display sample-time colors when an update diagram occurs. Input blocks In1_1s and In2_1s specify a 1-second sample time, which is enforced by the model configuration parameter Periodic sample time constraint. To view Periodic sample time constraint and related parameters on the Solver pane of the Model Configuration Parameters dialog box, double-click the yellow button labeled View Solver Configuration. To verify use of one sample time, double-click the yellow button labeled Display Sample Time Colors. Because the model is configured with one sample time, the model appears red, which is the color that represents the fastest discrete sample time in the model.
click the yellow button labeled **Display Sample Time Colors**. Because the model is configured with one sample time, the model appears red, which is the color that represents the fastest discrete sample time in the model.

**Multirate Modeling in Single-Tasking Mode (Bare Board, no OS)**

This model shows the code generated for a multirate discrete-time model configured for single-tasking on a bare-board target (one with no operating system).

**Open Example Model**

Open the example model `rtwdemo_mrstbb`.

```matlab
open_system('rtwdemo_mrstbb')
```
The model is configured to display sample-time colors upon diagram update. Red represents the fastest discrete sample time in the model, green represents the second fastest, and yellow represents mixed sample times. Click the yellow button to the right to update the diagram and show sample-time colors.

This model shows the code generated for a multirate discrete-time model configured for single-tasking on a bare-board target (one with no operating system). The model contains two sample times. Inport block 1 and Inport block 2 specify 1-second and 2-second sample times, respectively, which are enforced by the "Periodic sample time constraint" option on the Solver configuration page. The solver is set for single-tasking operation. Rate transition blocks are, therefore, not necessary between blocks executing at different sample times because preemption will not occur.

Generate Code Using Simulink Coder (double-click)
Generate Code Using Embedded Coder (double-click)
View Solver Configuration (double-click)
The model contains two sample times. Inport block 1 and Inport block 2 specify 1-second and 2-second sample times, respectively, which are enforced by the **Periodic sample time constraint** option on the **Solver** configuration page. The solver is set for single-tasking operation. Rate transition blocks are, therefore, not necessary between blocks executing at different sample times because preemption will not occur.

The model is configured to display sample-time colors upon diagram update. Red represents the fastest discrete sample time in the model, green represents the second fastest, and yellow represents mixed sample times. Double-click the yellow button in the model to update the diagram and show sample-time colors.

**Multirate Modeling in Multitasking Mode (Bare Board, no OS)**

This model shows the code generated for a multirate discrete-time model configured for a multitasking bare-board target (one with no operating system).

**Open Example Model**

Open the example model `rtwdemo_mrmtbb`.

```
open_system('rtwdemo_mrmtbb')
```
The model is configured to display sample-time colors upon diagram update. Red represents the fastest discrete sample time in the model, green represents the second fastest, and yellow represents mixed sample times. Click the yellow button to the right to update the diagram and show sample-time colors.

This model shows the code generated for a multirate discrete-time model configured for a multitasking bare-board target (one with no operating system). The model contains two sample times. Inport block 1 and Inport block 2 specify 1-second and 2-second sample times, respectively, which are enforced by the "Periodic sample time constraint" option on the Solver configuration page. The solver is set for multitasking operation, which means a rate transition block is required to ensure that data integrity is enforced when the 1-second task preempts the 2-second task. Proper rate transitions are always enforced by Simulink and Simulink Coder. This model specifies an explicit rate transition block. Alternatively, this block could be automatically inserted by Simulink using the "Automatically handle data transfers between tasks" option on the Solver configuration page.
Explore Example Model

The model contains two sample times. Inport block 1 and Inport block 2 specify 1-second and 2-second sample times, respectively, which are enforced by the Periodic sample time constraint option on the Solver configuration page. The solver is set for multitasking operation, which means a rate transition block is required to ensure that data integrity is enforced when the 1-second task preempts the 2-second task. Proper rate transitions are always enforced by Simulink and Simulink Coder. This model specifies an explicit rate transition block. Alternatively, this block could be automatically inserted by Simulink using the model configuration parameter Automatically handle rate transition for data transfer.

The model is configured to display sample-time colors upon diagram update. Red represents the fastest discrete sample time in the model, green represents the second fastest, and yellow represents mixed sample times. Click the yellow button to the right to update the diagram and show sample-time colors.

Data Transfer Assumptions

Basis of operation for data transfers between tasks:

1. Data transitions occur between a single reading task and a single writing task.
2. A read or write of a byte sized variable is atomic.
3. When two tasks interact through a data transition, only one of them can preempt the other.
4. For periodic tasks, the faster rate task has higher priority than the slower rate task; the faster rate task always preempts the slower rate task.
5. All tasks run on a single processor. Time slicing is not allowed.
6. Processes do not crash/restart (especially while data is being transferred between tasks)

Trade Determinism and Data Integrity to Improve System Performance

This model shows the differences in the operation modes of the Rate Transition block when used in a multirate, multitasking model. The flexible options for the Rate Transition block allow you to select the mode that is best suited for your application. You can trade levels of determinism and data integrity to improve system performance.
Rate Transition Block Modes of Operation

**Ensure data integrity and determinism (DetAndInteg)**: Data is transferred such that all data bytes for the signal (including all elements of a wide signal) are from the same time step. Additionally, it is ensured that the relative sample time (delay) from which the data is transferred from one rate to another is always the same. Only ANSI-C code is used, no target specific 'critical section' protection is needed.

**Ensure integrity (IntegOnly)**: Data is transferred such that all data bytes for the signal (including all elements of a wide signal) are from the same time step. However, from one transfer of data to the next, the relative sample time (delay) for which the data is transferred can vary. In this mode, the code to read/write the data is run more often than in the DetAndInt mode. In the worst case, the delay is equivalent to the DetAndInt mode, but the delay can be less which is important in some applications. Also, this mode supports data transfers to/from asynchronous rates which the DetAndInt mode cannot support. Only ANSI-C code is used, no target specific 'critical section' protection is needed.

**No data consistency operations are performed (None)**: For this case, the Rate Transition block does not generate code. This mode is acceptable in some applications where atomic access of scalar data types is guaranteed and when the relative temporal values of the data is not important. This mode does not introduce any delay.

Data Transfer Assumptions

Basis of operation for data transfers between tasks:

- Data transitions occur between a single reading task and a single writing task.
- A read or write of a byte sized variable is atomic.
- When two tasks interact through a data transition, only one of them can preempt the other.
- For periodic tasks, the faster rate task has higher priority than the slower rate task; the faster rate task always preempts the slower rate task.
- All tasks run on a single processor. Time slicing is not allowed.
- Processes do not crash/restart (especially while data is being transferred between tasks)

**Model rtwdemo_ratetrans**

```matlab
open_system('rtwdemo_ratetrans')
```
This model shows the differences in the operation modes of the Rate Transition block when used in a multirate, multitasking model. The flexible options for the Rate Transition block allow you to select the mode that is best suited for your application. You can trade levels of determinism and data integrity to improve system performance.
Model `rtwdemo_ratetrans` shows the differences in the operation modes of the following Rate Transition blocks.

**Rate Transition block DetAndIntegF2S**

Determinism and data integrity (fast to slow transition):

- The block output is used as a persistent data buffer.
- Data is written to output at slower rate but done during the faster rate context.
- Data as seen by the slower rate is always the value when both the faster and slower rate last executed. Any subsequent steps by the faster rate (and associated data updates) while the slower rate is running are not seen by the slower rate.

**Rate Transition block DetAndIntegS2F**

Determinism and data integrity (slow to fast transition):

- Uses two persistent data buffers, an internal buffer and the blocks output.
- The internal buffer is copied to the output at the slower rate but done during the faster rate context.
- The internal buffer is written at the slower rate and during the slower rate context.
- The data that Fast rate sees is always delayed, i.e. data is from the previous step of the slow rate code.

**Rate Transition block IntegOnlyF2S**

Data integrity only (fast to slow transition):

- The block output is used as a persistent data buffer.
- Data is written to buffer during the faster rate context if a flag indicates it not in the process of being read.
- The flag is set and data is copied from the buffer to output at the slow rate, the flag is then cleared. This is an additional copy as compared to the deterministic case.
- Data as seen by the slower rate can be from a more recent step of the faster rate than from when the slower rate and faster rate both executed.

**Rate Transition block IntegOnlyS2F**

Data integrity only (slow to fast transition):
• Uses two persistent data buffers, both are internal buffers.
• One of the 2 buffers is always copied to the output at faster rate.
• One of the 2 buffers is written at the slower rate and during the slower rate context, then the active buffer is switched.
• The data as seen by the faster rate can be more recent than for the deterministic case. Specifically, when both the slower and faster rate have their hits, the faster rate will see a previous value from the slower rate. But, subsequent steps for the faster rate may see an updated value (when the slower rate updates the non-active buffer and switches the active buffer flag.

**Rate Transition block NoneF2S**

No code is generated for the Rate Transition block when determinism and data integrity is waived.

**Rate Transition block NoneS2F**

No code is generated for the Rate Transition block when determinism and data integrity is waived.

```matlab
bdclose('rtwdemo_ratetrans');
```

**See Also**

**More About**

• “Time-Based Scheduling and Code Generation” on page 4-2
• “Modeling for Single-Tasking Execution” on page 4-8
• “Modeling for Multitasking Execution” on page 4-12
Event-Based Scheduling in Simulink Coder

- “Asynchronous Events” on page 5-2
- “Generate Interrupt Service Routines” on page 5-6
- “Spawn and Synchronize Execution of RTOS Task” on page 5-15
- “Pass Asynchronous Events in RTOS as Input To a Referenced Model” on page 5-32
- “Rate Transitions and Asynchronous Blocks” on page 5-36
- “Timers in Asynchronous Tasks” on page 5-42
- “Create a Customized Asynchronous Library” on page 5-45
- “Import Asynchronous Event Data for Simulation” on page 5-54
- “Asynchronous Support Limitations” on page 5-58
Asynchronous Events

Asynchronous Support

Normally, you time models from which you plan to generate code from a periodic interrupt source (for example, a hardware timer). Blocks in a periodically clocked single-rate model run at a timer interrupt rate (the base rate of the model). Blocks in a periodically clocked multirate model run at the base rate or at multiples of that rate.

Many systems must also support execution of blocks in response to events that are asynchronous with respect to the periodic timing source of the system. For example, a peripheral device might signal completion of an input operation by generating an interrupt. The system must service such interrupts, for example, by acquiring data from the interrupting device.

This chapter explains how to use blocks to model and generate code for asynchronous event handling, including servicing of hardware-generated interrupts, maintenance of timers, asynchronous read and write operations, and spawning of asynchronous tasks under a real-time operating system (RTOS). This block library demonstrates integration with an example RTOS (VxWorks®). Although the blocks target an example RTOS, this chapter provides source code analysis and other information you can use to develop blocks that support asynchronous event handling for an alternative target RTOS.²

Block Library for Calls to an Example Real-Time Operating System

The next figure shows the blocks in the vxlib1 block library.

². VxWorks is a registered trademark of Wind River® Systems, Inc.
The key blocks in the library are the Async Interrupt and Task Sync blocks. These blocks are targeted for an example RTOS (VxWorks). You can use them, with modification, to support your RTOS applications.

**Note** You can use the blocks in the vxlib1 on page 5-2 library (Async Interrupt and Task Sync) for simulation and code generation. These blocks provide starting point examples to help you develop custom blocks for your target environment.

To implement asynchronous support for an RTOS other than the example RTOS, use the guidelines and example code are provided to help you adapt the vxlib1 library blocks to target your RTOS. This topic is discussed in “Create a Customized Asynchronous Library” on page 5-45.

The vxlib1 library includes blocks you can use to

- Generate interrupt-level code — Async Interrupt block
- Spawn an RTOS task that calls a function call subsystem — Task Sync block
- Enable data integrity when transferring data between blocks running as different tasks — Protected RT block
- Use an unprotected/nondeterministic mode when transferring data between blocks running as different tasks — Unprotected RT block

The use of protected and unprotected Rate Transition blocks in asynchronous contexts is discussed in “Rate Transitions and Asynchronous Blocks” on page 5-36. For general information on rate transitions, see “Time-Based Scheduling and Code Generation” on page 4-2.
Access the Block Library for RTOS Integration

To access the example RTOS (VxWorks) block library, enter the MATLAB command `vxlib1`.

Generate Code Using Library Blocks for RTOS Integration

To generate an example RTOS compatible application from a model containing `vxlib1` library blocks, use the following configuration parameter values for your model.

- Select system target file `ert.tlc` (requires an Embedded Coder license) from the browse menu for the **Code Generation > System target file** parameter (SystemTargetFile).
- Enable the **Configuration Parameters > Code Generation > Generate code only** parameter (GenCodeOnly).
- Enable the **Configuration Parameters > Code Generation > Templates > Custom templates > Generate an example main program** parameter (GenerateSampleERTMain).
- Select **VxWorksExample** from the menu for the **Configuration Parameters > Code Generation > Templates > Custom templates > Target operating system** parameter (TargetOS).

Examples and Additional Information

Additional information relevant to the topics in this chapter can be found in

- The `rtwdemo_async` model, which uses the `tornado.tlc` system target file and `vxlib1` block library. To open this example, type `rtwdemo_async` at the MATLAB command prompt.
- The `rtwdemo_async_mdlreftop` model, which uses the `tornado.tlc` system target file and `vxlib1` block library. To open this example, type `rtwdemo_async_mdlreftop` at the MATLAB command prompt.
- “Time-Based Scheduling and Code Generation” on page 4-2, discusses general multitasking and rate transition issues for periodic models.
- The Embedded Coder documentation discusses the `ert.tlc` system target file, including task execution and scheduling.
• For detailed information about the system calls to the example RTOS (VxWorks) mentioned in this chapter, see VxWorks system documentation on the Wind River website.

See Also

More About

• “Time-Based Scheduling and Code Generation” on page 4-2
• “Generate Interrupt Service Routines” on page 5-6
• “Spawn and Synchronize Execution of RTOS Task” on page 5-15
• “Pass Asynchronous Events in RTOS as Input To a Referenced Model” on page 5-32
• “Timers in Asynchronous Tasks” on page 5-42
• “Import Asynchronous Event Data for Simulation” on page 5-54
• “Rate Transitions and Asynchronous Blocks” on page 5-36
• “Create a Customized Asynchronous Library” on page 5-45
• “Asynchronous Support Limitations” on page 5-58
Generate Interrupt Service Routines

To generate an interrupt service routine (ISR) associated with a specific VME interrupt level for the example RTOS (VxWorks), use the Async Interrupt block. The Async Interrupt block enables the specified interrupt level and installs an ISR that calls a connected function call subsystem.

You can also use the Async Interrupt block in a simulation. It provides an input port that can be enabled and connected to a simulated interrupt source.

**Note** The operating system integration techniques that are demonstrated in this section use one or more blocks the blocks in the **vxlib1 on page 5-2 library.** These blocks provide starting point examples to help you develop custom blocks for your target environment.

Connecting the Async Interrupt Block

To generate an ISR, connect an output of the Async Interrupt block to the control input of

- A function call subsystem
- The input of a Task Sync block
- The input to a Stateflow chart configured for a function call input event

The next figure shows an Async Interrupt block configured to service two interrupt sources. The outputs (signal width 2) are connected to two function call subsystems.
Requirements and Restrictions

Note the following requirements and restrictions:

- The Async Interrupt block supports VME interrupts 1 through 7.
- The Async Interrupt block uses the following system calls to the example RTOS (VxWorks):
  - sysIntEnable
  - sysIntDisable
  - intConnect
  - intLock
  - intUnlock
  - tickGet

Performance Considerations

Execution of large subsystems at interrupt level can have a significant impact on interrupt response time for interrupts of equal and lower priority in the system. As a general rule, it is best to keep ISRs as short as possible. Connect only function call subsystems that contain a small number of blocks to an Async Interrupt block.
A better solution for large subsystems is to use the Task Sync block to synchronize the execution of the function call subsystem to a RTOS task. The Task Sync block is placed between the Async Interrupt block and the function call subsystem. The Async Interrupt block then installs the Task Sync block as the ISR. The ISR releases a synchronization semaphore (performs a `semGive`) to the task, and returns immediately from interrupt level. The task is then scheduled and run by the example RTOS (VxWorks). See “Spawn and Synchronize Execution of RTOS Task” on page 5-15 for more information.

**Using the Async Interrupt Block in Simulation and Code Generation**

This section describes a *dual-model* approach to the development and implementation of real-time systems that include ISRs. In this approach, you develop one model that includes a plant and a controller for simulation, and another model that only includes the controller for code generation. Using a Simulink library, you can implement changes to both models simultaneously. The next figure shows how changes made to the plant or controller, both of which are in a library, are propagated to the models.

![Dual-Model Use of Async Interrupt Block for Simulation and Code Generation](image)

**Dual-Model Use of Async Interrupt Block for Simulation and Code Generation**

A *single-model* approach is also possible. In this approach, the Plant component of the model is active only in simulation. During code generation, the Plant components are effectively switched out of the system and code is generated only for the interrupt block and controller parts of the model. For an example of this approach, see the `rtwdemo_async` model.
Dual-Model Approach: Simulation

The following block diagram shows a simple model that illustrates the dual-model approach to modeling. During simulation, the Pulse Generator blocks provide simulated interrupt signals.

The simulated interrupt signals are routed through the Async Interrupt block's input port. Upon receiving a simulated interrupt, the block calls the connected subsystem.

During simulation, subsystems connected to Async Interrupt block outputs are executed in order of their priority in the example RTOS (VxWorks). In the event that two or more interrupt signals occur simultaneously, the Async Interrupt block executes the downstream systems in the order specified by their interrupt levels (level 7 gets the highest priority). The first input element maps to the first output element.

You can also use the Async Interrupt block in a simulation without enabling the simulation input. In such a case, the Async Interrupt block inherits the base rate of the model and calls the connected subsystems in order of their priorities in the RTOS. (In this case, the Async Interrupt block behaves as if all inputs received a 1 simultaneously.)

Dual-Model Approach: Code Generation

In the generated code for the sample model,
• Ground blocks provide input signals to the Environment Controller block
• The Async Interrupt block does not use its simulation input

The Ground blocks drive control input of the Environment Controller block, so code is not generated for that signal path. The code generator does not produce code for blocks that drive the simulation control input to the Environment Controller block because that path is not selected during code generation. However, the sample times of driving blocks for the simulation input to the Environment Controller block contribute to the sample times supported in the generated code. To avoid including unnecessary sample times in the generated code, use the sample times of the blocks driving the simulation input in the model where generated code is intended.

Standalone functions are installed as ISRs and the interrupt vector table is as follows:

<table>
<thead>
<tr>
<th>Offset</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>192</td>
<td>&amp;isr_num1_vec192()</td>
</tr>
<tr>
<td>193</td>
<td>&amp;isr_num2_vec193()</td>
</tr>
</tbody>
</table>

Consider the code generated from this model, assuming that the Async Interrupt block parameters are configured as shown in the next figure.
Initialization Code

In the generated code, the Async Interrupt block installs the code in the Subsystem blocks as interrupt service routines. The interrupt vectors for IRQ1 and IRQ2 are stored at locations 192 and 193 relative to the base of the interrupt vector table, as specified by the VME interrupt vector offset(s) parameter.

Installing an ISR requires two RTOS (VxWorks) calls, int_connect and sysInt_Enable. The Async Interrupt block inserts these calls in the model_initialize function, as shown in the following code excerpt.

```c
/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
/* Connect and enable ISR function: isr_num1_vec192 */
if( intConnect(INUM_TO_IVEC(192), isr_num1_vec192, 0) != OK) {
    printf("intConnect failed for ISR 1.\n");
}
sysIntEnable(1);
```
/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
/* Connect and enable ISR function: isr_num2_vec193 */
if( intConnect(INUM_TO_IVEC(193), isr_num2_vec193, 0) != OK)
{
    printf("intConnect failed for ISR 2.\n");
}
sysIntEnable(2);

The hardware that generates the interrupt is not configured by the Async Interrupt block. Typically, the interrupt source is a VME I/O board, which generates interrupts for specific events (for example, end of A/D conversion). The VME interrupt level and vector are set up in registers or by using jumpers on the board. You can use the mdlStart routine of a user-written device driver (S-function) to set up the registers and enable interrupt generation on the board. You must match the interrupt level and vector specified in the Async Interrupt block dialog to the level and vector set up on the I/O board.

**Generated ISR Code**

The actual ISR generated for IRQ1 in the RTOS (VxWorks) is listed below.

```c
/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */

void isr_num1_vec192(void)
{
    int_T lock;
    FP_CONTEXT context;
    /* Use tickGet() as a portable tick counter example. 
    A much higher resolution can be achieved with a 
    hardware counter */
    Async_Code_M->Timing.clockTick2 = tickGet();
    /* disable interrupts (system is configured as non-ive) */
    lock = intLock();
    /* save floating point context */
    fppSave(&context);
    /* Call the system: <Root>/Subsystem A */
    Count(0, 0);
    /* restore floating point context */
    fppRestore(&context);
    /* re-enable interrupts */
```

5-12
intUnlock(lock);
}

There are several features of the ISR that should be noted:

- Because of the setting of the **Preemption Flag(s)** parameter, this ISR is locked; that is, it cannot be preemted by a higher priority interrupt. The ISR is locked and unlocked in the example RTOS (VxWorks) by the `int_lock` and `int_unlock` functions.
- The connected subsystem, `Count`, is called from within the ISR.
- The `Count` function executes algorithmic (model) code. Therefore, the floating-point context is saved and restored across the call to `Count`.
- The ISR maintains its own absolute time counter, which is distinct from other periodic base rate or subrate counters in the system. Timing data is maintained for the use of any blocks executed within the ISR that require absolute or elapsed time.

See “Timers in Asynchronous Tasks” on page 5-42 for details.

**Model Termination Code**

The model's termination function disables the interrupts in the RTOS (VxWorks):

```c
/* Model terminate function */
void Async_Code_terminate(void)
{
    /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
    /* Disable interrupt for ISR system: isr_num1_vec192 */
    sysIntDisable(1);

    /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
    /* Disable interrupt for ISR system: isr_num2_vec193 */
    sysIntDisable(2);
}
```

**See Also**

**More About**

- “Spawn and Synchronize Execution of RTOS Task” on page 5-15
• “Pass Asynchronous Events in RTOS as Input To a Referenced Model” on page 5-32
• “Import Asynchronous Event Data for Simulation” on page 5-54
• “Rate Transitions and Asynchronous Blocks” on page 5-36
Spawn and Synchronize Execution of RTOS Task

This example shows how to simulate and generate code for asynchronous events on a multitasking real-time operating system (VxWorks®). The model shows different techniques for handling asynchronous events depending on the size of the triggered subsystems.

About the Example Model

Open the example model rtwdemo_async.
The model simulates an interrupt source and includes an Async Interrupt block, a Task Sync block, function-call subsystems Count and Algorithm, and Rate Transition blocks. The Async Interrupt block creates two Versa Module Eurocard (VME) interrupt service routines (ISRs) that pass interrupt signals to subsystem Count and the Task Sync block. You can place an Async Interrupt block between a simulated interrupt source and one of the following:
• Function call subsystem
• Task Sync block
• A Stateflow® chart configured for a function call input event
• A referenced model with an Inport block that connects to one of the preceding model elements

The Async Interrupt and Task Sync blocks enable the subsystems to execute asynchronously.

Count represents a simple interrupt service routine (ISR) that executes at interrupt level. It is best to keep ISRs as simple as possible. This subsystem includes only a Discrete-Time Integrator block.

Algorithm includes more substance. It includes multiple blocks and produces two output values. Execution of larger subsystems at interrupt level can significantly impact response time for interrupts of equal and lower priority in the system. A better solution for larger subsystems is to use the Task Sync block to represent the ISR for the function-call subsystem.

The Async Interrupt block generates calls to ISRs. Place the block between a simulated interrupt source and one of the following:

• Function call subsystem
• Task Sync block
• A Stateflow® chart configured for a function call input event

For each specified interrupt level, the block generates a Versa Module Eurocard (VME) ISR that executes the connected subsystem, Task Sync block, or chart.

In the example model, the Async Interrupt block is configured for VME interrupts 1 and 2, by using interrupt vector offsets 192 and 193. Interrupt 1 connects directly to subsystem Count. Interrupt 2 connects to a Task Sync block, which serves as the ISR for Algorithm. Place a Task Sync block in one of the following locations:

• Between an Async Interrupt block and a function-call subsystem or Stateflow® chart.
• At the output port of a Stateflow® chart that has an event, Output to Simulink, that you configure as a function call.

In the example model, the Task Sync block is between the Async Interrupt block and function-call subsystem Algorithm. The Task Sync block is configured with the task
name `Task()`, a priority of 50, a stack size of 8192, and data transfers of the task synchronized with the caller task. The spawned task uses a semaphore to synchronize task execution. The Async Interrupt block triggers a release of the task semaphore.

Four Rate Transition blocks handle data transfers between ports that operate at different rates. In two instances, Protected Rate Transition blocks protect data transfers (prevent them from being preempted and corrupted). In the other two instances, Unprotected Rate Transition blocks introduce no special behavior. Their presence informs Simulink® of a rate transition.

The code generated for the Async Interrupt and Task Sync blocks is tailored for the example RTOS (VxWorks®). However, you can modify the blocks to generate code specific to your run-time environment.

**Data Transfer Assumptions**

- Data transfers occur between one reading task and one writing task.
- A read or write operation on a byte-size variable is atomic.
- When two tasks interact, only one can preempt the other.
- For periodic tasks, the task with the faster rate has higher priority than the task with the slower rate. The task with the faster rate preempts the tasks with slower rates.
- Tasks run on a single processor. Time slicing is not allowed.
- Processes do not stop and restart, especially while data is being transferred between tasks.

**Simulate the Model**

Simulate the model. By default, the model is configured to show sample times in different colors. Discrete sample times for input and output appear red and green, respectively. Constants are reddish-blue. Asynchronous interrupts and tasks are purple. The Rate Transition Blocks, which are a hybrid rate (their input and output sample times can differ), are yellow.

**Generate Code and Report**

Generate code and a code generation report for the model. Generated code for the Async Interrupt and Task Sync blocks is for the example RTOS (VxWorks®). However, you can modify the blocks to generate code for another run-time environment.

1. Create a temporary folder for the build and inspection process.
2. Build the model.

### Starting build procedure for model: rtwdemo_async
Warning: Simulink Coder: The tornado.tlc target will be removed in a future release.

### Wrapping unrecognized make command (angle brackets added)
###    <make>
### in default batch file
### Successful completion of code generation for model: rtwdemo_async

**Review Initialization Code**

Open the generated source file `rtwdemo_async.c`. The initialization code:

1. Creates and initializes the synchronization semaphore `Task0_semaphore`.

   ```c
   *(SEM_ID *)rtwdemo_async_DW.SFunction_PWORK.SemID = semBCreate(SEM_Q_PRIORITY,
   SEM_EMPTY);
   if (rtwdemo_async_DW.SFunction_PWORK.SemID == NULL) {
       printf("semBCreate call failed for block Task0.\n");
   }
   
   2. Spawns task `task0` and assigns the task priority 50.

   ```c
   rtwdemo_async_DW.SFunction_IWORK.TaskID = taskSpawn("Task0",
   50.0,
   VX_FP_TASK,
   8192.0,
   (FUNCPTR)Task0,
   0, 0, 0, 0, 0, 0, 0, 0, 0);  
   if (rtwdemo_async_DW.SFunction_IWORK.TaskID == ERROR) {
       printf("taskSpawn call failed for block Task0.\n");
   }
   
   /* End of Start for S-Function (vxtask1): '<S5>/S-Function' */
   
   /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
   /* Connect and enable ISR function: isr_num1_vec192 */
   if (intConnect(INUM_TO_IVEC(192), isr_num1_vec192, 0) != OK) {
       printf("intConnect failed for ISR 1.\n");
   }
   ```
sysIntEnable(1);

/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
/* Connect and enable ISR function: isr_num2_vec193 */
if (intConnect(INUM_TO_IVEC(193), isr_num2_vec193, 0) != OK) {
    printf("intConnect failed for ISR 2.\n");
}

sysIntEnable(2);

3. Connects and enables ISR isr_num1_vec192 for interrupt 1 and ISR
isr_num2_vec193 for interrupt 2.

{
    int32_T i;

    /* InitializeConditions for RateTransition: '<Root>/Protected RT1' */
    for (i = 0; i < 60; i++) {
        rtwdemo_async_DW.ProtectedRT1_Buffer[i] = 0.0;
    }

    /* End of InitializeConditions for RateTransition: '<Root>/Protected RT1' */

    /* InitializeConditions for RateTransition: '<Root>/Protected RT2' */
    for (i = 0; i < 60; i++) {
        rtwdemo_async_DW.ProtectedRT2_Buffer[i] = 0.0;
    }

    /* End of InitializeConditions for RateTransition: '<Root>/Protected RT2' */

    /* SystemInitialize for S-Function (vxinterrupt1): '<Root>/Async Interrupt' incorporates:
    * SubSystem: '<Root>/Count'
    */
    /* System initialize for function-call system: '<Root>/Count' */
    rtwdemo_async_DW.Count_PREV_T = rtwdemo_async_M->Timing.clockTick2;

    /* InitializeConditions for DiscreteIntegrator: '<S2>/Integrator' */
    rtwdemo_async_DW.Integrator_DSTATE_l = 0.0;

    /* SystemInitialize for Outport: '<Root>/Out1' incorporates:
    * Outport: '<S2>/Out'
    */
    rtwdemo_async_Y.Out1 = 0.0;
/* SystemInitialize for S-Function (vxinterrupt1): '<Root>/Async Interrupt' incorporates:
 *  SubSystem: '<S4>/Subsystem'
 */
/* System initialize for function-call system: '<S4>/Subsystem' */

/* SystemInitialize for S-Function (vxtask1): '<S5>/S-Function' incorporates:
 *  SubSystem: '<Root>/Algorithm'
 */

/* System initialize for function-call system: '<Root>/Algorithm' */
rtwdemo_async_M->Timing.clockTick4 = rtwdemo_async_M->Timing.clockTick3;
rtwdemo_async_DW.Algorithm_PREV_T = rtwdemo_async_M->Timing.clockTick4;

/* InitializeConditions for DiscreteIntegrator: '<S1>/Integrator' */
rtwdemo_async_DW.Integrator_DSTATE = 0.0;

/* SystemInitialize for Outport: '<S1>/Out1' */
memset(&rtwdemo_async_B.Sum[0], 0, 60U * sizeof(real_T));

/* SystemInitialize for Outport: '<Root>/Out3' incorporates:
 *  Outport: '<S1>/Out2'
 */
rtwdemo_async_Y.Out3 = 0.0;

/* End of SystemInitialize for S-Function (vxtask1): '<S5>/S-Function' */

/* End of SystemInitialize for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

/* End of SystemInitialize for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

/* Model terminate function */
static void rtwdemo_async_terminate(void)
{
    /* Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

    /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
    /* Disable interrupt for ISR system: isr_num1_vec192 */
    sysIntDisable(1);

    /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
    /* Disable interrupt for ISR system: isr_num2_vec193 */
    sysIntDisable(2);

    /* End of Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
/* Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' incorporates:
   * SubSystem: '<S4>/Subsystem'
 */

/* Termination for function-call system: '<S4>/Subsystem' */
/* Terminate for S-Function (vxtask1): '<S5>/S-Function' */
/* VxWorks Task Block: '<S5>/S-Function' (vxtask1) */
/* Destroy task: Task0 */
taskDelete(rtwdemo_async_DW.SFunction_IWORK.TaskID);

/* End of Terminate for S-Function (vxtask1): '<S5>/S-Function' */
/* End of Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
}

/*========================================================================*
* Start of Classic call interface                                        *
*========================================================================*/

void MdlOutputs(int_T tid)
{
    rtwdemo_async_output(tid);
}

void MdlUpdate(int_T tid)
{
    rtwdemo_async_update(tid);
}

void MdlInitializeSizes(void)
{
}

void MdlInitializeSampleTimes(void)
{
}

void MdlInitialize(void)
{
}

void MdlStart(void)
rtwdemo_async_initialize();

void MdlTerminate(void)
{
    rtwdemo_async_terminate();
}

/* Registration function */
RT_MODEL_rtwdemo_async_T *rtwdemo_async(void)
{
    /* Registration code */
    /* initialize non-finites */
    rt_InitInfAndNaN(sizeof(real_T));

    /* initialize real-time model */
    (void) memset((void *)rtwdemo_async_M, 0,
    sizeof(RT_MODEL_rtwdemo_async_T));

    /* Initialize timing info */
    {
        int_T *mdlTsMap = rtwdemo_async_M->Timing.sampleTimeTaskIDArray;
        mdlTsMap[0] = 0;
        mdlTsMap[1] = 1;
        rtwdemo_async_M->Timing.sampleTimeTaskIDPtr = (&mdlTsMap[0]);
        rtwdemo_async_M->Timing.sampleTimes =
        (rtwdemo_async_M->Timing.sampleTimesArray[0]);
        rtwdemo_async_M->Timing.offsetTimes =
        (rtwdemo_async_M->Timing.offsetTimesArray[0]);

        /* task periods */
        rtwdemo_async_M->Timing.sampleTimes[0] = (0.016666666666666666);
        rtwdemo_async_M->Timing.sampleTimes[1] = (0.05);

        /* task offsets */
        rtwdemo_async_M->Timing.offsetTimes[0] = (0.0);
        rtwdemo_async_M->Timing.offsetTimes[1] = (0.0);
    }

    rtmSetTPtr(rtwdemo_async_M, &rtwdemo_async_M->Timing.tArray[0]);
}
int_T *mdlSampleHits = rtwdemo_async_M->Timing.sampleHitArray;
int_T *mdlPerTaskSampleHits = rtwdemo_async_M->Timing.perTaskSampleHitsArray;
rtwdemo_async_M->Timing.perTaskSampleHits = (&mdlPerTaskSampleHits[0]);
mdlSampleHits[0] = 1;
rtwdemo_async_M->Timing.sampleHits = (&mdlSampleHits[0]);
}

rtmSetTFinal(rtwdemo_async_M, 0.5);
rtwdemo_async_M->Timing.stepSize0 = 0.016666666666666666;
rtwdemo_async_M->Timing.stepSize1 = 0.05;
rtwdemo_async_M->solverInfoPtr = (&rtwdemo_async_M->solverInfo);
rtwdemo_async_M->Timing.stepSize = (0.016666666666666666);
rtsiSetFixedStepSize(&rtwdemo_async_M->solverInfo, 0.016666666666666666);
rtsiSetSolverMode(&rtwdemo_async_M->solverInfo, SOLVER_MODE_MULTITASKING);

/* block I/O */
rtwdemo_async_M->blockIO = ((void *) &rtwdemo_async_B);
(void) memset(((void *) &rtwdemo_async_B), 0,
sizeof(B_rtwdemo_async_T));

/* states (dwork) */
rtwdemo_async_M->dwork = ((void *) &rtwdemo_async_DW);
(void) memset((void *)&rtwdemo_async_DW, 0,
sizeof(DW_rtwdemo_async_T));

/* external inputs */
rtwdemo_async_M->inputs = (((void*)&rtwdemo_async_U));
(void)memset(&rtwdemo_async_U, 0, sizeof(ExtU_rtwdemo_async_T));

/* external outputs */
rtwdemo_async_M->outputs = (&rtwdemo_async_Y);
(void) memset((void *)&rtwdemo_async_Y, 0,
sizeof(ExtY_rtwdemo_async_T));

/* Initialize Sizes */
rtwdemo_async_M->Sizes.numContStates = (0);/* Number of continuous states */
rtwdemo_async_M->Sizes.numY = (3);    /* Number of model outputs */
rtwdemo_async_M->Sizes.numU = (60);  /* Number of model inputs */
rtwdemo_async_M->Sizes.sysDirFeedThru = (0);/* The model is not direct feedthrough */
rtwdemo_async_M->Sizes.numSampTimes = (2);/* Number of sample times */
rtwdemo_async_M->Sizes.numBlocks = (17);/* Number of blocks */
rtwdemo_async_M->Sizes.numBlockIO = (4);/* Number of block outputs */
return rtwdemo_async_M;
The order of these operations is important. Before the code generator enables the interrupt that activates the task, it must spawn the task.

**Review Task and Task Synchronization Code**

In the generated source file `rtwdemo_async.c`, review the task and task synchronization code.

The code generator produces the code for function `Task0` from the Task Sync block. That function includes a small amount of interrupt-level code and runs as an RTOS task.

The task waits in an infinite `for` loop until the system releases a synchronization semaphore. If the system releases the semaphore, the function updates its task timer and calls the code generated for the Algorithm subsystem.

In the example model, the **Synchronize the data transfer of this task with the caller task** parameter for the Task Sync block is set. This parameter setting updates the timer associated with the Task Sync block (`rtM->Timing.clockTick2`) with the value of the timer that the Async Interrupt block (`rtM->Timing.clockTick3`) maintains. As a result, code for blocks within the Algorithm subsystem use timer values that are based on the time of the most recent interrupt, rather than the most recent activation of `Task0`.

```c
{
    /* Wait for semaphore to be released by system: rtwdemo_async/Task Sync */
    for (;;) {
        if (semTake(*(SEM_ID *)rtwdemo_async_DW.SFunction_PWORK.SemID,NO_WAIT) != ERROR) {
            logMsg("Rate for Task Task0() too fast.\n",0,0,0,0,0);
        } else {
            #if STOPONOVERRUN
                logMsg("Aborting real-time simulation.\n",0,0,0,0,0);
                semGive(stopSem);
                return(ERROR);
            #endif
        }
    }
}
```
semTake(*(SEM_ID *)rtwdemo_async_DW.SFunction_PWORK.SemID, WAIT_FOREVER);
}

/* Use the upstream clock tick counter for this Task. */
rtwdemo_async_M->Timing.clockTick4 = rtwdemo_async_M->Timing.clockTick3;

/* Call the system: '<Root>/Algorithm' */
{
    int32_T tmp;
    int32_T i;

    /* RateTransition: '<Root>/Protected RT1' */
    tmp = rtwdemo_async_DW.ProtectedRT1_ActiveBufIdx * 60;
    for (i = 0; i < 60; i++) {
        rtwdemo_async_B.ProtectedRT1[i] =
            rtwdemo_async_DW.ProtectedRT1_Buffer[i + tmp];
    }

    /* End of RateTransition: '<Root>/Protected RT1' */

    /* S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

    /* S-Function (vxtask1): '<S5>/S-Function' */

    /* Output and update for function-call system: '<Root>/Algorithm' */
    {
        real_T tmp;
        int32_T i;
        uint32_T Algorithm_ELAPS_T_tmp;
        rtwdemo_async_M->Timing.clockTick4 =
            rtwdemo_async_M->Timing.clockTick3;
        Algorithm_ELAPS_T_tmp = rtwdemo_async_M->Timing.clockTick4;
        rtwdemo_async_DW.Algorithm_ELAPS_T = Algorithm_ELAPS_T_tmp -
            rtwdemo_async_DW.Algorithm_PREV_T;
        rtwdemo_async_DW.Algorithm_PREV_T = Algorithm_ELAPS_T_tmp;

        /* Outport: '<Root>/Out3' incorporates:
        * DiscreteIntegrator: '<S1>/Integrator'
        */
        rtwdemo_async_Y.Out3 = rtwdemo_async_DW.Integrator_DSTATE;

        /* Sum: '<S1>/Sum1' */
        tmp = -0.0;
for (i = 0; i < 60; i++) {
    /* Sum: '<S1>/Sum' incorporates:
    *  Constant: '<S1>/Offset'
    */
    rtwdemo_async_B.Sum[i] = rtwdemo_async_B.ProtectedRT1[i] + 1.25;
    /* Sum: '<S1>/Sum1' */
    tmp += rtwdemo_async_B.Sum[i];
}

/* Update for DiscreteIntegrator: '<S1>/Integrator' incorporates:
 *  Sum: '<S1>/Sum1'
 */
rtwdemo_async_DW.Integrator_DSTATE += 0.016666666666666666 * (real_T)
    rtwdemo_async_DW.Algorithm_ELAPS_T * tmp;
/* End of Outputs for S-Function (vxtask1): '<S5>/S-Function' */
/* End of Outputs for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

int32_T i;
/* Update for RateTransition: '<Root>/Protected RT2' */
for (i = 0; i < 60; i++) {
    rtwdemo_async_DW.ProtectedRT2_Buffer[i +
        (rtwdemo_async_DW.ProtectedRT2_ActiveBufIdx == 0) * 60] =
        rtwdemo_async_B.Sum[i];
}

rtwdemo_async_DW.ProtectedRT2_ActiveBufIdx = (int8_T)
    (rtwdemo_async_DW.ProtectedRT2_ActiveBufIdx == 0);
/* End of Update for RateTransition: '<Root>/Protected RT2' */

The code generator produces code for ISRs isr_num1_vec192 and isr_num2_vec293.
ISR isr_num2_vec192:
- Disables interrupts.
- Saves floating-point context.
- Calls the code generated for the subsystem that connects to the referenced model Inport block, which receives the interrupt.
- Restores floating-point context.
- Reenables interrupts.

```c
void isr_num1_vec192(void)
{
    int_T lock;
    FP_CONTEXT context;

    /* Use tickGet() as a portable tick counter example. A much higher resolution can be achieved with a hardware counter */
    rtwdemo_async_M->Timing.clockTick2 = tickGet();

    /* disable interrupts (system is configured as non-preemptive) */
    lock = intLock();

    /* save floating point context */
    fppSave(&context);

    /* Call the system: '<Root>/Count' */
    {
        /* S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

        /* Output and update for function-call system: '<Root>/Count' */
        {
            uint32_T Count_ELAPS_T_tmp;
            Count_ELAPS_T_tmp = rtwdemo_async_M->Timing.clockTick2;
            rtwdemo_async_DW.Count_ELAPS_T = Count_ELAPS_T_tmp -
            rtwdemo_async_DW.Count_PREV_T;
            rtwdemo_async_DW.Count_PREV_T = Count_ELAPS_T_tmp;

            /* Outport: '<Root>/Out1' incorporates: */
            /*  DiscreteIntegrator: '<S2>/Integrator' */
            rtwdemo_async_Y.Out1 = rtwdemo_async_DW.Integrator_DSTATE_l;

            /* Update for DiscreteIntegrator: '<S2>/Integrator' */
            rtwdemo_async_DW.Integrator_DSTATE_l += 0.016666666666666666 * (real_T)
        }
    }
}
```
ISR `isr_num2_vec293` maintains a timer that stores the tick count at the time that the interrupt occurs. After updating the timer, the ISR releases the semaphore that activates Task0.

```c
void isr_num2_vec193(void)
{
    /* Use tickGet() as a portable tick counter example. A much higher resolution can be achieved with a hardware counter */
    rtwdemo_async_M->Timing.clockTick3 = tickGet();

    /* Call the system: '<S4>/Subsystem' */
    {
        /* S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

        /* Output and update for function-call system: '<S4>/Subsystem' */

        /* S-Function (vxtask1): '<S5>/S-Function' */

        /* VxWorks Task Block: '<S5>/S-Function' (vxtask1) */
        /* Release semaphore for system task: Task0 */
        semGive(*(SEM_ID *)rtwdemo_async_DW.SFunction_PWORK.SemID);

        /* End of Outputs for S-Function (vxtask1): '<S5>/S-Function' */

        /* End of Outputs for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
    }
}
```
Review Task Termination Code

The Task Sync block generates the following termination code.

```c
static void rtwdemo_async_terminate(void)
{
    /* Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

    /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
    /* Disable interrupt for ISR system: isr_num1_vec192 */
    sysIntDisable(1);

    /* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
    /* Disable interrupt for ISR system: isr_num2_vec193 */
    sysIntDisable(2);

    /* End of Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */

    /* Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' incorporates:
       * SubSystem: '<S4>/Subsystem'
    */

    /* Termination for function-call system: '<S4>/Subsystem' */

    /* Terminate for S-Function (vxtask1): '<S5>/S-Function' */

    /* VxWorks Task Block: '<S5>/S-Function' (vxtask1) */
    /* Destroy task: Task0 */
    taskDelete(rtwdemo_async_DW.SFunction_IWORK.TaskID);

    /* End of Terminate for S-Function (vxtask1): '<S5>/S-Function' */

    /* End of Terminate for S-Function (vxinterrupt1): '<Root>/Async Interrupt' */
}
```

Related Information

- Async Interrupt
- Task Sync
- “Generate Interrupt Service Routines” on page 5-6
See Also

More About

- “Generate Interrupt Service Routines” on page 5-6
- “Pass Asynchronous Events in RTOS as Input To a Referenced Model” on page 5-32
- “Timers in Asynchronous Tasks” on page 5-42
- “Import Asynchronous Event Data for Simulation” on page 5-54
- “Rate Transitions and Asynchronous Blocks” on page 5-36
Pass Asynchronous Events in RTOS as Input To a Referenced Model

This example shows how to simulate and generate code for a model that triggers asynchronous events in an example RTOS (VxWorks®) that get passed as input to a referenced model.

Open Example Model

Open the example model `rtwdemo_async_mdlreftop`.

The model simulates an interrupt source and includes an Async Interrupt block and referenced model. The Async Interrupt block creates two Versa Module Eurocard (VME) interrupt service routines (ISRs) that pass interrupt signals to Inport blocks 1 and 2 of the referenced model. You can place an Async Interrupt block between a simulated interrupt source and one of the following:

- Function call subsystem
- Task Sync block
- A Stateflow® chart configured for a function call input event
- A referenced model with a Inport block that connects to one of the preceding model elements

In this example model, the Async Interrupt block passes asynchronous events (function-call trigger signals), `Interrupt1` and `Interrupt2`, to the referenced model through Inport blocks 1 and 2.

The code generated for the Async Interrupt block is tailored for the example real-time operating system (VxWorks). However, you can modify the block to generate code specific to your run-time environment.

Open the referenced model.

The referenced model includes the two Inport blocks that receive the interrupts, each connected to an Asynchronous Task Specification block, function-call subsystems Count and Algorithm, and Rate Transition blocks. The Asynchronous Task Specification block, in combination with a root-level Inport block, allows a reference model to receive asynchronous function-call input. To use the block:
1 Connect the Asynchronous Task Specification block to the output port of a root-level Inport block that outputs a function-call trigger.

2 Select the **Output function call** parameter of the Inport block to specify that it accepts function-call signals.

3 On the Asynchronous Task Specification parameters dialog box, set the task priority for the asynchronous task associated with an Inport block. Specify an integer or []. If you specify an integer, it must match the priority of the interrupt initiated by the Async Interrupt block in the parent model. If you specify [], the priorities do not have to match.

The Asynchronous Task Specification block for the higher priority interrupt, interrupt1, connects to function-call subsystem Count. Count represents a simple interrupt service routine (ISR). The second Asynchronous Task Specification block connects to the subsystem Algorithm, which includes more substance. It includes multiple blocks and produces two output values. Both subsystems execute at interrupt level.

For each interrupt level specified for the Async Interrupt block in the parent model, the block generates a VME ISR that executes the connected subsystem, Task Sync block, or chart.

In the example top model, the Async Interrupt block is configured for VME interrupts 1 and 2, using interrupt vector offsets 192 and 193. Interrupt 1 is wired to trigger subsystem Count. Interrupt 2 is wired to trigger subsystem Algorithm.

The Rate Transition blocks handle data transfers between ports that operate at different rates. In two instances, the blocks protect data transfers (prevent them from being preempted and corrupted). In the other instance, no special behavior occurs.

**Data Transfer Assumptions**

- Data transfers occur between one reading task and one writing task.
- A read or write operation on a byte-sized variable is atomic.
- When two tasks interact, only one can preempt the other.
- For periodic tasks, the task with the faster rate has higher priority than the task with the slower rate. The task with the faster rate preempts the tasks with slower rates.
- Tasks run on a single processor. Time slicing is not allowed.
- Processes do not crash and restart, especially while data is being transferred between tasks.
Simulate the Model

Simulate the model. By default, the model is configured to show sample times in different colors. Discrete sample times for input and output appear red and green, respectively. Constants are magenta. Asynchronous interrupts are purple. The Rate Transition Blocks, which are hybrid (input and output sample times can differ), appear yellow.

Generate Code and Report

Generate code and a code generation report for the model. Async Interrupt block and Task Sync block generated code is for the example RTOS (VxWorks). However, you can modify the blocks to generate code for another run-time environment.

1. Create a temporary folder for the build and inspection process.

2. Build the model.

Review Initialization Code

Open the generated source file rtwdemo_async_mdlreftop.c. The initialization code connects and enables ISR isr_num1_vec192 for interrupt 1 and ISR isr_num2_vec193 for interrupt 2.

Review ISR Code

In the generated source file rtwdemo_async_mdlreftop.c, review the code for ISRs isr_num1_vec192 and isr_num2_vec293. Each ISR:

- Disables interrupts.
- Saves floating-point context.
- Calls the code generated for the subsystem connected to the referenced model Inport block that receives the interrupt.
- Restores floating-point context.
- Reenables interrupts.

Review Task Termination Code

The Task Sync block generates the following termination code.
Related Information

- Async Interrupt
- Asynchronous Task Specification
- “Generate Interrupt Service Routines” on page 5-6
- “Timers in Asynchronous Tasks” on page 5-42
- “Create a Customized Asynchronous Library” on page 5-45
- “Import Asynchronous Event Data for Simulation” on page 5-54
- “Load Data to Root-Level Input Ports” (Simulink)
- “Asynchronous Events” on page 5-2
- “Rate Transitions and Asynchronous Blocks” on page 5-36
- “Asynchronous Support Limitations” on page 5-58

See Also

More About

- “Generate Interrupt Service Routines” on page 5-6
- “Spawn and Synchronize Execution of RTOS Task” on page 5-15
- “Timers in Asynchronous Tasks” on page 5-42
- “Import Asynchronous Event Data for Simulation” on page 5-54
- “Rate Transitions and Asynchronous Blocks” on page 5-36
Rate Transitions and Asynchronous Blocks

Because an asynchronous function call subsystem can preempt or be preempted by other model code, an inconsistency arises when more than one signal element is connected to an asynchronous block. The issue is that signals passed to and from the function call subsystem can be in the process of being written to or read from when the preemption occurs. Thus, some old and some new data is used. This situation can also occur with scalar signals in some cases. For example, if a signal is a double (8 bytes), the read or write operation might require two machine instructions.

**Note** The operating system integration techniques that are demonstrated in this section use one or more blocks the blocks in the **vxlib1** library. These blocks provide starting point examples to help you develop custom blocks for your target environment.

About Rate Transitions and Asynchronous Blocks

The Simulink Rate Transition block is designed to deal with preemption problems that occur in data transfer between blocks running at different rates. These issues are discussed in “Time-Based Scheduling and Code Generation” on page 4-2.

You can handle rate transition issues automatically by selecting the **Automatically handle rate transition for data transfer** parameter on the **Solver** pane of the **Configuration Parameters** dialog box. This saves you from having to manually insert Rate Transition blocks to avoid invalid rate transitions, including invalid **asynchronous-to-periodic** and **asynchronous-to-asynchronous** rate transitions, in multirate models. For asynchronous tasks, the Simulink engine configures inserted blocks for data integrity but not determinism during data transfers.

For asynchronous rate transitions, the Rate Transition block provides data integrity, but cannot provide determinism. Therefore, when you insert Rate Transition blocks explicitly, you must clear the **Ensure data determinism** check box in the Block Parameters dialog box.

When you insert a Rate Transition block between two blocks to maintain data integrity and priorities are assigned to the tasks associated with the blocks, the code generator assumes that the higher priority task can preempt the lower priority task and the lower priority task cannot preempt the higher priority task. If the priority associated with task
for either block is not assigned or the priorities of the tasks for both blocks are the same, the code generator assumes that either task can preempt the other task.

Priorities of periodic tasks are assigned by the Simulink engine, in accordance with the options specified in the Solver selection section of the Solver pane of the Configuration Parameters dialog box. When the Periodic sample time constraint option field of Solver selection is set to Unconstrained, the model base rate priority is set to 40. Priorities for subrates then increment or decrement by 1 from the base rate priority, depending on the setting of the Higher priority value indicates higher task priority option.

You can assign priorities manually by using the Periodic sample time properties field. The Simulink engine does not assign a priority to asynchronous blocks. For example, the priority of a function call subsystem that connects back to an Async Interrupt block is assigned by the Async Interrupt block.

The Simulink task priority field of the Async Interrupt block specifies a priority level (required) for every interrupt number entered in the VME interrupt number(s) field. The priority array sets the priorities of the subsystems connected to each interrupt.

For the Task Sync block, if the example RTOS (VxWorks) is the target, the Higher priority value indicates higher task priority option should be deselected. The Simulink task priority field specifies the block priority relative to connected blocks (in addition to assigning an RTOS priority to the generated task code).

The vxlib1 library provides two types of rate transition blocks as a convenience. These are simply preconfigured instances of the built-in Simulink Rate Transition block:

- Protected Rate Transition block: Rate Transition block that is configured with the Ensure data integrity during data transfers on and Ensure deterministic data transfer off.
- Unprotected Rate Transition block: Rate Transition block that is configured with the Ensure data integrity during data transfers option off.

### Handle Rate Transitions for Asynchronous Tasks

For rate transitions that involve asynchronous tasks, you can maintain data integrity. However, you cannot achieve determinism. You have the option of using the Rate Transition block or target-specific rate transition blocks.

Consider the following model, which includes a Rate Transition block.
You can use the Rate Transition block in either of the following modes:

- Maintain data integrity, no determinism
- Unprotected

Alternatively, you can use target-specific rate transition blocks. The following blocks are available for the example RTOS (VxWorks):

- Protected Rate Transition block (reader)
- Protected Rate Transition block (writer)
- Unprotected Rate Transition block

**Handle Multiple Asynchronous Interrupts**

Consider the following model, in which two functions trigger the same subsystem.
The two tasks must have equal priorities. When priorities are the same, the outcome depends on whether they are firing periodically or asynchronously, and also on a diagnostic setting. The following table and notes describe these outcomes:

**Supported Sample Time and Priority for Function Call Subsystem with Multiple Triggers**

<table>
<thead>
<tr>
<th></th>
<th>Async Priority = 1</th>
<th>Async Priority = 2</th>
<th>Async Priority Unspecified</th>
<th>Periodic Priority = 1</th>
<th>Periodic Priority = 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Async Priority = 1</td>
<td>Supported (1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Async Priority = 2</td>
<td></td>
<td>Supported (1)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Async Priority Unspecified</td>
<td></td>
<td></td>
<td>Supported (2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Periodic Priority = 1</td>
<td></td>
<td></td>
<td></td>
<td>Supported</td>
<td></td>
</tr>
<tr>
<td>Periodic Priority = 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Supported</td>
</tr>
</tbody>
</table>

1. Control these outcomes using the **Tasks with equal priority** option in the **Diagnostics** pane of the Configuration Parameters dialog box; set this diagnostic to *none* if tasks of equal priority cannot preempt each other in the target system.

2. For this case, the following warning message is issued unconditionally:

   The function call subsystem `<name>` has multiple asynchronous triggers that do not specify priority. Data integrity will not be maintained if these triggers can preempt one another.

Empty cells in the above table represent multiple triggers with differing priorities, which are unsupported.

The code generator provides absolute time management for a function call subsystem connected to multiple interrupts in the case where timer settings for TriggerA and TriggerB (time source, resolution) are the same.

Assume that all of the following conditions are true for the model shown above:

- A function call subsystem is triggered by two asynchronous triggers (TriggerA and TriggerB) having identical priority settings.
Each trigger sets the source of time and timer attributes by calling the functions `ssSetTimeSource` and `ssSetAsyncTimerAttributes`.

The triggered subsystem contains a block that needs elapsed or absolute time (for example, a Discrete Time Integrator).

The asynchronous function call subsystem has one global variable, `clockTick#` (where # is the task ID associated with the subsystem). This variable stores absolute time for the asynchronous task. There are two ways timing can be handled:

- If the time source is set to `SS_TIMESOURCE_BASERATE`, the code generator produces timer code in the function call subsystem, updating the clock tick variable from the base rate clock tick. Data integrity is maintained if the same priority is assigned to TriggerA and TriggerB.
- If the time source is `SS_TIMESOURCE_SELF`, generated code for both TriggerA and TriggerB updates the same clock tick variable from the hardware clock.

The word size of the clock tick variable can be set directly or be established according to the **Application lifespan (days)** (Simulink) setting and the timer resolution set by the TriggerA and TriggerB S-functions (which must be the same). See “Timers in Asynchronous Tasks” on page 5-42 and “Control Memory Allocation for Time Counters” on page 33-11 for more information.

**Protect Data Integrity with volatile Keyword**

When you select **Ensure data integrity during data transfer**, the code generated for a Rate Transition block defines volatile global buffers and semaphores and uses them to protect the integrity of the transferred data. If necessary, for additional protection, or for protection without a Rate Transition block, you can explicitly apply volatile to the transferred data. For more information, see “Protect Global Data with const and volatile Type Qualifiers” (Embedded Coder).

**See Also**

**More About**

- “Handle Rate Transitions” on page 4-21
- “Time-Based Scheduling and Code Generation” on page 4-2
• “Asynchronous Support Limitations” on page 5-58
Timers in Asynchronous Tasks

An ISR can set a source for absolute time. This is done with the function `ssSetTimeSource`. The function `ssSetTimeSource` cannot be called before `ssSetOutputPortWidth` is called. If this occurs, the program will come to a halt and generate an error message. `ssSetTimeSource` has the following three options:

- **SS_TIMESOURCE_SELF**: Each generated ISR maintains its own absolute time counter, which is distinct from a periodic base rate or subrate counters in the system. The counter value and the timer resolution value (specified in the **Timer resolution (seconds)** parameter of the Async Interrupt block) are used by downstream blocks to determine absolute time values required by block computations.

- **SS_TIMESOURCE_CALLER**: The ISR reads time from a counter maintained by its caller. Time resolution is thus the same as its caller's resolution.

- **SS_TIMESOURCE_BASERATE**: The ISR can read absolute time from the model's periodic base rate. Time resolution is thus the same as its base rate resolution.

*Note* The operating system integration techniques that are demonstrated in this section use one or more blocks the blocks in the `vxlib1` library. These blocks provide starting point examples to help you develop custom blocks for your target environment.

By default, the counter is implemented as a 32-bit unsigned integer member of the **Timing** substructure of the real-time model structure. For a target that supports the **rtModel** data structure, when the time data type is not set by using `ssSetAsyncTimeDataType`, the counter word size is determined by the **Application lifespan (days)** (Simulink) model parameter. As an example (from ERT target code),

```c
/* Real-time Model Data Structure */
struct _RT_MODEL_elapseTime_exp_Tag {
    const char *errorStatus;

    /*
     * Timing:
     * The following substructure contains information regarding
     * the timing information for the model.
     */
    struct {
        uint32_T clockTick1;
```
The example omits unused fields in the `Timing` data structure (a feature of ERT target code not found in GRT). For a target that supports the `rtModel` data structure, the counter word size is determined by the **Application lifespan (days)** (Simulink) model parameter.

By default, the `vxlib1` library blocks for the example RTOS (VxWorks) set the timer source to `SS_TIMESOURCE_SELF` and update their counters by using the system call `tickGet`. `tickGet` returns a timer value maintained by the RTOS kernel. The maximum word size for the timer is `UINT32`. The following example shows a generated call to `tickGet`.

```c
/* VxWorks Interrupt Block: '<Root>/Async Interrupt' */
void isr_num2_vec193(void)
{

    /* Use tickGet() as a portable tick counter example. A much
       higher resolution can be achieved with a hardware counter */
    rtM->Timing.clockTick2 = tickGet();

    ...

The `tickGet` call is supplied only as an example. It can (and in many instances should) be replaced by a timing source that has better resolution. If you are implementing a custom asynchronous block for an RTOS other than the example RTOS (VxWorks), you should either generate an equivalent call to the target RTOS, or generate code to read a timer register on the target hardware.

The default **Timer resolution (seconds)** parameter of your Async Interrupt block implementation should be changed to match the resolution of your target's timing source.

The counter is updated at interrupt level. Its value represents the tick value of the timing source at the most recent execution of the ISR. The rate of this timing source is unrelated to sample rates in the model. In fact, typically it is faster than the model's base rate. Select the timer source and set its rate and resolution based on the expected rate of interrupts to be serviced by the Async Interrupt block.

For an example of timer code generation, see “Async Interrupt Block Implementation” on page 5-46.
See Also

Related Examples
- “Generate Interrupt Service Routines” on page 5-6
- “Spawn and Synchronize Execution of RTOS Task” on page 5-15
- “Timers in Asynchronous Tasks” on page 5-42
- “Create a Customized Asynchronous Library” on page 5-45
- “Import Asynchronous Event Data for Simulation” on page 5-54

More About
- “Absolute and Elapsed Time Computation” on page 3-2
- “Time-Based Scheduling and Code Generation” on page 4-2
- “Asynchronous Events” on page 5-2
- “Asynchronous Support Limitations” on page 5-58
Create a Customized Asynchronous Library

This topic describes how to implement asynchronous blocks for use with your target RTOS, using the Async Interrupt and Task Sync blocks as a starting point. Rate Transition blocks are target-independent, so you do not need to develop customized rate transition blocks.

**Note** The operating system integration techniques that are demonstrated in this section use one or more blocks the blocks in the `vxlib1` library. These blocks provide starting point examples to help you develop custom blocks for your target environment.

About Implementing Asynchronous Blocks

You can customize the asynchronous library blocks by modifying the block implementation. These files are

- The block's underlying S-function MEX-file
- The TLC files that control code generation of the block

In addition, you need to modify the block masks to remove references specific to the example RTOS (VxWorks) and to incorporate parameters required by your target RTOS.

Custom block implementation is an advanced topic, requiring familiarity with the Simulink MEX S-function format and API, and with the Target Language Compiler (TLC). These topics are covered in the following documents:

- Simulink topics “What Is an S-Function?” (Simulink), “Use S-Functions in Models” (Simulink), “How S-Functions Work” (Simulink), and “Implementing S-Functions” (Simulink) describe MEX S-functions and the S-function API in general.

The following sections discuss the C/C++ and TLC implementations of the asynchronous library blocks, including required SimStruct macros and functions in the TLC asynchronous support library (`asynclib.tlc`).
Async Interrupt Block Implementation

The source files for the Async Interrupt block are located in `matlabroot/rtw/c/tornado/devices` (open):

- `vxinterrupt1.c`: C MEX-file source code, for use in configuration and simulation
- `vxinterrupt1.tlc`: TLC implementation, for use in code generation
- `asynclib.tlc`: library of TLC support functions, called by the TLC implementation of the block. The library calls are summarized in “asynclib.tlc Support Library” on page 5-52.

C MEX Block Implementation

Most of the code in `vxinterrupt1.c` performs ordinary functions that are not related to asynchronous support (for example, obtaining and validating parameters from the block mask, marking parameters nontunable, and passing parameter data to the `model.rtw` file).

The `mdlInitializeSizes` function uses special SimStruct macros and `SS_OPTIONS` settings that are required for asynchronous blocks, as described below.

Note that the following macros cannot be called before `ssSetOutputPortWidth` is called:

- `ssSetTimeSource`
- `ssSetAsyncTimerAttributes`
- `ssSetAsyncTimerResolutionEl`
- `ssSetAsyncTimerDataType`
- `ssSetAsyncTimerDataTypeEl`
- `ssSetAsyncTaskPriorities`
- `ssSetAsyncTaskPrioritiesEl`

If one of the above macros is called before `ssSetOutputPortWidth`, the following error message appears:

```
SL_SfcnMustSpecifyPortWidthBfCallSomeMacro {
S-function '%%%s' in '<%<BLOCKFULLPATH>'
must set output port %d width using
ssSetOutputPortWidth before calling macro %s
}
```
**ssSetAsyncTimerAttributes**

`ssSetAsyncTimerAttributes` declares that the block requires a timer, and sets the resolution of the timer as specified in the **Timer resolution (seconds)** parameter.

The function prototype is

```c
ssSetAsyncTimerAttributes(SimStruct *S, double res)
```

where

- `S` is a Simstruct pointer.
- `res` is the **Timer resolution (seconds)** parameter value.

The following code excerpt shows the call to `ssSetAsyncTimerAttributes`:

```c
/* Setup Async Timer attributes */
ssSetAsyncTimerAttributes(S, mxGetPr(TICK_RES)[0]);
```

**ssSetAsyncTaskPriorities**

`ssSetAsyncTaskPriorities` sets the Simulink task priority for blocks executing at each interrupt level, as specified in the block's **Simulink task priority** field.

The function prototype is

```c
ssSetAsyncTaskPriorities(SimStruct *S, int numISRs,
                         int *priorityArray)
```

where

- `S` is a SimStruct pointer.
- `numISRs` is the number of interrupts specified in the **VME interrupt number(s)** parameter.
- `priorityArray` is an integer array containing the interrupt numbers specified in the **VME interrupt number(s)** parameter.

The following code excerpt shows the call to `ssSetAsyncTaskPriorities`:

```c
/* Setup Async Task Priorities */
    priorityArray = malloc(numISRs*sizeof(int_T));
    for (i=0; i<numISRs; i++) {
        priorityArray[i] = (int_T)(mxGetPr(ISR_PRIORITIES)[i]);
```
SS_OPTION Settings

The code excerpt below shows the SS_OPTION settings for vxinterrupt1.c. SS_OPTION ASYNCHRONOUS_INTERRUPT should be used when a function call subsystem is attached to an interrupt. For more information, see the documentation for SS_OPTION and SS_OPTION ASYNCHRONOUS in matlabroot/simulink/include/simstruc.h.

ssSetOptions( S, (SS_OPTION_EXCEPTION_FREE_CODE |
SS_OPTION_DISALLOW_CONSTANT_SAMPLE_TIME | 
SS_OPTION ASYNCHRONOUS_INTERRUPT | 

If an S-function specifies the SS_OPTION_DISALLOW_CONSTANT_SAMPLE_TIME option and inherits a sample time of Inf, the code generator determines how to produce code for the block based on whether the block is invariant. A block is invariant if its port signals are invariant. A signal is invariant if it has a constant value during the entire simulation. A Constant block sample time does not guarantee that the port signals are invariant. For more information, see “Inline Invariant Signals” on page 33-44. If the block is not invariant, the code generator produces code only in the initialize entry-point function. If the block is invariant, the code generator does not produce code for the block.

TLC Implementation

This section discusses each function of vxinterrupt1.tlc, with an emphasis on target-specific features that you will need to change to generate code for your target RTOS.

Generate #include Directives

vxinterrupt1.tlc begins with the statement

%include "vxlib.tlc"

vxlib.tlc is a target-specific file that generates directives to include header files for the example RTOS (VxWorks). You should replace this with a file that generates includes for your target RTOS.
**BlockInstanceSetup Function**

For each connected output of the Async Interrupt block, `BlockInstanceSetup` defines a function name for the corresponding ISR in the generated code. The functions names are of the form

\[ \text{isr\_num\_vec\_offset} \]

where \textit{num} is the ISR number defined in the **VME interrupt number(s)** block parameter, and \textit{offset} is an interrupt table offset defined in the **VME interrupt vector offset(s)** block parameter.

In a custom implementation, this naming convention is optional.

The function names are cached for use by the `Outputs` function, which generates the actual ISR code.

**Outputs Function**

`Outputs` iterates over the connected outputs of the Async Interrupt block. An ISR is generated for each such output.

The ISR code is cached in the "Functions" section of the generated code. Before generating the ISR, `Outputs` does the following:

- Generates a call to the downstream block (cached in a temporary buffer).
- Determines whether the ISR should be locked or not (as specified in the **Preemption Flag(s)** block parameter).
- Determines whether the block connected to the Async Interrupt block is a Task Sync block. (This information is obtained by using the `asynclib` calls `LibGetFcnCallBlock` and `LibGetBlockAttribute`.) If so,
  - The preemption flag for the ISR must be set to 1. An error results otherwise.
  - The RTOS (VxWorks) calls to save and restore floating-point context are generated, unless the user has configured the model for integer-only code generation.

When generating the ISR code, `Outputs` calls the `asynclib` function `LibNeedAsyncCounter` to determine whether a timer is required by the connected subsystem. If so, and if the time source is set to be **SS_TIMESOURCE_SELF** by `ssSetTimeSource`, `LibSetAsyncCounter` is called to generate an RTOS (VxWorks) `tickGet` function call and update the counter. In your implementation, you should
generate either an equivalent call to the target RTOS, or generate code to read the a
timer register on the target hardware.

**Start Function**

The **Start** function generates the required RTOS (VxWorks) calls (int_connect and
sysInt_Enable) to connect and enable each ISR. You should replace this with calls to
your target RTOS.

**Terminate Function**

The **Terminate** function generates the call sysIntDisable to disable each ISR. You
should replace this with calls to your target RTOS.

**Task Sync Block Implementation**

The source files for the Task Sync block are located in `matlabroot/rtw/c/tornado/
devices` (open). They are

- `vxtask1.cpp`: MEX-file source code, for use in configuration and simulation.
- `vxtask1.tlc`: TLC implementation, for use in code generation.
- `asynclib.tlc`: library of TLC support functions, called by the TLC implementation of
  the block. The library calls are summarized in “asynclib.tlc Support Library” on page
  5-52.

**C MEX Block Implementation**

Like the Async Interrupt block, the Task Sync block sets up a timer, in this case with a
fixed resolution. The priority of the task associated with the block is obtained from the
**Simulink task priority** parameter. The **SS_OPTION** settings are the same as those used
for the Async Interrupt block.

```c
ssSetAsyncTimerAttributes(S, 0.01);
priority = (int_T) (*mxGetPr(PRIORITY));
ssSetAsyncTaskPriorities(S, 1, &priority);

ssSetOptions(S, (SS_OPTION_EXCEPTION_FREE_CODE |
               SS_OPTION_ASYNCHRONOUS |
               SS_OPTION_DISALLOW_CONSTANT_SAMPLE_TIME |}
```
**TLC Implementation**

**Generate #include Directives**

`vxtask1.tlc` begins with the statement

```
#include "vxlib.tlc"
```

`vxlib.tlc` is a target-specific file that generates directives to include header files for the example RTOS (VxWorks). You should replace this with a file that generates includes for your target RTOS.

**BlockInstanceSetup Function**

The `BlockInstanceSetup` function derives the task name, block name, and other identifiers used later in code generation. It also checks for and warns about unconnected block conditions, and generates a storage declaration for a semaphore (`stopSem`) that is used in case of interrupt overflow conditions.

**Start Function**

The `Start` function generates the required RTOS (VxWorks) calls to define storage for the semaphore that is used in management of the task spawned by the Task Sync block. Depending on the value of the `CodeFormat` TLC variable of the target, either a static storage declaration or a dynamic memory allocation call is generated. This function also creates a semaphore (`semBCreate`) and spawns an RTOS task (`taskSpawn`). You should replace these with calls to your target RTOS.

**Outputs Function**

The `Outputs` function generates an example RTOS (VxWorks) task that waits for a semaphore. When it obtains the semaphore, it updates the block's tick timer and calls the downstream subsystem code, as described in “Spawn and Synchronize Execution of RTOS Task” on page 5-15. `Outputs` also generates code (called from interrupt level) that grants the semaphore.

**Terminate Function**

The `Terminate` function generates the example RTOS (VxWorks) call `taskDelete` to end execution of the task spawned by the block. You should replace this with calls to your target RTOS.

Note also that if the target RTOS has dynamically allocated memory associated with the task, the `Terminate` function should deallocate the memory.
asynclib.tlc Support Library

asynclib.tlc is a library of TLC functions that support the implementation of asynchronous blocks. Some functions are specifically designed for use in asynchronous blocks. For example, `LibSetAsyncCounter` generates a call to update a timer for an asynchronous block. Other functions are utilities that return information required by asynchronous blocks (for example, information about connected function call subsystems).

The following table summarizes the public calls in the library. For details, see the library source code and the `vxinterrupt1.tlc` and `vxtask1.tlc` files, which call the library functions.

### Summary of asynclib.tlc Library Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>LibBlockExecuteFcnCall</code></td>
<td>For use by inlined S-functions with function call outputs. Generates code to execute a function call subsystem.</td>
</tr>
<tr>
<td><code>LibGetBlockAttribute</code></td>
<td>Returns a field value from a block record.</td>
</tr>
<tr>
<td><code>LibGetFcnCallBlock</code></td>
<td>Given an S-Function block and call index, returns the block record for the downstream function call subsystem block.</td>
</tr>
<tr>
<td><code>LibGetCallerClockTickCounter</code></td>
<td>Provides access to the time counter of an upstream asynchronous task.</td>
</tr>
<tr>
<td><code>LibGetCallerClockTickCounterHighWord</code></td>
<td>Provides access to the high word of the time counter of an upstream asynchronous task.</td>
</tr>
<tr>
<td><code>LibManageAsyncCounter</code></td>
<td>Determines whether an asynchronous task needs a counter and manages its own timer.</td>
</tr>
<tr>
<td><code>LibNeedAsyncCounter</code></td>
<td>If the calling block requires an asynchronous counter, returns TLC_TRUE, otherwise returns TLC_FALSE.</td>
</tr>
<tr>
<td><code>LibSetAsyncClockTicks</code></td>
<td>Returns code that sets clockTick counters that are to be maintained by the asynchronous task.</td>
</tr>
<tr>
<td><code>LibSetAsyncCounter</code></td>
<td>Generates code to set the tick value of the block's asynchronous counter.</td>
</tr>
<tr>
<td><code>LibSetAsyncCounterHighWord</code></td>
<td>Generates code to set the tick value of the high word of the block's asynchronous counter.</td>
</tr>
</tbody>
</table>
See Also

More About

- “Asynchronous Events” on page 5-2
- “Generate Interrupt Service Routines” on page 5-6
- “Spawn and Synchronize Execution of RTOS Task” on page 5-15
- “Pass Asynchronous Events in RTOS as Input To a Referenced Model” on page 5-32
- “Timers in Asynchronous Tasks” on page 5-42
- “Import Asynchronous Event Data for Simulation” on page 5-54
- “Rate Transitions and Asynchronous Blocks” on page 5-36
- “Asynchronous Support Limitations” on page 5-58
Import Asynchronous Event Data for Simulation

Capabilities
You can import asynchronous event data into a function-call subsystem via an Inport block. For standalone fixed-step simulations, you can specify:

- The time points at which each asynchronous event occurs
- The number of asynchronous events at each time point

Input Data Format
You can enter your asynchronous data at the MATLAB command line or on the Data Import/Export pane of the Configuration Parameters dialog box. In either case, a number of restrictions apply to the data format.

- The expression for the parameter Data Import/Export > Input must be a comma-separated list of tables.
- The table corresponding to the input port outputting asynchronous events must be a column vector containing time values for the asynchronous events.
  - The time vector of the asynchronous events must be of double data type and monotonically increasing.
  - All time data must be integer multiples of the model step size.
  - To specify multiple function calls at a given time step, you must repeat the time value accordingly. In other words, if you wish to specify three asynchronous events at $t = 1$ and two events at $t = 9$, then you must list 1 three times and 9 twice in your time vector. ($t = [1 1 1 9 9]'$)
- The table corresponding to normal data input port can be of any other supported format.

See “Load Data to Root-Level Input Ports” (Simulink) for more information.

Example
In this model, a function-call subsystem is used to track the total number of asynchronous events and to multiply a set of inputs by 2.
To input data via the Configuration Parameters dialog box,

a. Select **Simulation > Configuration Parameters > Data Import/Export**.

b. Select the **Input** parameter.

c. For this example, enter the following command in the MATLAB window:

```
>> t = [1 1 5 9 9 9]', u = [ [0:10]' [0:10]' ]
```

Alternatively, you can enter the data as $t$, $tu$ in the Data Import/Export pane:
Here, \( t \) is a column vector containing the times of asynchronous events for Inport block In1 while \( tu \) is a table of input values versus time for Inport block In2.

2 By default, the **Time** and **Output** options are selected and the output variables are named \( tout \) and \( yout \).

3 Simulate the model.

4 Display the output by entering \([tout \ yout]\) at the MATLAB command line and obtain:

\[
\begin{array}{ccc}
0 & 0 & -1 \\
1 & 2 & 2 \\
2 & 2 & 2 \\
3 & 2 & 2 \\
4 & 2 & 2 \\
5 & 3 & 10 \\
6 & 3 & 10 \\
7 & 3 & 10 \\
8 & 3 & 10 \\
9 & 6 & 18 \\
10 & 6 & 18
\end{array}
\]

Here the first column contains the simulation times.

The second column represents the output of Out1 — the total number of asynchronous events. Since the function-call subsystem is triggered twice at \( t = 1 \), the output is 2. It is not called again until \( t = 5 \), and so does not increase to 3 until then. Finally, it is called three times at 9, so it increases to 6.
The third column contains the output of Out2 obtained by multiplying the input value at each asynchronous event time by 2. At any other time, the output is held at its previous value.

**See Also**

**More About**
- “Asynchronous Events” on page 5-2
- “Pass Asynchronous Events in RTOS as Input To a Referenced Model” on page 5-32
- “Load Data to Root-Level Input Ports” (Simulink)
- “Rate Transitions and Asynchronous Blocks” on page 5-36
Asynchronous Support Limitations

In this section...

“Asynchronous Task Priority” on page 5-58
“Convert an Asynchronous Subsystem into a Model Reference” on page 5-58

Asynchronous Task Priority

The Simulink product does not simulate asynchronous task behavior. Although you can specify a task priority for an asynchronous task represented in a model with the Task Sync block, the priority setting is for code generation purposes only and is not honored during simulation.

Convert an Asynchronous Subsystem into a Model Reference

You can use the Asynchronous Task Specification block to specify an asynchronous function-call input to a model reference. However, you must convert the Async Interrupt and Function-Call blocks into a subsystem and then convert the subsystem into a model reference.

Following is an example with step-by-step instructions for conversion.

1. Convert the Async Interrupt and Count blocks into a subsystem. Select both blocks and right-click Count. From the menu, select **Subsystem & Model Reference > Create Subsystem from Selection**.
To prepare for converting the new subsystem to a Model block, set the following configuration parameters in the top model. Open the Configuration Parameters dialog box.

- Under Diagnostics, navigate to the Sample Time pane. Then set **Multitask rate transition** to **error** and **Multitask conditionally executed subsystem** to **error**.

- Under Diagnostics, navigate to the Connectivity pane. Set **Bus signal treated as vector**, and **Invalid function-call connection** to **error**. Also set **Context-dependent inputs** to **Enable All**.

- Under Diagnostics, navigate to the Data Validity pane and set the **Multitask data store** option to **error**.

- Set the **Configuration Parameters > Diagnostics > Data Validity > Advanced parameters > Underspecified initialization detection** parameter to **Simplified**.

- If your model is large or complex, run the Model Advisor checks in the folder “Migrating to Simplified Initialization Mode Overview” (Simulink) and make the suggested changes.

Convert the subsystem to an atomic subsystem. Select **Edit > Subsystem Parameters > Treat as atomic unit**.
4 Convert the subsystem to a Model block. Right-click the subsystem and select **Subsystem & Model Reference > Convert Subsystem to > Referenced Model**. A window opens with a model reference block inside of it.

5 Replace the subsystem in the top model with the new model reference block.

6 Move the Async Interrupt block from the model reference to the top model, before the model reference block.
7  Insert an Asynchronous Task Specification block in the model reference. Set the priority of the Asynchronous Task Specification block. (For more information on setting the priority, see Asynchronous Task Specification.)

8  In the model reference, double-click the input port to open its Source Block Parameters dialog box. Click the Signal Attributes tab and select the Output function call option. Click OK.
9 Save your model and then perform **Simulation > Update Diagram** to verify your settings.
See Also

More About

• “Asynchronous Events” on page 5-2
Subsystems in Simulink Coder

- “Control Generation of Subsystem Functions” on page 6-2
- “Generate Code and Executables for Individual Subsystems” on page 6-4
- “Inline Subsystem Code” on page 6-8
- “Generate Subsystem Code as Separate Function and Files” on page 6-11
- “Optimize Code for Identical Nested Subsystems” on page 6-12
- “Code Generation of Constant Parameters” on page 6-13
Control Generation of Subsystem Functions

What is a Subsystem Function?

A subsystem function is function code that the code generator produces for a subsystem in a model. The function interface and how the code generator packages the code depends on whether the subsystem is a virtual or atomic (nonvirtual) subsystem and how you configure the subsystem block parameters. For more information, see Subsystem, Atomic Subsystem, Nonvirtual Subsystem, CodeReuse Subsystem.

Options for Controlling Generation of Subsystem Function Code

You can design and configure a model in a way that controls how the code generator produces code from subsystems.

<table>
<thead>
<tr>
<th>To</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate inlined code from a selected subsystem.</td>
<td>“Inline Subsystem Code” on page 6-8</td>
</tr>
<tr>
<td>Generate code for only a subsystem.</td>
<td>“Generate Code and Executables for Individual Subsystems” on page 6-4</td>
</tr>
<tr>
<td>Generate separate functions without arguments, and optionally place the subsystem code in a separate file.</td>
<td>“Generate Subsystem Code as Separate Function and Files” on page 6-11</td>
</tr>
<tr>
<td>Generate a single reentrant function for a subsystem that is included in multiple places within a model.</td>
<td>“Generate Reentrant Code from Subsystems” on page 9-43</td>
</tr>
<tr>
<td>Generate a single reentrant function for a subsystem that is included in multiple places in a model reference hierarchy.</td>
<td>“Generate Reusable Code from Library Subsystems Shared Across Models” on page 9-55</td>
</tr>
</tbody>
</table>

Subsystem Function Dependence

Code generated from subsystems can be completely independent of code generated for a model. When generating code for a subsystem, the code can reference global data structures of the model, even if the subsystem function code is in a separate file. Each
subsystem code file contains include directives and comments describing the dependencies. The code generator checks for cyclic file dependencies and warns about them at build time. For descriptions of how the code generator packages code, see “Manage Build Process File Dependencies” on page 21-53.

To generate subsystem function code that is independent of the code generated for the parent model, place the subsystem in a library and configure it as a reusable subsystem, as explained in “Generate Reusable Code from Library Subsystems Shared Across Models” on page 9-55.

See Also

Related Examples

• “Modeling Guidelines for Subsystems” (Embedded Coder)
Generate Code and Executables for Individual Subsystems

You can generate code and build an executable for a subsystem within a model. The code generation and build process uses the code generation and build parameters of the root model.

1. In the Configuration Parameters dialog box, set up the code generation and build parameters, similar to setting up the code generation for a model.

2. Right-click the Subsystem block. From the context menu, select C/C++ Code > Build This Subsystem from the context menu.

   Alternatively, in the current model, click a subsystem and then from the Code menu, select C/C++ Code > Build Selected Subsystem.

   **Note** When you select Build This Subsystem, if the model is operating in external mode, the build process automatically turns off external mode for the duration of the build. The code generator restores external mode upon completion of the build process.

3. The Build code for Subsystem window displays a list of the subsystem parameters. The upper pane displays the name, class, and storage class of each variable (or data object) that is referenced as a block parameter in the subsystem. When you select a parameter in the upper pane, the lower pane shows the blocks that reference the parameter and the parent system of each block.

   The Storage Class column contains a menu for each row. The menu options set the storage class or inline the parameter. To declare a parameter to be tunable, set the Storage Class to a value other than Inlined.
For more information on tunable and inlined parameters and storage classes, see “Create Tunable Calibration Parameter in the Generated Code” on page 15-122.

4 After selecting tunable parameters, **Build** to initiate the code generation and build process.

5 The build process displays status messages in the MATLAB Command Window. When the build is complete, the generated executable is in your working folder. The name of the generated executable is `subsystem.exe` (on PC platforms) or `subsystem` (on The Open Group UNIX platforms). `subsystem` is the name of the source subsystem block.

The generated code is in a build subfolder, named `subsystem_target_rtw`. `subsystem` is the name of the source subsystem block and `target` is the name of the target configuration.

When you generate code for a subsystem, you can generate an S-function by selecting **Code > C/C++ Code > Generate S-Function**, or you right-click the subsystem block and select **C/C++ Code > Build This Subsystem** from the context menu. For more information on S-functions, see “Generate S-Function from Subsystem” on page 14-74.
**Subsystem Build Limitations**

The following limitations apply to building subsystems:

- Subsystem build does not support a subsystem that has a function-call trigger input or a function-call output.

- When you right-click a subsystem block and select **C/C++ Code > Build This Subsystem** from the context menu to build a subsystem that includes an Outport block for which the **Data type** parameter specifies a bus object, you must address errors that result from setting signal labels. To configure the software to display these errors, in the Configuration Parameters dialog box for the parent model, on the **Diagnostics > Connectivity** pane, set the **Signal label mismatch** parameter to **error**.

- When a subsystem is in a triggered or function-call subsystem, the right-click build process might fail if the subsystem code is not sample-time independent. To find out whether a subsystem is sample-time independent:

  1. Copy all blocks in the subsystem to an empty model.
  2. In the Configuration Parameters dialog box, on the **Solver** pane, set:
      a. **Type** to Fixed-step.
      b. **Periodic sample time constraint** to **Ensure sample time independent**.
      c. Click **Apply**.
  3. Update the model. If the model is sample-time dependent, Simulink generates an error in the process of updating the diagram.

- When you use the right-click build process for a subsystem, the code generator attempts to use the subsystem name for generated code files. In some cases, there can be a conflict with the name that you specify when you set, for example, **File name options** to **Use function name** or **Function name options** to **Use subsystem name**. You see an error:

  The subsystem 'model/subsys'
  is trying to generate code to an reserved file (subsys) for
  the model 'subsys'...

  To resolve the error, modify one of the conflicting file names so that the names are unique.
• In a subsystem build warning, the subsystem block path hyperlink that is created references a temporary model block path instead of the actual model block path. In the Diagnostic Viewer, clicking the subsystem hyperlink does not take you to the block. In the Command Window, you see a message:

... 
No system or file called 'subsystemName' found. 
...


Inline Subsystem Code

You can configure a nonvirtual subsystem to inline the subsystem code with the model code. In the Subsystem Parameters dialog box, setting the Function packaging parameter to Auto or Inline inlines the generated code of the subsystem.

The Auto option is the default. When there is only one instance of a subsystem in the model, the Auto option inlines the subsystem code. When multiple instances of a subsystem exist, the Auto option results in a single copy of the function (as a reusable function). For function-call subsystems with multiple callers, the subsystem code is generated as if you specified Nonreusable function.

To inline subsystem code, select Inline. The Inline option explicitly directs the code generator to inline the subsystem unconditionally.

Configure Subsystem to Inline Code

To configure your subsystem for inlining:

1. Right-click the Subsystem block. From the context menu, select Block Parameters (Subsystem).
2. In the Subsystem Parameters dialog box, if the subsystem is virtual, select Treat as atomic unit. This option makes the subsystem nonvirtual. On the Code Generation tab, the Function packaging option is now available.

If the system is already nonvirtual, the Function packaging option is already selected.

3. Click the Code Generation tab and select Auto or Inline from the Function packaging parameter.
4 Click **Apply** and close the dialog box.

The border of the subsystem thickens, indicating that it is nonvirtual.

When you generate code from your model, the code generator inlines subsystem code within `model.c` or `model.cpp` (or in its parent system's source file). You can identify this code by system/block identification tags, such as:

```c
/* Atomic SubSystem Block: <Root>/AtomicSubsys1 */
```

## Exceptions to Inlining

There are certain cases in which the code generator does not inline a nonvirtual subsystem, even though the **Inline** option is selected.

- If the subsystem is a function-call subsystem that is called by a noninlined S-function, the **Inline** option is ignored. Noninlined S-functions make calls by using function pointers. Therefore, the function-call subsystem must generate a function with all arguments present.
• In a feedback loop involving function-call subsystems, the code generator forces one of the subsystems to be generated as a function instead of inlining it. Based on the order in which the subsystems are sorted internally, the software selects the subsystem to be generated as a function.

• If a subsystem is called from an S-function block that sets the option `SS_OPTION_FORCE_NONINLINED_FCNCALL` to TRUE, it is not inlined. When user-defined Async Interrupt blocks or Task Sync blocks are present, this result might occur. Such blocks must be generated as functions. These blocks are located in the `vxlib1` block library and use the `SS_OPTION_FORCE_NONINLINED_FCNCALL` option. This library demonstrates integration with an example RTOS (VxWorks).³

**Note** You can use the blocks in the `vxlib1` on page 5-2 library (Async Interrupt and Task Sync) for simulation and code generation. These blocks provide starting point examples to help you develop custom blocks for your target environment.

---

³ VxWorks is a registered trademark of Wind River Systems, Inc.
Generate Subsystem Code as Separate Function and Files

To generate a separate subsystem function and a separate file for a subsystem in a model:

1. Right-click a Subsystem block. From the context menu, select **Block Parameters (Subsystem)**.

2. In the Subsystem Parameters dialog box, if the subsystem is virtual, select **Treat as atomic unit**. On the **Code Generation** tab, the **Function packaging** parameter is now available.

3. Click the **Code Generation** tab and select **Nonreusable function** from the **Function packaging** parameter. The **Nonreusable function** option enables two parameters:

   - The “Function name options” (Simulink) parameter controls the naming of the generated function.
   - The “File name options” (Simulink) parameter controls the naming of the generated file.

4. Set the **Function name options** parameter.

5. Set the **File name options** parameter to a value other than **Auto**. If you are generating a reusable function for your subsystem, see “Generate Reentrant Code from Subsystems” on page 9-43 or “Generate Reusable Code from Library Subsystems Shared Across Models” on page 9-55.

6. Click **Apply** and close the dialog box.
Optimize Code for Identical Nested Subsystems

The **Function packaging** parameter `Auto` option can optimize code in situations in which identical subsystems contain other identical subsystems, by both reusing and inlining generated code. Suppose a model, such as the one shown in “Reuse of Identical Nested Subsystems” on page 6-12, contains identical subsystems `A1` and `A2`. `A1` contains subsystem `B1`, and `A2` contains subsystem `B2`, which are identical. In such cases, the `Auto` option causes one function to be generated which is called for both `A1` and `A2`. This function contains one piece of inlined code to execute `B1` and `B2`. This optimization generates less code which improves execution speed.

**Reuse of Identical Nested Subsystems**

Special Case Optimization:
When `B1=B2` and `A1=A2`, selecting the `Auto` option inlines code for `B` within code for function `A`
Code Generation of Constant Parameters

The code generator attempts to generate constant parameters to the shared utilities folder first. If constant parameters are not generated to the shared utilities folder, they are defined in the top model in a global constant parameter structure. The declaration of the structure, ConstParam_model, is in model.h:

```c
/* Constant parameters (auto storage) */
typedef struct {
    /* Expression: [1 2 3 4 5 6 7]
    * Referenced by: '<Root>/Constant'
    */
    real_T Constant_Value[7];

    /* Expression: [7 6 5 4 3 2 1]
    * Referenced by: '<Root>/Gain'
    */
    real_T Gain_Gain[7];
} ConstParam_model;
```

The definition of the constant parameters, model_constP, is in:

```c
/* Constant parameters (auto storage) */
const ConstParam_model model_ConstP = {
    /* Expression: [1 2 3 4 5 6 7]
    * Referenced by: '<Root>/Constant'
    */
    { 1.0, 2.0, 3.0, 4.0, 5.0, 6.0, 7.0 },

    /* Expression: [7 6 5 4 3 2 1]
    * Referenced by: '<Root>/Gain'
    */
    { 7.0, 6.0, 5.0, 4.0, 3.0, 2.0, 1.0 }
};
```

The model_constP is passed as an argument to referenced models.
See Also

Related Examples

•  “How Generated CodeStores Internal Signal, State, and Parameter Data” on page 15-50
Referenced Models in Simulink Coder

- “Code Generation of Referenced Models” on page 7-2
- “Generate Code for Referenced Models” on page 7-4
- “Configure Referenced Models” on page 7-14
- “Build Model Reference Targets” on page 7-15
- “Simulink Coder Model Referencing Requirements” on page 7-16
- “Storage Classes for Signals Used with Model Blocks” on page 7-21
- “Inherited Sample Time for Referenced Models” on page 7-25
- “Customize Library File Suffix and File Type” on page 7-27
- “Simulink Coder Model Referencing Limitations” on page 7-28
Code Generation of Referenced Models

This section describes model referencing considerations that apply specifically to code generation by the Simulink Coder. This section assumes that you understand referenced models and related terminology and requirements, as described in “Model Reference Basics” (Simulink) and associated topics.

When generating code for a referenced model hierarchy, the code generator produces a stand-alone executable for the top model, and a library module called a model reference target for each referenced model. When the code executes, the top executable invokes the model reference targets to compute the referenced model outputs. Model reference targets are sometimes called Simulink Coder targets.

Be careful not to confuse a model reference target (Simulink Coder target) with other types of targets:

- Target hardware — A platform for which the Simulink Coder software generates code
- System target — A file that tells the Simulink Coder software how to generate code for particular purpose
- Rapid Simulation target (RSim) — A system target file supplied with the Simulink Coder product
- Simulation target — A MEX-file that implements a referenced model that executes with Simulink Accelerator™ software

The code generator places the code for the top model of a hierarchy in the code generation folder (Simulink) and places the code for referenced models in an slprj folder in the code generation folder (Simulink). Subfolders in slprj provide separate places for different types of files. For folder information, see “Manage Build Process Folders” on page 21-37.

By default, the product uses incremental code generation. When generating code, it compares structural checksums of referenced model files with the generated code files to determine whether to regenerate model reference targets. To control when rebuilds occur, use the configuration parameter Model Referencing > Rebuild. For details, see “Rebuild” (Simulink).

In addition to incremental code generation, the Simulink Coder software uses incremental loading. The code for a referenced model is not loaded into memory until the code for its parent model executes and needs the outputs of the referenced model. The product then
loads the referenced model target and executes. Once loaded, the target remains in memory until it is no longer used.

Most code generation considerations are the same whether or not a model includes referenced models: the code generator handles the details automatically insofar as possible. This chapter describes topics that you may need to consider when generating code for a model reference hierarchy.

If you have a Embedded Coder license, custom targets must declare themselves to be model reference compliant if they need to support Model blocks. For more information, see “Support Model Referencing” on page 39-84.
Generate Code for Referenced Models

In this section...

“About Generating Code for Referenced Models” on page 7-4
“Create and Configure the Subsystem” on page 7-4
“Convert Model to Use Model Referencing” on page 7-7
“Generate Model Reference Code for a GRT Target” on page 7-10
“Work with Code Generation Folders” on page 7-12

About Generating Code for Referenced Models

To generate code for referenced models, you

1. Create a subsystem in an existing model.
2. Convert the subsystem to a referenced model (Model block).
3. Call the referenced model from the top model.
4. Generate code for the top model and referenced model.
5. Explore the generated code and the code generation folder.

You can accomplish some of these tasks automatically with a function called Simulink.Subsystem.convertToModelReference.

Create and Configure the Subsystem

In the first part of this example, you define a subsystem for the vdp example model, set configuration parameters for the model, and use the Simulink.Subsystem.convertToModelReference function to convert it into two new models — the top model (vdptop) and a referenced model vdpmultRM containing a subsystem you created (vdpmult).

1. In the MATLAB Command Window, create a new working folder wherever you want to work and cd into it:

   mkdir mrexample
   cd mrexample

2. Open the vdp example model by typing:
3 Drag a box around the three blocks outlined in blue below:

4 Choose Create Subsystem from Selection from the Diagram > Subsystem & Model Reference menu.

A subsystem block replaces the selected blocks.

5 If the new subsystem block is not where you want it, move it to a preferred location.

6 Rename the block vdpmult.

7 Right-click the vdpmult block and select Block Parameters (Subsystem).

The Function Block Parameters dialog box appears.

8 In the Function Block Parameters dialog box, select Treat as atomic unit, then click OK.

The border of the vdpmult subsystem thickens to indicate that it is now atomic. An atomic subsystem executes as a unit relative to the parent model: subsystem block execution does not interleave with parent block execution. This property makes it possible to extract subsystems for use as stand-alone models and as functions in generated code.
You must set several properties before you can extract a subsystem for use as a referenced model. To set the properties,

1. Open Model Explorer by selecting **Model Explorer** from the model's **View** menu.
2. In the **Model Hierarchy** pane, click the symbol preceding the model name to reveal its components.
3. Click **Configuration (Active)** in the left pane.
4. In the center pane, select **Solver**.
5. In the right pane, under **Solver selection** change the **Type** to **Fixed-step**, then click **Apply**. You must use fixed-step solvers when generating code, although referenced models can use different solvers than top models.
6. In the center pane, select **Diagnostics**. In the right pane, select the **Data Validity** tab. In the **Signals** area, set **Signal resolution** to **Explicit only**. Alternatively, if you do not want to use Simulink.Signal objects, set **Signal resolution** to **None**.
7. Click **Apply**.

The model now has the properties that model referencing requires.
In the center pane, click **Model Referencing**. In the right pane, set **Rebuild** to **If any changes in known dependencies detected**. Click **Apply**. This setting prevents code regeneration when it is not required.

In the vdp model window, choose **File > Save as**. Save the model as vdptop in your working folder. Leave the model open.

### Convert Model to Use Model Referencing

In this portion of the example, you use the conversion function `Simulink.SubSystem.convertToModelReference` to extract the subsystem `vdpmult` from `vdptop` and convert `vdpmult` into a referenced model named `vdpmultRM`. To see the complete syntax of the conversion function, type at the MATLAB prompt:

```
help Simulink.SubSystem.convertToModelReference
```

For additional information, type:

```
doc Simulink.SubSystem.convertToModelReference
```

If you want to see an example of `Simulink.SubSystem.convertToModelReference` before using it yourself, type:

```
sldemo_mdlref_conversion
```

Simulink also provides a menu command, **Subsystem & Model Reference > Convert Subsystem to > Referenced Model**, that you can use to convert a subsystem to a referenced model. The command calls `Simulink.SubSystem.convertToModelReference` with default arguments. For more information, see “Convert Subsystems to Referenced Models” (Simulink).

### Extract the Subsystem to a Referenced Model

To use `Simulink.SubSystem.convertToModelReference` to extract `vdpmult` and convert it to a referenced model, type:

```
Simulink.SubSystem.convertToModelReference('vdptop/vdpmult', 'vdpmultRM',
'ReplaceSubsystem', true, 'BuildTarget', 'Sim')
```

This command:

1. Extracts the subsystem `vdpmult` from `vdptop`. 
Converts the extracted subsystem to a separate model named \texttt{vdpmultRM} and saves the model to the working folder.

In \texttt{vdptop}, replaces the extracted subsystem with a Model block that references \texttt{vdpmultRM}.

Creates a simulation target for \texttt{vdptop} and \texttt{vdpmultRM}.

The converter prints progress messages and terminates with

\begin{verbatim}
ans =
1
\end{verbatim}

The parent model \texttt{vdptop} now looks like this:

Note the changes in the appearance of the block \texttt{vdpmult}. These changes indicate that it is now a Model block rather than a subsystem. As a Model block, it does not have contents of its own: the previous contents now exist in the referenced model \texttt{vdpmultRM}, whose name appears at the top of the Model block. Widen the Model block to expose the complete name of the referenced model.

If the parent model \texttt{vdptop} had been closed at the time of conversion, the converter would have opened it. Extracting a subsystem to a referenced model does \textit{not} automatically create or change a saved copy of the parent model. To preserve the changes to the parent model, save \texttt{vdptop}.

Right-click the Model block \texttt{vdpmultRM} and choose \textbf{Open} to open the referenced model. The model looks like this:
Files Created and Changed by the Converter

The files in your working folder now consist of the following (not in this order).

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vdptop model file</td>
<td>Top model that contains a Model block where the vdpmult subsystem was</td>
</tr>
<tr>
<td>vdpmultRM model file</td>
<td>Referenced model created for the vdpmult subsystem</td>
</tr>
<tr>
<td>vdpmultRM_msf.mexw64</td>
<td>Static library file (Microsoft Windows platforms only). The file extension is</td>
</tr>
<tr>
<td></td>
<td>system-dependent and may differ. This file executes when the vdptop</td>
</tr>
<tr>
<td></td>
<td>model calls the Model block vdpmult. When called, vdpmult in turn calls the</td>
</tr>
<tr>
<td></td>
<td>referenced model vdpmultRM.</td>
</tr>
<tr>
<td>/slprj</td>
<td>Folder for generated model reference code</td>
</tr>
</tbody>
</table>

Code for model reference simulation targets is placed in the slprj/sim subfolder.
Generated code for GRT, ERT, and other Simulink Coder targets is placed in slprj subfolders named for those targets. You will inspect some model reference code later in this example. For more information on code generation folders, see “Work with Code Generation Folders” on page 7-12.

Run theConverted Model

Open the Scope block in vdptop if it is not visible. In the vdptop window, click the Run tool or choose Run from the Simulation menu. The model calls the vdpmultRM_msf simulation target to simulate. The output looks like this:
Generate Model Reference Code for a GRT Target

The function `Simulink.SubSystem.convertToModelReference` created the model and the simulation target files for the referenced model `vdpmultRM`. In this part of the example, you generate code for that model and the `vdptop` model, and run the executable you create:

1. Verify that you are still working in the `mrexample` folder.
2. If the model `vdptop` is not open, open it. Make sure it is the active window.
3. Open Model Explorer by selecting `Model Explorer` from the model's `View` menu.
4. In the `Model Hierarchy` pane, click the symbol preceding the `vdptop` model to reveal its components.
5. Click `Configuration (Active)` in the left pane.
6. In the center pane, select `Data Import/Export`.
7. In the pane, select `Time` and `Output` and clear `Data stores`. Click `Apply`.

These settings instruct the model `vdptop` (and later its executable) to log time and output data to MAT-files for each time step.

8. Generate GRT code (the default) and an executable for the top model and the referenced model. For example, in the model, press `Ctrl+B`. 
The Simulink Coder build process generates and compiles code. The current folder now contains a new file and a new folder:

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>vdptop.exe</td>
<td>The executable created by the build process</td>
</tr>
<tr>
<td>vdptop_grt_rtw/</td>
<td>The build folder, containing generated code for the top model</td>
</tr>
</tbody>
</table>

The build process also generated GRT code for the referenced model and placed it in the slprj folder.

To view a model’s generated code in Model Explorer, the model must be open. To use the Model Explorer to inspect the newly created build folder, vdptop_grt_rtw:

1. Open Model Explorer by selecting Model Explorer from the model's View menu.
2. In the Model Hierarchy pane, click the symbol preceding the model name to reveal its components.
3. Click the symbol preceding Code for vdptop to reveal its components.
4. Directly under Code for vdptop, click This Model.

A list of generated code files for vdptop appears in the Contents pane:

- rtmodel.h
- vdptop.c
- vdptop.h
- vdptop.mk
- vdptop_private.h
- vdptop_types.h

You can browse code by selecting a file of interest in the Contents pane.

To open a file in a text editor, click a filename, and then click the hyperlink that appears in the gray area at the top of the Document pane. The figure below illustrates viewing code for vdptop.c, in a text editor. Your code may differ.
To view the generated code in the HTML code generation report, see “Generate a Code Generation Report” on page 22-6.

Work with Code Generation Folders

Model reference code is generated in your code generation folder (Simulink) and simulation target code is generated in your simulation cache folder (Simulink). Because of this process, there are constraints on:

- When and where model reference targets are built.
- How the model reference targets are accessed.

The models referenced by Model blocks can be stored anywhere on the MATLAB path. A given top model can include models stored on different file systems or in different folders. The same is not true for the simulation targets and generated code derived from these models. Under most circumstances, to allow code reuse, models referenced by a given top model must be set up to simulate and generate model reference target code in a single code generation folder.

This means that, if you reference the same model from several top models, each stored in a different folder, you must choose one of these approaches:

- Always work with the same code generation folder and be sure that the models are on your path.
• Allow separate code generation folders, simulation targets, and Simulink Coder targets to be generated in each folder in which you work.

The second approach requires maintenance of several instances of the model reference code and it is possible for generated code to become redundant. For example, when you make changes to the referenced model. Therefore, to minimize code regeneration of referenced models, choose a specific code generation folder for all sessions.

See Also

Related Examples

• “Specify Instance-Specific Parameter Values for Reusable Referenced Model” on page 15-143
• “Establish Data Ownership in a System of Components” (Embedded Coder)
Configure Referenced Models

Minimize occurrences of algebraic loops by selecting the Minimize algebraic loop occurrences parameter on the Model Reference pane. The setting of this option affects only generation of code from the model. For information on how this option affects code generation, see “Configure Run-Time Environment Options” on page 10-2. For more information about direct feed through, see “Algebraic Loops” (Simulink).

Use the Integer rounding mode parameter on your model's blocks to simulate the rounding behavior of the C compiler that you intend to use to compile code generated from the model. This setting appears on the Signal Attributes pane of the parameter dialog boxes of blocks that can perform signed integer arithmetic, such as the Product and n-D Lookup Table blocks.

For most blocks, the value of Integer rounding mode completely defines rounding behavior. For blocks that support fixed-point data and the Simplest rounding mode, the value of Signed integer division rounds to also affects rounding. For details, see “Precision” (Fixed-Point Designer).

When models contain Model blocks, all models that they reference must be configured to use identical hardware settings. For information on the Model Referencing pane options, see “Model Configuration Parameters: Model Referencing” (Simulink) and “Set Configuration Parameters for Model Referencing” (Simulink).

**Note** There are some configuration parameter setting limitations for code generation. See “Simulink Coder Model Referencing Limitations” on page 7-28.
Build Model Reference Targets

By default, the Simulink engine rebuilds simulation targets before the Simulink Coder software generates model reference targets. You can change the rebuild criteria or specify when the engine rebuilds targets. For more information, see “Rebuild” (Simulink).

The Simulink Coder software generates a model reference target directly from the Simulink model. The product automatically generates or regenerates model reference targets, for example, when they require an update.

You can command the Simulink and Simulink Coder products to generate a simulation target for an Accelerator mode referenced model, and a model reference target for a referenced model, by executing the `slbuild` command with arguments in the MATLAB Command Window.

The Simulink Coder software generates only one model reference target for all instances of a referenced model. See “Generate Reentrant Code from Subsystems” on page 9-43 for details.

Reduce Change Checking Time

You can reduce the time that the Simulink and Simulink Coder products spend checking whether simulation targets and model reference targets need to be rebuilt by setting configuration parameter values as follows:

- In the top model, consider setting the model configuration parameter **Model Referencing > Rebuild** to **If any changes in known dependencies detected**. (See “Rebuild” (Simulink).)

- In all referenced models throughout the hierarchy, set the configuration parameter **Diagnostics > Data Validity > Signal resolution** to **Explicit only** or **None**. (See “Signal resolution” (Simulink).)

These parameter values exist in a referenced model's configuration set, not in the individual Model block. Setting either value for an instance of a referenced model, sets it for all instances of that model.
Simulink Coder Model Referencing Requirements

A model reference hierarchy must satisfy various Simulink Coder requirements, as described in this section. In addition to these requirements, a model referencing hierarchy to be processed by the Simulink Coder software must satisfy:

- The Simulink requirements listed in:
  - “Configuration Requirements for All Referenced Model Simulation” (Simulink)
  - “Model Reference Interface” (Simulink)
- The Simulink limitations listed in “Signal Requirements and Limitations” (Simulink)
- The Simulink Coder limitations listed in “Simulink Coder Model Referencing Limitations” on page 7-28

Configuration Parameter Requirements

A referenced model uses a configuration set in the same way a top model does, as described in “Manage a Configuration Set” (Simulink). By default, every model in a hierarchy has its own configuration set, which it uses in the same way that it would if the model executed independently.

Because each model can have its own configuration set, configuration parameter values can be different in different models. Furthermore, some parameter values are intrinsically incompatible with model referencing. The response of the Simulink Coder software to an inconsistent or unusable configuration parameter depends on the parameter:

- Where an inconsistency has no significance, the product ignores or resolves the inconsistency without posting a warning.
- Where a nontrivial and possibly acceptable solution exists, the product resolves the conflict silently; resolves it with a warning; or generates an error.
- If an acceptable resolution is not possible, the product generates an error. You must then change parameter values to eliminate the problem.

When a model reference hierarchy contains many referenced models that have incompatible parameter values, or a changed parameter value must propagate to many referenced models, manually eliminating all configuration parameter incompatibilities can be tedious. You can control or eliminate such overhead by using configuration references to assign an externally-stored configuration set to multiple models. See “Manage a Configuration Reference” (Simulink) for details.
The following tables list configuration parameters that can cause problems if set in certain ways, or if set differently in a referenced model than in a parent model. Where possible, the Simulink Coder software resolves violations of these requirements automatically, but most cases require changes to the parameters in some or all models.

### Configuration Requirements for Model Referencing with All System Targets

<table>
<thead>
<tr>
<th>Dialog Box Pane</th>
<th>Option</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Solver</strong></td>
<td>Start time</td>
<td>Some system targets require the start time of all models to be zero.</td>
</tr>
<tr>
<td><strong>Hardware Implementation</strong></td>
<td></td>
<td>Values must be the same for top and referenced models.</td>
</tr>
<tr>
<td><strong>Code Generation</strong></td>
<td>System target file</td>
<td>Must be the same for top and referenced models.</td>
</tr>
<tr>
<td></td>
<td>Language</td>
<td>Must be the same for top and referenced models.</td>
</tr>
<tr>
<td></td>
<td>Generate code only</td>
<td>Must be the same for top and referenced models.</td>
</tr>
<tr>
<td><strong>Symbols</strong></td>
<td>Maximum identifier length</td>
<td>Cannot be longer for a referenced model than for its parent model.</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
<td>Code replacement library</td>
<td>Must be the same for top and referenced models.</td>
</tr>
<tr>
<td></td>
<td>C API options</td>
<td>The C API check boxes must be the same for top and referenced models.</td>
</tr>
<tr>
<td></td>
<td>ASAP2 interface</td>
<td>Can be on or off in a top model, but must be off in a referenced model. If it is not, the Simulink Coder software temporarily sets it to off during code generation.</td>
</tr>
</tbody>
</table>
### Configuration Requirements for Model Referencing with ERT System Targets
(Requires Embedded Coder License)

<table>
<thead>
<tr>
<th>Dialog Box Pane</th>
<th>Option</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments &gt; Advanced parameters</td>
<td>Ignore custom storage classes</td>
<td>Must be the same for top and referenced models.</td>
</tr>
<tr>
<td>Symbols</td>
<td>Global variables</td>
<td>$R$ token must appear.</td>
</tr>
<tr>
<td></td>
<td>Global types</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Subsystem methods</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Local temporary variables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Constant macros</td>
<td></td>
</tr>
<tr>
<td>Signal naming</td>
<td></td>
<td>Must be the same for top and referenced models.</td>
</tr>
<tr>
<td>M-function</td>
<td></td>
<td>If specified, must be the same for top and referenced models.</td>
</tr>
<tr>
<td>Parameter naming</td>
<td></td>
<td>Must be the same for top and referenced models.</td>
</tr>
<tr>
<td>#define naming</td>
<td></td>
<td>Must be the same for top and referenced models.</td>
</tr>
<tr>
<td>Interface</td>
<td>Support floating-point numbers</td>
<td>Must be the same for both top and referenced models.</td>
</tr>
<tr>
<td></td>
<td>Support non-finite numbers</td>
<td>If off for top model, must be off for referenced models.</td>
</tr>
<tr>
<td></td>
<td>Support complex numbers</td>
<td>If off for top model, must be off for referenced models.</td>
</tr>
<tr>
<td></td>
<td>Suppress error status in real-</td>
<td>If on for top model, must be on for referenced models.</td>
</tr>
<tr>
<td></td>
<td>time model</td>
<td></td>
</tr>
<tr>
<td>Code Placement</td>
<td>Use owner from data object for</td>
<td>Must be the same for top and referenced models.</td>
</tr>
<tr>
<td></td>
<td>data definition placement</td>
<td></td>
</tr>
</tbody>
</table>
### Configuration Parameters Changed During Code Generation

For referenced models, if these Configuration Parameters > Code Generation > Symbols parameters have settings that do not contain a $R$ token (which represents the name of the reference model), code generation prepends the $R$ token to the identifier format:

- **Global variables** (CustomSymbolStrGlobalVar)
- **Global types** (CustomSymbolStrType)
- **Subsystem methods** (CustomSymbolStrFcn)
- **Constant macros** (CustomSymbolStrMacro)

You can use the Model Advisor to identify models in a model referencing hierarchy for which code generation changes configuration parameter settings.

1. In the Simulink Editor, select Analysis > Model Advisor.
2. Select By Task.
3. Run the Check code generation identifier formats used for model reference check.

If a script that operates on generated code uses identifier formats that code generation changes, then update the script to use the updated identifier format (which includes an appended $R$ token).

For more information about identifiers, see “Identifier Format Control” (Embedded Coder).

### Naming Requirements

Within a model that uses model referencing, names of the constituent models cannot collide. When you generate code from a model that uses model referencing, the **Maximum identifier length** parameter must be large enough to accommodate the root...
model name and the name-mangling text. A code generation error occurs if Maximum identifier length is not large enough.

When a name conflict occurs between a symbol within the scope of a higher-level model and a symbol within the scope of a referenced model, the symbol from the referenced model is preserved. Name mangling is performed on the symbol from the higher-level model.

Embedded Coder Naming Requirements

The Embedded Coder product lets you control the formatting of generated symbols in much greater detail. When generating code with an ERT target from a model that uses model referencing:

- The $R$ token must be included in the Identifier format control parameter specifications (in addition to the $M$ token) except for Shared utilities identifier format.
- The Maximum identifier length must be large enough to accommodate full expansions of the $R$ and $M$ tokens.

See “Model Configuration Parameters: Code Generation Symbols” for more information.

Custom Target Requirements

If you have an Embedded Coder license, a custom target must meet various requirements to support model referencing. For details, see “Support Model Referencing” on page 39-84.
Storage Classes for Signals Used with Model Blocks

Models containing Model blocks can use signals of storage class Auto without restriction. However, when you declare signals to be global, you must be aware of how the signal data will be handled.

A global signal is a signal with a storage class other than Auto:

- ExportedGlobal
- ImportedExtern
- ImportedExternPointer
- Custom

The above are distinct from signals that use the storage class Model default when you set the default storage class of the corresponding data category to Default in the Code Mapping Editor, which are treated as test points with Auto storage class.

Global signals are declared, defined, and used as follows:

- An extern declaration is generated by all models that use a given global signal.

  As a result, if a signal crosses a Model block boundary, the top model and the referenced model both generate extern declarations for the signal.

- For an exported signal, the top model is responsible for defining (allocating memory for) the signal, whether or not the top model itself uses the signal.

- Global signals used by a referenced model are accessed directly (as global memory). They are not passed as arguments to the functions that are generated for the referenced models.

Custom storage classes also follow the above rules. However, certain custom storage classes are not currently supported for use with model reference. For details, see “Storage Class Limitations” on page 15-78.

Storage Classes for Parameters Used with Model Blocks

Storage classes are supported for both simulation and code generation, and all except Auto are tunable. The supported storage classes thus include

- Model default
• ExportedGlobal
• ImportedExtern
• ImportedExternPointer
• Custom

Note the following restrictions on parameters in referenced models:

• Tunable parameters are not supported for noninlined S-functions.
• Tunable parameters set using the Model Parameter Configuration dialog box are ignored.

Note the following considerations concerning how global tunable parameters are declared, defined, and used in code generated for targets:

• A global tunable parameter is a parameter in the base workspace with a storage class other than Auto.
• An extern declaration is generated by all models that use a given parameter.
• If a parameter is exported, the top model is responsible for defining (allocating memory for) the parameter (whether it uses the parameter or not).
• Global parameters are accessed directly (as global memory). They are not passed as arguments to the functions that are generated for the referenced models.
• In a referenced model that sets the default storage class for a category of parameter data to Default in the Code Mapping Editor, symbols for Model default parameters are generated using unstructured variables (rtP_XXX) instead of being written into the model_P structure. This is so that each referenced model can be compiled independently.

Certain custom storage classes for parameters are not currently supported for model reference. For details, see “Storage Class Limitations” on page 15-78.

Parameters used as Model block arguments must be defined in the referenced model’s workspace. For details, see “Parameterize Instances of a Reusable Referenced Model” (Simulink).

**Signal Name Mismatches Across Model Reference Boundary**

Within a parent model, the name and storage class for a signal entering or leaving a Model block might not match those of the signal attached to the root inport or outport
within that referenced model. Because referenced models are compiled independently without regard to a parent model, they cannot adapt to the possible variations in how parent models label and store signals.

The Simulink Coder software accepts all cases where input and output signals in a referenced model have Auto storage class. When such signals are test pointed or are global, as described above, certain restrictions apply. The following table describes how mismatches in signal labels and storage classes between parent and referenced models are handled:

### Relationships of Signals and Storage Classes Across Model Reference Boundary

<table>
<thead>
<tr>
<th>Referenced Model</th>
<th>Parent Model</th>
<th>Signal Passing Method</th>
<th>Signal Mismatch Checking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Any storage class</td>
<td>Function argument</td>
<td>None</td>
</tr>
<tr>
<td>Model default (when Code Mapping Editor specifies Default storage class) or resolved to Signal Object</td>
<td>Any storage class</td>
<td>Function argument</td>
<td>Signal label mismatch</td>
</tr>
<tr>
<td>Global</td>
<td>Auto or Model default (when Code Mapping Editor specifies Default storage class)</td>
<td>Global variable</td>
<td>Signal label mismatch</td>
</tr>
<tr>
<td>Global</td>
<td>Global</td>
<td>Global variable</td>
<td>Labels and storage classes must be identical (else error)</td>
</tr>
</tbody>
</table>

To summarize, the following signal resolution rules apply to code generation:

- If the storage class of a root input or output signal in a referenced model is Auto (or is Model default when you set the storage class of the corresponding data category to Default in the Code Mapping Editor), the signal is passed as a function argument.
  - When such a signal is Model default or resolves to a Simulink.Signal object, the **Signal label mismatch** diagnostic is applied.
- If a root input or output signal in a referenced model is global, it is communicated by using direct memory access (global variable). In addition,
• If the corresponding signal in the parent model is also global, the names and storage classes must match exactly.
• If the corresponding signal in the parent model is not global, the **Signal label mismatch** diagnostic is applied.

You can set the **Signal label mismatch** diagnostic to **error**, **warning**, or **none** in the **Diagnostics > Connectivity** pane of the Configuration Parameters dialog box.

### See Also

### Related Examples

• “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82
• “Establish Data Ownership in a System of Components” (Embedded Coder)
Inherited Sample Time for Referenced Models

For information about Model block sample time inheritance, see “Referenced Model Sample Times” (Simulink). In generated code, you can control inheriting sample time by using `ssSetModelReferenceSampleTimeInheritanceRule` in different ways:

- An S-function that precludes inheritance: If the sample time is used in the S-function's run-time algorithm, then the S-function precludes a model from inheriting a sample time. For example, consider the following `mdlOutputs` code:

  ```c
  static void mdlOutputs(SimStruct *S, int_T tid)
  {
      const real_T *u = (const real_T*) ssGetInputPortSignal(S,0);
      real_T       *y = ssGetOutputPortSignal(S,0);
      y[0] = ssGetSampleTime(S,tid) * u[0];
  }
  ```

  This `mdlOutputs` code uses the sample time in its algorithm, and the S-function therefore should specify

  ```c
  ssSetModelReferenceSampleTimeInheritanceRule(S, DISALLOW_SAMPLE_TIME_INHERITANCE);
  ```

- An S-function that does not preclude Inheritance: If the sample time is only used for determining whether the S-function has a sample hit, then it does not preclude the model from inheriting a sample time. For example, consider the `mdlOutputs` code from the S-function example `sfun_multirate.c`:

  ```c
  static void mdlOutputs(SimStruct *S, int_T tid)
  {
      InputRealPtrsType enablePtrs;
      int     *enabled = ssGetIWork(S);

      if (ssGetInputPortSampleTime(S,ENABLE_IPORT)==CONTINUOUS_SAMPLE_TIME &&
          ssGetInputPortOffsetTime(S,ENABLE_IPORT)==0.0) {
          if (ssIsMajorTimeStep(S) &&
              ssIsContinuousTask(S,tid)) {
              enablePtrs = ssGetInputPortRealSignalPtrs(S,ENABLE_IPORT);
              *enabled = (*enablePtrs[0] > 0.0);
          }
      } else {
  ```
int enableTid =
    ssGetInputPortSampleTimeIndex(S,ENABLE_IPORT);
if (ssIsSampleHit(S, enableTid, tid)) {
    enablePtrs =
        ssGetInputPortRealSignalPtrs(S,ENABLE_IPORT);
    *enabled = (*enablePtrs[0] > 0.0);
}

if (*enabled) {
    InputRealPtrsType uPtrs =
        ssGetInputPortRealSignalPtrs(S,SIGNAL_IPORT);
    real_T signal = *uPtrs[0];
    int i;

    for (i = 0; i < NOUTPUTS; i++) {
        if (ssIsSampleHit(S,
            ssGetOutputPortSampleTimeIndex(S,i), tid)) {
            real_T *y = ssGetOutputPortRealSignal(S,i);
            *y = signal;
        }
    }
} /* end mdlOutputs */

The above code uses the sample times of the block, but only for determining whether there is a hit. Therefore, this S-function should set

ssSetModelReferenceSampleTimeInheritanceRule
(S, USE_DEFAULT_FOR_DISCRETE_INHERITANCE);
Customize Library File Suffix and File Type

You can control the library file suffix and file type extension that the Simulink Coder code generator uses to name generated model reference libraries. Use the model configuration parameter TargetLibSuffix to specify the scheme for the suffix and extension. The scheme must include a period (.). If you do not set this parameter, the Simulink Coder software names the libraries as follows:

- On Windows systems, *model_rtwlib.lib*
- On UNIX or Linux® systems, *model_rtwlib.a*

The TargetLibSuffix parameter does not apply for model builds that use the toolchain approach. For more information, see “Identify Library File Type for Toolchain Approach” on page 37-8.
Simulink Coder Model Referencing Limitations

The following Simulink Coder limitations apply to model referencing. In addition to these limitations, a model reference hierarchy used for code generation must satisfy:

- The Simulink requirements listed in:
  - “Configuration Requirements for All Referenced Model Simulation” (Simulink)
  - “Model Reference Interface” (Simulink)
- The Simulink limitations listed in “Model Reference Requirements and Limitations” (Simulink).
- The Simulink Coder requirements applicable to the code generation target, as listed in “Configuration Parameter Requirements” on page 7-16.

Customization Limitations

- The code generator ignores custom code settings in the Configuration Parameters dialog box and custom code blocks when generating code for a referenced model.
- Data type replacement is not supported for simulation target code generation of referenced models.
- Simulation targets do not include Stateflow target custom code.
- If you have an Embedded Coder license, some restrictions exist on grouped custom storage classes in referenced models. For details, see “Storage Class Limitations” on page 15-78.

Data Logging Limitations

- To Workspace blocks, Scope blocks, and all types of runtime display, such as the display of port values and signal values, are ignored when the Simulink Coder software generates code for a referenced model. The resulting code is the same as if the constructs did not exist.
- Code generated for referenced models cannot log data to MAT-files. If data logging is enabled for a referenced model, the Simulink Coder software disables the option before code generation and re-enables it afterwards.
- If you log states for a model that contains referenced models, the ordering of the states in the output is determined by block sorted order, and might not match between simulation output and generated code MAT-file logging output.
State Initialization Limitation

When a top model uses the Data Import/Export > Initial state parameter in the Configuration Parameters dialog box to specify initial conditions, the Simulink Coder software does not initialize the discrete states of the referenced models during code generation.

Reusability Limitations

If a referenced model used for code generation has any of the following properties, the model must specify the configuration parameter Model Referencing > Total number of instances allowed per top model as One. No other instances of the model can exist in the hierarchy. If you do not set the parameter to One, or more than one instance of the model exists in the hierarchy, an error occurs. The properties are:

- The model references another model that has been set to single instance.
- The model contains an internal signal or state with a storage class that is not supported for multi-instance models. Internal signals and states must have the storage class set to Auto or Model default. The default storage class for internal data must be a multi-instance storage class.
- The model uses any of these Stateflow constructs:
  - Machine-parented data
  - Machine-parented events
  - Stateflow graphical functions
- The model contains a subsystem that is marked as a function
- The model contains an S-function that is:
  - Inlined but has not set the option SS_OPTION_WORKS_WITH_CODE_REUSE
  - Not inlined
- The model contains a function-call subsystem that:
  - The Simulink engine forces to be a function
  - Is called by a wide signal

For more information about Total number of instances allowed per top model, see “Total number of instances allowed per top model” (Simulink).
S-Function Limitations

- If a referenced model contains an S-function that should be inlined using a Target Language Compiler file, the S-function must use the \texttt{ssSetOptions} macro to set the \texttt{SS\_OPTION\_USE\_TLC\_WITH\_ACCELERATOR} option in its \texttt{mdlInitializeSizes} method. The simulation target will not inline the S-function unless this flag is set.
- A referenced model cannot use noninlined S-functions generated by the Simulink Coder software.
- The Simulink Coder S-function target does not support model referencing.

For additional information, see “S-Functions in Referenced Models” (Simulink).

Simulink Tool Limitations

- Simulink tools that require access to a model's internal data or configuration (including the Model Coverage tool, the Simulink Report Generator product, the Simulink debugger, and the Simulink profiler) have no effect on code generated by the Simulink Coder software for a referenced model, or on the execution of that code. Specifications made and actions taken by such tools are ignored and effectively do not exist.

Subsystem Limitations

- If a subsystem contains Model blocks, you cannot build a subsystem module by right-clicking the subsystem (or by using \texttt{Code > C/C++ Code > Build Selected Subsystem}) unless the model is configured to use an ERT target.
- If you generate code for an atomic subsystem as a reusable function, inputs or outputs that connect the subsystem to a referenced model might prevent code reuse, as described in “Generate Reentrant Code from Subsystems” on page 9-43.

Target Limitations

- The Simulink Coder S-function target does not support model referencing.
Other Limitations

- Errors or unexpected behavior can occur if a Model block is part of a cycle, the Model block is a direct feedthrough block, and an algebraic loop results. For details, see “Algebraic Loops” (Simulink).
- The External mode option is not supported. If it is enabled, it is ignored during code generation.
- When a model contains a trigger or enable port, you cannot generate standalone Simulink Coder code or PIL code.

Configuration Parameters Changed During Accelerated Simulation and Code Generation

During model referencing simulation in accelerator and rapid accelerator mode, Simulink temporarily sets several Configuration Parameters > Diagnostics > Data Validity parameter settings to None, if they are set to Warning or Error. You can use the Model Advisor to check for parameters that change. For details, see “Accelerated Simulation and Code Generation Changes Settings” (Simulink).

If the Configuration Parameters > Code Generation > Symbols parameters hold identifier information about the name of a referenced model and do not use a $R token, code generation prepends the $R token to the name of the model. You can use the Model Advisor to check for changed model names. See “Configuration Parameters Changed During Code Generation” on page 7-19.
Combined Models in Simulink Coder

- “Combine Code Generated for Multiple Models” on page 8-2
- “Function Reuse in Generated Code” on page 8-6
- “File Packaging for Models (Code and Data)” on page 8-12
Combine Code Generated for Multiple Models

Techniques

Techniques that you can use to combine code, which the code generator produces for multiple models or multiple instances of a model, into one executable program include:

- Referenced models. See “Model Reference Basics” (Simulink) and “Generate Code for Referenced Models” on page 7-4.
- If you have Embedded Coder software, interface the code for multiple models to a common harness program. From the harness program, call the entry-point functions generated for each model. The `ert.tlc` system target file has restrictions, relating to embedded processing, that could be incompatible with your application.
- Generate reusable, multi-instance code that is reentrant. See “Combine Code Generated for Multiple Models or Multiple Instances of a Model” on page 8-3.

The S-function system target (`rtwfcn.tlc`) does not support combining code generated for multiple models.

Consider using model referencing to combine models for simulation and code generation. Model referencing helps with:

- Symbol naming consistency
- Required scheduling of the overall algorithm
- Model configuration consistency

If you combine code generated for different models (that is, without using referenced models), consider:

- Data is global. Symbol (name) clashes can result.
- Configuration parameter settings for the models must match, including settings such as hardware word sizes.
- Reuse and sharing of code can be suboptimal (for example, duplicate code for shared utility functions, scheduling, and solvers).
- Scheduling can be more complex (for example, models can have periodic sample times that are not multiples of each other, making scheduling from a common timer interrupt more complicated)
• For plant models that use continuous time and state, the continuous time signals connecting models are not handled by a single solver like continuous time signals within a model. This can lead to subtle numeric differences.

Control Ownership of Data

If you have Embedded Coder software, you can specify an owner for individual data items such as signals, parameters, and states. The owner of a data item generates the definition (memory allocation and initialization) for the data item. For example, if you apply a custom storage class to a Simulink.Signal object so that it appears as a global variable in the generated code, specify one of the combined models as the owner of the object. The code generated for that model defines the variable.

If you use model referencing, you can modularize the generated code and establish clear ownership of data when you work in a team.

If you do not use model referencing, you can prevent generation of duplicate definitions for a data item. For example, suppose you store a Simulink.Parameter object in the base workspace and apply the storage class ExportedGlobal. If you generate code from two separate models that use the object, each model generates a definition for the corresponding global variable. Instead, you can specify an owner for the object so that only the owner generates a definition.

To specify an owner for a data item:

1. Apply a custom storage class to the data item. See “Apply Custom Storage Classes to Individual Signal, State, and Parameter Data Elements” (Embedded Coder).
2. Configure the owner of the data item by specifying the Owner custom attribute.
3. Select the model configuration parameter Use owner from data object for data definition placement.

For more information about controlling ownership and file placement of data definitions and declarations, see “Control Placement of Global Data Definitions and Declarations in Generated Files” (Embedded Coder).

Combine Code Generated for Multiple Models or Multiple Instances of a Model

For each model for which you are combining code, generate the code.
1 Set the system target file to a GRT- or ERT-based system target file. The system target file for the models you combine, must be the same.

2 If you intend to have multiple instances of that model in the application, set the model configuration parameter Code Generation > Interface > Code interface packaging to Reusable function. If you specified an ERT-based system target file, optionally, you can set the model configuration parameter Use dynamic memory allocation for model initialization, depending on whether you want to statically or dynamically allocate the memory for each instance of the model.

3 Generate source code. The code generator includes an allocation function in the generated file model.c. The allocation function dynamically allocates model data for each instance of the model.

After generating source code for each model:

1 Compile the code for each model that you are combining.
2 Combine the makefiles generated for the models into one makefile.
3 Create a combined simulation engine by modifying a main program, such as rt_malloc_main.c. The main program initializes and calls the code generated for each model.
4 Run the makefile. The makefile links the object files and the main program into an executable program.

Share Data Across Models

Use unidirectional signal connections between models. This affects the order in which models are called. For example, if you use an output signal from modelA as input to modelB, the modelA output computation should be called first.

Timing Issues

When combining code generated for multiple models or multiple instances of a model:

- Configure the models with the same solver mode (single-tasking or multitasking).
- If the models use continuous states, configure the models with the same solver.

If the base rates for the models differ, the main program (such as rt_malloc_main.c) must set up the timer interrupt to occur at the greatest common divisor rate of the models. The main program calls each model at a time interval.
Data Logging and External Mode Support

A multiple-model program can log data to separate MAT-files for each model.

Only one of the models in a multiple-model program can use external mode.
Function Reuse in Generated Code

This example shows how to configure an atomic subsystem for code generation. To specify that a subsystem's code executes as an atomic unit, select the Treat as atomic unit parameter on the block parameters dialog box. This parameter enables the Function Packaging parameter of the Code Generation tab. The Function Packaging parameter has these four settings:

- **Inline**: Inline the subsystem code
- **Nonreusable function**: Function with I/O passed as global data
- **Reusable function**: Function with I/O passed as function arguments
- **Auto**: Let Simulink Coder optimize based on context

The Reusable function and Auto settings permit the code generator to reuse subsystem code. The Reusable function and Nonreusable function settings enable the **Function name options**, **Function name**, and **File name options** parameters.

If you have an Embedded Coder license, you can configure a nonreusable subsystem to accept arguments.

**Example Model**

The `rtwdemo_ssreuse` model contains two identical subsystems, SS1 and SS2. For these subsystems, the Function packaging parameter is set to Reusable function, and the Function name parameter is `myfun`. The subsystems are parameterized masked subsystems. To see the contents of the masked subsystems, right-click the subsystem blocks and select **Mask > Look Under Mask**.

```matlab
model = 'rtwdemo_ssreuse';
open_system(model);
```
Description
This model shows how to configure a subsystem for reuse of generated code. By selecting the Subsystem Parameters option "Treat as atomic unit," you specify that the code for that subsystem executes as an atomic unit. Once a system is marked atomic, you can specify how the subsystem is represented in code via the Subsystem Parameters option "Code Generation Function Packaging."

- Inline: An inlined function
- Nonreusable Function: Function with I/O passed as global data
- Reusable Function: Function with I/O passed as function arguments
- Auto: Let Simulink Coder optimize based on context

The last two options permit Simulink to reuse the subsystem in the generated code. The function name is controlled with the "Code Generation Function name" option. Here, SS2 is simply a copy of SS1, which is configured as a "Reusable Function" with function name "myfun". Notice that the system is a parameterized masked subsystem. Parameters of a mask become arguments to the function. This example uses parameters: T1Break, T1Data, T2Break, and T2Data.

Instructions
To see the subsystem parameters, right-click the subsystem block and select "SubSystem Parameters." To see the content of the masked subsystem, right-click the subsystem block and select "Look Under Mask."
**Generate Code**

Create a temporary folder for the build and inspection process.

```matlab
currentDir=pwd;
[~,cgDir]=rtwdemodir();
```

Build the model.

```matlab
rtwbuild(model)
```

### Starting build procedure for model: rtwdemo_ssreuse
### Successful completion of build procedure for model: rtwdemo_ssreuse

```matlab
cfile=fullfile(cgDir, 'rtwdemo_ssreuse_grt_rtw', 'rtwdemo_ssreuse.c');
rtwdemodbtype(cfile, /* Model step', /* Model initialize', 1, 0);
```

```matlab
/* Model step function */
void rtwdemo_ssreuse_step(void)
{
    /* Outputs for Atomic SubSystem: '<Root>/SS1' */

    /* Inport: '<Root>/In1' incorporates:
     *  Inport: '<Root>/In2'
    */
    myfun(rtwdemo_ssreuse_U.In1, rtwdemo_ssreuse_U.In2, &rtwdemo_ssreuse_B.SS1,
          rtwdemo_ssreuse_P.T1Data, rtwdemo_ssreuse_P.T1Break);

    /* End of Outputs for SubSystem: '<Root>/SS1' */

    /* Outport: '<Root>/Out1' */
    rtwdemo_ssreuse_Y.Out1 = rtwdemo_ssreuse_B.SS1.LookupTable;

    /* Outputs for Atomic SubSystem: '<Root>/SS2' */

    /* Inport: '<Root>/In1' incorporates:
     *  Inport: '<Root>/In2'
    */
    myfun(rtwdemo_ssreuse_U.In1, rtwdemo_ssreuse_U.In2, &rtwdemo_ssreuse_B.SS2,
          rtwdemo_ssreuse_P.T2Data, rtwdemo_ssreuse_P.T2Break);

    /* End of Outputs for SubSystem: '<Root>/SS2' */

    /* Outport: '<Root>/Out2' */
```
rtwdemo_ssreuse_Y.Out2 = rtwdemo_ssreuse_B.SS2.LookupTable;
}

In the model step function, there are two calls to the reusable function, myfun. The mask parameters, T1Break, T1Data, T2Break, and T2Data, are function arguments.

Change the **Function Packaging** parameter to **Inline**.

```matlab
set_param('rtwdemo_ssreuse/SS1','RTWSystemCode','Inline')
set_param('rtwdemo_ssreuse/SS2','RTWSystemCode','Inline')
```

Build the model.

```matlab
rtwbuild(model)
```

### Starting build procedure for model: rtwdemo_ssreuse
### Successful completion of build procedure for model: rtwdemo_ssreuse

cfile=fullfile(cgDir, 'rtwdemo_ssreuse_grt_rtw', 'rtwdemo_ssreuse.c');
rtwdemodbtype(cfile, '/* Model step', '/* Model initialize', 1, 0);

```c
/* Model step function */
void rtwdemo_ssreuse_step(void)
{
  real_T Out1_tmp;

  /* Outputs for Atomic SubSystem: '<Root>/SS2' */
  /* Outputs for Atomic SubSystem: '<Root>/SS1' */
  /* Sum: '<S1>/Sum' incorporates:
     * Inport: '<Root>/In1'
     * Inport: '<Root>/In2'
     * Sum: '<S1>/Sum'
   */
  Out1_tmp = rtwdemo_ssreuse_U.In1 + rtwdemo_ssreuse_U.In2;

  /* End of Outputs for SubSystem: '<Root>/SS2' */

  /* Outport: '<Root>/Out1' incorporates:
     * Lookup n-D: '<S1>/Lookup Table'
     * Sum: '<S1>/Sum'
   */
  rtwdemo_ssreuse_Y.Out1 = look1_binlx(Out1_tmp, rtwdemo_ssreuse_P.T1Break, rtwdemo_ssreuse_P.T1Data, 10U);
```

8-9
In the model step function, the subsystem code is inline.

Change the Function Packaging parameter to Nonreusable function. For SS2, change the Function name parameter to myfun2.

```matlab
set_param('rtwdemo_ssreuse/SS1','RTWSystemCode','Nonreusable function')
set_param('rtwdemo_ssreuse/SS2','RTWSystemCode','Nonreusable function')
set_param('rtwdemo_ssreuse/SS2','RTWFcnName','myfun2')
```

Build the model.

```bash
rtwbuild(model)
```

### Starting build procedure for model: rtwdemo_ssreuse
### Successful completion of build procedure for model: rtwdemo_ssreuse

cfile=fullfile(cgDir, 'rtwdemo_ssreuse_grt_rtw', 'rtwdemo_ssreuse.c');
rtwodemodbtype(cfile, '/* Model step', '/* Model initialize', 1, 0);

```c
/* Model step function */
void rtwdemo_ssreuse_step(void)
{
    /* Outputs for Atomic SubSystem: '<Root>/SS1' */
    myfun();

    /* End of Outputs for SubSystem: '<Root>/SS1' */

    /* Outputs for Atomic SubSystem: '<Root>/SS2' */
    myfun2();

    /* End of Outputs for SubSystem: '<Root>/SS2' */
}
The model step function contains calls to the functions myfun and myfun2. These functions have a void-void interface.

Change the **Function Packaging** parameter to Auto.

```matlab
set_param('rtwdemo_ssreuse/SS1','RTWSystemCode','Auto')
set_param('rtwdemo_ssreuse/SS2','RTWSystemCode','Auto')
```

For the auto setting, Simulink Coder chooses the optimal format. For this model, the optimal format is a reusable function.

Close the model and clean up.

```matlab
bdclose(model)
rtwdemoclean;
cd(currentDir)
```
File Packaging for Models (Code and Data)

This example shows how referenced models provide system interface encapsulation and incremental code generation. You can reference one model from another model (one or more times), and all aspects of the referenced model are fixed: input/output signal types, parameter types, and sample times. Therefore, you can modularize your design and perform incremental code generation with Simulink Coder.

The data and functions of a referenced model are partitioned into its own set of files, independent of its parent model. In this example, the referenced model `rtwdemo_mdlrefbot` is referenced three times. For simulation and code generation, the model is incrementally generated, which means `rtwdemo_mdlrefbot` builds the first time, but not on subsequent builds (until you change `rtwdemo_mdlrefbot`).

```matlab
open_system('rtwdemo_mdlreftop')
```

This example shows Model Reference, which provides system interface encapsulation and incremental code generation. With Model Reference, you reference one model from another model (one or more times), whereby all aspects of the referenced model are fixed: input/output signal types, parameter types, and sample times. This allows you to modularize your design, and provides incremental code generation for Simulink and Simulink Coder.

The data and functions of a Model Reference system is partitioned into its own set of files, independent of its parent model. In this example, the model `rtwdemo_mdlrefbot.mdl` is referenced three times. For simulation and code generation, the model is incrementally generated. That is, `rtwdemo_mdlrefbot.mdl` will build the first time, but not on subsequent builds (until `rtwdemo_mdlrefbot.mdl` is changed).

Since Model Reference shares and manages code for models, each code generation target must be built into its own directory. The blue buttons below generate code for Simulink Coder and Embedded Coder.
bdclose('rtwdemo_mdlreftop');
Code Reuse for Simulink Coder
What Is Code Reuse?

Code reuse is a programming technique that reduces time and resources to develop software. When you develop code for reuse, the code serves multiple purposes. The technique involves modularization, which enables multiple individuals to develop code for various system components independently and in parallel. The technique also simplifies software distribution.

A software library is an example of code reuse. A library can contain code for several functions, each having specific behavior. To use a library, you need to know only the interface, which is the specification for calling the library functions.

Reusable code can be reentrant. You can invoke, interrupt, and reinvoke reentrant code. Reentrant code resides in shared memory. Instances of data associated with each use of the code are unique and preserved. Multiple calls to a reusable, reentrant function, for example, can access the function code with each call maintaining a unique data set.

Applications of code reuse include:

- Team-based development.
- Switching between implementations of a function.
- Intellectual property protection.
- Overriding library behavior with a custom implementation.
- Implementing a library that is based on standard library functions.
- Unit testing.
- Performance improvement.

The code generator supports code reuse and reentrancy. You can use key Simulink componentization techniques to partition a model into design components that you simulate, generate code for, and verify independently. You can save individual components as subsystems, libraries, referenced models, or combinations of these elements from which you can generate code. For example, the code generator produces reusable function code from library subsystems and export-function models.
See Also

More About

- “What Is Reentrant Code?” (Embedded Coder)
- “Choose a Componentization Technique for Code Reuse” (Embedded Coder)
What Is Reentrant Code?

Reentrant (multi-instance) code is a reusable routine that multiple programs can invoke, interrupt, and reinvoke simultaneously. When you want to reuse code, but associate each instance of the shared code with unique, preserved data, use reentrant code. For example, consider this figure that shows four instances of function `sensor_read`. Although the function algorithm is the same in each case, the data associated with each instance varies and is relative to the sensor position.

To make generated code for a model component reentrant, you configure the component such that model entry-point functions receive root-level input and output data as arguments. How you configure the component depends on the modeling style or technique that you apply.

See Also

More About

• “What Is Code Reuse?” (Embedded Coder)
• “Choose a Componentization Technique for Code Reuse” (Embedded Coder)
Choose a Componentization Technique for Code Reuse

Key componentization techniques that you can use with Simulink and the code generator to produce reusable code include:

- Referenced models
- Subsystems
- Library subsystems
- Combinations of models, subsystems, and library subsystems

Choose componentization techniques based on your code reuse goals.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Referenced Model</th>
<th>Subsystem in Model</th>
<th>Subsystem in Library</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design for explicit code reuse.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Facilitate parallel team development.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Reuse function within a model or across models.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Improve build performance by generating reusable code incrementally.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Verify reusable code with SIL or PIL simulation.</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Optimize generated code by configuring code generator to detect opportunities for code reuse.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Goal</td>
<td>Referenced Model</td>
<td>Subsystem in Model</td>
<td>Subsystem in Library</td>
</tr>
<tr>
<td>------</td>
<td>-----------------</td>
<td>--------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>Maximize reuse with context-dependent behavior.</td>
<td></td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td>Develop a frequently used, and infrequently changed, utility function.</td>
<td></td>
<td></td>
<td>√</td>
</tr>
</tbody>
</table>

**See Also**

**More About**
- “Componentization Guidelines” (Simulink)
- “Generate Reentrant Code from Top Models” (Embedded Coder)
- “Generate Reentrant Code from Subsystems” (Embedded Coder)
- “Generate Reentrant Code from Simulink Function Blocks” (Embedded Coder)
- “Generate Reusable Code from Library Subsystems Shared Across Models” (Embedded Coder)
Simulink Function Blocks and Code Generation

Why Generate Code from Simulink Function Blocks and Function Callers?

Simulink Function blocks provide a mechanism for generating C or C++ code for modeling components that represent shared resources. You define the logic as a resource in a Simulink Function block, which separates the function interface (name and arguments) from the implementation of the logic. Function callers (Function Caller blocks, MATLAB Function blocks, and Stateflow charts) can then reuse the function logic at different levels of the model hierarchy.

Simulink Function blocks provide an alternative to reusable subsystems. For example, a consideration for using a Simulink Function block instead of a subsystem block is that a Simulink Function block shares states between function callers. The code generator produces one function. If the Simulink Function block contains blocks that have states, such as a delay or memory, the states persistent between function callers. The order of the function calls is an important consideration.

Reusable functions that the code generator produces from subsystems do not share states. The code generator produces one function for multiple instances of the subsystem as an optimization. If that subsystem contains blocks that have states, the code generator produces one function, but passes a different state variable to each instance. The instances do not share states.

Other uses of Simulink Function blocks and callers include:

- Nesting calls to a function.
- Calling a function defined in one modeling component from another modeling component.
- Generating functions that are globally accessible or scoped.
- Producing code for a client and server application.

Implementation Options

Choose how to implement Simulink functions and function callers based on your code generation requirements. Considerations include:
• How you represent a function and function callers in a model
• Scope of a function
• Whether to export a function from a model (requires Embedded Coder)
• Function code interface customizations (requires Embedded Coder)
• Code generation requirements
• Code generation limitations

**Choose a Modeling Pattern**

This table shows C code for a function that multiplies an input value times two and a Simulink Function block that can represent that function in a Simulink model.

<table>
<thead>
<tr>
<th>Function Definition</th>
<th>Modeling Element</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>codegen-folder/subsystem.c</code></td>
<td>Simulink Function block</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>#include &quot;timestwo_sf.h&quot;</td>
<td></td>
</tr>
<tr>
<td>#include &quot;ex_slfunc_comp_sf.h&quot;</td>
<td></td>
</tr>
<tr>
<td>#include &quot;ex_slfunc_comp_sf_private.h&quot;</td>
<td></td>
</tr>
<tr>
<td>void timestwo_sf(real_T rtu_x, real_T *rty_y)</td>
<td></td>
</tr>
<tr>
<td>{</td>
<td></td>
</tr>
<tr>
<td>*rty_y = 2.0 * rtu_x;</td>
<td></td>
</tr>
<tr>
<td>}</td>
<td></td>
</tr>
</tbody>
</table>

A Simulink function caller invokes a function defined with a Simulink Function block. From anywhere in a model or chart hierarchy, you can call a function defined with a Simulink Function block by using one of these modeling elements:
### Function Call

**codegen-folder/model.c**

```c
void ex_slfunc_comp_sf_step(void) {
    real_T rtb_FunctionCaller1;
    timestwo_sf(ex_slfunc_comp_sf_U.In1, &rtb_FunctionCaller1);
    ex_slfunc_comp_sf_Y.Out1 = rtb_FunctionCaller1;
}
```

**codegen-folder/model.c**

```c
void ex_slfunc_comp_gf_step(void) {
    real_T rtb_y1_l;
    timestwo_gf(ex_slfunc_comp_gf_U.In4, &rtb_y1_l);
    ex_slfunc_comp_gf_Y.Out4 = rtb_y1_l;
}
```

**codegen-folder/model.c**

```c
void ex_slfunc_comp_mf_step(void) {
    real_T rtb_y;
    timestwo_mf(ex_slfunc_comp_mf_U.In3, &rtb_y);
    ex_slfunc_comp_mf_Y.Out3 = rtb_y;
}
```

### Modeling Element

**Function Caller block**

**Stateflow chart transition**

**MATLAB Function block**

For more information about modeling choices, see “Simulink Functions” (Simulink).
Specify Function Scope

A function that you define with a Simulink Function block can be global or scoped.

- **Global**---The code generator places code for a global function in source and header files that are separate from model code files (for example, `function.c` and `function.h`). The separate files make the function code available for sharing between function callers.

- **Scoped**---The code generator places code for a scoped function in model code files (`model.c` and `model.h`). To call a scoped function in the context of a model, the function caller must be at the same level as the function in the model hierarchy, or one or more levels below.

To create a library of functions that are accessible from anywhere in the generated model code, set up each function as a scoped Simulink Function block. Place each scoped function within a virtual subsystem at the root level of a model.

For more information, see and “Scoped and Global Simulink Function Blocks Overview” (Simulink).

Decide Whether to Generate Export Function Code

Although you can use Simulink Function blocks in a single top-model design, function code is more reusable when you generate it as standalone, atomic components. You do that by designing the functions in the context of export-function models.

For information, see “Generate Component Source Code for Export to External Code Base” (Embedded Coder) and “Export-Function Models” (Simulink).

Specify Function Code Interface Customizations

With Embedded Coder, simplify integration of generated code with external code by customizing generated function code interfaces for Simulink Function and Function Caller blocks. You can customize the function interfaces for:

- Global Simulink Function blocks
- Scoped Simulink Function blocks that are at the root level of a model

For more information, see “Customize Entry-Point Function Interfaces for Simulink Function and Function Caller Blocks” (Embedded Coder).
Uncalled Simulink Function Blocks

If you use a scoped Simulink Function block in a rate-based model and do not call that function, the code generator treats the Simulink Function block as a constant and produces no function code. For example, this can occur during model development when you are ready to define a function, but are not ready to identify a caller.

To identify such blocks in a rate-based model, display sample time colors during simulation. By default, Constant blocks appear magenta. Because the code generator considers uncalled Simulink Function blocks constants during simulation, they appear magenta.

Requirements

- Within a model hierarchy, function names are unique. If the code generator finds multiple functions with the same name, it issues an error. Change the name of one of the functions and delete the slprj folder.
- The signature (for example, the arguments and argument data types) for a function and function callers must match.
  - If the code generator finds the function first and the signature of a function caller does not match, the code generator issues an error. Change the function caller signature to match the signature of the Simulink Function block or delete the slprj folder.
  - If the code generator finds a function caller first and the signature of the function does not match, the code generator issues a warning message. Change the signature of the function or function caller so that the signatures match.
- In a Simulink Function block definition, do not define input and output signals for Argument Inport and Argument Outport blocks with a storage class.
- Do not specify Argument Inport and Argument Outport blocks as test points.
- If you specify the data type of input and output signals for Argument Inport and Argument Outport blocks as a Simulink.IntEnumType, Simulink.AliasType, or Simulink.Bus, set the DataScope property to Imported or Exported.
- A function interface and function callers must agree in data type, complexity, dimension, and number of arguments.
Limitations

- To generate code from a model that includes scoped Simulink functions, the model must be an export-function model. The code generator does not support rate-based models that include scoped Simulink functions.
- You can use a Simulink Function block to define a scoped function in a referenced model. However, you cannot generate code for an export-function model that uses a Function Caller block in an atomic subsystem to invoke that function.
- You can invoke a C++ function that the code generator produces from a Simulink Function block with code generated from a Stateflow chart. Due to current scope limitations for generated C++ functions, you must invoke those functions with code generated from a Function Caller block.
- Simulink functions and function callers do not honor the MaxStackSize parameter.
- Code generation for a C++ class interface supports scoped Simulink functions only.

Generate and Call Reusable Function Code

This example shows how to use the Simulink Function and Function Caller blocks to generate reusable function code. The code generator produces a global function, which complies with code requirements so that existing external code can call the function and a local function. The code generator also produces calls to global and local functions. The call to the global function shows that the global function is reused (shared).

Code requirements for the global function are:

- Function names start with prefix `func_`.
- Names of input arguments are of the form `xn`, where `n` is a unique integer value.
- Names of output arguments are of the form `yn`, where `n` is a unique integer value.
- Input and output arguments are integers (`int`) and are passed by reference. The native integer size of the target hardware is 32 bits.

You create a function that calls the generated reusable function code. Then, you construct and configure a model to match the code requirements.

Some of the features used in this example, such as data type aliasing and replacement, require Embedded Coder software.
Inspect External Code That Calls Reusable Function

In your code generation root folder, create the files `call_times2.h` and `call_times2.c`. If you prefer, you can copy the files from `matlabroot\help\toolbox\ecoder\examples`.

`call_times2.h`

typedef int my_int;

`call_times2.c`

#include "call_times2.h"

void call_times2(void)
{
    int times2result;
    
    func_times2(x1, &y1);
    
    printf('Times 2 Value:', y1);
}

This C code calls reusable function `func_times2`. The function multiplies an integer input value `x1` by 2 and returns the result as `y1`.

Create Model

Open the example model `ex_slfunc_comp`, which is available in the folder `matlabroot\help\toolbox\ecoder\examples`. The model includes two Simulink functions modeled as Simulink Function blocks, `func_times2` and `func_times3`, and a call to each function. As indicated in the model, the visibility of the Simulink Function block for `func_times2` is set to `global`. That visibility setting makes the function code accessible to other code, including external code that you want to integrate with the generated code. The visibility for `func_times3` is set to `scoped`. 
If you configure the model with the GRT system target file or the ERT system target file with **File packaging format** set to **Modular**, the code generator produces function code for the model.

For more information, see “Generate Code for a Simulink Function and Function Caller” on page 9-21.

**Configure Generated Code to Reuse Custom Data Type**

The example assumes that the generated code runs on target hardware with a native integer size of 32 bits. The external code represents integers with data type my_int, which is an alias of int. Configure the code generator to use my_int in place of the data type that the code generator uses by default, which is int32_T.

1. Create a Simulink.AliasType object to represent the custom data type my_int.

   ```
   my_int = Simulink.AliasType
   my_int = 
   AliasType with properties:
   Description: ''
   DataScope: 'Auto'
   HeaderFile: ''
   BaseType: 'double'
   ```
2 Set the alias type properties. Enter a description, set the scope to Imported, specify the header file that includes the type definition, and associate the alias type with the Simulink base type int32.

```matlab
my_int.Description='Custom 32-bit int representation';
my_int.DataScope='Imported';
my_int.HeaderFile='call_times2.h';
my_int.BaseType='int32';
```

```matlab
my_int
```

AliasType with properties:

- **Description**: 'Custom 32-bit int representation'
- **DataScope**: 'Imported'
- **HeaderFile**: 'call_times2.h'
- **BaseType**: 'int32'

3 Configure the code generator to replace instances of type int32_T with my_int. In the Configuration Parameters dialog box, open the **Code Generation Data Type Replacement** pane.

- Select **Replace data type names in the generated code**.
- In the **Data type names** table, enter `my_int` for the replacement name for `int32`.

**Configure Reusable, Global Function**

For external code to call a global function, configure the corresponding Simulink Function block to have global visibility and an interface that matches what is expected by the external callers.

1 Open the block that represents the `times2` function.
Configure the function name and visibility by setting Trigger Port block parameters. For example, the code requirements specify that the function name start with the prefix func_.

- Set **Function name** to `func_times2`.
- Set **Function visibility** to `global`.

Configure the function input and output arguments by setting Argument Inport and Argument Outport block parameters. For example, the code requirements specify that argument names be of the form `xn` and `yn`. The requirements also specify that arguments be type `my_int`.

- On the **Main** tab, set **Argument name** to `x1` (input) and `y1` (output).
- On the **Signal Attributes** tab, set **Data type** to `int32`. With the data type replacement that you specified previously, `int32` appears in the generated code as `myint`.

Configure the Simulink Function block code interface. At the top level of the model, right-click the global function `func_times2`. From the menu, select **C/C++ CodeConfigure C/C++ Function Interface**.

- Set **C/C++ function name** to `func_times2`.
- Set **C/C++ return argument** to `void`.
- Set **C/C++ Identifier Name** for argument `x1` to `x1`.
- Set **C/C++ Identifier Name** for argument `y1` to `y1`.

If the dialog box lists output argument `y1` before input argument `x1`, reorder the arguments by dragging the row for `x1` above the row for `y1`.

**Configure Local Function**

Configure a Simulink Function block that represents a local function with scoped visibility. Based on code requirements, you might also have to configure the function name, input and output argument names and types, and the function interface.

1. Open the block that represents the `times3` function.
2. Configure the function name and visibility by setting Trigger Port block parameters. For example, the code requirements specify that the function name start with the prefix `func_`.

- Set **Function name** to `func_times3`.
• Set **Function visibility** to *scoped*.

3 Configure the function input and output arguments by setting Argument Inport and Argument Outport block parameters. For example, the code requirements specify that argument names be of the form \( xn \) and \( yn \). The requirements also specify that arguments be type `my_int`.

• On the **Main** tab, set **Argument name** to \( x1 \) (input) and \( y1 \) (output).

• On the **Signal Attributes** tab, set **Data type** to `int32`. With the data type replacement that you specified previously, `int32` appears in the generated code as `my_int`.

4 Configure the Simulink Function block code interface. At the top level of the model, right-click the scoped function `func_times3`. From the menu, select **C/C++ Code Configure C/C++ Function Interface**. In this case, the code generator controls naming the function and arguments. The function name combines the name of the root model and the function name that you specify for the trigger port of the Simulink Function block. In this example, the name is `ex_slfunc_comp_func_times3`.

You can set **C/C++ return argument** to the argument name that you specify for the Argument Outport block or `void`. For this example, set it to `void`.

For arguments, the code generator prepends `rtu_` (input) or `rty_` (output) to the argument name that you specify for the Argument Inport block.

If the dialog box lists output argument \( y1 \) before input argument \( x1 \), reorder the arguments by dragging the row for \( x1 \) above the row for \( y1 \).

**Configure Function Callers**

For each function caller, configure Function Caller block parameters:

• Set **Function prototype** to \( y1 = func\_times2(x1) \).

• Set **Input argument specifications** to `int32(1)`.

• Set **Output argument specifications** to `int32(1)`.

**Generate and Inspect Code**

Generate code for the model.

• Global function code
Source code for the global, reusable function `func_times2` is in the build folder in subsystem file, `func_times2.c`.

```c
#include "func_times2.h"

/* Include model header file for global data */
#include "ex_slfunc_comp.h"
#include "ex_slfunc_comp_private.h"

void func_times2(my_int x1, my_int *y1)
{
    *y1 = x1 << 1;
}
```

- Local function code

The code generator places the definition for the local (scoped) function `func_times3` in file build folder in file `ex_slfunc_comp.c`.

```c
void ex_slfunc_comp_func_times3(my_int rtu_x1, my_int *rty_y1)
{
    *rty_y1 = 3 * rtu_x1;
}
```

- Calls to generated functions

The model execution (step) function, in model file `ex_slfunc_comp.c`, calls the two Simulink functions: global function `func_times2` and local function `ex_slfunc_comp_func_times3`. The name `ex_slfunc_comp_func_times3` reflects the scope of the local function by combining the name of the model and the name of the function.

```c
void ex_slfunc_comp_step(void)
{
    my_int rtb_FunctionCaller2;
    func_times2(ex_slfunc_comp_U.In1, &rtb_FunctionCaller2);
    ex_slfunc_comp_Y.Out1 = rtb_FunctionCaller2;
    ex_slfunc_comp_func_times3(ex_slfunc_comp_U.In2, &rtb_FunctionCaller2);
    ex_slfunc_comp_Y.Out2 = rtb_functionCaller2;
.
.
```

- Entry-point declaration for local function
The model header file `ex_slfunc_comp.h` includes an `extern` declaration for function `ex_slfunc_comp_func_times3`. That statement declares the function entry point.

```c
extern void ex_slfunc_comp_func_times3(my_int rtu_x1, my_int *rty_y1);
```

- Include statements for global function

The model header file `ex_slfunc_comp.h` lists include statements for the global function `func_times2`.

```c
#include "func_times2_private.h"
#include "func_times2.h"
```

- Local macros and data for global function

The subsystem header file `func_times2_private.h` defines macros and includes header files that declare data and functions for the global function, `func_times2`.

```c
#ifndef RTW_HEADER_func_times2_private_h_
#define RTW_HEADER_func_times2_private_h_
#ifndef ex_slfunc_comp_COMMON_INCLUDES_
#define ex_slfunc_comp_COMMON_INCLUDES_
#include "rtwtypes.h"
#endif
#endif
```

- Entry-point declaration for global function

The shared header file `func_times2.h`, in the shared utilities folder `slprj/stf/_sharedutils`, lists shared type includes for `rtwtypes.h`. The file also includes an `extern` declaration for the global function, `func_times2`. That statement declares the function entry point.

```c
#ifndef RTW_HEADER_func_times2_
#define RTW_HEADER_func_times2_

#include "rtwtypes.h"

extern void func_times2(my_int rtu_x1, my_int *rty_y1);
#endif
```
Generate Code for a Simulink Function and Function Caller

This example shows how to generate C code for Simulink Function and Function Caller blocks and displays the relevant generated code.

Open the example model rtwdemo_export_functions. The model uses Stateflow software, but this example reviews only the code generated from the referenced models.

Generate Code for Function Definition

1. To view the contents of the subsystem, double-click rtwdemo_functions. The Simulink Function block is the f3 subsystem defined as \( y = f_3(u) \).
Generate code.

The code generator creates `rtwdemo_functions.c`. This file contains the function definition and function initialization code.

- **Initialization code for function f3:**
  ```c
  void f3_Init(void)
  {
    rtDWork.Delay_DSTATE = 1;
  }
  ```
  - **Code for function f3:**
    ```c
    void f3(real_T rtu_u, real_T *rty_y)
    {
      rtY.TicToc10 = rtDWork.Delay_DSTATE;
      rtDWork.Delay_DSTATE = (int8_T)(int32_T)-(int32_T)rtY.TicToc10;
      adder_h(rtB.Subtract, rtU.U2, rtu_u, rtB.FunctionCaller);
    }
    ```
*rty_y = rtB.FunctionCaller;
}

void adder_h(real_T rtu_u1,
       real_T rtu_u2,
       real_T rtu_u3,
       real_T *rty_y)
{
  *rty_y = (rtu_u1 + rtu_u2) + rtu_u3;
}

• The shared header file f3.h contains the entry point declaration for function f3.

#include "rtwtypes.h"

extern void f3(real_T rtu_u, real_T *rty_y);

Generate Code for Function Caller

1 In the rtwdemo_export_functions model, double-click rtwdemo_caller to view the contents of the caller subsystem.

2 Generate code.

The code generator creates the files rtwdemo_caller.h and rtwdemo_caller.c in the folder rtwdemo_caller_ert_rtw.

rtwdemo_caller.h includes the shared header file, f3.h, which contains the function entry-point declaration.

rtwdemo_caller.c calls function f3.

void rtwdemo_caller_t_10tic(const real_T *rtu_u,
                  real_T *rty_y)
{
  f3(*rtu_u, rty_y);
}

See Also

More About
• “Generate Reentrant Code from Simulink Function Blocks” on page 9-31
• “Simulink Functions” (Simulink)
• “Scoped Simulink Function Blocks in Models” (Simulink)
• “Simulink Function Blocks in Referenced Models” (Simulink)
Generate Reentrant Code from Top Models

By default, for top models, the code generator produces code that is not reentrant. Entry-point functions have a void-void interface. Code communicates with other code by sharing access to global data structures that reside in shared memory.

For applications that can benefit from reuse and require that each use or instance of the code maintains its own unique data, configure a model such that the code generator produces reentrant code. To generate reentrant code, set the model configuration parameter “Code interface packaging” to Reusable function. If you are using Embedded Coder and generating C++ code, alternatively, you can set the parameter to C++ class. In both cases, the code generator:

- Packages model data, such as block I/O, DWork vectors, and parameters, in the real-time model data structure (rtModel).
- Passes the real-time model data structure as an input argument, by reference, to generated model entry-point functions.
- Passes root-level input and output arguments to generated model entry-point functions as individual arguments.
- Allocates memory for model data structures statically.
- Exports the real-time model data structure in the generated header file model.h.

Apply additional diagnostic and code generation control by setting these model configuration parameters:

- To select the severity level for diagnostic messages that the code generator displays when a model does not meet requirements for multi-instance code, set parameter “Multi-instance code error diagnostic” to None, Warning, or Error.
- To control how the generated code passes root-level model input and output to the reusable execution (step) function (requires Embedded Coder), set parameter “Pass root-level I/O as” to Individual arguments, Structure reference, or Part of model data structure.
- To reduce memory usage by omitting the error status field from the real-time model data structure (requires Embedded Coder), set parameter Remove error status field in real-time model data structure to On.
- To include a function in the generated file model.c that uses malloc to dynamically allocate memory for model data structures (requires Embedded Coder), set parameter Use dynamic memory allocation for model initialization to On.
Generate Reentrant, Multi-Instance Code

This example shows you how to configure a model for reentrant, multi-instance code generation. Multiple programs can use reentrant code simultaneously. When you configure a model for reentrancy, the execution (step) entry-point function uses root-level input and output arguments instead of global data structures. After examining the configuration settings, generate and review the generated code.

Open the Model

Open the model `rtwdemo_reusable`. The model contains two root Inport blocks and a root Outport block.

```matlab
model='rtwdemo_reusable';
open_system(model);
```

In your working folder, create a temporary folder for generating and reviewing the code.

```matlab
currentDir=pwd;
 [~,cgDir] = rtwdemodir();
```

Examine Relevant Model Configuration Settings

1. Open the Model Configuration Parameters dialog box.

2. System target file is set to `ert.tlc`. Although you can generate reentrant code for a model configured with the System target file set to `grt.tlc`, ERT and ERT-based system target files provide more control over how the code passes root-level I/O.

3. Open the Code Generation > Interface pane and explore relevant parameter settings.
- **Code interface packaging** is set to **Reusable function**. This parameter setting instructs the code generator to produce reusable, multi-instance code.
- The **Reusable function** parameter setting also displays the **Multi-instance code error diagnostic** parameter. That parameter is set to **Error**, indicating that the code generator abort if the model violates requirements for generating multi-instance code.
- **Pass root-level I/O as** is set to **Part of model data structure**. This setting packages root-level model input and output into the real-time model data structure (rtModel), which is an optimized data structure that replaces SimStruct as the top-level data structure for a model.
- **Remove error status field in real-time model data structure** is selected. This parameter setting reduces memory usage by omitting the error status field from the generated real-time model data structure.

**Generate and Review Code**

```matlab
rtwbuild(model);
```

### Starting build procedure for model: rtwdemo_reusable
### Successful completion of build procedure for model: rtwdemo_reusable

From the code generation report, review the generated code.

- **ert_main.c** is an example main program (execution framework) for the model. This code controls model code execution by calling the entry-point function **rtwdemo_reusable_step**. Use this file as a starting point for coding your execution framework.
- **rtwdemo_reusable.c** contains entry points for the code that implements the model algorithm. This file includes the rate scheduling code.
- **rtwdemo_reusable.h** declare model data structures and a public interface to the model entry points and data structures.
- **rtwtypes.h** defines data types, structures, and macros that the generated code requires.

Open and review the Code Interface Report. Use the information in that report to write the interface code for your execution framework.

1. Include the generated header file by adding directive `#include rtwdemo_reusable.h`
2. Write input data to the generated code for model Inport blocks.
3. Call the generated entry-point functions.

4. Read data from the generated code for the model Outport block.

Input ports:
- `<Root>/In1` of data type `real_T` with dimension of 1
- `<Root>/In2` of data type `real_T` with dimension of 1

Entry-point functions:
- Initialization entry-point function, `void rtwdemo_reusable_initialize(RT_MODEL *const rtM)`. At startup, call this function once.
- Output and update (step) entry-point function, `void rtwdemo_reusable_step(RT_MODEL *const rtM)`. Call this function periodically at the fastest rate in the model. For this model, call the function every second. To achieve real-time execution, attach this function to a timer.

Output port:
- `<Root>/Out1` of data type `real_T` with dimension of 1

Examine the `rtwdemo_reusable_step` function code in `rtwdemo_reusable.c`.

```c
/* Model step function */
void rtwdemo_reusable_step(RT_MODEL *const rtM) {
    Parameters *rtP = ((Parameters *) rtM->defaultParam);
    D_Work *rtDWork = ((D_Work *) rtM->dwork);
    ExternalInputs *rtU = (ExternalInputs *) rtM->inputs;
    ExternalOutputs *rtY = (ExternalOutputs *) rtM->outputs;
    /* Outport: '<Root>/Out1' incorporates:
       * UnitDelay: '<Root>/Delay'
       */
    rtY->Out1 = rtDWork->Delay_DSTATE;
    /* Gain: '<Root>/Gain' incorporates:
       * Inport: '<Root>/In1'
       */
```

9-28
* Inport: '<Root>/In2'
* Sum: '<Root>/Sum'
* UnitDelay: '<Root>/Delay'
*/
  rtDWork->Delay_DSTATE = (rtU->In1 + rtU->In2) * rtP->k1;
}

The code generator passes model data to the `rtwdemo_reusable_step` function as part of the real-time model data structure. Try different settings for the Code interface packaging and Pass root-level I/O parameters and regenerate code. Observe how the function signature for the `rtwdemo_reusable_step` function changes.

Close the model and the code generation report.

```matlab
bdclose(model)
rtwdemoclean;
cd(currentDir)
```

**Share Data Between Instances**

When your code calls a reentrant model entry-point function multiple times, each call represents an instance of the model. By default, the code generator generates code that assumes each instance reads from and writes to a separate copy of the signals, block states, and parameters in the model.

- To share a piece of parameter data between the instances (for example, to share a setpoint for a reusable PID control algorithm), use a parameter object, such as `Simulink.Parameter`, and apply a storage class other than Auto or, if you set the default storage class for the corresponding category of parameter data to Default (the default setting) in the Code Mapping Editor, Model default. The parameter object appears in the code as a global symbol, such as a global variable, that the function accesses directly. For more information, see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82.

- To share a piece of nonparameter data between the instances, for example, to share a fault indication or an accumulator, use a data store. You can configure the data store to appear in the code as a global symbol, such as a global variable, that the function accesses directly. Create a global data store by using a `Simulink.Signal` object or use a Data Store Memory block and select the **Share across model instances** parameter. For more information, see “Model Global Data by Creating Data Stores” (Simulink) and Data Store Memory.
See Also

More About
• “What Is Reentrant Code?” (Embedded Coder)
• “Design Models for Generated Embedded Code Deployment” (Embedded Coder)
• “Use Storage Classes in Reentrant, Multi-Instance Models and Components” on page 15-80
Generate Reentrant Code from Simulink Function Blocks

If you are using Embedded Coder, you can generate reusable, reentrant code by representing an algorithm as a scoped Simulink Function block. Examples of when to generate reentrant code from Simulink Function blocks are when a function shares state between function callers within a model or for client/server applications. You can generate code that is highly modularized by using multiple instances of a shared Simulink Function block in an export-function model. The code generator produces function code and associates each use or call to the function with instance-specific data. The scope of the function depends on whether you place the function at the root level of model or in a subsystem.

The code generator produces reentrant function code when you configure a:

- Top model with model configuration parameter “Code interface packaging” set to Reusable function or C++ class (C++ only).
- Referenced model with “Total number of instances allowed per top model” (Simulink) set to Multiple.

Call a function represented by a scoped Simulink Function block from one level above, at the same level, or from a level below the level of the function definition. You can scope a function in an atomic or nonvirtual subsystem, but function call accessibility is limited to the same level or below of the hierarchy. The function name does not have to be unique.

Identify Requirements

Before and while you design your model, consider:

- How many instances of each function are required?
- Do you need to restrict call sites for a function to the model containing the function definition?
- Do you need for a function to interface with signals in the local environment, but keep those signals hidden from callers?
- Do functions need to communicate directly with each other?
- Do functions need to connect to external I/O?
- Do you need to log function output?
**Create Model**

Use the example model component `rtwdemo_comp` to see how to use Simulink Function blocks to generate reentrant C code. Use example model `rtwdemo_comp_cpp` if you prefer to generate C++ code. Open the model and examine the model hierarchy.

The top level of the model includes a function-call subsystem and two instances of a referenced model.

The referenced model, `rtwdemo_func_dinteg`, consists of a Simulink Function block that defines function `multiinstfunc` and subsystem `subsys_calc`.

The subsystem consists of a Simulink Function block. This use of a Simulink Function block shows how you can limit the scope of the function that the block defines to the model that contains the subsystem. The code generator produces function code for
func_calc and associates each call to the function with instance-specific data. The data includes states, such as data stored in memory.

The Simulink Function block that defines function multiinstfunc uses a FunctionCaller block to invoke function func_calc. That Simulink Function block also shows that it can interface to signals in the local environment of the block through Inport and Outport blocks.

At the top level of model rtwdemo_comp, the function-call subsystem uses FunctionCaller blocks to invoke the two instances of function multiinstfunc. The code generator produces function code and associates each call with instance-specific data.
Configure Model and Model Elements

Configure Simulink Function Blocks

Configure the Simulink Function blocks by setting parameters for the function Trigger Port block. For the code generator to produce reentrant code from Simulink Function blocks:

- Configure block instances with the same function name.
- Set **Function visibility** to **scoped**.

In the example, the function name for the Simulink Function blocks in the two instances of the referenced model `rtwdemo_func_dinteg` is specified as `multiinstfunc`.

Configure Function Caller Blocks

Configure the Function Caller blocks. For each of the blocks, set the **Function prototype** block parameter. Start typing a prototype. For example, type `y`. Prototype options, based on function definitions in the model, appear in a selection list. Select the prototype that is appropriate for each function call.
For this example, the prototypes are configured as follows:

- In the function-call subsystem, the prototypes for the function callers are configured as \( y = \text{Instance1.multiinstfunc}(u) \) and \( y = \text{Instance2.multiinstfunc}(u) \). The \text{Instance}n prefix identifies each function invocation uniquely and associates the invocation with its own data set.
- The function caller in function \text{multiinstfunc} is configured with the prototype \( y = \text{subsys_calcalc.func_calc}(u) \). The prefix \text{subsys} \_\text{calc} identifies the subsystem that contains the function definition.

For the example, the input and output argument specifications and sample time retain default settings.

**Subsystem Configuration**

No configuration changes are required for the subsystem in the example model. When you include a Simulink Function block in a subsystem, the code generator

- Scopes the function to the model that includes the subsystem.
- Treats the subsystem as an atomic unit.

**Configure Referenced Model**

Configure the referenced model that includes a Simulink Function block:

- In the Block Parameters dialog box, set \textbf{Model name} to the referenced model file name. For this example, the model name is \textit{rtwdemo_func_dinteg.slx}.
- Set \textbf{Number of model instances allowed} to \textit{Multiple}.
- To generate a C++ class interface for the reference model, set \textbf{Language} to C++ and \textbf{Code interface packaging} to C++ \textit{class}.

Optionally, you can customize model entry-point function interfaces. You can specify entry-point function names. For the execution (step) entry-point function you can configure the function name and arguments. Custom entry-point function interfaces can minimize changes to existing external code that you integrate with the generated code. The example uses the default function interfaces. See “Customize Entry-Point Function Interfaces for Simulink Function and Function Caller Blocks” (Embedded Coder).

**Configure Top Model**

Configure the top model for a model component. If you want the model component (that is, the top model) to be reusable, set \textbf{Code interface packaging} to \textit{Reusable}
function. If you are generating C++ code, you can set this parameter to C++ class. In either case, also:

- Set **Multi-instance code error diagnostic** to Error.
- Set **Pass root-level I/O as** to Part of model data structure.

Optionally, you can customize model entry-point function interfaces. You can specify entry-point function names. For the execution (step) entry-point function you can configure the function name and arguments. Custom entry-point function interfaces can minimize changes to existing external code that you integrate with the generated code. The example uses the default function interfaces. See “Customize Entry-Point Function Interfaces for Simulink Function and Function Caller Blocks” (Embedded Coder).

### Generate and Inspect C Code

Generate C code for the model.

- **Function code for multi-instance Simulink Function block**

  When you place a scoped Simulink Function block in a referenced model that you use multiple times in another model, the code generator places the function code in the *model*.c file for the referenced model. For this example, the code generator places function code for multiinstfunc in `slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg.c`.

```c
real_T rtwdemo_func_dinteg_multiinstfunc(RT_MODEL_rtwdemo_func_dinteg_T * const rtwdemo_func_dinteg_M, const real_T rtu_u)
{
    real_T rtb_TmpLatchAtInOutport1;
    real_T rtb_TmpLatchAtIn2Outport1;
    real_T rty_y_0;

    rtb_TmpLatchAtInOutport1 =
        *rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextInport.rtu_In1;

    rtb_TmpLatchAtIn2Outport1 =
        *rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextInport.rtu_In2;

    *rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextOutport.rty_Out2 = 2.0 *
    rtb_TmpLatchAtIn2Outport1;

    rtwdemo_func_dinteg_func_calc(rtwdemo_func_dinteg_M, rtb_TmpLatchAtIn2Outport1,
        rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextOutport.rty_Out1);

    rty_y_0 = rtwdemo_func_dinteg_M->dwork.DiscreteIntegrator_DSTATE;

    rtwdemo_func_dinteg_M->dwork.DiscreteIntegrator_DSTATE += 0.1 * rtu_u;
```

---

9-36
Function code for a Simulink Function block defined in a subsystem

The code generator places the function code for a Simulink Function block that you define in a subsystem in the `model.c` file for the model that contains the subsystem. For this example, the code generator places the function code for `func_calc` in `slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg.c`.

```c
void rtwdemo_func_dinteg_func_calc(RT_MODEL_rtwdemo_func_dinteg_T *const rtwdemo_func_dinteg_M, real_T rtu_u, real_T *rty_y)
{
    rtwdemo_func_dinteg_M->dwork.calcMem = rtwdemo_func_dinteg_M->dwork.UnitDelay_DSTATE;
    *rty_y = rtwdemo_func_dinteg_M->dwork.UnitDelay_DSTATE;
    rtwdemo_func_dinteg_M->dwork.UnitDelay_DSTATE = rtu_u * 0.07;
}
```

Structure that stores multi-instance data for reusable functions

The code generator uses a structure similar to the real-time model (RT_MODEL) data structure to store the multi-instance data associated with a reusable function. The code generator defines the structure in `slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg.h`.

```c
typedef struct rtwdemo_func_dinteg_tag_RTM RT_MODEL_rtwdemo_func_dinteg_T;
```

Initialization code for multi-instance referenced model

For each instance of a referenced model that includes the same scoped Simulink Function block, the code generator produces initialization and startup function code. A single copy of the initialization code is defined in `slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg.c`.

```c
void rtwdemo_func_dinteg_Start(RT_MODEL_rtwdemo_func_dinteg_T *const rtwdemo_func_dinteg_M, const real_T *rtu_In1, const real_T *rtu_In2, real_T *rty_Out2, real_T *rty_Out1)
{
    rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextInport.rtu_In1 = rtu_In1;
    rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextInport.rtu_In2 = rtu_In2;
    rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextOutport.rty_Out2 = rty_Out2;
    rtwdemo_func_dinteg_M->rtwdemo_func_dintegrtextOutport.rty_Out1 = rty_Out1;
}
```

```c
void rtwdemo_func_dinteg_initialize(const char_T **rt_errorStatus, RT_MODEL_rtwdemo_func_dinteg_T *const rtwdemo_func_dinteg_M)
{
    rtmSetErrorStatusPointer(rtwdemo_func_dinteg_M, rt_errorStatus);
}
```
The initialization code is called for each instance of a referenced model that contains
the same Simulink Function block. That code is in file `rtwdemo_comp.c` in the build
folder.

rtwdemo_func_dinteg_initialize(rtmGetErrorStatusPointer(rtwdemo_comp_M),
   (&(rtwdemo_comp_M->Instance1)));

rtwdemo_func_dinteg_initialize(rtmGetErrorStatusPointer(rtwdemo_comp_M),
   (&(rtwdemo_comp_M->Instance2)));

rtwdemo_func_dinteg_Start((&(rtwdemo_comp_M->Instance1)), &rtU->In2, &rtU->In3,
   &rtY->Out2, &rtY->Out3);

rtwdemo_func_dinteg_Start((&(rtwdemo_comp_M->Instance2)), &rtU->In4, &rtU->In5,
   &rtY->Out4, &rtY->Out5);

• Top model entry-point function declarations

The model header file `rtwdemo_comp.h` includes extern declarations for top model
initialize, terminate, and execution (run) entry-point functions.

extern void rtwdemo_comp_initialize(RT_MODEL_rtwdemo_comp_T *const
   rtwdemo_comp_M);

extern void Run(RT_MODEL_rtwdemo_comp_T *const rtwdemo_comp_M);

• Reference model entry-point function declarations

Header file `slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg.h`
includes extern declarations for reference model entry-point functions.

extern void rtwdemo_func_dinteg_initialize(const char_T **rt_errorStatus,
   RT_MODEL_rtwdemo_func_dinteg_T *const rtwdemo_func_dinteg_M);
extern real_T rtwdemo_func_dinteg_multiinstfunc(RT_MODEL_rtwdemo_func_dinteg_T *
   const rtwdemo_func_dinteg_M, const real_T rtu_u);
extern void rtwdemo_func_dinteg_Start(RT_MODEL_rtwdemo_func_dinteg_T *const
   rtwdemo_func_dinteg_M, const real_T *rtu_In1, const real_T *rtu_In2, real_T
   *rty_Out2, real_T *rty_Out1);

**Generate and Inspect C++ Code**

Generate C++ code for the model.
Function code for multi-instance Simulink Function block

When you place a scoped Simulink Function block in a referenced model that you use multiple times in another model, the code generator places the function code in the model.cpp file for the referenced model. For this example, the code generator places function code for multiinstfunc in slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg_cpp.cpp.

```cpp
class rtwdemo_func_dintegModelClass{
public:
    real_T multiinstfunc(const real_T rtu_u) {
        real_T rtb_TmpLatchAtInOutport1;
        real_T rtb_TmpLatchAtIn2Outport1;
        real_T rty_y_0;

        rtb_TmpLatchAtInOutport1 = *rtwdemo_func_dinteg_cprtrtu_In1;
        rtb_TmpLatchAtIn2Outport1 = *rtwdemo_func_dinteg_cprtrtu_In2;
        *rtwdemo_func_dinteg_crtrty_Out2 = 2.0 * rtb_TmpLatchAtInOutport1;
        rtwdemo_func_dinteg_c_func_calc(rtb_TmpLatchAtIn2Outport1,
            rtwdemo_func_dinteg_crtrty_Out1);
        rty_y_0 = rtwdemo_func_dinteg_cpprtDW.DiscreteIntegrator_DSTATE;
        rtwdemo_func_dinteg_cpprtDW.UnitDelay_DSTATE += 0.1 * rtu_u;
        return rty_y_0;
    }
}
```

Function code for a Simulink Function block defined in a subsystem

The code generator places the function code for a Simulink Function block that you define in a subsystem in model.cpp for the model that contains the subsystem. For this example, the code generator places the function code for func_calc in slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg_cpp.cpp.

```cpp
class rtwdemo_func_dintegModelClass{
public:
    void func_calc(real_T rtu_u, real_T *rty_y) {
        rtwdemo_func_dinteg_cpprtDW.calcMem =
            rtwdemo_func_dinteg_cpprtDW.UnitDelay_DSTATE;
        *rty_y = rtwdemo_func_dinteg_cpprtDW.UnitDelay_DSTATE;
        rtwdemo_func_dinteg_cpprtDW.UnitDelay_DSTATE = rtu_u * 0.07;
    }
}
```

Structure that stores multi-instance data for reusable functions

The code generator uses a structure similar to the real-time model (RT_MODEL) data structure to store the multi-instance data associated with a Reusable function. The
code generator defines the structure in slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg_cpp.h.

typedef struct rtwdemo_func_dinteg_cpp_tag_RTM rtwdemo_func_dinteg_cp_RT_MODEL;

• Initialization code for multi-instance referenced model

For each instance of a referenced model that includes the same scoped Simulink Function block, the code generator produces initialization and startup function code. A single copy of the initialization code is defined in slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg_cpp.cpp.

```cpp
void rtwdemo_func_dintegModelClass::start(real_T *rtu_In1, real_T *rtu_In2,
                                          real_T *rty_Out2, real_T *rty_Out1)
{
    rtwdemo_func_dinteg_cp_rtu_In1 = rtu_In1;
    rtwdemo_func_dinteg_cp_rtu_In2 = rtu_In2;
    rtwdemo_func_dinteg_cr_rty_Out2 = rty_Out2;
    rtwdemo_func_dinteg_cr_rty_Out1 = rty_Out1;
}
```

```cpp
void rtwdemo_func_dintegModelClass::initializeRTM()
{
    (void) memset((void *)(&rtwdemo_func_dinteg_cpprtM), 0,
                  sizeof(rtwdemo_func_dinteg_cp_RT_MODEL));
}
```

The initialization code is called for each instance of a referenced model that contains the same Simulink Function block. That code is in file rtwdemo_comp_cpp.cpp in the build folder.

```cpp
Instance1MDLOBJ0.initializeRTM();
Instance1MDLOBJ0.setErrorStatusPointer(rtmGetErrorStatusPointer(&rtM));
Instance1MDLOBJ0.initialize();
Instance2MDLOBJ1.initializeRTM();
Instance2MDLOBJ1.setErrorStatusPointer(rtmGetErrorStatusPointer(&rtM));
Instance1MDLOBJ0.start(&rtU.In2, &rtU.In3, &rtY.Out2, &rtY.Out3);
Instance2MDLOBJ1.start(&rtwU.In4, &rtwU.In5, &rtY.Out4, &rtY.Out5);
}
```

• Top model class declaration
The model header file `rtwdemo_comp_cpp.h` includes the class declaration for the top model.

```cpp
class rtwdemo_compModelClass {
  public:
    ExtU rtU;
    ExtY rtY;
    void initialize();
    void Run();
    rtwdemo_compModelClass();
    -rtwdemo_compModelClass();
    RT_MODEL * getRTM();
  private:
    RT_MODEL rtM;
    rtwdemo_func_dintegModelClass Instance1MDLOBJ0;
    rtwdemo_func_dintegModelClass Instance2MDLOBJ1;
};
```

- Reference model class declaration

Header file `slprj/ert/rtwdemo_func_dinteg/rtwdemo_func_dinteg_cpp.h` includes the class declaration for the reference model.

```cpp
class rtwdemo_func_dintegModelClass {
  public:
    real_T multiinstfunc(const real_T rtu_u);
    void start(real_T *rtu_In1, real_T *rtu_In2, real_T *rty_Out2, real_T *rty_Out1);
    rtwdemo_func_dintegModelClass();
    -rtwdemo_func_dintegModelClass();
    rtwdemo_func_dinteg_cp_RT_MODEL * getRTM();
    void initializeRTM();
    void setErrorStatusPointer(const char_T **rt_errorStatus);
  private:
    rtwdemo_func_dinteg_cpp_DW rtwdemo_func_dinteg_cpprtDW;
    const real_T *rtwdemo_func_dinteg_cprtrtu_In1;
    const real_T *rtwdemo_func_dinteg_cprtrtu_In2;
    real_T *rtwdemo_func_dinteg_crrtty_Out2;
};
```
real_T *rtwdemo_func_dinteg_crtnty_Out1;

rtwdemo_func_dinteg_cp_RT_MODEL rtwdemo_func_dinteg_cpprtM;

void rtwdemo_func_dinteg_c_func_calc(real_T rtu_u, real_T *rty_y);
};

Limitations

These code generation limitations apply to export-function models that include multiple instances of a Simulink Function block.

- You must set the model configuration parameter **Pass root-level I/O as to Part of model data structure.**
- Generated code is compatible with single-threaded execution only. To avoid race conditions for shared signal data, invoke instances of the function code from the same execution thread.
- You cannot:
  - Generate code if the export-function model includes model variants.
  - Call the generated code from a Stateflow chart.
  - Enable the external mode data exchange interface.

See Also

More About

- “Simulink Functions” (Simulink)
- “Simulink Functions in Simulink Models” (Simulink)
- “Simulink Function Blocks in Referenced Models” (Simulink)
- “Use Storage Classes in Reentrant, Multi-Instance Models and Components” on page 15-80
You can reduce the amount of code that the code generator produces for identical atomic subsystems by configuring the subsystems as reusable functions that pass data as arguments (for example, rtB_* for block input and output, rtDW_* for continuous states, and rtP_* for parameters). By default, the code generator produces subsystem code that communicates with other code by sharing access to global data structures that reside in shared memory. By passing data as arguments, the code can be reentrant. Each instance of the code maintains its own unique data.

To configure subsystems for reusability and reentrancy, configure mask and block parameters of the identical subsystems the same way. The code generator performs a checksum to determine whether subsystems are identical and whether the code is reusable. If the code is reusable, the code generator produces a single instance of reusable, reentrant function code.

To configure the subsystem block parameters:

1. If a subsystem is virtual, select “Treat as atomic unit” (Simulink) to enable function packaging parameters.
2. On the Code Generation tab, set “Function packaging” (Simulink) to Reusable function. The code generator produces a separate function with arguments for each subsystem. Selecting Reusable function also enables additional parameters that you can use to control the names of the function and file that the code generator produces for the subsystem code.
3. Set “Function name options” (Simulink). To generate reusable, reentrant code, specify the same setting for identical subsystems.
   - To let the code generator determine the function name, select Auto.
   - To use the subsystem name or, for a library block, the name of the library block, select Use subsystem name.
   - To display the “Function name” (Simulink) parameter and enter a unique, valid C/C++ function name, select User specified.

If there are multiple instances of an identical subsystem within a model reference hierarchy, select Auto.

If you are using Embedded Coder, you can use identifier format controls. See “Identifier Format Control” (Embedded Coder).
4 Set “File name options” (Simulink). To generate reusable, reentrant code, specify the same setting for identical subsystems.

- To let the code generator determine file naming select Auto.
- To use the subsystem name or, for a library block, the name of the library block select Use subsystem name.
- To use the function name, as specified by Function name options select Use function name.
- To display the “File name (no extension)” (Simulink) parameter and enter a file name, excluding the extension (for example, .c or .cpp) select User specified.

Other considerations:

- If there are multiple instances of an identical subsystem within a model reference hierarchy, select Auto.
- If the code generator does not generate a separate file for a subsystem, the function code is placed in the file generated from the subsystem's parent system. If the parent is the model itself, the code generator places the function code in model.c or model.cpp.
- If your generated code is under source control, specify a value other than Auto. This specification prevents the generated file name from changing when you modify and rebuild the model.
- If you select Use subsystem name, the code generator mangles the subsystem file name if the model contains Model blocks, or if a model reference target is being generated for the model. In these situations, the code generator uses the file name modelsubsystem.c.

If subsystem A has mask parameter b and K and subsystem B has mask parameters c and K, code reuse is not possible. The code generator produces separate functions for subsystems A and B. If you set block parameters for subsystems A and B differently, code reuse is not possible.

**Limitations**

- The code generator uses a checksum to determine whether subsystems are identical and reusable. Subsystem code is not reused if:
• In blocks and data objects, you use symbols to specify dimensions.
• A port has different sample times, data types, complexity, frame status, or dimensions across subsystems.
• The output of a subsystem is marked as a global signal.
• Subsystems contain identical blocks with different names or parameter settings.
• The output of a subsystem is connected to a Merge block, and the output of the Merge block is configured with a custom storage class that is implemented in the C code as nonaddressable memory (for example, BitField).
• The input of a subsystem is nonscalar and is configured with a custom storage class that is implemented in the C code as nonaddressable memory.
• A masked subsystem has a parameter that is nonscalar and is configured with a custom storage class that is implemented in the C code as nonaddressable memory.
• A function-call subsystem uses mask parameters when you set the model configuration parameter “Default parameter behavior” to Tunable. To reuse the masked function-call subsystem, place it inside a new atomic subsystem without a mask. Then move the Trigger block from the masked subsystem into the atomic subsystem.
• A block in a subsystem uses a partially tunable expression. Some partially tunable expressions disable code reuse.

Partially tunable expressions are expressions that contain one or more tunable variables and an expression that is not tunable. For example, suppose that you create the tunable variable K with value 15.23 and the tunable variable P with value [5;7;9]. The expression K+P' is a partially tunable expression because the expression P' is not tunable. For more information about tunable expression limitations, see “Tunable Expression Limitations” on page 15-136.

• For subsystems that contain S-function blocks that are reusable, the blocks must meet the requirements listed in “S-Functions That Support Code Reuse” (Embedded Coder).
• If you select Reusable function, and the code generator determines that you cannot reuse the code for a subsystem, it generates a separate function that is not reused. The code generation report might show that the separate function is reusable, even if only one subsystem uses it. If you prefer that the code generator inline subsystem code in such cases (rather than deployed as functions), set “Function packaging” (Simulink) to Auto.
• If a reusable subsystem uses a shared local data store and you configure default mapping for model data elements, leave the default storage class mapping for category Shared local data stores set to Default.
- Use of these blocks in a subsystem can prevent the subsystem code from being reused:
  - Scope blocks (with data logging enabled)
  - S-Function blocks that fail to meet certain criteria (see “S-Functions That Support Code Reuse” (Embedded Coder))
  - To File blocks (with data logging enabled)
  - To Workspace blocks (with data logging enabled)
- For reusable library subsystems (subsystems shared across reference models), the code generator uses a checksum to determine whether subsystems are identical. The code generator places the reusable library subsystem code in the shared utilities folder, and the reusable code is independent of the generated code of the top model or the reference model. For example, the reusable library subsystem code does not include `model.h` or `model_types.h`.

Reusable code that the code generator places in the shared utilities folder and is dependent on the model code does not compile. If the code generator determines that the reusable library subsystem code is dependent on the model code, the reusable subsystem code is not placed in the shared utilities folder. The code generator produces code that is dependent on the model code when the reusable library subsystem:
  - Contains a block that uses time-related functionality, such as a Step block, or continuous time or multirate blocks.
  - Contains one or more Model blocks.
  - Contains a subsystem that is not inlined or a reusable library subsystem.
  - Contains a signal that is not configured with storage class Auto. The code generator places variables that are configured with a non-Auto storage class in `model.h`.
  - Contains a parameter that is not configure with storage class Auto.
  - Contains a user-defined storage class like Enumeration, Simulink.Signal, Simulink.Parameter, etc. where Data Scope is not set to Exported. The code generator might place the type definition in `model_types.h`.
  - Is a variant subsystem that generates preprocessor conditionals. The code generator places preprocessor directives that define the variant objects in `model_types.h`
Determine Why Subsystem Code Is Not Reused

Due to the limitations described in “Generate Reentrant Code from Subsystems” on page 9-43, the code generator might not reuse generated code as you expect. To determine why code generated for a subsystem is not reused:

1. Review the Subsystems section of the code generation report.
2. Compare subsystem checksum data.

Review Subsystems Section of HTML Code Generation Report

If the code generator does not generate code for a subsystem as reusable code, and you configured the subsystem as reusable, examine the Subsystems section of the code generation report (see “Generate a Code Generation Report” on page 22-6). The Subsystems section contains:

- A table that summarizes how nonvirtual subsystems were converted to generated code.
- Diagnostic information that describes why subsystems were not generated as reusable code.

The Subsystems section also maps noninlined subsystems in the model to functions or reused functions in the generated code. For an example, open and build the rtwdemo_atomic model.

Compare Subsystem Checksum Data

You can determine why subsystem code is not reused by comparing subsystem checksum data. The code generator determines whether subsystems are identical by comparing subsystem checksums, as noted in “Limitations” on page 9-44. For subsystem reuse across referenced models, this procedure might not flag every difference.

Consider the model, rtwdemo_ssreuse. SS1 and SS2 are instances of the same subsystem. In both instances the subsystem parameter Function packaging is set to Reusable function.
Use the method `Simulink.SubSystem.getChecksum` to get the checksum for a subsystem. Review the results to determine why code is not reused.

1. Open the model `rtwdemo_ssreuse`. Save a copy of the model in a folder where you have write access.

2. Associate the subsystems SS1 and SS2 with `gcb`. For each of the subsystems, in the model window, select the subsystem. While the subsystem is selected, in the Command Window, enter:

   ```
   SS1 = gcb;
   SS2 = gcb;
   ```

3. Use the method `Simulink.SubSystem.getChecksum` to get the checksum for each subsystem. This method returns two output values: the checksum value and details on the input used to compute the checksum.

   ```
   [chksum1, chksum1_details] = ...
   Simulink.SubSystem.getChecksum(SS1);
   [chksum2, chksum2_details] = ...
   Simulink.SubSystem.getChecksum(SS2);
   ```

4. Compare the two checksum values. The values should be equal based on the subsystem configurations.

   ```
   isequal(chksum1, chksum2)
   ans =
       1
   ```

5. To use `Simulink.SubSystem.getChecksum` to determine why the checksums of two subsystems differ, change the data type mode of the output port of SS1 so that it differs from that of SS2.
Look under the mask of SS1. Right-click the subsystem. In the context menu, select **MaskLook Under Mask**.

In the block diagram of the subsystem, double-click the Lookup Table block to open the Subsystem Parameters dialog box.

Click **Data Types**.

Select **Saturate on integer overflow** and click **OK**.

Get the checksum for SS1. Compare the checksums for the two subsystems. This time, the checksums are not equal.

```matlab
[chksum1, chksum1_details] = ... Simulink.SubSystem.getChecksum(SS1); isequal(chksum1, chksum2) ans = 0
```

After you determine that the checksums are different, find out why. The Simulink engine uses information, such as signal data types, some block parameter values, and block connectivity information, to compute the checksums. To determine why checksums are different, compare the data that computes the checksum values. You can get this information from the second value returned by `Simulink.SubSystem.getChecksum`, which is a structure array with four fields.

Look at the structure `chksum1_details`.

```matlab
chksum1_details
chksum1_details =
    ContentsChecksum: [1x1 struct]
    InterfaceChecksum: [1x1 struct]
    ContentsChecksumItems: [287x1 struct]
    InterfaceChecksumItems: [53x1 struct]
```

`ContentsChecksum` and `InterfaceChecksum` are component checksums of the subsystem checksum. The remaining two fields, `ContentsChecksumItems` and `InterfaceChecksumItems`, contain the checksum details.

Determine whether a difference exists in the subsystem contents, interface, or both. For example:

```matlab
```
isequal(chksum1_details.InterfaceChecksum.Value,...
    chksum2_details.InterfaceChecksum.Value)
ans =
    1

In this case, differences exist in the content.

9 Write a script like this script to find the differences.

```matlab
idxForCDiffs=[];
for idx = 1:length(chksum1_details.ContentsChecksumItems)
    if (~strcmp(chksum1_details.ContentsChecksumItems(idx).Identifier, ...
        chksum2_details.ContentsChecksumItems(idx).Identifier))
        disp(['Identifiers different for contents item ', num2str(idx)]);
        idxForCDiffs=[idxForCDiffs, idx];
    end
    if (ischar(chksum1_details.ContentsChecksumItems(idx).Value))
        if (~strcmp(chksum1_details.ContentsChecksumItems(idx).Value, ...
            chksum2_details.ContentsChecksumItems(idx).Value))
            disp(['Character vector values different for contents item ', num2str(idx)]);
            idxForCDiffs=[idxForCDiffs, idx];
        end
    end
    if (isnumeric(chksum1_details.ContentsChecksumItems(idx).Value))
        if (chksum1_details.ContentsChecksumItems(idx).Value ~= ...
            chksum2_details.ContentsChecksumItems(idx).Value)
            disp(['Numeric values different for contents item ', num2str(idx)]);
            idxForCDiffs=[idxForCDiffs, idx];
        end
    end
end
```

10 Run the script. The example assumes that you named the script check_details.

```matlab
check_details
Character vector values different for contents item 202
```

The results indicate that differences exist for index item 202 in the subsystem contents.

11 Use the returned index values to get the handle, identifier, and value details for each difference found.

```matlab
chksum1_details.ContentsChecksumItems(202)
```

ans =

```
Handle: 'rtwdemo_ssreuse/SS1/Lookup Table'
Identifier: 'SaturateOnIntegerOverflow'
Value: 'on'
```

The details identify the Lookup Table block parameter **Saturate on integer overflow** as the focus for debugging a subsystem reuse issue.
See Also

More About

- “What Is Reentrant Code?” (Embedded Coder)
- “Design Models for Generated Embedded Code Deployment” (Embedded Coder)
- “Generate Reusable Code from Library Subsystems Shared Across Models” (Embedded Coder)
- “Control Generation of Subsystem Functions” (Embedded Coder)
- “Use Storage Classes in Reentrant, Multi-Instance Models and Components” on page 15-80
Generate Reusable Code From Referenced Models

Considerations for Subsystems that Contain Referenced Models

You can generate reusable code for subsystems that contain referenced models by using the same procedures and options described in “Control Generation of Subsystem Functions” (Embedded Coder). However, consider these restrictions:

- A top model that uses single-tasking mode and includes a referenced model that uses multi-tasking mode executes for blocks with different rates that are not connected. However, you get an error if the blocks with different rates are connected by a Rate Transition block (inserted manually or by Simulink).
- S-functions that you generate with the Embedded Coder Code > C/C++ Code > Generate S-function menu option do not support subsystems that contain a continuous sample time.
- The S-function system target file is not supported.
- The code generator ignores tunable parameters settings that you configure from the Model Parameter Configuration dialog box. To configure parameters to be tunable, define them as Simulink parameter objects in the base workspace.
- The code generator inlines parameters that are not tunable in the generated code and S-function.

**Note** If you select the S-function system target file, the subsystem block menu options Code > C/C++ Code > Build This System and Code > C/C++ Code > Build Selected Subsystem behave like Code > C/C++ Code > Generate S-Function (see “Generate S-Function from Subsystem” (Embedded Coder)).

Code Reuse and Model Blocks with Root Inport or Outport Blocks

A reusable subsystem function with input or output connected to the root Inport or Outport block of a referenced model can affect code reuse. This can prevent you from reusing atomic subsystems in a reference model context the same way you might reuse the subsystems in a standalone model.

For example, consider this subsystem:
Suppose that you make the following changes to the subsystem block parameters:

- Select “Treat as atomic unit” (Simulink).
- On the **Code Generation** tab, set “Function packaging” (Simulink) to **Reusable function**.

Then, suppose you create this model, which includes three instances of the preceding subsystem.

With the model configuration parameter “Default parameter behavior” set to **Inlined**, the code generator optimizes the code by generating one copy of the function for the reused subsystem.

```c
void reuse_subsys1_Subsystem(real_T rtu_In1, B_Subsystem_reuse_subsys1_T *localB) {
    localB->Gain = 3.0 * rtu_In1;
}
```

If you move the three subsystems into a Model block, you must modify your model and model configuration.

1. Add a Signal Conversion block or a Bias block between Subsystem3 and the Outport block. If the subsystem has a Merge block with initial conditions, do not add a Signal Conversion block. Instead, add a Bias block to obtain a reusable function.
2. Select the model configuration parameter “Pass fixed-size scalar root inputs by value for code generation” (Simulink).

The result is a single reusable function:
void reuse_subsys1_Subsystem(real_T rtu_In1, B_Subsystem_reuse_subsys1_T *localB)
{
    localB->Gain = 3.0 * rtu_In1;
}

See Also

Related Examples
• “Generate Reusable Code from Library Subsystems Shared Across Models” on page 9-55
Generate Reusable Code from Library Subsystems Shared Across Models

What Is a Reusable Library Subsystem?

A reusable library subsystem is a subsystem included in a library that is configured for reuse. You must define a subsystem in a library and configure it for reuse to reuse the subsystem across models.

To reuse common functionality, you can include multiple instances of a subsystem:

- Within a single model, which is a top model or part of model reference hierarchy
- Across multiple referenced models in a model reference hierarchy
- Across multiple top models that contain Model blocks
- Across multiple top models that do not include Model blocks

The code generator uses checksums to determine reusability. There are cases when the code generator cannot reuse subsystem code.

For incremental code generation, if the reusable library subsystem changes, a rebuild of itself and its parents occurs. During the build, if a matching function is not found, a new instance of the reusable function is generated into the shared utilities folder. If a different matching function is found from previous builds, that function is used, and a new reusable function is not emitted.

For subsequent builds, unused files are not replaced or deleted from your folder. During development of a model, when many obsolete shared functions exist in the shared utilities folder, you can delete the folder and regenerate the code. If all instances of a reusable library subsystem are removed from a model reference hierarchy and you regenerate the code, the obsolete shared functions remain in the shared utilities folder until you delete them.

If a model changes such that the change might cause different generated code for the subsystem, a new reusable function is generated. For example, model configuration parameters that modify code comments might cause different generated code for the subsystem even if the reusable library subsystem did not change.
Reusable Library Subsystem Code Placement and Naming

The generated code of a reusable library subsystem is independent of the generated code of the model. Code for the reusable library subsystem is generated to the shared utility folder, `slprj/target/_sharedutils`, instead of the model reference hierarchy folders. The generated code for the supporting types, which are generated to the `.h` file, are also in the shared utilities folder.

For unique naming, reusable function names have a checksum appended to the reusable library subsystem name. For example, the code and files for a subsystem, SS1, which links to a reusable library subsystem, RLS, might be:

- Function name: `RLS_mgdjlngd`
- File name: `RLS_mgdjlnnd.c` and `RLS_mgdjlnnd.h`

Configure Reusable Library Subsystem

Set the Subsystem parameters as listed here:

- Select **Treat as an atomic unit**.
- On the **Code Generation** tab:
  - Set **Function packaging** to **Reusable function**.
  - Set **Function name options** and **File name options** to **Auto**, **Use subsystem name**, or **User specified**.

In a model reference hierarchy, if an instance of the reusable library subsystem is in the top model, then on the **Model Referencing** pane of the Configuration Parameters dialog box, you must select the **Pass fixed-size scalar root input by value for code generation** parameter. If you do not select the parameter, a separate shared function is generated for the reusable library subsystem instance in the top model, and a reusable function is generated for instances in the referenced models.

If a reusable library subsystem is connected to the root outport, reuse does not happen with identical subsystems that are not connected to the root outport. However, you can set **Pass reusable system outputs as** to **Individual arguments** on the **Optimizations** pane to make sure that reuse occurs between these subsystems. This parameter requires an Embedded Coder license.
For more information on creating a library, see “Libraries” (Simulink). For an example of creating a reusable library subsystem, see “Generate Reusable Code for Subsystems Shared Across Models” on page 9-57.

**Configure Models That Include Reusable Library Subsystems**

For a model to use a reusable library subsystem, you must configure the model differently depending on whether the model is a reference model or top model. If the subsystem is in a referenced model hierarchy, set the configuration parameter, “Shared code placement” to Auto. Otherwise, for each model that uses the subsystem, set the model configuration parameter **Shared code placement** to **Shared location**.

If a reusable library subsystem uses a shared local data store and you configure default mapping for model data elements, leave the default storage class mapping for category **Shared local data stores** set to **Default**.

**Generate Reusable Code for Subsystems Shared Across Models**

This example shows how to configure a reusable library subsystem and generate a reusable function for a subsystem shared across referenced models. The result is reusable code for the subsystem, which is generated to the shared utility folder (`slprj/target/_sharedutils`).

- “Create a reusable library subsystem.” on page 9-57
- “Create the example model.” on page 9-60
- “Set configuration parameters of the top model.” on page 9-62
- “Create and propagate a configuration reference.” on page 9-62
- “Generate and view the code.” on page 9-63

**Create a reusable library subsystem.**

1. In the Simulink Editor, select **File > New > Library**. Open `rtwdemo_ssreuse` to copy and paste subsystem SS1 into the Library Editor. This action loads the variables for SS1 into the base workspace. Rename the subsystem block to RLS.
2 Click the Subsystem block and press **Ctrl+U** to view the contents of subsystem RLS.
3  To configure the subsystem, in the Library editor, right-click RLS. In the context menu, select **Block Parameters(Subsystem)**. In the Subsystem Parameters dialog box, choose the following options:

- Select **Treat as an atomic unit**.
- On the **Code Generation** tab:
  - Set **Function packaging** to Reusable function.
  - Set **Function name options** to User specified and verify that the **Function name** is set to myfun.
  - Set **File name options** to Auto.

4  Click **Apply** and **OK**.
5  Save the reusable library subsystem as `ssreuselib`, which creates a file, `ssreuselib.slx`.

**Create the example model.**

1  Create a model which includes one instance of RLS from `ssreuselib`. Name this subsystem SS1. Add another subsystem and name it SS2. Name the model `ex_model1`.

![Diagram of example model](image_url)

2  Create another model which includes one instance of RLS from `ssreuselib`. Name this subsystem SS1. Add another subsystem and name it SS3. Name the model `ex_model2`. 
Create a top model with two model blocks that reference `ex_model1` and `ex_model2`. Save the top model as `ex_mdlref_ssreuse`.
Set configuration parameters of the top model.

1  With model `ex_mdlref_ssreuse` open in the Simulink Editor, select **Simulation > Model Configuration Parameters** to open the Configuration Parameters dialog box.
2  On the **Solver** pane, specify the **Type** as **Fixed-step**.
3  On the **Model Referencing** pane, select **Pass fixed-size scalar root inputs by value for code generation**.
4  On the **Code Generation > Report** pane, select **Create code generation report** and **Open report automatically**.
5  On the **Code Generation > Interface** pane, set the “Shared code placement” to **Shared location**.
6  On the **Code Generation > Symbols** pane, set the **Maximum identifier length** to 256. This step is optional.
7  Click **Apply** and **OK**.

Create and propagate a configuration reference.

1  In the Simulink Editor, select **View > Model Explorer** to open the Model Explorer. In the left navigation column of the Model Explorer, expand the `ex_mdlref_ssreuse` node.
2 Right-click **Configuration** and select **Convert to Configuration Reference**.

3 In the Convert Active Configuration to Reference dialog box, click **OK**. This action converts the model configuration set to a configuration reference, `Simulink.ConfigSetRef`, and creates the configuration reference object, `configSetObj`, in the base workspace.

4 In the left navigation column, right-click **Reference (Active)** and select **Propagate to Referenced Models**.

5 In the Configuration Reference Propagation to Referenced Models dialog box, select the referenced models in the list. Click **Propagate**.

Now, the top model and referenced models use the same configuration reference, **Reference (Active)**, which points to a model configuration reference object, `configSetObj`, in the base workspace. When you save your model, you also need to export the `configSetObj` to a MAT-file.

**Generate and view the code.**

1 To generate code, in the Simulink Editor, press **Ctrl+B**. After the code is generated, the code generation report opens.

2 To view the code generation report for a referenced model, in the left navigation pane, in the **Referenced Models** section, select **ex_model1**. The code generation report displays the generated files for **ex_model1**.

3 In the left navigation pane, expand the **Shared files**. The code generator uses the reusable library subsystem name. The code for subsystem **SS1** is in **myfun.c** and **myfun.h**.
Click Back and navigate to the `ex_model2` code generation report. `ex_model2` uses the same source code, `myfun.c` and `myfun.h`, as the code for `ex_model1`. Your subsystem function and file names will be different.
See Also

More About

- “Libraries” (Simulink)
- “Generate Reentrant Code from Subsystems” (Embedded Coder)
- “Control Generation of Subsystem Functions” on page 6-2
Generate Reusable Code from Stateflow Atomic Subcharts

Generate Reusable Code for Linked Atomic Subcharts

To specify code generation parameters for linked atomic subcharts from the same library:

1. Open the library model that contains your atomic subchart.
2. Unlock the library.
3. Right-click the library chart and select Block Parameters.
4. In the dialog box, specify the following parameters:
   a. On the Main tab, select Treat as atomic unit.
   b. On the Code Generation tab, set Function packaging to Reusable function.
   c. Set File name options to User specified.
   d. For File name, enter the name of the file with no extension.
   e. Click OK to apply the changes.
5. (OPTIONAL) Customize the generated function names for atomic subcharts:
   a. Set model configuration parameter System target file to ert.tlc.
   b. For model configuration parameter Subsystem methods, specify the format of the function names using a combination of the following naming rule tokens:
      - $R — root model name
      - $F — type of interface function for the atomic subchart
      - $N — block name
      - $H — subsystem index
      - $M — name-mangling text
   c. Click OK to apply the changes.

When you generate code for your model, a separate file stores the code for linked atomic subcharts from the same library.
Generate Reusable Code for Unlinked Atomic Subcharts

To specify code generation parameters for an unlinked atomic subchart:

1. In your chart, right-click the atomic subchart and select Properties.
2. In the dialog box, specify the following parameters:
   a. Set Code generation function packaging to Reusable function.
   b. Set Code generation file name options to User specified.
   c. For Code generation file name, enter the name of the file with no extension.
   d. Click OK to apply the changes.
3. (OPTIONAL) Customize the generated function names for atomic subcharts:
   a. Set model configuration parameter System target file to ert.tlc.
   b. For model configuration parameter Subsystem methods, specify the format of the function names using a combination of the following naming rule tokens:
      • $R — root model name
      • $F — type of interface function for the atomic subchart
      • $N — block name
      • $H — subsystem index
      • $M — name-mangling text
   c. Click OK to apply the changes.

When you generate code for your model, a separate file stores the code for the atomic subchart. For more information, see “Generate Reusable Code for Unit Testing” on page 13-8.

Generate Reusable Code for Unit Testing

Convert a State to an Atomic Subchart

To convert state A to an atomic subchart, right-click the state and select Group & Subchart > Atomic Subchart. State A changes to an atomic subchart:
Set Up a Standalone C File for the Atomic Subchart

1. Open the properties dialog box for A.
2. Set **Code generation function packaging** to Reusable function.
3. Set **Code generation file name options** to User specified.
4. For **Code generation file name**, enter saturator as the name of the file.
5. Click **OK**.

Set Up the Code Generation Report

1. Open the Model Configuration Parameters dialog box.
2. In the **Code Generation** pane, set **System target file** to ert.tlc.
3. In the **Code Generation > Report** pane, select **Create code generation report**.

   This step automatically selects **Open report automatically** and **Code-to-model**.
4. Select **Model-to-code**.
5. Click **Apply**.
Customize the Generated Function Names

1. In the Model Configuration Parameters dialog box, go to the Code Generation > Symbols pane.

2. Set Subsystem methods to the format scheme $R$N$M$F, where:
   - $R$ is the root model name.
   - $N$ is the block name.
   - $M$ is the mangle token.
   - $F$ is the type of interface function for the atomic subchart.

   For more information, see “Subsystem methods”.

3. Click Apply.

Generate Code for Only the Atomic Subchart

To generate code for your model, press Ctrl+B. In the code generation report that appears, you see a separate file that contains the generated code for the atomic subchart.

To inspect the code for saturator.c, click the hyperlink in the report to see the following code:
void ex_reuse_states_A_during(real_t rtu_u1, real_T *rty_v1, struct ex_reuse_states *localDW)
{
    /* During: Chart/A */
    localDW->isStable = TRUE;
    switch (localDW->is_c2_ex_reuse_states) {
        case ex_reuse_states_IN_Neg:
            /* During 'Neg': '<S2>:17' */
            if (rtu_u1 > 0.0) {
                /* Transition: '<S2>:5' */
                localDW->isStable = FALSE;
                localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Pos;
                /* Entry 'Pos': '<S2>:16' */
                (*rty_v1) = 1.0;
            }
            break;
        case ex_reuse_states_IN_Pos:
            /* During 'Pos': '<S2>:16' */
            if (rtu_u1 < 0.0) {
                /* Transition: '<S2>:4' */
                localDW->isStable = FALSE;
                localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Neg;
                /* Entry 'Neg': '<S2>:17' */
                (*rty_v1) = -1.0;
            }
            break;
        default:
            if (rtu_u1 > 0.0) {
                /* Transition: '<S2>:12' */
                localDW->isStable = FALSE;
                localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Pos;
                /* Entry 'Pos': '<S2>:16' */
                (*rty_v1) = 1.0;
            } else {
                /* Transition: '<S2>:13' */
                localDW->isStable = FALSE;
                localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Neg;
                /* Entry 'Neg': '<S2>:17' */
                (*rty_v1) = -1.0;
            }
            break;
    }
}
Line 28 shows that the during function generated for the atomic subchart has the name `ex_reuse_states_A_during`. This name follows the format scheme $R$N$M$F specified for **Subsystem methods**:

- $R$ is the root model name, `ex_reuse_states`.
- $N$ is the block name, `A`.
- $M$ is the mangle token, which is empty.
- $F$ is the type of interface function for the atomic subchart, `during`.

**Note** The line numbers shown can differ from the numbers that appear in your code generation report.

**See Also**

**More About**

- “Basic Approach for Modeling Event-Driven Systems” (Stateflow)
- “Encapsulate Modal Logic Using Subcharts” (Stateflow)
Generate Shared Utility Code

When to Generate Shared Utility Code

Blocks in a model can require common functionality to implement their algorithms. Consider modularizing this functionality into standalone support or helper functions. This approach can be more efficient than inlining the code for the functionality for each block instance. To decide about using a library or a shared utility, consider:

- Packaging functions that can have multiple callers into a library when the functions are defined statically. That is, before you use the code generator to produce code for your model, the function source code exists in a file.
- Packaging functions that can have multiple callers as shared utilities (produced during code generation) when the functions cannot be defined statically. For example, several model- and block-specific properties specify which functions are used and their behavior. Also, these properties determine type definitions (for example, typedef) in shared utility header files. The number of possible combinations of properties that determine unique behavior make it impractical to define statically the possible function files before code generation.

Configure Naming of Generated Functions

Configure a default naming rule for generated shared utility functions by using one of these methods.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>A new model or an existing model for which you have mapped default customization settings by using the Code Mapping Editor or code default mapping programming interface</td>
<td>In the Embedded Coder Dictionary, define a function customization template that specifies a custom function naming rule. Then, in the Code Mapping Editor or by using the code default mapping programming interface, map the Shared utility function category to that template. For more information, see “Configure Default C Code Generation for Categories of Model Data and Functions” (Embedded Coder).</td>
</tr>
</tbody>
</table>
Once you use the **Code Mapping Editor** or default mapping programming interface to configure a model, setting the **Shared utilities identifier format** parameter has no effect.

The naming rule for shared utility functions must include the conditional checksum token $C$. To customize the length of the checksum that the code generator produces, use the **Shared checksum length** (SharedChecksumLength) parameter. Increasing the length of the checksum reduces the probability of clashes.

This example shows the customization of shared utility function names.

1. Open the example model `rtwdemo_crlmath`.
2. Set model configuration parameter **Shared code placement** to **Shared location**.
3. Set parameter **Shared utilities identifier format** as `mymodel_$N$C`. You can customize this format with any string. However, you must include token $C$.
4. Set parameter **Shared checksum length** to 5.
5. Generate code and a code generation report.
6. In the left navigation pane of the report, review the list generated files for shared utilities under **Shared files**.

---

**Control Placement of Shared Utility Code**

Control placement of shared utility code with the model configuration parameter **Shared code placement**. The default option value is **Auto**. For this setting, the code generator places required code for fixed-point and other utilities in the `model.c` file, the `model.cpp` file, or a separate file in the build folder (for example, `vdp_grt_rtw`) if a model does not contain existing shared utility code or one of these blocks:

- Model blocks
• Simulink Function blocks
• Function Caller blocks
• Calls to Simulink Functions from Stateflow or MATLAB Function blocks
• Stateflow graphical functions when you select the Export Chart Level Functions parameter

If a model contains one or more of the preceding blocks, the code generator creates and uses a shared utilities folder within `slprj`. The naming convention for shared utility folders is `slprj/target/_sharedutils`. `target` is `sim` for simulations with Model blocks or the name of the system target file for code generation.

```
slprj/sim/_sharedutils   % folder used with simulation
slprj/grt/_sharedutils   % folder used with grt.tlc STF
slprj/ert/_sharedutils   % folder used with ert.tlc STF
slprj/mytarget/_sharedutils % folder used with mytarget.tlc STF
```

To force a model build to use the `slprj` folder for shared utility generation, even when the current model does not contain existing shared utility code or one of the preceding blocks, set parameter Shared code placement to Shared location. The code generator places utilities under the `slprj` folder rather than in the normal build folder. This setting is useful when you are manually combining code from several models, because it prevents symbol collisions between the models.

### Control Placement of rtwtypes.h for Shared Utility Code

The generated `rtwtypes.h` header file provides fundamental type definitions, `#define` statements, and enumerations. For more information, see “rtwtypes.h” on page 21-50.

Control placement of `rtwtypes.h` file by selecting whether the build process uses the shared utilities folder. If the model build uses a shared utilities folder, the build process places `rtwtypes.h` in `slprj/target/_sharedutils`. Otherwise, the software places `rtwtypes.h` in `model_target_rtw`.

Adding a model to a model hierarchy or changing an existing model in the hierarchy can result in updates to the shared `rtwtypes.h` file during code generation. If updates occur, recompile and, depending on your development process, reverify previously generated code. To minimize updates to the `rtwtypes.h` file, make the following changes in the Configuration Parameters dialog box:

• Select Support: complex numbers even if the model does not currently use complex data types. Selecting this parameter protects against a future requirement to add support for complex data types when integrating code.
• Clear the **Support non-inlined S-functions** parameter. If you use noninlined S-functions in the model, this option generates an error.
• Clear the **Classic call interface** parameter. This parameter setting disables use of the GRT system target file.

**Avoid Duplicate Header Files for Exported Data**

Exported header files appear in the shared utility folder when:

• You control the file placement of declarations for signals, parameters, and states by defining and applying storage classes.
• The code generator places utility code in a shared location.

For example, you can specify a header file for a piece of data through:

• A storage class that you define in the **Embedded Coder Dictionary** and map to categories of model data in the **Code Mapping Editor**.
• The **Code Generation** tab in a Signal Properties dialog box.
• The **HeaderFile** property of a data object. Data objects are objects of the classes Simulink.Signal and Simulink.Parameter.

If you want the declaration to appear in the file *model.h*, it is a best practice to leave the header file name unspecified. By default, the code generator places data declarations in *model.h*.

If you specify *model.h* as the header file name, and if the code generator places utility code in a shared location, you cannot generate code from the model. The code generator cannot create the file *model.h* in both the model build folder and the shared utility folder.

**Reduce Shared Utility Code Generation with Incremental Builds**

You can specify that the model build generates C source files in a shared utilities folder. See “Generate Shared Utility Code” on page 9-72. These files include C source files that contain function definitions and header files that contain macro definitions. For this discussion, the term functions means functions and macros.

Blocks within the same model and blocks in different models can use a shared function when you use model reference or when you build multiple standalone models from the
same start build folder. The code generator produces the code for a given function only once for the block that first triggers code generation. As the product determines the requirement to generate function code for subsequent blocks, it performs a file existence check. If the file exists, the model build does not regenerate the function. The shared utility code mechanism requires that a given function and file name represent the same functional behavior regardless of which block or model generates the function. To satisfy this requirement:

• Model properties that determine function behavior contribute to the shared utility checksum or determine the function and file name.
• Block properties that determine the function behavior also determine the function and file name.

During compilation, makefile rules for the shared utilities folder select compilation of only new C files and incrementally archive the object file into the shared utility library, rtwshared.lib, or rtwshared.a. Incremental compilation also occurs.

**Manage the Shared Utility Code Checksum**

When you set the model configuration parameter **Shared code placement** to **Shared location** or when the model contains Model blocks, the code generator places shared code in the shared utilities folder. The build process generates a shared utilities checksum of the code generation configuration for the shared code.

During subsequent code generation, if the checksum file slprj/target/_sharedutils/checksummap.mat exists relative to the current folder, the code generator reads that file. The code generator verifies that the current model that you are building has configuration properties that match the checksum of properties from the shared utility model. If mismatches occur between the properties defined in checksummap.mat and the current model properties, you see an error. Use the error message to manage the checksum (for example, diagnose and resolve the configuration issues with the current model).

For more information, see “Reduce Shared Utility Code Generation with Incremental Builds” on page 9-75.

• “View the Shared Utility Checksum Hash Table” on page 9-77
• “Relate the Shared Utility Checksum to Configuration Parameters” on page 9-78
**View the Shared Utility Checksum Hash Table**

It is helpful to view the property values that contribute to the checksum. This example uses the `rtwdemo_lct_start_term.slx` model. To load the `checksum.mat` file into MATLAB and view the `targetInfoStruct` that defines the checksum-related properties:

1. Open the `rtwdemo_lct_start_term.slx` model. In the Command Window, type:
   ```matlab
   rtwdemo_lct_start_term
   ```
2. Create and move to a new working folder.
   ```matlab
   mkdir C:\Temp\demo
   cd C:\Temp\demo
   ```
3. Save a copy of the model in the folder.
4. Build the model. This model is already set up to produce shared utilities.
5. Move to the `_sharedutils` folder created by the build process.
   ```matlab
   cd C:\Temp\demo\slprj\grt\_sharedutils
   ```
6. Load the `checksummap.mat` file into MATLAB.
   ```matlab
   load checksummap
   ```
7. Display the contents of `hashTbl.targetInfoStruct` and examine the checksum-related property values.
   ```matlab
   hashTbl.targetInfoStruct
   ```

For this example, the Command Window displays `hashTbl.targetInfoStruct` for the shared utilities that you generated from the model:

```
ShiftRightIntArith: 'on'
ProdShiftRightIntArith: 'on'
       Endianess: 'LittleEndian'
       ProdEndianess: 'LittleEndian'
       wordlengths: '8,16,32,32,64,32,64,64,64,64'
       Prodwordlengths: '8,16,32,32,64,32,64,64,64,64'
      TargetWordSize: '64'
      ProdWordSize: '64'
 TargetHWDeviceType: 'Custom Processor->MATLAB Host Computer'
 ProdHWDeviceType: 'Intel->x86-64 (Windows64)'
    TargetIntDivRoundTo: 'Zero'
    ProdIntDivRoundTo: 'Zero'
       tmfName: ''
     toolchainName: ''
       computer: 'PCWIN64'
UseDivisionForNetSlopeComputation: 'off'
  PurelyIntegerCode: 'off'
PortableWordSizes: 'off'
SupportNonInlinedSFcns: '
```
Relate the Shared Utility Checksum to Configuration Parameters

Examine the targetInfoStruct hash table from the shared utility model. Some key-value pairs relate directly to a model property. Other pairs relate to groups of properties.

The following table describes the key-value pairs.

<table>
<thead>
<tr>
<th>Key Names</th>
<th>Model Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>ShiftRightIntArith</td>
<td>TargetShiftRightIntArith</td>
</tr>
<tr>
<td>ProdShiftRightIntArith</td>
<td>ProdShiftRightIntArith</td>
</tr>
<tr>
<td>Endianess</td>
<td>TargetEndianess</td>
</tr>
<tr>
<td>ProdEndianess</td>
<td>ProdEndianess</td>
</tr>
<tr>
<td>Key Names</td>
<td>Model Properties</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>wordlengths</td>
<td>TargetBitPerChar, TargetBitPerShort, TargetBitPerInt, TargetBitPerLong, TargetBitPerLongLong, TargetBitPerFloat, TargetBitPerDouble, TargetBitPerPointer</td>
</tr>
<tr>
<td>Prodwordlengths</td>
<td>ProdBitPerChar, ProdBitPerShort, ProdBitPerInt, ProdBitPerLong, ProdBitPerLongLong, ProdBitPerFloat, ProdBitPerDouble, ProdBitPerPointer</td>
</tr>
<tr>
<td>TargetWordSize</td>
<td>TargetWordSize</td>
</tr>
<tr>
<td>ProdWordSize</td>
<td>ProdWordSize</td>
</tr>
<tr>
<td>TargetHWDeviceType</td>
<td>TargetHWDeviceType</td>
</tr>
<tr>
<td>ProdHWDeviceType</td>
<td>ProdHWDeviceType</td>
</tr>
<tr>
<td>TargetIntDivRoundTo</td>
<td>TargetIntDivRoundTo</td>
</tr>
<tr>
<td>ProdIntDivRoundTo</td>
<td>ProdIntDivRoundTo</td>
</tr>
<tr>
<td>tmfName</td>
<td>TemplateMakefile</td>
</tr>
<tr>
<td>toolchainName</td>
<td>Toolchain</td>
</tr>
<tr>
<td>computer</td>
<td>return value of the computer command</td>
</tr>
<tr>
<td>UseDivisionForNetSlopeComputation</td>
<td>UseDivisionForNetSlopeComputation</td>
</tr>
<tr>
<td>PurelyIntegerCode</td>
<td>PurelyIntegerCode</td>
</tr>
<tr>
<td>PortableWordSizes</td>
<td>PortableWordSizes</td>
</tr>
<tr>
<td>SupportNonInlinedSFcns</td>
<td>SupportNonInlinedSFcns</td>
</tr>
<tr>
<td>RTWReplacementTypes</td>
<td>EnableUserReplacementTypes, ReplacementTypes</td>
</tr>
<tr>
<td>MaxIdInt8</td>
<td>MaxIdInt8</td>
</tr>
<tr>
<td>MinIdInt8</td>
<td>MinIdInt8</td>
</tr>
<tr>
<td>MaxIdUint8</td>
<td>MaxIdUint8</td>
</tr>
<tr>
<td>MaxIdInt16</td>
<td>MaxIdInt16</td>
</tr>
<tr>
<td>Key Names</td>
<td>Model Properties</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>MinIdInt16</td>
<td>MinIdInt16</td>
</tr>
<tr>
<td>MaxIdUint16</td>
<td>MaxIdUint16</td>
</tr>
<tr>
<td>MaxIdInt32</td>
<td>MaxIdInt32</td>
</tr>
<tr>
<td>MinIdInt32</td>
<td>MinIdInt32</td>
</tr>
<tr>
<td>MaxIdUint32</td>
<td>MaxIdUint32</td>
</tr>
<tr>
<td>BooleanTrueId</td>
<td>BooleanTrueId</td>
</tr>
<tr>
<td>BooleanFalseId</td>
<td>BooleanFalseId</td>
</tr>
<tr>
<td>TypeLimitIdReplacementHeaderFile</td>
<td>TypeLimitIdReplacementHeaderFile</td>
</tr>
<tr>
<td>SharedCodeRepository</td>
<td>reserved (internal use only)</td>
</tr>
<tr>
<td>TargetLang</td>
<td>TargetLang</td>
</tr>
<tr>
<td>PreserveExternInFcnDecls</td>
<td>PreserveExternInFcnDecls</td>
</tr>
<tr>
<td>EnableSignedRightShifts</td>
<td>EnableSignedRightShifts</td>
</tr>
<tr>
<td>EnableSignedLeftShifts</td>
<td>EnableSignedLeftShifts</td>
</tr>
<tr>
<td>TflName</td>
<td>CodeReplacementLibrary</td>
</tr>
<tr>
<td>TflCheckSum</td>
<td>reserved (internal use only)</td>
</tr>
<tr>
<td>UtilMemSecName</td>
<td>MemSecFuncSharedUtil, MemSecPackage</td>
</tr>
<tr>
<td>CodeCoverageChecksum</td>
<td>reserved (internal use only)</td>
</tr>
<tr>
<td>TargetLargestAtomicInteger</td>
<td>TargetLargestAtomicInteger</td>
</tr>
<tr>
<td>TargetLargestAtomicFloat</td>
<td>TargetLargestAtomicFloat</td>
</tr>
<tr>
<td>ProdLargestAtomicInteger</td>
<td>ProdLargestAtomicInteger</td>
</tr>
<tr>
<td>ProdLargestAtomicFloat</td>
<td>ProdLargestAtomicFloat</td>
</tr>
<tr>
<td>LongLongMode</td>
<td>TargetLongLongMode</td>
</tr>
<tr>
<td>ProdLongLongMode</td>
<td>ProdLongLongMode</td>
</tr>
<tr>
<td>CollapseNonTrivialExpressions</td>
<td>reserved (internal use only)</td>
</tr>
</tbody>
</table>
See Also

More About

- “Generate Shared Utility Code for Fixed-Point Functions” on page 9-82
- “Generate Shared Utility Code for Custom Data Types” on page 9-84
- “Cross-Release Shared Utility Code Reuse” on page 21-84
- “Customize Generated C Function Interfaces” (Embedded Coder)
Generate Shared Utility Code for Fixed-Point Functions

An important set of generated functions that the model build places in the shared utility folder are the fixed-point support functions. Based on model and block properties, there are many possible versions of fixed-point utilities functions that make it impractical to provide a complete set as static files. Generating only the required fixed-point utility functions during the code generation process is an efficient alternative.

The shared utility checksum mechanism makes sure that several critical properties are identical for models that use the shared utilities. For the fixed-point functions, there are additional properties that determine function behavior. The mechanism codes these properties into the functions and file names to maintain requirements. The additional properties include:

<table>
<thead>
<tr>
<th>Category</th>
<th>Function/Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block properties</td>
<td>• Fixed-point operation that the block performs</td>
</tr>
<tr>
<td></td>
<td>• Fixed-point data type and scaling (Slope, Bias) of function inputs and outputs</td>
</tr>
<tr>
<td></td>
<td>• Overflow handling mode (Saturation, Wrap)</td>
</tr>
<tr>
<td></td>
<td>• Rounding Mode (Floor, Ceil, Zero)</td>
</tr>
<tr>
<td>Model properties</td>
<td>get_param(bdroot, 'NoFixptDivByZeroProtection')</td>
</tr>
</tbody>
</table>

The property-based naming convention for the fixed-point utilities is as follows:

operation + [zero protection] + output data type + output bits + [input1 data] + input1 bits + [input2 data type + input2 bits] + [shift direction] + [saturate mode] + [round mode]

The file names shown are examples of generated fixed-point utility files. The function or macro names in the file are identical to the file name without the extension.

- FIX2FIX_U12_U16.c
- FIX2FIX_S9_S9_SR99.c
- ACCUM_POS_S30_S30.h
- MUL_S30_S30_S16.h
- div_nzp_s16s32_floor.c
- div_s32_sat_floor.c

For these examples, the table shows how the respective fields correspond.

The ACCUM_POS example uses the output variable as one of the input variables. So, the file and macro name only contain the output and second input.
The second `div` example has identical data type and bits for both inputs and the output. So, the file and function name only include the output.

<table>
<thead>
<tr>
<th>Operation</th>
<th>FIX2FIX</th>
<th>FIX2FIX</th>
<th>ACCUM_POS</th>
<th>MUL</th>
<th>div</th>
<th>div</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero protection</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
<td>_nzp</td>
<td>NULL</td>
</tr>
<tr>
<td>Output data type</td>
<td>_U</td>
<td>_S</td>
<td>_S</td>
<td>_S</td>
<td>_s</td>
<td>_s</td>
</tr>
<tr>
<td>Output bits</td>
<td>12</td>
<td>9</td>
<td>30</td>
<td>30</td>
<td>16</td>
<td>32</td>
</tr>
<tr>
<td>Input data type</td>
<td>_U</td>
<td>_S</td>
<td>_S</td>
<td>_S  [and _S]</td>
<td>s</td>
<td>NULL</td>
</tr>
<tr>
<td>Input bits</td>
<td>16</td>
<td>9</td>
<td>30</td>
<td>30 [and 16]</td>
<td>32</td>
<td>NULL</td>
</tr>
<tr>
<td>Shift direction</td>
<td>NULL</td>
<td>SR99</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
</tr>
<tr>
<td>Saturate mode</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
<td>_sat</td>
</tr>
<tr>
<td>Round mode</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
<td>NULL</td>
<td>_floor</td>
<td>_floor</td>
</tr>
</tbody>
</table>

See Also

More About

- “Generate Shared Utility Code” on page 9-72
- “Generate Shared Utility Code for Custom Data Types” on page 9-84
- “Cross-Release Shared Utility Code Reuse” on page 21-84
Generate Shared Utility Code for Custom Data Types

By default, if a model employs a custom data type (such as a Simulink.AliasType object or an enumeration class), the code generator places the corresponding type definition (typedef) in the model_types.h file. When you generate code from multiple models, each model duplicates the type definition. These duplicate definitions can prevent you from compiling the bodies of generated code together.

However, you can configure the code generator to place a single type definition in a header file in the _sharedutils folder. Then, when you generate code from a model, if the type definition already exists in the _sharedutils folder, the code generator does not duplicate the definition, but instead reuses it through inclusion (#include).

Through this mechanism, you can share:

- Simulink data type objects that you instantiate from the classes Simulink.AliasType, Simulink.Bus, and Simulink.NumericType. For basic information about creating and using these objects, see “Control Data Type Names in Generated Code” (Embedded Coder) and Simulink.Bus.

- Enumerations that you define, for example, by authoring an enum class in a script file or by using the function Simulink.defineIntEnumType. For basic information about defining enumerations in Simulink, see “Use Enumerated Data in Simulink Models” (Simulink).

To share a custom data type across multiple models:

1. Define the data type. For example, create the Simulink.AliasType object.
2. Set data scope and header file properties to specific values that enable sharing.
   
   For a data type object, set the DataScope property to 'Exported' and, optionally, specify the header file name through the HeaderFile property.

   For an enumeration that you define as an enum class in a script file, implement the getDataScope method (with return value 'Exported') and, optionally, implement the getHeaderFile method.

   For an enumeration that you define by using the Simulink.defineIntEnumType function, set the 'DataScope' pair argument to 'Exported' and, optionally, specify the 'HeaderFile' pair argument.
3. Use the data type in the models.
Before generating code from each model, set the model configuration parameter **Shared code placement** to **Shared location**.

Generate code from the models.

**Note** You can configure the definition of the custom data type to appear in a header file in the `_sharedutils` folder. The shared utility functions that the model build generates into the `_sharedutils` folder do not use the custom data type name. Only model code located in code folders for each model uses the custom data type name.

**See Also**

**More About**

- “Generate Shared Utility Code” on page 9-72
- “Generate Shared Utility Code for Fixed-Point Functions” on page 9-82
- “Cross-Release Shared Utility Code Reuse” on page 21-84
- “Control File Placement of Custom Data Types” (Embedded Coder)
Shared Constant Parameters for Code Reuse

You can share the generated code for constant parameters across models if either of the following conditions applies:

- Constant parameters are shared in a model reference hierarchy.
- The model configuration parameter “Shared code placement” is set to Shared location.

If you do not want to generate shared constants, and Shared code placement is set to Shared location, set the parameter GenerateSharedConstants to off. For example, to turn off shared constants for the current model, in the Command Window, type the following.

```MATLAB
set_param(gcs,'GenerateSharedConstants','off');
```

The code generator produces shared constant parameters individually and places them in the file const_params.c. The code generator places that file in the shared utilities folder slprj/target/_sharedutils.

For example, if a constant has multiple uses within a model reference hierarchy where the top model is named topmod, the code for the shared constant is as follows:

- In the shared utility folder, slprj/grt/_sharedutils, the constant parameters are defined in const_params.c and named rtCP_pooled_ appended to a unique checksum:
  ```c
  extern const real_T rtCP_pooled_lfcjjmohiecj[7];
  const real_T rtCP_pooled_lfcjjmohiecj[7] = { 1.0, 2.0, 3.0, 4.0, 5.0, 6.0, 7.0 };
  
  extern const real_T rtCP_pooled_ppphodhfbcba[7];
  const real_T rtCP_pooled_ppphodhfbcba[7] = { 7.0, 6.0, 5.0, 4.0, 3.0, 2.0, 1.0 };  
  ```
- In top_model_private.h or in a referenced model, ref_model_private.h, for better readability, the constants are renamed as follows:
  ```c
  #define rtCP_Constant_Value   rtCP_pooled_lfcjjmohiecj  /* Expression: [1 2 3 4 5 6 7] *
  * Referenced by: '<Root>/Constant'*/
  
  #define rtCP_Gain_Gain        rtCP_pooled_ppphodhfbcba  /* Expression: [7 6 5 4 3 2 1] *
  * Referenced by: '<Root>/Gain' */
  ```
- In topmod.c or refmod.c, the call site might be:
  ```c
  for (i = 0; i < 7; i++) {
      topmod_Y.Out1[i] = (topmod_U.In1 + rtCP_Constant_Value[i]) * rtCP_Gain_Gain[i];
  }
  ```
The code generator attempts to generate constants as individual constants to the `const_params.c` file in the shared utilities folder. Otherwise, constants are generated as described in “Code Generation of Constant Parameters” on page 6-13.

**Suppress Shared Constants in the Generated Code**

You can choose whether the code generator produces shared constants and shared functions. You might want to be able to keep the code and data separate between subsystems, or you might find that sharing constants results in a memory shortage during code generation.

You can change this setting programmatically by using the parameter `GenerateSharedConstants` with `set_param` and `get_param`.

In the following example, when `GenerateSharedConstants` is set to `on`, the code generator defines the constant values in the `sharedutils` folder in the `const_params.c` file. When `GenerateSharedConstants` is set to `off`, the code generator defines the constant values in a nonshared area, in the `model_ert_rtw` file in the `model_data.c` file.

Open the model `rtwdemo_throttlecntrl`:

In the Configuration parameters dialog box, on the **Code Generation > Interface** pane, verify that “Shared code placement” is set to **Shared location**. If **Shared code**
**placement** is set to Auto, the `GenerateSharedConstants` setting is ignored. If you try to set the parameter value, an error message appears. The default value of `GenerateSharedConstants` is on.

In the Command Window, set `GenerateSharedConstants` to on:

```matlab
>> set_param('rtwdemo_throttlecntrl','GenerateSharedConstants','on')
```

You see the shared constant definitions in the folder `slprj/grt/_sharedutils`, in the file `const_params.c`:

```c
extern const real_T rtCP_pooled_H4eTKtECwweN[9];
const real_T rtCP_pooled_H4eTKtECwweN[9] = { 1.0, 0.75, 0.6, 0.0, 0.0, 0.0, 0.6, 0.75, 1.0 };

extern const real_T rtCP_pooled_SghuHxKVKGHD[9];
const real_T rtCP_pooled_SghuHxKVKGHD[9] = { -1.0, -0.5, -0.25, -0.05, 0.0, 0.05, 0.25, 0.5, 1.0 };

extern const real_T rtCP_pooled_WqWb2t17NA2R[7];
const real_T rtCP_pooled_WqWb2t17NA2R[7] = { -1.0, -0.25, -0.01, 0.0, 0.01, 0.25, 1.0 };

extern const real_T rtCP_pooled_Ygnal0wM3c14[7];
const real_T rtCP_pooled_Ygnal0wM3c14[7] = { 1.0, 0.25, 0.0, 0.0, 0.0, 0.25, 1.0 };
```

In the Command Window, set `GenerateSharedConstants` to off:

```matlab
>> set_param('rtwdemo_throttlecntrl','GenerateSharedConstants','off')
```

You can see the unshared constants in the folder `rtwdemo_throttlecntrl_grt_rtw`, in the file `rtwdemo_throttlecntrl_data.c`:

```c
/* Constant parameters (auto storage) */
const ConstP_rtwdemo_throttlecntrl_T rtwdemo_throttlecntrl_ConstP = {
    /* Pooled Parameter (Expression: P_OutMap)
    * Referenced by:
    *   '<S2>/Proportional Gain Shape'
    *   '<S3>/Proportional Gain Shape'
    */
    { 1.0, 0.25, 0.0, 0.0, 0.0, 0.25, 1.0 },

    /* Pooled Parameter (Expression: P_InErrMap)
    * Referenced by:
    *   '<S2>/Proportional Gain Shape'
    *   '<S3>/Proportional Gain Shape'
    */
    { -1.0, -0.25, -0.01, 0.0, 0.01, 0.25, 1.0 },

    /* Pooled Parameter (Expression: I_OutMap)
    * Referenced by:
```
* 'S2>/Integral Gain Shape'
* 'S3>/Integral Gain Shape'
*/
{ 1.0, 0.75, 0.6, 0.0, 0.0, 0.6, 0.75, 1.0 },

/* Pooled Parameter (Expression: I_InErrMap)
* Referenced by:
* 'S2>/Integral Gain Shape'
* 'S3>/Integral Gain Shape'
*/
{ -1.0, -0.5, -0.25, -0.05, 0.0, 0.05, 0.25, 0.5, 1.0 }
};

**Shared constant Parameters Limitations**

No shared constants or shared functions are generated for a model when:

- The model has a code replacement library (CRL) that is specified for data alignment.
- The model is specified to replace data type names in the generated code.
- The Memory Section for constants is MemVolatile or MemConstVolatile.
- The parameter GenerateSharedConstants is set to off.

Individual constants are not shared, if:

- A constant is referenced by a non-inlined S-function.
- A constant has a user-defined type where Data Scope is not set to Exported.

**See Also**

**More About**

- “Generate Reentrant Code from Subsystems” (Embedded Coder)
- “Generate Reusable Code from Library Subsystems Shared Across Models” on page 9-55
Configure Model Parameters for Simulink Coder
Configure Run-Time Environment Options

When you use Simulink software to create and execute a model and use the code generator to produce C or C++ code, consider your configuration for up to three run-time environments:

- The MATLAB development computer run-time environment that runs MathWorks software during application development.
- The production hardware run-time environment in which you deploy an application when it is put into production.
- The test hardware run-time environment in which you test an application under development before deployment.

One run-time environment can serve in multiple capacities, but the run-time environments remain conceptually distinct. Often, the MATLAB development computer is the test hardware. Typically, the production hardware is different from, and less powerful than, the MATLAB development or the test hardware. Many types of production hardware can do little more than run a downloaded executable file.

Provide information about the production hardware board and the compiler that you use with it when:

- You use Simulink software to simulate a model for which you later generate code
- You use the code generator to produce code for deployment on production hardware

The software uses the board and compiler information to get bit-true agreement for the results of integer and fixed-point operations performed in simulation and in code generated for the production hardware. The code generator uses the information to create code that executes with maximum efficiency.

When you generate code for testing on test hardware, provide information about the test hardware board and the compiler that you use. The code generator uses this information to create code that provides bit-true agreement between results from:

- Integer and fixed-point operations performed in simulation
- Generated code run on the production hardware
- Generated code run on the test hardware
You can achieve bit-true agreement for results even if the production and test hardware are different. Where the C standard does not completely define behavior, the compilers for the two types of hardware can use different defaults.

**Configure Production and Test Hardware**

You can specify model simulation or code generation for a specific hardware board and its device type. For example, you can set the data size, byte ordering, and compiler behavior, such as integer rounding. You can configure:

- The production hardware and the compiler that you use with it. This information affects simulation and code generation. See “Example Production Hardware Setting That Affects Normal Mode Simulation” on page 10-14.
- The test hardware and the compiler that you use with it. This information affects only code generation.

Configure production hardware by selecting **Configuration Parameters > Hardware Implementation**. By default, the Hardware Implementation pane lists **Hardware board**, **Device vendor**, and **Device type** parameter fields only. Unless you have installed hardware support packages, **Hardware board** lists values None or Determine by Code Generation system target file, and Get Hardware Support Packages. After installing a hardware support package, the list also includes the corresponding hardware board name. If you select a hardware board name, parameters for that board appear. To set device details, such as data size and byte ordering, click **Device details**.

Configure test hardware on the **Configuration Parameters > Hardware Implementation > Advanced parameters** pane. To enable parameters for configuring test hardware details, disable the **Configuration Parameters > Hardware Implementation > Advanced parameters > Test hardware is the same as production hardware** parameter. Code generated for test hardware executes in the environment specified by the test hardware parameters. The code behaves as if it were executing in the environment specified for the production hardware. For more information, see “Test Hardware Considerations” on page 10-14.

Default values and properties appear as initial values in the **Hardware Implementation** pane when:

- You specify a **System target file** in the **Code Generation** pane.
- The system target file specifies a default microprocessor and its hardware properties.
You cannot change parameters that have only one possible value. Parameters that have more than one possible value provide a list of valid values. If you specify hardware properties manually in **Hardware Implementation** pane, verify that these values are consistent with the system target file. Otherwise, the generated code can fail to compile or execute, or can execute but produce incorrect results.

Hardware implementation parameters describe hardware and compiler properties to MATLAB software. The code generator uses the information to produce code for the runtime environment that runs as efficiently as possible. The generated code gives bit-true agreement for the results of integer and fixed-point operations in simulation, production code, and test code.

For details about specific parameters, see “Hardware Implementation Pane” (Simulink). To see an example of **Hardware Implementation** pane capabilities, see the `rtwdemo_targetsettings` example model. For details related to configuring a hardware implementation, see:

- “Specify Hardware Board” on page 10-4
- “Specify Device Vendor” on page 10-5
- “Specify the Device Type” on page 10-5
- “Register More Device Vendor and Device Type Values” on page 10-6
- “Set Bit Lengths for Device Data Types” on page 10-9
- “Set Byte Ordering for Device” on page 10-10
- “Set Quotient Rounding Behavior for Signed Integer Division” on page 10-10
- “Set Arithmetic Right Shift Behavior for Signed Integers” on page 10-11
- “Update Release 14 Hardware Configuration” on page 10-12

**Specify Hardware Board**

Specify the hardware board that runs the code generated from your model. Select a value for **Configuration Parameters > Hardware Implementation > Hardware board**.

The Hardware Implementation pane identifies the system target file selected on **Configuration Parameters > Code Generation**.

To configure test hardware, use the **Configuration Parameters > Hardware Implementation > Advanced parameters** pane.

To enable parameters for configuring test hardware details, set `ProdEqTarget` to `off`. 
Ways to Specify the Hardware Board

<table>
<thead>
<tr>
<th>If</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>The menu includes the name of the hardware board that you want to use.</td>
<td>The name of that hardware board. If you select a hardware board name, parameters for that board appear.</td>
</tr>
<tr>
<td>The menu does not include the name of the hardware board that you want to use.</td>
<td>Get Hardware Support Packages. That value opens the Support Package Installer. Install the support package that you want. After you install the support package, the menu includes relevant hardware board names.</td>
</tr>
<tr>
<td>The model configuration uses system target file ert.tlc, realtime.tlc, or autosar.tlc.</td>
<td>None. No hardware board is specified for the hardware implementation.</td>
</tr>
<tr>
<td>The model configuration does not use system target file ert.tlc, realtime.tlc, or autosar.tlc.</td>
<td>Determine by Code Generation system target file. The code generator uses the specified system target file to determine the hardware implementation.</td>
</tr>
</tbody>
</table>

Specify Device Vendor

To specify the vendor of the microprocessor of the hardware device, use the **Device vendor** parameter. Your selection determines the available microprocessors in the **Device type** menu. If the vendor name does not appear, select **Custom Processor**. Then, use the **Device type** parameter to specify the microprocessor.

- For complete lists of **Device vendor** and **Device type** values, see “Device vendor” (Simulink) and “Device type” (Simulink).
- To add **Device vendor** and **Device type** values to the default set that is displayed on the **Hardware Implementation** pane, see “Register More Device Vendor and Device Type Values” on page 10-6.

Specify the Device Type

To specify the microprocessor name from the supported devices listed for your **Device vendor** selection, use the **Device type** parameter. If the microprocessor does not appear
in the menu, change **Device vendor** to Custom Processor. Then, specify device details for your custom device.

If you select a device type for which the system target file specifies default hardware properties, the properties appear as initial values. You cannot change the value of parameters with only one possible selection. Parameters that have more than one possible value provide a menu. Select values for your hardware.

**Register More Device Vendor and Device Type Values**

To add **Device vendor** and **Device type** values to the default set that is displayed on the **Hardware Implementation** pane, you can use a hardware device registration API provided by the code generator.

To use this API, you create an `sl_customization.m` file, on your MATLAB path, that invokes the `registerTargetInfo` function and fills in a hardware device registry entry with device information. The device information is registered with Simulink software for each subsequent Simulink session. (To register your device information without restarting MATLAB, issue the MATLAB command `sl_refresh_customizations`.)

For example, the following `sl_customization.m` file adds device vendor `MyDevVendor` and device type `MyDevType` to the Simulink device lists.

```matlab
function sl_customization(cm)
    cm.registerTargetInfo(@loc_register_device);
end

function thisDev = loc_register_device
    thisDev = RTW.HWDeviceRegistry;
    thisDev.Vendor = 'MyDevVendor';
    thisDev.Type = 'MyDevType';
    thisDev.Alias = {};
    thisDev.Platform = {'Prod', 'Target'};
    thisDev.setWordSizes([8 16 32 32 32]);
    thisDev.LargestAtomicInteger = 'Char';
    thisDev.LargestAtomicFloat = 'None';
    thisDev.Endianess = 'Unspecified';
    thisDev.IntDivRoundTo = 'Undefined';
    thisDev.ShiftRightIntArith = true;
    thisDev.setEnabled({'IntDivRoundTo'});
end
```

After device registration, you can select the device in the **Hardware Implementation** pane.
To register multiple devices, specify an array of `RTW.HWDeviceRegistry` objects in your `sl_customization.m` file. For example:

```matlab
function sl_customization(cm)
    cm.registerTargetInfo(@loc_register_device);
end

global thisDev

function thisDev = loc_register_device

    thisDev(1) = RTW.HWDeviceRegistry;
    thisDev(1).Vendor = 'MyDevVendor';
    thisDev(1).Type = 'MyDevType1';
    ...

    thisDev(4) = RTW.HWDeviceRegistry;
    thisDev(4).Vendor = 'MyDevVendor';
    thisDev(4).Type = 'MyDevType4';
    ...

end

You can specify various `RTW.HWDeviceRegistry` properties in the `registerTargetInfo` function call in your `sl_customization.m` file.
## Properties for `registerTargetInfo` Function Call

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vendor</td>
<td>Character vector specifying the <strong>Device vendor</strong> value for your hardware device.</td>
</tr>
<tr>
<td>Type</td>
<td>Character vector specifying the <strong>Device type</strong> value for your hardware device.</td>
</tr>
<tr>
<td>Alias</td>
<td>Cell array of character vectors specifying aliases or legacy names that can resolve to this device. Specify each alias or legacy name in the format 'Vendor-&gt;Type'.</td>
</tr>
<tr>
<td></td>
<td>Embedded Coder software provides the utility functions <code>RTW.isHWDeviceTypeEq</code> and <code>RTW.resolveHWDeviceType</code>. These functions detect and resolve alias values or legacy values when testing user-specified values for the hardware device type.</td>
</tr>
<tr>
<td>Platform</td>
<td>Cell array of enumerated character vector values specifying whether this device can be listed in the <strong>Production hardware</strong> subpane (<code>{'Prod'}</code>), the <strong>Test hardware</strong> subpane (<code>{'Target'}</code>), or both (<code>{'Prod', 'Target'}</code>).</td>
</tr>
<tr>
<td>setWordSizes</td>
<td>Array of integer sizes to associate with the <strong>Number of bits</strong> parameters <code>char</code>, <code>short</code>, <code>int</code>, <code>long</code>, and <strong>native word size</strong>, respectively.</td>
</tr>
<tr>
<td>LargestAtomicInteger</td>
<td>Character vector specifying an enumerated value for the <strong>Largest atomic size: integer</strong> parameter: 'Char', 'Short','Int', or 'Long'.</td>
</tr>
<tr>
<td>LargestAtomicFloat</td>
<td>Character vector specifying an enumerated value for the <strong>Largest atomic size: floating-point</strong> parameter: 'Float', 'Double', or 'None'.</td>
</tr>
<tr>
<td>Endianess</td>
<td>Character vector specifying an enumerated value for the <strong>Byte ordering</strong> parameter: 'Unspecified','Little' for little Endian, or 'Big' for big Endian.</td>
</tr>
<tr>
<td>IntDivRoundTo</td>
<td>Character vector specifying an enumerated value for the <strong>Signed integer division rounds to</strong> parameter: 'Zero', 'Floor', or 'Undefined'.</td>
</tr>
</tbody>
</table>
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ShiftRightIntArith</td>
<td>Boolean value specifying whether your compiler implements a signed integer right shift as an arithmetic right shift (true) or not (false).</td>
</tr>
<tr>
<td>setEnabled</td>
<td>Cell array of character vectors specifying which device properties you can modify in the Hardware Implementation pane when you select this device type. The property applies for the 'Endianess', 'IntDivRoundTo', and 'ShiftRightIntArith' properties. You can apply this property to individual Number of bits parameters by using the property names 'BitPerChar', 'BitPerShort', 'BitPerInt', 'BitPerLong', and 'NativeWordSize'.</td>
</tr>
</tbody>
</table>

### Set Bit Lengths for Device Data Types

The **Number of bits** parameters describe the native word size of the microprocessor and the bit lengths of **char**, **short**, **int**, and **long** data. For code generation to succeed:

- The bit lengths must be such that **char** <= **short** <= **int** <= **long**.
- Bit lengths must be multiples of 8, with a maximum of 32.
- The bit length for **long** data must not be less than 32.

The *rtwtypes.h* file defines integer type names. The values that you provide must be consistent with the word sizes as defined in the compiler *limits.h* header file. The code generator maps its integer type names to the corresponding Simulink integer type names.

If no ANSI® C type with a matching word size is available, but a larger ANSI C type is available, the code generator uses the larger type for **int8_T**, **uint8_T**, **int16_T**, **uint16_T**, **int32_T**, and **uint32_T**. When the code generator uses a larger type, the resulting logged values (for example, MAT-file logging) can have different data types than logged values for simulation.

An application can use an integer data of length from 1 (unsigned) or 2 (signed) bits up 32 bits. If the integer length matches the length of an available type, the code generator uses that type. If a matching type is not available, the code generator uses the smallest available type that can hold the data, generating code that does not use unnecessary higher-order bits. For example, on hardware that supports 8-bit, 16-bit, and 32-bit
integers, for a signal specified as 24 bits, the code generator implements the data as an int32_T or uint32_T.

Code that uses emulated integer data is not maximally efficient. This code can be useful during application development for emulating integer lengths that are available only on production hardware. Emulation does not affect the results of execution.

During code generation, the software checks the compatibility of model data types with the data types that you specify for production hardware.

- If none of the lengths that you specify for production hardware integers is 32 bits, the software generates an error.
- If the lengths of data types that the model uses are smaller than the available production hardware integer lengths, the software generates a warning.

### Mapping of Integer Types from Code Generator to Simulink

<table>
<thead>
<tr>
<th>Code Generator Integer Type</th>
<th>Simulink Integer Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>boolean_T</td>
<td>boolean</td>
</tr>
<tr>
<td>int8_T</td>
<td>int8</td>
</tr>
<tr>
<td>uint8_T</td>
<td>uint8</td>
</tr>
<tr>
<td>int16_T</td>
<td>int16</td>
</tr>
<tr>
<td>uint16_T</td>
<td>uint16</td>
</tr>
<tr>
<td>int32_T</td>
<td>int32</td>
</tr>
<tr>
<td>uint32_T</td>
<td>uint32</td>
</tr>
</tbody>
</table>

### Set Byte Ordering for Device

The **Byte ordering** parameter specifies whether the hardware uses BigEndian (most significant byte first) or LittleEndian (least significant byte first) byte ordering. If left as Unspecified, the code generator produces code that determines the endianness of the hardware. This setting is the least efficient.

### Set Quotient Rounding Behavior for Signed Integer Division

ANSI C does not completely define the quotient rounding technique for compilers to use when dividing one signed integer by another. So, the behavior is implementation-dependent. If both integers are positive, or both are negative, the quotient must round...
down. If either integer is positive and the other is negative, the quotient can round up or down.

The **Signed integer division rounds to** parameter instructs the code generator about how the compiler rounds the result of signed integer division. Providing this information does not change the operation of the compiler. It only describes that behavior to the code generator, which uses the information to optimize code generated for signed integer division. The parameter values are:

- **Zero** — If the quotient is between two integers, the compiler chooses the integer that is closer to zero as the result.
- **Floor** — If the quotient is between two integers, the compiler chooses the integer that is closer to negative infinity.
- **Undefined** — If Zero or Floor do not describe the compiler behavior or if that behavior is unknown, choose this value.

Avoid selecting Undefined. When the code generator does not know the signed integer division rounding behavior of the compiler, the model build generates extra code.

The compiler quotient rounding behavior varies according to these values.

You can obtain the compiler implementation for signed integer division rounding from the compiler documentation. If documentation is not available, you can determine this behavior by experiment.

**Example Quotient Rounding for Zero, Floor, and Undefined**

<table>
<thead>
<tr>
<th>N</th>
<th>D</th>
<th>Ideal N/D</th>
<th>Zero</th>
<th>Floor</th>
<th>Undefined</th>
</tr>
</thead>
<tbody>
<tr>
<td>33</td>
<td>4</td>
<td>8.25</td>
<td>8</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>-33</td>
<td>4</td>
<td>-8.25</td>
<td>-8</td>
<td>-9</td>
<td>-8 or -9</td>
</tr>
<tr>
<td>33</td>
<td>-4</td>
<td>-8.25</td>
<td>-8</td>
<td>-9</td>
<td>-8 or -9</td>
</tr>
<tr>
<td>-33</td>
<td>-4</td>
<td>8.25</td>
<td>8</td>
<td>8</td>
<td>8 or 9</td>
</tr>
</tbody>
</table>

**Set Arithmetic Right Shift Behavior for Signed Integers**

ANSI C does not define the behavior of right shifts on negative integers for compilers. So, the behavior is implementation-dependent. The **Shift right on a signed integer as arithmetic shift** option instructs the code generator about how the compiler implements right shifts on negative integers. Providing this information does not change the operation
of the compiler. It only describes that behavior to the code generator, which uses the information to optimize the code generated for arithmetic right shifts.

If the C compiler implements a signed integer right shift as an arithmetic right shift, select the option. Otherwise, clear the option. An arithmetic right shift fills bits vacated by the right shift with the value of the most significant bit, which indicates the sign of the number in two's-complement notation. The option is selected by default. If your compiler handles right shifts as arithmetic shifts, this setting is preferred.

- When you select the option, the code generator produces efficient code whenever the Simulink model performs arithmetic shifts on signed integers.
- When the option is cleared, the code generator produces fully portable but less efficient code to implement right arithmetic shifts.

You can obtain the compiler implementation for arithmetic right shifts from the compiler documentation. If documentation is not available, you can determine this behavior by experiment.

**Update Release 14 Hardware Configuration**

If your model was created before Release 14 and you have not updated the model, the **Configure current execution hardware device** parameter (TargetUnknown) value is 'on' by default.

To update your model, clear the box for **Configuration Parameters > Hardware Implementation > Advanced parameters > Test hardware > Configure test hardware**. Or in the Command Window, type:

```matlab
cs = getActiveConfigSet('your_model_name');
set_param(cs,'TargetUnknown','off');
```

This update to your model:

- Enables the **Test Hardware is the same as production hardware** parameter (ProdEqTarget), setting the parameter to 'on'.
- Copies the **Production device vendor and type** parameter (ProdHWDeviceType) value to the **Test device vendor and type** parameter (TargetHWDeviceType).

To complete the update:

1. Clear the box for **Configuration Parameters > Hardware Implementation > Advanced parameters > Test hardware > Test Hardware is the same as...**
production hardware. Apply this step only if your production and test hardware are different.

2 Set the parameters in Configuration Parameters > Hardware implementation > Advanced parameters to match your production and test systems.

3 Save the model.

Production Hardware Considerations

When you configure production hardware, consider these points:

• Production hardware can have word sizes and other hardware characteristics that differ from the MATLAB development computer. You can prototype code on hardware that is different from the production hardware or the MATLAB development computer. When producing code, the code generator accounts for these differences.

• The Simulink product uses some of the information in the production hardware configuration. That information enables simulations without code generation to give the same results as executing generated code. For example, the results can detect error conditions that arise on the production hardware, such as hardware overflow.

• The code generator produces code that provides bit-true agreement with Simulink results for integer and fixed-point operations. Generated code that emulates unavailable data lengths runs less efficiently than without emulation. The emulation does not affect bit-true agreement with Simulink for integer and fixed-point results.

• If you change run-time environments during application development, before generating or regenerating code, reconfigure the hardware implementation parameters for the new run-time environment. When code executes on hardware for which it was not generated, bit-true agreement is not always achieved for results of integer and fixed-point operations in simulation, production code, and test code.

• To compile code generated from the model, use the Integer rounding mode parameter on model blocks to simulate the rounding behavior of the C compiler that you intend. This setting appears on the Signal Attributes pane in the parameter dialog boxes of blocks that can perform signed integer arithmetic, such as the Product and n-D Lookup Table blocks.

• For most blocks, the value of Integer rounding mode completely defines rounding behavior. For blocks that support fixed-point data and the simplest rounding mode, the value of Signed integer division rounds to also affects rounding. For details, see “Precision” (Fixed-Point Designer).

• When models contain Model blocks, configure models that they reference to use identical hardware settings.
Test Hardware Considerations

By default, the test hardware configuration is the same as the configuration for the production hardware. You can use the generated code for testing in an environment that is identical to the production environment.

If the test and production environments differ, you can generate code that runs on test hardware as if it were running on production hardware:

1. To enable test hardware parameters, clear the box for Configuration Parameters > Hardware Implementation > Advanced parameters > Test hardware > Test hardware is the same as production hardware. Or, in the Command Window type:

   ```
   cs = getActiveConfigSet('your_model_name');
   set_param(cs,'ProdEqTarget','off');
   ```

2. Specify device type details through the test hardware (Target*) parameters.

If you select a system target file that specifies a default microprocessor and its hardware properties, these default values and properties appear as initial values.

Parameters with only one possible value cannot be changed. If you modify hardware properties, check that their values are consistent with the system target file. Otherwise, the generated code can fail to compile or execute, or can execute but produce incorrect results.

Example Production Hardware Setting That Affects Normal Mode Simulation

Changing some production hardware settings, for example, ProdLongLongMode and ProdIntDivRoundTo, can affect normal mode simulation results. The following example simulates an adder with four inputs. In the first simulation, ProdLongLongMode is disabled. In the second simulation, ProdLongLongMode is enabled. In the plot of simulation outputs, you observe small differences between output values in the time step range 125–175.

```matlab
model = 'hwSettingEffect';
new_system(model)
open_system(model)

% Create adder
pos = [140 140 200 340];
add_block('simulink/Math Operations/Add', ...
          [model '/sum_int32'], ...
```
pos = [75   155   105   175];
add_block('built-in/Inport',[model '/In1'],'Position',pos)
set_param([model '/In1'], ['OutDataTypeStr', 'int32', 'PortDimensions', '1', 'SampleTime', '1']);
add_line(model, 'In1/1','sum_int32/1')

pos = [75 205 105 225];
add_block('built-in/Inport',[model '/In2'],'Position',pos)
set_param([model '/In2'], ['OutDataTypeStr', 'int32', 'PortDimensions', '1', 'SampleTime', '1']);
add_line(model, 'In2/1','sum_int32/2')

pos = [75 255 105 275];
add_block('built-in/Inport',[model '/In3'],'Position',pos)
set_param([model '/In3'], ['OutDataTypeStr', 'int32', 'PortDimensions', '1', 'SampleTime', '1']);
add_line(model, 'In3/1','sum_int32/3')

pos = [75 305 105 325];
add_block('built-in/Inport',[model '/In4'],'Position',pos)
set_param([model '/In4'], ['OutDataTypeStr', 'int32', 'PortDimensions', '1', 'SampleTime', '1']);
add_line(model, 'In4/1','sum_int32/4')

pos = [275 230 305 250];
add_block('built-in/Outport',[model '/Out1'],'Position',pos)
add_line(model, 'sum_int32/1','Out1/1')

% Specify input data

t = 0:200;
peakValue = 1.5e9;
in1 = peakValue * sin(t*2*pi/100);
in2 = peakValue * cos(t*2*pi/70);
in3 = -peakValue * sin(t*2*pi/40);
in4 = -peakValue * cos(t*2*pi/30);
set = Simulink.SimulationData.Dataset;
set = set.addElement(1, timeseries(int32(in1),t,'Name','sig1'));
set = set.addElement(2, timeseries(int32(in2),t,'Name','sig2'));
set = set.addElement(3, timeseries(int32(in3),t,'Name','sig3'));
set = set.addElement(4, timeseries(int32(in4),t,'Name','sig4'));

set_param(model, 'LoadExternalInput', 'on');
set_param(model, 'ExternalInput', 'set');
set_param(model, 'StopTime', '50');

% Disable production hardware setting and run first simulation
set_param(model, 'ProdLongLongMode', 'off');
[-, - , y1] = sim(model, 200);
% Enable production hardware setting and run second simulation
set_param(model, 'ProdLongLongMode', 'on');
[~, ~, y2] = sim(model, 200);

plot([y1 y2]);
figure(gcf);

The difference in behavior is due to the accumulator data type in the Sum block. The Accumulator data type block parameter is set to Inherit: Inherit via internal rule. For this example, the resulting accumulator data type is 64 bits wide if the use of the C long long data type is enabled. Otherwise, it is 32 bits wide. Depending on the input values for the sum block, the 32-bit accumulator can saturate when the 64-bit accumulator does not. Therefore, normal mode behavior can depend on the ProdLongLongMode setting. In both cases, the normal mode behavior and production hardware behavior matches bitwise.

See Also

More About

- “Hardware Implementation Pane” (Simulink)
- “Device vendor” (Simulink)
- “Device type” (Simulink)
- “Precision” (Fixed-Point Designer)
Model Protection in Simulink Coder

- “Protect Models for Third-Party Use” on page 11-2
- “Harness Model” on page 11-5
- “Protected Model Report” on page 11-6
- “Code Generation Support in Protected Models” on page 11-7
- “Protected Model File” on page 11-10
- “Create a Protected Model” on page 11-12
- “Protected Model Creation Settings” on page 11-17
- “Create a Protected Model with Multiple Targets” on page 11-20
- “Use a Protected Model with Multiple Targets” on page 11-22
- “Test the Protected Model” on page 11-23
- “Save Base Workspace Definitions” on page 11-25
- “Package a Protected Model” on page 11-26
- “Specify Custom Obfuscator for Protected Model” on page 11-27
- “Define Callbacks for Protected Models” on page 11-29
Protect Models for Third-Party Use

Protect a model when you want to share a model with a third party without revealing intellectual property. Protecting a model does not use encryption technology unless you use the optional password protection available for read-only view, simulation, and code generation. If you choose password protection for one of these options, the software protects the supporting files by using AES-256 encryption.

When you create a protected model (Simulink):

- By default, Simulink creates and stores a protected version of the model in the current working folder. The protected model has the same name as the source model, with an `.slxp` extension.
- To share a protected model, share only the protected model file.
- The original Model block does not change. If the Model block parameter `Model name` does not specify an extension, a protected model, `.slxp`, takes precedence over a model file, `.slx`.
- You can optionally create a harness model which includes the protected model. A badge icon appears in the lower-left corner of the protected model block in the harness model. For more information, see “Harness Model” on page 11-5.
- You can optionally include generated code with the protected model so that a third party can generate code for a model that contains the protected model. For more information, see “Code Generation Support in Protected Models” on page 11-7.
- The model protection process does not preserve any callbacks. For more information on creating callbacks for use with a protected model, see “Define Callbacks for Protected Models” on page 11-29.
- If you rename a protected model, or change its suffix, the model is unusable until you restore its original name and suffix. You cannot change a protected model file internally because such changes make the file unusable.

Create a protected model by using one of these options:

- The Model block context menu. For more information, see “Create a Protected Model” on page 11-12.
- The `Simulink.ModelReference.protect` function.
- The Simulink Editor menu bar. To create a protected model from the current model, select `File > Export Model To > Protected Model`. 

Requirements for Protecting a Model

To protect a model, the model must meet all requirements listed in “Model Reference Requirements and Limitations” (Simulink) and these requirements:

- You must have a Simulink Coder license to create a protected model.
- The model must be available on the MATLAB path.
- The model cannot have unsaved changes.
- The model cannot use a noninlined S-function directly or indirectly.
- All protected referenced models must support simulation in Accelerator mode. The protected referenced model creator must select Simulate in the Create Protected Model dialog box or set the 'Mode' to 'Accelerator' or 'CodeGeneration' by using the Simulink.ModelReference.protect function.
- All protected referenced models must use the default 'CodeInterface' setting: 'Model reference'.
- Protected referenced models cannot have password protection on simulation.
- Protected referenced models cannot have callbacks.
- The model cannot support operations that a protected referenced model does not support or supports with password protection. For example, a protected model can support code generation only if all protected referenced models support code generation without password protection.
- When protecting a model for code generation, the model must use a Content type that is compatible with the Content type of each protected referenced model. See “Code Generation Support in Protected Models” on page 11-7.

To use a protected model that requires passwords across platforms, before you create the protected model, set the MATLAB character set encoding to 'US-ASCII'. For more information, see slCharacterEncoding.

See Also

Related Examples

- “Protected Models for Model Reference” (Simulink)
More About

• “Reference Protected Models from Third Parties” (Simulink)
Harness Model

You can create a harness model for the generated protected model. The harness model opens as a new, untitled model that contains only a Model block that references the protected model. This Model block:

- Specifies the Model block parameter, **Model name**, as the name of the protected model.
- Has a badge icon in the lower-left corner.
- Has the same number of input and output ports as the protected model.
- Defines model reference arguments that the protected model uses, but does not provide values.

To create a harness model, see “Create a Protected Model” on page 11-12. You can use a harness model to test your protected model. For more information, see “Test the Protected Model” on page 11-23. You can also copy the Model block in your harness model to another model, where it is an interface to the protected model.
Protected Model Report

You can generate a protected model report when you create the protected model. The report is included as part of the protected model. The report has:

- A **Summary**, including the following tables:
  - **Environment**, providing the Simulink version and platform used to create the protected model.
  - **Supported functionality**, reporting On, Off, or On with password protection for each possible functionality that the protected model supports.
  - **Licenses**, listing licenses required to run the protected model.
- An **Interface Report**, including model interface information such as input and output specifications, exported function information, interface parameters, and data stores.

When you create the protected model from the Simulink Editor, the protected model report is generated. To generate a report when using the `Simulink.ModelReference.protect` function, set the 'Report' option to true.

If you configure your protected model for multiple targets, the **Summary** includes a list of supported targets in the **Supported functionality** table. When you build a model that references a protected model with multiple targets, the protected model code generation report represents the currently configured target.

To view the protected model report, right-click the protected-model badge icon and select **Display Report**. Or, call the `Simulink.ProtectedModel.open` function with the report option.
Code Generation Support in Protected Models

You can create a protected model that supports code generation. When a protected model includes generated code, a third party can generate code for a model that includes the protected model. If you choose to obfuscate the code, the code is obfuscated before compilation. The protected model file contains only headers and binaries. Source code, such as .c and .cpp, is not present in the protected model file, although the headers are documented in the protected model report. For more information, see “Protected Model File” on page 11-10 and “Protected Model Report” on page 11-6.

In the Create Protected Model dialog box, select the Use generated code check box. The Content type determines the appearance of the generated code. If you select Readable source code or Obfuscated source code, the header files match the appearance of the generated code. If you select Binaries, the header files can appear readable or obfuscated based on the 'ObfuscateCode' argument. By default, the header files appear obfuscated.

When you create a protected model that supports code generation:

- Simulink ignores source code comments in the Code Generation > Comments pane. Obfuscation of the generated code removes comments because comments can reveal intellectual property.
- Simulink obfuscates custom code specified in the Code Generation > Custom Code pane, but does not obfuscate identifiers.

For an example on including code generation support, see “Create a Protected Model” on page 11-12.

Protected Model Requirements to Support Code Generation

Contents and configuration of a model can prevent code generation support of the protected model. Interaction between the parent model and the protected referenced model can also prevent code generation.

To create a protected model that supports code generation, your model must meet all requirements as described in “Requirements for Protecting a Model” on page 11-3 and these requirements:

- The protected model must use normal, accelerator, software-in-the-loop (SIL), or processor-in-the-loop (PIL) mode and a single target.
• To avoid an error during code generation of a model that includes a protected model:
  • The protected model name must be unique from other model names in the same model reference hierarchy.
  • The interfaces must match.
  • The parameters must be compatible.
• You must not select the Code Generation > Verification > Measure function execution time check box. If you have this option selected when you protect your model, the software turns off the parameter and displays a warning.
• The protected model Existing shared code (ExistingSharedCode) parameter must not specify a value.
• All protected referenced models must support code generation without password protection.
• The protected model must be compatible with the Content type of each protected referenced model. This table provides compatibility information.

**Code Generation Content Type Compatibility**

<table>
<thead>
<tr>
<th>Protected Parent Model Content Type</th>
<th>Compatible Protected Referenced Model Content Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binaries</td>
<td>• Binaries</td>
</tr>
<tr>
<td></td>
<td>• Obfuscated source code</td>
</tr>
<tr>
<td>Binaries with 'ObfuscateCode' set to 'false'</td>
<td>• Binaries</td>
</tr>
<tr>
<td></td>
<td>• Binaries with 'ObfuscateCode' set to 'false'</td>
</tr>
<tr>
<td></td>
<td>• Obfuscated source code</td>
</tr>
<tr>
<td></td>
<td>• Readable source code</td>
</tr>
<tr>
<td>Obfuscated source code</td>
<td>• Obfuscated source code</td>
</tr>
<tr>
<td>Readable source code</td>
<td>• Obfuscated source code</td>
</tr>
<tr>
<td></td>
<td>• Readable source code</td>
</tr>
</tbody>
</table>

When the **Content type** of the protected parent model and protected referenced models do not match, code generation applies the more secure **Content type**. For example, a protected parent model set for Binaries generates Binaries for protected referenced models that are set to Obfuscated source code. A protected
parent model set for Readable source code generates Obfuscated source code for protected referenced models that are set to Obfuscated source code.
Protected Model File

A protected model file (.slx) consists of the model itself and supporting files, depending on the options that you selected when you created the protected model.

If you created a protected model for simulation only and the referencing model is in Normal mode, after simulation, the model.mexext file is placed in the build folder.

If you created a protected model for simulation only and the referencing model is in Accelerator or Rapid Accelerator mode, after simulation, the following files are unpacked:

- slprj/sim/model/**.h
- slprj/sim/model/modellib.a (or modellib.lib)
- slprj/sim/model/tmwinternal/*
- slprj/sim/_sharedutils/*

For the protected model report, these additional files are unpacked (but not in the build folder):

- slprj/sim/model/html/*
- slprj/sim/model/buildinfo.mat

If you included code generation support when you created the protected model, after building your model the following files are unpacked (in addition to the preceding files):

- slprj/sim/model/**.h
- slprj/sim/model/modellib.a (or modellib.lib)
- slprj/sim/model/tmwinternal/*
- slprj/sim/_sharedutils/*
- slprj/target/model/**.h
- slprj/target/model/model_rtwlib.a (or model_rtwlib.lib)
- slprj/target/model/buildinfo.mat
- slprj/target/model/codeinfo.mat
- slprj/target/_sharedutils/*
- slprj/target/model/tmwinternal/*
With an Embedded Coder license, you can specify a Top model code interface. In this case, if you opted to include code generation support when you created the protected model, after building your model the following files are unpacked:

- `slprj/sim/model/*.h`
- `slprj/sim/model/modellib.a` (or `modellib.lib`)
- `slprj/sim/model/tmwinternal/*`
- `slprj/sim/_sharedutils/*`
- `model_target_rtw/*.h`
- `model_target_rtw/*.objExt`
- `model_target_rtw/buildinfo.mat`
- `model_target_rtw/codeinfo.mat`
- `slprj/target/_sharedutils/*`
- `slprj/target/model/tmwinternal/*`

For the protected model report, after building your model these files are unpacked (in addition to the preceding files):

- `slprj/target/model/html/*`
- `slprj/target/model/buildinfo.mat`
- `slprj/target/_sharedutils/html/*`

**Note** The `slprj/sim/model/*` files are deleted after they are used.
Create a Protected Model

This example shows how to create a protected model for read-only viewing, simulation, or code generation.

1. Open your model. For this example, sldemo_mdlref_basic is used as a demonstration.

2. In the Simulink Editor, right-click the model block that references the model for which you want to generate protected model code. In this example, right-click CounterA.

3. From the context menu, select Block Parameters (ModelReference).

4. In the Block Parameters dialog box, in the Model name field, specify the extension for the model, .slx. When both the model and the protected model exist in the same folder, .slxp takes precedence over .slx. In the Model name field, if you do not specify an extension, then the original model block in the model becomes protected.

5. Click OK.

6. Right-click the model block. From the context menu, select Subsystem & Model Reference > Create Protected Model for Selected Model Block.
7 In the Create Protected Model dialog box, select the **Simulate** and **Use generated code** check boxes. If you want to password-protect the functionality of the protected model, enter a password with a minimum of four characters. Each functionality can have a unique password.

8 If you have an Embedded Coder license and specify an ERT-based system target file (for example, `ert.tlc`) for the model, the **Code interface** field is visible. From the **Code interface** drop-down list, select one of the following options:

- **Model reference** — Specifies code access through the model reference code interface, which allows use of the protected model within a model reference hierarchy. Users of the protected model can generate code from a parent model that contains the protected model. In addition, users can run Model block SIL/PIL simulations with the protected model.

- **Top model** — Specifies code access through the standalone interface. Users of the protected model can run Model block SIL/PIL simulations with the protected model.
Note In this example, sldemo_mdllref_basic does not specify an ERT-based system target file, therefore the Code interface options are not available on the Create Protected Model dialog box.

9 From the Content type list, select Obfuscated source code to conceal the source code purpose and logic of the protected model.

10 In the Create protected model in field, specify the folder path for the protected model. The default value is the current working folder.

11 To create a harness model for the protected model, select the Create harness model for protected model check box.

12 Click Create. An untitled harness model opens. It contains a model block, which refers to the protected model sldemo_mdllref_counter.slxp. The Simulation mode for the Model block is set to Accelerator. You cannot change the mode.

13 To view the protected model report, right-click the protected-model badge icon on the CounterA block and select Display Report.
See Also

Related Examples

• “Test the Protected Model” on page 11-23
• “Package a Protected Model” on page 11-26
• “Configure and Run SIL Simulation“ (Embedded Coder)
• “Protected Models for Model Reference” (Simulink)

More About

• “Code Generation Support in Protected Models” on page 11-7
• “Protected Model Creation Settings” on page 11-17
• “Code Interfaces for SIL and PIL” (Embedded Coder)
• “Reference Protected Models from Third Parties” (Simulink)
Protected Model Creation Settings

When you create a protected model, in the Create Protected Model dialog box, you can select which settings you want configured. The settings provide certain functionality permissions when using a protected model. The functionality choices are:

- Read-only viewing
- Simulation
- Code Generation

Password-protection is optional. You must have a minimum of four characters.
Open Read-Only View of Model

If you want to share a view-only version of your model, this option allows someone using the protected model to open a Web view of the model. The contents and block parameters are viewable in the model Web view.

Simulate

The **Simulate** check box allows someone to simulate a protected model. When you select this check box, the Web view is not inherited. To enable the Web view with simulation functionality, select the **Open Read-Only View of Model** check box. The **Simulate** functionality:

- Enables protected model Simulation Report.
- Sets Mode to Accelerator. You can run Normal Mode and Accelerator simulations.
- Displays only binaries and headers.
- Enables code obfuscation.

Use Generated Code

The **Use generated code** check box allows simulation and code generation for a protected model. To generate code, the **Simulate** check box must also be selected. This functionality:

- Sets Mode to enable code generation.
- Enables support for simulation.
- Supports the Model block if you have an Embedded Coder license and specify an ERT system target file (ert.tlc) for the model. From the **Code interface** drop-down list, select one of the following options:
  - **Model reference** — Specifies the model reference code interface, which allows use of the protected model within a model reference hierarchy. Users of the protected model can generate code from a parent model that contains the protected model. In addition, users can run Model block SIL/PIL simulations with the protected model.
• **Top model** — Specifies code access through the standalone interface. Users of the protected model can run Model block SIL/PIL simulations with the protected model.

• Determines the appearance of the generated code by the **Content type** list. The options are:
  
  • **Binaries**
  
  • **Obfuscated source code** (default)
  
  • **Readable source code**, which also includes readable code comments
Create a Protected Model with Multiple Targets

You can create a protected model that supports multiple code generation targets. This example shows how to use command-line functions to create a protected model that supports code generation for GRT and ERT targets.

1. Load a model and save a local copy. This model is configured for a GRT target.

```matlab
sldemo_mdlref_counter
save_system('sldemo_mdlref_counter','mdlref_counter.slx');
```

2. Add a required password for modifying a protected model. If you do not add a password, you are prompted to set a password when you create a modifiable, protected model.

```matlab
Simulink.ModelReference.ProtectedModel.setPasswordForModify(...
    'mdlref_counter','password');
```

3. Create a modifiable, protected model with support for code generation.

```matlab
Simulink.ModelReference.protect('mdlref_counter','Mode', ...
    'CodeGeneration', 'Modifiable',true, 'Report',true);
```

4. Get a list of targets that the protected model supports.

```matlab
st = Simulink.ProtectedModel.getSupportedTargets('mdlref_counter')
```

```matlab
st =
    'grt'    'sim'
```

5. Configure the unprotected model to support an ERT target.

```matlab
set_param('mdlref_counter', 'SystemTargetFile', 'ert.tlc');
save_system('mdlref_counter');
```

6. Add support to the protected model for the ERT target. You are prompted for the modification password.

```matlab
Simulink.ProtectedModel.addTarget('mdlref_counter');
```

7. Verify that the list of supported targets now includes the ERT target.

```matlab
st = Simulink.ProtectedModel.getSupportedTargets('mdlref_counter')
```
st =

'ert'    'grt'    'sim'
Use a Protected Model with Multiple Targets

When using a protected model with multiple targets, prepare your model for code generation.

1. Get a list of the targets that the protected model supports using the Simulink.ProtectedModel.getSupportedTargets function.

   You can also get this information from the protected model report. To view the report, on the protected model block, right-click the badge icon. Select Display Report. The Summary lists the supported targets.

2. Get the configuration set for your chosen target using the Simulink.ProtectedModel.getConfigSet function. You can use the configuration set to verify that the protected model interface is compatible with the parent model.

3. Generate code. The build process selects the corresponding target.
Test the Protected Model

To test a protected model that you created, you use the generated harness model and the procedure described in “Protected Model Simulation Requirements” (Simulink).

You can also compare the output of the protected model to the output of the original model. Because you are the supplier, both the original and the protected model might exist on the MATLAB path. In the original model, if the Model block Model name parameter names the model without providing a suffix, the protected model takes precedence over the unprotected model. To override this default when testing the output, in the Model block Model name parameter, specify the file name with the extension of the unprotected model, .slx.

To compare the unprotected and protected versions of a Model block, use the Simulation Data Inspector. This example uses sldemo_mdlref_basic and the protected model, sldemo_mdlref_counter.slxp, which is created in “Create a Protected Model” on page 11-12.

1 If it is not already open, open sldemo_mdlref_basic.

2 Enable logging for the output signal of the Model block, CounterA. In the Configuration Parameters dialog box, in the Data Import/Export pane, select the Signal logging parameter. Click Apply and OK.

3 Right-click the output signal. From the context menu, select Properties. In the Signal Properties dialog box, select Log signal data. Click Apply and OK. For more information, see “Export Signal Data Using Signal Logging” (Simulink).

4 Right-click the CounterA block. From the context menu, select Block Parameters (ModelReference). In the Block Parameters dialog box, specify the Model name parameter with the name of the unprotected model and the extension, sldemo_mdlref_counter.slx. Click Apply and OK. Repeat this step for CounterB block and CounterC block.

5 In the Simulink Editor, click the Simulation Data Inspector button arrow and select Send Logged Workspace Data to Data Inspector from the menu.

6 Simulate the model. When the simulation is complete, click the Simulation Data Inspector button to open the Simulation Data Inspector.

7 In the Simulation Data Inspector, rename the run to indicate that it is for the unprotected model.

8 In the Simulink Editor, right-click the CounterA block. From the context menu, select Block Parameters (ModelReference). In the Block Parameters dialog
box, specify the **Model name** parameter with the name of the protected model, `sldemo_mdlref_counter.slx`. A badge icon appears on the Model block. Repeat this step for CounterB block and CounterC block.

9  Simulate the model, which now refers to the protected model. When the simulation is complete, a new run appears in the Simulation Data Inspector.

10 In the Simulation Data Inspector, rename the new run to indicate that it is for the protected model.

11 In the Simulation Data Inspector, click the **Compare** tab. From the **Baseline** and **Compare To** lists, select the runs from the unprotected and protected model, respectively. To compare the runs, click **Compare Runs**. For more information about comparing runs, see “Compare Simulation Data” (Simulink).
Save Base Workspace Definitions

Referenced models can use object definitions or tunable parameters that are defined in the MATLAB base workspace. These variables are not saved with the model. When you protect a model, you must obtain the definitions of required base workspace entities and ship them with the model.

The following base workspace variables must be saved to a MAT-file:

- Global tunable parameter
- Global data store
- The following objects used by a signal that connects to a root-level model Inport or Outport:
  - `Simulink.Signal`
  - `Simulink.Bus`
  - `Simulink.Alias`
  - `Simulink.NumericType` that is an alias

For more information, see “Edit and Manage Workspace Variables by Using Model Explorer” (Simulink).

Before executing the protected model as a part of a third-party model, the receiver of the protected model must load the MAT-file.
Package a Protected Model

In addition to the protected model file (.slxp), you can include additional files in the protected model package:

- Harness model file.
- Any required definitions saved in a MAT-file. For more information, see “Save Base Workspace Definitions” on page 11-25.
- Instructions on how to retrieve the files.

Some ways to deliver the protected model package are:

- Provide the .slxp file and other supporting files as separate files.
- Combine the files into a ZIP or other container file.
- Combine the files using a manifest. For more information, see “Export Files in a Manifest” (Simulink).
- Provide the files in some other standard or proprietary format specified by the receiver.

Whichever approach you use to deliver a protected model, include information on how to retrieve the original files. One approach to consider is to use the Simulink Manifest Tools, as described in “Analyze Model Dependencies” (Simulink).
Specify Custom Obfuscator for Protected Model

When creating a protected model, you can specify your own postprocessing function for files that the protected model creation process generates. Before packaging the protected model files, this function is called by the `Simulink.ModelReference.protect` function. You can use this functionality to run your own custom obfuscator on the generated files by following these steps:

1. Create your postprocessing function. Use this function to call your custom obfuscator. The function must be on the MATLAB path and accept a `Simulink.ModelReference.ProtectedModel.HookInfo` object as an input variable.

2. In your function, get the files and exported symbol information that your custom obfuscator requires to process the protected model files. To get the files and information, access the properties of your function input variable. The variable is a `Simulink.ModelReference.ProtectedModel.HookInfo` object with the following properties:
   - `SourceFiles`
   - `NonSourceFiles`
   - `ExportedSymbols`

3. Pass the protected model file information to your custom obfuscator. The following is an example of a postprocessing function for custom obfuscation:

   ```matlab
   function myHook(protectedModelInfo)
       % Get source file list information.
       srcFileList = protectedModelInfo.SourceFiles;
       disp('### Obfuscating...');
       for i=1:length(srcFileList)
           disp(['### Obfuscator: Processing ' srcFileList{i} '...']);
           % call to custom obfuscator
           customObfuscator(srcFileList{i});
       end
   end
   ```

4. Specify your postprocessing function when creating the protected model:

   ```matlab
   Simulink.ModelReference.protect('myModel, ...
   'Mode', ...
   'CodeGeneration', ...
   ```
'CustomPostProcessingHook', ...
@protectedModelInfo.myHook(protectedModelInfo))

The protected model creator can also enable obfuscation of simulation target code and generated code through the 'ObfuscateCode' option of the `Simulink.ModelReference.protect` function. Your custom obfuscator runs only on the generated code and not on the simulation target code. If both obfuscators are in use, the custom obfuscator is the last to run on the generated code before the files are packaged.
Define Callbacks for Protected Models

When you create a protected model, you can customize its behavior by defining callbacks. Callbacks specify code that executes when you view, simulate, or generate code for the protected model. A protected model user cannot view or modify a callback. If a model references a protected model with callbacks, you cannot protect the model.

To create a protected model with callbacks:

1 Define Simulink.ProtectedModel.Callback objects for each callback.
2 To create your protected model, call the Simulink.ModelReference.protect function. Use the 'Callbacks' option to specify a cell array of callbacks to include in the protected model.

Creating Callbacks

To create and define a protected model callback, create a Simulink.ProtectedModel.Callback object. Callback objects specify:

- The code to execute for the callback. The code can be a character vector of MATLAB commands or a script on the MATLAB path.
- The event that triggers the callback. The event can be 'PreAccess' or 'Build'.
- The protected model functionality that the event applies to. The functionality can be 'CODEGEN', 'SIM', 'VIEW', or 'AUTO'. If you select 'AUTO', and the event is 'PreAccess', the callback applies to each functionality. If you select 'AUTO', and the event is 'Build', the callback applies only to 'CODEGEN' functionality. If you do not select any functionality, the default behavior is 'AUTO'.
- The option to override the protected model build process. This option applies only to 'CODEGEN' functionality.

You can create only one callback per event and per functionality.

Defining Callback Code

You can define the code for a callback by using either a character vector of MATLAB commands or a script on the MATLAB path. When you write callback code, follow these guidelines:
• Callbacks must use MATLAB code (.m or .p).
• The code can include protected model functions or any MATLAB command that does not require loading the model.
• Callback code must not call out to external utilities unless those utilities are available in the environment where the protected model is used.
• Callback code cannot reference the source protected model unless you are using protected model functions.

You can use the `Simulink.ProtectedModel.getCallbackInfo` function in callback code to get information on the protected model. The function returns a `Simulink.ProtectedModel.CallbackInfo` object that provides the protected model name and the names of submodels. If the callback is specified for 'CODEGEN' functionality and 'Build' event, the object provides the target identifier and model code interface type ('Top model' or 'Model reference').

**Create a Protected Model with Callbacks**

This example creates a protected model with a callback for code generation.

1. On the MATLAB path, create a callback script, `pm_callback.m`, containing:
   ```matlab
   s1 = 'Code interface is: ';
   cbinfoobj = Simulink.ProtectedModel.getCallbackInfo(...
   'sldemo_mdlref_counter','Build','CODEGEN');
   disp([s1 cbinfoobj.CodeInterface]);
   ```

2. Create a callback that uses the script.
   ```matlab
   pmCallback = Simulink.ProtectedModel.Callback('Build',...
   'CODEGEN', 'pm_callback.m');
   ```

3. Create the protected model and specify the code generation callback.
   ```matlab
   Simulink.ModelReference.protect('sldemo_mdlref_counter',...
   'Mode', 'CodeGeneration','Callbacks',{pmCallback})
   ```

4. Build the protected model. Before the build, the callback displays the code interface.
   ```matlab
   rtwbuild('sldemo_mdlref_basic')
   ```
See Also
Simulink.ModelReference.protect | Simulink.ProtectedModel.Callback |
Simulink.ProtectedModel.getCallbackInfo

More About
• “Protect Models for Third-Party Use” on page 11-2
• “Code Generation Support in Protected Models” on page 11-7
Component Initialization, Reset, and Termination in Simulink Coder
Generate Code That Responds to Initialize, Reset, and Terminate Events

To generate code from a modeling component that responds to initialize, reset, and terminate events during execution, use the blocks Initialize Function and Terminate Function. For information on how to use these blocks, see “Customize Initialize, Reset, and Terminate Functions” (Simulink). You can use the blocks anywhere in a model hierarchy.

Examples of when to generate code that responds to initialize, reset, or terminate events include:

- Starting and stopping a component.
- Calculating initial conditions.
- Saving and restoring state from nonvolatile memory.
- Generating reset entry-point functions that respond to external events.

Each nonvirtual subsystem and referenced model can have its own set of initialize, reset, and terminate functions.

The code generator produces initialization and termination code differently than reset code. For initialization and termination code, the code generator includes your component initialization and termination code in the default entry-point functions, `model_initialize` and `model_terminate`. The code generator produces reset code only if you model reset behavior.

Generate Code for Initialize and Terminate Events

When you generate code for a component that includes Initialize Function and Terminate Function blocks, the code generator:

- Includes initialize event code with default initialize code in entry-point function `model_initialize`.
- Includes terminate event code with default terminate code in entry-point function `model_terminate`.

Consider the model `rtwdemo_irt_base`.
For this model, the code generator produces initialize and terminate entry-point functions that other code can interface with.

```c
void rtwdemo_irt_base_initialize(void)
void rtwdemo_irt_base_terminate(void)
```

This code appears in the generated file `rtwdemo_irt_base.c`. The initialize function, `rtwdemo_irt_base_initialize`:

- Initializes an error status.
- Allocates memory for block I/O and state parameters.
- Sets the output value
- Sets the initial condition for the discrete integrator.

The terminate function, `rtwdemo_irt_base_terminate`, requires no code.

This code assumes that support for nonfinite numbers and MAT-file logging is disabled.

```c
void rtwdemo_irt_base_initialize(void)
{
    rtmSetErrorStatus(rtwdemo_irt_base_M, (NULL));

    (void) memset((void *)&rtwdemo_irt_base_DW, 0,
    sizeof(DW_rtwdemo_irt_base_T));

    rtwdemo_irt_base_Y.Out1 = 0.0;

    rtwdemo_irt_base_DW.DiscreteIntegrator_DSTATE = 0.0;
}

void rtwdemo_irt_base_terminate(void)
{
    /* (no terminate code required) */
}
```
Add Initialize Function and Terminate Function blocks to the model (see `rtwdemo_irt_initterm`). The Initialize Function block uses the State Writer block to set the initial condition of a Discrete Integrator block. The Terminate Function block includes a State Reader block, which reads the state of the Discrete Integrator block.

The **Event type** parameter of the Event Listener block for the initialize and terminate functions is set to **Initialize** and **Terminate**, respectively. The initialize function uses the State Writer block to initialize the input value for the Discrete Integrator block to 10. The terminate function uses the State Reader block to read the state of the Discrete Integrator block.
Generate Code That Responds to Initialize, Reset, and Terminate Events

Event Listener

Constant 10 → State Writer

Discrete Integrator

Block Parameters: Event Listener

Event Listener
Specify event type for subsystem.

Event type: Initialize

Enable variant condition

OK Cancel Help Apply
The code generator includes the event code that it produces for the Initialize Function and Terminate Function blocks with standard initialize and terminate code in entry-point functions `rtwdemo_irt_initterm_initialize` and `rtwdemo_irt_initterm_terminate`. This code assumes that support for nonfinite numbers and MAT-file logging is disabled.

```c
void rtwdemo_irt_initterm_initialize(void)
{
    rtmSetErrorStatus(rtwdemo_irt_initterm_M, (NULL));

    (void) memset((void *)&rtwdemo_irt__initterm_DW, 0, sizeof(DW_rtwdemo_irt__initterm_T));

    rtwdemo_irt_initterm_Y.Out1 = 0.0;
}
```
rtwdemo_irt_initterm_DW.DiscreteIntegrator_DSTATE = 10.0;
}

void rtwdemo_irt__initterm_terminate(void)
{
    /* (no terminate code required) */
}

**Generate Code for Reset Events**

Generate code that responds to a reset event by including an Initialize Function or Terminate Function block in a modeling component. Configure the block for a reset by setting the **Event type** parameter of its Event Listener block to **Reset**. Also set the **Event name** parameter. The default name is **reset**.

The code generator produces a reset entry-point function *only* if you model reset behavior. If a component contains multiple reset specifications, the code that the code generator produces depends on whether reset functions share an event name. For a given component hierarchy:

- For reset functions with unique event names, the code generator produces a separate entry-point function for each named event. The name of each function is the name of the corresponding event.
- For reset functions that share an event name, the code generator aggregates the reset code into one entry-point function. The code for the reset functions appears in order, starting with the lowest level (innermost) of the component hierarchy and ending with the root (outermost). The name of the function is **model_reset**. For more information, see “Event Names and Code Aggregation” on page 12-9.

Consider the model **rtwdemo_irt_reset**, which includes a Reset Function block derived from an Initialize Function block.
The Event type and Event name parameters of the Event Listener block are set to Reset and reset, respectively. The function uses the State Writer block to reset the input value for the Discrete Integrator block to 5.
The code generator produces reset function `rtwdemo_irt_reset_reset`.

```c
void rtwdemo_irt_reset_reset(void)
{
    rtwdemo_irt_reset_DW.DiscreteIntegrator_DSTATE = 5.0;
}
```

### Event Names and Code Aggregation

Use the Initialize Function and Terminate Function blocks to define multiple initialize, reset, and terminate functions for a component hierarchy. Define only one initialize function and one terminate function per hierarchy level. You can define multiple reset functions for a hierarchy level. The event names that you configure for the functions at a given level must be unique.
When producing code, the code generator aggregates code for functions that have a given event name across the entire component hierarchy into one entry-point function. The code for reset functions appears in order, starting with the lowest level (innermost) of the component hierarchy and ending with the root (outermost). The code generator uses the event name to name the function.

For example, the model `rtwdemo_irt_shared` includes a subsystem that replicates the initialize, reset, and terminate functions that are in the parent model.

Although the model includes multiple copies of the initialize, reset, and terminate functions, the code generator produces one entry-point function for reset
Generate Code That Responds to Initialize, Reset, and Terminate Events

(rtwdemo_irt_shared_reset), one for initialize (rtwdemo_irt_shared_initialize), and one for terminate (rtwdemo_irt_shared_terminate). Within each entry-point function, after listing code for blocks configured with an initial condition (model_P.block.IC), the code generator orders code for components, starting with the lowest level of the hierarchy and ending with the root.

```c
void rtwdemo_irt_shared_reset(void)
{
    rtwdemo_irt_shared_DW.SubIntegrator2_DSTATE = 5.0;
    rtwdemo_irt_shared_DW.Integrator2_DSTATE = 5.0;
}

void rtwdemo_irt_shared_initialize(void)
{
    rtmSetErrorStatus(rtwdemo_irt_shared_M, (NULL));
    (void) memset(((void *)&rtwdemo_irt_shared_DW), 0, sizeof(DW_rtwdemo_irt_shared_T));
    rtwdemo_irt_shared_Y.Out1 = 0.0;
    rtwdemo_irt_shared_DW.Integrator1_DSTATE = 0.0;
    rtwdemo_irt_shared_DW.SubIntegrator2_DSTATE = 2.0;
    rtwdemo_irt_shared_DW.Integrator2_DSTATE = 10.0;
}

void rtwdemo_irt_shared_terminate(void)
{
    /* (no terminate code required) */
}
If you rename the event configured for the subsystem reset function to reset_02, the code generator produces two reset entry-point functions, rtwdemo_irt_shared_reset and rtwdemo_irt_shared_reset_02.

```c
void rtwdemo_irt_shared_reset(void) {
    rtwdemo_irt_shared_DW.SubIntegrator2_DSTATE = 5.0;
}

void rtwdemo_irt_shared_reset_02(void) {
    rtwdemo_irt_shared_DW.Integrator2_DSTATE = 5.0;
}
```

**Limitation**

You cannot generate code from a harness model—a root model that contains a Model block, which exposes initialize, reset, or terminate function ports.

**See Also**

**Related Examples**

- “Customize Initialize, Reset, and Terminate Functions” (Simulink)
- “Configure Code Generation for Model Entry-Point Functions” on page 16-2
- “Customize Generated C Function Interfaces” (Embedded Coder)
- “Initialization of Signal, State, and Parameter Data in the Generated Code” on page 15-229
Stateflow Blocks in Simulink Coder

- “Code Generation of Stateflow Blocks” on page 13-2
- “Generate Reusable Code for Atomic Subcharts” on page 13-6
- “Generate Reusable Code for Unit Testing” on page 13-8
- “Inline State Functions in Generated Code” on page 13-13
- “Air-Fuel Ratio Control System with Stateflow Charts” on page 13-16
Code Generation of Stateflow Blocks

The code generator produces code for Stateflow blocks for rapid prototyping. If you have an Embedded Coder license, you can generate production code for Stateflow blocks.

Comparison of Code Generation Methods

The following sections compare two ways of generating code.

Code Generation Without Atomic Subcharts

You generate code for the entire model in one file and look through that entire file to find code for a specific part of the chart.
Code Generation With Atomic Subcharts

You specify code generation parameters so that code for an atomic subchart appears in a separate file. This method of code generation enables unit testing for a specific part of a chart. You can avoid searching through unrelated code and focus only on the part that interests you.
void ex_reuse_states_A_during(real_T rtu_u1, real_T *xty_y1, real_T *localDW)
{
    /* During: Chart/A */
    localDW->isStable = TRUE;
    switch (localDW->is_c2_ex_reuse_states) {
        case ex_reuse_states_IN_Neg:
            /* During 'Neg': '<S2>:17' */
            if (rtu_u1 > 0.0) {
                /* Transition: '<S2>:5' */
                localDW->isStable = FALSE;
                localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Pos;
                /* Entry 'Pos': '<S2>:16' */
                (*xty_y1) = 1.0;
            }
            break;
        case ex_reuse_states_IN_Pos:
            /* During 'Pos': '<S2>:16' */
            if (rtu_u1 < 0.0) {
                /* Transition: '<S2>:4' */
                localDW->isStable = FALSE;
                localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Neg;
                /* Entry 'Neg': '<S2>:17' */
                (*xty_y1) = -1.0;
            }
            break;
        default:
            if (rtu_u1 > 0.0) {
                /* Transition: '<S2>:12' */
                localDW->isStable = FALSE;
                localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Pos;
                /* Entry 'Pos': '<S2>:16' */
                (*xty_y1) = 1.0;
            } else {
                /* Transition: '<S2>:19' */
                localDW->isStable = FALSE;
                localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Neg;
                /* Entry 'Neg': '<S2>:17' */
                (*xty_y1) = -1.0;
            } 
            break;
    }
    }
**Note** Unreachable Stateflow states are optimized out and are not included in the generated code.

**See Also**

**Related Examples**

- “Generate Reusable Code for Unit Testing” on page 13-8
- “Generate C or C++ Code from Stateflow Blocks” (Stateflow)
Generate Reusable Code for Atomic Subcharts

In this section...

“How to Generate Reusable Code for Linked Atomic Subcharts” on page 13-6
“How to Generate Reusable Code for Unlinked Atomic Subcharts” on page 13-7

How to Generate Reusable Code for Linked Atomic Subcharts

To specify code generation parameters for linked atomic subcharts from the same library:

1. Open the library model that contains your atomic subchart.
2. Unlock the library.
3. Right-click the library chart and select Block Parameters.
4. In the dialog box, specify the following parameters:
   a. On the Main tab, select Treat as atomic unit.
   b. On the Code Generation tab, set Function packaging to Reusable function.
   c. Set File name options to User specified.
   d. For File name, enter the name of the file with no extension.
   e. Click OK to apply the changes.
5. (OPTIONAL) Customize the generated function names for atomic subcharts:
   a. Open the Model Configuration Parameters dialog box.
   c. Navigate to the Code Generation > Symbols pane.
   d. For Subsystem methods, specify the format of the function names using a combination of the following tokens:
      • $R — root model name
      • $F — type of interface function for the atomic subchart
      • $N — block name
      • $H — subsystem index
      • $M — name-mangling text
e  Click OK to apply the changes.

When you generate code for your model, a separate file stores the code for linked atomic subcharts from the same library.

How to Generate Reusable Code for Unlinked Atomic Subcharts

To specify code generation parameters for an unlinked atomic subchart:

1  In your chart, right-click the atomic subchart and select Properties.
2  In the dialog box, specify the following parameters:
   a  Set Code generation function packaging to Reusable function.
   b  Set Code generation file name options to User specified.
   c  For Code generation file name, enter the name of the file with no extension.
   d  Click OK to apply the changes.
3  (OPTIONAL) Customize the generated function names for atomic subcharts:
   a  Open the Model Configuration Parameters dialog box.
   b  On the Code Generation pane, set System target file to ert.tlc.
   c  Navigate to the Code Generation > Symbols pane.
   d  For Subsystem methods, specify the format of the function names using a combination of the following tokens:
      •  $R — root model name
      •  $F — type of interface function for the atomic subchart
      •  $N — block name
      •  $H — subsystem index
      •  $M — name-mangling text
   e  Click OK to apply the changes.

When you generate code for your model, a separate file stores the code for the atomic subchart. For more information, see “Generate Reusable Code for Unit Testing” on page 13-8.
Generate Reusable Code for Unit Testing

Goal of the Tutorial

Assume that you have the following model, and the chart has two states:

Suppose that you want to generate reusable code so that you can perform unit testing on state A. You can convert that part of the chart to an atomic subchart and then specify a separate file to store the generated code.
Convert a State to an Atomic Subchart

To convert state A to an atomic subchart, right-click the state and select **Group & Subchart > Atomic Subchart**. State A changes to an atomic subchart:

Specify Code Generation Parameters

Set Up a Standalone C File for the Atomic Subchart

1. Open the properties dialog box for A.
2. Set **Code generation function packaging** to Reusable function.
3. Set **Code generation file name options** to User specified.
4. For **Code generation file name**, enter saturator as the name of the file.
5. Click OK.

Set Up the Code Generation Report

1. Open the Model Configuration Parameters dialog box.
In the **Code Generation** pane, set **System target file** to ert.tlc.

3. In the **Code Generation > Report** pane, select **Create code generation report**.

   This step automatically selects **Open report automatically** and **Code-to-model**.

4. Select **Model-to-code**.

5. Click **Apply**.

**Customize the Generated Function Names**

1. In the Model Configuration Parameters dialog box, go to the **Code Generation > Symbols** pane.

2. Set **Subsystem methods** to the format scheme $R$N$M$F, where:
   - $R$ is the root model name.
   - $N$ is the block name.
   - $M$ is the mangle token.
   - $F$ is the type of interface function for the atomic subchart.

   For more information, see “Subsystem methods”.

3. Click **Apply**.

**Generate Code for Only the Atomic Subchart**

To generate code for your model, press **Ctrl+B**. In the code generation report that appears, you see a separate file that contains the generated code for the atomic subchart.

To inspect the code for **saturator.c**, click the hyperlink in the report to see the following code:
void ex_reuse_states_A_during(double rtu ui, double *rtv y1, 
rtwU ex_reuse_states *localDW)
{
    /* During: Chart/A */
    localDW->isStable = IS_TRUE;
    switch (localDW->is_c2_ex_reuse_states) {
    case ex_reuse_states_IN_Neg:
        /* During 'Neg': '<S2>17' */
        if (rtu ui > 0.0) {
            /* Transition: '<S2>17' */
            localDW->isStable = IS_FALSE;
            localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Pos;
            /* Entry 'Pos': '<S2>16' */
            *(rtv y1) = 1.0;
        }
        break;
    case ex_reuse_states_IN_Pos:
        /* During 'Pos': '<S2>16' */
        if (rtu ui < 0.0) {
            /* Transition: '<S2>17' */
            localDW->isStable = IS_FALSE;
            localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Neg;
            /* Entry 'Neg': '<S2>17' */
            *(rtv y1) = -1.0;
        }
        break;
    default:
        if (rtu ui > 0.0) {
            /* Transition: '<S2>17' */
            localDW->isStable = IS_FALSE;
            localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Pos;
            /* Entry 'Pos': '<S2>16' */
            *(rtv y1) = 1.0;
        } else {
            /* Transition: '<S2>17' */
            localDW->isStable = IS_FALSE;
            localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Neg;
            /* Entry 'Neg': '<S2>17' */
            *(rtv y1) = -1.0;
        }
        break;
    }
}
Line 28 shows that the during function generated for the atomic subchart has the name `exReuseStates_A_during`. This name follows the format scheme $R$N$M$F specified for Subsystem methods:

- $R$ is the root model name, `exReuseStates`.
- $N$ is the block name, A.
- $M$ is the mangle token, which is empty.
- $F$ is the type of interface function for the atomic subchart, during.

**Note** The line numbers shown can differ from the numbers that appear in your code generation report.
**Inline State Functions in Generated Code**

**In this section...**

“Inlined Generated Code for State Functions” on page 13-13
“How to Set the State Function Inline Option” on page 13-15
“Best Practices for Controlling State Function Inlining” on page 13-15

**Inlined Generated Code for State Functions**

By default, the code generator uses an internal heuristic to determine whether to inline generated code for state functions. The heuristic takes into consideration an inlining threshold. As code grows and shrinks in size, generated code for state functions can be unpredictable.

If your model includes Stateflow objects and you have rigorous requirements for traceability between generated code and the corresponding state functions, you can override the default behavior. Use the state property `Function Inline Option` to explicitly force or prevent inlining of state functions.

**What Happens When You Force Inlining**

If you force inlining for a state, the code generator inlines code for state actions into the parent function. The parent function contains code for executing the state actions, outer transitions, and flow charts. It does not include code for empty state actions.

**What Happens When You Prevent Inlining**

If you prevent inlining for a state, the code generator produces these static functions for state `foo`.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>enter_atomic_foo</td>
<td>Marks <code>foo</code> active and performs entry actions.</td>
</tr>
<tr>
<td>enter_internal_foo</td>
<td>Calls default paths.</td>
</tr>
<tr>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>inner_default_foo</td>
<td>Executes flow charts that originate when an inner transition and default transition reach the same junction inside a state. The code generator produces this function only when the flow chart is complex enough to exceed the inlining threshold. In generated code, Stateflow software calls this function from both the enter_internal_foo and foo functions.</td>
</tr>
<tr>
<td>foo</td>
<td>Checks for valid outer transitions and if none, performs during actions.</td>
</tr>
<tr>
<td>exit_atomic_foo</td>
<td>Performs exit actions and marks foo inactive.</td>
</tr>
<tr>
<td>exit_internal_foo</td>
<td>Performs exit actions of the child substates and then exits foo.</td>
</tr>
</tbody>
</table>

Suppose the following chart is in model M.

![Stateflow Chart](chart.png)

If you prevent inlining for state A, the code generator produces this code.
static void M_inner_default_A(void);
static void M_exit_atomic_A(void);
static void M_A(void);
static void M_enter_atomic_A(void);
static void M_enter_internal_A(void);

How to Set the State Function Inline Option

To set the function inlining property for a state:

1  Right-click inside the state and, from the context menu, select Properties.

   The State properties dialog box opens.

2  In the Function Inline Option field, select one of these options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inline</td>
<td>Forces inlining of state functions into the parent function, as long as the function is not part of a recursion. See “What Happens When You Force Inlining” on page 13-13.</td>
</tr>
<tr>
<td>Auto</td>
<td>Uses internal heuristics to determine whether or not to inline the state functions.</td>
</tr>
</tbody>
</table>

3  Click Apply.

Best Practices for Controlling State Function Inlining

<table>
<thead>
<tr>
<th>To</th>
<th>Set Function Inline Option Property To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate a separate function for each action of a state and a separate function for each action of its substates</td>
<td>Function for the state and each substate</td>
</tr>
<tr>
<td>Generate a separate function for each action of a state, but include code for the associated action of its substates</td>
<td>Function for the state and Inline for each substate</td>
</tr>
</tbody>
</table>
Air-Fuel Ratio Control System with Stateflow Charts

Generate code for an air-fuel ratio control system designed with Simulink® and Stateflow®.

Figures 1, 2, and 3 show relevant portions of the sldemo_fuelsys model, a closed-loop system containing a plant and controller. The plant validates the controller in simulation early in the design cycle. In this example, you generate code for the relevant controller subsystem, "fuel_rate_control". Figure 1 shows the top-level simulation model.

Open sldemo_fuelsys via rtwdemo_fuelsys and compile the diagram to see the signal data types.

```
rtwdemo_fuelsys
sldemo_fuelsys([],[],[],'compile');
sldemo_fuelsys([],[],[],'term');
```

**Fault-Tolerant Fuel Control System**

Figure 1: Top-level model of the plant and controller
The air-fuel ratio control system is comprised of Simulink® and Stateflow®. The control system is the portion of the model for which you generate code.

```
open_system('sldemo_fuelsys/fuel_rate_control');
```

**Fuel Rate Control Subsystem**

![Diagram of Fuel Rate Control Subsystem](image)

**Figure 2: The air-fuel ratio controller subsystem**

The control logic is a Stateflow® chart that specifies the different modes of operation.

```
open_system('sldemo_fuelsys/fuel_rate_control/control_logic');
```
Close these windows.

close_system('sldemo_fuelsys/fuel_rate_control/airflow_calc');
close_system('sldemo_fuelsys/fuel_rate_control/fuel_calc');
close_system('sldemo_fuelsys/fuel_rate_control/control_logic');
hDemo.rt=sfroot;hDemo.m=hDemo.rt.find('-isa','Simulink.BlockDiagram');
hDemo.c=hDemo.m.find('-isa','Stateflow.Chart','-and','Name','control_logic');
hDemo.c.visible=false;
close_system('sldemo_fuelsys/fuel_rate_control');
Configure and Build the Model with Simulink® Coder™

Simulink® Coder™ generates generic ANSI® C code for Simulink® and Stateflow® models via the Generic Real-Time (GRT) target. You can configure a model for code generation programmatically.

rtwconfiguredemo('sldemo_fuelsys','GRT');

For this example, build only the air-fuel ratio control system. Once the code generation process is complete, an HTML report detailing the generated code is displayed. The main body of the code is located in fuel_rate_control.c.

rtwbuild('sldemo_fuelsys/fuel_rate_control');

### Starting build procedure for model: fuel_rate_control
### Successful completion of build procedure for model: fuel_rate_control

Configure and Build the Model with Embedded Coder®

Embedded Coder® generates production ANSI® C/C++ code via the Embedded Real-Time (ERT) target. You can configure a model for code generation programmatically.

rtwconfiguredemo('sldemo_fuelsys','ERT');

Repeat the build process and inspect the generated code. In the Simulink® Coder™ Report, you can navigate to the relevant code segments interactively by using the Previous and Next buttons. From the chart context menu (right-click the Stateflow® block), select Code Generation > Navigate to Code. Programmatically, use the rtwtrace utility.

rtwbuild('sldemo_fuelsys/fuel_rate_control');
rtwtrace('sldemo_fuelsys/fuel_rate_control/control_logic')

### Starting build procedure for model: fuel_rate_control
### Successful completion of build procedure for model: fuel_rate_control

View the air-fuel ratio control logic in the generated code.

rtwdemodbtype('fuel_rate_control_ert_rtw/fuel_rate_control.c','/* Function for Chart:','case IN_Warmup:',1,0);

/* Function for Chart: '<S1>/control_logic' */
static void Fueling_Mode(const int32_T *sfEvent)
{
    /* This state interprets the other states in the chart to directly control the fueling... */
switch (rtDW.bitsForTID0.is_Fueling_Mode) {
    case IN_Fuel_Disabled:
        rtDW.fuel_mode = DISABLED;
        /* The fuel is completely shut off while in this state. */
        switch (rtDW.bitsForTID0.is_Fuel_Disabled) {
            case IN_Overspeed:
                /* Inport: '<Root>/sensors' */
                /* The speed is dangerously high, so shut off the fuel. */
                if ((rtDW.bitsForTID0.is_Speed == IN_normal) && (rtU.sensors.speed < 603.0F)) {
                    if (rtDW.bitsForTID0.is_Fail != IN_Multi) {
                        rtDW.bitsForTID0.is_Fuel_Disabled = IN_NO_ACTIVE_CHILD;
                        rtDW.bitsForTID0.is_Fueling_Mode = IN_Running;
                        switch (rtDW.bitsForTID0.was_Running) {
                            case IN_Low_Emissions:
                                rtDW.bitsForTID0.is_Running = IN_Low_Emissions;
                                rtDW.bitsForTID0.was_Running = IN_Low_Emissions;
                                rtDW.fuel_mode = LOW;
                                switch (rtDW.bitsForTID0.was_Low_Emissions) {
                                    case IN_Normal:
                                        rtDW.bitsForTID0.is_Low_Emissions = IN_Normal;
                                        rtDW.bitsForTID0.was_Low_Emissions = IN_Normal;
                                        break;
                            }
                        }
                    }
                }
        }
    }
}

Close the model and code generation report.

clear hDemo;
rtwdemoclean;
close_system('sldemo_fuelsys',0);

**Related Examples**

For related fixed-point examples that use sldemo_fuelsys, see

- **Fixed-point design** - “Fixed-Point Fuel Rate Control System” (Fixed-Point Designer)
- **Fixed-point production C/C++ code generation** - “Air-Fuel Ratio Control System with Fixed-Point Data”
Block Authoring and Code Generation for Simulink Coder

- “S-Functions and Code Generation” on page 14-2
- “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7
- “Integrate External C Functions That Pass Input and Output Arguments as Parameters with a Fixed-Point Data Type” on page 14-51
- “Integrate External C Functions That Implement N-Dimensional Table Lookups” on page 14-55
- “Integrate External C++ Object Methods” on page 14-59
- “External Code Integration Examples” on page 14-63
- “Generate S-Function from Subsystem” on page 14-74
- “S-Functions That Support Expression Folding” on page 14-79
- “S-Functions That Specify Port Scope and Reusability” on page 14-91
- “S-Functions That Specify Sample Time Inheritance Rules” on page 14-96
- “S-Functions That Support Code Reuse” on page 14-99
- “S-Functions for Multirate Multitasking Environments” on page 14-100
- “Write Noninlined S-Function” on page 14-107
- “Write Wrapper S-Function and TLC Files” on page 14-110
- “Write Fully Inlined S-Functions” on page 14-119
- “Write Fully Inlined S-Functions with mdlRTW Routine” on page 14-121
You use S-functions to extend Simulink support for simulation and code generation. For example, you can use them to:

- Represent custom algorithms
- Interface existing external code with Simulink and the code generator
- Represent device drivers for interfacing with hardware
- Generate highly optimized code for embedded systems
- Verify code generated for a subsystem as part of a Simulink simulation

The application program interface (API) for writing S-functions allows you to implement generic algorithms in the Simulink environment with a great deal of flexibility. If you intend to use S-functions in a model for code generation, the level of flexibility can vary. For example, it is not possible to access the MATLAB workspace from an S-function that you use with the code generator. This topic explains conditions to be aware of for using S-functions. However, using the techniques presented in this topic, you can create S-functions for most applications that work with the generated code.

Although S-functions provide a generic and flexible solution for implementing complex algorithms in a model, the underlying API incurs overhead in terms of memory and computation resources. Most often the additional resources are acceptable for real-time rapid prototyping systems. Often, though, additional resources are unavailable in real-time embedded applications. You can minimize memory and computational requirements by using the Target Language Compiler technology provided with the code generator to inline your S-functions. If you are producing an S-function for existing external code, consider using the Legacy Code Tool to generate your S-function and relevant TLC file.

This content assumes that you understand the following concepts:

- Level 2 S-functions
- Target Language Compiler (TLC) scripting
• How the code generator produces and builds C/C++ code

Notes  This information is for code generator users. Even if you do not currently use the code generator, follow these practices when writing S-functions, especially if you are creating general-purpose S-functions.

Types of S-Functions

Examples for which you might choose to implement an S-function for simulation and code generation include:

1  “I'm not concerned with efficiency. I want to write one version of my algorithm and have it work in the Simulink and code generator products automatically.”
2  “I want to implement a highly optimized algorithm in the Simulink and code generator products that looks like a built-in block and generates efficient code.”
3  “I have a lot of hand-written code that I need to interface. I want to call my function from the Simulink and code generator products efficiently.”

Respectively, the preceding situations map to the following MathWorks terminology:

1  Noninlined S-function
2  Inlined S-function
3  Auto-generated S-function for external code

Noninlined S-Functions

A noninlined S-function is a C or C++ MEX S-function that is treated identically by the Simulink engine and generated code. In general, you implement your algorithm once according to the S-function API. The Simulink engine and generated code call the S-function routines (for example, mdlOutputs) during model execution.

Additional memory and computation resources are required for each instance of a noninlined S-Function block. However, this routine of incorporating algorithms into models and code generation applications is typical during the prototyping phase of a project where efficiency is not important. The advantage gained by forgoing efficiency is the ability to change model parameters and structures rapidly.

Writing a noninlined S-function does not involve TLC coding. Noninlined S-functions are the default case for the build process in the sense that once you build a MEX S-function in
your model, there is no additional preparation before pressing \texttt{Ctrl+B} to build your model.

Some restrictions exist concerning the names and locations of noninlined S-function files when generating makefiles. See “Write Noninlined S-Function” on page 14-107.

**Inlined S-Functions**

For S-functions to work in the Simulink environment, some overhead code is generated. When the code generator produces code from models that contain S-functions (without \texttt{sfunction.tlc} files), it embeds some of this overhead code in the generated code. If you want to optimize your real-time code and eliminate some of the overhead code, you must \textit{inline} (or embed) your S-functions. This involves writing a TLC (\texttt{sfunction.tlc}) file that eliminates overhead code from the generated code. The Target Language Compiler processes \texttt{sfunction.tlc} files to define how to inline your S-function algorithm in the generated code.

**Note** Do not confuse the term \textit{inline} with the C++ \textit{inline} keyword. Inline means to specify text in place of the call to the general S-function API routines (for example, \texttt{mdlOutputs}). For example, when a TLC file is used to inline an S-function, the generated code contains the C/ C++ code that normally appears within the S-function routines and the S-function itself that has been removed from the build process.

A fully inlined S-function builds your algorithm (block) into generated code in a manner that is indistinguishable from a built-in block. Typically, a fully inlined S-function requires you to implement your algorithm twice: once for the Simulink model (C/C++ MEX S-function) and once for code generation (TLC file). The complexity of the TLC file depends on the complexity of your algorithm and the level of efficiency you try to achieve in the generated code. TLC files vary from simple to complex in structure. See “Inlining S-Functions”

**Auto-generated S-Functions for Legacy or Custom Code**

If you need to invoke hand-written C/C++ code in your model, consider using the Simulink Legacy Code Tool. The Legacy Code Tool can automate the generation of a fully inlined S-function and a corresponding TLC file based on information that you register in a Legacy Code Tool data structure.
For more information, see “Integrate C Functions Using Legacy Code Tool” (Simulink) and see “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7.

**Files Required for Implementing Noninlined and Inlined S-Functions**

This topic briefly describes what files and functions you need to create noninlined and inlined S-functions.

- Noninlined S-functions require the C or C++ MEX S-function source code (*sfunction.c* or *sfunction.cpp*).
- Fully inlined S-functions require an *sfunction.tlc* file. Fully inlined S-functions produce the optimal code for a parameterized S-function. This is an S-function that operates in a specific mode dependent upon fixed S-function parameters that do not change during model execution. For a given operating mode, the *sfunction.tlc* file specifies the exact code that is generated to implement the algorithm for that mode. For example, the direct-index lookup table S-function in “Write Fully Inlined S-Functions with mdlRTW Routine” on page 14-121 contains two operating modes — one for evenly spaced *x*-data and one for unevenly spaced *x*-data.

| Note | Fully inlined S-functions that are generated to invoke legacy or custom C/C++ code also require an *sfunction.tlc* file, which is generated by Legacy Code Tool. |

Fully inlined S-functions might require the placement of the *mdlRTW* routine in your S-function MEX-file *sfunction.c* or *sfunction.cpp*. The *mdlRTW* routine lets you place information in *model.rtw*. *model.rtw* is the record file that specifies a model, and which the code generator invokes the Target Language Compiler to process before executing *sfunction.tlc* when generating code.

Including a *mdlRTW* routine is useful when you want to introduce non-tunable parameters into your TLC file. Such parameters are used to determine which operating mode is active in a given instance of the S-function. Based on this information, the TLC file for the S-function can generate highly efficient, optimal code for that operating mode.
**Guidelines for Writing S-Functions that Support Code Generation**

- You can use C/C++ MEX, MATLAB language, and Fortran MEX S-functions with code generation.
- You can inline S-functions for code generation by providing an inlining TLC file. See S-Function Inlining in “Target Language Compiler”. MATLAB and Fortran MEX S-functions must be inlined. C/C++ MEX S-functions can be inlined for code efficiency, or noninlined.
- To automatically generate a fully inlined C MEX S-function for invoking legacy or custom code, use the Legacy Code Tool. For more information, see “Integrate C Functions Using Legacy Code Tool” (Simulink) and see “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7.
- If code efficiency is not an overriding consideration, for example, if you are rapid prototyping, you can choose not to inline a C/C++ MEX S-function. For more information, see “Write Noninlined S-Function” on page 14-107.

**See Also**

**More About**

- “Import Calls to External Code into Generated Code with Legacy Code Tool” (Embedded Coder)
- “Generate S-Function from Subsystem” (Embedded Coder)
Import Calls to External Code into Generated Code with Legacy Code Tool

In this section...

“Legacy Code Tool and Code Generation” on page 14-7
“Generate Inlined S-Function Files for Code Generation” on page 14-8
“Apply Code Style Settings to Legacy Functions” on page 14-9
“Address Dependencies on Files in Different Locations” on page 14-9
“Deploy S-Functions for Simulation and Code Generation” on page 14-10
“Integrate External C++ Object Methods” on page 14-11
“Integrate External C++ Objects” on page 14-14
“Legacy Code Tool Examples” on page 14-16

Legacy Code Tool and Code Generation

You can use the Simulink Legacy Code Tool to generate fully inlined C MEX S-functions for legacy or custom code. The S-functions are optimized for embedded components, such as device drivers and lookup tables, and they call existing C or C++ functions.

Note The Legacy Code Tool can interface with C++ functions, but not C++ objects. To work around this issue so that the tool can interface with C++ objects, see “Legacy Code Tool Limitations” (Simulink).

You can use the tool to:

- Compile and build the generated S-function for simulation.
- Generate a masked S-Function block that is configured to call the existing external code.

If you want to include these types of S-functions in models for which you intend to generate code, use the tool to generate a TLC block file. The TLC block file specifies how the generated code for a model calls the existing C or C++ function.

If the S-function depends on files in folders other than the folder containing the S-function dynamically loadable executable file, use the tool to generate an
Generate Inlined S-Function Files for Code Generation

Depending on the code generation requirements of your application, to generate code for a model that uses the S-function, do either of the following:

- Generate one .cpp file for the inlined S-function. In the Legacy Code Tool data structure, set the value of the Options.singleCPPMexFile field to true before generating the S-function source file from your existing C function. For example:

  ```
  def.Options.singleCPPMexFile = true;
  legacy_code('sfcn_cmex_generate', def);
  ```

- Generate a source file and a TLC block file for the inlined S-function. For example:

  ```
  def.Options.singleCPPMexFile = false;
  legacy_code('sfcn_cmex_generate', def);
  legacy_code('sfcn_tlc_generate', def);
  ```

singleCPPMexFile Limitations

You cannot set the singleCPPMexFile field to true if

- Options.language='C++'
- You use one of the following Simulink objects with the IsAlias property set to true:
  - Simulink.Bus
  - Simulink.AliasType
  - Simulink.NumericType
- The Legacy Code Tool function specification includes a void* or void** to represent scalar work data for a state argument
- HeaderFiles field of the Legacy Code Tool structure specifies multiple header files
Apply Code Style Settings to Legacy Functions

To apply the model configuration parameters for code style to a legacy function:

1. Initialize the Legacy Code Tool data structure. For example:
   ```
   def = legacy_code('initialize');
   ```

2. In the data structure, set the value of the `Options.singleCPPMexFile` field to `true`. For example:
   ```
   def.Options.singleCPPMexFile = true;
   ```

To check the setting, enter:

```
def.Options.singleCPPMexFile
```

**singleCPPMexFile Limitations**

You cannot set the `singleCPPMexFile` field to `true` if

- `Options.language='C++'`
- You use one of the following Simulink objects with the `IsAlias` property set to `true`:
  - `Simulink.Bus`
  - `Simulink.AliasType`
  - `Simulink.NumericType`
- The Legacy Code Tool function specification includes a `void*` or `void**` to represent scalar work data for a state argument
- `HeaderFiles` field of the Legacy Code Tool structure specifies multiple header files

**Address Dependencies on Files in Different Locations**

By default, the Legacy Code Tool assumes that files on which an S-function depends reside in the same folder as the dynamically loadable executable file for the S-function. If your S-function depends on files that reside elsewhere and you are using the template makefile build process, generate an `sFunction_makecfg.m` or `rtwmakecfg.m` file for the S-function. For example, you might generate this file if your Legacy Code Tool data structure defines compilation resources as path names.

To generate the `sFunction_makecfg.m` or `rtwmakecfg.m` file, call the `legacy_code` function with `'sfcn_makecfg_generate'` or `'rtwmakecfg_generate'` as the first
argument, and the name of the Legacy Code Tool data structure as the second argument. For example:

```matlab
legacy_code('sfcn_makecfg_generate', lct_spec);
```

If you use multiple registration files in the same folder and generate an S-function for each file with a single call to `legacy_code`, the call to `legacy_code` that specifies 'sfcn_makecfg_generate' or 'rtwmakecfg_generate' must be common to all registration files. For more information, see “Handling Multiple Registration Files” (Simulink).

For example, if you define `defs` as an array of Legacy Code Tool structures, you call `legacy_code` with 'sfcn_makecfg_generate' once.

```matlab
defs = [defs1(:);defs2(:);defs3(:)];
legacy_code('sfcn_makecfg_generate', defs);
```

For more information, see “Build Support for S-Functions” on page 26-57.

**Deploy S-Functions for Simulation and Code Generation**

You can deploy the S-functions that you generate with the Legacy Code Tool so that other people can use them. To deploy an S-function for simulation and code generation, share the following files:

- Registration file
- Compiled dynamically loadable executable
- TLC block file
- `sFunction_makecfg.m` or `rtwmakecfg.m` file
- Header, source, and include files on which the generated S-function depends

When you use these deployed files:

- Before using the deployed files in a Simulink model, add the folder that contains the S-function files to the MATLAB path.
- If the Legacy Code Tool data structure registers required files as absolute paths and the location of the files changes, regenerate the `sFunction_makecfg.m` or `rtwmakecfg.m` file.
Integrate External C++ Object Methods

Integrate legacy C++ object methods by using the Legacy Code Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C++ MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a block TLC file and optional rtwmakecfg.m file that calls the legacy code during code generation.

Provide the Legacy Function Specification

Functions provided with the Legacy Code Tool take a specific data structure or array of structures as the argument. The data structure is initialized by calling the function legacy_code() using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call legacy_code('help'). The definition of the legacy C++ class in this example is:

class adder {
  private:
    int int_state;
  public:
    adder();
    int add_one(int increment);
    int get_val();
};

The legacy source code is in the files adder_cpp.h and adder_cpp.cpp.

% rtwdemo_sfun_adder_cpp
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_adder_cpp';
def.StartFcnSpec = 'createAdder()';
def.OutputFcnSpec = 'int32 y1 = adderOutput(int32 u1)';
def.TerminateFcnSpec = 'deleteAdder()';
def.HeaderFiles = {'adder_cpp.h'};
def.SourceFiles = {'adder_cpp.cpp'};
def.IncPaths = {'rtwdemo_lct_src'};
def.SrcPaths = {'rtwdemo_lct_src'};
def.Options.language = 'C++';
def.Options.useTlcWithAccel = false;

**Generate an S-Function for Simulation**

To generate a C-MEX S-function according to the description provided by the input argument 'def', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function calls the legacy functions during simulation. The source code for the S-function is in the file rtwdemo_sfun_adder_cpp.cpp.

```plaintext
legacy_code('sfcn_cmex_generate', def);
```

**Compile the Generated S-Function for Simulation**

After you generate the C-MEX S-function source file, to compile the S-function for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

```plaintext
legacy_code('compile', def);
```

### Start Compiling rtwdemo_sfun_adder_cpp

```plaintext
mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\ib632619\23\pad8c268a_afaa_4c4e_9c1c_257c1741819e\adder_cpp.obj')
Building with 'Microsoft Visual C++ 2017'.
MEX completed successfully.
mex('rtwdemo_sfun_adder_cpp.cpp', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\adder_cpp.obj')
Building with 'Microsoft Visual C++ 2017'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_adder_cpp

### Exit

**Generate a TLC Block File for Code Generation**

After you compile the S-function and use it in simulation, you can call the function legacy_code() again. Set the first input to 'sfcn_tlc_generate' to generate a TLC block file that supports code generation through Simulink® Coder™. If the TLC block file is not created and you try to generate code for a model that includes the S-function, code generation fails. The TLC block file for the S-function is: rtwdemo_sfun_adder_cpp.tlc.

```plaintext
legacy_code('sfcn_tlc_generate', def);
```

**Generate an rtwmakecfg.m File for Code Generation**

After you create the TLC block file, you can call the function legacy_code() again. Set the first input to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file that supports code generation.
generation through Simulink® Coder™. If the required source and header files for the S-function are not in the same folder as the S-function, and you want to add these dependencies in the makefile produced during code generation, generate the rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

**Generate a Masked S-Function Block for Calling the Generated S-Function**

After you compile the C-MEX S-function source, you can call the function legacy_code() again. Set the first input to 'slblock_generate' to generate a masked S-function block that is configured to call that S-function. The software places the block in a new model. You can copy the block to an existing model.

% legacy_code('slblock_generate', def);

**Show the Generated Integration with Legacy Code**

The model rtwdemo_lct_cpp shows integration with the legacy code.

open_system('rtwdemo_lct_cpp')
sim('rtwdemo_lct_cpp')
Integrate External C++ Objects

The Legacy Code Tool can interface with C++ functions, but not C++ objects. Using the previous example as a starting point, here is an example of how you can work around this limitation.

- Modify the class definition for `adder` in a new file `adder_cpp.hpp`. Add three new macros that dynamically allocate a new `adder` object, invoke the method `add_one()`, and free the memory allocated. Each macro takes a pointer to an `adder` object. Because each function called by the Legacy Code Tool must have a C-like signature, the pointer is cached and passed as a `void*`. Then you must explicitly cast to `adder*` in the macro. The new class definition for `adder`:

```cpp
#ifndef _ADDER_CPP_
#define _ADDER_CPP_

class adder {
private:
    int int_state;
public:
    adder(): int_state(0) {};

```
int add_one(int increment);
int get_val() {return int_state;};

// Method wrappers implemented as macros
#define createAdder(work1) 
    *(work1) = new adder

#define deleteAdder(work1) 
    delete(static_cast<adder*>(*(work1)))

#define adderOutput(work1, u1) 
    (static_cast<adder*> ((work1)))->add_one(u1)
#endif /* _ADDER_CPP_ */

• Update adder_cpp.cpp. With the class modification, instead of one global instance, each generated S-function manages its own adder object.

#include "adder_cpp.hpp"

int adder::add_one(int increment)
{
    int_state += increment;
    return int_state;
}

• Update rtwdemo_sfun_adder_cpp.cpp with the following changes:
  • StartFcnSpec calls the macro that allocates a new adder object and caches the pointer.
    def.StartFcnSpec = 'createAdder(void **work1)';
  • OutputFcnSpec calls the macro that invokes the method add_one() and provides the S-function specific adder pointer object.
    def.OutputFcnSpec = 'int32 y1 = adderOutput(void *work1, int32 u1)';
  • TerminateFcnSpec calls the macro that frees the memory.
    def.TerminateFcnSpec = 'deleteAdder(void **work1)';
Legacy Code Tool Examples

Integrate External C Functions That Pass Input Arguments By Value Versus Address

This example shows how to use the Legacy Code Tool to integrate legacy C functions that pass their input arguments by value versus address.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function legacy_code() using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call legacy_code('help'). The prototypes of the legacy functions being called in this example are:

• FLT filterV1(const FLT signal, const FLT prevSignal, const FLT gain)
• FLT filterV2(const FLT* signal, const FLT prevSignal, const FLT gain)

FLT is a typedef to float. The legacy source code is in the files your_types.h, myfilter.h, filterV1.c, and filterV2.c.

Note the difference in the OutputFcnSpec defined in the two structures; the first case specifies that the first input argument is passed by value, while the second case specifies pass by pointer.

defs = [];
% rtwdemo_sfun_filterV1
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_filterV1';
def.OutputFcnSpec = 'single y1 = filterV1(single u1, single u2, single p1)';
def.HeaderFiles   = {'myfilter.h'};
def.SourceFiles   = {'filterV1.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

% rtwdemo_sfun_filterV2
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_filterV2';
def.OutputFcnSpec = 'single y1 = filterV2(single u1[1], single u2, single p1)';
def.HeaderFiles   = {'myfilter.h'};
def.SourceFiles   = {'filterV2.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

Generate S-Functions for Simulation

To generate C-MEX S-functions according to the description provided by the input argument 'defs', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-functions call the legacy functions in simulation. The source code for the S-functions is in the files rtwdemo_sfun_filterV1.c and rtwdemo_sfun_filterV2.c.

legacy_code('sfcn_cmex_generate', defs);

Compile the Generated S-Functions for Simulation

After you generate the C-MEX S-function source files, to compile the S-functions for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', defs);

### Start Compiling rtwdemo_sfun_filterV1
mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', ... 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\filterV1.c')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
mex('rtwdemo_sfun_filterV1.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', 'C:\TEMP\Bdoc18b_943130_7372\ib632619\23\tp892111de_0ad1_40b2_a84d_44a9ca3a6bcd\filterV1.obj')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_filterV1
### Exit
### Start Compiling rtwdemo_sfun_filterV2
```
mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\ib632619\23\tpb8405c_eb3b_4f28_af04_26634ba093c2\filterV2.obj')
```
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
```
mex('rtwdemo_sfun_filterV2.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_9430_7372\ib632619\23\tpb8405c_eb3b_4f28_af04_26634ba093c2\filterV2.obj')
```
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_filterV2
### Exit

### Generate TLC Block Files for Code Generation

After you compile the S-functions and use them in simulation, you can call the function `legacy_code()` again with the first input set to 'sfcn_tlc_generate' to generate TLC block files. Block files specify how the generated code for a model calls the legacy code. If you do not generate TLC block files and you try to generate code for a model that includes the S-functions, code generation fails. The TLC block files for the S-functions are `rtwdemo_sfun_filterV1.tlc` and `rtwdemo_sfun_filterV2.tlc`.

```matlab
legacy_code('sfcn_tlc_generate', defs);
```

### Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block files, you can call the function `legacy_code()` again with the first input set to 'rtwmakecfg_generate' to generate an `rtwmakecfg.m` file to support code generation. If the required source and header files for the S-functions are not in the same folder as the S-functions, and you want to add these dependencies in the makefile produced during code generation, generate the `rtwmakecfg.m` file.

```matlab
legacy_code('rtwmakecfg_generate', defs);
```

### Generate Masked S-Function Blocks for Calling the Generated S-Functions

After you compile the C-MEX S-function source, you can call the function `legacy_code()` again with the first input set to 'slblock_generate' to generate masked S-function blocks that call the S-functions. The software places the blocks in a new model. From there you can copy them to an existing model.

```matlab
legacy_code('slblock_generate', defs);
```
Show the Generated Integration with Legacy Code

The model `rtwdemo_lct_filter` shows integration of the model with the legacy code. The subsystem `TestFilter` serves as a harness for the calls to the legacy C functions via the `generate S-functions`, with unit delays serving to store the previous output values.

```matlab
open_system('rtwdemo_lct_filter')
open_system('rtwdemo_lct_filter/TestFilter')
sim('rtwdemo_lct_filter')
```
**Integrate External C Functions That Pass the Output Argument As a Return Argument**

This example shows how to use the Legacy Code Tool to integrate legacy C functions that pass their output as a return argument.

With the Legacy Code Tool, you can:

- Provide the legacy function specification.
- Generate a C-MEX S-function that calls the legacy code during simulation.
- Compile and build the generated S-function for simulation.
- Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code for a model calls the legacy code.
Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function legacy_code() using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call legacy_code('help'). The prototype of the legacy functions being called in this example is:

FLT gainScalar(const FLT in, const FLT gain)

FLT is a typedef to float. The legacy source code is in the files your_types.h, gain.h, and gainScalar.c.

% rtwdemo_sfun_gain_scalar
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_gain_scalar';
def.OutputFcnSpec = 'single y1 = gainScalar(single u1, single p1)';
def.HeaderFiles = {'gain.h'};
def.SourceFiles = {'gainScalar.c'};
def.IncPaths = {'rtwdemo_lct_src'};
def.SrcPaths = {'rtwdemo_lct_src'};

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function calls the legacy functions during simulation. The source code for the S-function is in the file rtwdemo_sfun_gain_scalar.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_gain_scalar
mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7C64IL\Building with 'Microsoft Visual C++ 2017 (C)'.

---

14-21
MEX completed successfully.
   mex('rtwdemo_sfun_gain_scalar.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\ib632619\23\te31ca0aa\ex09148220', 'C:\TEMP\Bdoc18b_943130_7372\ib632619\23\tpc3ba59ba_8028_410b_862a_22a5b1e644c5\gainScalar.obj')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_gain_scalar
### Exit

### Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function `legacy_code()` again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file specifies how the generated code for a model calls the legacy code. If you do not generate a TLC block file and you try to generate code for a model that includes the S-function, code generation fails. The TLC block file for the S-function is: `rtwdemo_sfun_gain_scalar.tlc`.

```
legacy_code('sfcn_tlc_generate', def);
```

### Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function `legacy_code()` again with the first input set to 'rtwmakecfg_generate' to generate an `rtwmakecfg.m` file to support code generation. If the required source and header files for the S-function are not in the same folder as the S-function, and you want to add these dependencies in the makefile produced during code generation, generate the `rtwmakecfg.m` file.

```
legacy_code('rtwmakecfg_generate', def);
```

### Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function `legacy_code()` again with the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-function. The software places the block in a new model. From there you can copy it to an existing model.

```
legacy_code('slblock_generate', def);
```
Show the Generated Integration with Legacy Code

The model rtwdemo_lct_gain shows integration of the model with the legacy code. The subsystem TestGain serves as a harness for the call to the legacy C function via the generate S-function.

```matlab
open_system('rtwdemo_lct_gain')
open_system('rtwdemo_lct_gain/TestGain')
sim('rtwdemo_lct_gain')
```

Integrate External C Functions That Pass Input and Output Arguments as Signals with a Fixed-Point Data Type

This example shows how to use the Legacy Code Tool to integrate legacy C functions that pass their inputs and outputs by using parameters of fixed-point data type.

With the Legacy Code Tool, you can:

- Provide the legacy function specification.
- Generate a C-MEX S-function that calls the legacy code during simulation.
- Compile and build the generated S-function for simulation.
- Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function `legacy_code()` using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call `legacy_code('help')`. The prototype of the legacy functions being called in this example is:

```c
myFixpt timesS16(const myFixpt in1, const myFixpt in2, const uint8_T fracLength)
```
myFixpt is logically a fixed-point data type, which is physically a typedef to a 16-bit integer:

```matlab
myFixpt = Simulink.NumericType;
myFixpt.DataTypeMode = 'Fixed-point: binary point scaling';
myFixpt.Signed = true;
myFixpt.WordLength = 16;
myFixpt.FractionLength = 10;
myFixpt.IsAlias = true;
myFixpt.HeaderFile = 'timesFixpt.h';
```

The legacy source code is in the files timesFixpt.h, and timesS16.c.

```matlab
% rtwdemo_sfun_times_s16
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_times_s16';
def.OutputFcnSpec = 'myFixpt y1 = timesS16(myFixpt u1, myFixpt u2, uint8 p1)';
def.HeaderFiles = {'timesFixpt.h'};
def.SourceFiles = {'timesS16.c'};
def.IncPaths = {'rtwdemo_lct_src'};
def.SrcPaths = {'rtwdemo_lct_src'};
```

**Generate an S-Function for Simulation**

To generate a C-MEX S-function according to the description provided by the input argument `def`, call the function `legacy_code()` again with the first input set to 'sfcn_cmex_generate'. The S-function calls the legacy functions during simulation. The source code for the S-function is in the file rtwdemo_sfun_times_s16.c.

```matlab
legacy_code('sfcn_cmex_generate', def);
```

**Compile the Generated S-Function for Simulation**

After you generate the C-MEX S-function source file, to compile the S-function for simulation with Simulink®, call the function `legacy_code()` again with the first input set to 'compile'.

```matlab
legacy_code('compile', def);
```
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_times_s16
### Exit

### Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function `legacy_code()` again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file specifies how the generated code for a model calls the legacy code. If you do not generate a TLC block file and you try to generate code for a model that includes the S-function, code generation fails. The TLC block file for the S-function is: rtwdemo_sfun_times_s16.tlc.

```matlab
legacy_code('sfcn_tlc_generate', def);
```

### Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function `legacy_code()` again with the first input set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the required source and header files for the S-function are not in the same folder as the S-function, and you want to add these dependencies in the makefile produced during code generation, generate the rtwmakecfg.m file.

```matlab
legacy_code('rtwmakecfg_generate', def);
```

### Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function `legacy_code()` again with the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-function. The software places the block in a new model. From there you can copy it to an existing model.

```matlab
legacy_code('slblock_generate', def);
```
Show the Integration of the Model with Legacy Code

The model rtwdemo_lct_fixpt_signals shows integration of the model with the legacy code. The subsystem TestFixpt serves as a harness for the call to the legacy C function via the generated S-function.

```matlab
open_system('rtwdemo_lct_fixpt_signals')
open_system('rtwdemo_lct_fixpt_signals/TestFixpt')
sim('rtwdemo_lct_fixpt_signals')
```

Integrate External C Functions with Instance-Specific Persistent Memory

Integrate legacy C functions that use instance-specific persistent memory by using the Legacy Code Tool.

With the Legacy Code Tool, you can:

- Provide the legacy function specification.
- Generate a C-MEX S-function that calls the legacy code during simulation.
- Compile and build the generated S-function for simulation.
- Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function legacy_code() using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call legacy_code('help'). The prototypes of the legacy functions being called in this example are:
void memory_bus_init(COUNTERBUS *mem, int32_T upper_sat, int32_T lower_sat);
void memory_bus_step(COUNTERBUS *input, COUNTERBUS *mem, COUNTERBUS *output);

mem is an instance-specific persistent memory for applying a one integration step delay. COUNTERBUS is a struct typedef defined in counterbus.h and implemented with a Simulink.Bus object in the base workspace. The legacy source code is in the files memory_bus.h, and memory_bus.c.

evalin('base','load rtwdemo_lct_data.mat')

% rtwdemo_sfun_work
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_work';
def.InitializeConditionsFcnSpec = ...
    'void memory_bus_init(COUNTERBUS work1[1], int32 p1, int32 p2)';
def.OutputFcnSpec = ...
    'void memory_bus_step(COUNTERBUS u1[1], COUNTERBUS work1[1], COUNTERBUS y1[1])';
def.HeaderFiles   = {'memory_bus.h'};
def.SourceFiles   = {'memory_bus.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function calls the legacy functions during simulation. The source code for the S-function is in the file rtwdemo_sfun_work.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_work
  mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_1_0_0_0\...
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.

```c
mex('rtwdemo_sfun_work.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\ib632619\23\tpc4f651d8_445b_43e3_8c9f_b113161c7379\memory_bus.obj')
```

### Finish Compiling rtwdemo_sfun_work
### Exit

**Generate a TLC Block File for Code Generation**

After you compile the S-function and use it in simulation, you can call the function `legacy_code()` again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file specifies how the generated code for a model calls the legacy code. If you do not generate a TLC block file and you try to generate code for a model that includes the S-function, code generation fails. The TLC block file for the S-function is: rtwdemo_sfun_work.tlc.

```c
legacy_code('sfcn_tlc_generate', def);
```

**Generate an rtwmakecfg.m File for Code Generation**

After you create the TLC block file, you can call the function `legacy_code()` again with the first input set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the required source and header files for the S-function are not in the same folder as the S-function, and you want to add these dependencies in the makefile produced during code generation, generate the rtwmakecfg.m file.

```c
legacy_code('rtwmakecfg_generate', def);
```

**Generate a Masked S-Function Block for Calling the Generated S-Function**

After you compile the C-MEX S-function source, you can call the function `legacy_code()` again with the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-function. The software places the block in a new model. From there you can copy it to an existing model.

```c
legacy_code('slblock_generate', def);
```
**Show the Integration of the Model with Legacy Code**

The model `rtwdemo_lct_work` shows integration of the model with the legacy code. The subsystem `memory_bus` serves as a harness for the call to the legacy C function.

```matlab
open_system('rtwdemo_lct_work')
open_system('rtwdemo_lct_work/memory_bus')
sim('rtwdemo_lct_work')
```

**Integrate External C Functions That Use Structure Arguments**

Integrate legacy C functions with structure arguments that use Simulink® buses with the Legacy Code Tool.

With the Legacy Code Tool, you can:

- Provide the legacy function specification.
- Generate a C-MEX S-function that calls the legacy code during simulation.
- Compile and build the generated S-function for simulation.
- Generate a TLC block file and optional `rtwmakecfg.m` file that specifies how the generated code for a model calls the legacy code.

**Provide the Legacy Function Specification**

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function `legacy_code()` using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call `legacy_code('help')`. The prototype of the legacy functions being called in this example is:

```c
counterbusFcn(COUNTERBUS *u1, int32_T u2, COUNTERBUS *y1, int32_T *y2)
```
COUNTERBUS is a struct typedef defined in counterbus.h and implemented with a Simulink.Bus object in the base workspace. The legacy source code is in the files counterbus.h, and counterbus.c.

```matlab
evalin('base','load rtwdemo_lct_data.mat')
```

```matlab
% rtwdemo_sfun_counterbus
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_counterbus';
def.OutputFcnSpec = ...
    'void counterbusFcn(COUNTERBUS u1[1], int32 u2, COUNTERBUS y1[1], int32 y2[1])';
def.HeaderFiles   = {'counterbus.h'};
def.SourceFiles   = {'counterbus.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
```

### Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function calls the legacy functions during simulation. The source code for the S-function is in the file rtwdemo_sfun_counterbus.c.

```matlab
legacy_code('sfcn_cmex_generate', def);
```

### Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

```matlab
legacy_code('compile', def);
```
Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code() again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file specifies how the generated code for a model calls the legacy code. If you do not generate a TLC block file and you try to generate code for a model that includes the S-function, code generation fails. The TLC block file for the S-function is: rtwdemo_sfun_counterbus.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again with the first input set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the required source and header files for the S-function are not in the same folder as the S-function, and you want to add these dependencies in the makefile produced during code generation, generate the rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again with the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-function. The software places the block in a new model. From there you can copy it to an existing model.

legacy_code('slblock_generate', def);

Show the Integration of the Model with Legacy Code

The model rtwdemo_lct_bus shows integration of the model with the legacy code. The subsystem TestCounter serves as a harness for the call to the legacy C function.

open_system('rtwdemo_lct_bus')
open_system('rtwdemo_lct_bus/TestCounter')
sim('rtwdemo_lct_bus')
Integrate External C Functions That Pass Input and Output Arguments as Signals with Complex Data

Integrate legacy C functions using complex signals with the Legacy Code Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function legacy_code() using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call legacy_code('help'). The prototype of the legacy functions being called in this example is:

```c
void cplx_gain(creal_T *input, creal_T *gain, creal_T *output);
```

creal_T is the complex representation of a double. The legacy source code is in the files cplxgain.h, and cplxgain.c.

```matlab
% rtwdemo_sfun_gain_scalar
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_cplx_gain';
def.OutputFcnSpec = ...
    ['void cplx_gain(complex<double> u1[1], ...']
```
Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function calls the legacy functions during simulation. The source code for the S-function is in the file rtwdemo_sfun_cplx_gain.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code() again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file specifies how the generated code for a model calls the legacy code. If you do not generate a TLC block file and you try to generate code for a model that includes the S-function, code generation fails. The TLC block file for the S-function is: rtwdemo_sfun_cplx_gain.tlc.

legacy_code('sfcn_tlc_generate', def);
Generate an `rtwmakecfg.m` File for Code Generation

After you create the TLC block file, you can call the function `legacy_code()` again with the first input set to 'rtwmakecfg_generate' to generate an `rtwmakecfg.m` file to support code generation. If the required source and header files for the S-function are not in the same folder as the S-function, and you want to add these dependencies in the makefile produced during code generation, generate the `rtwmakecfg.m` file.

```matlab
legacy_code('rtwmakecfg_generate', def);
```

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function `legacy_code()` again with the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-function. The software places the block in a new model. From there you can copy it to an existing model.

```matlab
legacy_code('slblock_generate', def);
```

### Code Snippet

```matlab
>> void cplx_gain(complex<double> u1[1], complex<double> p1[1], complex<double> y1[1])
   rtwdemo_sfun_cplx_gain
```

Show the Integration of the Model with Legacy Code

The model `rtwdemo_lct_cplxgain` shows integration of the model with the legacy code. The subsystem `complex_gain` serves as a harness for the call to the legacy C function via the generate S-function.

```matlab
if isempty(find_system('SearchDepth',0,'Name','rtwdemo_lct_cplxgain'))
   open_system('rtwdemo_lct_cplxgain')
   open_system('rtwdemo_lct_cplxgain/complex_gain')
   sim('rtwdemo_lct_cplxgain')
end
```
Integrate External C Functions That Pass Arguments That Have Inherited Dimensions

This example shows how to use the Legacy Code Tool to integrate legacy C functions whose arguments have inherited dimensions.

With the Legacy Code Tool, you can:

- Provide the legacy function specification.
- Generate a C-MEX S-function that calls the legacy code during simulation.
- Compile and build the generated S-function for simulation.
- Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function legacy_code() using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call legacy_code('help'). The prototypes of the legacy functions being called in this example are:

- void mat_add(real_T *u1, real_T *u2, int32_T nbRows, int32_T nbCols, real_T *y1)
- void mat_mult(real_T *u1, real_T *u2, int32_T nbRows1, int32_T nbCols1, int32_T nbCols2, real_T *y1)

real_T is a typedef to double, and int32_T is a typedef to a 32-bit integer. The legacy source code is in the files mat_ops.h, and mat_ops.c.

```matlab
defs = [];
% rtwdemo_sfun_mat_add
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_mat_add';
```
```plaintext
def.OutputFcnSpec = ['void mat_add(double u1[][], double u2[][], ' ...
          'int32 u3, int32 u4, double y1[size(u1,1)][size(u1,2)])'];
def.HeaderFiles   = {'mat_ops.h'};
def.SourceFiles   = {'mat_ops.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

% rtwdemo_sfun_mat_mult
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_mat_mult';
def.OutputFcnSpec = ['void mat_mult(double u1[p1][p2], double u2[p2][p3], ' ...
          'int32 p1, int32 p2, int32 p3, double y1[p1][p3])'];
def.HeaderFiles   = {'mat_ops.h'};
def.SourceFiles   = {'mat_ops.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

Generate S-Functions for Simulation

To generate C-MEX S-functions according to the description provided by the input argument 'defs', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-functions call the legacy functions during simulation. The source code for the S-function is in the files rtwdemo_sfun_mat_add.c and rtwdemo_sfun_mat_mult.c.

legacy_code('sfcn_cmex_generate', defs);

Compile the Generated S-Functions for Simulation

After you generate the C-MEX S-function source files, to compile the S-functions for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', defs);

### Start Compiling rtwdemo_sfun_mat_add
mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', ... 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\mat_ops.c')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
mex('rtwdemo_sfun_mat_add.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', ... 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\mat_ops.obj')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
```
Generate TLC Block Files for Code Generation

After you compile the S-functions and use them in simulation, you can call the function `legacy_code()` again with the first input set to 'sfcn_tlc_generate' to generate TLC block files. Block files specify how the generated code for a model calls the legacy code. If you do not generate TLC block files and you try to generate code for a model that includes the S-functions, code generation fails. The TLC block files for the S-functions are `rtwdemo_sfun_mat_add.tlc` and `rtwdemo_sfun_mat_mult.tlc`.

`legacy_code('sfcn_tlc_generate', defs);`

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block files, you can call the function `legacy_code()` again with the first input set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the required source and header files for the S-functions are not in the same folder as the S-functions, and you want to add these dependencies in the makefile produced during code generation, generate the rtwmakecfg.m file.

`legacy_code('rtwmakecfg_generate', defs);`

Generate Masked S-Function Blocks for Calling the Generated S-Functions

After you compile the C-MEX S-function source, you can call the function `legacy_code()` again with the first input set to 'slblock_generate' to generate masked S-function blocks that call the S-functions. The software places the blocks in a new model. From there you can copy them to an existing model.

`legacy_code('slblock_generate', defs);`
Show the Generated Integration with Legacy Code

The model rtwdemo_lct_inherit_dims shows integration of the model with the legacy code. The subsystem TestMatOps serves as a harness for the calls to the legacy C functions, with unit delays serving to store the previous output values.

```matlab
open_system('rtwdemo_lct_inherit_dims')
open_system('rtwdemo_lct_inherit_dims/TestMatOps')
sim('rtwdemo_lct_inherit_dims')
```
Integrate External C Functions That Implement Start and Terminate Actions

Integrate legacy C functions that have start and terminate actions by using the Legacy Code Tool.

With the Legacy Code Tool, you can:

- Provide the legacy function specification.
- Generate a C-MEX S-function that calls the legacy code during simulation.
- Compile and build the generated S-function for simulation.
- Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function legacy_code() using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties,
call legacy_code('help'). The prototypes of the legacy functions being called in this example are:

- void initFaultCounter(unsigned int *counter)
- void openLogFile(void **fid)
- void incAndLogFaultCounter(void *fid, unsigned int *counter, double time)
- void closeLogFile(void **fid)

The legacy source code is in the files your_types.h, fault.h, and fault.c.

```c
#define rtwdemo_sfun_fault

def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_fault';
def.InitializeConditionsFcnSpec = 'initFaultCounter(uint32 work2[1])';
def.StartFcnSpec = 'openLogFile(void **work1)';
def.OutputFcnSpec = ...
   'incAndLogFaultCounter(void *work1, uint32 work2[1], double u1)';
def.TerminateFcnSpec = 'closeLogFile(void **work1)';
def.HeaderFiles = {'fault.h'};
def.SourceFiles = {'fault.c'};
def.IncPaths = {'rtwdemo_lct_src'};
def.SrcPaths = {'rtwdemo_lct_src'};
def.Options.useTlcWithAccel = false;

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function calls the legacy functions during simulation. The source code for the S-function is in the file rtwdemo_sfun_fault.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_fault
Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code() again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file specifies how the generated code for a model calls the legacy code. If you do not generate a TLC block file and you try to generate code for a model that includes the S-function, code generation fails. The TLC block file for the S-function is: rtwdemo_sfun_fault.tlc.

legacy_code('sfcn_tlc_generate', def);

Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function legacy_code() again with the first input set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the required source and header files for the S-function are not in the same folder as the S-function, and you want to add these dependencies in the makefile produced during code generation, generate the rtwmakecfg.m file.

legacy_code('rtwmakecfg_generate', def);

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function legacy_code() again with the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-function. The software places the block in a new model. From there you can copy it to an existing model.

legacy_code('slblock_generate', def);
Showing the Generated Integration with Legacy Code

The model `rtwdemo_lct_start_term` shows integration of the model with the legacy code. The subsystem `TestFixpt` serves as a harness for the call to the legacy C function, and the scope compares the output of the function with the output of the built-in Simulink® product block; the results should be identical.

```matlab
open_system('rtwdemo_lct_start_term')
open_system('rtwdemo_lct_start_term/TestFault')
sim('rtwdemo_lct_start_term')
```

Integrate External C Functions That Pass Arguments as Multi-Dimensional Signals

This example shows how to use the Legacy Code Tool to integrate legacy C functions with multi-dimensional Signals.

With the Legacy Code Tool, you can:

- Provide the legacy function specification.
- Generate a C-MEX S-function that calls the legacy code during simulation.
- Compile and build the generated S-function for simulation.
- Generate a TLC block file and optional `rtwmakecfg.m` file that specifies how the generated code for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function `legacy_code()` using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call `legacy_code('help')`. The prototype of the legacy functions being called in this example is:
void array3d_add(real_T *y1, real_T *u1, real_T *u2, int32_T nbRows, int32_T nbCols, int32_T nbPages);

real_T is a typedef to double, and int32_T is a typedef to a 32-bit integer. The legacy source code is in the files ndarray_ops.h, and ndarray_ops.c.

% rtwdemo_sfun_ndarray_add
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_ndarray_add';
def.OutputFcnSpec =
    ['void array3d_add(double y1[size(u1,1)][size(u1,2)][size(u1,3)], ',
    'double u1[][[]][], double u2[][[]][], ',
    'int32 size(u1,1), int32 size(u1,2), int32 size(u1,3))'];
def.HeaderFiles   = {'ndarray_ops.h'};
def.SourceFiles   = {'ndarray_ops.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

y1 is a 3-D output signal of same dimensions as the 3-D input signal u1. Note that the last 3 arguments passed to the legacy function correspond to the number of element in each dimension of the 3-D input signal u1.

**Generate an S-Function for Simulation**

To generate a C-MEX S-function according to the description provided by the input argument 'def', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function calls the legacy functions during simulation. The source code for the S-function is in the file rtwdemo_sfun_ndarray_add.c.

legacy_code('sfcn_cmex_generate', def);

**Compile the Generated S-Function for Simulation**

After you generate the C-MEX S-function source file, to compile the S-function for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_ndarray_add
mex('-IB:\matlab\toolbox\rtw\rtwdeemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_t')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
mex('rtwdemo_sfun_ndarray_add.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\ib632619\23\tp0eccdda8_c673_45e7_9671_7619acdef8b1\ndarray_ops.obj')

Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_ndarray_add
### Exit

**Generate a TLC Block File for Code Generation**

After you compile the S-function and use it in simulation, you can call the function `legacy_code()` again with the first input set to 'sfcn_tlc_generate' to generate a TLC block file. The block file specifies how the generated code for a model calls the legacy code. If you do not generate a TLC block file and you try to generate code for a model that includes the S-function, code generation fails. The TLC block file for the S-function is: `rtwdemo_sfun_ndarray_add.tlc`.

```plaintext
legacy_code('sfcn_tlc_generate', def);
```

**Generate an rtwmakecfg.m File for Code Generation**

After you create the TLC block file, you can call the function `legacy_code()` again with the first input set to 'rtwmakecfg_generate' to generate an `rtwmakecfg.m` file to support code generation. If the required source and header files for the S-function are not in the same folder as the S-function, and you want to add these dependencies in the makefile produced during code generation, generate the `rtwmakecfg.m` file.

```plaintext
legacy_code('rtwmakecfg_generate', def);
```

**Generate a Masked S-Function Block for Calling the Generated S-Function**

After you compile the C-MEX S-function source, you can call the function `legacy_code()` again with the first input set to 'slblock_generate' to generate a masked S-function block that calls that S-function. The software places the block in a new model. From there you can copy it to an existing model.

```plaintext
legacy_code('slblock_generate', def);
```
Showing the Generated Integration with Legacy Code

The model rtwdemo_lct_ndarray shows integration of the model with the legacy code. The subsystem ndarray_add serves as a harness for the call to the legacy C function.

```matlab
open_system('rtwdemo_lct_ndarray')
open_system('rtwdemo_lct_ndarray/ndarray_add')
sim('rtwdemo_lct_ndarray')
```

Integrate External C Functions with a Block Sample Time Specified, Inherited, and Parameterized

This example shows how to use the Legacy Code Tool to integrate legacy C functions with the block's sample time specified, inherited and parameterized.

With the Legacy Code Tool, you can:

- Provide the legacy function specification.
- Generate a C-MEX S-function that calls the legacy code during simulation.
- Compile and build the generated S-function for simulation.
- Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function legacy_code() using 'initialize' as the first input. After initializing the structure, assign its properties to values
corresponding to the legacy code being integrated. For detailed help on the properties, call legacy_code('help'). The prototype of the legacy functions being called in this example is:

```c
FLT gainScalar(const FLT in, const FLT gain)
```

FLT is a typedef to float. The legacy source code is in the files your_types.h, gain.h, and gainScalar.c.

defs = [];

```c
% rtwdemo_sfun_st_inherited
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_st_inherited';
def.OutputFcnSpec = 'single y1 = gainScalar(single u1, single p1)';
def.HeaderFiles   = {'gain.h'};
def.SourceFiles   = {'gainScalar.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];
```

```c
% rtwdemo_sfun_st_fixed
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_st_fixed';
def.OutputFcnSpec = 'single y1 = gainScalar(single u1, single p1)';
def.HeaderFiles   = {'gain.h'};
def.SourceFiles   = {'gainScalar.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
def.SampleTime    = [2 1];
defs = [defs; def];
```

```c
% rtwdemo_sfun_st_parameterized
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_st_parameterized';
def.OutputFcnSpec = 'single y1 = gainScalar(single u1, single p1)';
def.HeaderFiles   = {'gain.h'};
def.SourceFiles   = {'gainScalar.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
def.SampleTime    = 'parameterized';
defs = [defs; def];
```
Generate S-Functions for Simulation

To generate C-MEX S-functions according to the description provided by the input argument 'defs', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-functions call the legacy functions during simulation. The source code for the S-functions is in the files rtwdemo_sfun_st_inherited.c and rtwdemo_sfun_st_fixed.c. rtwdemo_sfun_st_parameterized.c.

legacy_code('sfcn_cmex_generate', defs);

Compile the Generated S-Functions for Simulation

After you generate the C-MEX S-function source files, to compile the S-functions for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', defs);

### Start Compiling rtwdemo_sfun_st_inherited

```matlab
mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\ib632619\23\tp10eb3c86_8590_49af_bb9e_b395268bbdf4\gainScalar.obj')
```
MEX completed successfully.

### Finish Compiling rtwdemo_sfun_st_inherited

### Exit

### Start Compiling rtwdemo_sfun_st_fixed

```matlab
mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\ib632619\23\tp80426d15_64de_4566_abf9_6baadbe275db\gainScalar.obj')
```
MEX completed successfully.

### Finish Compiling rtwdemo_sfun_st_fixed

### Exit

### Start Compiling rtwdemo_sfun_st_parameterized

```matlab
mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\ib632619\23\tp839638be_6d66_41c2_98d2_6890007eed09\gainScalar.obj')
```
MEX completed successfully.

### Exit

14-47
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_st_parameterized
### Exit

**Generate TLC Block Files for Code Generation**

After you compile the S-functions and use them in simulation, you can call the function `legacy_code()` again with the first input set to 'sfcn_tlc_generate' to generate TLC block files. Block files specify how the generated code for a model calls the legacy code. If you do not generate TLC block files and you try to generate code for a model that includes the S-functions, code generation fails. The TLC block files for the S-functions are `rtwdemo_sfun_st_inherited.tlc` and `rtwdemo_sfun_st_fixed.tlc`. `rtwdemo_sfun_st_parameterized.tlc`.

`legacy_code('sfcn_tlc_generate', defs);`

**Generate an rtwmakecfg.m File for Code Generation**

After you create the TLC block files, you can call the function `legacy_code()` again with the first input set to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file to support code generation. If the required source and header files for the S-functions are not in the same folder as the S-functions, and you want to add these dependencies in the makefile produced during code generation, generate the rtwmakecfg.m file.

`legacy_code('rtwmakecfg_generate', defs);`

**Generate Masked S-Function Blocks for Calling the Generated S-Functions**

After you compile the C-MEX S-function source, you can call the function `legacy_code()` again with the first input set to 'slblock_generate' to generate masked S-function blocks that call the S-functions. The software places the blocks in a new model. From there you can copy them to an existing model.

`legacy_code('slblock_generate', defs);`
Show the Generated Integration with Legacy Code

The model `rtwdemo_lct_sampletime` shows integration of the model with the legacy code. The subsystem `sample_time` serves as a harness for the calls to the legacy C functions, with unit delays serving to store the previous output values.

```matlab
open_system('rtwdemo_lct_sampletime')
open_system('rtwdemo_lct_sampletime/sample_time')
sim('rtwdemo_lct_sampletime')
```
See Also
legacy_code

Related Examples
• “Integrate C Functions Using Legacy Code Tool” (Simulink)
• “Call External C Code from Model and Generated Code” (Embedded Coder)
Integrate External C Functions That Pass Input and Output Arguments as Parameters with a Fixed-Point Data Type

Integrate legacy C functions that pass their inputs and outputs by using parameters of a fixed-point data type with the Legacy Code Tool.

With the Legacy Code Tool, you can:

• Provide the legacy function specification.
• Generate a C-MEX S-function that calls the legacy code during simulation.
• Compile and build the generated S-function for simulation.
• Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function legacy_code() using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call legacy_code('help'). The prototype of the legacy functions being called in this example is:

myFixpt timesS16(const myFixpt in1, const myFixpt in2, const uint8_T fracLength)

myFixpt is logically a fixed point data type, which is physically a typedef to a 16-bit integer:

myFixpt = Simulink.NumericType;
myFixpt.DataTypeMode = 'Fixed-point: binary point scaling';
myFixpt.Signed = true;
myFixpt.WordLength = 16;
myFixpt.FractionLength = 10;
myFixpt.IsAlias = true;
myFixpt.HeaderFile = 'timesFixpt.h';

The legacy source code is in the files timesFixpt.h, and timesS16.c.

% rtwdemo_sfun_gain_fixpt
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_gain_fixpt';
def.OutputFcnSpec = 'myFixpt y1 = timesS16(myFixpt u1, myFixpt p1, uint8 p2)';
def.HeaderFiles   = {'timesFixpt.h'};
def.SourceFiles   = {'timesS16.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};

Generate an S-Function for Simulation

To generate a C-MEX S-function according to the description provided by the input argument 'def', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function calls the legacy functions during simulation. The source code for the S-function is in the file rtwdemo_sfun_gain_fixpt.c.

legacy_code('sfcn_cmex_generate', def);

Compile the Generated S-Function for Simulation

After you generate the C-MEX S-function source file, to compile the S-function for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_gain_fixpt
mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', ... 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\timesS16.c')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
mx('rtwdemo_sfun_gain_fixpt.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_gain_fixpt
### Exit

Generate a TLC Block File for Code Generation

After you compile the S-function and use it in simulation, you can call the function legacy_code() again. Set the first input to 'sfcn_tlc_generate' to generate a TLC block file. The block file specifies how the generated code for a model calls the legacy code. If you do not generate a TLC block file and you try to generate code for a model that includes the S-function, code generation fails. The TLC block file for the S-function is: rtwdemo_sfun_gain_fixpt.tlc.

legacy_code('sfcn_tlc_generate', def);
Generate an rtwmakecfg.m File for Code Generation

After you create the TLC block file, you can call the function `legacy_code()` again. Set the first input to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file that supports code generation. If the required source and header files for the S-function are not in the same folder as the S-function, and you want to add these dependencies in the makefile produced during code generation, generate the rtwmakecfg.m file.

```matlab
legacy_code('rtwmakecfg_generate', def);
```

Generate a Masked S-Function Block for Calling the Generated S-Function

After you compile the C-MEX S-function source, you can call the function `legacy_code()` again. Set the first input to 'slblock_generate' to generate a masked S-function block that calls that S-function. The software places the block in a new model. You can copy the block to an existing model.

```matlab
legacy_code('slblock_generate', def);
```

Show the Generated Integration with Legacy Code

The model `rtwdemo_lct_fixpt_params` shows integration of the model with the legacy code. The subsystem TestFixpt serves as a harness for the call to the legacy C function via the generated S-function.

```matlab
open_system('rtwdemo_lct_fixpt_params')
open_system('rtwdemo_lct_fixpt_params/TestFixpt')
sim('rtwdemo_lct_fixpt_params')
```
See Also

legacy_code

Related Examples

- “Integrate C Functions Using Legacy Code Tool” (Simulink)
- “Call External C Code from Model and Generated Code” (Embedded Coder)
Integrate External C Functions That Implement N-Dimensional Table Lookups

Integrate legacy C functions that implement N-dimensional table lookups by using the Legacy Code Tool.

With the Legacy Code Tool, you can:

- Provide the legacy function specification.
- Generate a C-MEX S-function that calls the legacy code during simulation.
- Compile and build the generated S-function for simulation.
- Generate a TLC block file and optional rtwmakecfg.m file that specifies how the generated code for a model calls the legacy code.

Provide the Legacy Function Specification

Legacy Code Tool functions take a specific data structure or array of structures as the argument. You can initialize the data structure by calling the function legacy_code() using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call legacy_code('help'). The prototype of the legacy functions being called in this example is:

```c
FLT directLookupTableND(const FLT *tableND, const UINT32 nbDims, const UINT32 *tableDims, const UINT32 *tableIdx)
```

FLT is a typedef to float, and UINT32 is a typedef to unsigned int32. The legacy source code is in the files your_types.h, lookupTable.h, and directLookupTableND.c.

defs = [];  
evalin('base','load rtwdemo_lct_data.mat')

% rtwdemo_sfun_dlut3D
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_dlut3D';
def.OutputFcnSpec = 'single y1 = DirectLookupTable3D(single p1[][][], uint32 p2[3], uint32 u1[3])';
def.HeaderFiles = {'lookupTable.h'};
def.SourceFiles = {'directLookupTableND.c'};
def.IncPaths = {'rtwdemo_lct_src'};
def.SrcPaths = {'rtwdemo_lct_src'};
defs = [defs; def];
% rtwdemo_sfun_dlut4D
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_dlut4D';
def.OutputFcnSpec = 'single y1 = DirectLookupTable4D(single p1[][][][][], uint32 p2[4], uint32 u1[4])';
def.HeaderFiles   = {'lookupTable.h'};
def.SourceFiles   = {'directLookupTableND.c'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
defs = [defs; def];

Generate S-Functions for Simulation

To generate C-MEX S-functions according to the description provided by the input argument 'defs', call the function legacy_code() again. Set the first input to 'sfcn_cmex_generate'. The S-functions call the legacy functions during simulation. The source code for the S-functions is in the files rtwdemo_sfun_dlut3D.c and rtwdemo_sfun_dlut4D.c.

legacy_code('sfcn_cmex_generate', defs);

Compile the Generated S-Functions for Simulation

After you generate the C-MEX S-function source files, to compile the S-functions for simulation with Simulink®, call the function legacy_code() again. Set the first input to 'compile'.

legacy_code('compile', defs);

### Start Compiling rtwdemo_sfun_dlut3D
mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\Bdoc18b_943130_7372\rtwdemos\rtwdemo_lct_src\directLookupTableND.obj')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
mex('rtwdemo_sfun_dlut3D.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\Bdoc18b_943130_7372\rtwdemos\rtwdemo_lct_src\directLookupTableND.obj')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_dlut3D
### Exit

### Start Compiling rtwdemo_sfun_dlut4D
mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\Bdoc18b_943130_7372\rtwdemos\rtwdemo_lct_src\directLookupTableND.obj')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
mex('rtwdemo_sfun_dlut4D.c', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\Bdoc18b_943130_7372\rtwdemos\rtwdemo_lct_src\directLookupTableND.obj')
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Exit
Building with 'Microsoft Visual C++ 2017 (C)'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfuntlut4D
### Exit

**Generate TLC Block Files for Code Generation**

After you compile the S-functions and use them in simulation, you can call the function `legacy_code()` again. Set the first input to 'sfcn_tlc_generate' to generate TLC block files. Block files specify how the generated code for a model calls the legacy code. If you do not generate TLC block files and you try to generate code for a model that includes the S-functions, code generation fails. The TLC block files for the S-functions are `rtwdemo_sfuntlut3D.tlc` and `rtwdemo_sfuntlut4D.tlc`.

```matlab
legacy_code('sfcn_tlc_generate', defs);
```

**Generate an rtwmakecfg.m File for Code Generation**

After you create the TLC block files, you can call the function `legacy_code()` again. Set the first input to 'rtwmakecfg_generate' to generate an `rtwmakecfg.m` file to support code generation. If the required source and header files for the S-functions are not in the same folder as the S-functions, and you want to add these dependencies in the makefile produced during code generation, generate the `rtwmakecfg.m` file.

```matlab
legacy_code('rtwmakecfg_generate', defs);
```

**Generate Masked S-Function Blocks for Calling the Generated S-Functions**

After you compile the C-MEX S-function source, you can call the function `legacy_code()` again. Set the first input to 'slblock_generate' to generate masked S-function blocks that call the S-functions. The software places the blocks in a new model. You can copy the blocks to an existing model.

```matlab
legacy_code('slblock_generate', defs);
```
Show the Generated Integration with Legacy Code

The model `rtwdemo_lct_lut` shows integration of the model with the legacy code. The subsystem `TestFixpt` serves as a harness for the call to the legacy C function, and the Display blocks compare the output of the function with the output of the built-in Simulink® lookup blocks. The results are identical.

```matlab
open_system('rtwdemo_lct_lut')
open_system('rtwdemo_lct_lut/TestLut1')
sim('rtwdemo_lct_lut')
```

See Also

- `legacy_code`

Related Examples

- “Integrate C Functions Using Legacy Code Tool” (Simulink)
- “Call External C Code from Model and Generated Code” (Embedded Coder)
Integrate External C++ Object Methods

Integrate legacy C++ object methods by using the Legacy Code Tool.

With the Legacy Code Tool, you can:

- Provide the legacy function specification.
- Generate a C++ MEX S-function that calls the legacy code during simulation.
- Compile and build the generated S-function for simulation.
- Generate a block TLC file and optional rtwmakecfg.m file that calls the legacy code during code generation.

Provide the Legacy Function Specification

Functions provided with the Legacy Code Tool take a specific data structure or array of structures as the argument. The data structure is initialized by calling the function legacy_code() using 'initialize' as the first input. After initializing the structure, assign its properties to values corresponding to the legacy code being integrated. For detailed help on the properties, call legacy_code('help'). The definition of the legacy C++ class in this example is:

```cpp
class adder {
  private:
    int int_state;
  public:
    adder();
    int add_one(int increment);
    int get_val();
};
```

The legacy source code is in the files adder_cpp.h and adder_cpp.cpp.

```matlab
% rtwdemo_sfun_adder_cpp
def = legacy_code('initialize');
def.SFunctionName = 'rtwdemo_sfun_adder_cpp';
def.StartFcnSpec  = 'createAdder()';
def.OutputFcnSpec = 'int32 y1 = adderOutput(int32 u1)';
def.TerminateFcnSpec = 'deleteAdder()';
def.HeaderFiles   = {'adder_cpp.h'};
def.SourceFiles   = {'adder_cpp.cpp'};
def.IncPaths      = {'rtwdemo_lct_src'};
def.SrcPaths      = {'rtwdemo_lct_src'};
```
def.Options.language = 'C++';
def.Options.useTlcWithAccel = false;

**Generate an S-Function for Simulation**

To generate a C-MEX S-function according to the description provided by the input argument 'def', call the function legacy_code() again with the first input set to 'sfcn_cmex_generate'. The S-function calls the legacy functions during simulation. The source code for the S-function is in the file rtwdemo_sfun_adder_cpp.cpp.

legacy_code('sfcn_cmex_generate', def);

**Compile the Generated S-Function for Simulation**

After you generate the C-MEX S-function source file, to compile the S-function for simulation with Simulink®, call the function legacy_code() again with the first input set to 'compile'.

legacy_code('compile', def);

### Start Compiling rtwdemo_sfun_adder_cpp

mex('-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', ... 'B:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src\adder_cpp.cpp')
Building with 'Microsoft Visual C++ 2017'.
MEX completed successfully.

mex('rtwdemo_sfun_adder_cpp.cpp', '-IB:\matlab\toolbox\rtw\rtwdemos\rtwdemo_lct_src', '-IC:\TEMP\Bdoc18b_943130_7372\ib632619\23\tpad8c268a_afaa_4c4e_9c1c_257c1741819e\adder_cpp.obj')
Building with 'Microsoft Visual C++ 2017'.
MEX completed successfully.
### Finish Compiling rtwdemo_sfun_adder_cpp

### Exit

**Generate a TLC Block File for Code Generation**

After you compile the S-function and use it in simulation, you can call the function legacy_code() again. Set the first input to 'sfcn_tlc_generate' to generate a TLC block file that supports code generation through Simulink® Coder™. If the TLC block file is not created and you try to generate code for a model that includes the S-function, code generation fails. The TLC block file for the S-function is: rtwdemo_sfun_adder_cpp.tlc.

legacy_code('sfcn_tlc_generate', def);

**Generate an rtwmakecfg.m File for Code Generation**

After you create the TLC block file, you can call the function legacy_code() again. Set the first input to 'rtwmakecfg_generate' to generate an rtwmakecfg.m file that supports code
generation through Simulink® Coder™. If the required source and header files for the S-function are not in the same folder as the S-function, and you want to add these dependencies in the makefile produced during code generation, generate the rtwmakecfg.m file.

```matlab
legacy_code('rtwmakecfg_generate', def);
```

**Generate a Masked S-Function Block for Calling the Generated S-Function**

After you compile the C-MEX S-function source, you can call the function `legacy_code()` again. Set the first input to 'slblock_generate' to generate a masked S-function block that is configured to call that S-function. The software places the block in a new model. You can copy the block to an existing model.

```matlab
% legacy_code('slblock_generate', def);
```

**Show the Generated Integration with Legacy Code**

The model `rtwdemo_lct_cpp` shows integration with the legacy code.

```matlab
open_system('rtwdemo_lct_cpp')
sim('rtwdemo_lct_cpp')
```
See Also

legacy_code

Related Examples

- “Integrate C Functions Using Legacy Code Tool” (Simulink)
- “Call External C Code from Model and Generated Code” (Embedded Coder)
External Code Integration Examples

This topic shows various scenarios of external code integration.

Insert External C and C++ Code Into Stateflow Charts for Code Generation

This example shows how to use Stateflow® to integrate external code into a model.

Open Model

```matlab
model='rtwdemo_sfcustom';
open_system(model);
```

---

**Integrating c-code into model**

Custom written c-files can be easily integrated into Stateflow models. This code can be used to augment Stateflow's capabilities or to take advantage of legacy code.

To add custom c-files open the simulation target and enter the following:

- **Include Code** - Header that defines functions, structures, and data to be accessible by Stateflow.
- **Include Path** - Path to this include file.
- **Source Files** - c-files that define the functions and data accessible by Stateflow.

**Open simulation custom code settings**

If generating code via Simulink Coder, these same settings must also be added to the Model's configuration parameters custom code settings.

**Open Code Generation custom code settings**

**Build model using Simulink Coder**

---

**Calling c-code from Stateflow**

- **Functions**
  
  Custom c-code functions can be called from Stateflow using the same syntax as graphical function calls. The statement takes the form:
  
  ```
  result = my_custom_function(in_args);
  ```

- **Structures**
  
  Variables of structure type can be accessed in Stateflow via the "dot" notation. The expression takes the form:
  
  ```
  result = my_var.my_field;
  ```

To view the custom source for this example simulation double click the links below:

- **Open my_header.h**
- **Open my_function.c**

---

**Calling C++ code from Stateflow**

Custom C++ code can also be integrated into Stateflow and Simulink Coder. Double-click below for an example.

- **Open rtwdemo_stepp**

---

**Additional documentation**

Additional documentation is available for integrating C and C++ code in your model by double-clicking the link below.

- **C-Code integration**
- **C++-Code integration**

---

Copyright 1994-2016 The MathWorks, Inc.
Integrate Code

1. The example includes the custom header file `my_header.c` and the custom source file `my_function.c`.

```matlab
%Open files my_header.h and my_function.c
eval('edit my_header.h')
eval('edit my_function.c')
```

2. On the Configuration Parameters dialog box **Simulation Target** pane, enter the custom source file and header file. Also enter additional include directories and source files.

In this example, the custom header file `my_header.c` and source file `my_function.c` are entered on the **Simulation Target** pane.

```matlab
%Open Configuration Parameters dialog box
slCfgPrmDlg(model,'Open');
slCfgPrmDlg(bdroot,'TurnToPage','Simulation Target');
```

3. If you generate code with Simulink Coder®, on the Configuration Parameters dialog box **Code Generation > Custom Code** pane, enter the same custom source file and header file. Also enter the same additional include directories and source files.

In this example, the custom header file `my_header.c` and source file `my_function.c` are entered on the **Code Generation > Custom Code** pane.

```matlab
%Open Configuration Parameters dialog box
slCfgPrmDlg(model,'Open');
slCfgPrmDlg(bdroot,'TurnToPage','Code Generation/Custom Code');
```

Generate Code

```matlab
rtwbuild('rtwdemo_sfcustom')
```

### Starting build procedure for model: rtwdemo_sfcustom
### Successful completion of build procedure for model: rtwdemo_sfcustom

Call C Code from Stateflow

To call custom C code functions from Stateflow, use the same syntax as graphical function calls: `result = my_custom_function(in_args)`;

To call variables of structure type, use the dot notation: `result = my_var.my_field`;
See Also

- Include Custom C Code in Simulation Targets for Library Models
- Integrate Custom C++ Code for Simulation

Close Model

rtwdemoclean;
close_system('rtwdemo_sfcustom',0);

Integrate External C Code Into Generated Code By Using Custom Code Blocks and Model Configuration Parameters

This example shows how to place external code in generated code by using custom code blocks and model configuration parameters.

1. Open the model rtwdemo_slcustcode.

open_system('rtwdemo_slcustcode')
2. Open the Model Configuration Parameters dialog box and navigate to the Custom Code pane.

3. Examine the settings for parameters Source file and Initialize function.
• **Source file** specifies a comment and sets the variable GLOBAL_INT2 to -1.
• **Initialize function** initializes the variable GLOBAL_INT2 to 1.

4. Close the dialog box.

5. Double-click the Model Source block. The **Top of Model Source** field specifies that the code generator declare the variable GLOBAL_INT1 and set it to 0 at the top of the generated file rtwdemo_slcustcode.c.

6. Open the triggered subsystem Amplifier. The subsystem includes the System Outputs block. The code generator places code that you specify in that block in the generated code for the nearest parent atomic subsystem. In this case, the code generator places the external code in the generated code for the Amplifier subsystem. The external code:
   - Declares the pointer variable *intPtr and initializes it with the value of variable GLOBAL_INT1.
   - Sets the pointer variable to -1 during execution.
   - Resets the pointer variable to 0 before exiting.

7. Generate code and a code generation report.

8. Examine the code in the generated source file rtwdemo_slcustcode.c. At the top of the file, after the #include statements, you find the following declaration code. The example specifies the first declaration with the **Source file** configuration parameter and the second declaration with the Model Source block.

```
int_T GLOBAL_INT2 = -1;
int_T GLOBAL_INT1 = 0;
```

The Output function for the Amplifier subsystem includes the following code, which shows the external code integrated with generated code that applies the gain. The example specifies the three lines of code for the pointer variable with the System Outputs block in the Amplifier subsystem.

```
int_T *intPtr = &GLOBAL_INT1;
*intPtr = -1;
rtwdemo_slcustcode_Y.Output = rtwdemo_slcustcode_U.Input << 1;
```
The following assignment appears in the model initialize entry-point function. The example specifies this assignment with the `Initialize function` configuration parameter.

```
GLOBAL_INT2 = 1;
```

**Integrate External C Code Into Generated Code By Using Custom Code Blocks and Model Configuration Parameters**

This example shows how to place external code in generated code by using custom code blocks and model configuration parameters.

1. Open the model `rtwdemo_slcustcode`.

```plaintext
open_system('rtwdemo_slcustcode')
```
2. Open the Model Configuration Parameters dialog box and navigate to the **Custom Code** pane.

3. Examine the settings for parameters **Source file** and **Initialize function**.
• **Source file** specifies a comment and sets the variable GLOBAL_INT2 to -1.
• **Initialize function** initializes the variable GLOBAL_INT2 to 1.

4. Close the dialog box.

5. Double-click the Model Source block. The **Top of Model Source** field specifies that the code generator declare the variable GLOBAL_INT1 and set it to 0 at the top of the generated file rtwdemo_slcustcode.c.

6. Open the triggered subsystem **Amplifier**. The subsystem includes the System Outputs block. The code generator places code that you specify in that block in the generated code for the nearest parent atomic subsystem. In this case, the code generator places the external code in the generated code for the Amplifier subsystem. The external code:

   • Declares the pointer variable *intPtr and initializes it with the value of variable GLOBAL_INT1.
   • Sets the pointer variable to -1 during execution.
   • Resets the pointer variable to 0 before exiting.

7. Generate code and a code generation report.

8. Examine the code in the generated source file rtwdemo_slcustcode.c. At the top of the file, after the #include statements, you find the following declaration code. The example specifies the first declaration with the **Source file** configuration parameter and the second declaration with the Model Source block.

   ```
   int_T GLOBAL_INT2 = -1;
   int_T GLOBAL_INT1 = 0;
   ```

The Output function for the Amplifier subsystem includes the following code, which shows the external code integrated with generated code that applies the gain. The example specifies the three lines of code for the pointer variable with the System Outputs block in the Amplifier subsystem.

```c
int_T *intPtr = &GLOBAL_INT1;
*intPtr = -1;
rtwdemo_slcustcode_Y.Output = rtwdemo_slcustcode_U.Input << 1;
```
*intPtr = 0;

The following assignment appears in the model initialize entry-point function. The example specifies this assignment with the Initialize function configuration parameter.

GLOBAL_INT2 = 1;

**Insert External C and C++ Code Into Stateflow Charts for Code Generation**

This example shows how to use Stateflow® to integrate external code into a model.

**Open Model**

```matlab
model='rtwdemo_sfcustom';
open_system(model);
```

---

**Integrating C-code into model**

Custom written C-files can be easily integrated into Stateflow models. This code can be used to augment Stateflow's capabilities or to take advantage of legacy code.

To add custom C-files open the simulation target and enter the following:

- Include Code - Header that defines functions, structures, and data to be accessible by Stateflow.
- Include Path - Path to this include file.
- Source Files - C-files that define the functions and data accessible by Stateflow.

**Calling C-code from Stateflow**

**Functions**

Custom C-code functions can be called from Stateflow using the same syntax as graphical function calls. The statement takes the form:

```c
result = my_custom_function(in_args);
```

**Structures**

Variables of structure type can be accessed in Stateflow via the "dot" notation. The expression takes the form:

```c
result = my_var.my_field;
```

To view the custom source for this example, click the links below.

- Open my_header.h
- Open my_function.c

**Calling C++ code from Stateflow**

Custom C++ code can also be integrated into Stateflow and SimulinkCoder. Double-click below for an example.

- Open rtwdemo_cpp

**Additional documentation**

Additional documentation is available for integrating C and C++ code in your model by double-clicking the links below.

- C-Code integration
- C++-Code integration

---

Copyright 1994-2016 The MathWorks, Inc.

14-71
Integrate Code

1. The example includes the custom header file my_header.c and the custom source file my_function.c.

%Open files my_header.h and my_function.c
eval('edit my_header.h')
eval('edit my_function.c')

2. On the Configuration Parameters dialog box Simulation Target pane, enter the custom source file and header file. Also enter additional include directories and source files.

In this example, the custom header file my_header.c and source file my_function.c are entered on the Simulation Target pane.

%Open Configuration Parameters dialog box
slCfgPrmDlg(model,'Open');
slCfgPrmDlg(bdroot,'TurnToPage','Simulation Target');

3. If you generate code with Simulink Coder®, on the Configuration Parameters dialog box Code Generation > Custom Code pane, enter the same custom source file and header file. Also enter the same additional include directories and source files.

In this example, the custom header file my_header.c and source file my_function.c are entered on the Code Generation > Custom Code pane.

%Open Configuration Parameters dialog box
slCfgPrmDlg(model,'Open');
slCfgPrmDlg(bdroot,'TurnToPage','Code Generation/Custom Code');

Generate Code

rtwbuild('rtwdemo_sfcustom')

### Starting build procedure for model: rtwdemo_sfcustom
### Successful completion of build procedure for model: rtwdemo_sfcustom

Call C Code from Stateflow

To call custom C code functions from Stateflow, use the same syntax as graphical function calls: result = my_custom_function(in_args);

To call variables of structure type, use the dot notation: result = my_var.my_field;
See Also

- Include Custom C Code in Simulation Targets for Library Models
- Integrate Custom C++ Code for Simulation

Close Model

rtwdemoclean;
close_system('rtwdemo_sfcustom',0);
Generate S-Function from Subsystem

The **Generate S-function** feature automates the process of generating an S-function from a subsystem. In addition, the **Generate S-function** feature presents a display of parameters used within the subsystem, and lets you declare selected parameters tunable.

As an example, consider **SourceSubsys**, the same subsystem illustrated in the example “Create S-Function Blocks from a Subsystem” on page 24-62. The objective is to automatically extract **SourceSubsys** from the model and build an S-Function block from it, as in the previous example. In addition, the workspace variable K, which is the gain factor of the Gain block within **SourceSubsys** (as shown in the following Gain block parameter dialog box), is declared and generated as a tunable variable.

To auto-generate an S-function from **SourceSubsys** with tunable parameter K,

1. With the **SourceSubsys** model open, click the subsystem to select it.
2. From the **Code** menu, select **C/C++ Code > Generate S-Function**. This menu item is enabled when a subsystem is selected in the current model.

   Alternatively, you can right-click the subsystem and select **C/C++ Code > Generate S-Function** from the subsystem block's context menu.

3. The **Generate S-Function** window is displayed (see the next figure). This window shows variables (or data objects) that are referenced as block parameters in the subsystem, and lets you declare them as tunable.
The upper pane of the window displays three columns:

- **Variable Name**: name of the parameter.
- **Class**: If the parameter is a workspace variable, its data type is shown. If the parameter is a data object, its name and class is shown.
- **Tunable**: Lets you select tunable parameters. To declare a parameter tunable, select the check box. In the next figure, the parameter K is declared tunable.

When you select a parameter in the upper pane, the lower pane shows the blocks that reference the parameter, and the parent system of each such block.

**Generate S-Function Window**

4. After selecting tunable parameters, click the **Build** button. This initiates code generation and compilation of the S-function, using the S-function target. The **Create New Model** option is automatically enabled.

5. The build process displays status messages in the MATLAB Command Window. When the build completes, the tunable parameters window closes, and a new untitled model window opens.
The model window contains an S-Function block with the same name as the subsystem from which the block was generated (in this example, SourceSubsys). Optionally, you can save the generated model containing the generated block.

The generated code for the S-Function block is stored in the current working folder. The following files are written to the top-level folder:

- `subsys_sf.c` or `.cpp`, where `subsys` is the subsystem name (for example, `SourceSubsys_sf.c`)
- `subsys_sf.h`
- `subsys_sf.mexext`, where `mexext` is a platform-dependent MEX-file extension (for example, `SourceSubsys_sf.mexw64`)

The source code for the S-function is written to the subfolder `subsys_sfcn_rtw`. The top level `.c` or `.cpp` file is a stub file that simply contains an include directive that you can use to interface other C/C++ code to the generated code.

**Note** For a list of files required to deploy your S-Function block for simulation or code generation, see “Required Files for S-Function Deployment” on page 24-60.

The generated S-Function block has inports and outports whose widths and sample times correspond to those of the original model.

The following code, from the `mdlOutputs` routine of the generated S-function code (in `SourceSubsys_sf.c`), shows how the tunable variable `K` is referenced by using calls to the MEX API.

```c
static void mdlOutputs(SimStruct *S, int_T tid)
...
```
/* Gain: '<S1>/Gain' incorporates:
   * Sum: '<S1>/Sum'
*/
rtb_Gain_n[0] = (rtb_Product_p + (*((const
    real_T**)ssGetInputPortSignalPtrs(S, 2)[0]))) * (*((real_T
    *)(mxGetData(K(S)))));
rtb_Gain_n[1] = (rtb_Product_p + (*((const
    real_T**)ssGetInputPortSignalPtrs(S, 2)[1]))) * (*((real_T
    *)(mxGetData(K(S)))));

- In automatic S-function generation, the **Use Value for Tunable Parameters** option is cleared or at the command line is set to 'off'.
- Use a MEX S-function wrapper only in the MATLAB version in which the wrapper is created.

If you specify paths and files with absolute

**Macro Parameters**

Suppose that you apply a custom storage class such as **Define** to a Simulink.Parameter object so that the parameter appears as a macro in the generated code. If you use the parameter object inside a subsystem from which you generate an ERT S-function, you cannot select the parameter object as a tunable parameter. Instead, the S-function code generator applies the custom storage class to the parameter object. This generation of macros in the S-function code allows you to generate S-functions from subsystems that contain variant elements, such as Variant Subsystem blocks, that you configure to produce preprocessor conditionals in the generated code. However, you cannot change the value of the parameter during simulation of the S-function.

To select the parameter object as a tunable parameter, apply a different storage class or custom storage class. Custom storage classes that treat parameters as macros include **Define**, **ImportedDefine**, **CompilerFlag**, and custom storage classes that you create by setting **Data initialization** to **Macro** in the Custom Storage Class Designer. If you use a non-macro storage class or custom storage class, you cannot use the parameter object as a variant control variable and generate preprocessor conditionals.

If you apply a custom storage class that treats the parameter object as an imported macro, provide the macro definition before you generate the ERT S-function. For example, suppose that you apply the custom storage class **ImportedDefine** to a Simulink.Parameter object, and use the parameter object as a variant control variable in the subsystem. If you set the custom attribute **HeaderFile** to 'myHdr.h', when you generate the S-function, place the custom header file myHdr.h in the current folder. The
generated S-function uses the macro value from your header file instead of the value from the Value property of the parameter object.

To use a macro that you define through a compiler option, for example by applying the custom storage class CompilerFlag, use the model configuration parameter Configuration Parameters > Code Generation > Custom Code > Additional build information > Defines to specify the compiler option. For more information, see Code Generation Pane: Custom Code: Additional Build Information: Defines.

See Also
legacy_code

More About
- “S-Functions and Code Generation” on page 14-2
- “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7
- “Build S-Functions Automatically” (Simulink)
S-Functions That Support Expression Folding

Use expression folding to increase the efficiency of code generated by your own inlined S-Function blocks, by calling macros provided in the S-Function API.

The S-Function API lets you specify whether a given S-Function block should nominally accept expressions at a given input port. A block should not always accept expressions. For example, if the address of the signal at the input is used, expressions should not be accepted at that input, because it is not possible to take the address of an expression.

The S-Function API also lets you specify whether an expression can represent the computations associated with a given output port. When you request an expression at a block's input or output port, the Simulink engine determines whether or not it can honor that request, given the block's context. For example, the engine might deny a block's request to output an expression if the destination block does not accept expressions at its input, if the destination block has an update function, or if multiple output destinations exist.

The decision to honor or deny a request to output an expression can also depend on the category of output expression the block uses.

To take advantage of expression folding in your S-functions, you should understand when to request acceptance and generation of expressions for specific blocks. You do not have to understand the algorithm by which the Simulink engine chooses to accept or deny these requests. However, if you want to trace between the model and the generated code, it is helpful to understand some of the more common situations that lead to denial of a request.

Categories of Output Expressions

When you implement a C MEX S-function, you can specify whether the code corresponding to a block's output is to be generated as an expression. If the block generates an expression, you must specify that the expression is constant, trivial, or generic.

A constant output expression is a direct access to one of the block's parameters. For example, the output of a Constant block is defined as a constant expression because the output expression is simply a direct access to the block's Value parameter.

A trivial output expression is an expression that can be repeated, without a performance penalty, when the output port has multiple output destinations. For example, the output of
a Unit Delay block is defined as a trivial expression because the output expression is simply a direct access to the block's state. Because the output expression does not have computations, it can be repeated more than once without degrading the performance of the generated code.

A *generic* output expression is an expression that should be assumed to have a performance penalty if repeated. As such, a generic output expression is not suitable for repeating when the output port has multiple output destinations. For instance, the output of a Sum block is a generic rather than a trivial expression because it is costly to recompute a Sum block output expression as an input to multiple blocks.

**Examples of Trivial and Generic Output Expressions**

Consider this block diagram. The Delay block has multiple destinations, yet its output is designated as a trivial output expression, so that it can be used more than once without degrading the efficiency of the code.

This code excerpt shows the code generated from the Unit Delay block in this block diagram. The three root outputs are directly assigned from the state of the Unit Delay block, which is stored in a field of the global data structure `rtDWork`. Since the assignment is direct, without expressions, there is no performance penalty associated with using the trivial expression for multiple destinations.

```c
void MdlOutputs(int_T tid)
{
    ... /* Outport: <Root>/Out1 incorporates:
    *    UnitDelay: <Root>/Unit Delay */
    rtY.Out1 = rtDWork.Unit_Delay_DSTATE;
    /* Outport: <Root>/Out2 incorporates:
    *    UnitDelay: <Root>/Unit Delay */
    /* Outport: <Root>/Out3 incorporates:
    *    UnitDelay: <Root>/Unit Delay */
```
The code generated shows how code is generated for Sum blocks with single and multiple destinations.

On the other hand, consider the Sum blocks in this model:

The upper Sum block in the model generates the signal labeled `non_triv`. Computation of this output signal involves two multiplications and an addition. If the Sum block's output were permitted to generate an expression even when the block had multiple destinations, the block's operations would be duplicated in the generated code. In this case, the generated expressions would proliferate to four multiplications and two additions. This would degrade the efficiency of the program. Accordingly the output of the Sum block is not allowed to be an expression because it has multiple destinations.

The Simulink engine does not permit the output of the upper Sum block to be an expression because the signal `non_triv` is routed to two output destinations. Instead, the result of the multiplication and addition operations is stored in a temporary variable (`rtb_non_triv`) that is referenced twice in the statements that follow, as seen in the code excerpt below.

In contrast, the lower Sum block, which has only a single output destination (`Out2`), does generate an expression.
void MdlOutputs(int_T tid)
{
    /* local block i/o variables */
    real_T rtb_non_triv;
    real_T rtb_Sine_Wave;

    /* Sum: <Root>/Sum incorporates:
    *   Gain: <Root>/Gain
    *   Inport: <Root>/u1
    *   Gain: <Root>/Gain1
    *   Inport: <Root>/u2
    *
    * Regarding <Root>/Gain:
    *   Gain value: rtP.Gain_Gain
    *
    * Regarding <Root>/Gain1:
    *   Gain value: rtP.Gain1_Gain
    */
    rtb_non_triv = (rtP.Gain_Gain * rtU.u1) + (rtP.Gain1_Gain * rtU.u2);

    /* Outport: <Root>/Out1 */
    rtY.Out1 = rtb_non_triv;

    /* Sin Block: <Root>/Sine Wave */
    rtb_Sine_Wave = rtP.Sine_Wave_Amp *
        sin(rtP.Sine_Wave_Freq * rtmGetT(rtM_model) + rtP.Sine_Wave_Phase) + rtP.Sine_Wave_Bias;

    /* Outport: <Root>/Out2 incorporates:
    *   Sum: <Root>/Sum1
    */
    rtY.Out2 = (rtb_non_triv + rtb_Sine_Wave);
}

Specify the Category of an Output Expression

The S-Function API provides macros that let you declare whether an output of a block
should be an expression, and if so, to specify the category of the expression. This table
specifies when to declare a block output to be a constant, trivial, or generic output
expression.
Types of Output Expressions

<table>
<thead>
<tr>
<th>Category of Expression</th>
<th>When to Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>Use only if block output is a direct memory access to a block parameter.</td>
</tr>
<tr>
<td>Trivial</td>
<td>Use only if block output is an expression that can appear multiple times in the code without reducing efficiency (for example, a direct memory access to a field of the DWork vector, or a literal).</td>
</tr>
<tr>
<td>Generic</td>
<td>Use if output is an expression, but not constant or trivial.</td>
</tr>
</tbody>
</table>

You must declare outputs as expressions in the `mdlSetWorkWidths` function using macros defined in the S-Function API. The macros have the following arguments:

- `SimStruct *S`: pointer to the block's `SimStruct`.
- `int idx`: zero-based index of the output port.
- `bool value`: pass in `TRUE` if the port generates output expressions.

The following macros are available for setting an output to be a constant, trivial, or generic expression:

- `void ssSetOutputPortConstOutputExprInRTW(SimStruct *S, int idx, bool value)`
- `void ssSetOutputPortTrivialOutputExprInRTW(SimStruct *S, int idx, bool value)`
- `void ssSetOutputPortOutputExprInRTW(SimStruct *S, int idx, bool value)`

The following macros are available for querying the status set by prior calls to the macros above:

- `bool ssGetOutputPortConstOutputExprInRTW(SimStruct *S, int idx)`
- `bool ssGetOutputPortTrivialOutputExprInRTW(SimStruct *S, int idx)`
- `bool ssGetOutputPortOutputExprInRTW(SimStruct *S, int idx)`

The set of generic expressions is a superset of the set of trivial expressions, and the set of trivial expressions is a superset of the set of constant expressions.
Therefore, when you query an output that has been set to be a constant expression with `ssGetOutputPortTrivialOutputExprInRTW`, it returns `True`. A constant expression is considered a trivial expression because it is a direct memory access that can be repeated without degrading the efficiency of the generated code.

Similarly, an output that has been configured to be a constant or trivial expression returns `True` when queried for its status as a generic expression.

**Acceptance or Denial of Requests for Input Expressions**

A block can request that its output be represented in code as an expression. Such a request can be denied if the destination block cannot accept expressions at its input port. Furthermore, conditions independent of the requesting block and its destination blocks can prevent acceptance of expressions.

A block should not be configured to accept expressions at its input port under the following conditions:

- The block must take the address of its input data. It is not possible to take the address of most types of input expressions.
- The code generated for the block references the input more than once (for example, the Abs or Max blocks). This would lead to duplication of a potentially complex expression and a subsequent degradation of code efficiency.

If a block refuses to accept expressions at an input port, then a block that is connected to that input port is not permitted to output a generic or trivial expression.

A request to output a constant expression is not denied, because there is no performance penalty for a constant expression, and the software can take the parameter’s address.

**S-Function API to Specify Input Expression Acceptance**

The S-Function API provides macros that let you:

- Specify whether a block input should accept nonconstant expressions (that is, trivial or generic expressions).
• Query whether a block input accepts nonconstant expressions.

By default, block inputs do not accept nonconstant expressions.

You should call the macros in your `mdlSetWorkWidths` function. The macros have these arguments:

• `SimStruct *S`: pointer to the block's SimStruct.
• `int idx`: zero-based index of the input port.
• `bool value`: pass in TRUE if the port accepts input expressions; otherwise pass in FALSE.

The macro available for specifying whether or not a block input should accept a nonconstant expression is:

```c
void ssSetInputPortAcceptExprInRTW(SimStruct *S, int portIdx, bool value)
```

The corresponding macro available for querying the status set by any prior calls to `ssSetInputPortAcceptExprInRTW` is:

```c
bool ssGetInputPortAcceptExprInRTW(SimStruct *S, int portIdx)
```

**Denial of Block Requests to Output Expressions**

Even after a specific block requests that it be allowed to generate an output expression, that request can be denied for generic reasons. These reasons include, but are not limited to:

• The output expression is nontrivial, and the output has multiple destinations.
• The output expression is nonconstant, and the output is connected to at least one destination that does not accept expressions at its input port.
• The output is a test point.
• The output has been assigned an external storage class.
• The output must be stored using global data (for example is an input to a merge block or a block with states).
• The output signal is complex.

You do not need to consider these generic factors when deciding whether or not to utilize expression folding for a particular block. However, these rules can be helpful when you are examining generated code and analyzing cases where the expression folding optimization is suppressed.
Expression Folding in a TLC Block Implementation

To take advantage of expression folding, modify the TLC block implementation of an
inlined S-Function such that it informs the Simulink engine whether it generates or
accepts expressions at its

- Input ports, as explained in “S-Function API to Specify Input Expression Acceptance”
on page 14-84.
- Output ports, as explained in “Categories of Output Expressions” on page 14-79.

This topic discusses required modifications to the TLC implementation.

Expression Folding Compliance

In the BlockInstanceSetup function of your S-function, register your block to be
compliant with expression folding. Otherwise, expression folding requested or allowed at
the block's outputs or inputs will be disabled, and temporary variables will be used.

To register expression folding compliance, call the TLC library function
LibBlockSetIsExpressionCompliant(block), which is defined in
matlabroot/rtw/c/tlc/lib/utillib.tlc. For example:

%% Function: BlockInstanceSetup ===========================================
%%
%function BlockInstanceSetup(block, system) void
  %<LibBlockSetIsExpressionCompliant(block)>
%%
%endfunction

You can conditionally disable expression folding at the inputs and outputs of a block by
making the call to this function conditionally.

If you override one of the TLC block implementations provided by the code generator with
your own implementation, you should not make the preceding call until you have updated
your implementation.

Output Expressions

The BlockOutputSignal function is used to generate code for a scalar output
expression or one element of a nonscalar output expression. If your block outputs an
expression, you should add a BlockOutputSignal function. The prototype of the
BlockOutputSignal is

%function BlockOutputSignal(block, system, portIdx, ucv, lcv, idx, retType) void
The arguments to `BlockOutputSignal` are these:

- **block**: the record for the block for which an output expression is being generated
- **system**: the record for the system containing the block
- **portIdx**: zero-based index of the output port for which an expression is being generated
- **ucv**: user control variable defining the output element for which code is being generated
- **lcv**: loop control variable defining the output element for which code is being generated
- **idx**: signal index defining the output element for which code is being generated
- **retType**: character vector defining the type of signal access desired:
  - "Signal" specifies the contents or address of the output signal
  - "SignalAddr" specifies the address of the output signal

The `BlockOutputSignal` function returns a character vector for the output signal or address. The character vector should enforce the precedence of the expression by using opening and terminating parentheses, unless the expression consists of a function call. The address of an expression can only be returned for a constant expression; it is the address of the parameter whose memory is being accessed. The code implementing the `BlockOutputSignal` function for the Constant block is:

```matlab
%% Function: BlockOutputSignal =================================================
%% Abstract:
%%      Return the reference to the parameter.  This function *may*
%%      be used by Simulink when optimizing the Block IO data structure.
%%
%function BlockOutputSignal(block,system,portIdx,ucv,lcv,idx,retType) void
%switch retType
%case "Signal"
  %return LibBlockParameter(Value,ucv,lcv,idx)
%case "SignalAddr"
  %return LibBlockParameterAddr(Value,ucv,lcv,idx)
%default
%assign errTxt = "Unsupported return type: %<retType>"
%<LibBlockReportError(block,errTxt)>
%endswitch
%endfunction
```

The code implementing the `BlockOutputSignal` function for the Relational Operator block is:

```matlab
%% Function: BlockOutputSignal =================================================
%% Abstract:
%%
```
Expression Folding for Blocks with Multiple Outputs

When a block has a single output, the Outputs function in the block's TLC file is called only if the output port is not an expression. Otherwise, the BlockOutputSignal function is called.

If a block has multiple outputs, the Outputs function is called if any output port is not an expression. The Outputs function should guard against generating code for output ports that are expressions. This is achieved by guarding sections of code corresponding to individual output ports with calls to LibBlockOutputSignalIsExpr().

For example, consider an S-Function with two inputs and two outputs, where

- The first output, \( y_0 \), is equal to two times the first input.
- The second output, \( y_1 \), is equal to four times the second input.

The Outputs and BlockOutputSignal functions for the S-function are shown in this code excerpt:
%case "Signal"
  %if portIdx == 0
    %return "(2 * %<u>)"
  %elseif portIdx == 1
    %return "(4 * %<u>)"
  %endif
%default
%assign errTxt = "Unsupported return type: %<retType>"
%<LibBlockReportError(block,errTxt)>
%endswitch
%endfunction

% % Function: Outputs  =================================================
% Abstract:  
% Compute output signals of block
% %
%function Outputs(block,system) Output
%assign rollVars = ["U", "Y"]
%roll sigIdx = RollRegions, lcv = RollThreshold, block, "Roller", rollVars
%assign u0 = LibBlockInputSignal(0, "", lcv, sigIdx)
%assign u1 = LibBlockInputSignal(1, "", lcv, sigIdx)
%assign y0 = LibBlockOutputSignal(0, "", lcv, sigIdx)
%assign y1 = LibBlockOutputSignal(1, "", lcv, sigIdx)
%if !LibBlockOutputSignalIsExpr(0)
  %<y0> = 2 * %<u0>;
%endif
%if !LibBlockOutputSignalIsExpr(1)
  %<y1> = 4 * %<u1>;
%endif
%endroll
%endfunction

Comments for Blocks That Are Expression-Folding-Compliant

In the past, blocks preceded their outputs code with comments of the form

/* %<Type> Block: %<Name> */

When a block is expression-folding-compliant, the initial line shown above is generated automatically. Do not include the comment as part of the block's TLC implementation. Register additional information by using the LibCacheBlockComment function.

The LibCacheBlockComment function takes a character vector as an input, defining the body of the comment, except for the opening header, the final newline of a single or multiline comment, and the closing trailer.

The following TLC code illustrates registering a block comment. Note the use of the function LibBlockParameterForComment, which returns a character vector, suitable for a block comment, specifying the value of the block parameter.

%openfile commentBuf
$c(*) Gain value: %<LibBlockParameterForComment(Gain)>
See Also

Related Examples

- “S-Functions That Specify Port Scope and Reusability” on page 14-91
- “S-Functions That Specify Sample Time Inheritance Rules” on page 14-96
- “S-Functions That Support Code Reuse” on page 14-99
S-Functions That Specify Port Scope and Reusability

You can use the following SimStruct macros in the mdlInitializeSizes method to specify the scope and reusability of the memory used for your S-function's input and output ports:

• **ssSetInputPortOptimOpts**: Specify the scope and reusability of the memory allocated to an S-function input port.

• **ssSetOutputPortOptimOpts**: Specify the scope and reusability of the memory allocated to an S-function output port.

• **ssSetInputPortOverWritable**: Specify whether one of your S-function's input ports can be overwritten by one of its output ports.

• **ssSetOutputPortOverwritesInputPort**: Specify whether an output port can share its memory buffer with an input port.

You declare an input or output as local or global, and indicate its reusability, by passing one of the following four options to the ssSetInputPortOptimOpts and ssSetOutputPortOptimOpts macros:

• **SS_NOT_REUSABLE_AND_GLOBAL**: Indicates that the input and output ports are stored in separate memory locations in the global block input and output structure.

• **SS_NOT_REUSABLE_AND_LOCAL**: Indicates that the code generator can declare individual local variables for the input and output ports.

• **SS_REUSABLE_AND_LOCAL**: Indicates that the code generator can reuse a single local variable for these input and output ports.

• **SS_REUSABLE_AND_GLOBAL**: Indicates that these input and output ports are stored in a single element in the global block input and output structure.

**Note** Marking an input or output port as a local variable does not imply that the code generator uses a local variable in the generated code. If your S-function accesses the inputs and outputs only in its mdlOutputs routine, the code generator declares the inputs and outputs as local variables. However, if the inputs and outputs are used elsewhere in the S-function, the code generator includes them in the global block input and output structure.

The reusability setting indicates if the memory associated with an input or output port can be overwritten. To reuse input and output port memory:
1 Indicate the ports are reusable using either the SS_REUSABLE_AND_LOCAL or SS_REUSABLE_AND_GLOBAL option in the ssSetInputPortOptimOpts and ssSetOutputPortOptimOpts macros.

2 Indicate the input port memory is overwritable using ssSetInputPortOverWritable.

3 If your S-function has multiple input and output ports, use ssSetOutputPortOverwritesInputPort to indicate which output and input ports share memory.

The following example shows how different scope and reusability settings affect the generated code. The following model contains an S-function block pointing to the C MEX S-function `matlabroot/toolbox/simulink/simdemos/simfeatures/src/sfun_directlook.c`, which models a direct 1-D lookup table.

The S-function's `mdlInitializeSizes` method declares the input port as reusable, local, and overwritable and the output port as reusable and local, as follows:

```c
static void mdlInitializeSizes(SimStruct *S)
{
    /* snip */
    ssSetInputPortOptimOpts(S, 0, SS_REUSABLE_AND_LOCAL);
    ssSetInputPortOverWritable(S, 0, TRUE);

    /* snip */
    ssSetOutputPortOptimOpts(S, 0, SS_REUSABLE_AND_LOCAL);

    /* snip */
}
```

The generated code for this model stores the input and output signals in a single local variable `rtb_SFunction`, as shown in the following output function:

```c
static void sl_directlook_output(int_T tid)
{
    /* local block i/o variables */
    real_T rtb_SFunction[2];

    /* Sin: '<Root>/Sine Wave' */
    rtb_SFunction[0] = sin(((real_T)sl_directlook_DWork.counter[0] +
                            sl_directlook_P.SineWave_Offset) * 2.0 * 3.1415926535897931E+000 +
                            14-92
```
This table shows variations of the code generated for this model when using the generic real-time target (GRT). Each row explains a different setting for the scope and reusability of the S-function's input and output ports.

<table>
<thead>
<tr>
<th>Scope and reusability</th>
<th>S-function mdlInitializeSizes code</th>
<th>Generated code</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inputs:</strong> Local, reusable, overwritable</td>
<td>ssSetInputPortOptimOpts(S, 0, SS_REUSABLE_AND_LOCAL); ssSetInputPortOverWritable(S, 0, TRUE);</td>
<td>The model.c file declares a local variable in the output function. /* local block i/o variables */ real_T rtb_SFunction[2];</td>
</tr>
<tr>
<td><strong>Outputs:</strong> Local, reusable</td>
<td>ssSetOutputPortOptimOpts(S, 0, SS_REUSABLE_AND_LOCAL);</td>
<td></td>
</tr>
</tbody>
</table>

S-Functions That Specify Port Scope and Reusability

```c
sl_directlook_P.SineWave_NumSamp) * sl_directlook_P.SineWave_Amp[0] + sl_directlook_P.SineWave_Bias;
/* S-Function Block: <Root>/S-Function */
{
    const real_T *xData = &sl_directlook_P.SFunction_XData[0];
    const real_T *yData = &sl_directlook_P.SFunction_YData [0];
    real_T spacing = xData[1] - xData[0];
    if (rtb_SFunction[0] <= xData[0] ) {
        rtb_SFunction[0] = yData[0];
    } else if (rtb_SFunction[0] >= yData[20] ) {
        rtb_SFunction[0] = yData[20];
    } else {
        int_T idx = (int_T)( ( rtb_SFunction[0] - xData[0] ) / spacing );
        rtb_SFunction[0] = yData[idx];
    }
    if (rtb_SFunction[1] <= xData[0] ) {
        rtb_SFunction[1] = yData[0];
    } else if (rtb_SFunction[1] >= yData[20] ) {
        rtb_SFunction[1] = yData[20];
    } else {
        int_T idx = (int_T)( ( rtb_SFunction[1] - xData[0] ) / spacing );
        rtb_SFunction[1] = yData[idx];
    }
}
/* Outport: '<Root>/Out1' */
sl_directlook_Y.Out1[0] = rtb_SFunction[0];
sl_directlook_Y.Out1[1] = rtb_SFunction[1];
UNUSED_PARAMETER(tid);
}
**Scope and reusability** | **S-function mdlInitializeSizes code** | **Generated code**
--- | --- | ---
**Inputs**: Global, reusable, overwritable  
**Outputs**: Global, reusable | ssSetInputPortOptimOpts(S, 0, SS_REUSABLE_AND_GLOBAL);  
ssSetInputPortOverWritable(S, 0, TRUE);  
ssSetOutputPortOptimOpts(S, 0, SS_REUSABLE_AND_GLOBAL); | The *model*.h file defines a block signals structure with a single element to store the S-function's input and output.

```c
/* Block signals (auto storage) */
typedef struct {
    real_T SFunction[2];
} BlockIO_sl_directlook;
```

The *model*.c file uses this element of the structure in calculations of the S-function's input and output signals.

```c
/* Sin: '<Root>/Sine Wave' */
sl_directlook_B.SFunction[0] = sin ...
/* snip */
/*S-Function Block:<Root>/S-Function*/
{  
    const real_T *xData = &sl_directlook_P.SFunction_XData[0]
```  

**Inputs**: Local, not reusable  
**Outputs**: Local, not reusable | ssSetInputPortOptimOpts(S, 0, SS_NOT_REUSABLE_AND_LOCAL);  
ssSetInputPortOverWritable(S, 0, FALSE);  
ssSetOutputPortOptimOpts(S, 0, SS_NOT_REUSABLE_AND_LOCAL); | The *model*.c file declares local variables for the S-function's input and output in the output function.

```c
/* local block i/o variables */  
real_T rtb_SineWave[2];  
real_T rtb_SFunction[2];
```
<table>
<thead>
<tr>
<th>Scope and reusability</th>
<th>S-function mdlInitializeSizes code</th>
<th>Generated code</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inputs:</strong> Global, not reusable</td>
<td>ssSetInputPortOptimOpts(S, 0, SS_NOT_REUSABLE_AND_GLOBAL); ssSetInputPortOverWritable(S, 0, FALSE); ssSetOutputPortOptimOpts(S, 0, SS_NOT_REUSABLE_AND_GLOBAL);</td>
<td>The <code>model.h</code> file defines a block signal structure with individual elements to store the S-function's input and output. <code>typedef struct { real_T SineWave[2]; real_T SFunction[2]; } BlockIO_sl_directlook;</code></td>
</tr>
<tr>
<td><strong>Outputs:</strong> Global, not reusable</td>
<td></td>
<td>The <code>model.c</code> file uses the different elements in this structure when calculating the S-function's input and output. <code>/* Sin: '&lt;Root&gt;/Sine Wave' */ sl_directlook_B.SineWave[0] = sin ... /* snip */</code></td>
</tr>
</tbody>
</table>

### See Also

### Related Examples
- “S-Functions That Support Expression Folding” on page 14-79
- “S-Functions That Specify Sample Time Inheritance Rules” on page 14-96
- “S-Functions That Support Code Reuse” on page 14-99
S-Functions That Specify Sample Time Inheritance Rules

For the Simulink engine to determine whether a model can inherit a sample time, the S-functions in the model need to specify how they use sample times. You can specify this information by calling the macro 
ssSetModelReferenceSampleTimeInheritanceRule from mdlInitializeSizes or mdlSetWorkWidths. To use this macro:

1. Check whether the S-function calls any of these macros:
   - ssGetSampleTime
   - ssGetInputPortSampleTime
   - ssGetOutputPortSampleTime
   - ssGetInputPortOffsetTime
   - ssGetOutputPortOffsetTime
   - ssGetSampleTimePtr
   - ssGetInputPortSampleTimeIndex
   - ssGetOutputPortSampleTimeIndex
   - ssGetSampleTimeTaskID
   - ssGetSampleTimeTaskIDPtr

2. Check for these in your S-function TLC code:
   - LibBlockSampleTime
   - CompiledModel.SampleTime
   - LibBlockInputSignalSampleTime
   - LibBlockInputSignalOffsetTime
   - LibBlockOutputSignalSampleTime
   - LibBlockOutputSignalOffsetTime

3. Depending on your search results, use 
   ssSetModelReferenceSampleTimeInheritanceRule as indicated in this table.
<table>
<thead>
<tr>
<th>If...</th>
<th>Use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>None of the macros or functions are present, the S-function does</td>
<td>\texttt{ssSetModelReferenceSampleTimeInheritanceRule} \texttt{(S, USE_DEFAULT_FOR_DISCRETE_INHERITANCE)}</td>
</tr>
<tr>
<td>not preclude the model from inheriting a sample time.</td>
<td></td>
</tr>
<tr>
<td>Any of the macros or functions are used for:</td>
<td>\texttt{ssSetModelReferenceSampleTimeInheritanceRule...} \texttt{(S,USE_DEFAULT_FOR_DISCRETE_INHERITANCE)}</td>
</tr>
<tr>
<td>• Throwing errors if sample time is inherited, continuous, or</td>
<td></td>
</tr>
<tr>
<td>constant</td>
<td></td>
</tr>
<tr>
<td>• Checking \texttt{ssIsSampleHit}</td>
<td></td>
</tr>
<tr>
<td>• Checking whether sample time is inherited in either \texttt{mdlSetInputPortSampleTime} or \texttt{mdlSetOutputPortSampleTime} before setting</td>
<td></td>
</tr>
<tr>
<td>The S-function uses its sample time for computing parameters,</td>
<td>\texttt{ssSetModelReferenceSampleTimeInheritanceRule} \texttt{(S, DISALLOW_SAMPLE_TIME_INHERITANCE)}</td>
</tr>
<tr>
<td>outputs, and so on.</td>
<td></td>
</tr>
</tbody>
</table>

**Note** If an S-function does not set the \texttt{ssSetModelReferenceSampleTimeInheritanceRule} macro, by default the Simulink engine assumes that the S-function does not preclude the model containing that S-function from inheriting a sample time. However, the engine issues a warning indicating that the model includes S-functions for which this macro is not set.

You can use settings in the Configuration Parameters on the **Diagnostics > Sample Time** pane to control how the Simulink engine responds when it encounters S-functions that have unspecified sample time inheritance rules. Toggle the **Unspecified inheritability of sample time** (Simulink) diagnostic to none, warning, or error. The default is warning.
See Also

Related Examples

- “S-Functions That Support Expression Folding” on page 14-79
- “S-Functions That Specify Port Scope and Reusability” on page 14-91
- “S-Functions That Support Code Reuse” on page 14-99
S-Functions That Support Code Reuse

You can reuse the generated code for identical subsystems that occur in multiple instances within a model and across referenced models. For more information about code generation of subsystems for code reuse, see “Control Generation of Subsystem Functions” on page 6-2. If you want your S-function to support code reuse for a subsystem, the S-function must meet these requirements:

- The S-function must be inlined.
- Code generated from the S-function must not use static variables.
- The S-function must initialize its pointer work vector in `mdlStart` and not before.
- The S-function must not be a sink that logs data to the workspace.
- The S-function must register its parameters as run-time parameters in `mdlSetWorkWidths`. (It must not use `ssWriteRTWParameters` in its `mdlRTW` function for this purpose.)
- The S-function must not be a device driver.

In addition to meeting the preceding requirements, your S-function must set the `SS_OPTION_WORKS_WITH_CODE_REUSE` flag in the `ssSetOptions` function. This flag indicates that your S-function meets the requirements for subsystem code reuse.

See Also

Related Examples

- “S-Functions That Support Expression Folding” on page 14-79
- “S-Functions That Specify Port Scope and Reusability” on page 14-91
- “S-Functions That Specify Sample Time Inheritance Rules” on page 14-96
S-Functions for Multirate Multitasking Environments

**In this section...**

- “About S-Functions for Multirate Multitasking Environments” on page 14-100
- “Rate Grouping Support in S-Functions” on page 14-100
- “Create Multitasking, Multirate, Port-Based Sample Time S-Functions” on page 14-101

**About S-Functions for Multirate Multitasking Environments**

S-functions can be used in models with multiple sample rates and deployed in multitasking target environments. Likewise, S-functions themselves can have multiple rates at which they operate. The code generator produces code for multirate multitasking models using an approach called *rate grouping*. In code generated for ERT-based targets, rate grouping generates separate `model_step` functions for the base rate task and each subrate task in the model. Although rate grouping is a code generation feature found in ERT targets only, your S-functions can use it in other contexts when you code them as explained below.

**Rate Grouping Support in S-Functions**

To take advantage of rate grouping, you must inline your multirate S-functions if you have not done so. You need to follow certain Target Language Compiler protocols to exploit rate grouping. Coding TLC to exploit rate grouping does not prevent your inlined S-functions from functioning properly in GRT. Likewise, your inlined S-functions will still generate valid ERT code even if you do not make them rate-grouping-compliant. If you do so, however, they will generate more efficient code for multirate models.

For instructions and examples of Target Language Compiler code illustrating how to create and upgrade S-functions to generate rate-grouping-compliant code, see “Rate Grouping Compliance and Compatibility Issues” (Embedded Coder).

For each multirate S-function that is not rate grouping-compliant, the code generator issues the following warning when you build:

Warning: Simulink Coder: Code of output function for multirate block
'\<Root>/S-Function' is guarded by sample hit checks rather than being rate grouped. This will generate the same code for all rates used by the block, possibly generating dead code. To avoid dead code, you must update the TLC file for the block.
You will also find a comment such as the following in code generated for each noncompliant S-function:

/* Because the output function of multirate block
<Root>/S-Function is not rate grouped,
the following code might contain unreachable blocks of code.
To avoid this, you must update your block TLC file. */

The words “update function” are substituted for “output function” in these warnings.

**Create Multitasking, Multirate, Port-Based Sample Time S-Functions**

The following instructions show how to support both data determinism and data integrity in multirate S-functions. They do not cover cases where there is no determinism nor integrity. Support for frame-based processing does not affect the requirements.

**Note** The slow rates must be multiples of the fastest rate. The instructions do not apply when two rates being interfaced are not multiples or when the rates are not periodic.

**Rules for Properly Handling Fast-to-Slow Transitions**

The rules that multirate S-functions should observe for inputs are

- The input should only be read at the rate that is associated with the input port sample time.
- Generally, the input data is written to DWork, and the DWork can then be accessed at the slower (downstream) rate.

The input can be read at every sample hit of the input rate and written into DWork memory, but this DWork memory cannot then be directly accessed by the slower rate. DWork memory that will be read by the slow rate must only be written by the fast rate when there is a *special sample hit*. A special sample hit occurs when both this input port rate and rate to which it is interfacing have a hit. Depending on their requirements and design, algorithms can process the data in several locations.

The rules that multirate S-functions should observe for outputs are

- The output should not be written by a rate other than the rate assigned to the output port, except in the optimized case described below.
The output should always be written when the sample rate of the output port has a hit. If these conditions are met, the S-Function block can specify that the input port and output port can both be made local and reusable.

You can include an optimization when little or no processing needs to be done on the data. In such cases, the input rate code can directly write to the output (instead of by using DWork) when there is a special sample hit. If you do this, however, you must declare the output port to be global and not reusable. This optimization results in one less memcpy but does introduce nonuniform processing requirements on the faster rate.

Whether you use this optimization or not, the most recent input data, as seen by the slower rate, is the value when both the faster and slower rate had their hits (and possible earlier input data as well, depending on the algorithm). Subsequent steps by the faster rate and the associated input data updates are not seen by the slower rate until the next hit for the slow rate occurs.

**Pseudocode Examples of Fast-to-Slow Rate Transition**

The pseudocode below abstracts how you should write your C MEX code to handle fast-to-slow transitions, illustrating with an input rate of 0.1 second driving an output rate of one second. A similar approach can be taken when inlining the code. The block has following characteristics:

- **File:** sfun_multirate_zoh.c, Equation: \( y = u(t_{slow}) \)
- **Input:** local and reusable
- **Output:** local and reusable
- **DirectFeedthrough:** yes

```c
OutputFcn
if (ssIsSampleHit(".1")) {
    if (ssIsSepcialSampleHit("1")) {
        DWork = u;
    }
}
if (ssIsSampleHit("1")) {
    y = DWork;
}
```

An alternative, slightly optimized approach for simple algorithms:

- **Input:** local and reusable
- **Output:** global and not reusable because it needs to persist between special sample hits
Example adding a simple algorithm:

- File: sfun_multirate_avg.c; Equation: \( y = \text{average}(u) \)
- Input: local and reusable
- Output: local and reusable
- DirectFeedthrough: yes

(Assume DWork[0:10] and DWork[mycounter] are initialized to zero)

```java
OutputFcn
if (ssIsSampleHit(".1")) {
    if (ssIsSpecialSampleHit("1")) {
        y = u;
    }
}
```

```java
OutputFcn
if (ssIsSampleHit(".1")) {
    /* In general, processing on 'u' could be done here,
    it runs on every hit of the fast rate. */
    DWork[DWork[mycounter]++] = u;
    if (ssIsSpecialSampleHit("1")) {
        /* In general, processing on DWork[0:10] can be done
        here, but it does cause the faster rate to have
        nonuniform processing requirements (every 10th hit,
        more code needs to be run). */
        DWork[10] = sum(DWork[0:9])/10;
        DWork[mycounter] = 0;
    }
}
```

```java
if (ssIsSampleHit("1")) {
    /* Processing on DWork[10] can be done here before
    outputing. This code runs on every hit of the
    slower task. */
    y = DWork[10];
}
```

**Rules for Properly Handling Slow-to-Fast Transitions**

When output rates are faster than input rates, input should only be read at the rate that is associated with the input port sample time, observing the following rules:

- Always read input from the update function.
- Use no special sample hit checks when reading input.
- Write the input to a DWork.
• When there is a special sample hit between the rates, copy the DWork into a second DWork in the output function.
• Write the second DWork to the output at every hit of the output sample rate.

The block can request that the input port be made local but it cannot be set to reusable. The output port can be set to local and reusable.

As in the fast-to-slow transition case, the input should not be read by a rate other than the one assigned to the input port. Similarly, the output should not be written to at a rate other than the rate assigned to the output port.

An optimization can be made when the algorithm being implemented is only required to run at the slow rate. In such cases, you use only one DWork. The input still writes to the DWork in the update function. When there is a special sample hit between the rates, the output function copies the same DWork directly to the output. You must set the output port to be global and not reusable in this case. This optimization results in one less memcpy operation per special sample hit.

In either case, the data that the fast rate computations operate on is always delayed, that is, the data is from the previous step of the slow rate code.

**Pseudocode Examples of Slow-to-Fast Rate Transition**

The pseudocode below abstracts what your S-function needs to do to handle slow-to-fast transitions, illustrating with an input rate of one second driving an output rate of 0.1 second. The block has following characteristics:

• File: sfun_multirate_delay.c, Equation: \( y = u(t_{\text{slow}} - 1) \)
• Input: Set to local, will be local if output/update are combined (ERT) otherwise will be global. Set to not reusable because input needs to be preserved until the update function runs.
• Output: local and reusable
• DirectFeedthrough: no

```c
OutputFcn
if (ssIsSampleHit(".1")) {
    if (ssIsSpecialSampleHit("1")) {
        DWork[1] = DWork[0];
    }
    y = DWork[1];
}
UpdateFcn
if (ssIsSampleHit("1")) {
```
An alternative, optimized approach can be used by some algorithms:

- **Input**: Set to local, will be local if output/update are combined (ERT) otherwise will be global. Set to not reusable because input needs to be preserved until the update function runs.
- **Output**: global and not reusable because it needs to persist between special sample hits.
- **DirectFeedthrough**: no

```matlab
OutputFcn
if (ssIsSampleHit(".1") {  
  if (ssIsSpecialSampleHit("1") {  
    y = DWork;  
  }
}
```

```matlab
UpdateFcn
if (ssIsSampleHit("1") {  
  DWork = u;
}
```

Example adding a simple algorithm:

- **File**: `sfun_multirate_modulate.c`, **Equation**: \( y = \sin(t_{\text{fast}}) + u(t_{\text{slow}-1}) \)
- **Input**: Set to local, will be local if output/update are combined (an ERT feature) otherwise will be global. Set to not reusable because input needs to be preserved until the update function runs.
- **Output**: local and reusable
- **DirectFeedthrough**: no

```matlab
OutputFcn
if (ssIsSampleHit(".1") {  
  if (ssIsSpecialSampleHit("1") {  
    /* Processing not likely to be done here. It causes  
    * the faster rate to have nonuniform processing  
    * requirements (every 10th hit, more code needs to  
    * be run).*/  
    DWork[1] = DWork[0];  
  }  
  /* Processing done at fast rate */  
  y = \sin(ssGetTaskTime(".1")) + DWork[1];
}
```

```matlab
UpdateFcn
if (ssIsSampleHit("1") {  
  /* Processing on 'u' can be done here. There is a delay of  
  */
```
one slow rate period before the fast rate sees it.*/
DWork[0] = u;}

Write Noninlined S-Function

A noninlined S-function is a C or C++ MEX S-function that is treated identically by the Simulink engine and by the generated code. You implement your algorithm once according to the S-function API. The Simulink engine and generated code call the S-function routines (for example, mdlOutputs) during model execution.

Noninlined S-functions are identified by the absence of an sfunction.tlc file for your S-function. The file name varies depending on your platform. For example, on a 64-bit Microsoft Windows system, the file name is sfunction.mexw64. In the MATLAB Command Window, type mexext to see which extension your system uses.

Guidelines for Writing Noninlined S-Functions

• The MEX-file cannot call MATLAB functions.
• If the MEX-file uses functions in the MATLAB External Interface libraries, include the header file cg_sfun.h instead of mex.h or simulink.c. For the header file cg_sfun.h, at the end of your S-function, include these lines:

```c
#ifdef MATLAB_MEX_FILE /* Is this file being compiled as a MEX-file? */
#include "simulink.c" /* MEX-file interface mechanism */
#else
#include "cg_sfun.h" /* Code generation registration function */
#endif
```
• Use only the MATLAB API function that the code generator supports. The supported API functions are:
  • mxGetEps
  • mxGetInf
  • mxGetM
  • mxGetN
  • mxGetNaN
  • mxGetPr
  • mxGetScalar
  • mxGetString
  • mxIsEmpty
  • mxIsFinite
• `mxIsInf`
• MEX library calls are not supported in generated code. To use such calls in the MEX-file and not in the generated code, add the following condition:

```c
#ifdef MATLAB_MEX_FILE
#endif
```
• Use only full matrices that contain only real data.
• Do not specify a return value for calls to `mxGetString`. If you do specify a return value, the MEX-file does not compile. Instead, use the second input argument of the function, which returns a pointer to a character vector.
• Use the correct `#define s-function_name` statement. The S-function name that you specify must match the S-function file name.
• If possible, use the data types `real_T` and `int_T` instead of `double` and `int`. The data types `real_T` and `int_T` are more generic and can be used in multiple environments.
• Provide the build process with the names of the modules used to build the S-function. Use a template make file, the `set_param` function, or the S-function modules field of the S-Function block parameters dialog box. For example, suppose that you build your S-function with this command:

```c
mex sfun_main.c sfun_module1.c sfun_module2.c
```

You can then use the following call to `set_param` to include the required modules:

```c
set_param(sfun_block, "SFunctionModules", "sfun_module1 sfun_module2")
```

When you are ready to generate code, force the code generator to rebuild the top model. For more information, see “Control Regeneration of Top Model Code” on page 27-46.

### Noninlined S-Function Parameter Type Limitations

Parameters to noninlined S-functions can be of the following types only:

• Double precision
• Characters in scalars, vectors, or 2-D matrices

For more flexibility in the type of parameters that you can supply to S-functions or the operations in the S-function, inline your S-function and consider using an `mdlRTW` S-function routine.
Use of other functions from the MATLAB `matrix.h` API or other MATLAB APIs, such as `mex.h` and `mat.h`, are not supported. If you call unsupported APIs from an S-function source file, compiler errors occur. For details on supported MATLAB API functions, see the files `matlabroot/rtw/c/src/rt_matrix.h` and `matlabroot/rtw/c/src/rt_matrix.c`.

If you use `mxGetPr` on an empty matrix, the function does not return `NULL`. It returns a random value. Therefore, you must protect calls to `mxGetPr` by using `mxIsEmpty`.

**See Also**

**Related Examples**

- “Inlined and Noninlined S-Function Code”
- “S-Functions and Code Generation” on page 14-2
Write Wrapper S-Function and TLC Files

Create S-functions that work seamlessly with the Simulink and code generator products by using the wrapper concept. You can:

- Interface your algorithms in Simulink models by writing MEX S-function wrappers (`sfunction.mex`).
- Direct the code generator to insert your algorithm into the generated code by creating a TLC S-function wrapper (`sfunction.tlc`).

**MEX S-Function Wrapper**

Creating S-functions by using an S-function wrapper enables you to insert C/C++ code algorithms in Simulink models and the generated code with little or no change to your original C/C++ function. A MEX S-function wrapper is an S-function that calls code, which resides in another module.

**Note** Use a MEX S-function wrapper only in the MATLAB version in which you created the wrapper.

Suppose that you have an algorithm (that is, a C function) called `my_alg` that resides in the file `my_alg.c`. You can integrate `my_alg` into a Simulink model by creating a MEX S-function wrapper (for example, `wrapsfcn.c`). A Simulink model can then call `my_alg` from an S-Function block. The Simulink S-function contains a set of empty functions that the Simulink engine requires for various API related purposes. For example, although only `mdlOutputs` calls `my_alg`, the engine calls `mdlTerminate`, even though this S-function routine performs no action.

You can embed the call to `my_alg` in the generated code by creating a TLC S-function wrapper (for example, `wrapsfcn.tlc`). You can eliminate the empty function calls. You can avoid the overhead of executing the `mdlOutputs` function and you can then eliminate the `my_alg` function.

Wrapper S-functions are useful when you are creating algorithms that are procedural or when you are integrating legacy code into a Simulink model. If you want to create code that is:

- Interpretive in nature (that is, highly parameterized by operating modes)
• Heavily optimized (that is, no extra tests to decide what mode the code is operating in) then you must create a fully inlined TLC file for your S-function.

The next figure shows the wrapper S-function concept.

Using an S-function wrapper to import algorithms into your Simulink model means that the S-function serves as an interface that calls your C/C++ algorithms from `mdlOutputs`.
You can quickly integrate large standalone C/C++ programs into your model without having to change the code.

This sample model includes an S-function wrapper.

Two files are associated with the `wrapsfcn` block: the S-function wrapper and the C/C++ code that contains the algorithm. The first three statements:

1. Define the name of the S-function (what you enter in the Simulink S-Function block dialog box).
2. Specify that the S-function is using the level 2 format.
3. Provide access to the `SimStruct` data structure. `SimStruct` contains pointers to data used during simulation and code generation and defines macros that store data in and retrieve data from the `SimStruct`.

```c
#define S_FUNCTION_NAME wrapsfcn
#define S_FUNCTION_LEVEL 2
#include "simstruc.h"

extern real_T my_alg(real_T u); /* Declare my_alg as extern */

/* mdlInitializeSizes - initialize the sizes array */
static void mdlInitializeSizes(SimStruct *S)
{
    ssSetNumSFcnParams( S, 0); /*number of input arguments*/

    if (!ssSetNumInputPorts(S, 1)) return;
    ssSetInputPortWidth(S, 0, 1);
    ssSetInputPortDirectFeedThrough(S, 0, 1);

    if (!ssSetNumOutputPorts(S,1)) return;
    ssSetOutputPortWidth(S, 0, 1);
    ssSetNumSampleTimes( S, 1);
}
function mdlInitializeSampleTimes(SimStruct *S)
{
    ssSetSampleTime(S, 0, INHERITED_SAMPLE_TIME);
    ssSetOffsetTime(S, 0, 0.0);
}

function mdlOutputs(SimStruct *S, int_T tid)
{
    InputRealPtrsType uPtrs = ssGetInputPortRealSignalPtrs(S,0);
    real_T *y = ssGetOutputPortRealSignal(S,0);
    *y = my_alg(*uPtrs[0]); /* Call my_alg in mdlOutputs */
}

function mdlTerminate(SimStruct *S)
{
}

For more information, see “Templates for C S-Functions” (Simulink).

The S-function routine mdlOutputs contains a function call to my_alg, which is the C function containing the algorithm that the S-function performs. For my_alg.c, the code is:

```c
#include "tmwtypes.h"
else
#include "rtwtypes.h"
endif
real_T my_alg(real_T u)
{
    return(u * 2.0);
}
```

For more information, see “Manage Build Process File Dependencies” on page 21-53.
The wrapper S-function \texttt{wrapsfcn} calls \texttt{my\_alg}, which computes \texttt{u \ast 2.0}. To build \texttt{wrapsfcn.mex}, use this command:

\texttt{mex \texttt{wrapsfcn.c \texttt{my\_alg.c}}}

\section*{TLC S-Function Wrapper}

A TLC S-function wrapper is a TLC file that specifies how the code generator calls your code. For example, you can inline the call to \texttt{my\_alg} in the \texttt{mdlOutputs} section of the generated code. In the “MEX S-Function Wrapper” on page 14-110 example, the call to \texttt{my\_alg} is embedded in the \texttt{mdlOutputs} section as:

\begin{verbatim}
*y = my_alg(*uPtrs[0]);
\end{verbatim}

When you are creating a TLC S-function wrapper, the goal is to embed the same type of call in the generated code.

Look at how the code generator executes S-functions that are not inlined. A noninlined S-function is identified by the absence of the file \texttt{sfunction.tlc} and the existence of \texttt{sfunction.mex}. When generating code for a noninlined S-function, the code generator produces a call to \texttt{mdlOutputs} through a function pointer that, in this example, then calls \texttt{my\_alg}.

The wrapper example contains one S-function, \texttt{wrapsfcn.mex}. You must compile and link an additional module, \texttt{my\_alg}, with the generated code. At the MATLAB command prompt, enter:

\texttt{set_param('wrapper/S-Function','SFunctionModules','my\_alg')}

\section*{Code Overhead for Noninlined S-Functions}

The code generated when using \texttt{grt.tlc} as the system target file \textit{without} \texttt{wrapsfcn.tlc} is:

\begin{verbatim}
<Generated code comments for wrapper model with noninlined \texttt{wrapsfcn} S-function>

#include <math.h>
#include <string.h>
#include "wrapper.h"
#include "wrapper.prm"

/* Start the model */
void mdlStart(void)
{
  /* (start code not required) */
\end{verbatim}
Write Wrapper S-Function and TLC Files

The `wrapper.reg` generated file contains the initialization of the SimStruct for the wrapper S-Function block. There is one child SimStruct for each S-Function block in your model. You can significantly reduce this overhead by creating a TLC wrapper for the S-function.
Inline a Wrapper S-Function

The generated code makes the call to your S-function, \texttt{wrapsfcn.c}, in \texttt{mdlOutputs} by using this code:

\begin{verbatim}
SimStruct *rts = ssGetSFunction(rtS, 0);
sfcnOutputs(rts, tid);
\end{verbatim}

This call has computational overhead associated with it. The Simulink engine creates a \texttt{SimStruct} data structure for the S-Function block. The code generator constructs a call through a function pointer to execute \texttt{mdlOutputs}, then \texttt{mdlOutputs} calls \texttt{my_alg}. By inlining the call to your C/C++ algorithm, \texttt{my_alg}, you can eliminate both the \texttt{SimStruct} and the extra function call, thereby improving the efficiency and reducing the size of the generated code.

Inlining a wrapper S-function requires an \texttt{sfunction.tlc} file for the S-function. The TLC file must contain the function call to \texttt{my_alg}. The figure shows the relationships between the algorithm, the wrapper S-function, and the \texttt{sfunction.tlc} file.

The \texttt{wrapsfcn.tlc} file tells Simulink Coder how to inline the call to \texttt{my_alg} using this statement.

\begin{verbatim}
wrapsfcn.tlc
     ...<y> = my_alg(<u>);
     ...
\end{verbatim}

To inline the call to \texttt{my_alg}, place your function call in an \texttt{sfunction.tlc} file with the same name as the S-function (in this example, \texttt{wrapsfcn.tlc}). The Target Language Compiler overrides the default method of placing calls to your S-function in the generated code.

This code is the TLC file \texttt{wrapsfcn.tlc} that inlines \texttt{wrapsfcn.c}:

\begin{verbatim}
%% File     : wrapsfcn.tlc
%% Abstract:
%%      Example inlined tlc file for S-function wrapsfcn.c
\end{verbatim}
The first section of this code inlines the \texttt{wrapsfcn} S-Function block and generates the code in C:

\%implements "wrapsfcn" "C"

The next task is to inform the code generator that the routine \texttt{my\_alg} must be declared as external in the generated \texttt{wrapper.h} file for any \texttt{wrapsfcn} S-Function blocks in the model. Do this declaration once for all \texttt{wrapsfcn} S-Function blocks by using the \texttt{BlockTypeSetup} function. In this function, you direct the Target Language Compiler to create a buffer and cache the \texttt{my\_alg} as \texttt{extern} in the \texttt{wrapper.h} generated header file.

The final step is the inlining of the call to the function \texttt{my\_alg}. The \texttt{Outputs} function inlines the call. In this function, you access the block input and output and place a direct call to \texttt{my\_alg}. The call is embedded in \texttt{wrapper.c}.

\textbf{The Inlined Code}

The code generated when you inline your wrapper S-function is similar to the default generated code. The \texttt{mdlTerminate} function does not contain a call to an empty function and the \texttt{mdlOutputs} function now directly calls \texttt{my\_alg}.
void mdlOutputs(int_T tid)
{
    /* Sin Block: <Root>/Sin */
    rtB.Sin = rtP.Sin.Amplitude * sin(rtP.Sin.Frequency * ssGetT(rtS) + rtP.Sin.Phase);

    /* S-Function Block: <Root>/S-Function */
    rtB.S_Function = my_alg(rtB.Sin); /* Inlined call to my_alg */

    /* Outport Block: <Root>/Out */
    rtY.Out = rtB.S_Function;
}

wrapper.reg does not create a child SimStruct for the S-function because the generated code is calling my_alg directly, eliminating over 1 KB of memory usage.

See Also

Related Examples

- “Write Noninlined S-Function” on page 14-107
- “Write Fully Inlined S-Functions” on page 14-119
Write Fully Inlined S-Functions

A fully inlined S-function builds your algorithm (block) into generated code that you cannot distinguish from a built-in block. Typically, a fully inlined S-function requires you to implement your algorithm twice: once for the Simulink model (C/C++ MEX S-function) and once for code generation (TLC file).

Using the example in “Write Wrapper S-Function and TLC Files” on page 14-110, you can eliminate the call to \( \text{my\_alg} \) entirely by specifying the explicit code (that is, \( 2.0 \times u \)) in \text{wrapsfcn.tlc}. While this can improve performance, if you are working with a large amount of C/C++ code, the task can be lengthy. You also have to maintain your algorithm in two places, the C/C++ S-function itself and the corresponding TLC file. Consider whether the performance gains might outweigh the disadvantages. To inline the algorithm used in this example, in the Outputs section of your \text{wrapsfcn.tlc} file, instead of writing:

\[
\%y = \text{my\_alg}(\%u);
\]

Use:

\[
\%y = 2.0 \times \%u;
\]

This code is the code produced in \text{mdlOutputs}:

```c
void mdlOutputs(int_T tid)
{
    /* Sin Block: \(<\text{Root}>\)/Sin */
    rtB.Sin = rtP.Sin.Amplitude * 
        \text{\( \sin(\text{rtP.Sin.Frequency} \times \text{ssGetT(rtS)} + \text{rtP.Sin.Phase}) \)};

    /* S-Function Block: \(<\text{Root}>\)/S-Function */
    rtB.S_Function = 2.0 * rtB.Sin; /* Explicit embedding of algorithm */

    /* Outport Block: \(<\text{Root}>\)/Out */
    rtY.Out = rtB.S_Function;
}
```

The Target Language Compiler replaces the call to \( \text{my\_alg} \) with the algorithm itself.

Multiport S-Function

A more advanced multiport inlined S-function example is \text{sfun\_multiport.c} and \text{sfun\_multiport.tlc}. This S-function illustrates how to create a fully inlined TLC file for an S-function that contains multiple ports.
Guidelines for Writing Inlined S-Functions

- Consider using the block property RTWdata (see “S-Function RTWdata” on page 14-121). This property is a structure of character vectors that you can associate with a block. The code generator saves the structure with the model in the model.rtw file and makes the .rtw file more readable. For example in the MATLAB Command Window, suppose you enter these commands:

```matlab
mydata.field1 = 'information for field1';
mydata.field2 = 'information for field2';
set_param(sfun_block, 'RTWdata', mydata);
```

The .rtw file that the code generator produces for the block includes the comments specified in the structure mydata.

- Consider using the mdlRTW function to inline your C MEX S-function in the generated code for:
  - Renaming tunable parameters in the generated code.
  - Introducing non-tunable parameters into a TLC file.

See Also

Related Examples

- “Write Fully Inlined S-Functions with mdlRTW Routine” on page 14-121
Write Fully Inlined S-Functions with mdlRTW Routine

You can inline more complex S-functions by using the S-function mdlRTW routine. The mdlRTW routine provides the code generation process with more information about how the S-function is to be inlined by creating a parameter record of a non-tunable parameter for use with a TLC file. The mdlRTW routine places information in the model.rtw file. The mdlRTW function is described in the text file matlabroot/simulink/src/sfuntmpl_doc.c.

To use the mdlRTW function, take steps to create a direct-index lookup S-function. Lookup tables are collections of ordered data points of a function. Typically, these tables use some interpolation scheme to approximate values of the associated function between known data points. To incorporate the example lookup table algorithm into a Simulink model, the first step is to write an S-function that executes the algorithm in mdlOutputs. To produce the most efficient code, the next step is to create a corresponding TLC file to eliminate computational overhead and improve the speed of the lookup computations.

The Simulink product provides support for two general-purpose lookup 1-D and 2-D algorithms. You can use these algorithms as they are or create a custom lookup table S-function to fit your requirements. You can create a 1-D lookup S-function, sfun_directlook.c, and its corresponding inlined sfun_directlook.tlc file (see “Target Language Compiler” for more details). You can:

- Error check of S-function parameters.
- Cache information for the S-function that does not change during model execution.
- Use the mdlRTW function to customize the code generator to produce the optimal code for a given set of block parameters.
- Create a TLC file for an S-function that either fully inlines the lookup table code or calls a wrapper function for the lookup table algorithm.

S-Function RTWdata

RTWdata is a property of blocks, which can be used by the Target Language Compiler when inlining an S-function. RTWdata is a structure of character vectors that you can attach to a block. RTWdata is saved with the model and placed in the model.rtw file when you generate code. For example, this set of MATLAB commands:

```matlab
mydata.field1 = 'information for field1';
mydata.field2 = 'information for field2';
set_param(gcb,'RTWdata',mydata);
get_param(gcb,'RTWdata')
```
produces this result:

```matlab
ans =
    field1: 'information for field1'
    field2: 'information for field2'
```

The information for the associated S-Function block inside the `model.rtw` file is:

```matlab
Block {
    Type                    "S-Function"
    RTWdata {
        field1                  "information for field1"
        field2                  "information for field2"
    }
}
```

**Note** `RTWdata` is saved in the model file for S-functions that are not linked to a library. However, `RTWdata` is **not persistent** for S-Function blocks that are linked to a library.

**Direct-Index Lookup Table Algorithm**

The 1-D lookup table block provided in the Simulink library uses interpolation or extrapolation when computing outputs. In this example, you create a lookup table that directly indexes the output vector (y-data vector) based on the current input (x-data) point.

This direct 1-D lookup example computes an approximate solution \( p(x) \) to a partially known function \( f(x) \) at \( x=x_0 \), given data point pairs \( (x,y) \) in the form of an x-data vector and a y-data vector. For a given data pair (for example, the \( i^{th} \) pair), \( y_i = f(x_i) \). It is assumed that the x-data values are monotonically increasing. If \( x_0 \) is outside the range of the x-data vector, the first or last point is returned.

The parameters to the S-function are:

`XData, YData, XEvenlySpaced`

`XData` and `YData` are double vectors of equal length representing the values of the unknown function. `XDataEvenlySpaced` is a scalar, 0.0 for false and 1.0 for true. If the `XData` vector is evenly spaced, `XDataEvenlySpaced` is 1.0 and more efficient code is generated.

The graph shows how the parameters `XData=[1:6]` and `YData=[1,2,7,4,5,9]` are handled. For example, if the input (x-value) to the S-Function block is 3, the output (y-value) is 7.
**Direct-Index Lookup Table Example**

Improve the lookup table by inlining a direct-index S-function with a TLC file. This direct-index lookup table S-function does not require a TLC file. The example uses a TLC file for the direct-index lookup table S-function to reduce the code size and increase efficiency of the generated code.

Implementation of the direct-index algorithm with an inlined TLC file requires the S-function main module, `sfunk_directlook.c` and a corresponding `lookup_index.c` module. The `lookup_index.c` module contains the `GetDirectLookupIndex` function.
that is used to locate the index in the XData for the current x input value when the XData is unevenly spaced. The GetDirectLookupIndex routine is called from the S-function and the generated code. The example uses the wrapper concept for sharing C/C++ code between Simulink MEX-files and the generated code.

If the XData is evenly spaced, then both the S-function main module and the generated code contain the lookup algorithm to compute the y-value of a given x-value because the algorithm is short.

The inlined TLC file is sfun_directlook.tlc, which is used to either perform a wrapper call or embed the optimal C/C++ code for the S-function. (See the example in “mdlRTW Usage” on page 14-125).

**Error Handling**

In sfun_directlook.tlc, the mdlCheckParameters routine verifies that:

- The new parameter settings are valid.
- XData and YData are vectors of the same length containing real, finite numbers.
- XDataEvenlySpaced is a scalar.
- The XData vector is a monotonically increasing vector and evenly spaced.

The mdlInitializeSizes function explicitly calls mdlCheckParameters after it verifies the number of parameters passed to the S-function. After the Simulink engine calls mdlInitializeSizes, it then calls mdlCheckParameters whenever you change the parameters or reevaluate them.

**User Data Caching**

In sfun_directlook.tlc, the mdlStart routine shows how to cache information that does not change during the simulation or while the generated code is executing. The example caches the value of the XDataEvenlySpaced parameter in UserData, a field of the SimStruct. The following line in mdlInitializeSizes instructs the Simulink engine to disallow changes to XDataEvenlySpaced.

```c
ssSetSFcnParamTunable(S, iParam, SS_PRM_NOT_TUNABLE);
```

During execution, mdlOutputs accesses the value of XDataEvenlySpaced from UserData rather than calling the mxGetPr MATLAB API function.
**mdlRTW Usage**

The code generator calls the `mdlRTW` routine while generating the `model.rtw` file. To produce optimal code for your Simulink model, you can add information to the `model.rtw` file about the mode in which your S-Function block is operating.

The example adds parameter settings to the `model.rtw` file. The parameter settings do not change during execution. In this case, the `XDataEvenlySpaced` S-function parameter cannot change during execution (`ssSetSFCnParamTunable` was specified as false (0) for it in `mdlInitializeSizes`). The parameter setting (`XSpacing`) uses the function `ssWriteRTWParamSettings`.

Because `xData` and `yData` are registered as run-time parameters in `mdlSetWorkWidths`, the code generator writes to the `model.rtw` file automatically.

Before examining the S-function and the inlined TLC file, consider the generated code for this model.

```
set_param('sfun_directlook_ex/S-Function','SFunctionModules','lookup_index')
set_param('sfun_directlook_ex/S-Function1','SFunctionModules','lookup_index')
```

The build process uses the module `lookup_index.c` when creating the executable.
When generating code for this model, the code generator uses the S-function `mdlRTW` method to generate a `model.rtw` file with the value `EvenlySpaced` for the XSpacing parameter for the top S-Function block and the value `UnEvenlySpaced` for the XSpacing parameter for the bottom S-Function block. The TLC-file uses the value of XSpacing to determine what algorithm to include in the generated code. The generated code contains the lookup algorithm when the XData is evenly spaced, but calls the `GetDirectLookupIndex` routine when the XData is unevenly spaced. The generated `model.c` or `model.cpp` code for the lookup table example model is similar to this code:

```c
/*
 * sfun_directlook_ex.c
 *
 * Code generation for Simulink model
 * "sfun_directlook_ex.slx".
 *
 ... */

#include "sfun_directlook_ex.h"
#include "sfun_directlook_ex_private.h"

/* External outputs (root outports fed by signals with auto storage) */
ExtY_sfun_directlook_ex_T sfun_directlook_ex_Y;

/* Real-time model */
RT_MODEL_sfun_directlook_ex_T sfun_directlook_ex_M;
RT_MODEL_sfun_directlook_ex_T *const sfun_directlook_ex_M = &sfun_directlook_ex_M;

/* Model output function */
void sfun_directlook_ex_output(void)
{
    /* local block i/o variables */
    real_T rtb_SFunction;
    real_T rtb_SFunction1;

    /* Sin: '<Root>/Sine Wave' */
    rtb_SFunction1 = sin(sfun_directlook_ex_M->Timing.t[0]);

    /* Code that is inlined for the top S-function block in the */
    /* sfun_directlook_ex model */
    /* */
    /* S-Function (sfun_directlook): '<Root>/S-Function' */
    {
        const real_T *xData = sfun_directlook_ex_ConstP.SFunction_XData;
        const real_T *yData = sfun_directlook_ex_ConstP.SFunction_YData;
        real_T spacing = xData[1] - xData[0];
        if (rtb_SFunction1 <= xData[0] ) {
            rtb_SFunction = yData[0];
        } else if (rtb_SFunction1 >= yData[20] ) {
            rtb_SFunction = yData[20];
        } else {
            int_T idx = (int_T)( ( rtb_SFunction1 - xData[0] ) / spacing );
        }
    }

    /* Code that is inlined for the bottom S-function block in the */
    /* sfun_directlook_ex model */
    /* */
    /* S-Function (sfun_directlook): '<Root>/S-Function' */
    {
        const real_T *xData = sfun_directlook_ex_ConstP.SFunction_XData;
        const real_T *yData = sfun_directlook_ex_ConstP.SFunction_YData;
        real_T spacing = xData[1] - xData[0];
        if (rtb_SFunction1 <= xData[0] ) {
            rtb_SFunction = yData[0];
        } else if (rtb_SFunction1 >= yData[20] ) {
            rtb_SFunction = yData[20];
        } else {
            int_T idx = (int_T)( ( rtb_SFunction1 - xData[0] ) / spacing );
        }
    }
```
rtb_SFunction = yData[idx];
}

/* Outport: '<Root>/Out1' */
sfun_directlook_ex_Y.Out1 = rtb_SFunction;

/* Code that is inlined for the bottom S-function block in the
 * sfun_directlook_ex model */
/* S-Function (sfun_directlook): '<Root>/S-Function1' */
{
  const real_T *xData = sfun_directlook_ex_ConstP.SFunction1_XData;
  const real_T *yData = sfun_directlook_ex_ConstP.SFunction1_YData;
  int_T idx;
  idx = GetDirectLookupIndex(xData, 5, rtb_SFunction1);
  rtb_SFunction1 = yData[idx];
}

/* Outport: '<Root>/Out2' */
sfun_directlook_ex_Y.Out2 = rtb_SFunction1;

/* Model update function */
void sfun_directlook_ex_update(void)
{
  /* signal main to stop simulation */
  { /* Sample time: [0.0s, 0.0s] */
    if (((rtmGetTFinal(sfun_directlook_ex_M)!=-1) &&
        !((rtmGetTFinal(sfun_directlook_ex_M)-sfun_directlook_ex_M->Timing.t[0])
        > sfun_directlook_ex_M->Timing.t[0] * (DBL_EPSILON)))
      
        rtmSetErrorStatus(sfun_directlook_ex_M, "Simulation finished");
    }
  }

  /* Update absolute time for base rate */
  /* The "clockTick0" counts the number of times the code of this task has
   * been executed. The absolute time is the multiplication of "clockTick0"
   * and "Timing.stepSize0". Size of "clockTick0" ensures timer will not
   * overflow during the application lifespan selected.
   * Timer of this task consists of two 32 bit unsigned integers.
   * The two integers represent the low bits Timing.clockTick0 and the high bits
   * Timing.clockTickH0. When the low bit overflows to 0, the high bits increment.
   */
  if (![++sfun_directlook_ex_M->Timing.clockTick0])
    ++sfun_directlook_ex_M->Timing.clockTickH0;

  sfun_directlook_ex_M->Timing.t[0] = sfun_directlook_ex_M->Timing.clockTick0 *
      sfun_directlook_ex_M->Timing.stepSize0 +
      sfun_directlook_ex_M->Timing.clockTickH0 *
      sfun_directlook_ex_M->Timing.stepSize0 * 4294967296.0;
}

See Also

Related Examples

• “Write Fully Inlined S-Functions” on page 14-119
Data, Function, and File Definition
Data Representation in Simulink Coder

- “Configure Data Accessibility for Rapid Prototyping” on page 15-3
- “Access Signal, State, and Parameter Data During Execution” on page 15-7
- “Standard Data Structures in the Generated Code” on page 15-26
- “Use the Real-Time Model Data Structure” on page 15-29
- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “Control Data and Function Interface in Generated Code” on page 15-42
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
- “Choose Storage Class for Controlling Data Representation in Generated Code” on page 15-69
- “Use Storage Classes in Reentrant, Multi-Instance Models and Components” on page 15-80
- “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82
- “Use Enumerated Data in Generated Code” on page 15-91
- “Data Stores in Generated Code” on page 15-101
- “Specify Single-Precision Data Type for Embedded Application” on page 15-112
- “Tune Phase Parameter of Sine Wave Block During Code Execution” on page 15-116
- “Switch Between Output Waveforms During Code Execution for Waveform Generator Block” on page 15-118
- “Create Tunable Calibration Parameter in the Generated Code” on page 15-122
- “Limitations for Block Parameter Tunability in the Generated Code” on page 15-136
- “Code Generation of Parameter Objects With Expression Values” on page 15-140
- “Specify Instance-Specific Parameter Values for Reusable Referenced Model” on page 15-143
- “Parameter Data Types in the Generated Code” on page 15-157
• “Generate Efficient Code by Specifying Data Types for Block Parameters” on page 15-163
• “Reuse Parameter Data in Different Data Type Contexts” on page 15-173
• “Organize Data into Structures in Generated Code” on page 15-177
• “Switch Between Sets of Parameter Values During Simulation and Code Execution” on page 15-197
• “Design Data Interface by Configuring Inport and Outport Blocks” on page 15-207
• “Generate Efficient Code for Bus Signals” on page 15-213
• “Control Signal and State Initialization in the Generated Code” on page 15-217
• “Initialization of Signal, State, and Parameter Data in the Generated Code” on page 15-229
• “Optimize Speed and Size of Signal Processing Algorithm by Using Fixed-Point Data” on page 15-240
• “Optimize Generated Code Using Fixed-Point Data with Simulink®, Stateflow®, and MATLAB®” on page 15-242
• “Declare Workspace Variables as Tunable Parameters Using the Model Parameter Configuration Dialog Box” on page 15-244
• “Share Data Between Code Generated from Simulink, Stateflow, and MATLAB” on page 15-248
Configure Data Accessibility for Rapid Prototyping

As you iteratively develop a model, you capture the values of signals and states that model execution generates. You also tune parameter values during execution to observe the effect on the signals and states. You can then base your design decisions upon analysis of these outputs. To access signal, state, and parameter data in a rapid prototyping environment, you can configure the generated code to store the data in addressable memory.

Depending on the system target file that you use (such as grt.tlc), by default, optimization settings can make the generated code more efficient by:

- Eliminating unnecessary global and local storage for signals and some states.

  However, the optimizations do not eliminate storage for root-level Inport and Outport blocks, which represent the primary inputs and outputs of a system. To access this data, you do not need to take optimizations into consideration.

- Inlining the numeric values of block parameters. The code does not store the parameters in memory, so you cannot interact with the parameters during code execution.

To generate code that instead allocates addressable memory for this data, you can disable the optimizations, or override the optimizations by specifying code generation settings for individual data items.

Access Signal, State, and Parameter Data During Execution

For an example that shows how to configure data accessibility for rapid prototyping, see “Access Signal, State, and Parameter Data During Execution” on page 15-7.
## Configure Data Accessibility

<table>
<thead>
<tr>
<th>Goal</th>
<th>Considerations and More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure signals as accessible and parameters as tunable by default</td>
<td>Clear the model configuration parameter <strong>Signal storage reuse</strong> and set the configuration parameter <strong>Default parameter behavior</strong> to Tunable. These settings prevent the elimination of storage for signals and prevent parameter inlining. Each block parameter and signal line appears in the generated code as a field of a structure. For more information about these data structures, see “How Generated Code Exchanges Data with an Environment” on page 15-33 and “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50. For more information about <strong>Default parameter behavior</strong>, see “Default parameter behavior”. For more information about optimizations that eliminate storage for signals, see “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50 and “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 33-41.</td>
</tr>
</tbody>
</table>
| Preserve accessibility and tunability of a data item after you select optimizations | You can generate more efficient code by selecting optimizations such as **Signal storage reuse**, but the code generator eliminates storage for as many data items as possible. To exclude individual data items from the optimizations:  
  - Configure a signal as a test point (see “Configure Signals as Test Points“ (Simulink)) or apply a storage class such as ExportedGlobal to the signal (see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82). If you use test points, when you later configure the model for efficient production code, you can subject all of the test-point signals to optimizations by selecting the model configuration parameter **Ignore test point signals**. Apply a storage class only when you need to control the representation of the signal in the code.  
  - Apply a storage class, such as ExportedGlobal, to states and parameters. See “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82. |
<table>
<thead>
<tr>
<th>Goal</th>
<th>Considerations and More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Represent a data item as a separate global variable in the generated code</td>
<td>When you disable optimizations, signal lines, block states, and parameters appear in the generated code as fields of structures. You cannot control the names of the structures without Embedded Coder. To instead store a data item in a separate global variable whose name, file placement, and other characteristics you can control, apply a storage class to a signal, state, or Simulink.Parameter object. See “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82.</td>
</tr>
<tr>
<td>Generate a standardized C-code interface for accessing data</td>
<td>You can configure the generated code to contain extra code and files so that you can access model data through standardized interfaces. For more information, see “Exchange Data Between Generated and External Code Using C API” on page 30-2.</td>
</tr>
<tr>
<td>Tune parameters and monitor signals during external mode simulation</td>
<td>When you generate code and an external executable from a model, you can simulate the model in external mode to communicate with the running executable. You can tune parameters and monitor signals during the simulation. However, in this simulation mode, parameter tunability limitations that apply to code generation also apply to the simulation. For information about the code generation limitations, see “Limitations for Block Parameter Tunability in the Generated Code” on page 15-136. For information about external mode, see “Host-Target Communication with External Mode Simulation” on page 28-2.</td>
</tr>
<tr>
<td>Tune parameters and monitor signals with Simulink Real-Time</td>
<td>If you have Simulink Real-Time, you can tune parameters and monitor signals during execution of your real-time application. Make signals accessible and parameters tunable by clearing optimizations and applying test points and storage classes. See “Parameter Tuning with Simulink Real-Time Explorer” (Simulink Real-Time).</td>
</tr>
</tbody>
</table>

**Limitations**

For information about limitations that apply to the tunability of parameters in the generated code, see “Limitations for Block Parameter Tunability in the Generated Code” on page 15-136.
See Also

Related Examples

- “Deploy Algorithm Model for Real-Time Rapid Prototyping” on page 25-2
- “Access Signal, State, and Parameter Data During Execution” on page 15-7
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
- “Create Tunable Calibration Parameter in the Generated Code” on page 15-122
- “Switch Between Sets of Parameter Values During Simulation and Code Execution” on page 15-197
Access Signal, State, and Parameter Data During Execution

As you iteratively develop a model, you capture output signal and state data that model execution generates. You also tune parameter values during execution to observe the effect on the outputs. You can then base your design decisions upon analysis of these outputs. To access this signal, state, and parameter data in a rapid prototyping environment, you can configure the generated code to store the data in addressable memory.

By default, optimization settings make the generated code more efficient by eliminating unnecessary signal storage and inlining the numeric values of block parameters. To generate code that instead allocates addressable memory for this data, you can disable the optimizations or specify code generation settings for individual data items.

Explore Example Model

Run a script that prepares the model rtwdemo_basicsc for this example.

```matlab
run(fullfile(matlabroot,'examples','simulinkcoder','main','prepare_rtwdemo_basicsc'));
```

Open the example model, rtwdemo_basicsc.

```matlab
rtwdemo_basicsc
```
The model loads numeric MATLAB variables into the base workspace. The workspace variables set some block parameters in the model. However, the Gain block in the model uses the literal value 2.

**Disable Optimizations**

In the model, clear the model configuration parameter Signal storage reuse. When you clear this optimization and other optimizations such as Eliminate superfluous local variables (expression folding), the generated code allocates memory for signal lines. Clearing Signal storage reuse disables most of the other optimizations.

```matlab
set_param('rtwdemo_basicsc','OptimizeBlockIOStorage','off')
```

Set the optimization Configuration Parameters > Optimization > Default parameter behavior to Tunable. When set to Tunable, this configuration parameter causes the generated code to allocate memory for block parameters and workspace variables.

```matlab
set_param('rtwdemo_basicsc','DefaultParameterBehavior','Tunable')
```

Generate code from the model.
rtwbuild('rtwdemo_basicsc')

### Starting build procedure for model: rtwdemo_basicsc
### Successful completion of build procedure for model: rtwdemo_basicsc

In the code generation report, view the file `rtwdemo_basicsc.h`. This header file defines a structure type that contains signal data. The structure contains fields that each represent a signal line in the model. For example, the output signal of the Gain block, whose name is `Gain`, appears as the field `Gain`.

```c
file = fullfile('rtwdemo_basicsc_grt_rtw','rtwdemo_basicsc.h');
rtwdemodbtype(file,'/* Block signals (default storage) */','B_rtwdemo_basicsc_T;',1,1)

/* Block signals (default storage) */
typedef struct {
    real32_T Table1;                     /* '<Root>/Table1' */
    real32_T Gain;                       /* '<Root>/Gain' */
    real32_T Delay;                      /* '<Root>/Delay' */
    real32_T Table2;                     /* '<Root>/Table2' */
    boolean_T RelOp1;                    /* '<Root>/RelOp1' */
    boolean_T RelOp2;                    /* '<Root>/RelOp2' */
    boolean_T LogOp;                     /* '<Root>/LogOp' */
} B_rtwdemo_basicsc_T;
```

The file defines a structure type that contains block parameter data. For example, the `Gain` parameter of the Gain block appears as the field `Gain_Gain`. The other fields of the structure represent other block parameters and workspace variables from the model, including initial conditions for signals and states.

```c
rtwdemodbtype(file,'/* Parameters (default storage) */','/* Real-time Model Data Structure */',1,0)

/* Parameters (default storage) */
struct P_rtwdemo_basicsc_T_ {
    real_T K2;                           /* Variable: K2
     * Referenced by: '<Root>/Stateflow Chart'
     */
    real32_T LOWER;                      /* Variable: LOWER
     * Referenced by: '<Root>/Constant2'
     */
    real32_T T1Break[11];                /* Variable: T1Break
     * Referenced by: '<Root>/Table1'
```

15-9
View the file `rtwdemo_basicsc_data.c`. This source file allocates global memory for a parameter structure and initializes the field values based on the parameter values in the model.

View the source file `rtwdemo_basicsc.c`. The code allocates global memory for a structure variable that contains signal data.

```c
real32_T T1Data[11];  /* Variable: T1Data */
  * Referenced by: '<Root>/Table1'
*/
real32_T T2Break[3];  /* Variable: T2Break */
  * Referenced by: '<Root>/Table2'
*/
real32_T T2Data[9];  /* Variable: T2Data */
  * Referenced by: '<Root>/Table2'
*/
real32_T UPPER;  /* Variable: UPPER */
  * Referenced by: '<Root>/Constant1'
*/
real32_T Gain_Gain;  /* Computed Parameter: Gain_Gain */
  * Referenced by: '<Root>/Gain'
*/
real32_T Delay_InitialCondition;  /* Computed Parameter: Delay_InitialCondition */
  * Referenced by: '<Root>/Delay'
*/
uint32_T Table2_maxIndex[2];  /* Computed Parameter: Table2_maxIndex */
  * Referenced by: '<Root>/Table2'
*/
boolean_T DataStoreMemory_InitialValue;  /* Computed Parameter: DataStoreMemory_InitialValue */
  * Referenced by: '<Root>/Data Store Memory'
*/

View the source file `rtwdemo_basicsc.c`. The code allocates global memory for a structure variable that contains signal data.

```c
file = fullfile('rtwdemo_basicsc_grt_rtw','rtwdemo_basicsc.c');
rtwdemodbtype(file,'/* Block signals (default storage) */',...
  'B_rtwdemo_basicsc_T rtwdemo_basicsc_B;',1,1)

/* Block signals (default storage) */
B_rtwdemo_basicsc_T rtwdemo_basicsc_B;
```

The code algorithm in the model `step` function calculates the signal values. It then assigns these values to the fields of the signal structure. To perform the calculations, the algorithm uses the parameter values from the fields of the parameter structure.
Exclude Data Items from Optimizations

When you want to select code generation optimizations such as Signal storage reuse, you can preserve individual data items from the optimizations. The generated code then allocates addressable memory for the items.

Select the optimizations that you previously cleared.

```matlab
set_param('rtwdemo_basicsc','OptimizeBlockI0Storage','on')
set_param('rtwdemo_basicsc','LocalBlockOutputs','on')
set_param('rtwdemo_basicsc','DefaultParameterBehavior','Inlined')
```

In the model, select View > Model Data Editor.

In the Model Data Editor, inspect the Signals tab.

Set the Change view drop-down list to Instrumentation.

In the model, select the output signal of the Gain block.

In the Model Data Editor, select the check box in the Test Point column.

```matlab
portHandle = get_param('rtwdemo_basicsc/Gain','PortHandles');
portHandle = portHandle.Outport;
set_param(portHandle,'TestPoint','on')
```

Inspect the Parameters tab.

In the model, select the Gain block.

In the Model Data Editor, use the Value column to set the gain value to \( K_1 \).

Next to \( K_1 \), click the action button (with three vertical dots) and select Create.

In the Create New Data dialog box, set Value to `Simulink.Parameter(2)` and click Create. A `Simulink.Parameter` object named \( K_1 \), with value 2, appears in the base workspace.

In the property dialog box for \( K_1 \), apply a storage class other than Auto by using Storage class. For example, use the storage class `Model default` to represent the parameter object as a field of the global parameters structure.
set_param('rtwdemo_basicsc/Gain','Gain','K1');
K1 = Simulink.Parameter(2);
K1.StorageClass = 'Model default';

Generate code from the model.

rtwbuild('rtwdemo_basicsc')

### Starting build procedure for model: rtwdemo_basicsc
### Successful completion of build procedure for model: rtwdemo_basicsc

In the code generation report, view the file rtwdemo_basicsc.h. The structure that contains signal data now defines only one field, Gain, which represents the test-pointed output of the Gain block.

file = fullfile('rtwdemo_basicsc_grt_rtw','rtwdemo_basicsc.h');
rtwdemodbtype(file,'/* Block signals (default storage) */',...
 'B_rtwdemo_basicsc_T;',1,1)

/* Block signals (default storage) */
typedef struct {
   real32_T Gain;                        /* '<Root>/Gain' */
} B_rtwdemo_basicsc_T;

The structure that contains block parameter data defines one field, K1, which represents the parameter object K1.

rtwdemodbtype(file,'/* Parameters (default storage) */',...
 '/* Real-time Model Data Structure */',1,0)

/* Parameters (default storage) */
struct P_rtwdemo_basicsc_T_ {
   real32_T K1;           /* Variable: K1
                        * Referenced by: '<Root>/Gain' */
};

Access Data Through Generated Interfaces

You can configure the generated code to contain extra code and files so that you can access model data through standardized interfaces. For example, use the C API to log signal data and tune parameters during execution.

Copy this custom source code into a file named ex_myHandCode.c in your current folder.
#include "ex_myHandHdr.h"

#define paramIdx 0 /* Index of the target parameter, 
determined by inspecting the array of structures generated by the C API. */
#define sigIdx 0 /* Index of the target signal, 
determined by inspecting the array of structures generated by the C API. */

void tuneFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr)
{
    /* Take action with the parameter value only at 
    the beginning of simulation and at the 5-second mark. */
    if (*tPtr == 0 || *tPtr == 5) {

        /* Local variables to store information extracted from 
        the model mapping information (mmi). */
        void** dataAddrMap;
        const rtwCAPI_DataTypeMap *dataTypeMap;
        const rtwCAPI_ModelParameters *params;
        int_T addrIdx;
        uint16_T dTypeIdx;
        uint8_T slDataType;

        /* Use built-in C API macros to extract information. */
        dataAddrMap = rtwCAPI_GetDataAddressMap(mmi);
        dataTypeMap = rtwCAPI_GetDataTypeMap(mmi);
        params = rtwCAPI_GetModelParameters(mmi);
        addrIdx = rtwCAPI_GetModelParameterAddrIdx(params,paramIdx);
        dTypeIdx = rtwCAPI_GetModelParameterDataTypeIdx(params,paramIdx);
        slDataType = rtwCAPI_GetDataTypeSLId(dataTypeMap, dTypeIdx);

        /* Handle data types 'double' and 'int8'. */
        switch (slDataType) {
            case SS_DOUBLE: {
                real_T* dataAddress;
                dataAddress = dataAddrMap[addrIdx];
                /* At the 5-second mark, increment the parameter value by 1. */
                if (*tPtr == 5) {
                    (*dataAddress)++;
                }
                printf("Parameter value is %f\n", *dataAddress);
                break;
            }
        }
    }
}
case SS_INT8: {
    int8_T* dataAddress;
    dataAddress = dataAddrMap[addrIdx];
    if (*tPtr == 5) {
        (*dataAddress)++;
    }
    printf("Parameter value is %i\n", *dataAddress);
    break;
}
}

void logFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr)
{
    /* Take action with the signal value only when 
       the simulation time is an integer value. */
    if (*tPtr-(int_T)*tPtr == 0) {
        /* Local variables to store information extracted from 
           the model mapping information (mmi). */
        void** dataAddrMap;
        const rtwCAPI_DataTypeMap *dataTypeMap;
        const rtwCAPI_Signals *sigs;
        int_T addrIdx;
        uint16_T dTypeIdx;
        uint8_T slDataType;

        /* Use built-in C API macros to extract information. */
        dataAddrMap = rtwCAPI.GetDataAddressMap(mmi);
        dataTypeMap = rtwCAPI.GetDataTypeMap(mmi);
        sigs = rtwCAPI.GetDataSignals(mmi);
        addrIdx = rtwCAPI.GetDataSignalAddrIdx(sigs,sigIdx);
        dTypeIdx = rtwCAPI.GetDataSignalDataTypeIdx(sigs,sigIdx);
        slDataType = rtwCAPI.GetDataSignalSLId(dataTypeMap, dTypeIdx);

        /* Handle data types 'double' and 'single'. */
        switch (slDataType) {
            case SS_DOUBLE: {
                real_T* dataAddress;
                dataAddress = dataAddrMap[addrIdx];
                printf("Signal value is %f\n", *dataAddress);
            }
        }
    }
}
break;
}

case SS_SINGLE: {
    real32_T* dataAddress;
    dataAddress = dataAddrMap[addrIdx];
    printf("Signal value is %f\n", *dataAddress);
    break;
}
}
}

Copy this custom header code into a file named `ex_myHandHdr.h` in your current folder.

```c
#include <stdio.h>
#include <string.h>
#include <math.h>
/* Include rtw_modelmap.h for definitions of C API macros. */
#include "rtw_modelmap.h"
#include "builtin_typeid_types.h"
#include "rtwtypes.h"
void tuneFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr);
void logFcn(rtwCAPI_ModelMappingInfo *mmi, time_T *tPtr);
```

These files use the C API to access signal and parameter data in the code that you generate from the example model.

In the model, set Configuration Parameters > Code Generation > Custom Code > Insert custom C code in generated > Header file to `#include "ex_myHandHdr.h"`. In the same pane in the Configuration Parameters dialog box, set Additional Build Information > Source files to `ex_myHandCode.c`.

```matlab
set_param('rtwdemo_basicsc','CustomHeaderCode','#include "ex_myHandHdr.h"')
set_param('rtwdemo_basicsc','CustomSource','ex_myHandCode.c')
```

Select Configuration Parameters > MAT-file Logging. The generated executable runs only until the simulation stop time (which you set in the model configuration parameters).

```matlab
set_param('rtwdemo_basicsc','MatFileLogging','on')
```

Select all of the options under Configuration Parameters > Code Generation > Interface > Generate C API for.
set_param('rtwdemo_basicsc','RTWCAPIParams','on')
set_param('rtwdemo_basicsc','RTWCAPISignals','on')
set_param('rtwdemo_basicsc','RTWCAPIStates','on')
set_param('rtwdemo_basicsc','RTWCAPIRootIO','on')

Load the Custom Code block library.

custcode

Add a System Outputs block to the model.

add_block('custcode/System Outputs','rtwdemo_basicsc/System Outputs')

In the System Outputs block dialog box, set **System Outputs Function Execution Code** to this code:

```c
{  
    rtwdemo_basicsc_U.input2++;  
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_basicsc_M).mmi);  
    tuneFcn(MMI, rtmGetTPtr(rtwdemo_basicsc_M));  
}
```

In the block dialog box, set **System Outputs Function Exit Code** to this code:
Alternatively, to configure the System Outputs block, at the command prompt, use these commands:

```matlab
temp.TLCFile = 'custcode';
temp.Location = 'System Outputs Function';
temp.Middle = sprintf(['{"\rtwCAPI_ModelMappingInfo *MMI = &\(\rtmGetDataMapInfo(rtwdemo_basicsc_M).mmi\);\nlogFcn(MMI, rtmGetTPtr(rtwdemo_basicsc_M));\n}']);
temp.Bottom = sprintf(['{"\rtwCAPI_ModelMappingInfo *MMI = &\(\rtmGetDataMapInfo(rtwdemo_basicsc_M).mmi\);\n\n\ntuneFcn(MMI, rtmGetTPtr(rtwdemo_basicsc_M));\n}']);
set_param('rtwdemo_basicsc/System Outputs','RTWdata',temp)
```

Generate code from the model.

```bash
rtwbuild('rtwdemo_basicsc')
```

In the code generation report, view the interface file `rtwdemo_basicsc_capi.c`. This file initializes the arrays of structures that you can use to interact with data items through the C API. For example, in the array of structures `rtBlockSignals`, the first structure (index 0) describes the test-pointed output signal of the Gain block in the model.

```c
/* Block output signal information */
static const rtwCAPI_Signals rtBlockSignals[] = {
  /* addrMapIndex, sysNum, blockPath,
    * signalName, portNumber, dataTypeIndex, dimIndex, fxpIndex, sTimeIndex
    */
  { 0, 0, TARGET_STRING("rtwdemo_basicsc/Gain"),
      TARGET_STRING(""), 0, 0, 0, 0 },
};
```
The fields of the structure, such as `addrMapIndex`, indicate indices into other arrays of structures, such as `rtDataAddrMap`, that describe the characteristics of the signal. These characteristics include the address of the signal data (a pointer to the data), the numeric data type, and the dimensions of the signal.

In the file `rtwdemo_basicsc.c`, view the code algorithm in the model `step` function. The algorithm first executes the code that you specified in the System Outputs block.

```c
file = fullfile('rtwdemo_basicsc_grt_rtw','rtwdemo_basicsc.c');
rtdemodbtype(file,'/* user code (Output function Body) */','...'
    '/* Logic: ''<Root>/LogOp'' incorporates:'1,0)

    /* user code (Output function Body) */

    /* System '<Root>' */
    {
        rtwdemo_basicsc_U.input2++;
        rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_basicsc_M).mmi);
        tuneFcn(MMI, rtmGetTPtr(rtwdemo_basicsc_M));
    }

    /* DataStoreWrite: '<Root>/DSWrite' incorporates:
    * Constant: '<Root>/Constant1'
    * Constant: '<Root>/Constant2'
    * Inport: '<Root>/In1'
    * Logic: '<Root>/LogOp'
    * RelationalOperator: '<Root>/RelOp1'
    * RelationalOperator: '<Root>/RelOp2'
    */
    rtwdemo_basicsc_DW.mode = ((rtwdemo_basicsc_U.input1 > 10.0F) ||
        (rtwdemo_basicsc_U.input1 < -10.0F));

    /* Gain: '<Root>/Gain' incorporates:
    * Inport: '<Root>/In2'
    * Lookup_n-D: '<Root>/Table1'
    */
    rtwdemo_basicsc_B.Gain = rtwdemo_basicsc_P.K1 * look1_iflf_binlx
        (rtwdemo_basicsc_U.input2, rtCP_Table1_bp01Data, rtCP_Table1_tableData, 10U);
```
/* Chart: '<Root>/Stateflow Chart' */
/* Gateway: Stateflow Chart */
/* During: Stateflow Chart */
/* Entry Internal: Stateflow Chart */
/* Transition: '<S1>:5' */
if (rtwdemo_basicsc_DW.mode) {
  /* Transition: '<S1>:6' */
  /* Transition: '<S1>:2' */
  rtwdemo_basicsc_DW.X = rtwdemo_basicsc_B.Gain;
} else {
  /* Transition: '<S1>:4' */
}

/* Outport: '<Root>/Out1' incorporates:
 *  Chart: '<Root>/Stateflow Chart'
 *  Transition: '<S1>:3' */
rtwdemo_basicsc_Y.Out1 = (real32_T)(rtwdemo_basicsc_DW.X * 3.0);

/* Lookup n-D: '<Root>/Table2' incorporates:
 *  Inport: '<Root>/In3'
 *  Inport: '<Root>/In4'
 */
rtwdemo_basicsc_DW.X = look2_iflf_binlx(rtwdemo_basicsc_U.input3,
  rtwdemo_basicsc_U.input4, rtCP_Table2_bp01Data, rtCP_Table2_bp02Data,
  rtCP_Table2_tableData, rtCP_Table2_maxIndex, 3U);

/* user code (Output function Trailer) */

/ System '<Root>' */
{ 
  rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_basicsc_M).mmi);
  logFcn(MMI, rtmGetTPtr(rtwdemo_basicsc_M));
}

/* Matfile logging */
rt_UpdateTXYLogVars(rtwdemo_basicsc_M->rtwLogInfo,
  (&rtwdemo_basicsc_M->Timing.taskTime0));

/* signal main to stop simulation */
{ 
  /* Sample time: [1.0s, 0.0s] */
  if ((rtmGetTFinal(rtwdemo_basicsc_M)!=-1) &&
      ((rtmGetTFinal(rtwdemo_basicsc_M)-rtwdemo_basicsc_M->Timing.taskTime0) >
       rtwdemo_basicsc_M->Timing.taskTime0 * (DBL_EPSILON))) {

15-19
rtmSetErrorStatus(rtwdemo_basicsc_M, "Simulation finished");
}

/* Update absolute time for base rate */
/* The "clockTick0" counts the number of times the code of this task has
* been executed. The absolute time is the multiplication of "clockTick0"
* and "Timing.stepSize0". Size of "clockTick0" ensures timer will not
* overflow during the application lifespan selected.
* Timer of this task consists of two 32 bit unsigned integers.
* The two integers represent the low bits Timing.clockTick0 and the high bits
* Timing.clockTickH0. When the low bit overflows to 0, the high bits increment. */
if (!(++rtwdemo_basicsc_M->Timing.clockTick0)) {
    ++rtwdemo_basicsc_M->Timing.clockTickH0;
}

rtwdemo_basicsc_M->Timing.taskTime0 = rtwdemo_basicsc_M->Timing.clockTick0 *
    rtwdemo_basicsc_M->Timing.stepSize0 + rtwdemo_basicsc_M->Timing.clockTickH0 *
    rtwdemo_basicsc_M->Timing.stepSize0 * 4294967296.0;
}

/* Model initialize function */
void rtwdemo_basicsc_initialize(void)
{
    /* Registration code */

    /* initialize non-finites */
    rt_InitInfAndNaN(sizeof(real_T));

    /* initialize real-time model */
    (void) memset((void *)rtwdemo_basicsc_M, 0,
                  sizeof(RT_MODEL_rtwdemo_basicsc_T));
    rtmSetTFinal(rtwdemo_basicsc_M, 10.0);
    rtwdemo_basicsc_M->Timing.stepSize0 = 1.0;

    /* Setup for data logging */
    {
        static RTWLogInfo rt_DataLoggingInfo;
        rt_DataLoggingInfo.loggingInterval = NULL;
        rtwdemo_basicsc_M->rtwLogInfo = &rt_DataLoggingInfo;
    }

    /* Setup for data logging */
rtliSetLogXSignalInfo(rtwdemo_basicsc_M->rtwLogInfo, (NULL));
rtliSetLogXSignalPtrs(rtwdemo_basicsc_M->rtwLogInfo, (NULL));
rtliSetLogT(rtwdemo_basicsc_M->rtwLogInfo, "tout");
rtliSetLogX(rtwdemo_basicsc_M->rtwLogInfo, "");
rtliSetLogXFinal(rtwdemo_basicsc_M->rtwLogInfo, "");
rtliSetLogVarNameModifier(rtwdemo_basicsc_M->rtwLogInfo, "rt_");
rtliSetLogFormat(rtwdemo_basicsc_M->rtwLogInfo, 0);
rtliSetLogMaxRows(rtwdemo_basicsc_M->rtwLogInfo, 1000);
rtliSetLogDecimation(rtwdemo_basicsc_M->rtwLogInfo, 1);

/*
 * Set pointers to the data and signal info for each output
 */
{
    static void * rt_LoggedOutputSignalPtrs[] = {
        &rtwdemo_basicsc_Y.Out1
    };
    rtliSetLogYSignalPtrs(rtwdemo_basicsc_M->rtwLogInfo, ((LogSignalPtrsType)rt_LoggedOutputSignalPtrs));
}

{
    static int_T rt_LoggedOutputWidths[] = {
        1
    };
    static int_T rt_LoggedOutputNumDimensions[] = {
        1
    };
    static int_T rt_LoggedOutputDimensions[] = {
        1
    };
    static boolean_T rt_LoggedOutputIsVarDims[] = {
        0
    };
    static void* rt_LoggedCurrentSignalDimensions[] = {
        (NULL)
    };
}
static int_T rt_LoggedCurrentSignalDimensionsSize[] = {
    4
};

static BuiltInDTypeId rt_LoggedOutputDataTypeIds[] = {
    SS_SINGLE
};

static int_T rt_LoggedOutputComplexSignals[] = {
    0
};

static RTWPreprocessingFcnPtr rt_LoggingPreprocessingFcnPtrs[] = {
    (NULL)
};

static const char_T *rt_LoggedOutputLabels[] = {
    "output"
};

static const char_T *rt_LoggedOutputBlockNames[] = {
    "rtwdemo_basicsc/Out1"
};

static RTWLogDataTypeConvert rt_RTWLogDataTypeConvert[] = {
    { 0, SS_SINGLE, SS_SINGLE, 0, 0, 0, 1.0, 0, 0.0 }
};

static RTWLogSignalInfo rt_LoggedOutputSignalInfo[] = {
    {
        1,
        rt_LoggedOutputWidths,
        rt_LoggedOutputNumDimensions,
        rt_LoggedOutputDimensions,
        rt_LoggedOutputIsVarDims,
        rt_LoggedCurrentSignalDimensions,
        rt_LoggedCurrentSignalDimensionsSize,
        rt_LoggedOutputDataTypeIds,
        rt_LoggedOutputComplexSignals,
        (NULL),
        rt_LoggingPreprocessingFcnPtrs,
        { rt_LoggedOutputLabels },
        (NULL),
        (NULL),
        (NULL),
        (NULL),
    }
};
{ rtLoggedOutputBlockNames },
{ (NULL) },
(NULL),
rt_RTWLogDataTypeConvert
};

rtliSetLogYSignalInfo(rtwdemo_basicsc_M->rtwLogInfo,
 rtLoggedOutputSignalInfo);
/* set currSigDims field */
rtLoggedCurrentSignalDimensions[0] = &rtLoggedOutputWidths[0];
}

rtliSetLogY(rtwdemo_basicsc_M->rtwLogInfo, "yout");

/* block I/O */
(void) memset(((void *) &rtwdemo_basicsc_B), 0,
sizeof(B_rtwdemo_basicsc_T));

/* states (dwork) */
(void) memset((void *)&rtwdemo_basicsc_DW, 0,
sizeof(DW_rtwdemo_basicsc_T));

/* external inputs */
(void) memset(&rtwdemo_basicsc_U, 0, sizeof(ExtU_rtwdemo_basicsc_T));

/* external outputs */
rtwdemo_basicsc_Y.Out1 = 0.0F;

/* Initialize DataMapInfo substructure containing ModelMap for C API */
rtwdemo_basicsc_InitializeDataMapInfo();

/* Matfile logging */
rt_StartDataLoggingWithStartTime(rtwdemo_basicsc_M->rtwLogInfo, 0.0,
 rtmGetTFinal(rtwdemo_basicsc_M), rtwdemo_basicsc_M->Timing.stepSize0,
(&rtmGetErrorStatus(rtwdemo_basicsc_M)));

/* Start for DataStoreMemory: '<Root>/Data Store Memory' */
rtwdemo_basicsc_DW.mode = false;
This code first perturbs the input signal input2 by incrementing the value of the signal each time the step function executes. The code then uses the built-in macro rtmGetDataMapInfo to extract model mapping information from the model data structure rtwdemo_basicsc_M. The pointer MMI points to the extracted mapping information, which allows the functions tuneFcn and logFcn to access the information contained in the arrays of structures that the C API file rtwdemo_basicsc_capi.c defines.

View the function tuneFcn in the file ex_myHandCode.c. This function uses the C API (through the model mapping information MMI) and a pointer to the simulation time to print the value of the parameter K1 at specific times during code execution. When the simulation time reaches 5 seconds, the function changes the parameter value in memory. By using a switch case block, the function can access the parameter data whether the data type is int8 or double.

View the code algorithm in the model step function again. Near the end of the function, the algorithm executes the code that you specified in the System Outputs block. This code calls the function logFcn.

rtwdemodbtype(file,'/* user code (Output function Trailer) */','/* Matfile logging */',1,0)

/* user code (Output function Trailer) */

/* System '<Root>' */
{
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_basicsc_M).mmi);
    logFcn(MMI, rtmGetTPtr(rtwdemo_basicsc_M));
}

View the function logFcn in the file ex_myHandCode.c. The function uses the C API to print the value of the test-pointed signal. The function can access the signal data whether the data type is single or double.
At the command prompt, run the generated executable `rtwdemo_bascisc.exe`.

```matlab
system('rtwdemo_bascisc')
```

The parameter and signal values appear in the Command Window output.

For more information about data interfaces, including the C API, see “Data Exchange Interfaces”.

**See Also**


**Related Examples**

- “Standard Data Structures in the Generated Code” on page 15-26
- “Configure Data Accessibility for Rapid Prototyping” on page 15-3
- “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82
- “Exchange Data Between Generated and External Code Using C API” on page 30-2
Standard Data Structures in the Generated Code

By default, signal lines, block parameters, states, and other model data appear in the generated code as fields of standard structures. For general information, see “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50.

The table shows some common data structures in the generated code. The name of the structure type and, if applicable, structure variable in the code that you generate from a model depends on the model settings. Regardless of the settings, the name of the structure type in the code contains the short name from the **Short Name of Structure Type** column in the table.

### Data Structures Generated for a Model

<table>
<thead>
<tr>
<th>Short Name of Structure Type</th>
<th>Data Represented in the Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExtU</td>
<td>Data from root Inport blocks</td>
</tr>
<tr>
<td>ExtY</td>
<td>Data from root Outport blocks</td>
</tr>
<tr>
<td>B</td>
<td>Block output signals</td>
</tr>
<tr>
<td>ConstB</td>
<td>Block outputs that have constant values</td>
</tr>
<tr>
<td>P</td>
<td>Block parameters</td>
</tr>
<tr>
<td>ConstP</td>
<td>Constant parameters</td>
</tr>
<tr>
<td>DW</td>
<td>Discrete block states</td>
</tr>
<tr>
<td>XDis</td>
<td>Status of enabled subsystems</td>
</tr>
</tbody>
</table>

For additional structures, see “System-generated identifiers”.

You can exclude data from appearing in these structures by using:

- Direct application of storage classes. For example, you can use storage classes to represent signals, tunable parameters, and states as individual global variables. For more information, see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82.

- Configuration parameters, such as those on the **Optimization** pane in the Configuration Parameters dialog box. You can adjust these configuration parameters to control the default representation of data. For more information, see “Model Configuration Parameters: Code Generation Optimization”.

15-26
Control Characteristics of Data Structures (Embedded Coder)

To control the characteristics of the standard data structures, use the information in the table.

<table>
<thead>
<tr>
<th>Name</th>
<th>How to Change Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Structure types</td>
<td>Specify a naming rule to use for all of the types. Set a value for Configuration</td>
</tr>
<tr>
<td></td>
<td>Parameters &gt; Global types.</td>
</tr>
<tr>
<td>Global structure variables</td>
<td>Specify a naming rule with Configuration Parameters &gt; Global variables.</td>
</tr>
<tr>
<td>Names of structure fields</td>
<td>By default, the name of each structure field derives from the name of the data item</td>
</tr>
<tr>
<td></td>
<td>in the model (for example, the name of a block state, which you specify by using the State</td>
</tr>
<tr>
<td></td>
<td>name block parameter). Specify a naming rule with Configuration Parameters &gt; Field</td>
</tr>
<tr>
<td></td>
<td>name of global types.</td>
</tr>
<tr>
<td>Data types of structure fields</td>
<td>Use Simulink.AliasType objects and data type replacement to rename primitive types</td>
</tr>
<tr>
<td></td>
<td>for the corresponding data items in the model. See “Control Data Type Names in Generated</td>
</tr>
<tr>
<td></td>
<td>Code” (Embedded Coder).</td>
</tr>
</tbody>
</table>

For more information about configuration parameters that control names and other identifiers in the generated code, see “Customize Generated Identifiers” (Embedded Coder).

See Also

“Combine signal/state structures”

Related Examples

- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
• “Use the Real-Time Model Data Structure” on page 15-29
• “Access Signal, State, and Parameter Data During Execution” on page 15-7
• “Environment for Configuring Model Data and Functions for Code Generation” (Embedded Coder)
Use the Real-Time Model Data Structure

The code generator uses the real-time model (RT_MODEL) data structure. This structure is also referred to as the rtModel data structure. You can access rtModel data by using a set of macros analogous to the ssSetxxx and ssGetxxx macros that S-functions use to access SimStruct data, including noninlined S-functions compiled by the code generator.

You need to use the set of macros rtmGetxxx and rtmSetxxx to access the real-time model data structure. The rtModel is an optimized data structure that replaces SimStruct as the top level data structure for a model. The rtmGetxxx and rtmSetxxx macros are used in the generated code as well as from the main.c or main.cpp module. If you are customizing main.c or main.cpp (either a static file or a generated file), you need to use rtmGetxxx and rtmSetxxx instead of the ssSetxxx and ssGetxxx macros.

Usage of rtmGetxxx and rtmSetxxx macros is the same as for the ssSetxxx and ssGetxxx versions, except that you replace SimStruct S by real-time model data structure rtM. The following table lists rtmGetxxx and rtmSetxxx macros that are used in grt_main.c and grt_main.cpp.
## Macros for Accessing the Real-Time Model Data Structure

<table>
<thead>
<tr>
<th>rtm Macro Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rtmGetdX(rtm)</td>
<td>Get the derivatives of block continuous states</td>
</tr>
<tr>
<td>rtmGetOffsetTablePtr(RT_MDL rtM)</td>
<td>Return the pointer to vector that stores sample time offsets of the model associated with rtM</td>
</tr>
<tr>
<td>rtmGetNumSampleTimes(RT_MDL rtM)</td>
<td>Get the number of sample times that a block has</td>
</tr>
<tr>
<td>rtmGetPerTaskSampleHitsPtr(RT_MDL)</td>
<td>Return a pointer to NumSampleTime × NumSampleTime matrix</td>
</tr>
<tr>
<td>rtmGetRTWExtModeInfo(RT_MDL rtM)</td>
<td>Return an external mode information data structure of the model (used internally for external mode)</td>
</tr>
<tr>
<td>rtmGetRTWLogInfo(RT_MDL)</td>
<td>Return a data structure used by code generator logging (internal use only)</td>
</tr>
<tr>
<td>rtmGetRTWRTModelMethodsInfo(RT_MDL)</td>
<td>Return a data structure of real-time model methods information (internal use only)</td>
</tr>
<tr>
<td>rtmGetRTWSolverInfo(RT_MDL)</td>
<td>Return data structure containing solver information of the model (internal use only)</td>
</tr>
<tr>
<td>rtmGetSampleHitPtr(RT_MDL)</td>
<td>Return a pointer to Sample Hit flag vector</td>
</tr>
<tr>
<td>rtmGetSampleTime(RT_MDL rtM, int TID)</td>
<td>Get task sample time</td>
</tr>
<tr>
<td>rtmGetSampleTimePtr(RT_MDL rtM)</td>
<td>Get pointer to a task sample time</td>
</tr>
<tr>
<td>rtmGetSampleTimeTaskIDPtr(RT_MDL rtM)</td>
<td>Get pointer to a task ID</td>
</tr>
<tr>
<td>rtmGetSimTimeStep(RT_MDL)</td>
<td>Return simulation step type ID (MINOR_TIME_STEP, MAJOR_TIME_STEP)</td>
</tr>
<tr>
<td>rtmGetStepSize(RT_MDL)</td>
<td>Return the fundamental step size of the model</td>
</tr>
<tr>
<td>rtmGetT(RT_MDL,t)</td>
<td>Get the current simulation time</td>
</tr>
<tr>
<td>rtmSetT(RT_MDL,t)</td>
<td>Set the time of the next sample hit</td>
</tr>
<tr>
<td>rtmGetTaskTime(RT_MDL,tid)</td>
<td>Get the current time for the current task</td>
</tr>
<tr>
<td>rtmGetTfinal(RT_MDL)</td>
<td>Get the simulation stop time</td>
</tr>
<tr>
<td>rtmSetTfinal(RT_MDL,finalT)</td>
<td>Set the simulation stop time</td>
</tr>
<tr>
<td>rtmGetTimingData(RT_MDL)</td>
<td>Return a data structure used by timing engine of the model (internal use only)</td>
</tr>
<tr>
<td>rtm Macro Syntax</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>rtmGetTPtr(RT_MDL)</td>
<td>Return a pointer to the current time</td>
</tr>
<tr>
<td>rtmGetTStart(RT_MDL)</td>
<td>Get the simulation start time</td>
</tr>
<tr>
<td>rtmIsContinuousTask(rtm)</td>
<td>Determine whether a task is continuous</td>
</tr>
<tr>
<td>rtmIsMajorTimeStep(rtm)</td>
<td>Determine whether the simulation is in a major step</td>
</tr>
<tr>
<td>rtmIsSampleHit(RT_MDL,tid)</td>
<td>Determine whether the sample time is hit</td>
</tr>
<tr>
<td>rtmGetErrorStatus(rtm)</td>
<td>Get the current error status</td>
</tr>
<tr>
<td>rtmSetErrorStatus(rtm,val)</td>
<td>Set the current error status</td>
</tr>
<tr>
<td>rtmGetErrorStatusPointer(rtm)</td>
<td>Return a pointer to the current error status</td>
</tr>
<tr>
<td>rtmGetStopRequested(rtm)</td>
<td>Return whether a stop is requested</td>
</tr>
<tr>
<td>rtmGetBlockIO(rtm)</td>
<td>Get the block I/O data structure</td>
</tr>
<tr>
<td>rtmSetBlockIO(rtm,val)</td>
<td>Set the block I/O data structure</td>
</tr>
<tr>
<td>rtmGetContStates(rtm)</td>
<td>Get the continuous states data structure</td>
</tr>
<tr>
<td>rtmSetContStates(rtm,val)</td>
<td>Set the continuous states data structure</td>
</tr>
<tr>
<td>rtmGetDefaultParam(rtm)</td>
<td>Get the default parameters data structure</td>
</tr>
<tr>
<td>rtmSetDefaultParam(rtm,val)</td>
<td>Set the default parameters data structure</td>
</tr>
<tr>
<td>rtmGetPrevZCSigState(rtm)</td>
<td>Get the previous zero-crossing signal state data structure</td>
</tr>
<tr>
<td>rtmSetPrevZCSigState(rtm,val)</td>
<td>Set the previous zero-crossing signal state data structure</td>
</tr>
<tr>
<td>rtmGetRootDWork(rtm)</td>
<td>Get the DWork data structure</td>
</tr>
<tr>
<td>rtmSetRootDWork(rtm,val)</td>
<td>Set the DWork data structure</td>
</tr>
<tr>
<td>rtmGetU(rtm)</td>
<td>Get the root inputs data structure (when root inputs are passed as part of the model data structure)</td>
</tr>
<tr>
<td>rtmSetU(rtm,val)</td>
<td>Set the root inputs data structure (when root inputs are passed as part of the model data structure)</td>
</tr>
<tr>
<td>rtm Macro Syntax</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>rtmGetY(rtm)</td>
<td>Get the root outputs data structure (when root outputs are passed as part of the model data structure)</td>
</tr>
<tr>
<td>rtmSetY(rtm,val)</td>
<td>Set the root outputs data structure (when root outputs are passed as part of the model data structure)</td>
</tr>
</tbody>
</table>

For additional details on usage, see “SimStruct Macros and Functions Listed by Usage” (Simulink).

**See Also**

**Related Examples**

- “SimStruct Macros and Functions Listed by Usage” (Simulink)
- “Compare System Target File Support Across Products” on page 19-21
- “Standard Data Structures in the Generated Code” on page 15-26
- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
How Generated Code Exchanges Data with an Environment

To use the code that you generate from a model, you call the generated entry-point functions such as `step` and `initialize`. The environment in which you call these functions must provide input signal data and, depending on your application, scheduling information. The generated algorithm then calculates output data that the calling environment can use. The environment and the algorithm can exchange this data through global variables or through formal parameters (arguments).

The set of input and output data and the exchange mechanisms constitute the interfaces of the entry-point functions. When you understand the default interfaces and how to control them, you can:

- Write code that calls the generated code.
- Generate reusable (reentrant) code that you can call multiple times in a single application.
- Integrate the generated code with other, external code in your application.

In a model, root-level Inport and Outport blocks represent the primary inputs and outputs of the block algorithm. By default, the code generator aggregates these blocks into standard structures that store input and output data.

For information about how the generated code stores internal data, which does not participate in the model interface, see “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50.

Data Interfaces in the Generated Code

This example shows how the generated code exchanges data with an environment.

Explore Example Model

Open the example model `rtwdemo_roll`.

```matlab
open_system('rtwdemo_roll')
```
At the root level, the model has a number of Inport blocks and one Outport block.

In the model, set **Configuration Parameters > Code Generation > System target file** to `grt.tlc`.

```matlab
set_param('rtwdemo_roll','SystemTargetFile','grt.tlc')
```

Inspect the setting for **Configuration Parameters > Code Generation > Interface > Code interface packaging**. The setting **Nonreusable function** means that the generated code is not reusable (not reentrant).

For this example, to generate simpler code, clear the **Configuration Parameters > Code Generation > Interface > Advanced parameters > Mat-file logging**.

```matlab
set_param('rtwdemo_roll','MatFileLogging','off')
```

**Generate Nonreusable Code**

Generate code from the model.

```matlab
rtwbuild('rtwdemo_roll')
```
### Starting build procedure for model: rtwdemo_roll
### Successful completion of build procedure for model: rtwdemo_roll

Inspect the file `rtwdemo_roll.h`. The file defines a structure type that represents input data and a type that represents output data.

```c
file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.h');
rtwdemodbtype(file,...
    '/* External inputs (root inport signals with default storage) */',...
    '} ExtY_rtwdemo_roll_T;',1,1)

/* External inputs (root inport signals with default storage) */
typedef struct {
    real32_T Phi;                        /* '<Root>/Phi' */
    real32_T Psi;                        /* '<Root>/Psi' */
    real32_T Rate_FB;                    /* '<Root>/Rate_FB' */
    real32_T TAS;                        /* '<Root>/TAS' */
    boolean_T AP_Eng;                    /* '<Root>/AP_Eng' */
    boolean_T HDG_Mode;                  /* '<Root>/HDG_Mode' */
    real32_T HDG_Ref;                    /* '<Root>/HDG_Ref' */
    real32_T Turn_Knob;                  /* '<Root>/Turn_Knob' */
} ExtU_rtwdemo_roll_T;

/* External outputs (root outports fed by signals with default storage) */
typedef struct {
    real32_T Ail_Cmd;                    /* '<Root>/Ail_Cmd' */
} ExtY_rtwdemo_roll_T;

Each field corresponds to an Inport or Outport block at the root level of the model. The name of each field derives from the name of the block.

The file also defines a structure type, the `real-time model data structure`, whose single field stores a run-time indication of whether the generated code has encountered an error during execution.

```c
rtwdemodbtype(file,'/* Real-time Model Data Structure */',...
    '/* Block states (default storage) */',1,0)

/* Real-time Model Data Structure */
struct tag_RTM_rtwdemo_roll_T {
    const char_T *errorStatus;
};
```
When you modify model configuration parameters to suit your application, this structure can also contain other data that pertain to the entire model, such as scheduling information.

For the structure type that represents the real-time model data structure, the file `rtwdemo_roll_types.h` creates an alias (typedef) that the generated code later uses to allocate memory for the structure.

```matlab
file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll_types.h');
rtwdemodbtype(file,'/* Forward declaration for rtModel */',
'R_TMODEL_rtwdemo_roll_T;',1,1)
/* Forward declaration for rtModel */
typedef struct tag_RTM_rtwdemo_roll_T RT_MODEL_rtwdemo_roll_T;
```

Using these structure types, the file `rtwdemo_roll.c` defines (allocates memory for) global structure variables that store input and output data for the generated algorithm. The file also defines variables that represent the real-time model data structure and a pointer to the structure.

```matlab
file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
rtwdemodbtype(file,
'/* External inputs (root inport signals with default storage) */',
'= &rtwdemo_roll_M_;',1,1)
/* External inputs (root inport signals with default storage) */
ExtU_rtwdemo_roll_T rtwdemo_roll_U;
/* External outputs (root outports fed by signals with default storage) */
ExtY_rtwdemo_roll_T rtwdemo_roll_Y;
/* Real-time model */
RT_MODEL_rtwdemo_roll_T rtwdemo_roll_M;
RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M = &rtwdemo_roll_M;
```

The file `rtwdemo_roll.h` declares these structure variables. Your external code can include (#include) this file, whose general name is `model.h` where `model` is the name of the model, to access data that participate in the model interface.

In `rtwdemo_roll.c`, the model step function, which represents the primary model algorithm, uses a `void void` interface (with no arguments).
/* Model step function */
void rtwdemo_roll_step(void)

In the function definition, the algorithm reads input data and writes output data by directly accessing the global structure variables. For example, near the end of the algorithm, the code for the EngSwitch block reads the value of the AP_Eng field (which represents an input) and, based on that value, conditionally writes a constant value to the Ail_Cmd field (which represents an output).

if (rtwdemo_roll_U.AP_Eng) {
    /* Outputs for Atomic SubSystem: '<Root>/BasicRollMode' */
    /* Saturate: '<S1>/CmdLimit' */
    if (rtwdemo_roll_Y.Ail_Cmd > 15.0F) {
        /* Sum: '<S1>/Sum2' incorporates:
           * Outport: '<Root>/Ail_Cmd' */
        rtwdemo_roll_Y.Ail_Cmd = 15.0F;
    } else {
        if (rtwdemo_roll_Y.Ail_Cmd < -15.0F) {
            /* Sum: '<S1>/Sum2' incorporates:
               * Outport: '<Root>/Ail_Cmd' */
            rtwdemo_roll_Y.Ail_Cmd = -15.0F;
        }
    }
}

Due to the void void interface and the direct data access, the function is not reentrant. If you call the function multiple times in an application, each call reads and writes input and output data to the same global structure variables, resulting in data corruption and unintentional interaction between the calls.

The model initialization function, rtwdemo_roll_initialize, initializes all of the input and output data to zero. The function also initializes the error status. The function directly accesses the global variables, which means the function is not reentrant.
/* Model initialize function */
void rtwdemo_roll_initialize(void)
{
    /* Registration code */

    /* initialize error status */
    rtmSetErrorStatus(rtwdemo_roll_M, (NULL));

    rtwdemodbtype(file,' /* external inputs */',
                  ' /* SystemInitialize for Atomic SubSystem: ',1,0)

    /* external inputs */
    (void)memset(&rtwdemo_roll_U, 0, sizeof(ExtU_rtwdemo_roll_T));

    /* external outputs */
    rtwdemo_roll_Y.Ail_Cmd = 0.0F;

**Generate Reusable Code**

You can configure the generated code as reentrant, which means that you can call the entry-point functions multiple times in an application. With this configuration, instead of directly accessing global variables, the entry-point functions exchange input, output, and other model data through formal parameters (pointer arguments). With these pointer arguments, each call can read inputs and write outputs to a set of separate global variables, preventing unintentional interaction between the calls.

In the model, set **Configuration Parameters > Code Generation > Interface > Code interface packaging** to **Reusable function**.

```matlab
set_param('rtwdemo_roll','CodeInterfacePackaging','Reusable function')
```

Generate code from the model.

```bash
rtwbuild('rtwdemo_roll')
```

### Starting build procedure for model: rtwdemo_roll
### Successful completion of build procedure for model: rtwdemo_roll

Now, in `rtwdemo_roll.h`, the real-time model data structure contains pointers to the error indication, the input data, the output data, and additional data in the form of a DWork substructure (which stores, for example, block states such as the state of a Discrete-Time Integrator block).
file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.h');
rtwdemodbtype(file,'/* Real-time Model Data Structure */',
  '/* External data declarations for dependent source files */',1,0)

/* Real-time Model Data Structure */
struct tag_RTM_rtwdemo_roll_T {
  const char_T *errorStatus;
  ExtU_rtwdemo_roll_T *inputs;
  ExtY_rtwdemo_roll_T *outputs;
  DW_rtwdemo_roll_T *dwork;
};

To call the generated code multiple times in an application, your code must allocate
memory for a real-time model data structure per call. The file rtwdemo_roll.c defines a
specialized function that allocates memory for a new real-time model data structure and
returns a pointer to the structure. The function also allocates memory for the
substructures that the fields in the model data structure point to, such as the input and
output structures.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
rtwdemodbtype(file,'/* Model data allocation function */',
  'RT_MODEL_rtwdemo_roll_T *rtwdemo_roll(void)',1,1)

/* Model data allocation function */
RT_MODEL_rtwdemo_roll_T *rtwdemo_roll(void)

In rtwdemo_roll.c, the model step function accepts an argument that represents the
real-time model data structure.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
rtwdemodbtype(file,'/* Model step function */',
  'void rtwdemo_roll_step',1,1)

/* Model step function */
void rtwdemo_roll_step(RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M)

In the function definition, the algorithm first extracts each pointer from the real-time
model data structure into a local variable.

rtwdemodbtype(file,...
  '*rtwdemo_roll_DW =','rtwdemo_roll_M->outputs;',1,1)
Then, to access the input and output data stored in global memory, the algorithm interacts with these local variables.

```c
const char rtwdemodbtype[file,'  if (rtwdemo_roll_U->AP_Eng) {
  /* End of Switch: ''<Root>/EngSwitch'' */',1,1)

if (rtwdemo_roll_U->AP_Eng) {
  /* Outputs for Atomic SubSystem: '<Root>/BasicRollMode' */
  /* Saturate: '<S1>/CmdLimit' */
  if (rtwdemo_roll_Y->Ail_Cmd > 15.0F) {
    /* Sum: '<S1>/Sum2' incorporates:
    *  Outport: '<Root>/Ail_Cmd'
    */
    rtwdemo_roll_Y->Ail_Cmd = 15.0F;
  } else {
    if (rtwdemo_roll_Y->Ail_Cmd < -15.0F) {
      /* Sum: '<S1>/Sum2' incorporates:
      *  Outport: '<Root>/Ail_Cmd'
      */
      rtwdemo_roll_Y->Ail_Cmd = -15.0F;
    }
  }
  /* End of Saturate: '<S1>/CmdLimit' */
  /* End of Outputs for SubSystem: '<Root>/BasicRollMode' */
} else {
  /* Sum: '<S1>/Sum2' incorporates:
  *  Constant: '<Root>/Zero'
  *  Outport: '<Root>/Ail_Cmd'
  */
  rtwdemo_roll_Y->Ail_Cmd = 0.0F;
}
```

Similarly, the model initialization function accepts the real-time model data structure as an argument.
rtwdemodbtype(file,...
   '/* Model initialize function */','void rtwdemo_roll_initialize',1,1)

/* Model initialize function */
void rtwdemo_roll_initialize(RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M)

Because each call that you make to an entry-point function interacts with a separate real-time model data structure, you avoid unintentional interaction between the calls.

**Configure Data Interface**

To control the characteristics of the data interface in the generated code, see “Control Data and Function Interface in Generated Code” on page 15-42.

**See Also**

**Related Examples**
- “Standard Data Structures in the Generated Code“ on page 15-26
- “Use the Real-Time Model Data Structure” on page 15-29
- “Analyze the Generated Code Interface” (Embedded Coder)
- “Control Data and Function Interface in Generated Code” (Embedded Coder)
- “How Generated Code Stores Internal Signal, State, and Parameter Data” (Embedded Coder)
Control Data and Function Interface in Generated Code

To use the code that you generate from a model, you call generated entry-point functions such as `step` and `initialize`. The calling environment and the generated functions exchange input and output data through global variables or through formal parameters (arguments). This data and the exchange mechanisms constitute the interfaces of the entry-point functions. For information about the default interfaces for reentrant and nonreentrant models in the generated code, see “How Generated Code Exchanges Data with an Environment” on page 15-33.

By controlling the interfaces that appear in the generated code, you can:

- Minimize the modifications that you must make to existing code.
- Generate stable interfaces that do not change or minimally change when you make changes to the model.
- Generate code that exchanges data more efficiently (for example, by using pointers and pass-by-reference arguments for nonscalar data).

Control Type Names, Field Names, and Variable Names of Standard I/O Structures (Embedded Coder)

By default, for nonreentrant code, Inport blocks at the root level of the model appear in the generated code as fields of a global structure variable. Similarly, Outport blocks appear in a different structure. For reentrant code, depending on your setting for model configuration parameter `Pass root-level I/O as`, the code generator can also package input and output data into standard structures.

With Embedded Coder, you can control these names. See “Control Characteristics of Data Structures (Embedded Coder)” on page 15-27.

Control Names of Generated Entry-Point Functions (Embedded Coder)

To use the generated code, you write code that calls generated entry-point functions. For example, entry-point functions include `model_step`, `model_initialize`, and top-level functions generated from an export-function model. To control the names of the model entry-point functions, use the Code Mapping Editor (requires Embedded Coder) to apply a combination of these techniques:
• On the **Function Defaults** tab, specify default naming rules for categories of entry-point functions by applying function customization templates in the Code Mapping Editor. With this technique, a naming rule applies to functions in a category. For more information, see “Configure Default Code Generation for Functions” (Embedded Coder).

• On the **Entry-Point Functions** tab, specify names for individual entry-point functions in the **Function Name** column. Names that you specify on this tab override default naming rules specified by function customization templates.

• You use different tools and dialog boxes to apply function prototype control based on the kind of target function. For more information, see “Customize Generated C Function Interfaces” (Embedded Coder).

### Control Data Interface for Nonreentrant Code

When you set the model configuration parameter **Code interface packaging** to **Nonreusable function** (the default), generated entry-point functions are not reentrant. Typically, the functions exchange data with the calling environment through direct access to global variables.

#### Configure Inport or Outport Block as Separate Global Variable

To remove the block from the standard I/O structures by creating a separate global variable, apply a storage class, such as **ExportedGlobal** or **ExportToFile**, to the signal that the block represents.

• To specify a default storage class for Inport blocks and a different default for Outport blocks, use the Code Mapping Editor. As you add such blocks to the model, they acquire the storage class that you specify. You do not need to configure each individual block.

  For this technique, you must have Embedded Coder.

• To override the default for an individual block, apply a different storage class by using other tools such as the Model Data Editor or the Property Inspector. See “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82.

For an example, see “Design Data Interface by Configuring Inport and Outport Blocks” on page 15-207. For general information about storage classes, see “Choose Storage Class for Controlling Data Representation in Generated Code” on page 15-69.
**Configure Generated Code to Read or Write to Global Variables Defined by External Code**

If your calling code already defines a global variable that you want the generated code to use as input data or use to store output data, you can reuse the variable by preventing the code generator from duplicating the definition. Apply a storage class to the corresponding Inport or Outport block in the model. Choose a storage class that specifies an imported data scope, such as `ImportedExtern` or `ImportFromFile`. For information about applying storage classes, see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82 and “Apply Custom Storage Classes to Individual Signal, State, and Parameter Data Elements” (Embedded Coder).

**Package Multiple Inputs or Outputs into Custom Structure**

You can configure a single Inport or Outport block to appear in the generated code as a custom structure that contains multiple input or output signals. You can also configure the block to appear as a substructure of the default I/O structures or as a separate structure variable.

Configure the block as a nonvirtual bus by using a `Simulink.Bus` object as the data type of the block. If your external code defines the structure type, consider using the `Simulink.importExternalCTypes` function to generate the bus object.

- To generate the bus signal as a substructure in the standard I/O structures, leave the block storage class at the default setting, `Auto`. If you have Embedded Coder, in the Code Mapping Editor, on the **Data Defaults** tab, set the storage class for categories **Imports** and **Outports** to **Default**.
- To generate the bus signal as a separate global structure variable, apply a storage class such as `ExportedGlobal` or `ExportToFile`.

For more information about grouping signals into custom structures in the generated code, see “Organize Data into Structures in Generated Code” on page 15-177.

**Configure Inport or Outport Block as Function Call (Embedded Coder)**

If your external code defines a function that returns input data for the generated code or accepts output data that the generated code produces, you can configure an Inport or Outport block so that the generated code calls the function instead of accessing a global variable. Apply the Embedded Coder storage class `GetSet`. For more information, see “Access Data Through Functions with Custom Storage Class GetSet” (Embedded Coder).
**Pass Inputs and Outputs Through Function Arguments (Embedded Coder)**

With Embedded Coder, you can optionally configure the model step (execution) function to access root-level input and output through arguments instead of directly reading and writing to global variables. Completely control the argument characteristics such as name, order, and passing mechanism (by reference or by value). This level of configuration can help to integrate generated code with your external code.

To pass inputs and outputs through arguments, in the Configure C Step Function interface dialog box, select **Configure arguments for Step function prototype**. Each Inport and Outport block at the root level of the model appears in the code as an argument of the execution function. For more information, see “Customize Generated C Function Interfaces” (Embedded Coder).

**Configure Referenced Model Inputs and Outputs as Global Variables (void-void)**

By default, for a nonreentrant referenced model, the generated code passes root-level input and output through function arguments. A nonreentrant referenced model is one in which you set model configuration parameter **Total number of instances allowed per top model** to 1.

To pass this data through global variables instead (for a void-void interface), in the referenced model, apply storage classes such as ExportedGlobal and ExportToFile to root-level Inport and Outport blocks.

- To apply a default storage class to all such blocks, use the Code Mapping Editor, which requires Embedded Coder. With this technique, as you add such blocks to the model, the blocks acquire the default storage class, preserving the void-void interface. For more information, see “Configure Default Code Generation for Data” (Embedded Coder).
- To override the default storage class, apply storage classes directly to individual blocks by using the Model Data Editor. See “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” (Embedded Coder).
- For an example that requires Embedded Coder, see “Establish Data Ownership in a System of Components” (Embedded Coder).

**Control Data Interface for Reentrant Code**

When you set **Code interface packaging** to **Reusable function**, generated entry-point functions are reentrant. The functions exchange data with the calling environment
through formal parameters (arguments). By default, each root-level Inport and Outport block appears in the generated code as a separate argument instead of a field of the standard I/O structures.

• To reduce the number of arguments, see “Reduce Number of Arguments by Using Structures” on page 15-47.

• To control the data types of the arguments, see “Control Data Types of Arguments” on page 15-48.

Prevent Unintended Changes to the Interface

Some changes that you make to a model change the entry-point function interfaces in the generated code. For example, if you change the name of the model, the names of the functions can change. If you configure the model code to exchange data through arguments, when you add or remove Inport or Outport blocks or change the names of the blocks, the corresponding arguments can change.

For easier maintenance of your calling code, prevent changes to the interfaces of the entry-point functions.

• If you exchange input and output data through arguments, configure the generated code to package Inport and Outport blocks into structures instead of allowing each block to appear as a separate argument (the default). Then, when you add or remove Inport or Outport blocks, or change their properties such as name and data type, the fields of the structures change, but the function interfaces do not change. See “Reduce Number of Arguments by Using Structures” on page 15-47.

• Set the data types of Inport and Outport blocks explicitly instead of using an inherited data type setting (which these blocks use by default). Inherited data type settings can cause the blocks to use different data types depending on the data types of upstream and downstream signals. For more information about configuring data types, see “Control Signal Data Types” (Simulink).

• With Embedded Coder, specify function names that do not depend on the model name. If you specify a naming rule with a function customization template, do not use the token $R in the rule. See “Control Names of Generated Entry-Point Functions (Embedded Coder)” on page 15-42.
Reduce Number of Arguments by Using Structures

Reducing the number of arguments of a function can improve the readability of the code and reduce consumption of stack memory. To create a structure argument that can pass multiple pieces of data at one time, use these techniques:

- Manually combine multiple Inport or Outport blocks so that they appear in the generated code as fields of a structure or substructure of a standard data structure. The generated entry-point function or functions accept the address of the structure as a separate argument or as a substructure (field) of the standard I/O structures.

Replace the Inport or Outport blocks with a single block, and configure the new block as a nonvirtual bus by using a Simulink.Bus object as the data type of the block. If your external code defines the structure type, consider using the Simulink.importExternalCTypes function to generate the bus object. See “Organize Data into Structures in Generated Code” on page 15-177 and Simulink.importExternalCTypes.

- When you generate reentrant code with Embedded Coder, configure Inport and Outport blocks to appear in aggregated structures by default. Set model configuration parameter Pass root-level I/O as to a setting other than Individual arguments.

- To package Inport and Outport blocks into the real-time model data structure, select Part of model data structure. The code generator aggregates the blocks into the default I/O structures to which the real-time model data structure points. The generated entry-point function or functions accept the real-time model data structure as a single argument. If you choose this setting, the function has the smallest number of arguments.

- To aggregate Inport blocks into a structure and Outport blocks into a different structure, select Structure reference. The generated entry-point function or functions accept the address of each structure as an argument. Another argument accepts the real-time model data structure. If you choose this setting, the inputs and outputs are more identifiable in the function interfaces.

With this setting, if you remove the root-level Inport blocks or the root-level Outport blocks, the function signature can change. Similarly, the signature can change if you add a root-level Inport or Outport block to a model that does not include such blocks.

- For more control over the characteristics of the structures, set Pass root-level I/O as to Part of model data structure. Then, set the default storage class for
Inport and Outport blocks to a structured storage class that you create. With this technique:

- You can create a single structure for the blocks or create two separate structures.
- You can control the names of the structure types.
- The structures appear as substructures of the real-time model data structure.

You must set **Pass root-level I/O as** to **Part of model data structure**.

Create the storage class by using the Embedded Coder Dictionary (see “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture” (Embedded Coder)). Apply the storage class by using the Code Mapping Editor (see “Configure Default Code Generation for Data” (Embedded Coder)).

For more information, see “Pass root-level I/O as”.

**Control Data Types of Arguments**

You can configure the generated entry-point functions to exchange data through arguments. For a scalar or array argument, to control the name of the primitive data type, use a Simulink.AliasType object to either set the data type of the corresponding block or to configure data type replacements for the entire model. These techniques require Embedded Coder. For more information, see “Control Data Type Names in Generated Code” (Embedded Coder).

**Promote Data Item to the Interface**

By default, the code generator assumes that Inport and Outport blocks at the root level of the model constitute the data interface of the model. You can promote an arbitrary signal, block parameter, or block state to the interface so that other systems and components can access it. See “Promote Internal Data to the Interface” on page 15-63.
See Also

Related Examples

- “Design Data Interface by Configuring Inport and Outport Blocks” on page 15-207
- “Interface Design” (Simulink)
- “Analyze the Generated Code Interface” (Embedded Coder)
- “Customize Generated C Function Interfaces” (Embedded Coder)
- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on page 26-102
- “Configure Generated Code According to Interface Control Document Interactively” (Embedded Coder)
- “Environment for Configuring Model Data and Functions for Code Generation” (Embedded Coder)
How Generated Code Stores Internal Signal, State, and Parameter Data

To calculate outputs from inputs, the generated code stores some internal data in global memory. A signal that does not connect to a root-level input or output (Inport or Outport block) is internal data.

Internal data can also include:

- A block state such as the state of a Unit Delay block. The algorithm must retain the state value between execution cycles, so the generated code typically stores states in global memory (for example, as a global variable or a field of a global structure variable).
- A block parameter, such as the Gain parameter of a Gain block, whose value the code generator cannot inline in the code. For example, the code generator cannot inline the value of a nonscalar parameter.
- The status indicator of a conditionally executed subsystem such as an enabled subsystem.

For more efficient code, you can configure optimizations such as Configuration Parameters > Default parameter behavior and Configuration Parameters > Signal storage reuse that attempt to eliminate storage for internal data. However, the optimizations cannot eliminate storage for some data, which consume memory in the generated code.

When you understand the default format in which the generated code stores internal data, you can:

- Make signals accessible and parameters tunable by default. You can then interact with and monitor the code during execution.
- Generate efficient production code by eliminating storage for internal data and, depending on your hardware and build toolchain, controlling the placement in memory of data that the optimizations cannot eliminate.
- Promote pieces of internal data to the model interface so that other components and systems can access that data.

For information about how the generated code exchanges data with a calling environment through interfaces, see “How Generated Code Exchanges Data with an Environment” on page 15-33.
Internal Data in the Generated Code

This example shows how the generated code stores internal data such as block states.

Explore Example Model

Open the example model rtwdemo_roll.

open_system('rtwdemo_roll')

The model contains internal signals that do not connect to root-level Inport or Outport blocks. Some of the signals have a name, such as the phiCmd signal.

The model also contains some blocks that maintain state data. For example, in the BasicRollMode subsystem, a Discrete-Time Integrator block labeled Integrator maintains a state.

In the model, set Configuration Parameters > Code Generation > System target file to grt.tlc.

set_param('rtwdemo_roll','SystemTargetFile','grt.tlc')
Inspect the setting for **Configuration Parameters > Code Generation > Interface > Code interface packaging**. The setting **Nonreusable function** means that the generated code is not reusable (reentrant).

For this example, generate simpler code by clearing **Configuration Parameters > Code Generation > Interface > Advanced parameters > Mat-file logging**.

```matlab
set_param('rtwdemo_roll','MatFileLogging','off')
```

**Generate Nonreusable Code**

Set these configuration parameters:

- Set **Default parameter behavior** to **Tunable**.
- Clear **Signal storage reuse**.

```matlab
set_param('rtwdemo_roll','DefaultParameterBehavior','Tunable',... 'OptimizeBlockIOStorage','off')
```

Generate code from the model.

```matlab
rtwbuild('rtwdemo_roll')
```

```matlab
### Starting build procedure for model: rtwdemo_roll
### Successful completion of build procedure for model: rtwdemo_roll
```

The file `rtwdemo_roll.h` defines several structure types that represent internal data. For example, the block input and output structure defines one field for each internal signal in the model. Each field name derives from the name of the block that generates the signal or, if you specify a name for the signal, from the name of the signal.

```matlab
file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.h');
rtwdemodbtype(file,...
  '/* Block signals (default storage) */','} B_rtwdemo_roll_T;',1,1)
```

```c
/* Block signals (default storage) */
typedef struct {
    real32_T phiCmd;         /* '<Root>/ModeSwitch' */
    real32_T Abs;            /* '<S3>/Abs' */
    real32_T FixPtUnitDelay1;/* '<S7>/FixPt Unit Delay1' */
    real32_T Xnew;           /* '<S7>/Enable' */
    real32_T TKSwitch;       /* '<S3>/TKSwitch' */
    real32_T RefSwitch;      /* '<S3>/RefSwitch' */
} B_rtwdemo_roll_T;
```

15 Data Representation in Simulink Coder
The file defines a structure type, the DWork structure, to represent block states such as the state of the Discrete-Time Integrator block.

```
real32_T Integrator;  /* '<S1>/Integrator' */
real32_T DispLimit;  /* '<S1>/DispLimit' */
real32_T Sum;  /* '<S1>/Sum' */
real32_T DispGain;  /* '<S1>/DispGain' */
real32_T RateLimit;  /* '<S1>/RateLimit' */
real32_T Sum1;  /* '<S1>/Sum1' */
real32_T RateGain;  /* '<S1>/RateGain' */
real32_T Sum2;  /* '<S1>/Sum2' */
real32_T CmdLimit;  /* '<S1>/CmdLimit' */
real32_T IntGain;  /* '<S1>/IntGain' */
real32_T hdgError;  /* '<S2>/Sum' */
real32_T DispGain_a;  /* '<S2>/DispGain' */
real32_T Product;  /* '<S2>/Product' */
boolean_T NotEngaged;  /* '<S3>/NotEngaged' */
boolean_T TKThreshold;  /* '<S3>/TKThreshold' */
boolean_T RefThreshold2;  /* '<S3>/RefThreshold2' */
boolean_T RefThreshold1;  /* '<S3>/RefThreshold1' */
boolean_T Or;  /* '<S3>/Or' */
boolean_T NotEngaged_e;  /* '<S1>/NotEngaged' */
} B_rtwdemo_roll_T;
```

The file defines a structure type, the DWork structure, to represent block states such as the state of the Discrete-Time Integrator block.

```
rtwdemodbtype(file,...
   '/* Block states (default storage) for system','} DW_rtwdemo_roll_T;',1,1)

/* Block states (default storage) for system '<Root>' */
typedef struct {
   real32_T FixPtUnitDelay1_DSTATE;  /* '<S7>/FixPt Unit Delay1' */
   real32_T Integrator_DSTATE;  /* '<S1>/Integrator' */
   int8_T Integrator_PrevResetState;  /* '<S1>/Integrator' */
} DW_rtwdemo_roll_T;
```

The file defines a structure type to represent parameter data. Each tunable block parameter in the model, such as the Gain parameter of a Gain block, appears as a field of this structure. If a block parameter acquires its value from a MATLAB variable or a Simulink.Parameter object, the variable or object appears as a field, not the block parameter.

The file also defines a structure type, the real-time model data structure, whose single field represents a run-time indication of whether the generated code has encountered an error during execution.
For the structure type that represents the real-time model data structure, the file `rtwdemo_roll_types.h` creates an alias that the generated code later uses to allocate memory for the structure.

Using these structure types, the file `rtwdemo_roll.c` defines (allocates memory for) global structure variables that store internal data for the generated algorithm. The file also defines variables that represent the real-time model data structure and a pointer to the structure.
The model step function, which represents the primary model algorithm, uses a **void** interface (with no arguments).

```c
/* Model step function */
void rtwdemo_roll_step(void)
```

In the function definition, the algorithm performs calculations and stores intermediate results in the signal and state structures by directly accessing the global variables. The algorithm also reads parameter data from the corresponding global variable. For example, in the **BasicRollMode** subsystem, the code generated for the **Integrator** block reads and writes signal, state, and parameter data from the structures.

```c
/* DiscreteIntegrator: '<S1>/Integrator' */
if (rtwdemo_roll_B.NotEngaged_e || (rtwdemo_roll_DW.Integrator_PrevResetState != 0)) {
    rtwdemo_roll_DW.Integrator_DSTATE = rtwdemo_roll_P.Integrator_IC;
}
if (rtwdemo_roll_DW.Integrator_DSTATE >= rtwdemo_roll_P.intLim) {
    rtwdemo_roll_DW.Integrator_DSTATE = rtwdemo_roll_P.intLim;
} else {
    if (rtwdemo_roll_DW.Integrator_DSTATE <= rtwdemo_roll_P.Integrator_LowerSat) {
        rtwdemo_roll_DW.Integrator_DSTATE = rtwdemo_roll_P.Integrator_LowerSat;
    }
}
rtwdemo_roll_B.Integrator = rtwdemo_roll_DW.Integrator_DSTATE;
```

Due to the **void** interface and the direct data access, the function is not reentrant. If you call the function multiple times in an application, each call writes data to the global structure variables and the subsequent call can read that data, resulting in unintentional interference between the calls.
The model initialization function `rtwdemo_roll_initialize` initializes all of the internal data to zero. The function also initializes the error status by calling a specialized macro function. The initialization function directly accesses the global variables, which means that the function is not reentrant.

```c
rtwdemodbtype(file,'/* Model initialize function */',... 'sizeof(DW_rtwdemo_roll_T));',1,1)

/* Model initialize function */
void rtwdemo_roll_initialize(void)
{
    /* Registration code */

    /* initialize error status */
    rtmSetErrorStatus(rtwdemo_roll_M, (NULL));

    /* block I/O */
    (void) memset(((void *) &rtwdemo_roll_B), 0,
                  sizeof(B_rtwdemo_roll_T));

    /* states (dwork) */
    (void) memset((void *)&rtwdemo_roll_DW, 0,
                  sizeof(DW_rtwdemo_roll_T));

    The function then initializes the block states in the DWork structure to the initial values that the block parameters in the model specify. Two of the three states in the model have tunable initial values, so the code initializes them by reading data from the parameters structure.

rtwdemodbtype(file,...
    '/* SystemInitialize for Atomic SubSystem: '<Root>/RollAngleReference'' */,...
    '/* Model terminate function */',1,0)

    /* SystemInitialize for Atomic SubSystem: '<Root>/RollAngleReference' */
    /* InitializeConditions for UnitDelay: '<S7>/FixPt Unit Delay1' */
    rtwdemo_roll_DW.FixPtUnitDelay1_DSTATE = rtwdemo_roll_P.LatchPhi_vinit;

    /* End of SystemInitialize for SubSystem: '<Root>/RollAngleReference' */

    /* SystemInitialize for Atomic SubSystem: '<Root>/BasicRollMode' */
    /* InitializeConditions for DiscreteIntegrator: '<S1>/Integrator' */
    rtwdemo_roll_DW.Integrator_DSTATE = rtwdemo_roll_P.Integrator_IC;
    rtwdemo_roll_DW.Integrator_PrevResetState = 0;
```
Generate Reusable Code

You can configure the generated code as reentrant, which means you can call the entry-point functions multiple times in an application. With this configuration, instead of directly accessing global variables, the entry-point functions accept internal data through formal parameters (pointer arguments). With these pointer arguments, each call can maintain internal data in a set of separate global variables, preventing unintentional interaction between the calls.

In the model, set Configuration Parameters > Code Generation > Interface > Code interface packaging to Reusable function.

```matlab
set_param('rtwdemo_roll','CodeInterfacePackaging','Reusable function')
```

Generate code from the model.

```matlab
rtwbuild('rtwdemo_roll')
```

Now, in rtwdemo_roll.h, the real-time model data structure contains pointers to the error indication, the internal data, and primary input and output data in the form of ExtU and ExtY substructures (the fields of which represent Inport and Outport blocks at the root level of the model).

```matlab
file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.h');
rtwdemodbtype(file,'/* Real-time Model Data Structure */','/* External data declarations for dependent source files */',1,0)
```

```c
/* Real-time Model Data Structure */
struct tag_RTM_rtwdemo_roll_T {
    const char_T *errorStatus;
    B_rtwdemo_roll_T *blockIO;
    P_rtwdemo_roll_T *defaultParam;
    ExtU_rtwdemo_roll_T *inputs;
    ExtY_rtwdemo_roll_T *outputs;
    boolean_T paramIsMalloced;
    DW_rtwdemo_roll_T *dwork;
};
```

15-57
To call the generated code multiple times in an application, your code must allocate memory for a real-time model data structure per call. The file `rtwdemo_roll.c` defines a specialized function that allocates memory for a new real-time model data structure and returns a pointer to the structure. The function also allocates memory for the substructures that the fields in the model data structure point to, such as the DWork structure.

```c
file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
rtwdemodbtype(file,'/* Model data allocation function */','RT_MODEL_rtwdemo_roll_T *rtwdemo_roll(void)',1,1)

/* Model data allocation function */
RT_MODEL_rtwdemo_roll_T *rtwdemo_roll(void)

The model step function accepts an argument that represents the real-time model data structure.

```c
rtwdemodbtype(file,'/* Model step function */','void rtwdemo_roll_step',1,1)

/* Model step function */
void rtwdemo_roll_step(RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M)

In the function definition, the algorithm first extracts each pointer from the real-time model data structure into a local variable.

```c
rtwdemodbtype(file,'*rtwdemo_roll_P_e =','rtwdemo_roll_M->outputs;',1,1)

P_rtwdemo_roll_T *rtwdemo_roll_P_e = ((P_rtwdemo_roll_T *) rtwdemo_roll_M->defaultParam);
B_rtwdemo_roll_T *rtwdemo_roll_B = ((B_rtwdemo_roll_T *) rtwdemo_roll_M->blockIO);
DW_rtwdemo_roll_T *rtwdemo_roll_DW = ((DW_rtwdemo_roll_T *) rtwdemo_roll_M->dwork);
ExtU_rtwdemo_roll_T *rtwdemo_roll_U = (ExtU_rtwdemo_roll_T *) rtwdemo_roll_M->inputs;
ExtY_rtwdemo_roll_T *rtwdemo_roll_Y = (ExtY_rtwdemo_roll_T *) rtwdemo_roll_M->outputs;

Then, to access the internal data stored in global memory, the algorithm interacts with these local variables.
rtwdemodbtype(file,'/* DiscreteIntegrator: '<S1>/Integrator' */',...  
'/* End of DiscreteIntegrator: '<S1>/Integrator' */',1,1)

    /* DiscreteIntegrator: '<S1>/Integrator' */
    if (rtwdemo_roll_B->NotEngaged_e ||
        (rtwdemo_roll_DW->Integrator_PrevResetState != 0)) {
        rtwdemo_roll_DW->Integrator_DSTATE = rtwdemo_roll_P_e->Integrator_IC;
    }

    if (rtwdemo_roll_DW->Integrator_DSTATE >= rtwdemo_roll_P_e->intLim) {
        rtwdemo_roll_DW->Integrator_DSTATE = rtwdemo_roll_P_e->intLim;
    } else {
        if (rtwdemo_roll_DW->Integrator_DSTATE <= rtwdemo_roll_P_e->Integrator_LowerSat) {
            rtwdemo_roll_DW->Integrator_DSTATE = rtwdemo_roll_P_e->Integrator_LowerSat;
        }
    }

    rtwdemo_roll_B->Integrator = rtwdemo_roll_DW->Integrator_DSTATE;

Similarly, the model initialization function accepts the real-time model data structure as
an argument.

rtwdemodbtype(file,...
    '/* Model initialize function */','void rtwdemo_roll_initialize',1,1)

    /* Model initialize function */
void rtwdemo_roll_initialize(RT_MODEL_rtwdemo_roll_T *const rtwdemo_roll_M)

Because each call that you make to an entry-point function interacts with a separate real-
time model data structure, you avoid unintentional interaction between the calls.

**Eliminate Internal Data with Code Generation Optimizations**

For more efficient code that consumes less memory, select the optimizations, such as
**Default parameter behavior**, that you cleared earlier.

set_param('rtwdemo_roll','DefaultParameterBehavior','Inlined',...
    'OptimizeBlockIOStorage','on',...
    'LocalBlockOutputs','on')
In this example, for simpler code, set **Code interface packaging** to **Nonreusable function**.

```plaintext
def set_param('rtwdemo_roll','CodeInterfacePackaging','Nonreusable function')
```

Generate code from the model.

```plaintext
def rtwbuild('rtwdemo_roll')
### Starting build procedure for model: rtwdemo_roll
### Successful completion of build procedure for model: rtwdemo_roll
```

Now, `rtwdemo_roll.h` does not define a structure for block inputs and outputs. For all of the internal signals in the model, the optimizations either eliminated storage or created local function variables instead of global structure fields.

The optimizations were not able to eliminate storage for the three block states, so the file continues to define the DWork structure type.

```plaintext
file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.h');
def rtwmoddbtype(file,...
   '/* Block states (default storage) for system','} DW_rtwdemo_roll_T;',1,1)
typedef struct {
   real32_T FixPtUnitDelay1_DSTATE;   /* '<S7>/FixPt Unit Delay1' */
   real32_T Integrator_DSTATE;        /* '<S1>/Integrator' */
   int8_T Integrator_PrevResetState;  /* '<S1>/Integrator' */
} DW_rtwdemo_roll_T;
```

The code generated for the Discrete-Time Integrator block now stores state and output data only in the DWork structure.

```plaintext
file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
def rtwmodbtype(file,'/* Update for DiscreteIntegrator: ''<S1>/Integrator''','...
   '/* End of Update for DiscreteIntegrator: ''<S1>/Integrator'' */',1,1)
/* Update for DiscreteIntegrator: '<S1>/Integrator' incorporates:
 * Gain: '<S1>/IntGain'
 */
rtwdemo_roll_DW.Integrator_DSTATE += 0.5F * rtb_TKSwitch * 0.025F;
if (rtwdemo_roll_DW.Integrator_DSTATE >= 5.0F) {
   rtwdemo_roll_DW.Integrator_DSTATE = 5.0F;
}
```
The optimizations also eliminated storage for the block parameters in the model. For example, in the Discrete-Time Integrator block, the **Upper saturation limit** and **Lower saturation limit** parameters are set to `intLim` and `-intLim`. `intLim` is a `Simulink.Parameter` object that stores the value 5. In the code generated for the Discrete-Time Integrator, these block parameters and `intLim` appear as inlined literal numbers `5.0F` and `-5.0F`.

If a model contains a parameter that the code generator cannot inline directly (for example, an array parameter), the code defines a structure type that represents the data. This *constant parameters* structure uses the `const` storage type qualifier, so some build toolchains can optimize the assembly code further.

**Local Variables in the Generated Code**

When you select the optimization **Configuration Parameters > Enable local block outputs**, the code generator attempts to yield more efficient code by representing internal signals as local variables instead of fields of a global structure. If the memory consumed by local variables risks exceeding the stack space available on your target hardware, consider indicating the maximum stack size by setting **Configuration Parameters > Maximum stack size (bytes)**. For more information, see “Maximum stack size (bytes)”. 

**Appearance of Test Points in the Generated Code**

A *test point* is a signal that is stored in a unique memory location. For information about including test points in your model, see “Test Points” (Simulink).

When you generate code for models that include test points, the build process allocates a separate memory buffer for each test point. By default, test points are stored as members of an appropriate standard data structure such as `model_B`.

If you have Embedded Coder:
• You can control the default representation of test points by specifying code generation settings for the **Internal data** category of data in the Code Mapping Editor (see “Configure Default Code Generation for Data” (Embedded Coder)).

• You can specify that the build process ignore test points in the model, allowing optimal buffer allocation, by using the “Ignore test point signals” parameter. Ignoring test points facilitates transitioning from prototyping to deployment and avoids accidental degradation of generated code due to workflow artifacts. See “Ignore test point signals”.

Virtual buses do not appear in generated code, even when associated with a test point. To display a bus in generated code, use a nonvirtual bus or a virtual bus converted to a nonvirtual bus by a Signal Conversion block.

### Appearance of Workspace Variables in the Generated Code

Workspace variables are variables that you use to specify block parameter values in a model. Workspace variables include numeric MATLAB variables and `Simulink.Parameter` objects that you store in a workspace, such as the base workspace, or in a data dictionary.

When you set **Default parameter behavior** to **Tunable**, by default, workspace variables appear in the generated code as tunable fields of the global parameters structure. If you use such a variable to specify multiple block parameter values, the variable appears as a single field of the global parameters structure. The code does not create multiple fields to represent the block parameters. Therefore, tuning the field value during code execution changes the mathematical behavior of the model in the same way as tuning the value of the MATLAB variable or parameter object during simulation.

If you have Embedded Coder, you can control the default representation of workspace variables by specifying code generation settings for categories of parameter data in the Code Mapping Editor (see “Configure Default Code Generation for Data” (Embedded Coder)).

• The **Local parameters** category applies to variables that you store in a model workspace.

• The **Global parameters** category applies to variables that you store in the base workspace or a data dictionary.
Promote Internal Data to the Interface

By default, the code generator assumes that other systems and components in your application do not need to access internal data. For example, internal data are subject to optimizations that can eliminate them from the generated code. For prototyping and testing purposes, you can access internal data by clearing the optimizations or by configuring test points and applying storage classes (see “Configure Data Accessibility for Rapid Prototyping” on page 15-3). For optimized production code, configure individual data items to appear in the generated code as part of the model interface.

Data That You Can Promote

Depending on the reentrancy of the generated code, that is, the setting that you choose for **Code interface packaging**, you can configure each data item in a model to participate in the interface by appearing in the code as one of these entities:

- A global symbol, such as a global variable or a call to a specialized function
- A formal parameter (argument) of the generated entry-point functions

The table shows the mechanisms that each category of data can use to participate in the interface.

<table>
<thead>
<tr>
<th>Category of Data</th>
<th>Appear as Global Symbol</th>
<th>Appear as Argument of Entry-Point Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root-level Inport or Outport block</td>
<td>Only for a nonreentrant model.</td>
<td>Yes.</td>
</tr>
<tr>
<td>Signal connecting two blocks</td>
<td>Only for a nonreentrant model.</td>
<td>Only for a reentrant model and only as a field of a structure. Alternatively, connect the signal to a root-level Outport block.</td>
</tr>
<tr>
<td>Block state</td>
<td>Only for a nonreentrant model.</td>
<td>Only for a reentrant model and only as a field of a structure.</td>
</tr>
<tr>
<td>Category of Data</td>
<td>Appear as Global Symbol</td>
<td>Appear as Argument of Entry-Point Function</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>-------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Data store such as a Data Store Memory block</td>
<td>Yes.</td>
<td>Only for a reentrant model and only as a field of a structure.</td>
</tr>
<tr>
<td>Block parameter or parameter object such as Simulink.Parameter</td>
<td>Yes.</td>
<td>Only as a field of a structure.</td>
</tr>
</tbody>
</table>

**Single-Instance Algorithm**

For a single-instance algorithm (you set Code interface packaging to Nonreusable function), apply storage classes directly to individual data items by using the Model Data Editor or the Property Inspector. With a directly applied storage class, a data item appears in the code as a global symbol such as a global variable. The storage class also prevents optimizations from eliminating storage for the data item.

You can apply storage classes to signals, block states, and block parameters. (For block parameters, you apply storage classes indirectly through parameter objects such as Simulink.Parameter). However, for a signal, consider connecting the signal to an Outport block at the root level of the model. Then, optionally, you can apply a storage class to the block. In the block diagram, the Outport block shows that the signal represents a system output.

For more information about storage classes, see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82.

**Reentrant Algorithm**

For a reentrant algorithm (you set Code interface packaging to Reusable function), use different techniques to configure data items to appear in the code as formal parameters (arguments) of the generated entry-point functions.

- For an internal signal, directly apply the storage class Model default (see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82). If you have Embedded Coder, in the Code Mapping Editor, for the Internal data category, set the default storage class to Default or to a structured storage class that you define in an Embedded Coder Dictionary (see “Create Code Definitions for Use as Default Code Generation Settings” (Embedded Coder)). Alternatively, configure the signal as a test point (see “Appearance of Test Points in the Generated
By default, the signal appears as a field of one of the standard data structures (see “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50). If you do not want the signal to appear in production code, use a test point so that you can later select the model configuration parameter **Ignore test point signals**.

Alternatively, connect the signal to an Outport block at the root level of the model. Connecting the signal to a root-level Outport block prevents optimizations from eliminating the signal from the code. To help with signal routing in a large model, use Goto and From blocks.

- For a block parameter, create a parameter object such as `Simulink.Parameter` and directly apply a storage class other than `Auto` to the object. The storage class prevents optimizations from inlining the parameter value in the code.

  With the storage class, the parameter is shared between all instances of the model, which are calls to the entry-point functions. The functions access the parameter data directly, as a global symbol, not an argument. You cannot configure a parameter to appear in the code as an argument, so you cannot enable each instance of the model to use a different value for the parameter.

  For information about applying storage classes, see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82.

**Control Default Representation of Internal Data (Embedded Coder)**

By default, the code generator aggregates internal data that optimizations cannot eliminate, such as most state data, into standard structures such as the DWork structure. With Embedded Coder, you can control how the generated code stores this data.

**Control Placement of Data in Memory by Inserting Pragmas**

Use the Code Mapping Editor to specify a default memory section for each category of data such as states and signals (**Internal data**). In the generated code, your custom pragmas or other decorations surround the data definitions and declarations.

You can also partition the structures according to atomic subsystems in your model so that you can specify different default memory sections for the data of subroutines and other algorithmic subcomponents.
For more information, see “Control Data and Function Placement in Memory by Inserting Pragmas” (Embedded Coder).

Control Names of Types, Fields, and Global Variables for Standard Data Structures

You can control some characteristics of the standard data structures. For more information, see “Control Characteristics of Data Structures (Embedded Coder)” on page 15-27.

For additional control over structure characteristics, such as placement in generated code files, create your own structured storage class by using the Embedded Coder Dictionary. Then, apply the storage class to categories of data by using the Code Mapping Editor. The storage class removes the data from the standard structures, creating other structures that you can more finely control. For more information about applying default storage classes to categories of data, see “Configure Default Code Generation for Data” (Embedded Coder). For more information about creating a storage class, see “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture” (Embedded Coder).

Organize Data into Structures According to Subcomponents

- In the standard data structures, to create substructures that contain the data for a single-instance (nonreentrant) subroutine or subcomponent, use an atomic subsystem to encapsulate the corresponding blocks. In the subsystem parameters, set Function packaging to Reusable function. For more information, see “Generate Modular Function Code for Nonvirtual Subsystems” (Embedded Coder).

Alternatively, encapsulate the blocks in a model and use a Model block. In the referenced model, set Configuration Parameters > Model Referencing > Total number of instances allowed per top model to Multiple. For more information, see “Code Generation of Referenced Models” on page 7-2.

- To create separate, standalone structures that contain the data for a multi-instance (reentrant) subroutine or subcomponent, in the model, use an atomic subsystem to encapsulate the corresponding blocks. In the subsystem parameters, set Function packaging to Nonreusable function and select Function with separate data. For more information, see “Generate Modular Function Code for Nonvirtual Subsystems” (Embedded Coder).

Alternatively, encapsulate the blocks in a model and use a Model block. In the referenced model, choose one of these techniques:
• Set **Configuration Parameters > Model Referencing > Total number of instances allowed per top model** to `One`. For more information, see “Code Generation of Referenced Models” on page 7-2.

• Set **Total number of instances allowed per top model** to Multiple and create a structured storage class by using an Embedded Coder Dictionary. Then, apply the storage class to categories of data by using the Code Mapping Editor. To create a storage class, see “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture” (Embedded Coder). To apply the storage class to categories of data, see “Configure Default Code Generation for Data” (Embedded Coder).

**Organize Signal and Parameter Data into Meaningful, Custom Structures and Substructures**

To organize arbitrary signals and parameters into custom structures and substructures, create nonvirtual bus signals and parameter structures. Optionally, to prevent optimizations from eliminating the data from the code, set the storage class of a bus signal or parameter structure to a value other than `Auto` (the default setting).

As you add blocks to the model, you must explicitly place each new signal and parameter into a bus or a structure.

For more information, see “Organize Data into Structures in Generated Code” on page 15-177.

**Create Separate Global Variables Instead of Structure Fields**

To make a category of internal data appear in the generated code as separate, unstructured global variables instead of fields of a standard data structure, apply an unstructured storage class to the data category by using the Code Mapping Editor. For example, apply the storage class `ExportedGlobal`. However, if you generate multi-instance, reentrant code by setting the configuration parameter **Code interface packaging** to a value other than *Nonreusable function*, you cannot use this technique for some categories of data (see “Use Storage Classes in Reentrant, Multi-Instance Models and Components” on page 15-80).

To apply default storage classes to categories of data by using the Code Mapping Editor, see “Configure Default Code Generation for Data” (Embedded Coder). To choose a storage class, see “Choose Storage Class for Controlling Data Representation in Generated Code” on page 15-69.
See Also

Related Examples

- “Standard Data Structures in the Generated Code” on page 15-26
- “Use the Real-Time Model Data Structure” on page 15-29
- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “Environment for Configuring Model Data and Functions for Code Generation” (Embedded Coder)
Choose Storage Class for Controlling Data Representation in Generated Code

A storage class is a code generation setting that you apply to model data, such as signals, block parameters, and states. Use storage classes to control the appearance of data elements in the generated code.

The table shows built-in storage classes that you can choose. These storage classes come with Simulink Coder.
<table>
<thead>
<tr>
<th>Storage Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>Auto is the default storage class setting for each data element in a model. The data element is subject to code generation optimizations, which can eliminate the element from the code or change the representation of the element. For information about these optimizations, such as those on the <strong>Configuration Parameters &gt; Code Generation &gt; Optimization</strong> pane, see “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50. Optimizations cannot eliminate some data, such as most block states, from the code. This remaining data acquire the appropriate default storage class that you specify with the Code Mapping Editor (see “Configure Default Code Generation for Data” (Embedded Coder)—requires Embedded Coder). If you leave the storage class setting in the Code Mapping Editor at the default value, Default, the data element appears as a field of the appropriate standard data structure (see “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50). If optimizations cannot eliminate the data element, the name of the element in the code is based on naming rules that you specify with model configuration parameters (see “Identifier Format Control” (Embedded Coder)—requires Embedded Coder). Use this storage class to enable optimizations to operate on the data</td>
</tr>
<tr>
<td>Storage Class Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>element, potentially generating more efficient code.</td>
<td>The data element acquires the corresponding default storage class that you specify with the Code Mapping Editor. The name of the data element in the code is the same as the name in the model. Use this storage class to prevent optimizations from eliminating storage for a data element (see “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50).</td>
</tr>
<tr>
<td>The data element acquires the corresponding default storage class that you specify with the Code Mapping Editor. The name of the data element in the code is the same as the name in the model. Use this storage class to prevent optimizations from eliminating storage for a data element (see “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50).</td>
<td>Generate a global variable definition and declaration. The name of the variable is the name of the data element. The code declares the variable in the generated file model.h, which you can include (#include) in your external code.</td>
</tr>
<tr>
<td>Generate code that reads from and writes to a global variable defined by your external code. The generated code declares the variable in the generated file model_private.h so that the model entry-point functions can read and write to the variable. Use this storage class to make a data element in a model represent a global variable that your external code defines. The generated algorithmic code uses the variable without defining it.</td>
<td>Generate code that reads from and writes to a global variable defined by your external code. The generated code declares the variable in the generated file model_private.h so that the model entry-point functions can read and write to the variable. Use this storage class to make a data element in a model represent a global variable that your external code defines. The generated algorithmic code uses the variable without defining it.</td>
</tr>
</tbody>
</table>
### Storage Class Name

<table>
<thead>
<tr>
<th>Storage Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ImportedExternPointer</td>
<td>Generate code that reads from and writes to a global pointer variable defined by your external code. The generated code declares the variable in the generated file <code>model_private.h</code> and reads and writes to the data by dereferencing the pointer. Use this storage class when your external code defines a data element and provides a pointer for accessing that data.</td>
</tr>
</tbody>
</table>

If you have Embedded Coder, you can choose additional built-in storage classes, shown in the next table.

<table>
<thead>
<tr>
<th>Storage Class Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BitField</td>
<td>Generate a structure that stores Boolean data in named bit fields. For an example, see “Bitfields” (Embedded Coder). You cannot use this storage class in the Code Mapping Editor.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Use for Signal or State Data</th>
<th>Use for Parameter Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Storage Class Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>CompilerFlag</td>
<td>Supports preprocessor conditionals defined via compiler flag or option. See “Generate Preprocessor Conditionals for Variant Systems” (Embedded Coder). If you build the generated code by using Embedded Coder (you clear Configuration Parameters &gt; Generate code only), to specify the compiler option, you can use the model configuration parameter Configuration Parameters &gt; Code Generation &gt; Custom Code &gt; Additional build information &gt; Defines. See Code Generation Pane: Custom Code: Additional Build Information: Defines.</td>
</tr>
<tr>
<td>Const</td>
<td>Generate a global variable definition and declaration with the const type qualifier.</td>
</tr>
<tr>
<td>ConstVolatile</td>
<td>Generate a global variable definition and declaration with the const and volatile type qualifiers. For an example, see “Type Qualifiers” (Embedded Coder).</td>
</tr>
<tr>
<td>Define</td>
<td>Generate a macro (#define directive) such as #define myParam 5. For an example, see “Macro Definitions (#define)” (Embedded Coder).</td>
</tr>
<tr>
<td>ExportToFile</td>
<td>Generate a global variable definition and declaration. You can specify the names of the files that define and declare the variable.</td>
</tr>
<tr>
<td>Storage Class Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>FileScope</td>
<td>Generate a global variable definition and declaration with the static type qualifier. In the generated code, the scope of the variable is limited to the current file, which is typically <em>model.c</em>. In a model reference hierarchy, if a referenced model uses a parameter object (such as <code>Simulink.Parameter</code>) that you create in the base workspace or a data dictionary, you cannot apply FileScope to the object. As a workaround, move the parameter object into the model workspace of the referenced model. Then, you can use FileScope.</td>
</tr>
<tr>
<td>GetSet</td>
<td>Generate code that interacts with data by calling your custom accessor functions. Your external code defines the data and provides the function definitions. For examples, see “Access Data Through Functions with Custom Storage Class GetSet” (Embedded Coder).</td>
</tr>
<tr>
<td>ImportedDefine</td>
<td>Generate code that uses a macro (#define directive) defined in a header file in your external code. For an example, see “Macro Definitions (#define)” (Embedded Coder).</td>
</tr>
<tr>
<td>ImportFromFile</td>
<td>Generate code that reads from and writes to a global variable defined by your external code. Similar to ExportToFile, but the generated code does not define the variable.</td>
</tr>
<tr>
<td>Storage Class Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Reusable</td>
<td>Generate more efficient code that stores intermediate calculations of a data path (a series of connected blocks) in a single, reused global variable. For an example, see “Specify Buffer Reuse by Using Simulink.Signal Objects” (Embedded Coder). You can apply this storage class only to a Simulink.Signal object that represents multiple signal lines in a model.</td>
</tr>
<tr>
<td>Struct</td>
<td>Generate a global structure whose name you can specify. For examples, see “Organize Parameter Data into a Structure by Using the Struct Custom Storage Class” (Embedded Coder) and “Structures of Signals” (Embedded Coder). You cannot use this storage class in the Code Mapping Editor.</td>
</tr>
<tr>
<td>Volatile</td>
<td>Generate a global variable definition and declaration with the volatile type qualifier.</td>
</tr>
<tr>
<td>ParamStruct</td>
<td>Generate global structures that contain parameter data. In a hierarchy of components (referenced models or atomic subsystems), you can use this storage class to create a corresponding hierarchy of parameter structures. This storage class appears only in the Code Mapping Editor for the data category called Local parameters.</td>
</tr>
<tr>
<td>Storage Class Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>SignalStruct</td>
<td>Generate global structures that contain signal or state data. In a hierarchy of components (referenced models or atomic subsystems), you can use this storage class to create a corresponding hierarchy of signal and state structures. This storage class appears only in the Code Mapping Editor.</td>
</tr>
<tr>
<td>Localizable</td>
<td>For signals, if possible, generate variables that are local to functions rather than in global storage. Generating local variables prevents the code generator from implementing optimizations that remove the variables from the generated code. For an example, see “Generate Local Variables with Localizable Custom Storage Class” (Embedded Coder).</td>
</tr>
</tbody>
</table>

These storage classes are examples of storage classes that you can add to an Embedded Coder Dictionary. These examples are defined and made available when you prepare a model for code generation with the Quick Start tool.
<table>
<thead>
<tr>
<th>Storage Class Name</th>
<th>Description</th>
<th>Use for Signal or State Data</th>
<th>Use for Parameter Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>ParamStruct</td>
<td>Generate global structures that contain parameter data. In a hierarchy of components (referenced models or atomic subsystems), you can use this example storage class to create a corresponding hierarchy of parameter structures. This storage class appears only in the Code Mapping Editor for data category Local parameters after preparing a model for code generation with the Quick Start tool.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>SignalStruct</td>
<td>Generate global structures that contain signal or state data. In a hierarchy of components (referenced models or atomic subsystems), you can use this example storage class to create a corresponding hierarchy of signal and state structures. This storage class appears only in the Code Mapping Editor after preparing a model for code generation with the Quick Start tool.</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

When you generate reentrant, multi-instance code, limitations and restrictions apply if you want to use storage classes. See “Use Storage Classes in Reentrant, Multi-Instance Models and Components” on page 15-80.

**Specify File Names and Other Data Attributes With Storage Class (Embedded Coder)**

After you apply some storage classes, such as ExportToFile, you can specify additional settings such as declaration (header) and definition file names. In the Code Mapping Editor, to access these additional settings, you use the Property Inspector.

With other storage classes, you cannot specify additional settings.
• These built-in Simulink Coder storage classes do not allow you to specify additional settings:
  • ExportedGlobal
  • ImportedExtern
  • ImportedExternPointer
• The built-in Embedded Coder storage classes typically allow you to specify declaration and definition file names.
• For the ExportToFile storage class, the definition file setting is honored only for single-instance models. The setting is ignored for reusable multi-instance models because the data definition is handled at the parent level.
• When you create a storage class with the Custom Storage Class Designer, you can choose whether the user of the storage class can specify additional settings. See “Allow Users of Custom Storage Class to Specify Property Value” (Embedded Coder).

Specify Default #include Syntax for Header Files That Declare Data (Embedded Coder)

To control the file placement of a data item, such as a signal line or block state, in the generated code, you can apply a storage class to the data item (see “Apply Custom Storage Classes to Individual Signal, State, and Parameter Data Elements” (Embedded Coder)). You then use the Header file custom attribute to specify the generated or external header file that contains the declaration of the data.

To reduce maintenance effort and data entry, when you specify Header file, you can omit delimiters (" or <> ) and use only the file name. You can then control the default delimiters that the generated code uses for the corresponding #include directives. To use angle brackets by default, set Configuration Parameters > Code Generation > Code Placement > #include file delimiters to #include <header.h>.

Storage Class Limitations

• When you use storage classes in the Code Mapping Editor (Embedded Coder), some limitations apply. See “Limitations” (Embedded Coder).
• Data objects cannot use an Embedded Coder storage class and a multiword data type.
• The Fcn block does not support parameters with an Embedded Coder storage class in code generation.
• For Embedded Coder storage classes in models that use referenced models:

  • If you apply a grouped storage class to multiple data items, the storage class `Data scope` property must be set to `Imported` and you must provide the data declaration in an external header file. Grouped storage classes use a single variable in the generated code to represent multiple data objects. For example, the storage classes `BitField` and `Struct` are grouped storage classes.

  • If a parameter object exists in the base workspace or a data dictionary, and a referenced model uses the object, you cannot apply the storage class `FileScope`. As a workaround, move the object into the model workspace of the referenced model. Then, you can use `FileScope`.

  • You cannot apply the storage class `FileScope` to data items used by a data exchange interface (C API, external mode, or ASAP2) or MAT-file logging. File-scoped data is not externally accessible.

**See Also**

**Related Examples**

- “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82
- “Apply Custom Storage Classes to Individual Signal, State, and Parameter Data Elements” (Embedded Coder)
- “Configure Default C Code Generation for Categories of Model Data and Functions” (Embedded Coder)
- “Control Data and Function Interface in Generated Code” on page 15-42
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Use Storage Classes in Reentrant, Multi-Instance Models and Components

The code that you generate from a model or component (referenced model or subsystem) is multi-instance code if it allows your application to maintain multiple independent instances of the component during execution. For example, you can generate reentrant, multi-instance code from an entire model by setting the model configuration parameter **Code interface packaging** to **Reusable function**. For general information about multi-instance models and components, see “Code Reuse”.

Under some circumstances, applying storage classes can:

- Prevent you from generating multi-instance code.
- Cause some data elements to appear in the generated code as singletons, which means that each instance of the model or component directly accesses the same shared, global data, creating dependencies between the instances.

To avoid errors and unexpected generation of single-instance code and singleton data, observe the guidelines and limitations below.

**Directly Applied Storage Classes**

When you apply a storage class directly to a data element (see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82):

- To generate multi-instance code, you must apply the storage class only to parameter objects, global data stores, shared local data stores, and root-level I/O.
- The storage class yields only singleton data.

**Storage Classes Applied by Default**

When you apply a default storage class by using the Code Mapping Editor (see “Configure Default Code Generation for Data” (Embedded Coder)—requires Embedded Coder):

- For these data categories, you can generate only singleton data:
  - **Local parameters**
  - **Global parameters**
• Global data stores
• Shared local data stores

• For Internal data, you can generate only instance-specific data, which means each instance of the model or component operates on a separate copy of the data. For this category, you must use the built-in storage class SignalStruct or create your own structured storage class by using an Embedded Coder Dictionary.

See Also

Related Examples
• “What Is Reentrant Code?” on page 9-4
• “Choose Storage Class for Controlling Data Representation in Generated Code” on page 15-69
Apply Storage Classes to Individual Signal, State, and Parameter Data Elements

A storage class is a code generation setting that you apply to a data item (signal, block parameter, or state) in a model. When you directly apply it to a data item, a storage class:

• Causes the data item to appear in the generated code as a global symbol, typically a global variable.
• Prevents optimizations such as Default parameter behavior and Signal storage reuse from eliminating the data item from the generated code.
• With Embedded Coder, you can configure the format in which the generated code stores or otherwise defines the data item. For example, you can apply the storage type qualifiers const or volatile or configure a parameter data item to appear as a macro (#define).

Directly apply storage classes to individual data items to:

• Tune parameters and monitor signals and states during execution.
• Configure data placement in memory through memory sections.
• Generate code that exchanges data (for example, global variables) with your external code.

For information about applying storage classes to categories of data by default, by using the Code Mapping Editor, see “Configure Default Code Generation for Data” (Embedded Coder).

Apply Storage Classes to Data Items

This example shows how to apply storage classes to a signal, a block state, and a block parameter in a model.

Explore Example Model

Open the example model rtwdemo_roll.

open_system(‘rtwdemo_roll’)
Navigate into the BasicRollMode subsystem.

```matlab
open_system('rtwdemo_roll/BasicRollMode')
```

The subsystem contains an Integrator block, which maintains a piece of state data.
From the root level of the model, navigate into the RollAngleReference subsystem.

```matlab
open_system('rtwdemo_roll/RollAngleReference')
```

The subsystem contains a Constant block labeled UpThr.

In this example, you configure the state and output signal of the Integrator block and the **Constant value** parameter of the Constant block to appear in the generated code as separate global variables.

**Apply Storage Classes**

Navigate to the root level of the model.

Select **View > Model Data Editor**.

To see the data items in the subsystems, activate the **Change scope** button.

Select the **Signals** tab.

Set the **Change view** drop-down list to **Code**.

In the **Filter contents** box, enter **integrator**.

Optionally, use the **Name** column to specify a name for the output signal of the Integrator block, such as **mySignal**.
Use the **Storage Class** column to apply the storage class `ExportedGlobal`.

Select the **States** tab.

Optionally, use the **Name** column to specify a name for the state, such as `myState`.

Use the **Storage Class** column to apply the storage class `ExportedGlobal`.

Select the **Parameters** tab. You cannot apply a storage class directly to a block parameter. Instead, you must create a parameter object, such as `Simulink.Parameter`, use the object to set the value of the block parameter, and apply the storage class to the object.

Set the **Change view** drop-down list to **Design**.

In the **Filter contents** box, enter `UpThr`.

Use the **Value** column to change the parameter value from 6 to `UpThr`.

While editing the parameter value, next to `UpThr`, click the action button (with three vertical dots) and select **Create**.

In the **Create New Data** dialog box, set **Value** to `Simulink.Parameter` and click **OK**. A `Simulink.Parameter` object named `UpThr` appears in the base workspace.

In the `UpThr` property dialog box, set **Value** to 6 and **Storage class** to `ExportedGlobal`. Click **OK**.

Alternatively, you can use these commands at the command prompt to configure the signal, state, and parameter data.

```matlab
% Configure signal
portHandles = get_param('rtwdemo_roll/BasicRollMode/Integrator',... 'PortHandles');
outportHandle = portHandles.Outport;
set_param(outportHandle,'Name','mySignal')
set_param(outportHandle,'StorageClass','ExportedGlobal')

% Configure state
set_param('rtwdemo_roll/BasicRollMode/Integrator',... 'StateName','myState')
set_param('rtwdemo_roll/BasicRollMode/Integrator',... 'StateStorageClass','ExportedGlobal')
```
% Configure parameter
set_param('rtwdemo_roll/RollAngleReference/UpThr','Value','UpThr')
UpThr = Simulink.Parameter(6);
UpThr.StorageClass = 'ExportedGlobal';

**Generate and Inspect Code**

Generate code from the model.

set_param('rtwdemo_roll','SystemTargetFile','grt.tlc')
rtwbuild('rtwdemo_roll')

### Starting build procedure for model: rtwdemo_roll
### Successful completion of build procedure for model: rtwdemo_roll

Inspect the file `rtwdemo_roll.c`. The file defines the global variables.

file = fullfile('rtwdemo_roll_grt_rtw','rtwdemo_roll.c');
rtwdemodbtype(file,'/* Exported block signals */','real32_T myState;',1,1)

/* Exported block signals */
real32_T mySignal;                     /* '<S1>/Integrator' */

/* Exported block parameters */
real32_T UpThr = 6.0F;                 /* Variable: UpThr
 * Referenced by: '<S3>/UpThr'
 */

/* Exported block states */
real32_T myState;                      /* '<S1>/Integrator' */

The file `rtwdemo_roll.h` declares the variables. To access these variables, your external code can include (#include) this header file.

In `rtwdemo_roll.c`, search the file for the names of the variables, such as `UpThr`. The model algorithm in the `rtwdemo_roll_step` function reads and writes to the variables.

**Built-In Storage Classes You Can Choose**

The default storage class setting for a data item is Auto, which means the code generator determines how the item appears in the code. For a list of built-in storage classes that you can choose, see “Choose Storage Class for Controlling Data Representation in Generated Code” on page 15-69.
Decide Where to Store Storage Class Specification

For each individual signal or state data item (including Data Store Memory blocks) to which you directly apply a storage class, Simulink stores your storage class specification either in the model file or in the properties of a signal data object (Simulink.Signal), which you create in the base workspace, a model workspace, or a data dictionary. To apply a storage class to a block parameter, you must create a parameter data object (such as Simulink.Parameter) and specify the storage class in the object.

- When you apply a storage class to a signal or state in a model, for example, by using the Model Data Editor or the Property Inspector, you store the storage class specification in the model file.

  If you use this technique, you cannot control other characteristics of the data item, such as data type, by using an external signal data object.

- When you create a signal or parameter data object, you apply the storage class by using the CoderInfo property of the object. The value of the property is a Simulink.CoderInfo object, whose StorageClass property you use to specify the storage class. After you associate the data item in the model with the object, the data item acquires the storage class from the object.

For signals, states, and Data Store Memory blocks, to decide whether to store the storage class specification in the model or in a data object, see “Store Design Attributes of Signals and States” (Simulink).

Apply Storage Classes to Outport Blocks by Using the Model Data Editor

You can use the Model Data Editor to apply a storage class directly to a root-level Outport block or to the input signal that drives the block.

- To store the storage class specification in the Outport block, use the Inports/Outports tab in the Model Data Editor. When you use this technique, the specification remains after you delete the input signal that drives the block. Use this technique to configure the model interface before you develop the internal algorithm.

- To store the specification in the input signal that drives the block, use the Signals tab in the Model Data Editor.
Techniques to Apply Storage Classes Interactively

To apply storage classes to multiple data items in a list that you can search, sort, and filter, use the Model Data Editor (View > Model Data Editor) as shown in “Apply Storage Classes to Data Items” on page 15-82.

To apply a storage class while focusing on a single signal, block state, or parameter, use the Property Inspector (View > Property Inspector), the Signal Properties dialog box (for a signal), or the block dialog box (for a state or parameter). Under Code Generation, apply the storage class.

- For a parameter, first set the value of the parameter to the name that you want to use for the required parameter object. Then, create and configure the parameter object as shown in “Create Tunable Calibration Parameter in the Generated Code” on page 15-122.

- For a signal, state, or Data Store Memory block, first give the signal or state a name, which the code generator uses as the name of the corresponding global symbol. Then, either specify a storage class using Storage class (in which case the model file stores the specification) or create a signal data object as shown in “Use Data Objects in Simulink Models” (Simulink) and apply a storage class to the object.

Techniques to Apply Storage Classes Programmatically

- For a block parameter, use set_param to set the value of the parameter. Use other commands to create and configure the properties of the required parameter object. For an example, see “Create Tunable Calibration Parameter in the Generated Code” on page 15-122.

- For a signal, use get_param or find_system to return a handle to the block port that generates the signal. Use the parameters of the handle to name the signal, then apply the storage class directly (see “Apply Storage Class Directly to Signal Line” on page 15-89) or configure the signal to acquire settings, including the storage class, from a signal object (see “Use Data Objects in Simulink Models” (Simulink)).

- For an Inport block, configure the signal line that exits the block. For an Outport block, configure the block or the signal line that enters the block. For an example, see “Design Data Interface by Configuring Inport and Outport Blocks” on page 15-207.

- For a block state, use set_param to interact with the block. Name the state, then apply the storage class directly (see “Apply Storage Class Directly to Block State” on page 15-89) or configure the state to acquire the storage class from a signal object (see “Use Data Objects in Simulink Models” (Simulink)).
Apply Storage Classes to Individual Signal, State, and Parameter Data Elements

- For a Data Store Memory block, use `set_param` to interact with the block. Because the data store already has a name, you do not need to specify a name. Apply the storage class directly by using the `StateStorageClass` parameter or configure the data store to acquire the storage class from a signal object.

To interact with a signal or parameter data object that you store in a model workspace or data dictionary, use the programmatic interface of the workspace or dictionary. See “Interact With Variables Programmatically” (Simulink).

**Apply Storage Class Directly to Signal Line**

This example shows how to programmatically apply a storage class directly to a signal line.

1. Open the example model `rtwdemo_secondOrderSystem`.
   ```matlab
rtdemo_secondOrderSystem
```
2. Get a handle to the output of the block named Force: f(t).
   ```matlab
   portHandles = ...
   get_param('rtwdemo_secondOrderSystem/Force: f(t)','PortHandles');
   outportHandle = portHandles.Outport;
```
3. Set the name of the corresponding signal to `ForceSignal`.
   ```matlab
   set_param(outportHandle,'Name','ForceSignal')
```
4. Set the storage class of the signal to `ExportedGlobal`.
   ```matlab
   set_param(outportHandle,'StorageClass','ExportedGlobal')
```
5. Generate code from the model. The code declares and defines a global variable `ForceSignal` to represent the signal.

**Apply Storage Class Directly to Block State**

This example shows how to programmatically apply a storage class to a block state.

1. Open the example model `rtwdemo_basicsc`.
   ```matlab
   rtwdemo_basicsc
```
2. Name the state of the Delay block as `myState`.
   ```matlab
   set_param('rtwdemo_basicsc/Delay','StateName','myState')
   ```
3 Set the storage class of the state to `ExportedGlobal`.

```matlab
set_param('rtwdemo_basicsc/Delay', ...
    'StateStorageClass','ExportedGlobal')
```

4 Generate code from the model. The code declares and defines a global variable `myState` to represent the state.

**Parameter Object Configuration Quick Reference Diagram**

This diagram shows the code generation and storage class options that control the representation of parameter objects in the generated code.

**See Also**

**Related Examples**

- “Choose Storage Class for Controlling Data Representation in Generated Code” on page 15-69
- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Use Enumerated Data in Generated Code

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Enumerated Data Types” on page 15-91</td>
</tr>
<tr>
<td>“Specify Integer Data Type for Enumeration” on page 15-91</td>
</tr>
<tr>
<td>“Customize Enumerated Data Type” on page 15-93</td>
</tr>
<tr>
<td>“Control Enumerated Type Implementation in Generated Code” on page 15-97</td>
</tr>
<tr>
<td>“Type Casting for Enumerations” on page 15-99</td>
</tr>
<tr>
<td>“Enumerated Type Limitations” on page 15-100</td>
</tr>
</tbody>
</table>

Enumerated Data Types

Enumerated data is data that is restricted to a finite set of values. An enumerated data type is a MATLAB class that defines a set of enumerated values. Each enumerated value consists of an enumerated name and an underlying integer which the software uses internally and in generated code. The following is a MATLAB class definition for an enumerated data type named BasicColors, which is used in the examples in this section.

```matlab
classdef BasicColors < Simulink.IntEnumType
    enumeration
        Red(0)
        Yellow(1)
        Blue(2)
    end
end
```

For basic information about enumerated data types and their use in Simulink models, see “Use Enumerated Data in Simulink Models” (Simulink). For information about enumerated data types in Stateflow charts, see “Define Enumerated Data Types” (Stateflow).

Specify Integer Data Type for Enumeration

When you specify a data type for your enumeration, you can:

- Control the size of enumerated data types in the generated code by specifying a superclass.
• Reduce RAM/ROM usage.
• Improve code portability.
• Improve integration with legacy code.

You can specify any of these integer data types:

• int8
• uint8
• int16
• uint16
• int32
• Simulink.IntEnumType. Specify values in the range of the signed integer for your hardware platform.

**Use a Class Definition in a MATLAB File**

To specify an integer data type size, derive your enumeration class from the integer data type.

```matlab
classdef Colors < int8
    enumeration
        Red(0)
        Green(1)
        Blue(2)
    end
end
```

The code generator generates this code:

```c
typedef int8_T Colors;

#define Red    ((Colors)0)
#define Green  ((Colors)1)
#define Blue   ((Colors)2)
```

**Use the Function Simulink.defineIntEnumType**

To specify an integer data type size, specify the name-value pair `StorageType` as the integer data type.

```matlab
Simulink.defineIntEnumType('Colors', {'Red', 'Green', 'Blue'}, ...
[0;1;2], 'StorageType', 'int8')
```
The code generator generates this code:

typedef int8_T Colors;

#define Red ((Colors)0)
#define Green ((Colors)1)
#define Blue ((Colors)2)

**Customize Enumerated Data Type**

When you generate code from a model that uses enumerated data, you can implement these static methods to customize the behavior of the type during simulation and in generated code:

- `getDefaultValue` — Specifies the default value of the enumerated data type.
- `getDescription` — Specifies a description of the enumerated data type.
- `getHeaderFile` — Specifies a header file where the type is defined for generated code.
- `getDataScope` — Specifies whether generated code exports or imports the enumerated data type definition to or from a separate header file.
- `addClassNameToEnumNames` — Specifies whether the class name becomes a prefix in generated code.

The first of these methods, `getDefaultValue`, is relevant to both simulation and code generation, and is described in “Specify a Default Enumerated Value” (Simulink). The other methods are relevant only to code generation. To customize the behavior of an enumerated type, include a version of the method in the `methods(Static)` section of the enumeration class definition. If you do not want to customize the type, omit the `methods(Static)` section. The table summarizes the methods and the data to supply for each one.
<table>
<thead>
<tr>
<th>Static Method</th>
<th>Purpose</th>
<th>Default Value Without Implementing Method</th>
<th>Custom Return Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>getDefaultValue</td>
<td>Specifies the default enumeration member for the class.</td>
<td>First member specified in the enumeration definition</td>
<td>A character vector containing the name of an enumeration member in the class (see “Instantiate Enumerations” (Simulink)).</td>
</tr>
<tr>
<td>getDescription</td>
<td>Specifies a description of the enumeration class.</td>
<td>''</td>
<td>A character vector containing the description of the type.</td>
</tr>
</tbody>
</table>
| getHeaderFile   | Specifies the name of a header file. The method getDataScope determines the significance of the file. | ''                                       | A character vector containing the name of the header file that defines the enumerated type.  

By default, the generated `#include` directive uses the preprocessor delimiter " instead of `< and `>. To generate the directive `#include <myTypes.h>`, specify the custom return value as `'<myTypes.h>'`. |
<table>
<thead>
<tr>
<th>Static Method</th>
<th>Purpose</th>
<th>Default Value Without Implementing Method</th>
<th>Custom Return Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>getDataScope</td>
<td>Specifies whether generated code exports or imports the definition of the enumerated data type. Use the method <code>getHeaderFile</code> to specify the generated or included header file that defines the type.</td>
<td>'Auto'</td>
<td>One of: 'Auto', 'Exported', or 'Imported'.</td>
</tr>
<tr>
<td>addClassNameToEnumNames</td>
<td>Specifies whether to prefix the class name in generated code.</td>
<td>false</td>
<td>true or false.</td>
</tr>
</tbody>
</table>

**Specify a Description**

To specify a description for an enumerated data type, include this method in the `methods(Static)` section of the enumeration class:

```matlab
function retVal = getDescription()
    % GETDESCRIPTION Optional description of the data type.
    retVal = 'description';
end
```

Substitute a MATLAB character vector for `description`. The generated code that defines the enumerated type includes the specified description.

**Import Type Definition in Generated Code**

To prevent generated code from defining an enumerated data type, which allows you to provide the definition in an external file, include these methods in the `methods(Static)` section of the enumeration class:

```matlab
function retVal = getHeaderFile()
    % GETHEADERFILE Specifies the file that defines this type in generated code.
    % The method `getDataScope` determines the significance of the specified file.
    retVal = 'imported_enum_type.h';
end
```
Instead of defining the type in `model_types.h`, which is the default behavior, generated code imports the definition from the specified header file using a `#include` statement like:

```
#include "imported_enum_type.h"
```

Generating code does not create the imported header file. You must provide the header file, using the file name specified by the method `getHeaderFile`, that defines the enumerated data type.

To create a Simulink enumeration that corresponds to your existing C-code enumeration, use the `Simulink.importExternalCTypes` function.

**Export Type Definition in Generated Code**

To generate a separate header file that defines an enumerated data type, include these methods in the `methods(Static)` section of the enumeration class:

```matlab
function retVal = getDataScope()
    % GETDATASCOPE Specifies whether generated code imports or exports this type.
    % Return one of:
    % 'Auto': define type in model_types.h, or import if header file specified
    % 'Exported': define type in a generated header file
    % 'Imported': import type definition from specified header file
    % If you do not define this method, DataScope is 'Auto' by default.
    retVal = 'Imported';
end

function retVal = getHeaderFile()
    % GETHEADERFILE Specifies the file that defines this type in generated code.
    % The method getDataScope determines the significance of the specified file.
    retVal = 'exported_enum_type.h';
end
```

Generated code exports the enumerated type definition to the generated header file `exported_enum_type.h`. 
Add Prefixes To Class Names

By default, enumerated values in generated code have the same names that they have in the enumeration class definition. Alternatively, your code can prefix every enumerated value in an enumeration class with the name of the class. You can use this technique to prevent identifier conflicts or to improve the readability of the code. To specify class name prefixing, include this method in the methods(Static) section of an enumeration class:

```matlab
function retVal = addClassNameToEnumNames()
  % ADDCLASSNAMETOENUMNAMES Specifies whether to add the class name
  % as a prefix to enumeration member names in generated code.
  % Return true or false.
  % If you do not define this method, no prefix is added.
  retVal = true;
end
```

Specify the return value as `true` to enable class name prefixing or as `false` to suppress prefixing. If you specify `true`, each enumerated value in the class appears in generated code as `EnumTypeName_EnumName`. For the example enumeration class `BasicColors` in “Enumerated Data Types” on page 15-91, the data type definition in generated code might look like this:

```c
#ifndef _DEFINED_TYPEDEF_FOR_BasicColors_
#define _DEFINED_TYPEDEF_FOR_BasicColors_

typedef enum {
    BasicColors_Red = 0,    /* Default value */
    BasicColors_Yellow = 1,
    BasicColors_Blue = 2,
} BasicColors;

#endif
```

The enumeration class name `BasicColors` appears as a prefix for each of the enumerated names.

Control Enumerated Type Implementation in Generated Code

Suppose that you define an enumerated type `BasicColors`. You can specify that the generated code implement the type definition using:

- An `enum` block. The native integer type of your hardware is the underlying integer type for the enumeration members.
- A `typedef` statement and a series of `#define` macros. The `typedef` statement bases the enumerated type name on a specific integer data type, such as `int8`. The macros associate the enumeration members with the underlying integer values.
**Implement Enumerated Type Using enum Block**

To implement the type definition using an enum block:

- In Simulink, define the enumerated type using a `classdef` block in a script file. Derive the enumeration from the type `Simulink.IntEnumType`.
- Alternatively, use the function `Simulink.defineIntEnumType`. Do not specify the property `StorageType`.

When you generate code, the type definition appears in an `enum` block:

```c
#ifndef _DEFINED_TYPEDEF_FOR_BasicColors_
#define _DEFINED_TYPEDEF_FOR_BasicColors_

typedef enum {
    Red = 0,            /* Default value */
    Yellow,
    Blue,
} BasicColors;

#endif
```

**Implement Enumerated Type Using a Specific Integer Type**

To implement the type definition using a `typedef` statement and `#define` macros:

- In Simulink, define the enumerated type using a `classdef` block in a script file. Derive the enumeration from a specific integer type such as `int8`.
- Alternatively, use the function `Simulink.defineIntEnumType`. Specify the property `StorageType` using a specific integer type such as `int8`.

When you generate code, the type definition appears as a `typedef` statement and a series of `#define` macros.

```c
#ifndef _DEFINED_TYPEDEF_FOR_BasicColors_
#define _DEFINED_TYPEDEF_FOR_BasicColors_

typedef int8_T BasicColors;

#define Red ((BasicColors)0)            /* Default value */
#define Yellow ((BasicColors)1)
#define Blue ((BasicColors)2)
```

15-98
By default, the generated file `model_types.h` contains enumerated type definitions.

**Type Casting for Enumerations**

**Safe Casting**

A Simulink Data Type Conversion block accepts a signal of integer type. The block converts the input to one of the underlying values of an enumerated type.

If the input value does not match any of the underlying values of the enumerated type values, Simulink inserts a safe cast to replace the input value with the enumerated type default value.

**Enable and Disable Safe Casting**

You can enable or disable safe casting for enumerations during code generation for a Simulink Data Type Conversion block or a Stateflow block.

To control safe casting, enable or disable the **Saturate on integer overflow** block parameter. The parameter works as follows:

- **Enabled**: Simulink replaces a nonmatching input value with the default value of the enumerated values during simulation. The software generates a safe cast function during code generation.
- **Disabled**: For a nonmatching input value, Simulink generates an error during simulation. The software omits the safe cast function during code generation. In this case, the code is more efficient. However, the code may be more vulnerable to run-time errors.

**Safe Cast Function in Generated Code**

This example shows how the safe cast function `int32_T ET08_safe_cast_to_BasicColors` for the enumeration `BasicColors` appears in generated code when generated for 32-bit hardware.

```c
static int32_T ET08_safe_cast_to_BasicColors(int32_T input)
{
    int32_T output;
    /* Initialize output value to default value for BasicColors (Red) */
```
output = 0;
if ((input >= 0) && (input <= 2)) {
    /* Set output value to input value if it is a member of BasicColors */
    output = input;
}
return output;
}

Through this function, the enumerated type’s default value is used if the input value does not match one of underlying values of the enumerated type’s values.

If the block’s **Saturate on integer overflow** parameter is disabled, this function does not appear in generated code.

**Enumerated Type Limitations**

- Generated code does not support logging enumerated data.

**See Also**

Simulink.data.getEnumTypeInfo | Simulink.defineIntEnumType | enumeration

**Related Examples**

- “Use Enumerated Data in Simulink Models” (Simulink)
- “Simulink Enumerations” (Simulink)
- “Exchange Structured and Enumerated Data Between Generated and External Code” (Embedded Coder)
Data Stores in Generated Code

About Data Stores
A data store contains data that is accessible in a model hierarchy at or below the level in which the data store is defined. Data stores can allow subsystems and referenced models to share data without having to use I/O ports to pass the data from level to level. See “Data Stores with Data Store Memory Blocks” (Simulink) for information about data stores in Simulink. This section provides additional information about data store code generation.

Generate Code for Data Store Memory Blocks
To control the code generated for a Data Store Memory block, apply a storage class to the data store. You can associate a Data Store Memory block with a signal object that you store in a workspace or data dictionary, and control code generation for the block by applying the storage class to the object:

1. In the model, select View > Model Data Editor.
2. In the Model Data Editor, select the Data Stores tab.
3. Begin editing the name of the target Data Store Memory block by clicking the corresponding row in the Name column.
4. Next to the name, click the button and select Create and Resolve.
5. In the Create New Data dialog box, set Value to Simulink.Signal. Optionally, use the Location drop-down list to choose a workspace for storing the resulting Simulink.Signal object.
6 Click **Create**. The `Simulink.Signal` object, which has the same name as the data store, appears in the target workspace. Simulink selects the block parameter **Data store name must resolve to Simulink signal object**.

The property dialog box for the object opens.

7 Use the **Storage class** drop-down list to apply the target storage class.

**Note** When a Data Store Memory block is associated with a signal object, the mapping between the **Data store name** and the signal object name must be one-to-one. If two or more identically named entities map to the same signal object, the name conflict is flagged as an error at code generation time. See “Resolve Conflicts in Configuration of Signal Objects for Code Generation” (Simulink) for more information.

### Storage Classes for Data Store Memory Blocks

You can control how Data Store Memory blocks in your model are stored and represented in the generated code by assigning storage classes and type qualifiers. You do this in almost exactly the same way you assign storage classes and type qualifiers for block states.

Data Store Memory blocks, like block states, have Auto storage class by default, and their memory is stored within the `DWork` vector. The symbolic name of the storage location is based on the data store name.

You can generate code from multiple Data Store Memory blocks that have the same data store name, subject to the following restriction: *at most one* of the identically named blocks can have a storage class other than Auto. An error is reported if this condition is not met.

For blocks with Auto storage class, the code generator produces a unique symbolic name for each block to avoid name clashes. For Data Store Memory blocks with storage classes other than Auto, the generated code uses the data store name as the symbol.

In the following model, a Data Store Write block writes to memory declared by the Data Store Memory block `myData`:
To control the storage declaration for a Data Store Memory block, use the **Code Generation > Signal object class** and **Code Generation > Storage class** drop-down lists of the Data Store Memory block dialog box. Set **Signal object class** to `Simulink.Signal` (the default), and choose a storage class from the **Storage class** drop-down list. The next figure shows the Data Store Memory block dialog box for the preceding model.

To apply storage classes to data stores, you can alternatively use the **Data Stores** tab in the Model Data Editor (in the model, **View > Model Data Editor**).
Data Store Memory blocks are nonvirtual because code is generated for their initialization in `.c` and `.cpp` files and their declarations in header files. The following table shows how the code generated for the Data Store Memory block in the preceding model differs for different storage classes. The table gives the variable declarations and `MdlOutputs` code generated for the `myData` block.

<table>
<thead>
<tr>
<th>Storage Class</th>
<th>Declaration</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto or Model default</strong> (when Code Mapping Editor specifies Default storage class)</td>
<td>In <code>model.h</code>&lt;br&gt;typedef struct D_Work_tag&lt;br&gt;    {&lt;br&gt;        real_T myData;&lt;br&gt;    } D_Work;&lt;br&gt;    In <code>model.c</code> or <code>model.cpp</code>&lt;br&gt;    /* Block states (auto storage) */&lt;br&gt;    D_Work model_DWork;</td>
<td>model_DWork.myData = rtb_SineWave;</td>
</tr>
<tr>
<td><strong>ExportedGlobal</strong></td>
<td>In <code>model.c</code> or <code>model.cpp</code>&lt;br&gt;    /* Exported block states */&lt;br&gt;    real_T myData;&lt;br&gt;    In <code>model.h</code>&lt;br&gt;    extern real_T myData;</td>
<td>myData = rtb_SineWave;</td>
</tr>
<tr>
<td><strong>ImportedExtern</strong></td>
<td>In <code>model_private.h</code>&lt;br&gt;    extern real_T myData;</td>
<td>myData = rtb_SineWave;</td>
</tr>
<tr>
<td><strong>ImportedExternPointer</strong></td>
<td>In <code>model_private.h</code>&lt;br&gt;    extern real_T *myData;</td>
<td>(*myData) = rtb_SineWave;</td>
</tr>
</tbody>
</table>

For information about applying storage classes, see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82.

**Data Store Buffering in Generated Code**

A Data Store Read block is a nonvirtual block that copies the value of the data store to its output buffer when it executes. Since the value is buffered, downstream blocks connected to the output of the data store read utilize the same value, even if a Data Store Write block updates the data store in between execution of two of the downstream blocks.
The next figure shows a model that uses blocks whose priorities have been modified to achieve a particular order of execution:

1. The block Data Store Read buffers the current value of the data store A at its output.
2. The block Abs1 uses the buffered output of Data Store Read.
3. The block Data Store Write updates the data store.
4. The block Abs uses the buffered output of Data Store Read.
Because the output of Data Store Read is a buffer, both Abs and Abs1 use the same value: the value of the data store at the time that Data Store Read executes.

The next figure shows another example:

![Diagram of Simulink model](image)

```plaintext
real_T rtb_DataStoreRead;

/* DataStoreWrite: '<Root>/Data Store Write' incorporates: */
/* Constant: '<Root>/Constant' */
A = DoBufferDSMRead2_P.Constant_Value;

/* DataStoreRead: '<Root>/Data Store Read' */
rtb_DataStoreRead = A;  // Buffer the value of A

/* Outputs for Atomic SubSystem: '<Root>/Atomic SubSystem' */
DoBufferDSMReadAtomicSubsystem();  // We don't do a global analysis to detect if this function writes to A

/* Output: '<Root>/Out1' incorporates: */
/* Sum: '<Root>/Sum' */
DoBufferDSMRead2_Y.Out1 = rtb_DataStoreRead + DoBufferDSMRead2_E.Abs;
```

In this example, the following execution order applies:

1. The block Data Store Read buffers the current value of the data store A at its output.
2. Atomic Subsystem executes.
3. The Sum block adds the output of Atomic Subsystem to the output of Data Store Read.
Simulink assumes that Atomic Subsystem might update the data store, so Simulink buffers the data store. Atomic Subsystem executes after Data Store Read buffers its output, and the buffer provides a way for the Sum block to use the value of the data store as it was when Data Store Read executed.

In some cases, the code generator determines that it can optimize away the output buffer for a Data Store Read block, and the generated code refers to the data store directly, rather than a buffered value of it. The next figure shows an example:

In the generated code, the argument of the \texttt{fabs()} function is the data store \( A \) rather than a buffered value.

**Data Stores Shared by Instances of a Reusable Model**

You can use a data store to share a piece of data between the instances of a reusable referenced model (see “Share Data Among Referenced Model Instances” (Simulink)) or a model that you configure to generate reentrant code (by setting the configuration
parameter **Code interface packaging** to Reusable function). If you implement the data store as a Data Store Memory block and select the **Share across model instances** parameter:

- By default, the data store appears in the generated code as a separate global symbol.
- If you have Embedded Coder, to restrict access such that only the code generated from the model can use the data store, configure the data store to appear as static by applying the custom storage class **FileScope**. For more information about **FileScope** and other custom storage classes, see “Choose Storage Class for Controlling Data Representation in Generated Code” (Embedded Coder).

### Structures in Generated Code Using Data Stores

If you use more than one data store to provide global access to multiple signals in generated code, you can combine the signals into a single structure variable by using one data store. This combination of signal data can help you integrate the code generated from a model with other existing code that requires the data in a structure format.

This example shows how to store several model signals in a structure in generated code using a single data store. To store multiple signals in a data store, you configure the data store to accept a composite signal, such as a nonvirtual bus signal or an array of nonvirtual bus signals.

**Explore Example Model**

1. Open the example model `ex_bus_struct_in_code`.

   The model contains three subsystems that perform calculations on the inputs from the top level of the model. In each subsystem, a Data Store Memory block stores an intermediate calculated signal.

2. Generate code with the model. In the code generation report, view the file `ex_bus_struct_in_code.c`. The code defines a global variable for each data store.

   ```c
   real_T BioBTURate;
   real_T CoalBTURate;
   real_T GasBTURate;
   ```

   Suppose that you want to integrate code generated from the example model with other existing code. Suppose also that the existing code requires access to all of the data from the three data stores in a single structure variable. You can use a data store to assemble all of the target data in a structure in generated code.
**Configure Data Store**

Configure a data store to contain multiple signals by creating a bus type to use as the data type of the data store. Define the bus type using the same hierarchy of elements as the structure that you want to appear in generated code.

1. Open the Bus Editor tool.

   `buseditor`

2. Define a new bus type `Raw_BTU_Rate` with one element for each of the three target signals. Name the elements `BioBTU`, `GasBTU`, and `CoalBTU`.

3. At the top level of the example model, add a Data Store Memory block.

4. In the Simulink Editor, select **View > Model Data Editor**.

5. In the Model Data Editor, inspect the **Data Stores** tab.

6. For the new Data Store Memory block, use the **Name** column to set the data store name to `Raw_BTU_Data`.

7. Use the **Data Type** column to set the data type of the data store to `Bus: Raw_BTU_Rate`.

8. Set the **Change view** drop-down list to **Code**.

9. Use the **Storage Class** column to apply the storage class **ExportedGlobal**.

**Write to Data Store Elements**

To write to a specific element of a data store, use a Data Store Write block. On the **Element Assignment** tab in the dialog box, you can specify to write to a single element, a collection of elements, or the entire contents of a data store.

1. Open the **Biomass Calc** subsystem.

2. Delete the Data Store Memory block `BioBTURate`.

3. In the block dialog box for the Data Store Write block, set **Data store name** to `Raw_BTU_Data`.
4 On the **Element Assignment** tab, under **Signals in the bus**, expand the contents of the data store *Raw_BTU_Data*. Click the element *BioBTU*, and then click **Select**. Click **OK**.

5 Modify the **Gas Calc** and **Coal Calc** subsystems similarly.

   - Delete the Data Store Memory block in each subsystem.
   - In each Data Store Write block dialog box, set **Data store name** to *Raw_BTU_Data*.
   - In the **Gas Calc** subsystem, use the Data Store Write block to write to the data store element *GasBTU*. In the **Coal Calc** subsystem, write to the element *CoalBTU*. 
Generate Code with Data Store Structure

1. Generate code for the example model.
2. In the code generation report, view the file `ex_bus_struct_in_code_types.h`. The code defines a structure that corresponds to the bus type `Raw_BTU_Rate`.

```c
typedef struct {
    real_T BioBTU;
    real_T GasBTU;
    real_T CoalBTU;
} Raw_BTU_Rate;
```
3. View the file `ex_bus_struct_in_code.c`. The code represents the data store with a global variable `Raw_BTU_Data` of the structure type `Raw_BTU_Rate`. In the model step function, the code assigns the data from the calculated signals to the fields of the global variable `Raw_BTU_Data`.

See Also

Related Examples

- “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82
- “Structures in Generated Code Using Data Stores” on page 15-108
- “When to Use a Data Store” (Simulink)
- “Generate Code That Dereferences Data from a Literal Memory Address” (Embedded Coder)
Specify Single-Precision Data Type for Embedded Application

When you want code that uses only single precision, such as when you are targeting a single-precision processor, you can use model configuration parameters and block parameters to prevent the introduction of double in the model.

To design and validate a single-precision model, see “Validate a Floating-Point Embedded Model” (Simulink). If you have Fixed-Point Designer, you can use the Single Precision Converter app (see “Single-Precision Design for Simulink” (Fixed-Point Designer)).

Use single Data Type as Default for Underspecified Types

This example shows how to avoid introducing a double-precision data type in code generated for a single-precision hardware target.

If you specify an inherited data type for signals, but data type propagation rules cannot determine data types for the signals, the signal data types default to double. You can use a model configuration parameter to specify the default data type as single.

Explore Example Model

Open the example model rtwdemo_underspecified_datatype and configure it to show the generated names of blocks.

```matlab
model = 'rtwdemo_underspecified_datatype';
load_system(model)
set_param(model,'HideAutomaticNames','off')
open_system(model);
```
The root imports In2, In3, and In4 specify Inherit: Auto for the Data type block parameter. The downstream blocks also use inherited data types.

**Generate Code with double as Default Data Type**

The model starts with the configuration parameter System target file set to ert.tlc, which requires Embedded Coder. Set System target file to grt.tlc instead.

```matlab
set_param(model,'SystemTargetFile','grt.tlc')
```

Generate code from the model.

```matlab
rtwbuild(model)
```

```markdown
### Starting build procedure for model: rtwdemo_underspecified_datatype
### Successful completion of build procedure for model: rtwdemo_underspecified_datatype
```
In the code generation report, view the file `rtwdemo_underspecified_datatype.h`. The code uses the `double` data type to define the variables `In2`, `In3`, and `In4` because the Inport data types are underspecified in the model.

```matlab
cfile = fullfile('rtwdemo_underspecified_datatype_grt_rtw',...
    'rtwdemo_underspecified_datatype.h');
rtwdemodbtype(cfile,...
    '/* External inputs (root inport signals with default storage) */',...'
    '/* External outputs (root outports fed by signals with default storage) */',... 1, 0);

/* External inputs (root inport signals with default storage) */
typedef struct {
    int8_T In1;                            /* '<Root>/In1' */
    real_T In2;                            /* '<Root>/In2' */
    real_T In3;                            /* '<Root>/In3' */
    real_T In4;                            /* '<Root>/In4' */
} ExtU_rtwdemo_underspecified_d_T;

Generate Code with single as Default Data Type

Open the Configuration Parameters dialog box. On the Math and Data Types pane, select `single` in the Default for underspecified data type drop-down list.

Alternatively, enable the optimization at the command prompt.

```matlab
set_param(model, 'DefaultUnderspecifiedDataType', 'single');
```

Generate code from the model.

```matlab
rtwbuild(model)
```

### Starting build procedure for model: rtwdemo_underspecified_datatype
### Successful completion of build procedure for model: rtwdemo_underspecified_datatype

In the code generation report, view the file `rtwdemo_underspecified_datatype.h`. The code uses the `single` data type to define the variables `In2`, `In3`, and `In4`.

```matlab
rtwdemodbtype(cfile,...
    '/* External inputs (root inport signals with default storage) */',...'
    '/* External outputs (root outports fed by signals with default storage) */',... 1, 0);

/* External inputs (root inport signals with default storage) */
```
typedef struct {
    int8_T In1;                        /* '<Root>/In1' */
    real32_T In2;                      /* '<Root>/In2' */
    real32_T In3;                      /* '<Root>/In3' */
    real32_T In4;                      /* '<Root>/In4' */
} ExtU_rtwdemo_underspecified_d_T;

See Also

Related Examples

•  “Default for underspecified data type” (Simulink)
•  “Subnormal Number Performance” on page 33-18
•  “Standard math library”
•  “Control Data Type Names in Generated Code” (Embedded Coder)
•  “About Data Types in Simulink” (Simulink)
Tune Phase Parameter of Sine Wave Block During Code Execution

Under certain conditions, you cannot configure the Phase parameter of a Sine Wave block to appear in the generated code as a tunable global variable (for more information, see the block reference page). This example shows how to generate code so that you can tune the phase during execution.

Create the model `ex_phase_tunable` by using a Digital Clock block.

```matlab
open_system('ex_phase_tunable')
```

Set Default parameter behavior to Tunable so that the parameters of the Sine Wave block appear in the generated code as tunable fields of the global parameter structure.

```matlab
set_param('ex_phase_tunable','DefaultParameterBehavior','Tunable')
```

Generate code from the model.

```matlab
rtwbuild('ex_phase_tunable')
```

### Starting build procedure for model: ex_phase_tunable  
### Successful completion of code generation for model: ex_phase_tunable

In the code generation report, view the file `ex_phase_tunable.c`. The code algorithm in the model step function calculates the Sine Wave block output. The parameters of the block, including Phase, appear in the code as tunable structure fields.

```matlab
file = fullfile('ex_phase_tunable_grt_rtw','ex_phase_tunable.c');
rtwdemodbtype(file,'/* Outport: '<Root>/Out1' incorporates:','...  
  'ex_phase_tunable_P.SineWave_Bias;',1,1)
```

/* Outport: '<Root>/Out1' incorporates:  
  * DigitalClock: '<Root>/Digital Clock'  
  * Sin: '<Root>/Sine Wave'  
  */
ex_phase_tunable_Y.Out1 = \sin((ex_phase_tunable_P.SineWave_Freq \times ((ex_phase_tunable_M->Timing.clockTick1+\(\text{ex_phase_tunable_M->Timing.clockTickH1* 4294967296.0\)) * 1.0)) \times \text{ex_phase_tunable_P.SineWave_Phase}) \times \text{ex_phase_tunable_P.SineWave_Amp} + \text{ex_phase_tunable_P.SineWave_Bias});

During code execution, you can assign new values to the structure field that corresponds to the **Phase** parameter.

**See Also**

**Related Examples**
- “Configure Data Accessibility for Rapid Prototyping” on page 15-3
Switch Between Output Waveforms During Code Execution for Waveform Generator Block

This example shows how to generate code that enables you to switch between stimulus waveforms during code execution.

For a Waveform Generator block, you cannot make the parameters of a waveform, such as amplitude and phase shift, tunable in the generated code. Instead, you can generate code that enables you to choose an active waveform from a set of waveform variants that you specify in the block. During execution of the code, you activate a variant by adjusting the value of a global structure field.

You must set the model configuration parameter **Default parameter behavior** to **Tunable**. Then, by default, block parameters in the model appear tunable in the generated code. These parameters can consume large amounts of memory for a large model.

Create the model `ex_switch_waveform`.

```matlab
open_system('ex_switch_waveform')
```

In the Waveform Generator block, configure this waveform:

```matlab
square(amp, 10, 0, dutyCycle)
```

In the base workspace, create the variables `amp` and `dutyCycle`.

```matlab
amp = 2.71;
dutyCycle = 50;
```

This waveform represents the baseline stimulus that you want the application to use at the start of execution.
Suppose that, during execution, you want to observe the effects of changing the waveform frequency from 10 to 15 and the phase shift from 0 to 0.5. In the Waveform Generator block, add these waveform variants:

\[
\text{square}(\text{amp},10,0.5,\text{dutyCycle}) \\
\text{square}(\text{amp},15,0,\text{dutyCycle}) \\
\text{square}(\text{amp},15,0.5,\text{dutyCycle})
\]

Set the model configuration parameter **Default parameter behavior** to Tunable.

\[
\text{set_param('ex_switch_waveform','DefaultParameterBehavior','Tunable')}
\]

Generate code from the model.

\[
\text{rtwbuild('ex_switch_waveform')}
\]

### Starting build procedure for model: ex_switch_waveform
### Successful completion of code generation for model: ex_switch_waveform

The generated file `ex_switch_waveform.h` defines the standard structure type that stores tunable parameter data for the model. The structure contains a field whose value represents the active waveform.

\[
\text{file} = \text{fullfile('ex_switch_waveform_grt_rtw','ex_switch_waveform.h')}; \\
\text{rtwdemodbtype(file,'/* Parameters (default storage) */','...} \\
\quad /* Real-time Model Data Structure */',1,1)
\]

```c
/* Parameters (default storage) */
struct P_ex_switch_waveform_T_ {
    real_T WaveformGeneratorStimulus_Selec; /* Mask Parameter: WaveformGeneratorStimulus_Selec */
        /* Referenced by: '<S1>/Switch' */
    real_T GainControlSystem_Gain;    /* Expression: 3.5 */
        /* Referenced by: '<Root>/Gain (Control System)' */
};
```

The file `ex_switch_waveform_data.c` defines a global structure variable and initializes the field value to 1. This value represents the baseline waveform.

\[
\text{file} = \text{fullfile('ex_switch_waveform_grt_rtw','ex_switch_waveform_data.c')}; \\
\text{rtwdemodbtype(file,'/* Block parameters (default storage) */',1,1)}
\]

```c
/* Block parameters (default storage) */
```
The file `ex_switch_waveform.c` defines the model execution function. The function uses a `switch` statement to determine the value of the active waveform, and then calculates the value of the root-level Outport block, `Out1`.

```c
switch ((int32_T)ex_switch_waveform_P.WaveformGeneratorStimulus_Selec) {
    case 1:
        temp = temp - floor(temp) <= 0.5 ? 2.71 : -2.71;
        break;
    case 2:
        temp = (temp - 0.79577471545947676) - floor(temp - 0.79577471545947676) <= 0.5 ? 2.71 : -2.71;
        break;
    case 3:
        temp = temp_tmp_tmp - floor(temp_tmp_tmp) <= 0.5 ? 2.71 : -2.71;
        break;
    default:
        temp = (temp_tmp_tmp - 1.1936620731892151) - floor(temp_tmp_tmp - 1.1936620731892151) <= 0.5 ? 2.71 : -2.71;
        break;
}
/* End of MultiPortSwitch: '<S1>/MultiportSwitch' */
/* Outport: '<Root>/Out1' incorporates:
 * Gain: '<Root>/Gain (Control System)'
*/
During code execution, to change the active waveform, adjust the value of the structure field in the global parameters structure.

**See Also**

**Related Examples**

- “Configure Data Accessibility for Rapid Prototyping” on page 15-3
Create Tunable Calibration Parameter in the Generated Code

A calibration parameter is a value stored in global memory that an algorithm reads for use in calculations but does not write to. Calibration parameters are tunable because you can change the stored value during algorithm execution. You create calibration parameters so that you can:

- Determine an optimal parameter value by tuning the parameter and monitoring signal values during execution.
- Efficiently adapt an algorithm to different execution conditions by overwriting the parameter value stored in memory. For example, you can use the same control algorithm for multiple vehicles of different masses by storing different parameter values in each vehicle’s engine control unit.

In Simulink, create a `Simulink.Parameter` object to represent a calibration parameter. You use the parameter object to set block parameter values, such as the `Gain` parameter of a Gain block. To control the representation of the parameter object in the generated code, you apply a storage class to the object.

To make block parameters accessible in the generated code by default, for example for rapid prototyping, set `Default parameter behavior` (see “Default parameter behavior”) to Tunable. For more information, see “Configure Data Accessibility for Rapid Prototyping” on page 15-3.

Represent Block Parameter as Tunable Global Variable

This example shows how to create tunable parameter data by representing block parameters as global variables in the generated code.

Configure Block Parameter by Using Parameter Object

Open the example model `rtwdemo_paraminline` and configure it to show the generated names of blocks.

```matlab
load_system('rtwdemo_paraminline')
set_param('rtwdemo_paraminline','HideAutomaticNames','off')
open_system('rtwdemo_paraminline')
```
In the model, select **View > Model Data Editor**.

In the Model Data Editor, inspect the **Parameters** tab.

In the model, click the G1 Gain block. The Model Data Editor highlights the row that corresponds to the **Gain** parameter of the block.

In the Model Data Editor **Value** column, change the gain value from 2 to myGainParam.

Next to myGainParam, click the action button (with three vertical dots) and select **Create**.

In the Create New Data block dialog box, set **Value** to Simulink.Parameter(2). Click **Create**. A Simulink.Parameter object myGainParam stores the parameter value, 2, in the base workspace.

In the myGainParam dialog box, set **Storage class** to ExportedGlobal and click **OK**. This storage class causes the parameter object to appear in the generated code as a tunable global variable.

Alternatively, to create the parameter object and configure the model, use these commands at the command prompt:
set_param('rtwdemo_paraminline/G1','Gain','myGainParam')
myGainParam = Simulink.Parameter(2);
myGainParam.CoderInfo.StorageClass = 'ExportedGlobal';

Use the Model Data Editor to create a parameter object, myOtherGain, for the G2 Gain block. Apply the storage class ExportedGlobal.

Alternatively, use these commands at the command prompt:

set_param('rtwdemo_paraminline/G2','Gain','myOtherGain')
myOtherGain = Simulink.Parameter(-2);
myOtherGain.CoderInfo.StorageClass = 'ExportedGlobal';

**Generate and Inspect Code**

Generate code from the model.

rtwbuild('rtwdemo_paraminline')

### Starting build procedure for model: rtwdemo_paraminline
### Successful completion of build procedure for model: rtwdemo_paraminline

The generated file rtwdemo_paraminline.h contains extern declarations of the global variables myGainParam and myOtherGain. You can include (#include) this header file so that your code can read and write the value of the variable during execution.

```matlab
file = fullfile('rtwdemo_paraminline_grt_rtw','rtwdemo_paraminline.h');
rtwdemodbtype(file,...
    'extern real_T myGainParam;','Referenced by: ''<Root>/G2''',1,1)

    extern real_T myGainParam;       /* Variable: myGainParam
* Referenced by: '<Root>/G1'
*/

    extern real_T myOtherGain;      /* Variable: myOtherGain
* Referenced by: '<Root>/G2'
*/
```

The file rtwdemo_paraminline.c allocates memory for and initializes myGainParam and myOtherGain.

```matlab
file = fullfile('rtwdemo_paraminline_grt_rtw','rtwdemo_paraminline.c');
rtwdemodbtype(file,...
    /* Exported block parameters */','Referenced by: ''<Root>/G2''',1,1)

/* Exported block parameters */
The generated code algorithm in the model step function uses myGainParam and myOtherGain for calculations.

void rtwdemo_paraminline_step(void)
{
    rtwdemo_paraminline_Y.Out1 = myGainParam * rtwdemo_paraminline_U.In1 +
        myOtherGain * -75.0;
}

Apply Storage Class When Block Parameter Refers to Numeric MATLAB Variable

If you use a numeric variable to set the value of a block parameter, you cannot apply a storage class to the variable. As a workaround, you can convert the variable to a parameter object, and then apply a storage class to the object. To convert the variable to a parameter object, choose one of these techniques:

- On the Model Data Editor Parameters tab, with Change view set to Code, find the row that corresponds to the variable. In the Storage Class column, from the drop-down list, select Convert to parameter object. The Model Data Editor converts the variable to a parameter object. Then, use the Storage Class column to apply a storage class to the object.

You can also use this technique in the Model Explorer.

- Use the Data Object Wizard (see “Create Data Objects for a Model Using Data Object Wizard” (Simulink)). In the Wizard, select the Parameters check box. The Wizard...
converts variables to objects. Then, apply storage classes to the objects, for example, by using the Model Data Editor or the Model Explorer.

Create Storage Class That Represents Calibration Parameters (Embedded Coder)

This example shows how to create a storage class that yields a calibration parameter in the generated code. The storage class causes each parameter object (Simulink.Parameter) to appear as a global variable with special decorations such as keywords and pragmas.

In the generated code, the calibration parameters must appear as global variables defined in a file named `calPrms.c` and declared in `calPrms.h`. The variable definitions must look like these definitions:

```
#pragma SEC(CALPRM)
const volatile float param1 = 3.0F;
const volatile float param2 = 5.0F;
const volatile float param3 = 7.0F;
#pragma SEC()
```

The variables use the keywords `const` and `volatile`. The pragma `#pragma SEC(CALPRM)` controls the placement of the variables in memory. To implement the pragma, all of the variable definitions must appear in a contiguous block of code.

Also, the generated code must include an ASAP2 (a2l) description of each parameter.

Create Package for Storing Storage Class and Memory Section Definitions

Now, create a package in your current folder by copying the example package `+SimulinkDemos`. The package stores the definitions of Parameter and Signal classes that you later use to apply the storage class to data elements in models. Later, the package also stores the definitions of the storage class and an associated memory section.

1. Set your current MATLAB folder to a writable location.
2. Copy the `+SimulinkDemos` package folder into your current folder. Name the copy `+myPackage`. 

15-126
copyfile(fullfile(matlabroot,...
    'toolbox','simulink','simdemos','dataclasses','+SimulinkDemos'),...
    '+myPackage','f')

3 Navigate inside the +myPackage folder to the file Signal.m to edit the definition of the Signal class.

4 Uncomment the methods section that defines the method setupCoderInfo. In the call to the function useLocalCustomStorageClasses, replace 'packageName' with 'myPackage'. When you finish, the section looks like this:

```matlab
methods
    function setupCoderInfo(h)
        % Use custom storage classes from this package
        useLocalCustomStorageClasses(h, 'myPackage');
    end
end % methods
```

5 Save and close the file.

6 Navigate inside the +myPackage folder to the file Parameter.m to edit the definition of the Parameter class. Uncomment the methods section that defines the method setupCoderInfo and replace 'packageName' with 'myPackage'.

7 Save and close the file.

**Create Storage Class and Memory Section**

1 Set your current folder to the folder that contains the package folder +myPackage.

2 Open the Custom Storage Class Designer.

   `cscdesigner('myPackage')`

3 In the Custom Storage Class Designer, on the **Memory Sections** tab, click **New**.

4 For the new memory section, set properties according to the table.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>CalMem</td>
</tr>
<tr>
<td>Statements Surround</td>
<td>Group of variables</td>
</tr>
<tr>
<td>Pre Statement</td>
<td>#pragma SEC(CALPRM)</td>
</tr>
<tr>
<td>Post Statement</td>
<td>#pragma SEC()</td>
</tr>
<tr>
<td>Is const</td>
<td>Select</td>
</tr>
<tr>
<td>Is volatile</td>
<td>Select</td>
</tr>
</tbody>
</table>

5 Click Apply.

6 On the **Custom Storage Class** tab, click **New**.
7 For the new storage class, set properties according to the table.

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>CalParam</td>
</tr>
<tr>
<td>For signals</td>
<td>Clear</td>
</tr>
<tr>
<td>Data scope</td>
<td>Exported</td>
</tr>
<tr>
<td>Header File</td>
<td>calPrms.h</td>
</tr>
<tr>
<td>Definition File</td>
<td>calPrms.c</td>
</tr>
<tr>
<td>Memory Section</td>
<td>CalMem</td>
</tr>
</tbody>
</table>

8 Click OK. In response to the message about saving changes, click Yes.

Set Default Parameter Object to myPackage.Parameter

To make applying the storage class easier, use the Model Explorer to change the default parameter object from Simulink.Parameter to myPackage.Parameter.

1 At the command prompt, open the Model Explorer.

\[\text{daexplr}\]

2 In the Model Explorer Model Hierarchy pane, select Base Workspace.
3 In the Model Explorer toolbar, click the arrow next to the Add Simulink Parameter button. In the drop-down list, select Customize class lists.
4 In the Customize class lists dialog box, under Parameter classes, select the check box next to myPackage.Parameter. Click OK.
5 In the Model Explorer toolbar, click the arrow next to the Add Simulink Parameter button. In the drop-down list, select myPackage Parameter.

A myPackage.Parameter object appears in the base workspace. You can delete this object.

Now, when you use tools such as the Model Data Editor to create parameter objects, Simulink creates myPackage.Parameter objects instead of Simulink.Parameter objects.

Apply Storage Class

In the example model rtwdemo_roll, the BasicRollMode subsystem represents a PID controller. Configure the P, I, and D parameters as calibration parameters.
1 Open the model.

```
rtwdemo_roll
```

2 In the model, navigate into the **BasicRollMode** subsystem.

3 Select **Code > C/C++ Code > Configure Model in Code Perspective**.

4 Underneath the block diagram, open the Model Data Editor by selecting the **Model Data Editor** tab.

5 In the Model Data Editor, select the **Parameters** tab and update the block diagram.

Now, the data table contains rows that correspond to workspace variables used by the Gain blocks (which represent the P, I, and D parameters of the controller).

6 In the Model Data Editor, next to the **Filter contents** box, activate the **Filter using selection** button.

7 In the model, select the three Gain blocks.

8 In the **Filter contents** box, enter `model workspace`.

The variables that the Gain blocks use are in the model workspace.

9 In the data table, select the three rows and, in the **Storage Class** column for any of the rows, select **Convert to parameter object**.

The Model Data Editor converts the workspace variables to `myPackage.Parameter` objects. Now, you can apply a storage class to the objects.

10 In the **Storage Class** column for any of the rows, select **CalParam**.

**Configure Generation of ASAP2 Interface**

Configure the model to generate a2l files. Select **Configuration Parameters > Code Generation > Interface > ASAP2 interface**.

**Generate and Inspect Code**

1 Generate code from the model.

2 In the code generation report, inspect the `calPrms.c` file. The file defines the calibration parameters.

```c
/* Exported data definition */
#pragma SEC(CALPRM)

/* Definition for custom storage class: CalParam */
const volatile real32_T dispGain = 0.75F;
const volatile real32_T intGain = 0.5F;
const volatile real32_T rateGain = 2.0F;
```
The file calPrms.h declares the parameters.

3 Inspect the interface file rtwdemo_roll.a2l. The file contains information about each parameter, for example, for dispGain.

/begin CHARACTERISTIC
/* Name */ dispGain
/* Long Identifier */ 
/* Type */ VALUE
/* ECU Address */ 0x0000 /* @ECU_Address@dispGain@ */
/* Record Layout */ Scalar_FLOAT32_IEEE
/* Maximum Difference */ 0
/* Conversion Method */ rtwdemo_roll_CM_single
/* Lower Limit */ -3.4E+38
/* Upper Limit */ 3.4E+38
/end CHARACTERISTIC

Initialize Parameter Value From System Constant or Other Macro (Embedded Coder)

You can generate code that initializes a tunable parameter with a value calculated from some system constants (macros). For example, you can generate this code, which initializes a tunable parameter totalVol with a value calculated from macros numVessels and vesInitVol:

#define numVessels 16
#define vesInitVol 18.2

double totalVol = numVessels * vesInitVol;

This initialization technique preserves the mathematical relationship between the tunable parameter and the system constants, which can make the generated code more readable and easier to maintain. To generate this code:

1 Create parameter objects that represent the system constants.

    numVessels = Simulink.Parameter(16);
    vesInitVol = Simulink.Parameter(18.2);

2 Configure the objects to use the storage class Define, which yields a macro in the generated code.
3 Create another parameter object that represents the tunable parameter. Configure the object to use the storage class `ExportedGlobal`, which yields a global variable in the generated code.

```matlab
totalVol = Simulink.Parameter;
totalVol.CoderInfo.StorageClass = 'ExportedGlobal';
```

4 Set the value of `totalVol` by using the expression `numVessels * vesInitVol`. To specify that the generated code preserve the expression, use the `slexpr` function.

```matlab
totalVol.Value = slexpr('numVessels * vesInitVol');
```

5 Use `totalVol` to set block parameter values in your model. The code that you generate from the model initializes the tunable parameter with a value based on the system constants.

For more information and limitations about using an expression to set the value of a `Simulink.Parameter` object, see “Set Variable Value by Using a Mathematical Expression” (Simulink).

### Code Generation Impact of Storage Location for Parameter Objects

You can create a parameter object in the base workspace, a model workspace, or a data dictionary. However, when you end your MATLAB session, variables in the base workspace are deleted. To determine where to store parameter objects and other variables that a model uses, see “Determine Where to Store Variables and Objects for Simulink Models” (Simulink).

The location of a parameter object can impact the file placement of the corresponding data definition in the generated code.

- If you place a parameter object in the base workspace or a data dictionary, the code generator assumes that the corresponding parameter data (for example, a global variable) belongs to the system from which you generate code, not to any specific component in the system. For example, if a model in a model reference hierarchy uses a parameter object with a storage class other than `Auto`, the data definition appears in
the code generated for the top model in the hierarchy, not in the code generated for
the model that uses the object.

However, if you have Embedded Coder, some custom storage classes enable you to
specify the name of the model that owns a piece of data. When you specify an owner
model, the code generated for that model defines the data. For more information about
data ownership, see “Control Placement of Global Data Definitions and Declarations in
Generated Files” (Embedded Coder).

- If you place a parameter object in a model workspace, the code generator assumes
  that the model owns the data. If you generate code from a reference hierarchy that
  includes the containing model, the data definition appears in the code generated for
  the containing model.

  For more information about data ownership, see “Control Placement of Global Data
  Definitions and Declarations in Generated Files” (Embedded Coder).

- If you apply a storage class other than Auto to a parameter object, the object appears
  in the generated code as a global symbol. Therefore, in a model reference hierarchy,
  two such objects in different model workspaces or dictionaries cannot have the same
  name. The name of each object must be unique throughout the model hierarchy.

  However, if you have Embedded Coder, you can use the storage class FileScope to
  prevent name clashes between parameter objects in different model workspaces. See
  “Apply Custom Storage Classes to Individual Signal, State, and Parameter Data
  Elements” (Embedded Coder).

If you store an AUTOSAR.Parameter object in a model workspace, the code generator
ignores the storage class that you specify for the object.

**Configure Accessibility of Signal Data**

When you tune the value of a parameter during algorithm execution, you monitor or
capture output signal values to analyze the effect of the tuning. To represent signals in
the generated code as accessible data, you can use techniques such as test points and
storage classes. See “Configure Data Accessibility for Rapid Prototyping” on page 15-3.

**Programmatic Interfaces for Tuning Parameters**

You can configure the generated code to include:
• A C application programming interface (API) for tuning parameters independent of external mode. The generated code includes extra code so that you can write your own code to access parameter values. See “Exchange Data Between Generated and External Code Using C API” on page 30-2.

• A Target Language Compiler API for tuning parameters independently of external mode. See “Parameter Functions”.

**Set Tunable Parameter Minimum and Maximum Values**

It is a best practice to specify minimum and maximum values for tunable parameters.

You can specify these minimum and maximum values:

• In the block dialog box that uses the parameter object. Use this technique to store the minimum and maximum information in the model.

• By using the properties of a Simulink.Parameter object that you use to set the parameter value. Use this technique to store the minimum and maximum information outside the model.

For more information, see “Specify Minimum and Maximum Values for Block Parameters” (Simulink).

**Considerations for Other Modeling Goals**

<table>
<thead>
<tr>
<th>Goal</th>
<th>Considerations and More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply storage type qualifiers const and volatile</td>
<td>If you have Embedded Coder, to generate the storage type qualifiers, see “Protect Global Data with const and volatile Type Qualifiers” (Embedded Coder).</td>
</tr>
<tr>
<td>Prevent name clashes between parameters in different components by applying the keyword static</td>
<td>If you have Embedded Coder, use the storage class FileScope or a similar storage class that you create. See “Choose Storage Class for Controlling Data Representation in Generated Code” (Embedded Coder).</td>
</tr>
<tr>
<td>Generate ASAP2 (a2l) description</td>
<td>You can generate an a2l file that uses the ASAP2 standard to describe your calibration parameters. For more information, see “Define ASAP2 Information for Parameters and Signals” on page 31-4.</td>
</tr>
</tbody>
</table>
## Considerations and More Information

<table>
<thead>
<tr>
<th>Goal</th>
<th>Considerations and More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate AUTOSAR (arxml) description</td>
<td>If you have Embedded Coder, you can generate an arxml file that describes calibration parameters used by models that you configure for the AUTOSAR standard. See “Model AUTOSAR Calibration Parameters and Lookup Tables” (Embedded Coder).</td>
</tr>
<tr>
<td>Store lookup table data for calibration</td>
<td>To store lookup table data for calibration according to the ASAP2 or AUTOSAR standards (for example, STD_AXIS, COM_AXIS, or CURVE), you can use Simulink.LookupTable and Simulink.Breakpoint objects in lookup table blocks. However, some limitations apply. See Simulink.LookupTable.</td>
</tr>
<tr>
<td></td>
<td>To work around the limitations of Simulink.LookupTable and Simulink.Breakpoint objects, use Simulink.Parameter and AUTOSAR.Parameter objects instead. See “Define ASAP2 Information for Parameters and Signals” on page 31-4 and “Configure STD_AXIS and COM_AXIS Lookup Tables for AUTOSAR Measurement and Calibration” (Embedded Coder).</td>
</tr>
<tr>
<td>Use pragmas to store parameter data in specific memory locations</td>
<td>If you have an Embedded Coder license, to generate code that includes custom pragmas, use custom storage classes and memory sections. See “Control Data and Function Placement in Memory by Inserting Pragmas” (Embedded Coder).</td>
</tr>
</tbody>
</table>

### See Also

- Simulink.Breakpoint
- Simulink.LookupTable
- Simulink.Parameter

### Related Examples

- “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on page 26-102
- “Reuse Parameter Data in Different Data Type Contexts” on page 15-173
- “Limitations for Block Parameter Tunability in the Generated Code” on page 15-136
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
- “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82
- “Access Structured Data Through a Pointer That External Code Defines” (Embedded Coder)
Limitations for Block Parameter Tunability in the Generated Code

A block parameter, MATLAB variable, or Simulink.Parameter object is tunable if it appears in the generated code as data stored in memory, such as a global variable. For example, when you apply the storage class ExportedGlobal to a parameter object, the parameter object appears tunable in the generated code. When you set Default parameter behavior to Tunable, MATLAB variables and parameter objects appear tunable in the generated code. By definition, model arguments also appear tunable.

Under certain conditions, the code generator cannot maintain tunability of a parameter, variable, object, or expression. In this case, the code generator inlines the numeric value, preventing you from changing the value during code execution.

To detect these conditions in your model, set the model configuration parameter Detect loss of tunability (see “Detect loss of tunability” (Simulink)) to warning or error.

Tunable Expression Limitations

You can specify block parameter values as expressions that use Simulink.Parameter objects or workspace variables. For example, you can use the expression 5 * gainParam. For general information about using expressions to set block parameter values, see “Use Mathematical Expressions, MATLAB Functions, and Custom Functions” (Simulink). For limitations with respect to expressions that you use to set the values of Simulink.Parameter objects, see “Code Generation of Parameter Objects With Expression Values” on page 15-140.

A tunable workspace variable is a Simulink.Parameter object or workspace variable that appears tunable in the generated code. For example, an object or variable is tunable if you apply a storage class other than Auto or if you set Default parameter behavior to Tunable.

An expression that contains one or more tunable workspace variables, model arguments, or tunable mask parameters is called a tunable expression. The expression is tunable because the code generator attempts to preserve the expression in the code. Because the code generator preserves the expression, you can change the values of the parameter data during code execution.
The code generator reduces certain expressions to an inlined numeric value in the generated code. The inlining renders workspace variables in the expression nontunable. To avoid loss of tunability due to unsupported expressions, observe these guidelines:

- Expressions involving complex (i) workspace variables or parameter objects are not supported.
- Certain operators and functions cause the code generator to reduce expressions and remove tunability. To determine whether an operator or function causes loss of tunability, use the information in this table.

<table>
<thead>
<tr>
<th>Category</th>
<th>Operators or Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+ - .* ./ &lt; &gt; &lt;= &gt;= == ~= &amp;</td>
</tr>
<tr>
<td>2</td>
<td>* /</td>
</tr>
<tr>
<td>3</td>
<td>abs, acos, asin, atan, atan2, boolean, ceil, cos, cosh, exp, floor, log, log10, sign, sin, sinh, sqrt, tan, tanh, single, int8, int16, int32, uint8, uint16, uint32</td>
</tr>
<tr>
<td>4</td>
<td>: .^ ^ [] {} . \ . \ ' . ' , ;</td>
</tr>
</tbody>
</table>

- Use operators from category 1 without loss of tunability.
- Use operators from category 2 in expressions as long as at least one operand is a scalar. For example, scalar/scalar and scalar/matrix operand combinations are supported, but matrix/matrix combinations are not supported.
- You can use tunable workspace variables as arguments for the functions in category 3. If you use other functions, the code generator removes the tunability of the arguments.
- The operators in category 4 are not supported.
- The Fcn and If blocks do not support tunable expressions for code generation or in referenced models.
- You can write mask initialization code that creates and modifies variables. If you use those variables in an expression, the expression is not tunable.
- You can specify any data type for the Simulink.Parameter objects or workspace variables that makeup expressions. As long as the data type of these variables and objects and the data type of the corresponding block parameters are the same or double, the code generator can preserve tunability.
Linear Block Parameter Tunability

These blocks have a Realization parameter that affects the tunability of their numeric parameters:

- Transfer Fcn
- State-Space
- Discrete State-Space

To set the Realization parameter, you must use the command prompt:

```
set_param(gcf,'Realization','auto')
```

For the Realization parameter, you can choose these options:

- **general**: The block's numeric parameters appear tunable in the generated code.
- **sparse**: The generated code represents the block’s parameters as transformed values that increase efficiency. The parameters are not tunable.
- **auto**: The default. If one or more of the block’s parameters are tunable (for example, because you use a tunable parameter object to set a parameter value), then the block uses the general realization. Otherwise, the block uses the sparse realization.

To tune the parameter values of one of these blocks during an external mode simulation, the block must use the general realization.

Parameter Structures

As described in “Organize Data into Structures in Generated Code” on page 15-177, you can create structures of parameter data in the generated code.

- If a parameter structure is tunable, the numeric fields of the structure are tunable in the generated code. However, if any field contains a nontunable entity, such as a multidimensional array, none of the structure fields are tunable.
- You cannot declare individual substructures or fields within a parameter structure as tunable. You cannot use a Simulink.Parameter object as the value of a structure field. Instead, you must store the entire structure in the parameter object.
See Also

Related Examples

- “Create Tunable Calibration Parameter in the Generated Code” on page 15-122
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Code Generation of Parameter Objects With Expression Values

As described in “Set Variable Value by Using a Mathematical Expression” (Simulink), you can set the value of a Simulink.Parameter object to an expression involving other MATLAB variables or parameter objects. When you generate code from a model that uses such a parameter object, to achieve your goal, use the information in the table.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Technique and More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate code without Embedded Coder.</td>
<td>For the parameter object that uses the expression, apply any available storage class (see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82). For the parameter objects used in the expression, apply only the storage class Auto.</td>
</tr>
<tr>
<td>Generate code that defines a global variable and initializes it by using an expression involving system constants and other macros (requires Embedded Coder).</td>
<td>See “Initialize Parameter Value From System Constant or Other Macro (Embedded Coder)” (Embedded Coder).</td>
</tr>
<tr>
<td>Generate code that defines a macro whose value is an expression involving other macros (requires Embedded Coder).</td>
<td>For the parameter object that uses the expression, apply a storage class that yields a macro in the generated code, such as Define (see “Macro Definitions (#define)” (Embedded Coder)). For the parameter objects used in the expression, apply storage classes that yield imported macros. For example, use the storage class ImportedDefine. Your external code must define these macros.</td>
</tr>
</tbody>
</table>

Considerations and Limitations

- To avoid errors that prevent code generation, if you apply a storage class other than Auto to the dependent parameter object (which uses the expression as its value), the
parameter objects used in the expression must use either Auto or a storage class that yields a macro in the generated code.

- You cannot set the value of a parameter object that represents a symbolic dimension (see “Implement Dimension Variants for Array Sizes in Generated Code” (Embedded Coder)) to an expression.
- With Embedded Coder, you can generate code that preserves the expression, but only for the purpose of statically initializing the value of a global variable or macro that corresponds to the dependent parameter object. Follow the guidelines in “Expression Preservation” on page 15-141.

**Expression Preservation**

If you want Embedded Coder to preserve expressions in the generated code, adhere to these restrictions and guidelines.

- The dependent parameter object must use a storage class other than Auto. For example, to generate a global variable and initialize it by using the expression, use ExportedGlobal or ExportToFile.
- The parameter objects used in the expression must:
  - Use a storage class that yields a macro in the generated code, such as Define.
  - Have scalar, real values if the expression uses operators.
- The expression can use only these operators (in MATLAB syntax):
  - Mathematical: +, -, *
  - Relational: ==, ~=, <, >, <=, >=
- These data typing guidelines apply:
  - If possible, for a parameter object used in an expression, leave the DataType property at the default value, auto.
    
    To use a value other than auto, you must set the DataType property of the object that uses the expression to the same value. Otherwise, the code generator does not preserve the expression.
  - If you want to use a parameter object in multiple different expressions, and the dependent parameter objects have different data types, leave the DataType property of the independent object at the default value, auto. In the generated code, the value of the macro is expressed as a floating-point number (with effective...
data type `double`), and the code initializes the dependent parameters by typecasting the result of each expression.

**See Also**
Simulink.Parameter

**Related Examples**
- “Create Tunable Calibration Parameter in the Generated Code” on page 15-122
- “Share and Reuse Block Parameter Values by Creating Variables” (Simulink)
Specify Instance-Specific Parameter Values for Reusable Referenced Model

When you use model referencing to break a large system into components, each component is a separate model. You can reuse a component by referring to it with multiple Model blocks. Each Model block is an instance of the component. You can then configure a block parameter (such as the Gain parameter of a Gain block) to use either the same value or a different value for each instance of the component. To use different values, create and use a model argument to set the value of the block parameter.

When you generate code from a model hierarchy that uses model arguments, the arguments appear in the code as formal parameters of the referenced model entry-point functions, such as the output (step) function. The generated code then passes the instance-specific parameter values, which you specify in each Model block, to the corresponding function calls.

Whether you use or do not use model arguments, you can use storage classes to configure block parameters to appear in the generated code as tunable global variables. You can also use storage classes to generate tunable model argument values, which the generated code stores in memory and passes to the function calls. You can then change the values during execution.

Pass Parameter Data to Referenced Model Entry-Point Functions as Arguments

Configure a referenced model to accept parameter data through formal parameters of the generated model entry-point function. This technique enables you to specify a different parameter value for each instance (Model block) of the referenced model.

Configure Referenced Model to Use Model Arguments

Create the model ex_arg_code_ref. This model represents a reusable algorithm.

open_system('ex_arg_code_ref')
In the model, select **View > Model Data Editor**.

In the Model Data Editor, in the data table, use the **Data Type** column to set the data type of the Inport block to **single**. Due to data type inheritance, the other signals in the model use the same data type.

Select the **Parameters** tab.

In the model, select the Gain block.

In the Model Data Editor, use the **Value** column to set the value of the **Gain** parameter to **gainArg**.

Next to **gainArg**, click the action button \( \text{?} \) and select **Create**.

In the Create New Data dialog box, set **Value** to **Simulink.Parameter** and **Location** to **Model Workspace**. Click **Create**.

In the property dialog box, set **Value** to a number, for example, **3.17**. Click **OK**.

Use the Model Data Editor to set the **Numerator** parameter by using a **Simulink.Parameter** object named **coeffArg** whose value is **1.05**. As with **gainArg**, store the parameter object in the model workspace.

In the Model Data Editor, click the **Show/refresh additional information** button.

Use the **Filter contents** box to find each parameter object (**gainArg** and **coeffArg**). For each object, select the check box in the **Argument** column.
Save the `ex_arg_code_ref` model.

Alternatively, at the command prompt, you can use these commands to configure the blocks and the parameter objects:

```matlab
set_param('ex_arg_code_ref/In1','OutDataTypeStr','single')
set_param('ex_arg_code_ref/Gain','Gain','gainArg')
modelWorkspace = get_param('ex_arg_code_ref','ModelWorkspace');
assignin(modelWorkspace,'gainArg',Simulink.Parameter(3.17));
set_param('ex_arg_code_ref/Discrete Filter','Numerator','coeffArg')
assignin(modelWorkspace,'coeffArg',Simulink.Parameter(1.05));
set_param('ex_arg_code_ref','ParameterArgumentNames','coeffArg,gainArg')
save_system('ex_arg_code_ref')
```

**Specify Instance-Specific Parameter Values in Model Blocks**

Create the model `ex_arg_code_ref`. This model uses multiple instances (Model blocks) of the reusable algorithm.

```matlab
open_system('ex_arg_code')
```
In the model, open the Model Data Editor **Parameters** tab (View > Model Data Editor). The Model Data Editor shows four rows that correspond to the model arguments, `coeffArg` and `gainArg`, that you can specify for the two Model blocks.

Use the Model Data Editor to set values for the model arguments. For example, use the values in the figure.

```
Alternatively, at the command prompt, you can use these commands to set the values:

```
set_param('ex_arg_code/Model','ParameterArgumentValues',... 
    struct('coeffArg','0.98','gainArg','2.98'))

set_param('ex_arg_code/Model1','ParameterArgumentValues',... 
    struct('coeffArg','1.11','gainArg','3.34'))
```

Generate code from the top model.

```
rtwbuild('ex_arg_code')
```
The file `ex_arg_code_ref.c` defines the referenced model entry-point function, `ex_arg_code_ref`. The function has two formal parameters, `rtp_coeffArg` and `rtp_gainArg`, that correspond to the model arguments, `coeffArg` and `gainArg`. The formal parameters use the data type `real32_T`, which corresponds to the data type `single` in Simulink.

```c
/* Output and update for referenced model: */
'define ex_arg_code_ref' */
void ex_arg_code_ref(const real32_T *rtu_In1,
    real32_T *rty_Out1,
    DW_ex_arg_code_ref_f_T *localDW,
    real32_T rtp_coeffArg,
    real32_T rtp_gainArg)
```

The file `ex_arg_code.c` contains the definition of the top model entry-point function `ex_arg_code`. This function calls the referenced model entry-point function `ex_arg_code_ref` and uses the model argument values that you specified (such as 1.11 and 3.34) as the values of `rtp_coeffArg` and `rtp_gainArg`.

```c
/* ModelReference: '<Root>/Model' incorporates:
 *  Inport: '<Root>/In1'
 *  Outport: '<Root>/Out1'
*/
ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out1,
    &(ex_arg_code_DW.Model_InstanceData.rtdw), 0.98F, 2.98F);

/* ModelReference: '<Root>/Model1' incorporates:
 *  Inport: '<Root>/In1'
 *  Outport: '<Root>/Out2'
*/
ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out2,
    &(ex_arg_code_DW.Model1_InstanceData.rtdw), 1.11F, 3.34F);
```

The formal parameters use the data type `real32_T (single)`.

- The block parameters in `ex_arg_code_ref` determine their data types through internal rules. For example, in the Gain block dialog box, on the `Parameter Attributes` tab, `Parameter data type` is set to Inherit: Inherit via internal rule (the default). In this case, the internal rule chooses the same data type as the input and output signals, single.

- The model arguments in the model workspace use context-sensitive data typing because the value of the `DataType` property is set to `auto` (the default). With this setting, the model arguments use the same data type as the block parameters, single.

- The formal parameters in the generated code use the same data type as the model arguments, single.
**Generate Tunable Argument Values**

You can configure the instance-specific values in the Model blocks to appear in the generated code as tunable global variables. This technique enables you to store the parameter values for each instance in memory and tune the values during code execution.

In the top model `ex_arg_code`, select the Model Data Editor **Parameters** tab.

Use the Model Data Editor to set the values of the model arguments according to this figure.

```plaintext
set_param('ex_arg_code/Model','ParameterArgumentValues',...   struct('coeffArg','coeffForInst1','gainArg','gainForInst1'))
set_param('ex_arg_code/Model1','ParameterArgumentValues',...   struct('coeffArg','coeffForInst2','gainArg','gainForInst2'))
```

View the contents of the `ex_arg_code_ref` model workspace in Model Explorer by selecting **View > Model Explorer > Model Explorer**.

Copy `gainArg` and `coeffArg` from the `ex_arg_code_ref` model workspace to the base workspace.

Rename `gainArg` as `gainForInst1`. Rename `coeffArg` as `coeffForInst1`.

```plaintext
gainForInst1 = getVariable(modelWorkspace,'gainArg');
gainForInst1 = copy(gainForInst1);
coeffForInst1 = getVariable(modelWorkspace,'coeffArg');
coeffForInst1 = copy(coeffForInst1);
```

Copy `gainForInst1` and `coeffForInst1` as `gainForInst2` and `coeffForInst2`.

```plaintext
gainForInst2 = copy(gainForInst1);
coeffForInst2 = copy(coeffForInst1);
```
Set the instance-specific parameter values by using the Value property of the parameter objects in the base workspace.

gainForInst1.Value = 2.98;
coeffForInst1.Value = 0.98;

gainForInst2.Value = 3.34;
coeffForInst2.Value = 1.11;

In the Model Data Editor for the top model `ex_arg_code`, click the **Show/refresh additional information** button.

Set the **Change view** drop-down list to **Code**.

For the new parameter objects, set the value in the **Storage Class** column to **ExportedGlobal**. This setting causes the parameter objects to appear in the generated code as tunable global variables.

gainForInst1.StorageClass = 'ExportedGlobal';
coeffForInst1.StorageClass = 'ExportedGlobal';
gainForInst2.StorageClass = 'ExportedGlobal';
coeffForInst2.StorageClass = 'ExportedGlobal';

Generate code from the top model.

```
rtwbuild('ex_arg_code')
```

The file `ex_arg_code.c` defines the global variables that correspond to the parameter objects in the base workspace.

```
/* Exported block parameters */
real32_T coeffForInst1 = 0.98F;    /* Variable: coeffForInst1
   * Referenced by: '<Root>/Model'
*/
real32_T coeffForInst2 = 1.11F;    /* Variable: coeffForInst2
   * Referenced by: '<Root>/Model1'
*/
real32_T gainForInst1 = 2.98F;     /* Variable: gainForInst1
   * Referenced by: '<Root>/Model'
*/
real32_T gainForInst2 = 3.34F;     /* Variable: gainForInst2
   * Referenced by: '<Root>/Model1'
*/
```
In each call to `ex_arg_code_ref`, the top model algorithm uses the global variables to set the values of the formal parameters.

```c
/* ModelReference: '<Root>/Model' incorporates:
 *  Inport: '<Root>/In1'
 *  Outport: '<Root>/Out1'
 */
ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out1,
                   &(ex_arg_code_DW.Model_InstanceData.rtdw), coeffForInst1,
                   gainForInst1);

/* ModelReference: '<Root>/Model1' incorporates:
 *  Inport: '<Root>/In1'
 *  Outport: '<Root>/Out2'
 */
ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out2,
                   &(ex_arg_code_DW.Model1_InstanceData.rtdw), coeffForInst2,
                   gainForInst2);
```

The global variables in the generated code use the data type `real32_T` (single).

- The parameter objects in the base workspace use context-sensitive data typing because the `DataType` property is set to `auto` (the default). With this setting, the parameter objects in the base workspace use the same data type as the model arguments, `single`.
- The global variables in the generated code use the same data type as the parameter objects in the base workspace.

**Group Multiple Model Arguments into Single Structure**

Use the Model Explorer to copy `gainArg` and `coeffArg` from the `ex_arg_code_ref` model workspace into the base workspace.

```matlab
temp = getVariable(modelWorkspace, 'gainArg');
gainArg = copy(temp);
temp = getVariable(modelWorkspace, 'coeffArg');
coeffArg = copy(temp);
```

At the command prompt, combine these two parameter objects into a structure, `structArg`.

```matlab
structArg = Simulink.Parameter(struct('gain', gainArg.Value, ...
                                   'coeff', coeffArg.Value));
```

Use the Model Explorer to move `structArg` into the model workspace.

```matlab
assignin(modelWorkspace, 'structArg', copy(structArg));
clear structArg gainArg coeffArg
```
In the Contents pane, configure `structArg` as the only model argument.

```matlab
set_param('ex_arg_code_ref','ParameterArgumentNames','structArg')
```

In the `ex_arg_code_ref` model, select the Model Data Editor Parameters tab.

Use the Model Data Editor to set the value of the Gain parameter to `structArg.gain` and the value of the Numerator parameter to `structArg.coeff`. Save the model.

```matlab
set_param('ex_arg_code_ref/Gain','Gain','structArg.gain')
set_param('ex_arg_code_ref/Discrete Filter',... 'Numerator','structArg.coeff')
save_system('ex_arg_code_ref')
```

At the command prompt, combine the four parameter objects in the base workspace into two structures. Each structure stores the parameter values for one instance of `ex_arg_code_ref`.

```matlab
structForInst1 = Simulink.Parameter(struct('gain',gainForInst1.Value,... 'coeff',coeffForInst1.Value));
structForInst2 = Simulink.Parameter(struct('gain',gainForInst2.Value,... 'coeff',coeffForInst2.Value));
```

In the top model `ex_arg_code`, set the Change view drop-down list to Design. Use the Model Data Editor to set the argument values according to this figure.
set_param('ex_arg_code/Model','ParameterArgumentValues',
    struct('structArg','structForInst1'))
set_param('ex_arg_code/Model1','ParameterArgumentValues',
    struct('structArg','structForInst2'))

Click the **Show/refresh additional information** button.

For the new parameter objects `structForInst1` and `structForInst2`, use the Model Data Editor to apply the storage class `ExportedGlobal`.

```matlab
structForInst1.StorageClass = 'ExportedGlobal';
structForInst2.StorageClass = 'ExportedGlobal';
```

At the command prompt, use the function `Simulink.Bus.createObject` to create a `Simulink.Bus` object. The hierarchy of elements in the object matches the hierarchy of the structure fields. The default name of the object is `slBus1`.

```matlab
Simulink.Bus.createObject(structForInst1.Value);
```

Rename the bus object as `myParamStructType` by copying it.

```matlab
myParamStructType = copy(slBus1);
```

In the Model Data Editor for `ex_arg_code`, set **Change view** to **Design**. Use the **Data Type** column to set the data type of `structForInst1` and `structForInst2` to `Bus: myParamStructType`.

```matlab
structForInst1.DataType = 'Bus: myParamStructType';
structForInst2.DataType = 'Bus: myParamStructType';
```

In the Model Data Editor for `ex_arg_code_ref`, use the Model Data Editor to set the data type of `structArg` to `Bus: myParamStructType`. 
temp = getVariable(modelWorkspace,'structArg');
temp = copy(temp);
temp.DataType = 'Bus: myParamStructType';
assignin(modelWorkspace,'structArg',copy(temp));

Save the ex_arg_code_ref model.
save_system('ex_arg_code_ref')

When you use structures to group parameter values, you cannot take advantage of context-sensitive data typing to control the data types of the fields of the structures (for example, the fields of structForInst1). However, you can use the properties of the bus object to control the field data types.

At the command prompt, set the data type of the elements in the bus object to single. The corresponding fields in the structures (such as structForInst1 and structArg) use the same data type.

myParamStructType.Elements(1).DataType = 'single';
myParamStructType.Elements(2).DataType = 'single';

Generate code from the top model ex_arg_code.

rtwbuild('ex_arg_code')

The file ex_arg_code_types.h defines the structure type myParamStructType, which corresponds to the Simulink.Bus object.

typedef struct {
    real32_T gain;
    real32_T coeff;
} myParamStructType;

In the file ex_arg_code_ref.c, the referenced model entry-point function has a formal parameter, rtp_structArg, that corresponds to the model argument structArg.

/* Output and update for referenced model: 
   'ex_arg_code_ref' */
void ex_arg_code_ref(const real32_T *rtu_In1,
real32_T *rty_Out1, DW_ex_arg_code_ref_f_T *localDW, const myParamStructType *rtp_structArg)

The file ex_arg_code.c defines the global structure variables that correspond to the parameter objects in the base workspace.

/* Exported block parameters */
myParamStructType structForInst1 = {
    2.98F,
    0.98F
} ; /* Variable: structForInst1
    * Referenced by: '<Root>/Model'
    */

myParamStructType structForInst2 = {
    3.34F,
    1.11F
} ; /* Variable: structForInst2
    * Referenced by: '<Root>/Model1'
    */

The top model algorithm in the file ex_arg_code.c passes the addresses of the structure variables to the referenced model entry-point function.

/* ModelReference: '<Root>/Model' incorporates:
    * Inport: '<Root>/ln1'
    * Outport: '<Root>/Out1'
    */
ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out1,
    &ex_arg_code_DW.Model_InstanceData.rtdw), &structForInst1);

/* ModelReference: '<Root>/Model1' incorporates:
    * Inport: '<Root>/ln1'
    * Outport: '<Root>/Out2'
    */
ex_arg_code_ref(&ex_arg_code_U.In1, &ex_arg_code_Y.Out2,
    &ex_arg_code_DW.Model1_InstanceData.rtdw), &structForInst2);

Control Data Types of Model Arguments and Argument Values

When you use model arguments, you can apply a data type to:

• The block parameters that use the arguments (for certain blocks, such as those in the Discrete library).
• The arguments in the referenced model workspace.
• The argument values that you specify in Model blocks.

To generate efficient code by eliminating unnecessary typecasts and C shifts, consider using inherited and context-sensitive data typing to match the data types.

• In the model workspace, use a MATLAB variable whose data type is double or a parameter object whose DataType property is set to auto. In this case, the variable or object uses the same data type as the block parameter.

• When you set the argument values in Model blocks, take advantage of context-sensitive data typing. To set an argument value, use an untyped value.

  - A literal number such as 15.23. Do not use a typed expression such as single(15.23).
  - A MATLAB variable whose data type is double.
  - A Simulink.Parameter object whose DataType property is set to auto.

In these cases, the number, variable, or object uses the same data type as the model argument in the referenced model workspace. If you also configure the model argument to use context-sensitive data typing, you can control the data types of the block parameter, the argument, and the argument value by specifying the type only for the block parameter.

For basic information about controlling parameter data types, see “Parameter Data Types in the Generated Code” on page 15-157.

**Use Model Argument in Different Data Type Contexts**

If you use a model argument to set multiple block parameter values, and the data types of the block parameters differ, you cannot use context-sensitive data typing (double or auto) for the argument in the model workspace. You must explicitly specify a data type for the argument. For example, if the argument in the model workspace is a parameter object (such as Simulink.Parameter), set the DataType property to a value other than auto. For more information about this situation, see “Reuse Parameter Data in Different Data Type Contexts” on page 15-173.

In this case, you can continue to take advantage of context-sensitive data typing to control the data type of the argument values that you specify in Model blocks. Each argument value uses the data type that you specify for the corresponding argument in the model workspace.
See Also

Related Examples

- “Code Generation of Referenced Models” on page 7-2
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
- “Parameterize Instances of a Reusable Referenced Model” (Simulink)
- “Organize Data into Structures in Generated Code” on page 15-177
- “Parameter Data Types in the Generated Code” on page 15-157
Parameter Data Types in the Generated Code

The data type of a block parameter (such as the Gain parameter of a Gain block), numeric MATLAB variable, or Simulink.Parameter object determines the data type that the corresponding entity in the generated code uses (for example, a global variable or an argument of a function). To generate more efficient code, you can match parameter data types with signal data types or store parameters in smaller data types.

For basic information about setting block parameter data types in a model, see “Control Block Parameter Data Types” (Simulink).

Significance of Parameter Data Types

The data type that a block parameter, MATLAB variable, or parameter object uses determines the data type that the generated code uses to store the parameter value in memory. For example:

- If you set the model configuration parameter Default parameter behavior (see “Default parameter behavior”) to Tunable, the Gain parameter of a Gain block appears in the generated code as a field of a global structure that stores parameter data. If you apply the data type single to the block parameter in the model, the structure field in the code uses the corresponding data type, real32_T.

- If you apply the storage class ExportedGlobal to a Simulink.Parameter object, the object appears in the generated code as a separate global variable. If you set the DataType property of the object to int8, the global variable in the code uses the corresponding data type, int8_T.

- If you configure a Simulink.Parameter object in a model workspace as a model argument, the object appears in the generated code as a formal parameter (argument) of a model entry-point function, such as the step function. The DataType property of the object determines the data type of the formal parameter.

Other than determining the data type that the generated code uses to store parameter values in memory, the data type of a parameter, variable, or object can also:

- Cause the block to cast the value of the parameter prior to code generation. The cast can result in overflow, underflow, or quantization.
- Cause the generated code to include extra code, for example saturation code.
Typecasts Due to Parameter Data Type Mismatches

When the data types of block parameters, workspace variables, and signals differ, blocks can use typecasts to reconcile the data type mismatches. These typecasts can cause the generated code algorithm, including the model step function, to include explicit casts to reconcile mismatches in storage data type and C bit shifts to reconcile mismatches in fixed-point scaling.

Parameter data type mismatches can occur when:

- The data type that you specify for a MATLAB variable or parameter object (Simulink.Parameter) differs from the data type of a block parameter. The block parameter typecasts the value of the variable or object.
- The data type that you specify for an initial value differs from the data type of the initialized signal or state.
- The data type that you specify for a block parameter differs from the data type of the signal or signals that the parameter operates on. Some blocks typecast the parameter to perform the operation. For example, the Gain block performs this typecast.

If you configure a variable or object to use bias or fractional fixed-point slope, the block parameter cannot perform the typecast. In this case, you must match the data type of the variable or parameter object with the data type of the block parameter. Use one of these techniques:

- Use context-sensitive data typing for the variable or parameter object. For a MATLAB variable, use a double number to set the value of the variable. For a parameter object, set the DataType property to auto.
- Use a Simulink.AliasType or Simulink.NumericType object to set the data type of the block parameter and the data type of a parameter object.

Use this technique when you cannot rely on context-sensitive data typing, for example, when you use the field of a structure to set the value of the block parameter.
- Manually specify the same data type for the block parameter and the variable or parameter object.

Use this technique to reduce the dependence of the model on inherited and context-sensitive data types and on external variables and objects.

For blocks that access parameter data through pointer or reference in the generated code, if you specify different data types for the workspace variable and the block...
parameter, the generated code implicitly casts the data type of the variable to the data type of the block parameter. Note, that an implicit cast requires a data copy which could significantly increase RAM consumption and slow down code execution speed for large data sets. For example, Lookup Table blocks often access large vectors or matrices through pointer or reference in the generated code.

For information about matching parameter data types when you use model arguments, see “Control Data Types of Model Arguments and Argument Values” on page 15-154.

**Detect Downcast and Loss of Precision due to Data Type Mismatches**

You can configure diagnostic configuration parameters to detect unintentional data type mismatches that result in quantization and loss of parameter precision. See “Model Configuration Parameters: Data Validity Diagnostics” (Simulink).

**Considerations for Other Modeling Patterns**

When you use specific modeling patterns and constructs such as fixed-point data types, parameter structures, and lookup table objects, use different techniques to control parameter data types.

- “Tunable Parameters and Best-Precision Fixed-Point Scaling” on page 15-159
- “Control Data Types of Structure Fields” on page 15-160
- “Control Data Types of Lookup Table Objects” on page 15-160
- “Data Typing for Expressions in Parameter Objects” on page 15-161

**Tunable Parameters and Best-Precision Fixed-Point Scaling**

To apply best-precision fixed-point scaling to a tunable block parameter or parameter object, you can use the Fixed-Point Tool to autoscale an entire system or use the Data Type Assistant to configure individual parameters or objects. See “Calculate Best-Precision Fixed-Point Scaling for Tunable Block Parameters” (Simulink).

If a tunable parameter uses best-precision fixed-point scaling, Simulink chooses a data type based on the minimum and maximum values that you specify for the parameter (see “Specify Minimum and Maximum Values for Block Parameters” (Simulink)). You can specify these values in the block dialog box that uses the parameter or in the properties of a Simulink.Parameter object.

If you do not specify a minimum or maximum, Simulink chooses a data type based on the value of the parameter. The chosen scaling might restrict the range of possible tuning
values. Therefore, it is a best practice to specify minimum and maximum values for each tunable parameter.

A tunable parameter can use best-precision scaling even if you do not specify it in the parameter data type. For example, the Gain block can choose a best-precision scaling if the **Parameter data type** in the block dialog box is set to *Inherit: Inherit via internal rule*. This setting is the default for the block.

**Control Data Types of Structure Fields**

When you use a structure as the value of a block parameter (for example to initialize a bus signal), or when you organize multiple block parameter values into a single structure, you can create a Simulink.Bus object to use as the data type of a Simulink.Parameter object. You can then control the data types of individual fields in the structure. See “Control Field Data Types and Characteristics by Creating Parameter Object” (Simulink) and “Control Data Types of Initial Condition Structure Fields” (Simulink).

**Control Data Types of Lookup Table Objects**

When you use Simulink.LookupTable and Simulink.Breakpoint objects to store table and breakpoint data for a lookup table block, to control the data types of the table and breakpoint data, use one of these techniques:

- Set the Value property of the embedded Simulink.lookuptable.Table and Simulink.lookuptable.Breakpoint objects by using untyped expressions such as `[1 2 3]`, which returns a double vector. To control the data type, set the **DataType** property to a value other than **auto**.

  Use this technique to separate the value of the table or breakpoint data from the data type, which can improve readability and understanding of your design. You can then use a Simulink.NumericType or Simulink.AliasType object to:

  - Customize the name of the data type in the generated code.
  - Match the data type of the table or breakpoint data with the data type of a signal in the model.
  - Set the Value property of the embedded objects by using typed expressions such as `single([1 2 3])`. To use a fixed-point data type, set the Value property with an **fi** object.
Set the **DataType** property of the embedded objects to the default value, **auto**. The table and breakpoint data then acquire the data type that you use to set the **Value** property.

Use this technique to store the data type information in the **Value** property, which can simplify the way you interact with the **Simulink.LookupTable** and **Simulink.Breakpoint** objects. You can leave the **DataType** property at the default value.

When you later change the breakpoint or table data in the **Value** property, preserve the data type information by using a typed expression. Alternatively, if you use a command at the command prompt or a script to change the data, to avoid using a typed expression, use subscripted assignment, (:).

```plaintext
myLUTObject.Table.Value(:) = [4 5 6];
```

When you change the data stored in the **Value** property, if you do not use a typed expression or subscripted assignment, you lose the data type information.

When blocks in a subsystem use **Simulink.LookupTable** or **Simulink.Breakpoint** objects, you cannot set data type override (see “Control Fixed-Point Instrumentation and Data Type Override” (Simulink)) only on the subsystem. Instead, set data type override on the entire model.

**Data Typing for Expressions in Parameter Objects**

You can use an expression to set the value of a parameter object (such as **Simulink.Parameter**). The expression encodes mathematical relationships between different objects. When you use this technique, different data typing rules apply. See “Set Variable Value by Using a Mathematical Expression” (Simulink).

**See Also**

**Related Examples**

- “Generate Efficient Code by Specifying Data Types for Block Parameters” on page 15-163
- “Reuse Parameter Data in Different Data Type Contexts” on page 15-173
- “Data Types Supported by Simulink” (Simulink)
• “Control Signal Data Types” (Simulink)
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Generate Efficient Code by Specifying Data Types for Block Parameters

To generate more efficient code, match the data types of block parameters (such as the Gain parameter of a Gain block) with signal data types. Alternatively, you can store parameters in smaller data types.

Eliminate Unnecessary Typecasts and Shifts by Matching Data Types

These examples show how to generate efficient code by configuring a block parameter to use the same data type as a signal that the block operates on.

Store Data Type Information in Model

Open the example model `rtwdemo_basicsc` and configure it to show the generated names of blocks.

```matlab
load_system('rtwdemo_basicsc')
set_param('rtwdemo_basicsc','HideAutomaticNames','off')
open_system('rtwdemo_basicsc')
```

Identify the Gain block in the model, which uses the base workspace variable `K1` to set the value of the Gain parameter. The input signal of this block uses the data type `single`.

In the model, select View > Model Data Editor.

In the Model Data Editor, select the Parameters tab.

In the model, select the Gain block. In the Model Data Editor, the Data Type column shows that the data type of the Gain parameter of the block is set to Inherit: Same as input. With this setting, the Gain parameter of this block uses the same data type as the input signal.

In the Model Data Editor, set the Change view drop-down list to Code.

Update the block diagram. Now, in the Model Data Editor, the data table shows rows that correspond to workspace variables that the model uses, including `K1`. 

15-163
In the Model Data Editor, find the row that corresponds to K1. For that row, in the Storage Class column, select Convert to parameter object. Simulink converts K1 to a Simulink.Parameter object.

Use the Storage Class column to apply the storage class ExportedGlobal. With this setting, the object appears in the generated code as a global variable.

In the Model Data Editor, set Change view to Design.

In the data table, for the row that represents K1, in the Data Type column, select auto. With this setting, the parameter object acquires its data type from the block parameters that use the object (in this case, the Gain block parameter).

Alternatively, to create and configure the object, use these commands at the command prompt:

```matlab
K1 = Simulink.Parameter(2);
K1.CoderInfo.StorageClass = 'ExportedGlobal';
```

Generate code from the model.

```bash
rtwbuild('rtwdemo_basicsc')
```

### Starting build procedure for model: rtwdemo_basicsc
### Successful completion of build procedure for model: rtwdemo_basicsc

The generated file rtwdemo_basicsc.c defines the global variable K1 by using the data type real32_T, which corresponds to the data type single in Simulink.

```bash
file = fullfile('rtwdemo_basicsc_grt_rtw','rtwdemo_basicsc.c');
rtwdemodbtype(file,'/* Exported block parameters */','real32_T K1 = 2.0F;',1,1)

/* Exported block parameters */
real32_T K1 = 2.0F;                    /* Variable: K1
```

The generated code algorithm in the model step function uses K1 directly without typecasting.

```bash
rtwdemodbtype(file,' rtwdemo_basicsc_DW.X = K1',...'
    rtCP_Table1_bp01Data, rtCP_Table1_tableData',1,1)
    rtwdemo_basicsc_DW.X = K1 * look1_iflf_binlx(rtwdemo_basicsc_U.input2, rtCP_Table1_bp01Data, rtCP_Table1_tableData, 10U);
```

On the Model Data Editor Parameters tab, you can optionally set the data type of the Gain block parameter to Inherit: Inherit via internal rule (the default). In
this case, the block parameter chooses the same data type as the input signal, single. However, when you use Inherit: Inherit via internal rule, under other circumstances (for example, when you use fixed-point data types), the block parameter might choose a different data type.

**Store Data Type Information in Parameter Object**

When you use a Simulink.Parameter object to export or import parameter data from the generated code to your external code, for example by applying the storage class ImportedExtern, you can specify data type information in the parameter object. To match the data type of the parameter object with a signal data type, create a Simulink.NumericType or Simulink.AliasType object. You can strictly control the data type that the parameter object uses in the generated code, eliminating the risk that Simulink chooses a different data type when you make changes to the model.

At the command prompt, create a Simulink.NumericType object that represents the data type single.

```matlab
myType = Simulink.NumericType;
myType.DataTypeMode = 'Single';
```

Use the Model Data Editor **Data Type** column to set these data types to `myType`:

- The parameter object. Use the **Parameters** tab.
- The Inport block named In2. Use the **Imports/Outports** tab. Due to data type propagation, the input signal of the Gain block also uses `myType`.

Use the Model Data Editor **Parameters** tab to set the data type of the Gain block parameter to Inherit: Inherit from 'Gain'. Use this data type object as the data type of the parameter object.

Alternatively, to configure the object and the blocks, use these commands at the command prompt:

```matlab
K1.DataType = 'myType';
set_param('rtwdemo_basicsc/In2','OutDataTypeStr','myType')
set_param('rtwdemo_basicsc/Gain','ParamDataTypeStr','Inherit: Inherit from ''Gain''')
```

Generate code from the model.

```bash
rtwbuild('rtwdemo_basicsc')
```

```bash
### Starting build procedure for model: rtwdemo_basicsc
### Successful completion of build procedure for model: rtwdemo_basicsc
```
The global variable K1 continues to use the data type real32_T.

```matlab
file = fullfile('rtwdemo_basicsc_grt_rtw','rtwdemo_basicsc.c');
rtwdemodbtype(file, '/* Exported block parameters */','real32_T K1 = 2.0F;', 1, 1)

/* Exported block parameters */
real32_T K1 = 2.0F;                    /* Variable: K1

Reduce Memory Consumption by Storing Parameter Value in Small Data Type

When you use a parameter object (for example, Simulink.Parameter) to set block parameter values, you can configure the object to appear in the generated code as a tunable global variable. By default, the parameter object and the corresponding global variable typically uses the same data type as the signal or signals on which the block operates. For example, if the input signal of a Gain block uses the data type int16, the parameter object typically use the same data type. To reduce the amount of memory that this variable consumes, specify that the variable use a smaller integer data type such as int8.

Store Parameter Value in Integer Data Type

Run the script prepare_rtwdemo_basicsc_2, which prepares the model rtwdemo_basicsc for this example.

```
run(fullfile(matlabroot,'examples','simulinkcoder', ...
    'main','prepare_rtwdemo_basicsc_2'))
Many of the signals in the model use the data type `single`.

In the model, select **View > Model Data Editor**.

In the Model Data Editor, inspect the **Parameters** tab.

Click the **Show/refresh additional information** button.

Next to the **Filter contents** box, activate the **Filter using selection** button.

In the model, click the Gain block. The Model Data Editor shows one row that corresponds to the **Gain** parameter of the block and one row that corresponds to the MATLAB variable `K1`, which sets the parameter value to 2. `K1` resides in the base workspace.

In the Model Data Editor, set the **Change view** drop-down list to Code.

In the data table, for the row that corresponds to `K1`, in the **Storage Class** column, from the drop-down list, select **Convert to parameter object**. Simulink converts `K1` to a `Simulink.Parameter` object.
K1 = Simulink.Parameter(K1);

Use the **Storage Class** column to apply the storage class ExportedGlobal to K1. With this setting, K1 appears in the generated code as a global variable.

K1.CoderInfo.StorageClass = 'ExportedGlobal';

In the Model Data Editor, set **Change view** to **Design** and use the **Data Type** column to apply the data type int8 to K1.

K1.DataType = 'int8';

For the row that represents the **Gain** block parameter, in the **Data Type** column, set the drop-down list to **Inherit: Inherit from 'Gain'**. With this setting, the **Gain** parameter of the block inherits the int8 data type from the parameter object.

set_param('rtwdemo_basicsc/Gain','ParamDataTypeStr','Inherit: Inherit from ''Gain''')

Generate code from the model.

rtwbuild('rtwdemo_basicsc')

### Starting build procedure for model: rtwdemo_basicsc
### Successful completion of build procedure for model: rtwdemo_basicsc

The generated file `rtwdemo_basicsc.c` defines the global variable K1 by using the data type `int8_T`, which corresponds to the data type int8 in Simulink.

```matlab
file = fullfile('rtwdemo_basicsc_grt_rtw','rtwdemo_basicsc.c');
rtwdemodbtype(file,'/* Exported block parameters */','int8_T K1 = 2;',1,1)

/* Exported block parameters */
int8_T K1 = 2; /* Variable: K1
```

The code algorithm in the model **step** function uses K1 to calculate the output of the Gain block. The algorithm casts K1 to the data type `real32_T` (single) because the signals involved in the calculation use the data type `real32_T`.

```matlab
rtwdemodbtype(file,' rtwdemo_basicsc_DW.X =','10U');',1,1)

rtwdemo_basicsc_DW.X = (real32_T)K1 * look1_iflf_binlx
(rtwdemo_basicsc_U.input2, rtCP_Table1_bp01Data, rtCP_Table1_tableData, 10U);
```
Store Fixed-Point Parameter Value in Smaller Integer Data Type

Suppose you configure the signals in your model to use fixed-point data types. You want a gain parameter to appear in the generated code as a tunable global variable. You know the range of real-world values that you expect the parameter to assume (for example, between 0 and 4). If you can meet your application requirements despite reduced precision, you can reduce memory consumption by configuring the parameter to use a different data type than the input and output signals of the block.

Open the example model `fxpdemo_direct_form2` and configure it to show the generated names of blocks.

```matlab
load_system('fxpdemo_direct_form2')
set_param('fxpdemo_direct_form2', 'HideAutomaticNames', 'off')
open_system('fxpdemo_direct_form2')
```
Update the block diagram. Signals in this model use signed fixed-point data types with a word length of 16 and binary-point-only scaling.

Open the Gain5 block dialog box. The Gain parameter is set to 1.85. Suppose you want to configure this parameter.

Set Gain to myGainParam and click Apply.

Click the action button (with three vertical dots) next to the parameter value. Select Create.

In the Create New Data dialog box, set Value to Simulink.Parameter(1.85) and click Create. The Simulink.Parameter object myGainParam appears in the base workspace.

In the myGainParam property dialog box, set Storage class to ExportedGlobal and click OK. With this setting, myGainParam appears in the generated code as a global variable.

In the block dialog box, on the Parameter Attributes tab, set Parameter minimum to 0 and Parameter maximum to 4.

Set Parameter data type to fixdt(0,8) and click Apply.

Click the Show Data Type Assistant button. The Data Type Assistant shows that the expression fixdt(0,8) specifies an unsigned fixed-point data type with a word length of 8 and best-precision scaling. When you simulate or generate code, the block parameter chooses a fraction length (scaling) that enables the data type to represent values between the parameter minimum and maximum (0 and 4) with the best possible precision.

In the Data Type Assistant, set Scaling to Binary point. Click Calculate Best-Precision Scaling, Fixed-point details, and Refresh Details. The information under Fixed-point details shows that a fraction length of 5 can represent the parameter values with a precision of 0.03125.

Set Scaling back to Best precision and click OK. In this example, when you simulate or generate code, the block parameter chooses a fraction length of 5.

Alternatively, you can use these commands at the command prompt to create the object and configure the block:

```matlab
myGainParam = Simulink.Parameter(1.85);
myGainParam.CoderInfo.StorageClass = 'ExportedGlobal';
```
set_param('fxpdemo_direct_form2/Gain5','Gain','myGainParam')
set_param('fxpdemo_direct_form2/Gain5','ParamMin','0','ParamMax','4')
set_param('fxpdemo_direct_form2/Gain5','ParamDataTypeStr','fixdt(0,8)')

Configure the model to produce a code generation report. To reduce clutter in the Command Window, clear the configuration parameter **Verbose build**.

set_param('fxpdemo_direct_form2','GenerateReport','on',
    'LaunchReport','on','RTWVerbose','off')

Generate code from the model.

evalc('rtwbuild(''fxpdemo_direct_form2'')');

The generated file `fxpdemo_direct_form2.c` defines the global variable `myGainParam` by using the data type `uint8_T`, which corresponds to the specified word length, 8. The code initializes the variable by using an integer value that, given the fraction length of 5, represents the real-world parameter value 1.85.

```c
file = fullfile('fxpdemo_direct_form2_grt_rtw','fxpdemo_direct_form2.c');
rtwdemodbtype(file,'
    /* Exported block parameters */','uint8_T myGainParam = 59U;',1,1)
/* Exported block parameters */
uint8_T myGainParam = 59U;             /* Variable: myGainParam */
```

The code algorithm uses `myGainParam` to calculate the output of the Gain5 block. The algorithm uses a C shift to scale the result of the calculation.

```c
rtwdemodbtype(file,'
    /* Gain: '<Root>/Gain5' */','
    /* Gain: '<Root>/Gain' incorporates:','1,0)
    /* Gain: '<Root>/Gain5' */
    fxpdemo_direct_form2_B.Gain5 = (int16_T)((myGainParam *
        fxpdemo_direct_form2_B.UnitDelay1) >> 5);
```

**See Also**

**Related Examples**

- “Optimization Tools and Techniques” on page 33-7
• “Parameter Data Types in the Generated Code” on page 15-157
• “Reuse Parameter Data in Different Data Type Contexts” on page 15-173
Reuse Parameter Data in Different Data Type Contexts

When you use a Simulink.Parameter object or a numeric MATLAB variable to set two or more block parameter values, if the block parameters have different data types, you must explicitly specify the data type of the object or variable. For example, you cannot leave the data type of the parameter object at the default value, auto.

Create and Configure Example Model

Create the model `ex_paramdt_contexts`.

```
ex_paramdt_contexts
```

In the model, select View > Model Data Editor.

In the Model Data Editor, on the `Inports/Outports` tab, use the `Data Type` column to set the data type of the `In1 Inport` block to `single` and the data type of the `In2` block to `int8`.

On the `Signals` tab, set the data types of the Gain block outputs to `Inherit: Same as input`.

On the `Parameters` tab, for the `Gain` parameters of the Gain blocks, set `Data Type` to `Inherit: Same as input`.

For the `Gain` parameters, set `Value` to `myGainParam`.

Alternatively, to configure the blocks, use these commands at the command prompt:
In the Model Data Editor, for either Gain block parameter, click the cell in the Value column. Next to myGainParam, click the action button (with three vertical dots) and select Create.

In the Create New Data dialog box, set Value to Simulink.Parameter(3) and click Create. A Simulink.Parameter object with value 3 appears in the base workspace.

In the myGainParam property dialog box, set Data type to int8 and Storage class to ExportedGlobal. With the storage class ExportedGlobal, the object appears in the generated code as a global variable.

Alternatively, to create and configure the parameter object, use these commands at the command prompt:

```matlab
myGainParam = Simulink.Parameter(3);
myGainParam.CoderInfo.StorageClass = 'ExportedGlobal';
myGainParam.DataType = 'int8';
```

In this model, you use the parameter object myGainParam to set two block parameter values. The block parameters inherit different data types from the block input signals (single or int8). To use myGainParam in these different data type contexts, you explicitly specify the data type of the parameter object by setting the DataType property to int8.

**Match Parameter Object Data Type with Signal Data Type**

Optionally, use a Simulink.NumericType or Simulink.AliasType object to set the parameter object data type and one of the signal data types. This technique eliminates unnecessary typecasts and shifts in the generated code due to a mismatch between the parameter object data type and the signal data type.

At the command prompt, create a Simulink.NumericType object to represent the data type int8.

```matlab
sharedType_int8 = fixdt('int8');
```
In the Model Data Editor, on the **Imports/Outports** tab, set the data type of the In2 Inport block to `sharedType_int8`.

On the **Parameters** tab, update the block diagram. The data table now contains a row that represents the parameter object, `myGainParam`.

Use the **Data Type** column to set the data type of the parameter object to `sharedType_int8`.

Alternatively, to configure the block and the object, use these commands at the command prompt:

```matlab
myGainParam.DataType = 'sharedType_int8';
set_param('ex_paramdt_contexts/In2','OutDataTypeStr','sharedType_int8')
```

The parameter object and the signal use the data type `int8`. To change this data type, adjust the properties of the data type object `sharedType_int8`.

### Generate and Inspect Code

Generate code from the model.

```bash
rtwbuild('ex_paramdt_contexts')
```

The generated file `ex_paramdt_contexts.c` defines the global variable `myGainParam` by using the data type `int8_T`, which corresponds to the data type `int8` in Simulink.

```c
file = fullfile('ex_paramdt_contexts_grt_rtw','ex_paramdt_contexts.c');
rtwdemodbtype(file,'/* Exported block parameters */','int8_T myGainParam = 3;',1,1)
```

```c
/* Exported block parameters */
int8_T myGainParam = 3; /* Variable: myGainParam */
```

The generated code algorithm in the model **step function** uses `myGainParam` to calculate the outputs of the two Gain blocks. In the case of the Gain block whose input signal uses the data type `single`, the code algorithm casts `myGainParam` to the data type `real32_T`, which corresponds to the data type `single` in Simulink.

```c
rtwdemodbtype(file,'/* Model step function */','...'
 /* Model initialize function */',1,0)
```
void ex_paramdt_contexts_step(void)
{
    ex_paramdt_contexts_Y.Out1 = (real32_T)myGainParam * ex_paramdt_contexts_U.In1;
    ex_paramdt_contexts_Y.Out2 = (int8_T)(myGainParam * ex_paramdt_contexts_U.In2);
}

See Also

Related Examples

- “Parameter Data Types in the Generated Code” on page 15-157
- “Generate Efficient Code by Specifying Data Types for Block Parameters” on page 15-163
- “Create Tunable Calibration Parameter in the Generated Code” on page 15-122
Organize Data into Structures in Generated Code

In C code, you use structures (struct) to store data in contiguous locations in memory. You can organize data, such as signals and states, by using meaningful names. Each structure acts as a namespace, so you can reuse a name to designate multiple data items. Like arrays, with structures, you can write code that efficiently transfers and operates on large amounts of data by using pointers.

By default, the code generator aggregates data into standard structures (see “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50). To control the characteristics of these structures or to override this default behavior by creating different structures, use the information in the table.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Technique</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control the characteristics of the standard data structures. For example, specify the names of the structure types, structure variables, and field names.</td>
<td>With Embedded Coder, see “Control Characteristics of Data Structures (Embedded Coder)” (Embedded Coder).</td>
</tr>
<tr>
<td>Control the placement of the structures in memory, for example, by inserting pragmas or other code decorations.</td>
<td>With Embedded Coder, see “Control Data and Function Placement in Memory by Inserting Pragmas” (Embedded Coder).</td>
</tr>
<tr>
<td>Goal</td>
<td>Technique</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
</tr>
<tr>
<td>Aggregate data into structures whose names and other basic characteristics you can control. As you add blocks and signals to the model, the resulting new data appears in these structures by default.</td>
<td>With Embedded Coder, apply a structured custom storage class to a category of data by using the Code Mapping Editor.</td>
</tr>
<tr>
<td>• When you generate nonreentrant, single-instance code by setting the model configuration parameter <strong>Code interface packaging</strong> to <strong>Nonreusable function</strong>, create flat, global structure variables by applying the built-in storage class <strong>Struct</strong>. Alternatively, use example storage classes created by Quick Start tool, <strong>ParamStruct</strong> and <strong>SignalStruct</strong>, or create and apply your own structured custom storage class.</td>
<td></td>
</tr>
<tr>
<td>• When you generate multi-instance (reentrant) code from a model or a component, for example by setting <strong>Code interface packaging</strong> to a value other than <strong>Nonreusable function</strong>, in the Code Mapping Editor, you cannot use the built-in storage class <strong>Struct</strong> or any structured storage class that you create in a package. Instead, create your own structured custom storage class by using an Embedded Coder Dictionary. If you use the Embedded Coder Quick Start tool to prepare the model for code generation (see “Generate Code by Using the Quick Start Tool” (Embedded Coder)), you can use example storage classes <strong>ParamStruct</strong> and <strong>SignalStruct</strong>.</td>
<td></td>
</tr>
<tr>
<td>• You cannot use this technique to aggregate global data stores or global parameters (which include parameter objects that you store in the base...</td>
<td></td>
</tr>
<tr>
<td><strong>Goal</strong></td>
<td><strong>Technique</strong></td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Improve readability of the generated code by organizing individual data items into a custom structure whose characteristics you can finely control. | Create a `Simulink.Bus` object that represents the structure type that you want. Use the bus object to set the data types of nonvirtual bus signals and parameter structures in your model.  
• For an example that shows how to organize parameter data, see “Structures of Parameters” on page 15-185.  
• For an example that shows how to organize signal data, see “Structures of Signals” on page 15-188.  
To create an array of structures, see “Arrays of Structures” on page 15-195. |
<p>| workspace or a data dictionary). For these kinds of data, use other techniques to create structures. | For more information about the Code Mapping Editor, see “Configure Default C Code Generation for Categories of Model Data and Functions” (Embedded Coder). To create your own storage class, see “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture” (Embedded Coder). |</p>
<table>
<thead>
<tr>
<th><strong>Goal</strong></th>
<th><strong>Technique</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Exchange structured data between generated code and your external code, for example, when the external code already defines a custom structure type and a corresponding global variable.</td>
<td>Create a <code>Simulink.Bus</code> object that represents the structure type that you want. If your external code already defines the type, use the <code>Simulink.importExternalCTypes</code> function to generate the bus object. Use the bus object to set the data types of nonvirtual bus signals and parameter structures in your model. For an example, see “Exchange Structured and Enumerated Data Between Generated and External Code” (Embedded Coder).</td>
</tr>
<tr>
<td>Goal</td>
<td>Technique</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Reduce the number of arguments (formal parameters) for generated functions. | • To reduce the number of arguments for the entry-point functions of the model from which you generate code, such as `model_step`, see “Reduce Number of Arguments by Using Structures” on page 15-47.  
• To reduce the number of arguments for the entry-point functions of a referenced model, in the referenced model:  
  • Configure root-level Inport and Outport blocks to appear in the code as structure fields. Replace multiple such blocks with a single block that you configure as a nonvirtual bus signal. With this technique, you have the greatest control over the structure characteristics. As you add blocks to the model, you must manually modify the bus definitions. See “Nonvirtual Buses and Parameter Structures” on page 15-184.  
  • Organize model arguments into a custom structure (see “Specify Instance-Specific Parameter Values for Reusable Referenced Model” on page 15-143).  
• To reduce the number of arguments for the entry-point functions of a masked, reentrant subsystem, aggregate mask parameters into a custom structure. |
| Organize lookup table data into a structure.                         | Use `Simulink.LookupTable` and `Simulink.Breakpoint` objects. See `Simulink.LookupTable`.                                                  |
Goal

Generate bit fields.

Technique

See “Bitfields” (Embedded Coder) and “Optimize Generated Code By Packing Boolean Data Into Bitfields” (Embedded Coder).

### Techniques to Create Structures

To create structures in the generated code, you can use any of these techniques:

- Apply a structured storage class to categories of data by using the Code Mapping Editor. As you add blocks and signals to a model, new data elements acquire this storage class by default.
- Apply a structured storage class, such as the built-in custom storage class `Struct`, directly to individual data items by using the Model Data Editor.
- Create custom nonvirtual buses and parameter structures.

To decide which techniques to use, use the information in the table.

<table>
<thead>
<tr>
<th>Capability</th>
<th>Default Application of Structured Storage Class</th>
<th>Direct Application of Structured Storage Class</th>
<th>Nonvirtual Buses and Parameter Structures</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate new data items into a structure by default</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Prevent elimination of the target data by optimizations (specify that the data appear in the generated code)</td>
<td>No</td>
<td>Yes</td>
<td>Only if you directly apply a storage class such as ExportedGlobal to the bus or structure</td>
</tr>
<tr>
<td>Aggregate data into a structure without changing the appearance of the block diagram</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Capability</td>
<td>Default Application of Structured Storage Class</td>
<td>Direct Application of Structured Storage Class</td>
<td>Nonvirtual Buses and Parameter Structures</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------</td>
<td>------------------------------------------------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Place signal, state, and parameter data in the same structure</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Include state data in a structure</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Organize structures into nested structures</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Organize structures into an array of structures</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Control name of structure type</td>
<td>Yes</td>
<td>Yes, but the type name derives from the variable name, which you specify</td>
<td>Yes</td>
</tr>
<tr>
<td>Create a structure to reduce the number of arguments in a generated function</td>
<td>Yes, but you must create your own storage class by using an Embedded Coder Dictionary</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Requires Embedded Coder</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Default Application of Structured Storage Class**

You can apply a default storage class to a category of model data. As you add blocks and signals to the model, the associated data acquire the default storage class that you specify. To aggregate new data into structures by default, you can apply structured storage classes. You must use example storage classes `ParamStruct` and `SignalStruct` created by the Quick Start tool or create your own storage class by using an Embedded Coder Dictionary.

You cannot use default application to aggregate global data stores or global parameters (parameter objects that you store in the base workspace or a data dictionary).
To apply default storage classes, use the Code Mapping Editor. In a model window, select
**Code > C/C++ Code > Configure Model in Code Perspective.** Then, under **Code Mappings > Data Defaults**, apply storage classes by using the **Storage Class** column.

For more information about the Code Mapping Editor, see “Configure Default C Code Generation for Categories of Model Data and Functions” (Embedded Coder). To create your own storage class by using an Embedded Coder Dictionary, see “Create Code Definitions for Use as Default Code Generation Settings” (Embedded Coder).

**Direct Application of Structured Storage Class**

You can apply a structured storage class to individual data items. The direct application prevents code generation optimizations, such as **Default parameter behavior** and **Signal storage reuse**, from eliminating each data item from the generated code. The direct application also overrides the default storage classes that you specify with **Code Mappings > Data Defaults**.

To directly apply a storage class, use the Model Data Editor (**View > Model Data Editor**). Set **Change view** to Code and apply the storage class by using the **Storage Class** column.

For an example that shows how to use **Struct**, see “Organize Parameter Data into a Structure by Using the Struct Custom Storage Class” (Embedded Coder). For more information about applying storage classes, see “Apply Custom Storage Classes to Individual Signal, State, and Parameter Data Elements” (Embedded Coder).

**Nonvirtual Buses and Parameter Structures**

- To create a nonvirtual bus signal, use a Bus Creator block to organize multiple signal lines into a single bus, or configure an Inport block or Outport block as a nonvirtual bus. You must create a **Simulink.Bus** object that represents the structure type. For an example, see “Structures of Signals” on page 15-188. For general information about nonvirtual buses, see “Getting Started with Buses” (Simulink).
- To create a parameter structure, use MATLAB commands or the Variable Editor to organize the values of multiple block parameters into a MATLAB structure. Optionally, create a **Simulink.Bus** object so that you can control the name of the structure type and other characteristics such as the data type and dimensions of each field. For an example, see “Structures of Parameters” on page 15-185. For general information about parameter structures, see “Organize Related Block Parameter Definitions in Structures” (Simulink).
**Structures of Parameters**

Create a structure in the generated code. The structure stores parameter data.

**C Construct**

```c
typedef struct {
    double G1;
    double G2;
} myStructType;

myStructType myStruct = {
    2.0,
    -2.0
} ;
```

**Procedure**

Open the example model `rtwdemo_paraminline`.

`rtwdemo_paraminline`
Select **View > Model Data Editor**.

In the Model Data Editor, select the **Parameters** tab.

In the model, click the Gain block labeled G1.

In the Model Data Editor, use the **Value** column to set the value of the **Gain** parameter to `myStruct.G1`.

Use the Model Data Editor to set the value of the **Gain** parameter in the G2 block to `myStruct.G2`.

Next to `myStruct.G2`, click the action button (with three vertical dots) and select **Create**.

In the Create New Data dialog box, set **Value** to `Simulink.Parameter(struct)` and click **Create**. A `Simulink.Parameter` object named `myStruct` appears in the base workspace.

In the Simulink.Parameter property dialog box, next to the **Value** property, click the action button and select **Open Variable Editor**.

In the Variable Editor, right-click the white space under the **Field** column and select **New**. Name the new structure field G1. Use the **Value** column to set the value of the field to 2.

Use the Variable Editor to add a field G2 whose value is -2 and then close the Variable Editor.

In the Simulink.Parameter property dialog box, set **Storage class** to ExportedGlobal. With this setting, the structure `myStruct` appears in the generated code as a global variable.

Alternatively, use these commands to configure the blocks and create `myStruct`.

```plaintext
rtwdemo_paraminline
set_param('rtwdemo_paraminline/G1','Gain','myStruct.G1')
set_param('rtwdemo_paraminline/G2','Gain','myStruct.G2')
myStruct.G1 = 2;
myStruct.G2 = -2;
myStruct = Simulink.Parameter(myStruct);
myStruct.CoderInfo.StorageClass = 'ExportedGlobal';
```
Results

Generate code from the model.

```matlab
rtwbuild('rtwdemo_paraminline')
```

### Starting build procedure for model: rtwdemo_paraminline
### Successful completion of build procedure for model: rtwdemo_paraminline

The generated header file `rtwdemo_paraminline_types.h` defines a structure type with a random name.

```matlab
file = fullfile('rtwdemo_paraminline_grt_rtw',...
    'rtwdemo_paraminline_types.h');
rtwdemodbtype(file,'typedef struct {','} struct_6h72eH5WFuEiyQr5YrdGuB;',...
    1,1)

typedef struct {
    real_T G1;
    real_T G2;
} struct_6h72eH5WFuEiyQr5YrdGuB;
```

The source file `rtwdemo_paraminline.c` defines and initializes the structure variable `myStruct`.

```matlab
file = fullfile('rtwdemo_paraminline_grt_rtw','rtwdemo_paraminline.c');
rtwdemodbtype(file,'struct_6h72eH5WFuEiyQr5YrdGuB myStruct',...
    '/* Variable: myStruct',1,1)

struct_6h72eH5WFuEiyQr5YrdGuB myStruct = {
    2.0,
    -2.0
} ;                                   /* Variable: myStruct
```

Specify Name of Structure Type

Optionally, specify a name to use for the structure type definition (struct).

At the command prompt, use the function `Simulink.Bus.createObject` to create a `Simulink.Bus` object that represents the structure type.

```matlab
Simulink.Bus.createObject(myStruct.Value);
```
The default name of the object is `slBus1`. Change the name by copying the object into a new MATLAB variable.

```matlab
myStructType = copy(slBus1);
```

In the Model Data Editor, click the **Show/refresh additional information** button.

In the data table, find the row that corresponds to `myStruct`. Use the **Data Type** column to set the data type of `myStruct` to **Bus: myStructType**.

Alternatively, at the command prompt, use this command to set the data type of `myStruct`.

```matlab
myStruct.DataType = 'Bus: myStructType';
```

Generate code from the model.

```matlab
rtwbuild('rtwdemo_paraminline')
```

### Starting build procedure for model: rtwdemo_paraminline
### Successful completion of build procedure for model: rtwdemo_paraminline

The code generates the definition of the structure type `myStructType` and uses this type to define the global variable `myStruct`.

```c
rtwdemodbtype(file,'myStructType myStruct = {','/* Variable: myStruct',... 1,1)

myStructType myStruct = {
  2.0,
  -2.0
} ;                                     /* Variable: myStruct
```

**Structures of Signals**

This example shows how to create a structure of signal data in the generated code.

**C Construct**

```c
typedef struct {
    double signal1;
    double signal2;
    double signal3;
} my_signals_type;
```
Procedure

To represent a structure type in a model, create a Simulink.Bus object. Use the object as the data type of bus signals in your model.

Create the `ex_signal_struct` model with Gain blocks, a Bus Creator block, and a Unit Delay block. The Gain and Unit Delay blocks make the structure more identifiable in the generated code.

To configure the Bus Creator block to accept three inputs, in the block dialog box, set **Number of inputs** to 3.

In the model, select **Edit > Bus Editor**.

Use the Bus Editor to create a Simulink.Bus object named `my_signals_type` that contains three signal elements: `signal1`, `signal2`, and `signal3`. To create bus objects with the Bus Editor, see “Create Bus Objects with the Bus Editor” (Simulink).

This bus object represents the structure type that you want the generated code to use.
In the Bus Creator block dialog box, set **Output data type** to **Bus: my_signals_type**.

Select **Output as nonvirtual bus**. Click **OK**. A nonvirtual bus appears in the generated code as a structure.

In the model, select **View > Model Data Editor**.

In the Model Data Editor, on the **Signals** tab, from the **Change view** drop-down list, select **Code**.

In the model, click the output signal of the Bus Creator block.

In the Model Data Editor, for the output of the Bus Creator block, set **Name** to **sig_struct_var**.

Set **Storage Class** to **ExportedGlobal**. With this setting, the output of the Bus Creator block appears in the generated code as a separate global structure variable named **sig_struct_var**.

Generate code from the model.

**Results**

The generated header file **ex_signal_struct_types.h** defines the structure type **my_signals_type**.

```c
typedef struct {
    real_T signal1;
    real_T signal2;
    real_T signal3;
} my_signals_type;
```

The source file **ex_signal_struct.c** allocates memory for the global variable **sig_struct_var**, which represents the output of the Bus Creator block.

```c
/* Exported block signals */
my_signals_type sig_struct_var;        /* '<Root>/Bus Creator' */
```
In the same file, in the model `step` function, the algorithm accesses `sig_struct_var` and the fields of `sig_struct_var`.

**Nested Structures of Signals**

You can create nested structures of signal data in the generated code.

**C Construct**

```c
typedef struct {
    double signal1;
    double signal2;
    double signal3;
} B_struct_type;

typedef struct {
    double signal1;
    double signal2;
} C_struct_type;

typedef struct {
    B_struct_type subStruct_B;
    C_struct_type subStruct_C;
} A_struct_type;
```

**Procedure**

To represent a structure type in a model, create a `Simulink.Bus` object. Use the object as the data type of bus signals in your model.

To nest a structure inside another structure, use a bus object as the data type of a signal element in another bus object.

Create the `ex_signal_nested_struct` model with Gain blocks, Bus Creator blocks, and a Unit Delay block. The Gain and Unit Delay blocks make the structure more identifiable in the generated code.
To configure a Bus Creator block to accept three inputs, in the block dialog box, set **Number of inputs** to 3.

In the model, select **Edit > Bus Editor**.

Use the Bus Editor to create a `Simulink.Bus` object named `A_struct_type` that contains two signal elements: `subStruct_B` and `subStruct_C`. To create bus objects with the Bus Editor, see “Create Bus Objects with the Bus Editor” (Simulink). This bus object represents the top-level structure type that you want the generated code to use.

For the `subStruct_B` element, set **DataType** to `Bus: B_struct_type`. Use a similar type name for `subStruct_C`. 
Each signal element in A_struct_type uses another bus object as a data type. Now, these elements represent substructures.

Use the Bus Editor to create the Simulink.Bus objects B_struct_type (with three signal elements) and C_struct_type (with two signal elements).

In the dialog box of the Bus Creator block that collects the three Gain signals, set Output data type to Bus: B_struct_type. Click Apply.

Select Output as nonvirtual bus and click OK.

In the dialog box of the other subordinate Bus Creator block, set Output data type to Bus: C_struct_type and select Output as nonvirtual bus. Click OK.

In the last Bus Creator block dialog box, set Output data type to Bus: A_struct_type and select Output as nonvirtual bus. Click OK.

In the model, select View > Model Data Editor.

In the Model Data Editor, on the Signals tab, from the Change view drop-down list, select Code.
In the model, click the output signal of the **A_struct_type** Bus Creator block, which feeds the Unit Delay block.

In the Model Data Editor, for the output of the Bus Creator block, set **Name** to **sig_struct_var**.

Set **Storage Class** to **ExportedGlobal**. With this setting, the output of the Bus Creator block appears in the generated code as a separate global structure variable named **sig_struct_var**.

Generate code from the model.

**Results**

The generated header file `ex_signal_nested_struct_types.h` defines the structure types. Each structure type corresponds to a **Simulink.Bus** object.

```c
typedef struct {
    real_T signal1;
    real_T signal2;
    real_T signal3;
} B_struct_type;

typedef struct {
    real_T signal1;
    real_T signal2;
} C_struct_type;

typedef struct {
    B_struct_type subStruct_B;
    C_struct_type subStruct_C;
} A_struct_type;
```

The generated source file `ex_signal_nested_struct.c` allocates memory for the global structure variable **sig_struct_var**. By default, the name of the **A_struct_type** Bus Creator block is **Bus Creator2**.

```c
/* Exported block signals */
A_struct_type sig_struct_var;          /* '<Root>/Bus Creator2' */
```
In the same file, in the model `step` function, the algorithm accesses `sig_struct_var` and the fields of `sig_struct_var`.

**Combine Techniques to Work Around Limitations**

To work around some of the limitations of each technique, you can combine structured custom storage classes with nonvirtual buses and parameter structures. For example, you can:

- Include a structure of signal data and a structure of parameter data in the same parent structure.
- Nest structures while aggregating new data by default.

In the generated code, a flat parent structure, which corresponds to the structured custom storage class, contains substructures, which correspond to each bus and parameter structure. Choose one of these combined techniques:

- Apply the structured custom storage class directly to each bus and parameter structure. For example, set the storage class of two nonvirtual bus signals to `Struct`. Each bus appears in the generated code as a field (substructure) of a single structure.
- Leave the storage class of each bus and parameter structure at the default setting, `Auto`, or at `Model default`, which prevents code generation optimizations from eliminating the bus or parameter structure. Then, configure default storage classes such that signal data and parameter data use the structured custom storage class by default.

**Arrays of Structures**

You can further package multiple consistent bus signals or parameter structures into an array. The array of buses or parameter structures appears in the generated code as an array of structures. To create arrays of buses, see “Combine Buses into an Array of Buses” (Simulink). To create arrays of parameter structures, see “Group Multiple Parameter Structures into an Array” (Simulink).

**Structure Padding**

By default, the code generator does not explicitly add padding fields to structure types. Structure types can appear in the generated code through, for example, the standard data
structures (see “Standard Data Structures in the Generated Code” on page 15-26), Simulink.Bus objects, and parameter structures that you use in a model.

However, when you use a code replacement library with Embedded Coder, you can specify data alignment (including structure padding) as part of the replacement library. For more information, see “Provide Data Alignment Specifications for Compilers” (Embedded Coder).

**Limitations**

- With built-in Simulink Coder and Embedded Coder features, you cannot generate or use a custom structure that contains a field whose value is a pointer. You can do so manually by creating an advanced custom storage class and writing accompanying TLC code (see “Finely Control Data Representation by Writing TLC Code for a Custom Storage Class” (Embedded Coder)).

- You cannot use the built-in storage class Struct, or any structured storage class that you create with the Custom Storage Class Designer (you set the storage class property **Type** to FlatStructure), to set data defaults in the Code Mapping Editor.

**See Also**
Simulink.Bus

**Related Examples**

- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
- “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on page 26-102
- “Environment for Configuring Model Data and Functions for Code Generation” (Embedded Coder)
- “Control Data and Function Placement in Memory by Inserting Pragmas” (Embedded Coder)
- “Composite Signal Techniques” (Simulink)
Switch Between Sets of Parameter Values During Simulation and Code Execution

To store multiple independent sets of values for the same block parameters, you can use an array of structures. To switch between the parameter sets, create a variable that acts as an index into the array, and change the value of the variable. You can change the value of the variable during simulation and, if the variable is tunable, during execution of the generated code.

Explore Example Model

Open the example model.

```
open_system('sldemo_fuelsys_dd_controller')
```

This model represents the fueling system of a gasoline engine. The output of the model is the rate of fuel flow to the engine.

Navigate to the `switchable_compensation` nested subsystem.

```
open_system(["sldemo_fuelsys_dd_controller/fuel_calc/",...
            'switchable_compensation'])
```
This subsystem corrects and filters noise out of the fuel rate signal. The subsystem uses different filter coefficients based on the fueling mode, which the control logic changes based on sensor failures in the engine. For example, the control algorithm activates the low_mode subsystem during normal operation. It activates the rich_mode subsystem in response to sensor failure.

Open the low_mode subsystem.

```
open_system(['sldemo_fuelsys_dd_controller/fuel_calc/','...
    'switchable_compensation/low_mode'])
```
The Discrete Filter block filters the fuel rate signal. In the block dialog box, the **Numerator** parameter sets the numerator coefficients of the filter.

The sibling subsystem `rich_mode` also contains a Discrete Filter block, which uses different coefficients.

Update the model diagram to display the signal data types. The input and output signals of the block use the single-precision, floating-point data type `single`.

In the lower-left corner of the model, click the data dictionary badge. The data dictionary for this model, `sldemo_fuelsys_dd_controller.sldd`, opens in the Model Explorer.

In the Model Explorer **Model Hierarchy** pane, select the **Design Data** node.

In the **Contents** pane, view the properties of the `Simulink.NumericType` objects, such as `s16En15`. All of these objects currently represent the single-precision, floating-point data type `single`. The model uses these objects to set signal data types, including the input and output signals of the Discrete Filter blocks.

Suppose that during simulation and execution of the generated code, you want each of these subsystems to switch between different numerator coefficients based on a variable whose value you control.

**Store Parameter Values in Array of Structures**

Store the existing set of numerator coefficients in a `Simulink.Parameter` object whose value is a structure. Each field of the structure stores the coefficients for one of the Discrete Filter blocks.
lowBlock = ['sldemo_fuelsys_dd_controller/fuel_calc/... 
  'switchable_compensation/low_mode/Discrete Filter'];
richBlock = ['sldemo_fuelsys_dd_controller/fuel_calc/... 
  'switchable_compensation/rich_mode/Discrete Filter'];
params.lowNumerator = eval(get_param(lowBlock,'Numerator'));
params.richNumerator = eval(get_param(richBlock,'Numerator'));
params = Simulink.Parameter(params);

Copy the value of params into a temporary variable. Modify the field values in this 
temporary structure, and assign the modified structure as the second element of params.

temp = params.Value;
temp.lowNumerator = params.Value.lowNumerator * 2;
temp.richNumerator = params.Value.richNumerator * 2;
params.Value(2) = temp;
clear temp

The value of params is an array of two structures. Each structure stores one set of filter 
coefficients.

**Create Variable to Switch Between Parameter Sets**

Create a Simulink.Parameter object named Ctrl.

Ctrl = Simulink.Parameter(2);
Ctrl.DataType = 'uint8';

In the low_mode subsystem, in the Discrete Filter block dialog box, set the Numerator 
parameter to the expression params(Ctrl).lowNumerator.

set_param(lowBlock,'Numerator','params(Ctrl).lowNumerator');

In the Discrete Filter block in the rich_mode subsystem, set the value of the Numerator 
parameter to params(Ctrl).richNumerator.

set_param(richBlock,'Numerator','params(Ctrl).richNumerator');

The expressions select one of the structures in params by using the variable Ctrl. The expressions then dereference one of the fields in the structure. The field value sets the 
values of the numerator coefficients.

To switch between the sets of coefficients, you change the value of Ctrl to the 
corresponding index in the array of structures.
Use Bus Object as Data Type of Array of Structures

Optionally, create a Simulink.Bus object to use as the data type of the array of structures. You can:

- Control the shape of the structures.
- For each field, control characteristics such as data type and physical units.
- Control the name of the struct type in the generated code.

Use the function Simulink.Bus.createObject to create the object and rename the object as paramsType.

```
Simulink.Bus.createObject(params.Value)
paramsType = slBus1;
clear slBus1
```

You can use the Simulink.NumericType objects from the data dictionary to control the data types of the structure fields. In the bus object, use the name of a data type object to set the DataType property of each element.

```
paramsType.Elements(1).DataType = 's16En15';
paramsType.Elements(2).DataType = 's16En7';
```

Use the bus object as the data type of the array of structures.

```
params.DataType = 'Bus: paramsType';
```

Use Enumerated Type for Switching Variable

Optionally, use an enumerated type as the data type of the switching variable. You can associate each of the parameter sets with a meaningful name and restrict the allowed values of the switching variable.

Create an enumerated type named FilterCoeffs. Create an enumeration member for each of the structures in params. Set the underlying integer value of each enumeration member to the corresponding index in params.

```
Simulink.defineIntEnumType('FilterCoeffs',{'Weak','Aggressive'},[1 2])
```

Use the enumerated type as the data type of the switching variable. Set the value of the variable to Aggressive, which corresponds to the index 2.

```
Ctrl.Value = FilterCoeffs.Aggressive;
```
Add New Objects to Data Dictionary

Add the objects that you created to the data dictionary sldemo_fuelsys_dd_controller.sldd.

dictObj = Simulink.data.dictionary.open('sldemo_fuelsys_dd_controller.sldd');
sectObj = getSection(dictObj,'Design Data');
addEntry(sectObj,'Ctrl',Ctrl)
addEntry(sectObj,'params',params)
addEntry(sectObj,'paramsType',paramsType)

You can also store enumerated types in data dictionaries. However, you cannot import the enumerated type in this case because you cannot save changes to sldemo_fuelsys_dd_controller.sldd. For more information about storing enumerated types in data dictionaries, see “Enumerations in Data Dictionary” (Simulink).

Switch Between Parameter Sets During Simulation

Open the example model sldemo_fuelsys_dd, which references the controller model sldemo_fuelsys_dd_controller.

open_system('sldemo_fuelsys_dd')

Fault-Tolerant Fuel Control System

The sensor switches simulate any combination of sensor failures. The Engine Speed Selector switch simulates different engine speeds (rad/s).
Set the simulation stop time to `Inf` so that you can interact with the model during simulation.

Begin a simulation run and open the Scope block dialog box. The scope shows that the fuel flow rate (the fuel signal) oscillates with significant amplitude during normal operation of the engine.

In the Model Explorer, view the contents of the data dictionary `sldemo_fuelsys_dd_controller.sldd`. Set the value of `Ctrl` to `FilterCoeffs.Weak`.

Update the `sldemo_fuelsys_dd` model diagram. The scope shows that the amplitude of the fuel rate oscillations decreases due to the less aggressive filter coefficients.

Stop the simulation.

**Generate and Inspect Code**

If you have Simulink Coder software, you can generate code that enables you to switch between the parameter sets during code execution.

In the Model Explorer, view the contents of the data dictionary `sldemo_fuelsys_dd_controller.sldd`. In the **Contents** pane, set **Column View** to **Storage Class**.

Use the **StorageClass** column to apply the storage class `ExportedGlobal` to `params` so that the array of structures appears as a tunable global variable in the generated code. Apply the same storage class to `Ctrl` so that you can change the value of the switching variable during code execution.

Alternatively, to configure the objects, use these commands:

```matlab
tempEntryObj = getEntry(sectObj,'params');
params = getValue(tempEntryObj);
params.StorageClass = 'ExportedGlobal';
setValue(tempEntryObj,params);

tempEntryObj = getEntry(sectObj,'Ctrl');
Ctrl = getValue(tempEntryObj);
Ctrl.StorageClass = 'ExportedGlobal';
setValue(tempEntryObj, Ctrl);
```

Generate code from the controller model.
rtwbuild('sldemo_fuelsys_dd_controller')
### Starting build procedure for model: sldemo_fuelsys_dd_controller
### Successful completion of code generation for model: sldemo_fuelsys_dd_controller

In the code generation report, view the header file sldemo_fuelsys_dd_controller_types.h. The code defines the enumerated data type FilterCoeffs.

```c
file = fullfile('sldemo_fuelsys_dd_controller_ert_rtw', ...
    'sldemo_fuelsys_dd_controller_types.h');
rtwdemodbtype(file,'#ifndef DEFINED_TYPEDEF_FOR_FilterCoeffs_', ...
    '/* Forward declaration for rtModel */',1,0)

#ifndef DEFINED_TYPEDEF_FOR_FilterCoeffs_
#define DEFINED_TYPEDEF_FOR_FilterCoeffs_

typedef enum {
    Weak = 1,                  /* Default value */
    Aggressive
} FilterCoeffs;
#endif
```

The code also defines the structure type paramsType, which corresponds to the Simulink.Bus object. The fields use the single-precision, floating-point data type from the model.

```c
rtwdemodbtype(file,'#ifndef DEFINED_TYPEDEF_FOR_paramsType_', ...
    '#ifdef DEFINED_TYPEDEF_FOR_FilterCoeffs_',1,0)

#ifndef DEFINED_TYPEDEF_FOR_paramsType_
#define DEFINED_TYPEDEF_FOR_paramsType_

typedef struct {
    real32_T lowNumerator[2];
    real32_T richNumerator[2];
} paramsType;
#endif
```

View the source file sldemo_fuelsys_dd_controller.c. The code uses the enumerated type to define the switching variable Ctrl.
file = fullfile('sldemo_fuelsys_dd_controller_ert_rtw', ...
'sldemo_fuelsys_dd_controller.c');
rtwdemodbtype(file,'FilterCoeffs Ctrl = Aggressive;',...
'/* Block signals (default storage) */',1,0)

FilterCoeffs Ctrl = Aggressive;        /* Variable: Ctrl
 * Referenced by:
 *   '<S12>/Discrete Filter'
 *   '<S13>/Discrete Filter'
 */

The code also defines the array of structures params.

rtwdemodbtype(file,'/* Exported block parameters */',...
'/* Variable: params',1,1)

/* Exported block parameters */
paramsType params[2] = { {
  { 8.7696F, -8.5104F },
  { 0.0F, 0.2592F } },
  { 17.5392F, -17.0208F },
  { 0.0F, 0.5184F } }
} ;                                /* Variable: params

The code algorithm in the model step function uses the switching variable to index into
the array of structures.

To switch between the parameter sets stored in the array of structures, change the value
of Ctrl during code execution.

Close the connections to the data dictionary. This example discards unsaved changes. To
save the changes, use the ' -save' option.
Simulink.data.dictionary.closeAll('sldemo_fuelsys_dd_controller.sldd','-discard')

See Also

Related Examples

- “Tune and Experiment with Block Parameter Values” (Simulink)
- “Create Tunable Calibration Parameter in the Generated Code” on page 15-122
- “Organize Related Block Parameter Definitions in Structures” (Simulink)
- “Access Structured Data Through a Pointer That External Code Defines” (Embedded Coder)
Design Data Interface by Configuring Inport and Outport Blocks

The data interface of a model is the means by which the model exchanges data (for example, signal values) with other, external models or systems. Customize the data interface of a model to:

- Enable integration of the generated code with your own code.
- Improve traceability and readability of the code.

At the top level of a model, Inport and Outport blocks represent the input and output signals of the model. To customize the data interface in the generated code, configure these blocks. Early in the design process, when a model can contain unconnected Inport and Outport blocks, use this technique to specify the interface before developing the internal algorithm.

When you apply storage classes to Inport and Outport blocks, each block appears in the generated code as a field of a global structure or as a separate global variable that the generated algorithm references directly. If you have Embedded Coder, you can use function prototype control instead of storage classes to pass data into and out of the model step function as formal parameters. See “Customize Generated C Function Interfaces” (Embedded Coder).

**Design Data Interface**

Open the example model `rtwdemo_basicsc`.

```matlab
open_system('rtwdemo_basicsc')
```
Configure the model to show the generated names of blocks.

```matlab
set_param('rtwdemo_basicsc','HideAutomaticNames','off')
```

In the model, select **View > Model Data Editor**.

In the Model Data Editor, select the **Inports/Outports** tab. Each row in the table represents an Outport block or a signal that exits an Inport block.

Name the signal data that the Outport block `Out1` represents. Set **Signal Name** to `output_sig`.

For each of the signals that exit the Inport blocks, set **Data Type** to `single` or to a different data type. Due to the data type inheritance settings that the other blocks in the model use by default, downstream signals in the rest of the model use the same or a similar data type.

Optionally, configure other design attributes such as **Min** and **Max** (minimum and maximum values).
Set the **Change View** drop-down list to **Code**.

For the Outport block and all of the Inport blocks, set **Storage Class** to **ExportedGlobal**. To configure all of the blocks at once, select all of the rows in the table.

To configure the blocks and signals, you can use these commands at the command prompt.

```matlab
portHandles = get_param('rtwdemo_basicsc/In1','portHandles');
outPortHandle = portHandles.Outport;
set_param(outPortHandle,'StorageClass','ExportedGlobal');

portHandles = get_param('rtwdemo_basicsc/In2','portHandles');
outPortHandle = portHandles.Outport;
set_param(outPortHandle,'StorageClass','ExportedGlobal');

portHandles = get_param('rtwdemo_basicsc/In3','portHandles');
outPortHandle = portHandles.Outport;
set_param(outPortHandle,'StorageClass','ExportedGlobal');

portHandles = get_param('rtwdemo_basicsc/In4','portHandles');
outPortHandle = portHandles.Outport;
set_param(outPortHandle,'StorageClass','ExportedGlobal');

set_param('rtwdemo_basicsc/Out1','SignalName','output_sig',...  
'StorageClass','ExportedGlobal')
```

Generate code from the model.

```matlab
rtwbuild('rtwdemo_basicsc');
```

### Starting build procedure for model: rtwdemo_basicsc
### Successful completion of build procedure for model: rtwdemo_basicsc

View the generated file `rtwdemo_basicsc.c`. Because you applied the storage class `ExportedGlobal` to the Inport and Outport blocks, the code creates separate global variables that represent the inputs and the output.

```matlab
file = fullfile('rtwdemo_basicsc_grt_rtw','rtwdemo_basicsc.c');
rtwdemodbtype(file,'/* Exported block signals */','real32_T output_sig;',1,1)

/* Exported block signals */
real32_T input1;       /* '<Root>/In1' */
The generated algorithm in the model step function directly references these global variables to calculate and store the output signal value, output_sig.

While you use the Model Data Editor to configure the interface of a system, consider using the interface display to view the system inputs and outputs (Inport and Outport blocks) at a high level. See “Configure Data Interface for Component” (Simulink).

**Reduce Manual Data Entry by Configuring Default Storage Class (Embedded Coder)**

If you have Embedded Coder, you can configure a default storage class for Inport blocks and Outport blocks. As you add such blocks to the model, they acquire the storage class that you specify.

In the model, set **Configuration Parameters > Code Generation > System target file** to ert.tlc.

In the model, select **Code > C/C++ Code > Configure Model in Code Perspective**.

Underneath the block diagram, under **Code Mappings > Data Defaults**, for the **Inports** and **Outports** rows, set **Storage Class** to ExportedGlobal.

Underneath the block diagram, open the Model Data Editor by clicking the **Model Data Editor** tab.

Use the Model Data Editor to set the storage class of the Inport and Outport blocks to **Auto**. With this setting, the blocks acquire the default storage classes that you specified in **Code Mappings > Data Defaults**.

With Auto, the global variables that correspond to the Inport and Outport blocks are subject to a naming rule that you specify in the model configuration parameters. By default, the naming rule adds the name of the model to the name of each variable. To remove the model name, change the value of **Configuration Parameters > Code Generation > Symbols > Global variables** from $R$N$M to $N$M. The token $R$ represents the model name.

Alternatively, to configure the data defaults and the configuration parameter, at the command prompt, use these commands:
set_param('rtwdemo_basicsc','SystemTargetFile','ert.tlc')

coder.mapping.create('rtwdemo_basicsc')
coder.mapping.defaults.set('rtwdemo_basicsc','Inports',...
  'StorageClass','ExportedGlobal')
coder.mapping.defaults.set('rtwdemo_basicsc','Outports',...
  'StorageClass','ExportedGlobal')

portHandles = get_param('rtwdemo_basicsc/In1','portHandles');
outPortHandle = portHandles.Outport;
set_param(outPortHandle,'StorageClass','Auto');

portHandles = get_param('rtwdemo_basicsc/In2','portHandles');
outPortHandle = portHandles.Outport;
set_param(outPortHandle,'StorageClass','Auto');

portHandles = get_param('rtwdemo_basicsc/In3','portHandles');
outPortHandle = portHandles.Outport;
set_param(outPortHandle,'StorageClass','Auto');

portHandles = get_param('rtwdemo_basicsc/In4','portHandles');
outPortHandle = portHandles.Outport;
set_param(outPortHandle,'StorageClass','Auto');

set_param('rtwdemo_basicsc/Out1','SignalName','output_sig',...
  'StorageClass','Auto')

set_param('rtwdemo_basicsc','CustomSymbolStrGlobalVar','$N$M')

**Route Signal Data to Multiple Outputs**

You can route a single signal to multiple Outport blocks and apply a different storage class to each Outport. For example, use this technique to send signal data to a custom function (such as a device driver) and to a global variable that your custom algorithmic code can use:

1. Branch the target signal line to each Outport block.
2. For more efficient code, set the storage class of the target signal line to Auto (the default). Optimizations can then eliminate the signal line from the generated code.
3. Use the Model Data Editor to apply the custom storage class GetSet to one Outport block and ExportToFile to the other Outport block. Apply a signal name to each block.
open_system('ex_route_sig')

Limitations

You cannot apply a storage class to an Outport block if the input to the block has a variable size. Instead, apply the storage class to the signal line.

See Also

Related Examples

- “Analyze the Generated Code Interface” (Embedded Coder)
- “Trace Connections Using Interface Display” (Simulink)
- “Interface Design” (Simulink)
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
- “Configure Generated Code According to Interface Control Document Interactively” (Embedded Coder)
- “Customize Generated C Function Interfaces” (Embedded Coder)
- “Configure Data Properties by Using the Model Data Editor” (Simulink)
- “Replace and Rename Data Types to Conform to Coding Standards” (Embedded Coder)
Generate Efficient Code for Bus Signals

In this section...

“Code Efficiency for Bus Signals” on page 15-213
“Set Bus Diagnostics” on page 15-214
“Optimize Virtual and Nonvirtual Buses” on page 15-214

In a model, you use bus signals to package multiple signals together into a single signal line. You can create virtual or nonvirtual bus signals. The representation in the generated code depends on:

• For a virtual bus, the generated code appears as if the bus did not exist.
• Generated code for a nonvirtual bus represents the bus data with a structure. When you want to trace the correspondence between the model and the code, the use of a structure in the generated code can be helpful. To generate structures using nonvirtual bus signals, see “Organize Data into Structures in Generated Code” on page 15-177.

For general information about buses, see and “Virtual and Nonvirtual Buses” (Simulink).

To generate efficient code from models that contain bus signals, eliminate unnecessary data copies by following best practices as you construct the model.

Code Efficiency for Bus Signals

When you use buses in a model for which you intend to generate code:

• Setting bus diagnostic configuration parameters can make model development easier.
• The bus implementation techniques, and the choice of a nonvirtual or virtual bus, can influence the speed, size, and clarity of the generated code.
• Some useful bus implementation techniques are not immediately obvious.

When you work with buses, these guidelines help you to improve the results. The guidelines describe techniques to:

• Simplify the layout of the model.
• Increase the efficiency of generated code.
Define data structures for function (subsystem) interfaces.
Define data structures that match existing data structures in external C code.

There are some trade-offs among speed, size, and clarity. For example, the code for nonvirtual buses is easier to read because the buses appear in the code as structures, but the code for virtual buses is faster because virtual buses do not require copying signal data. Apply some of the guidelines based on where you are in the application development process.

**Set Bus Diagnostics**

Simulink provides diagnostics that you can use to optimize bus usage. Set the following values on the *Configuration Parameters > Diagnostics > Connectivity* pane.

![Configure Bus Diagnostics](image)

**Optimize Virtual and Nonvirtual Buses**

Virtual buses are graphical conveniences that do not affect generated code. As a result, the code generation engine is able to fully optimize the signals in the bus. Use virtual buses rather than nonvirtual buses wherever possible. You can convert between virtual and nonvirtual buses by using Signal Conversion blocks. In some cases, Simulink automatically converts a virtual bus to a nonvirtual bus when required. For example, a Stateflow chart converts an input virtual bus to a nonvirtual bus.

To bundle function-call signals, you must use a virtual bus.

You must use nonvirtual buses for:

- Nonauto storage classes
• Generating a specific structure from the bus
• Root-level Inport or Outport blocks when the bus has mixed data types

**Avoid Nonlocal Nested Buses in Nonvirtual Buses**

Buses can contain subordinate buses. To generate efficient code, set the storage classes of subordinate buses to `Auto`. Setting the storage class to `Auto` eliminates:

• Allocation of redundant memory for the subordinate bus signal and for the parent bus signal
• Additional copy operations (copying data to the subordinate bus, and then copying from the subordinate bus to the final bus)

This model contains nonvirtual bus signals. The subordinate bus signals `Sub_Bus_1` and `Sub_Bus_2` use the storage class `Auto`.

The generated code algorithm efficiently assigns the input signal data to the bus signals.

```c
void ex_nonvirtual_buses_step(void)
{
    Nonvirtual_In_One.SimpleBus_1.A1 = A1;
    Nonvirtual_In_One.SimpleBus_1.A2 = A2;
    Nonvirtual_In_One.SimpleBus_2.A3 = A3;
    Nonvirtual_In_One.SimpleBus_2.A4 = A4;
    Nonvirtual_In_One.A5 = A5;
}
```
See Also
Simulink.Bus

Related Examples
• “Organize Data into Structures in Generated Code” on page 15-177
• “Specify Sample Times for Signal Elements” (Simulink)
Control Signal and State Initialization in the Generated Code

To initialize signals and discrete states with custom values for simulation and code generation, you can use signal objects and block parameters. Data initialization increases application reliability and is a requirement of safety critical applications. Initializing signals for both simulation and code generation can expedite transitions between phases of Model-Based Design.

For basic information about specifying initial values for signals and discrete states in a model, see “Initialize Signals and Discrete States” (Simulink).

Signal and State Initialization in the Generated Code

The initialization behavior for code generation is the same as that for model simulation with the following exceptions:

- RSim executables can use the Data Import/Export pane of the Configuration Parameters dialog box to load input values from MAT-files. GRT and ERT executables cannot load input values from MAT-files.
- The initial value for a block output signal or root level input or output signal can be overwritten by an external (calling) program.
- Setting the initial value for persistent signals is relevant if the value is used or viewed by an external application.

When you generate code, initialization statements are placed in model.c or model.cpp in the model's initialize code.

For example, consider the model rtwdemo_sigobj_iv.
If you create and initialize signal objects in the base workspace, the code generator places initialization code for the signals in the file `rtwdemo_sigobj_iv.c` under the `rtwdemo_sigobj_iv Initialize` function, as shown below.

```c
/* Model initialize function */
void rtwdemo_sigobj_iv Initialize(void)
{
    .
    .
    /* exported global signals */
    S3 = -3.0;
    S2 = -2.0;
    .
    .
    /* exported global states */
    X1 = 0.0;
    X2 = 0.0;
    .
    .
    /* external inputs */
    S1 = -4.5;
    .
    .

The following code shows the initialization code for the enabled subsystem's Unit Delay block state X1 and output signal S2.

```c
void MdlStart(void) {
    .
    .
    /* InitializeConditions for UnitDelay: '<S2>/Unit Delay' */
    X1 = aa1;
```
For an enabled subsystem, the initial value is also used as a reset value if the subsystem's Outport block parameter **Output when disabled** is set to *reset*. The following code from `rtwdemo_sigobj_iv.c` shows the assignment statement for `S3` as it appears in the model output function `rtwdemo_sigobj_iv_output`.

```c
/* Model output function */
static void rtwdemo_sigobj_iv_output(void)
{
    //
    //
    /* Disable for enable system: '<Root>/Enabled Subsystem (state X1 inside)' */
    /* (Virtual) Outport Block: '<S2>/Out1' */
    S2 = aa2;
}
```

### Generate Tunable Initial Conditions

You can represent initial conditions for signals and states by creating tunable global variables in the generated code. These variables allow you to restart an application by using initial conditions that are stored in memory.

If you set **Configuration Parameters > Optimization > Default parameter behavior** to *Tunable*, initial conditions appear as tunable fields of the global parameters structure.

Whether you set **Default parameter behavior** to Tunable or Inlined, you can use a tunable parameter to specify the **InitialValue** property of a signal object or the **Initial condition** parameter of a block. For basic information about tunable parameters, see “Create Tunable Calibration Parameter in the Generated Code” on page 15-122.

This example shows how to use tunable parameters to specify initial conditions for signals and states.

### Explore Example Model

Open the example model `rtwdemo_sigobj_iv` and configure it to show the generated names of blocks. The signal `S2` uses a `Simulink.Signal` object in the base workspace.
Double-click the Simulink.Signal object S2 to view its properties. The Initial value property is set to aa2. The object uses the variable aa2 to specify an initial condition for the signal S2. The Storage class property is set to ExportedGlobal. To use a Simulink.Signal object to initialize a signal, the signal object must use a storage class other than Auto or, if the corresponding data category in the Code Mapping Editor uses a storage class setting other than Default, Model default.

On the Optimization pane, in the Configuration Parameters dialog box, click Configure. The variable aa2 is a tunable parameter that uses the storage class ExportedGlobal.

In the model, open the Enabled Subsystem. In the Outport block dialog box, the parameter Output when disabled is set to reset. When the subsystem becomes disabled, the output signal S2 resets to the initial value aa2.

Open the Unit Delay block dialog box. On the State Attributes tab, the State name box is set to X1.

Open the Enable block dialog box. The parameter States when enabling is set to reset. When the subsystem transitions from a disabled state to an enabled state, it resets internal block states, such as X1, to their initial values.
In the base workspace, double-click the Simulink.Signal object X1 to view its properties. The Initial value property is set to aa1.

Double-click the Simulink.Parameter object aa1 to view its properties. The Storage class property is set to ExportedGlobal. You can generate tunable initial conditions for block states by using tunable parameters such as aa1 and Simulink.Signal objects such as X1.

**Generate and Inspect Code**

Generate code with the example model.

```bash
### Starting build procedure for model: rtwdemo_sigobj_iv
### Successful completion of build procedure for model: rtwdemo_sigobj_iv
```

In the code generation report, view the file rtwdemo_sigobj_iv.c. The code uses global variables to represent the block state X1 and the signal S2.

```c
/* Exported block states */
real_T X1;                             /* '<S2>/Unit Delay' */

/* Exported block signals */
real_T S1;                             /* '<Root>/In1' */
real_T S3;                             /* '<Root>/Signal Conversion' */
real_T S2;                             /* '<S2>/Unit Delay' */

The code uses global variables to represent the tunable parameters aa1 and aa2.

```c
/* Exported block parameters */
real_T aa1 = -2.5;                     /* Variable: aa1 */
real_T aa2 = -2.0;                     /* Variable: aa2 */
```

The model initialization function uses the tunable parameter aa1 to initialize the state X1. The function also uses the tunable parameter aa2 to initialize the signal S2.

```c
/* SystemInitialize for Enabled SubSystem: '<Root>/Enabled Subsystem (state X1 inside)' */
/* InitializeConditions for UnitDelay: '<S2>/Unit Delay' */
X1 = aa1;

/* SystemInitialize for Outport: '<S2>/Out1' */
```
S2 = aa2;

In the model step function, when the Enabled Subsystem transitions from a disabled state to an enabled state, the Unit Delay block state X1 resets to its initial value.

```matlab
if (rtb_PulseGenerator > 0) {
    if (!rtwdemo.sigobj.iv DW.EnabledSubsystemstateX1inside_M) {
        /* InitializeConditions for UnitDelay: '<S2>/Unit Delay' */
        X1 = aa1;
        rtwdemo.sigobj.iv DW.EnabledSubsystemstateX1inside_M = true;
    }
}
```

If the Enabled Subsystem becomes disabled during code execution, the algorithm uses the tunable initial condition aa2 to set the value of the signal S2.

```matlab
} else {
    if (rtwdemo.sigobj.iv DW.EnabledSubsystemstateX1inside_M) {
        /* Disable for Outport: '<S2>/Out1' */
        S2 = aa2;
        rtwdemo.sigobj.iv DW.EnabledSubsystemstateX1inside_M = false;
    }
}
```

**Generate Tunable Initial Condition Structure for Bus Signal**

When you use a MATLAB® structure to specify initialization values for the signal elements in a bus, you can create a tunable global structure in the generated code.

If you set **Configuration Parameters > Optimization > Default parameter behavior** to Tunable, the initial condition appears as a tunable substructure of the global parameters structure.

Whether you set **Default parameter behavior** to Tunable or Inlined, you can specify the initial condition by using a tunable Simulink.Parameter object whose value is a structure. If you apply a storage class other than Auto to the parameter object, the structure is tunable in the generated code.

To generate efficient code by avoiding data type mismatches between the structure and the bus signal, use either:
Typed expressions to specify the values of the structure fields. Match the data type of each field with the data type of the corresponding signal element.

- A Simulink.Bus object to control the data types of the structure fields and the signal elements.

For basic information about using structures to initialize bus signals, and to decide how to control field data types, see “Specify Initial Conditions for Bus Signals” (Simulink).

**Generate Tunable Initial Condition Structure**

This example shows how to use a tunable structure parameter to initialize a virtual bus signal.

Open the example model `rtwdemo_tunable_init_struct` and configure it to show the generated names of blocks.

In the model, select **View > Model Data Editor**.

On the **Imports/Outports** tab, the **Data Types** column shows that each Inport block in the model uses a different output data type.

Open the Bus Creator block dialog box. The block output is a virtual bus.

In the Configuration Parameters dialog box, open the **Optimization** pane. The configuration parameter **Default parameter behavior** is set to **Tunable**. By default, block parameters, including initial conditions, appear in the generated code as tunable fields of the global parameters structure.
In the Model Data Editor, inspect the **States** tab.

For the Unit Delay block, set **Initial Value** to a structure that specifies an initial condition for each of the three signal elements. To generate efficient code, match the data types of the structure fields with the data types of the corresponding signal elements. For example, set **Initial Value** to the expression `struct('thermocpl', 15.23, 'magFlow', uint32(79), 'posSwitch', false).

```matlab
set_param('rtwdemo_tunable_init_struct/Unit Delay','InitialCondition','struct(''thermocpl'',15.23,''magFlow'',uint32(79),''posSwitch'',false)')
```

Generate code from the example model.

```plaintext
### Starting build procedure for model: rtwdemo_tunable_init_struct
### Successful completion of build procedure for model: rtwdemo_tunable_init_struct
```

In the code generation report, view the file `rtwdemo_tunable_init_struct_types.h`. The code defines a structure type whose fields use the data types that you specified in the `struct` expression.

```c
#ifndef DEFINED_TYPEDEF_FOR_struct_mqGi1jsItE0G7cf1bNqMu_
#define DEFINED_TYPEDEF_FOR_struct_mqGi1jsItE0G7cf1bNqMu_

typedef struct {
    real_T thermocpl;
    uint32_T magFlow;
    boolean_T posSwitch;
} struct_mqGi1jsItE0G7cf1bNqMu;
```

View the file `rtwdemo_tunable_init_struct.h`. The structure type definition of the global parameters structure contains a substructure, `UnitDelay_InitialCondition`, which represents the **Initial condition** parameter of the Unit Delay block.

```c
struct P_rtwdemo_tunable_init_struct_T_ {
    struct_mqGi1jsItE0G7cf1bNqMu UnitDelay_InitialCondition;/* Mask Parameter: UnitDelay_InitialCondition
```

View the file `rtwdemo_tunable_init_struct_data.c`. This source file allocates memory for the global parameters structure. The substructure `UnitDelay_InitialCondition` appears.

```c
/* Block parameters (default storage) */
```
P_rtwdemo_tunable_init_struct_T rtwdemo_tunable_init_struct_P = {
/* Mask Parameter: UnitDelay_InitialCondition
 * Referenced by:
 *   '<Root>/Unit Delay'
 *   '<Root>/Unit Delay'
 *   '<Root>/Unit Delay'
 */
{
  15.23,
  79U,
  0
},

View the file rtwdemo_tunable_init_struct.c. The model initialization function uses the fields of the substructure to initialize the block states.

/* InitializeConditions for UnitDelay: '<Root>/Unit Delay' */
rtwdemo_tunable_init_struct_DW.UnitDelay_1_DSTATE =
  rtwdemo_tunable_init_struct_P.UnitDelay_InitialCondition.thermocpl;
rtwdemo_tunable_init_struct_DW.UnitDelay_2_DSTATE =
  rtwdemo_tunable_init_struct_P.UnitDelay_InitialCondition.magFlow;
rtwdemo_tunable_init_struct_DW.UnitDelay_3_DSTATE =
  rtwdemo_tunable_init_struct_P.UnitDelay_InitialCondition.posSwitch;

Use Bus Object to Specify Data Types

If you create a bus object, you can use it to specify the data type of the bus signal and the tunable initial condition structure. Before code generation, the Simulink.Parameter object casts the values of the structure fields to the data types of the signal elements. For basic information about creating bus objects and using them in models, see “When to Use Bus Objects” (Simulink).

Open the example model rtwdemo_init_struct_busobj and configure it to show the generated names of blocks.
In the base workspace, double-click the Simulink.Bus object ComponentData. The object defines three signal elements: thermocpl, magFlow, and posSwitch. The elements each use a different data type.

In the model, open the Model Data Editor (View > Model Data Editor). The Inports/Outports tab shows that for the Inport block DataIn, the output data type (Data Type column) is set to Bus: ComponentData.

At the command prompt, create the structure parameter initStruct. You can specify the field values by using untyped expressions. To improve readability, specify the field posSwitch with a Boolean value.

```matlab
initStruct = struct( ... 'thermocpl',15.23,... 'magFlow',79,... 'posSwitch',false ... );
initStruct = Simulink.Parameter(initStruct);
```

In the Model Data Editor, inspect the Parameters tab.

In the model, click the Unit Delay block. The Model Data Editor highlights the row that corresponds to the Initial condition parameter of the block.

In the Model Data Editor, set the parameter value (Value column) to initStruct.
Click the **Show/refresh additional information** button. The parameter object, `initStruct`, appears in the data table as a row.

Use the **Data Type** column to set the data type of `initStruct` to **Bus: ComponentData**.

```
initStruct.DataType = 'Bus: ComponentData';
```

Set the **Change View** drop-down list to **Code**.

Use the **Storage Class** column to apply the storage class **ExportedGlobal** to `initStruct`.

```
initStruct.StorageClass = 'ExportedGlobal';
```

Generate code from the example model.

```plaintext
### Starting build procedure for model: rtwdemo_init_struct_busobj
### Successful completion of build procedure for model: rtwdemo_init_struct_busobj
```

In the code generation report, view the file `rtwdemo_init_struct_busobj_types.h`. The code creates a structure type **ComponentData** whose fields use the data types in the bus object.

```c
#ifndef DEFINED_TYPEDEF_FOR_ComponentData_
#define DEFINED_TYPEDEF_FOR_ComponentData_

typedef struct {
  real_T thermocpl;
  uint32_T magFlow;
  boolean_T posSwitch;
} ComponentData;

View the file `rtwdemo_init_struct_busobj.c`. The code creates a global variable to represent the tunable parameter object `initStruct`.

```c
/* Exported block parameters */
ComponentData initStruct = {
  15.23,
  79U,
  0
};                                  /* Variable: initStruct */
```
The model initialization function uses the structure fields to initialize the block states.

```c
/* InitializeConditions for UnitDelay: '<Root>/Unit Delay' */
rtwdemo_init_struct_busobj_DW.UnitDelay_1_DSTATE = initStruct.thermocpl;
rtwdemo_init_struct_busobj_DW.UnitDelay_2_DSTATE = initStruct.magFlow;
rtwdemo_init_struct_busobj_DW.UnitDelay_3_DSTATE = initStruct.posSwitch;
```

To change the data type of any of the three signal elements, specify the new type in the bus object. The signal element in the model uses the new type. Before simulation and code generation, the parameter object `initStruct` casts the corresponding structure field to the new type.

**See Also**
State Reader | State Writer

**Related Examples**
- “Initialization Behavior Summary for Signal Objects” (Simulink)
- “Specify Initial Conditions for Bus Signals” (Simulink)
- “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82
- “Generate Code That Responds to Initialize, Reset, and Terminate Events” on page 12-2
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
- “Initialization of Signal, State, and Parameter Data in the Generated Code” on page 15-229
- “Remove Initialization Code” (Embedded Coder)
Initialization of Signal, State, and Parameter Data in the Generated Code

Signal lines, block parameters, and block states in a model can appear in the generated code as data, for example, as global variables. By default, the code initializes this data before execution of the primary algorithm. To match the numerics of simulation in Simulink, the code generator chooses the initial values based on specifications that you make in the model.

By understanding how the generated code initializes data, you can:

- Model a system that reinitializes states during execution, which means that the application can restart the entire system.
- Store initial values in memory as variables, which can persist between execution runs. You can then overwrite these values before starting or restarting a system.
- Generate efficient code by eliminating storage for invariant initial values and by preventing the generation of code that unnecessarily or redundantly initializes data.

For basic information about initializing signals and states in a model, see “Initialize Signals and Discrete States” (Simulink) and “Load State Information” (Simulink).

Static Initialization and Dynamic Initialization

To initialize a data item such as a global variable, an application can use either static or dynamic initialization.

- Static initialization occurs in the same statement that defines (allocates memory for) the variable. The initialization does not occur inside a function definition.

  The code can be more efficient because none of the generated model functions execute initialization statements.

- Dynamic initialization occurs inside a function. For each model or nonvirtual subsystem, the code generator typically creates one or more functions that are dedicated to initialization.

  The generated code or your code can restart a system by calling the initialization function or functions at any time during execution.
Real-World Ground Initialization Requiring Nonzero Bit Pattern

Each data item has a real-world ground value. This value can depend on the data type of the item. For example, for a signal whose data type is `double` or `int8`, the real-world ground value is zero. For an enumeration, the ground value is the default enumeration member.

For some kinds of data, to represent a real-world ground value, a computer stores zero in memory (all bits zero). However, for some other data, a computer stores a nonzero value in memory. This data includes, for example:

- Fixed-point data with bias. The code initializes such a data item to the stored integer value that, given the scaling and bias, represents real-world zero.
- An enumeration whose default member maps to an integer value other than zero. For example, if the default member is `High` with an underlying integer value of 3, the code initializes such a data item to `High`.

Initialization of Signal and State Data

In a model, you can control signal and state initial values through block parameters. For example, to set the initial value of a Unit Delay block, you use the `Initial condition` parameter. In some cases, you can also use the `InitialValue` property of a `Simulink.Signal` object. For most of these block parameters, the default value is 0.

You can also initialize states by using State Writer blocks in Initialize Function subsystems and the `Initial states` model configuration parameter.

By default, the generated code dynamically initializes signal and state data (and other data, such as the model error status) in the generated initialization function. The function, named `model_initialize` by default, performs signal and state initialization operations in this order:

1. Initializes all of the signal and state data in the default generated structures, such as the DWork structure, to a stored value of zero.
2. Initializes additional signal and state data that are not in the default generated structures to the relevant real-world ground value.

This initialization applies only to data that meet both of these criteria:
• The generated code defines (allocates memory for) the data.
• The data use a storage class other than Auto (the default storage class) or Model default (when the Code Mapping Editor specifies the Default storage class, the default setting).

For example, the code applies this operation to data items that use the storage class ExportedGlobal.

3 Initializes each signal and state to the real-world value that the model specifies, for example, through the Initial condition parameter of a Unit Delay block.

4 Initializes each state to the real-world value that you assign by using a State Writer block. The function performs this initialization only if you use an Initialize Function subsystem in the model.

5 Initializes each state to the real-world value that you specify with the configuration parameter Initial states.

After this initialization function executes, each data item has the last real-world value that the function assigned. For example, if you use a State Writer block to initialize a block state to 5 while also using the Initial states configuration parameter to initialize the same state to 10, the state ultimately uses 10 as an initial value.

memset for Bulk Initialization

To initialize signal or state data items that have contiguous storage to a stored value of zero, the generated code can call memset in an initialization function. Data items that have contiguous storage include the DWork structure, arrays, or data items that use a multiword data type.

If your application requires it, you can prevent the generated code from using memset for initializing floating-point data to stored zero. See “Use memset to initialize floats and doubles to 0.0”.

Tunable Initial Values

You can configure the way that tunable block parameters, such as the Gain parameter of a Gain block, appear in the generated code. Most block parameters that set initial values (for example, Initial condition) are tunable. For example, the configuration parameter Default parameter behavior can determine whether the initial values appear in the generated code as inlined constants or as tunable global data. You can also use parameter objects and storage classes to control the representation of these initial values.
For tunable initial values, in the model initialization function, the right-hand side of the assignment statement is a global variable, structure field, or other data whose value you can change in memory.

To make initial values tunable in the generated code, see “Control Signal and State Initialization in the Generated Code” on page 15-217.

**Initialization of Parameter Data**

The generated code statically initializes parameter data to the values that you specify in Simulink.

To express the initial value of a tunable parameter (a global variable) as a mathematical expression involving system constants or other macros, which requires Embedded Coder, see “Initialization by Mathematical Expression (Embedded Coder)” on page 15-232.

**Kinds of Parameter Data**

These model elements appear in the generated code as parameter data:

- Tunable block parameters, such as the Gain parameter of a Gain block, when you set Default parameter behavior to Tunable. Each parameter appears as a field of a dedicated global structure.
- Some tunable block parameters when you set Default parameter behavior to Inlined. When the code generator cannot inline the value of a parameter as a literal number, the parameter appears as a field of a dedicated global const structure.
- Simulink.Parameter objects to which you apply a storage class or custom storage class that has an exported data scope. For example, the built-in storage class ExportedGlobal has an exported data scope, but the storage class ImportedExtern does not.

**Initialization by Mathematical Expression (Embedded Coder)**

You can set the value of a parameter object (such as Simulink.Parameter) to a mathematical expression involving numbers, MATLAB variables, and other parameter objects. See “Set Variable Value by Using a Mathematical Expression” (Simulink).

If you use this technique with Embedded Coder, you can generate code that initializes the corresponding parameter data (global variable) by using the specified expression. For an example, see “Initialize Parameter Value From System Constant or Other Macro
Data Initialization in the Generated Code

This example shows how the generated code initializes signal, state, and parameter data.

Explore Example Model

Open the example model, rtwdemo_rtwintro.

In the model, select View > Model Data Editor.
In the Model Data Editor, inspect the **States** tab. For the Unit Delay block state, the **Initial Value** is set to 0, the default, which means the initial value of the state is zero. The state is named X.

Set **Initial Value** to a nonzero number, for example, 5.

```matlab
set_param('rtwdemo_rtwintro/X','InitialCondition','5')
```

Set the **Change view** drop-down list to **Code**.

In the data table, set **Storage Class** to **ExportedGlobal**. With this setting, the block state appears in the generated code as a separate global variable.

```matlab
set_param('rtwdemo_rtwintro/X','StateStorageClass','ExportedGlobal')
```

In the model, open the **Amplifier** subsystem, which is a triggered subsystem.

In the Model Data Editor, inspect the **Parameters** tab and set the **Change view** drop-down list to **Design**. To set and inspect initial values of signals and states, you can use the **Parameters** tab instead of the **States** tab.

The Model Data Editor shows that for the Outport block, the **Initial output** (InitialOutput) parameter is set to 0, the default. This subsystem output requires an initial value because the subsystem executes conditionally. Leave the initial value at the default.

In the model, clear **Configuration Parameters** > **Signal storage reuse**. When you clear this setting, signal lines appear in the generated code as fields of a generated structure whose purpose is to store signal data. This representation of the signals makes it easier to see how the code generator initializes data.

```matlab
set_param('rtwdemo_rtwintro','OptimizeBlockIOStorage','off')
```

In the model, inspect the configuration parameter **Configuration Parameters** > **Optimization** > **Default parameter behavior**. The configuration parameter is set to **Inlined**, which means block parameters, including initial values, appear in the generated code as inlined literals or as **const** data.

Navigate to the root level of the model.

In the Model Data Editor, click the **Show/refresh additional information** button.

Near the **Filter contents** box, click the **Filter using selection** button.
In the model, click the Constant block labeled INC. The Model Data Editor shows that the Constant value (Value) parameter of the block is set to INC. INC is a MATLAB variable in the base workspace.

For INC, set the value in the Value column to Simulink.Parameter(uint8(1)). MATLAB converts INC to a Simulink.Parameter object.

Use the Storage Class column to apply the storage class ExportedGlobal to INC. With this setting, the generated code defines INC as a global variable. Concerning initialization, INC is an item of parameter data.

INC = Simulink.Parameter(INC);
INC.StorageClass = 'ExportedGlobal';

**Generate and Inspect Code**

Generate code from the model.

rtwbuild('rtwdemo_rtwintro');

### Starting build procedure for model: rtwdemo_rtwintro
### Successful completion of build procedure for model: rtwdemo_rtwintro

In the generated file rtwdemo_rtwintro.c, outside the definition of any function, the code statically initializes the parameter data INC. The value of INC is 1.

file = fullfile('rtwdemo_rtwintro_grt_rtw','rtwdemo_rtwintro.c');
rtwdemodbtype(file,'/* Exported block parameters */','uint8_T INC = 1U;',1,1)

/* Exported block parameters */
uint8_T INC = 1U;                      /* Variable: INC

In the same file, inspect the definition of the rtwdemo_rtwintro_initialize function. First, the function uses memset to initialize all of the internal signals in the model to a stored value of 0.

rtwdemodbtype(file,'/* block I/O */','sizeof(B_rtwdemo_rtwintro_T);',1,1)

/* block I/O */
(void) memset(((void *) &rtwdemo_rtwintro_B), 0,
             sizeof(B_rtwdemo_rtwintro_T));

15-235
The function then initializes the Unit Delay state, $X$, to the appropriate ground value. In this case, the ground value is zero.

```matlab
rtwdemodbtype(file,'/* exported global states */','X = 0U;',1,1)
```

```matlab
/* exported global states */
X = 0U;
```

The function also initializes other data, including the root-level inputs and outputs (Inport and Outport blocks), to the appropriate ground values.

```matlab
rtwdemodbtype(file,'/* external inputs */','Amplifier_Trig_ZCE = POS_ZCSIG;',1,1)
```

```matlab
/* external inputs */
rtwdemo_rtwintro_U.Input = 0;
```

```matlab
/* external outputs */
rtwdemo_rtwintro_Y.Output = 0;
rtwdemo_rtwintro_PrevZCX.Amplifier_Trig_ZCE = POS_ZCSIG;
```

The function then initializes $X$ to the value that you specified in the **Initial condition** block parameter.

```matlab
rtwdemodbtype(file,'/* InitializeConditions for UnitDelay: '<Root>/X' */...',
[X = 5U;]',1,1)
```

```matlab
/* InitializeConditions for UnitDelay: '<Root>/X' */
X = 5U;
```

Finally, the function initializes the output of the Amplifier subsystem.

```matlab
rtwdemodbtype(file,'SystemInitialize for Triggered SubSystem',...
'End of SystemInitialize for SubSystem',1,1)
```

```matlab
/* SystemInitialize for Triggered SubSystem: '<Root>/Amplifier' */
/* SystemInitialize for Outport: '<Root>/Output' incorporates: */
/*    Outport: '<S1>/Out' */
rtwdemo_rtwintro_Y.Output = 0;
```
Inspect Difference Between Stored Value and Real-World Value

For some data, even if the real-world initial value is zero, a computer stores a nonzero value in memory. To observe this difference, apply a slope-bias fixed-point data type to the block state, X. To run this example, you must have Fixed-Point Designer™.

In the Model Data Editor, inspect the Signals tab.

In the model, click the output signal of the Switch block, switch_out.

Use the Data Type column of the Model Data Editor to set the signal data type to fixdt(1,16,1,3). This expression represents a fixed-point data type with a slope of 1 and a bias of 3.

```
set_param('rtwdemo_rtwintro/Switch','OutDataTypeStr','
  fixdt(1,16,1,3)')
```

In the model, select View > Property Inspector and click the Sum block.

In the Property Inspector, under Signal Attributes, clear Require all inputs to have the same data type.

```
set_param('rtwdemo_rtwintro/Sum','InputSameDT','off')
```

To prevent compilation errors on different platforms, select the model configuration parameter Generate code only. This setting causes the model to generate only code.

```
set_param('rtwdemo_rtwintro','GenCodeOnly','on')
```

Generate code from the model.

```
rtwbuild('rtwdemo_rtwintro')
```

The model initialization function first initializes X to the appropriate real-world ground value, 0. Due to the slope-bias data type, which has bias 3, this real-world value corresponds to a stored value of -3.

```
rtwdemodbtype(file,'/* exported global states */','X = -3;',1,1)
```

```
/* exported global states */
X = -3;
```
The function then initializes $X$ to the real-world initial value that you specified in the **Initial condition** block parameter, 5. This real-world value corresponds to a stored value of 2.

```plaintext
rtwdemodbtype(file,'/* InitializeConditions for UnitDelay: ''<Root>/X'' */',
   'X = 2;',1,1)

/* InitializeConditions for UnitDelay: '<Root>/X' */
X = 2;
```

### Modeling Goals

<table>
<thead>
<tr>
<th>Goal</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explicitly model initialization behavior by using blocks</td>
<td>You can explicitly model initialization and reset behavior by using Initialize Function and Reset Function subsystems. In the subsystems, use State Writer blocks to calculate and assign an initial value for a state dynamically. The corresponding code appears in the model initialization function.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Generate Code That Responds to Initialize, Reset, and Terminate Events” on page 12-2.</td>
</tr>
<tr>
<td>Prevent generation of code that explicitly initializes data to zero</td>
<td>If your application environment already initializes global variables to zero, for more efficient code, you can prevent the generation of statements that explicitly initialize global variables to zero. This optimization applies only to signals and states whose initial values are stored in memory as zero. For example, the code generator does not apply the optimization to:</td>
</tr>
<tr>
<td></td>
<td>• Data for which you specify a nonzero initial value by using a block parameter.</td>
</tr>
<tr>
<td></td>
<td>• Data whose real-world initial value is zero but whose corresponding stored value is not zero.</td>
</tr>
<tr>
<td></td>
<td>• Enumerated data whose default member maps to a nonzero integer.</td>
</tr>
<tr>
<td></td>
<td>The optimization requires Embedded Coder. For more information, see “Remove Initialization Code” (Embedded Coder).</td>
</tr>
</tbody>
</table>
### Goal
Generate code that imports data from your external code

### More Information
You can generate code that reuses (imports) data that your external code defines. For example, you can apply the storage class `ImportedExtern` to a signal line, block state, or parameter object. For imported data:

- The generated code does not initialize parameter data. Your code must initialize imported parameter data.
- The generated initialization functions dynamically initialize some signal and state data. Unlike data that the generated code allocates, the code does not initialize imported signal or state data to a stored value of zero. Instead, the code immediately initializes the data to the real-world value that you specify in Simulink.

For more information, including how to prevent the generated code from initializing imported data, see “Exchange Data Between External Calling Code and Generated Code” on page 26-114.

### See Also
- `model_initialize`

### Related Examples
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Optimize Speed and Size of Signal Processing Algorithm by Using Fixed-Point Data

This model shows a fixed-point version of an acoustic noise canceller.

Acoustic Noise Celler (Fixed-Point Version). See the Signal Processing Blockset documentation for details on the dspcex example.
See Also

More About

• “Fixed Point” (Simulink)
• “Acoustic Noise Cancellation (LMS)” (DSP System Toolbox)
Optimize Generated Code Using Fixed-Point Data with Simulink®, Stateflow®, and MATLAB®

This model shows fixed-point code generation in Simulink®, Stateflow®, and MATLAB®.

open_system ('rtwdemo_fixpt1');
This introductory model shows fixed-point code generation in Simulink, Stateflow, and MATLAB. To generate and inspect the code, double-click the blue buttons below. An HTML report detailing the code is displayed automatically.

See Also

More About

• “Fixed Point” (Simulink)
Declare Workspace Variables as Tunable Parameters
Using the Model Parameter Configuration Dialog Box

You can use the Model Parameter Configuration dialog box to declare numeric MATLAB variables in the base workspace as tunable parameters. You can select code generation options, such as storage class, for each tunable parameter.

However, it is a best practice to instead use parameter objects to declare tunable parameters. Do not use the Model Parameter Configuration dialog box to select parameter objects in the base workspace. To use parameter objects, instead of the Model Parameter Configuration dialog box, to declare tunable parameters, see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82.

**Note** You cannot use the Model Parameter Configuration dialog box to declare tunable parameters for a referenced model. Use Simulink.Parameter objects instead.

Declare Existing Workspace Variables as Tunable Parameters

Use the Model Parameter Configuration dialog box to declare existing workspace variables as tunable parameters for a model.

1. In the Configuration Parameters dialog box, on the **Optimization** pane, click **Configure**.

2. In the Model Parameter Configuration dialog box, under **Source list**, select a method to populate the list of available workspace variables.
   - Select **MATLAB workspace** to view all of the numeric variables that are defined in the base workspace.
   - Select **Referenced workspace variables** to view only the numeric variables in the base workspace that the model uses. Selecting this option begins a diagram update and a search for used variables, which can take time for a large model.

3. In the Model Parameter Configuration dialog box, under **Source list**, select one or more workspace variables.

4. Click **Add to table**. The variables appear as tunable parameters under **Global (tunable) parameters**, and appear in italic font under **Source list**.

5. Optionally, select a parameter under **Global (tunable) parameters**, and adjust the code generation settings for the parameter. For more information about adjusting the
code generation options for tunable parameters, see “Set Tunable Parameter Code Generation Options” on page 15-245

6 Click OK to apply your selection of tunable parameters and close the dialog box.

**Declare New Tunable Parameters**

Use the Model Parameter Configuration dialog box to declare new tunable parameters. You can use this technique to declare the names of tunable parameters, and to adjust their code generation settings, before you create the corresponding workspace variables.

1 In the Configuration Parameters dialog box, on the Optimization > Signals and Parameters pane, click Configure.

2 In the Model Parameter Configuration dialog box, under Global (tunable) parameters, click New.

3 Under the Name column, specify a name for the new tunable parameter.

4 Optionally, adjust the code generation settings for the new parameter. For more information about adjusting the code generation options for tunable parameters, see “Set Tunable Parameter Code Generation Options” on page 15-245

5 Click OK to apply your changes and close the dialog box.

**Set Tunable Parameter Code Generation Options**

To set the properties of tunable parameters listed under Global (tunable) parameters in the Model Parameter Configuration dialog box, select a parameter and specify a storage class and, optionally, a storage type qualifier.
### Property Description

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage class</td>
<td>Select one of the following to use for code generation:</td>
</tr>
<tr>
<td></td>
<td>• Model default</td>
</tr>
<tr>
<td></td>
<td>• ExportedGlobal</td>
</tr>
<tr>
<td></td>
<td>• ImportedExtern</td>
</tr>
<tr>
<td></td>
<td>• ImportedExternPointer</td>
</tr>
<tr>
<td></td>
<td>For more information about tunable parameter storage classes, see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82.</td>
</tr>
<tr>
<td>Storage type qualifier</td>
<td>For variables with a storage class other than Auto, you can add a qualifier (such as const or volatile) to the generated storage declaration. To do so, you can select a predefined qualifier from the list, or add qualifiers not in the list by typing them in. The code generator does not check the storage type qualifier for validity, and includes the qualifier text in the generated code without checking syntax.</td>
</tr>
</tbody>
</table>

### Programmatically Declare Workspace Variables as Tunable Parameters

#### Tune Parameters from the Command Line

When parameters are MATLAB workspace variables, the Model Parameter Configuration dialog box is the recommended way to see or set the properties of tunable parameters. In addition to that dialog box, you can also use MATLAB `get_param` and `set_param` commands.

**Note** You can also use `Simulink.Parameter` objects for tunable parameters. See “Create Tunable Calibration Parameter in the Generated Code” on page 15-122 for details.

The following commands return the tunable parameters and corresponding properties:
• `get_param(gcs,'TunableVars')`
• `get_param(gcs,'TunableVarsStorageClass')`
• `get_param(gcs,'TunableVarsTypeQualifier')`

The following commands declare tunable parameters or set corresponding properties:

• `set_param(gcs,'TunableVars',str)`
  The argument `str` (character vector) is a comma-separated list of variable names.

• `set_param(gcs,'TunableVarsStorageClass',str)`
  The argument `str` (character vector) is a comma-separated list of storage class settings.

  The valid storage class settings are
  • Auto
  • ExportedGlobal
  • ImportedExtern
  • ImportedExternPointer

• `set_param(gcs,'TunableVarsTypeQualifier',str)`
  The argument `str` (character vector) is a comma-separated list of storage type qualifiers.

The following example declares the variable `k1` to be tunable, with storage class `ExportedGlobal` and type qualifier `const`. The number of variables and number of specified storage class settings must match. If you specify multiple variables and storage class settings, separate them with a comma.

```
set_param(gcs,'TunableVars','k1')
set_param(gcs,'TunableVarsStorageClass','ExportedGlobal')
set_param(gcs,'TunableVarsTypeQualifier','const')
```
Share Data Between Code Generated from Simulink, Stateflow, and MATLAB

Stateflow and MATLAB Coder can fully define their data definitions, or they can inherit them from Simulink. Data definition capabilities include:

- Inheriting input/output data types and sizes from Simulink.
- Parameterized data types and sizes. That is, data type and size may be specified as a function of another data's type and size, e.g., type(y)=type(u) and size(y)=size(u).
- Inferred output size and type from Simulink via signal attribute back propagation.
- Parameter scoped data, which allows referencing Simulink parameters in Stateflow and MATLAB.

Open Example Model

Open the example model rtwdemo_dymamicio.

open_system('rtwdemo_dymamicio')
Instructions

1. Compile the model (Simulation > Update Diagram) and note the displayed signal types and sizes.

2. Change the data type and/or size of the Constant block and recompile the model. Note that the attributes of the signals automatically adapt to the Constant block specification.

3. Generate and inspect code using the blue buttons in the model. Note that K is shared by the Gain and sfVerticalSum block.

Notes

- The data type and size of all Stateflow and MATLAB data is inherited from Simulink.
- The Gain block and the Stateflow chart sfVerticalSum share the Simulink parameter K, which is defined in the MATLAB workspace as a Simulink.Parameter with Model default storage class (i.e., rtP.K in the generated code).
Entry-Point Functions and Scheduling in Simulink Coder

- “Configure Code Generation for Model Entry-Point Functions” on page 16-2
- “Generate C++ Class Interface to Model or Subsystem Code” on page 16-9
- “Execution of Code Generated from a Model” on page 16-13
- “Rapid Prototyping Model Functions” on page 16-25
Configure Code Generation for Model Entry-Point Functions

What Is an Entry-Point Function?

An entry point is a location in code where a transfer of program control (execution) occurs. The main function (`main()`) is the entry point to a C/C++ program and is called when the application starts executing. Calls to other functions, for example from the `main` function, provide entry points to function code. Program control is transferred to the called function. The function code executes, and when finished, returns control to the `main` or other calling function.

When producing code for a model, the code generator defines a set of entry-point functions that you can call to execute the generated code. You can call the generated functions from external code or from a version of the generated main function that you modify.

The Code Interface Report section of the code generation report lists the entry-point functions that the code generator produces for a model. For more information, see “Analyze the Generated Code Interface” (Embedded Coder).

Categories and Types of Generated Entry-Point Functions

The entry-point functions that the code generator produces for a model and the calling interface for the functions depends on whether the model is:

- Rate-based or is an export-function model
- Configured for reusable, multi-instance code generation

Depending on the style and configuration of a model, the code generator produces one or more of these entry-point functions.

<table>
<thead>
<tr>
<th>Function Category</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialize/ Terminate</td>
<td><code>model_initialize</code></td>
<td>Initialization code for a model. At the start of the application code, call the function once. Do not use this function to reset the real-time model data structure (<code>rtM</code>).</td>
</tr>
</tbody>
</table>
## Configure Code Generation for Model Entry-Point Functions

<table>
<thead>
<tr>
<th>Function Category</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>model_terminate</em></td>
<td>Code for turning off a system. For ERT-based models, you can suppress generation of this function by clearing the model configuration parameter “Terminate function required” (set by default).</td>
</tr>
<tr>
<td>Execution</td>
<td><em>model_step</em></td>
<td>For blocks in a rate-based model, output and update code. If you clear the model configuration parameter “Single output/update function” (selected by default), instead of producing a <em>model_step</em> function, the code generator produces functions <em>model_output</em> and <em>model_update</em>.</td>
</tr>
<tr>
<td></td>
<td><em>model_function-name</em></td>
<td>For an exported-function model, the exported function for a subsystem.</td>
</tr>
<tr>
<td></td>
<td><em>function-name</em></td>
<td>For an exported-function model, the exported function for a Simulink Function block.</td>
</tr>
<tr>
<td></td>
<td><em>model_reset</em></td>
<td>If the model includes a Reset Function block, reset code generated. To reset conditions or state, call the function from the application code.</td>
</tr>
<tr>
<td></td>
<td><em>ref-model</em></td>
<td>For a reference model, output and update code.</td>
</tr>
<tr>
<td></td>
<td><em>isr_numinterrupt-number_vecinterrupt-vector-offset</em></td>
<td>For an Async Interrupt block, interrupt service routine (ISR) code.</td>
</tr>
<tr>
<td>Shared utility</td>
<td><em>function-name</em></td>
<td>For shared utility functions, output code.</td>
</tr>
</tbody>
</table>

### Configure Whether Entry-Point Functions Are Reusable

By default, for top models, the code generator produces code that is not reusable or reentrant. Entry-point functions have a `void-void` interface. Code communicates with other code by directly accessing global data structures that reside in shared memory.
If your application requires reusable, multi-instance entry-point function code, you can configure the code generator to call each function (instance) with unique data. In this case, the code is reentrant.

You configure whether entry-point functions are reusable with the model configuration parameter “Code interface packaging” and related parameters. The parameter settings that you choose depend on factors such as configuration selections for the system target file, programming language, and argument interface.

**Default Configurations for Single-Instance C Entry-Point Functions**

By default, for GRT- and ERT-based system target files, the code generator produces single-instance C entry-point functions. The generated code:

- Creates an execution function with no arguments (void-void).
- Allocates memory statically (at compile time) for model data structures.

The default model configuration parameter settings for configuring single-instance entry-point function code are:

- “Language” set to C.
- “Code interface packaging” set to Nonreusable function.

**Generate Reusable, Multi-Instance C Entry-Point Functions**

You can configure the code generator to produce reusable entry-point functions in C for either a GRT- or ERT-based system target file. However, the function interfaces that the code generator produces by default varies. Assuming that model configuration parameter “Language” is set to C and “Code interface packaging” is set to Reusable function, the code generator produces this entry-point function code for each system target file scenario.
<table>
<thead>
<tr>
<th>System Target File</th>
<th>Interface</th>
</tr>
</thead>
</table>
| GRT-based          | • Reusable, multi-instance C entry-point functions that are reentrant.  
|                    | • Packs values of model root-level Inport blocks and Output blocks into the real-time model data structure. Passes that structure to the execution function as an argument by reference.  
|                    | • Allocates memory dynamically at runtime for the data of a model instance. Allocates the memory by calling a function, such as malloc. |
| ERT-based          | • Reusable, multi-instance C entry-point functions that are reentrant.  
|                    | • Passes the value of each model root-level Inport block and Outport block to the execution function as a separate argument.  
|                    | • Allocates memory statically for model data structures. |

If you are using an ERT-based system target file and want to generate reusable, multi-instance C entry-point functions that are reentrant, set “Language” to C and set “Code interface packaging” to Reusable function. Also consider:

- Using dynamic memory allocation to initialize model data structures. Select “Use dynamic memory allocation for model initialization”.
- Packing values of model root-level Inport blocks into a structure, packing values of root-level Outport blocks into a second structure, and passing the structures to the execution function as arguments by reference. Set “Pass root-level I/O as” to Structure reference.
- Packing values of model root-level Inport blocks and Output blocks into the real-time model data structure and passing that structure to the execution function as an argument by reference. Set “Pass root-level I/O as” to Part of model data structure.

**Generate Reusable, Multi-Instance C++ Entry-Point Functions**

The C++ class interface encapsulates model data as class properties and entry-point functions as class methods. That interface is available for use with ERT-based system target files. To use the interface, set “Language” to C++ and set “Code interface packaging” to C++ class. You can:
• Preview and customize the C++ class interface by clicking “Configure C++ Class Interface”. Customization means that you can generate code for integration with external code and, if necessary, make sure that the code complies with coding standards.

• Configure the visibility of class inheritance by specifying whether to generate the block parameter structure as a public, private, or protected data member. Set “Parameter visibility” to public, private, or protected.

• Generate C++ interface code for model block parameters that meet code performance or tunability requirements. The code can be noninlined or inlined access methods. Set “Parameter access” to Method or Inlined method.

• Generate C++ interface code for model root-level Inport and Outport blockset that meets code performance, data tunability, or data packaging requirements. The code can be one of these types of access methods.

<table>
<thead>
<tr>
<th>For Access Method Type</th>
<th>Set “External I/O access” To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Noninlined</td>
<td>Method</td>
</tr>
<tr>
<td>Inlined</td>
<td>Inlined method</td>
</tr>
<tr>
<td>Noninlined structure-based</td>
<td>Structure-based method</td>
</tr>
<tr>
<td>Inlined structured-based</td>
<td>Inlined structure-based method</td>
</tr>
</tbody>
</table>

**Configure Generated Entry-Point Function Declarations**

Depending on application requirements, such as integration or compliance with code standards, you might need to configure how the code generator produces declarations for entry-point functions. Embedded Coder provides multiple configuration options.

• Apply a default function naming rule to a category of functions across a model. For example, a default naming rule can produce a `model_step` function for each rate in the multi-rate model. In the Code Mapping Editor, on the Function Defaults tab, map a function category to a function customization template that is defined to use the function naming rule (see Code Mapping Editor). If necessary, you can override the default naming of a function by changing the name on the Entry-Point Functions tab (see “Override Default Naming for Individual C Entry-Point Functions” (Embedded Coder) or “Override Default C Step Function Interface” (Embedded Coder)).

• Configure interfaces for individual entry-point functions. In the Code Mapping Editor, on the Entry-Point Functions tab, specify the names of individual functions (see “Override Default Naming for Individual C Entry-Point Functions” (Embedded Coder)).
For a model step (execution) function, you can customize the entire entry-point function interface (see “Override Default C Step Function Interface” (Embedded Coder)).

**Configure Placement of Entry-Point Functions in Memory**

If your application requires that you configure the placement of entry-point functions in memory, for example, to optimize the generated code for specific hardware, you can apply a default memory section to a category of functions across a model. In the Code Mapping Editor, map a function category to a function customization template that is defined to use a specific memory section. See Code Mapping Editor.

**How to Interface with Generated Entry-Point Functions**

1. After generating code for a model, use the code perspective **Code** view to review the generated entry-point functions and, if applicable, variables representing external input and output ports.

2. Add `#include` statements to your external code that include the generated header files that declare the model entry-point functions.

3. Add an `#include` statement that includes the generated file `rtwtypes.h`. This file provides necessary type definitions, `#define` statements, and enumerations.

4. Initialize target-specific data structures and hardware, such as ADCs or DACs.

5. If applicable, initialize data for each instance of a reusable model.

6. If applicable, write input data to generated variables that represent model Inport blocks.

7. Call the generated entry-point functions or, if appropriate, set up use of the `rt_OneStep` function.

8. If applicable, read data from generated variables that represent model Outport blocks.

For more information, see “Deploy Generated Standalone Executable Programs To Target Hardware” (Embedded Coder).
See Also

More About

- “Generate Reentrant Code from Top Models” on page 9-25
- “Configure Default C Code Generation for Categories of Model Data and Functions” (Embedded Coder)
- “Execution of Code Generated from a Model” on page 16-13
- “Use the Real-Time Model Data Structure” (Embedded Coder)
- “Deploy Generated Standalone Executable Programs To Target Hardware” (Embedded Coder)
- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “Environment for Configuring Model Data and Functions for Code Generation” (Embedded Coder)
- “Generate Code That Responds to Initialize, Reset, and Terminate Events” on page 12-2
- “Configure a System Target File” (Embedded Coder)
Generate C++ Class Interface to Model or Subsystem Code

On the Configuration Parameters dialog box, set the **Code Generation > Interface** “Code interface packaging” parameter to **C++ class** for generating a C++ class interface to model code. The generated interface encapsulates required model data into C++ class attributes and model entry point functions into C++ class methods. The benefits of C++ class encapsulation include:

- Greater control over access to model data
- Ability to create multiple instances of model classes
- Easier integration of model code into C++ programming environments

C++ class encapsulation also works for right-click builds of nonvirtual subsystems. (For information on requirements that apply, see “Generate C++ Class Interface to Nonvirtual Subsystem Code” on page 16-10.)

**Generate C++ Class Interface to Model Code**

To generate encapsulated C++ class code from a GRT-based model:

1. Set the Configuration Parameters dialog box parameter **Code Generation > Language** to C++. This selection also enables C++ class code interface packaging for the model.

2. On the **Code Generation > Interface** pane, verify that the parameter **Code interface packaging** is set to **C++ class**.

3. Examine the setting of **Multi-instance code error diagnostic**. Leave the parameter at its default value **Error** unless you need to alter the severity level for diagnostics displayed when a model violates requirements for generating multi-instance code.

4. Generate code for the model.

5. Examine the C++ model class code in the generated files **model.h** and **model.cpp**. For example, the following code excerpt from the H file generated for the example model **rtwdemo_secondOrderSystem** shows the C++ class declaration for the model.
/* Class declaration for model rtwdemo_secondOrderSystem */
class rtwdemo_secondOrderSystemModelClass {
  /* public data and function members */
  public:
    /* External outputs */
    ExtY_rtwdemo_secondOrderSystem_T rtwdemo_secondOrderSystem_Y;

    /* Model entry point functions */
    void initialize();
    void step();
    void terminate();

    /* Constructor */
    rtwdemo_secondOrderSystemModelClass();

    /* Destructor */
    ~rtwdemo_secondOrderSystemModelClass();

    /* Real-Time Model get method */
    RT_MODEL_rtwdemo_secondOrderSystem_T * getRTM();
};

For more information about generating and calling model entry-point functions, see “Configure Code Generation for Model Entry-Point Functions” on page 16-2.

**Note** If you have an Embedded Coder license and you have selected an ERT target for your model, use additional **Code Generation > Interface** pane parameters to customize the generated C++ class interface.

### Generate C++ Class Interface to Nonvirtual Subsystem Code

You can generate C++ class interfaces for right-click builds of nonvirtual subsystems in Simulink models, if the following requirements are met:

- The model is configured for the C++ language and C++ class code interface packaging.
- The subsystem is convertible to a Model block using the function Simulink.SubSystem.convertToModelReference. For referenced model conversion requirements, see the Simulink reference page Simulink.SubSystem.convertToModelReference.
To configure C++ class interfaces for a subsystem that meets the requirements:

1. Open the containing model and select the subsystem block.
2. Right-click the subsystem and select **C/C++ Code > Build This Subsystem**.
3. When the subsystem build completes, examine the C++ class interfaces in the generated files and the HTML code generation report. For more information about generating and calling model entry-point methods, see “Configure Code Generation for Model Entry-Point Functions” on page 16-2.

**Note** If you have an Embedded Coder license and you have selected an ERT target for your model, you can use the MATLAB command `RTW.configSubsystemBuild` to customize the generated C++ class interface to subsystem code.

**C++ Class Interface Limitations**

• Among the data exchange interfaces available on the Interface pane of the Configuration Parameters dialog box, only the C API interface is supported for C++ class code generation. If you select **External mode** or **ASAP2 interface**, code generation fails with a validation error.

• If a model root inport value connects to a Simscape conversion block, you must insert a Simulink Signal Conversion block between the root inport and the Simscape conversion block. On the Simulink Signal Conversion block parameter dialog box, select **Exclude this block from 'Block reduction' optimization**.

• You cannot use a C++ class interface in cases when a referenced model cannot have a combined output/update function. Cases include a model that
  
  • Has a continuous sample time
  • Saves states

**See Also**

**More About**

• “Generate Reentrant Code from Top Models” on page 9-25
• “Configure Code Generation for Model Entry-Point Functions” on page 16-2
• “Execution of Code Generated from a Model” on page 16-13
• “Rapid Prototyping Model Functions” on page 16-25
Execution of Code Generated from a Model

The code generator produces algorithmic code as defined by your model. You can include external (for example, custom or legacy) code in a model by using techniques explained in “Choose an External Code Integration Workflow” on page 26-4.

The code generator also provides an interface that executes the generated model code. The interface and model code are compiled together to create an executable program. The next figure shows a high-level object-oriented view of the executable.

The Object-Oriented View of a Real-Time Program

In general, the conceptual design of the model execution driver does not change between the rapid prototyping and embedded style of generated code. The following sections describe model execution for single-tasking and multitasking environments both for simulation (non-real-time) and for real time. For most model code, the multitasking environment provides the most efficient model execution (that is, fastest sample rate).

The following concepts are useful in describing how model code executes.

- **Initialization**: `model_initialize` initializes the interface code and the model code.
- **ModelOutputs**: Calls blocks in your model that have a sample hit at the current time and has them produce their output. `model_output` can be done in major or minor time steps. In major time steps, the output is a given simulation time step. In minor time steps, the interface integrates the derivatives to update the continuous states.
- **ModelUpdate**: `model_update` calls blocks that have a sample hit at the current point in time and has them update their discrete states or similar type objects.
• **ModelDerivatives**: Calls blocks in your model that have continuous states and has them update their derivatives. `model_derivatives` is only called in minor time steps.

• **ModelTerminate**: `model_terminate` terminates the program if it is designed to run for a finite time. It destroys the real-time model data structure, deallocates memory, and can write data to a file.

### Program Execution

A real-time program cannot require 100% of the CPU time. This requirement provides an opportunity to run background tasks during the free time.

Background tasks include operations such as writing data to a buffer or file, allowing access to program data by third-party data monitoring tools, or using Simulink external mode to update program parameters.

It is important, however, that the program be able to preempt the background task so the model code can execute in real time.

The way the program manages tasks depends on capabilities of the environment in which it operates.

### Program Timing

Real-time programs require careful timing of the task invocations (either by using an interrupt or a real-time operating system tasking primitive) so that the model code executes to completion before another task invocation occurs. The timing includes time to read and write data to and from external hardware.

The next figure illustrates interrupt timing.
Task Timing

The sample interval must be long enough to allow model code execution between task invocations.

In the figure above, the time between two adjacent vertical arrows is the sample interval. The empty boxes in the upper diagram show an example of a program that can complete one step within the interval and still allow time for the background task. The gray box in the lower diagram indicates what happens if the sample interval is too short. Another task invocation occurs before the task is complete. Such timing results in an execution error.

Note also that, if the real-time program is designed to run forever (that is, the final time is 0 or infinite so that the while loop never exits), then the shutdown code does not execute.

For more information on how the timing engine works, see “Absolute and Elapsed Time Computation” on page 3-2.

External Mode Communication

External mode allows communication between the Simulink block diagram and the standalone program that is built from the generated code. In this mode, the real-time program functions as an interprocess communication server, responding to requests from the Simulink engine.
Data Logging in Single-Tasking and Multitasking Model Execution

“Debug” on page 18-43 explains how you can save system states, outputs, and time to a MAT-file at the completion of the model execution. The LogTXY function, which performs data logging, operates differently in single-tasking and multitasking environments.

If you examine how LogTXY is called in the single-tasking and multitasking environments, you will notice that for single-tasking LogTXY is called after ModelOutputs. During this ModelOutputs call, blocks that have a hit at time $t$ execute, whereas in multitasking, LogTXY is called after ModelOutputs(tid=0), which executes only the blocks that have a hit at time $t$ and that have a task identifier of 0. This results in differences in the logged values between single-tasking and multitasking logging. Specifically, consider a model with two sample times, the faster sample time having a period of 1.0 second and the slower sample time having a period of 10.0 seconds. At time $t = k*10$, $k=0,1,2...$ both the fast (tid=0) and slow (tid=1) blocks execute. When executing in multitasking mode, when LogTXY is called, the slow blocks execute, but the previous value is logged, whereas in single-tasking the current value is logged.

Another difference occurs when logging data in an enabled subsystem. Consider an enabled subsystem that has a slow signal driving the enable port and fast blocks within the enabled subsystem. In this case, the evaluation of the enable signal occurs in a slow task, and the fast blocks see a delay of one sample period; thus the logged values will show these differences.

To summarize differences in logged data between single-tasking and multitasking, differences will be seen when

- Any root outport block has a sample time that is slower than the fastest sample time
- Any block with states has a sample time that is slower than the fastest sample time
- Any block in an enabled subsystem where the signal driving the enable port is slower than the rate of the blocks in the enabled subsystem

For the first two cases, even though the logged values are different between single-tasking and multitasking, the model results are not different. The only real difference is where (at what point in time) the logging is done. The third (enabled subsystem) case results in a delay that can be seen in a real-time environment.
Non-Real-Time Single-Tasking Systems

The pseudocode below shows the execution of a model for a non-real-time single-tasking system.

main()
{
  Initialization
  While (time < final time)
    ModelOutputs     -- Major time step.
    LogTXY           -- Log time, states and root outports.
    ModelUpdate     -- Major time step.
    Integrate       -- Integration in minor time step for
                     -- models with continuous states.
    ModelDerivatives
    Do 0 or more
      ModelOutputs
      ModelDerivatives
    EndDo -- Number of iterations depends upon the solver
            Integrate derivatives to update continuous states.
    EndIntegrate
  EndWhile
  Termination
}  

The initialization phase begins first. This consists of initializing model states and setting up the execution engine. The model then executes, one step at a time. First ModelOutputs executes at time \( t \), then the workspace I/O data is logged, and then ModelUpdate updates the discrete states. Next, if your model has continuous states, ModelDerivatives integrates the continuous states' derivatives to generate the states for time \( t_{new} = t + h \), where \( h \) is the step size. Time then moves forward to \( t_{new} \) and the process repeats.

During the ModelOutputs and ModelUpdate phases of model execution, only blocks that reach the current point in time execute.

Non-Real-Time Multitasking Systems

The pseudocode below shows the execution of a model for a non-real-time multitasking system.

main()
{
Initialization
While (time < final time)
   ModelOutputs(tid=0)   -- Major time step.
   LogTXY                -- Log time, states, and root
                        -- outports.
   ModelUpdate(tid=0)    -- Major time step.
Integrate       -- Integration in minor time step for
                        -- models with continuous states.
   ModelDerivatives
   Do 0 or more
      ModelOutputs(tid=0)
   ModelDerivatives
   EndDo (Number of iterations depends upon the solver.)
   Integrate derivatives to update continuous states.
   EndIntegrate
For i=1:NumTids
   ModelOutputs(tid=i) -- Major time step.
   ModelUpdate(tid=i)  -- Major time step.
EndFor
EndWhile
Termination
}

Multitasking operation is more complex than single-tasking execution because the output and update functions are subdivided by the task identifier (tid) that is passed into these functions. This allows for multiple invocations of these functions with different task identifiers using overlapped interrupts, or for multiple tasks when using a real-time operating system. In simulation, multiple tasks are emulated by executing the code in the order that would occur if no preemption existed in a real-time system.

Multitasking execution assumes that all task rates are multiples of the base rate. The Simulink product enforces this when you create a fixed-step multitasking model. The multitasking execution loop is very similar to that of single-tasking, except for the use of the task identifier (tid) argument to ModelOutputs and ModelUpdate.

**Note** You cannot use tid values from code generated by a target file and not by Simulink Coder. Simulink Coder tracks the use of tid when generating code for a specific subsystem or function type. When you generate code in a target file, this argument cannot be tracked because the scope does not have subsystem or function type. Therefore, tid becomes an undefined variable and your target file fails to compile.
Real-Time Single-Tasking Systems

The pseudocode below shows the execution of a model in a real-time single-tasking system where the model is run at interrupt level.

```plaintext
rtOneStep()
{
    Check for interrupt overflow
    Enable "rtOneStep" interrupt
    ModelOutputs    -- Major time step.
    LogTXY          -- Log time, states and root outports.
    ModelUpdate     -- Major time step.
    Integrate       -- Integration in minor time step for models
                     -- with continuous states.
        ModelDerivatives
    Do 0 or more
        ModelOutputs
        ModelDerivatives
    EndDo (Number of iterations depends upon the solver.)
    Integrate derivatives to update continuous states.
    EndIntegrate
}

main()
{
    Initialization (including installation of rtOneStep as an interrupt service routine, ISR, for a real-time clock).
    While(time < final time)
        Background task.
    EndWhile
    Mask interrupts (Disable rtOneStep from executing.)
    Complete any background tasks.
    Shutdown
}
```

Real-time single-tasking execution is very similar to non-real-time single-tasking execution, except that instead of free-running the code, the `rt_OneStep` function is driven by a periodic timer interrupt.

At the interval specified by the program's base sample rate, the interrupt service routine (ISR) preempts the background task to execute the model code. The base sample rate is the fastest in the model. If the model has continuous blocks, then the integration step size determines the base sample rate.
For example, if the model code is a controller operating at 100 Hz, then every 0.01 seconds the background task is interrupted. During this interrupt, the controller reads its inputs from the analog-to-digital converter (ADC), calculates its outputs, writes these outputs to the digital-to-analog converter (DAC), and updates its states. Program control then returns to the background task. All of these steps must occur before the next interrupt.

### Real-Time Multitasking Systems

The following pseudocode shows how a model executes in a real-time multitasking system where the model is run at interrupt level.

```plaintext
rtOneStep()
{
    Check for interrupt overflow
    Enable "rtOneStep" interrupt
    ModelOutputs(tid=0)    -- Major time step.
    LogTXY                  -- Log time, states and root outports.
    ModelUpdate(tid=0)     -- Major time step.
    Integrate              -- Integration in minor time step for
    -- models with continuous states.
    ModelDerivatives
    Do 0 or more
        ModelOutputs(tid=0)
        ModelDerivatives
    EndDo (Number of iterations depends upon the solver.)
    Integrate derivatives and update continuous states.
    EndIntegrate
    For i=1:NumTasks
        If (hit in task i)
            ModelOutputs(tid=i)
            ModelUpdate(tid=i)
        EndIf
    EndFor
}
main()
{
    Initialization (including installation of rtOneStep as an
    interrupt service routine, ISR, for a real-time clock).
    While(time < final time)
        Background task.
    EndWhile
}
```
Running models at interrupt level in a real-time multitasking environment is very similar to the previous single-tasking environment, except that overlapped interrupts are employed for concurrent execution of the tasks.

The execution of a model in a single-tasking or multitasking environment when using real-time operating system tasking primitives is very similar to the interrupt-level examples discussed above. The pseudocode below is for a single-tasking model using real-time tasking primitives.

```
tSingleRate()
{
    MainLoop:
    If clockSem already "given", then error out due to overflow.
    Wait on clockSem
    ModelOutputs -- Major time step.
    LogTXY -- Log time, states and root
    -- outports
    ModelUpdate -- Major time step
    Integrate -- Integration in minor time step
    -- for models with continuous
    -- states.
    ModelDerivatives
    Do 0 or more
    ModelOutputs
    ModelDerivatives
    EndDo (Number of iterations depends upon the solver.)
    Integrate derivatives to update continuous states.
    EndIntegrate
    EndMainLoop
}

main()
{
    Initialization
    Start/spawn task "tSingleRate".
    Start clock that does a "semGive" on a clockSem semaphore.
    Wait on "model-running" semaphore.
    Shutdown
}
```
In this single-tasking environment, the model executes as real-time operating system tasking primitives. In this environment, create a single task (tSingleRate) to run the model code. This task is invoked when a clock tick occurs. The clock tick gives a clockSem (clock semaphore) to the model task (tSingleRate). The model task waits for the semaphore before executing. The clock ticks occur at the fundamental step size (base rate) for your model.

**Multitasking Systems Using Real-Time Tasking Primitives**

The pseudocode below is for a multitasking model using real-time tasking primitives.

```pseudocode
function tSubRate(subTaskSem, i)
    for Loop:
        Wait on semaphore subTaskSem.
        ModelOutputs(tid=i)
        ModelUpdate(tid=i)
    EndLoop
end function

function tBaseRate()
    for MainLoop:
        If clockSem already "given", then error out due to overflow.
        Wait on clockSem
        for i=1:NumTasks
            if (hit in task i)
                if task i is currently executing, then error out due to overflow.
                Do a "semGive" on subTaskSem for task i.
            end if
        end for
        ModelOutputs(tid=0)   -- major time step.
        LogTXY                 -- Log time, states and root outports.
        ModelUpdate(tid=0)    -- major time step.
        for Loop:
            if (number of iterations depends upon the solver).
            ModelDerivatives
            Do 0 or more
                ModelOutputs(tid=0)
                ModelDerivatives
            EndDo
            Integrate derivatives to update continuous states.
        EndLoop
    end for
end function
```
EndMainLoop
}
main()
{
    Initialization
    Start/spawn task "tSubRate".
    Start/spawn task "tBaseRate".

    Start clock that does a "semGive" on a clockSem semaphore.
    Wait on "model-running" semaphore.
    Shutdown
}

In this multitasking environment, the model is executed using real-time operating system tasking primitives. Such environments require several model tasks (tBaseRate and several tSubRate tasks) to run the model code. The base rate task (tBaseRate) has a higher priority than the subrate tasks. The subrate task for tid=1 has a higher priority than the subrate task for tid=2, and so on. The base rate task is invoked when a clock tick occurs. The clock tick gives a clockSem to tBaseRate. The first thing tBaseRate does is give semaphores to the subtasks that have a hit at the current point in time. Because the base rate task has a higher priority, it continues to execute. Next it executes the fastest task (tid=0), consisting of blocks in your model that have the fastest sample time. After this execution, it resumes waiting for the clock semaphore. The clock ticks are configured to occur at the fundamental step size for your model.

**Rapid Prototyping and Embedded Model Execution Differences**

The rapid prototyping program framework provides a common application programming interface (API) that does not change between model definitions.

The Embedded Coder product provides a different framework called the embedded program framework. The embedded program framework provides an optimized API that is tailored to your model. When you use the embedded style of generated code, you are modeling how you would like your code to execute in your embedded system. Therefore, the definitions defined in your model should be specific to your embedded targets. Items such as the model name, parameter, and signal storage class are included as part of the API for the embedded style of code.

One major difference between the rapid prototyping and embedded style of generated code is that the latter contains fewer entry-point functions. The embedded style of code can be configured to have only one function, `model_step`. 
Thus, model execution code eliminates `Loop...EndLoop` statements and groups `ModelOutputs`, `LogTXY`, and `ModelUpdate` into a single statement, `model_step`.

For more information about how generated embedded code executes, see “Configure Code Generation for Model Entry-Point Functions” on page 16-2.

**See Also**

**More About**

- “Time-Based Scheduling and Code Generation” (Embedded Coder)
- “Sample Times in Subsystems” (Simulink)
- “Sample Times in Systems” (Simulink)
- “Time-Based Scheduling Example Models” (Embedded Coder)
Rapid Prototyping Model Functions

Rapid prototyping code defines the following functions that interface with the main program (main.c or main.cpp):

- **Model()**: The model registration function. This function initializes the work areas (for example, allocating and setting pointers to various data structures) used by the model. The model registration function calls the `MdlInitializeSizes` and `MdlInitializeSampleTimes` functions. These two functions are very similar to the S-function `mdlInitializeSizes` and `mdlInitializeSampleTimes` methods.

- **MdlStart(void)**: After the model registration functions `MdlInitializeSizes` and `MdlInitializeSampleTimes` execute, the main program starts execution by calling `MdlStart`. This routine is called once at startup.

The function `MdlStart` has four basic sections:

- Code to initialize the states for each block in the root model that has states. A subroutine call is made to the “initialize states” routines of conditionally executed subsystems.

- Code generated by the one-time initialization (start) function for each block in the model.

- Code to enable the blocks in the root model that have enable methods, and the blocks inside triggered or function-call subsystems residing in the root model. Simulink blocks can have enable and disable methods. An enable method is called just before a block starts executing, and the disable method is called just after the block stops executing.

- Code for each block in the model whose output value is constant. The block code appears in the `MdlStart` function only if the block parameters are not tunable in the generated code and if the code generator cannot eliminate the block code through constant folding.

- **MdlOutputs(int_T tid)**: `MdlOutputs` updates the output of blocks. The tid (task identifier) parameter identifies the task that in turn maps when to execute blocks based upon their sample time. This routine is invoked by the main program during major and minor time steps. The major time steps are when the main program is taking an actual time step (that is, it is time to execute a specific task). If your model contains continuous states, the minor time steps will be taken. The minor time steps are when the solver is generating integration stages, which are points between major outputs. These integration stages are used to compute the derivatives used in advancing the continuous states.
• **MdlUpdate(int_T tid):** MdlUpdate updates the states and work vector state information (that is, states that are neither continuous nor discrete) saved in work vectors. The `tid` (task identifier) parameter identifies the task that in turn indicates which sample times are active, allowing you to conditionally update only states of active blocks. This routine is invoked by the interface after the major `MdlOutputs` has been executed. The solver is also called, and `model_Derivatives` is called in minor steps by the solver during its integration stages. All blocks that have continuous states have an identical number of derivatives. These blocks are required to compute the derivatives so that the solvers can integrate the states.

• **MdlTerminate(void):** MdlTerminate contains any block shutdown code. MdlTerminate is called by the interface, as part of the termination of the real-time program.

The contents of the above functions are directly related to the blocks in your model. A Simulink block can be generalized to the following set of equations.

\[
y = f_0(t, x_c, x_d, u)
\]

Output \(y\) is a function of continuous state \(x_c\), discrete state \(x_d\), and input \(u\). Each block writes its specific equation in a section of `MdlOutputs`.

\[
x_{d+1} = f_u(t, x_d, u)
\]

The discrete states \(x_d\) are a function of the current state and input. Each block that has a discrete state updates its state in `MdlUpdate`.

\[
\dot{x} = f_d(t, x_c, u)
\]

The derivatives \(\dot{x}\) are a function of the current input. Each block that has continuous states provides its derivatives to the solver (for example, `ode5`) in `model_Derivatives`. The derivatives are used by the solver to integrate the continuous state to produce the next value.

The output, \(y\), is generally written to the block I/O structure. Root-level Outport blocks write to the external outputs structure. The continuous and discrete states are stored in the states structure. The input, \(u\), can originate from another block's output, which is located in the block I/O structure, an external input (located in the external inputs structure), or a state. These structures are defined in the `model.h` file that the Simulink Coder software generates.
The next example shows the general contents of the rapid prototyping style of C code written to the *model.c* file.

```c
/*
 * Version, Model options, TLC options,
 * and code generation information are placed here.
 */
#include

void MdlStart(void)
{
    /*
    * State initialization code.
    * Model start-up code - one time initialization code.
    * Execute any block enable methods.
    * Initialize output of any blocks with constant sample times.
    */
}

void MdlOutputs(int_T tid)
{
    /* Compute: y = f0(t,xc,xd,u) for each block as needed. */
}

void MdlUpdate(int_T tid)
{
    /* Compute: xd+1 = fu(t,xd,u) for each block as needed. */

    /* Compute: dxc = fd(t,xc,u) for each block in model_derivatives
       as needed. */
}

void MdlTerminate(void)
{
    /* Perform shutdown code for any blocks that
       have a termination action */
}
```

The next figure shows a flow chart describing the execution of the rapid prototyping generated code.
**Rapid Prototyping Execution Flow Chart**

Each block places code in specific `Mdl` routines according to the algorithm that it is implementing. Blocks have input, output, parameters, and states, as well as other general items. For example, in general, block inputs and outputs are written to a block I/O structure (`model_B`). Block inputs can also come from the external input structure (`model_U`) or the state structure when connected to a state port of an integrator (`model_X`), or ground (`rtGround`) if unconnected or grounded. Block outputs can also go to the external output structure (`model_Y`). The next figure shows the general mapping between these items.
Data View of the Generated Code

The following list defines the structures shown in the preceding figure:

- **Block I/O structure** (*model_B*): This structure consists of persistent block output signals. The number of block output signals is the sum of the widths of the data output ports of all nonvirtual blocks in your model. If you activate block I/O optimizations, the Simulink and Simulink Coder products reduce the size of the *model_B* structure by
  - Reusing the entries in the *model_B* structure
  - Making other entries local variables

See “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50 for more information on these optimizations.

Structure field names are determined either by the block's output signal name (when present) or by the block name and port number when the output signal is left unlabeled.

- **Block states structures**: The continuous states structure (*model_X*) contains the continuous state information for blocks in your model that have continuous states. Discrete states are stored in a data structure called the *DWork vector* (*model_DWork*).
• Block parameters structure (*model_P*): The parameters structure contains block parameters that can be changed during execution (for example, the parameter of a Gain block).

• External inputs structure (*model_U*): The external inputs structure consists of all root-level Inport block signals. Field names are determined by either the block's output signal name, when present, or by the Inport block's name when the output signal is left unlabeled.

• External outputs structure (*model_Y*): The external outputs structure consists of all root-level Outport blocks. Field names are determined by the root-level Outport block names in your model.

• Real work, integer work, and pointer work structures (*model_RWork*, *model_IWork*, *model_PWork*): Blocks might have a need for real, integer, or pointer work areas. For example, the Memory block uses a real work element for each signal. These areas are used to save internal states or similar information.

### See Also

### More About

- “Time-Based Scheduling and Code Generation” (Embedded Coder)
- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Array Layout
Column-Major Layout to Row-Major Layout Conversion of Models with Lookup Table Blocks

Simulink® Coder™ supports row-major array layout for code generation. You can integrate existing applications that use row-major array layout with the generated code in row-major array layout. When you switch an existing model with lookup table (LUT) blocks from the column-major array layout to the row-major array layout, it is recommended to convert the LUT blocks from the column-major algorithm to the row-major algorithm. The code generated by using row-major algorithm performs with the best speed and memory usage when operating on table data with row-major array layout. The code generated by using column-major algorithm performs best with column-major array layout.

This example shows the workflow of converting a model with LUT blocks from column-major layout to row-major layout to achieve the best performance on a row-major array layout.

In this example, you:

- Identify the array layout and select the optimized algorithm.
- Preserve semantics through table permutation.
- Generate code by using a row-major algorithm and an array layout.

Simulate and Generate Code by Using Column-Major Algorithms

1. Open the example model rtwdemo_row_lutcol2row_workflow.

open_system('rtwdemo_row_lutcol2row_workflow');
By default, Simulink configures a model to use column-major algorithms and a column-major array layout. These parameters are the configuration parameters in the Model Configuration Parameters dialog box.

- Math and Data Types > **Use algorithms optimized for row-major array layout** — This parameter affects simulation and code generation.
- Code Generation > Interface > **Array layout** — This parameter affects only code generation.
2. On the model toolstrip, click **Run** to simulate the model and observe the output logged in workspace variable `yout`.

3. Change your current folder in MATLAB® to a writable folder. Click **Build model** to generate C code.

**Select Optimized Algorithms for Row-Major Array Layout**

Table data with row-major array layout is frequently used in the field of calibration. To interface the row-major table data with the existing model, update the column-major model to operate efficiently on row-major table data.

Use the algorithm that is optimized for the specified array layout to achieve the best performance. For example, use row-major algorithms when **Array layout** is set as **Row-major** during code generation.

<table>
<thead>
<tr>
<th>Array Layout</th>
<th>Algorithm</th>
<th>Cache-Friendly Algorithm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column-major</td>
<td>Column-major</td>
<td>✓ (Recommended)</td>
</tr>
<tr>
<td>Row-major</td>
<td>Row-major</td>
<td>✓ (Recommended)</td>
</tr>
<tr>
<td>Row-major</td>
<td>Column-major</td>
<td>! (Not recommended)</td>
</tr>
<tr>
<td>Column-major</td>
<td>Row-major</td>
<td>! (Not recommended)</td>
</tr>
</tbody>
</table>

1. To enable row-major algorithms, open the Model Configuration Parameters dialog box. On the **Math and Data Types** pane, select the configuration parameter **Use algorithms optimized for row-major array layout**. Alternatively, in the MATLAB Command Window, enter:

   ```
   set_param('rtwdemo_row_lutcol2row_workflow','UseRowMajorAlgorithm','on');
   ```

2. Click **Run** to simulate the model. Simulink reports errors because it encounters inconsistent breakpoint and table data between prelookup and interpolation blocks. The causes of this error are the two semantic changes that occur when you switch from column-major algorithms to row-major algorithms, that is, when you:
• Select a plane from a 3-D table in interpolation block.
• Select a plane from a 4-D table through a direct lookup table block.

**Preserve Semantics by Using Table Permutation**

1. For subtable selection before interpolation, or direct lookup that outputs a vector or 2-D matrix, the model semantics change when you switch from a column-major algorithm to a row-major algorithm by selecting the configuration parameter **Use algorithms optimized for row-major array layout**. To preserve the semantics and fix the previous errors, permute the table data by using these commands:

```matlab
T4d_str = get_param('rtwdemo_row_lutcol2row_workflow/Direct LUT','Table');
set_param('rtwdemo_row_lutcol2row_workflow/Direct LUT','Table',...['permute('','T4d_str','',[3,4,1,2])']);
```
T3d_str = get_param('rtwdemo_row_lutcol2row_workflow/Interp2','Table');
set_param('rtwdemo_row_lutcol2row_workflow/Interp2','Table',
['permute(',T3d_str,',[3,1,2])']);

2. Before you import table data from a file, you must permute the table data in the file. This permutation keeps the table tunable throughout the simulation and code generation workflow.

**Code Generation by Using Row-Major Algorithm and Array Layout**

After permuting the table data, Simulink configures the model `rtwdemo_row_lutcol2row_workflow` for row-major simulation. The model is equivalent to the preconfigured model `rtwdemo_row_lutcol2row_workflow_rowrow` that has permuted table data and uses a row-major algorithm.

1. Open the example model `rtwdemo_row_lutcol2row_workflow_rowrow`.

   ```plaintext```
   open_system('rtwdemo_row_lutcol2row_workflow_rowrow');
   ```plaintext```
2. To set up these models for row-major code generation, open the Model Configuration Parameters dialog box. In addition to enabling the **Use algorithms optimized for row-major array layout** configuration parameter, on the Code Generation > Interface pane, set the configuration parameter **Array Layout** to Row-Major option. The **Array Layout** parameter enables the model for row-major code generation. Alternatively, in the MATLAB Command Window, enter:

```matlab
% For model 'rtwdemo_row_lutcol2row_workflow_rowrow'
set_param('rtwdemo_row_lutcol2row_workflow_rowrow', 'ArrayLayout','Row-major');
% For model 'rtwdemo_row_lutcol2row_workflow'
set_param('rtwdemo_row_lutcol2row_workflow', 'ArrayLayout','Row-major');
```

3. In the block dialog boxes, examine the permuted 3-D table.
4. Change your current folder in MATLAB to a writable folder. On the model toolstrip, click **Build model** to generate C code. In the generated code, observe the table data with row-major array layout.
In the generated code, the `memcpy` function replaces the `for` loops. Using `memcpy` reduces the amount of memory for storing data. This optimization improves execution speed.
Observe the algorithms optimized for row-major data.
```c
17    real_T intrp2d_la(const uint32_T bpIndex[], const real_T frac[], const real_T
table[], const uint32_T stride, const uint32_T maxIndex[])
18    {
19        real_T y;
20        real_T yR_1d;
21        uint32_T offset_1d;
22
23/* Row-major Interpolation 2-D */
24          "Interpolation method: 'Linear point-slope'"
25          "Use last breakpoint for index at or above upper limit: 'on'"
26          "Overflow mode: 'wrapping'"
27          "/*
28             offset_1d = bpIndex[1U] * stride + bpIndex[0U];
29             if (bpIndex[0U] == maxIndex[0U]) {
30                 y = table[offset_1d];
31             } else {
32                 y = (table[offset_1d + 1U] - table[offset_1d]) * frac[0U] + table[offset_1d];
33             }
34          }
35
36          if (bpIndex[1U] == maxIndex[1U]) {
37              } else {
38                  offset_1d += stride;
39                  if (bpIndex[0U] == maxIndex[0U]) {
40                      yR_1d = table[offset_1d];
```

See Also

Related Examples

- "Code Generation of Matrices and Arrays" on page 21-76
- "Interpolation Algorithm for Row-Major Array Layout" on page 17-12
Interpolation Algorithm for Row-Major Array Layout

This example illustrates the interpolation algorithm in 2-D and 3-D Lookup Table that is optimized for row-major array layout. The interpolation algorithm that is optimized for column-major array layout is also presented as a reference. The code generated by using row-major interpolation algorithm performs with the best speed and memory usage when operating on table data with row-major array layout. The code generated by using column-major interpolation algorithm performs best with column-major array layout.

In this example, you:

- Interpolate on a 2-D Lookup Table with column-major and row-major algorithm.
- Generate code with a row-major algorithm and an array layout.
- Identify the array layout and select the optimized algorithm.
- Interpolate on a 3-D Lookup Table with column-major and row-major algorithm.

Simulate with 2-D Row-Major Algorithm

1. Open the example model `rtwdemo_row_lut2d`.

```matlab
model = 'rtwdemo_row_lut2d';
open_system(model);
```

2. By default, Simulink configures a model with column-major algorithm and column-major array layout. The model `rtwdemo_row_lut2d` is configured to use column-major algorithm. Simulate the model. To observe the output, open the Simulation Data Inspector from the Simulink Editor toolbar. The output value is 4.
3. To enable row-major algorithms, open the Model Configuration Parameters dialog box. On the Math and Data Types pane, enable the configuration parameter **Use algorithms optimized for row-major array layout**. Alternatively, in the MATLAB Command Window, enter:

```matlab
set_param(model,'UseRowMajorAlgorithm','on');
```

4. Simulate the model and observe those results in the Simulation Data Inspector. The output value is 4.

The column-major and row-major algorithms differ only in the interpolation order. In some cases, due to different operation order on the same data set, you might experience minor numeric differences in the outputs of column-major and row-major algorithms. For the 2-D Lookup Table used in the example model, the interpolation algorithm is illustrated here.

---

**Generate Code by Using Row-Major Algorithm and Array Layout**

The 2-D table data used in model `rtwdemo_row_lut2d` is:

```
Table_3by2.Value
```
ans =
1     4
2     5
3     6

1. Open the Model Configuration Parameters dialog box. In addition to enabling the **Use algorithms optimized for row-major array layout** configuration parameter, on the **Code Generation > Interface** pane, set the configuration parameter **Array Layout** to **Row-Major** option. This configuration parameter enables the model for row-major code generation. Alternatively, in the MATLAB Command Window, enter:

```matlab
set_param(model, 'ArrayLayout', 'Row-major');
```

2. Change your current folder in MATLAB to a writable folder. To generate code, build the model by using **Ctrl+B** or by clicking the **Build Model** button on the toolstrip.

3. In the generated code, observe the table data with row-major array layout. For comparison, here is the table data in the generated code for column-major array layout.

<table>
<thead>
<tr>
<th>2-D Table with row-major array layout</th>
<th>2-D Table with column-major array layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>/* Block parameters (default storage) */</td>
<td>/* Block parameters (default storage) */</td>
</tr>
<tr>
<td>P_rtwdemo_rowlut2d_T rtwdemo_rowlut2d_P = {</td>
<td>P_rtwdemo_rowlut2d_T rtwdemo_rowlut2d_P = {</td>
</tr>
<tr>
<td>/* Variable: Table_3by2 */</td>
<td>/* Variable: Table_3by2 */</td>
</tr>
<tr>
<td>* Referenced by: '&lt;Root&gt;/2-D Lookup Table' */</td>
<td>* Referenced by: '&lt;Root&gt;/2-D Lookup Table' */</td>
</tr>
<tr>
<td>{ 1.0, 4.0, 2.0, 5.0, 3.0, 6.0 }</td>
<td>{ 1.0, 2.0, 3.0, 4.0, 5.0, 6.0 }</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the generated code, the table data is in row-major order and the interpolation algorithm is optimized for row-major array layout. The row-major algorithm operates on table data that is contiguous in memory. This leads to faster cache access, making these algorithms cache-friendly.

This table summarizes the relationship between array layout and cache-friendly algorithms. It is recommended to use the algorithm that is optimized for the specified array layout to achieve good performance. For example, use row-major interpolation algorithm when the array layout is set to **Row-Major** for code generation.
Interpolation on a 3-D Table

1. Open the example model `rtwdemo_row_interpalg`.
   
   ```matlab
   open_system('rtwdemo_row_interpalg');
   ```

2. Generate code for the model by using the preceding procedure. Simulate and generate code from the model by repeating the steps performed on `rtwdemo_row_lut2d` model.
The row-major and column-major interpolations on the 3-D table used in the example model are illustrated here.
close_system('rtwdemo_row_lut2d', 0);
close_system('rtwdemo_row_interpalg', 0);

See Also

Related Examples
- “Code Generation of Matrices and Arrays” on page 21-76
- “Interpolation with Subtable Selection Algorithm for Row-Major Array Layout” on page 17-18
Interpolation with Subtable Selection Algorithm for Row-Major Array Layout

This example illustrates the algorithm for interpolating a subtable that the interpolation block selects from a higher dimension table. The interpolation algorithm with subtable selection is optimized for row-major array layout. As a reference, see the interpolation algorithm with subtable selection that is optimized for column-major array layout. The code generated by using row-major interpolation algorithm performs with the best speed and memory usage when operating on table data with row-major array layout. The code generated by using column-major algorithm performs best with column-major array layout.

In this example, you:

- Interpolate on a selected subtable with column-major and row-major algorithm.
- Preserve block semantics through table permutation.
- Generate code with row-major algorithm and array layout.

**Simulate by Using Row-Major Algorithm**

1. Open example model `rtwdemo_col_interpselsubtable` and `rtwdemo_row_interpselsubtable`.

```matlab
open_system('rtwdemo_col_interpselsubtable');
open_system('rtwdemo_row_interpselsubtable');
```
Interpolation with Subtable Selection Algorithm for Row-Major Array Layout

Column-Major Algorithm

Index search in 3 breakpoints

Index search in 2 breakpoints

Interpolation with sub-table selection on a 3x2x4 table
2. By default, Simulink configures a model with column-major algorithm and column-major array layout. The model `rtwdemo_col_interpselsubtable` is configured to use a column-major algorithm. Run the model and observe the output stored in workspace variable `yout`.

3. To enable row-major algorithms, open the Model Configuration Parameters dialog box. On the Math and Data Types pane, select the configuration parameter **Use algorithms optimized for row-major array layout**. Alternatively, in the MATLAB Command Window, enter:

   ```matlab
   set_param('rtwdemo_col_interpselsubtable','UseRowMajorAlgorithm','on');
   ```

4. Simulate the model and observe the error.
The column-major and row-major algorithms differ in terms of subtable selection and interpolation order. The subtable selection is performed inside the original table. No extra memory is allocated for the subtable. The selected subtable is contiguous in memory. The interpolation order is cache-friendly for column-major algorithms with column-major array layouts and row-major algorithms with row-major array layouts. This illustration compares the row-major and column-major interpolations with subtable selection.
Due to a change in semantics, column-major and row-major interpolations are performed on different subtables or data sets. This interpolation leads to different numeric outputs or an error.

**Preserve Semantics Through Table Permutation**

With subtable selection, the model semantics change when switching from a column-major algorithm to a row-major algorithm. To preserve the semantics or ensure that the same subtable is selected for interpolation, you need to permute the table data. Otherwise, Simulink might report error if it encounters inconsistent breakpoint and table data between prelookup and interpolation blocks.

1. The block `rtwdemo_col_interpselsubtable/Interp` has 3-D table data given as $T3d = \text{reshape}([1:24], 3,2,4)$ and one selection port with input 2 (0-based index). The selected subtable is $T3d(:,:,3)$ (1-based index in MATLAB) for the column-major algorithm. To preserve the semantics for the row-major algorithm on the same model, that is, select the same subtable with same index and selection port inputs, permute the table as $T3d_p = \text{permute}(T3d, [3,1,2])$. The selected subtable is $T3d_p(3,:,:)$ (1-based index) for the row-major algorithm.
T3d_str = get_param('rtwdemo_col_interpselsubtable/Interp','Table');
set_param('rtwdemo_col_interpselsubtable/Interp','Table', ... 
    ['permute(',T3d_str,',[3,1,2])']);

2. When you import table data from a file, you must permute the table data in the file before importing it. This permutation keeps the table tunable throughout the simulation and code generation workflow.

**Generate Code by Using Row-Major Algorithm and Array Layout**

After permuting the table data, model `rtwdemo_col_interpselsubtable` is configured for row-major simulation. The model is equivalent to the preconfigured model `rtwdemo_row_interpselsubtable` that uses a row-major algorithm.

1. To set up the model for row-major code generation, open the Model Configuration Parameters dialog box. In addition to selecting the **Use algorithms optimized for row-major array layout** configuration parameter, on the **Code Generation > Interface** pane, set the configuration parameter **Array Layout** to Row-Major option. This configuration parameter enables the model for row-major code generation. Alternatively, in the MATLAB Command Window, enter:

   set_param('rtwdemo_col_interpselsubtable', 'ArrayLayout','Row-major');

2. In the dialog box, examine the permuted 3-D table data and the selected 2-D subtable.
3. Change your current folder in MATLAB to a writable folder. On the model toolstrip, click **Build model** to generate C code. In the generated code, observe the 2-D interpolation algorithm optimized for row-major data.
static real_T interp2d_1d(const uint32_T bpIndex[], const real_T frac[], const real_T table[], const uint32_T stride, const uint32_T maxIndex[])
{
    real_T y;
    real_T yr_1d;
    uint32_T offset_1d;

    /* Row-major Interpolation 2-D
       Interpolation method: 'Linear point-slope'
       Use last breakpoint for index at or above upper limit: 'on'
       overflow mode: 'wrapping'
    */
    offset_1d = bpIndex[1u] * stride + bpIndex[0u];
    if (bpIndex[0u] == maxIndex[0u]) {
        y = table[offset_1d];
    } else {
        y = (table[offset_1d + 1u] - table[offset_1d]) * frac[0u] + table[offset_1d];
    }

    if (bpIndex[1u] == maxIndex[1u]) {
    } else {
        offset_1d += stride;
        if (bpIndex[0u] == maxIndex[0u]) {
            yr_1d = table[offset_1d];
        } else {
            yr_1d = (table[offset_1d + 1u] - table[offset_1d]) * frac[0u] +
                     table[offset_1d];
        }
    }
    y += (yr_1d - y) * frac[1u];
}
return y;
close_system('rtwdemo_col_interpselsubtable',0);

See Also

Related Examples
•  “Code Generation of Matrices and Arrays” on page 21-76
•  “Interpolation Algorithm for Row-Major Array Layout” on page 17-12
Direct Lookup Table Algorithm for Row-Major Array Layout

This example shows how Simulink selects a vector or a 2-D matrix from table data. In a 2-D table, the output vector can be a column or a row depending on the model configuration setting **Use algorithms optimized for row-major array layout**. In this example, the Direct Lookup Table algorithm is optimized for row-major array layout. The Direct Lookup Table algorithm that is optimized for column-major array layout is also presented as a reference. The code generated by using row-major interpolation algorithm performs with the best speed and memory usage when operating on table data with row-major array layout. The code generated by using column-major algorithm performs best with column-major array layout.

In this example, you:

- Output a vector or a plane by using direct lookup with a column-major or a row-major algorithm.
- Preserve semantics when switching from a column-major algorithm to a row-major algorithm.
- Generate code by using a row-major algorithm and an array layout.

**Simulate by Using Row-Major Algorithm — Output a Vector from 3-D Table**

Open example models `rtwdemo_row_dlut3d_selvector` and `rtwdemo_col_dlut3d_selvector`.

```matlab
open_system('rtwdemo_row_dlut3d_selvector');
open_system('rtwdemo_col_dlut3d_selvector');
```

![Row-Major Algorithm](image)
1. By default, Simulink configures a model with column-major algorithm and column-major array layout. The model `rtwdemo_col_dlut3d_selvector` is preconfigured to use column-major algorithms. Simulate the model and observe the output stored in workspace variable `yout`.

2. To enable row-major algorithms, open the Model Configuration Parameters dialog box. On the Math and Data Types pane, select the configuration parameter **Use algorithms optimized for row-major array layout**. Alternatively, in the MATLAB Command Window, enter:

   ```matlab
   set_param('rtwdemo_col_dlut3d_selvector','UseRowMajorAlgorithm','on');
   ```

3. Click **Run** to simulate the model. Observe the change in output dimension and numeric values logged in workspace variable `yout`.

The column-major and row-major algorithms differ semantically in the selection of output vector. For example, in a 2-D table, Simulink selects a column vector as output for column-major algorithm and a row vector for row-major algorithm. In a table with a 3-D or higher dimension, Simulink selects the output vector from the first dimension of the table for a column-major algorithm and from the last dimension of the table for a row-major algorithm. The elements of the selected vector are contiguous in the table storage memory. In this example, the last dimension is the third dimension of the 3-D table. Due to semantic change, column-major and row-major direct lookup table algorithms output different vector size and numeric values.

These illustrations compare the vector output of row-major and column-major direct lookup table algorithms in a 3-D table.
Direct Lookup Table Algorithm for Row-Major Array Layout

Row-major Direct lookup – select a vector from 3D table
Preserve Semantics by Using Table Permutation

For a direct lookup table that outputs a vector or 2-D matrix, the model semantics change when you switch from a column-major algorithm to a row-major algorithm. To preserve the semantics or ensure the same output given the same block I/O connections, you must permute the table data. Otherwise, Simulink propagates incorrect dimensions to downstream blocks.

1. The block rtwdemo_col_dlut3d_selvector/Direct Lookup Table (n-D) has 3-D table data $T_{3d} = \text{reshape}([1:24], 3,2,4)$ and two input ports with value 0 and 1 (both are 0-based indices). The selected output vector is $T_{3d}(;,1,2)$ (1-based index) for a column-major algorithm. To preserve the semantics for a row-major algorithm on the same model, that is, select the same vector with same index port inputs, permute the table as $T_{3d_p} = \text{permute}(T_{3d}, [2,3,1])$. For a row-major algorithm, the selected vector is $T_{3d_p}(1,2,:)$.

```matlab
T3d_str = get_param('rtwdemo_col_dlut3d_selvector/Direct Lookup Table (n-D)','Table');
set_param('rtwdemo_col_dlut3d_selvector/Direct Lookup Table (n-D)','Table',...['permute(','T3d_str,',[2,3,1])']);
```
2. When you import table data from a file, you must permute the table data in the file before importing it. This permutation keeps the table tunable throughout the simulation and code generation workflow.

**Code Generation by Using Row-Major Algorithm and Array Layout**

After permuting the table data, Simulink configures the model \texttt{rtwdemo\_col\_dlut3d\_selvector} for row-major simulation. The model is equivalent to the preconfigured model \texttt{rtwdemo\_row\_dlut3d\_selvector} that has permuted table data and uses a row-major algorithm.

**1.** To set up these models for row-major code generation, open the Model Configuration Parameters dialog box. In addition to enabling the Use algorithms optimized for row-major array layout configuration parameter, on the Code Generation > Interface pane, set the configuration parameter Array Layout to the Row-Major option. This configuration parameter enables the model for row-major code generation. Alternatively, in the MATLAB Command Window, enter:

```matlab
% For model 'rtwdemo\_col\_dlut3d\_selvector'
set_param('rtwdemo\_col\_dlut3d\_selvector', 'ArrayLayout','Row-major');
% For model 'rtwdemo\_row\_dlut3d\_selvector'
set_param('rtwdemo\_row\_dlut3d\_selvector', 'ArrayLayout','Row-major');
```

**2.** In the Direct Lookup Table (n-D) block dialog box, examine the permuted 3-D table data.
3. Change your current folder in MATLAB to a writable folder. On the model toolstrip, click **Build model** to generate C code. In the generated code, the `memcpy` function replaces the `for` loops. Using `memcpy` reduces the amount of memory for storing data. This optimization improves execution speed.
Simulate by Using Row-Major Algorithm — Output a Plane from 3-D Table

```c
void rtwdemo_row_dlut3d_selvector_step(void)
{
    /* Outport: '<Root>/Out2' incorporates:
       * LookupNDDirect: '<Root>/Direct Lookup Table (n-D)'
       * About '<Root>/Direct Lookup Table (n-D)':
       * 3-dimensional Direct Look-Up returning a Vector,
       * which is contiguous for row-major array
       */

    memcpy(&rtY.Out2[0], &rtCP_DirectLookupTablenD_table[3], 3U * sizeof(real_T));
}
```

**Row-Major Algorithm**

![Diagram showing 3-D table and selecting a plane](image)

Copyright 2018 The MathWorks, Inc.
1. Open the example model `rtwdemo_row_dlut3d_selplane` that outputs a plane or 2-D matrix from a 3-D table.

2. Simulate and generate code from the model by repeating the steps performed on `rtwdemo_col_dlut3d_selvector`. The row-major and column-major direct lookup algorithms that output a 2-D matrix from a 3-D table are illustrated here.
close_system('rtwdemo_row_dlut3d_selvector',0);
close_system('rtwdemo_col_dlut3d_selvector',0);
close_system('rtwdemo_row_dlut3d_selplane',0);
close_system('rtwdemo_col_dlut3d_selplane',0);

See Also

Related Examples

- “Code Generation of Matrices and Arrays” on page 21-76
- “Interpolation Algorithm for Row-Major Array Layout” on page 17-12
Generate Row-Major Code for S-Functions

Starting in R2018b, you can generate row-major code for models that contain S-functions. By default, the code generator generates column-major code. To learn more about row-major code generation, see “Code Generation of Matrices and Arrays” on page 21-76.

For an existing model that contains S-functions, when you set the configuration parameter **Array layout** as **Row-major**, the configuration parameter **External functions compatibility for row-major code generation** is enabled and set to **error** by default. When you try to build the existing model, you get an error because the S-functions are not enabled for row-major code generation by default. You can test the compatibility of your S-function for row-major code generation by using the **External functions compatibility for row-major code generation** configuration parameter.

This workflow is applicable to C Caller blocks in the model.

For example, consider this example model.

1. The model *sfun_simple_unset* is a simple model that contains S-function *sfnc_simple_rowmajor_unset*.

   ![reshape(1:25,[5,5])](image)

2. To enable row-major code generation, set **Array layout** to **Row-major**.
3. When you build the model, the code generator terminates the build and you see this error message:

   ```
   S-function "sfnc_simple_rowmajor_unset" with SSArrayLayout set to 'SS_UNSET' does not support row major code generation. To test this S-function, set the configuration parameter 'External functions compatibility for row-major code generation' to 'warning' or 'none'.
   Component: Simulink | Category: Block diagram error
   ```

4. To proceed, do one of the following:
   - If you want to test your existing S-functions with the row-major code for the model, change the setting of the configuration parameter **External functions compatibility for row-major code generation** to **warning** or **none**. The code
generator completes the build without generating row-major code for the S-functions.

- If you want to update your S-functions so that they are compatible with row-major array layout, use the S-function API to enable the S-function for row-major code generation.

To test your model for any S-functions with unspecified array layout, you can also run the Model Advisor checks on the model. Select the Identify TLC S-functions with unset array layout check and click the Run This Check button. If there are any S-functions in the model with unspecified array layout, you see a warning such as:

![Identify TLC S-Functions with unset array layout](image)

To specify the array layout of the user-defined S-function, use the `ssSetArrayLayoutForCodeGen` function of the SimStruct API. You can set the enumerated type `SSArrayLayout` to:

- **SS_UNSET** - This setting is the default setting that disables the block for row-major code generation.
- **SS_COLUMN_MAJOR** - Specify the block for column-major code generation only.
- **SS_ROW_MAJOR** - Specify the block for row-major code generation only.
• **SS\_ALL** - Specify the block as allowed for code generation with any array layout.

5 Update the `sfcn_simple_rowmajor_unset.c` file by adding the `ssSetArrayLayoutForCodeGen` in the `mdlInitializeSizes` method:

```c
static void mdlInitializeSizes(SimStruct *S)
{
    ssSetArrayLayoutForCodeGen(S, SS_ROW_MAJOR);

    [... other initialization code ...]
}
```

If your S-function is not affected by any array layout, set `SSArrayLayout` to `SS\_ALL`.

6 Compile the S-function by using this command in the MATLAB Command Window:

```bash
mex sfcn_simple_rowmajor_unset.c
```

7 Build the model.

If you generate S-functions by using S-Function Builder, use the parameter **Array layout** to specify the majority of the S-function. For more information, see “S-Function Builder Dialog Box” (Simulink). If you use the Legacy Code Tool to integrate C functions, use the `convertNDArrayToRowMajor` option in `legacy_code`. The S-Function Builder and Legacy Code Tool apply preceding transposes when the S-function is set to row-major array layout during simulation in normal mode.

**See Also**

**Related Examples**

• “Integrate C Code Using C Caller Blocks“ (Simulink)
Code Generation
Configuration for Simulink Coder

- “Code Generation Configuration” on page 18-2
- “Configure Code Generation Parameters for Model Programmatically” on page 18-5
- “Configure Model from Command Line” on page 18-7
- “Use Configuration Reference to Select Code Generation Target” on page 18-13
- “Check Model and Configuration for Code Generation” on page 18-19
- “Application Objectives Using Code Generation Advisor” on page 18-22
- “Simulink Coder Model Advisor Checks for Standards and Code Efficiency” on page 18-26
- “Configure Code Comments” on page 18-28
- “Include MATLAB Code as Comments in Generated Code” on page 18-30
- “Construction of Generated Identifiers” on page 18-35
- “Identifier Name Collisions and Mangling” on page 18-36
- “Specify Identifier Length to Avoid Naming Collisions” on page 18-37
- “Specify Reserved Names for Generated Identifiers” on page 18-38
- “Reserved Keywords” on page 18-39
- “Debug” on page 18-43
Code Generation Configuration

When you are ready to generate code for a model, you can modify the model configuration parameters specific to code generation. The code generation parameters determine how the code generator produces code and builds an executable program from your model.

The model configuration parameters for code generation are in the Code Generation and Optimization panes in the Configuration Parameters dialog box. The content of the Code Generation pane and its subpanes can change depending on the target that you specify. Some configuration options are available only with the Embedded Coder product. The Optimization pane includes code generation parameters that help to improve the performance of the generated code.

Your application objectives can include a combination of these code generation objectives: debugging, traceability, execution efficiency, and safety precaution. There are tradeoffs associated with these configuration choices, such as execution speed and memory usage. To help configure a model to achieve your application objectives, use the Model Advisor and the Code Generation Advisor.

Open the Model Configuration for Code Generation

To modify the model configuration parameters for code generation, open the Code Generation pane. There are several different ways to open the Code Generation pane from the Simulink editor:

- To open the Configuration Parameters dialog box, click the model configuration parameters icon.

Then click Code Generation in the Select (left) pane.

- From the Simulation menu, select Model Configuration Parameters. When the Configuration Parameters dialog box opens, click Code Generation in the Select (left) pane.

- From the Code menu, select C/C++ Code > Code Generation Options.

- From the View menu in the model window, select Model Explorer, or from the MATLAB command line, type daexplr and press Enter. In the Model Explorer, expand the node for the current model in the left pane and click Configuration
(active). Click elements in the middle pane to display the corresponding parameters in the right pane.

**Note** In a Configuration Parameters dialog box, when you change the value of a check box, menu selection, or edit field, the white background of the element changes color to indicate that you made an unsaved change. When you click **OK, Cancel**, or **Apply**, the background resets to white.

### Configuration Tools

To help you configure your model for code generation and to check your configuration against your code generation objectives, Simulink Coder and Embedded Coder provide several tools.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Approach</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automate configuration.</td>
<td>At the MATLAB command line, use the <code>set_param</code> function</td>
<td>“Configure Code Generation Parameters for Model Programmatically” on page 18-5</td>
</tr>
<tr>
<td>Configure your model for code generation quickly and easily (Embedded Coder).</td>
<td>Embedded Coder Quick Start tool</td>
<td>“Generate Code by Using the Quick Start Tool” (Embedded Coder)</td>
</tr>
</tbody>
</table>
| Use a template to create a model configured for code generation, ready for you to add your own blocks. | Code generation templates | • “Generate Code and Simulate Models in a Simulink Project”  
• “Generate Code and Simulate Models in a Simulink Project” (Embedded Coder) |
<p>| To configure your model for code generation, use Simulink blocks and predefined or custom MATLAB scripts. | Code Generation Wizards blocks | “Configure and Optimize Model with Configuration Wizard Blocks” (Embedded Coder) |</p>
<table>
<thead>
<tr>
<th>Goal</th>
<th>Approach</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verify that your model meets standards and guidelines.</td>
<td>Model Advisor</td>
<td>“Select and Run Model Advisor Checks” (Simulink)</td>
</tr>
<tr>
<td>Verify that your model meets your application objectives.</td>
<td>Code Generation Advisor</td>
<td>“Application Objectives Using Code Generation Advisor” on page 18-22</td>
</tr>
</tbody>
</table>

**See Also**

**Related Examples**

- “Configuration Reuse” (Simulink)
- “Configure Code Generation Parameters for Model Programmatically” on page 18-5
- “Application Objectives Using Code Generation Advisor” on page 18-22
Configure Code Generation Parameters for Model Programmatically

You can modify code generation parameters for the active configuration set in the Configuration Parameters dialog box or from the MATLAB command line. Use the command-line approach for creating a script that automates setting parameters for an established model configuration.

Modify Parameters to Support Execution efficiency

In this example, you modify the configuration parameters to support the Code Generation Advisor application objective, Execution efficiency.

Step 1. Open a model.

slexAircraftExample

Step 2. Get the active configuration set.

cs = getActiveConfigSet(model);

Step 3. Select the Generic Real-Time (GRT) target.

switchTarget(cs,'grt.tlc',[]);

Step 4. To optimize execution speed, modify parameters.

If your application objective is Execution efficiency, use set_param to modify these parameters:

```matlab
set_param(cs,'MatFileLogging','off');
set_param(cs,'SupportNonFinite','off');
set_param(cs,'RTWCompilerOptimization','on');
set_param(cs,'OptimizeBlockIOStorage','on');
set_param(cs,'EnhancedBackFolding','on');
set_param(cs,'ConditionallyExecuteInputs','on');
set_param(cs,'DefaultParameterBehavior','Inlined');
set_param(cs,'BooleanDataType','on');
set_param(cs,'BlockReduction','on');
set_param(cs,'ExpressionFolding','on');
set_param(cs,'LocalBlockOutputs','on');
set_param(cs,'EfficientFloat2IntCast','on');
set_param(cs,'BufferReuse','on');
```
Step 5. Save the model configuration to a file.

Save the model configuration to a file, 'Exec_efficiency_cs.m', and view the parameter settings.

saveAs(cs,'Exec_Efficiency_cs');
dbtype Exec_Efficiency_cs 1:50

See Also

More About
• “Code Generation Configuration” on page 18-2
• “Application Objectives Using Code Generation Advisor” on page 18-22
Configure Model from Command Line

The code generator provides model configuration parameters for customizing generated code. Depending on how you use and interact with the generated code, you make configuration decisions. You choose a configuration that best matches your needs for debugging, traceability, code efficiency, and safety precaution.

It is common to automate the model configuration process by using a MATLAB® script once you have decided upon a desired configuration.

The example describes:

- Concepts of working with configuration parameters
- Documentation to understand the code generation options
- Tools and scripts to automate the configuration of a model

Configuration Parameter Workflows

There are many workflows for Configuration Parameters that include persistence within a single model or persistence across multiple models. Depending on your needs, you can work with configuration sets as copies or references. This example shows the basics steps for working directly with the active configuration set of a model. For a comprehensive description of configuration set features and workflows, see Configuration Sets in the Simulink® documentation.

Configuration Set Basics

Load a model into memory.

```matlab
model='rtwdemo_configwizard';
load_system(model)
```

Obtain the model's active configuration set.

```matlab
cs = getActiveConfigSet(model);
```

Simulink® Coder™ exposes a subset of the code generation options. If you are using Simulink® Coder™, select the Generic Real-Time (GRT) target.

```matlab
switchTarget(cs,'grt.tlc',[]);
```

Embedded Coder® exposes the complete set of code generation options. If you are using Embedded Coder®, select the Embedded Real-Time (ERT) target.

```matlab
switchTarget(cs,'ert.tlc',[]);
```
To automate configuration of models built for GRT- and ERT-based targets, the configuration set `IsERTTarget` attribute is useful.

```matlab
isERT = strcmp(get_param(cs,'IsERTTarget'),'on');
```

You can interact with code generation options via the model or the configuration set. This example gets and sets options indirectly via the model.

```matlab
defParamBehvr = get_param(model,'DefaultParameterBehavior'); % Get
set_param(model,'DefaultParameterBehavior',deftParamBehvr) % Set
```

This example gets and sets options directly via the configuration set.

```matlab
if isERT
    lifespan = get_param(cs,'LifeSpan'); % Get LifeSpan
    set_param(cs,'LifeSpan',lifespan) % Set LifeSpan
end
```

**Configuration Option Summary**

The full list of code generation options are documented with tradeoffs for debugging, traceability, code efficiency, and safety precaution.

- Simulink® Coder™ options
- Embedded Coder® options

Use Code Generation Advisor to obtain a model configuration optimized for your goals. In the Set Objectives dialog box, you can set and prioritize objectives.
You can find documentation about the Code Generation Advisor in the Simulink Coder documentation and additional documentation specific to Embedded Coder®.

**Parameter Configuration Scripts**

Simulink® Coder™ provides an example configuration script that you can use as a starting point for your application. A list of the most relevant GRT and ERT code generation options are contained in rtwconfiguremodel.m.

Alternatively, you can generate a MATLAB function that contains the complete list of model configuration parameters by using the configuration set saveAs function.

```matlab
% Go to a temporary writable directory.
currentDir = pwd;
rtwdemodir();

% Save the model's configuration parameters to file 'MyConfig.m'.
saveAs(cs,'MyConfig')

% Display the first 50 lines of MyConfig.m.
dbtype MyConfig 1:50

function cs = MyConfig()
% MATLAB function for configuration set generated on 27-Aug-2018 19:49:59
% MATLAB version: 9.5.0.942161 (R2018b)

  cs = Simulink.ConfigSet;

  % Original configuration set version: 1.18.1
  if cs.versionCompare('1.18.1') < 0
    error('Simulink:MFileVersionViolation', 'The version of the target configuration set is older than the original configuration set.');
  end

  % Original environment character encoding: windows-1252
  if ~strcmpi(get_param(0, 'CharacterEncoding'), 'windows-1252')
    warning('Simulink:EncodingUnMatched', 'The target character encoding (%s) is different from the original (%s).', get_param(0, 'CharacterEncoding'), 'windows-1252');
  end

  % Do not change the order of the following commands. There are dependencies between the parameters.
  cs.set_param('Name', 'Configuration'); % Name
  cs.set_param('Description', ''); % Description

  % Original configuration set target is ert.tlc
```

18-9
Each parameter setting in the generated file includes a comment for the corresponding parameter string in the Configuration Parameters dialog box.

% Return to previous working directory.
cd(currentDir)

**Configuration Wizard Blocks**

Embedded Coder® provides a set of Configuration Wizard blocks to obtain an initial configuration of a model for a specific goal. The predefined blocks provide configuration for:

- ERT optimized for fixed point
- ERT optimized for floating point
• GRT optimized for fixed and floating point
• GRT debug settings for fixed and floating point
• Custom (you provide the script)

Put the block into a model and double-click it to configure the model. Open model rtwdemo_configwizard and click Open Configuration Wizard Library to interact with the blocks.

open_system(model)

To use configuration wizard blocks in the rtwdemo_configwizard model follow these steps:

• Open the Configuration Wizard Library by clicking the link provided in the model.
• Open the Model's Configuration Parameters by clicking the link provided in the model.
• Drag and drop a Configuration Wizard Block, for example ERT (optimized for fixed point), from the wizard library into the model.
• Double-click the wizard block.

The Configuration Parameter options are modified automatically.

% cleanup
rtwdemoclean;
close_system(model,0)

Summary

Simulink provides a rich set of MATLAB functions to automate the configuring a model for simulation and code generation. Simulink Coder and Embedded Coder® provide
additional functionality specific for code generation. The Code Generation Advisor optimizes the model configuration based on a set of prioritized goals. You can save the optimal configuration to a MATLAB file by using the configuration set saveAs function, and reuse it across models and projects.

See Also

More About
• “Code Generation Configuration” on page 18-2
• “Application Objectives Using Code Generation Advisor” on page 18-22
Use Configuration Reference to Select Code Generation Target

This example shows how to use a configuration reference to select a code generation target for a model reference hierarchy without modifying individual models.

**Open Example Model**

Open the example model `slexConfigSetRefExample`.

```
open_system('slexConfigSetRefExample');
```

**Sharing and Switching Configurations with Configuration Reference**

This model and its referenced model use the same configuration set stored in data dictionary.

To open the active configuration set for the model `slexConfigSetRefExample`, from the model editor menu, select **Simulation > Model Configuration Parameters**.
Because the model is using a referenced configuration, the Configuration Reference dialog box opens and displays a read-only view of the referenced configuration set. Information at the top of the dialog box indicates that the model is using the configuration set, Reference, located in the data dictionary, slexConfigSetRefData.sldd. In this example, Reference is another configuration reference, Configuration_ETRT.

In the model editor, double-click the Model block, Amplifier.

```matlab
open_system('slexConfigSetRefExample/Amplifier');
```
Sharing and Switching Configurations with Configuration Reference

This model and its parent model use the same configuration set stored in data dictionary.

Open the active configuration set for this model. The name and location for the referenced configuration is the same as in slexConfigSetRefExample.
Open the Referenced Configuration Set

If you need to change and apply parameter values in the configuration set, open Configuration_ERT for edit in the Configuration Parameters dialog box by clicking the Model Configuration Parameters icon at the top of either of the Configuration Reference dialog boxes.

Generate Code for ERT Target

The referenced configuration set is customized for ERT code generation. To generate code, press Ctrl+B.
rtwbuild('slexConfigSetRefExample');

### Starting build procedure for model: slexConfigSetRefMdlRef
### Successful completion of code generation for model: slexConfigSetRefMdlRef
### Starting build procedure for model: slexConfigSetRefExample
### Successful completion of code generation for model: slexConfigSetRefExample

The code generation report displays once code generation is complete.

**Switch Targets and Generate Code for AUTOSAR Target**

For this model there is another configuration set, Configuration AUTOSAR, that is customized for AUTOSAR code generation. At the top of the Configuration Reference dialog box, in the rightmost drop-down list, select Configuration_AUTOSAR. slexConfigSetRefExample and its referenced model, slexConfigSetMdlRef, now both use the configuration set, Configuration_AUTOSAR.

Because you edited the configuration reference, the data dictionary has unsaved changes. The configurations are stored outside of the models so the models do not have unsaved changes.
If you have downloaded the AUTOSAR package, you can now generate code for an AUTOSAR target. In the model editor window, press Ctrl+B.
Check Model and Configuration for Code Generation

You can use the Model Advisor checks to assess model readiness to generate code. To check and configure your model for code generation application objectives such as traceability or debugging, use the Code Generation Advisor.

<table>
<thead>
<tr>
<th>For information about</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model Advisor</td>
<td>“Run Model Checks” (Simulink)</td>
</tr>
<tr>
<td>Code Generation Advisor</td>
<td>“Application Objectives Using Code Generation Advisor” on page 18-22</td>
</tr>
<tr>
<td>Checks available with Simulink Coder</td>
<td>“Simulink Coder Checks”</td>
</tr>
<tr>
<td>Checks available with Embedded Coder</td>
<td>“Embedded Coder Checks” (Embedded Coder)</td>
</tr>
</tbody>
</table>

Check Mode for Code Efficiency with Model Advisor

To check model rtwdemo_throttlecntrl for code efficiency, use the Model Advisor.

1. Open rtwdemo_throttlecntrl. Save a copy as throttlecntrl in a writable location on your MATLAB path.
2. To start the Model Advisor, select Analysis > Model Advisor > Model Advisor. A dialog box opens showing the model system hierarchy.
3. Click throttlecntrl and then click OK. The Model Advisor window opens.
4. Expand By Task > Code Generation Efficiency. To check your model for code generation efficiency, use the checks in the folder. By default, checks that do not trigger an Update Diagram are selected. The checks available for code generation efficiency depend on whether you have a Simulink Coder or Embedded Coder license.
5. In the left pane, select the remaining checks, and then select Code Generation Efficiency.
6. In the right pane, select Show report after run and click Run Selected Checks. The report shows a Run Summary that flags check warnings.
7. Review the report. The warnings highlight issues that impact code efficiency. For more information about the report, see “View Model Advisor Reports” (Simulink).
Check Model During Code Generation with Code Generation Advisor

To review a model as part of the code generation process, use the Code Generation Advisor.

1. To specify your code generation objectives, on the Configuration Parameters > Code Generation pane, choose a value for the Select objective parameter.

2. On the Configuration Parameters > Code Generation > General pane, select one of the following from Check model before generating code:
   - On (proceed with warnings)
   - On (stop for warnings)

3. If you want to only generate code, select Generate code only. Otherwise clear the check box to build an executable.

4. Apply your changes, and then click Generate Code/Build. The Code Generation Advisor starts and reviews the top model and subsystems.

   If the Code Generation Advisor issues failures or warnings, and you specified:
   - On (proceed with warnings) — The Code Generation Advisor window opens while the build process proceeds. After the build process is complete, you can review the results.
   - On (stop for warnings) — The build process halts and displays the Diagnostic Viewer. To continue, you must review and resolve the Code Generation Advisor results or clear the Check model before generating code parameter.

5. In the Code Generation Advisor window, review the results by selecting a check from the left pane. The results for that check display in the right pane.

6. After reviewing the check results, you can choose to fix warnings and failures as described in “Fix a Model Check Warning or Failure” (Simulink).

**Note** When you specify an efficiency or Safety precaution objective, the Code Generation Advisor includes additional checks. When you make changes to one of these additional checks, previous check results can potentially become invalid and need to be rerun.

For more information, see “Set Objectives — Code Generation Advisor Dialog Box”
See Also

Related Examples

• “Select and Run Model Advisor Checks” (Simulink)
• “Application Objectives Using Code Generation Advisor” on page 18-22
Application Objectives Using Code Generation Advisor

In this section...

“High-Level Code Generation Objectives” on page 18-23
“Configure Model for Code Generation Objectives Using Code Generation Advisor” on page 18-23
“Configure Model for Code Generation Objectives by Using Configuration Parameters Dialog Box” on page 18-25

Consider how your application objectives, such as efficiency, traceability, and safety, map to code generation options in a model configuration set. Parameters that you set in the Solver, Data Import/Export, Diagnostics, and Code Generation panes in the Configuration Parameters dialog box specify the behavior of a model in simulation and the code generated for the model.

Before generating code, or as part of the code generation process, you can use the Code Generation Advisor to review a model. When you choose to review a model before generating code, you specify which model, subsystem, or referenced model the Code Generation Advisor reviews. When you choose to review a model as part of the code generation process, the Code Generation Advisor reviews the entire system. The Code Generation Advisor uses the information presented in “Recommended Settings Summary for Model Configuration Parameters” (Embedded Coder) to determine the parameter values that meet your objectives. When there is a conflict between multiple objectives, the higher-priority objective takes precedence.

Setting code generation objectives, and then running the Code Generation Advisor provides information on how to meet code generation objectives for your model. The Code Generation Advisor does not alter the generated code. You can use the Code Generation Advisor to make the suggested changes to your model. The generated code is changed only after you modify your model and regenerate code. When you use the Code Generation Advisor to set code generation objectives and check your model, the generated code includes comments identifying which objectives you specified, the checks the Code Generation Advisor ran on the model, and the results of running the checks.

If a model uses a configuration reference (Simulink), you can run the Code Generation Advisor to review your configuration parameter settings. However, the Code Generation Advisor cannot modify the configuration parameter settings.
High-Level Code Generation Objectives

Depending on the type of application that your model represents, you are likely to have specific high-level code generation objectives. For example, safety and traceability might be more critical than efficient use of memory. If you have specific objectives, you can quickly configure your model to meet those objectives by selecting and prioritizing from these code generation objectives:

- **Execution efficiency (all targets)** — Configure code generation settings to achieve fast execution time.
- **ROM efficiency (ERT-based targets)** — Configure code generation settings to reduce ROM usage.
- **RAM efficiency (ERT-based targets)** — Configure code generation settings to reduce RAM usage.
- **Traceability (ERT-based targets)** — Configure code generation settings to provide mapping between model elements and code.
- **Safety precaution (ERT-based targets)** — Configure code generation settings to increase clarity, determinism, robustness, and verifiability of the code.
- **Debugging (all targets)** — Configure code generation settings to debug the code generation build process.
- **MISRA C:2012 guidelines (ERT-based targets)** — Configure code generation settings to increase compliance with MISRA C:2012 guidelines.
- **Polyspace (ERT-based targets)** — Configure code generation settings to prepare the code for Polyspace analysis.

If you select the MISRA C:2012 guidelines code generation objective, the Code Generation Advisor:

- Checks the model configuration settings for compliance with the MISRA C:2012 configuration setting recommendations.
- Checks for blocks that are not supported or recommended for MISRA C:2012 compliant code generation.

Configure Model for Code Generation Objectives Using Code Generation Advisor

This example shows how to use the Code Generation Advisor to check and configure your model to meet code generation objectives:
1 On the menu bar, select **Code > C/C++ Code > Code Generation Advisor**.
2 In the System Selector window, select the model or subsystem that you want to review, and then click **OK**.
3 In the Code Generation Advisor, on the **Code Generation Objectives** pane, select the code generation objectives from the drop-down list (GRT-based targets). As you select objectives, on the left pane, the Code Generation Advisor updates the list of checks it will run on your model. If your model is configured with an ERT-based target, more objectives are available.
4 Click **Run Selected Checks** to run the checks listed in the left pane of the Code Generation Advisor.
5 In the Code Generation Advisor window, review the results for **Check model configuration settings against code generation objectives** by selecting it from the left pane. The results for that check are displayed in the right pane.

**Check model configuration settings against code generation objectives** triggers a warning for these issues:

- Parameters are set to values other than the value recommended for the specified code generation objectives.
- Selected code generation objectives differ from the objectives set in the model.

Click **Modify Parameters** to set:

- Parameters to the value recommended for the specified code generation objectives.
- Code generation objectives in the model to the objectives specified in the Code Generation Advisor.

6 In the Code Generation Advisor window, review the results for the remaining checks by selecting them from the left pane. The results for the checks display in the right pane.
7 After reviewing the check results, you can choose to fix warnings and failures, as described in “Fix a Model Check Warning or Failure” (Simulink).

When you specify an efficiency or Safety precaution objective, the Code Generation Advisor includes additional checks. When you make changes to one of these additional checks, previous check results can potentially become invalid and need to be rerun.
Configure Model for Code Generation Objectives by Using Configuration Parameters Dialog Box

This example shows how to check and configure the code generation objectives in the Configuration Parameters dialog box:

1. Open the Configuration Parameters dialog box and select **Code Generation**.
2. Select or confirm selection of a System target file.
3. Specify the objectives using the **Select objectives** drop-down list (GRT-based targets) or clicking **Set Objectives** button (ERT-based targets). Clicking **Set Objectives** opens the “Set Objectives — Code Generation Advisor Dialog Box” dialog box.
4. Click **Check Model** to run the model checks. The Code Generation Advisor dialog box opens. The Code Generation Advisor uses the code generation objectives to determine which model checks to run.
5. On the left pane, the Code Generation Advisor lists the checks run on the model and the results. Click each warning to see the suggestions for changes that you can make to your model to pass the check.
6. Determine which changes to make to your model. On the right pane of the Code Generation Advisor, follow the instructions listed for each check to modify the model.
Simulink Coder Model Advisor Checks for Standards and Code Efficiency

To check that your model meets standards and is ready to generate code, you can use the Model Advisor checks available with Simulink Coder.

- To start the Model Advisor, in the model window, select **Analysis > Model Advisor > Model Advisor**.
- In the Model Advisor window, expand the **By Task** folder. The folder contains Model Advisor checks that you can run to help accomplish the task.

For more information about the Model Advisor, see “Run Model Checks” (Simulink).

The table summarizes the Simulink Coder Model Advisor checks that are available in the **By Task** folders.

<table>
<thead>
<tr>
<th>By Task folder</th>
<th>Model Advisor checks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Code Generation Efficiency</strong></td>
<td>“Identify blocks using one-based indexing”</td>
</tr>
<tr>
<td><strong>Modeling Standards for DO-178C/DO-331</strong></td>
<td>“Check solver for code generation”</td>
</tr>
<tr>
<td></td>
<td>“Check for blocks that have constraints on tunable parameters”</td>
</tr>
<tr>
<td></td>
<td>“Check sample times and tasking mode”</td>
</tr>
<tr>
<td><strong>Model Referencing</strong></td>
<td>“Check for model reference configuration mismatch”</td>
</tr>
<tr>
<td></td>
<td>“Check for code generation identifier formats used for model reference”</td>
</tr>
</tbody>
</table>

**See Also**

**Related Examples**

- “Select and Run Model Advisor Checks” (Simulink)
- “Embedded Coder Model Advisor Checks for Standards, Guidelines, and Code Efficiency” (Embedded Coder)
• “Modeling Guidelines for Model Configuration” on page 2-45
Configure Code Comments

Configure how the code generator inserts comments into generated code by modifying parameters on the Code Generation > Comments pane.

<table>
<thead>
<tr>
<th>Goal</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include comments in generated code</td>
<td>Include comments. Selecting this parameter allows you to select one or more autogenerated comment types to be placed in the code.</td>
</tr>
<tr>
<td>Include comments that describe a Simulink block's code</td>
<td>Simulink block comments. Selecting this parameter includes the comments before the Simulink block’s code in the generated code. In Embedded Coder, use Trace to model using to select Block path or Simulink identifier as the comment format.</td>
</tr>
<tr>
<td>Include comments that describe Stateflow objects</td>
<td>Stateflow object comments. Selecting this parameter includes the comments describing Stateflow objects in the generated code. In Embedded Coder, use Trace to model using to select Block path or Simulink identifier as the comment format.</td>
</tr>
<tr>
<td>Include MATLAB source code as comments</td>
<td>MATLAB source code as comments. Selecting this parameter inserts these comments preceding the associated generated code. The function signature is included in the function banner.</td>
</tr>
<tr>
<td>Include comments for eliminated blocks</td>
<td>Show eliminated blocks. Selecting this parameter includes comments for blocks that were eliminated as the result of optimizations, such as inlining parameters.</td>
</tr>
<tr>
<td>Include parameter comments regardless of the number of parameters</td>
<td>Verbose comments for SimulinkGlobal storage class. Selecting this parameter includes comments for parameter variable names and names of source blocks in the model parameter structure declaration in model_prm.h. If you do not select this parameter, parameter comments are generated if less than 1000 parameters are declared. This reduces the size of the generated file for models with a large number of parameters.</td>
</tr>
<tr>
<td>Include MATLAB user comments</td>
<td>MATLAB user comments. Selecting this parameter includes function description comments and other user comments from MATLAB code as comments in the generated code.</td>
</tr>
<tr>
<td>Specify comment style</td>
<td>Comment style. Select Auto, Multi-line or Single-line as the style of comments in the generated code.</td>
</tr>
</tbody>
</table>
**Note** When you configure the code generator to produce code that includes comments, the code generator includes text for model parameters, block names, signal names, and Stateflow object names in the generated code comments. If the text includes characters that are unrepresented in the character set encoding for the model, the code generator replaces the characters with XML escape sequences. For example, the code generator replaces the Japanese full-width Katakana letter 気持ち with the escape sequence `&#{x30A2};`. For more information, see “Internationalization and Code Generation” on page 20-2.
Include MATLAB Code as Comments in Generated Code

If you have a Simulink Coder license, you can include MATLAB source code as comments in the code generated for a MATLAB Function block. Including this information in the generated code enables you to:

• Correlate the generated code with your source code.
• Understand how the generated code implements your algorithm.
• Evaluate the quality of the generated code.

When you select MATLAB source code as comments parameter, the generated code includes:

• The source code as a comment immediately after the traceability tag. When you enable traceability and generate code for ERT targets (requires an Embedded Coder license), the traceability tags are hyperlinks to the source code. For more information on traceability for the MATLAB Function block, see “Use Traceability in MATLAB Function Blocks” (Embedded Coder).

For examples and information on the location of the comments in the generated code, see “Location of Comments in Generated Code” on page 18-31.

• The function help text in the function body in the generated code. The function help text is the first comment after the MATLAB function signature. It provides information about the capabilities of the function and how to use it.

Note With an Embedded Coder license, you can also include the function help text in the function banner of the generated code. For more information, see “Including MATLAB user comments in Generated Code” on page 18-33.

How to Include MATLAB Code as Comments in the Generated Code

To include MATLAB source code as comments in the code generated for a MATLAB Function block:

1 In the model, select Simulation > Model Configuration Parameters.
2 In the Code Generation > Comments pane, select MATLAB source code as comments and click Apply.
Location of Comments in Generated Code

The automatically generated comments containing the source code appear after the traceability tag in the generated code as follows.

/* '<S2>:1:18' for y = 1 : 2 : (HEIGHT-4) */

Selecting the Stateflow object comments parameter generates the traceability comment ' <S2>:1:18 '. Selecting the MATLAB source code as comments parameter generates the for y = 1 : 2 : (HEIGHT-4) comment.

Straight-Line Source Code

The comment containing the source code precedes the generated code that implements the source code statement. This comment appears after any comments that you add that precede the generated code. The comments are separated from the generated code because the statements are assigned to function outputs.

MATLAB Code

function [x y] = straightline(r,theta)
  %#codegen
  % Convert polar to Cartesian
  x = r * cos(theta);
  y = r * sin(theta);

Commented C Code

/* MATLAB Function 'straightline': '<S1>:1' */
  /* Convert polar to Cartesian */
  /* '<S1>:1:4' x = r * cos(theta); */
  /* '<S1>:1:5' y = r * sin(theta); */
  straightline0_Y.x = straightline0_U.r * cos(straightline0_U.theta);

  /* Outport: '<Root>/y' incorporates:
  * Inport: '<Root>/r'
  * Inport: '<Root>/theta'
  * MATLAB Function Block: '<Root>/straightline'
  */
  straightline0_Y.y = straightline0_U.r * sin(straightline0_U.theta);

If Statements

The comment for the if statement immediately precedes the code that implements the statement. This comment appears after any comments that you add that precede the
generated code. The comments for the elseif and else clauses appear immediately after the code that implements the clause, and before the code generated for statements in the clause.

**MATLAB Code**

```matlab
function y = ifstmt(u,v)
    %#codegen
    if u > v
        y = v + 10;
    elseif u == v
        y = u * 2;
    else
        y = v - 10;
    end
```

**Commented C Code**

```c
/* MATLAB Function 'MLFcn': '<S1>:1' */
    /* '<S1>:1:3' if u > v */
    if (MLFcn_U.u > MLCfcn_U.v) {
        /* Outport: '<Root>/y' */
        /* '<S1>:1:4' y = v + 10; */
        MLCfcn_Y.y = MLCfcn_U.v + 10.0;
    } else if (MLFcn_U.u == MLCfcn_U.v) {
        /* Outport: '<Root>/y' */
        /* '<S1>:1:5' elseif u == v */
        /* '<S1>:1:6' y = u * 2; */
        MLCfcn_Y.y = MLCfcn_U.u * 2.0;
    } else {
        /* Outport: '<Root>/y' */
        /* '<S1>:1:7' else */
        /* '<S1>:1:8' y = v - 10; */
        MLCfcn_Y.y = MLCfcn_U.v - 10.0;
    }
```

**For Statements**

The comment for the for statement header immediately precedes the generated code that implements the header. This comment appears after any comments that you add that precede the generated code.

**MATLAB Code**

```matlab
function y = forstmt(u)
    %#codegen
```
y = 0;
for i=1:u
    y = y + 1;
end

Commented C Code

/* MATLAB Function 'MLFcn': '<S1>:1' */
/* '<S1>:1:3' y = 0; */
rtb_y = 0.0;
/* '<S1>:1:5' for i=1:u */
for (i = 1.0; i <= MLFcn_U.u; i++) {
    /* '<S1>:1:6' y = y + 1; */
    rtb_y++;
}

While Statements

The comment for the while statement header immediately precedes the generated code that implements the statement header. This comment appears after any comments that you add that precede the generated code.

Switch Statements

The comment for the switch statement header immediately precedes the generated code that implements the statement header. This comment appears after any comments that you add that precede the generated code. The comments for the case and otherwise clauses appear immediately after the generated code that implements the clause, and before the code generated for statements in the clause.

Including MATLAB user comments in Generated Code

MATLAB user comments include the function help text and other comments. The function help text is the first comment after the MATLAB function signature. It provides information about the capabilities of the function and how to use it. You can include the MATLAB user comments in the code generated for a MATLAB Function block.

1. In the model, select Simulation > Model Configuration Parameters.
2. In the Code Generation > Comments pane, select “MATLAB user comments” and click Apply.
Limitations of MATLAB Source Code as Comments

The MATLAB Function block has the following limitations for including MATLAB source code as comments.

- You cannot include MATLAB source code as comments for:
  - MathWorks toolbox functions
  - P-code
  - Simulation targets
  - Stateflow Truth Table blocks
- The appearance or location of comments can vary depending on the following conditions:
  - Comments might still appear in the generated code even if the implementation code is eliminated, for example, due to constant folding.
  - Comments might be eliminated from the generated code if a complete function or code block is eliminated.
  - For certain optimizations, the comments might be separated from the generated code.
  - The generated code always includes legally required comments from the MATLAB source code, even if you do not choose to include source code comments in the generated code.

See Also

More About

- “Verify Generated Code by Using Code Tracing” (Embedded Coder)
- “Use Traceability in MATLAB Function Blocks” (Embedded Coder)
Construction of Generated Identifiers

For GRT and RSIm targets, the code generator automatically constructs identifiers for
variables and functions in the generated code. These identifiers represent:

- Signals and parameters that have Auto storage class
- Subsystem function names that are not user-defined
- Stateflow names

The components of a generated identifier include

- The root model name, followed by
- The name of the generating object (signal, parameter, state, and so on), followed by
- Unique name-mangling text

The code generator conditionally generates the name-mangling text to resolve potential
conflicts with other generated identifiers.

To configure how the code generator names identifiers and objects, see:

- “Specify Identifier Length to Avoid Naming Collisions” on page 18-37
- “Specify Reserved Names for Generated Identifiers” on page 18-38

The code generator reserves certain words for its own use as keywords of the generated
code language. For more information, see “Reserved Keywords” on page 18-39.

With an Embedded Coder license, you can specify parameters to control identifier
formats, mangle length, scalar inlined parameters, and Simulink data object naming
rules. For more information, see “Customize Generated Identifier Naming Rules”
(Embedded Coder).
Identifier Name Collisions and Mangling

In identifier generation, a circumstance that would cause generation of two or more identical identifiers is called a *name collision*. When a potential name collision exists, unique *name-mangling* text is generated and inserted into each of the potentially conflicting identifiers. Each set of name-mangling characters is unique for each generated identifier.

**Identifier Name Collisions with Referenced Models**

Referenced models can introduce additional naming constraints. Within a model that uses referenced models, collisions between the names of the models cannot exist. When you generate code from a model that includes referenced models, the **Maximum identifier length** parameter must be large enough to accommodate the root model name and name-mangling text. A code generation error occurs if **Maximum identifier length** is too small.

When a name conflict occurs between an identifier within the scope of a higher-level model and an identifier within the scope of a referenced model, the identifier from the referenced model is preserved. Name mangling is performed on the identifier from the higher-level model.

For more information on referenced models, see “Parameterize Instances of a Reusable Referenced Model” (Simulink).
Specify Identifier Length to Avoid Naming Collisions

The length of a generated identifier is limited by the **Maximum identifier length** parameter specified on the **Symbols** pane of the Configuration Parameters dialog box. The **Maximum identifier length** field allows you to limit the number of characters in function, type definition, and variable names. The default is 31 characters. This is also the minimum length you can specify. The maximum is 256 characters.

When there is a potential name collision between two identifiers, name-mangling text is generated. The text has the minimum number of characters required to avoid the collision. The other symbol components are then inserted. If **Maximum identifier length** is not large enough to accommodate full expansions of the other components, they are truncated. To avoid this outcome, it is good practice to:

- Avoid name collisions by not using default block names (for example, Gain1, Gain2...) when the model includes multiple blocks of the same type.
- For subsystems, make them atomic and reusable.
- Increase the **Maximum identifier length** parameter to accommodate the length of the identifier you expect to generate.
Specify Reserved Names for Generated Identifiers

You can specify a set of reserved keywords that the code generation process should not use, facilitating code integration where functions and variables from external environments are unknown in the Simulink model. To create a list of reserved names, open the Configuration Parameters dialog box. On the Code Generation > Symbols pane, enter the keywords in the “Reserved names” field.

If your model contains MATLAB Function or Stateflow blocks, the code generation process can use the reserved names specified for those blocks if you select Use the same reserved names as Simulation Target on the Code Generation > Symbols pane.
Reserved Keywords

In this section...

“C Reserved Keywords” on page 18-39
“C++ Reserved Keywords” on page 18-40
“Reserved Keywords for Code Generation” on page 18-40
“Code Generation Code Replacement Library Keywords” on page 18-41

Generator keywords are reserved for internal use. Do not use them in models as identifiers or function names. Also avoid using C reserved keywords in models as identifiers or function names. If your model contains reserved keywords, code generation does not complete and an error message appears. To address the error, modify your model to use identifiers or names that are not reserved.

If you use the code generator to produce C++ code, your model must not contain the “Reserved Keywords for Code Generation” on page 18-40 nor the “C++ Reserved Keywords” on page 18-40.

Note You can register additional reserved identifiers in the Simulink environment. For more information, see “Specify Reserved Names for Generated Identifiers” on page 18-38.

C Reserved Keywords

<table>
<thead>
<tr>
<th>auto</th>
<th>double</th>
<th>int</th>
<th>struct</th>
</tr>
</thead>
<tbody>
<tr>
<td>break</td>
<td>else</td>
<td>long</td>
<td>switch</td>
</tr>
<tr>
<td>case</td>
<td>enum</td>
<td>register</td>
<td>typedef</td>
</tr>
<tr>
<td>char</td>
<td>extern</td>
<td>return</td>
<td>union</td>
</tr>
<tr>
<td>const</td>
<td>float</td>
<td>short</td>
<td>unsigned</td>
</tr>
<tr>
<td>continue</td>
<td>for</td>
<td>signed</td>
<td>void</td>
</tr>
<tr>
<td>default</td>
<td>goto</td>
<td>sizeof</td>
<td>volatile</td>
</tr>
<tr>
<td>do</td>
<td>if</td>
<td>static</td>
<td>while</td>
</tr>
</tbody>
</table>
### C++ Reserved Keywords

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Keyword</th>
<th>Keyword</th>
<th>Keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>catch</td>
<td>friend</td>
<td>protected</td>
<td>try</td>
</tr>
<tr>
<td>class</td>
<td>inline</td>
<td>public</td>
<td>typeid</td>
</tr>
<tr>
<td>const_cast</td>
<td>mutable</td>
<td>reinterpret_cast</td>
<td>typename</td>
</tr>
<tr>
<td>delete</td>
<td>namespace</td>
<td>static_cast</td>
<td>using</td>
</tr>
<tr>
<td>dynamic_cast</td>
<td>new</td>
<td>template</td>
<td>virtual</td>
</tr>
<tr>
<td>explicit</td>
<td>operator</td>
<td>this</td>
<td>wchar_t</td>
</tr>
<tr>
<td>export</td>
<td>private</td>
<td>throw</td>
<td></td>
</tr>
</tbody>
</table>

### Reserved Keywords for Code Generation

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Keyword</th>
<th>Keyword</th>
<th>Keyword</th>
</tr>
</thead>
<tbody>
<tr>
<td>abs</td>
<td>int8_T</td>
<td>MAX_uint8_T*</td>
<td>rtInf</td>
</tr>
<tr>
<td>asm</td>
<td>int16_T</td>
<td>MAX_uint16_T*</td>
<td>rtMinusInf</td>
</tr>
<tr>
<td>bool</td>
<td>int32_T</td>
<td>MAX_uint32_T*</td>
<td>rtNaN</td>
</tr>
<tr>
<td>boolean_T</td>
<td>int64_T</td>
<td>MAX_uint64_T</td>
<td>SeedFileBuffer</td>
</tr>
<tr>
<td>byte_T</td>
<td>INTEGER_CODE</td>
<td>MIN_int8_T*</td>
<td>SeedFileBufferLen</td>
</tr>
<tr>
<td>char_T</td>
<td>LINK_DATA_BUFFER_SIZE</td>
<td>MIN_int16_T*</td>
<td>single</td>
</tr>
<tr>
<td>cint8_T</td>
<td>LINK_DATA_STREAM</td>
<td>MIN_int32_T*</td>
<td>TID01EQ</td>
</tr>
<tr>
<td>cint16_T</td>
<td>localB</td>
<td>MIN_int64_T</td>
<td>time_T</td>
</tr>
<tr>
<td>cint32_T</td>
<td>localC</td>
<td>MODEL</td>
<td>true</td>
</tr>
<tr>
<td>creal_T</td>
<td>localDWork</td>
<td>MT</td>
<td>uint_T</td>
</tr>
<tr>
<td>creal32_T</td>
<td>localP</td>
<td>NCSTATES</td>
<td>uint8_T</td>
</tr>
<tr>
<td>creal64_T</td>
<td>localX</td>
<td>NULL</td>
<td>uint16_T</td>
</tr>
<tr>
<td>cuint8_T</td>
<td>localXdis</td>
<td>NUMST</td>
<td>uint32_T</td>
</tr>
<tr>
<td>cuint16_T</td>
<td>localXdot</td>
<td>pointer_T</td>
<td>uint64_T</td>
</tr>
<tr>
<td>cuint32_T</td>
<td>localZCE</td>
<td>PROFILING_ENABLED</td>
<td>UNUSED_PARAMETER</td>
</tr>
<tr>
<td>ERT</td>
<td>localZCSV</td>
<td>PROFILING_NUM_SAMPLES</td>
<td>USE_RTMODEL</td>
</tr>
<tr>
<td>false</td>
<td>matrix</td>
<td>real_T</td>
<td>VCAST_FLUSH_DATA</td>
</tr>
</tbody>
</table>

18 Configuration for Simulink Coder
**Reserved Keywords**

<table>
<thead>
<tr>
<th>fortran</th>
<th>MAX_int8_T*</th>
<th>real32_T</th>
<th>vector</th>
</tr>
</thead>
<tbody>
<tr>
<td>HAVESTDIO</td>
<td>MAX_int16_T*</td>
<td>real64_T</td>
<td></td>
</tr>
<tr>
<td>id_t</td>
<td>MAX_int32_T*</td>
<td>RT</td>
<td></td>
</tr>
<tr>
<td>int_T</td>
<td>MAX_int64_T</td>
<td>RT_MALLOC</td>
<td></td>
</tr>
</tbody>
</table>

*Not reserved if you specify a replacement identifier.*

---

**Code Generation Code Replacement Library Keywords**

The list of code replacement library reserved keywords for your development environment varies depending on which libraries are registered. The list of available code replacement libraries varies depending on other installed products (for example, a target product), or if you used Embedded Coder to create and register custom code replacement libraries.

To generate a list of reserved keywords for libraries currently registered in your environment, use the following MATLAB function:

```
lib_ids = RTW.TargetRegistry.getInstance.getTflReservedIdentifiers()
```

This function returns an array of library keywords. Specifying the input argument is optional.

**Note** To list the libraries currently registered in your environment, use the MATLAB command `crviewer`.

To generate a list of reserved keywords for a specific library that you are using to generate code, call the function passing the name of the library as displayed in the Code replacement library menu on the Code Generation > Interface pane of the Configuration Parameters dialog box. For example,

```
lib_ids = RTW.TargetRegistry.getInstance.getTflReservedIdentifiers('GNU C99 Extensions')
```

Here is a partial example of the function output:

```
>> lib_ids = ...
   RTW.TargetRegistry.getInstance.getTflReservedIdentifiers('GNU C99 Extensions')
lib_ids =
   'exp10'
   'exp10f'
```
'acosf'
'acoshf'
'asinf'
'asinhf'
'atanf'
'atanhf'
...
'rt_lu_cplx'
'rt_lu_cplx_sgl'
'rt_lu_real'
'rt_lu_real_sgl'
'rt_mod_boolean'
'rt_rem_boolean'
'strcpy'
'utAssert'

**Note** Some of the returned keywords appear with the suffix $N$, for example, 'rt_atan2$N'$. N expands into the suffix _snf only if nonfinite numbers are supported. For example, 'rt_atan2$N' represents 'rt_atan2_snf' if nonfinite numbers are supported and 'rt_atan2' if nonfinite numbers are not supported. As a precaution, you should treat both forms of the keyword as reserved.
Debug

In the Configuration Parameters dialog box, use parameters on the Diagnostics pane and debugging parameters to configure a model such that the generated code and the build process are set for debugging. You can set parameters that apply to the model compilation phase, the target language code generation phase, or both.

Parameters in the following table will be helpful if you are writing TLC code for customizing targets, integrating legacy code, or developing new blocks.

<table>
<thead>
<tr>
<th>To...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display progress information during code generation in the MATLAB Command Window</td>
<td>“Verbose build”. Compiler output also displays.</td>
</tr>
<tr>
<td>Prevent the build process from deleting the model.rtw file from the build folder at the end of the build</td>
<td>“Retain .rtw file”. This parameter is useful if you are modifying the target files, in which case you need to look at the model.rtw file.</td>
</tr>
<tr>
<td>Instruct the TLC profiler to analyze the performance of TLC code executed during code generation and generate a report</td>
<td>“Profile TLC”. The report is in HTML format and can be read in your web browser.</td>
</tr>
<tr>
<td>Start the TLC debugger during code generation</td>
<td>“Start TLC debugger when generating code”. Alternatively, enter the argument -dc for the “System target file” parameter on the Code Generation pane. To start the debugger and run a debugger script, enter -df filename for System target file.</td>
</tr>
<tr>
<td>To...</td>
<td>Select...</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Generate a report containing statistics indicating how many times the code generator reads each line of TLC code during code generation</td>
<td>“Start TLC coverage when generating code”. Alternatively, enter the argument -dg for the System Target File parameter on the Code Generation pane.</td>
</tr>
</tbody>
</table>
| Halt a build if a user-supplied TLC file contains an %assert directive that evaluates to FALSE | “Enable TLC assertion”. Alternatively, you can use MATLAB commands to control TLC assertion handling.  
To set the flag on or off, use the `set_param` command. The default is off.  
`set_param(model, 'TLCAssertion', 'on|off')`  
To check the current setting, use `get_param`.  
`get_param(model, 'TLCAssertion')` |
| Detect loss of tunability                                             | “Detect loss of tunability” (Simulink) on the Diagnostics > Data Validity pane. You can use this parameter to report loss of tunability when an expression is reduced to a numeric expression. This can occur if a tunable workspace variable is modified by Mask Initialization code, or is used in an arithmetic expression with unsupported operators or functions. Possible values are:  
• none — Loss of tunability can occur without notification.  
• warning — Loss of tunability generates a warning (default).  
• error — Loss of tunability generates an error.  
For a list of supported operators and functions, see “Tunable Expression Limitations” on page 15-136 |
<table>
<thead>
<tr>
<th>To...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable model verification (assertion) blocks</td>
<td>“Model Verification block enabling” (Simulink). Use this parameter to enable or disable model verification blocks such as Assert, Check Static Gap, and related range check blocks. The diagnostic applies to generated code and simulation behavior. For example, simulation and code generation ignore this parameter when model verification blocks are inside an S-function. Possible values are:</td>
</tr>
<tr>
<td></td>
<td>• User local settings</td>
</tr>
<tr>
<td></td>
<td>• Enable All</td>
</tr>
<tr>
<td></td>
<td>• Disable All</td>
</tr>
</tbody>
</table>

For Assertion blocks not disabled, generated code for a model includes one of the following statements, depending on the blocks input signal type (Boolean, real, or integer, respectively).

\[
\text{utAssert(input\_signal)}; \\
\text{utAssert(input\_signal} \neq 0.0); \\
\text{utAssert(input\_signal} \neq 0);
\]

By default, `utAssert` does not change generated code. For assertions to abort execution, you must enable them by specifying the following `make_rtw` command for **Code Generation > “Make command”** parameter:

```
make_rtw OPTS="-DDOASSERTS"
```

Use the following variant if you want triggered assertions to print the assertion statement instead of aborting execution:

```
make_rtw OPTS="-DDOASSERTS -DPRINT_ASSERTS"
```

`utAssert` is defined as `#define utAssert(exp) assert(exp)`.

To customize assertion behavior, provide your own definition of `utAssert` in a handwritten header file that overrides the default `utAssert.h`. For details on how to include a customized header file in generated code, see “Integrate...”
When running a model in accelerator mode, the Simulink engine calls back to itself to execute assertion blocks instead of using generated code. Thus, user-defined callbacks are still called when assertions fail.

For more information about the TLC debugging options, see Debugging on “Target Language Compiler”. Also, consider using the Model Advisor as a tool for troubleshooting model builds.

**See Also**

**More About**
- “Tunable Expression Limitations” on page 15-136
- “Integrate External Code by Using Model Configuration Parameters” on page 26-45
- “Target Language Compiler”
System Target File Configuration

- “Configure a System Target File” on page 19-2
- “Configure STF-Related Code Generation Parameters” on page 19-7
- “Configure a Code Replacement Library” on page 19-17
- “Configure Standard Math Library for Target System” on page 19-18
- “Compare System Target File Support Across Products” on page 19-21
Configure a System Target File

To configure a model for code generation, follow the steps in “Select a Solver That Supports Code Generation” on page 19-2 and “Select a System Target File from STF Browser” on page 19-3. When you select a system target file, other model configuration parameters change to serve requirements of the execution environment. For example:

- Code interface parameters
- Build process parameters, such as the toolchain or template makefile
- Target hardware parameters, such as word size and byte ordering

After selecting a system target file, you can modify model configuration parameter settings.

You can switch between different system target files in a single workflow for different code generation purposes (for example, rapid prototyping versus production code deployment). To switch, set up different configuration sets for the same model and switch the active configuration set for the current operation. For more information on how to set up configuration sets and change the active configuration set, see “Manage a Configuration Set” (Simulink).

Select a Solver That Supports Code Generation

To build a model, the model configuration must select a solver that is compatible with code generation for the system target file. Few system target files support code generation with variable-step solvers or for models with a nonzero start time.

- Use Configuration Parameters > Solver > Type and select Fixed-step for GRT, ERT, and ERT-based system target files.
- Use Configuration Parameters > Solver > Type and select Fixed-step or Variable-step for Rapid Simulation (Rsim) or S-Function (rtwsfcn) system target files.

For more information about the requirement that you use a fixed-step solver to generate code for a realtime system target file, see “Time-Based Scheduling and Code Generation” (Embedded Coder).

When you try to build models with a nonzero start time using a system target file does not support a nonzero start time, the code generator does not produce code. The build process displays an error message. The Rapid Simulation (RSim) system target file
supports a nonzero start time when Configuration Parameters > RSim Target > Solver selection is set to Use Simulink solver module. Other system target files do not support a nonzero start time.

Select a System Target File from STF Browser

After you select a solver (see “Select a Solver That Supports Code Generation” on page 19-2), use Configuration Parameters > Code Generation > System target file and click the Browse button to open the System Target File Browser. Select a system target file from the list. Your selection appears in the System target file field (target.tlc).

If you use a system target file that does not appear in the System Target File Browser, enter the name of your system target file in the System target file field.

You also can select a system target file programmatically from MATLAB code, as described in “Select a System Target File Programmatically” on page 19-4.

After selecting a system target file, you can modify model configuration parameter settings. Selecting a system target file for your model selects either the toolchain approach or template makefile approach for build process control. For more information about these approaches, see “Choose Build Approach and Configure Build Process” on page 27-14.

If you want to switch between different system target files in a single workflow for different code generation purposes, set up different configuration sets for the same model. Switch the active configuration set for the current operation. This approach is useful for switching between rapid prototyping and production code deployment. For more information on how to set up configuration sets and change the active configuration set, see “Manage a Configuration Set” (Simulink).

To select a system target file using the System Target File Browser,

1. Open the Code Generation pane of the Configuration Parameters dialog box.
2. Click the Browse button next to the System target file field. This button opens the System Target File Browser. The browser displays a list of currently available system target files, including customizations. When you select a system target file, the code generator automatically chooses the system target file, toolchain or template makefile, and/or make command for that configuration.

The next step shows the System Target File Browser with the GRT system target file selected.
3 Click the desired entry in the list of available configurations. The background of the list box turns yellow to indicate that an unapplied choice has been made. To apply it, click **Apply** or **OK**.

![System Target File Browser](image_url)

**System Target File Browser**

When you choose a system target file, the code generator selects the toolchain or template makefile and/or `make` command for that configuration and displays them in the **System target file** field. The description of the system target file from the browser is placed below its name in the **Code Generation** pane. For information each system target file, see “Compare System Target File Support Across Products” on page 19-21.

**Select a System Target File Programmatically**

Simulink models store model-wide parameters and system target file-specific data in **configuration sets**. Every configuration set contains a component that defines the structure of a particular system target file and the current values of relevant options. Simulink loads some of this information from the system target file that you specify. You can configure models to generate alternative code by copying and modifying old or adding new configuration sets and browsing to select a new system target file. Then, you can interactively select an active configuration from among these sets (only one configuration set can be active at a given time).

Scripts that automate system target file selection must emulate this process.

To program system target file selection:
1. Obtain a handle to the active configuration set with a call to the `getActiveConfigSet` function.

2. Define character vector variables that correspond to the required system target file, toolchain or template makefile, and/or make command settings. For example, for the ERT system target file, you would define variables for the character vectors 'ert.tlc', 'ert_default_tmf', and 'make_rtw'.

3. Select the system target file with a call to the `switchTarget` function. In the function call, specify the handle for the active configuration set and the system target file.

4. Set the `TemplateMakefile` and `MakeCommand` configuration parameters to the corresponding variables created in step 2.

For example:

```matlab
cs = getActiveConfigSet(model);
stf = 'ert.tlc';
tmf = 'ert_default_tmf';
mc  = 'make_rtw';
switchTarget(cs,stf,[]);
set_param(cs,'TemplateMakefile',tmf);
set_param(cs,'MakeCommand',mc);
```

For more information about selecting system target files programmatically, see `switchTarget`.

**Develop Custom System Target Files**

You can create your own system target files that interface with external code or operating environments.

For more information on how to make custom system target files appear in the System Target File Browser and display relevant controls, see “About Embedded Target Development” on page 39-2 and the topics it references.

**See Also**

`getActiveConfigSet` | `switchTarget`
More About

• “Configure STF-Related Code Generation Parameters” on page 19-7
• “Configure a Code Replacement Library” on page 19-17
• “Configure Standard Math Library for Target System” on page 19-18
• “Compare System Target File Support Across Products” on page 19-21
• “About Embedded Target Development” on page 39-2
Configure STF-Related Code Generation Parameters

Many model configuration parameters for code generation are specific to GRT, ERT, or ERT-based system target files.

Specify Generated Code Interfaces

Use interface model configuration parameters to control which libraries to use when generating code, whether to include support for an API in generated code, and other interface options.

<table>
<thead>
<tr>
<th>To...</th>
<th>Select or Enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the standard math library that the code generator uses when generating code.</td>
<td>Select C89/C90 (ANSI), C99 (ISO), or C++03 (ISO) for the Standard math library parameter. Selecting C89/C90 (ANSI) provides the ANSI C set of library functions. For example, selecting C89/C90 (ANSI) results in generated code that calls sin() whether the input argument is double precision or single precision. However, if you select C99 (ISO), the generated code calls the function sinf() when the input argument is single precision. If your compiler supports the ISO C math extensions, selecting the ISO C library can result in more efficient code. For more information, see “Standard math library”. The options for this parameter have dependencies. See Interface Dependencies.</td>
</tr>
<tr>
<td>Specify an application-specific library that the code generator uses when generating code.</td>
<td>If you generate application-specific C or C++ code for math functions or operations, select a value for Code replacement library. Otherwise, specify None. For more information about code replacement libraries, see “Choose a Code Replacement Library” on page 23-8 and “Code replacement library”. The options for this parameter have dependencies. See Interface Dependencies.</td>
</tr>
<tr>
<td><strong>To...</strong></td>
<td><strong>Select or Enter...</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
| Direct where the code generator places fixed-point and other utility code. | Select Auto or Shared location for **Shared code placement**. The shared location directs code for utilities to be placed within the slprj folder in your working folder, which is used for building referenced models. If you select Auto,  
- When the model contains Model blocks, places utility code within the slprj/target/_sharedutils folder.  
- When the model does not contain Model blocks, places utility code in the build folder (generally, in `model.c` or `model.cpp`). |
| Specify text to be added to the variable names used when logging data to MAT-files and to distinguish logging data from code generation and simulation applications. | Enter a prefix or suffix, such as `rt_` or `_rt`, for the **MAT-file variable name modifier** parameter. The code generator prefixes or appends the text to the variable names for system outputs, states, and simulation time specified in the **Data Import/Export** pane. See “Log Program Execution Results” on page 29-2 for information on MAT-file data logging. |
| Specify data exchange APIs to be included in generated code. | Select one or more **C API** options, the **ASAP2 interface** option, or the **External mode** option. When you select **External mode**, other options appear. The data exchange APIs are independent, and you can select combinations of these APIs. For example, you could choose C API and external mode.  
For more information on working with these interfaces, see “Exchange Data Between Generated and External Code Using C API” on page 30-2, “Export ASAP2 File for Data Measurement and Calibration” on page 31-2, and “Host-Target Communication with External Mode Simulation” on page 28-2.  
The options for this parameter have dependencies. See Interface Dependencies. |

**Note** Before setting **Standard math library** or **Code replacement library**, verify that your compiler supports the library you want to use. If you select a parameter value that your toolchain does not support, compiler errors can occur. For example, if you select

---

a. ANSI is a registered trademark of the American National Standards Institute, Inc.  
b. ISO is a registered trademark of the International Organization for Standardization.
standard math library C99 (ISO) and your compiler does not support the ISO C math extensions, compile-time errors could occur.

When the Embedded Coder product is installed on your system, the Code Generation > Interface pane expands to include several additional options. For descriptions of Code Generation > Interface pane parameters, see “Model Configuration Parameters: Code Generation Interface”.

Several interface parameters have dependencies on settings of other parameters. The following table summarizes the dependencies.
## Interface Dependencies

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Dependencies?</th>
<th>Dependency Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard math library</strong></td>
<td>Yes</td>
<td>Available values depend on <strong>Language selection</strong>.</td>
</tr>
<tr>
<td><strong>Code replacement library</strong></td>
<td>Yes</td>
<td>Available values depend on product licensing and other parameters. For more information, see “Code replacement library”.</td>
</tr>
<tr>
<td><strong>Shared code placement</strong></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td><strong>Support: floating-point numbers</strong></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>(ERT system target files only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Support: non-finite numbers</strong></td>
<td>Yes (ERT)</td>
<td>For ERT system target files, enabled by <strong>Support floating-point numbers</strong></td>
</tr>
<tr>
<td></td>
<td>No (GRT)</td>
<td></td>
</tr>
<tr>
<td><strong>Support: complex numbers</strong></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>(ERT system target files only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Support: absolute time</strong></td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>(ERT system target files only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Support: continuous time</strong></td>
<td>Yes</td>
<td>Requires that you disable <strong>Remove error status field in real-time model data structure.</strong></td>
</tr>
<tr>
<td>(ERT system target files only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Support: non-inlined S-functions</strong></td>
<td>Yes</td>
<td>Requires that you enable <strong>Support floating-point numbers</strong> and <strong>Support non-finite numbers</strong></td>
</tr>
<tr>
<td>(ERT system target files only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Classic call interface</strong></td>
<td>Yes</td>
<td>Requires that you disable <strong>Single output/update function</strong>. For ERT system target files, requires that you enable <strong>Support floating-point numbers</strong>.</td>
</tr>
<tr>
<td><strong>Single output/update function</strong></td>
<td>Yes</td>
<td>Disable for <strong>Classic call interface</strong></td>
</tr>
<tr>
<td><strong>Terminate function required</strong></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>(ERT system target files only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Code interface packaging</strong></td>
<td>Yes</td>
<td>Available values depend on <strong>Language selection</strong>.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Dependencies?</td>
<td>Dependency Details</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Multi-instance code error diagnostic</td>
<td>Yes</td>
<td>Set <strong>Code interface packaging</strong> to Reusable function or C++ class</td>
</tr>
<tr>
<td>Pass root-level I/O as (ERT system target files only)</td>
<td>Yes</td>
<td>Set <strong>Code interface packaging</strong> to Reusable function</td>
</tr>
<tr>
<td>Use dynamic memory allocation for model initialization (ERT system target files only)</td>
<td>Yes</td>
<td>Set <strong>Code interface packaging</strong> to Reusable function</td>
</tr>
<tr>
<td>MAT-file logging</td>
<td>Yes</td>
<td>For GRT system target files, requires that you enable <strong>Support non-finite numbers</strong>; for ERT system target files, requires that you enable <strong>Support floating-point numbers</strong>, <strong>Support non-finite numbers</strong>, and <strong>Terminate function required</strong></td>
</tr>
<tr>
<td>MAT-file file variable name modifier</td>
<td>Yes</td>
<td>Enabled by <strong>MAT-file logging</strong></td>
</tr>
<tr>
<td>Remove error status field in real-time model data structure (ERT system target files only)</td>
<td>Yes</td>
<td>Requires that you disable <strong>Support: continuous time</strong>.</td>
</tr>
<tr>
<td>Generate C API for: signals</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Generate C API for: parameters</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Generate C API for: states</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Generate C API for: root-level I/O</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>ASAP2 interface</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>External mode</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Transport layer</td>
<td>Yes</td>
<td>Enable <strong>External mode</strong></td>
</tr>
<tr>
<td>MEX-file arguments</td>
<td>Yes</td>
<td>Enable <strong>External mode</strong></td>
</tr>
<tr>
<td>Static memory allocation</td>
<td>Yes</td>
<td>Enable <strong>External mode</strong></td>
</tr>
<tr>
<td>Static memory buffer size</td>
<td>Yes</td>
<td>Enable <strong>Static memory allocation</strong></td>
</tr>
</tbody>
</table>
Configure Numeric Data Support

By default, ERT system target files support code generation for integer, floating-point, nonfinite, and complex numbers.

<table>
<thead>
<tr>
<th>To Generate Code That Supports...</th>
<th>Do...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integer data only</td>
<td>Clear Support floating-point numbers. If noninteger data or expressions are encountered during code generation, an error message reports the offending blocks and parameters.</td>
</tr>
<tr>
<td>Floating-point data</td>
<td>Select Support floating-point numbers.</td>
</tr>
<tr>
<td>Nonfinite values (for example, NaN, Inf)</td>
<td>Select Support floating-point numbers and Support non-finite numbers.</td>
</tr>
<tr>
<td>Complex data</td>
<td>Select Support complex numbers.</td>
</tr>
</tbody>
</table>

For more information, see “Model Configuration Parameters: Code Generation Interface”.

Configure Time Value Support

Certain blocks require the value of absolute time, elapsed time, or continuous time. Absolute time is the time from the start of program execution to the present time. Elapsed time is the time elapsed between two trigger events. Depending on the blocks used, your model could require adjustment of the configuration settings for supported time values.

<table>
<thead>
<tr>
<th>To...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate code that creates and maintains integer counters for blocks that use absolute or elapsed time values (default).</td>
<td>Support absolute time. For further information on the allocation and operation of absolute and elapsed timers, see “Absolute and Elapsed Time Computation” on page 3-2. If you do not select this parameter and the model includes a block that uses absolute or elapsed time values, the build process generates an error.</td>
</tr>
<tr>
<td>Generate code for blocks that rely on continuous time.</td>
<td>Support continuous time. If you do not select this parameter and the model includes continuous-time blocks, the build process generates an error.</td>
</tr>
</tbody>
</table>

For more information, see “Model Configuration Parameters: Code Generation Interface”.
Configure Noninlined S-Function Support

To generate code for noninlined S-Functions in a model, select **Support noninlined S-functions**. The generation of noninlined S-functions requires floating-point and nonfinite numbers. Thus, when you select **Support non-inlined S-functions**, the ERT system target file selects **Support floating-point numbers** and **Support non-finite numbers**.

When you select **Support non-finite numbers** and the model includes a C MEX S-function that does not have a corresponding TLC implementation (for inlining code generation), the build process generates an error.

Inlining S-functions is highly advantageous in production code generation, for example in implementing device drivers. To enforce the use of inlined S-functions for code generation, clear **Support non-inlined S-functions**.

When generating code for a model that contains noninlined S-functions with an ERT system target file, there could be a mismatch between the simulation and code generation results when either of the following is true:

- Model configuration parameter GenCodeOnly is set to off or **Configuration Parameters > Code Generation > Generate code only** is cleared.
- Model configuration parameter ProdEqTarget is set to off.

To avoid such a mismatch, set ProdEqTarget to on or select **Configuration Parameters > Code Generation > Generate code only** (or set GenCodeOnly to on).

Configure Model Function Generation and Argument Passing

For ERT system target files, you can configure model for how functions are generated and how arguments are passed to the functions.

<table>
<thead>
<tr>
<th>To...</th>
<th>Do...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate model function calls that are compatible with the main</td>
<td>Select <strong>Classic call interface</strong> and <strong>MAT-file logging</strong>. In</td>
</tr>
<tr>
<td>program module of the pre-R2012a GRT system target file (grt_main.c</td>
<td>addition, clearing **Remove error status field in real-time</td>
</tr>
<tr>
<td>or .cpp).</td>
<td>model data structure. <strong>Classic call interface</strong> provides a quick</td>
</tr>
<tr>
<td></td>
<td>way to use code generated in R2012a or higher with a pre-R2012a</td>
</tr>
<tr>
<td></td>
<td>GRT-based custom system target file by generating wrapper function</td>
</tr>
<tr>
<td></td>
<td>calls that interface to the generated code.</td>
</tr>
<tr>
<td><strong>To...</strong></td>
<td><strong>Do...</strong></td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Reduce overhead and use more local variables by combining the output and update functions in a single <code>model_step</code> function.</td>
<td>Select <strong>Single output/update function</strong>. Errors or unexpected behavior can occur if a Model block is part of a cycle and the model configuration enables “Single output/update function” (the default). For more information about direct feed through, see “Algebraic Loops” (Simulink).</td>
</tr>
<tr>
<td>Generate a <code>model_terminate</code> function for a model not designed to run indefinitely.</td>
<td>Select <strong>Terminate function required</strong>. For more information, see the description of <code>model_terminate</code>.</td>
</tr>
<tr>
<td>Generate reusable, reentrant code from a model or subsystem.</td>
<td>Select <strong>Generate reusable code</strong>. See “Configure Code Reuse Support” on page 19-15 for details.</td>
</tr>
<tr>
<td>Statically allocate model data structures and access them directly in the model code.</td>
<td>Clear <strong>Generate reusable code</strong>. The generated code is not reusable or reentrant. See “Configure Code Generation for Model Entry-Point Functions” on page 16-2 for information on the calling interface generated for model functions in this case.</td>
</tr>
<tr>
<td>Suppress the generation of an error status field in the real-time model data structure, <code>rtModel</code>, for example, if you do not require to log or monitor error messages.</td>
<td>Select <strong>Remove error status field in real-time model data structure</strong>. Selecting this parameter can also cause the code generator to omit the <code>rtModel</code> structure from the generated code. When generating code for multiple integrated models, set this parameter the same for all of the models. Otherwise, the integrated application could exhibit unexpected behavior. For example, if you select the option in one model but not in another, it is possible that the integrated application could not register the error status. Do not select this parameter if you select the MAT-file logging option. The two options are incompatible.</td>
</tr>
</tbody>
</table>
To... | Do...
---|---
Open the Configure C Step Function Interface dialog box and modify the `model_step` function prototype. | In the Code Mapping Editor, on the **Entry-Point Functions** tab, click in the Function Name column for the base-rate step function. Click the three vertical dots that appear. Then click **Configure Prototype**. Unless a function prototype was previously configured, the dialog box opens showing a preview of the step function interface with no arguments (**void-void**). The dialog box also shows the current function name. If arguments have previously been configured for the model, the dialog box displays the current settings. If necessary, change the name and argument settings for the step function. For more information, see “Override Default C Step Function Interface” (Embedded Coder).

For more information, see “Model Configuration Parameters: Code Generation Interface”.

**Configure Code Reuse Support**

For GRT, ERT, GRT-based, and ERT-based system target files, you can configure how a model reuses code by setting the **Configuration Parameters > Code Generation > Code interface packaging** parameter value to **Reusable function**.

The **Configuration Parameters > Code Generation > Pass root-level I/O as** parameter provides options that control how model inputs and outputs at the root level of the model are passed to the `model_step` function.

<table>
<thead>
<tr>
<th>To...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pass each root-level model input and output argument to the <code>model_step</code> function individually (the default)</td>
<td><strong>Code interface packaging</strong> &gt; Reusable function and <strong>Pass root-level I/O as</strong> &gt; Individual arguments.</td>
</tr>
<tr>
<td>Pack root-level input arguments and root-level output arguments into separate structures that are then passed to the <code>model_step</code> function</td>
<td><strong>Code interface packaging</strong> &gt; Reusable function and <strong>Pass root-level I/O as</strong> &gt; Structure reference.</td>
</tr>
<tr>
<td>Pack root-level input arguments and root-level output arguments into the model data structure to support reentrant multi-instance code from a model for ERT system target file</td>
<td><strong>Code interface packaging</strong> &gt; Reusable function and <strong>Pass root-level I/O as</strong> &gt; Part of model data structure.</td>
</tr>
</tbody>
</table>
If using the **Code interface packaging** > Reusable function selection, consider using the **Use dynamic memory allocation for model initialization** option to control whether an allocation function is generated. This option applies for ERT system target files.

Sometimes, selecting **Code interface packaging** as Reusable function can generate code that compiles but is not reentrant. For example, if a signal, DWork structure, or parameter data has a storage class other than Auto, global data structures are generated. To handle such cases, use the **Multi-instance code error diagnostic** parameter to choose the severity levels for diagnostics.

Sometimes, the code generator is unable to generate valid and compilable code. For example, if the model contains one of the following, the generated code is invalid.

- An S-function that is not code-reuse compliant
- A subsystem triggered by a wide function-call trigger

In these cases, the build terminates after reporting the problem.

For more information, see “Generate Reentrant Code from Top-Level Models” (Embedded Coder) and “Model Configuration Parameters: Code Generation Interface”.

### See Also

### More About

- “Configure a System Target File” on page 19-2
- “Configure a Code Replacement Library” on page 19-17
- “Configure Standard Math Library for Target System” on page 19-18
- “Compare System Target File Support Across Products” on page 19-21
Configure a Code Replacement Library

You can configure the code generator to change the code that it generates for functions and operators such that the code meets application requirements. Configure the code generator to apply a code replacement library (CRL) during code generation. If you have Embedded Coder, you can develop and apply custom code replacement libraries.

For more information about replacing code, using code replacement libraries that MathWorks provides, see “What Is Code Replacement?” (Embedded Coder) and “Code Replacement Libraries” on page 23-2. For information about developing code replacement libraries, see “What Is Code Replacement Customization?” (Embedded Coder).

See Also

More About

- “Configure a System Target File” on page 19-2
- “Configure STF-Related Code Generation Parameters” on page 19-7
- “Configure Standard Math Library for Target System” on page 19-18
- “Compare System Target File Support Across Products” on page 19-21
- “Specify Generated Code Interfaces” (Embedded Coder)
Configure Standard Math Library for Target System

Specify standard library extensions that the code generator uses for math operations. When you generate code for a new model or with a new configuration set object, the code generator uses the ISO®/IEC 9899:1999 C (C99 (ISO)) library by default. For preexisting models and configuration set objects, the code generator uses the library specified by the **Standard math library** parameter.

If your compiler supports the ISO®/IEC 9899:1990 (C89/C90 (ANSI)) or ISO/IEC 14882:2003(C++03 (ISO)) math library extensions, you can change the standard math library setting. The C++03 (ISO) library is an option when you select C++ for the programming language.

The C99 library leverages the performance that a compiler offers over standard ANSI C. When using the C99 library, the code generator produces calls to ISO C functions when possible. For example, the generated code calls the function `sqrtf()`, which operates on single-precision data, instead of `sqrt()`.

To change the library setting, use the **Configuration Parameters>Standard math library** parameter. The command-line equivalent is `TargetLangStandard`.

**Generate and Inspect ANSI C Code**

1. Open the example model `rtwdemo_clibsup`. 
2. Generate code.

```matlab
if (rtb_Abs2 < 0.0F) {
    rtb_Abs2 = -(real32_T)sqrt((real32_T)fabs(rtb_Abs2));
} else {
    rtb_Abs2 = (real32_T)sqrt(rtb_Abs2);
}
```

3. Examine the code in the generated file `rtwdemo_clibsup.c`. Note that the code calls the `sqrt` function.
Generate and Inspect ISO C Code

1. Change the setting of **Standard math library** to C99 (ISO). Alternatively, at the command line, set **TargetLangStandard** to C99 (ISO).

2. Regenerate the code.

   ```
   ### Starting build procedure for model: rtwdemo_clibsup
   ### Successful completion of code generation for model: rtwdemo_clibsup
   ```

3. Reexamine the code in the generated file `rtwdemo_clibsup.c`. Now the generated code calls the function `sqrtf` instead of `sqrt`.

   ```
   if (rtb_Abs2 < 0.0F) {
       rtb_Abs2 = -sqrtf(fabsf(rtb_Abs2));
   } else {
       rtb_Abs2 = sqrtf(rtb_Abs2);
   }
   ```

Related Information

- “Standard math library”
- “Configure a System Target File” on page 19-2
- “Configure STF-Related Code Generation Parameters” on page 19-7
- “Configure a Code Replacement Library” on page 19-17
- “Compare System Target File Support Across Products” on page 19-21
- “Replace Code Generated from Simulink Models” on page 23-10
Compare System Target File Support Across Products

When you select a system target file (such as grt.tlc), the selection defines the run-time environment and the code generation features. Identify the system target file features that match your code generation workflow goals.

The code generator uses the system target file to produce code intended for execution on certain target hardware or on a certain operating system. The system target file invokes other run-time environment-specific files. For more information on configuring model code generation parameters for target hardware, see “Configure Run-Time Environment Options” on page 10-2.

Different types of system target files support a selection of generated code features. In the system target file, the value of the CodeFormat TLC variable and corresponding rtwgensettings.DerivedFrom field value identify the system target file type and generated code features. These selections apply your code generation control decisions at several points in the code generation process. Your selections include whether and how the model build generates:

- Certain data structures (for example, SimStruct or rtModel)
- Static or dynamic memory allocation code
- Calling interface for generated model functions

For custom system target file development, the CodeFormat value differs among code generation targets:

- If the system target file does not include a value for the CodeFormat TLC variable, the default value is RealTime for generic real-time target (GRT). The corresponding rtwgensettings.DerivedFrom field value is grt.tlc (default value).
- If you are developing a custom system target file and you have Embedded Coder software, consider setting the CodeFormat TLC variable value to Embedded-C for embedded real-time target (ERT). The corresponding rtwgensettings.DerivedFrom field value is ert.tlc. The ERT system target file supports more generated code features than the GRT system target file.

This example shows how the value for the CodeFormat TLC variable and corresponding rtwgensettings.DerivedFrom field value are set in ert.tlc.

%assign CodeFormat = "Embedded-C"
Note  Use the value for the CodeFormat TLC variable with its corresponding rtwgensettings.DerivedFrom field value to generate code for the model. If no values are explicitly selected, the default values correspond. For more information, see “System Target File Structure” on page 39-29.

For a description of the optimized call interface generated by default for the GRT and ERT system target files, see “Configure Code Generation for Model Entry-Point Functions” on page 16-2.

Code generation with the GRT and ERT system target files uses the real-time model data structure (rtModel). This structure encapsulates model-specific information in a much more compact form than the simulation structure, SimStruct. Many efficient features of generated code depend on generation of rtModel rather than SimStruct, including:

• Integer absolute and elapsed timing services
• Independent timers for asynchronous tasks
• Generation of improved C API code for signal, state, and parameter monitoring
• Pruning the data structure to minimize its size (ERT-derived system target files only)

For a description of the rtModel data structure, see “Use the Real-Time Model Data Structure” on page 15-29.

**Compare Product System Target Files**

You can select from a range of system target files by using the System Target File Browser. This selection lets you experiment with configuration options and save your model with different configurations.

You cannot build or generate code for non-GRT system target files, unless you have the required software on your system. For example, you require Embedded Coder for ERT system target files, Simulink Desktop Real-Time for SLDRT system target files, and so on.
Selecting a system target file for your model selects either the toolchain approach or the template makefile approach for build process control. For more information about these approaches, see “Choose Build Approach and Configure Build Process” on page 27-14.
## System Target Files Available from System Target File Browser

<table>
<thead>
<tr>
<th>Supported System Target File</th>
<th>File Names</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embedded Coder (for PC or UNIX platforms)</td>
<td>ert.tlc</td>
<td>“Configure a System Target File” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>ert_shrlib.tlc</td>
<td></td>
</tr>
<tr>
<td>Create Visual C++® Solution File for Embedded Coder</td>
<td>ert.tlc</td>
<td>“Configure a System Target File” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>(Requires RTW.MSVCBuild as TMF. See note.)</td>
<td></td>
</tr>
<tr>
<td>Embedded Coder for AUTOSAR</td>
<td>autosar.tlc</td>
<td>“Getting Started with AUTOSAR Code Generation” (Embedded Coder)</td>
</tr>
<tr>
<td>Generic Real-Time (for PC or UNIX platforms)</td>
<td>grt.tlc</td>
<td>“Compare Generated Code Features by STF” on page 19-30</td>
</tr>
<tr>
<td>Create Visual C++ Solution File</td>
<td>grt.tlc</td>
<td>“Compare Generated Code Features by STF” on page 19-30</td>
</tr>
<tr>
<td></td>
<td>(Requires RTW.MSVCBuild as TMF. See note.)</td>
<td></td>
</tr>
<tr>
<td>Rapid Simulation (default for PC or UNIX platforms)</td>
<td>rsim.tlc</td>
<td>“Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by Using RSim System Target File” on page 24-2</td>
</tr>
<tr>
<td>Rapid Simulation for LCC compiler</td>
<td>rsim.tlc</td>
<td>“Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by Using RSim System Target File” on page 24-2</td>
</tr>
<tr>
<td>Rapid Simulation for UNIX platforms</td>
<td>rsim.tlc</td>
<td>“Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by Using RSim System Target File” on page 24-2</td>
</tr>
<tr>
<td>Rapid Simulation for Visual C++ + compiler</td>
<td>rsim.tlc</td>
<td>“Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by Using RSim System Target File” on page 24-2</td>
</tr>
<tr>
<td>Supported System Target File</td>
<td>File Names</td>
<td>Reference</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>S-Function for PC or UNIX platforms</td>
<td><code>rtwsfcn.tlc</code></td>
<td>“Accelerate Simulation, Reuse Code, or Protect Intellectual Property by Using S-Function Target” on page 24-59</td>
</tr>
<tr>
<td>S-Function for LCC</td>
<td><code>rtwsfcn.tlc</code></td>
<td>“Accelerate Simulation, Reuse Code, or Protect Intellectual Property by Using S-Function Target” on page 24-59</td>
</tr>
<tr>
<td>S-Function for UNIX platforms</td>
<td><code>rtwsfcn.tlc</code></td>
<td>“Accelerate Simulation, Reuse Code, or Protect Intellectual Property by Using S-Function Target” on page 24-59</td>
</tr>
<tr>
<td>S-Function for Visual C++ compiler</td>
<td><code>rtwsfcn.tlc</code></td>
<td>“Accelerate Simulation, Reuse Code, or Protect Intellectual Property by Using S-Function Target” on page 24-59</td>
</tr>
<tr>
<td>ASAM-ASAP2 Data Definition</td>
<td><code>asap2.tlc</code></td>
<td>“Export ASAP2 File for Data Measurement and Calibration” on page 31-2</td>
</tr>
<tr>
<td>Simulink Desktop Real-Time</td>
<td><code>sldrt.tlc</code> <code>sldrtert.tlc</code></td>
<td>“Set External Mode Code Generation Parameters” (Simulink Desktop Real-Time)</td>
</tr>
<tr>
<td>Simulink Real-Time</td>
<td><code>slrt.tlc</code></td>
<td>“Simulink Real-Time Options Pane” (Simulink Real-Time)</td>
</tr>
<tr>
<td>IDE Link capability</td>
<td><code>idelink_grt.tlc</code> <code>idelink_ert.tlc</code></td>
<td>Embedded IDE or target topics such as “Model Setup” (Embedded Coder)</td>
</tr>
</tbody>
</table>

**Note** To create and build a Visual C++ Solution (.sln) file with Debug configuration, select RTW.MSVCBuild in the “Template makefile” field.
Compare Code Styles and STF Support

The code generator produces two styles of code. One code style is suitable for rapid prototyping (and simulation by using code generation). The other style is suitable for embedded applications. This table maps system target files to corresponding code styles.

**Code Styles Listed by System Target File**

<table>
<thead>
<tr>
<th>System Target File</th>
<th>Code Style</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embedded Coder embedded real-time (ERT)</td>
<td>Embedded</td>
<td>A starting point for embedded application development of C/C++ generated code.</td>
</tr>
<tr>
<td>Simulink Coder generic real-time (GRT)</td>
<td>Rapid prototyping</td>
<td>A starting point for creating a rapid prototyping target hardware that does not use real-time operating system tasking primitives and for verifying the generated C/C++ code on your desktop computer.</td>
</tr>
<tr>
<td>Rapid simulation (RSIm)</td>
<td>Rapid prototyping</td>
<td>Provides non-real-time simulation on your desktop computer and a high-speed or batch simulation tool.</td>
</tr>
<tr>
<td>S-function</td>
<td>Rapid prototyping</td>
<td>Creates a C MEX S-function for simulation within another Simulink model.</td>
</tr>
<tr>
<td>Simulink Desktop Real-Time</td>
<td>Rapid prototyping</td>
<td>Runs a model in real time at interrupt level while your desktop computer runs Microsoft Windows in the background.</td>
</tr>
<tr>
<td>Simulink Real-Time</td>
<td>Rapid prototyping</td>
<td>Runs a model in real time on a desktop computer running the Simulink Real-Time kernel.</td>
</tr>
</tbody>
</table>

Third-party vendors supply additional system target files to support code generation for their products. For more information about third-party products, see the vendor website or the MathWorks Connections program web page: https://www.mathworks.com/products/connections.

**Compare Generated Code Features by Product**

The code generation process for real-time system target files (such as GRT) provides many embedded code optimizations. Selecting an ERT-based system target file offers
more extensive features than GRT. The system target file selection determines the available features for the code generation product. As you select the code generation target that matches your development process, use this table to compare code generation features available with Simulink Coder and features available with Embedded Coder.
### Compare Code Generation Features for Simulink Coder Versus Embedded Coder

<table>
<thead>
<tr>
<th>Feature</th>
<th>Simulink Coder</th>
<th>Embedded Coder</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>rtModel data structure</strong></td>
<td>• Full rtModel structure generated</td>
<td>• rtModel is optimized for the model</td>
</tr>
<tr>
<td></td>
<td>• GRT variable declaration: rtModel_model_model_M_;</td>
<td>• Optional suppression of error status field and data logging fields</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• ERT variable declaration: RT_MODEL_model_model_M_;</td>
</tr>
<tr>
<td><strong>Custom storage classes (CSCs)</strong></td>
<td>Code generation ignores CSCs. Objects are assigned a CSC default to Auto storage class.</td>
<td>Code generation with CSCs is supported</td>
</tr>
<tr>
<td><strong>HTML code generation report</strong></td>
<td>Basic HTML code generation report</td>
<td>Enhanced report with additional detail and hyperlinks to the model</td>
</tr>
<tr>
<td><strong>Symbol formatting</strong></td>
<td>Symbols (for signals, parameters, and so on) are generated in accordance with hard-coded default</td>
<td>Detailed control over generated symbols</td>
</tr>
<tr>
<td><strong>User-defined maximum identifier length for generated symbols</strong></td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td><strong>Generation of terminate function</strong></td>
<td>Generated</td>
<td>Option to suppress the terminate function</td>
</tr>
<tr>
<td><strong>Combined output/update function</strong></td>
<td>Separate output/update functions are generated</td>
<td>Option to generate combined output/update function</td>
</tr>
<tr>
<td><strong>Optimized data initialization</strong></td>
<td>Not available</td>
<td>Options to suppress generation of unnecessary initialization code for zero-valued memory, I/O ports, and so on</td>
</tr>
<tr>
<td><strong>Comments generation</strong></td>
<td>Basic options to include or suppress comment generation</td>
<td>Options to include Simulink block descriptions, Stateflow object descriptions, and Simulink data object descriptions in comments</td>
</tr>
<tr>
<td>Feature</td>
<td>Simulink Coder</td>
<td>Embedded Coder</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Module Packaging Features (MPF)</td>
<td>Not supported</td>
<td>Extensive code customization features See “Control Data Type Names in Generated Code” (Embedded Coder) and “MPT Data Object Properties” (Embedded Coder).</td>
</tr>
<tr>
<td>System target file-optimized data types</td>
<td>Requires full tmwtypes.h header file</td>
<td>Generates optimized rtwtypes.h header file, including definitions required by the system target file</td>
</tr>
<tr>
<td>header file</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User-defined types</td>
<td>User-defined types default to base types in code generation</td>
<td>User-defined data type aliases are supported in code generation</td>
</tr>
<tr>
<td>Rate grouping</td>
<td>Not supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Auto-generation of main program module</td>
<td>Not supported. Static main program module is provided.</td>
<td>Automated and customizable generation of main program module is supported (static main program also available)</td>
</tr>
<tr>
<td>Reusable (multi-instance) code generation</td>
<td>Option to generate reusable code with dynamic memory allocation</td>
<td>Option to generate reusable code with static or dynamic memory allocation</td>
</tr>
<tr>
<td>Software constraint options</td>
<td>Support for floating-point, complex, and nonfinite numbers is enabled</td>
<td>Options to enable or disable support for floating-point, complex, and nonfinite numbers</td>
</tr>
<tr>
<td>Application life span</td>
<td>Defaults to inf</td>
<td>User-specified. Determines most efficient word size for integer timers</td>
</tr>
<tr>
<td>Software-in-the-loop (SIL) testing</td>
<td>Model reference simulation target can be used for SIL testing</td>
<td>Additional SIL testing support by using auto-generation of SIL block</td>
</tr>
<tr>
<td>ANSI-C/C++ code generation</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>ISO-C/C++ code generation</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>GNU®-C/C++ code generation</td>
<td>Supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>
### Compare Generated Code Features by STF

The code generator supports a selection of generated code features for different types of system target files. In each system target file, the value of the `CodeFormat` TLC variable identifies the set of features.

This table summarizes how different system target files support applications.

<table>
<thead>
<tr>
<th>Application</th>
<th>System Target File (STF)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed- or variable-step acceleration</td>
<td>RSIM, S-Function, Model Reference</td>
</tr>
<tr>
<td>Fixed-step real-time deployment</td>
<td>GRT, ERT, Simulink Real-Time, Simulink Desktop Real-Time, ...</td>
</tr>
</tbody>
</table>

This table summarizes the various options available for each System target file selection, with the exceptions noted.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Simulink Coder</th>
<th>Embedded Coder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate scalar inlined parameters as #DEFINE statements</td>
<td>Not supported</td>
<td>Supported</td>
</tr>
<tr>
<td>MAT-file variable name modifier</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Data exchange: C API, ASAP2, external mode</td>
<td>Supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>
## Features Supported in Code Generated for System Target Files (STF)

<table>
<thead>
<tr>
<th>Feature</th>
<th>System Target Files (STF)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>grt.tlc (See note 1.)</td>
</tr>
<tr>
<td>Static memory allocation</td>
<td>X</td>
</tr>
<tr>
<td>Dynamic memory allocation</td>
<td>(See notes 4, 5.)</td>
</tr>
<tr>
<td>Continuous time</td>
<td>X</td>
</tr>
<tr>
<td>C/C++ MEX S-functions (noninlined)</td>
<td>X</td>
</tr>
<tr>
<td>S-function (inlined)</td>
<td>X</td>
</tr>
<tr>
<td>Minimize RAM/ROM usage</td>
<td>X</td>
</tr>
<tr>
<td>Supports external mode</td>
<td>X</td>
</tr>
<tr>
<td>Rapid prototyping</td>
<td>X</td>
</tr>
<tr>
<td>Production code</td>
<td>X</td>
</tr>
<tr>
<td>Feature</td>
<td>System Target Files (STF)</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td></td>
<td>grt.tlc (See note 1.)</td>
</tr>
<tr>
<td>Batch parameter tuning and Monte Carlo methods</td>
<td>X</td>
</tr>
<tr>
<td>System-level Simulator</td>
<td>X</td>
</tr>
<tr>
<td>Executes in hard real time</td>
<td>X</td>
</tr>
<tr>
<td>Non-real-time executable included</td>
<td>X</td>
</tr>
<tr>
<td>Multiple instances of model</td>
<td>X</td>
</tr>
<tr>
<td>Supports variable-step solvers</td>
<td>X</td>
</tr>
<tr>
<td>Supports SIL/PIL</td>
<td>X</td>
</tr>
</tbody>
</table>

**Notes**

1. System Target Files:
• **grt.tlc** - generic real-time target
• **ert.tlc** - embedded real-time target
• **ert_shrlib.tlc** - embedded real-time target shared library
• **rtwsfcn.tlc** - S-Function
• **rsim.tlc** - rapid simulation
• **sldrt.tlc** - Simulink Desktop Real-Time
• **slrt.tlc** - Simulink Real-Time
• **Other** - The embedded real-time capabilities in Simulink Coder support other system target files

2 Does not apply to GRT-based system target files. Applies to only ERT-based system target files.

3 The default GRT and ERT *rt_main* files emulate execution of hard real time. When explicitly connected to a real-time clock, they execute in hard real time.

4 You can generate code for multiple instances of a Stateflow chart or subsystem containing a chart, except when the chart contains exported graphical functions or the Stateflow model contains machine-parented events.

5 Select the value Reusable function for **Code interface packaging** in the **Code Generation** > **Interface** pane in the Configuration Parameters dialog box.

**See Also**

**More About**

• “Configure a System Target File” on page 19-2
• “Configure STF-Related Code Generation Parameters” on page 19-7
• “Configure a Code Replacement Library” on page 19-17
• “Configure Standard Math Library for Target System” on page 19-18
Internationalization Support in Simulink Coder
Internationalization and Code Generation

Internationalization support in software development tooling is vital for enabling efficient globalization. If there is any possibility of future collaboration with others across locales, consider internationalization from project inception. Internationalization can prevent rework or having to develop a new model design. The relevant requirement concerns locale settings.

Locale Settings

On a computer, a locale setting defines the language (character set encoding) for the user interface and the display formats for information such as time, date, and currency. The encoding dictates the number of characters that a locale can render. For example, the US-ASCII coded character set (codeset) defines 128 characters. A Unicode® codeset, such as UTF-8, defines more than 1,100,000 characters.

For code generation, the locale setting determines the character set encoding of generated file content. To avoid garbled text or incorrectly displayed characters, the locale setting for your MATLAB session must be compatible with the setting for your compiler and operating system. For information on finding and changing the operating system setting, see “Internationalization” (MATLAB) or see the operating system documentation.

To check a model for characters that cannot be represented in the locale setting of your current MATLAB session, use the Simulink Model Advisor check “Check model for foreign characters” (Simulink).

Prepare to Generate Code for Mixed Languages and Locales

To prepare to generate code for a model, identify:

- The operating system locale.
- The locale of the MATLAB session.
- Code generation requirements for:
  - Target Language Compiler files
  - Code generation template files that include comments (requires Embedded Coder)
Character Set Limitations

Target language compiler files support user default encoding only. To produce international, custom generated code that is portable, use the 7-bit ASCII character set.

XML Escape Sequence Replacements

The code generator replaces characters that are not represented in the character set encoding of a model with XML escape sequences. Escape sequence replacements occur for block, signal, and Stateflow object names that appear in:

- Generated code comments
- Code generation reports
- Block paths logged to MAT-files
- Block paths logged to C API files model_capi.c (or .cpp) and model_capi.h

Generate and Review Code with Mixed Languages and Mixed Locales

This example shows how to use the code generator to generate and review code for use in mixed languages and mixed locales.

Before using this example, see “Internationalization and Code Generation” on page 20-2 or “Internationalization and Code Generation” (Embedded Coder).

The rtwdemo_unicode model configuration uses the Embedded Coder (R) ert.tlc system target file. To see internationalization and localization support with Simulink Coder®, configure the model to use the grt.tlc system target file. The example indicates the support that is specific to Embedded Coder® (for example, code generation templates).

The model configuration specifies files and settings that control how the code generator handles localization for:

- C and C++ API interfaces
- Code generation template (CGT) files (requires Embedded Coder®)
- Target Language Compiler (TLC) files that apply code customizations (requires Embedded Coder®)
Open the example model `rtwdemo_unicode`.

Labels in the model appear in multiple languages (Arabic, Chinese, English, German, and Japanese) and various Unicode symbols.

```matlab
text = 'rtwdemo_unicode';
open_system(text);
```

Verify Locale Settings

Verify that the locale setting for your MATLAB® software is compatible with your compiler. See the documentation for your operating system or the following MATLAB documentation:

- “Set Locale on Windows Platforms” (MATLAB)
- “Set Locale on Linux Platforms” (MATLAB)
- “Set Locale on Mac Platforms” (MATLAB)

Verify Model for Use of Foreign Characters

To verify the model for characters that the code generator cannot represent in the model's current character set encoding, use the Simulink® Model Advisor check **Check model for foreign characters**.

1. Open the Model Advisor in Simulink®. Select **Analysis > Model Advisor > Model Advisor**. Or, in the Command Window, type:

```matlab
modeladvisor('rtwdemo_unicode')
```
2. Expand **By Product**.

3. Expand **Simulink**.

4. Select **Check model for foreign characters**

5. Click **Run This Check**.

6. Review the results. Several warnings appear. Verify that the characters in the model can be represented in the current character set encoding.

7. Close the Model Advisor.

**Code Generation Template Files**

To use a code generation template file with unicode characters when generating code, complete these steps (requires Embedded Coder®). Otherwise, go to the next section.

1. Open the **Configuration Parameters** dialog box.

2. Navigate to the **Code Generation > Template** pane. The model is configured to use the code generation template file `rtwdemo_unicode.cgt`. That file adds comments to the top of generated code files. For the code generator to apply escape sequence replacements for the character set encoding `UTF-8`, enable replacements by specifying:

   `<encodingIn = "encoding-name">`

3. Open the file `/toolbox/rtw/rtwdemos/rtwdemo_unicode.cgt`.

   **edit rtwdemo_unicode.cgt**

4. Find the line of code that enables escape sequence replacements for the character set encoding `UTF-8`.

   `<encodingIn = "UTF-8">`


**Generated File Customization Template**

To use file customization templates with unicode characters when generating code, complete these steps (requires Embedded Coder®). Otherwise, go to the next section.
You can specify customizations to generated code files by using TLC code. TLC files support user default encoding only. To produce international custom generated code that is portable, use the 7-bit ASCII character set.

1. Open the Configuration Parameters dialog box.

2. Navigate to the **Code Generation > Template** pane. The model is configured to use the code customization file `example_file_process.tlc`. That file customizes the generated code just before the code generator writes the code files. For example, the file adds a C source file, corresponding include file, and `#define` and `#include` statements.

3. Open the file `/toolbox/rtw/rtwdemos/example_file_process.tlc`.

```matlab
edit example_file_process.tlc
```

4. Before generating code, uncomment the following line of code:

```matlab
%% %assign ERTCustomFileTest = TLC_TRUE%
```

5. Close the file `/toolbox/rtw/rtwdemos/example_file_process.tlc`.

**Generate C Code**

Generate C code and a code generation report.

```matlab
evalc('rtwbuild(''rtwdemo_unicode'')');
```

**Review the Generated Code**

For characters that are not in the current MATLAB® character set encoding, the code generator uses escape sequence replacements to render characters correctly in the code generation report.

1. If the code generation report for model `rtwdemo_unicode` is not open, in the Command Window, type:

```matlab
coder.report.open(''rtwdemo_unicode'')
```

2. Review the generated code in `rtwdemo_unicode.c` and `rtwdemo_unicode.h`. Names of model elements appear in code comments as replacement names in the local language.
3. Open the Traceability Report. The report maintains traceability information, even when the name contains characters that are not represented in the current encoding. Names of model elements appear in the report as replacement names in the local language.

4. Scroll down to and click the code location link for the first Chart (State 'Selection' <S2>:23). The report view changes to show the corresponding code in rtwdemo_unicode.c.

5. In the code comment, click the <S2>:23 link. The model window shows the chart in a new tab.

6. In the model window, right-click that chart. Select C/C++ Code > Navigate to C/C++ Code. The report view changes to show the named constant section of code for that chart.

7. Close the code generation report, Model Advisor, and model. In the Command Window, type:

   coder.report.close();
   bdclose('all');

**Generate C++ Code**

Generate C++ code and a code generation report.

1. Open the model.

   model = 'rtwdemo_unicode';
   open_system(model);
2. Change **Configuration Parameters > Code Generation > Language** to C++. Or, in the Command Window, type:

```matlab
set_param('rtwdemo_unicode','TargetLang','C++');
```

3. Change **Configuration Parameters > Code Generation > Interface > Code interface packaging** to C++ class. Or, in the Command Window, type:

```matlab
set_param('rtwdemo_unicode','CodeInterfacePackaging','C++ class');
```

4. Generate C++ code and a code generation report.

```matlab
evalc('rtwrebuild(''rtwdemo_unicode'')');
```

5. To see internationalization and localization support, review the generated code. See **Review the Generated Code**.

6. Close the code generation report and model. In the Command Window, type:

```matlab
coder.report.close();
bdclose('all');
```

**See Also**

**More About**
- “Locale Settings for MATLAB Process” (MATLAB)
Source Code Generation in Simulink Coder

- “Configure Model, Generate Code, and Simulate” on page 21-2
- “Configure Model and Generate Code” on page 21-13
- “Configure Data Interface” on page 21-20
- “Call External C Functions” on page 21-29
- “Reload Generated Code” on page 21-36
- “Manage Build Process Folders” on page 21-37
- “Manage Build Process Files” on page 21-43
- “Manage Build Process File Dependencies” on page 21-53
- “Add Build Process Dependencies” on page 21-64
- “Enable Build Process for Folder Names with Spaces” on page 21-70
- “Code Generation of Matrices and Arrays” on page 21-76
- “Cross-Release Shared Utility Code Reuse” on page 21-84
- “Cross-Release Code Integration” on page 21-87
- “Generate Code Using Simulink® Coder™” on page 21-103
Configure Model, Generate Code, and Simulate

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“About This Example” on page 21-2</td>
</tr>
<tr>
<td>“Functional Design of the Model” on page 21-3</td>
</tr>
<tr>
<td>“View the Top Model” on page 21-3</td>
</tr>
<tr>
<td>“View the Subsystems” on page 21-4</td>
</tr>
<tr>
<td>“Simulation Test Environment” on page 21-5</td>
</tr>
<tr>
<td>“Run Simulation Tests” on page 21-10</td>
</tr>
<tr>
<td>“Key Points” on page 21-11</td>
</tr>
<tr>
<td>“Learn More” on page 21-12</td>
</tr>
</tbody>
</table>

About This Example

Learning Objectives

- Learn about the functional behavior of the example model.
- Learn about the role of the example test harness and its components.
- Run simulation tests on a model.

Prerequisites

- Ability to open and modify Simulink models and subsystems.
- Understand subsystems and how to view subsystem details.
- Understand referenced models and how to view referenced model details.
- Ability to set model configuration parameters.

Required Files

Before you use each example model file, place a copy in a writable location and add it to your MATLAB path.

- `rtwdemo_throttlecntrl` model file
- `rtwdemo_throttlecntrl_testharness` model file
Functional Design of the Model

This example uses a simple, but functionally complete, example model of a throttle controller. The model features redundant control algorithms. The model highlights a standard model structure and a set of basic blocks in algorithm design.

View the Top Model

Open rtwdemo_throttlecntrl and save a copy as throttlecntrl in a writable location on your MATLAB path.

Note This model uses Stateflow software.

The top level of the model consists of the following elements:

<table>
<thead>
<tr>
<th>Subsystems</th>
<th>PI_ctrl_1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>PI_ctrl_2</td>
</tr>
<tr>
<td></td>
<td>Define_Throt_Param</td>
</tr>
<tr>
<td></td>
<td>Pos_Command_Arbitratin</td>
</tr>
<tr>
<td>Top-level input</td>
<td>pos_rqst</td>
</tr>
<tr>
<td></td>
<td>fbk_1</td>
</tr>
<tr>
<td></td>
<td>fbk_2</td>
</tr>
</tbody>
</table>
Top-level output

| pos_cmd_one  
| pos_cmd_two  
| ThrotComm1  

Signal routing

*Omit blocks that change the value of a signal, such as Sum and Integrator*

The layout uses a basic architectural style for models:

- Separation of calculations from signal routing (lines and buses)
- Partitioning into subsystems

You can apply this style to a wide range of models.

**View the Subsystems**

Explore two of the subsystems in the top model.

1. If not already open, open `throttlecntrl`.

Two subsystems in the top model represent proportional-integral (PI) controllers, `PI_ctrl_1` and `PI_ctrl_2`. At this stage, these identical subsystems, use identical data.

2. Open the `PI_ctrl_1` subsystem.
The PI controllers in the model are from a library, a group of related blocks or models for reuse. Libraries provide one of two methods for including and reusing models. The second method, model referencing, is described in “Simulation Test Environment” on page 21-5. You cannot edit a block that you add to a model from a library. Edit the block in the library so that instances of the block in different models remain consistent.

3 Open the Pos_Command_Arbitration subsystem. This Stateflow chart performs basic error checking on the two command signals. If the command signals are too far apart, the Stateflow diagram sets the output to a fail_safe position.

4 Close throttlecntrl.

Simulation Test Environment

To test the throttle controller algorithm, incorporate it into a test harness. A test harness is a model that evaluates the control algorithm and offers the following benefits:

- Separates test data from the control algorithm.
- Separates the plant or feedback model from the control algorithm.
- Provides a reusable environment for multiple versions of the control algorithm.

The test harness model for this example implements a common simulation testing environment consisting of the following parts:

- Unit under test
- Test vector source
- Evaluation and logging
- Plant or feedback system
- Input and output scaling

Explore the simulation testing environment.

1. Open the test harness model `rtwdemo_throttlecntrl_testharness` and save a copy as `throttlecntrl_testharness` in a writable location on your MATLAB path.

2. Set up your `throttlecntrl` model as the control algorithm of the test harness.
   a. Open the `Unit_Under_Test` block and view the control algorithm.
   b. View the model reference parameters by right-clicking the `Unit_Under_Test` block and selecting **Block Parameters (ModelReference)**.
rtwdemo_throttlecntrl appears as the name of the referenced model.

c  Change the value of **Model name** to throttlecntrl.

d  Update the test harness model diagram by clicking **Simulation > Update Diagram**.

The control algorithm is the unit under test, as indicated by the name of the Model block, **Unit_Under_Test**.

The Model block provides a method for reusing components. From the top model, it allows you to reference other models (directly or indirectly) as compiled functions. By default, Simulink software recompiles the model when the referenced models change. Compiled functions have the following advantages over libraries:

- Simulation time is faster for large models.
• You can directly simulate compiled functions.
• Simulation requires less memory. Only one copy of the compiled model is in memory, even when the model is referenced multiple times.

3 Open the test vector source, implemented in this test harness as the `Test_Vectors` subsystem.

```
Group 1
PosRequest
ThrottleCommand_Act_Golden
pos_cmd_one_golden
pos_cmd_two_golden
throttle_cmd_error_golden
```

The subsystem uses a Signal Builder block for the test vector source. The block has data that drives the simulation (`PosRequest`) and provides the expected results used by the `Verification` subsystem. This example test harness uses only one set of test data. Typically, create a test suite that fully exercises the system.

4 Open the evaluation and logging subsystem, implemented in this test harness as subsystem `Verification`.

A test harness compares control algorithm simulation results against golden data — test results that exhibit the desired behavior for the control algorithm as certified by an expert. In the `Verification` subsystem, an Assertion block compares the simulated throttle value position from the plant against the golden value from the test harness. If the difference between the two signals is greater than 5%, the test fails and the Assertion block stops the simulation.
Alternatively, you can evaluate the simulation data after the simulation completes execution. Perform the evaluation with either MATLAB scripts or third-party tools. Post-execution evaluation provides greater flexibility in the analysis of data. However, it requires waiting until execution is complete. Combining the two methods can provide a highly flexible and efficient test environment.

5 Open the plant or feedback system, implemented in this test harness as the Plant subsystem.

The Plant subsystem models the throttle dynamics with a transfer function in canonical form. You can create plant models to varying levels of fidelity. It is common to use different plant models at different stages of testing.

6 Open the input and output scaling subsystems, implemented in this test harness as Input_Signal_Scaling and Output_Signal_Scaling.
The subsystems that scale input and output perform the following primary functions:

- Select input signals to route to the unit under test.
- Select output signals to route to the plant.
- Rescale signals between engineering units and units that are writable for the unit under test.
- Handle rate transitions between the plant and the unit under test.

Save and close `throttlecntrl_testharness`.

**Run Simulation Tests**

1. Check that your working folder is set to a writable folder, such as the folder into which you placed copies of the example model files.
2. Open your copy of the test harness model, `throttlecntrl_testharness`.
3. Start a test harness model simulation. When the simulation is complete, the following results appear.
The lower-right hand plot shows the difference between the expected (golden) throttle position and the throttle position that the plant calculates. If the difference between the two values is greater than ±0.05, the simulation stops.

4 Save and close throttle controller and test harness models.

**Key Points**

- A basic model architecture separates calculations from signal routing and partitions the model into subsystems
- Two options for model reuse include block libraries and model referencing.
- If you represent your control algorithm in a test harness as a Model block, specify the name of the control algorithm model in the Model Reference Parameters dialog box.
A test harness is a model that evaluates a control algorithm. Typically, a harness consists of a unit under test, a test vector source, evaluation and logging, a plant or feedback system, and input and output scaling components.

The unit under test is the control algorithm being tested.

The test vector source provides the data that drives the simulation which generates results used for verification.

During verification, the test harness compares control algorithm simulation results against golden data and logs the results.

The plant or feedback component of a test harness models the environment that is being controlled.

When developing a test harness,

- Scale input and output components.
- Select input signals to route to the unit under test.
- Select output signals to route to the plant.
- Rescale signals between engineering units and units that are writable for the unit under test.
- Handle rate transitions between the plant and the unit under test.
- Before running simulation or completing verification, consider checking a model with the Model Advisor.

Learn More

- “Support Model Referencing” on page 39-84
- “Code Generation”
- “Signal Groups” (Simulink)
Configure Model and Generate Code

In this section...

“About This Example” on page 21-13
“Configure the Model for Code Generation” on page 21-14
“Save Your Model Configuration as a MATLAB Function” on page 21-15
“Check Model Conditions and Configuration Settings” on page 21-16
“Generate Code for the Model” on page 21-16
“Review the Generated Code” on page 21-17
“Generate an Executable” on page 21-18
“Key Points” on page 21-18

About This Example

Learning Objectives

• Configure a model for code generation.
• Apply model checking tools to discover conditions and configuration settings resulting in generation of inaccurate or inefficient code.
• Generate code from a model.
• Locate and identify generated code files.
• Review generated code.

Prerequisites

• Ability to open and modify Simulink models and subsystems.
• Ability to set model configuration parameters.
• Ability to use the Simulink Model Advisor.
• Ability to read C code.
• An installed, supported C compiler.

Required Files

rtwdemo_throttlecntrl model file
Configure the Model for Code Generation

Model configuration parameters determine the method for generating the code and the resulting format.

1. Open `rtwdemo_throttlecntrl` and save a copy as `throttlecntrl` in a writable location on your MATLAB path.

2. Open the Configuration Parameters dialog box, Solver pane. To generate code for a model, you must configure the model to use a fixed-step solver. The following table shows the solver configuration for this example.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
<th>Effect on Generated Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Fixed-step</td>
<td>Maintains a constant (fixed) step size, which is required for code generation</td>
</tr>
<tr>
<td>Solver</td>
<td>discrete (no continuous states)</td>
<td>Applies a fixed-step integration technique for computing the state derivative of the model</td>
</tr>
<tr>
<td>Fixed-step size</td>
<td>.001</td>
<td>Sets the base rate; must be the lowest common multiple of the rates in the system</td>
</tr>
</tbody>
</table>

3. Open the Code Generation > General pane and note that the System target file is set to `grt.tlc`.

**Note** The GRT (Generic Real-Time Target) configuration requires a fixed-step solver. However, the `rsim.tlc` system target file supports variable step code generation.
The system target file (STF) defines an environment for generating and building code for execution on a certain hardware or operating system platform. For example, one property of a system target file is the value for the CodeFormat TLC variable. The GRT configuration requires a fixed step solver and the rsim.tlc supports variable step code generation.

4 Open the Code Generation > Custom Code pane and under Include list of additional, select Include directories. The following path appears in the text field:

"$matlabroot\toolbox\rtw\rtwdemos\EmbeddedCoderOverview\"

This folder includes files that are required to build an executable for the model.

5 Close the dialog box.

**Save Your Model Configuration as a MATLAB Function**

You can save the settings of model configuration parameters as a MATLAB function by using the `getActiveConfigSet` function. In the MATLAB Command Window, enter:

```matlab
thcntrlAcs = getActiveConfigSet('throttlecntrl');
thcntrlAcs.saveAs('throttlecntrlModelConfig');
```

You can then use the resulting function (for example, `throttlecntrlModelConfig`) to:

- Archive the model configuration.
- Compare different model configurations by using differencing tools.
- Set the configuration of other models.

For example, you can set the configuration of model `myModel` to match the configuration of the throttle controller model by opening `myModel` and entering:

```matlab
myModelAcs = throttlecntrlModelConfig;
attachConfigSet('myModel', myModelAcs, true);
setActiveConfigSet('myModel', myModelAcs.Name);
```

For more information, see “Save a Configuration Set” (Simulink) and “Load a Saved Configuration Set” (Simulink).
Check Model Conditions and Configuration Settings

Before generating code for a model, use the Simulink Model Advisor to check the model for conditions and configuration settings. This check finds issues that can result in inaccurate or inefficient code.

1. Open throttlecntrl.
2. Start the Model Advisor by selecting Analysis > Model Advisor > Model Advisor. A dialog box opens showing the model system hierarchy.
3. Click throttlecntrl and then click OK. The Model Advisor window opens.
4. Expand By Product and Embedded Coder. By default, checks that do not trigger an Update Diagram, with one exception, are selected.
5. In the left pane, select the remaining checks and select Embedded Coder.
6. In the right pane, select Show report after run and click Run Selected Checks. The report shows a Run Summary that flags check warnings.
7. Review the report. The warnings highlight issues for embedded systems. At this point, you can ignore them. For more information about reports, see “View Model Advisor Reports” (Simulink).

Generate Code for the Model

1. Open throttlecntrl.
2. In the Configuration Parameters dialog box, select Code Generation > Generate code only and click Apply.
4. With the model open, initiate code generation and the build process for the model by using any of the following options:
   - Click the Build Model button.
   - Press Ctrl+B.
   - Select Code > C/C++ Code > Build Model.
   - Invoke the rtwbuild command from the MATLAB command line.
   - Invoke the slbuild command from the MATLAB command line.

Watch the messages that appear in the MATLAB Command Window. The code generator produces standard C and header files, and an HTML code generation
Configure Model and Generate Code

Review the Generated Code

1. Open Model Explorer, and in the **Model Hierarchy** pane, expand the node for the throttlecntrl model, and select the **Code for** node.

2. In the **Contents** pane, select **HTML Report**. Model Explorer displays the HTML code generation report for the throttle controller model.

3. In the HTML report, click the link for the generated C model file and review the generated code. Look for these items in the report:
   - Identification, version, timestamp, and configuration comments.
   - Links to help you navigate within and between files
   - Data definitions
   - Scheduler code
   - Controller code
   - Model initialization and termination functions
   - Call interface for the GRT system target file — output, update, initialization, start, and terminate

4. Save and close throttlecntrl.

Consider examining the following files. In the HTML report **Contents** pane, click the links. Or, in your working folder, explore the generated code subfolder.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>throttlecntrl.c</td>
<td>C file that contains the scheduler, controller, initialization, and interface code</td>
</tr>
<tr>
<td>throttlecntrl_data.c</td>
<td>C file that assigns values to generated data structures</td>
</tr>
<tr>
<td>throttlecntrl.h</td>
<td>Header file that defines data structures</td>
</tr>
<tr>
<td>throttlecntrl_private.h</td>
<td>Header file that defines data used only by the generated code</td>
</tr>
<tr>
<td>throttlecntrl_types.h</td>
<td>Header file that defines the model data structure</td>
</tr>
</tbody>
</table>
For more information, see “Manage Build Process File Dependencies” on page 21-53.

At this point, consider logging data to a MAT-file. For an example, see “Log Data for Analysis” on page 29-2.

**Generate an Executable**

1. Open `throttlecntrl`.
2. In the Configuration Parameters dialog box, clear the **Code Generation > Generate code only** check box and click **Apply**.
3. Press **Ctrl+B**. Watch the messages in the MATLAB Command Window. The code generator uses a template make file associated with your system target file selection to create an executable file. You can run this program on your workstation, independent of external timing and events.
4. Check your working folder for the file `throttlecntrl.exe`.
5. Run the executable. In the Command Window, enter `!throttlecntrl`. The `!` character passes the command that follows it to the operating system, which runs the standalone program.

The program produces one line of output in the Command Window:

```
** starting the model **
```

At this point, consider logging data to a MAT-file. For an example, see “Log Data for Analysis” on page 29-2.

**Tip** For UNIX platforms, run the executable in the Command Window with the syntax `!/executable_name`. If preferred, run the executable from an OS shell with the syntax `./executable_name`. For more information, see “Run External Commands, Scripts, and Programs” (MATLAB).

**Key Points**

- To generate code, change the model configuration to specify a fixed-step solver then select a system target file. Using the `grt.tlc` file requires a fixed-step solver. If the model contains continuous time blocks, you can use a variable-step solver with the `rsim.tlc` system target file.
• After debugging a model, consider configuring a model with parameter inlining enabled.
• Use the `getActiveConfigSet` function to save a model configuration for future use or to apply it to another model.
• Before generating code, consider checking a model with the Model Advisor.
• The code generator places generated files in a subfolder (`model_grt_rtw`) of your working folder.

See Also

More About
• “Code Generation”
• “Configuration Reuse” (Simulink)
• “Run Model Checks” (Simulink)
Configure Data Interface

About This Example

Learning Objectives

- Configure the data interface for code generated for a model.
- Control the name, data type, and data storage class of signals and parameters in generated code.

Prerequisites

- Understanding ways to represent and use data and signals in models.
- Familiarity with representing data constructs as data objects.
- Ability to read C code.

Required File

rtwdemo_throttlecntrl_datainterface model file

Declare Data

Most programming languages require that you declare data before using it. The declaration specifies the following information:

<table>
<thead>
<tr>
<th>Data Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scope</td>
<td>The region of the program that has access to the data</td>
</tr>
<tr>
<td>Duration</td>
<td>The period during which the data is resident in memory</td>
</tr>
<tr>
<td>Data type</td>
<td>The amount of memory allocated for the data</td>
</tr>
<tr>
<td>Initialization</td>
<td>An initial value, a pointer to memory, or NULL. If you do not provide an initial value, most compilers assign a zero value or a null pointer.</td>
</tr>
</tbody>
</table>

The following data types are supported for code generation.
## Supported Data Types

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>double</td>
<td>Double-precision floating point</td>
</tr>
<tr>
<td>single</td>
<td>Single-precision floating point</td>
</tr>
<tr>
<td>int8</td>
<td>Signed 8-bit integer</td>
</tr>
<tr>
<td>uint8</td>
<td>Unsigned 8-bit integer</td>
</tr>
<tr>
<td>int16</td>
<td>Signed 16-bit integer</td>
</tr>
<tr>
<td>uint16</td>
<td>Unsigned 16-bit integer</td>
</tr>
<tr>
<td>int32</td>
<td>Signed 32-bit integer</td>
</tr>
<tr>
<td>uint32</td>
<td>Unsigned 32-bit integer</td>
</tr>
<tr>
<td>Fixed-point data types</td>
<td>8-, 16-, 32-bit word lengths</td>
</tr>
</tbody>
</table>

A storage class is the scope and duration of a data item. For more information about storage classes, see “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82.

## Use Data Objects

In Simulink models and Stateflow charts, the following methods are available for declaring data: data objects and direct specification. This example uses the data object method. Both methods allow full control over the data type and storage class. You can mix the two methods in a single model.

In the MATLAB and Simulink environment, you can use data objects in various ways. This example focuses on the following types of data objects:

- Signal
- Parameter
- Bus

To configure the data interface for your model using the data object method, in the MATLAB base workspace, you define data objects. Then, associate them with your Simulink model or embedded Stateflow chart. When you build your model, the build process uses the associated base workspace data objects in the generated code.

You can set the values of the data object properties, which include:
• Data type
• Storage class
• Value (parameters)
• Initial value (signals)
• Alias (define a different name in the generated code)
• Dimension (typically inherited for parameters)
• Complexity (inherited for parameters)
• Unit (physical measurement unit)
• Minimum value
• Maximum value
• Description (used to document your data objects — does not affect simulation or code generation)

You can create and inspect base workspace data objects by entering commands in the MATLAB Command Window or by using Model Explorer. To explore base workspace signal data objects, use these steps:

1. Open `rtwdemo_throttlecntrl_datainterface` and save a copy as `throttlecntrl_datainterface` in a writable location on your MATLAB path.
2. Open Model Explorer.
3. Select **Base Workspace**.
4. Select the `pos_cmd_one` signal object for viewing.
You can also view the definition of a signal object. In the MATLAB Command Window, enter `pos_cmd_one`:

```matlab
pos_cmd_one =
```

Signal with properties:

- **CoderInfo**: [1x1 Simulink.CoderInfo]
- **Description**: 'Throttle position command from the first PI controller'
- **DataType**: 'double'
- **Min**: -1
- **Max**: 1
- **Unit**: ''
- **Dimensions**: -1
- **DimensionsMode**: 'auto'
- **Complexity**: 'auto'
- **SampleTime**: -1
- **InitialValue**: '0'

To view other signal objects, in Model Explorer, click the object name or in the MATLAB Command Window, enter the object name. The following table summarizes object characteristics for some of the data objects in this model.
<table>
<thead>
<tr>
<th>Object Characteristics</th>
<th>pos_cmd_one</th>
<th>pos_rqst</th>
<th>P_InErrMap</th>
<th>ThrotComm*</th>
<th>ThrottleCommands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Top-level output</td>
<td>Top-level input</td>
<td>Calibration parameter</td>
<td>Top-level output structure</td>
<td>Bus definition</td>
</tr>
<tr>
<td>Data type</td>
<td>Double</td>
<td>Double</td>
<td>Auto</td>
<td>Auto</td>
<td>Structure</td>
</tr>
<tr>
<td>Storage class</td>
<td>Exported global</td>
<td>Imported extern pointer</td>
<td>Constant</td>
<td>Exported global</td>
<td>None</td>
</tr>
</tbody>
</table>

* ThrottleCommands defines a Bus object; ThrotComm is an instantiation of the bus. If the bus is a nonvirtual bus, the signal generates a structure in the C code.

You can use a bus definition (ThrottleCommands) to instantiate multiple instances of the structure. In a model diagram, a bus object appears as a wide line with central dashes, as shown.

![Model Diagram](image)

**Add New Data Objects**

You can create data objects for named signals, states, and parameters. To associate a data object with a construct, the construct must have a name.

To find constructs for which you can create data objects, use the Data Object Wizard. This tool finds the constructs and then creates the objects for you. The model includes two signals that are not associated with data objects: fbk_1 and pos_cmd_two.

To find the signals and create data objects for them:

1. In the model window, select **Code > Data Objects > Data Object Wizard**. The Data Object Wizard dialog box opens.
2. To find candidate constructs, click **Find**. Constructs fbk_1 and pos_cmd_two appear in the dialog box.
3 To select both constructs, click **Select All**.

4 In the table, under **Class**, make sure that each proposed data object uses the class *Simulink.Signal*. To change the class of the objects, click **Change Class**.

5 To create the data objects, click **Create**. Constructs `fbk_1` and `pos_cmd_two` are removed from the dialog box.

6 Close the Data Object Wizard.

7 In the **Contents** pane of the Model Explorer, find the newly created objects `fbk_1` and `pos_cmd_two`.

---

**Enable Data Objects for Generated Code**

1 Enable a signal to appear in generated code.

   a In the model window, right-click the `pos_cmd_one` signal line and select **Properties**. A Signal Properties dialog box opens.

   b Make sure that you select the **Signal name must resolve to Simulink signal object** parameter.

![Signal Properties: pos_cmd_one](image)

2 Enable signal object resolution for the signals in the model. In the MATLAB Command Window, enter:

   ```matlab
disableimplicitsignalresolution('throttlecntrl_datainterface')
```

3 Save and close `throttlecntrl_datainterface`.

---

**Effects of Simulation on Data Typing**

In the throttle controller model, the data types are set to `double`. Because Simulink software uses the `double` data type for simulation, do not expect changes in the model behavior when you run the generated code. You verify this effect by running the test harness.
Before you run your test harness, update it to include the `throttlecntrl_datainterface` model.

**Note** The following procedure requires a Stateflow license.

1. Open `throttlecntrl_datainterface`.
2. Open your copy of test harness, `throttlecntrl_testharness`.
3. Right-click the `Unit_Under_Test` Model block and select **Block Parameters (ModelReference)**.
4. Set **Model name** to `throttlecntrl_datainterface`. Click **OK**.
5. Update the test harness model diagram.
6. Simulate the test harness.

The resulting plot shows that the difference between the golden and simulated versions of the model remains zero.
7  Save and close `throttlecntrl_testharness`.

**Manage Data**

Data objects exist in a separate file from the model in the base workspace. To save the data manually, in the MATLAB Command Window, enter `save`.

The separation of data from the model provides the following benefits:

- One model, multiple data sets:
• Use of different parameter values to change the behavior of the control algorithm (for example, for reusable components with different calibration values)
• Use of different data types to change targeted hardware (for example, for floating-point and fixed-point targeted hardware)
• Multiple models, one data set:
  • Sharing data between models in a system
  • Sharing data between projects (for example, transmission, engine, and wheel controllers can use the same CAN message data set)

**Key Points**

• You can declare data in Simulink models and Stateflow charts by using data objects or direct specification.
• From the Model Explorer or from the command line in the MATLAB Command Window, manage (create, view, configure, and so on) base workspace data.
• The Data Object Wizard provides a quick way to create data objects for constructs such as signals, buses, and parameters.
• Configure data objects explicitly to appear by name in generated code.
• Separation of data from model provides several benefits.

**See Also**

**More About**

• “Load Signal Data for Simulation” (Simulink)
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
• “Apply Custom Storage Classes to Individual Signal, State, and Parameter Data Elements” (Embedded Coder)
• “Control Placement of Global Data Definitions and Declarations in Generated Files” (Embedded Coder)
Call External C Functions

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“About This Example” on page 21-29</td>
</tr>
<tr>
<td>“Include External C Functions in a Model” on page 21-30</td>
</tr>
<tr>
<td>“Create a Block That Calls a C Function” on page 21-30</td>
</tr>
<tr>
<td>“Validate External Code in the Simulink Environment” on page 21-32</td>
</tr>
<tr>
<td>“Validate C Code as Part of a Model” on page 21-33</td>
</tr>
<tr>
<td>“Call a C Function from Generated Code” on page 21-35</td>
</tr>
<tr>
<td>“Key Points” on page 21-35</td>
</tr>
</tbody>
</table>

About This Example

Learning Objectives

- Evaluate a C function as part of a model simulation.
- Call an external C function from generated code.

Prerequisites

- Ability to open and modify Simulink models and subsystems.
- Ability to set model configuration parameters.
- Ability to read C code.
- An installed, supported C compiler.

Required Files

- rtwdemo_throttlecntrl_extfunccall model file
- rtwdemo_ValidateLegacyCodeVrsSim model file
- /toolbox/rtw/rtwdemos/EmbeddedCoderOverview/stage_4_files/SimpleTable.c
- /toolbox/rtw/rtwdemos/EmbeddedCoderOverview/stage_4_files/SimpleTable.h
Include External C Functions in a Model

Simulink models are one part of Model-Based Design. For many applications, a design also includes a set of pre-existing C functions created, tested (verified), and validated outside of a MATLAB and Simulink environment. You can integrate these functions easily into a model and the generated code. You can use external C code in the generated code to access hardware devices and external data files during rapid simulation runs.

This example shows you how to create a custom block that calls an external C function. When the block is part of the model, you can take advantage of the simulation environment to test the system further.

Create a Block That Calls a C Function

To specify a call to an external C function, use an S-Function block. You can automate the process of creating the S-Function block by using the Simulink Legacy Code Tool. Using this tool, specify an interface for your external C function. The tool then uses that interface to automate creation of an S-Function block.

1. Make copies of the files SimpleTable.c and SimpleTable.h, located in the folder `matlabroot/toolbox/rtw/rtwdemos/EmbeddedCoderOverview/stage_4_files` (open). Put the copies in your working folder.

2. Create an S-Function block that calls the specified function at each time step during simulation:

   a. In the MATLAB Command Window, create a function interface definition structure:

   ```matlab
   def=legacy_code('initialize')
   ```

   The data structure `def` defines the function interface to the external C code.

   ```matlab
   def =
   ```

   ```matlab
   SFunctionName: ''
   InitializeConditionsFcnSpec: ''
   OutputFcnSpec: ''
   StartFcnSpec: ''
   TerminateFcnSpec: ''
   HeaderFiles: {}
   SourceFiles: {}
   HostLibFiles: {}
   ```
Populate the function interface definition structure by entering the following commands:

```matlab
def.OutputFcnSpec=['double y1 = SimpleTable(double u1,',...
    'double p1[], double p2[], int16 p3)'];
def.HeaderFiles = {'SimpleTable.h'};
def.SourceFiles = {'SimpleTable.c'};
def.SFunctionName = 'SimpTableWrap';
```

Create the S-function:

```matlab
legacy_code('sfcn_cmex_generate', def)
```

Compile the S-function:

```matlab
legacy_code('compile', def)
```

Create the S-Function block:

```matlab
legacy_code('slblock_generate', def)
```

A new model window opens that contains the `SimpTableWrap` block.

Tip Creating the S-Function block is a one-time task. Once the block exists, you can reuse it in multiple models.

3 Save the model to your working folder as: `s_func_simptablewrap`.

4 Create a Target Language Compiler (TLC) file for the S-Function block:

```matlab
legacy_code('sfcn_tlc_generate', def)
```

The TLC file is the component of an S-function that specifies how the code generator produces the code for a block.

For more information on using the Legacy Code Tool, see:

- “Integrate C Functions Using Legacy Code Tool” (Simulink)
- “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7
Validate External Code in the Simulink Environment

When you integrate external C code with a Simulink model, before using the code, validate the functionality of the external C function code as a standalone component.

1. Open the model `rtwdemo.ValidateLegacyCodeVrsSim`. This model validates the S-function block that you created.

   ![Simulink model diagram]

   - The Sine Wave block produces output values from [-2 : 2].
   - The input range of the lookup table is from [-1 : 1].
   - The output from the lookup table is the absolute value of the input.
   - The lookup table output clips the output at the input limits.

2. Simulate the model.

3. View the validation results by opening the Validation subsystem and, in that subsystem, clicking the Scope block.

   The following figure shows the validation results. The external C code and the Simulink Lookup table block provide the same output values.
4 Close the validation model.

**Validate C Code as Part of a Model**

After you validate the functionality of the external C function code as a standalone component, validate the S-function in the model. Use the test harness model to complete the validation.

**Note** The following procedure requires a Stateflow license.

1 Open `rtwdemo_throttlecntrl_extfuncall` and save a copy to `throttlecntrl_extfuncall` in a writable folder on your MATLAB path.
2 Examine the `PI_ctrl_1` and `PI_ctrl_2` subsystems.
   a Lookup blocks have been replaced with the block you created using the Legacy Code Tool.
b  Note the block parameter settings for SimpTableWrap and SimpTableWrap1.
c  Close the Block Parameter dialog boxes and the PI subsystem windows.

3  Open the test harness model, right-click the Unit_Under_Test Model block, and select **Block Parameters (ModelReference)**.
4  Set **Model name** to throttlecntrl_extfunccall. Click **OK**.
5  Update the test harness model diagram.
6  Simulate the test harness.

The simulation results match the expected golden values.

7  Save and close throttlecntrl_extfunccall and throttlecntrl_testharness.
Call a C Function from Generated Code

The code generator uses a TLC file to process the S-Function block. Calls to C code embedded in an S-Function block:

• Can use data objects.
• Are subject to expression folding, an operation that combines multiple computations into a single output calculation.

1 Open `throttlecntrl_extfunccall`
2 Generate code for the model.
3 Examine the generated code in the file `throttlecntrl_extfunccall.c`
4 Close `throttlecntrl_extfunccall` and `throttlecntrl_testharness`.

Key Points

• You can easily integrate external functions into a model and generated code by using the Legacy Code Tool.
• Validate the functionality of external C function code which you integrate into a model as a standalone component.
• After you validate the functionality of external C function code as a standalone component, validate the S-function in the model.

See Also

More About

• “Integrate C Functions Using Legacy Code Tool” (Simulink)
• “S-Functions and Code Generation” on page 14-2
Reload Generated Code

You can reload the code generated for a model from the Model Explorer.

1. Click the **Code for model** node in the **Model Hierarchy** pane.
2. In the **Code** pane, click the **Refresh** link.

The code generator reloads the code for the model from the build folder.

See Also

More About

- “Rebuild a Model” on page 27-44
- “Control Regeneration of Top Model Code” on page 27-46
Manage Build Process Folders

The build process places generated files from Simulink diagram updates and model builds into a hierarchy of folders that is specified by default. You can change the default specification for build process folders, if, for example:

- Your company does not use the current working folder as the location for the code generation folder or the simulation cache folder.
- You place the code generation folder under version control, but do not place the simulation cache folder under version control.

The MATLAB session parameters CacheFolder, CodeGenFolder, and CodeGenFolderStructure are file generation control parameters that specify the folder locations for the build process. At the start of a MATLAB session, these Simulink preferences determine the values of the parameters:

**Simulation cache folder** (Simulink) – CacheFolder

**Code generation folder** (Simulink) – CodeGenFolder

**Code generation folder structure** (Simulink) – CodeGenFolderStructure

To modify the parameters during a MATLAB session, use `Simulink.fileGenControl`. The parameter values that you set expire at the end of the MATLAB session.

File Generation Control Parameters

This table provides information about how you can use the parameters to manage build process folders.
<table>
<thead>
<tr>
<th>MATLAB Session Parameter</th>
<th>Simulink Preference</th>
<th>Description</th>
</tr>
</thead>
</table>
| CacheFolder              | **Simulation cache folder** (Simulink) | The build process places generated files from Simulink diagram updates and model build artifacts for simulation in the simulation cache folder `simulationCacheFolder`. The folder is a root folder.

By default (`CacheFolder = ''`), `simulationCacheFolder` is the current working folder, `pwd`.

You can use the parameter to specify another folder. For example, if you want to:

- Separate generated files from the models and other source material.
- Reuse or share previously built simulation targets without having to set the current working folder back to a previous working folder. |
<table>
<thead>
<tr>
<th>MATLAB Session Parameter</th>
<th>Simulink Preference</th>
<th>Description</th>
</tr>
</thead>
</table>
| CodeGenFolder            | Code generation folder (Simulink) | The build process, which uses system target files to generate production code from a Simulink model, places the production code in the code generation folder `codeGenerationFolder`. The folder is a root folder. If you choose to generate an executable program file, the build process writes the file `model.exe` (Windows) or `model` (UNIX) to the folder. By default (`CodeGenFolder = ''`), `codeGenerationFolder` is the current working folder, `pwd`. You can use the parameter to specify another folder. For example, if you want to separate generated production code from:
  - Models and other source material.
  - Generated simulation artifacts.

If you specify the root folder of a drive as the code generation folder, the build process cannot generate code for your model. For example, `C:\`. |

| CodeGenFolderStructure  | Code generation folder structure (Simulink) | To specify the folder structure within the code generation folder, use the parameter. For example, if you configure models for different target environments, you can specify a separate subfolder for the generated code from each model. |
## Build Process Folders

This table provides information about how `CodeGenFolderStructure` controls the folder structure within the simulation cache folder and the code generation folder.

<table>
<thead>
<tr>
<th>Folder Name when <code>CodeGenFolderStructure</code> = 'ModelSpecific'</th>
<th>Folder Name when <code>CodeGenFolderStructure</code> = 'TargetEnvironmentSubfolder'</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>codeGenerationFolder/model_target_rtw</code></td>
<td><code>codeGenerationFolder/targetSpecific/model</code></td>
<td>Build folder, which stores generated source code and other files created by the build process. Contains the generated code modules, <code>model.c</code> and <code>model.h</code>, and the generated makefile, <code>model.mk</code>. <code>model</code> is the name of the source model.</td>
</tr>
<tr>
<td><code>codeGenerationFolder/slprj/target/model</code></td>
<td><code>codeGenerationFolder/targetSpecific/_ref/model</code></td>
<td>Model reference target files.</td>
</tr>
<tr>
<td><code>codeGenerationFolder/slprj/target/model/referenced_model_includes</code></td>
<td><code>codeGenerationFolder/targetSpecific/_ref/model/referenced_model_includes</code></td>
<td>Header files from models referenced by <code>model</code>.</td>
</tr>
<tr>
<td><code>codeGenerationFolder/slprj/target/model/tmwinternal</code></td>
<td><code>codeGenerationFolder/targetSpecific/_ref/model/tmwinternal</code></td>
<td>MAT-files used during code generation.</td>
</tr>
<tr>
<td>Folder Name when CodeGenFolderStructure = 'ModelSpecific'</td>
<td>Folder Name when CodeGenFolderStructure = 'TargetEnvironmentSub folder'</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>-----------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>codeGenerationFolder/SLPRJ/target/_sharedutils</td>
<td>codeGenerationFolder/SLPRJ/targetSpecific/_shared</td>
<td>Utility functions for model reference system target files, which are shared across models.</td>
</tr>
<tr>
<td>simulationCacheFolder/SLPRJ/sim/model</td>
<td>simulationCacheFolder/SLPRJ/sim/model</td>
<td>Simulation target files for referenced models.</td>
</tr>
<tr>
<td>simulationCacheFolder/SLPRJ/sim/model/tmwinternal</td>
<td>simulationCacheFolder/SLPRJ/sim/model/tmwinternal</td>
<td>MAT-files used during code generation.</td>
</tr>
<tr>
<td>simulationCacheFolder/SLPRJ/sim/_sharedutils</td>
<td>simulationCacheFolder/SLPRJ/sim/_sharedutils</td>
<td>Utility functions for simulation system target files, which are shared across models.</td>
</tr>
</tbody>
</table>

If the system target file is ERT-based, then these configuration parameters also control the location of shared utility code:

- Shared code placement (UtilityFuncGeneration)
- Existing shared code (Embedded Coder) (ExistingSharedCode)

You can use `RTW.getBuildDir` to display build folder information for the model.

**See Also**

`RTW.getBuildDir` | `Simulink.fileGenControl`

**More About**

- “Manage Build Process Files” on page 21-43
- “Manage Build Process File Dependencies” on page 21-53
- “Add Build Process Dependencies” on page 21-64
- “Enable Build Process for Folder Names with Spaces” on page 21-70
• “Build Process Workflow for Real-Time Systems” on page 27-32
• “Generate Code for Referenced Models” on page 7-4
• “Cross-Release Shared Utility Code Reuse” on page 21-84
• “Cross-Release Code Integration” on page 21-87
• “Generate Code and Simulate Models in a Simulink Project”
• “Generate Code and Simulate Models with Simulink Project API”
Manage Build Process Files

To apply generated code source and header files from the build process, it is helpful to understand the files that the build process generates and the conditions that control file generation. This information provides access to generated code resources, such as:

- Public interface to the model entry points
- Enumerated types corresponding to built-in data types
- Data structures that describe the model signals, states, and parameters

The code generator creates `model.*` files during the code generation and build process. You can customize the file names for generated header, source, and data files. For more information, see “Customize Generated File Names” (Embedded Coder). The code generator creates additional folders and dependency files to support shared utilities and model references. For more information about the folders that the build process creates, see “Manage Build Process Folders” on page 21-37. For an example that shows how to use Simulink project to manage build process folders, see “Generate Code and Simulate Models in a Simulink Project”.

Depending on model architectures and code generation options, the build process for a GRT-based system target file can produce files that the build process does not generate for an ERT-based system target file. Also, for ERT-based system target files, the build process packages generated files differently than for GRT-based system target files. See “Manage File Packaging of Generated Code Modules” (Embedded Coder).

**Note** By default, the build process deletes foreign (not generated) source files in the build folder. It is possible to preserve foreign source files in the build folder by following the guidelines in “Preserve External Code Files in Build Folder” on page 26-57.

The table describes the principal generated files. Within the generated file names shown in the table, the `model` represents the name of the model for which you are generating code. The `subsystem` represents the name of a subsystem within the model. When you select the **Create code generation report** parameter, the code generator produces a set of HTML files. There is one HTML file for each source file plus a `model_contents.html` index file in the `html` subfolder within your build folder. The source and header files in the table have dependency relationships. For descriptions of other file dependencies, see “Manage Build Process File Dependencies” on page 21-53 and “Add Build Process Dependencies” on page 21-64.
<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
</table>
| `builtin_typeid_types.h` | Defines an enumerated type corresponding to built-in data types. A model build generates this file when one or more of these conditions apply:  
  • Your model contains a Stateflow chart that uses messages.  
  • Your model configuration enables MAT-file logging.  
  • Your model configuration enables C API options in Code Generation > Interface. |
| `modelsources.txt`    | Lists additional sources to include in the compilation.                                                                                                                                                     |
| `model.bat`           | Contains Windows batch file commands that set the compiler environment and invoke the make utility. For more information about using this file, see “model.bat” on page 21-49.                                 |
| `model.c`             | Corresponds to the model file. The Target Language Compiler generates this C or C++ source code file. The file contains:  
  • Include files `model.h` and `model_private.h`  
  • Data, except data placed in `model_data.c`  
  • Model-specific scheduler code  
  • Model-specific solver code  
  • Model registration code  
  • Algorithm code  
  • Optional GRT wrapper functions |
<p>| <code>model.cpp</code>           |                                                                                                                                                                                                          |
| <code>model.exe</code> (Windows platform) | Executable program file. A model build generates this file unless you explicitly specify that the code generator produce code only. The build generates the executable in the current folder (not the build folder) under control of the make utility of your development system. |
| <code>model</code> (UNIX and Macintosh platforms) |                                                                                                                                                                                                          |</p>
<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
</table>
| `model.h`    | Defines model data structures and a public interface to the model entry points and data structures. Provides an interface to the real-time model data structure (`model_rtm`) via access macros.  
Subsystem `.c` or `.cpp` files in the model include `model.h`. This file includes:  
• Exported Simulink data symbols  
• Exported Stateflow machine parented data  
• Model data structures, including `rtM`  
• Model entry-point functions  
For more information, see “`model.h`” on page 21-49. |
| `model.mk`   | Generated makefile that controls compiling and linking the generated code into the final binary file by the `make` utility of your development system.  
If you set the `MAKEFLAGS` environment variable, do not select options with this variable that conflict with the current `make` utility used by the build process. |
| `model.rtw`  | Represents the compiled model.  
By default, the build process deletes this ASCII file when the build process is complete. You can choose to retain the file for inspection. |
| `model_capi.h` | (optional files) Contain data structures that describe the model signals, states, and parameters without using external mode.  
For more information, see “Exchange Data Between Generated and External Code Using C API” on page 30-2. |
<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
</table>
| `model_data.c`              | Contains (if conditionally generated) declarations for the parameters data structure and the constant block I/O data structure, and zero representations for structure data types that the model uses.  
  
  A model build generates this file when the model uses these data structures. The `extern` declarations for structures appear in `model.h`. When present, this file contains:  
  - Constant block I/O parameters  
  - Include files `model.h` and `model_private.h`  
  - Definitions for the zero representations for user-defined structure data types that the model uses  
  - Constant parameters |
| `model_dt.h`                | (optional file) Declares structures that contain data type and data type transition information for generated model data structures for supporting external mode. |
| `model_private.h`           | Contains local `define` constants and local data for the model and subsystems.  
  
  The generated source files from the model build include this file. When you interface external code with generated code from a model, include `model_private.h`. The file contains:  
  - Imported Simulink data symbols  
  - Imported Stateflow machine parented data  
  - Stateflow entry points  
  - Simulink Coder details (various macros, `enums`, and so forth, that are private to the code)  
  
  For more information, see “Manage Build Process File Dependencies” on page 21-53. |
<p>| <code>model_reference_types.h</code>   | Contains type definitions for timing bridges. A model build generates this file for a referenced model or a model containing model reference blocks. |</p>
<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>model_targ_data_map.m</code></td>
<td>(optional file) Contains MATLAB language commands that external mode uses to initialize the external mode connection.</td>
</tr>
<tr>
<td><code>model_types.h</code></td>
<td>Provides forward declarations for the real-time model data structure and the parameters data structure.</td>
</tr>
<tr>
<td></td>
<td>The generated header files from the model build include this file. Function declarations of reusable functions can use these structures.</td>
</tr>
<tr>
<td><code>multiword_types.h</code></td>
<td>Contains type definitions for multiple-word wide data types and their word-size chunks. If your code uses multiword data types, include this header file.</td>
</tr>
<tr>
<td></td>
<td>A model build generates this file when one or more of these conditions apply:</td>
</tr>
<tr>
<td></td>
<td>• Your model uses multiword data types.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration enables <strong>MAT-file logging</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration enables <strong>Code Generation &gt; Interface &gt; External mode</strong>.</td>
</tr>
<tr>
<td><code>rtGetInf.c</code></td>
<td>Declares and initializes global nonfinite values for inf, minus inf, and nan. Provides nonfinite comparison functions.</td>
</tr>
<tr>
<td><code>rtGetInf.h</code></td>
<td>A model build generates these files when one or more of these conditions apply:</td>
</tr>
<tr>
<td><code>rtGetNaN.c</code></td>
<td>• The model contains S-functions.</td>
</tr>
<tr>
<td><code>rtGetNaN.h</code></td>
<td>• The generated code from the model requires nonfinite numbers.</td>
</tr>
<tr>
<td><code>rt_nonfinite.c</code></td>
<td>• Your model configuration enables <strong>MAT-file logging</strong>.</td>
</tr>
<tr>
<td><code>rt_nonfinite.h</code></td>
<td>• Your model configuration selects <code>grt.tlc</code> as the <strong>System target file</strong> and enables the <strong>Classic call interface</strong>.</td>
</tr>
<tr>
<td><code>rtmodel.h</code></td>
<td>Contains <code>#include</code> directives required by static main program modules such as <code>rt_main.c</code>.</td>
</tr>
<tr>
<td></td>
<td>The build process does not create these modules at code generation time. The modules include <code>rt_model.h</code> to access model-specific data structures and entry points. If you create your own main program module, make sure to include <code>rtmodel.h</code>.</td>
</tr>
<tr>
<td>File</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| rtwtypes.h      | Provides the essential type definitions, `#define` statements, and enumerations.  
                          
                          For GRT-based system target files, `rtwtypes.h` includes `simstruc_types.h` which, in turn, includes `tmwtypes.h`.  
                          
                          For ERT-based system target files that do not generate a GRT interface and do not have noninlined S-functions, `rtwtypes.h` does not include `simstruc_types.h`.  
                          
                          For more information, see “rtwtypes.h” on page 21-50 and “Manage Build Process File Dependencies” on page 21-53. |
| rtw_proj.tmw     | Marker files.                                                                 |
| sl_proj.tmw      | The build process generates these files to help the `make` utility determine when to recompile and link the generated code. |
| rt_defines.h     | Contains type definitions for special mathematical constants (such as \( \pi \) and \( e \)) and defines the `UNUSED_PARAMETER` macro.  
                          
                          A model build generates this file when the generated code requires a mathematical constant definition or when the function body does not access a required model function argument. |
| rt_sfcn_helper.h | (optional files) Provide functions that the noninlined S-functions use in a model.  
                          
                          The noninlined S-functions use functions `rt_CallSys`, `rt_enableSys`, and `rt_DisableSys` to call downstream function-call subsystems. |
| rt_sfcn_helper.c |                                                              |
| subsystem.c     | (optional file) Contains C source code for each noninlined nonvirtual subsystem or copy the code when the subsystem is configured to place code in a separate file. |
| subsystem.h     | (optional file) Contains exported symbols for noninlined nonvirtual subsystems. |
model.bat

This file contains Windows batch file commands that set the compiler environment and invoke the make utility.

If you are using the toolchain approach for the build process, you also can use this batch file to extract information from the generated makefile, model.mk. The information includes macro definitions and values that appear in the makefile, such as CFLAGS (C compiler flags) and CPP_FLAGS (C++ compiler flags). With the folder containing model.bat selected as the current working folder, in the Command Window, type:

```bash
>> system('model.bat info')
```

On UNIX and Macintosh platforms, the code generator does not create the model.bat file. To extract information for toolchain approach builds from the generated makefile on these systems, in the Command Window, type:

```bash
>> system('gmake -f model.mk info')
```

model.h

The header file model.h declares model data structures and a public interface to the model entry points and data structures. This header file also provides an interface to the real-time model data structure (model_M) by using access macros. If your code interfaces to model functions or model data structures, include model.h:

- Exported global signals

  ```c
  extern int32_T INPUT;    /* '<Root>/In' */
  ```

- Global structure definitions

  ```c
  /* Block parameters (auto storage) */
  extern Parameters_mymodel mymodel_P;
  ```

- Real-time model (RTM) macro definitions

  ```c
  #ifndef rtmGetSampleTime
  # define rtmGetSampleTime(rtm, idx)
  ((rtm)->Timing.sampleTimes[idx])
  #endif
  ```

- Model entry point functions (ERT example)
extern void mymodel_initialize(void);
extern void mymodel_step(void);
extern void mymodel_terminate(void);

The main.c (or .cpp) file includes model.h. If the model build generates the main.c (or .cpp) file from a TLC script, the TLC source can include model.h.

#include "%<CompiledModel.Name>.h"

If main.c is a static source file, you can use the fixed header file name rtmodel.h. This file includes the model.h header file:

#include "model.h"      /* If main.c is generated */

or

#include "rtmodel.h"    /* If static main.c is used */

Other external source files can require to include model.h to interface to model data, for example exported global parameters or signals. The model.h file itself can have additional header dependencies due to requirements of generated code. See “System Header Files” on page 21-54 and “Code Generator Header Files” on page 21-57.

To reduce dependencies and reduce the number of included header files, see “Manage Build Process File Dependencies” on page 21-53.

rtwtypes.h

The header file rtwtypes.h defines data types, structures, and macros required by the generated code. You include rtwtypes.h for GRT and ERT system target files, instead of including tmwtypes.h or simstruc_types.h.

Often, the generated code requires that integer operations overflow or underflow at specific values. For example, when the code expects a 16-bit integer, the code does not accept an 8-bit or a 32-bit integer type. The C language does not set a standard for the number of bits in types such as char, int, and others. So, there is no universally accepted data type in C to use for sized-integers.

To accommodate this feature of the C language, the generated code uses sized integer types, such as int8_T, uint32_T, and others, which are not standard C types. In rtwtypes.h, the generated code maps these sized-integer types to the corresponding C keyword base type using information in the Hardware Implementation pane of the configuration parameters.
The code generator produces the optimized version of `rtwtypes.h` for ERT-based system target files when these conditions exist:

- The model has cleared the **Configuration Parameters > Code Generation > Interface > Advanced parameters > Classic call interface** option.
- The model does not contain noninlined S-functions.

Include `rtwtypes.h`. If you include it for GRT system target files, for example, it is easier to use your code with ERT-based system target files.

For GRT and ERT system target files, the location of `rtwtypes.h` depends on whether the build process uses the *shared utilities* location. If it uses a shared location, the code generator places `rtwtypes.h` in `slprj/target/_sharedutils`; otherwise, it places `rtwtypes.h` in the build folder (`model_target_rtw`). See “Specify Generated Code Interfaces” on page 19-7.

Source files include the `rtwtypes.h` header file when the source files use code generator type names or other code generator definitions. A typical example is for files that declare variables by using a code generator data type, for example, `uint32_T myvar`.

A source file that the code generator and an S-function use can use the preprocessor macro `MATLAB_MEX_FILE`. The macro definition comes from the `mex` function:

```c
#ifdef MATLAB_MEX_FILE
#include "tmwtypes.h"
#else
#include "rtwtypes.h"
#endif
```

A source file for the code generator `main.c` (or `cpp`) file includes `rtwtypes.h` without preprocessor checks.

```c
#include "rtwtypes.h"
```

Custom source files that the Target Language Compiler generates can also emit these `include` statements into their generated file.

See Also

More About

- “Manage Build Process Folders” on page 21-37
- “Manage Build Process File Dependencies” on page 21-53
- “Add Build Process Dependencies” on page 21-64
- “Enable Build Process for Folder Names with Spaces” on page 21-70
- “Generate Code and Simulate Models in a Simulink Project”
- “Generate Code and Simulate Models with Simulink Project API”
Manage Build Process File Dependencies

An important control of the size of generated code is managing the number and size of included files (dependencies). To reduce the number of system header files and generated header files that generated code requires, it is helpful to understand the dependencies that the build process generates and the conditions that lead to dependencies.

The dependency relationships among generated source and header files appear in the figure. Arrows coming from a file point to files it includes. Other dependencies exist, for example, on Simulink header files `tmwtypes.h` and `simstruc_types.h`, plus C or C++ library files. The figure maps inclusion relations between only those files that are generated in the build folder. These files can reference utility and model reference code located in a code generation folder. For more information about the folders and files that the build process creates, see “Manage Build Process Folders” on page 21-37 and “Manage Build Process Files” on page 21-43.

The two tables identify the conditions that control creation of dependency files for GRT and ERT targets. To manage build-related dependencies, consider how these conditions apply to your model and code generation process. Then, configure model parameters and code generation options to manage build process file dependencies.

Due to differences in file packaging options for code generated with ERT-based system target files, the file dependencies differ slightly from file packaging for code generated with GRT-based system target files. See “Manage File Packaging of Generated Code Modules” (Embedded Coder).

The parent system header files (`model.h`) include child subsystem header files (`subsystem.h`). In more layered models, subsystems similarly include their children's header files in the model hierarchy. As a consequence, subsystems are able to view recursively into their descendant subsystems and view into the root system because every `subsystem.c` or `subsystem.cpp` includes `model.h` and `model_private.h`.

In the figure, files `model.h`, `model_private.h`, and `subsystem.h` depend on the header file `rtwtypes.h`. If you use system target files that are not based on the ERT system target file, the source files that you generate can have additional dependencies on `tmwtypes.h` and `simstruc_types.h`. 


System Header Files

The system header files make function declarations, type definitions, and macro definitions available to the legacy or external code. Some code generation scenarios require including header files that are specific to the code generator product.

The code generator includes some system header files for broadly defined cases. For example, generated code includes `<stddef.h>` when the model contains a utility function that requires this header file. This approach helps identify header file dependencies:

1. Set the Shared code placement parameter to 'Shared location' and build the model. The code generator places the utility functions in `__sharedutils` folder.
2. Use a find-in-file utility (for example, grep utility) to search the `.c` and `.h` files in the `__sharedutils` folder for `#include`. The search results list the utilities with header file dependencies.
Use this information to identify utilities to remove from the model and reduce header file dependencies in the generated code.

For more information, see “Generate Shared Utility Code for Fixed-Point Functions” on page 9-82.

<table>
<thead>
<tr>
<th>System Header File</th>
<th>Description and Inclusion Conditions for GRT or ERT System Target Files</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;math.h&gt;</code></td>
<td>Defines math constants</td>
</tr>
<tr>
<td></td>
<td>GRT—Generated code does not include this file.</td>
</tr>
<tr>
<td></td>
<td>ERT—Generated code includes this file when the code honors your model configuration for solver <strong>Stop time</strong> and either:</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration enables <strong>MAT-file logging</strong>. See “MAT-file logging”.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration enables <strong>Code Generation &gt; Interface</strong> &gt; <strong>External mode</strong>.</td>
</tr>
<tr>
<td><code>&lt;float.h&gt;</code></td>
<td>Provides floating-point math functions</td>
</tr>
<tr>
<td></td>
<td>GRT—Generated code includes this file when your model contains a floating-point math function.</td>
</tr>
<tr>
<td></td>
<td>ERT—Generated code includes this file when your model contains a floating-point math function, unless a code replacement library entry overrides the function. For more information, see “Choose a Code Replacement Library” on page 23-8.</td>
</tr>
<tr>
<td><code>&lt;stddef.h&gt;</code></td>
<td>Defines NULL</td>
</tr>
<tr>
<td></td>
<td>GRT and ERT—Generated code includes this file when your model contains a utility function that requires this file.</td>
</tr>
<tr>
<td>System Header File</td>
<td>Description and Inclusion Conditions for GRT or ERT System Target Files</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td><code>&lt;stdio.h&gt;</code></td>
<td>Provides file I/O functions</td>
</tr>
<tr>
<td></td>
<td>GRT—Generated code includes this file when your model includes a To File block.</td>
</tr>
<tr>
<td></td>
<td>ERT—Generated code includes this file when either:</td>
</tr>
<tr>
<td></td>
<td>• Your model includes a To File block.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration enables <strong>MAT-file logging</strong>. See “MAT-file logging”.</td>
</tr>
<tr>
<td><code>&lt;stdlib.h&gt;</code></td>
<td>Provides utility functions such as the integer versions of <code>div()</code> and <code>abs()</code></td>
</tr>
<tr>
<td></td>
<td>GRT—Generated code includes this file when either:</td>
</tr>
<tr>
<td></td>
<td>• Your model includes a Stateflow chart.</td>
</tr>
<tr>
<td></td>
<td>• Your model includes a math function block configured for <code>mod()</code> or <code>rem()</code>, which generate calls to <code>div()</code>.</td>
</tr>
<tr>
<td></td>
<td>ERT—Generated code includes this file when either:</td>
</tr>
<tr>
<td></td>
<td>• Your model includes a Stateflow chart, and you select <strong>Support: floating-point numbers</strong>.</td>
</tr>
</tbody>
</table>
|                    | • Your model includes a math function block configured for `mod()` or `rem()`, which generate calls to `div()`.
<table>
<thead>
<tr>
<th>System Header File</th>
<th>Description and Inclusion Conditions for GRT or ERT System Target Files</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;string.h&gt;</code></td>
<td>Provides memory functions such as <code>memset()</code> and <code>memcpy()</code></td>
</tr>
</tbody>
</table>
|                   | GRT—Generated code includes this file when your model initialization code calls `memset()`.
|                   | ERT—Generated code includes this file when a block or model initialization code calls `memcpy()` or `memset()`.
|                   | For a list of relevant blocks, in the Command Window, type: `showblockdatatypetable`
|                   | Look for blocks with the N2 note. To omit calls to `memset()` from model initialization code, select the **Remove root level I/O zero initialization** and **Remove internal data zero initialization** optimization configuration parameters. |

**Code Generator Header Files**

Dependencies in the table for generated header files apply to the system target files `grt.tlc` and `ert.tlc`. System target files derived from these base system target files can have additional header dependencies. Code generation for blocks from blocksets, embedded targets, and custom S-functions can introduce additional header dependencies.

<table>
<thead>
<tr>
<th>Header File</th>
<th>Description and Inclusion Conditions for GRT or ERT System Target Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>builtin_typeid_types.h</td>
<td>Defines an enumerated type corresponding to built-in data types</td>
</tr>
<tr>
<td></td>
<td>GRT and ERT—Generated code includes this file when one or more of these conditions apply:</td>
</tr>
<tr>
<td></td>
<td>• Your model contains a Stateflow chart that uses messages.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration enables: <strong>MAT-file logging</strong>. See “MAT-file logging”.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration selects C API options at <strong>Code Generation &gt; Interface</strong>.</td>
</tr>
<tr>
<td>Header File</td>
<td>Description and Inclusion Conditions for GRT or ERT System Target Files</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>dt_info.h</td>
<td>Defines data structures for external mode</td>
</tr>
<tr>
<td></td>
<td>GRT and ERT—Generated code includes this file when your model configuration enables external mode.</td>
</tr>
<tr>
<td>ext_work.h</td>
<td>Defines external mode functions</td>
</tr>
<tr>
<td></td>
<td>GRT and ERT—Generated code includes this file when your model configuration enables external mode.</td>
</tr>
<tr>
<td>fixedpoint.h</td>
<td>Provides fixed-point support for noninlined S-functions</td>
</tr>
<tr>
<td></td>
<td>GRT—Generated code includes this file.</td>
</tr>
<tr>
<td></td>
<td>ERT—Generated code includes this file when either:</td>
</tr>
<tr>
<td></td>
<td>• Your model uses noninlined S-functions.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration selects <strong>Classic call interface</strong>.</td>
</tr>
<tr>
<td>model_reference_types.h</td>
<td>Contains type definitions for timing bridges</td>
</tr>
<tr>
<td></td>
<td>GRT and ERT—Generated code includes this file when building a reference model or building a model that contains model blocks.</td>
</tr>
<tr>
<td>model_types.h</td>
<td>Defines model-specific data types</td>
</tr>
<tr>
<td></td>
<td>GRT and ERT—Generated code includes this file.</td>
</tr>
<tr>
<td>multiword_types.h</td>
<td>Contains type definitions for multiword-wide data types and their word-size chunks</td>
</tr>
<tr>
<td></td>
<td>GRT and ERT—Generated code includes this file when one or more of these conditions apply:</td>
</tr>
<tr>
<td></td>
<td>• Your model uses multiword data types.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration enables <strong>MAT-file logging</strong>. See “MAT-file logging”.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration enables <strong>Code Generation &gt; Interface &gt; External mode</strong>.</td>
</tr>
<tr>
<td>Header File</td>
<td>Description and Inclusion Conditions for GRT or ERT System Target Files</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>rtGetInf.h</td>
<td>Support nonfinite numbers</td>
</tr>
<tr>
<td>rtGetNaN.h</td>
<td>GRT—Generated code includes this file when one or more of these conditions apply:</td>
</tr>
<tr>
<td></td>
<td>• Your model contains S-functions.</td>
</tr>
<tr>
<td></td>
<td>• The generated code requires nonfinite numbers.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration enables <strong>MAT-file logging</strong>. See “MAT-file logging”.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration selects the <strong>Classic call interface</strong>.</td>
</tr>
<tr>
<td>rt_nonfinite.h</td>
<td>ERT—Generated code includes this file when one or more of these conditions apply:</td>
</tr>
<tr>
<td></td>
<td>• Your model contains S-functions.</td>
</tr>
<tr>
<td></td>
<td>• The generated code requires nonfinite numbers.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration requires <strong>MAT-file logging</strong>. See “MAT-file logging”</td>
</tr>
<tr>
<td>rt_defines.h</td>
<td>Contains type definitions for special mathematical constants (such as π and e) and defines the <strong>UNUSED_PARAMETER</strong> macro</td>
</tr>
<tr>
<td></td>
<td>GRT and ERT—Generated code includes this file when either:</td>
</tr>
<tr>
<td></td>
<td>• The generated code requires a mathematical constant definition.</td>
</tr>
<tr>
<td></td>
<td>• The function body does not access a required model function argument.</td>
</tr>
<tr>
<td>Header File</td>
<td>Description and Inclusion Conditions for GRT or ERT System Target Files</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>rt_logging.h</td>
<td>Supports MAT-file logging and includes:</td>
</tr>
<tr>
<td></td>
<td>rtwtypes.h</td>
</tr>
<tr>
<td></td>
<td>builtin_typeid_types.h</td>
</tr>
<tr>
<td></td>
<td>multiword_types.h</td>
</tr>
<tr>
<td></td>
<td>rt_mxclassid.h</td>
</tr>
<tr>
<td></td>
<td>rtw_matlogging.h</td>
</tr>
<tr>
<td></td>
<td>GRT—Generated code includes this file.</td>
</tr>
<tr>
<td></td>
<td>ERT—Generated code includes this file when you model configuration enables <strong>MAT-file logging</strong>. See “<strong>MAT-file logging</strong>”.</td>
</tr>
<tr>
<td>rt_mxclassid.h</td>
<td>Defines mxArray class ID enumerations</td>
</tr>
<tr>
<td></td>
<td>GRT and ERT—Generated code includes this file when the code includes rt_logging.c.</td>
</tr>
<tr>
<td>rtw_continuous.h</td>
<td>Supports continuous time</td>
</tr>
<tr>
<td></td>
<td>GRT—Generated code includes this file when the code includes simstruc_types.h.</td>
</tr>
<tr>
<td></td>
<td>ERT—Generated code includes this file when your model configuration selects <strong>Support: continuous time</strong> and when the code does not already include simstruc.h.</td>
</tr>
<tr>
<td>rtw_extmode.h</td>
<td>Supports external mode</td>
</tr>
<tr>
<td></td>
<td>GRT—Generated code includes this file when the code includes simstruc_types.h.</td>
</tr>
<tr>
<td></td>
<td>ERT—Generated code includes this file when your model configuration selects external mode and when the code does not already include simstruc.h.</td>
</tr>
<tr>
<td>Header File</td>
<td>Description and Inclusion Conditions for GRT or ERT System Target Files</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| rtw_matlogging.h  | Supports MAT-file logging  
GRT—Generated code includes this file when the code includes simstruc_types.h and rt_logging.h.  
ERT—Generated code includes this file when the code includes rt_logging.h.                                                                                                                                                                                                                                              |
| rtw_solver.h      | Supports continuous states  
GRT—Generated code includes this file when the code includes simstruc_types.h.  
ERT—Generated code includes this file when your model configuration selects **Support: continuous time** and when the code does not already include simstruc.h.                                                                                                                       |
| rtwtypes.h        | Defines code generator data types  
GRT—Generated code includes this file. Use the complete version of the file, which includes tmwtypes.h and simstruc_types.h. See simstruc_types.h for dependencies.  
ERT—Generated code includes this file. Use the complete or optimized version of the file. See “rtwtypes.h” on page 21-50.  
If you include rtwtypes.h and tmwtypes.h in external code that you integrate with generated code, the #include for rtwtypes.h must precede the #include for tmwtypes.h. This ordering of #include statements preserves target-specific type definitions. If you reverse the order, a compiler error occurs. |
<table>
<thead>
<tr>
<th>Header File</th>
<th>Description and Inclusion Conditions for GRT or ERT System</th>
</tr>
</thead>
<tbody>
<tr>
<td>simstruc.h</td>
<td>Supports calling noninlined S-functions that use the Simstruct definition; also includes: limits.h string.h tmwtypes.h simstruc_types.h</td>
</tr>
<tr>
<td></td>
<td>GRT—Generated code includes this file.</td>
</tr>
<tr>
<td></td>
<td>ERT—Generated code includes this file when either:</td>
</tr>
<tr>
<td></td>
<td>• Your model uses noninlined S-functions.</td>
</tr>
<tr>
<td></td>
<td>• Your model configuration selects <strong>Classic call interface</strong>.</td>
</tr>
<tr>
<td>simstruc_types.h</td>
<td>Provides definitions that the generated code uses and includes the header files: rtw_matlogging.h rtw_extmode.h rtw_continuous.h rtw_solver.h sysran_types.h</td>
</tr>
<tr>
<td></td>
<td>GRT—Generated code includes this file when the code includes rtwtypes.h.</td>
</tr>
<tr>
<td></td>
<td>ERT—Generated code does not include this file. For ERT, rtwtypes.h contains definitions, and <em>model</em>.h contains header files.</td>
</tr>
<tr>
<td>sysran_types.h</td>
<td>Supports external mode</td>
</tr>
<tr>
<td></td>
<td>GRT—Generated code includes this file when the code includes simstruc_types.h.</td>
</tr>
<tr>
<td></td>
<td>ERT—Generated code includes this file when your model configuration selects external mode and when the code does not already include simstruc.h.</td>
</tr>
</tbody>
</table>
### Description and Inclusion Conditions for GRT or ERT System Target Files

<table>
<thead>
<tr>
<th>Header File</th>
<th>Description and Inclusion Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>zero_crossing_types.h</td>
<td>Contains zero-crossing definitions for models with triggered subsystems where the trigger is rising, falling, or either. File is generated only if required by the model as determined by the data type of the trigger signal. For example, if the data type of the trigger signal is Boolean, zero-crossing detection not needed. GRT—Generated code does not include this file for GRT code generation targets. ERT—Generated code includes this file when a model has a conditionally executed subsystem where a trigger uses zero crossing detection. If generated, the content of <code>zero_crossing_types.h</code> is always the same.</td>
</tr>
</tbody>
</table>

### See Also

**More About**

- “Manage Build Process Folders” on page 21-37
- “Manage Build Process Files” on page 21-43
- “Add Build Process Dependencies” on page 21-64
- “Enable Build Process for Folder Names with Spaces” on page 21-70
Add Build Process Dependencies

When you specify a system target file for code generation, the code generator can build a standalone executable program that can run on the development computer. To build the executable program, the code generator uses the selected compiler and the generated makefile for a toolchain approach or for a template makefile (TMF) approach build processes. Part of the makefile generation process is to add source file, header file, and library file information (the dependencies) in the generated makefile for a compilation. Or, for a specific application, you can add the generated files and file dependencies through a configuration management system.

The generated code for a model consists of a small set of files. (See “Manage Build Process Files” on page 21-43.) These files have dependencies on other files, which occur due to:

- Header file inclusions
- Macro declarations
- Function calls
- Variable declarations

The model or external code introduces dependencies for various reasons:

- Blocks in a model generate code that makes function calls. These calls can occur in several forms:
  
  - Included source files (not generated) declare the called functions. In cases such as a blockset, manage these source file dependencies by compiling them into a library file.
  
  - The generated code makes calls to functions in the run-time library provided by the compiler.
  
  - Some function dependencies also are generated files, which are referred to as shared utilities. Some examples are fixed-point utilities and non-finite support functions. These dependencies are referred to as shared utilities. The generated functions can appear in files in the build folder for standalone models or in the sharedutils folder under the slprj folder for builds that involve model reference.

- Models with continuous time require solver source code files.
- Code generator options such as external mode, C API, and MAT-file logging.
• External code specifies dependencies.

**File Dependency Information for the Build Process**

The code generator provides several mechanisms to input file dependency information into the build process. The mechanisms depend on whether your dependencies are block-based or are model- or system target file-based.

For block dependencies, consider using:

• S-functions and blocksets
  • Add folders that contain S-function MEX-files that the model uses to the header include path.
  • Create makefile rules for these folders to allow for finding source code.
  • Specify additional source file names with the S-Function block parameter `SFunctionModules`.
  • Specify additional dependencies with the `rtwmakecfg.m` mechanism. See “Use `rtwmakecfg.m` API to Customize Generated Makefiles” on page 37-26.

For more information on applying these approaches to legacy or external code integration, see “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7.

• S-Function Builder block, which provides its own UI for specifying dependency information

For model- or system target file-based dependencies, such as external header files, consider using:

• The **Code Generation > Custom Code** pane in the Configuration Parameters dialog box. You can specify additional libraries, source files, and include folders.

• TLC functions `LibAddToCommonIncludes()` and `LibAddToModelSources()`. You can specify dependencies during the TLC phase. See “`LibAddToCommonIncludes(incFileName)`” and “`LibAddSourceFileCustomSection(file, builtInSection, newSection)`”. The Embedded Coder product also provides a TLC-based customization template for generating additional source files.

**Generated Makefile Dependencies**

For toolchain approach or template makefile (TMF) approach build processes, the code generator generates a makefile. For TMFs, the generated makefile provides token
expansion in which the build process expands different tokens in the makefile to include the additional dependency information. The resulting makefile contains the complete dependency information. See “Customize Template Makefiles” on page 39-62.

The generated makefile contains:

- Names of the source file dependencies
- Folders where source files are located
- Location of the header files
- Precompiled library dependencies
- Libraries that the \texttt{make} utility compiles and creates

A property of \texttt{make} utilities is that you do not have to specify the specific location for a given source C or C++ file. If a rule exists for that folder and the source file name is a prerequisite in the makefile, the \texttt{make} utility can find the source file and compile it. The C or C++ compiler (preprocessor) does not require absolute paths to the headers. The compiler finds header file with the name of the header file by using an \texttt{#include} directive and an include path. The generated C or C++ source code depends on this standard compiler capability.

Libraries are created and linked against, but occlude the specific functions that the program calls.

These properties can make it difficult to determine the minimum list of file dependencies manually. You can use the makefile as a starting point to determine the dependencies in the generated code. For an example that shows how to identify dependencies, see “Relocate Code to Another Development Environment with packNGo”.

Another approach to determining the dependencies is using linker information, such as a linker map file, to determine the symbol dependencies. The map file provides the location of code generator and blockset source and header files to help in locating the dependencies.

\textbf{Code Generator Static File Dependencies}

Several locations in the MATLAB folder tree contain static file dependencies specific to the code generator:

- \texttt{matlabroot/rtw/c/src} (open)

  This folder has subfolders and contains additional files must be compiled. Examples include solver functions (for continuous time support), external mode support files, C
API support files, and S-function support files. Include source files in this folder into the build process with the SRC variables of the makefile.

- Header files in the folder `matlabroot/rtw/extern/include`
- Header files in the folder `matlabroot/simulink/include`

These folders contain additional header file dependencies such as `tmwtypes.h`, `simstruc_types.h`, and `simstruc.h`.

**Note** For ERT-based system target files, you can avoid several header dependencies. ERT-based system target files generate the minimum set of type definitions, macros, and so on, in the file `rtwtypes.h`.

**Blockset Static File Dependencies**

Blockset products with S-function code apply the `rtwmakecfg.m` mechanism to provide the code generator with dependency information. The `rtwmakecfg.m` file from the blockset contains the list of include path and source path dependencies for the blockset. Typically, blocksets create a library from the source files to which the generated model code can link. The libraries are created and identified when you use the `rtwmakecfg.m` mechanism.

To locate the `rtwmakecfg.m` files for blocksets in your MATLAB installed tree, use the following command:

```plaintext
>> which -all rtwmakecfg.m
```

If the model that you are compiling uses one or more of the blocksets listed by the `which` command, you can determine folder and file dependency information from the respective `rtwmakecfg.m` file.

**Folder Dependency Information for the Build Process**

You can add `#include` statements to generated code. Such references can come from several sources, including TLC scripts for inlining S-functions, custom storage classes, bus objects, and data type objects. The included files consist of header files for external code or other customizations. You can specify compiler include paths with the `-I` compiler option. The build process uses the specified paths to search for included header files.

Usage scenarios for the generated code include, but are not limited to, the following:
• A custom build process compiles generated code that requires an environment-specific set of #include statements.

In this scenario, the build process invokes the code generator when you select the Generate code only check box. Consider using fully qualified paths, relative paths, or just the header file names in the #include statements. Use include paths.

• The build process compiles the generated code.

In this case, you can specify compiler include paths (-I) for the build process in several ways:

• Specify additional include paths on the Code Generation > Custom Code pane in the Configuration Parameters dialog box. The code generator propagates the include paths into the generated makefile.

• The rtwmakecfg.m mechanism allows S-functions to introduce additional include paths into the build process. The code generator propagates the include paths into the generated makefile.

• When building a model that uses a custom system target file and is makefile-based, you can directly add the include paths into the template makefile that the system target file uses.

• Use the make command to specify a USER_INCLUDES make variable that defines a folder in which the build process searches for included files. For example:

  make_rtw USER_INCLUDES=-I:d:\work\feature1

  The build process passes the custom includes to the command-line invocation of the make utility, which adds them to the overall flags passed to the compiler.

Use #include Statements and Include Paths

Consider the following approaches for using #include statements and include paths with the build process to generate code that remains portable and minimizes compatibility problems with future versions.

Assume that additional header files are:

  c:\work\feature1\foo.h
  c:\work\feature2\bar.h

• An approach is to include in the #include statements only the file name, such as:

  #include "foo.h"
  #include "bar.h"
Then, the include path passed to the compiler contains folders in which the headers files exist:

```
cc -Ic:\work\feature1 -Ic:\work\feature2     ...
```

- Another approach is to use relative paths in `#include` statements and provide an anchor folder for these relative paths using an include path, for example:

```
#include "feature1\foo.h"
#include "feature2\bar.h"
```

Then, specify the anchor folder (for example `\work`) to the compiler:

```
cc -Ic:\work   ...
```

### Avoid These Folder Dependencies

When using the build process, avoid dependencies on folders in the build process “Code generation folder” (Simulink), such as the `model_ert_rtw` folder or the `slprj` folder. Do not use paths in `#include` statements that are relative to the location of the generated source file. For example, if your MATLAB code generation folder is `c:\work`, the build process generates the `model.c` source file into a subfolder such as:

```
c:\work\model_ert_rtw\model.c
```

The `model.c` file has `#include` statements of the form:

```
#include "..\feature1\foo.h"
#include "..\feature2\bar.h"
```

It is preferable to use one of the other suggested approaches because the relative path creates a dependency on the code generator folder structure.

### See Also

#### More About

- “Manage Build Process Folders” on page 21-37
- “Manage Build Process Files” on page 21-43
- “Manage Build Process File Dependencies” on page 21-53
- “Enable Build Process for Folder Names with Spaces” on page 21-70
Enable Build Process for Folder Names with Spaces

The code generator uses alternate folder name support, which is specific to your Windows or UNIX operating system, to process folder names that include spaces. On Windows systems, the code generator maps a drive corresponding to the MATLAB installation folder for either of these conditions:

- The `matlabroot` folder is a UNC location.
- The path the `matlabroot` folder contains spaces, and the system has no alternate name support.

The build process provides similar support for other build-related folders. For a summary of support and limitations, see “Build Process Folder Support on Windows” on page 21-72.

Spaces in folder names can appear in the paths to build-related locations:

- `matlabroot`—path to your MATLAB installation folder.
  
  An example is a `matlabroot` similar to `C:\Program Files\MATLAB\R2015b`.
- `pwd`—current working folder from which you start the build.
  
  An example is a `pwd` at the start of a build similar to `C:\Users\username\Documents\My Work`.
- The installation folder for a compiler that the build process uses.

If your work environment includes one or more of the preceding scenarios, use the following support mechanisms for the build process:

- If you are using the toolchain approach to build generated code, the system support for spaces in folder names influences toolchain operation:
  
  - For UNIX systems and Windows systems with 8.3 name creation enabled, the toolchain manages spaces in folder names by using alternate names from the platform. The toolchain uses the `TransformPathsWithSpaces` attribute to manage these names.

    ```matlab
    addAttribute(toolchainObject, 'TransformPathsWithSpaces', true);
    ```
  
  - For Windows systems with 8.3 name creation disabled, the toolchain manages spaces in folder names by mapping a network drive using a batch file (.bat). This
operation requires adding the RequiresBatchFile attribute to the toolchain definition.

```
addAttribute(toolchainObject, 'RequiresBatchFile', true);
```

When developing a toolchain for a Windows system, set both attributes. For more information about the toolchain attributes, see `addAttribute`.

- If you are using the template makefile approach to build generated code, the template makefile (.tmf) requires code to manage spaces in folder names. When the alternate folder names (Windows short names) differ from the file system folder names (Windows long names), add this code to the makefile.

```plaintext
ALT_MATLAB_ROOT = |>ALT_MATLAB_ROOT<|
ALT_MATLAB_BIN  = |>ALT_MATLAB_BIN<|

!if "$(MATLAB_ROOT)" != "$(ALT_MATLAB_ROOT)"
    MATLAB_ROOT = $(ALT_MATLAB_ROOT)
!endif

!if "$(MATLAB_BIN)" != "$(ALT_MATLAB_BIN)"
    MATLAB_BIN = $(ALT_MATLAB_BIN)
!endif
```

When the values of the location tokens are not equal, this code replaces MATLAB_ROOT with ALT_MATLAB_ROOT. The replacement indicates that the path to your MATLAB installation folder includes spaces. This code applies the same type of replacement for MATLAB_BIN with ALT_MATLAB_BIN. The preceding code is specific to nmake. For platform-specific examples, see the supplied template makefiles.

With either build approach, when there is an issue with support for creation of alternate names (short names), build errors can occur on Windows. If a build generates an error message similar to the following message, see “Troubleshooting Errors When Folder Names Have Spaces” on page 21-73.

```
NMAKE : fatal error U1073: don't know how to make ' ...
```

When using operating system commands, such as `system` or `dos`, enclose paths that specify executable files or command parameters in double quotes (" "). For example:

```plaintext
system('dir "D:\Applications\Common Files"')
```
# Build Process Folder Support on Windows

<table>
<thead>
<tr>
<th>Build Process Folders</th>
<th>Approach for Paths with UNC or Spaces</th>
<th>Support for Windows Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>matlabroot folder</td>
<td>During a build, a UNC location such as: <code>\networkdrive\matlab\R20xxb</code> could be remapped as: <code>T:\</code></td>
<td>Build process folder support available independent of file system (NTFS or ReFS) or file system configuration for short file name support. <strong>Limitations:</strong> On systems that require drive mapping for the installation location, the build process requires that a drive letter is available for mapping. On systems without short file name (8.3) support (using ReFS or using NTFS with 8.3 support disabled), the final folder in the installation location cannot contain spaces. For example, a final folder name: <code>C:\Program Files\MATLAB\R20xxb sp1</code> is not supported.</td>
</tr>
</tbody>
</table>

**Note:** The `matlabroot` value is derived from the MATLAB installation location.

During a build on a Windows system with short file name (8.3) support (default for Windows using NTFS), the build process uses the Windows API `getShortPathName()` for the folder location.

During a build on a Windows system without short file name (8.3) support (systems using ReFS or using NTFS with 8.3 support disabled), a location with spaces in the path such as:

`C:\Program Files\MATLAB\R20xxb`

could be remapped as:

`T:\R20xxb`

**Code generation folder**

**Simulation cache folder**

**Custom code source file locations—among others,**

For UNC locations, build process temporarily maps a drive by using the shell commands `pushd` and `popd`. Build process folder support is available independent of file system (NTFS or ReFS) or file system configuration for short path name support.
### Build Process Folders

These locations include folders specified by:

- `rtwmakecfg .m`
- **Configuration Parameters** > **Code Generation** > **Custom Code** > **Additional build information**
- Code replacement library

### Approach for Paths with UNC or Spaces

For paths with spaces, build process uses the Windows short path name (8.3) by using the Windows API:

```c
getShortPathName()
```

### Support for Windows Platform

Build process folder support depends on NTFS file system and requires Windows default support. Registry sets value of 2 or 0 for:

```c
NtfsDisable8dot3NameCreation
```

**Limitations:** Build process does not support spaces in the path to these folders for:

- NTFS file system with short path name support disabled
- ReFS file system (this file system does not support short path names)

### Troubleshooting Errors When Folder Names Have Spaces

On Windows, when there is an issue with support for creation of short file names, build process errors can occur. When this issue affects a build, you see an error message similar to:

```
NMAKE : fatal error U1073: don't know how to make 'C:\Work\My'
```

This message can occur if a space in the folder name (`C:\Work\My Models`) prevents the build process from finding the model or a file to build. For descriptions of the build-related folders that are sensitive to a space in the folder name or path, see “Build Process Folder Support on Windows” on page 21-72.

To avoid issues from folder names with spaces when Windows short file name support for file names is disabled, do not use paths with spaces. For example, install third-party software to paths without spaces. Do not use paths with spaces for folders containing your models, source files, or libraries.
An issue can occur with builds that use folder names with spaces, because it is possible to disable Windows alternate name support. The build process uses this alternate name support on Windows systems. There are many terms for this file, folder, and path alternate name support:

- 8.3 name
- DOS path
- short file name (SFN, ShortFileName)
- long name alias
- Windows path alias

Verify the type of file system that the drive uses. In Windows Explorer, right-click the drive icon and select properties.

- If the file system is ReFS (Resilient File System), it is an issue. The ReFS does not provide short file name support. Except for the MATLAB installation folder, the build process does not support folder names with spaces for the ReFS file system. If your work environment requires short file name support for the build folder or for additional external code folders, do not use ReFS.
- If the file system is NTFS (New Technology File System), it is possible that the build error is related to a registry setting incompatibility. Continue with troubleshooting steps.

The error could stem from an issue with short file name support on a system using NTFS. Check the Windows registry setting that enables the creation of short names for files, folders, and paths.

1. Open the Windows command prompt, running as administrator. For example, from the Windows Start menu, type cmd, right-click the cmd.exe icon, and select Run as administrator.

2. Change to the windows\system32 folder and query the NtfsDisable8dot3NameCreation status by typing:
   
   > fsutil 8dot3name query

3. If the registry state of NtfsDisable8dot3NameCreation is not 2, the default (Volume level setting), change the value to 2 by typing:
   
   > fsutil 8dot3name set 2

Changing the registry setting enables creation of short names only for files and folders that are created after the change.

4 To create short names for files created while short name creation was disabled, at the Windows command line, use the fsutil utility.

To set the short name, the syntax is:

```plaintext
> fsutil file setshortname <FileName> <ShortName>
```

For example, to create the short name PROGRA~1 for the long name C:\Program Files, type:

```plaintext
> fsutil file setshortname "C:\Program Files" PROGRA-1
```

The C:\Program Files folder name is in quotations because it has spaces.

5 To verify that the short name was created, use the dir command with /x option to show short names.

```plaintext
> dir C:\ /x
```

**See Also**

addAttribute

**More About**

- “Manage Build Process Folders” on page 21-37
- “Manage Build Process Files” on page 21-43
- “Manage Build Process File Dependencies” on page 21-53
- “Add Build Process Dependencies” on page 21-64

**External Websites**

- MATLAB Answers: “Why is the build process failing ...?”
Code Generation of Matrices and Arrays

MATLAB stores matrix data and arrays (1-D, 2-D, ...) in column-major format as a vector. Simulink and the code generator can store array data in column-major or row-major format. For an array stored in column-major layout, the elements of the columns are contiguous in memory. In row-major layout, the elements of the rows are contiguous. Array layout is also referred to as order, format, and representation. The order in which elements are stored can be important for integration, usability, and performance. Certain algorithms perform better on data stored in a particular order.

Programming languages and environments typically assume a single array layout for all data. MATLAB and Fortran use column-major layout by default, whereas C and C++ use row-major layout. With Simulink Coder, you can generate C/C++ code that uses row-major layout or column-major layout.

Array Storage in Computer Memory

Computer memory stores data in terms of one-dimensional arrays. For example, when you declare a 3-by-3 matrix, the software stores this matrix as a one-dimensional array with nine elements. By default, MATLAB stores these elements with a column-major array layout. The elements of each column are contiguous in memory.

Consider the matrix A:

\[
A = \begin{bmatrix}
1 & 2 & 3 \\
4 & 5 & 6 \\
7 & 8 & 9
\end{bmatrix}
\]

A translates to an array of length 9 in this order:

\[
A(1) = A(1,1) = 1; \\
A(2) = A(2,1) = 4; \\
A(3) = A(3,1) = 7; \\
A(4) = A(1,2) = 2; \\
A(5) = A(2,2) = 5;
\]

and so on.

In column-major format, the next element of an array in memory is accessed by incrementing the first index of the array. For example, these element pairs are stored sequentially in memory:
• A(i) and A(i+1)
• B(i,j) and B(i+1,j)
• C(i,j,k) and C(i+1,j,k)

The matrix A is represented in memory by default with this arrangement:

```
  1   4   7   2   5   8   3   6   9
```

In row-major array layout, the programming language stores row elements contiguously in memory. In row-major layout, the elements of the array are stored as:

```
  1   2   3   4   5   6   7   8   9
```

You can store the N-dimensional arrays in column-major or row-major layout. In column-major layout, the elements from the first (leftmost) dimension or index are contiguous in memory. In row-major layout, the elements from the last (rightmost) dimension or index are contiguous.

For more information on the internal representation of MATLAB data, see “MATLAB Data” (MATLAB).

Code generation software uses column-major format by default for several reasons:

• The world of signal and array processing is largely in column-major array layout: MATLAB, LAPack, Fortran90, and DSP libraries.
• A column is equivalent to a channel in frame-based processing. In this case, column-major storage is more efficient.
• A column-major array is self-consistent with its component submatrices:
  • A column-major 2-D array is a simple concatenation of 1-D arrays.
  • A column-major 3-D array is a simple concatenation of 2-D arrays.
  • The stride is the number of memory locations to index to the next element in the same dimension. The stride of the first dimension is one element. The stride of the nth dimension element is the product of the sizes of the lower dimensions.
  • Row-major n-D arrays have their stride of 1 for the highest dimension. Submatrix manipulations are typically accessing a scattered data set in memory, which does not allow for efficient indexing.

C uses row-major format. MATLAB and Simulink use column-major format by default. You can configure the code generation software to generate code with a row-major array.
layout. If you are integrating external C code with the generated code, see the considerations listed in this table.

<table>
<thead>
<tr>
<th>Action</th>
<th>Consider</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure array layout of the model for code generation.</td>
<td>In the Configuration Parameters dialog box, specify the <strong>Array layout</strong> parameter as Column-major or Row-major.</td>
</tr>
<tr>
<td>Enable efficient row-major algorithms for simulation and code generation.</td>
<td>In the Configuration Parameters dialog box, enable the <strong>Use algorithms optimized for row-major array layout</strong> (Simulink) parameter.</td>
</tr>
<tr>
<td>Integrate external C code functions in row-major array layout with the generated code.</td>
<td>Create S-functions that integrate external code functions with the generated code by using:</td>
</tr>
<tr>
<td></td>
<td>• The SimStruct function <code>ssSetArrayLayoutForCodeGen</code>.</td>
</tr>
<tr>
<td></td>
<td>• The <strong>Array layout</strong> (Simulink) setting in the S-Function Builder block.</td>
</tr>
<tr>
<td></td>
<td>• The Legacy Code Tool option <code>convert2DMatrixToRowMajor</code> in <code>legacy_code</code>. Using <code>convert2DMatrixToRowMajor</code> impacts code efficiency.</td>
</tr>
<tr>
<td></td>
<td>Use the C Caller block to call external C functions into Simulink. Specify array layout of custom C functions by using configuration parameter <strong>Default function array layout</strong> (Simulink).</td>
</tr>
</tbody>
</table>

**Code Generator Matrix Parameters**

The compiled model file, *model.rtw*, represents matrices as character vectors in MATLAB syntax, without an implied storage format. This format enables you to copy the character vector out of an *rtw* file, paste it into a MATLAB file, and have MATLAB recognize it.
Column-Major Layout

For example, the 3-by-3 matrix in the Constant block

\[
\begin{bmatrix}
1 & 2 & 3 \\
4 & 5 & 6 \\
7 & 8 & 9
\end{bmatrix}
\]

is stored in model.rtw as

Parameter {
  Identifier          "Constant_Value"
  LogicalSrc          P0
  Protected              no
  Value              [1.0, 4.0, 7.0, 2.0, 5.0, 8.0, 3.0, 6.0, 9.0]
  CGTypeIdx              18
  ContainerCGTypeIdx      19
  ReferencedBy          Matrix(1,4)
[[0, -1, 0, 0];
  GraphicalRef          Matrix(1,2)
[[0, 1];
  BHMPrmIdx              0
  GraphicalSource          [0, 1]
  OwnerSysIdx            [0, -1]
  VarGroupIdx          [1, 0]
  WasAccessedAsVariable   1
}

The model_data.c file declares the actual storage for the matrix parameter. You can see that the format is in column-major layout.

Parameters model_P = {
  /* Expression: [ [1,2,3] ; [4,5,6] ;[7,8,9]]
   * Referenced by: '<Root>/Constant  '
   */
  { 1.0, 4.0, 7.0, 2.0, 5.0, 8.0, 3.0, 6.0, 9.0 }
};
Row-Major Layout

For example, the 3-by-3 matrix in the Constant block

\[
\begin{bmatrix}
1 & 2 & 3 \\
4 & 5 & 6 \\
7 & 8 & 9
\end{bmatrix}
\]

is stored in `model.rtw` as

```plaintext
Parameter {
  Identifier          "Constant_Value"
  LogicalSrc          P0
  Protected              no
  Value              [1.0, 2.0, 3.0, 4.0, 5.0, 6.0, 7.0, 8.0, 9.0]
  CGTypeIdx            18
  ContainerCGTypeIdx    19
  ReferencedBy          Matrix(1,4)
  GraphicalRef          Matrix(1,2)
  [[0, -1, 0, 0];]
  GraphicalSource     [0, 1]
  BHMPrmIdx            0
  OwnerSysIdx          [0, -1]
  VarGroupIdx          [1, 0]
  WasAccessedAsVariable   1
}
```

The `model_data.h` file declares the actual storage for the matrix parameter. You can see that the format is in row-major layout.

```
Parameters model_P = {
  /* Expression: [ [1,2,3] ; [4,5,6] ;[7,8,9]]
   * Referenced by: '<Root>/Constant
   */
```

{ 1.0, 2.0, 3.0, 4.0, 5.0, 6.0, 7.0, 8.0, 9.0 }
}

**Internal Data Storage for Complex Number Arrays**

Simulink and code generator internal data storage formatting differs from MATLAB internal data storage formatting only in the storage of complex number arrays. In MATLAB, the real and imaginary parts are stored in separate arrays. In Simulink and the code generator, the parts are stored in an interleaved format. The numbers in memory alternate real, imaginary, real, imaginary, and so forth. This convention allows efficient implementations of small signals on Simulink lines, for Mux blocks, and other virtual signal manipulation blocks. For example, the signals do not actively copy their inputs, just the references.

**Unsupported Blocks for Row-Major Code Generation**

The code generator does not support these blocks for code generation in row-major array layout.

**Additional Math & Discrete**

**Additional Discrete**

- Fixed-Point State-Space
- Transfer Fcn Direct Form II
- Transfer Fcn Direct Form II Time Varying

**Additional Math: Increment — Decrement**

- Increment Real World
- Increment Stored Integer
- Decrement Real World
- Decrement Stored Integer
- Decrement Time To Zero
- Decrement To Zero

**Continuous**

- Derivative
• Integrator
• Integrator Limited
• Integrator, Second-Order
• Integrator, Second-Order Limited
• PID Controller
• PID Controller (2DOF)
• State-Space
• Transfer Fcn
• Transport Delay
• Variable Time Delay
• Variable Transport Delay
• Zero-Pole

Lookup Table
• 1-D Lookup Table
• 2-D Lookup Table

User-Defined Functions
• Interpreted MATLAB Function
• Level-2 MATLAB S-Function
• MATLAB Function
• MATLAB System

Signal Routing
• Environment Controller

Sources
• From Spreadsheet
See Also

More About

• “MATLAB Data” (MATLAB)
• “Mapping MATLAB Types to Types in Generated Code” (MATLAB Coder)
• “Row-Major and Column-Major Array Layouts” (MATLAB Coder)
• “Dimension Preservation of Multidimensional Arrays” (Embedded Coder)
Cross-Release Shared Utility Code Reuse

When you generate code for a model, the code generator by default creates shared utility files that the model requires. When you generate code with different releases, the code generators can produce functionally identical shared files that contain some nonfunctional differences. For example, different comments and different coding style. When you use the same release to generate code for different models in different folders, you can also produce shared files with nonfunctional differences. For example, if you specify different ParenthesesLevel or ExpressionFolding values for the models, the code generator can produce shared files that contain different comments or different coding styles.

Integrated code that includes functionally identical shared files:

- Is more expensive to verify because each shared file requires verification.
- Produces compilation errors if the shared files define duplicate symbols.

If you have an Embedded Coder license, you can avoid these issues by specifying the reuse of shared code from an existing folder, for example, a read-only library of verified code. In this case, the code generator does not create new shared utility files. The build process uses external code or previously generated shared utility code from the folder. An administrator maintains and updates the read-only library.

**Workflow to Reuse Shared Utility Code**

1. In the **Configuration Parameters > Code Generation > Interface > Advanced parameters > Existing shared code** field, enter the full path to your shared code folder.

2. Verify that the **Configuration Parameters > Diagnostics > Advanced parameters > Use only existing shared code** diagnostic is set to **error** (default).

3. Remove the slprj folder or move to a new working folder.

4. Build your model. If you do not see an error, your shared code folder contains the required shared utility files.
5 If files are missing from the existing shared code folder, you see an error. To continue code generation with a locally generated version of the missing shared utility files:

a Set Configuration Parameters > Diagnostics > Advanced parameters > Use only existing shared code to warning.

b Rebuild your model. The code generation process uses a locally generated version of the missing shared utility files.

c Provide the administrator of the verified code library with your model and information about missing shared utility files. With the model, the administrator generates the required shared utility files. Using sharedCodeUpdate, the administrator adds the files to the existing shared code folder.

If you require reuse of shared code for a component exported from a previous release, provide the administrator with information about the exported artifacts location. The administrator can use sharedCodeUpdate to copy the shared code for your component to the existing shared code folder.

d When the files are available in the existing shared code folder, repeat steps 1–4.

If the shared utility code is generated from library subsystems that are shared across models on page 9-55, you cannot reuse the code across releases because the code is release-specific—the symbol name and file name mangling includes the release number. The administrator must add the shared utility code generated for each release to the shared code folder.

The sharedCodeUpdate function can add files to the shared code folder that have identical content but different file and function names. This behavior is useful when you have different model components that require their own shared utility functions. Although some code is duplicated, the different model components can access the shared utility functions with which they were verified. To force model components to have their own versions of shared utility functions, configure naming rules to insert the model name into shared utility identifiers.

**Required Editing for Shared Utility Code Reuse**

For most shared utility code files, you can specify master copies that you can reuse across releases without modifying the files. With some files, for example, rtwtypes.h, and zero_crossing_types.h, there are situations where manual editing is required to produce master copies that you can use with generated code from different releases. For example:
• The rtwtypes.h file generated by releases up to and including R2013a contains a checksum.

    /* This ID is used to detect inclusion
     * of an incompatible rtwtypes.h */
    #define RTWTYPES_ID_C08S16I32L64N64F0

    For each version of this rtwtypes.h file that you want to include in your integration, copy the corresponding #define statement into your master copy of rtwtypes.h.

• In R2015a, the zero-crossing definitions moved from rtwtypes.h into zero_crossing_types.h. To create an rtwtypes.h file that is compatible with generated model code from different releases, in your master copy of rtwtypes.h, insert this statement.

    #include "zero_crossing_types.h"

    Remove definitions from rtwtypes.h that zero_crossing_types.h provides.

See Also

crossReleaseImport | crossReleaseExport | sharedCodeUpdate

Related Examples

• “Cross-Release Code Integration” (Embedded Coder)

More About

• “Generate Shared Utility Code” on page 9-72
• “Generate Shared Utility Code for Fixed-Point Functions” on page 9-82
• “Generate Shared Utility Code for Custom Data Types” on page 9-84
Cross-Release Code Integration

If you have an Embedded Coder license, you can integrate generated C code from previous releases (R2010a and later) with generated code from the current release when the source models are single-rate and the generated C code is from:

- Top-model or subsystem build processes that use the nonreusable function code interface.
- Single or multiple instance model reference build processes that suppress error status monitoring (SuppressErrorStatus is on).

If you can reuse existing code without modification, you can reduce the cost of reverification.

**Workflow**

Consider this control system model.
The Controller Model block references a model that consists of three components:

- **P1** is a Model block, which references a model developed with a previous release, for example, R2015b. The generated model code, with the standalone code interface, is in the folder `P1_ert_rtw`.
- **C1** is a Model block, which references a model that you are developing in the current release.
- **P2** is a subsystem block developed with a previous release, for example, R2016a. The generated subsystem code is in the folder `P2_ert_rtw`.
- **P3** is a Model block, which references a model developed with a previous release, for example, R2016b. The generated model code, with the model reference code interface, is in the folder `slprj/ert/P3`.

To integrate code from previous releases with generated code from the current release, use this workflow:

1. **Register previous releases with `sharedCodeMATLABVersions`**

   Use `sharedCodeMATLABVersions` to specify locations of the previous MATLAB releases, R2015b, R2016a, and R2016b.

2. **Export components from previous releases**

   In the current release, enter the commands:

   ```
   P1ArtifactsLocation = crossReleaseExport(folderPathForP1_ert_rtw);
   P2ArtifactsLocation = crossReleaseExport(folderPathForP2_ert_rtw);
   P3ArtifactsLocation = crossReleaseExport(folderPathForP3);
   ```

   The `crossReleaseExport` function starts the required previous release and creates a folder that contains export artifacts, for example, `P1_R2015b`.

3. **Specify an existing shared code folder**

   You can specify the reuse of shared code on page 21-84 from an existing folder, for example, a library of verified code that an administrator maintains and updates. Specify the shared code folder for model components that require code generation in the current release, for example, `Controller` and `C1`.

   In the **Configuration Parameters > Code Generation > Interface > Advanced parameters > Existing shared code** field, enter the full path to the shared code folder.

4. **Import components into current release**

   From the current release, using export artifacts created in step 2, import generated component code from previous releases as software-in-the-loop (SIL) blocks or processor-in-the-loop (PIL) blocks. For example:

   ```
   crossReleaseImport(P1ArtifactsLocation,'Controller', ...
   'SimulationMode','SIL');
   crossReleaseImport(P2ArtifactsLocation,'Controller', ...
   'SimulationMode','SIL');
   crossReleaseImport(P3ArtifactsLocation,'Controller', ...
   'SimulationMode','SIL');
   ```
P1ArtifactsLocation, P2ArtifactsLocation, and P3ArtifactsLocation are paths to the export artifact folders, P1_R2015b, P2_R2016a, and P3_R2016b, which are created in step 2.

In the current working folder, the crossReleaseImport function creates the xrel subfolder that contains software-in-the-loop (SIL) blocks and subfolders:

- P1_R2015b_sil and P1_R2015b_sil_resources
- P2_R2016a_sil and P2_R2016a_sil_resources
- P3_R2016b_sil and P3_R2016b_sil_resources

5 **Incorporate components into current release model**

To replace components with SIL or PIL blocks, use the Simulink Editor or the pil_block_replace command. For example, replace:

- P1 with P1_R2015b_sil.
- P2 with P2_R2016a_sil.
- P3 with P3_R2016b_sil.

When you run a model simulation, the simulation runs the previous release code through the SIL or PIL blocks.

When you build the Controller model (rtwbuild('Controller')), the code generator does not generate new code for the components represented by the SIL or PIL blocks. The model code calls code generated by previous releases.

The Simulink Code Inspector supports call-site validation for a cross-release SIL or PIL block. The block provides a specification of the expected function call, which is derived from the exported generated code and associated artifacts. During analysis, the Simulink Code Inspector compares the expected function call with the block behavior. For information about analysis limitations, see “S-Function” (Simulink Code Inspector).

**Limitations**

The cross-release code integration workflow does not support:

- Export-function models for ERT code.
- Simulink Function and Function Caller blocks across the boundaries of ERT code generated by different releases.
• The integration of generated code from releases before R2010a.
• The import of generated code from the current release into a previous release (forward compatibility).
• The export of files located in the MATLAB root folder of the previous release, for example, blockset library files.
• The export and import of generated code from models with non-inlined S-functions.
• C-API (Embedded Coder).

At the end of the model build process, the code generation report displays shared files that are directly used by the integration model, for example, Controller. The report does not display shared files used by the components of the model, for example, P1 and P2.

If your model has:

• A cross-release SIL or PIL block, you cannot run rapid accelerator mode simulations.
• A Model block that references a model containing a cross-release SIL or PIL block, you cannot run accelerator mode or rapid accelerator mode simulations.

You can run:

• Top-model SIL simulations of models that contain cross-release SIL or PIL blocks. The models must not contain cross-release AUTOSAR Model blocks.
• Model block SIL simulations of referenced models that contain cross-release SIL or PIL blocks. The referenced models must not contain cross-release AUTOSAR Model blocks.

For information about other cross-release AUTOSAR code integration limitations, see “Import AUTOSAR Code from Previous Releases” on page 21-102.

**Simulink.Bus Support**

To use a bus object as a data type in cross-release ERT code integration, use one of these approaches.
<table>
<thead>
<tr>
<th>Approach</th>
<th>Code Export</th>
<th>Code Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>In the previous release, before generating code, set the <code>DataScope</code> property of the <code>Simulink.Bus</code> object to Auto. Do not assign a value to the <code>HeaderFile</code> property. The code generator creates the <code>Simulink.Bus</code> data type definition in the default header file (Embedded Coder), which is located in the code generation folder for the model.</td>
<td>In the current release, before running <code>crossReleaseImport</code>, set the <code>DataScope</code> property of the <code>Simulink.Bus</code> object to Auto. When you build the integration model, the build process uses the <code>Simulink.Bus</code> data type from the header file in the imported code.</td>
</tr>
<tr>
<td>Approach</td>
<td>Code Export</td>
<td>Code Import</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Exported</td>
<td>In the previous release, before generating code, specify these properties of the Simulink.Bus object:</td>
<td>In the current release, before running crossReleaseImport, set the DataScope property of the Simulink.Bus object to Imported.</td>
</tr>
<tr>
<td>bus</td>
<td>• DataScope — Set to Exported.</td>
<td>When you build the integration model that incorporates the imported SIL or PIL block, the build process uses the Simulink.Bus data type definition in prevRelBusType.h.</td>
</tr>
<tr>
<td></td>
<td>• HeaderFile — Specify a file name, for example, prevRelBusType.</td>
<td>If the imported code is from R2010a or R2010b, specify these properties of the Simulink.Bus object:</td>
</tr>
<tr>
<td></td>
<td>The code generator creates prevRelBusType.h in the shared utility code folder. This header file contains the definition for the Simulink.Bus data type. Use sharedCodeUpdate to add prevRelBusType.h to the shared code folder that ExistingSharedCode specifies.</td>
<td>• DataScope — Set to Imported.</td>
</tr>
<tr>
<td></td>
<td>For R2010a and R2010b, the DataScope property is not available. Do not assign a value to the HeaderFile property. The code generator creates the Simulink.Bus data type definition in modelName_types.h, which is located in the code generation folder for the model.</td>
<td>• HeaderFile — Set to file path for modelName_types.h, which is in the imported code folder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When you build the integration model, the build process uses the Simulink.Bus data type definition in modelName_types.h.</td>
</tr>
</tbody>
</table>
In the previous release, before generating code, specify these properties of the Simulink.Bus object:

- DataScope — Set to Imported.
- HeaderFile — Specify a path to a file that contains the Simulink.Bus data type definition, for example, aBusType.h.

For R2010a and R2010b, the DataScope property is not available.

For the HeaderFile property, specify a path to a file that contains the Simulink.Bus data type definition, for example, aBusType.h.

In the current release, after importing generated code, you do not have to change the Simulink.Bus. When you build the integration model that incorporates the imported SIL or PIL block, the build process uses the Simulink.Bus data type definition from aBusType.h.

If the imported code is from R2010a or R2010b, specify these properties of the Simulink.Bus object:

- DataScope — Set to Imported.
- HeaderFile — Set to aBusType.h.

When you build the integration model, the build process uses the Simulink.Bus data type definition in aBusType.h.

### Root-Level I/O Through Global Variables in Generated Code

When imported ERT code from a previous release implements an input or output port through a global variable, the code that is generated from the integration model depends on the properties of the signal connected to the port in the integration model.

If the integration model signal does not map to a generated code variable that has the same name as the signal in the imported code, the generated code:

- Defines the variable if it is declared but undefined in the imported code.
- Creates additional code to copy data between the variable generated from the integration model and the variable in the imported code.

If the integration model signal maps to a variable with the same name as the signal in the imported code, the variable used by the imported code is also used by the code generated from the integration model. You must use a compatible storage class for the signal.
<table>
<thead>
<tr>
<th>Storage Class Property</th>
<th>Property Value Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Unstructured only</td>
</tr>
<tr>
<td>Data access</td>
<td>Cannot connect a port implemented as a <strong>Pointer</strong> variable in the imported code to a signal of the same name that is implemented through a <strong>Direct</strong> storage class in the integration model</td>
</tr>
<tr>
<td></td>
<td>Cannot connect a port implemented as a <strong>Direct</strong> variable in the imported code to a signal of the same name that is implemented as a <strong>Pointer</strong> in the integration model</td>
</tr>
<tr>
<td>Storage Class Property</td>
<td>Property Value Support</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------</td>
</tr>
</tbody>
</table>
| **Data scope**          | If the imported code declares but does not define the variable (i.e. code is generated from a signal that uses the `Imported` value), then one of the following is required:  
  - The integration model uses the `Exported` value.  
  - External code defines the variable.  
  If the imported code defines the variable (i.e. code is generated from a signal that uses the `Exported` value):  
    - For signals in the integration model that are connected to root-level I/O ports:  
      - Set the `EnableDataOwnership` configuration parameter to `on`.  
      - Use a custom storage class with these properties:  
        - **Type** - `Unstructured`  
        - **Data access** - `Direct`  
        - **Data scope** - `Exported`  
        - **Owner** - Non-empty value that is not the name of the integration model. For example, the value can be the name of the imported component.  
    - For signals in the integration model that are not connected to root-level I/O ports, use a custom storage class with these property values:  
      - **Data scope** - `Imported`  
      - **Data access** - `Direct` |
Communicate Between Current and Previous Release Components Through Global Data Stores

Current and previous release components can communicate through global data stores associated with Simulink.Signal objects in the MATLAB base workspace or a Simulink data dictionary. The workflow described here applies to cross-release ERT code integration.

Export Configuration

Before generating code in the old release, for the model component that you want to export, configure data store memory to use a storage class that imports external code.

If a top-model or subsystem build process generates the code, set the Storage class property of the Simulink.Signal objects to one of these classes:

- ImportedExtern
- ImportedExternPointer
- ImportFromFile custom storage class

If a model reference build process generates the code, you can also use these classes:

- ExportedGlobal
- ExportToFile custom storage class

When you run crossReleaseExport, the function identifies data store memories in the codeInfo.mat file and places required information in the crossReleaseInfo.m artifact.

Import Configuration

In the current release, before you run crossReleaseImport, define a Simulink.Signal object in the MATLAB base workspace or a Simulink data dictionary for each global data store of the component that you want to import:

1. For the object name and the Data type, Complexity, and Dimensions object properties, specify values that match values of the corresponding object in the component that you want to import.

2. For the Storage class property, specify a value that is compatible. If the previous release value is ImportedExtern, specify one of these values for the current release:
• ImportedExtern
• ExportedGlobal
• ImportFromFile or ExportToFile custom storage class.

If the previous release value is ImportedExternPointer, then specify ImportedExternPointer for the current release.

3 For the Alias property, specify a matching value only if the property is specified for the object in the component that you want to import.

4 Save the Simulink.Signal objects. The objects are required each time you simulate or build the imported SIL or PIL block.

For more information, see “Data Stores in Generated Code” on page 15-101.

**Parameter Tuning**

The cross-release ERT code integration workflow supports parameter tuning in an integration model that contains component code with tunable parameters from previous releases.

In the current release, before you run crossReleaseImport, for each tunable parameter of the component that you want to import:

1 Define a Simulink.Parameter object in the MATLAB base workspace or a Simulink data dictionary.

2 For the object name and the Data type, Complexity, and Dimensions object properties, specify values that match the exported object values. If the variable in the imported source code does not have the same name as the object, for the Alias property, specify a value that matches the variable name.

3 If the exported object uses the GetSet custom storage class, specify:

   • A matching value for the Storage class object property.
   • The header file that defines the get and set access functions. For details, see “Control Data Representation by Configuring Custom Storage Class Properties” (Embedded Coder) and “Access Data Through Functions with Custom Storage Class GetSet” (Embedded Coder).

Support of the GetSet custom storage class from a previous release applies only for R2011a and later releases.
For code generated by a top-model or subsystem build process in a previous release, these limitations apply:

- If a tunable parameter specified by a `Simulink.Parameter` object is exported from the previous release with storage class set to `ExportedGlobal` and the storage class of the `Simulink.Parameter` object in the current release is also `ExportedGlobal`, an error occurs when you build the integration model.

- On a Mac operating system, if a tunable parameter specified by a `Simulink.Parameter` object is exported from a previous release with storage class set to `ExportedGlobal`, you cannot build the integration model if the storage class of the `Simulink.Parameter` object in the current release (with the same name or alias) is `ImportedExtern`. To work around this limitation, modify the default settings:

  1. Get the build tool from the default toolchain.
     ```
     tc = coder.make.getDefaultToolchain;
     cComp = tc.getBuildTool('C Compiler');
     ```
  2. Extract the C compiler standard options.
     ```
     stdMaps = cComp.SupportedStandard.getLangStandardMaps;
     optionValues = stdMaps.getCompilerOptions('*');
     ```
  3. Remove `-fno-common` from the standard options for the C and C++ compilers.
     ```
     optionToRemove = '-fno-common';
     optionsToKeep = strrep(optionValues, optionToRemove, '');
     c_standard_opts_id = '$(C_STANDARD_OPTS)';
     custToolChainOpts = get_param(model,'CustomToolchainOptions');
     custToolChainOpts{2} = ...
     strrep(custToolChainOpts{2}, c_standard_opts_id, optionsToKeep);
     set_param(model, 'CustomToolchainOptions',custToolChainOpts);
     ```

**Use Multiple Instances of Code Generated from Reusable Referenced Model**

Using a reusable referenced model, you can specify unique model argument values (Simulink) for each instance of the referenced model in a parent model. You can export previously generated code for the reusable referenced model, import the code into the current release as a parameterized cross-release SIL or PIL block, and then insert multiple instances of the block into an integration model. For each block instance, you can specify unique model argument values.

  1. Export generated code for the reusable referenced model.
artifactLocation = crossReleaseExport(reusableReferencedModelcodeLocation)

2 Update existing shared code folder.

sharedCodeUpdate(sourceFolder, destinationFolder)

3 Import the code into the current release as a parameterized cross-release block, for example, a SIL block.

handleSILBlock = crossReleaseImport(artifactLocation, ...
    configSetIntegrationModel, 'SimulationMode', 'SIL');

4 In the integration model, replace, for example, two instances of the referenced model with instances of the cross-release SIL block.

open_system(integrationModel);

blockInstanceName1 = 'refModelInstanceName1';
blockinstanceName2 = 'refModelInstanceName2';

SILBlockFullName = getfullname(handleSILBlock);
replace_block(integrationModel, 'Name', blockInstanceName1, ...
    SILBlockFullName, 'noprompt');
replace_block(integrationModel, 'Name', blockInstanceName2, ...
    SILBlockFullName, 'noprompt');

5 Suppose the reusable referenced model has model arguments paramA and paramB, and the values for the referenced model instances, refModelInstanceName1 and refModelInstanceName2, are workspace variables. In this case, you can specify argument values for the cross-release block instances that are workspace variables.

pathToBlockInstanceName1 = [integrationModel, '/', blockInstanceName1];
pathToBlockInstanceName2 = [integrationModel, '/', blockInstanceName2];

set_param(pathToBlockInstanceName1, 'paramA', 'paramA_instName1');
set_param(pathToBlockInstanceName1, 'paramB', 'paramB_instName1');

set_param(pathToBlockInstanceName2, 'paramA', 'paramA_instName2');
set_param(pathToBlockInstanceName2, 'paramB', 'paramB_instName2');

6 To specify unique model argument values for the block instances in the integration model, assign values to the workspace variables, paramA_instName1, paramB_instName1, paramA_instName2, and paramB_instName2.
Compare Simulation Behavior of Model Component in Current Release and Generated Code from Previous Release

In a previous release, suppose that you developed a model component, generated code for the component, and tested and deployed the generated code. Now, in the current release, you want to add features to the model component and use the model component in system development and code generation. Before you proceed, you can compare the functional behavior of the model component and the generated code from the previous release.

To test the numerical equivalence between the model component and the generated code from the previous release, use Simulink Test. With the Test Manager (Simulink Test), you can perform back-to-back tests and output comparisons:

1. Bring the model component into the current release as a Model block with the Simulation mode block parameter set to Normal.
2. With the Model block, create a top model that specifies test input data.
3. Import the code generated in the previous release into the current release as a SIL block.
4. With the SIL block, create another top model that specifies the same the test input data.
5. In the Test Manager, create an equivalence test case that runs simulations of the top models and compares outputs.
6. Run the test case and review results.

For more information, see “Baseline and Equivalence Testing” (Simulink Test).

**Note** If you want to compare the behavior of generated code from the current and previous release, in step 1, specify these Model block parameters:

- Set **Simulation mode** to Software-in-the-loop (SIL) or Processor-in-the-loop (PIL).
- Set **Code interface** to Top model.
Import AUTOSAR Code from Previous Releases

If you install the Embedded Coder Support Package for AUTOSAR Standard, you can import into the current release AUTOSAR component code that you generated in a previous release.

When you run `crossReleaseImport`, the function imports the AUTOSAR code as a cross-release Model block instead of a SIL or PIL block. The `Simulation mode` parameter of the Model block is set to `Software-in-the-loop (SIL)` or `Processor-in-the-loop (PIL)`. Incorporate the Model block into the current release model.

These limitations apply:

- The cross-release workflow does not support per-instance memory that accesses NVRAM.
- Tunable parameters must use AUTOSAR `CalPrm` or `InternalCalPrm` custom storage classes.
- If the original model uses variants or symbolic dimensions (dimension variants), the imported model can use only the same variant and symbolic dimension configuration that was used when generating the code in the previous release.

See Also

`crossReleaseImport` | `crossReleaseExport` | `sharedCodeMATLABVersions` | `sharedCodeUpdate`

More About

- “Cross-Release Shared Utility Code Reuse” (Embedded Coder)
- “Generate Shared Utility Code” on page 9-72
- “Generate Shared Utility Code for Fixed-Point Functions” on page 9-82
- “Generate Shared Utility Code for Custom Data Types” on page 9-84
- “Integrate Generated Code Using Cross-Release Workflow” (Embedded Coder)
Generate Code Using Simulink® Coder™

This example shows how to select a system target file for a Simulink® model, generate C code for real-time simulation, and view generated files.

The model represents an 8-bit counter that feeds a triggered subsystem that is parameterized by constant blocks INC, LIMIT, and RESET. Input and Output represent I/O for the model. The Amplifier subsystem amplifies the input signal by gain factor K, which updates when signal equal_to_count is true.

1. Open the model. For example, type the following commands at the MATLAB® command prompt.

```matlab
model = 'rtwdemo_rtwintro';
open_system(model)
```

![Diagram of the model](image)

Algorithm Description
An 8-bit counter feeds a triggered subsystem parameterized by constants INC, LIMIT, and RESET. The I/O for the model is Input and Output. The Amplifier subsystem amplifies the input signal by gain factor K, which is updated whenever signal equal_to_count is true.

Copyright 1994-2012 The MathWorks, Inc.
2. Open the Configuration Parameters dialog box from the model editor by clicking **Simulation > Configuration Parameters**.

Alternately, type the following commands at the MATLAB® command prompt.

```matlab
cs = getActiveConfigSet(model);
openDialog(cs);
```

3. Select the **Code Generation** node.

4. In the **Target Selection** pane, click **Browse** to select a target.

You can generate code for a particular target environment or purpose. Some built-in targeting options are provided using system target files, which control the code generation process for a target.
5. Select the **Generic Real-Time (GRT)** target and click **Apply**.

Optionally, in the **Code Generation Advisor** pane set the **Select objective** field to **Execution efficiency** or **Debugging**. Then click **Check model...** to identify and systematically change parameters to meet your objectives.

6. In the model window, initiate code generation and the build process for the model by using any of the following options:
• Click the Build Model button.
• Press Ctrl+B.
• Select Code > C/C++ Code > Build Model.
• Invoke the rtwbuild command from the MATLAB command line.
• Invoke the slbuild command from the MATLAB command line.

7. View the code generation report that appears.

The report includes links to model files such as rtwdemo_rtwintro.c and associated utility and header files.
The figure below contains a portion of `rtwdemo_rtwintro.c`
```c
/* Model step function */
void rtwdemo_rtwintro_step(void)
{
  uint8_T rtb_sum_out;
  boolean_T rtb_equal_to_count;

  /* Sum: '<Root>/Sum' incorporates:
     * Constant: '<Root>/INC'
     * UnitDelay: '<Root>/X'
   */
  rtb_sum_out = (uint8_T)(1U + (uint32_T)rtwdemo_rtwintro_DWork.X);

  /* RelationalOperator: '<Root>/RelOpt' incorporates:
     * Constant: '<Root>/LIMIT'
   */
  rtb_equal_to_count = (rtb_sum_out != 16);

  /* Outputs for Triggered SubSystem: '<Root>/Amplifier' incorporates:
     * TriggerPort: '<S1>/Trigger'
   */
  if (rtb_equal_to_count && (rtwdemo_rtwintro_Prev2CZSigState.Amplifier_Trig_ZCE
                               != POS_ZCSIG)) {
    /* Output: '<Root>/Output' incorporates:
       * Gain: '<S1>/Gain'
       * Inport: '<Root>/Input'
     */
    rtwdemo_rtwintro_Y.Output = rtwdemo_rtwintro_U.Input << 1;
  }

  rtwdemo_rtwintro_Prev2CZSigState.Amplifier_Trig_ZCE = (uint8_T)
     (rtb_equal_to_count ? (int32_T)POS_ZCSIG : (int32_T)ZERO_ZCSIG);

  /* End of Outputs for SubSystem: '<Root>/Amplifier' */

  /* Switch: '<Root>/Switch' */
  if (rtb_equal_to_count) {
    /* Update for UnitDelay: '<Root>/X' */
    rtwdemo_rtwintro_DWork.X = rtb_sum_out;
  } else {
    /* Update for UnitDelay: '<Root>/X' incorporates:
       * Constant: '<Root>/RESET'
     */
    rtwdemo_rtwintro_DWork.X = 0U;
  }

  /* End of Switch: '<Root>/Switch' */
```

8. Close the model.

bdclose(model)
rtwdemoclean;

Related Topics

- “Configure Model, Generate Code, and Simulate” on page 21-2
- “Configure a System Target File” on page 19-2
- “Generate Code Using Embedded Coder®” (Embedded Coder)
- “Generate Code and Simulate Models in a Simulink Project”
- “Generate Code and Simulate Models with Simulink Project API” (Embedded Coder)
Report Generation in Simulink Coder

- “Reports for Code Generation” on page 22-2
- “Generate a Code Generation Report” on page 22-6
- “Generate Code Generation Report After Build Process” on page 22-7
- “Open Code Generation Report” on page 22-9
- “Generate Code Generation Report Programmatically” on page 22-11
- “View Code Generation Report in Model Explorer” on page 22-12
- “Package and Share the Code Generation Report” on page 22-14
- “Document Generated Code with Simulink Report Generator” on page 22-16
- “Document Generated Code” on page 22-23
- “Get Code Description of Generated Code” on page 22-25
Reports for Code Generation

The code generator software produces an HTML code generation report so that you can view and analyze the generated code. When your model is built, the code generation process produces an HTML file that is displayed in an HTML browser or in the Model Explorer. The code generation report includes:

- The **Summary** section that contains model and code information, including **Author**, **Tasking Mode**, **System Target File**, **Hardware Device Type**, and code generation objectives information. The **Configuration settings at the time of code generation** link opens a noneditable view of the Configuration Parameters dialog box. The dialog box shows the Simulink model settings at the time of code generation, including TLC options.

- The **Subsystem Report** section that contains information on nonvirtual subsystems in the model.

- In the **Generated Files** section on the **Contents** pane, you can click the names of source code files generated from your model to view their contents in a MATLAB Web browser window. In the displayed source code, global variables are hypertext that links to their definitions.

For an example, see “Generate a Code Generation Report” on page 22-6.

If you have a Simulink Report Generator license, you can document your code generation project in multiple formats, including HTML, PDF, RTF, Microsoft Word, and XML. For an example of how to create a Microsoft Word report, see “Document Generated Code with Simulink Report Generator” on page 22-16.

**HTML Code Generation Report Location**

The default location for the code generation report files is in the `html` subfolder of the build folder, `model_target_rtw/html/`. `target` is the name of the **System target file** specified on the **Code Generation** pane. The default name for the top-level HTML report file is `model_codegen_rpt.html` or `subsystem_codegen_rpt.html`. For more
information on the location of the build folder; see “Manage Build Process Folders” on page 21-37.

**HTML Code Generation Report for Referenced Models**

To generate a code generation report for a top model and code generation reports for each referenced model, you need to specify the Create code generation report on the Code Generation > Report pane for the top model and each referenced model. You can open the code generation report of a referenced model in one of two ways:

- From the top-model code generation report, you can access the referenced model code generation report by clicking a link under Referenced Models in the left navigation pane. Clicking a link opens the code generation report for the referenced model in the browser. To navigate back to the top model code generation report, use the Back button at the top of the left navigation pane.


For more information, see “Generate Code for Referenced Models” on page 7-4

**HTML Code Generation Report Extensions**

If you have an Embedded Coder license, the code generator enhances the HTML code generation report. Configure your model to include the following sections in the report:

- The Code Interface Report section provides information about the generated code interface, including model entry-point functions and input/output data. For more information, see “Analyze the Generated Code Interface” (Embedded Coder).

- The Traceability Report section allows you to account for Eliminated / Virtual Blocks that are untraceable versus the listed Traceable Simulink Blocks / Stateflow Objects / MATLAB Scripts. This provides a complete mapping between model elements and code. For more information, see “Customize Traceability Reports” (Embedded Coder).

- The Static Code Metrics Report section provides statistics of the generated code. Metrics are estimated from static analysis of the generated code. For more information, see “Static Code Metrics” (Embedded Coder).

- The Code Replacements Report section allows you to account for code replacement library (CRL) functions that were used during code generation, providing a mapping between each replacement instance and the Simulink block that triggered the
replacement. For more information, see “Analyze Code Replacements in Generated Code” (Embedded Coder).

- The **Coder Assumptions** section provides a list of:
  - Code generation assumptions for your target hardware that you can check.
  - Expected results for the assumption checks.

For more information, see “Check Code Generation Assumptions” (Embedded Coder).

- The model Web view displays an interactive model diagram within the code generation report and supports traceability between the source code and the model. Therefore, you can share your model and generated code outside of the MATLAB environment. For more information, see “Web View of Model in Code Generation Report” (Embedded Coder).

On the **Contents** pane, in the **Generated Files** section, you can click the names of source code files generated from your model to view their contents in a MATLAB Web browser window. In the displayed source code:

- If you enable code-to-model traceability, hyperlinks within the displayed source code navigate to the blocks or subsystems from which the code is generated. For more information, see “Code-to-Model Traceability” (Embedded Coder).

- If you enable model-to-code traceability, you can navigate to the generated code for a block in the model. For more information, see “Model-to-Code Traceability” (Embedded Coder).

- If you set the **Code coverage tool** parameter on the **Code Generation > Verification** pane, you can view the code coverage data and annotations. For more information, see “Configure Code Coverage with Third-Party Tools” (Embedded Coder).

- If you select the **Static code metrics** check box on the **Code Generation > Report** pane, you can view code metrics information and navigate to code definitions and declarations in the generated code. For more information, see “View Static Code Metrics and Definitions Within the Generated Code” (Embedded Coder).

**Note** To view the contents of your generated code and navigate between model and code, you can also use the code view in the code perspective. In the perspective, click the **Code** tab in the bottom-right corner.
See Also

Related Examples
• “Verify Generated Code by Using Code Tracing” (Embedded Coder)
Generate a Code Generation Report

To generate a code generation report when the model is built:


2. Select the Create code generation report parameter.

3. If you want the code generation report to automatically open after generating code, select the Open report automatically parameter (which is enabled by selecting Create code generation report).

4. Generate code.

The build process writes the code generation report files to the html subfolder of the build folder (see “HTML Code Generation Report Location” on page 22-2). Next, the build process automatically opens a MATLAB Web browser window and displays the code generation report.

To open an HTML code generation report at any time after a build, see “Open Code Generation Report” on page 22-9 and “Generate Code Generation Report After Build Process” on page 22-7.
Generate Code Generation Report After Build Process

After generating code, if you did not configure your model to create a code generation report, you can generate a code generation report without rebuilding your model.

1. In the model diagram window, select **Code > C/C++ Code > Code Generation Report > Open Model Report**.

2. If your current working folder contains the code generation files the following dialog opens.

![Generate Report Dialog](image)

Click **Generate Report**.

3. If the code generation files are not in your current working directory, the following dialog opens.

![Open Code Generation Report](image)

Enter the full path of the build folder for your model, `../model_target_rtw` and click **Open Report**.
The software generates a report, `model_codgen_rpt.html`, from the code generation files in the build folder you specified.

**Note** An alternative method for generating the report after the build process is complete is to configure your model to generate a report and build your model. In this case, the software generates the report without regenerating the code.
Open Code Generation Report

You can refer to existing code generation reports at any time. If you generated a code generation report, in the Simulink Editor, you can open the report by selecting the menu option Code > C/C++ Code > Code Generation Report > Open Model Report. If you are opening a report for a subsystem, select Open Subsystem Report. A Simulink Coder license is required to view the code generation report. An Embedded Coder license is required to view a code generation report enhanced with Embedded Coder features.

If your current working folder does not contain the code generation files and the code generation report, the following dialog box opens:

![Enter the full path of the build folder for your model, ..\model_target_rtw and click Open Report.](image)

Alternatively, you can open the code generation report (model_codegen_rpt.html or subsystem_codegen_rpt.html) manually into a MATLAB Web browser window, or in another Web browser. For the location of the generated report files, see “HTML Code Generation Report Location” on page 22-2.

Limitation

After building your model or generating the code generation report, if you modify legacy or custom code, you must rebuild your model or regenerate the report for the code generation report to include the updated legacy source files. For example, if you modify your legacy code, and then use the Code > C/C++ Code > Code Generation Report >
Open Model Report menu to open an existing report, the software does not check if the legacy source file is out of date compared to the generated code. Therefore, the code generation report is not regenerated and the report includes the out-of-date legacy code. This issue also occurs if you open a code generation report using the `coder.report.open` function.

To regenerate the code generation report, do one of the following:

- Rebuild your model.
- Generate the report using the `coder.report.generate` function.
Generate Code Generation Report Programatically

At the MATLAB command line, you can generate, open, and close an HTML Code Generation Report with the following functions:

- `coder.report.generate` generates the code generation report for the specified model.
- `coder.report.open` opens an existing code generation report.
- `coder.report.close` closes the code generation report.
View Code Generation Report in Model Explorer

After generating an HTML code generation report, you can view the report in the right pane of the Model Explorer. You can also browse the generated files directly in the Model Explorer.

When you generate code, or open a model that has generated code for its current target configuration in your working folder, the Hierarchy (left) pane of Model Explorer contains a node named Code for model. Under that node are other nodes, typically called This Model and Shared Code. Clicking This Model displays in the Contents (middle) pane a list of generated source code files in the build folder of that model. The next figure shows code for the rtwdemo_counter model.

In this example, the file S:/rtwdemo_counter_grt_rtw/rtwdemo_counter.c is being displayed. To view a file in the Contents pane, click it once.

The views in the Document (right) pane are read only. The code listings there contain hyperlinks to functions and macros in the generated code. Clicking the file hyperlink opens that source file in a text editing window where you can modify its contents.

If an open model contains Model blocks, and if generated code for these models exists in the current slprj folder, nodes for the referenced models appear in the Hierarchy pane.
one level below the node for the top model. Such referenced models do not need to be open for you to browse and read their generated source files.

If the code generator produces shared utility code for a model, a node named Shared Code appears directly under the This Model node. It collects source files that exist in the ./slprj/target/_sharedutils subfolder.

**Note** You cannot use the Search tool built into Model Explorer toolbar to search generated code displayed in the Code Viewer. On PCs, typing Ctrl+F when focused on the Document pane opens a Find dialog box that you can use to search for text in the currently displayed file. You can also search for text in the HTML report window, and you can open the files in the editor.
Package and Share the Code Generation Report

In this section...

“Package the Code Generation Report” on page 22-14
“View the Code Generation Report” on page 22-15

Package the Code Generation Report

To share the code generation report, you can package the code generation report files and supporting files into a zip file for transfer. The default location for the code generation report files is in two folders:

- /slprj
- html subfolder of the build folder, model_target_rtw, for example
  rtwdemo_counter_grt_rtw/html

To create a zip file from the MATLAB command window:

1. In the Current Folder browser, select the two folders:
   - /slprj
   - Build folder: model_target_rtw

2. Right-click to open the context menu.

3. In the context menu, select Create Zip File. A file appears in the Current Folder browser.

4. Name the zip file.

Alternatively, you can use the MATLAB `zip` command to zip the code generation report files:

```matlab
zip('myzip',{'slprj','rtwdemo_counter_grt_rtw'})
```

**Note**  If you need to relocate the static and generated code files for a model to another development environment, such as a system or an integrated development environment (IDE) that does not include MATLAB and Simulink products, use the code generator pack-and-go utility. For more information, see “Relocate Code to Another Development Environment” on page 27-60.
View the Code Generation Report

To view the code generation report after transfer, unzip the file and save the two folders at the same folder level in the hierarchy. Navigate to the `model_target_rtw/html/` folder and open the top-level HTML report file named `model_codgen_rpt.html` or `subsystem_codegen_rpt.html` in a Web browser.
Document Generated Code with Simulink Report Generator

In this section...

“Generate Code for the Model” on page 22-17
“Open the Report Generator” on page 22-17
“Set Report Name, Location, and Format” on page 22-19
“Include Models and Subsystems in a Report” on page 22-20
“Customize the Report” on page 22-21
“Generate the Report” on page 22-22

The Simulink Report Generator software creates documentation from your model in multiple formats, including HTML, PDF, RTF, Microsoft Word, and XML. This example shows one way to document a code generation project in Microsoft Word. The generated report includes:

• System snapshots (model and subsystem diagrams)
• Block execution order list
• Simulink Coder and model version information for generated code
• List of generated files
• Optimization configuration parameter settings
• System target file selection and build process configuration parameter settings
• Subsystem map
• File name, path, and generated code listings for the source code

To adjust Simulink Report Generator settings to include custom code and then generate a report for a model, complete the following tasks:

1  “Generate Code for the Model” on page 22-17
2  “Open the Report Generator” on page 22-17
3  “Set Report Name, Location, and Format” on page 22-19
4  “Include Models and Subsystems in a Report” on page 22-20
5  “Customize the Report” on page 22-21
A Simulink Report Generator license is required for the following report formats: PDF, RTF, Microsoft Word, and XML. For more information on generating reports in these formats, see the Simulink Report Generator documentation.

**Generate Code for the Model**

Before you use the Report Generator to document your project, generate code for the model.

1. In the MATLAB Current Folder browser, navigate to a folder where you have write access.
2. Create a working folder from the MATLAB command line by typing:
   ```
   mkdir report_ex
   ```
3. Make `report_ex` your working folder:
   ```
   cd report_ex
   ```
4. Open the `slexAircraftExample` model by entering the model name on the MATLAB command line.
5. In the model window, choose **File > Save As**, navigate to the working folder, `report_ex`, and save a copy of the `slexAircraftExample` model as `myModel`.
6. Open the Configuration Parameters dialog box by selecting **Model Configuration Parameters** from the **Simulation** menu.
7. Select the **Solver** pane. In the **Solver selection** section, specify the **Type** parameter as **Fixed-step**.
8. Select the **Code Generation** pane. Select **Generate code only**.
9. Click **Apply**.
10. In the model window, press **Ctrl+B**. The build process generates code for the model.

**Open the Report Generator**

After you generate the code, open the Report Generator.

1. In the model diagram window, select **Tools > Report Generator**.
2. In the Report Explorer window, in the options pane (center), click the folder `rtw` (`\toolbox\rtw`). Click the setup file that it contains, `codegen.rpt`.
Double-click **codegen.rpt** or select it and click the Open report button. The Report Explorer displays the structure of the setup file in the outline pane (left).
Set Report Name, Location, and Format

Before generating a report, you can specify report output options, such as the folder, file name, and format. For example, to generate a Microsoft Word report named MyCGModelReport.rtf:

1. In the properties pane, under **Report Options**, review the options listed.
2 Leave the **Directory** field set to **Present working directory**.

3 For **Filename**, select **Custom**: and replace **index** with the name **MyModelCGReport**.

4 For **File format**, specify **Rich Text Format** and replace **Standard Print** with **Numbered Chapters & Sections**.

**Include Models and Subsystems in a Report**

Specify the models and subsystems that you want to include in the generated report by setting options in the Model Loop component.

1 In the outline pane (left), select **Model Loop**. Report Generator displays Model Loop component options in the properties pane.

2 If not already selected, select **Current block diagram** for the **Model name** option.
3 In the outline pane, click **Report - codegen.rpt**.

![Report Explorer](image)

**Customize the Report**

After specifying the models and subsystems to include in the report, you can customize the sections included in the report.

1 In the outline pane (left), expand the node **Chapter - Generated Code**. By default, the report includes two sections, each containing one of two report components.

2 Expand the node **Section 1 — Code Generation Summary**.

3 Select **Code Generation Summary**. Options for the component are displayed in the properties pane.

4 Click **Help** to review the report customizations that you can make with the Code Generation Summary component. For this example, do not customize the component.

5 In the Report Explorer window, expand the node **Section 1 — Generated Code Listing**.

6 Select **Import Generated Code**. Options for the component are displayed in the properties pane.

7 Click **Help** to review the report customizations that you can make with the Import Generated Code component.
Generate the Report

After you adjust the report options, from the Report Explorer window, generate the report by clicking File > Report. A Message List dialog box opens, which displays messages that you can monitor as the report is generated. Model snapshots also appear during report generation. The Message List dialog box might be hidden behind other dialog boxes.

When the report is complete, open the report, MyModelCGReport.rtf in the folder report_ex (in this example).
Document Generated Code

This example shows how to use the Simulink® Report Generator with Simulink® Coder™ to automatically generate documentation for a model and its generated code.

```matlab
model='rtwdemo_codegenrpt';
open_system(model)
```

### Step 1: Generate and Inspect Code
Generate code by double-clicking one of the blue buttons below. After generating the code, Simulink Coder displays an HTML report that includes embedded hyperlinks to the generated source files.

### Step 2: Generate Document
After generating code, use the Simulink Report Generator to generate a project document by double-clicking the yellow button below. An HTML document that includes snapshots of the model and generated code listings appears.

### Step 3: Customize Document
If you have a Simulink Report Generator license, you can customize the generated document by double-clicking the blue button below. The Report Explorer appears. From the Report Explorer, you can set file location, format, style, and other report generation options. For example, you can set the file format to Rich Text Format for use with Microsoft(R) Word.

---

Copyright 2006-2012 The MathWorks, Inc.
% Cleanup
rtwdemoclean;
close_system(model,0)

See Also

More About
  - “Document Generated Code with Simulink Report Generator” on page 22-16
Get Code Description of Generated Code

You can use the code descriptor API to obtain meta-information about the generated code. For each model build, the code generator, by default, creates a `codedescriptor.dmr` file in the build folder. When simulating the model in Accelerator and Rapid Accelerator modes, the `codedescriptor.dmr` is not generated.

You can use the code descriptor API once the code is generated. Use the code descriptor API to describe these items in the generated code:

- Data Interfaces: inports, outports, parameters, and global data stores.
- Function Interfaces: initialize, output, update, and terminate.
- Run-time information of the data and function interfaces, such as timing requirements of each interface entity.
- Model hierarchy information and code description of referenced models.

Get Data Interface Information

The `coder.descriptor.DataInterface` object describes various properties for a specified data interface in the generated code. In the model `rtwdemo_comments`, there are four inports, one outport, and a tunable global parameter. For more information about the data interfaces in your model, use the `coder.codedescriptor.CodeDescriptor` object and its methods.

1. Create a temporary folder for the build and inspection process.
   ```matlab
currentDir = pwd;
[~,cgDir] = rtwdemodir();
```
2. Build the model.
   ```matlab
rtwbuild('rtwdemo_comments')
```
3 Create a `coder.codedescriptor.CodeDescriptor` object for the required model by using the `getCodeDescriptor` function.

```matlab
codeDescriptor = coder.getCodeDescriptor('rtwdemo_comments')
```

4 To obtain a list of all the data interface types in the generated code, use the `getDataInterfaceTypes` method.

```matlab
dataInterfaceTypes = codeDescriptor.getDataInterfaceTypes()
```

A list of all the data interface types in `rtwdemo_comments` model is returned.

```matlab
{
    {'Inports'     },
    {'Outports'    },
    {'Parameters'  },
    {'GlobalParameters'}
}
```

To obtain a list of all the supported data interfaces, use the `getAllDataInterfaceTypes` method.

5 To obtain more information about a particular data interface type, use the `getDataInterfaces` method.

```matlab
dataInterface = codeDescriptor.getDataInterfaces('Inports')
```

This method returns properties of the Inport blocks in the generated code.

6 Because this model has four inports, `dataInterface` is an array of `coder.descriptor.DataInterface` objects. Obtain the details of the first Inport of the model by accessing the first location in the array.

```matlab
dataInterface(1)
The first `coder.descriptor.DataInterface` object corresponding to the `In1` block in the model is returned with its properties.

- **Type:** `[1×1 coder.descriptor.types.Double]`
- **SID:** `'rtwdemo_comments:1'`
- **GraphicalName:** `'In1'`
- **VariantInfo:** `[0×0 coder.descriptor.VariantInfo]`
- **Implementation:** `[1×1 coder.descriptor.StructExpression]`
- **Timing:** `[1×1 coder.descriptor.TimingInterface]`

### Get Function Interface Information

The function interfaces are the entry-point functions in the generated code. In the model `rtwdemo_roll`, the entry-point functions are `model_initialize`, `model_step`, and `model_terminate`. For more information about the function interfaces in your model, use the `coder.codedescriptor.CodeDescriptor` object.

1. Create a temporary folder for the build and inspection process.
   ```matlab
currentDir = pwd;
 [~,cgDir] = rtwdemodir();
```
2. Build the model.
   ```matlab
rtwbuild('rtwdemo_roll')
```
Create a `coder.codedescriptor.CodeDescriptor` object for the required model by using the `getCodeDescriptor` function. Use the code descriptor object to use the methods currently available in the API.

```matlab
codeDescriptor = coder.getCodeDescriptor('rtwdemo_roll')
```

To obtain a list of all the function interface types in the generated code, use the `getFunctionInterfaceTypes` method.

```matlab
functionInterfaceTypes = codeDescriptor.getFunctionInterfaceTypes()
```

A list of all the function interface types in `rtwdemo_roll` model is returned.

```matlab
{'Initialize'}
{'Output'}
{'Terminate'}
```

To obtain a list of all the supported function interfaces, use the `getAllFunctionInterfaceTypes` method.

To obtain more information about a particular function interface type, use the `getFunctionInterfaces` method.

```matlab
functionInterface = codeDescriptor.getFunctionInterfaces('Initialize')
```

This method returns properties of a specified function interface in the generated code.

`functionInterface` is a `coder.descriptor.FunctionInterface` object. The properties of the `rtwdemo_roll_initialize` function are returned.

```matlab
Prototype: [1x1 coder.descriptor.types.Prototype]
ActualReturn: [0x0 coder.descriptor.DataInterface]
VariantInfo: [0x0 coder.descriptor.VariantInfo]
Timing: [1x1 coder.descriptor.TimingInterface]
ActualArgs: [1x0 coder.descriptor.DataInterface List]
```

You can further expand on the properties to obtain detailed information. To get the function return value, name, and arguments:

```matlab
functionInterface.Prototype
```

The object of `coder.descriptor.types.Prototype` is returned with properties.

```matlab
Name: 'rtwdemo_roll_initialize'
Return: [0x0 coder.descriptor.types.Argument]
HeaderFile: 'rtwdemo_roll.h'
SourceFile: 'rtwdemo_roll.c'
Arguments: [1x0 coder.descriptor.types.Argument List]
Get Model Hierarchy Information

Use the `coder.codedescriptor.CodeDescriptor` object to get the entire model hierarchy information. The model `rtwdemo_async_mdlreftop` has model `rtwdemo_async_mdlrefbot` as the referenced model.

1. Create a temporary folder for the build and inspection process.
   ```
   currentDir = pwd;
   [~,cgDir] = rtwdemodir();
   ```
2. Build the root model.
   ```
   rtwbuild('rtwdemo_async_mdlreftop')
   ```
   ```
   codeDescriptor = coder.getCodeDescriptor('rtwdemo_async_mdlreftop')
   ```
4. Get a list of all the referenced models by using the `getReferencedModelNames` method.
   ```
   refModels = codeDescriptor.getReferencedModelNames()
   ```
   `refModels` has the list of referenced model.
   ```
   {'rtwdemo_async_mdlrefbot'}
   ```
5. To obtain the `coder.codedescriptor.CodeDescriptor` object for the referenced model, use the `getReferencedModelCodeDescriptor(refModelName)` method.
refCodeDescriptor = codeDescriptor.getReferencedModelCodeDescriptor('rtwdemo_async.mdlrefbot')

You can now use the refCodeDescriptor object to obtain more information about the referenced model by using all the available methods in the Code Descriptor API.

See Also

Related Examples

• "Analyze the Generated Code Interface" (Embedded Coder)
• coder.codedescriptor.CodeDescriptor
Code Replacement in Simulink Coder

- “Choose a Code Replacement Library” on page 23-8
- “Replace Code Generated from Simulink Models” on page 23-10
What Is Code Replacement?

Code replacement is a technique to change the code that the code generator produces for functions and operators to meet application code requirements. For example, you can replace generated code to meet requirements such as:

- Optimization for a specific run-time environment, including, but not limited to, specific target hardware.
- Integration with existing application code.
- Compliance with a standard, such as AUTOSAR.
- Modification of code behavior, such as enabling or disabling nonfinite or inline support.
- Application- or project-specific code requirements, such as:
  - Elimination of `math.h`.
  - Elimination of system header files.
  - Elimination of calls to `memcpy` or `memset`.
  - Use of BLAS.
  - Use of a specific BLAS.

To apply this technique, configure the code generator to apply a code replacement library (CRL) during code generation. By default, the code generator does not apply a code replacement library. You can choose from libraries that MathWorks provides and that you create and register by using the Embedded Coder product. The list of available libraries depends on:

- Installed support packages.
- System target file, language, standard math library, and device vendor configuration.
- Whether you have created and registered libraries, using the Embedded Coder product.

Libraries that include GNU99 extensions are intended for use with the GCC compiler. If you use one of those libraries with another compiler, generated code might not compile.

Code Replacement Libraries

A code replacement library consists of one or more code replacement tables that specify application-specific implementations of functions and operators. For example, a library for
a specific embedded processor specifies function and operator replacements that optimize generated code for that processor.

A code replacement table contains one or more code replacement entries, with each entry representing a potential replacement for a function or operator. Each entry maps a conceptual representation of a function or operator to an implementation representation and priority.

<table>
<thead>
<tr>
<th>Table Entry Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Conceptual representation | Identifies the table entry and contains match criteria for the code generator. Consists of:  
  - Function name or a key. The function name identifies most functions. For operators and some functions, a series of characters, called a key identifies a function or operator. For example, function name 'cos' and operator key 'RTW_OP_ADD'.  
  - Conceptual arguments that observe code generator naming ('y1', 'u1', 'u2', ...), with corresponding I/O types (output or input) and data types.  
  - Other attributes, such as an algorithm, fixed-point saturation, and rounding modes, which identify matching criteria for the function or operator. |
<table>
<thead>
<tr>
<th>Table Entry Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| Implementation representation | Specifies replacement code. Consists of:  
• Function name. For example, `cos_dbl` or `u8_add_u8_u8`.  
• Implementation arguments, with corresponding I/O types (output or input) and data types.  
• Parameters that provide additional implementation details, such as header and source file names and paths of build resources. |
| Priority | Defines the entry priority relative to other entries in the table. The value can range from 0 to 100, with 0 being the highest priority. If multiple entries have the same priority, the code generator uses the first match with that priority. |

When the code generator looks for a match in a code replacement library, it creates and populates a call site object with the function or operator conceptual representation. If a match exists, the code generator uses the matched code replacement entry populated with the implementation representation and uses it to generate code.

The code generator searches the tables in a code replacement library for a match in the order that the tables appear in the library. If the code generator finds multiple matches within a table, the priority determines the match. The code generator uses a higher-priority entry over a similar entry with a lower priority.

### Code Replacement Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache hit</td>
<td>A code replacement entry for a function or operator, defined in the specified code replacement library, for which the code generator finds a match.</td>
</tr>
<tr>
<td>Cache miss</td>
<td>A conceptual representation of a function or operator for which the code generator does not find a match.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Call site object</td>
<td>Conceptual representation of a function or operator that the code generator uses when it encounters a call site for a function or operator. The code generator uses the object to query the code replacement library for a conceptual representation match. If a match exists, the code generator returns a code replacement object, fully populated with the conceptual representation, implementation representation, and priority, and uses that object to generate replacement code.</td>
</tr>
<tr>
<td>Code replacement library</td>
<td>One or more code replacement tables that specify application-specific implementations of functions and operators. When configured to use a code replacement library, the code generator uses criteria defined in the library to search for matches. If a match is found, the code generator replaces code that it generates by default with application-specific code defined in the library.</td>
</tr>
<tr>
<td>Code replacement table</td>
<td>One or more code replacement table entries. Provides a way to group related or shared entries for use in different libraries.</td>
</tr>
<tr>
<td>Code replacement entry</td>
<td>Represents a potential replacement for a function or operator. Maps a conceptual representation of a function or operator to an implementation representation and priority.</td>
</tr>
<tr>
<td>Conceptual argument</td>
<td>Represents an input or output argument for a function or operator being replaced. Conceptual arguments observe naming conventions (&quot;y1&quot;, &quot;u1&quot;, &quot;u2&quot;, ...) and data types familiar to the code generator.</td>
</tr>
<tr>
<td><strong>Term</strong></td>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Conceptual representation</td>
<td>Represents match criteria that the code generator uses to qualify functions and operators for replacement. Consists of:</td>
</tr>
<tr>
<td></td>
<td>• Function or operator name or key</td>
</tr>
<tr>
<td></td>
<td>• Conceptual arguments with type, dimension, and complexity specification for inputs and output</td>
</tr>
<tr>
<td></td>
<td>• Attributes, such as an algorithm and fixed-point saturation and rounding modes</td>
</tr>
<tr>
<td>Implementation argument</td>
<td>Represents an input or output argument for a C or C++ replacement function. Implementation arguments observe C/C++ name and data type specifications.</td>
</tr>
<tr>
<td>Implementation representation</td>
<td>Specifies C or C++ replacement function prototype. Consists of:</td>
</tr>
<tr>
<td></td>
<td>• Function name (for example, <code>cos_dbl</code> or <code>u8_add_u8_u8</code>)</td>
</tr>
<tr>
<td></td>
<td>• Implementation arguments specifying type, type qualifiers, and complexity for the function inputs and output</td>
</tr>
<tr>
<td></td>
<td>• Parameters that provide build information, such as header and source file names and paths of build resources and compile and link flags</td>
</tr>
<tr>
<td>Key</td>
<td>Identifies a function or operator that is being replaced. A function name or key appears in the conceptual representation of a code replacement entry. The key RTW_OP_ADD identifies the addition operator.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td>Priority</td>
<td>Defines the match priority for a code replacement entry relative to other entries, which have the same name and conceptual argument list, within a code replacement library. The priority can range from 0 to 100, with 0 being the highest priority. The default is 100. If a library provides two implementations for a function or operator, the implementation with the higher priority shadows the one with the lower priority.</td>
</tr>
</tbody>
</table>

**Code Replacement Limitations**

Code replacement verification — It is possible that code replacement behaves differently than you expect. For example, data types that you observe in code generator input might not match what the code generator uses as intermediate data types during an operation. Verify code replacements by examining generated code.


**See Also**

**Related Examples**
- “Choose a Code Replacement Library” on page 23-8
- “Replace Code Generated from Simulink Models” on page 23-10
Choose a Code Replacement Library

In this section...

| “About Choosing a Code Replacement Library” on page 23-8 |
| “Explore Available Code Replacement Libraries” on page 23-8 |
| “Explore Code Replacement Library Contents” on page 23-8 |

About Choosing a Code Replacement Library

By default, the code generator does not use a code replacement library.

If you are considering using a code replacement library:

1. Explore available libraries. Identify one that best meets your application needs.
   - Consider the lists of application code replacement requirements and libraries that MathWorks provides in “What Is Code Replacement?” on page 23-2.


If you do not find a suitable library and you have an Embedded Coder license, you can create a custom code replacement library. For more information, see “What Is Code Replacement Customization?” (Embedded Coder).

Explore Available Code Replacement Libraries

Select the “Code replacement library” to use for code generation from the Configuration Parameters > Code Generation > Interface pane. To view a description of a library, select and hover your cursor over the library name. A tooltip describes the library and lists the tables that it contains. The tooltip lists the tables in the order that the code generator searches for a function or operator match.

Explore Code Replacement Library Contents

Use the Code Replacement Viewer to explore the content of a code replacement library.
1 At the command prompt, type `crviewer`.
   
   
   ```
   >> crviewer
   ```
   
   The viewer opens. To view the content of a specific library, specify the name of the library as an argument in single quotes. For example:
   
   ```
   >> crviewer('GNU C99 extensions')
   ```

2 In the left pane, select the name of a library. The viewer displays information about the library in the right pane.

3 In the left pane, expand the library, explore the list of tables it contains, and select a table from the list. In the middle pane, the viewer displays the function and operator entries that are in that table, along with abbreviated information for each entry.

4 In the middle pane, select a function or operator. The viewer displays information from the table entry in the right pane.

   If you select an operator entry that specifies net slope fixed-point parameters (instantiated from entry class `RTW.TflCOperationEntryGenerator` or `RTW.TflCOperationEntryGenerator_NetSlope`), the viewer displays an additional tab that shows fixed-point settings.

See **Code Replacement Viewer** for details on what the viewer displays.

### See Also

### Related Examples

- “Replace Code Generated from Simulink Models” on page 23-10
Replace Code Generated from Simulink Models

This example shows how to replace generated code, using a code replacement library. Code replacement is a technique you can use to change the code that the code generator produces for functions and operators to meet application code requirements. For example, you can replace generated code to meet requirements such as:

- Optimization for a specific run-time environment, including, but not limited to, specific target hardware.
- Integration with existing application code.
- Compliance with a standard, such as AUTOSAR.
- Modification of code behavior, such as enabling or disabling nonfinite or inline support.
- Application- or project-specific code requirements, such as elimination of `math.h`, system header files, or calls to `memcpy` or `memset`, or use of BLAS.

Prepare for Code Replacement

1. Make sure that MATLAB®, Simulink®, Simulink Coder™, and a C compiler are installed on your system. Some code replacement libraries available in your development environment can require Embedded Coder®.

To install MathWorks® products, see the MATLAB installation documentation. If you have installed MATLAB and want to see which other MathWorks products are installed, in the Command Window, enter `ver`.

2. Identify an existing Simulink model or create a model for which you want the code generator to replace code.

Choose a Code Replacement Library

By default, the code generator does not apply a code replacement library. You can choose from libraries that MathWorks® provides and that you create and register by using the Embedded Coder® product. The list of available libraries depends on:

- Installed support packages.
- System target file, language, standard math library, and device vendor configuration.
- Whether you have created and registered libraries, using the Embedded Coder® product.
Libraries that include GNU99 extensions are intended for use with the GCC compiler. If you use one of those libraries with another compiler, generated code might not compile.

Depending on the product licenses that you have, other libraries might be available. If you have an Embedded Coder license, you can view and choose from other libraries and you can create custom code replacement libraries.

**Configure Code Generator to Use Code Replacement Library**

1. Configure the code generator to apply a code replacement library during code generation for the model. Do one of the following:
   - In the Configuration Parameters dialog box, on the **Code Generation > Interface** pane, select a library for the “Code replacement library” parameter.
   - Set the CodeReplacementLibrary parameter at the command line or programmatically.

2. Configure the code generator to produce code only (not build an executable program) so you can verify your code replacements before building an executable program. Do one of the following:
   - In the Configuration Parameters dialog box, on the **Code Generation** pane, select “Generate code only”.
   - Set the GenCodeOnly parameter at the command line or programmatically.

**Include Code Replacement Information in Code Generation Report**

If you have an Embedded Coder license, you can configure the code generator to include a code replacement section in the code generation report. The additional information can help you verify code replacements.

1. Configure the code generator to generate a report. In the Configuration Parameters dialog box, on the **Code Generation > Report** pane, select “Create code generation report”. Consider having the report open automatically. Select Open report automatically.

2. Include the code replacement section in the report. Select “Summarize which blocks triggered code replacements”.

**Generate Replacement Code**

Generate C/C++ code from the model and, if you configured the code generator accordingly, a code generation report. For example, in the model window, press **Ctrl+B**.
The code generator produces the code and displays the report.

**Verify Code Replacements**

Verify code replacements by examining the generated code. It is possible that code replacement behaves differently than you expect. For example, data types that you observe in the code generator input might not match what the code generator uses as intermediate data types during an operation.

**More About**

- “Choose a Code Replacement Library” on page 23-8
- “Code Generation Configuration” on page 18-2
Deployment
Desksops in Simulink Coder

- “Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by Using RSim System Target File” on page 24-2
- “Run Rapid Simulations Over Range of Parameter Values” on page 24-35
- “Run Batch Simulations Without Recompiling Generated Code” on page 24-43
- “Use MAT-Files to Feed Data to Inport Blocks for Rapid Simulations” on page 24-51
- “Accelerate Simulation, Reuse Code, or Protect Intellectual Property by Using S-Function Target” on page 24-59
Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by Using RSim System Target File

After you create a model, you can use the rapid simulation (RSim) system target file to characterize model behavior. The executable program that results from the build process is for non-real-time execution on your development computer. The executable program is highly optimized for simulating models of hybrid dynamic systems, including models that use variable-step solvers and zero-crossing detection. The speed of the generated code makes the RSim system target file ideal for building programs for batch or Monte Carlo simulations.

About Rapid Simulation

Use the RSim target to generate an executable that runs fast, standalone simulations. You can repeat simulations with varying data sets, interactively or programmatically with scripts, without rebuilding the model. This can accelerate the characterization and tuning of model behavior and code generation testing.

Using command-line options:

• Define parameter values and input signals in one or more MAT-files that you can load and reload at the start of simulations without rebuilding your model.
• Redirect logging data to one or more MAT-files that you can then analyze and compare.
• Control simulation time.
• Specify external mode options.

Note To run an RSim executable, configure your computer to run MATLAB and have the MATLAB and Simulink installation folders accessible. To deploy a standalone host executable (i.e., without MATLAB and Simulink installed), consider using the Host-Based Shared Library target (ert shrlib)."

Rapid Simulation Advantage

The advantage that you gain from rapid simulation varies. Larger simulations achieve speed improvements of up to 10 times faster than standard Simulink simulations. Some models might not show noticeable improvement in simulation speed. To determine the
speed difference for your model, time your standard Simulink simulation and compare the results with a rapid simulation. In addition, test the model simulation in Rapid Accelerator simulation mode.

**General Rapid Simulation Workflow**

Like other stages of Model-Based Design, characterization and tuning of model behavior is an iterative process, as shown in the general workflow diagram in the figure. Tasks in the workflow are:

1. Identify your rapid simulation requirements. on page 24-4
2. Configure Inport blocks on page 24-6 that provide input source data for rapid simulations.
3. Configure the model on page 24-6 for rapid simulation.
4. Set up simulation input data. on page 24-8
5. Run the rapid simulations. on page 24-19
Identify Rapid Simulation Requirements

The first step to setting up a rapid simulation is to identify your simulation requirements.

<table>
<thead>
<tr>
<th>Question</th>
<th>For More Information, See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>How long do you want simulations to run?</td>
<td>“Configure and Build Model for Rapid Simulation” on page 24-6</td>
</tr>
<tr>
<td>Are there solver requirements? Do you expect to use the same solver for which the model is configured for your rapid simulations?</td>
<td>“Configure and Build Model for Rapid Simulation” on page 24-6</td>
</tr>
<tr>
<td><strong>Question...</strong></td>
<td><strong>For More Information, See...</strong></td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Do your rapid simulations need to accommodate flexible custom code interfacing? Or, do your simulations need to retain storage class settings?</td>
<td>“Configure and Build Model for Rapid Simulation” on page 24-6</td>
</tr>
<tr>
<td>Will you be running simulations with multiple data sets?</td>
<td>“Set Up Rapid Simulation Input Data” on page 24-8</td>
</tr>
<tr>
<td>Will the input data consist of global parameters, signals, or both?</td>
<td>“Set Up Rapid Simulation Input Data” on page 24-8</td>
</tr>
<tr>
<td>What type of source blocks provide input data to the model — From File, Inport, From Workspace?</td>
<td>“Set Up Rapid Simulation Input Data” on page 24-8</td>
</tr>
<tr>
<td>Will the model’s parameter vector (model_P) be used as input data?</td>
<td>“Create a MAT-File That Includes a Model Parameter Structure” on page 24-9</td>
</tr>
<tr>
<td>What is the data type of the input parameters and signals?</td>
<td>“Set Up Rapid Simulation Input Data” on page 24-8</td>
</tr>
<tr>
<td>Will the source data consist of one variable or multiple variables?</td>
<td>“Set Up Rapid Simulation Input Data” on page 24-8</td>
</tr>
<tr>
<td>Does the input data include tunable parameters?</td>
<td>“Create a MAT-File That Includes a Model Parameter Structure” on page 24-9</td>
</tr>
<tr>
<td>Do you need to gain access to tunable parameter information — model checksum and parameter data types, identifiers, and complexity?</td>
<td>“Create a MAT-File That Includes a Model Parameter Structure” on page 24-9</td>
</tr>
<tr>
<td>Will you have a need to vary the simulation stop time for simulation runs?</td>
<td>“Configure and Build Model for Rapid Simulation” on page 24-6 and “Override a Model Simulation Stop Time” on page 24-22</td>
</tr>
<tr>
<td>Do you want to set a time limit for the simulation? Consider setting a time limit if your model experiences frequent zero crossings and has a small minor step size.</td>
<td>“Set a Clock Time Limit for a Rapid Simulation” on page 24-22</td>
</tr>
<tr>
<td>Do you need to preserve the output of each simulation run?</td>
<td>“Specify a New Output File Name for a Simulation” on page 24-29 and “Specify New Output File Names for To File Blocks” on page 24-30</td>
</tr>
</tbody>
</table>
**Configure Inports to Provide Simulation Source Data**

You can use Inport blocks as a source of input data for rapid simulations. To do so, configure the blocks so that they can import data from external MAT-files. By default, the Inport block inherits parameter settings from downstream blocks. In most cases, to import data from an external MAT-file, you must explicitly set the following parameters to match the source data in the MAT-file.

- **Main > Interpolate data**
- **Signal Attributes > Port dimensions**
- **Signal Attributes > Data type**
- **Signal Attributes > Signal type**

If you do not have control over the model content, you might need to modify the data in the MAT-file to conform to what the model expects for input. Input data characteristics and specifications of the Inport block that receives the data must match.

For details on adjusting these parameters and on creating a MAT-file for use with an Inport block, see “Create a MAT-File for an Inport Block” on page 24-14. For descriptions of the preceding block parameters, see the block description of Inport.

**Configure and Build Model for Rapid Simulation**

After you identify your rapid simulation requirements, configure the model for rapid simulation.

1. Open the Configuration Parameters dialog box.
2. Go to the **Code Generation** pane.
3. On the **Code Generation** pane, click **Browse**. The System Target File Browser opens.
4. Select `rsim.tlc` (Rapid Simulation Target) and click **OK**.
On the **Code Generation** pane, the code generator populates the **Make command** and “Template makefile” fields with default settings and adds the **RSim Target** pane under **Code Generation**.

5. **Click** **RSim Target** **to view the RSim Target pane.**

6. **Set the RSim target configuration parameters to your rapid simulation requirements.**

<table>
<thead>
<tr>
<th>If You Want to...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate code that allows the RSim executable to load parameters from a MAT-file</td>
<td>Select <strong>Enable RSim executable to load parameters from a MAT-file</strong> (default).</td>
</tr>
<tr>
<td>Let the target choose a solver based on the solver already configured for the model</td>
<td>Set <strong>Solver selection</strong> to auto (default). The code generator uses a built-in solver if a fixed-step solver is specified on the <strong>Solver</strong> pane or calls the Simulink solver module (a shared library) if a variable-step solver is specified.</td>
</tr>
<tr>
<td>Explicitly instruct the target to use a fixed-step solver</td>
<td>Set <strong>Solver selection</strong> to <strong>Use fixed-step solvers</strong>. In the Configuration Parameters dialog box, on the <strong>Solver</strong> pane, specify a fixed-step solver.</td>
</tr>
<tr>
<td>Explicitly instruct the target to use a variable-step solver</td>
<td>Set <strong>Solver selection</strong> to <strong>Use Simulink solver module</strong>. In the Configuration Parameters dialog box, on the <strong>Solver</strong> pane, specify a variable-step solver.</td>
</tr>
<tr>
<td>Force storage classes to Auto for flexible custom code interfacing</td>
<td>Select <strong>Force storage classes to AUTO</strong> (default).</td>
</tr>
</tbody>
</table>
If You Want to... | Then...
---|---
Retain storage class settings, such as `ExportedGlobal` or `ImportedExtern`, due to application requirements | Clear Force storage classes to AUTO.

7 Set up data import and export options. On the **Data Import/Export** pane, in the **Save to Workspace** section, select the **Time, States, Outputs**, and **Final States** options, as they apply. By default, the code generator saves simulation logging results to a file named `model.mat`. For more information, see “Export Simulation Data” (Simulink).

8 If you are using external mode communication, set up the interface, using the **Code Generation > Interface** pane. See “Host-Target Communication with External Mode Simulation” on page 28-2 for details.

9 Press **Ctrl+B**. The code generator builds a highly optimized executable program that you can run on your development computer with varying data, without rebuilding.

For more information on compilers that are compatible with the Simulink Coder product, see “Select and Configure C or C++ Compiler or IDE” on page 27-3 and “Template Makefiles and Make Options” on page 27-26.

### Set Up Rapid Simulation Input Data

- “About Rapid Simulation Data Setup” on page 24-8
- “Create a MAT-File That Includes a Model Parameter Structure” on page 24-9
- “Create a MAT-File for a From File Block” on page 24-13
- “Create a MAT-File for an Inport Block” on page 24-14

### About Rapid Simulation Data Setup

The format and setup of input data for a rapid simulation depends on your requirements.

<table>
<thead>
<tr>
<th>If the Input Data Source Is...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The model's global parameter vector (<code>model_P</code>)</td>
<td>Use the <code>rsimgetrtp</code> function to get the vector content and then save it to a MAT-file.</td>
</tr>
<tr>
<td>The model's global parameter vector and you want a mapping between the vector and tunable parameters</td>
<td>Call the <code>rsimgetrtp</code> function to get the global parameter structure and then save it to a MAT-file.</td>
</tr>
</tbody>
</table>
If the Input Data Source Is... | Then...
--- | ---
Provided by a From File block | Create a MAT-file that a From File block can read.
Provided by an Inport block | Create a MAT-file that adheres to one of the three data file formats that the Inport block can read.
Provided by a From Workspace block | Create structure variables in the MATLAB workspace.

The RSim target requires that MAT-files used as input for From File and Inport blocks contain data. The grt target inserts MAT-file data directly into the generated code, which is then compiled and linked as an executable. In contrast, RSim allows you to replace data sets for each successive simulation. A MAT-file containing From File or Inport block data must be present if a From File block or Inport block exists in your model.

**Create a MAT-File That Includes a Model Parameter Structure**

To create a MAT-file that includes a model global parameter structure (`model_P`),

1. Get the structure by calling the function `rsimgetrtp`.
2. Save the parameter structure to a MAT-file.

If you want to run simulations over varying data sets, consider converting the parameter structure to a cell array and saving the parameter variations to a single MAT-file.

**Get the Parameter Structure for a Model**

Get the global parameter structure (`model_P`) for a model by calling the function `rsimgetrtp`.

```matlab
param_struct = rsimgetrtp('model')
```

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>model</code></td>
<td>The model for which you are running the rapid simulations.</td>
</tr>
</tbody>
</table>

The `rsimgetrtp` function forces an update diagram action for the specified model and returns a structure that contains the following fields.
### modelChecksum

A four-element vector that encodes the structure of the model. The code generator uses the checksum to check whether the structure of the model has changed since the RSim executable was generated. If you delete or add a block, and then generate a new `model_P` vector, the new checksum does not match the original checksum anymore. The RSim executable detects this incompatibility in parameter vectors and exits to avoid returning incorrect simulation results. If the model structure changes, you must regenerate the code for the model.

### parameters

A structure that contains the model's global parameters.

The parameter structure contains the following information.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dataTypeName</td>
<td>The name of the parameter data type, for example, <code>double</code></td>
</tr>
<tr>
<td>dataTypeID</td>
<td>Internal data type identifier used by the code generator</td>
</tr>
<tr>
<td>complex</td>
<td>The value 0 if real; 1 if complex</td>
</tr>
<tr>
<td>dtTransIdx</td>
<td>Internal data index used by the code generator</td>
</tr>
<tr>
<td>values</td>
<td>A vector of the parameter values associated with this structure</td>
</tr>
<tr>
<td>map</td>
<td>This field contains the mapping information that correlates the 'values' to the tunable parameters of the model. This mapping information, in conjunction with <code>rsimsetrtpparam</code>, is useful for creating subsequent <code>rtP</code> structures without compiling the block diagram.</td>
</tr>
</tbody>
</table>

The code generator reports a tunable fixed-point parameter according to its stored value. For example, an `sfix(16)` parameter value of 1.4 with a scaling of $2^{-8}$ has a value of 358 as an `int16`.

In the following example, `rsimgetrtpp` returns the parameter structure for the example model `rtwdemo_rsimtf` to `param_struct`.

```matlab
param_struct = rsimgetrtpp('rtwdemo_rsimtf')
```

```matlab
param_struct =

    modelChecksum: [1.7165e+009 3.0726e+009 2.6061e+009 2.3064e+009]
    parameters: [1x1 struct]
```
Save the Parameter Structure to a MAT-File

After you issue a call to rsimgetrtp, save the return value of the function call to a MAT-file. Using a command-line option, you can then specify that MAT-file as input for rapid simulations.

The following example saves the parameter structure returned for rtwdemo_rsimtf to the MAT-file myrsimdemo.mat.

save myrsimdemo.mat param_struct;

For information on using command-line options to specify required files, see “Run Rapid Simulations” on page 24-19.

Convert the Parameter Structure for Running Simulations on Varying Data Sets

To use rapid simulations to test changes to specific parameters, you can convert the model parameter structure to a cell array. You can then access a specific parameter set by using the @ operator to specify the index for a specific parameter set in the file.

To convert the structure to a cell array:

1 Use the function rsimgetrtp to get a structure containing parameter information for the example model rtwdemo_rsimtf. Store the structure in a variable param_struct.

   param_struct = rsimgetrtp('rtwdemo_rsimtf');

   The parameters field of the structure is a substructure that contains parameter information. The values field of the parameters substructure contains the numeric values of the parameters that you can tune during execution of the simulation code.

2 Use the function rsimsetrtpparam to expand the structure so that it contains more parameter sets. In this case, create two more parameter sets (for a total of three sets).

   param_struct = rsimsetrtpparam(param_struct,3);

   The function converts the parameters field to a cell array with three elements. Each element contains information for a single parameter set. By default, the function creates the second and third elements of the cell array by copying the first element. Therefore, all of the parameter sets use the same parameter values.

3 Specify new values for the parameters in the second and third parameter sets.
param_struct.parameters{2}.values = [-150 -5000 0 4950];
param_struct.parameters{3}.values = [-170 -5500 0 5100];

4 Save the structure containing the parameter set information to a MAT-file.

    save rtwdemo_rsimtf.mat param_struct;

Alternatively, you can modify the block parameters in the model, and use rsimgetrtp to create multiple parameter sets:

1 Use the function rsimgetrtp to get a structure containing parameter information for the example model rtwdemo_rsimtf. Store the structure in a variable param_struct.

    param_struct = rsimgetrtp('rtwdemo_rsimtf');

2 Use the function rsimsetrtpparam to expand the structure so that it contains more parameter sets. In this case, create two more parameter sets (for a total of three sets).

    param_struct = rsimsetrtpparam(param_struct,3);

The function converts the parameters field to a cell array with three elements. Each element contains information for a single parameter set. By default, the function creates the second and third elements of the cell array by copying the first element. Therefore, all of the parameter sets use the same parameter values.

3 Change the values of block parameters or workspace variables. For example, change the value of the variable w from 70 to 72.

    w = 72;

4 Use rmsgetrtp to get another structure containing parameter information. Store the structure in a temporary variable rtp_temp.

    rtp_temp = rsimgetrtp('rtwdemo_rsimtf');

5 Assign the value of the parameters field of rtp_temp to the structure param_struct as a second parameter set.

    param_struct.parameters{2} = rtp_temp.parameters;

6 Change the value of the variable w from 72 to 75.

    w = 75;

7 Use rmsgetrtp to get another structure containing parameter information. Then, assign the value of the parameters field to param_struct as a third parameter set.
rtp_temp = rsimgetrtp('rtwdemo_rsimtf');
param_struct.parameters{3} = rtp_temp.parameters;

8 Save the structure containing the parameter set information to a MAT-file.

save rtwdemo_rsimtf.mat param_struct;

For more information on how to specify each parameter set when you run the simulations, see “Change Block Parameters for an RSim Simulation” on page 24-28.

Create a MAT-File for a From File Block

You can use a MAT-file as the input data source for a From File block. The format of the data in the MAT-file must match the data format expected by that block. For example, if you are using a matrix as an input for the MAT file, this cannot be different from the matrix size for the executable.

To create a MAT-file for a From File block:

1 For array format data, in the workspace create a matrix that consists of two or more rows. The first row must contain monotonically increasing time points. Other rows contain data points that correspond to the time point in that column. The time and data points must be data of type double.

For example:

t=[0:0.1:2*pi];
Ina1=[2*sin(t) 2*cos(t)];
Ina2=sin(2*t);
Ina3=[0.5*sin(3*t) 0.5*cos(3*t)];
var_matrix=[t Ina1 Ina2 Ina3];

For other supported data types, such as int16 or fixed-point, the time data points must be of type double, just as for array format data. However, the sample data can be of any dimension.

For more information on setting up the input data, see the block description of From File.

2 Save the matrix to a MAT-file.

The following example saves the matrix var_matrix to the MAT-file myrsimdemo.mat in Version 7.3 format.

save '-v7.3' myrsimdemo.mat var_matrix;
Using a command-line option, you can then specify that MAT-file as input for rapid simulations.

**Create a MAT-File for an Inport Block**

You can use a MAT-file as the input data source for an Inport block.

The format of the data in the MAT-file must adhere to one of the three column-based formats listed in the following table. The table lists the formats in order from least flexible to most flexible.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single time/data matrix</td>
<td>• Least flexible.</td>
</tr>
<tr>
<td></td>
<td>• One variable.</td>
</tr>
<tr>
<td></td>
<td>• Two or more columns. Number of columns must equal the sum of the dimensions of all root Inport blocks plus 1. First column must contain monotonically increasing time points. Other columns contain data points that correspond to the time point in a given row.</td>
</tr>
<tr>
<td></td>
<td>• Data of type double.</td>
</tr>
</tbody>
</table>

For an example, see **Single time/data matrix** in the following procedure, step 4. For more information, see “Loading Data Arrays to Root-Level Inputs” (Simulink).
<table>
<thead>
<tr>
<th><strong>Format</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
</table>
| Signal-and-time structure | • More flexible than the single time/data matrix format.  
• One variable.  
• Must contain two top-level fields: time and signals. The time field contains a column vector of the simulation times. The signals field contains an array of substructures, each of which corresponds to an Inport block. The substructure index corresponds to the Inport block number. Each signals substructure must contain a field named values. The values field must contain an array of inputs for the corresponding Inport block, where each input corresponds to a time point specified by the time field.  
• If the time field is set to an empty value, clear the check box for the Inport block **Interpolate data** parameter.  
• Data type must match Inport block settings. |

For an example, see **Signal-and-time structure** in the following procedure, step 4. For more information on this format, see “Loading Data Structures to Root-Level Inputs” (Simulink).
<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
</table>
| Per-port structure | • Most flexible  
• Multiple variables. Number of variables must equal the number of Inport blocks.  
• Consists of a separate structure-with-time or structure-without-time for each Inport block. Each Inport block data structure has only one `signals` field. To use this format, in the **Input** text field, enter the names of the structures as a comma-separated list, `in1, in2,..., inN`, where `in1` is the data for your model's first port, `in2` for the second port, and so on.  
• Each variable can have a different time vector.  
• If the `time` field is set to an empty value, clear the check box for the Inport block **Interpolate data** parameter.  
• Data type must match Inport block settings.  
• To save multiple variables to the same data file, you must save them in the order expected by the model, using the `-append` option.  

For an example, see **Per-port structure** in the following procedure, step 4. For more information, see “Loading Data Structures to Root-Level Inputs” (Simulink).

The supported formats and the following procedure are illustrated in `rtwdemo_rsim_i`.

To create a MAT-file for an Inport block:

1. Choose one of the preceding data file formats.
2. Update Inport block parameter settings and specifications to match specifications of the data to be supplied by the MAT-file.

By default, the Inport block inherits parameter settings from downstream blocks. To import data from an external MAT-file, explicitly set the following parameters to match the source data in the MAT-file.

- **Main > Interpolate data**
- **Signal Attributes > Port dimensions**
- **Signal Attributes > Data type**
- **Signal Attributes > Signal type**
If you choose to use a structure format for workspace variables and the time field is empty, you must clear **Interpolate data** or modify the field so that it is set to a nonempty value. Interpolation requires time data.

For descriptions of the preceding block parameters, see the block description of Inport.

3 **Build an RSim executable program for the model.** The build process creates and calculates a structural checksum for the model and embeds it in the generated executable. The RSim target uses the checksum to verify that data being passed into the model is consistent with what the model executable expects.

4 **Create the MAT-file that provides the source data for the rapid simulations.** You can create the MAT-file from a workspace variable. Using the specifications in the preceding format comparison table, create the workspace variables for your simulations.

An example of each format follows:

**Single time/data matrix**

```matlab
t=[0:0.1:2*pi]';
Ina1=[2*sin(t) 2*cos(t)];
Ina2=sin(2*t);
Ina3=[0.5*sin(3*t) 0.5*cos(3*t)];
var_matrix=[t Ina1 Ina2 Ina3];
```

**Signal-and-time structure**

```matlab
t=[0:0.1:2*pi]';
var_single_struct.time=t;
var_single_struct.signals(1).values(:,1)=2*sin(t);
var_single_struct.signals(1).values(:,2)=2*cos(t);
var_single_struct.signals(2).values=sin(2*t);
var_single_struct.signals(3).values(:,1)=0.5*sin(3*t);
var_single_struct.signals(3).values(:,2)=0.5*cos(3*t);
v=[var_single_struct.signals(1).values... 
  var_single_struct.signals(2).values... 
  var_single_struct.signals(3).values];
```

**Per-port structure**

```matlab
t=[0:0.1:2*pi]';
Inb1.time=t;
Inb1.signals.values(:,1)=2*sin(t);
```
Inb1.signals.values(:,2)=2*cos(t);
t=[0:0.2:2*pi]';
Inb2.time=t;
Inb2.signals.values(:,1)=sin(2*t);
t=[0:0.1:2*pi]';
Inb3.time=t;
Inb3.signals.values(:,1)=0.5*sin(3*t);
Inb3.signals.values(:,2)=0.5*cos(3*t);

Save the workspace variables to a MAT-file.

**Single time/data matrix**

The following example saves the workspace variable var_matrix to the MAT-file rsim_i_matrix.mat.

```matlab
save rsim_i_matrix.mat var_matrix;
```

**Signal-and-time structure**

The following example saves the workspace structure variable var_single_struct to the MAT-file rsim_i_single_struct.mat.

```matlab
save rsim_i_single_struct.mat var_single_struct;
```

**Per-port structure**

To order data when saving per-port structure variables to a single MAT-file, use the `save` command's `-append` option. Be sure to append the data in the order that the model expects it.

The following example saves the workspace variables Inb1, Inb2, and Inb3 to MAT-file rsim_i_multi_struct.mat.

```matlab
save rsim_i_multi_struct.mat Inb1;
save rsim_i_multi_struct.mat Inb2 -append;
save rsim_i_multi_struct.mat Inb3 -append;
```

The `save` command does not preserve the order in which you specify your workspace variables in the command line when saving data to a MAT-file. For example, if you specify the variables v1, v2, and v3, in that order, the order of the variables in the MAT-file could be v2  v1  v3.

Using a command-line option, you can then specify the MAT-files as input for rapid simulations.
Scripts for Batch and Monte Carlo Simulations

The RSim target is for batch simulations in which parameters and input signals vary for multiple simulations. New output file names allow you to run new simulations without overwriting prior simulation results. You can set up a series of simulations to run by creating a .bat file for use on a Microsoft Windows platform.

Create a file for the Windows platform with a text editor and execute it by typing the file name, for example, mybatch, where the name of the text file is mybatch.bat.

rtwdemo_rsimtf -f rtwdemo_rsimtf.mat=run1.mat -o results1.mat -tf 10.0
rtwdemo_rsimtf -f rtwdemo_rsimtf.mat=run2.mat -o results2.mat -tf 10.0
rtwdemo_rsimtf -f rtwdemo_rsimtf.mat=run3.mat -o results3.mat -tf 10.0
rtwdemo_rsimtf -f rtwdemo_rsimtf.mat=run4.mat -o results4.mat -tf 10.0

In this case, batch simulations run using four sets of input data in files run1.mat, run2.mat, and so on. The RSim executable saves the data to the files specified with the -o option.

The variable names containing simulation results in each of the files are identical. Therefore, loading consecutive sets of data without renaming the data once it is in the MATLAB workspace results in overwriting the prior workspace variable with new data. To avoid overwriting, you can copy the result to a new MATLAB variable before loading the next set of data.

You can also write MATLAB scripts to create new signals and new parameter structures, as well as to save data and perform batch runs using the bang command (!).

For details on running simulations and available command-line options, see “Run Rapid Simulations” on page 24-19. For an example of a rapid simulation batch script, see the example “Run Batch Simulations Without Recompiling Generated Code”.

Run Rapid Simulations

- “Rapid Simulations” on page 24-20
- “Requirements for Running Rapid Simulations” on page 24-21
- “Set a Clock Time Limit for a Rapid Simulation” on page 24-22
- “Override a Model Simulation Stop Time” on page 24-22
- “Read the Parameter Vector into a Rapid Simulation” on page 24-23
- “Specify New Signal Data File for a From File Block” on page 24-23
• “Specify Signal Data File for an Inport Block” on page 24-26
• “Change Block Parameters for an RSim Simulation” on page 24-28
• “Specify a New Output File Name for a Simulation” on page 24-29
• “Specify New Output File Names for To File Blocks” on page 24-30

Rapid Simulations

Using the RSim target, you can build a model once and run multiple simulations to study effects of varying parameter settings and input signals. You can run a simulation directly from your operating system command line, redirect the command from the MATLAB command line by using the bang (!) character, or execute commands from a script.

From the operating system command line, use

rtwdemo_rsimtf

From the MATLAB command line, use

!rtwdemo_rsimtf

The following table lists ways you can use RSim target command-line options to control a simulation.

<table>
<thead>
<tr>
<th>To...</th>
<th>Use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read input data for a From File block from a MAT-file other than the MAT-file used for the previous simulation</td>
<td><code>model -f oldfilename.mat=newfilename.mat</code></td>
</tr>
<tr>
<td>Print a summary of the options for RSim executable targets</td>
<td><code>executable filename -h</code></td>
</tr>
<tr>
<td>Read input data for an Inport block from a MAT-file</td>
<td><code>model -i filename.mat</code></td>
</tr>
<tr>
<td>Time out after $n$ clock time seconds, where $n$ is a positive integer value</td>
<td><code>model -L n</code></td>
</tr>
<tr>
<td>Write MAT-file logging data to file <code>filename.mat</code></td>
<td><code>model -o filename.mat</code></td>
</tr>
<tr>
<td>Read a parameter vector from file <code>filename.mat</code></td>
<td><code>model -p filename.mat</code></td>
</tr>
<tr>
<td><strong>To...</strong></td>
<td><strong>Use...</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Override the default TCP port (17725) for external mode</td>
<td><code>model -port TCPport</code></td>
</tr>
<tr>
<td>Write MAT-file logging data to a MAT-file other than the MAT-file used for the previous simulation</td>
<td><code>model -t oldfilename.mat=newfilename.mat</code></td>
</tr>
<tr>
<td>Run the simulation until the time value <code>stoptime</code> is reached</td>
<td><code>model -tf stoptime</code></td>
</tr>
<tr>
<td>Run in verbose mode</td>
<td><code>model -v</code></td>
</tr>
<tr>
<td>Wait for the Simulink engine to start the model in external mode</td>
<td><code>model -w</code></td>
</tr>
</tbody>
</table>

The following sections use the `rtwdemo_rsimtf` example model in examples to illustrate some of these command-line options. In each case, the example assumes you have already done the following:

- Created or changed to a working folder.
- Opened the example model.
- Copied the data file `matlabroot/toolbox/rtw/rtwdemos/rsimdemos/rsim_tfdata.mat` to your working folder. You can perform this operation using the command:

  ```matlab
copyfile(fullfile(matlabroot,'toolbox','rtw','rtwdemos','rsimdemos','rsim_tfdata.mat'),pwd);
```

**Requirements for Running Rapid Simulations**

The following requirements apply to both fixed and variable step executables.

- You must run the RSim executable on a computer configured to run MATLAB. Also, the `RSim.exe` file must be able to access the MATLAB and Simulink installation folders on this machine. To obtain that access, your PATH environment variable must include `/bin` and `/bin/($ARCH)`, where ($ARCH) represents your operating system architecture. For example, for a personal computer running on a Windows platform, ($ARCH) is “win64”, whereas for a Linux machine, ($ARCH) is “glnxa64”.
- On GNU Linux platforms, to run an RSim executable, define the LD_LIBRARY_PATH environment variable to provide the path to the MATLAB installation folder, as follows:

  ```bash
  % setenv LD_LIBRARY_PATH /matlab/sys/os/glnx64:$LD_LIBRARY_PATH
  ```
On the Apple Macintosh OS X platform, to run RSim target executables, you must define the environment variable \texttt{DYLD\_LIBRARY\_PATH} to include the folders \texttt{bin/mac} and \texttt{sys/os/mac} under the MATLAB installation folder. For example, if your MATLAB installation is under \texttt{/MATLAB}, add \texttt{/MATLAB/bin/mac} and \texttt{/MATLAB/sys/os/mac} to the definition for \texttt{DYLD\_LIBRARY\_PATH}.

### Set a Clock Time Limit for a Rapid Simulation

If a model experiences frequent zero crossings and the model's minor step size is small, consider setting a time limit for a rapid simulation. To set a time limit, specify the \texttt{-L} option with a positive integer value. The simulation aborts after running for the specified amount of clock time (not simulation time). For example,

\begin{verbatim}
!rtwdemo_rsimtf -L 20
\end{verbatim}

Based on your clock, after the executable runs for 20 seconds, the program terminates. You see a message similar to one of the following:

- On a Microsoft Windows platform,
  
  Exiting program, time limit exceeded
  Logging available data ...  

- On The Open Group UNIX platform,
  
  ** Received SIGALRM (Alarm) signal @ Fri Jul 25 15:43:23 2003  
  ** Exiting model 'vdp' @ Fri Jul 25 15:43:23 2003 

You do not need to do anything to your model or to its configuration to use this option.

### Override a Model Simulation Stop Time

By default, a rapid simulation runs until the simulation time reaches the time specified the Configuration Parameters dialog box, on the \textbf{Solver} pane. You can override the model simulation stop time by using the \texttt{-tf} option. For example, the following simulation runs until the time reaches 6.0 seconds.

\begin{verbatim}
!rtwdemo_rsimtf -tf 6.0
\end{verbatim}

The RSim target stops and logs output data using MAT-file data logging rules.

If the model includes a From File block, the end of the simulation is regulated by the stop time setting specified in the Configuration Parameters dialog box, on the \textbf{Solver} pane, or with the RSim target option \texttt{-tf}. The values in the block's time vector are ignored.
However, if the simulation time exceeds the endpoints of the time and signal matrix (if the final time is greater than the final time value of the data matrix), the signal data is extrapolated to the final time value.

**Read the Parameter Vector into a Rapid Simulation**

To read the model parameter vector into a rapid simulation, you must first create a MAT-file that includes the parameter structure as described in “Create a MAT-File That Includes a Model Parameter Structure” on page 24-9. You can then specify the MAT-file in the command line with the `-p` option.

For example:

1. Build an RSim executable for the example model `rtwdemo_rsimtf`.
2. Modify parameters in your model and save the parameter structure.
   ```matlab
   param_struct = rsimgetrtp('rtwdemo_rsimtf');
   save myrsimdata.mat param_struct
   ``
3. Run the executable with the new parameter set.
   ```bash
   !rtwdemo_rsimtf -p myrsimdata.mat
   ** Starting model 'rtwdemo_rsimtf' @ Tue Dec 27 12:30:16 2005**
   ** created rtwdemo_rsimtf.mat **
   ``
4. Load workspace variables and plot the simulation results by entering the following commands:
   ```matlab
   load myrsimdata.mat
   plot(rt_yout)
   ```

**Specify New Signal Data File for a From File Block**

If your model's input data source is a From File block, you can feed the block with input data during simulation from a single MAT-file or you can change the MAT-file from one simulation to the next. Each MAT-file must adhere to the format described in “Create a MAT-File for a From File Block” on page 24-13.

To change the MAT-file after an initial simulation, you specify the executable with the `-f` option and an `oldfile.mat=newfile.mat` parameter, as shown in the following example.

1. Set some parameters in the MATLAB workspace. For example:
w = 100;
theta = 0.5;

2 Build an RSim executable for the example model rtwdemo_rsimtf.
3 Run the executable.

!rtwdemo_rsimtf

The RSim executable runs a set of simulations and creates output MAT-files containing the specific simulation result.

4 Load the workspace variables and plot the simulation results by entering the following commands:

load rtwdemo_rsimtf.mat
plot(rt_yout)

The resulting plot shows simulation results based on default input data.

5 Create a new data file, newfrom.mat, that includes the following data:

```
t=[0:.001:1];
u=sin(100*t.*t);
```
tu=[t;u];
save newfrom.mat tu;

6 Run a rapid simulation with the new data by using the -f option to replace the original file, rsim_tftdata.mat, with newfrom.mat.

!rtwdemo_rsimtf -f rsim_tftdata.mat=newfrom.mat

7 Load the data and plot the new results by entering the following commands:

load rtwdemo_rsimtf.mat
plot(rt_yout)

The next figure shows the resulting plot.

From File blocks require input data of type double. If you need to import signal data of a data type other than double, use an Inport block (see “Create a MAT-File for an Inport Block” on page 24-14) or a From Workspace block with the data specified as a structure.

Workspace data must be in the format:

variable.time
variable.signals.values
If you have more than one signal, use the following format:

variable.time
variable.signals(1).values
variable.signals(2).values

Specify Signal Data File for an Inport Block

If your model's input data source is an Inport block, you can feed the block with input data during simulation from a single MAT-file or you can change the MAT-file from one simulation to the next. Each MAT-file must adhere to one of the three formats described in “Create a MAT-File for an Inport Block” on page 24-14.

To specify the MAT-file after a simulation, you specify the executable with the -i option and the name of the MAT-file that contains the input data. For example:

1. Open the model rtwdemo_rsim_i.
2. Check the Inport block parameter settings. The following Inport block data parameter settings and specifications that you specify for the workspace variables must match settings in the MAT-file, as indicated in “Configure Inports to Provide Simulation Source Data” on page 24-6:
   - **Main > Interpolate data**
   - **Signal Attributes > Port dimensions**
   - **Signal Attributes > Data type**
   - **Signal Attributes > Signal type**
3. Build the model.
4. Set up the input signals. For example:

```matlab
t=[0:0.01:2*pi]';
s1=[2*sin(t) 2*cos(t)];
s2=sin(2*t);
s3=[0.5*sin(3*t) 0.5*cos(3*t)];
plot(t, [s1 s2 s3])
```
Prepare the MAT-file by using one of the three available file formats described in “Create a MAT-File for an Inport Block” on page 24-14. The following example defines a signal-and-time structure in the workspace and names it `var_single_struct`.

```matlab
t=[0:0.1:2*pi];
var_single_struct.time=t;
var_single_struct.signals(1).values(:,1)=2*sin(t);
var_single_struct.signals(1).values(:,2)=2*cos(t);
var_single_struct.signals(2).values=sin(2*t);
var_single_struct.signals(3).values(:,1)=0.5*sin(3*t);
var_single_struct.signals(3).values(:,2)=0.5*cos(3*t);
v=[var_single_struct.signals(1).values...
   var_single_struct.signals(2).values...
   var_single_struct.signals(3).values];
```

6 Save the workspace variable `var_single_struct` to MAT-file `rsim_i_single_struct.mat`.

```matlab
save rsim_i_single_struct.mat var_single_struct;
```

7 Run a rapid simulation with the input data by using the `-i` option. Load and plot the results.

```matlab
!rtwdemo_rsim_i -i rsim_i_single_struct.mat
```
** Starting model 'rtwdemo_rsim_i' @ Tue Aug 19 10:26:53 2014
*** rsim_i_single_struct.mat is successfully loaded! ***
** created rtwdemo_rsim_i.mat **
** Execution time = 0.02024185130718954s

8 Load and plot the results.

```
load rtwdemo_rsim_i.mat
plot(rt_tout, rt_yout);
```

![Figure1](image)

**Change Block Parameters for an RSim Simulation**

As described in “Create a MAT-File That Includes a Model Parameter Structure” on page 24-9, after you alter one or more parameters in a Simulink block diagram, you can extract the parameter vector, `model_P`, for the entire model. You can then save the parameter vector, along with a model checksum, to a MAT-file. This MAT-file can be read directly by the standalone RSim executable, allowing you to replace the entire parameter vector or individual parameter values, for running studies of variations of parameter values representing coefficients, new data for input signals, and so on.

RSim can read the MAT-file and replace the entire `model_P` structure whenever you change one or more parameters, without recompling the entire model.
For example, assume that you changed one or more parameters in your model, generated the new `model_P` vector, and saved `model_P` to a new MAT-file called `mymatfile.mat`. To run the same `rtwdemo_rsimtf` model and use these new parameter values, use the `-p` option, as shown in the following example:

```
!rtwdemo_rsimtf -p mymatfile.mat
load rtwdemo_rsimtf
plot(rt_yout)
```

If you have converted the parameter structure to a cell array for running simulations on varying data sets, as described in “Convert the Parameter Structure for Running Simulations on Varying Data Sets” on page 24-11, you must add an `@n` suffix to the MAT-file specification. `n` is the element of the cell array that contains the specific input that you want to use for the simulation.

The following example converts `param_struct` to a cell array, changes parameter values, saves the changes to MAT-file `mymatfile.mat`, and then runs the executable using the parameter values in the second element of the cell array as input.

```
param_struct = rsimgetrtp('rtwdemo_rsimtf');
param_struct = rsimsetrtpparam(param_struct,2);
param_struct.parameters{1}
ans =
```

```
dataTypeName: 'double'
   dataTypeId: 0
       complex: 0
   dtTransIdx: 0
   values: [-140 -4900 0 4900]
    map: []
structParamInfo: []
```

```
param_struct.parameters{2}.values = [-150 -5000 0 4950];
save mymatfile.mat param_struct;
!rtwdemo_rsimtf -p mymatfile.mat@2 -o rsim2.mat
```

**Specify a New Output File Name for a Simulation**

If you have specified one or more of the Save to Workspace options — Time, States, Outputs, or Final States — in the Configuration Parameters dialog box, on the Data Import/Export pane, the default is to save simulation logging results to the file `model.mat`. For example, the example model `rtwdemo_rsimtf` normally saves data to `rtwdemo_rsimtf.mat`, as follows:
You can specify a new output file name for data logging by using the `-o` option when you run an executable.

```
!rtwdemo_rsimtf -o rsim1.mat
```

In this case, the set of parameters provided at the time of code generation, including From File block data parameters, is run.

### Specify New Output File Names for To File Blocks

In much the same way as you can specify a new system output file name, you can also provide new output file names for data saved from one or more To File blocks. To do this, specify the original file name at the time of code generation with a new name, as shown in the following example:

```
!rtwdemo_rsimtf -t rtwdemo_rsimtf_data.mat=mynewrsimdata.mat
```

In this case, assume that the original model wrote data to the output file `rtwdemo_rsimtf_data.mat`. Specifying a new file name forces RSim to write to the file `mynewrsimdata.mat`. With this technique, you can avoid overwriting an existing simulation run.

### Tune Parameters Interactively During Rapid Simulation

The RSim target was designed to let you run batch simulations at the fastest possible speed. Using variable-step or fixed-step solvers with RSim combined with the use of a tunable parameter data structure, whether you set **Default parameter behavior** to Tunable or to Inlined, you can create multiple parameter sets to run with the RSim target's standalone executable file (.exe on Windows) generated using Simulink Coder. Each invocation of the executable allows specification of the file name to use for results.

For this example, **Default parameter behavior** is set to Inlined. The model declares workspace variables as tunable parameters. To use RSim with **Default parameter behavior** set to Tunable, and without explicitly declaring tunable parameters, see “Run Batch Simulations Without Recompiling Generated Code”.

### Open Example Model

Open the example model `rtwdemo_rsim_param_tuning`.
open_system('rtwdemo_rsim_param_tuning');
The RSIm target was designed to let you run batch simulations at the fastest possible speed. Using variable-step or fixed-step solvers with RSim combined with the use of a tunable parameter data structure, you can create multiple parameter sets to run with the RSim target’s standalone executable file (exe on Windows) generated using Simulink Coder. Each invocation of the executable allows specification of the filename to use for results.

This model uses the RSim target to allow a non-real-time executable to be passed new data without the need to recompile the Simulink model. This feature allows you to easily get a map of the tunable parameters declared in a model and save it in a MAT-file. You can then create your own MATLAB GUI or a standalone GUI (independent of MATLAB) to read and write the MAT-file and rerun the executable to produce new output files.

Double-click the buttons at the upper right sequentially to run the example. To review the code used to create both the MATLAB GUI and standalone GUI, double-click the View MATLAB programs button.

For more information, you can also refer to the "Rapid Simulation Target" section in the Simulink Coder documentation.
This model uses the RSim target and the \texttt{rsimgetrtp} function to allow a non real time executable to be passed new data without the need to recompile the Simulink model. This feature allows you to get a map of the tunable parameters declared in a model and save it in a MAT-file. You can then create your own MATLAB GUI or a standalone GUI (independent of MATLAB) to read and write the MAT-file and rerun the executable to produce new output files.

Double-click the buttons at the upper right sequentially to run the example.

To review the code used to create both the MATLAB GUI and standalone GUI, double-click the View MATLAB programs button.

For more information, you can also refer to the "Rapid Simulation Target" section in the Simulink Coder documentation.

**Rapid Simulation Target Limitations**

The RSim target has the following limitations:

- Does not support algebraic loops.
- Does not support Interpreted MATLAB Function blocks.
- Does not support noninlined MATLAB language or Fortran S-functions.
- If an RSim build includes referenced models (by using Model blocks), set up these models to use fixed-step solvers to generate code for them. The top model, however, can use a variable-step solver as long as the blocks in the referenced models are discrete.
- In certain cases, changing block parameters can result in structural changes to your model that change the model checksum. An example of such a change is changing the number of delays in a DSP simulation. In such cases, you must regenerate the code for the model.

**See Also**

**More About**

- “Acceleration” (Simulink)
• “Accelerate Simulation, Reuse Code, or Protect Intellectual Property by Using S-Function Target” on page 24-59
Run Rapid Simulations Over Range of Parameter Values

This example shows how to use the RSim target to run simulations over a range of parameter values. The example uses the Van der Pol oscillator and performs a parameter sweep over a range of initial state values to obtain the phase diagram of a nonlinear system.

It is very easy to customize this example for your own application by modifying the MATLAB® script used to build this example. Click the link in the top left corner of this page to edit the MATLAB® script. Click the link in the top right corner to run this example from MATLAB®. When running this example, make sure you are in a writable directory. The example creates files that you may want to investigate later.

For this example, Default parameter behavior is set to Inlined. In the example, you create Simulink.Parameter objects as tunable parameters. To use RSim with Default parameter behavior set to Tunable, and without explicitly declaring tunable parameters, see “Run Batch Simulations Without Recompiling Generated Code”.

To quickly run multiple simulations in the Simulink environment, consider using rapid accelerator instead of RSim. For information about rapid accelerator, see “What Is Acceleration?” (Simulink). To sweep parameter values, see “Optimize, Estimate, and Sweep Block Parameter Values” (Simulink).

Step 1. Preparation

Make sure the current directory is writable because this example will be creating files.

```matlab
[stat, fa] = fileattrib(pwd);
if ~fa.UserWrite
    disp('This script must be run in a writable directory');
    return
end
```

Open the model and configure it to use the RSim target. For more information on doing this graphically and setting up other RSim target related options, look here.

```matlab
mdlName = 'rtwdemo_rsim_vdp';
open_system(mdlName);
cs = getActiveConfigSet(mdlName);
cs.switchTarget('rsim.tlc',[]);
```
Specify as Tunable the variables INIT_X1 (the initial condition for state x1), INIT_X2 (the initial condition for state x2), and MU (the gain value). To create tunable parameters, convert the variables to Simulink.Parameter objects, and use a storage class other than Auto for each object. In this example we will be investigating how the state trajectories evolve from different initial values for the states x1 and x2 in the model.

```plaintext
INIT_X1 = Simulink.Parameter(INIT_X1);
INIT_X1.StorageClass = 'Model default';

INIT_X2 = Simulink.Parameter(INIT_X2);
INIT_X2.StorageClass = 'Model default';

MU = Simulink.Parameter(MU);
MU.StorageClass = 'Model default';
```

Define the names of files that will be created during this example.

```plaintext
prmFileName = [mdlName, '_prm_sets.mat'];
logFileName = [mdlName, '_run_scr.log'];
batFileName = [mdlName, '_run_scr'];
exeFileName = mdlName;
if ispc
    exeFileName = [exeFileName, '.exe'];
    batFileName = [batFileName, '.bat'];
end
```
Step 2. Build the Model

Build the RSim executable for the model. During the build process, a structural checksum is calculated for the model and embedded into the generated executable. This checksum is used to check that a parameter set passed to the executable is compatible with it.

```matlab
rtwbuild(mdlName);
```

### Starting build procedure for model: rtwdemo_rsim_vdp
### Successful completion of build procedure for model: rtwdemo_rsim_vdp

Step 3. Get the Default Parameter Set for the Model

Get the default rtP structure (parameter set) for the model. The modelChecksum field in the rtP structure is the structural checksum of the model. This must match the checksum embedded in the RSim executable (generated in step 2 above). If the two checksums do not match, the executable will generate an error. `rsimgetrtp` generates an rtP structure with entries for the named tunable variables INIT_X1, INIT_X2 and MU in the model.

```matlab
rtp = rsimgetrtp(mdlName)
```

```matlab
rtp =

struct with fields:

    modelChecksum: [466355069 1.3775e+09 3.9845e+09 42814085]
    parameters: [1x1 struct]
    globalParameterInfo: [1x1 struct]
```

Step 4. Create Parameter Sets

Using the rtp structure from step 4, we build a structure array with different values for the tunable variables in the model. As mentioned earlier, in this example we want to see how the state trajectories evolve for different initial values for the states x1 and x2 in the model. Hence we generate different parameter sets with different values for INIT_X1 and INIT_X2 and leave the tunable variable MU at the default value.

```matlab
INIT_X1_vals = -5:1:5;
INIT_X2_vals = -5:1:5;
```
MU_vals = 1;
nPrmSets = length(INIT_X1_vals)*length(INIT_X2_vals)*length(MU_vals)

nPrmSets =

121

Note that in this example we have nPrmSets parameter sets, i.e., we need to run that many simulations. Initialize aggData, which is a structure array used to hold the parameter set and the corresponding results.

aggData = struct('tout', [], 'yout', [], ...
'prms', struct('INIT_X1',[],'INIT_X2',[], 'MU', []))
aggData = repmat(aggData, nPrmSets, 1);

aggData =

struct with fields:

tout: []
yout: []
prms: [1x1 struct]

The utility function rsimsetrtpparam is a convenient way to build the rtP structure by adding parameter sets one at a time with different parameters values.

idx = 1;
for iX1 = INIT_X1_vals
    for iX2 = INIT_X2_vals
        for iMU = MU_vals
            rtp = rsimsetrtpparam(rtp,idx,'INIT_X1',iX1,'INIT_X2',iX2,'MU',iMU);
            aggData(idx).prms.INIT_X1 = iX1;
            aggData(idx).prms.INIT_X2 = iX2;
            aggData(idx).prms.MU      = iMU;
            idx = idx + 1;
        end
    end
end

Save the rtP structure array with the parameter sets to a MAT-file.

save(prmFileName,'rtp');
Step 5. Create a Batch File

We create a batch/script file to run the RSim executable over the parameter sets. Each run reads the specified parameter set from the parameter MAT-file and writes the results to the specified output MAT-file. Note that we use the time out option so that if a particular run were to hang (because the model may have a singularity for that particular parameter set), we abort the run after the specified time limit is exceeded and proceed to the next run.

For example, the command (on Windows®)

```
model.exe -p prm.mat@3 -o run3.mat -L 3600 2>&1>> run.log
```

specifies using the third parameter set from the rtP structure in prm.mat, writing the results to run3.mat, and aborting execution if a run takes longer than 3600 seconds of CPU time. In addition, messages from model.exe while it is running are piped to run.log. In case of problems, we can look at run.log to help debug.

```matlab
fid = fopen(batFileName, 'w');
idx = 1;
for iX1 = INIT_X1_vals
    for iX2 = INIT_X2_vals
        for iMU = MU_vals
            outMatFile = [mdlName, '_run', num2str(idx),'.mat'];
            cmd = [exeFileName, ... ' -p ', prmFileName, '@', int2str(idx), ... ' -o ', outMatFile, ... ' -L 3600'];
            if ispc
                cmd  = [cmd, ' 2>&1>> ', logFileName];
            else % (unix)
                cmd  = ['.' filesep cmd, ' 1> ', logFileName, ' 2>&1'];
            end
            fprintf(fid, ['echo ''', cmd, '''
']);
            fprintf(fid, [cmd, '
']);
            idx = idx + 1;
        end
    end
end
if isunix,
    system(['touch ', logFileName]);
    system(['chmod +x ', batFileName]);
end
fclose(fid);
```
Creating a batch file to run the simulations enables us to call the system command once to run the simulations (or even run the batch script outside MATLAB®) instead of calling the system command in a loop for each simulation. This results in a performance improvement because the system command has significant overhead.

**Step 6. Execute Batch File to Run Simulations**

Run the batch/script file, which runs the RSim executable once for each parameter set and saves the results to a different MAT-file each time. Note that this batch file can be run from outside MATLAB®.

```matlab
[stat, res] = system(['.' filesep batFileName]);
if stat ~= 0
    error(['Error running batch file ''', batFileName, ''' :', res]);
end
```

In this example we put the simulation runs into one batch file, ran the batch file to sequentially run 'n' simulations over 'n' parameter sets. For your application this script can be modified to generate multiple batch files, and these batch files are run in parallel by distributing them across multiple computers. Also the batch files can be run without launching MATLAB®.

**Step 7. Load Output MAT-files and Collate the Results**

Here we collect the simulation results from the output MAT-files into the aggData structure. If the output MAT-file corresponding to a particular run is not found, we set the results corresponding to that run to be NaN (not a number). This situation can occur if a simulation run with a particular set of parameters encounters singularities in the model.

```matlab
idx = 1;
for iX1 = INIT_X1_vals
    for iX2 = INIT_X2_vals
        for iMU = MU_vals
            outMatFile = [mdlName, '_run',num2str(idx),'.mat'];
            if exist(outMatFile,'file')
                load(outMatFile);
                aggData(idx).tout = rt_tout;
                aggData(idx).yout = rt_yout;
            else
                aggData(idx).tout = nan;
                aggData(idx).yout = nan;
            end
            idx = idx + 1;
        end
    end
end
```
End
end

Save the aggData structure to the results MAT-file. At this point, you can delete the other MAT-files, as the aggData data structure contains the aggregation of input (parameters sets) and output data (simulation results).

save(aggDataFile,'aggData');

disp(['Took ', num2str(cputime-startTime), ...
     ' seconds to generate results from ', ...
     num2str(nPrmSets), ' simulation runs (Steps 2 to 7).']);

Took 12.9844 seconds to generate results from 121 simulation runs (Steps 2 to 7).

Step 8. Analyze Simulation Results

We now have data to plot the phase diagram (X2 versus X1) with different initial values for x1 and x2. The diagram shows that, irrespective of the initial condition, the Van der Pol oscillator converges to its natural oscillator mode.

colors = {'b','g','r','c','m','y','k'}; nColors = length(colors);
for idx = 1:nPrmSets
    col = colors{idx - nColors*floor(idx/nColors) + 1};
    plot(aggData(idx).prms.INIT_X1, aggData(idx).prms.INIT_X2, [col,'x'], ...
         aggData(idx).yout(:,1), aggData(idx).yout(:,2),col);
    hold on
end
grid on
xlabel('X1');
ylabel('X2');
axis('square');
title('Phase diagram for Van der Pol equation');
Phase diagram for Van der Pol equation
Run Batch Simulations Without Recompiling Generated Code

This example shows how to run batch simulations without recompiling the generated code. The example modifies input signal data and model parameters by reading data from a MAT-file. In the first part (steps 1-5), ten parameter sets are created from the Simulink® model by changing the transfer function damping factor. The ten parameter sets are saved to a MAT-file, and the RSim executable reads the specified parameter set from the file. In the second part (step 6-7) of this example, five sets of signal data chirps are created with increasingly high frequencies. In both parts, the RSim executable runs the set of simulations and creates output MAT-files containing the specific simulation result. Finally, a composite of runs appears in a MATLAB® figure.

To quickly run multiple simulations in the Simulink environment, consider using rapid accelerator instead of RSim. See “What Is Acceleration?” (Simulink).

Step 1. Preparation

Make sure the current directory is writable because this example will be creating files.

```matlab
[stat, fa] = fileattrib(pwd);
if ~fa.UserWrite
    disp('This script must be run in a writable directory');
    return;
end
```

Open the model and configure it to use the RSim target. For more information on doing this graphically and setting up other RSim target related options, look here.

```matlab
mdlName = 'rtwdemo_rsimtf';
open_system(mdlName);
cs = getActiveConfigSet(mdlName);
cs.switchTarget('rsim.tlc',[]);
```
The MAT-file `rsim_tfdata.mat` is required in the local directory.

```matlab
if ~isempty(dir('rsim_tfdata.mat')),
    delete('rsim_tfdata.mat');
end
str1 = fullfile(matlabroot,'toolbox','rtw','rtwdemos','rsimdemos','rsim_tfdata.mat');
str2 = ['copyfile(''', str1, ''',''rsim_tfdata.mat'',''writable'')'];
eval(str2);
```

**Step 2. Build the Model**

Build the RSim executable for the model. During the build process, a structural checksum is calculated for the model and embedded into the generated executable. This checksum is used to check that a parameter set passed to the executable is compatible with it.

```matlab
evalin('base','w = 70;')
evalin('base','theta = 1.0;')
disp('Building compiled RSim simulation.')
rtwbuild(mdlName);
```

Building compiled RSim simulation.
### Starting build procedure for model: rtwdemo_rsimtf
### Successful completion of build procedure for model: rtwdemo_rsimtf

**Step 3. Get the Default Parameter Set and Create 10 Parameters Sets**

```matlab
disp('Creating rtP data files')
for i=1:10
    % Extract current rtP structure using new damping factor.
    [rtpstruct]=evalin('base','rsimgetrtp('''rtwdemo_rsimtf''');');
    savestr = strcat('save params',num2str(i),'.mat rtpstruct');
    eval(str2);
```
eval(savestr);
evalin('base','theta = theta - .1;');
end
disp('Finished creating parameter data files.')

Creating rtP data files
Finished creating parameter data files.

**Step 4. Run 10 RSim Simulations Using New Parameter Sets and Plot the Results**

```matlab
figure
for i=1:10
    % Bang out and run a simulation using new parameter data
    runstr = ['.', filesep, 'rtwdemo_rsimtf -p params',num2str(i),'.mat', ' -v'];
    [status, result] = system(runstr);
    if status ~= 0, error(result); end
    % Load simulation data into MATLAB for plotting.
    load rtwdemo_rsimtf.mat;
    axis([0 1 0 2]);
    plot(rt_tout, rt_yout)
    hold on
end
```
Step 5. Set Up a Time Vector and an Initial Frequency Vector

The plot shows 10 simulations, each using a different damping factor.

The time vector has 4096 points in the event we want to do windowing and spectral analysis on simulation results.

```matlab
dt = .001;
nn = [0:1:4095];
t = dt*nn; [m,n] = size(t);
wlo = 1; whi = 4;
omega = [wlo:((whi-wlo)/n):whi - (whi-wlo)/n];
```
Step 6. Create 5 Sets of Signal Data in MAT Files

Creating .mat files with chirp data.

disp('This part of the example illustrates a sequence of 5 plots. Each')
disp('plot shows an input chirp signal of certain frequency range.')
for i = 1:5
    wlo = whi; whi = 3*whi; % keep increasing frequencies
    omega = [wlo:((whi-wlo)/n):whi - (whi-wlo)/n];
    % In a real application we recommend shaping the chirp using
    % a windowing function (hamming or hanning window, etc.)
    % This example does not use a windowing function.
    u = sin(omega.*t);
    tudata = [t;u];
    % At each pass, save one more set of tudata to the next
    % .mat file.
    savestr = strcat('save sweep',num2str(i),'.mat tudata');
    eval(savestr);
    % Display each chirp. Note that this is only input data.
    % Simulations have not been run yet.
    plotstr = strcat('subplot(5,1,',num2str(i),');
    eval(plotstr);
    plot(t,u)
    pause(0.3)
end

This part of the example illustrates a sequence of 5 plots. Each
plot shows an input chirp signal of certain frequency range.
Step 7. Run the RSIm Compiled Simulation Using New Signal Data

Replace the original signal data (rsim_tfdata.mat) with the files sweep1.mat, sweep2.mat, and so on.

```matlab
disp('Starting batch simulations.')
for i = 1:5
    % Bang out and run the next set of data with RSim
    runstr = ['.', filesep, 'rtwdemo_rsimtf -f rsim_tfdata.mat=sweep', ...        num2str(i),'.mat -v -tf 4.096'];
    [status, result] = system(runstr);
    if status ~= 0, error(result); end
    % Load the data to MATLAB and plot the results.
    load rtwdemo_rsimtf.mat
```
plotstr = strcat('subplot(5,1,',num2str(i),');');
eval(plotstr);
    plot(rt_tout, rt_yout); axis([0 4.1 -3 3]);
end
zoom on
% cleanup
evalin('base','clear w theta')
disp('This part of the example illustrates a sequence of 5 plots. Each plot')
disp('shows the simulation results for the next frequency range. Using the')
disp('mouse, zoom in on each signal to observe signal amplitudes.')
close_system(mdlName, 0);

Starting batch simulations.
This part of the example illustrates a sequence of 5 plots. Each plot shows the simulation results for the next frequency range. Using the mouse, zoom in on each signal to observe signal amplitudes.
Use MAT-Files to Feed Data to Inport Blocks for Rapid Simulations

This example shows how the RSim -i option in Simulink® Coder™ lets you use a MAT-file as the input data source for Inport blocks for rapid simulations. The data in such a MAT-file can be presented in any of the following formats:

1. One variable that defines a time/input data matrix of double values.
2. One variable that defines a structure that uses a combination of Simulink® data types.
3. Multiple variables, each defining a structure that uses a combination of Simulink® data types.

This flexibility lends itself well to applications for which you must run simulations over a range of input data stored in different data files. This example explains how to use this feature.

To quickly run multiple simulations in the Simulink environment, consider using rapid accelerator instead of RSim. See “What Is Acceleration?” (Simulink).

Step 1. Preparation

Open the model and configure it to use the Simulink® Coder™ RSim target. For more information on doing this graphically and setting up other RSim target related options, look here.

```matlab
mdlName = 'rtwdemo_rsim_i';
open_system(mdlName);
cs = getActiveConfigSet(mdlName);
cs.switchTarget('rsim.tlc',[]);
```
Step 2. Configure the Inport Blocks

To use the RSim -i option, you must configure each Inport block properly. You can double-click an Inport block to view its properties. By default, Inport blocks inherit their properties from downstream blocks. Before you can import data from external MAT-files, you must set the parameters of each Inport block to match the data in the MAT file. In most cases, the following parameters of an Inport block must be set: Interpolate Data, Port Dimensions, Data Type, and Signal Type. For more information on these parameters, click the Help button. In this example model, three Inport blocks exist. We want Inport 1 and Inport 2 to interpolate between data, and Inport 3 to not interpolate. The dimension of the Inport blocks are 2, 1, and 2, respectively. Signals are real. The settings are as follows:

```matlab
for i = 1:3
    portName = ['/In', num2str(i)];
    Interp = get_param(strcat(mdlName, portName), 'Interpolate');
    PortDimension = get_param(strcat(mdlName, portName), 'PortDimensions');
    DataType = get_param(strcat(mdlName, portName), 'OutDataTypeStr');
```
SignalType = get_param(strcat(mdlName, portName), 'SignalType');
s1 = sprintf('For inport %s ', portName(2:4));
disp('-------------------------------');
disp(s1);
s2 = sprintf('The interpolation flag is %s', Interp);
disp(s2);
s3 = sprintf('The port dimension is %s', PortDimension);
disp(s3);
s4 = sprintf('The data type is %s', DataType);
disp(s4);
s5 = sprintf('The signal type is %s
', SignalType);
disp(s5);
end

-----------------------------
For inport In1
The interpolation flag is on
    The port dimension is 2
    The data type is double
    The signal type is real
-----------------------------
For inport In2
The interpolation flag is on
    The port dimension is 1
    The data type is double
    The signal type is real
-----------------------------
For inport In3
The interpolation flag is off
    The port dimension is 2
    The data type is double
    The signal type is real

Step 3. Build the Model

Build the RSim executable for the model. During the build process, a structural checksum is calculated for the model and embedded into the generated executable. This checksum is used to check that a parameter set passed to the executable is compatible with it.

evalc('rtwbuild(mdlName)');
Step 4. The Input Signals

Once the Inport block is configured, the data file should be prepared based on the Inport blocks. The following figure shows the input signals to be used.

```matlab
t=[0:0.01:2*pi]';
s1 = [2*sin(t) 2*cos(t)];
s2 = sin(2*t);
s3 = [0.5*sin(3*t) 0.5*cos(3*t)];
figure;
plot(t, [s1 s2 s3]);
disp('The following figure displays the input signals.');
```

The following figure displays the input signals.
**Step 5. Prepare the MAT-File**

Generally, the MAT-file can be created from a workspace variable. The RSim -i option supports three data file formats:

1) The MAT-file contains one variable in TU matrix format of doubles. For this format, the first column is the time vector and the remaining columns are input vectors. The number of columns in the TU matrix equals the sum of the dimensions of the root Inport blocks plus 1. The following MATLAB® code generates a MAT-file containing one variable var_matrix in TU matrix format. Note that you can use this format only if the input ports in your model have the same data type.

   ```matlab
t=[0:0.1:2*pi]';
Ina1 = [2*sin(t) 2*cos(t)];
Ina2 = sin(2*t);
Ina3 = [0.5*sin(3*t) 0.5*cos(3*t)];
var_matrix = [ t Ina1 Ina2 Ina3];
save rsim_i_matrix.mat var_matrix;
disp('rsim_i_matrix.mat contains one variable var_matrix in TU matrix format.');
```

2) The MAT-file contains one variable in structure format. For this format, the variable must contain two fields called time and signals. If one of the Inport block sets Interpolate Data to On, then the time field of the variable must not be an empty vector. Also, the width of the signals must equal the total width of the Inport blocks. The following code generates a MAT-file that contains one variable var_matrix in signal variable structure format. This format is more flexible than the TU matrix format because it can support input ports with different data types.

   ```matlab
t=[0:0.1:2*pi]';
var_single_struct.time = t;
var_single_struct.signals(1).values(:,1) = 2*sin(t);
var_single_struct.signals(1).values(:,2) = 2*cos(t);
var_single_struct.signals(2).values = sin(2*t);
var_single_struct.signals(3).values(:,1) = 0.5*sin(3*t);
var_single_struct.signals(3).values(:,2) = 0.5*cos(3*t);
v=[var_single_struct.signals(1).values var_single_struct.signals(2).values ...
   var_single_struct.signals(3).values ];
save rsim_i_single_struct.mat var_single_struct;
disp('rsim_i_single_struct.mat contains one variable var_single_struct in')
disp('struct format.');
```
rsim_i_single_struct.mat contains one variable var_single_struct in struct format.

3) The MAT-file contains multiple variables in structure format. For this format, the number of variables equals the number of Import blocks. Different variables can have different time vectors. The following code generates a MAT-file that contains multiple variables, each in structure format. This is the most flexible format because it allows each Import block to have its own time vector.

```matlab
t= [0:0.1:2*pi]';
Inb1.time = t;
Inb1.signals.values(:,1) = 2*sin(t);
Inb1.signals.values(:,2) = 2*cos(t);
t= [0:0.2:2*pi]';
Inb2.time = t;
Inb2.signals.values(:,1) = sin(2*t);
t= [0:0.1:2*pi]';
Inb3.time = t;
Inb3.signals.values(:,1) = 0.5*sin(3*t);
Inb3.signals.values(:,2) = 0.5*cos(3*t);
save rsim_i_multi_struct.mat Inb1;
save rsim_i_multi_struct.mat Inb2 -append;
save rsim_i_multi_struct.mat Inb3 -append;
disp('rsim_i_multi_struct.mat contains three variables Inb1\Inb2\Inb3 in struct format. Note that command save -append option must be used to generate the MAT-file to preserve the order of the variables in the MAT-file generated. The command: save rsim_i_multi_struct.mat Inb1 Inb2 Inb3 might not preserve the order of the variables in the MAT-file and you should not use it to generate the MAT-file.');
```

**Step 6. Run 3 RSim Simulations Using Different Files and Plot the Results**

RSim -i options can also be used for batch mode simulation. Prepare different MAT-files and run the RSim target with them.
figure
fileName = ({'rsim_i_matrix', 'rsim_i_single_struct', 'rsim_i_multi_struct'});
for i=1:3
    % bang out and run a simulation using new parameter data
    name = fileName(i);
    runstr = ['.', filesep, 'rtwdemo_rsim_i -i ',char(name),'.mat', ' -v'];
    evalc('system(runstr)');
    pause(0.5);
    % load simulation data into MATLAB(R) for plotting.
    load rtwdemo_rsim_i.mat;
    subplot(3,1,i);
    axis([0,6, -5, 5]);
    plot(rt_tout, rt_yout);
    hold on
end

disp('This part of the example illustrates a sequence of 3 plots. Each plot');
disp('shows the simulation results by using input MAT-file with different');
disp('variable format. Notice that the model is compiled only once.');
close_system(mdlName, 0);

This part of the example illustrates a sequence of 3 plots. Each plot shows the simulation results by using input MAT-file with different variable format. Notice that the model is compiled only once.
Accelerate Simulation, Reuse Code, or Protect Intellectual Property by Using S-Function Target

S-functions are an important class of system target file for which the code generator can produce code. The ability to encapsulate a subsystem into an S-function allows you to increase its execution efficiency and facilitate code reuse.

The following sections describe the properties of S-function targets and illustrate how to generate them. For more details on the structure of S-functions, see “C/C++ S-Function Basics” (Simulink).

### In this section...

- “About the S-Function Target” on page 24-59
- “Create S-Function Blocks from a Subsystem” on page 24-62
- “Tunable Parameters in Generated S-Functions” on page 24-66
- “System Target File” on page 24-68
- “Checksums and the S-Function Target” on page 24-68
- “Generated S-Function Compatibility” on page 24-69
- “S-Function Target Limitations” on page 24-69

### About the S-Function Target

Using the S-function target, you can build an S-function component and use it as an S-Function block in another model. The following sections describe deployment considerations for the S-function target.

- “Required Files for S-Function Deployment” on page 24-60
- “Sample Time Propagation in Generated S-Functions” on page 24-61
- “Choose a Solver Type” on page 24-61

The 'S-Function' value for CodeFormat TLC variable used by the S-function target generates code that conforms to the Simulink C MEX S-function application programming interface (API). Applications of this format include

- Conversion of a model to a component. You can generate an S-Function block for a model, m1. Then, you can place the generated S-Function block in another model, m2. Regenerating code for m2 does not require regenerating code for m1.
Conversion of a subsystem to a component. By extracting a subsystem to a separate model and generating an S-Function block from that model, you can create a reusable component from the subsystem. See “Create S-Function Blocks from a Subsystem” on page 24-62 for an example of this procedure.

• Speeding up simulation. Often, an S-function generated from a model performs more efficiently than the original model.

• Code reuse. You can incorporate multiple instances of one model inside another without replicating the code for each instance. Each instance continues to maintain its own unique data.

You can place a generated S-function block into another model from which you can generate another S-function. This approach allows any level of nested S-functions. For limitations related to nesting, see “Limitations on Nesting S-Functions” on page 24-74.

Note While the S-function target provides a means to deploy an application component for reuse while shielding its internal logic from inspection and modification, the preferred solutions for protecting intellectual property in distributed components are:

• The protected model, a referenced model that hides all block and line information. For more information, see “Reference Protected Models from Third Parties” (Simulink).

• The shared library system target file, used to generate a shared library for a model or subsystem for use in a system simulation external to Simulink. For more information, see “Package Generated Code as Shared Libraries” (Embedded Coder).

Required Files for S-Function Deployment

There are different files required to deploy a generated S-Function block for simulation versus code generation.

To deploy your generated S-Function block for inclusion in other models for simulation, you need only provide the binary MEX-file object that was generated in the current working folder when the S-Function block was created. The required file is:

• `subsys_sf.mexext`

where `subsys` is the subsystem name and `mexext` is a platform-dependent MEX-file extension (see `mexext`). For example, `SourceSubsys_sf.mexw64`. 

24-60
To deploy your generated S-Function block for inclusion in other models for code generation, you must provide all of the files that were generated in the current working folder when the S-Function block was created. The required files are:

- `subsys_sf.c` or `.cpp`, where `subsys` is the subsystem name (for example, `SourceSubsys_sf.c`)
- `subsys_sf.h`
- `subsys_sf.mexext`, where `mexext` is a platform-dependent MEX-file extension (see `mexext`)
- Subfolder `subsys_sfcn_rtw` and its contents

**Note** The generated S-function code uses **Configuration Parameters > Hardware Implementation** parameter values that match the host system on which the function was built. When you use the S-function in a model for code generation, make sure that these parameter values for the model match the parameter values of the S-function.

### Sample Time Propagation in Generated S-Functions

A generated S-Function block can inherit its sample time from the model in which it is placed if certain criteria are met. Conditions that govern sample time propagation for both Model blocks and generated S-Function blocks are described in “Referenced Model Sample Times” (Simulink) and “Inherited Sample Time for Referenced Models” on page 7-25.

To generate an S-Function block that meets the criteria for inheriting sample time, you must constrain the solver for the model from which the S-Function block is generated. On the **Solver** configuration parameters dialog box pane, set **Type** to **Fixed-step** and **Periodic sample time constraint** to **Ensure sample time independent**. If the model is unable to inherit sample times, this setting causes the Simulink software to display an error message when building the model. For more information about this option, see “Periodic sample time constraint” (Simulink).

### Choose a Solver Type

The table shows the possible combinations of top-level model solver types as these types relate to whether the model has discrete or continuous sample times and solver types for generated S-functions.
### Top-Level Model Solver Options and Sample Times

<table>
<thead>
<tr>
<th>Sample Times</th>
<th>Solver Options, Type: Variable-step</th>
<th>Solver Options, Type: Fixed-step</th>
</tr>
</thead>
<tbody>
<tr>
<td>Discrete</td>
<td>Generated S-function requires a variable-step solver</td>
<td>Generated S-function can have a variable-step solver or a fixed-step solver</td>
</tr>
<tr>
<td>Continuous</td>
<td>Generated S-function requires a variable-step solver</td>
<td>Generated S-function requires a fixed-step solver</td>
</tr>
</tbody>
</table>

**Note** S-functions generated from a subsystem have parameters that are hardcoded into the block. Simulink calculates parameters such as sample time when it generates the block, not during simulation run time. It is important to verify whether the generated S-Function block works as expected in the destination model.

### Create S-Function Blocks from a Subsystem

This section illustrates how to extract a subsystem from a model and generate a reusable S-function component from it.

The next figure shows `SourceModel`, a simple model that inputs signals to a subsystem. The subsequent figure shows the subsystem, `SourceSubsys`. The signals, which have different widths and sample times, are:

- A Step block with sample time 1
- A Sine Wave block with sample time 0.5
- A Constant block whose value is the vector [-2 3]
The objective is to extract SourceSubsys from the model and build an S-Function block from it, using the S-function target. The S-Function block must perform identically to the subsystem from which it was generated.

In this model, SourceSubsys inherits sample times and signal widths from its input signals. However, S-Function blocks created from a model using the S-function target has all signal attributes (such as signal widths or sample times) hard-wired. (The sole exception to this rule concerns sample times, as described in “Sample Time Propagation in Generated S-Functions” on page 24-61.)
In this example, you want the S-Function block to retain the properties of SourceSubsys as it exists in SourceModel. Therefore, before you build the subsystem as a separate S-function component, you must set the inport sample times and widths explicitly. In addition, the solver parameters of the S-function component must be the same as those parameters of the original model. The generated S-function component operates identically to the original subsystem (see “Choose a Solver Type” on page 24-61 for more information).

To build SourceSubsys as an S-function component,

1 Create a new model and copy/paste the SourceSubsys block into the empty window.
2 Set the signal widths and sample times of inports inside SourceSubsys such that they match those of the signals in the original model. Inport 1, Filter, has a width of 1 and a sample time of 1. Inport 2, Xferfcn, has a width of 1 and a sample time of 0.5. Inport 3, offsets, has a width of 2 and a sample time of 0.5.
3 The generated S-Function block should have three inports and one outport. Connect inports and an outport to SourceSubsys, as shown in the next figure.

![Diagram of SourceSubsys block diagram](image)

The signal widths and sample times are propagated to these ports.
4 Set the solver type, mode, and other solver parameters such that they are identical to those of the source model. This is easiest to do if you use Model Explorer.
5 In the Configuration Parameters dialog box, go to the Code Generation pane.
6 Click Browse to open the System Target File Browser.
7 In the System Target File Browser, select the S-function target, rtwsfcn.tlc, and click OK.
8 Select the S-Function Target pane. Make sure that Create new model is selected, as shown in the next figure:

![Create new model options]

When this option is selected, the build process creates a new model after it builds the S-function component. The new model contains an S-Function block, linked to the S-function component.

Click Apply.

9 Save the new model containing your subsystem, for example as SourceSubsys.

10 Build the model.

11 The build process produces the S-function component in the working folder. After the build, a new model window is displayed.

![Generated S-Function]

Optionally you can save the generated model, for example as SourceSubsys_Sfunction.

12 You can now copy the S-Function block generated from the new model and use it in other models or in a library.

**Note** For a list of files required to deploy your S-Function block for simulation or code generation, see “Required Files for S-Function Deployment” on page 24-60.

The next figure shows the S-Function block plugged into the original model. Given identical input signals, the S-Function block performs identically to the original subsystem.
Generated S-Function Configured Like Source Model

The speed at which the S-Function block executes is typically faster than the original model. This difference in speed is more pronounced for larger and more complicated models. By using generated S-functions, you can increase the efficiency of your modeling process.

Tunable Parameters in Generated S-Functions

You can use tunable parameters in generated S-functions in two ways:

- Use the **Generate S-function** feature (see “Generate S-Function from Subsystem” on page 14-74).

  or

- Use the Model Parameter Configuration dialog box (see “Declare Workspace Variables as Tunable Parameters Using the Model Parameter Configuration Dialog Box” on page 15-244) to declare desired block parameters tunable.

Block parameters that are declared tunable with the `auto` storage class in the source model become tunable parameters of the generated S-function. These parameters do not become part of a generated `model_P` (formerly `rtP`) parameter data structure, as they would in code generated from other targets. Instead, the generated code accesses these parameters by using MEX API calls such as `mxGetPr` or `mxGetData`. Your code should access these parameters in the same way.

For more information on MEX API calls, see “About C MEX S-Functions” (Simulink) and “MATLAB API for Other Languages” (MATLAB).
S-Function blocks created by using the S-function target are automatically masked. The mask displays each tunable parameter in an edit field. By default, the edit field displays the parameter by variable name, as in the following example.

![Block Parameters: Generated S-Function](image)

You can choose to display the value of the parameter rather than its variable name by selecting **Use value for tunable parameters** on the **Code Generation > S-Function Target** pane of the Configuration Parameters dialog box.

![Configuration Parameters](image)

When this option is chosen, the value of the variable (at code generation time) is displayed in the edit field, as in the following example.
System Target File

The rtwsfcn.tlc system target file is provided for use with the S-function target.

Checksums and the S-Function Target

The code generator creates a checksum for a model and uses the checksum during the build process for code reuse, model reference, and external mode features.

The code generator calculates a model checksum by

1. Calculating a checksum for each subsystem in the model. A subsystem's checksum is the combination of properties (data type, complexity, sample time, port dimensions, and so forth) of the subsystem's blocks.

2. Combining the subsystem checksums and other model-level information.

An S-function can add additional information, not captured during the block property analysis, to a checksum by calling the function ssSetChecksumVal. For the S-Function target, the value that gets added to the checksum is the checksum of the model or subsystem from which the S-function is generated.

The code generator applies the subsystem and model checksums as follows:
• Code reuse — If two subsystems in a model have the same checksum, the code generator produces code for one function only.
• Model reference — If the current model checksum matches the checksum when the model was built, the build process does not rebuild referenced models.
• External mode — If the current model checksum does not match the checksum of the code that is running on the target hardware, the build process generates an error.

**Generated S-Function Compatibility**

When you build a MEX S-function from your model, the code generator builds a level 2 noninlined S-function. Cross-release usage limitations on the generated code and binary MEX file (for example, *.mexw64) include:

• S-function target generated code from previous MATLAB release software is not compatible with newer releases. Do not recompile the generated code from a previous release with newer MATLAB release software. Use the same MATLAB release software to generate code for the S-function target and compile the code into a MEX file.
• You can use binary S-function MEX files generated from previous MATLAB release software with the same or newer releases with the same compatibility considerations as handwritten S-functions. For more information, see “S-Function Compatibility” (Simulink).
• The code generator can generate code and build an executable from a model that contains generated S-functions. This support requires that the S-functions are built with the same MATLAB release software that builds the model. It is not possible to incorporate a generated S-function MEX file from previous MATLAB release software into a model and build the model with newer releases.

**S-Function Target Limitations**

• “Limitations on Using Tunable Variables in Expressions” on page 24-70
• “Parameter Tuning” on page 24-70
• “Run-Time Parameters and S-Function Compatibility Diagnostics” on page 24-70
• “Limitations on Using Goto and From Block” on page 24-71
• “Limitations on Building and Updating S-Functions” on page 24-72
• “Unsupported Blocks” on page 24-73
• “SimState Not Supported for Code Generation” on page 24-73
Limitations on Using Tunable Variables in Expressions

Certain limitations apply to the use of tunable variables in expressions. When the code generator encounters an unsupported expression while producing code, a warning appears and the equivalent numeric value is generated in the code. For a list of the limitations, see “Tunable Expression Limitations” on page 15-136.

Parameter Tuning

The S-Function block does not support tuning of tunable parameters with:

- Complex values.
- Values or data types that are transformed to a constant (by setting the model configuration parameter Optimization > Default parameter behavior to Inlined).
- Data types that are not built-in.

If you select these tunable parameters (through the Generate S-Function for Subsystem dialog box):

- The software produces warnings during the build process.
- The generated S-Function block mask does not display these parameters.

Run-Time Parameters and S-Function Compatibility Diagnostics

If you set the S-function upgrades needed option on the Diagnostics > Compatibility pane of the Configuration Parameters dialog box to warning or error, the code generator instructs you to upgrade S-functions that you create with the Generate S-function feature. This is because the S-function system target file does not register run-time parameters. Run-time parameters are only supported for inlined S-Functions and the
generated S-Function supports features that prevent it from being inlined (for example, it can call or contain other noninlined S-functions).

You can work around this limitation by setting the **S-function upgrades needed** option to **none**.

**Limitations on Using Goto and From Block**

When using the S-function system target file, the code generator restricts I/O to correspond to the root model Inport and Outport blocks (or the Inport and Outport blocks of the Subsystem block from which the S-function target was generated). No code is generated for Goto or From blocks.

To work around this restriction, create your model and subsystem with the required Inport and Outport blocks, instead of using Goto and From blocks to pass data between the root model and subsystem. In the model that incorporates the generated S-function, you would then add Goto and From blocks.

**Example Before Work Around**

- Root model with a From block and subsystem, **Subsystem1**

![Diagram](image1)

- **Subsystem1** with a Goto block, which has global visibility and passes its input to the From block in the root model

![Diagram](image2)

- **Subsystem1** replaced with an S-function generated with the S-Function target — a warning results when you run the model because the generated S-function does not implement the Goto block
**Example After Work Around**

An Outport block replaces the GoTo block in *Subsystem1*. When you plug the generated S-function into the root model, its output connects directly to the To Workspace block.

**Limitations on Building and Updating S-Functions**

The following limitations apply to building and updating S-functions using the S-function system target file:

- You cannot build models that contain Model blocks using the S-function system target file. This also means that you cannot build a subsystem module by right-clicking (or by using **Code > C/C++ Code > Build Selected Subsystem**) if the subsystem contains Model blocks. This restriction applies only to S-functions generated using the S-function target, not to ERT S-functions.

- If you modify the model that generated an S-Function block, the build process does not automatically rebuild models containing the generated S-Function block. This is in contrast to the practice of automatically rebuilding models referenced by Model blocks when they are modified (depending on the Model Reference **Rebuild** configuration setting).
• Handwritten S-functions without corresponding TLC files must contain exception-free code. For more information on exception-free code, see “Exception Free Code” (Simulink).

Unsupported Blocks

The S-function format does not support the following built-in blocks:

• Interpreted MATLAB Function block
• S-Function blocks containing any of the following:
  • MATLAB language S-functions (unless you supply a TLC file for C code generation)
  • Fortran S-functions (unless you supply a TLC file for C code generation)
  • C/C++ MEX S-functions that call into the MATLAB environment
• Scope block
• To Workspace block

The S-function format does not support blocks from the `embeddedtargetslib` block library.

SimState Not Supported for Code Generation

You can use SimState within C-MEX and Level-2 MATLAB language S-functions to save and restore the simulation state. See “S-Function Compliance with the SimState” (Simulink). However, SimState is not supported for code generation, including with the S-function system target file.

Profiling Code Performance with TLC Hook Function Not Supported

Profiling the performance of generated code using the Target Language Compiler (TLC) hook function interface described in “Profile Code Performance” on page 27-77 is not supported for the S-function target.

Note If you have an Embedded Coder license, see “Code Execution Profiling” (Embedded Coder) for an alternative and simpler approach based on software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulations.
Limitations on Nesting S-Functions

The following limitations apply to nesting a generated S-Function block in a model or subsystem from which you generate another S-function:

- The software does not support nonvirtual bus input and output signals for a nested S-function.
- You should avoid nesting an S-function in a model or subsystem having the same name as the S-function (possibly several levels apart). In such situations, the S-function can be called recursively. The software currently does not detect such loops in S-function dependency, which can result in aborting or hanging your MATLAB session. To prevent this from happening, be sure to name the subsystem or model to be generated as an S-function target uniquely, to avoid duplicating existing MEX filenames on the MATLAB path.

Limitations on User-Defined Data Types

The S-function system target file does not support the HeaderFile property that can be specified on user-defined data types, including those based on Simulink.AliasType, Simulink.Bus, and Simulink.NumericType objects. If a user-defined data type in your model uses the HeaderFile property to specify an associated header file, code generation with the S-function system target file disregards the value and does not generate a corresponding include statement.

Limitation on Right-Click Generation of an S-Function Target

If you generate an S-function target by right-clicking a Function-Call Subsystem block, the original subsystem and the generated S-function might not be consistent. An inconsistency occurs when the States when enabling parameter of the Trigger Port block inside the Function-Call Subsystem block is set to inherit. You must set the States when enabling parameter to reset or held, otherwise Simulink reports an error.

Limitation on S-Functions with Bus I/O Signals

If an S-function generated using the S-function target has bus input or output signals, the generated bus data structures might include padding to align fields of the bus elements with the Simulink representation used during simulation. However, if you insert the S-function in a model and generate code using a model target such as grt.tlc, the bus structure alignment generated for the model build might be incompatible with the padding generated for the S-function and might affect the numerical results of code execution. To make the structure alignment consistent between model simulation and
execution of the model code, for each Simulink.Bus object, you can modify the HeaderFile property to remove the unpadded bus structure header file. This will cause the bus typedefs generated for the S-function to be reused in the model code.

**Limitation on Subsystems with Function-Call I/O Signals**

The S-function target does not support creating an S-Function block from a subsystem that has a function-call trigger input or a function-call output.

**Data Store Access**

When an S-Function in your model accesses a data store during simulation, Simulink disables data store diagnostics.

- If you created the S-Function from a model, the diagnostic is disabled for global data stores as well.
- If you created the S-Function from a subsystem, the diagnostic is disabled for the following data stores:
  - Global data stores
  - Data stores placed outside the subsystem, but accessed by Data Store Read or Data Store Write blocks.

**Cannot Specify Inport or Outport Block Parameters Through Subsystem Mask**

You cannot specify any Inport or Outport block parameters through subsystem mask variables if you want to generate an S-Function block from the subsystem. The software produces an error when you try to run a simulation that uses the S-Function block, for example:

```
Invalid setting in 'testSystem/Subsystem/__OutputSSForSFun__/Out2'
for parameter 'PortDimensions'
...
```

**See Also**

**More About**

- “Acceleration” (Simulink)
• “Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by Using RSim System Target File” on page 24-2
Real-Time Systems in Simulink Coder

• “Deploy Algorithm Model for Real-Time Rapid Prototyping” on page 25-2
• “Deploy Environment Model for Real-Time Hardware-In-the-Loop (HIL) Simulation” on page 25-5
Deploy Algorithm Model for Real-Time Rapid Prototyping

Use the code generator to deploy algorithm models for real-time rapid prototyping.

About Real-Time Rapid Prototyping

Real-time rapid prototyping requires the use of a real-time simulator, potentially connected to system hardware (for example, physical plant or vehicle) being controlled. You generate, deploy, and tune code as it runs on the real-time simulator or embedded microprocessor. This design step is crucial for verifying whether a component can adequately control the system, and allows you to assess, interact with, and optimize code.

The following figure shows a typical approach for real-time rapid prototyping.

Goals of Real-Time Rapid Prototyping

Assuming that you have documented functional requirements, refined concept models, system hardware for the physical plant or vehicle being controlled, and access to target products you intend to use (for example, the Simulink Real-Time or Simulink Desktop Real-Time product), you can use real-time prototyping to:

- Refine component and environment model designs by rapidly iterating between algorithm design and prototyping
• Validate whether a component can adequately control the physical system in real time
• Evaluate system performance before laying out hardware, coding production software, or committing to a fixed design
• Test hardware

**Refine Code With Real-Time Rapid Prototyping**

To perform real-time rapid prototyping:

1. Create or acquire a real-time system that runs in real time on rapid prototyping hardware. The Simulink Real-Time product facilitates real-time rapid prototyping. This product provides a real-time operating system that makes PCs run in real time. It also provides device driver blocks for numerous hardware I/O cards. You can then create a rapid prototyping system using inexpensive commercial-off-the-shelf (COTS) hardware. In addition, third-party vendors offer products based on the Simulink Real-Time product or other code generation technology that you can integrate into a development environment.

2. Use provided system target files to generate code that you can deploy onto a real-time simulator. See the following information.

<table>
<thead>
<tr>
<th>Engineering Tasks</th>
<th>Related Product Information</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Generate code for real-time rapid prototyping | “Compare System Target File Support Across Products” on page 19-21  
“Event-Based Scheduling”  
Embedded Coder  
“Support for Standards and Guidelines” (Embedded Coder) | rtwdemo_counter  
rtwdemo_counter_msvc |

Generate code for rapid prototyping in hard real time, using PCs | Simulink Real-Time  
“Simulink Real-Time Options Pane” (Simulink Real-Time) | help xpcdemos |
### Engineering Tasks

<table>
<thead>
<tr>
<th>Engineering Tasks</th>
<th>Related Product Information</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate code for rapid prototyping in soft real time, using PCs</td>
<td>Simulink Desktop Real-Time</td>
<td>sldrtex_vdp (and others)</td>
</tr>
<tr>
<td></td>
<td>“Simulink Desktop Real-Time</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pane” (Simulink Desktop Real-</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Time)</td>
<td></td>
</tr>
</tbody>
</table>

3. Monitor signals, tune parameters, and log data.

## See Also

## More About

-  “Access Signal, State, and Parameter Data During Execution” on page 15-7
-  “Basic Process Steps” (Simulink Real-Time)
Deploy Environment Model for Real-Time Hardware-In-the-Loop (HIL) Simulation

In this section...

“About Hardware-In-the-Loop Simulation” on page 25-5
“Set Up and Run HIL Simulations” on page 25-6

About Hardware-In-the-Loop Simulation

Hardware-in-the-loop (HIL) simulation tests and verifies an embedded system or control unit in the context of a software test platform. Examples of test platforms include real-time target systems and instruction set simulators (IISs). You use Simulink software to develop and verify a model that represents the test environment. Using the code generator, you produce, build, and download an executable program for the model to the HIL simulation platform. After you set up the environment, you can run the executable to validate the embedded system or control unit in real time.

During HIL simulation, you gradually replace parts of a system environment with hardware components as you refine and fabricate the components. HIL simulation offers an efficient design process that eliminates costly iterations of part fabrication.

The code that you build for the system simulator provides real-time system capabilities. For example, the code can include VxWorks from Wind River or another real-time operating system (RTOS).

The following figure shows a typical HIL setup.

![Diagram of HIL setup]

Simulink

Algorithm model

Environment model

Code generation

Embedded system

Harness

Real-time simulator

Code generation
The HIL platform available from MathWorks is the Simulink Real-Time product. Several third-party products are also available for use as HIL platforms. The Simulink Real-Time product offers hard real-time performance for PCs with Intel® or AMD® 32-bit processors functioning as your real-time target. The Simulink Real-Time product enables you to add I/O interface blocks to your models and automatically generate code with code generation technology. The Simulink Real-Time product can download the code to a second PC running the Simulink Real-Time real-time kernel. System integrator solutions that are based on Simulink Real-Time are also available.

**Set Up and Run HIL Simulations**

To set up and run HIL simulations iterate through the following steps:

1. Develop a model that represents the environment or system under development.
   For more information, see “Compare System Target File Support Across Products” on page 19-21.
2. Generate an executable for the environment model.
3. Download the executable for the environment model to the HIL simulation platform.
4. Replace software representing a system component with corresponding hardware.
5. Test the hardware in the context of the HIL system.
6. Repeat steps 4 and 5 until you can simulate the system after including components that require testing.

**See Also**

**More About**

- “Access Signal, State, and Parameter Data During Execution” on page 15-7
- “Real-Time Simulation and Testing” (Simulink Real-Time)
External Code Integration in Simulink Coder

The code generator includes multiple approaches for integrating legacy or custom code with generated code. Legacy code is existing handwritten code or code for environments that you integrate with code produced by the code generator. Custom code is legacy code or other user-specified lines of code that you include in the code generator build process. Collectively, legacy and custom code are called external code.

You integrate external code by importing existing external code into code produced by the code generator, exporting generated code into an existing external code base, or you can do both. For example, you can import code by calling an external function, by using the Legacy Code Tool, or place external code at specific locations in generated code by including Custom Code blocks in a model. When you import external code, the resulting generated code interfaces with generated scheduling code.

You can export generated code as a plug-in function for use in an external development environment. When you export generated code, you intend to interface that code manually with a scheduling mechanism in your application run-time environment.

For guidance on choosing an approach based on your application, see “Choose an External Code Integration Workflow” on page 26-4.

- “Choose an External Code Integration Workflow” on page 26-4
- “Configure Target Hardware Characteristics” on page 26-13
- “Check Code Generation Assumptions” on page 26-15
- “Call Reusable External Algorithm Code for Simulation and Code Generation” on page 26-19
- “Place External C/C++ Code in Generated Code” on page 26-39
- “Call External Device Drivers” on page 26-51
- “Apply Function and Operator Code Replacements” on page 26-53
- “Build Integrated Code Within the Simulink Environment” on page 26-54
• “Generate Component Source Code for Export to External Code Base” on page 26-64
• “Generate Shared Library for Export to External Code Base” on page 26-85
• “Interface to a Development Computer Simulator By Using a Shared Library” on page 26-92
• “Build Integrated Code Outside the Simulink Environment” on page 26-95
• “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on page 26-102
• “Exchange Data Between External Calling Code and Generated Code” on page 26-114
• “Generate Code That Matches Appearance of External Code” on page 26-118
What Is External Code Integration?

Software projects typically involve combining code from multiple sources. A typical system structure for a code generation application consists of a framework that combines code from multiple sources, including external code and code generated from Simulink models.

This figure shows an application that requires integration of existing driver code for hardware devices. The core software algorithms and logic can be a combination of code modules for external reusable algorithms integrated into the Simulink environment and code generated as part of an overall model design.

Several workflows and tools are available for you to integrate external and generated code. Each workflow identifies tooling for generating code that aligns interfaces, code appearance, and other factors, such as optimization between external and generated code.

See Also

More About
- “Choose an External Code Integration Workflow” (Embedded Coder)
Choose an External Code Integration Workflow

In this section...

“Choose a Software Execution Framework for Scheduling Code Execution” on page 26-5
“Evaluate Characteristics of External Code” on page 26-7
“Identify Integration Requirements” on page 26-8
“Choose a Workflow” on page 26-10

Completing these tasks helps you choose external code integration workflows and tooling that align with your project.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Partition your application, map algorithms to components, and identify integration points.</td>
<td>“Design Models for Generated Embedded Code Deployment” (Embedded Coder)</td>
</tr>
<tr>
<td>2</td>
<td>Determine whether you can rely on scheduling code that the code generator produces, or whether you must integrate generated code with scheduling mechanisms that are specific to your run-time environment.</td>
<td>“Choose a Software Execution Framework for Scheduling Code Execution” (Embedded Coder)</td>
</tr>
<tr>
<td>3</td>
<td>Evaluate the characteristics of the external code that you are importing or to which you are exporting generated code.</td>
<td>“Evaluate Characteristics of External Code” (Embedded Coder)</td>
</tr>
<tr>
<td>4</td>
<td>Identify integration requirements, which assists with choosing optimal tooling for your integration.</td>
<td>“Identify Integration Requirements” (Embedded Coder)</td>
</tr>
<tr>
<td>5</td>
<td>Based on the results of tasks 1–4, choose a workflow.</td>
<td>“Choose a Workflow” (Embedded Coder)</td>
</tr>
</tbody>
</table>
Choose a Software Execution Framework for Scheduling Code Execution

The code generator supports two types of software execution frameworks—single top model and multiple top-level, as described in “Design Models for Generated Embedded Code Deployment” (Embedded Coder). The first question to answer concerns which of the two frameworks meets the scheduling and other needs of your project. For example, you can import external code into a single, rate-based top model. You can export code from a single top model or multiple top-level models for integration with custom (external) scheduling mechanisms.

- **Single top model**

Generate one set of application code files from external code and code that the Simulink C/C++ code generator produces. The generated code includes a scheduler. In this case, you import code into the Simulink code generation environment.
• Single top model or multiple top-level models

Integrate C or C++ code that the code generator produces from model components with external application code and an external scheduler. You export generated code from the Simulink code generation environment.

Importing calls to external device driver code into a model and generating code for that model for export involves importing and exporting code.

Based on goals and requirements, external code integration is characterized in several ways, requiring different workflows and integration tooling:

• Import existing external code into generated code.
  • Call reusable external algorithm code for simulation and code generation.
  • Place external C/C++ code in generated code.
• Call external device drivers.
• Apply function and operator code replacements.
• Interface with external timer interrupt or scheduler.
• Generate replacement code for specific run-time environment.
• Export generated code for inclusion in external code base.
  • Generate component source code for export.
  • Generate shared library for export.

Next, see “Evaluate Characteristics of External Code” (Embedded Coder).

**Evaluate Characteristics of External Code**

Before choosing an external integration workflow, evaluate these characteristics of the external code. To interface with external code, generated C or C++ code handles one or more of the external code characteristics. An understanding of these characteristics and your requirements for modeling, simulation, and code generation helps you choose the optimal workflow for your integration scenario. (See “Identify Integration Requirements” (Embedded Coder).)

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>What to Consider</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware dependency</td>
<td>Is the external code hardware-dependent? Utility functions, lookup tables, and filters are examples of hardware-independent code.</td>
</tr>
<tr>
<td></td>
<td>Device drivers interact directly with hardware. They depend on characteristics of the hardware. For example, a device driver for an analog-to-digital converter initializes, reads data from, and writes data to hardware registers. Hardware differences and dependencies concern data type size, endianess, shift operations, compiler directives, and optimized function and operator support. Other code interfaces with device drivers by using an API and data mapped to specific memory addresses. Typically, simulation on a development computer is not possible. Reading from and writing to a register during simulation on a development computer produces unexpected and unwanted results.</td>
</tr>
<tr>
<td>Characteristic</td>
<td>What to Consider</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reusable</td>
<td>Is the external code a reusable software module? Examples include utility functions, lookup tables, filters, specialized integrators, and proportional-integral-derivative (PID) control modules.</td>
</tr>
<tr>
<td>Dependency on data persistence between function calls</td>
<td>Does the external code require persistent data? For example, a call to a first order filter function uses the output of the previous call to the function to calculate a new output value. You have the option of defining the data as global or using shared memory outside the context of the function.</td>
</tr>
<tr>
<td>Data typing and interface</td>
<td>How complex is the data that the external code uses? What does the data interface look like? It consists of arguments, a return value, global variables, and access functions. What data types does the code use? Are the types limited to basic ANSI C integers, floating-point types, arrays of integers or floating-point types, and pointers to these types? Does the interface include structures or pointers to structures?</td>
</tr>
<tr>
<td>Fixed-point code</td>
<td>Is the external code designed to run on integer-only processors? If yes, the code exchanges and uses data represented as integers only. Data can be associated with fixed-point scaling or offsets.</td>
</tr>
<tr>
<td>External resource dependencies</td>
<td>Does the external code use data, functions, or macros defined outside the scope of the code? For example, the function can use a standard ANSI function, a shared library, or predefined constants. In these cases, you must inform the compiler and linker of the paths and file names of the external resources.</td>
</tr>
<tr>
<td>External solver required</td>
<td>Are you using the external function for advanced development or rapid prototyping to describe a system with a continuous transfer function or a set of differential equations? If yes, the external code relies on an external solver.</td>
</tr>
</tbody>
</table>

Next, see “Identify Integration Requirements” (Embedded Coder).

**Identify Integration Requirements**

Before choosing an external integration workflow, review these integration requirements. An understanding of these requirements and the characteristics of your external code helps you choose the optimal workflow for your integration scenario. (See “Evaluate Characteristics of External Code” (Embedded Coder).)
<table>
<thead>
<tr>
<th>Requirement</th>
<th>What to Consider</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effort</td>
<td>What level of effort is planned for the integration project—low, medium, or high?</td>
</tr>
<tr>
<td>Learning effort</td>
<td>What is the programming experience of assigned project resources? How much experience do assigned resources have with Simulink and MathWorks C/C++ code generation products?</td>
</tr>
<tr>
<td>Simulation and code generation behaviors</td>
<td>Do you want to take advantage of Model-Based Design? To take full advantage of Model-Based Design, convert code to modeling elements, which you can then use in the Simulink and Stateflow simulation environment. Then, simulate and generate code for the integrated component. Use software-in-the-loop (SIL) or processor-in-the-loop (PIL) testing to verify whether algorithm behavior is the same in both environments.</td>
</tr>
<tr>
<td>Data interface and typing</td>
<td>• Does your model or generated code need to exchange data with the external function? If so, map inputs, outputs, and parameters to the external function interface. Typical function interfaces involve function arguments and return values, global variables, and access functions, such as <code>getRPM</code>.</td>
</tr>
<tr>
<td></td>
<td>• Do you want to represent arrays, structures, or enumerated types? In the Simulink environment, you can represent these types as vectors, buses, and <code>IntEnum</code>, respectively.</td>
</tr>
<tr>
<td></td>
<td>• Is fixed-point support required? If you use the Simulink fixed-point interface, you can scale and specify offsets.</td>
</tr>
<tr>
<td></td>
<td>• Does the external code use company-specific data types? If yes and you have Embedded Coder software, create alias types to represent those external types. The code generator uses the alias types in the code that it produces. For example, once defined, you can specify an alias type in a function prototype, for a temporary variable, or for block output.</td>
</tr>
<tr>
<td></td>
<td>• Does the code exchange data with shared memory? If yes, define and use memory sections.</td>
</tr>
<tr>
<td>Direct function call</td>
<td>Do you want to call C external code directly from a model? You can choose from mechanisms, such as the Legacy Code Tool, Stateflow external code interface and chart action language, and the MATLAB Function block.</td>
</tr>
<tr>
<td>Requirement</td>
<td>What to Consider</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Insertion of external code into generated code</td>
<td>Do you want to control the placement of external code within generated code? Do you want to insert code into generated entry-point functions? You can place code within generated code by using model configuration parameters or custom code blocks.</td>
</tr>
<tr>
<td>Code generation optimization support</td>
<td>Do you want to optimize the code that the code generator produces? If so, you can configure the model for the code generator to optimize the code it produces based on application objectives, such as execution, ROM, and RAM efficiency. You also have the option of using code replacement libraries.</td>
</tr>
<tr>
<td>Files required</td>
<td>Do you want to minimize the number of files that you maintain? Some external code integration tools require that you maintain separate files for defining simulation and code generation.</td>
</tr>
</tbody>
</table>

Next, see “Choose a Workflow” (Embedded Coder).

**Choose a Workflow**

To choose a workflow for each integration point, use the following flow diagram. The gray boxes identify common workflows and provide links to more information. Click the gray box that best addresses the requirements of an integration point.
Choose an External Code Integration Workflow

1. Algorithm mapped to modeling components?
   - Yes: Specific to runtime environment?
     - Yes: Model-Based Design - simulation and code generation?
       - Yes: Call reusable external algorithm code, simulation, and code generation.
       - No: Place external C code in generate.
     - No: External to algorithm?
       - Yes: Call external design drivers.
       - No: Optimize generated math or utility code?
         - Yes: Apply function or operator code replacement.
         - No: Deploy as standalone executable program or integrate component with scheduler?
           - Yes: Standalone executable program.
           - No: Component with scheduler.
   - No: Import existing external code into Simulink environment?
     - Yes: Export generated code from Simulink environment?
       - Yes: Source code or shared library?
         - Yes: Generate code for export to external code base.
         - No: Shared library.
       - No: Use component as is.

26-11
See Also

More About

- “Call Reusable External Algorithm Code for Simulation and Code Generation” (Embedded Coder)
- “Place External C/C++ Code in Generated Code” (Embedded Coder)
- “Call External Device Drivers” (Embedded Coder)
- “Deploy Generated Standalone Executable Programs To Target Hardware” (Embedded Coder)
- “Deploy Generated Component Software to Application Target Platforms” (Embedded Coder)
- “Code Replacement” (Embedded Coder)
- “Generate Component Source Code for Export to External Code Base” (Embedded Coder)
- “Generate Shared Library for Export to External Code Base” (Embedded Coder)
Configure Target Hardware Characteristics

Simulink® allows you to configure the hardware implementation characteristics of your target system. Failure to do so can result in code that is incorrect or inefficient.

Open Example Model

Open the example model rtwdemo_targetsettings.

open_system('rtwdemo_targetsettings');

Open the Hardware Implementation pane of the Configuration Parameters dialog box by double-clicking the yellow button in the model.

Hardware Board Configuration

By default, the model is configured for the code generator to determine the hardware board configuration based on the specified system target file. The default system target file setting is grt.tlc.
If you have installed support for a hardware board, that board should appear in the **Hardware board** menu. If you select it, the dialog box displays parameters that are relevant to your hardware board.

**My Hardware Board is Not Listed**

If you are using a hardware board that is not listed, add it to the menu by installing the corresponding target support package. Start the Support Package Installer by setting **Hardware board** to **Get hardware Support Packages**, or by entering `supportPackageInstaller` in the MATLAB® Command Window.

After installing support for a hardware board, reopen the Configuration Parameters dialog box and select the hardware board.

**Cross-Development Systems that Include Source Level Debuggers**

If you use a cross-development system that includes a source level debugger:

1. Configure the model for your hardware board.

2. Generate code and build an executable using your target development system. For details about retrieving file and path information, see the documentation on the Simulink Coder® Build Information API.

3. Download the executable to the target hardware and set breakpoints at the model output code for each outport of the model.

4. Run a debugging session and observe the behavior of the code as it executes on the target hardware. As you step through the code, it computes the values for target hardware device characteristics.

If your target development system does not support source level debugging, generate code and add `printf` statements or other code that gets the results.

5. On the **Hardware Implementation** pane of the Configuration Parameters dialog box, set **Device vendor** to **Custom processor**, click the **Device details** arrow, and adjust the microprocessor device settings manually.
Check Code Generation Assumptions

The code generator implements assumptions that depend, for example, on the hardware implementation settings for your model. It is important to check that the assumptions are valid for your target hardware. Use the `buildStandaloneCoderAssumptions` function to create an application that performs assumption checks on your target hardware.

When you configure your model, try to specify hardware implementation and build configuration settings that match your target hardware. Then, to check code generator assumptions for your target hardware, use this workflow:

1. With `GenerateReport` set to `'on'`, build (`Ctrl+B`) your model.
2. To view the list of code generator assumptions that you can check, open the code generation report and click the **Coder Assumptions** link.

   For more information, see “Coder Assumptions List” on page 26-17.
3. Run `buildStandaloneCoderAssumptions`, which uses the generated code in the build folder to create an application that runs code generation assumption checks.
4. Download the application onto the target hardware or target environment, and then run the application.
5. While the application runs, use a debug tool to view check results that are in a data structure.

Check Code Generator Assumptions for Development Computer

If the target hardware is, for example, your Windows development computer, you can use Microsoft Visual Studio® to run and debug the application:

1. To open a model, in the Command Window, enter `rtwdemo_sil_topmodel`.
2. On the **Configuration Parameters > Hardware Implementation** pane, specify settings to match the target hardware. For example, for a 64-bit Windows computer specify these settings:
   - **Device vendor** -- Intel
   - **Device type** -- x86-64 (Windows 64)
3. On the **Configuration Parameters > Code Generation > Verification** pane, clear the **Enable portable word sizes** check box.
4. Build the model (**Ctrl+B**).

5. To view the list of code generator assumptions, select **Code > C/C++ Code > Code Generation Report > Open Model Report** and click the **Coder Assumptions** link.

6. From the Command Window, in the working folder, run:

   ```
   buildStandaloneCoderAssumptions('rtwdemo_sil_topmodel_ert_rtw')
   ```

   In the build folder, the function creates the `coderassumptions\standalone` subfolder, which contains the target application, `rtwdemo_sil_topmodel_ca`.

7. Open Microsoft Visual Studio and select **File > Open > Project/Solution**

8. Using the Open Project dialog box, navigate to the `coderassumptions\standalone` subfolder and select `rtwdemo_sil_topmodel_ca`. Then click **Open**.

9. Select **File > Open > File**. Using the Open File dialog box, select `coderassumptions\standalone\rtwdemo_sil_topmodel_ca.c`.

10. At the return statement, insert a break point.

11. Select **Debug > Start Debugging**.

12. To check that the code generator assumptions are correct, use a Watch window to inspect the Results data structure:

    a. In the `rtwdemo_sil_topmodel_ca.c` code, right-click **Results**.
    b. From the context menu, select **Add Watch**.

The variables in the data structure contain:

- Check outcomes (**TestResults**)
- Target hardware truths (**ActualValues**)
- Code generator assumptions (**ExpectedValues**)

For example, if the code generator assumption for **bitsPerChar** is correct, you see the **CA_PASS** value in the status variable.
## Coder Assumptions List

The contents section of the code generation report has a link to the Coder Assumptions page. The page provides a list of:

- Code generation assumptions that you can check
- Expected results for the assumption checks

This table describes the labels that you see in the list.

<table>
<thead>
<tr>
<th>Category</th>
<th>Label</th>
<th>Assumption You Can Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>C/C++ Language Configuration for Target Hardware or Development Computer</td>
<td>BitPerChar</td>
<td>Number of bits per char (ProdBitPerChar)</td>
</tr>
<tr>
<td></td>
<td>BitPerShort</td>
<td>Number of bits per short (ProdBitPerShort)</td>
</tr>
<tr>
<td></td>
<td>BitPerInt</td>
<td>Number of bits per int (ProdBitPerInt)</td>
</tr>
<tr>
<td></td>
<td>BitPerLong</td>
<td>Number of bits per long (ProdBitPerLong)</td>
</tr>
<tr>
<td></td>
<td>BitPerFloat</td>
<td>Size of float (Only if PurelyIntegerCode is 'off')</td>
</tr>
<tr>
<td></td>
<td>BitPerDouble</td>
<td>Size of double (Only if PurelyIntegerCode is ‘off’)</td>
</tr>
<tr>
<td></td>
<td>BitPerPointer</td>
<td>Number of bits per pointer (ProdBitPerPointer)</td>
</tr>
<tr>
<td></td>
<td>BitPerSizeT</td>
<td>Number of bits per size_t (ProdBitPerSizeT)</td>
</tr>
<tr>
<td></td>
<td>BitPerPtrDiffT</td>
<td>Number of bits per pptrdiff_t (ProdBitPerPtrDiffT)</td>
</tr>
<tr>
<td></td>
<td>Endianess</td>
<td>Byte ordering (ProdEndianess)</td>
</tr>
<tr>
<td></td>
<td>Shift right for signed integer is arithmetic shift</td>
<td>Sign bit behavior (ProdShiftRightIntArith)</td>
</tr>
<tr>
<td></td>
<td>Signed integer division rounds to</td>
<td>Rounding behavior for integer division (ProdIntDivRoundTo)</td>
</tr>
<tr>
<td>Category</td>
<td>Label</td>
<td>Assumption You Can Check</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>C/C++ Language Standard</td>
<td>Initial value of a global integer variable is zero</td>
<td>Zero initialization of memory (ZeroExternalMemoryAtStartup and ZeroInternalMemoryAtStartup)</td>
</tr>
<tr>
<td>Floating-Point Numbers</td>
<td>Flush-to-zero computed subnormal values (FTZ)</td>
<td>Flush-to-zero subnormal number processing</td>
</tr>
<tr>
<td></td>
<td>Flush-to-zero incoming subnormal values (DAZ)</td>
<td>Denormals-are-zero subnormal number processing</td>
</tr>
</tbody>
</table>

**See Also**

buildStandaloneCoderAssumptions

**More About**

- “Verification of Code Generation Assumptions” (Embedded Coder)
Call Reusable External Algorithm Code for Simulation and Code Generation

Code reuse offers business and technological advantages. From a business perspective, code reuse saves time and resources. From a technological perspective, code reuse promotes consistency and reduces memory requirements. Other considerations include:

- Modularizing an application
- Reusing an optimized algorithm
- Interfacing with a predefined dataset
- Developing application variants

Examples of reusable hardware-independent algorithmic code to consider importing into the Simulink environment for simulation and code generation include:

- Utility functions
- Lookup tables
- Digital filters
- Specialized integrators
- Proportional-integral-derivative (PID) control modules

Workflow

To call reusable external algorithm code for simulation and code generation, iterate through the tasks listed in this table.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Review your assessment of external code characteristics and integration requirements.</td>
<td>“Choose an External Code Integration Workflow” (Embedded Coder)</td>
</tr>
<tr>
<td>2</td>
<td>Based on the programming language of the external code, choose an integration approach to add the external code to a Simulink model.</td>
<td>“Choose an Integration Approach” (Embedded Coder)</td>
</tr>
<tr>
<td>Task</td>
<td>Action</td>
<td>More Information</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>------------------</td>
</tr>
<tr>
<td>3</td>
<td>Verify algorithm behavior and performance by simulating the model.</td>
<td>“Simulation” (Simulink)</td>
</tr>
<tr>
<td>4</td>
<td>Define the representation of model data for code generation.</td>
<td>“Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” (Embedded Coder)</td>
</tr>
<tr>
<td>5</td>
<td>Configure the model for code generation.</td>
<td>“Generate Code That Matches Appearance of External Code” (Embedded Coder) and “Model Configuration” (Embedded Coder)</td>
</tr>
<tr>
<td>6</td>
<td>Generate code and a code generation report.</td>
<td>“Code Generation” (Embedded Coder)</td>
</tr>
<tr>
<td>7</td>
<td>Review the generated code interface and static code metrics.</td>
<td>“Analyze the Generated Code Interface” (Embedded Coder) and “Static Code Metrics” (Embedded Coder)</td>
</tr>
<tr>
<td>8</td>
<td>Build an executable program from the model.</td>
<td>“Build Integrated Code Within the Simulink Environment” (Embedded Coder)</td>
</tr>
<tr>
<td>9</td>
<td>Verify that executable program behaves as expected.</td>
<td>“Numerical Equivalence Testing” (Embedded Coder)</td>
</tr>
<tr>
<td>10</td>
<td>Verify that executable program performs as expected.</td>
<td>“Code Execution Profiling” (Embedded Coder)</td>
</tr>
</tbody>
</table>

**Choose an Integration Approach**

Several approaches are available for integrating reusable algorithmic code into the Simulink environment for code generation. Some approaches integrate external code directly. Other approaches convert the external code to Simulink or Stateflow modeling elements for simulation, and later for code generation from the modeled design. The integration approach that you choose depends on:

- Programming language of the external code — MATLAB, C, C++, or Fortran
- Your programming language experience and preference
- Performance requirements
- Whether the algorithm must model continuous time dynamics or you are integrating the algorithm into an application that uses discrete and continuous time
• Whether you want to take advantage of Model-Based Design
• Level of control required over the code that the code generator produces

To choose an approach for a reusable algorithm, see the subsection that matches the programming language of your external algorithm code.

• “Integration Approaches for External MATLAB Code” (Embedded Coder)
• “Integration Approaches for External C or C++ Code” (Embedded Coder)
• “Integration Approaches for External Fortran Code” (Embedded Coder)

Integration Approaches for External MATLAB Code

Multiple approaches are available for integrating external MATLAB code into the Simulink environment. The following diagram and table help you choose the best integration approach for your application based on integration requirements.
<table>
<thead>
<tr>
<th>Condition or Requirement</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The algorithm must model continuous state dynamics.</td>
<td>Write a MATLAB S-function and, for generating code, a corresponding TLC file for the algorithm. Add the S-function to your model.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Create and Configure MATLAB S-Functions” (Simulink)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “S-Functions”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Target Language Compiler”</td>
</tr>
<tr>
<td>Condition or Requirement</td>
<td>Action</td>
<td>More Information</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------</td>
<td>------------------</td>
</tr>
</tbody>
</table>
| 2 External code complies with the MATLAB code for code generation subset and you want to call MATLAB code from a Simulink model. | Add a MATLAB Function block to the model. Embed the MATLAB code in that block. | • “Integrate C Code Using the MATLAB Function Block” (Simulink)  
• MATLAB Function |
| 3 External code complies with the MATLAB code for code generation subset, you want to call MATLAB code from a Simulink model, and your algorithm includes iterative computations that process large streams of data. | Add a MATLAB System block to the model. Embed the MATLAB code in that block as a System object™. | • “Integrate C Code Using the MATLAB Function Block” (Simulink)  
• MATLAB System |
| 4 External code complies with the MATLAB code for code generation subset, you want to call MATLAB code from a Simulink model, and your algorithm includes design logic that is based on state machines and flow charts. | Add a Stateflow chart to the model. Call the external code from the chart, using MATLAB as the action language. | • “Chart Programming Basics” (Stateflow)  
• “Insert External Code into Stateflow Charts” (Embedded Coder) |
| 5 You want to use the `parfor` function for parallel computing or interface data types that are available to MATLAB Coder but are not available to Simulink Coder or Embedded Coder. | Use MATLAB Coder software to generate C code. Then, call that generated code as external C code. | • “C Code Generation Using the MATLAB Coder App” (MATLAB Coder)  
• “Getting Started with MATLAB Coder” (MATLAB Coder) |
### Condition or Requirement

<table>
<thead>
<tr>
<th>Condition or Requirement</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>6 You have C or C++ programming experience and the external MATLAB code is compact and primarily uses C or C++ constructs.</td>
<td>Manually convert the MATLAB code to C or C++ code. Choose an integration approach for C or C++ code.</td>
<td>“Integration Approaches for External C or C++ Code” (Embedded Coder)</td>
</tr>
<tr>
<td>7 Sections of the external MATLAB code map to built-in blocks.</td>
<td>Develop the algorithm in the context of a model, using the applicable built-in blocks.</td>
<td>• “Model Editing Fundamentals” (Simulink) and “Component-Based Modeling” (Simulink)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Blocks and Products Supported for C Code Generation” on page 2-4</td>
</tr>
</tbody>
</table>

To embed external MATLAB code in a MATLAB Function block or generate C or C++ code from MATLAB code with the MATLAB Coder software, the MATLAB code must use functions and classes supported for C/C++ code generation.

- “Functions and Objects Supported for C/C++ Code Generation — Alphabetical List” (MATLAB Coder)
- “Functions and Objects Supported for C/C++ Code Generation — Category List” (MATLAB Coder)

### Integration Approaches for External C or C++ Code

Under most circumstances, you can integrate external code written in C or C++ into the Simulink environment by generating S-functions and TLC files with the Legacy Code Tool. This tool uses specifications that you supply as MATLAB code to transform existing MATLAB functions into C MEX S-functions that you can include in Simulink models and call from generated code. For details, see “Integrate Legacy Code” (Simulink) and “Import Calls to External Code into Generated Code with Legacy Code Tool” (Embedded Coder).

In comparison to alternative approaches, Legacy Code Tool is the most optimal choice for generating code optimized enough for embedded systems. Consider alternative approaches if one or more of the following conditions exist:

- The external code uses global variables to exchange data.
• Programming experience is limited.
• The algorithm must model discrete and continuous state dynamics.
• You want to include the integrated external code in a Stateflow chart.
• The external code requires a fixed-point interface.
• You want maximum flexibility for controlling what code the code generator produces.
• You quickly want to embed a call to the external code in a call to the `coder.ceval` function that is embedded in the MATLAB Function block, and performance is not an issue.

This diagram and table help you choose the best integration approach based on your integration requirements.
<table>
<thead>
<tr>
<th>Condition or Requirement</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 You want to integrate external C code with generated C++ code or conversely</td>
<td>Match the language choice for the generated code by modifying the language of the external code.</td>
<td>“Modify Programming Language of External Code to Match Generated Code” (Embedded Coder)</td>
</tr>
<tr>
<td>2 Your algorithm includes design logic that is based on state machines and flow charts. Or, a function that you want to integrate must exchange data with a model by using global variables. The function defines the global variables and uses them to write output rather than returning a value (return) or writing output to an argument.</td>
<td>Add a Stateflow chart to the model. Call the external code from the chart, using C as the action language. In the chart, write code that calls the external function and reads from and writes to the global variables. To perform calculations with output of the external code, the model must read from the global variable during execution.</td>
<td>“Insert External Code into Stateflow Charts” (Embedded Coder)</td>
</tr>
</tbody>
</table>
| 3 You want to include external C or C++ code in a Stateflow chart for simulation and code generation. | Configure the model that contains the chart to apply the external C or C++ code. | • “Custom Code Algorithm” (Stateflow)  
• “Call C Functions in C Charts” (Stateflow)  
• “Insert External Code into Stateflow Charts” (Embedded Coder) |
| 4 You quickly want to embed a call to external C or C++ code in a model. Performance is not an issue. | Call the C or C++ code with the `coder.ceval` function from within a MATLAB Function block. | • `coder.ceval` function  
• “Integrate C Code Using the MATLAB Function Block” (Simulink)  
• MATLAB Function block |
<table>
<thead>
<tr>
<th>Condition or Requirement</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
</table>
| 5                        | The application requires more entry-point functions than the code generator typically produces—for example, more than `model_step`, `model_initialize`, and `model_terminate`. You want maximum flexibility for controlling what code the code generator produces. | Manually write an S-function and TLC file. | • “C/C++ S-Function Basics” (Simulink)  
• “S-Functions and Code Generation” (Embedded Coder)  
• “C S-Function Examples” (Simulink) and “C++ S-Function Examples” (Simulink) |
| 6                        | You want to simulate and generate external code for a discrete time application. Optimizing generated code is essential. You want ease of use with moderate flexibility for controlling what code the code generator produces. You have C or C++ programming experience, but you prefer to generate the files for adding the code to a model. | Generate S-function and TLC files by using the Legacy Code Tool. If necessary, refine the generated code manually to meet application requirements. (If you change the generated code, you lose the changes if you regenerate the S-function and TLC files.) For simple algorithms written in C, consider using the Simulink C Caller block. | • “Integrate C Functions Using Legacy Code Tool” (Simulink)  
• “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7  
• “Integrate C Code Using C Caller Blocks” (Simulink) |
<table>
<thead>
<tr>
<th>Condition or Requirement</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
</table>
| The algorithm must model discrete and continuous state dynamics for simulation and rapid prototyping. The external code requires a fixed-point interface. Programming experience is limited. You want ease of use with basic flexibility for controlling what code the code generator produces for rapid prototyping. | Generate S-function and TLC files by using the S-Function Builder. If necessary, refine the generated code manually to meet application requirements. (If you change the generated code, you lose the changes if you regenerate the S-function and TLC files.) | “Build S-Functions Automatically” (Simulink)  
“Generate S-Function from Subsystem” (Embedded Coder) |

### Modify Programming Language of External Code to Match Generated Code

To integrate external C code with generated C++ code or conversely, modify the language of the external code to match the programming language choice for the generated code. Options for making the programming language match include:

- Writing or rewriting the external code in the language choice for the generated code.
- If you are generating C++ code and the external code is C code, for each C function, create a header file that prototypes the function. Use this format:

```c
#ifdef __cplusplus
extern "C" {
#endif
int my_c_function_wrapper();
#ifdef __cplusplus
}
#endif
```

The prototype serves as a function wrapper. If your compiler supports C++ code, the value `__cplusplus` is defined. The linkage specification `extern "C"` specifies C linkage without name mangling.

- If you are generating C code and the external code is C++ code, include an `extern "C"` linkage specification in each `.cpp` file. For example, the following example shows C++ code in the file `my_func.cpp`:
Integration Approaches for External Fortran Code

To integrate external Fortran code, write an S-function and corresponding TLC file.

See “C/C++ S-Function Basics” (Simulink), “Integrate Fortran Code” (Simulink), “S-Functions and Code Generation” (Embedded Coder), and “Fortran S-Function Examples” (Simulink).

Insert External Code into Stateflow Charts

• “Integrate External Code for Library Charts” on page 26-30
• “Integrate External Code for All Charts” on page 26-31
• “Call External C Code from Model and Generated Code” on page 26-32

Integrate External Code for Library Charts

To integrate external code that applies only to Stateflow library charts for code generation, for each library model that contributes a chart to your main model, complete these steps. Then, generate code.

1 In the Stateflow Editor, select Code > C/C++ Code > Code Generation Options.
2 In the Model Configuration Parameters dialog box, select **Code Generation > Use local custom code settings (do not inherit from main model)**.

The library model retains its own custom code settings during code generation.

3 Specify your custom code in the subpanes.

Follow the guidelines in “Specify Relative Paths for Custom Code” (Stateflow).

If you specified custom code settings for simulation, you can apply these settings to code generation. To avoid entering the same information twice, select **Use the same custom code settings as Simulation Target**.

4 Click OK.

After completing these steps for each library model, generate code.

**Integrate External Code for All Charts**

To integrate external code that applies to all charts for code generation:

1 Specify custom code options for code generation of your main model.

   a In the Model Configuration Parameters dialog box, select **Code Generation > Custom Code**.

   b In the custom code text fields, specify your custom code.

      Follow the guidelines in “Specify Relative Paths for Custom Code” (Stateflow).

      If you specified custom code settings for simulation, you can apply these settings to code generation. To avoid entering the same information twice, select **Use the same custom code settings as Simulation Target**.

2 Configure code generation for each library model that contributes a chart to your main model.

   a In the Stateflow Editor, select **Code > C/C++ Code > Code Generation Options**.

   b In the **Code Generation** pane, clear the **Use local custom code settings (do not inherit from main model)** check box.

      The library charts inherit the custom code settings of your main model.

   c Click OK.
3  Generate code.

**Call External C Code from Model and Generated Code**

Call existing, external functions from a simulation or from the generated code by using the Legacy Code Tool.

Learn how to:

- Evaluate a C function as part of a Simulink® model simulation.
- Call a C function from the code that you generate from a model.

For information about the example model and other examples in this series, see “Generate C Code from a Control Algorithm for an Embedded System” (Embedded Coder).

**Replacement Process**

Open the example model, `rtwdemo_PCG_Eval_P4`.

For many Model-Based Design applications, in addition to Simulink® models, a design includes a set of existing C functions that have been tested and validated. You can integrate these functions into a Simulink® model and generate code that uses the functions.

In this example, you create a custom Simulink® block that calls an existing C function. You then include the block in a model and test the overall system through model simulation in Simulink®.

In the example model, you can replace the Lookup blocks (lookup tables) in the PI controllers with calls to an existing C function. The function is defined in the files `SimpleTable.c` and `SimpleTable.h`.

View `SimpleTable.c`.

View `SimpleTable.h`.  

Create Block That Calls C Function

To specify a call to an existing C function, use an S-Function block. You can automate the creation of the S-Function block by using the Legacy Code Tool. In the tool, you first specify an interface for your existing C function. The tool then uses that interface to create an S-Function block.

Use the Legacy Code Tool to create an S-Function block for the existing C function in SimpleTable.c.

1. Create a structure to contain the definition of the function interface.

```matlab
def = legacy_code('initialize')
```

You can use the structure `def` to define the function interface to the existing C code.

2. Populate the fields of the structure.

```matlab
% Defines the function interface, inputs, return values and parameters
def.OutputFcnSpec  = ['double y1 = SimpleTable(double u1,','...
'  'double p1[], double p2[], int16 p3)';

% the C and H files where the external code is defined
def.HeaderFiles    = {'SimpleTable.h'};
def.SourceFiles     = {'SimpleTable.c'};
% The name of the created S-Function
def.SFunctionName  = 'SimpTableWrap';
```

3. Create the S-function.

```matlab
legacy_code('sfcn_cmex_generate',def)
```
4. Compile the S-function.

legacy_code('compile',def)

5. Create the S-Function block.

legacy_code('slblock_generate',def)

The generated S-Function block calls the C function in SimpleTable.c. You can now use and reuse this S-Function block in models.

6. Create the TLC file.

legacy_code('sfcn_tlc_generate',def)

This command creates a TLC file, which is the component of an S-Function that specifies how to generate code for the block.

**Validate External Code Through Simulation**

When you integrate existing C code in a Simulink® model, first validate the generated S-Function block.

To validate the replacement of the Lookup blocks, compare the simulation results produced by the Lookup blocks with the results produced by the new S-Function block.

1. Open the validation model.

   • The Sine Wave block produces output values from [-2 : 2].
   • The input range of the lookup table is from [-1 : 1].
   • The lookup table outputs the absolute value of the input.
   • The lookup table clips the output at the input limits.

2. Run the validation model.

The figure shows the validation results. The existing C code and the Simulink® table block produce the same output values.
Validate C Code as Part of Simulink® Model

After validating the existing C function code as a standalone component, you can validate the S-function in the model. To complete the validation, use the test harness model.
1. Open the test harness.

2. Run the test harness.

The simulation results match the golden values.

**Call C Function from the Generated Code**

The code generator uses the TLC file to process the S-Function block like any other block. The code generator can implement *expression folding* with the S-Function block, an operation that combines multiple computations into a single output calculation.
1. Build the full model.

2. Examine the generated code in PI_Control_Reusable.c.

The generated code now calls the SimpleTable C function.

The figures show the generated code before and after the C code integration. Before the integration, the code calls a generated lookup routine. After the integration, the generated code calls the C function SimpleTable.

Discrete_Time_Integrator1 = rtp_Masked_I_Gain * look1_binlX(rtb_Sum2, (&(I_InErrMap[0])), (&(I_OutMap[0])), 8U) * rtb_Sum2 * 0.001 + localDW->Discrete_Time_Integrator1_DSTAT;

/* Discrete Integrator: '<S3>/Discrete_Time_Integrator1' incorporates:
  * Gain: '<S3>/Int_GAIN1'
  * Product: '<S3>/Product3'
  * S-Function (SimpTableWrap): '<S3>/SimpTableWrap1'
  */
Discrete_Time_Integrator1 = I_Gain * SimpleTable rtb_Sum2, (real_T*)((I_InErrMap[0]), (real_T*)(&(I_OutMap[0])), 7) * rtb_Sum2 * 0.001 + localDW->Discrete_Time_Integrator1_DSTAT;

For the next example in this series, see “Build Integrated Code Outside the Simulink Environment” (Embedded Coder).

See Also

More About

- “Integrate C Functions Using Legacy Code Tool” (Simulink)
- “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7
- “Custom Code Algorithm” (Stateflow)
• “Integrate C Code Using the MATLAB Function Block” (Simulink)
• “C/C++ S-Function Basics” (Simulink)
• “S-Functions and Code Generation” (Embedded Coder)
Place External C/C++ Code in Generated Code

You can customize code that the code generator produces for a model by specifying external code with custom code blocks or model configuration parameters.

- Place code at the start and end of the generated code for the root model.
- Place declaration, body, and exit code in generated function code for blocks in the root model or nonvirtual subsystems.

The functions that you can augment with external code depends on the functions that the code generator produces for blocks that are in the model. For example, if a model or atomic subsystem includes blocks that have states, you can specify code for a disable function. Likewise, if you need the code for a block to save data, free memory, or reset target hardware, specify code for a terminate function. For more information, see “Block Target File Methods”.

Workflow

To place external C or C++ code at specific locations in code that the code generator produces for root models and subsystems, iterate through the tasks listed in this table.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>If you want to integrate external C code with generated C++ code or conversely, modify the language of the external code to match the language choice for the generated code.</td>
<td>“Modify Programming Language of External Code to Match Generated Code” on page 26-29</td>
</tr>
</tbody>
</table>
Choose an Integration Approach

Within the Simulink modeling environment, two approaches are available for placing external C or C++ code into sections of code that the code generator produces:

- Add blocks from the Custom Code library to a root model or atomic subsystem.
- Set model configuration parameters on the Code Generation > Custom Code pane.

The following table compares the two approaches. Choose the approach that aligns best with your integration requirements. For more information about how to apply each
approach, see “Integrate External Code by Using Custom Code Blocks” (Embedded Coder) and “Integrate External Code by Using Model Configuration Parameters” (Embedded Coder).

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Blocks</th>
<th>Model Configuration Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include a representation of your external code in the modeling canvas</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Place code in functions generated for root models</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Place code in functions generated for atomic subsystems</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Save code placement in a model configuration set</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Place code at the top and bottom of the header and source files generated for a model</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Place code within declaration, execution, and exit sections of the SystemInitialize and SystemTerminate functions that the code generator creates</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Place code within declaration, execution, and exit sections of the SystemStart, SystemEnable, SystemDisable, SystemOutputs, SystemUpdate, or SystemDerivatives functions that the code generator creates</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Add preprocessor macro definitions to generated code</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Use the custom code settings that are specified for the simulation target</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Configure a library model to use custom code settings of the parent model to which the library is linked</td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>
Integrate External Code by Using Custom Code Blocks

- “Custom Code Block Library” on page 26-42
- “Add Custom Code Blocks to the Modeling Canvas” on page 26-43
- “Add External Code to Generated Start Function” on page 26-43

Custom Code Block Library

The Custom Code block library contains blocks that you can use to place external C or C++ code into specific locations and functions within code that the code generator produces. The library consists of 10 blocks that add your code to the model header (`model.h`) and source (`model.c` or `model.cpp`) files that the code generator produces.

The Model Header and Model Source blocks add external code at the top and bottom of header and source files that the code generator produces for a root model. These blocks display two text fields into which you can type or paste code. One field specifies code that you want to place at the top of the generated header or source file. The second field specifies code that you want to place at the bottom of the file.

The remaining blocks add external code to functions that the code generator produces for the root model or atomic subsystem that contains the block. The blocks display text fields into which you can type or paste code that customizes functions that the code generator produces. The text fields correspond to the declaration, execution, and exit sections of code for a given function.

<table>
<thead>
<tr>
<th>To Customize Code That</th>
<th>Use This Block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computes continuous states</td>
<td>System Derivatives</td>
</tr>
<tr>
<td>Disables state</td>
<td>System Disable</td>
</tr>
<tr>
<td>Enables state</td>
<td>System Enable</td>
</tr>
<tr>
<td>Resets state</td>
<td>System Initialize</td>
</tr>
<tr>
<td>Produces output</td>
<td>System Outputs</td>
</tr>
<tr>
<td>Executes once</td>
<td>System Start</td>
</tr>
<tr>
<td>Saves data, free memory, reset target hardware</td>
<td>System Terminate</td>
</tr>
<tr>
<td>Requires updates at each major time step</td>
<td>System Update</td>
</tr>
</tbody>
</table>

The block and its location within a model determines where the code generator places the external code. For example, if the System Outputs block is at the root model level, the
code generator places the code in the model *Outputs* function. If the block resides in a triggered or enabled subsystem, the code generator places the code in the subsystem *Outputs* function.

If the code generator does not need to generate a function that corresponds to a Custom Code block that you include in a model, the code generator does one of the following:

• Omits the external code that you specify in the Custom Code block.
• Returns an error, indicating that the model does not include a relevant block. In this case, remove the Custom Code block from the model.

For more information, see “Block Target File Methods”.

**Add Custom Code Blocks to the Modeling Canvas**

To add the Custom Code library blocks to a model:

1. In the Simulink Library Browser, open the Custom Code block library. You can gain access to the library by:
   
   • Navigating to Simulink Coder > Custom Code in the browser.
   • Entering the MATLAB command `custcode`.

2. Drag the blocks that you want into your model or subsystem. Drag Model Header and Model Source blocks into root models only. Drag function-based Custom Code blocks into root models or atomic subsystems.

You can use models that contain Custom Code blocks as referenced models. The code generator ignores the blocks when producing code for a simulation target. When producing code for a code generation target, the code generator includes and compiles the custom code.

**Add External Code to Generated Start Function**

This example shows how to use the System Start block to place external C code in the code that the code generator produces for a model that includes a discrete filter.

1. Create the following model.
2 Configure the model for code generation.
3 Double-click the System Start block.
4 In the block parameters dialog box, in the **System Start Function Declaration Code** field, enter this code:

   ```c
   unsigned int *ptr = 0xFFEE;
   ```

5 In the **System Start Function Execution Code** field, enter this code:

   ```c
   /* Initialize hardware */
   *ptr = 0;
   ```

6 Click **OK**.
7 Generate code and a code generation report.
8 View the generated `model.c` file. Search for the string `start function`. You should find the following code, which includes the external code that you entered in steps 4 and 5.

   ```c
   {
   {
      /* user code (Start function Header) */
      /* System '<Root>' */
      unsigned int *ptr = 0xFFEE;
      /* user code (Start function Body) */
      /* System '<Root>' */
      /* Initialize hardware */
      *ptr = 0;
   }
   }
   ```

For another example, see “Integrate External C Code Into Generated Code By Using Custom Code Blocks and Model Configuration Parameters” (Embedded Coder).
### Integrate External Code by Using Model Configuration Parameters

Model configuration parameters provide a way to place external C or C++ code into specific locations and functions within code that the code generator produces.

<table>
<thead>
<tr>
<th><strong>To</strong></th>
<th><strong>Select</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert external code near the top of the generated <code>model.c</code> or <code>model.cpp</code> file</td>
<td><strong>Source file</strong>, and enter the external code to insert. <strong>Note</strong> If you generate subsystem code into separate files, that code does not have access to external code that you specify with the <strong>Source file</strong> parameter. For example, if you specify an include file as a <strong>Source file</strong> setting, the code generator inserts the <code>#include</code> near the top of the <code>model.c</code> or <code>model.cpp</code> file. The subsystem code that the code generator places in a separate file does not have access to declarations inside your included file. In this case, consider specifying your external code with the <strong>Header file</strong> parameter.</td>
</tr>
<tr>
<td>Insert external code near the top of the generated <code>model.h</code> file</td>
<td><strong>Header file</strong>, and enter the external code to insert.</td>
</tr>
<tr>
<td>Insert external code inside the model initialize function in the <code>model.c</code> or <code>model.cpp</code> file</td>
<td><strong>Initialize function</strong>, and enter the external code to insert.</td>
</tr>
<tr>
<td>Insert external code inside the model terminate function in the <code>model.c</code> or <code>model.cpp</code> file</td>
<td><strong>Terminate function</strong>, and enter the external code to insert. Also select the <strong>Terminate function required</strong> parameter on the <strong>Interface</strong> pane.</td>
</tr>
<tr>
<td>Add preprocessor macro definitions</td>
<td><strong>Defines</strong>, and enter a space-separated list of preprocessor macro definitions to add to the generated code. The list can include simple definitions (for example, <code>-DEF1</code>) and definitions with a value (for example, <code>-DDEF2=1</code>). Definitions can omit the <code>-D</code> (for example, <code>-DF00=1</code> and <code>FOO=1</code> are equivalent). If a definition includes <code>-D</code>, the toolchain can override the flag if the toolchain uses a different flag for defines.</td>
</tr>
<tr>
<td><strong>To</strong></td>
<td><strong>Select</strong></td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>Use the same custom code parameter settings as the settings specified for simulation of MATLAB Function blocks, Stateflow charts, and Truth Table blocks</td>
<td><strong>Use the same custom code settings as Simulation Target</strong>&lt;br&gt;This parameter refers to the <strong>Simulation Target</strong> pane in the Configuration Parameters dialog box.</td>
</tr>
<tr>
<td>Enable a library model to use custom code settings unique from the parent model to which the library is linked</td>
<td><strong>Use local custom code settings (do not inherit from main model)</strong>&lt;br&gt;This parameter is available only for library models that contain MATLAB Function blocks, Stateflow charts, or Truth Table blocks.</td>
</tr>
</tbody>
</table>

To include a header file in an external header file, add `#ifndef` code. Using this code avoids multiple inclusions. For example, in `rtwtypes.h`, the following `#include` guards are added:

```c
#ifndef RTW_HEADER_rtwtypes_h_
#define RTW_HEADER_rtwtypes_h_
...
#endif /* RTW_HEADER_rtwtypes_h_ */
```

For more information on how to add files names and locations of header, source, and shared library files to the build process, see “Build Integrated Code Within the Simulink Environment” (Embedded Coder).

**Note** The code generator includes external code that you include in a configuration set when generating code for software-in-the-loop (SIL) and processor-in-the-loop (PIL) simulations. However, the code generator ignores external code that you include in a configuration set when producing code with the S-function, rapid simulation, or simulation system target file.

For more information about **Custom Code** parameters, see “Model Configuration Parameters: Code Generation Custom Code”. For an example, see “Integrate External C Code Into Generated Code By Using Custom Code Blocks and Model Configuration Parameters” (Embedded Coder).
Integrate External C Code Into Generated Code By Using Custom Code Blocks and Model Configuration Parameters

This example shows how to place external code in generated code by using custom code blocks and model configuration parameters.

1. Open the model `rtwdemo_slcustcode`.

```matlab
open_system('rtwdemo_slcustcode')
```
2. Open the Model Configuration Parameters dialog box and navigate to the **Custom Code** pane.

3. Examine the settings for parameters **Source file** and **Initialize function**.
• **Source file** specifies a comment and sets the variable `GLOBAL_INT2` to -1.
• **Initialize function** initializes the variable `GLOBAL_INT2` to 1.

4. Close the dialog box.

5. Double-click the Model Source block. The **Top of Model Source** field specifies that the code generator declare the variable `GLOBAL_INT1` and set it to 0 at the top of the generated file `rtwdemo_slcustcode.c`.

6. Open the triggered subsystem **Amplifier**. The subsystem includes the System Outputs block. The code generator places code that you specify in that block in the generated code for the nearest parent atomic subsystem. In this case, the code generator places the external code in the generated code for the **Amplifier** subsystem. The external code:

   • Declares the pointer variable `*intPtr` and initializes it with the value of variable `GLOBAL_INT1`.
   • Sets the pointer variable to -1 during execution.
   • Resets the pointer variable to 0 before exiting.

7. Generate code and a code generation report.

8. Examine the code in the generated source file `rtwdemo_slcustcode.c`. At the top of the file, after the `#include` statements, you find the following declaration code. The example specifies the first declaration with the **Source file** configuration parameter and the second declaration with the Model Source block.

   ```c
   int_T GLOBAL_INT2 = -1;
   int_T GLOBAL_INT1 = 0;
   ```

   The Output function for the **Amplifier** subsystem includes the following code, which shows the external code integrated with generated code that applies the gain. The example specifies the three lines of code for the pointer variable with the System Outputs block in the **Amplifier** subsystem.

   ```c
   int_T *intPtr = &GLOBAL_INT1;
   *intPtr = -1;
   rtwdemo_slcustcode_Y.Output = rtwdemo_slcustcode_U.Input << 1;
   ```
*intptr = 0;

The following assignment appears in the model initialize entry-point function. The example specifies this assignment with the Initialize function configuration parameter.

GLOBAL_INT2 = 1;

See Also

More About
  • “Configure a Model for Code Generation” (Embedded Coder)
Call External Device Drivers

Device drivers for protocols and target hardware are essential to many real-time development projects. For example, you can have a working device driver that you want to integrate with algorithmic code that has to read data from and write data to the I/O device that the driver supports. The code generator can produce a single set of application source files from an algorithm model and integrated driver code written in C or C++.

To call external device driver code from the Simulink environment, iterate through the tasks in this table.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Review your assessment of external code characteristics and integration requirements.</td>
<td>“Choose an External Code Integration Workflow” (Embedded Coder)</td>
</tr>
<tr>
<td>2</td>
<td>Define the representation of model data for code generation.</td>
<td>“Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” (Embedded Coder)</td>
</tr>
</tbody>
</table>
| 3    | Generate S-function and TLC files by using the Legacy Code Tool. If necessary, refine the generated code manually to meet application requirements. | • “Integrate C Functions Using Legacy Code Tool” (Simulink)  
• “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7 |
<p>| 4    | Verify algorithm behavior and performance by simulating the model. | “Simulation” (Simulink) |
| 5    | Configure the model for code generation. | “Generate Code That Matches Appearance of External Code” (Embedded Coder) and “Model Configuration” (Embedded Coder) |
| 6    | Generate code and a code generation report. | “Code Generation” (Embedded Coder) |
| 7    | Review the generated code interface and static code metrics. | “Analyze the Generated Code Interface” (Embedded Coder) and “Static Code Metrics” (Embedded Coder) |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Build an executable program from the model.</td>
<td>“Build Integrated Code Within the Simulink Environment” (Embedded Coder)</td>
</tr>
<tr>
<td>9</td>
<td>Verify that executable program behaves and performs as expected.</td>
<td>“Numerical Equivalence Testing” (Embedded Coder)</td>
</tr>
<tr>
<td>10</td>
<td>Verify that executable program performs as expected.</td>
<td>“Code Execution Profiling” (Embedded Coder)</td>
</tr>
</tbody>
</table>

**See Also**

**More About**
- “Integrate C Functions Using Legacy Code Tool” (Simulink)
- “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7
- “About Embedded Target Development” on page 39-2
Apply Function and Operator Code Replacements

If your generated code must use functions and operators that are consistent with external code, configure the code generator to use a code replacement library (CRL). By default, the code generator does not apply a code replacement library. You can choose from several libraries that MathWorks provides, including GNU C99 extensions, AUTOSAR 4.0, and several Intel platform-specific IPP and IPP/SSE libraries. Depending on the products that you have, other libraries might be available. If you have Embedded Coder software, you can view and choose from additional libraries and you can create custom code replacement libraries.

See Also

More About

• “What Is Code Replacement?” (Embedded Coder)
• “What Is Code Replacement Customization?” (Embedded Coder)
• Code Replacement Viewer
• Code Replacement Tool
# Build Integrated Code Within the Simulink Environment

## Workflow

To build executable programs that integrate generated code and external C or C++ code, iterate through the tasks in this table.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose whether to use the toolchain approach or template makefile approach build process.</td>
<td>“Choose Build Approach and Configure Build Process” (Embedded Coder) For an example, see “Build Process Workflow for Real-Time Systems” (Embedded Coder).</td>
</tr>
<tr>
<td>2</td>
<td>Configure build process support for your external code.</td>
<td>“Configure Parameters for Integrated Code Build Process” (Embedded Coder)</td>
</tr>
<tr>
<td>3</td>
<td>Configure S-Function build support for your external code.</td>
<td>“Build Support for S-Functions” (Embedded Coder) “Use makecfg to Customize Generated Makefiles for S-Functions” (Embedded Coder) For examples, see “Call External C Code from Model and Generated Code” (Embedded Coder) and “Call Reusable External Algorithm Code for Simulation and Code Generation” (Embedded Coder).</td>
</tr>
<tr>
<td>4</td>
<td>Configure build process to find the external code source, library, and header files.</td>
<td>“Manage Build Process File Dependencies” (Embedded Coder) “Control Library Location and Naming During Build” (Embedded Coder)</td>
</tr>
</tbody>
</table>
Configure Parameters for Integrated Code Build Process

The table provides a guide to configuration parameters that support the build process for external code integration. For information about folders for your external code, see “Manage Build Process Folders” (Embedded Coder). If you choose to place your external code in the “Code generation folder” (Simulink), see “Preserve External Code Files in Build Folder” (Embedded Coder).

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Set up custom build processing required for your external code integration.</td>
<td>For the build process customization workflow, see “Customize Post-Code-Generation Build Processing” (Embedded Coder). To automate applying build customizations to a toolchain approach build, see “Customize Build Process with sl_customization.m” (Embedded Coder). To automate applying build customizations to a template makefile approach build, see “Customize Build Process with STF_make_rtw_hook File” (Embedded Coder).</td>
</tr>
</tbody>
</table>

**To Select**

Add include folders, which contain header files, to the build process

**Select**

Configuration Parameters > Code Generation > Custom Code > Additional build information > Include directories, and enter the absolute or relative paths to the folders. If you specify relative paths, the paths must be relative to the folder containing your model files, not relative to the build folder. The order in which you specify the folders is the order in which they are searched for header, source, and library files.
<table>
<thead>
<tr>
<th>To</th>
<th>Select</th>
</tr>
</thead>
</table>
| Add source files to be compiled and linked | **Configuration Parameters > Code Generation > Custom Code > Additional build information > Source files**, and enter the full paths or just the file names for the files. Enter just the file name if the file is in the current MATLAB folder or in one of the include folders. For each additional source that you specify, the build process expands a generic rule in the template makefile for the folder in which the source file is located. For example, if a source file is located in folder inc, the build process adds a rule similar to the following: 

```
%.obj: buildir\inc\%.c
   $(CC) -c -Fo$(@F) $(CFLAGS) $<
```

The build process adds the rules in the order that you list the source files. |
| Add libraries to be linked | **Configuration Parameters > Code Generation > Custom Code > Additional build information > Libraries**, and enter the full paths or just the file names for the libraries. Enter just the file name if the library is located in the current MATLAB folder or in one of the include folders. |
| Use the same custom code settings as those specified for simulation of MATLAB Function blocks, Stateflow charts, and Truth Table blocks | **Configuration Parameters > Code Generation > Custom Code > Use the same custom code settings as Simulation Target**  

**Note** This parameter refers to the **Simulation Target** pane in the Configuration Parameters dialog box. |
| Enable a library model to use custom code settings unique from the parent model to which the library is linked | **Configuration Parameters > Code Generation > Custom Code > Use local custom code settings (do not inherit from main model)**  

**Note** This parameter is available only for library models that contain MATLAB Function blocks, Stateflow charts, or Truth Table blocks. |
Preserve External Code Files in Build Folder

By default, the build process deletes foreign source files. You can preserve foreign source files by following these guidelines.

If you put a .c/.cpp or .h source file in a build folder, and you want to prevent the code generator from deleting it during the TLC code generation process, insert the text target specific file in the first line of the .c/.cpp or .h file. For example:

```c
/*  COMPANY-NAME target specific file
 *  This file is created for use with the
 *  COMPANY-NAME target.
 *  It is used for ...
 */
...
```

Make sure that you spell the text “target specific file” as shown in the preceding example, and that the text is in the first line of the source file. Other text can appear before or after this text.

Flagging user files in this manner prevents postprocessing these files to indent them with generated source files. Auto-indenting occurred in previous releases to build folder files with names having the pattern `model_*.c/.cpp` (where * was text). The indenting is harmless, but can cause differences detected by source control software that can potentially trigger unnecessary updates.

Build Support for S-Functions

User-written S-Function blocks provide a powerful way to incorporate external code into the Simulink development environment. In most cases, you use S-functions to integrate existing external code with generated code. Several approaches to writing S-functions are available:

- “Write Noninlined S-Function” on page 14-107
- “Write Wrapper S-Function and TLC Files” on page 14-110
- “Write Fully Inlined S-Functions” on page 14-119
- “Write Fully Inlined S-Functions with mdlRTW Routine” on page 14-121
- “S-Functions That Support Code Reuse” on page 14-99
- “S-Functions for Multirate Multitasking Environments” on page 14-100
S-functions also provide the most flexible and capable way of including build information for legacy and custom code files in the build process.

There are different ways of adding S-functions to the build process.

**Implicit Build Support**

When building models with S-functions, the build process adds rules, include paths, and source file names to the generated makefile. The source files (.h, .c, and .cpp) for the S-function must be in the same folder as the S-function MEX-file. Whether using the toolchain approach or template makefile approach for builds, the build process propagates this information through the toolchain or template makefile.

- If the file `sfcnname.h` exists in the same folder as the S-function MEX-file (for example, `sfcnname.mexext`), the folder is added to the include path.
- If the file `sfcnname.c` or `sfcnname.cpp` exists in the same folder as the S-function MEX-file, the build process adds a makefile rule for compiling files from that folder.
- When an S-function is not inlined with a TLC file, the build process must compile the S-function source file. To determine the name of the source file to add to the list of files to compile, the build process searches for `sfcnname.cpp` on the MATLAB path. If the source file is found, the build process adds the source file name to the makefile. If `sfcnname.cpp` is not found on the path, the build process adds the file name `sfcnname.c` to the makefile, whether or not it is on the MATLAB path.

**Note** For the Simulink engine to find the MEX-file for simulation and code generation, it must exist on the MATLAB path or exist in our current MATLAB working folder.

**Specify Additional Source Files for an S-Function**

If your S-function has additional source file dependencies, you must add the names of the additional modules to the build process. Specify the file names:

- In the **S-function modules** field in the S-Function block parameter dialog box
- With the `SFunctionModules` parameter in a call to the `set_param` function

For example, suppose you build your S-function with multiple modules.

```
mex sfun_main.c sfun_module1.c sfun_module2.c
```

You can then add the modules to the build process by doing one of the following:
In the S-function block dialog box, specify `sfun_main`, `sfun_module1`, and `sfun_module2` in the **S-function modules** field.

At the MATLAB command prompt, enter:

```matlab
set_param(sfun_block,'SFunctionModules','sfun_module1 sfun_module2')
```

Alternatively, you can define a variable to represent the parameter value.

```matlab
modules = 'sfun_module1 sfun_module2'
set_param(sfun_block,'SFunctionModules', modules)
```

The **S-function modules** field and `SFunctionModules` parameter do not support complete source file path specifications. To use the parameter, the code generator must find the additional source files when executing the makefile. For the code generator to locate the additional files, place them in the same folder as the S-function MEX-file. You can then leverage the implicit build support described in “Implicit Build Support” on page 26-58.

When you are ready to generate code, force the code generator to rebuild the top model, as described in “Control Regeneration of Top Model Code” on page 27-46.

For more complicated S-function file dependencies, such as specifying source files in other locations or specifying libraries or object files, use the `rtwmakecfg.m` API, as described in “Use `rtwmakecfg.m` API to Customize Generated Makefiles” on page 37-26.

**Use TLC Library Functions**

If you inline your S-function by writing a TLC file, you can add source file names to the build process by using the TLC library function `LibAddToModelSources`. For details, see “LibAddSourceFileCustomSection(file, builtInSection, newSection)”.

**Note** This function does not support complete source file path specifications. The function assumes that the code generator can find the additional source files when executing the makefile.

Another useful TLC library function is `LibAddToCommonIncludes`. Use this function in a `#include` statement to include S-function header files in the generated `model.h` header file. For details, see “LibAddToCommonIncludes(incFileName)”.

For more complicated S-function file dependencies, such as specifying source files in other locations or specifying libraries or object files, use the `rtwmakecfg.m` API, as described in “Use `rtwmakecfg.m` API to Customize Generated Makefiles” on page 37-26.
Precompile S-Function Libraries

You can precompile new or updated S-function libraries (MEX-files) for a model by using
the MATLAB language function rtw_precompile_libs. Using a specified model and a
library build specification, this function builds and places the libraries in a precompiled
library folder.

By precompiling S-function libraries, you can optimize system builds. Once your
precompiled libraries exist, the build process can omit library compilation from
subsequent builds. For models that use numerous libraries, the time savings for build
processing can be significant.

To use rtw_precompile_libs:

1. Set the library file suffix, including the file type extension, based on your system
platform.

   Consider determining the type of platform, and then use the TargetLibSuffix
parameter to set the library suffix accordingly. For example, when applying a suffix
for a GRT target, you can set the suffix to _std.a for a UNIX platform and
_vcxx64.lib for a Windows platform.

   if isunix
       suffix = '_std.a';
   else
       suffix = '_vcx64.lib';
   end

   set_param(my_model,'TargetLibSuffix', suffix);

There are a number of factors that influence the precompiled library suffix and
extension. The following table provides examples for typical selections of system
target file, the compiler toolchain, and other options that affect your choice of suffix
and extension. For more information, examine the template make files in the
matlab/rtw/c/grt folder or matlab/rtw/c/ert folder.
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ert_lcc64.tmf</td>
<td>lcc</td>
<td>_rtwsgcn_lcc</td>
<td>int_ert_lcc</td>
<td>ert_lcc</td>
<td>.lib</td>
<td></td>
</tr>
<tr>
<td>ert_vcx64.tmf</td>
<td>vcx64</td>
<td>_rtwsfcn_vcx64</td>
<td>int_ert_vcx64</td>
<td>ert_vcx64</td>
<td>.lib</td>
<td></td>
</tr>
<tr>
<td>ert_unix.tmf</td>
<td>unix</td>
<td>_rtwsfcn</td>
<td>int_ert</td>
<td>ert</td>
<td>.a</td>
<td></td>
</tr>
<tr>
<td>grt_lcc64.tmf</td>
<td>lcc</td>
<td>n/a</td>
<td>n/a</td>
<td>_lcc</td>
<td>.lib</td>
<td></td>
</tr>
<tr>
<td>grt_vcx64.tmf</td>
<td>vcx64</td>
<td>n/a</td>
<td>n/a</td>
<td>_vcx64</td>
<td>.lib</td>
<td></td>
</tr>
<tr>
<td>grt_unix.tmf</td>
<td>unix</td>
<td>n/a</td>
<td>n/a</td>
<td>_std</td>
<td>.a</td>
<td></td>
</tr>
</tbody>
</table>

2  Set the precompiled library folder.

   Use one of the following methods to set the precompiled library folder:

   • Set the TargetPreCompLibLocation parameter, as described in “Specify the Location of Precompiled Libraries” on page 37-8.
   • Set the makeInfo.precompile field in an rtwmakecfg.m function file. (For more information, see “Use rtwmakecfg.m API to Customize Generated Makefiles” on page 37-26.)

   If you set TargetPreCompLibLocation and makeInfo.precompile, the setting for TargetPreCompLibLocation takes precedence.

   The following command sets the precompiled library folder for model my_model to folder lib under the current working folder.

   ```matlab
   set_param(my_model,'TargetPreCompLibLocation', fullfile(pwd,'lib'));
   ```

   **Note** If you set both the target folder for the precompiled library files and a target library file suffix, the build process detects whether any precompiled library files are missing while processing builds.

3  Define a build specification.
Set up a structure that defines a build specification. The following table describes fields that you can define in the structure. These fields are optional, except for `rtwmakecfgDirs`.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>rtwmakecfgDirs</code></td>
<td>A cell array of character vectors that name the folders containing <code>rtwmakecfg</code> files for libraries to be precompiled. The function uses the Name and Location elements of <code>makeInfo.library</code>, as returned by <code>rtwmakecfg</code>, to specify the name and location of the precompiled libraries. If you set the <code>TargetPreCompLibLocation</code> parameter to specify the library folder, that setting overrides the <code>makeInfo.library.Location</code> setting. <strong>Note:</strong> The specified model must contain blocks that use precompiled libraries specified by the <code>rtwmakecfg</code> files because the TMF-to-makefile conversion generates the library rules only if the build process uses the libraries.</td>
</tr>
<tr>
<td><code>libSuffix</code></td>
<td>A character vector that specifies the suffix, including the file type extension, to be appended to the name of each library (for example, <code>.a</code> or <code>_vc.lib</code>). The character vector must include a period (.), You must set the suffix with either this field or the <code>TargetLibSuffix</code> parameter. If you specify a suffix with both mechanisms, the <code>TargetLibSuffix</code> setting overrides the setting of this field.</td>
</tr>
<tr>
<td><code>intOnlyBuild</code></td>
<td>A Boolean flag. When set to true, the flag indicates the libraries are to be optimized such that they are compiled from integer code only. This field applies to ERT targets only.</td>
</tr>
<tr>
<td><code>makeOpts</code></td>
<td>A character vector that specifies an option to be included in the <code>rtwMake</code> command line.</td>
</tr>
</tbody>
</table>
| `addLibs`       | A cell array of structures that specify libraries to be built that are not specified by an `rtwmakecfg` function. Each structure must be defined with two fields that are character arrays:  

  - `libName` — the name of the library without a suffix  
  - `libLoc` — the location for the precompiled library  

The target makefile (TMF) can specify other libraries and how those libraries are built. Use this field to precompile those libraries. |
The following commands set up build specification `build_spec`, which indicates that the files to be compiled are in folder `src` under the current working folder.

```matlab
build_spec = []; 
build_spec.rtwmakecfgDirs = {fullfile(pwd,'src')};
```

4  Issue a call to `rtw_precompile_libs`.

The call must specify the model for which you want to build the precompiled libraries and the build specification. For example:

```matlab
rtw_precompile_libs(my_model,build_spec);
```

### See Also

### More About

- “Call Reusable External Algorithm Code for Simulation and Code Generation” (Embedded Coder)
- “Place External C/C++ Code in Generated Code” (Embedded Coder)
- “Call External Device Drivers” (Embedded Coder)
- “Deploy Generated Standalone Executable Programs To Target Hardware” (Embedded Coder)
- “Deploy Generated Component Software to Application Target Platforms” (Embedded Coder)
Generate Component Source Code for Export to External Code Base

In this section...

“Modeling Options” on page 26-64
“Requirements” on page 26-65
“Limitations for Export-Function Subsystems” on page 26-66
“Workflow” on page 26-67
“Choose an Integration Approach” on page 26-68
“Generate C Function Code for Export-Function Model” on page 26-71
“Generate C++ Function and Class Code for Export-Function Model” on page 26-76
“Generate Code for Export-Function Subsystems” on page 26-81

If you have Embedded Coder software, you can generate function source code from modeling components to use in an external code base. The generated code does not include supporting scheduling code (for example, a step function). Controlling logic outside of the Simulink environment invokes the generated function code.

Modeling Options

You can generate function code to export for these modeling components:

- Export-function models (model containing functional blocks that consist exclusively of function-call subsystems, function-call model blocks, or other export-function models, as described in “Export-Function Models” (Simulink))
- Export-function subsystems (virtual subsystem that contains function-call subsystems)

To export code that the code generator produces for these modeling components, the modeling components must meet specific requirements (Embedded Coder).

For models designed in earlier releases, the code generator can export functions from triggered subsystems. The requirements stated for export-function subsystems also apply to exporting functions from triggered subsystems, with the following exceptions:

- Encapsulate triggered subsystems from which you intend to export functions in a top-level virtual subsystem.
• Triggered subsystems do not have to meet requirements and limitations identified for virtual subsystems that contain function-call subsystem.

• “Export Functions That Use Absolute or Elapsed Time” (Embedded Coder) does not apply to exporting functions from triggered subsystems.

## Requirements

• Model solver must be a fixed-step discrete solver.

• You must configure each root-level Inport block that triggers a function-call subsystem to output a function-call trigger. These Inport blocks cannot connect to an Asynchronous Task Specification block.

• Model or subsystem, must contain only the following blocks at the root level:

  • Function-call blocks (such as Function-Call Subsystem, Simulink Function, S-Functions, and Function-Call Model blocks at the root level if the solver parameter Tasking and sample time options > Periodic sample time constraint is set to Ensure sample time independent)
  
  • Inport and Outport blocks (ports)
  
  • Constant blocks (including blocks that resolve to constants, such as Add)
  
  • Blocks with a sample time of Inf
  
  • Merge and data store memory blocks
  
  • Virtual connection blocks (such as, Function-Call Split, Mux, Demux, Bus Creator, Bus Selector, Signal Specification, and virtual subsystems that contain these blocks)
  
  • Signal-viewer blocks, such as Scope blocks (export-function subsystems only)

• When a constant block appears at the top level of the model or subsystem, you must set the model configuration parameter Optimization > Default parameter behavior for the model or containing model to Inlined.

• Blocks inside the model or subsystem must support code generation.

• Blocks that use absolute or elapsed time must be inside a periodic function-call subsystem with a discrete sample time specified on the corresponding function-call root-level Inport block. See “Export Functions That Use Absolute or Elapsed Time” (Embedded Coder).

• Data signals that cross the boundary of an exported system cannot be a virtual bus and cannot be implemented as a Goto-From connection. Data signals that cross the export boundary must be scalar, muxed, or a nonvirtual bus.
In addition, for export-function models:

- Data logging and signal-viewer blocks, such as the Scope block, are not allowed at the root level or within the function-call blocks.
- You cannot generate code for a rate-based model that includes multiple instances of an export-function model. For example, you cannot generate code for a test harness model that you use for scheduling reusable export-function models during simulation.

For export-function subsystems, the following additional requirements apply:

- A trigger signal that crosses the boundary of an export-function subsystem must be scalar. Input and output data signals that do not act as triggers do not have to be scalar.
- When a constant signal drives an output port of an export-function subsystem, the signal must specify a storage class.

**Export Functions That Use Absolute or Elapsed Time**

If you want to export function code for a modeling component with blocks that use absolute or elapsed time, those blocks must be inside a function-call subsystem that:

- You configure for periodic execution
- You configure the root-level Inport block with a discrete sample time

To configure a function-call subsystem for periodic execution:

1. In the function-call subsystem, right-click the Trigger block and choose **Block Parameters** from the context menu.
2. In the **Sample time type** field, specify periodic.
3. Set the **Sample time** to the same granularity specified (directly or by inheritance) in the function-call initiator.
4. Click **OK** or **Apply**.

For more information, see “Absolute and Elapsed Time Computation” on page 3-2.

**Limitations for Export-Function Subsystems**

- Subsystem block parameters do not control the names of the files containing the generated code. The file names begin with the name of the exported subsystem.
• Subsystem block parameters do not control the names of top-level functions in the generated code. Each function name reflects the name of the signal that triggers the function or (for an unnamed signal) reflects the block from which the signal originates.

• You can export function-call systems for the C++ class code interface packaging only when its function specification is set to Default step method. See “Customize Generated C++ Class Interfaces” (Embedded Coder). The exported function is compatible with single-threaded execution. To avoid potential data race conditions for shared signals, invoke all members for the class from the same execution thread.

• The code generator supports a SIL or PIL block in accelerator mode only if its function-call initiator is noninlined in accelerator mode. Examples of noninlined initiators include Stateflow charts.

• A Level-2 S-function initiator block, such as a Stateflow chart or the built-in Function-Call Generator block, must drive a SIL block.

• You can export an asynchronous (sample-time) function-call system, but the software does not support the SIL or PIL block for an asynchronous system.

• The software does not support MAT-file logging for export-function subsystems. Specifications that enable MAT-file logging are ignored.

• The use of the TLC function LibIsFirstInit has been removed for export-function subsystems.

**Workflow**

To generate code for an exported function, iterate through the tasks listed in this table.

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Review your assessment of external code characteristics and integration requirements.</td>
<td>“Choose an External Code Integration Workflow” (Embedded Coder)</td>
</tr>
<tr>
<td>2</td>
<td>Verify that the model or subsystem that you are exporting satisfies function exporting requirements.</td>
<td>“Requirements” (Embedded Coder)</td>
</tr>
<tr>
<td>3</td>
<td>Address data interface requirements by modifying the model or subsystem.</td>
<td>“Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” (Embedded Coder)</td>
</tr>
</tbody>
</table>
Choose an Integration Approach

Multiple approaches are available for generating function code for export to an external development environment. The following table compares approaches. Choose the
approach that aligns best with your integration requirements. For more information on how to create export-function models, see “Export-Function Models” (Simulink). For more information on generating code for function call subsystems, see “Generate Component Source Code for Export to External Code Base” (Embedded Coder).

<table>
<thead>
<tr>
<th>Condition or Requirement</th>
<th>Use</th>
<th>More Information</th>
</tr>
</thead>
</table>
| • Traceability between modeling elements and generated code | **Function-call subsystem** | • “Generate C Function Code for Export-Function Model” (Embedded Coder)  
• “Generate C++ Function and Class Code for Export-Function Model” (Embedded Coder)  
• “Using Function-Call Subsystems” (Simulink)  
• Function-Call Subsystem |
| • Local inputs (Inport block) and outputs (Outport block) |

| • Control over generated function prototype | **Simulink Function block** | • “Customize Entry-Point Function Interfaces for Simulink Function and Function Caller Blocks” (Embedded Coder)  
• “Simulink Function Blocks and Code Generation” on page 9-8  
• “Generate Code for a Simulink Function and Function Caller” (Embedded Coder)  
• “Simulink Functions in Simulink Models” (Simulink)  
• Simulink Function |
| • Formal input arguments (Argument Inport blocks) and output arguments (Argument Outport blocks)  
• Local inputs (Inport block) and outputs (Outport block) |
<table>
<thead>
<tr>
<th>Condition or Requirement</th>
<th>Use</th>
<th>More Information</th>
</tr>
</thead>
</table>
| Code responds to an initialization event                     | Initialize Function block| - “Generate C Function Code for Export-Function Model” (Embedded Coder)  
- “Generate C++ Function and Class Code for Export-Function Model” (Embedded Coder)  
- “Generate Code That Responds to Initialize, Reset, and Terminate Events” (Embedded Coder)  
- “Customize Initialize, Reset, and Terminate Functions” (Simulink) |
| Code responds to a reset event                               | Reset Function block     | - “Generate C Function Code for Export-Function Model” (Embedded Coder)  
- “Generate C++ Function and Class Code for Export-Function Model” (Embedded Coder)  
- “Generate Code That Responds to Initialize, Reset, and Terminate Events” (Embedded Coder)  
- “Customize Initialize, Reset, and Terminate Functions” (Simulink) |
| Code includes entry-point functions beyond what the code generator produces by default (model_initialize, model_step, and model_terminate) | S-function               | “S-Functions and Code Generation” on page 14-2                                                                                                  |
| Single-model execution framework to use as test harness and to export code generated for portions of a model | Export-function subsystem | - “Control Generation of Subsystem Functions” (Embedded Coder)  
- “Systems and Subsystems” (Simulink)  
- “Using Function-Call Subsystems” (Simulink)  
- Function-Call Subsystem |
Generate C Function Code for Export-Function Model

This example shows how to generate function code for individual Simulink function blocks and function-call subsystems in a model without generating scheduling code.

To generate function code for export:

1. Create a model that contains the functions for export.
2. Create a test harness model that schedules execution of the functions during simulation.
3. Simulate the model that contains the functions by using the test harness model.
4. Generate code for the model that contains the functions.

Create Model That Contains Functions for Export

The model with functions for export must satisfy architectural constraints at the model root level. At the root level, valid blocks are:

- Inport
- Outport
- Function-Call Subsystem
- Simulink Function
- Goto
- From
- Merge

The code generator produces function code for Function-Call Subsystem and Simulink Function blocks and Initialize and Reset Function blocks. For a Function-call Subsystem block, you connect the block input ports to root Inport blocks that assert function-call signals. The subsystem is executed based on the function-call signal that it receives. A Simulink Function block is executed in response to the execution of a corresponding Function Caller block or Stateflow chart. An Initialize Function block is executed on a model initialize event and a Reset Function block is executed on a user-defined reset event.

For exporting functions, model rtwdemo_functions contains two function-call subsystems (f1_alg and f2_alg) and a Simulink Function block (f3) for exporting functions. The model also contains an Initialize Function block (Initialize Function)
and a Reset Function block (Reset Function). To calculate initial conditions for blocks with state in other parts of the model, the State Writer blocks are used inside the Initialize and Reset Function blocks.

codeblock
open_system('rtwdemo_functions')

Create Model That Contains Function Caller Block

Use a Function Caller block to invoke a Simulink Function block. The Function Caller block can be in the same model or in a different model as the Simulink Function block.

Multiple Function Caller blocks can invoke a Simulink Function block. You can place the Function Caller block inside a function-call subsystem. During code generation, the code generator exports a function from the function-call subsystem.

The model `rtwdemo_caller` exports a function-call subsystem that contains a Function Caller block.
Create Test Harness Model for Simulation

When you export functions, the generated code does not include a scheduler. Create a test harness model to handle scheduling during simulation. Do not use the test harness model to generate code that you deploy.

Model rtwdemo_export_functions is a test harness. The model:

- Schedules the Simulink Function block with the Function Caller block in rtwdemo_caller.
- Provides function-call signals to other models in this example to schedule the model contents, including the model initialize and reset events.
Simulate the Test Harness Model

Verify that the model containing the functions that you want to export is executed as you expect by simulating the test harness model. For example, simulate `rtwdemo_export_functions`.

```matlab
sim('rtwdemo_export_functions')
```

Generate Function Code and Report

Generate code and a code generation report for the functions that you want to export. For example, generate code for `rtwdemo_functions`.

```matlab
rtwbuild('rtwdemo_functions')
```

### Starting build procedure for model: rtwdemo_functions
### Successful completion of code generation for model: rtwdemo_functions

Review Generated Code

From the code generation report, review the generated code.
• *ert_main.c* is an example main program (execution framework) for the model. This code shows how to call the exported functions. The code also shows how to initialize and execute the generated code.

• *rtwdemo_functions.c* calls the initialization function, including *Initialize Function*, and exported functions for model components *f1_alg*, *f2_alg*, and *f3*.

• *rtwdemo_functions.h* declares model data structures and a public interface to the exported entry-point functions and data structures.

• *f3.h* is a shared file that declares the call interface for the Simulink function *f3*.

• *rtwtypes.h* defines data types, structures, and macros that the generated code requires.

**Write Interface Code**

Open and review the Code Interface Report. To write the interface code for your execution framework, use the information in that report.

1. Include the generated header files by adding directives `#include rtwdemo_functions.h`, `#include f3.h`, and `#include rtwtypes.h`.

2. Write input data to the generated code for model Inport blocks.

3. Call the generated entry-point functions.

4. Read data from the generated code for model Outport blocks.

Input ports:

• *rtU.U1* of type *real_T* with dimension 1

• *rtU.U2* of type *real_T* with dimension 1

Entry-point functions:

• Initialize entry-point function, `void rtwdemo_functions_initialize(void)`. At startup, call this function once.

• Reset entry-point function, `void rtwdemo_functions_reset(void)`. Call this function as needed.

• Exported function, `void f1(void)`. Call this function as needed.

• Exported function, `void f2(void)`. Call this function as needed.

• Simulink function, `void f3(real_T rtu_u, real_T *rty_y)`. Call this function as needed.
Output ports:

- rtY.Accumulator1 of type int8_T with dimension [2]
- rtY.Accumulator2 of type int8_T with dimension [2]
- rtY.TicToc10 of type int8_T with dimension 1

More About

- “Generate Component Source Code for Export to External Code Base” (Embedded Coder)
- “Deploy Generated Standalone Executable Programs To Target Hardware” (Embedded Coder)
- “Customize Code Organization and Format” (Embedded Coder)
- “Customize Generated C Function Interfaces” (Embedded Coder)
- “Generate Code for a Simulink Function and Function Caller” on page 9-21

Close Example Models

bdclose('rtwdemo_export_functions')
bdclose('rtwdemo_functions')
bdclose('rtwdemo_caller')

Generate C++ Function and Class Code for Export-Function Model

This example shows how to generate function code for an export-function model that includes a function-call subsystem. The code generator produces function and class code that does not include scheduling code.

To generate function code for export:

1. Create a model that contains the functions for export.
2. Create a test harness model that schedules execution of the functions during simulation.
3. Simulate the model that contains the functions by using the test harness model.
4. Generate code for the model that contains the functions.
Create Model That Contains Functions and C++ Class Interface for Export

The model with functions for export with a C++ model class interface must satisfy architectural constraints at the model root level. For C++ class generation, blocks that are valid at the root level are:

- Inport
- Outport
- Function-Call Subsystem
- Goto
- From
- Merge

**Note:** Export Function-Call Subsystem with C++ class interface does not support Simulink Function blocks.

The code generator produces function code for the Function-Call Subsystem block. For a Function-call Subsystem block, you connect the block input ports to root Inport blocks that assert function-call signals. The subsystem is executed based on the function-call signal that it receives.

Model `rtwdemo_cppclass_functions` contains function-call subsystems `f1`, `f2`, and `f3` for exporting functions.

```matlab
open_system('rtwdemo_cppclass_functions')
```
Create Test Harness Model for Simulation

When you export functions, the generated code does not include a scheduler. Create a test harness model to handle scheduling during simulation. Do not use the test harness model to generate code that you deploy.

Model `rtwdemo_cppclass_export_functions` is a test harness. The model provides function-call signals to other models in this example to schedule the model contents.

```matlab
open_system('rtwdemo_cppclass_export_functions')
```
Simulate the Test Harness Model

Verify that the model containing the functions that you want to export is executed as you expect by simulating the test harness model. For example, simulate `rtwdemo_cppclass_export_functions`.

```matlab
sim('rtwdemo_cppclass_export_functions')
```

Generate Function Code and Report

Generate code and a code generation report for the functions that you want to export. For example, generate code for `rtwdemo_cppclass_functions`.

```matlab
rtwbuild('rtwdemo_cppclass_functions')
```

### Starting build procedure for model: rtwdemo_cppclass_functions
### Successful completion of build procedure for model: rtwdemo_cppclass_functions

Review Generated Code

From the code generation report, review the generated code.
• ert_main.cpp is an example main program (execution framework) for the model. This code shows how to call the exported functions. The code also shows how to initialize and execute the generated code.
• rtwdemo_cppclass_functions.cpp calls the initialization function, including Initialize Function, and exported functions for model subsystem components f1, f2, and f3.
• rtwdemo_cppclass_functions.h declares model data structures and a public interface to the exported entry-point functions and data structures.
• rtwtypes.h defines data types, structures, and macros that the generated code requires.

Write Interface Code

Open and review the Code Interface Report. To write the interface code for your execution framework, use the information in that report.

1 Include the generated header files by adding directives #include rtwdemo_cppclass_functions.h and #include rtwtypes.h.
2 Write input data to the generated code for model Inport blocks.
3 Call the generated entry-point functions.
4 Read data from the generated code for model Outport blocks.

Input ports:
• rtU.U1 of type real_T with dimension 1
• rtU.U2 of type real_T with dimension 1
• rtU.U3 of type real_T with dimension 1

Entry-point functions:
• Initialize entry-point function, void initialize(void). At startup, call this function once.
• Exported function, void t_1tic_A(void). Call this function as needed.
• Exported function, void t_1tic_B(void). Call this function as needed.
• Exported function, void t_1tic_C(void). Call this function as needed.

Output ports:
• `rtY.TicToc1` of type `int8_T` with dimension [2]
• `rtY.TicToc2` of type `int8_T` with dimension [2]
• `rtY.TicToc10` of type `int8_T` with dimension 1

More About

• “Generate Component Source Code for Export to External Code Base” (Embedded Coder)
• “Deploy Generated Standalone Executable Programs To Target Hardware” (Embedded Coder)
• “Customize Code Organization and Format” (Embedded Coder)
• “Customize Generated C++ Class Interfaces” (Embedded Coder)
• “Generate Code for a Simulink Function and Function Caller” on page 9-21

Close Example Models

```matlab
bdclose('rtwdemo_cppclass_export_functions')
bdclose('rtwdemo_cppclass_functions')
```

Generate Code for Export-Function Subsystems

• “Specify a Custom Initialize Function Name” on page 26-82
• “Specify a Custom Description” on page 26-82
• “Optimize Code Generated for Export-Function Subsystems” on page 26-83

To generate code for an export-function subsystem:

1. Verify that the subsystem for which you are generating code satisfies exporting requirements (Embedded Coder).
2. In the Configuration Parameters dialog box:
   a. On the Code Generation pane, specify an ERT-based system target file, such as `ert.tlc`.
   b. If you want a SIL block with the generated code, for verification purposes, from the Configuration Parameters > Code Generation > Verification > Advanced parameters > Create block drop-down list, select SIL.
   c. Click OK or Apply.
3 Right-click the subsystem block and choose **C/C++ Code > Export Functions** from the context menu.

The operation creates a new model, `subsystem.slx`, that contains the content of the original subsystem and creates a ScratchModel that contains a Model block. This block references the newly created `subsystem.slx` model.

The **Build code for subsystem: Subsystem** dialog box opens. This dialog box is not specific to export-function subsystems. Generating code does not require entering information in the dialog box.

4 Click **Build** to build the newly created `subsystem.slx` model.

The code generator produces code and places it in the working folder.

If you set **Create block** to **SIL** in step 2b, Simulink opens a new window that contains an S-function block that represents the generated code. This block has the same size, shape, and connectors as the original subsystem.

Code generation and optional block creation are now complete. You can test and use the code and optional block as you do for generated ERT code and S-function block. For optional workflow tasks, see “Specify a Custom Initialize Function Name” on page 26-82 and “Specify a Custom Description” on page 26-82.

**Specify a Custom Initialize Function Name**

You can specify a custom name for the initialize function of your exported function as an argument to the `rtwbuild` command. The command takes the following form:

```matlab
blockHandle = rtwbuild('subsystem', 'Mode', 'ExportFunctionCalls',...
    'ExportFunctionInitializeFunctionName', 'fcnname')
```

`fcnname` specifies the function name. For example, if you specify the name 'myinitfcn', the build process emits code similar to:

```c
/* Model initialize function */
void myinitfcn(void){
...}
```

**Specify a Custom Description**

You can enter a custom description for an exported function by using the Block Properties dialog box of an Inport block.
1 Right-click the Inport block that drives the control port of the subsystem for which you are exporting code.
2 Select Properties.
3 In the General tab, in the Description field, enter your descriptive text.

During function export, the text you enter is emitted to the generated code in the header for the Inport block. For example, if you open the example program `rtwdemo_exporting_functions` and enter a description in the Block Properties dialog box for port `t_1tic_A`, the code generator produces code that is similar to:

```c
/*
 * Output and update for exported function: t_1tic_A
 * My custom description of the exported function
 */
void t_1tic_A(void)
{
  ...
}
```

Optimize Code Generated for Export-Function Subsystems

To optimize the code generated for an export-function subsystem, specify a separate storage class for each input signal and output signal that crosses the boundary of the subsystem.

For each function-call subsystem that you are exporting:

1 Right-click the subsystem.
2 From the context menu, choose Block Parameters (Subsystem).
3 Select the Code Generation tab.
4 Set Function packaging to Auto.
5 Click OK or Apply.
See Also

More About

- “Design Models for Generated Embedded Code Deployment” (Embedded Coder)
- “Systems and Subsystems” (Simulink)
- “Using Triggered Subsystems” (Simulink)
- “Using Function-Call Subsystems” (Simulink)
- “Export-Function Models” (Simulink)
Generate Shared Library for Export to External Code Base

**In this section...**

- “About Generated Shared Libraries” on page 26-85
- “Workflow” on page 26-85
- “Generate Shared Libraries” on page 26-87
- “Create Application Code That Uses Generated Shared Libraries” on page 26-87
- “Limitations” on page 26-90

**About Generated Shared Libraries**

If you have Embedded Coder software, you can generate a shared library—Windows dynamic link library (.dll), UNIX shared object (.so), or Macintosh OS X dynamic library (.dylib)—from a model component. You or others can integrate the shared library into an application that runs on a Windows, UNIX, or Macintosh OS X development computer. Uses of shared libraries include:

- Adding a software component to an application for system simulation
- Reusing software modules among applications on a development computer
- Hiding intellectual property associated with software that you share with vendors

When producing a shared library, the code generator exports:

- Variables and signals of type `ExportedGlobal` as data
- Real-time model structure (`model_M`) as data
- Functions essential to executing the model code

**Workflow**

To generate a shared library from a model component and use the library, complete the tasks listed in this table.
<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
<th>More Information</th>
</tr>
</thead>
</table>
| 1    | Review your assessment of external code characteristics and integration requirements. | • “Choose an External Code Integration Workflow” (Embedded Coder)  
• “Shared Library Limitations” (Embedded Coder) |
| 2    | Configure the model for code generation. | “Generate Code That Matches Appearance of External Code” (Embedded Coder) and “Model Configuration” (Embedded Coder) |
| 3    | Configure the model for the code generator to produce a shared library and initiate code generation. | “Generate Shared Libraries” (Embedded Coder) |
| 4    | Verify that the generated shared library meets requirements. For example, review the code generation report and view the list of symbols in the library. |  
• On Windows, use the Dependency Walker utility, downloadable from www.dependencywalker.com  
• On UNIX, use `nm -D model.so`  
• On Macintosh OS X, use `nm -g model.dylib` |
| 5    | Use the shared library in application code. | “Create Application Code That Uses Generated Shared Libraries” (Embedded Coder) |
| 6    | Compile and link application code that loads and uses the generated shared library. | “Build Integrated Code Outside the Simulink Environment” (Embedded Coder) |
| 7    | Verify that executable program behaves and performs as expected. |
### Generate Shared Libraries

1. When configuring the model for code generation, select the system target file `ert_shrlib.tlc`.

2. Build the model. The code generator produces source code for the model and a shared library version of the code. The code generator places the source code in the code generation folder and the shared library (.dll, .so, or .dylib file) in your current working folder. The code generator also produces and retains a .lib file to support implicit linking.

### Create Application Code That Uses Generated Shared Libraries

This example application code is generated for the example “Interface to a Development Computer Simulator By Using a Shared Library” (Embedded Coder).

1. Create an application header file that contains type declarations for model external input and output. For example:

   ```
   #ifndef _APP_MAIN_HEADER_
   #define _APP_MAIN_HEADER_

   typedef struct {
       int32_T Input;
   } ExternalInputs_rtwdemo_shrlib;

   typedef struct {
       int32_T Output;
   } ExternalOutputs_rtwdemo_shrlib;

   #endif /*_APP_MAIN_HEADER_*/
   
   #ifdef _APP_MAIN_HEADER_
   #endif /*_APP_MAIN_HEADER_*/
   
   2. In the application C source code, dynamically load the shared library. Use preprocessing conditional statements to invoke platform-specific commands. For example:

   ```
   #if (defined(_WIN32)||defined(_WIN64)) /* WINDOWS */
   #include <windows.h>
   #define GETSYMBOLADDR GetProcAddress
   #define LOADLIB LoadLibrary
   #define CLOSELIB FreeLibrary
   ```
From the application C source code, access exported data and functions generated from the model. The code uses hooks to add user-defined initialization, step, and termination code.

```c
int32_T i;
...
void (*mdl_initialize)(boolean_T);
void (*mdl_step)(void);
void (*mdl_terminate)(void);

ExternalInputs_rtwdemo_shrlib (*mdl_Uptr);
ExternalOutputs_rtwdemo_shrlib (*mdl_Yptr);

uint8_T (*sum_outptr);
...
#if (defined(LCCDLL)||defined(BORLANDCDLL))
/* Exported symbols contain leading underscores when DLL is linked with LCC or BORLANDC */
mdl_initialize = (void(*)(boolean_T))GETSYMBOLADDR(handleLib, "_rtwdemo_shrlib_initialize");
```
mdl_step =
    (void(*)(void))GETSYMBOLADDR(handleLib ,
    "_rtwdemo_shrlib_step");
mdl_terminate =
    (void(*)(void))GETSYMBOLADDR(handleLib ,
    "_rtwdemo_shrlib_terminate");
mdl_Uptr =
    (ExternalInputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
    "_rtwdemo_shrlib_U");
mdl_Yptr =
    (ExternalOutputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
    "_rtwdemo_shrlib_Y");
sum_outptr =
    (uint8_T*)GETSYMBOLADDR(handleLib , "_sum_out");
#else
mdl_initialize =
    (void(*)(boolean_T))GETSYMBOLADDR(handleLib ,
    "rtwdemo_shrlib_initialize");
mdl_step =
    (void(*)(void))GETSYMBOLADDR(handleLib ,
    "rtwdemo_shrlib_step");
mdl_terminate =
    (void(*)(void))GETSYMBOLADDR(handleLib ,
    "rtwdemo_shrlib_terminate");
mdl_Uptr =
    (ExternalInputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
    "rtwdemo_shrlib_U");
mdl_Yptr =
    (ExternalOutputs_rtwdemo_shrlib*)GETSYMBOLADDR(handleLib ,
    "rtwdemo_shrlib_Y");
sum_outptr =
    (uint8_T*)GETSYMBOLADDR(handleLib , "sum_out");
#endif
if ((mdl_initialize &&
    mdl_step &&
    mdl_terminate &&
    mdl_Uptr &&
    mdl_Yptr &&
    sum_outptr)) {
    /* user application
     * initialization function */
    mdl_initialize(1);
    /* insert other user defined
application initialization code here */

/* user application
   step function */
for(i=0;i<=12;i++){
    mdl_Uptr->Input = i;
    mdl_step();
    printf("Counter out(sum out):
           Amplifier in(Input):
           out(Output):
           ", *sum_outptr, i,
           mdl_Yptr->Output);
/* insert other user defined
   application step function
code here */
}

/* user application
   terminate function */
mdl_terminate();
/* insert other user defined
   application termination
code here */
}
else {
    printf("Cannot locate the specified
           reference(s) in the shared library.\n")
    return(-1);
}

Limitations

- Code generation for the ert_shrlib.tlc system target file exports the following as data:
  - Variables and signals of type ExportedGlobal
  - Real-time model structure (model_M)
- Code generation for the ert_shrlib.tlc system target file supports the C language only (not C++). When you select ert_shrlib.tlc, language selection is unavailable on the Code Generation pane in the Configuration Parameters dialog box.
- To reconstruct a model simulation by using a generated shared library, the application author must maintain the timing between system and shared library function calls in
the original application. The timing must be consistent so that you can compare the 
simulation and integration results. Additional simulation considerations apply if 
generating a shared library from a model that enables model configuration 
parameters **Support: continuous time** and **Single output/update function**. For 
more information, see Single output/update function (Simulink Coder) dependencies.

### See Also

### More About

- “Interface to a Development Computer Simulator By Using a Shared Library” (Embedded Coder)
- “Design Models for Generated Embedded Code Deployment” (Embedded Coder)
- “Configure a System Target File” (Embedded Coder)
- “Manage Build Process Files” (Embedded Coder)
- “Model Protection” (Embedded Coder)
Interface to a Development Computer Simulator By Using a Shared Library

This example generates a shared library for interfacing to a simulator that runs on your development computer. Generate the shared library by using the system target file ert_shrlib.tlc.

To build a shared library from the model and use the library in an application:

1. Develop your model. For this example, open the model rtwdemo_shrlib.

open_system('rtwdemo_shrlib');
The model is a single-rate, discrete-time model. An 8-bit counter feeds the triggered subsystem named Amplifier. Parameters INC, LIMIT, and RESET are set to constant...
values 1, 4, and 0, respectively. When signal equal_to_count is true, the subsystem amplifies its input signal by a gain factor K=3 and the output signal is updated.

2. Configure the model for code generation, specifying ert_shrlib.tlc as the system target file. Click the yellow button on the model to view the configuration settings on the **Code Generation** pane in the Configuration Parameters dialog box.

3. Build the shared library file. The file that the code generator produces depends on your development platform. For example, on a Windows system, the code generator produces the library file rtwdemo_shrlib_win64.dll.

4. Create application code that uses the shared library. This example uses application code that is available in these files:

```matlab
matlabroot\toolbox\rtw\rtwdemos\shrlib_demo\rtwdemo_shrlib_app.h
matlabroot\toolbox\rtw\rtwdemos\shrlib_demo\rtwdemo_shrlib_app.c
```

To view the source code in these files, in the model, click the white buttons for the .h and .c files.

5. Compile and link the file application and shared library files to produce an executable program. The following script compiles, builds, and runs the program.

```matlab
matlabroot\toolbox\rtw\rtwdemos\shrlib_demo\run_rtwdemo_shrlib_app.m
```

To view the script code, in the model, click the white button for the .m file.

To build the model and run the application that uses the generated shared library, in the model, double-click the blue button.

For more information about using a shared library, see “Package Generated Code as Shared Libraries” (Embedded Coder).

**See Also**

**More About**
- “Generate Shared Library for Export to External Code Base” (Embedded Coder)
Build Integrated Code Outside the Simulink Environment

Identify required files and interfaces for calling generated code in an external build process.

Learn how to:

• Collect files required for building integrated code outside of Simulink®.
• Interface with external variables and functions.

For information about the example model and related examples, see “Generate C Code from a Control Algorithm for an Embedded System” (Embedded Coder).

Collect and Build Required Data and Files

The code that Embedded Coder® generates requires support files that MathWorks® provides. To relocate the generated code to another development environment, such as a dedicated build system, you must relocate these support files. You can package these files in a zip file by using the packNGo utility. This utility finds and packages the files that you need to build an executable image. The utility uses tools for customizing the build process after code generation, which include a buildinfo_data structure, and a packNGo function. These files include external files that you identify in the Code Generation > Custom Code pane in the Model Configuration Parameters dialog box. The utility saves the buildinfo MAT-file in the model_ert_rtw folder.

Open the example model, rtwdemo_PCG_Eval_P5.

This model is configured to run packNGo after code generation.

Generate code from the entire model.

To generate the zip file manually:

1 Load the file buildInfo.mat (located in the rtwdemo_PCG_Eval_P5_ert_rtw subfolder).

2 At the command prompt, enter the command packNGo(buildInfo).

The number of files in the zip file depends on the version of Embedded Coder® and on the configuration of the model that you use. The compiler does not require all of the files in the zip file. The compiled executable size (RAM/ROM) depends on the linking process. The linker likely includes only the object files that are necessary.
**Integrating the Generated Code into an Existing System**

This example shows how to integrate the generated code into an existing code base. The example uses the Eclipse™ IDE and the Cygwin™/gcc compiler. The required integration tasks are common to all integration environments.

**Overview of Integration Environment**

A full embedded controls system consists of multiple hardware and software components. Control algorithms are just one type of component. Other components can be:

- An operating system (OS)
- A scheduling layer
- Physical hardware I/O
- Low-level hardware device drivers

Typically, you do not use the generated code in these components. Instead, the generated code includes interfaces that connect with these components. MathWorks® provides hardware interface block libraries for many common embedded controllers. For examples, see the Embedded Targets block library.

This example provides files to show how you can build a full system. The main file is `example_main.c`, which contains a simple main function that performs only basic actions to exercise the code.

View `example_main.c`. 
int_T main(void)
{
    /* Initialize model */
    rt_Pos_Command_Arbitration_Init(); /* Set up the data structures for chart*/
    rtwdemo_PCG__Define_Throt_Param(); /* SubSystem: '<Root>/Define_Throt_Param' */
    defineImportData(); /* Defines the memory and values of inputs */

do /* This is the "Schedule" loop.
     Functions would be called based on a scheduling algorithm */
{
    /* HARDWARE I/O */

    /* Call control algorithms */
    PI_Cntrl_Reusable(*pos_rqst, fbk_1, &rtwdemo_PCG_Eval_P5_B.PI_ctrl_1,
                     &rtwdemo_PCG_Eval_P5_B.DWork.PI_ctrl_1);
    PI_Cntrl_Reusable(*pos_rqst, fbk_2, &rtwdemo_PCG_Eval_P5_B.PI_ctrl_2,
                     &rtwdemo_PCG_Eval_P5_B.DWork.PI_ctrl_2);
    pos_cmd_one = rtwdemo_PCG_Eval_P5_B.PI_ctrl_1.Saturation1;
    pos_cmd_two = rtwdemo_PCG_Eval_P5_B.PI_ctrl_2.Saturation1;
    rtwdemo_Pos_Command_Arbitration(pos_cmd_one, &Throt_Param, pos_cmd_two,
                     &rtwdemo_PCG_Eval_P5_B.sf_Pos_Command_Arbitration);

The file:

- Defines function interfaces (function prototypes).
- Includes files that declare external data.
- Defines `extern` data.
- Initializes data.
- Calls simulated hardware.
- Calls algorithmic functions.

The order of function execution matches the order of subsystem execution in the test harness model and in `rtwdemo_PCG_Eval_P5.h`. If you change the order of execution in `example_main.c`, results that the executable image produces differ from simulation results.
Match System Interfaces

Integration requires matching the Data and Function interfaces of the generated code and the existing system code. In this example, the example_main.c file imports and exports the data through #include statements and extern declarations. The file also calls the functions from the generated code.

Connect Input Data

The system has three input signals: pos_rqst, fbk_1, and fbk_2. The generated code accesses the two feedback signals through direct reference to imported global variables (storage class ImportedExtern). The code accesses the position signal through an imported pointer (storage class ImportedExternPointer).

The handwritten file defineImportedData.c defines the variables and the pointer. The generated code does not define the variables and the pointer because the handwritten code defines them. Instead, the generated code declares the imported data (extern) in the file rtwdemo_PCG_Eval_P5_Private.h. In a real system, the data typically comes from other software components or from hardware devices.

View defineImportedData.c.

```c
/* Define imported data */
#include "rtwtypes.h"
#include "defineImportedData.h"

real_T fbk_1;
real_T fbk_2;
real_T dummy_pos_value = 10.0;
real_T *pos_rqst;

void defineImportedData(void)
{
    pos_rqst = &dummy_pos_value;
}
```

View rtwdemo_PCG_Eval_P5_Private.h.
Connect Output Data

In this example, you do not access the output data of the system. The example “Test Generated Code” (Embedded Coder) shows how you can save the output data to a standard log file. You can access the output data by referring to the file `rtwdemo_PCG_Eval_P5.h`.

View `rtwdemo_PCG_Eval_P5.h`.

Access Additional Data

The generated code contains several structures that store commonly used data including:

- Block state values (integrator, transfer functions)
- Local parameters
- Time

The table lists the common data structures. Depending on the configuration of the model, some or all of these structures appear in the generated code. The data is declared in the file `rtwdemo_PCG_Eval_P5.h`, but in this example, you do not access this data.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Data Name</th>
<th>Data Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constants</td>
<td><code>model_cP</code></td>
<td>Constant parameters</td>
</tr>
<tr>
<td>Constants</td>
<td><code>model_cB</code></td>
<td>Constant block I/O</td>
</tr>
<tr>
<td>Output</td>
<td><code>model_U</code></td>
<td>Root and atomic subsystem input</td>
</tr>
<tr>
<td>Output</td>
<td><code>model_Y</code></td>
<td>Root and atomic subsystem output</td>
</tr>
<tr>
<td>Internal data</td>
<td><code>model_B</code></td>
<td>Value of block output</td>
</tr>
<tr>
<td>Internal data</td>
<td><code>model_D</code></td>
<td>State information vectors</td>
</tr>
<tr>
<td>Internal data</td>
<td><code>model_M</code></td>
<td>Time and other system level data</td>
</tr>
<tr>
<td>Internal data</td>
<td><code>model_Zero</code></td>
<td>Zero-crossings</td>
</tr>
<tr>
<td>Parameters</td>
<td><code>model_P</code></td>
<td>Parameters</td>
</tr>
</tbody>
</table>
Match Function Call Interfaces

By default, functions that the code generator generates have a `void Func(void)` interface. If you configure the model or atomic subsystem to generate reentrant code, the code generator creates a more complex function prototype. In this example, the `example_main` function calls the generated functions with the correct input arguments.

```c
PI_Cntrl_Reusable(*pos_rqst), fbk_1, &rtwdemo_PCG_Eval_P5_B.PI_ctrl_1,
&rtwdemo_PCG_Eval_P5_DWork.PI_ctrl_1);
PI_Cntrl_Reusable(*pos_rqst), fbk_2, &rtwdemo_PCG_Eval_P5_B.PI_ctrl_2,
&rtwdemo_PCG_Eval_P5_DWork.PI_ctrl_2);
pos_cmd_one = rtwdemo_PCG_Eval_P5_B.PI_ctrl_1.Saturation1;
pos_cmd_two = rtwdemo_PCG_Eval_P5_B.PI_ctrl_2.Saturation1;
rtwdemo_Pos_Command_Arbitration(pos_cmd_one, &Throt_Param, pos_cmd_two,
&rtwdemo_PCG_Eval_P5_B.sf_Pos_Command_Arbitration);
```

Calls to the function `PI_Cntrl_Reusable` use a mixture of separate, unstructured global variables and Simulink® Coder™ data structures. The handwritten code defines these variables. The structure types are defined in `rtwdemo_PCG_Eval_P5.h`.

Build Project in Eclipse™ Environment

This example uses the Eclipse™ IDE and the Cygwin™ GCC debugger to build the embedded system. The example provides installation files for both programs. Software components and versions numbers are:

- Eclipse™ SDK 3.2
- Eclipse™ CDT 3.3
- Cygwin™/GCC 3.4.4-1
- Cygwin™/GDB 20060706-2

To install and use Eclipse™ and GCC, see “Install and Use Cygwin and Eclipse” (Embedded Coder).

You can install the files for this example by clicking this hyperlink:

Set up the build folder.

Alternatively, to install the files manually:
1 Create a build folder (Eclipse_Build_P5).
2 Unzip the file rtwdemo_PCG_Eval_P5.zip into the build folder.
3 Delete the files rtwdemo_PCG_Eval_P5.c, ert_main.c and rt_logging.c, which are replaced by example_main.c.

You can use the Eclipse™ debugger to step through and evaluate the execution behavior of the generated C code. See the example “Install and Use Cygwin and Eclipse” (Embedded Coder).

To exercise the model with input data, see “Test Generated Code” (Embedded Coder).

**Related Topics**

- “Generate Component Source Code for Export to External Code Base” (Embedded Coder)
- “Generate Shared Library for Export to External Code Base” (Embedded Coder)
Exchange Data Between External C/C++ Code and Simulink Model or Generated Code

Whether you import your external code into a Simulink model (for example, by using the Legacy Code Tool) or export the generated code to an external environment, the model or the generated code typically exchange data (signals, states, and parameters) with your code.

Functions in C or C++ code, including your external functions, can exchange data with a caller or a called function through:

• Arguments (formal parameters) of functions. When a function exchanges data through arguments, an application can call the function multiple times. Each instance of the called function can manipulate its own independent set of data so that the instances do not interfere with each other.

• Direct access to global variables. Global variables can:
  • Enable different algorithms (functions) and instances of the same algorithm to share data such as calibration parameters and error status.
  • Enable the different rates (functions) of a multitasking system to exchange data.
  • Enable different algorithms to exchange data asynchronously.

In Simulink, you can organize and configure data so that a model uses these exchange mechanisms to provide, extract, and share data with your code.

Before you attempt to match data interfaces, to choose an overall integration approach, see “Choose an External Code Integration Workflow” on page 26-4.

Import External Code into Model

To exchange data between your model and your external function, choose an exchange mechanism based on the technique that you chose to integrate the function.

• To exchange data through the arguments of your external function, construct and configure your model to create and package the data according to the data types of the arguments. Then, you connect and configure the block that calls or represents your function to accept, produce, or refer to the data from the model.

  For example, if you use the Legacy Code Tool to generate an S-Function block that calls your function, the ports and parameters of the block correspond to the
arguments of the function. You connect the output signals of upstream blocks to the
input ports and set parameter values in the block mask. Then, you can create signal
lines from the output ports of the block and connect those signals to downstream
blocks.

- To exchange data through global variables that your external code already defines, a
  best practice is to use a Stateflow chart to call your function and to access the
  variables. You write algorithmic C code in the chart so that during simulation or
  execution of the generated code, the model reads and writes to the variables.

To use such a global variable as an item of parameter data (not signal or state data)
elsewhere in a model, you can create a numeric MATLAB variable or
Simulink.Parameter object that represents the variable. If you change the value of
the C-code variable in between simulation runs, you must manually synchronize the
value of the Simulink variable or object. If your algorithmic code (function) changes
the value of the C-code variable during simulation, the corresponding Simulink
variable or object does not change.

If you choose to create a Simulink representation of the C-code variable, you can
configure the Simulink representation so that the generated code reads and writes to
the variable but does not duplicate the variable definition. Apply a storage class to the
Simulink representation.

<table>
<thead>
<tr>
<th>Technique for Integrating External Function</th>
<th>Mechanism to Exchange Data with Model</th>
<th>Examples and More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>S-Function block</td>
<td>Function arguments</td>
<td>To call your function through an S-function that you create by using the Legacy Code Tool, see “Integrate C Functions into Simulink Models with Legacy Code Tool” (Simulink).</td>
</tr>
<tr>
<td>Stateflow chart</td>
<td>Function arguments and direct access to global variables</td>
<td>To call your function and access global variables in a Stateflow chart, see “Integrate Custom C/C++ Code for Simulation” (Stateflow). For information about creating data items in a chart (which you can pass to your function as arguments), see “Add Stateflow Data” (Stateflow).</td>
</tr>
</tbody>
</table>
## Technique for Integrating External Function

<table>
<thead>
<tr>
<th>Technique for Integrating External Function</th>
<th>Mechanism to Exchange Data with Model</th>
<th>Examples and More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>coder.ceval in MATLAB Function block</td>
<td>Function arguments</td>
<td>To call your function in a MATLAB Function block by using coder.ceval, see “Integrate C Code Using the MATLAB Function Block” (Simulink). For information about creating data items in a MATLAB Function block (which you can pass to your function as arguments), see “Ports and Data Manager” (Simulink).</td>
</tr>
</tbody>
</table>

### Export Generated Code to External Environment

To export the generated code into your external code, see “Exchange Data Between External Calling Code and Generated Code” on page 26-114.

### Simulink Representations of C Data Types and Constructs

To model and reuse your custom C data such as structures, enumerations, and typedef aliases, use the information in these tables.
## Modeling Patterns for Matching Data in External C Code

<table>
<thead>
<tr>
<th>C Data Type or Construct</th>
<th>Example C Code</th>
<th>Simulink Equivalent</th>
<th>More Information</th>
</tr>
</thead>
</table>
| Primitive type alias (typedef) | `typedef float mySinglePrec_T;` | Create a `Simulink.AliasType` object. Use the object to:  
  • Set the data types of signals and block parameters in a model.  
  • Configure data type replacements for code generation.  
  Generating code that uses an alias data type requires Embedded Coder. | For information about defining custom data types for your model, see `Simulink.AliasType` and “Control Data Type Names in Generated Code” (Embedded Coder).  
  For an example that shows how to export the generated code into your external code, see “Replace and Rename Data Types to Conform to Coding Standards” (Embedded Coder). |
<table>
<thead>
<tr>
<th>C Data Type or Construct</th>
<th>Example C Code</th>
<th>Simulink Equivalent</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Array</td>
<td>int myArray[6];</td>
<td>Specify signal and parameter dimensions as described in “Signal Dimensions” (Simulink). The generated code defines and accesses multidimensional data, including matrices, as column-major serialized vectors. If your external code uses a different format, consider using alternative techniques to integrate the generated code. See “Code Generation of Matrices and Arrays” on page 21-76.</td>
<td>For information about how the generated code stores nonscalar data (including limitations), see “Code Generation of Matrices and Arrays” on page 21-76. For an example that shows how to export the generated code into your external code, see “Reuse Parameter Data from External Code in the Generated Code” (Embedded Coder). To model lookup tables, see Simulink.LookupTable.</td>
</tr>
<tr>
<td>C Data Type or Construct</td>
<td>Example C Code</td>
<td>Simulink Equivalent</td>
<td>More Information</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enumeration</td>
<td><code>typedef enum myColorsType { Red = 0, Yellow, Blue } myColorsType;</code></td>
<td>Define a Simulink enumeration that corresponds to your enumeration definition. Use the Simulink enumeration to set data types in a model.</td>
<td>To use enumerated data in a Simulink model, see “Use Enumerated Data in Simulink Models” (Simulink). For an example that shows how to generate enumerated parameter data, see “Enumeration” (Embedded Coder). For an example that shows how to export the generated code into your external code by exchanging enumerated data, see “Exchange Structured and Enumerated Data Between Generated and External Code” (Embedded Coder).</td>
</tr>
<tr>
<td>C Data Type or Construct</td>
<td>Example C Code</td>
<td>Simulink Equivalent</td>
<td>More Information</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------</td>
<td>---------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Structure</td>
<td><code>typedef struct myStructType { int count; double coeff; } myStructType;</code></td>
<td>Create a Simulink.Bus object that corresponds to your structure type. To create structured signal or state data, package multiple signal lines in a model into a single nonvirtual bus signal. To create structured parameter data, create a parameter object (such as Simulink.Parameter) that stores a MATLAB structure. Use the bus object as the data type of the parameter object. To package lookup table data into a structure, use Simulink.LookupTable and, optionally, Simulink.Breakpoint objects.</td>
<td>For information about bus signals, see “Getting Started with Buses” (Simulink). For information about structures of parameters, see “Organize Related Block Parameter Definitions in Structures” (Simulink). For an example that shows how to import your external code into a model by using the Legacy Code Tool, see “Integrate C Function Whose Arguments Are Pointers to Structures” (Simulink). For examples that show how to export the generated code into your external code, see “Exchange Structured and Enumerated Data Between Generated and External Code” (Embedded Coder) and “Access Structured Data Through a Pointer” (Embedded Coder).</td>
</tr>
<tr>
<td>C Data Type or Construct</td>
<td>Example C Code</td>
<td>Simulink Equivalent</td>
<td>More Information</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------</td>
<td>---------------------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>That External Code Defines” (Embedded Coder).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>To package lookup table data into a structure, Simulink.LookupTable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For general information about creating structures in the generated code, see “Organize Data into Structures in Generated Code” on page 15-177.</td>
</tr>
</tbody>
</table>
## Additional Modeling Patterns for Code Generation (Embedded Coder)

<table>
<thead>
<tr>
<th>C Data Type or Construct</th>
<th>Example C Code</th>
<th>Simulink Equivalent</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Macro</td>
<td>#define myParam 9.8</td>
<td>Apply the custom storage classes Define and ImportedDefine to parameters. With macros, you can reuse a parameter value in multiple locations in an algorithm and change the parameter value between code compilations without consuming memory to store the value. Typically, macros represent engineering constants that you do not expect to change during code execution. This technique requires Embedded Coder.</td>
<td>“Macro Definitions (#define)” (Embedded Coder)</td>
</tr>
<tr>
<td>Storage type qualifiers such as const and volatile</td>
<td>const myParam = 9.8;</td>
<td>Apply the custom storage classes Const, Volatile, and ConstVolatile to data items.</td>
<td>“Protect Global Data with Keywords const and volatile” on page 26-116</td>
</tr>
<tr>
<td>C Data Type or Construct</td>
<td>Example C Code</td>
<td>Simulink Equivalent</td>
<td>More Information</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------</td>
<td>---------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Bit field</td>
<td>typedef struct myBitField { unsigned short int MODE : 1; unsigned short int FAIL : 1; unsigned short int OK : 1; } myBitField</td>
<td>• Apply the custom storage class BitField to signals, states, and parameters whose data type is boolean. • Use a model configuration parameter to aggregate Boolean data into bit fields. These techniques require Embedded Coder.</td>
<td></td>
</tr>
<tr>
<td>Call to custom external function that reads or writes to data</td>
<td>External code: /* Call this function to acquire the value of the signal. */ double get_inSig(void) { return myBigGlobalStruct.inSig; } Generated algorithmic code: algorithmInput = get_inSig();</td>
<td>Apply the custom storage class GetSet to signals, states, and parameters. Each data item appears in the generated code as a call to your custom functions that read and write to the target data. This technique requires Embedded Coder.</td>
<td></td>
</tr>
</tbody>
</table>

“Bitfields” (Embedded Coder) “Optimize Generated Code By Packing Boolean Data Into Bitfields” (Embedded Coder) “Access Data Through Functions with Custom Storage Class GetSet” (Embedded Coder)
## Considerations for Other Modeling Goals

<table>
<thead>
<tr>
<th>Goal</th>
<th>Considerations and More Information</th>
</tr>
</thead>
</table>
| Use Simulink to run and interact with the generated code | You can use SIL, PIL, and external mode simulations to connect your model to the corresponding generated application for simulation. When you import parameter data from your external code:  
  - At the time that you begin an external mode simulation, the external executable uses the value that your code uses to initialize the parameter data. However, when you change the corresponding value in Simulink during the simulation (for example by modifying the Value property of the corresponding parameter object), Simulink downloads the new value to the executable.  
  - SIL and PIL simulations do not import the parameter value from your code. Instead, the simulations use the parameter value from Simulink. If you include your external code in the Simulink Coder build process, duplicate data definitions can prevent the generated code from compiling.  
For information about SIL and PIL, see “Choose a SIL or PIL Approach” (Embedded Coder). For information about external mode simulation, see “Host-Target Communication with External Mode Simulation” on page 28-2. |
| Generate code comments that describe attributes of exported data including physical units, real-world initial value, and data type | Generating these comments can help you match data interfaces while handwriting integration code. See “Add Custom Comments for Variables in the Generated Code” (Embedded Coder). |

### See Also

### Related Examples

- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “Generate Code That Matches Appearance of External Code” on page 26-118
• “Design Data Interface by Configuring Inport and Outport Blocks” on page 15-207
• “Configure Generated Code According to Interface Control Document Interactively” (Embedded Coder)
• “Generate Code That Dereferences Data from a Literal Memory Address” (Embedded Coder)
Exchange Data Between External Calling Code and Generated Code

To export the generated code into your external code, you configure the generated code to match the data interface of your external code. For example, if your external code defines a global variable for storing output data and you need the generated code to read that data as input, you can configure a corresponding Inport block so that the generated code interacts with the existing variable.

- You can generate reentrant code from a model. The generated entry-point functions typically accept data through arguments. Your calling code passes data through these arguments. You can call the functions multiple times in a single application—the application can maintain multiple instances of the model. See “Data Exchange for Reentrant Generated Code” on page 26-114.

- When you generate nonreentrant code, by default, the entry-point functions exchange data between the generated code and your code through global variables. You can generate variable definitions for your code to use or you can share and reuse existing variables that your code already defines. See “Data Exchange for Nonreentrant Generated Code” on page 26-115.

Alternatively, you can configure the entry-point functions to exchange system inputs and outputs (root-level Inport and Outport blocks) through arguments instead of global variables. Apply function prototype control to the model, which requires Embedded Coder. For more information about function prototype control, see “Customize Generated C Function Interfaces” (Embedded Coder).

For general information about exchanging data between generated and external code, including how to match specific C code patterns, see “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on page 26-102.

Data Exchange for Reentrant Generated Code

When you generate reentrant code, the model entry-point functions exchange data through arguments. You can control some of the characteristics of the arguments. For more information, see “Control Data and Function Interface in Generated Code” on page 15-42.

For information about creating a separate set of data for each call site in your external code, see “Modify Static Main to Allocate and Access Model Instance Data” (Embedded Coder).
Data Exchange for Nonreentrant Generated Code

To make the generated code read or write to an item of signal, state, or parameter data as a global variable, apply a storage class or custom storage class to the data in the model. The storage class also determines whether the generated code exports the variable definition to your external code or imports the definition from your code. For general information about controlling the data interface of a model that you configure to generate nonreentrant code, see “Control Data Interface for Nonreentrant Code” on page 15-43. For examples, see “Design Data Interface by Configuring Inport and Outport Blocks” on page 15-207 and “Integrate External Application Code with Code Generated from PID Controller” (Embedded Coder).

When you generate code that defines (allocates memory for) global data, the generated code exports that data. When your external code defines data, the generated code imports that data. Typically, storage classes that import data have the word Import in the storage class name, for example, ImportedExternPointer.

Control File Placement of Exported Global Data (Embedded Coder)

When you export data from the generated code by using storage classes or custom storage classes, the code generator creates an extern declaration. By default, this declaration typically appears in the generated header file model.h. You can include (#include) this header file in your external code.

By default, the definition (memory allocation) of exported data typically appears in model.c.

You can control the file placement of the declarations and definitions to:

- Create separate object files that store only global parameter data.
- Modularize the generated code by organizing declarations into separate files.

For more information about controlling file placement of declarations and definitions, see “Control Placement of Global Data Definitions and Declarations in Generated Files” (Embedded Coder). For an example, see “Definition, Initialization, and Declaration of Parameter Data” (Embedded Coder).

Prevent Duplicate Initialization Code for Global Variables

When your external code defines global variables, you can generate code that interacts with those variables. For example, use the custom storage class ImportFromFile (see
“Choose Storage Class for Controlling Data Representation in Generated Code” on page 15-69).

For imported variables that represent signal or state data, the code generator can produce initialization code as described in “Initialization of Signal, State, and Parameter Data in the Generated Code” on page 15-229. If your code already initializes a variable, consider preventing the generation of duplicate initialization code. Create your own custom storage class and, for that storage class, set **Data initialization** to None. For information about creating and applying your own custom storage class, see “Define Storage Classes, Memory Sections, and Function Templates for Software Architecture” (Embedded Coder).

### Protect Global Data with Keywords const and volatile

When your external code and the generated code exchange data through global variables, you can generate code that uses C type qualifiers **const** and **volatile** to protect data integrity and improve the safety of your application. For example:

- Apply **const** to a calibration parameter.
- Apply **volatile** to a global variable that stores the output of a hardware device operating asynchronously.
- Apply **const** and **volatile** to signals, states, and parameters that represent data defined by your external code. Then, the generated code declares and interacts with the external data by using the correct storage type qualifiers.

You must have Embedded Coder. For more information, see “Protect Global Data with const and volatile Type Qualifiers” (Embedded Coder).

### See Also

### Related Examples

- “Exchange Data Between External C/C++ Code and Simulink Model or Generated Code” on page 26-102
- “Control Data and Function Interface in Generated Code” on page 15-42
- “Design Data Interface by Configuring Inport and Outport Blocks” on page 15-207
• “Integrate External Application Code with Code Generated from PID Controller” (Embedded Coder)
### Generate Code That Matches Appearance of External Code

A key aspect of code integration, especially for larger projects, is adherence to guidelines and standards for code appearance. If code appearance requirements apply to your project, review the requirements in this table. To learn more, see the relevant information.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thoroughly document code or document code in a specific way.</td>
<td>• “Configure Code Comments” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Add Custom Comments to Generated Code” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Add Custom Comments for Variables in the Generated Code” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Add Global Comments” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Annotate Code for Justifying Polyspace Checks” (Embedded Coder)</td>
</tr>
<tr>
<td>Control the length and naming of code identifiers (symbols), including the use of reserved names.</td>
<td>• “Identifier Format Control” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Specify Identifier Length to Avoid Naming Collisions” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Specify Reserved Names for Generated Identifiers” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Customize Generated Identifier Naming Rules” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Avoid Identifier Name Collisions with Referenced Models” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Control Name Mangling in Generated Identifiers” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Specify Boolean and Data Type Limit Identifiers” (Embedded Coder)</td>
</tr>
<tr>
<td>Requirement</td>
<td>More Information</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Control style aspects of code:</td>
<td>“Control Code Style” (Embedded Coder)</td>
</tr>
<tr>
<td>• Level of parenthesization</td>
<td></td>
</tr>
<tr>
<td>• Order of operations in expressions</td>
<td></td>
</tr>
<tr>
<td>• Empty primary condition expressions in if statements</td>
<td></td>
</tr>
<tr>
<td>• if-elseif-else or switch-case statements for decision logic</td>
<td></td>
</tr>
<tr>
<td>• Use of extern keyword in function declarations</td>
<td></td>
</tr>
<tr>
<td>• Use of static keyword in function declarations</td>
<td></td>
</tr>
<tr>
<td>• Use of default cases for switch-case statements</td>
<td></td>
</tr>
<tr>
<td>• Use multiplications by powers of two or signed bitwise shifts</td>
<td></td>
</tr>
<tr>
<td>• Cast expressions</td>
<td></td>
</tr>
<tr>
<td>• Indent style (Kernighan and Ritchie or Allman) and size</td>
<td></td>
</tr>
<tr>
<td>• Newline style</td>
<td></td>
</tr>
<tr>
<td>Placement of data definitions and declarations, including location of global identifiers and global data declarations (extern)</td>
<td>“Control Placement of Global Data Definitions and Declarations in Generated Files” (Embedded Coder)</td>
</tr>
<tr>
<td>Appearance of code for flow charts</td>
<td>“Enhance Readability of Code for Flow Charts” (Embedded Coder)</td>
</tr>
<tr>
<td>Requirement</td>
<td>More Information</td>
</tr>
<tr>
<td>----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Apply code templates to control organization of code and use of banners</td>
<td>• “Customize Code Organization and Format” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Template Symbols and Rules” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Specify Templates For Code Generation” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Generate Custom File and Function Banners” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Change the Organization of a Generated File” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Generate Source and Header Files with a Custom File Processing (CFP) Template” (Embedded Coder)</td>
</tr>
<tr>
<td></td>
<td>• “Customize Generated File Names” (Embedded Coder)</td>
</tr>
</tbody>
</table>

**See Also**

**More About**
- “Code Appearance” (Embedded Coder)
- “Choose an External Code Integration Workflow” (Embedded Coder)
Program Building, Interaction, and Debugging in Simulink Coder

- “Select C or C++ Programming Language” on page 27-2
- “Select and Configure C or C++ Compiler or IDE” on page 27-3
- “Troubleshoot Compiler Issues” on page 27-9
- “Choose Build Approach and Configure Build Process” on page 27-14
- “Template Makefiles and Make Options” on page 27-26
- “Build Models from a Windows Command Prompt Window” on page 27-41
- “Rebuild a Model” on page 27-44
- “Control Regeneration of Top Model Code” on page 27-46
- “Reduce Build Time for Referenced Models” on page 27-48
- “Relocate Code to Another Development Environment” on page 27-60
- “Compile and Debug Generated C Code with Microsoft® Visual Studio®” on page 27-72
- “Executable Program Generation” on page 27-74
- “Profile Code Performance” on page 27-77
Select C or C++ Programming Language

The default programming language selection for code generation is C language. In the code generation workflow, after the steps in “Select a Solver That Supports Code Generation” on page 19-2 and “Select a System Target File from STF Browser” on page 19-3, an optional step is to change the programming language selection for code generation.

To change the programming language setting:

1. From Configuration Parameters > Code Generation > Language, select C or C++ for the code generation language. Alternatively, set the TargetLang parameter at the command line.

   The code generator produces .c or .cpp files, depending on your selection, and places the generated files in your build folder.

   For more information, see “Language”.

2. Check whether you must choose and configure a compiler. If you select C++, you must choose and configure a compiler. For details, see “Select and Configure C or C++ Compiler or IDE” on page 27-3.


   For more information, see “Standard math library”.

See Also

More About

• “Select and Configure C or C++ Compiler or IDE” on page 27-3
• “Troubleshoot Compiler Issues” on page 27-9
Select and Configure C or C++ Compiler or IDE

The build process requires a supported compiler. Compiler, in this context, refers to a development environment (IDE) containing a linker and make utility, and a high-level language compiler. For details on supported compiler versions, see:

https://www.mathworks.com/support/compilers/current_release

When creating an executable program, the build process must be able to access a supported compiler. The build process can find a compiler to use based on your default MEX compiler.

The build process also requires the selection of a toolchain or template makefile. The toolchain or template makefile determines which compiler runs, during the make phase of the build. For more information, see “Choose Build Approach and Configure Build Process” on page 27-14

To determine which templates makefiles are available for your compiler and system target file, see “Compare System Target File Support Across Products” on page 19-21.

For both generated files and user-supplied files, the file extension, .c or .cpp, determines whether the build process uses a C or a C++ compiler. If the file extension is .c, the build process uses C compiler to compile the file, and the symbols use the C linkage convention. If the file extension is .cpp, the build process uses a C++ compiler to compile the file, and the symbols use the C++ linkage specification.

Language Standards Compliance

The code generator produces code that is compliant with the following standards:

<table>
<thead>
<tr>
<th>Language</th>
<th>Supported Standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>ISO/IEC 9899:1990, also known as C89/C90</td>
</tr>
<tr>
<td>C++</td>
<td>ISO/IEC 14882:2003</td>
</tr>
</tbody>
</table>

Code that the code generator produces from these sources is ANSI C/C++ compliant:

- Simulink built-in block algorithmic code
- Generated system-level code (task ID [TID] checks, management, functions, and so on)
- Code from other blocksets, including the Fixed-Point Designer product and the Communications Toolbox product
• Code from other code generators, such as MATLAB functions

Also, the code generator can incorporate code from:

• Embedded system target files (for example, startup code, device driver blocks)
• Custom S-functions or TLC files

**Note** Coding standards for these two sources are beyond the control of the code generator. These standards can be a source for compliance problems, such as code that uses C99 features not supported in the ANSI C, C89/C90 subset.

### Programming Language Considerations

The code generator produces C and C++ code. Consider the following as you choose a programming language:

• Does your project require you to configure the code generator to use a specific compiler? C/C++ code generation on Windows requires this selection.
• Does your project require you to change the default language configuration setting for the model? See “Select C or C++ Programming Language” on page 27-2.
• Does your project require you to integrate legacy or custom code with generated code? For a summary of integration options, see “What Is External Code Integration?” (Embedded Coder).
• Does your project require you to integrate C and C++ code? If so, see “What Is External Code Integration?” (Embedded Coder).

**Note** You can mix C and C++ code when integrating generated code with custom code. However, you must be aware of the differences between C and default C++ linkage conventions, and add the extern "C" linkage specifier where required. For the details of the differing linkage conventions and how to apply extern "C", refer to a C++ programming language reference book.

• Does your project require code generation support from other products? See “C++ Language Support Limitations” on page 27-5.

For C++ code generation examples with Stateflow, see the `sfcndemo_cppcount` model or `sf_cpp` model.
C++ Language Support Limitations

To use C++ language support, you could need to configure the code generator to use a specific compiler. For example, if a supported compiler is not installed on your Microsoft Windows computer, the default compiler is the lcc C compiler shipped with the MATLAB product. This compiler does not support C++. If you do not configure the code generator to use a C++ compiler before you specify C++ for code generation, the software produces an error message.

Code generator limitations on C++ support include:

• The code generator does not support C++ code generation for the following:
  Simscape Driveline
  Simscape Multibody First Generation (Simscape Multibody Second Generation is supported)
  Simscape Electrical Power Systems
  Simulink Real-Time

• For ERT and ERT-based system target files with Configuration Parameters > Data Placement > Interface > Code interface packaging set to Nonreusable function, the following fields currently do not accept the .cpp extension. If you specify a file name with a .c extension or without an extension and specify C++ for the code generation language, the code generator produces a .cpp file.

• Configuration Parameters > Code Placement > Data definition filename field (available when Configuration Parameters > Code Placement > Data definition is set to Data defined in a single separate source file)

• Definition file field for a data object in Model Explorer. Data objects are objects of the class Simulink.Signal, Simulink.Parameter, and subclasses.

Code Generator Assumes Wrap on Signed Integer Overflows

The code generator reduces memory usage and enhances generated code execution by assuming signed integer C operations wrap on overflow. A signed integer overflow occurs when the result of an arithmetic operation is outside the range of values that the output data type can represent. The C programming language does not define the results of such operations. Some C compilers aggressively optimize signed operations for in-range values at the expense of overflow conditions. Other compilers preserve the full wrap-on-overflow behavior. For example, the gcc and MinGW compilers provide an option to wrap on overflow reliably for signed integer overflows. The generated program image for a model
can produce results that differ from model simulation results because the handling of overflows varies, depending on your compiler.

When you generate code, if you use a supported compiler with the default options configured by the code generator, the compiler preserves the full wrap-on-overflow behavior. If you change the compiler options or compile the code in another development environment, it is possible that the compiler does not preserve the full wrap-on-overflow behavior. In this case, the executable program can produce unpredictable results.

If this issue is a concern for your application, consider one or more of the following actions:

• Verify that the compiled code produces expected results.
• If your compiler can force wrapping behavior, turn it on. For example, for the gcc compiler or a compiler based on gcc, such as MinGW, configure the build process to use the compiler option `-fwrapv`.
• Choose a compiler that wraps on integer overflow.
• If you have Embedded Coder installed, develop and apply a custom code replacement library to replace code generated for signed integers. For more information, see “Code Replacement Customization” (Embedded Coder).

Choose and Configure Compiler

The compiler for your model build appears in the build process parameters in Configuration Parameters > Code Generation. To view the installed compilers and select the default compiler, in the Command Window type:

```
mex -setup
```

On a Windows computer, you can install supported compilers and select a default compiler.

On a UNIX platform, the default compiler is GNU gcc/g++ for GNU or Xcode for Mac.

Unless the build approach configuration selects a specific compiler, the code generator uses the default compiler for the build process.

Primarily, the specified system target file determines the compiler that the code generator requires:
• If you select a toolchain-based system target file such as grt.tlc (Generic Real-Time Target), ert.tlc (Embedded Coder), or autosar.tlc (Embedded Coder for AUTOSAR), the **Build process** subpane displays toolchain parameters for configuring the build process. Use the **Toolchain** parameter to select a compiler and associated tools for your model build. To validate the selected toolchain, click the **Validate** button for the **Configuration Parameters > Code Generation > Build process > Toolchain settings** box.

• If you select a template makefile (TMF) based system target file, such as rsim.tlc, the **Build process** subpane displays template makefile parameters for configuring the build process. The **Template makefile** parameter displays the default TMF file for the selected system target file. If the system target file supports compiler-specific template makefiles (for example, Rapid Simulation or S-Function system target files), you can set **Template makefile** to a compiler-specific TMF, such as rsim_lcc.tmf or rsim_unix.tmf. (See “Compare System Target File Support Across Products” on page 19-21 for valid TMF names.)

### Include S-Function Source Code

When the code generator builds models with S-functions, source code for the S-functions can be either in the current folder or in the same folder as their MEX-file. The code generator adds an include path to the generated makefiles whenever it finds a file named `sfncname.h` in the same folder as the S-function MEX-file. This folder must be on the MATLAB path.

Similarly, the code generator adds a rule for the folder when it finds a file `sfncname.c` (or `.cpp`) in the same folder as the S-function MEX-file is in.

### See Also

#### More About

- “Run-Time Environment Configuration”
- “Compare System Target File Support Across Products” on page 19-21
- “Select C or C++ Programming Language” on page 27-2
- “Troubleshoot Compiler Issues” on page 27-9
External Websites

- https://www.mathworks.com/support/compilers/current_release
Troubleshoot Compiler Issues

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Compiler Version Mismatch Errors” on page 27-9</td>
</tr>
<tr>
<td>“Results for Model Simulation and Program Execution Differ” on page 27-9</td>
</tr>
<tr>
<td>“Generates Expected Code and Produces Unexpected Results” on page 27-10</td>
</tr>
<tr>
<td>“Compile-Time Issues” on page 27-11</td>
</tr>
<tr>
<td>“LCC Compiler Does Not Support Ampersands in Source Folder Paths” on page 27-12</td>
</tr>
<tr>
<td>“LCC Compiler Might Not Support Line Lengths of Rapid Accelerator Code” on page 27-13</td>
</tr>
</tbody>
</table>

Compiler Version Mismatch Errors

Description

The build process produces a compiler version mismatch error.

Action

1. Check the list of supported and compatible compilers available at www.mathworks.com/support/compilers/current_release/.
2. Upgrade or change your compiler. For more information, see “Choose and Configure Compiler” on page 27-6.
3. Rebuild the model.

Results for Model Simulation and Program Execution Differ

Description

The program generated for the model produces different results from model simulation results. The generated source code includes an arithmetic operation that produces a signed integer overflow. It is possible that your compiler does not implement wrapping behavior for signed integer overflow conditions. Or, if you are using a compiler that supports wrapping, it is possible that you did not configure it to use the -fwrapv option.

For more information, see “Code Generator Relies on Undefined Behavior of C Language for Integer Overflows.”
Action

- If your compiler can force wrapping behavior, turn it on. For example, for the gcc compiler or a compiler based on gcc, such as MinGW, specify the compiler option `-fwrapv`.
- Choose a compiler that checks for integer overflows.
- If you have Embedded Coder, develop and apply a code replacement library to replace code generated for signed integers.

Generates Expected Code and Produces Unexpected Results

Description

The build process generates expected source code, but the executable program produces unexpected results. The generated source code appears as expected. However, the executable program produces unexpected results.

Action

Do one of the following:

- Lower the compiler optimization level.
  1. Select Custom for the Model Configuration parameter **Code Generation** > **Compiler optimization level**.
  2. In the **Custom compiler optimization flags** field, specify a lower optimization level.
  3. Rebuild the model.
- Disable compiler optimizations.
  1. Select **Optimizations off (faster builds)** for the Model Configuration parameter **Code Generation** > **Compiler optimization level**.
  2. Rebuild the model.

For more information, see “Control Compiler Optimizations” on page 33-6 and your compiler documentation.
## Compile-Time Issues

<table>
<thead>
<tr>
<th>Issue</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error is present in the compiler configuration.</td>
<td>Make sure that MATLAB supports the compiler and version that you want to use. For a list of currently supported and compatible compilers, see <a href="http://www.mathworks.com/support/compilers/current_release/">www.mathworks.com/support/compilers/current_release/</a>. If necessary, upgrade or change your compiler (see “Choose and Configure Compiler” on page 27-6 or “Choose and Configure Compiler” on page 27-6).</td>
</tr>
<tr>
<td>Environment variables are incorrectly set up for your make utility,</td>
<td>Review the environment variable settings for your system by using the set command on a Windows platform or setenv on a UNIX platform. Make sure that the settings match what is required for the tools you are using.</td>
</tr>
<tr>
<td>compiler, or linker. For example, installation of Cygwin tools on a</td>
<td></td>
</tr>
<tr>
<td>Windows platform affects environment variables used by other compilers.</td>
<td></td>
</tr>
<tr>
<td>Error is present in custom code specified as an S-function block or</td>
<td>To isolate the source of the problem, remove the custom code from the model, debug, and rebuild the model.</td>
</tr>
<tr>
<td>in Configuration Parameters &gt; Code Generation &gt; Custom Code. For</td>
<td></td>
</tr>
<tr>
<td>example, the code refers to a header file that the compiler cannot</td>
<td></td>
</tr>
<tr>
<td>find.</td>
<td></td>
</tr>
<tr>
<td>The model includes a block, such as a device driver block, which is</td>
<td>Remove the system target file-specific block or configure the model for use with another system target file.</td>
</tr>
<tr>
<td>not intended for use with the currently selected system target file.</td>
<td></td>
</tr>
<tr>
<td><strong>Issue</strong></td>
<td><strong>Action</strong></td>
</tr>
<tr>
<td>-----------</td>
<td>-----------</td>
</tr>
</tbody>
</table>
| A linker error about an undefined reference to the data appears when the model build generates an executable from the model reference hierarchy and all these conditions are true:  
  - You represent signal, state, or parameter data by creating a data object such as `Simulink.Signal`. You use the object in a model reference hierarchy.  
  - You use a custom storage class with the data object. Custom storage classes require Embedded Coder.  
  - You set the owner of the object to a model that does not directly access the data.  
  - You use the toolchain `lcc-win64`. | To resolve the issue, choose one of these methods:  
  - In the data object, clear the `Owner` property. Alternatively, set the owner to a model that directly accesses the data.  
  - Use a different toolchain, such as `gcc`, instead of `lcc`. |

**LCC Compiler Does Not Support Ampersands in Source Folder Paths**

**Description**

If you use the LCC compiler and your model folder path contains an ampersand (&), the build process produces an error.

**Action**

Remove the ampersand from the model folder path. Then, rebuild the model.
LCC Compiler Might Not Support Line Lengths of Rapid Accelerator Code

Description

If you are compiling Rapid Accelerator code, the LCC compiler might produce an error related to line limits. Rapid Accelerator code can have longer line lengths due to obfuscation.

Action

Compile your Rapid Accelerator code using a compiler that supports longer code lines.

See Also

More About

- “Choose and Configure Compiler” on page 27-6
- “Select C or C++ Programming Language” on page 27-2
- “Troubleshoot Compiler Issues” on page 27-9
- “Choose Build Approach and Configure Build Process” on page 27-14
- “Rebuild a Model” on page 27-44
- “Reduce Build Time for Referenced Models” on page 27-48
- “Control Regeneration of Top Model Code” on page 27-46
- “Relocate Code to Another Development Environment” on page 27-60
- “Profile Code Performance” on page 27-77
- “Control Compiler Optimizations” on page 33-6
- “Select and Configure C or C++ Compiler or IDE” on page 27-3
- “Executable Program Generation” on page 27-74

External Websites

- www.mathworks.com/support/compilers/current_release/
Choose Build Approach and Configure Build Process

The code generator supports these approaches for building (compiling and linking) code that you generate from Simulink models:

- **Toolchain** — A build process that generates makefiles and supports custom toolchains. This approach:
  - Provides control of your build process with toolchain information objects. You can define these objects using MATLAB scripts.
  - Supports model referencing, SIL, and PIL.
  - Supports Simulink Coder, Embedded Coder, and MATLAB Coder.

- **Template makefile** — A build process that uses a template makefile with a toolchain that you specify. This approach:
  - Optionally uses a toolchain information object.
  - Supports model referencing, SIL, and PIL.
  - Supports Simulink Coder and Embedded Coder.

The “System target file” parameter, located in the **Configuration Parameters > Code Generation** pane, lets you select the build process for a model. When you set the **System target file** to:

- `ert.tlc`, `ert_shrlib.tlc`, `grt.tlc`, or any toolchain-compliant system target file, the build process uses the toolchain approach on page 27-14 by default.
- Any non-toolchain-compliant system target file, the build process uses the template makefile approach (Embedded Coder).

You can switch from the toolchain approach to the template makefile approach with this command:

```
set_param(model, 'MakeCommand', 'make_rtw TMF=1')
```

**Toolchain Approach**

**Toolchain settings** appear under **Build process** when you set **System target file** to:

- `grt.tlc` — Generic Real-Time Target
• ert.tlc — Embedded Coder (requires the Embedded Coder product)
• ert_shrlib.tlc — Embedded Coder (host-based shared library target) (requires Embedded Coder)
• Any toolchain-compliant system target file (If ERT-based, requires Embedded Coder)

For more information about toolchain-compliant system target files, see “Support Toolchain Approach with Custom Target” on page 39-82.

The **Toolchain settings** include:

- The “Toolchain” parameter specifies the collection of third-party software tools that builds the generated code. A toolchain can include a compiler, linker, archiver, and
other prebuild or postbuild tools that download and run the executable on the target hardware.

The default value of **Toolchain** is **Automatically locate an installed toolchain**. The **Toolchain** parameter displays name of the located toolchain just below **Automatically locate an installed toolchain**.

Click the **Validate** button for the **Configuration Parameters > Code Generation > Build process > Toolchain settings** parameter to check that the toolchain is present and validate that the code generator has the information required to use the toolchain. The resulting Validation Report gives a pass/fail for the selected toolchain, and identifies issues to resolve.

- The “Build configuration” parameter lets you choose or customize the optimization settings. By default, **Build Configuration** is set to **Faster Builds**. You can also select **Faster Runs**, **Debug**, and **Specify**. When you select **Specify** and click **Apply**, you can customize the toolchain options for each toolchain. These custom toolchain settings only apply to the current model.

**Note**  
The following system target files, which use the template makefile approach, have the same names but different descriptions from system target files that use the toolchain approach:

- **ert.tlc** – Create Visual C/C++ Solution File for Embedded Coder
- **grt.tlc** – Create Visual C/C++ Solution File for Simulink Coder

To avoid confusion, click **Browse** to select the system target file and look at the description of each file.

**Upgrade Model to Use Toolchain Approach**

When you open a model created before R2013b that uses the following system target files, the software tries to upgrade the model. The upgrade changes the configuration from using template makefile settings to using the toolchain settings:

- **ert.tlc** – Embedded Coder
- **ert_shrlib.tlc** – Embedded Coder (host-based shared library target)
- **grt.tlc** – Generic Real-Time Target
**Note** To upgrade models using a custom system target file to use the toolchain approach, see “Support Toolchain Approach with Custom Target” on page 39-82.

Some model configuration parameter values prevent the software from upgrading a model to use toolchain settings. The following instructions show you ways to complete the upgrade process.

Consider upgrading your models and use the toolchain build approach. Doing so is not required. You can continue generating code from a model that has not been upgraded.

**Note** The software does not upgrade models that use the following system target files:

- ert.tlc — Create Visual C/C++ Solution File for Embedded Coder
- grt.tlc — Create Visual C/C++ Solution File for Simulink Coder

To see if a model was upgraded:

1. Open the model configuration parameters by pressing Ctrl+E.
2. Select **Configuration Parameters > Code Generation**.
3. If the **Build process** subpane contains the **Toolchain** and **Build configuration** parameters, the model has already been upgraded.
If the **Build process** area displays **Makefile configuration** parameters, such as **Generate makefile**, **Make command**, and **Template makefile**, the software has not upgraded the model.

Start by creating a working copy of the model using **File > Save As**. This action preserves the original model and configuration parameters for reference.

Try to upgrade the model using Upgrade Advisor:

1. In your model, select **Analysis > Model Advisor > Upgrade Advisor**.
2. In Upgrade Advisor, select **Check and update model to use toolchain approach to build generated code** and click **Run This Check**.
3  Perform the suggested actions and/or click **Update Model**.

When you cannot upgrade the model using Upgrade Advisor, one or more of the following parameters is not set to its default value, shown here:

- **Compiler optimization level** — Optimizations off (faster builds)
- **Generate makefile** — Enabled
- **Template makefile** — System target file-specific template makefile
- **Make command** — make_rtw without arguments

Sometimes, a model cannot be upgraded. Try the following procedure:

- If **Generate makefile** is disabled, this case cannot be upgradable. However, you can try enabling it and try upgrading the model using Upgrade Advisor.
- If **Compiler optimization level** is set to **Optimizations on (faster runs)**:
  1. Set **Compiler optimization level** is to **Optimizations off (faster builds)**.
  2. Upgrade the model using Upgrade Advisor.
  3. Set **Build configuration** to Faster Runs.
- If **Compiler optimization level** is set to Custom:
  1. Copy the **Custom compiler optimization flags** to a text file.
  2. Set **Compiler optimization level** to **Optimizations off (faster builds)**.
  3. Upgrade the model using Upgrade Advisor.
  4. Set **Build configuration** to **Specify**.
  5. To perform the same optimizations, edit the compiler options.
- If **Template makefile** uses a customized template makefile, this case cannot be upgradable. However, you can try the following:
  1. Update **Template makefile** to use the default makefile for the system target file.

**Note**  To get the default makefile name, change the **System target file**, click **Apply**, change it back, and click **Apply** again.

2  Upgrade the model using Upgrade Advisor.

3  If the template makefile contains build tool options, such as compiler optimization flags, set **Build configuration** to Specify and update the options.
4 If the template makefile uses custom build tools, create and register a custom toolchain, as described in “Custom Toolchain Registration” (MATLAB Coder). Then, set the Toolchain parameter to use the custom toolchain.

**Note** After registering the custom toolchain, update Toolchain to use the custom toolchain.

5 If the template makefile contains custom rules and logic, these customizations cannot be applied to the upgraded model.

**Template Makefile Approach**

When the System target file is set to a tlC file that uses the template makefile approach, the software displays Compiler optimization level, Generate makefile, Make command, and Template makefile parameters.
Specify Whether to Generate a Makefile

The Generate makefile option specifies whether the build process is to generate a makefile for a model. By default, the build process generates a makefile. Suppress generation of a makefile, for example in support of custom build processing that is not based on makefiles, by clearing Generate makefile. When you clear this parameter:

- The Make command and Template makefile options are unavailable.
- Set up post code generation build processing using a user-defined command, as explained in “Customize Post-Code-Generation Build Processing” on page 37-14.
Specify a Make Command

Each template makefile-based system target file has an associated make command. The code generator uses this internal MATLAB command to control the build process. The command appears in the Make command field and runs when you start a build.

Most system target files use the default command, make_rtw. Third-party system target files could supply another make command. See the documentation from the vendor.

In addition to the name of the make command, you can supply makefile options in the Make command field. These options could include compiler-specific options, include paths, and other parameters. When the build process invokes the make utility, these options are passed on the make command line, which adds them to the overall flags passed to the compiler.

“Template Makefiles and Make Options” on page 27-26 lists the Make command options you can use with each supported compiler.

Specify the Template Makefile

The Template makefile field has these functions:

- If you selected a system target file with the System Target File Browser, this field displays the name of a MATLAB language file that selects a template makefile for your development environment. For example, in “Model Configuration Parameters: Code Generation”, the Template makefile field displays grt_default_tmf, indicating that the build process invokes grt_default_tmf.m.

  “Template Makefiles and Make Options” on page 27-26 gives a detailed description of the logic by which the build process selects a template makefile.

- Alternatively, you can explicitly enter the name of a specific template makefile (including the extension) or a MATLAB language file that returns a template makefile in this field. Use this approach if you are using a system target file that does not appear in the System Target File Browser. For example, use this approach if you have written your own template makefile for a custom system target file.

If you specify your own template makefile, be sure to include the file name extension. If you omit the extension, the build process attempts to find and execute a file with the extension .m (that is, a MATLAB language file). The template make file (or a MATLAB language file that returns a template make file) must be on the MATLAB path. To determine whether the file is on the MATLAB path, enter the following command in the MATLAB Command Window:
which \texttt{tmf_filename}

**Associate the Template Makefile with a Toolchain**

Specify a toolchain for the template makefile build process. This example provides a definition for a minimal toolchain and shows how you can associate the toolchain with a template makefile that is a copy of \texttt{ert_unix.tmf} or \texttt{ert_vcx64.tmf}.

Use this code for the toolchain definition file.

```matlab
function tc = minimalToolchainForTMF
    % Create a toolchain object
    tc = coder.make.ToolchainInfo('Name', 'Minimal Toolchain for TMF Build');

    % Specify that the linker requires a response file instead of
    % including all object file modules on the linker command line
    tc.addAttribute('RequiresCommandFile', true);

    if ispc
        objExt = '.obj';
    else
        objExt = '.o';
    end

    % Specify source file and object file extension used by the C compiler
    tool = tc.getBuildTool('C Compiler');
    tool.setFileExtension('Source', '.c');
    tool.setFileExtension('Header', '.h');
    tool.setFileExtension('Object', objExt);

    % Specify source file and object file extension used by the C++ compiler
    tool = tc.getBuildTool('C++ Compiler');
    tool.setFileExtension('Source', '.cpp');
    tool.setFileExtension('Header', '.hpp');
    tool.setFileExtension('Object', objExt);

    % Specify source file and object file extension used by the C++ compiler
    tool = tc.getBuildTool('C++ Compiler');
    tool.setFileExtension('Source', '.cpp');
    tool.setFileExtension('Header', '.hpp');
    tool.setFileExtension('Object', objExt);

    Use a copy of \texttt{ert_unix.tmf} or \texttt{ert_vcx64.tmf} as the template makefile.

    copyfile(fullfile(matlabroot,'rtw','c','ert','ert_vcx64.tmf'), 'ert_copy.tmf')

    In the template makefile, i.e. \texttt{ert_copy.tmf}, edit the \texttt{TOOLCHAIN_NAME} macro.

    \texttt{TOOLCHAIN\_NAME = "Minimal Toolchain for TMF Build"}

    Associate the toolchain with the template make file.
```
1 Run the toolchain definition file, which generates a ToolchainInfo object, tc.

   \[ \text{tc} = \text{minimalToolchainForTMF}; \]

2 Save the ToolchainInfo object to a MAT file.

   \[ \text{save('tcMinimal','tc')} \]

3 Register the toolchain in RTW.TargetRegistry.

   a Place this code in an rtwTargetInfo.m file.

     \[
     \text{function rtwTargetInfo(tr)}
     \text{tr.registerTargetInfo(@loc_createToolchain);} \]

     \[
     \text{function config = loc_createToolchain}
     \text{config(1) = coder.make.ToolchainInfoRegistry;} \]

       \[
       \text{config(1).Name = 'Minimal Toolchain for TMF Build'}; \]

       \[
       \text{config(1).FileName = fullfile(fileparts(mfilename('fullpath')),...}
       \text{'tcMinimal.mat');} \]

       \[
       \text{config(1).TargetHWDeviceType = {'*'}}; \]

       \[
       \text{config(1).Platform = {computer('arch')}}; \]

   b Save the file in the current working folder or in a folder that is on the MATLAB
   search path.

   c Reset the TargetRegistry.

     \[ \text{RTW.TargetRegistry.getInstance('reset');} \]

Associate the template makefile with your model and build the model.

\[
\text{set_param(model, 'TemplateMakefile', 'ert_copy.tmf');}
\text{rtwbuild(model);} \]

### Specify TLC for Code Generation

Target Language Compiler (TLC) is an integral part of the code generator. It enables you to customize generated code. Through customization, you can produce platform-specific code, or you can incorporate your own algorithmic changes for performance, code size, or compatibility with existing methods that you prefer to maintain. For additional information, see “Target Language Compiler Overview”.
TLC options that you specify for code generation appear in the summary section of the generated HTML code generation report.

**Note** Specifying TLC command-line options does not add flags to the make command line.

You can specify Target Language Compiler (TLC) command-line options and arguments for code generation using the model parameter `TLCOptions` in a `set_param` function call. For example,

```matlab
>> set_param(gcs,'TLCOptions','-p0 -aWarnNonSaturatedBlocks=0')
```

Some common uses of TLC options include the following:

- `-aVarName=1` to declare a TLC variable and/or assign a value to it
- `-IC:\Work` to specify an include path
- `-v` to obtain verbose output from TLC processing (for example, when debugging)

**See Also**

**More About**

- “Support Toolchain Approach with Custom Target” on page 39-82
- “Custom Toolchain Registration” (MATLAB Coder)
- “Register Custom Toolchain and Build Executable” on page 37-31
- “Template Makefiles and Make Options” on page 27-26
- “Target Language Compiler Overview”
- “Executable Program Generation” on page 27-74
Template Makefiles and Make Options

The code generator includes a set of built-in template makefiles that build programs for specific system target files.

Types of Template Makefiles

There are two types of template makefiles:

- **Compiler-specific** template makefiles are for a particular compiler or development system.
  
  By convention, compiler-specific template makefiles names correspond to the system target file and compiler (or development system). For example, grt_vcx64.tmf is the template makefile for building a generic real-time program under the Visual C++ compiler; ert_lcc.tmf is the template makefile for building an Embedded Coder program under the lcc compiler.

- **Default** template makefiles make your model designs more portable, by choosing the compiler-specific makefile and compiler for your installation. “Select and Configure C or C++ Compiler or IDE” on page 27-3 describes the operation of default template makefiles in detail.

  Default template makefiles have names that follow the pattern target_default_tmf. They are MATLAB language files that, when run, select the TMF for the specified system target file configuration. For example, grt_default_tmf is the default template makefile for building a generic real-time program; ert_default_tmf is the default template makefile for building an Embedded Coder program.

For details on the structure of template makefiles, see “Customize Template Makefiles” on page 39-62. This section describes compiler-specific template makefiles and common options you can use with each.

Specify Template Makefile Options

You can specify template makefile options by using the Make command box in Configuration Parameters > Code Generation. Append the options after make_rtw (or other make command), as in the following example:

```
make_rtw OPTS="-DMYDEFINE=1"
```
The syntax for make command options differs slightly for different compilers.

**Note** To control compiler optimizations for a makefile build at the Simulink GUI level, use the Configuration Parameters > Code Generation > Build process > Compiler optimization level parameter. The Compiler optimization level parameter provides

- System target file-independent values Optimizations on (faster runs) and Optimizations off (faster builds), which easily allow you to toggle compiler optimizations on and off during code development
- The value Custom for entering custom compiler optimization flags at Simulink GUI level (rather than at other levels of the build process)

If you specify compiler options for your makefile build using OPT_OPTS, MEX_OPTS (except MEX_OPTS="-v"), or MEX_OPT_FILE, the value of Compiler optimization level is ignored and a warning is issued about the ignored parameter.

## Template Makefiles for UNIX Platforms

The template makefiles for UNIX platforms are for the Free Software Foundation's GNU Make. These makefiles conform to the guidelines specified in the IEEE®⁴ Std 1003.2-1992 (POSIX) standard.

- ert_unix.tmf
- grt_unix.tmf
- rsim_unix.tmf
- rtwsfcn_unix.tmf

You can supply options to makefiles using the Make command box in the Configuration Parameters > Code Generation pane. Options specified in Make command are passed to the command-line invocation of the make utility, which adds them to the overall flags passed to the compiler. The following options can be used to modify the behavior of the build:

- **OPTS** — User-specific options, for example,

  \[\text{OPTS}=-\text{DMYDEFINE}=1\]

---

⁴ IEEE is a registered trademark of The Institute of Electrical and Electronics Engineers, Inc.
• **OPT_OPTS**—Optimization options. Default is -O. To enable debugging, specify the option as **OPT_OPTS=-g**. Because of optimization problems in IBM_RS, the default is no optimization.

• **CPP_OPTS**—C++ compiler options.

• **USER_SRCS**—Additional user sources, such as files used by S-functions.

• **USER_INCLUDES**—Additional include paths, for example,

```
USER_INCLUDES="-Iwhere-ever -Iwhere-ever2"
```

• **DEBUG_BUILD**—Add debug information to generated code, for example,

```
DEBUG_BUILD=1
```

These options are also documented in the comments at the head of the respective template makefiles.

**Template Makefiles for the Microsoft Visual C++ Compiler**

• “Visual C++ Executable Build” on page 27-28

• “Visual C++ Code Generation Only” on page 27-29

**Visual C++ Executable Build**

To build an executable using the Visual C++ compiler within the build process, use one of the `target_vcx64.tmf` template makefiles:

• `ert_vcx64.tmf`

• `grt_vcx64.tmf`

• `rsim_vcx64.tmf`

• `rtwsfcn_vcx64.tmf`

You can supply options to makefiles using the **Make command** field in the
**Configuration Parameters > Code Generation** pane. Options specified in **Make command** are passed to the command-line invocation of the `make` utility, which adds them to the overall flags passed to the compiler. The following options can be used to modify the behavior of the build:

• **OPT_OPTS**—Optimization option. Default is -O2. To enable debugging, specify the option as **OPT_OPTS=-Zi**.
Template Makefiles and Make Options

- **OPTS** — User-specific options.
- **CPP_OPTS** — C++ compiler options.
- **USER_SRCS** — Additional user sources, such as files used by S-functions.
- **USER_INCLUDES** — Additional include paths, for example,
  
  `USER_INCLUDES="-Iwhere-ever -Iwhere-ever2"

- **DEBUG_BUILD** — Add debug information to generated code, for example,
  
  `DEBUG_BUILD=1`

These options are also documented in the comments at the head of the respective template makefiles.

**Visual C++ Code Generation Only**

To create a Visual C++ project makefile (*model.mak*) without building an executable, use one of the *target_msvc.tmf* template makefiles:

- `ert_msvc.tmf`
- `grt_msvc.tmf`

These template makefiles are for *nmake*, which is bundled with the Visual C++ compiler.

You can supply options to makefiles using the **Make command** field in the **Configuration Parameters > Code Generation** pane. Options specified in **Make command** are passed to the command-line invocation of the *make* utility, which adds them to the overall flags passed to the compiler. The following options can be used to modify the behavior of the build:

- **OPTS** — User-specific options, for example,
  
  `OPTS="/D MYDEFINE=1"

- **USER_SRCS** — Additional user sources, such as files used by S-functions.
- **USER_INCLUDES** — Additional include paths, for example,
  
  `USER_INCLUDES="-Iwhere-ever -Iwhere-ever2"

- **DEBUG_BUILD** — Add debug information to generated code, for example,
  
  `DEBUG_BUILD=1`
These options are also documented in the comments at the head of the respective template makefiles.

**Template Makefiles for the LCC Compiler**

The code generator provides template makefiles to create an executable for the Windows platform using Lcc compiler Version 2.4 and GNU Make (gmake).

- ert_lcc.tmf
- grt_lcc.tmf
- rsim_lcc.tmf
- rtwsfcn_lcc.tmf

You can supply options to makefiles using the **Make command** field in the **Configuration Parameters** > **Code Generation** pane. Options specified in Make command are passed to the command-line invocation of the make utility, which adds them to the overall flags passed to the compiler. The following options can be used to modify the behavior of the build:

- **OPTS** — User-specific options, for example,
  
  `OPTS="-DMYDEFINE=1"
  
  **OPTS_OPTS** — Optimization options. Default is no options. To enable debugging, specify -g4:
  
  `OPT_OPTS="-g4"
  
  **CPP_OPTS** — C++ compiler options.
  
  **USER_SRCS** — Additional user sources, such as files used by S-functions.
  
  **USER_INCLUDES** — Additional include paths. For example:
  
  `USER_INCLUDES="-Iwhere-ever -Iwhere-ever2"
  
  For lcc, use / as file separator before the file name instead of \, for example, d:\work\proj1/myfile.c.
  
  **DEBUG_BUILD** — Add debug information to generated code, for example,

  `DEBUG_BUILD=1`

These options are also documented in the comments at the head of the respective template makefiles.
See Also

More About

- “Configure a System Target File” on page 19-2
- “Customize System Target Files” on page 39-28
- “Associate the Template Makefile with a Toolchain” on page 27-23
Build Process Workflow for Real-Time Systems

The building process includes generating code in C or C++ from a model and building an executable program from the generated code. This example can use a generic real-time (GRT) or an embedded real-time (ERT) system target file (STF) for code generation. The resulting standalone program runs on your development computer, independent of external timing and events.

Working Folder

This example uses a local copy of the slexAircraftExample model, stored in its own folder, aircraftexample. Set up your working folder as follows:

1. In the MATLAB Current Folder browser, navigate to a folder to which you have write access.
2. To create the working folder, enter the following MATLAB command:
   
   \texttt{mkdir aircraftexample}
   
3. Make aircraftexample your working folder:
   
   \texttt{cd aircraftexample}
   
4. Open the slexAircraftExample model:
   
   \texttt{slexAircraftExample}
   
   The model appears in the Simulink Editor model window.
5. In the model window, choose \texttt{File} > \texttt{Save As}. Navigate to your working folder, aircraftexample. Save a copy of the slexAircraftExample model as myAircraftExample.

Build Folder and Code Generation Folders

While producing code, the code generator creates a build folder within your working folder. The build folder name is \texttt{model_target_rtw}, derived from the name of the source model and the chosen system target file. The build folder stores generated source code and other files created during the build process. Examine the build folder contents at the end of this example.

When a model contains Model blocks (references to other models), the model build creates special subfolders in your “Code generation folder” (Simulink) to organize code
for the referenced models. These code generation folders exist alongside product build folders and are named slprj. “Generate Code for Referenced Models” on page 7-4 describes navigating code generation folder structures in Model Explorer.

Under the slprj folder, a subfolder named _sharedutils contains generated code that can be shared between models.

**Set Model Parameters for Code Generation**

To generate code from your model, you must change some of the model configuration parameters. In particular, the generic real-time (GRT) system target file and most other system target files require that the model specifies a fixed-step solver.

**Note** The code generator produces code for models, using variable-step solvers, for rapid simulation (rsim) and S-function system target files only.

To set model configuration parameters by using the Configuration Parameters dialog box:

1. Open the myAircraftExample model if it is not already open.
2. From the model window, open the Configuration Parameters dialog box by selecting Simulation > Model Configuration Parameters.
3. Select Configuration Parameters > Solver. Enter the following parameter values (some could already be set):
   - **Start time**: 0.0
   - **Stop time**: 60
   - **Type**: Fixed-step
   - **Solver**: ode5 (Dormand-Prince)
   - **Fixed step size (fundamental sample time)**: 0.1
   - **Treat each discrete rate as a separate task**: Off
4. Click Apply.
5. Save the model. Simulation parameters persist with the model for use in future sessions.
Configure Build Process

To configure the build process for your model, choose a system target file, a toolchain or template makefile, and a make command.

In these examples and in most applications, you do not need to specify these parameters individually. The examples use the ready-to-run generic real-time target (GRT) configuration. The GRT system target file builds a standalone executable program that runs on your desktop computer.

To select the GRT system target file using the Configuration Parameters dialog box:

1. With the myAircraftExample model open, select Simulation > Model Configuration Parameters to open the Configuration Parameters dialog box.
2. Select Configuration Parameters > Code Generation.
3. For System target file, enter grt.tlc, and click Apply.

The Configuration Parameters > Code Generation pane displays selections for the System target file (grt.tlc), Toolchain (Automatically locate an installed toolchain), and Build Configuration (Faster Builds).
Note If you click Browse, a System Target File Browser opens and displays the system target files on the MATLAB path. Some system target files require additional products. For example, ert.tlc requires Embedded Coder.

4 Save the model.

Set Code Generation Parameters

With the myAircraftExample model open, select Simulation > Model Configuration Parameters:
1 Select **Code Generation > Report > Create code generation report**. This action enables the software to create and display a code generation report for the `myAircraftExample` model.

2 Use the default **Code Generation > Comments** settings.

3 The **Code Generation > Symbols** options control the look and feel of generated code. Use the default settings.

4 These **Code Generation > Advanced parameters** parameters control build verbosity and debugging:

   - **Verbose build** (RTWVerbose parameter)
   - **Retain .rtw file** (RetainRTWFile parameter)
   - **Profile TLC** (ProfileTLC parameter)
   - **Start TLC debugger when generating code** (TLCDebug parameter)
   - **Start TLC coverage when generating code** (TLCCoverage parameter)
   - **Enable TLC assertion** (TLCAssert parameter)

   Use the default settings.

5 Select **Code Generation > Interface**.

   - For the **Shared code placement** parameter, select **Shared location**. The build process places generated code for utilities in a subfolder within your “Code generation folder” (Simulink).
   - Clear the **Advanced parameters > Classic call interface** check box.

6 Click **Apply** and save the model.

**Build and Run a Program**

The build process generates C code from the model. It then compiles and links the generated program to create an executable image. To build and run the program:

1 With the `myAircraftExample` model open, initiate code generation and the build process for the model by using any of the following options:

   - Click the **Build Model** button.
   - Press **Ctrl+B**.
   - Select **Code > C/C++ Code > Build Model**.
• Invoke the `rtwbuild` command from the MATLAB command line.
• Invoke the `slbuild` command from the MATLAB command line.

Some messages concerning code generation and compilation appear in the Command Window. The initial message is:

```plaintext
### Starting build procedure for model: myAircraftExample
```

The contents of many of the succeeding messages depends on your compiler and operating system. The final messages include:

```plaintext
### Created executable myAircraftExample.exe
### Successful completion of build procedure for model: myAircraftExample
### Creating HTML report file myAircraftExamplecodegen_rpt.html
```

The code generation folder now contains an executable, `myAircraftExample.exe` (Microsoft Windows platforms) or `myAircraftExample` (UNIX platforms). In addition, the build process has created an `slprj` folder and a `myAircraftExample_grt_rtw` folder in your “Code generation folder” (Simulink).

**Note** After generating the code for the `myAircraftExample` model, the build process displays a code generation report. See “Report Generation” for more information about how to create and use a code generation report.

2 To see the contents of the working folder after the build, enter the `dir` or `ls` command:

```plaintext
>> dir
.
  myAircraftExample.slx           slprj
..      myAircraftExample.slx.autosave
myAircraftExample.exe           myAircraftExample_grt_rtw
```

3 To run the executable from the Command Window, type `!myAircraftExample`. The `!` character passes the command that follows it to the operating system, which runs the standalone `myAircraftExample` program.

```plaintext
>> !myAircraftExample
** starting the model **
** created myAircraftExample.mat **
```

4 To see the files created in the build folder, use the `dir` or `ls` command again. The exact list of files produced varies among MATLAB platforms and versions. Here is a sample list from a Windows platform:

```plaintext
>> dir myAircraftExample_grt_rtw
```
Contents of the Build Folder

The build process creates a build folder and names it `model_target_rtw`, where `model` is the name of the source model and `target` is the system target file selected for the model. In this example, the build folder is named `myAircraftExample_grt_rtw`.

The build folder includes the following generated files.

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>myAircraftExample.c</td>
<td>Standalone C code that implements the model</td>
</tr>
<tr>
<td>myAircraftExample.h</td>
<td>An include header file containing definitions of parameters and state variables</td>
</tr>
<tr>
<td>myAircraftExample_private.h</td>
<td>Header file containing common include definitions</td>
</tr>
<tr>
<td>myAircraftExample_types.h</td>
<td>Forward declarations of data types used in the code</td>
</tr>
<tr>
<td>rtmodel.h</td>
<td>Master header file for including generated code in the static main program (its name does not change, and it simply includes myAircraftExample.h)</td>
</tr>
</tbody>
</table>

The code generation report that you created for the `myAircraftExample` model displays a link for each of these files. You can click the link explore the file contents.

The build folder contains other files used in the build process. They include:

- `myAircraftExample.mk` — Makefile for building executable using the specified Toolchain.
- Object (.obj) files
- `myAircraftExample.bat` — Batch control file
- `rtw_proj.tmw` — Marker file
- `buildInfo.mat` — Build information for relocating generated code to another development environment
- `defines.txt` — Preprocessor definitions required for compiling the generated code
- `myAircraftExample_ref.rsp` — Data to include as command-line arguments to `mex` (Windows systems only)

The build folder also contains a subfolder, `html`, which contains the files that make up the code generation report. For more information, see “Reports for Code Generation” on page 22-2.

**Customized Makefile Generation**

After producing code, the code generator produces a customized makefile, `model.mk`. The generated makefile instructs the `make` system utility to compile and link source code generated from the model, any required harness program, libraries, or user-provided modules. The code generator produces the file `model.mk` regardless of the approach that you use for build process control:

- If you use the toolchain approach, the code generator creates `model.mk` based on the model **Toolchain settings**. You can modify generation of the makefile through the `rtwmakecfg.m` API.
- If you use the template makefile approach, the code generator creates `model.mk` from a system template file, `system.tmf` (where `system` stands for the selected system target file name). The system template makefile is designed for your system target file. You can modify the template makefile to specify compilers, compiler options, and additional information for the creation of the executable.

For more information, see “Choose Build Approach and Configure Build Process” on page 27-14.

**See Also**

**More About**

- “Choose Build Approach and Configure Build Process” on page 27-14
- “Manage Build Process Folders” on page 21-37
• “Reports for Code Generation” on page 22-2
• “Select and Configure C or C++ Compiler or IDE” on page 27-3
Build Models from a Windows Command Prompt Window

This example shows how to build models by using a batch file, entering commands at the Command Prompt in Windows.

About MATLAB Command-Line (Start Up) Arguments

When you start MATLAB from a Command Prompt in Windows (as done in a batch file), you can control MATLAB start up with a number of command-line arguments.

For a description of these command-line arguments, in the Command Prompt window, type `matlab -help`.

To start MATLAB from a Command Prompt window, use these steps:

1. From the Windows Start menu, open a Command Prompt window.
2. Change folders to `$MATLABROOT\bin`. `$MATLABROOT` is the MATLAB root folder.
3. In the Command Prompt window, type: `matlab`

**Tip:** To display the path to the MATLAB root folder, at the MATLAB command prompt type: `matlabroot`.

Run MATLAB with a Batch File

When you run MATLAB with a batch file, you can:

- Control MATLAB start up with command-line arguments
- Run a series of operating system commands (such as source control checkout/commit)
- Run a series of MATLAB scripts

A batch approach also lets you automate your overall build process. Such a process can generate code from one or more Simulink models, then use your makefile to compile custom code and generated code.

This batch file sets the `MATLABROOT` environment variable, sets the PATH environment variable to include `MATLABROOT`, and starts MATLAB with an input script argument `%1` and a logfile argument.

**Note:** Customize the `MATLABROOT` value in the batch file to match your system. The batch file assumes that a `c:\temp` folder exists on your system.
Create a batch file named mat.bat

SET MATLABROOT="C:\Program Files\MATLAB\R2015b"
PATH=%MATLABROOT%;%PATH%
START matlab.exe -r %1 -logfile c:\temp\logfile
PAUSE

Create a MATLAB script myFilesToBuild.m

my_rtwdemo_counter_builder
my_rtwdemo_rtwintro_builder
exit

Create a MATLAB script my_rtwdemo_counter_builder.m

open_system('rtwdemo_counter');
save_system('rtwdemo_counter','my_rtwdemo_counter')
rtwbuild('my_rtwdemo_counter');
close_system('my_rtwdemo_counter');

Create a MATLAB script my_rtwdemo_rtwintro_builder.m

open_system('rtwdemo_rtwintro');
save_system('rtwdemo_rtwintro','my_rtwdemo_rtwintro')
rtwbuild('my_rtwdemo_rtwintro');
close_system('my_rtwdemo_rtwintro');

Run the batch file

From the Windows Start menu, open a Command Prompt window, change folders to the folder containing the batch file, and type:

mat myFilesToBuild

When you run the batch file with the input MATLAB script, the batch file runs MATLAB and loads, builds, and closes each of the example Simulink models.

Observe the log of MATLAB operations

After the batch file runs, view the c:\temp\logfile file.

Tip: Omitting the semicolon (;) from the rtwbuild line in each script provides more build information in the log file.
Optimize Your Batch File

Use the MATLAB command-line arguments to optimize the batch file. Some options to consider include:

• Suppress the MATLAB splash screen on startup with the -nosplash argument.
• Suppress the MATLAB window when running with the -nodesktop -minimize arguments.
• Provide command-line input to the input script or function selected with the -r argument.

For example, you can call a function myfile.m, which accepts two arguments:

matlab -r myfile(arg1,arg2)

To pass numeric values into myfile.m, replace arg1 and arg2 with numeric values.

To pass string or character values into myfile.m, replace arg1 and arg2 with the string or character values surrounded in single quotes. For example, to pass the string values hello and world into myfile.m, in the Command Prompt window, type:

matlab -r myfile('hello','world')

See Also

More About

• “Compile and Debug Generated C Code with Microsoft® Visual Studio®” on page 27-72
Rebuild a Model

If you update generated source code or makefiles manually to add customizations, you can rebuild the files with the `rtwrebuild` command. This command recompiles the modified files by invoking the generated makefile. Alternatively, you can use this command from the Model Explorer:

1. Open the top model. To open the Model Explorer window, select **View > Model Explorer**.
2. In the **Model Hierarchy** pane, expand the node for the model.
3. Click the **Code for model** node.
4. In the **Code** pane, next to **Code Recompile Command**, click **rebuild generated code**.
See Also

More About

- rtwrebuild
Control Regeneration of Top Model Code

When you rebuild a model, by default, the build process performs checks to determine whether changes to the model or relevant settings require regeneration of the top model code. The model build regenerates top model code if any of the following conditions is true:

• The structural checksum of the model has changed.
• The top-model-only checksum has changed. The top-model-only checksum provides information about top model parameters, such as application lifespan, maximum stack size, make command, verbose and .rtw file debug settings, and TLCOptions.
• Any of the following TLC debugging model options, on the Configuration Parameters > Code Generation > Advanced parameters tab, is on:
  • Start TLC debugger when generating code (TLCDebug)
  • Start TLC coverage when generating code (TLCCoverage)
  • Enable TLC assertion (TLCAssert)
  • Profile TLC (ProfileTLC)

Whether the top model code is regenerated, the build process calls the build process hooks and reruns the makefile. The hooks include the STF_make_rtw_hook functions and the post code generation command. This process recompiles and links the external dependencies.

System target file authors can perform actions related to code regeneration in the STF_make_rtw_hook functions that the build process calls. These actions include forcing or reacting to code regeneration. For more information, see “Control Code Regeneration Using STF_make_rtw_hook.m” on page 37-53.

Regeneration of Top Model Code

If the checks determine that top model code generation is required, the build process fully regenerates and compiles the model code. An example check is whether previously generated code is not current due to a model update.

The build process omits regeneration of the top model code when the checks indicate both:
• The top model generated code is current for the model.

• No model settings require full regeneration,

This omission can significantly reduce model build times.

With an Embedded Coder license, if you modify a code generation template (CGT) file then rebuild your model, the code generation process does not force a top model build. In this case, see “Force Regeneration of Top Model Code” on page 27-47.

**Force Regeneration of Top Model Code**

If you want to control or override the default top model build behavior, use one of the following command-line options:

• To ignore the checksum and force regeneration of the top model code:

  • `rtwbuild(model,'ForceTopModelBuild',true)`
  • `slbuild(model,'StandaloneRTWTarget','ForceTopModelBuild',true)`

• To clean the model build area enough to trigger regeneration of the top model code at the next build (`slbuild` only):
  ```
  slbuild(model,'CleanTopModel')
  ```

You can force regeneration of the top model code by deleting the `slprj` folder or the generated model code folder from the “Code generation folder” (Simulink).

**See Also**

**More About**

• `rtwrebuild`

• “Control Code Regeneration Using STF_make_rtw_hook.m” on page 37-53

• “Choose Build Approach and Configure Build Process” on page 27-14

• “Rebuild a Model” on page 27-44

• “Reduce Build Time for Referenced Models” on page 27-48
Reduce Build Time for Referenced Models

In a parallel computing environment, you can increase the speed of code generation and compilation for models containing large model reference hierarchies. Achieve the speed by building referenced models in parallel whenever conditions allow. For example, if you have Parallel Computing Toolbox software, code generation and compilation for each referenced model can be distributed across the cores of a multicore host computer. If you also have MATLAB Distributed Computing Server software, you can distribute code generation and compilation for each referenced model across remote workers in your MATLAB Distributed Computing Server configuration.

Parallel Building for Large Model Reference Hierarchies

The performance gain realized by using parallel builds for referenced models depends on several factors. These factors include how many models can be built in parallel for a given model referencing hierarchy, the size of the referenced models, and parallel computing resources. The resources include the number of local and/or remote workers available and the hardware attributes of the local and remote machines. Examples of hardware attributes are the amount of RAM and number of cores.

For configuration requirements that could apply to your parallel computing environment, see “Parallel Building Configuration Requirements” on page 27-49.

For a description of the general workflow for building referenced models in parallel whenever conditions allow, see “Build Models in a Parallel Computing Environment” on page 27-49.

For information on how to configure a custom embedded system target file to support parallel builds, see “Support Model Referencing” on page 39-84.

Note In a MATLAB Distributed Computing Server parallel computing configuration, parallel building is designed to work interactively with the software. You can initiate builds from the Simulink user interface or from the MATLAB Command Window using commands such as slbuild. You cannot initiate builds using batch or other batch mode workflows.
Parallel Building Configuration Requirements

The following requirements apply to configuring your parallel computing environment for building model reference hierarchies in parallel whenever conditions allow:

- For local pools, the host machine must have enough RAM to support the number of local workers (MATLAB sessions) that you plan to use. For example, using `parpool(4)` to create a parallel pool with four workers results in five MATLAB sessions on your machine. Each pool uses the amount of memory required for MATLAB and the code generator at startup. For memory requirements, see System Requirements for MATLAB & Simulink.
- Remote MATLAB Distributed Computing Server workers participating in a parallel build and the client machine must use a common platform and compiler.
- A consistent MATLAB environment must be set up in each MATLAB worker session as in the MATLAB client session — for example, shared base workspace variables, MATLAB path settings, and so forth. One approach is to use the `PreLoadFcn` callback of the top model. If you configure your model to load the top model with each MATLAB worker session, its preload function can be used for any MATLAB worker session setup.
- It is possible to cause a build error by relying on callbacks to load variables when executing an incremental parallel build (referenced model hierarchy build). To avoid this issue during parallel builds, use one of these options:
  - Do not rely on callback to manage workspace variable of referenced models,
  - Between builds, run the commands `spmd, bdclose all, end` to close all models on the parallel build workers, or
  - Between builds, restart the parallel pool.

Build Models in a Parallel Computing Environment

To take advantage of parallel building for a model reference hierarchy:

1. Set up a pool of local and/or remote MATLAB workers in your parallel computing environment.
   - Make sure that Parallel Computing Toolbox software is licensed and installed.
   - To use remote workers, make sure that MATLAB Distributed Computing Server software is licensed and installed.
c Issue MATLAB commands to set up the parallel pool, for example, `parpool(4)`.

2 From the top model of the model reference hierarchy, open the Configuration Parameters dialog box. Go to the **Model Referencing** pane and select the **Enable parallel model reference builds** (Simulink) option. This selection enables the parameter **MATLAB worker initialization for builds** (Simulink).

For **MATLAB worker initialization for builds**, select one of the following values:

- **None** if it is preferable that the software does not perform special worker initialization. Specify this value if the child models in the model reference hierarchy do not rely on anything in the base workspace beyond what they explicitly set up. An example is a model load function.
• **Copy base workspace** if it is preferable that the software attempts to copy the base workspace to each worker. Specify this value if you use a setup script to prepare the base workspace for multiple models to use.

• **Load top model** if it is preferable that the software loads the top model on each worker. Specify this value if the top model in the model reference hierarchy handles the base workspace setup. An example is a model load function.

**Note** Only set **Enable parallel model reference builds** for the top model of the model reference hierarchy to which it applies.

3 Optionally, turn on verbose messages for simulation builds, code generation builds, or both. If you select verbose builds, the build messages report the progress of each parallel build with the name of the model.

- To turn on verbose messages in model builds for simulation, go to **Configuration Parameters > Simulation Target > Advanced parameters** and select **Verbose accelerator builds**.
- To turn on verbose messages in model builds for code generation, go to **Configuration Parameters > Code Generation > Advanced parameters** and select **Verbose build**.

Verbose options control the build messages in the MATLAB Command Window and in parallel build log files.

4 Optionally, inspect the model reference hierarchy to determine, based on model dependencies, which models are built in parallel. For example, you can use the Model Dependency Viewer from the Simulink **Analysis > Model Dependencies** menu.

5 Build your model. Messages in the MATLAB Command Window record when each parallel or serial build starts and finishes. The order in which referenced models build is nondeterministic. They could build in a different order each time the model is built.

If you need more information about a parallel build, for example, if a build fails, see “Locate Parallel Build Logs” on page 27-51.

**Locate Parallel Build Logs**

If verbose builds are turned on when you build a model for which referenced models are built in parallel, messages in the MATLAB Command Window record when each parallel or serial build starts and finishes. For example,
### Initializing parallel workers for parallel model reference build.
### Parallel worker initialization complete.
### Starting parallel model reference SIM build for 'bot_model001'
### Starting parallel model reference SIM build for 'bot_model002'
### Starting parallel model reference SIM build for 'bot_model003'
### Starting parallel model reference SIM build for 'bot_model004'
### Finished parallel model reference SIM build for 'bot_model001'
### Finished parallel model reference SIM build for 'bot_model002'
### Finished parallel model reference SIM build for 'bot_model003'
### Finished parallel model reference SIM build for 'bot_model004'
### Starting parallel model reference RTW build for 'bot_model001'
### Starting parallel model reference RTW build for 'bot_model002'
### Starting parallel model reference RTW build for 'bot_model003'
### Starting parallel model reference RTW build for 'bot_model004'
### Finished parallel model reference RTW build for 'bot_model001'
### Finished parallel model reference RTW build for 'bot_model002'
### Finished parallel model reference RTW build for 'bot_model003'
### Finished parallel model reference RTW build for 'bot_model004'

To obtain more detailed information about a parallel build, you can examine the parallel build log. For each referenced model built in parallel, the build process generates a file named `model_buildlog.txt`, where `model` is the name of the referenced model. This file contains the full build log for that model.

If a parallel build completes, you can find the build log file in the build subfolder corresponding to the referenced model. For example, for a build of referenced model `bot_model004`, look for the build log file `bot_model004_buildlog.txt` in a referenced model subfolder such as `build_folder/slprj/grt/bot_model004`, `build_folder/slprj/ert/bot_model004`, or `build_folder/slprj/sim/bot_model004`. The build log (diagnostic viewer) provides a relative path to the location of each build log file.

If a parallel build fails, you could see output similar to the following:

```plaintext
### Initializing parallel workers for parallel model reference build.
### Parallel worker initialization complete.
... 
### Starting parallel model reference RTW build for 'bot_model002'
### Starting parallel model reference RTW build for 'bot_model003'
### Finished parallel model reference RTW build for 'bot_model002'
### Finished parallel model reference RTW build for 'bot_model003'
### Starting parallel model reference RTW build for 'bot_model004'
### Starting parallel model reference RTW build for 'bot_model001'
### Starting parallel model reference RTW build for 'bot_model004'
### The following error occurred during the parallel model reference RTW build for 'bot_model001':

Error(s) encountered while building model "bot_model001"

### Cleaning up parallel workers.
```
If a parallel build fails, you can find the build log file in a referenced model subfolder under the build subfolder /par_mdl_ref/model. For example, for a failed parallel build of model bot_model001, look for the build log file bot_model001_buildlog.txt in a subfolder such as build_folder/par_mdl_ref/bot_model001/slprj/grt/bot_model001, build_folder/par_mdl_ref/bot_model001/slprj/ert/bot_model001, or build_folder/par_mdl_ref/bot_model001/slprj/sim/bot_model001.

**View Build Process Status**

The **Build Process Status** window lets you view in-progress build status or cancel in-progress parallel builds of models. After completing a model build, you can view the completion status by using the **Build Process Status** window. For more information, see “Apply Build Process Status to Improve Parallel Builds” on page 27-54.

**Note** The **Build Process Status** window support parallel builds of referenced model hierarchies. Do not use the **Build Process Status** window for sequential (non-parallel) builds.

To open the **Build Process Status** window, use any of these options:

- To open the **Build Process Status** window for a *model*, in the command window, type:

  ```
coder.buildstatus.open('model')
  ```

- To open the **Build Process Status** window for a *model* with the rtwbuild function, in the command window, type:

  ```
  rtwbuild('model', ...
  'OpenBuildStatusAutomatically',true)
  ```

- To open the **Build Process Status** window for a *model* with the slbuild function, in the command window, type:

  ```
  slbuild('model','StandaloneRTWTarget', ... 
  'OpenBuildStatusAutomatically',true)
  ```

To cancel an in-progress model build, the **Build Process Status** window provides a **Cancel** button. This button cancels the build after completion of the current model or referenced model build. Using cancel to stop a build ends a build process without creating out-dated build artifacts that require post-build clean up.
Apply Build Process Status to Improve Parallel Builds

The **Build Process Status** window lets you view in-progress build status or cancel in-progress parallel builds of models. For more information, see “View Build Process Status” on page 27-53.

This example shows how apply build process status from parallel builds. The status information can help you identify ways to improve parallel builds by modifying the referenced model hierarchy.

1. Open a parallel pool for the build process and add the model folder to the path for all workers.

   ```
   parpool('local', 2)
   addpath(fullfile(matlabroot,'toolbox','rtw','rtwdemos','rtwdemo_parallelbuild'))
   spmd
   addpath(fullfile(matlabroot,'toolbox','rtw','rtwdemos','rtwdemo_parallelbuild'))
   end
   ```

2. Open the top-level model in a reference model hierarchy. The `rtwdemo_parabuild_a_1` model refers to a number of referenced models.

   ```
   open_system('rtwdemo_parabuild_a_1')
   ```
3 View the model dependencies with **Analysis > Model Dependencies > Model Dependency Viewer > Models Only**. This view displays the dependencies for the referenced model hierarchy.

During the build process, the Build Process Status window displays the progress of the code generator as it works its way up the referenced model hierarchy. The code generator builds the referenced models in the order that they block building of models further up the dependency tree.

4 Start a parallel build of the referenced model hierarchy and open the Build Process Status window.

```matlab
rtwbuild('rtwdemo_parabuild_a_1','OpenBuildStatusAutomatically',true)
```

5 As the build progresses, the Build Process Status window displays the status for each referenced model.
The table describes the types of build status.
### Build Process Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Blocked</strong></td>
<td>The code generator cannot schedule the model build because the build is blocked by dependencies. For example, another model build must complete before the blocked build can be scheduled.</td>
</tr>
<tr>
<td><strong>Scheduled</strong></td>
<td>For parallel build processes, the code generator schedules the model build when it is not blocked by dependencies. The model build waits at the scheduled status until a parallel core is available to process the model build.</td>
</tr>
<tr>
<td><strong>Building</strong></td>
<td>The code generator is executing the build process for the model.</td>
</tr>
<tr>
<td><strong>Completed</strong></td>
<td>When the build process exits successfully, the status is Completed.</td>
</tr>
<tr>
<td><strong>Error</strong></td>
<td>When the build process is not success, the status is Error.</td>
</tr>
<tr>
<td><strong>Up To Date</strong></td>
<td>When the build process detects that no code generation is needed (for example, generated code is current with the model), the status is Up to Date.</td>
</tr>
<tr>
<td><strong>Canceling</strong></td>
<td>When you use the Cancel Build button, the build process changes the status of all incomplete builds (for example, all except Completed or Error status) to Canceling. After processing the Canceling operation, the build process changes the status of these builds to Canceled.</td>
</tr>
</tbody>
</table>

The elapse time shows you where the build process spends time. Use the dependency tree of the model hierarchy and the elapse time of reference model builds to identify locations where the build process spends the most time and restricts the build progress. Some options for reducing the parallel build time include:

- Restructure the referenced model hierarchy to reduce build time for individual models.
- Provide sufficient parallel workers in the pool to match the number of referenced model dependencies being built.

**See Also**
coder.buildstatus.close | coder.buildstatus.open | rtwbuild | slbuild
More About

- “Control Regeneration of Top Model Code” on page 27-46
- “Reduce Update Time for Referenced Models” (Simulink)
- “Profile Code Performance” on page 27-77
- “Support Model Referencing” on page 39-84
Relocate Code to Another Development Environment

If you require relocating the static and generated code files for a model to another development environment, use the pack-and-go utility. This condition occurs when your system or integrated development environment (IDE) does not include MATLAB and Simulink products.

Code Relocation

The pack-n-go utility uses the tools for customizing the build process after code generation and a `packNGo` function to find and package files for building an executable image. The files are packaged in a compressed file that you can relocate and unpack using a standard `zip` utility.

To package model code files, you can do either of the following:

- Use the model option **Package code and artifacts** in the **Configuration Parameters > Code Generation** pane. See “Package Code Using the User Interface” on page 27-60.
- Use MATLAB commands to configure a `PostCodeGenCommand` parameter with a call to the `packNGo` function. See “Package Code Using the Command-Line Interface” on page 27-61. The command-line interface provides more control over the details of code packaging.

Package Code Using the User Interface

To package and relocate code for your model using the user interface:

1. Open **Configuration Parameters > Code Generation**.
2. Select the option **Package code and artifacts**. This option configures the build process to run the `packNGo` function after code generation to package generated code and artifacts for relocation.
3. In the **Zip file name** field, enter the name of the zip file in which to package generated code and artifacts for relocation. You can specify the file name with or without the `.zip` extension. If you specify no extension or an extension other than `.zip`, the `zip` utility adds the `.zip` extension. If you do not specify a value, the build process uses the name `model.zip`, where `model` is the name of the top model for which code is being generated.
4 Apply changes and generate code for your model. To verify that it is ready for relocation, inspect the resulting zip file. Depending on the zip tool that you use, you could be able to open and inspect the file without unpacking it.

5 Relocate the zip file to the destination development environment and unpack the file.

**Package Code Using the Command-Line Interface**

To package and relocate code for your model using the command-line interface:

1 Select a structure for the zip file. on page 27-62
Select a name for the zip file. on page 27-62
Package the model code files in the zip file. on page 27-63
Inspect the generated zip file. on page 27-64
Relocate and unpack the zip file. on page 27-64

Select a Structure for the Zip File

Before you generate and package the files for a model build, decide whether you want the files to be packaged in a flat or hierarchical folder structure. By default, the `packNGo` function packages the files in a single, flat folder structure.

<table>
<thead>
<tr>
<th>If...</th>
<th>Then Use a...</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are relocating files to an IDE that does not use the generated makefile, or the code is not dependent on the relative location of required static files</td>
<td>Single, flat folder structure</td>
</tr>
<tr>
<td>The destination development environment must maintain the folder structure of the source environment because it uses the generated makefile, or the code depends on the relative location of files</td>
<td>Hierarchical structure</td>
</tr>
</tbody>
</table>

If you use a hierarchical structure, the `packNGo` function creates two levels of zip files, a primary zip file, which in turn contains the following secondary zip files:

- `mlrFiles.zip` — files in your `matlabroot` folder tree
- `sDirFiles.zip` — files in and under your build folder where you initiated code generation for the model
- `otherFiles.zip` — required files not in the `matlabroot` or `start` folder trees

Paths for the secondary zip files are relative to the root folder of the primary zip file, maintaining the source development folder structure.

Select a Name for the Zip File

By default, the `packNGo` function names the primary zip file `model`. You have the option of specifying a different name. If you specify a file name and omit the file type extension, the function appends `.zip` to the name that you specify.
**Package Model Code in a Zip File**

Package model code files by using the `PostCodeGenCommand` configuration parameter, `packNGo` function, and build information object for the model. You can set up the packaging operation to use:

- **A system generated build information object.**

  In this case, before generating the model code, use `set_param` to set the configuration parameter `PostCodeGenCommand` to an explicit call to the `packNGo` function. For example:

  ```
  set_param(bdroot, 'PostCodeGenCommand', 'packNGo(buildInfo);');
  ```

  After generating and writing the model code to disk and before generating a makefile, this command instructs the build process to evaluate the call to `packNGo`. This command uses the system generated build information object for the currently selected model.

- **A build information object that you construct programmatically.**

  In this case, you could use other build information functions to include paths and files selectively in the build information object that you then specify with the `packNGo` function. For example:

  ```
  myModelBuildInfo = RTW.BuildInfo;
  addSourceFiles(myModelBuildInfo, {'test1.c' 'test2.c' 'driver.c'});
  ```

  ```
  packNGo(myModelBuildInfo);
  ```

  The following examples show how you can change the default behavior of `packNGo`.

<table>
<thead>
<tr>
<th>To...</th>
<th>Specify...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the structure of the file packaging to hierarchical</td>
<td><code>packNGo(buildInfo, {'packType' 'hierarchical'})</code>;</td>
</tr>
<tr>
<td>Rename the primary zip file</td>
<td><code>packNGo(buildInfo, {'fileName' 'zippedsrcs'})</code>;</td>
</tr>
</tbody>
</table>
**To...** | **Specify...**
---|---
Change the structure of the file packaging to hierarchical and rename the primary zip file | packNGo(buildInfo, {'packType' 'hierarchical'... 'fileName' 'zippedsrcs'});
Include header files found on the include path in the zip file | packNGo(buildInfo, {'minimalHeaders' false});
Generate warnings for parse errors and missing files | packNGo(buildInfo, {'ignoreParseError' true... 'ignoreFileMissing' true});

**Note** The packNGo function can potentially modify the build information passed in the first packNGo argument. As part of packaging model code, packNGo could find additional files from source and include paths recorded in build information for the model and add them to the build information.

**Inspect a Generated Zip File**

To verify that it is ready for relocation, inspect the generated zip file. Depending on the zip tool that you use, you could be able to open and inspect the file without unpacking it. If unpacking the file and you packaged the model code files as a hierarchical structure, unpacking requires you to unpack the primary and secondary zip files. When you unpack the secondary zip files, relative paths of the files are preserved.

**Relocate and Unpack a Zip File**

Relocate the generated zip file to the destination development environment and unpack the file.

**Code Packaging Example**

This example shows how to package code files generated for the example model rtwdemo_rtwintro using the command-line interface:

1. Set your working folder to a writable folder.
2. Open the model rtwdemo_rtwintro and save a copy to your working folder.
3. Enter the following MATLAB command:
   ```matlab
   set_param('rtwdemo_rtwintro', 'PostCodeGenCommand', ...
   'packNGo(buildInfo, {'packType' 'hierarchical'}));
   ```
You must double the single-quotes due to the nesting of character arrays 'packType' and 'hierarchical' within the character array that specifies the call to packNGo.

4  Generate code for the model.
5  Inspect the generated zip file, rtwdemo_rtwintro.zip. The zip file contains the two secondary zip files, mlrFiles.zip and sDirFiles.zip.
6  Inspect the zip files mlrFiles.zip and sDirFiles.zip.
7  Relocate the zip file to a destination environment and unpack it.

**Build Integrated Code Outside the Simulink Environment**

Identify required files and interfaces for calling generated code in an external build process.

Learn how to:

- Collect files required for building integrated code outside of Simulink®.
- Interface with external variables and functions.

For information about the example model and related examples, see “Generate C Code from a Control Algorithm for an Embedded System” (Embedded Coder).

**Collect and Build Required Data and Files**

The code that Embedded Coder® generates requires support files that MathWorks® provides. To relocate the generated code to another development environment, such as a dedicated build system, you must relocate these support files. You can package these files in a zip file by using the packNGo utility. This utility finds and packages the files that you need to build an executable image. The utility uses tools for customizing the build process after code generation, which include a buildinfo_data structure, and a packNGo function. These files include external files that you identify in the Code Generation > Custom Code pane in the Model Configuration Parameters dialog box. The utility saves the buildinfo MAT-file in the model_ert_rtw folder.

Open the example model, rtwdemo_PCG_Eval_P5.

This model is configured to run packNGo after code generation.

Generate code from the entire model.
To generate the zip file manually:

1. Load the file buildInfo.mat (located in the rtwdemo_PCG_Eval_P5_ert_rtw subfolder).
2. At the command prompt, enter the command packNGo(buildInfo).

The number of files in the zip file depends on the version of Embedded Coder® and on the configuration of the model that you use. The compiler does not require all of the files in the zip file. The compiled executable size (RAM/ROM) depends on the linking process. The linker likely includes only the object files that are necessary.

**Integrating the Generated Code into an Existing System**

This example shows how to integrate the generated code into an existing code base. The example uses the Eclipse™ IDE and the Cygwin™/gcc compiler. The required integration tasks are common to all integration environments.

**Overview of Integration Environment**

A full embedded controls system consists of multiple hardware and software components. Control algorithms are just one type of component. Other components can be:

- An operating system (OS)
- A scheduling layer
- Physical hardware I/O
- Low-level hardware device drivers

Typically, you do not use the generated code in these components. Instead, the generated code includes interfaces that connect with these components. MathWorks® provides hardware interface block libraries for many common embedded controllers. For examples, see the Embedded Targets block library.

This example provides files to show how you can build a full system. The main file is example_main.c, which contains a simple main function that performs only basic actions to exercise the code.

View example_main.c.
int_T main(void) {
    /* Initialize model */
    rt_Pos_Command_Arbitration_Init(); /* Set up the data structures for chart*/
    rtwdemo_PCG__Define_Throt_Param(); /* SubSystem: '<Root>/Define_Throt_Param' */
    defineImportData(); /* Defines the memory and values of inputs */

    do /* This is the "Schedule" loop. */
        Functions would be called based on a scheduling algorithm */
    {
        /* HARDWARE I/O */

        /* Call control algorithms */
        PI_Cntrl_Reusable(*pos_rqst, fbk_1, &rtwdemo_PCG_Eval_P5_B.PI_ctrl_1,
                         &rtwdemo_PCG_Eval_P5_B.DWork.PI_ctrl_1);
        PI_Cntrl_Reusable(*pos_rqst, fbk_2, &rtwdemo_PCG_Eval_P5_B.PI_ctrl_2,
                         &rtwdemo_PCG_Eval_P5_B.DWork.PI_ctrl_2);
        pos_cmd_one = rtwdemo_PCG_Eval_P5_B.PI_ctrl_1.Saturation1;
        pos_cmd_two = rtwdemo_PCG_Eval_P5_B.PI_ctrl_2.Saturation1;

        rtwdemo_Pos_Command_Arbitration(pos_cmd_one, &Throt_Param, pos_cmd_two,
                                         &rtwdemo_PCG_Eval_P5_B.sf_Pos_Command_Arbitration);
    }

The file:

- Defines function interfaces (function prototypes).
- Includes files that declare external data.
- Defines `extern` data.
- Initializes data.
- Calls simulated hardware.
- Calls algorithmic functions.

The order of function execution matches the order of subsystem execution in the test harness model and in `rtwdemo_PCG_Eval_P5.h`. If you change the order of execution in `example_main.c`, results that the executable image produces differ from simulation results.
Match System Interfaces

Integration requires matching the *Data* and *Function* interfaces of the generated code and the existing system code. In this example, the `example_main.c` file imports and exports the data through `#include` statements and `extern` declarations. The file also calls the functions from the generated code.

Connect Input Data

The system has three input signals: `pos_rqst`, `fbk_1`, and `fbk_2`. The generated code accesses the two feedback signals through direct reference to imported global variables (storage class `ImportedExtern`). The code accesses the position signal through an imported pointer (storage class `ImportedExternPointer`).

The handwritten file `defineImportedData.c` defines the variables and the pointer. The generated code does not define the variables and the pointer because the handwritten code defines them. Instead, the generated code declares the imported data (`extern`) in the file `rtwdemo_PCG_Eval_P5_Private.h`. In a real system, the data typically comes from other software components or from hardware devices.

View `defineImportedData.c`.

```c
/* Define imported data */
#include "rtwtypes.h"
#include "defineImportedData.h"

real_T fbk_1;
real_T fbk_2;
real_T dummy_pos_value = 10.0;
real_T *pos_rqst;
void defineImportedData(void)
{
    pos_rqst = &dummy_pos_value;
}
```

View `rtwdemo_PCG_Eval_P5_Private.h`. 
Connect Output Data

In this example, you do not access the output data of the system. The example “Test Generated Code” (Embedded Coder) shows how you can save the output data to a standard log file. You can access the output data by referring to the file rtwdemo_PCG_Eval_P5.h.

View rtwdemo_PCG_Eval_P5.h.

Access Additional Data

The generated code contains several structures that store commonly used data including:

- Block state values (integrator, transfer functions)
- Local parameters
- Time

The table lists the common data structures. Depending on the configuration of the model, some or all of these structures appear in the generated code. The data is declared in the file rtwdemo_PCG_Eval_P5.h, but in this example, you do not access this data.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Data Name</th>
<th>Data Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constants</td>
<td>model_cP</td>
<td>Constant parameters</td>
</tr>
<tr>
<td>Constants</td>
<td>model_cB</td>
<td>Constant block I/O</td>
</tr>
<tr>
<td>Output</td>
<td>model_U</td>
<td>Root and atomic subsystem input</td>
</tr>
<tr>
<td>Output</td>
<td>model_Y</td>
<td>Root and atomic subsystem output</td>
</tr>
<tr>
<td>Internal data</td>
<td>model_B</td>
<td>Value of block output</td>
</tr>
<tr>
<td>Internal data</td>
<td>model_D</td>
<td>State information vectors</td>
</tr>
<tr>
<td>Internal data</td>
<td>model_M</td>
<td>Time and other system level data</td>
</tr>
<tr>
<td>Internal data</td>
<td>model_Zero</td>
<td>Zero-crossings</td>
</tr>
<tr>
<td>Parameters</td>
<td>model_P</td>
<td>Parameters</td>
</tr>
</tbody>
</table>
Match Function Call Interfaces

By default, functions that the code generator generates have a `void Func(void)` interface. If you configure the model or atomic subsystem to generate reentrant code, the code generator creates a more complex function prototype. In this example, the `example_main` function calls the generated functions with the correct input arguments.

```c
PI_Cntrl_Reusable(*pos_rqst), fbk_1, &rtwdemo_PCG_Eval_P5_B.PI_ctrl_1,
&rtwdemo_PCG_Eval_P5_DWork.PI_ctrl_1);
PI_Cntrl_Reusable(*pos_rqst), fbk_2, &rtwdemo_PCG_Eval_P5_B.PI_ctrl_2,
&rtwdemo_PCG_Eval_P5_DWork.PI_ctrl_2);
pos_cmd_one = rtwdemo_PCG_Eval_P5_B.PI_ctrl_1.Saturation1;
pos_cmd_two = rtwdemo_PCG_Eval_P5_B.PI_ctrl_2.Saturation1;
rtwdemo_Pos_Command_Arbitration(pos_cmd_one, &Throt_Param, pos_cmd_two,
&rtwdemo_PCG_Eval_P5_B.sf_Pos_Command_Arbitration);
```

Calls to the function `PI_Cntrl_Reusable` use a mixture of separate, unstructured global variables and Simulink® Coder™ data structures. The handwritten code defines these variables. The structure types are defined in `rtwdemo_PCG_Eval_P5.h`.

Build Project in Eclipse™ Environment

This example uses the Eclipse™ IDE and the Cygwin™ GCC debugger to build the embedded system. The example provides installation files for both programs. Software components and versions numbers are:

- Eclipse™ SDK 3.2
- Eclipse™ CDT 3.3
- Cygwin™/GCC 3.4.4-1
- Cygwin™/GDB 20060706-2

To install and use Eclipse™ and GCC, see “Install and Use Cygwin and Eclipse” (Embedded Coder).

You can install the files for this example by clicking this hyperlink:

Set up the build folder.

Alternatively, to install the files manually:
1. Create a build folder (Eclipse_Build_P5).
2. Unzip the file rtwdemo_PCG_Eval_P5.zip into the build folder.
3. Delete the files rtwdemo_PCG_Eval_P5.c, ert_main.c and rt_logging.c, which are replaced by example_main.c.

You can use the Eclipse™ debugger to step through and evaluate the execution behavior of the generated C code. See the example “Install and Use Cygwin and Eclipse” (Embedded Coder).

To exercise the model with input data, see “Test Generated Code” (Embedded Coder).

**Related Topics**
- “Generate Component Source Code for Export to External Code Base” (Embedded Coder)
- “Generate Shared Library for Export to External Code Base” (Embedded Coder)

**packNGo Function Limitations**

The following limitations apply to the packNGo function:

- The function operates on source files, such as *.c, *.cpp, and *.h files, only. The function does not support compile flags, defines, or makefiles.
- Unnecessary files could be included. The function could find additional files from source and include paths recorded in build information for the model and include them, even if they are not used.

**See Also**

**More About**

- packNGo
- “Choose Build Approach and Configure Build Process” on page 27-14
- “Executable Program Generation” on page 27-74
Compile and Debug Generated C Code with Microsoft® Visual Studio®

This example shows how to generate code from a model and produce a Visual Studio Solution. For the base example, see rtwdemo_counter.

About This Example

Building this example model generates a Visual Studio Solution. These configuration settings control this code generation:

- **Target** - Select **Configuration Parameters > Code Generation > System target file** as grt.tlc Create Visual C/C++ Solution file for Simulink Coder.
- **Template makefile** - Select **Configuration Parameters > Code Generation > Template makefile** as RTW.MSVCBuild.

When you build the model with this configuration, Simulink Coder generates code in a Visual Studio Solution. Add this solution to a Visual Studio C/C++ project to integrate generated code with your custom Visual Studio code.

Before You Start

- This example builds code for Microsoft Visual Studio running on Microsoft Windows® platforms.
- This example works with Microsoft Visual Studio, but not with Visual Studio Express.
- Simulink Coder uses the GRT code format, which is intended for rapid prototyping.
- Embedded Coder uses the ERT code format, which is intended for production deployment.

Example Steps

1. Open the example model rtwdemo_counter_msvc. In the Command Window, type: `open_system('rtwdemo_counter_msvc');`
2. To generated debug output in the generated Visual Studio Solution, set the **Configuration Parameters > Code Generation > Make command** parameter to `make_rtw DEBUG_BUILD=1`. (Omit this step if debug output is not required in the solution.)
3. To generate code, double click the **Generate Code Using Simulink Coder** button in the model or at the command prompt, type: `rtwbuild('rtwdemo_counter_msvc');`
4 After the build process is complete, you can see a Visual Studio Solution was generated and placed in the `msvc` folder under the `rtwdemo_counter_msvc_grt_rtw` folder.

5 In Microsoft Visual Studio, open the `rtwdemo_counter_msvc.sln` solution file. Use the solution to build and debug the generated code in Visual Studio.

**See Also**

**Related Examples**

- “Choose an External Code Integration Workflow” on page 26-4
Executable Program Generation

The following figure shows how the process for program building.

During the final stage of processing, the build process invokes the generated makefile, `model.mk`, which in turn compiles and links the generated code. On PC platforms, a batch file is created to invoke the generated makefile. The batch file sets up the environment for invoking the `make` utility and related compiler tools. To avoid recompiling C files, the `make` utility performs date checking on the dependencies between the object and C files; only out-of-date source files are compiled. Optionally, the makefile can download the resulting executable image to your target hardware.
This stage is optional, as illustrated by the control logic in the preceding figure. You could choose to omit this stage (for example, if you are targeting an embedded microcontroller board).

To omit this stage of processing, select the **Configuration Parameters > Code Generation** pane and select the **Generate code only** check box. You can then cross-compile your code and download it to your target hardware.

If you select the **Configuration Parameters > Code Generation > Report** pane and select **Create code generation report**, the code generator produces a navigable summary of source files when the model is built. The report files occupy a folder called `html` within the build folder. The following display shows an example of an HTML code generation report for a generic real-time (GRT) system target file.
See Also

More About

• “Choose Build Approach and Configure Build Process” on page 27-14
• “Build Process Workflow for Real-Time Systems” on page 27-32
• “Executable Program Generation” on page 27-74
Profile Code Performance

By profiling the performance of generated code, you can help verify that the code meets performance requirements.

Profiling can be especially important early in the development cycle for identifying potential architectural issues that can be more expensive to address later in the process. Profiling can also identify bottlenecks and procedural issues that indicate a need for optimization, for example, with an inner loop or inline code.

**Note** If you have an Embedded Coder license, see “Code Execution Profiling” (Embedded Coder) for an alternative and simpler approach based on software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulations.

Use the Profile Hook Function Interface

You can profile code generated with code generation technology by using a Target Language Compiler (TLC) hook function interface.

To use the profile hook function interface:

1. For your system target file, create a TLC file that defines the following hook functions. Write the functions so that they specify profiling code. The code generator adds the hook function code to code generated for atomic systems in the model.

<table>
<thead>
<tr>
<th>Function</th>
<th>Input Arguments</th>
<th>Output Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProfilerHeaders</td>
<td>void</td>
<td>Array of header file names</td>
<td>Return an array of the header file names to be included in the generated code.</td>
</tr>
<tr>
<td>ProfilerTypedefs</td>
<td>void</td>
<td>typedefs</td>
<td>Generate code statements for profiler type definitions.</td>
</tr>
<tr>
<td>ProfilerGlobal-Data</td>
<td>system</td>
<td>Global data for the specified system</td>
<td>Generate code statements that declare global data.</td>
</tr>
<tr>
<td><strong>Function</strong></td>
<td><strong>Input Arguments</strong></td>
<td><strong>Output Type</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------</td>
<td>-----------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ProfilerExtern-DataDecls</td>
<td>system</td>
<td>extern declarations for the specified system</td>
<td>Generate code statements that create global extern declarations.</td>
</tr>
<tr>
<td>ProfilerSystem-Decls</td>
<td>system, functionType</td>
<td>Declarations for the specified system for the specified functionType</td>
<td>Generate code for required variable declarations within the scope of an atomic subsystem Output, Update, OutputUpdate, or Derivatives function.</td>
</tr>
<tr>
<td>ProfilerSystem-Start</td>
<td>system, functionType</td>
<td>Profiler start commands for the specified system and functionType</td>
<td>Generate code that starts the profiler within the scope of an atomic subsystem Output, Update, OutputUpdate, or Derivatives function.</td>
</tr>
<tr>
<td>ProfilerSystem-Finish</td>
<td>system, functionType</td>
<td>Profiler end commands for the specified system and functionType</td>
<td>Generate code that stops the profiler within the scope of the Output, Update, OutputUpdate, or Derivatives functions of an atomic subsystem.</td>
</tr>
<tr>
<td>ProfilerSystem-Terminate</td>
<td>system</td>
<td>Profiler termination code for the specified system</td>
<td>Generate code that terminates profiling (and possibly reports results) for an atomic subsystem.</td>
</tr>
</tbody>
</table>

For an example TLC file, see `matlabroot/toolbox/rtw/rtwdemos/rtwdemo_profile_hook.tlc`. 
2 In your target.tlc file, define the following global variables.

<table>
<thead>
<tr>
<th>Define...</th>
<th>To Be...</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProfileGenCode</td>
<td>TLC_TRUE or 1 to turn on profiling (TLC_FALSE or 0 to turn off profiling)</td>
</tr>
<tr>
<td>ProfilerTLC</td>
<td>The name of the TLC file that you created in step 1</td>
</tr>
</tbody>
</table>

A quick way to define global variables is to define the parameters with the -a option. You can apply this option by using the set_param command to set the model configuration parameter TLCOptions. For example,

```
>> set_param(gcs,'TLCOptions', ...
   '-aProfileGenCode=1 -aProfilerTLC="rtwdemo_profile_hook.tlc"')
```

3 Consider setting configuration parameters for generating a code generation report. You can then examine the profiling code in the context of the code generated for the model.

4 Build the model. The build process embeds the profiling code in the hook function locations in the generated code for the model.

5 Run the generated executable file. In the MATLAB Command Window, enter !model-name. You see the profiling report you programmed in the profiling TLC file that you created. For example, a profile report could list the number of calls made to each system in a model and the number of CPU cycles spent in each system.

For details on programming a .tlc file and defining TLC configuration variables, see “Target Language Compiler”.

**Profile Hook Function Interface Limitation**

The TLC hook function interface for profiling code performance does not support the S-function system target file (rtwsfcn.tlc).

**See Also**

**More About**

• “Code Execution Profiling” (Embedded Coder)
Host/Target Communication in Simulink Coder

- “Host-Target Communication with External Mode Simulation” on page 28-2
- “External Mode Simulation with XCP Communication” on page 28-8
- “Customize XCP Slave Software” on page 28-22
- “External Mode Simulation with TCP/IP or Serial Communication” on page 28-36
- “Create a Transport Layer for TCP/IP or Serial External Mode Communication” on page 28-90
Host-Target Communication with External Mode Simulation

You can use external mode simulations for rapid prototyping. An external mode simulation establishes a communication channel between Simulink on your development computer (host) and the target hardware that runs the executable file created by the code generation and build process.

Through the communication channel, you can:

• Modify or tune block parameters in real time. When you change parameters in the model, Simulink downloads the new values to the executing target application.
• Monitor and save signal data from the executing target application.

The low-level transport layer of the channel handles the physical transmission of messages. Simulink and the generated model code are independent of this layer. The transport layer and its interface code are isolated in separate modules that format, transmit, and receive messages and data packets.
Simulink supports two communication mechanisms for external mode simulation. Use the information in this table to decide which mechanism to use.
<table>
<thead>
<tr>
<th>Communication Mechanism</th>
<th>Supported By</th>
<th>Why Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>XCP, the Universal Measurement and Calibration Protocol</td>
<td>ERT and GRT system target files.</td>
<td>XCP external mode:</td>
</tr>
<tr>
<td></td>
<td>Some Simulink support packages. For details, see <a href="https://www.mathworks.com/hardware-support.html?q=&amp;page=1">https://www.mathworks.com/hardware-support.html?q=&amp;page=1</a>.</td>
<td>• Uses a standard communication protocol.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Requires only a lightweight communication software stack on the target hardware.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Supports signal logging and streaming for Dashboard blocks and the Simulation Data Inspector. You can stream signals from within a referenced model hierarchy.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Provides documented ext_mode.h API for external mode target connectivity.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Supports streaming of execution-time metrics to the Simulation Data Inspector for host-based and support package external mode simulations.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For information about running XCP external mode simulations, see:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “External Mode Simulation with XCP Communication” on page 28-8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• “Customize XCP Slave Software” on page 28-22</td>
</tr>
</tbody>
</table>
TCP/IP and serial (RS-232) Supported By ERT, GRT, and RSim system target files. Simulink support packages. Why Select You do not use the Simulation Data Inspector for visualizing, exporting, and saving data. You want to use signal triggering. For information about running TCP/IP and serial external mode simulations, see:
• “External Mode Simulation with TCP/IP or Serial Communication” on page 28-36
• “Create a Transport Layer for TCP/IP or Serial External Mode Communication” on page 28-90

This table summarizes feature support for both forms of external mode simulations.

<table>
<thead>
<tr>
<th>Feature</th>
<th>XCP Support</th>
<th>TCP/IP and Serial Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter tuning</td>
<td>With Dashboard blocks</td>
<td>Yes</td>
</tr>
<tr>
<td>Of tunable (Simulink) block parameters</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Simulation Data Inspector</td>
<td>Yes. Includes signals within referenced models.</td>
<td>No</td>
</tr>
<tr>
<td>Logic Analyzer</td>
<td>Yes. Includes signals within referenced models.</td>
<td>No</td>
</tr>
<tr>
<td>Feature</td>
<td>XCP Support</td>
<td>TCP/IP and Serial Support</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Blocks that receive and display signals from target application</td>
<td>Dashboard</td>
<td>Yes, provided signal logging is enabled for block input.</td>
</tr>
<tr>
<td></td>
<td>Floating Scope, Scope</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Spectrum Analyzer, Time Scope (DSP System Toolbox)</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Display</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>To Workspace</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>User-written S-Function. A method, which enables user-written blocks to support external mode, is built into the S-function API.</td>
<td>Yes, provided signal logging is enabled for block input.</td>
</tr>
<tr>
<td></td>
<td>See <code>matlabroot/simulink/include/simstruc.h</code>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>XY Graph</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Signal Viewing Subsystem on page 28-63</td>
<td>Yes</td>
</tr>
</tbody>
</table>
See Also

More About

- “External Mode Simulation with XCP Communication” on page 28-8
- “Customize XCP Slave Software” on page 28-22
- “External Mode Simulation with TCP/IP or Serial Communication” on page 28-36
- “Create a Transport Layer for TCP/IP or Serial External Mode Communication” on page 28-90
External Mode Simulation with XCP Communication

Set up and run external mode simulations on page 28-2 that use an XCP communication channel.

Run XCP External Mode Simulation From Simulink Editor

Configure and run an external mode simulation on page 28-2 that uses the XCP communication protocol. During the simulation:

- Monitor a signal by using a Scope block, a Dashboard block, and the Simulation Data Inspector.
- Tune a parameter by using a Dashboard block.

Configure Signal Monitoring and Parameter Tuning for XCP External Mode

1. Create a folder for this example.
   ```
   mkdir ext_mode_xcp_example
   cd ext_mode_xcp_example
   ```

2. Open Simulink and create a simple model, xcpExample, which contains these blocks:
   - Sine Wave
   - Scope
   - Half Gauge
   - Knob

3. Double-click the Sine Wave block. Set **Sample time** to 0.1, and then click **OK**.

4. Connect the Sine Wave block to the Scope block and name the connection, for example, **Test Signal**.

5. Configure the signal for logging:
   - Right-click **Test Signal**.
   - From the context menu, select **Log Selected Signals**. If you do not enable signal logging, you cannot view the signal by using the Scope block or stream signal data to the Simulation Data Inspector.

6. Configure the Half Gauge block to monitor the value of **Test Signal**:
a Double-click the Half Gauge block.
b In the Simulink Editor, select Test Signal.
c In the Block Parameters dialog box:
   • Connect the block to Test Signal.
   • In the Maximum field, enter a value, for example, 1.
d Click OK.

7 Configure the Knob block to tune the Amplitude parameter of the Sine Wave block:

a Double-click the Knob block.
b In the Simulink Editor, select the Sine Wave block.
c In the Block Parameters dialog box:
   • Connect the block to the Amplitude parameter of the Sine Wave block.
   • In the Minimum and Maximum fields, enter values, for example, 0.1 and 1 respectively.
d Click OK.

8 Save the model.
**Build Target Application for XCP External Mode**

1. Select *Simulation > Model Configuration Parameters*.

2. On the *Solver* pane:
   - In the *Type* field, specify *Fixed-step*.
   - Under *Solver details*, in the *Fixed-step size* field, specify a value, for example, 0.1.

3. On the *Code Generation* pane, set *System target file* to `grt.tlc` or `ert.tlc` (requires Embedded Coder).

4. On the *Code Generation > Optimization* pane, set *Default parameter behavior* to Tunable.

5. On the *Code Generation > Interface* pane, select the *External mode* check box.

6. Set *Transport layer* to `XCP on TCP/IP`, which specifies `ext_xcp` for *MEX-file name*.

7. In the *Mex-file arguments* field, enter `'localhost' 1 5555`. These arguments specify that the:
   - Target hardware is your development computer.
   - Verbosity level is 1.
   - Port number of the TCP/IP server is 5555.

8. Leave the *Static memory allocation* check unselected. The platform abstraction layer of the XCP slave software provides a configurable memory allocator.

9. If *System target file* is `ert.tlc`, on the *Code Generation > Templates* pane:
   - Select the *Generate an example main program* check box. The code generator uses `matlabroot\toolbox\coder\xcp\src\target\ext_mode\include\ext_mode.h` to produce an example main file, `ert_main.c`.
   - Set *Target operating system* to `BareBoardExample`.

10. Click *OK*. Then save the model.

11. Press *Ctrl+B*. The build process generates source code and creates the executable file.

In Windows, the build process creates:

- `xcpExample.exe` -- The executable file.
Run Target Application

1. Open a command prompt for your operating system and navigate to the `ext_mode_xcp_example` folder.
2. In the command prompt, enter:
   ```
   xcpExample -w -tf inf -port 5555
   ```
   The target application runs as a separate process on your development computer:
   - `-w` (optional) specifies that the target application enters a wait state until it receives a message from Simulink. The target application runs but does not yet execute model code.
   - `-tf inf` (optional) specifies that, when model code is executed, the model runs indefinitely. Use this option to override the model parameter `StopTime`.

3. Connect Simulink to the target application:
   a. Select `Simulation > Mode > External`.
   b. On the Simulink Editor toolbar, click the Connect to Target button 🌐. Simulink downloads current parameter values from the model to the target application.

4. To run the generated model code, click the Run button.

Monitor Signal and Tune Parameter

You can monitor `Test Signal` through the:

- Scope block -- Double-click the block.
- Simulation Data Inspector -- Click the Simulation Data Inspector button. When the Simulation Data Inspector opens, select the `Test Signal` check box, which displays streamed data.
• Half-Gauge block.

To change the amplitude of the sine wave, rotate the pointer on the Knob block to the required value.

To tune tunable (Simulink) block parameters during a simulation, you can also use these methods:

• If a block parameter is a variable in the MATLAB workspace, from the Command Window, assign a new value to the variable. Then, in the Simulink Editor, select Simulation > Update Diagram. Simulink downloads the new value to the target application.

• Open the Block Parameter dialog box. In the parameter field, specify the required value. When you click Apply or OK, Simulink downloads the new parameter value to the target application.

For more information about parameter tuning with generated code, see:

• “External Mode Simulation with TCP/IP or Serial Communication” on page 28-36

• “Create Tunable Calibration Parameter in the Generated Code” (Embedded Coder)

If your model contains a Stateflow chart, you can view state activity. For more information, see “Animate Stateflow Charts” (Stateflow).

### Stop Target Application

To stop the execution of generated model code (before StopTime is reached) and disconnect the target application, on the Simulink Editor toolbar, click the Stop button.

If you want to disconnect the target application from Simulink without stopping code execution, click the Disconnect from Target button.

### Target Application Arguments

You can run your target application with optional arguments.
### External Mode Simulation with XCP Communication

For host-based external mode simulations, you can specify additional `rtiostream` (Embedded Coder) arguments.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>-w</code></td>
<td>Specify that the target application enters and stays in a wait state until it receives a message from Simulink. If you do not specify <code>-w</code>, the target application executes model code immediately. The model code runs with parameter values from the time when you built the model.</td>
</tr>
<tr>
<td><code>-tf time</code></td>
<td>Override the model parameter <code>StopTime</code>. <code>-tf inf</code> specifies that the model runs indefinitely when model code is executed.</td>
</tr>
</tbody>
</table>

**Graphical Controls for XCP External Mode Simulations**

You can control an XCP external mode simulation through:
• The Simulink Editor toolbar.
• A Simulink Editor menu.
• The External Mode Control Panel. To open this dialog box, in Simulink Editor, select Code > External Mode Control Panel.

This table gives the controls that you can use for an XCP external mode simulation.

<table>
<thead>
<tr>
<th>External Mode Action</th>
<th>Toolbar</th>
<th>Menu</th>
<th>External Mode Control Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set simulation mode of model to external mode.</td>
<td>From the simulation mode drop-down list, select External.</td>
<td>Simulation &gt; Mode &gt; External</td>
<td>Connect</td>
</tr>
<tr>
<td>If the model simulation mode is not already set, clicking Connect sets the simulation mode to external.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>External Mode Action</strong></td>
<td><strong>Toolbar</strong></td>
<td><strong>Menu</strong></td>
<td><strong>External Mode Control Panel</strong></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------</td>
<td>----------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Connect Simulink to a waiting or running target application.</td>
<td>Connect to Target button</td>
<td>Simulation &gt; Connect to Target</td>
<td>Connect</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>When Simulink is connected to the target application, Connect changes to Disconnect.</td>
</tr>
<tr>
<td>Start real-time execution of generated code in the target environment.</td>
<td>Run button</td>
<td>Simulation &gt; Run (keyboard shortcut Ctrl+T)</td>
<td>Start Real-Time Code</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>When the generated code starts executing, the button changes to Stop Real-Time Code.</td>
</tr>
<tr>
<td>Disconnect Simulink from the target environment, but do not stop real-time execution of code.</td>
<td>Disconnect from Target button</td>
<td>Simulation &gt; Disconnect from Target</td>
<td>Disconnect</td>
</tr>
<tr>
<td>Stop target application execution and disconnect Simulink from the target environment.</td>
<td>Stop button</td>
<td>Simulation &gt; Stop (keyboard shortcut Ctrl+Shift+T)</td>
<td>Stop Real-Time Code</td>
</tr>
<tr>
<td><strong>External Mode Action</strong></td>
<td><strong>Toolbar</strong></td>
<td><strong>Menu</strong></td>
<td><strong>External Mode Control Panel</strong></td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------</td>
<td>----------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Tune batch of block parameters.</td>
<td>N/A</td>
<td>N/A</td>
<td><strong>Batch download</strong></td>
</tr>
</tbody>
</table>

To tune a batch of block parameters:

1. In the External Mode Control Panel, select **Batch download**.
2. In Simulink Editor, modify the required block parameters.
3. When you modify parameters, the External Mode Control Panel displays this message next to **Download**:

   Parameter changes pending...

   Simulink stores the modified parameters locally.
4. Click **Download**. Simulink downloads the batch of modified parameters to the target application.

---

**Run XCP External Mode Simulation From Command Line**

You can use commands or scripts to run XCP external mode simulations. Use `get_param` and `set_param` commands to retrieve and set the values of model parameters.

To run these commands, you must have a Simulink model open and a target application running:
1. Set simulation mode of the model to external mode.
   ```matlab
   set_param(gcs,'SimulationMode','external');
   ```

2. Connect Simulink to the target application.
   ```matlab
   set_param(gcs,'SimulationCommand','connect');
   ```

3. Run generated model code.
   ```matlab
   set_param(gcs,'SimulationCommand','start');
   ```

4. To tune a parameter, change its workspace variable value through a line command. For example, if a block parameter value is specified as a Simulink.Parameter object, assign the new value to the Value property.
   ```matlab
   myParamObj.Value = 5.23;
   ```

5. To download the new value to the target application, update the model.
   ```matlab
   set_param(gcs,'SimulationCommand','update');
   ```

6. Stop the target application and disconnect Simulink from the target environment.
   ```matlab
   set_param(gcs,'SimulationCommand','stop');
   ```
   To disconnect Simulink from the target application without stopping execution of generated code, use this command:
   ```matlab
   set_param(gcs,'SimulationCommand','disconnect');
   ```

### XCP External Mode Limitations

This table describes limitations that apply to external mode simulations that use XCP communication.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter updates that change model structure</td>
<td>You cannot change, for example:</td>
</tr>
<tr>
<td></td>
<td>• The number of states, inputs, or outputs of a block</td>
</tr>
<tr>
<td></td>
<td>• The sample time or the number of sample times</td>
</tr>
<tr>
<td></td>
<td>• The integration algorithm for continuous systems</td>
</tr>
<tr>
<td></td>
<td>• The name of the model or of a block</td>
</tr>
<tr>
<td></td>
<td>• The parameters to the Fcn block</td>
</tr>
<tr>
<td></td>
<td>If you make parameter updates that change the model structure, you must rebuild the target application.</td>
</tr>
<tr>
<td></td>
<td>You can change numerator and denominator polynomial parameters for the Transfer Fcn, Discrete Transfer Fcn, and Discrete Filter blocks if the number of states does not change.</td>
</tr>
<tr>
<td></td>
<td>You cannot change zero entries in the State-Space, Zero-Pole, and Discrete Zero-Pole blocks in the user-specified or computed parameters, that is, the A, B, C, and D matrices obtained by a zero-pole to state-space transformation.</td>
</tr>
<tr>
<td></td>
<td>In the State-Space block, if you specify the matrices in the controllable canonical realization, then changes to the A, B, C, and D matrices that preserve this realization and the dimensions of the matrices are allowed.</td>
</tr>
<tr>
<td></td>
<td>If the Simulink block diagram does not match the target application, Simulink produces an error stating that the checksums do not match. The checksums take into account the top models, but not referenced models. Use the updated block diagram to rebuild the target application.</td>
</tr>
<tr>
<td>Feature</td>
<td>Details</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Signal value display</td>
<td>The graphical display of signal values during a simulation is not supported. For example, you cannot use the <strong>Data Display in Simulation</strong> menu items <strong>Show Value Labels When Hovering</strong>, <strong>Toggle Value Labels When Clicked</strong>, and <strong>Show Value Label of Selected Port</strong>. For more information, see “Displaying Signal Values in Model Diagrams” (Simulink).</td>
</tr>
<tr>
<td>Signal triggering and data archiving</td>
<td>The <strong>Signal &amp; Triggering</strong>, <strong>Arm Trigger</strong>, <strong>Cancel Trigger</strong>, and <strong>Data Archiving</strong> features, which are available on the <strong>External Mode Control Panel</strong>, are not supported.</td>
</tr>
<tr>
<td>Signal streaming</td>
<td>Dynamic selection of signals for streaming is not supported. If want to select different signals for streaming, you must rebuild the model.</td>
</tr>
<tr>
<td>Overriding signal logging settings</td>
<td>Overriding signal logging settings by using the Signal Logging Selector is not supported.</td>
</tr>
<tr>
<td>Compiler debug symbol format</td>
<td>Your toolchain must generate debug information in one of these formats:</td>
</tr>
<tr>
<td></td>
<td>• DWARF</td>
</tr>
<tr>
<td></td>
<td>• PDB</td>
</tr>
<tr>
<td>Inlined parameters</td>
<td>If you set <strong>DefaultParameterBehavior</strong> to 'Inlined', the code generator embeds numeric model parameter values (instead of symbolic parameter names) in the generated code. You can use <strong>Simulink.Parameter</strong> objects to remove remove parameters from inlining and declare the parameters tunable. However, when you connect Simulink to the target application, the numeric values of the tunable parameters are not automatically uploaded to the model. Simulink produces a warning.</td>
</tr>
<tr>
<td>Feature</td>
<td>Details</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Global variables</td>
<td>Signals, parameters, and states must be specified as global variables. The target memory addresses at which the variables are stored must lie in the range 0 – 4294967295.</td>
</tr>
<tr>
<td>Parameter structures</td>
<td>You cannot tune parameters that are structures.</td>
</tr>
</tbody>
</table>
| Pure integer code            | Pure integer code is supported. For code generation, if 'PurelyIntegerCode' is 'on', specify 'FixedStep' with a resolution that is greater or equal to 1 microsecond. For example, specify 1.000001, but not 1.0000001. If you do not specify -tf finalTime in the execution command, the target application runs the generated model code indefinitely, ignoring StopTime. If you specify -tf finalTime in the execution command:  
  • The finalTime value represents base rate clock ticks, not seconds.  
  • The maximum value for finalTime, in ticks, is MAX_int32_T. |
<p>| Variable-size signals        | Uploading of variable-size signals is not supported.                                                                                   |
| Compiler support             | lcc-win64 is not supported.                                                                                                             |
| Mac operating system         | You cannot run host-based XCP external mode simulations on a Mac system because the default XCP slave platform abstraction layer supports only Linux and Windows systems. |
| Endianess                    | Target hardware that uses big endian architecture is not supported.                                                                    |
| Address granularity          | Target hardware that uses word addresses is not supported.                                                                             |
| Scope and Floating Scope blocks, and Scope Viewer | Some signal data types are not supported. The simulation produces a warning.                                                          |</p>
<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scopes in referenced models</td>
<td>In a model hierarchy, if the top model runs in external mode and a referenced model runs in normal or accelerator mode, scopes in the referenced model are not displayed.</td>
</tr>
<tr>
<td>Nonzero simulation start time</td>
<td>Nonzero simulation start times are not supported. Use the default value for Solver &gt; Start time, that is, 0.0.</td>
</tr>
<tr>
<td>File-scoped data</td>
<td>File-scoped data is not supported. For example, data items to which you apply the built-in custom storage class FileScope. The simulation produces a warning.</td>
</tr>
<tr>
<td>Row-major code generation</td>
<td>Code generated with the row-major format is not supported.</td>
</tr>
<tr>
<td>Concurrent execution</td>
<td>Concurrent execution is not supported. If System target file is ert.tlc and Target operating system is NativeThreadsExample, you cannot build the target application.</td>
</tr>
<tr>
<td>VxWorks example</td>
<td>If System target file is ert.tlc and Target operating system is VxWorksExample, you cannot build the target application.</td>
</tr>
</tbody>
</table>

See Also

More About
- “Host-Target Communication with External Mode Simulation” on page 28-2
- “Configure a Signal for Logging” (Simulink)
- “Customize XCP Slave Software” on page 28-22

External Websites
- https://www.asam.net/standards/detail/mcd-1-xcp/wiki/
Customize XCP Slave Software

The XCP communication protocol for Simulink external mode simulations is a master-slave communication protocol. By default, the software supports XCP external mode simulations:

- On your development computer for code that is generated by using ERT (ert.tlc) and GRT (grt.tlc) system target files.
- For some support packages on page 28-2.

If your system target file for custom target hardware is derived from the ERT or GRT system target files, you can use supplied APIs to provide XCP target connectivity. XCP external mode limitations on page 28-17 apply.

The external mode target connectivity software comprises:

- External mode abstraction layer
- XCP slave protocol layer
- XCP slave transport layer
- XCP platform abstraction layer
External Mode Abstraction Layer

To communicate with Simulink during an external mode simulation, your target application must invoke functions from the external mode abstraction layer.

The parent folder for source code files is:

`matlabroot\toolbox\coder\xcp\src\target\ext_mode`

The layer APIs are declared in `include\ext_mode.h` and implemented in `src\xcp_ext_mode.c`. 
To communicate with Simulink, the target application uses services exposed by the external mode abstraction layer. This flow chart shows the required target application steps to establish communication with Simulink.

This table lists the functions that your target application must invoke at each stage.
<table>
<thead>
<tr>
<th>Stage</th>
<th>Function</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>INITIALIZE</td>
<td>extmodeParseArgs</td>
<td>Extract external mode command-line arguments.</td>
</tr>
<tr>
<td></td>
<td>modelName_initiate</td>
<td>Initialize generated Simulink model code.</td>
</tr>
<tr>
<td></td>
<td>extmodeInit</td>
<td>Initialize external mode target connectivity.</td>
</tr>
<tr>
<td>HOST START REQUEST</td>
<td>extmodeWaitForHostRequest</td>
<td>Wait for a start request from development computer, which is created when you click Run button.</td>
</tr>
<tr>
<td>RUN</td>
<td>modelName_step</td>
<td>Run single step of generated Simulink model code.</td>
</tr>
<tr>
<td></td>
<td>extmodeEvent</td>
<td>For sample time ID of the model, sample signals generated by model step function and pass packet content to transport layer of communication protocol for transmission to development computer.</td>
</tr>
<tr>
<td></td>
<td>extmodeBackgroundRun</td>
<td>Transmit and receive packet from physical communication interface and process packet content in accordance with selected communication protocol.</td>
</tr>
<tr>
<td>HOST STOP REQUEST OR SIMULATION COMPLETE</td>
<td>extmodeStopRequested</td>
<td>Check whether a request to stop external mode simulation is received from the model on the development computer. The request is created when you click the Stop button.</td>
</tr>
<tr>
<td></td>
<td>extmodeSimulationComplete</td>
<td>Check whether execution of generated model code is complete.</td>
</tr>
<tr>
<td>RESET</td>
<td>modelName_terminate</td>
<td>Terminate generated Simulink model code.</td>
</tr>
</tbody>
</table>
This pseudo-code example shows how you can implement the various flowchart stages in your target application. During the RUN stage, the external mode run-time environment requires at least two threads:

- A periodic thread that is responsible for the execution of the generated model code.
- A background thread that is responsible for running the external mode communication stack and transmitting and receiving packets.

The pseudo-code simulates multithreading by running `periodicThread` and `extmodeBackgroundRun` sequentially within the same `while()` loop.

```c
/*------------- Pseudo-Code Example -------------*/
/* Define periodic thread */
void periodicThread(void)
{
    /* Run model step function */
    modelName_step();
    /* Notify external mode abstraction layer about periodic event */
    extmodeEvent(PERIODIC_EVENT_ID, currentSimulationTime);
}

/* Main function for target application */
main(int argc, char *argv[])
{
    /*------------- INITIALIZE -------------*/
    /* Parse external mode command line arguments */
    extmodeParseArgs(argc, argv);
    /* Initialize model */
    modelName_initialize();
    /* Initialize external mode target connectivity */
    extmodeInit(extModeInfo, finalSimulationTime);

    /*------------- HOST START REQUEST -------------*/
    /* Wait until a start request is received from development computer */
    extmodeWaitForHostRequest(EXTMODE_WAIT_FOREVER);

    /*------------- RUN -------------*/
    periodicThread();
    extmodeBackgroundRun();

    /*------------- RESET -------------*/
    /* Terminate model */
}
modelName_terminate();

/* Reset external mode target connectivity */
extmodeReset();
return 0;
}

To see code that invokes the functions, complete the example in “External Mode Simulation with XCP Communication” on page 28-8 with System target file set to ert.tlc. Then, from the code generation folder, open ert_main.c.

**XCP Slave Protocol Layer**

The XCP slave protocol layer interprets XCP commands and data according to the Association for Standardisation of Automation and Measuring Systems (ASAM) standard, ASAM MCD-1 XCP.

The source code folder is:

`matlabroot/toolbox/coder/xcp/src/target/slave/protocol/src`

In an external mode simulation, the build process automatically adds the required files to the build information object on page 37-15.

**XCP Slave Transport Layer**

The XCP slave transport layer transmits and receives messages from the communication medium according to ASAM specifications.

The source folder is:

`matlabroot/toolbox/coder/xcp/src/target/slave/transport/src`

In an external mode simulation, the build process automatically adds the required files to the build information object on page 37-15.

**XCP Platform Abstraction Layer**

The XCP platform abstraction layer provides:

- An XCP driver on page 28-28 for sending and receiving raw data through the physical communication interface.
• The implementation of a static memory allocator on page 28-28.
• Other target hardware-specific functionality on page 28-29.

For a customization example, see “Create Custom Abstraction Layer” on page 28-33.

**XCP Driver**

The XCP driver sends and receives XCP messages through the communication channel. In an external mode simulation, the build process automatically adds the driver files to the build information object.

The XCP driver is based on the `rtiostream` (Embedded Coder) API. For example, host-based external mode simulations use these `rtiostream` files:

- `matlabroot/rtw/c/src/rtiostream/rtiostreamtcpip.c`
- `matlabroot/rtw/c/src/rtiostream/rtiostream_serial.c`

For a custom platform abstraction layer, you must add your `rtiostream` files to the build information object on page 37-15. For an example, see “Create Custom Abstraction Layer” on page 28-33.

**Memory Allocator**

The XCP slave software requires the dynamic allocation of variable-size, contiguous memory blocks to:

• Store XCP messages that are received and transmitted.
• Hold internal data structures.

In an external mode simulation, the build process automatically adds memory allocator files to the build information object.

The `xcpMemBlockSizes` and `xcpMemBlockCounts` preprocessor macros define memory allocation.

The default memory allocator can allocate and deallocate up to 16 different sets of memory blocks. For each set, you can override the default allocations during compilation. You can specify:

• The block size through the `XCP_MEM_BLOCK_N_SIZE` preprocessor macro.
• The number of blocks in each set through the `XCP_MEM_BLOCK_N_NUMBER` preprocessor macro.
For example, these preprocessor macros create four blocks of 64 bytes and eight blocks of 256 bytes.

```c
#define XCP_MEM_BLOCK_1_SIZE 64
#define XCP_MEM_BLOCK_1_NUMBER 4
#define XCP_MEM_BLOCK_2_SIZE 256
#define XCP_MEM_BLOCK_2_NUMBER 8
```

Configure the block sizes of the different sets in ascending order:

```
XCP_MEM_BLOCK_N_SIZE < XCP_MEM_BLOCK_N+1_SIZE
```

The smallest block size, `XCP_MEM_BLOCK_1_SIZE`, must be large enough to hold a pointer.

Configure alignment for the memory allocator through the `XCP_MEM_ALIGNMENT` preprocessor macro. For example:

```c
#define XCP_MEM_ALIGNMENT 8
```

**Other Platform Abstraction Layer Functionality**

This file defines the platform abstraction layer interface:

```
matlabroot\toolbox\coder\xcp\src\target\slave\platform\include\xcp_platform.h
```

To implement custom platform abstraction layer functionality, add the `XCP_CUSTOM_PLATFORM` preprocessor macro to the build information object. Provide the implementation of the custom functionality in a file named `xcp_platform_custom.h`. If you do not define `XCP_CUSTOM_PLATFORM`, the build process uses default files that support Linux and Windows systems.

This table describes the functionality that you must provide for the XCP slave software that you deploy on your target hardware.
<table>
<thead>
<tr>
<th>Functionality</th>
<th>Details</th>
</tr>
</thead>
</table>
| Mutual exclusion    | To access system data structures with *mutual exclusion* support, the XCP driver depends on basic APIs for definition, initialization, lock, and unlock. To support mutual exclusion for your target hardware, provide a custom implementation. The default implementation for Linux and Windows supports mutual exclusion.  
  
  #if defined(_WIN32) || defined(_WIN32__) || defined(WIN32)  
  ...
  #define XCP_MUTEX_DEFINE(lock) HANDLE lock
  #define XCP_MUTEX_INIT(lock) lock = CreateMutex(0, FALSE, 0)
  #define XCP_MUTEX_LOCK(lock) WaitForSingleObject((lock), INFINITE)
  #define XCP_MUTEX_UNLOCK(lock) ReleaseMutex(lock)
  
  #else
  ...
  #include <pthread.h>
  #define XCP_MUTEX_DEFINE(lock) pthread_mutex_t lock
  #define XCP_MUTEX_INIT(lock) pthread_mutex_init(&(lock), NULL)
  #define XCP_MUTEX_LOCK(lock) pthread_mutex_lock(&(lock))
  #define XCP_MUTEX_UNLOCK(lock) pthread_mutex_unlock(&(lock))
  ...
  #endif |
<table>
<thead>
<tr>
<th><strong>Functionality</strong></th>
<th><strong>Details</strong></th>
</tr>
</thead>
</table>
| **Sleep**        | Provide a sleep API that makes the calling thread sleep until a specified time has elapsed. The default implementation for Linux and Windows systems is:  
  
  ```c
  #if defined(_WIN32) || defined(__WIN32__) || defined(WIN32)
  ...
  #define XCP_SLEEP(seconds,microseconds) Sleep((seconds) * 1000 
+ (((microseconds) + 1000 - 1) / 1000))
  #else
  ...
  #if _POSIX_C_SOURCE >= 199309L 
  #define XCP_SLEEP(seconds,microseconds) do {struct timespec t; 
  t.tv_sec = seconds; t.tv_nsec = microseconds * 1000; nanosleep(&t, NULL)} while(0)
  #else
  /* nanosleep is not available. Use select instead. */
  #define XCP_SLEEP(seconds,microseconds) do {struct timeval t; t.tv_usec = microseconds; select(0, NULL, NULL, NULL, &t);} while(0)
  #endif /* _POSIX_C_SOURCE >= 199309L */
  ...
  #endif
  ``` |
<p>| <strong>Logging</strong>      | To generate diagnostic messages, the XCP slave software requires a custom print API that supports logging services provided by the target hardware. If you do not define the XCP_PRINTF preprocessor macro, the default implementation is empty. |</p>
<table>
<thead>
<tr>
<th><strong>Functionality</strong></th>
<th><strong>Details</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Address conversion</td>
<td>The XCP standard expresses the address of a variable in memory as a 32-bit address with an 8-bit extension. The XCP Master extracts the addresses of signals and parameters of the model by parsing the debug information that the build process creates. The debug information is in DWARF or PDB format. The XCP Master requests access to parameters and signals by sending an XCP command that contains the arguments <code>addressExtension</code> and <code>address</code>. When <code>addressExtension</code> and <code>address</code> information is received by the target hardware, the XCP Slave must convert the address to the location of the variable in the target hardware memory. The variable location is assigned by the loader and is target-specific. Use the <code>XCP_ADDRESS_GET()</code> macro to specify the conversion logic. The default implementation for Linux and Windows systems is:</td>
</tr>
<tr>
<td></td>
<td>#if defined(<em>MINGW32</em>)</td>
</tr>
<tr>
<td></td>
<td>#define XCP_ADDRESS_GET(addressExtension, address)</td>
</tr>
<tr>
<td></td>
<td>(uintptr_t) (uint8_T*) address</td>
</tr>
<tr>
<td></td>
<td>#else</td>
</tr>
<tr>
<td></td>
<td>#define XCP_ADDRESS_GET(addressExtension, address)</td>
</tr>
<tr>
<td></td>
<td>(uint8_T*) (address) + (uint8_T*)&amp;__ImageBase</td>
</tr>
<tr>
<td></td>
<td>#endif</td>
</tr>
<tr>
<td></td>
<td>Currently, only 32-bit hardware architectures are supported, so <code>addressExtension</code> is 0.</td>
</tr>
<tr>
<td><strong>Functionality</strong></td>
<td><strong>Details</strong></td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set and copy memory</td>
<td>You can specify an optimized version of copy memory and set memory operations.</td>
</tr>
<tr>
<td></td>
<td>If you do not define the XCP_MEMCPY and XCP_MEMSET preprocessor macros, the default implementation specifies the standard C functions, memcpy and memset.</td>
</tr>
</tbody>
</table>
|                           | #ifndef XCP_MEMCPY
|                           | #define XCP_MEMCPY memcpy
|                           | #endif
|                           | #ifndef XCP_MEMSET
|                           | #define XCP_MEMSET memset
|                           | #endif
| Parsing command-line     | If your target hardware does not support the parsing of command-line arguments, define the preprocessor macro EXTMODE_DISABLE_ARGS_PROCESSING. |
| arguments                 | To replace the -w option, you can use this command to specify that the target application enters and stays in a wait state until it receives a Connect message from Simulink: |
|                           | set_param(modelName, 'OnTargetWaitForStart', 'on'); |
|                           | The build process provides the required option (-DON_TARGET_WAIT_FOR_START=1) to the compiler. |

### Create Custom Abstraction Layer

For the build process, you can define a post-code generation command that creates a custom platform abstraction layer.

1. Specify the header file `xcp_platform_custom.h`. This Linux example defines the required functions.

```c
#ifndef XCP_PLATFORM_CUSTOM_H
#define XCP_PLATFORM_CUSTOM_H

/* XCP_ADDRESS_GET */
#include <stdint.h>
#define XCP_ADDRESS_GET(addressExtension, address)  (uint8_T*) ((uintptr_t) address)

/* XCP_MUTEX */
```

28-33
28  Host/Target Communication in Simulink Coder

```c
#include <pthread.h>
define XCP_MUTEX_DEFINE(lock)    pthread_mutex_t lock
define XCP_MUTEX_INIT(lock)      pthread_mutex_init(&(lock), NULL)
define XCP_MUTEX_LOCK(lock)      pthread_mutex_lock(&(lock))
define XCP_MUTEX_UNLOCK(lock)    pthread_mutex_unlock(&(lock))

/* XCP_SLEEP */
#include <sys/time.h>    /* gettimeofday */
#if _POSIX_C_SOURCE >= 199309L
#include <time.h>       /* for nanosleep */
#else
#include <stddef.h>
#include <sys/select.h> /* for select */
#endif
/* _POSIX_C_SOURCE >= 199309L */
#if _POSIX_C_SOURCE >= 199309L
#define XCP_SLEEP(seconds,microseconds)  do {struct timespec t; t.tv_sec = seconds; t.tv_nsec = microseconds * 1000; nanosleep(&t, NULL);} while(0)
#else
/* nanosleep is not available. Use select instead. */
#define XCP_SLEEP(seconds,microseconds)  do {struct timeval t; t.tv_sec = seconds; t.tv_usec = microseconds; select(0, NULL, NULL, NULL, &t);} while(0)
#endif /* _POSIX_C_SOURCE >= 199309L */

2  Define the post-code generation command.

```c
function myXCPTargetPostCodeGenCommand(buildInfo)

    buildInfo.addDefines('-DXCP_CUSTOM_PLATFORM', 'OPTS');

    % Configure the default memory allocator
    buildInfo.addDefines('-DXCP_MEM_BLOCK_1_SIZE=64', 'OPTS');
    buildInfo.addDefines('-DXCP_MEM_BLOCK_1_NUMBER=46', 'OPTS');
    buildInfo.addDefines('-DXCP_MEM_BLOCK_2_SIZE=256', 'OPTS');
    buildInfo.addDefines('-DXCP_MEM_BLOCK_2_NUMBER=10', 'OPTS');

    % Add my rtiostream
    buildInfo.addSourceFiles(customRtIOStreamFileName, customRtIOStreamSrcPath);

    % If the target hardware does not support parsing of command line arguments
    buildInfo.addDefines('-DEXTMODE_DISABLE_ARGS_PROCESSING', 'OPTS');

end
```
See Also
extmodeBackgroundRun | extmodeEvent | extmodeGetFinalSimulationTime |
extmodeInit | extmodeParseArgs | extmodeReset |
extmodeSetFinalSimulationTime | extmodeSimulationComplete |
extmodeStopRequested | extmodeWaitForHostRequest

More About
• “Host-Target Communication with External Mode Simulation” on page 28-2
• “External Mode Simulation with XCP Communication” on page 28-8

External Websites
• https://www.asam.net/standards/detail/mcd-1-xcp/wiki/
External Mode Simulation with TCP/IP or Serial Communication

Set up and run an external mode simulation that uses a TCP/IP or serial (RS-232) communication channel.

1. Create and configure a simple model.
2. Build the target executable file.
3. Run the target application.
4. Tune parameters.

The example, which uses the GRT target, does not require external hardware. The generated executable file runs:

- On the development computer that hosts Simulink and Simulink Coder.
- As a separate process from MATLAB and Simulink.

Create and Configure Model

In this part of the example, you create a simple model, `ex_extModeExample`. You also create a folder called `ext_mode_example` to store the model and the generated executable.

To create the folder and the model:

1. From the MATLAB command line, type:

   ```
   mkdir ext_mode_example
   ```

2. Make `ext_mode_example` your working folder:

   ```
   cd ext_mode_example
   ```

3. Create a model in Simulink with a Sine Wave block for the input signal, two Gain blocks in parallel, and two Scope blocks. Be sure to label the Gain and Scope blocks as shown.
4 Define and assign two MATLAB workspace variables, A and B:

\[
A = 2; \\
B = 3;
\]

5 Open Gain block A and set its Gain parameter to the variable A.

6 Open Gain block B and set its Gain parameter to the variable B.

When the target application is built and connected to Simulink in external mode, you can download new gain values to the executing target application. To do this, you can
assign new values to workspace variables A and B, or edit the values in the block parameters dialog box. For more information, see “Tune Parameters” on page 28-44.

7 Verify operation of the model. Open the Scope blocks and run the model. When $A = 2$ and $B = 3$, the output appears as shown.

8 Save the model as ex_extModeExample.

**Build Target Executable**

Set up the model and code generation parameters required for an external mode target application. Then, generate code and build the target application.

1 Open the Configuration Parameters dialog box by selecting **Simulation > Model Configuration Parameters**.
2 Select the **Solver** pane.
3 In the **Solver selection** subpane:
   a In the **Type** field, select **Fixed-step**.
   b In the **Solver** field, select **discrete (no continuous states)**.
c  Open **Additional options**. In the **Fixed-step size** field, specify 0.1. (Otherwise, when you generate code, the Simulink Coder build process posts a warning and supplies a value.)

Leave **Start time** set to the default value of 0.0.

Click **Apply**.

4 Select the **Data Import/Export** pane, and clear the **Time** and **Output** check boxes. In this example, data is not logged to the workspace or to a MAT-file. Click **Apply**.

5 Select the **Code Generation** pane. By default, the generic real-time (GRT) target is selected.

6 Select the **Code Generation > Optimization** pane. Make sure that **Default parameter behavior** is set to **Tunable**. Inlined parameters are not part of this example. If you make a change, click **Apply**.

7 Select the **Code Generation > Interface** pane. In the **Data exchange interface** section, select **External mode**. This selection enables generation of external mode support code and displays additional external mode configuration parameters.

8 In the **External mode configuration** section, make sure that the default value `tcpip` is selected for the **Transport layer** parameter.

External mode supports communication via TCP/IP, serial, and custom transport protocols. The **MEX-file name** field specifies the name of a MEX-file that implements host and target communication on the host side. The default for TCP/IP is `ext_comm`, a MEX-file provided with the Simulink Coder software. You can override this default by supplying other files. If you need to support other transport layers, see “Create a Transport Layer for TCP/IP or Serial External Mode Communication” on page 28-90.

The **MEX-file arguments** field lets you specify arguments, such as a TCP/IP server port number, to be passed to the external interface program. These arguments are
specific to the external interface that you are using. For information on setting these arguments, see “MEX-File Optional Arguments for TCP/IP Transport” on page 28-71 and “MEX-File Optional Arguments for Serial Transport” on page 28-73.

This example uses the default arguments. Leave the MEX-file arguments field blank.

The Static memory allocation check box controls how memory is allocated for external mode communication buffers in the target. For this example, do not select the check box. For more information, see “Control Memory Allocation for Communication Buffers in Target” on page 28-46.

9   Click Apply to save the external mode settings.

10  Save the model.

11  Select the Code Generation pane. Make sure that Generate code only is cleared, and then, in the model window, press Ctrl+B to generate code and create the target application. The software creates the ex_extModeExample target executable in your working folder.

Run Target Application

You now run the ex_extModeExample target executable and use Simulink as an interactive front end to the running target application. The executable file is in your working folder. Run the target application and establish communication between Simulink and the target.

**Note** An external mode program like ex_extModeExample is a host-based executable. Its execution is not tied to a real-time operating system (RTOS) or a periodic timer interrupt, and it does not run in real time. The program just runs as fast as possible, and the time units it counts off are simulated time units that do not correspond to time in the world outside the program.

The External Signal & Triggering dialog box (accessed from the External Mode Control Panel) displays a list of blocks in your model that support external mode signal monitoring and logging. In the dialog box, you can configure the signals that are viewed, how they are acquired, and how they are displayed.

In this example, you observe and use the default settings of the External Signal & Triggering dialog box.
From the **Code** menu of the model diagram, select **External Mode Control Panel**. This control panel is where you configure signal monitoring and data archiving. You can also connect to the target application, and start and stop execution of the model code.

1. **Connection and triggering**
   - After the target application starts, you use the top row of buttons.
   - The **Signal & Triggering** button opens the External Signal & Triggering dialog box. Use this dialog box to select the signals that are collected from the target system and viewed in external mode. You can also select a signal that triggers uploading of data when certain signal conditions are met, and define the triggering conditions.
   - The **Data Archiving** button opens the Enable Data Archiving dialog box. Use data archiving to save data sets generated by the target application for future analysis. This example does not use data archiving. See “**Configure Host Archiving of Target Application Signal Data**” on page 28-59.
2 Click the **Signal & Triggering** button to open the External Signal & Triggering dialog box. The default configuration selects all signals for monitoring and sets signal monitoring to begin once the host and target application are connected.

![External Signal & Triggering dialog box](image)

3 Make sure that the External Signal & Triggering dialog box options are set to these defaults:

- **Select all** check box is selected. Signals in the **Signal selection** list are marked with an X in the **Selected** column.
- Under **Trigger options**:
  - **Source**: manual
  - **Mode**: normal
- **Duration**: 1000
- **Delay**: 0
- **Arm when connecting to target**: selected

To close the External Signal & Triggering dialog box, click **OK**. Then, close the External Mode Control Panel.

For descriptions of the External Signal & Triggering dialog box parameters, see “Configure Host Monitoring of Target Application Signal Data” on page 28-51.

4 To run the target application, open an operating system command window (on UNIX systems, a terminal emulator window). At the command prompt, use `cd` to navigate to the `ext_mode_example` folder in which you generated the target application.

Enter this command:

```
ex_extModeExample -tf inf -w
```

**Note** Alternatively, you can run the target application from the MATLAB Command Window, using the following syntax.

```
!ex_extModeExample -tf inf -w &
```

The target application begins execution, and enters a wait state.

The `-tf` switch overrides the stop time set for the model in Simulink. The `inf` value directs the model to run indefinitely. The model code runs until the target application receives a stop message from Simulink.

The `-w` switch instructs the target application to enter a wait state until it receives a **Start Real-Time Code** message from the host. If you want to view target application execution data from time step 0, or if you want to modify parameters before the target application begins execution of model code, this switch is required.

5 Open the Scope blocks in the model. Signals are not visible on the scopes. When you connect Simulink to the target application and begin model execution, the signals generated by the target application become visible on the scope displays.

6 Before communication between the model and the target application can begin, the model must be in external mode. To enable external mode, from the **Simulation > Mode** menu, select **External**.
Reopen the External Mode Control Panel (found in the Code menu) and click Connect. This action initiates a handshake between Simulink and the target application. When Simulink and the target are connected, the Start Real-Time Code button becomes enabled, and the label of the Connect button changes to Disconnect.

Click Start Real-Time Code. The outputs of Gain blocks A and B are displayed on the two scopes in your model.

You have established communication between Simulink and the running target application. You can now tune block parameters in Simulink and observe the effects the parameter changes have on the target application.

**Tune Parameters**

You can change the gain factor of either Gain block by assigning a new value to the variable A or B in the MATLAB workspace. When you change block parameter values in the workspace during a simulation, you must explicitly update the block diagram with these changes. When you update the block diagram, the new values are downloaded to the target application.

Under certain conditions, you can also tune the expressions that you use to specify block parameter values. To change an expression during simulation, open the block dialog box.

1. At the command prompt, assign new values to both variables, for example:

   ```
   A = 0.5;
   B = 3.5;
   ```

2. Open the ex_extModeExample model window. From the Simulation menu, select Update Diagram. As soon as Simulink has updated the block parameters, the new gain values are downloaded to the target application, and the scopes are changed because of the gain change.

3. In the Sine Wave block dialog box, set Amplitude to 0.5. Click Apply or OK.

   When you click Apply or OK, the simulation downloads the new block parameter value to the target application. The Scope block displays the change to reflect the new amplitude value.

4. To simultaneously disconnect host/target communication and end execution of the target application, from the Simulation menu, select Stop. Alternatively, in the External Mode Control Panel, click Stop Real-Time Code.
You cannot change the sample time of the Sine Wave block during simulation. Block sample times are part of the structural definition of the model and are part of the generated code. Therefore, if you want to change a block sample time, you must stop the external mode simulation, reset the sample time of the block, and rebuild the executable.

Block parameter tunability during external mode simulation depends on the way that the generated code represents block parameters.

For example, in the Gain A block dialog box, you cannot change the expression $A$ in the Gain parameter during simulation. Instead, you must change the value of the variable $A$ in the base workspace. You cannot change the expression because the generated code does not allocate storage in memory for the Gain parameter. Instead, the code creates a field $A$ in a structure:

```c
/* Parameters (auto storage) */
struct P_ex_extModeExample_T_ {
    real_T A;               /* Variable: A */
    real_T B;               /* Variable: B */
    real_T SineWave_Amp;    /* Expression: 1 */
    real_T SineWave_Bias;   /* Expression: 0 */
    real_T SineWave_Freq;   /* Expression: 1 */
    real_T SineWave_Phase;  /* Expression: 0 */
};
```

The generated code algorithm uses that field in the code that represents the block Gain A. In this case, the global structure variable ex_extModeExample_P uses the type P_ex_extModeExample_T_: 

```
ex_extModeExample_B.GainA = ex_extModeExample_P.A * rtb_SineWave;
```

When you change the value of $A$ in the base workspace, the simulation downloads the new value to the field $A$ in the target application.

You can change the expressions in the Sine Wave block parameters during simulation because the generated code creates a field in the global structure ex_extModeExample_P to represent each parameter in the block. When you change an expression in the block dialog box, the simulation first evaluates the new expression. The
simulation then downloads the resulting numeric value to the corresponding structure field in the target application.


**Control Memory Allocation for Communication Buffers in Target**

If you select the **Code Generation > Interface > Static memory allocation** check box (for GRT and ERT targets), the code generator produces code for external mode that uses only static memory allocation (“malloc-free” code). Selecting **Static memory allocation** enables the **Static memory buffer size** parameter. Use this parameter to specify the size of the external mode static memory buffer. The default value is 1,000,000 bytes. If you enter too small a value for your program, external mode issues an out-of-memory error when it tries to allocate more memory than you allowed. In such cases, increase the value in the **Static memory buffer size** field and regenerate the code.

To determine how much memory to allocate, enable verbose mode on the target (by including `OPTS=-DVERBOSE` on the `make` command line). As it executes, external mode displays the amount of memory it tries to allocate and the amount of memory available to it each time it attempts an allocation. If an allocation fails, you can use this console log to adjust the size in the **Static memory buffer size** field.

**Control External Mode Simulation Through Editor Toolbar**

This table gives Simulink Editor features that you can use to control an external mode simulation.

<table>
<thead>
<tr>
<th>External Mode Action</th>
<th>Toolbar Control</th>
<th>Menu Control</th>
<th>External Mode Control Panel Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the simulation mode of your model to external mode</td>
<td>From the simulation mode drop-down list, select External</td>
<td><strong>Simulation &gt; Mode &gt; External</strong></td>
<td><strong>Connect</strong> (if the model simulation mode is not already set, sets the simulation mode to external mode)</td>
</tr>
<tr>
<td>Connect your model to a waiting or running target application</td>
<td><strong>Connect to Target</strong> button</td>
<td><strong>Simulation &gt; Connect to Target</strong></td>
<td><strong>Connect</strong></td>
</tr>
</tbody>
</table>
### Control External Mode Simulation Through External Mode Control Panel

The External Mode Control Panel provides centralized control of external mode operations, including:

- “Connect, Start, and Stop” on page 28-48
- “Upload Target Application Signal Data to Host” on page 28-49
- “Download Parameters to Target Application” on page 28-50
- “Configure Host Monitoring of Target Application Signal Data” on page 28-51
- “Configure Host Archiving of Target Application Signal Data” on page 28-59

To open the External Mode Control Panel dialog box, in the model window, select **Code > External Mode Control Panel**.
Connect, Start, and Stop

The External Mode Control Panel performs the same connect/disconnect and start/stop functions found in the Simulation menu and the Simulink toolbar (see “Control External Mode Simulation Through Editor Toolbar” on page 28-46).

Clicking the Connect button connects your model to a waiting or running target application. While you are connected, the button changes to a Disconnect button. Disconnect disconnects your model from the target environment, but does not halt real-time code running in the target environment.

Connect sets the model simulation mode to external mode.

Clicking the Start Real-Time Code button commands the target to start running real-time code. While real-time code is running in the target environment, the button changes
to a **Stop Real-Time Code** button. **Stop Real-Time Code** stops target application execution and disconnects your model from the target environment.

**Upload Target Application Signal Data to Host**

The External Mode Control Panel allows you to trigger and cancel data uploads to the host. The destination for the uploaded data can be a scope block, Display block, To Workspace block, or another block or subsystem listed in “Blocks and Subsystems Compatible with External Mode” on page 28-62.

The **Arm Trigger** and **Cancel Trigger** buttons provide manual control of data uploading to compatible blocks or subsystems, except floating scopes. (For floating scopes, use the **Floating scope** section of the External Mode Control Panel.)

- To trigger data uploading to compatible blocks or subsystems, click the **Arm Trigger** button. The button changes to **Cancel Trigger**.
- To cancel data uploading, click the **Cancel Trigger** button. The button reverts to **Arm Trigger**.

You can trigger data uploads manually or automatically. To configure signals and triggers for data uploads, see “Configure Host Monitoring of Target Application Signal Data” on page 28-51.

A subset of external mode compatible blocks, including Scope, Time Scope, and To Workspace, allow you to log uploaded data to disk. To configure data archiving, see “Configure Host Archiving of Target Application Signal Data” on page 28-59.

The **Floating scope** section of the External Mode Control Panel controls when and for how long data is uploaded to Floating Scope blocks. When used in external mode, floating scopes:

- Do not appear in the External Signal & Triggering dialog box.
- Do not log data to external mode archiving.
- Support manual triggering only.

The **Floating scope** section contains the following parameters:

- **Enable data uploading** option, which functions as an **Arm Trigger** button for floating scopes. When the target is disconnected, the option controls whether to arm the trigger when connecting the floating scopes. When the target is connected, the option acts as a toggle button to arm or cancel the trigger.
• To trigger data uploading to floating scopes, select **Enable data uploading**.
• To cancel data uploading to floating scopes, clear **Enable data uploading**.
• **Duration** edit field, which specifies the number of base-rate steps for which external mode logs floating scopes data after a trigger event. By default, it is set to **auto**, which causes the duration value set in the External Signal & Triggering dialog box to be used. The default duration value is 1000 base rate steps.

**Download Parameters to Target Application**

The **Batch download** option on the External Mode Control Panel enables or disables batch parameter changes.

By default, batch download is disabled. If batch download is disabled, when you click **OK** or **Apply**, changes made directly to block parameters by editing block parameter dialog boxes are sent to the target. When you perform an **Update Diagram**, changes to MATLAB workspace variables are sent.

If you select **Batch download**, the **Download** button is enabled. Until you click **Download**, changes made to block parameters are stored locally. When you click **Download**, the changes are sent in a single transmission.

When parameter changes are awaiting batch download, the External Mode Control Panel displays the message **Parameter changes pending...** to the right of the **Download** button. This message remains visible until the Simulink engine receives notification that the new parameters have been installed in the parameter vector of the target system.

The next figure shows the External Mode Control Panel with the **Batch download** option activated and parameter changes pending.
Configure Host Monitoring of Target Application Signal Data

- “Role of Trigger in Signal Data Uploading” on page 28-52
- “Configure Signal Data Uploading” on page 28-52
- “Default Trigger Options” on page 28-53
- “Select Signals to Upload” on page 28-54
- “Configure Trigger Options” on page 28-54
- “Select Trigger Signal” on page 28-56
- “Set Trigger Conditions” on page 28-57
- “Modify Signal and Triggering Options While Connected” on page 28-58
Role of Trigger in Signal Data Uploading

In external mode, uploading target application signal data to the host depends on a trigger. The trigger is a set of conditions that must be met for data uploading to begin. The trigger can be armed or not armed.

- When the trigger is armed, the software checks for the trigger conditions that allow data uploading to begin.
- If the trigger is not armed, the software does not check for the trigger conditions and data uploading cannot begin.
- The trigger can be armed automatically, when the host connects to the target, or manually, by clicking the Arm Trigger button on the External Mode Control Panel.

When the trigger is armed and the trigger conditions are met, the trigger fires and data uploading begins.

When data has been collected for a defined duration, the trigger event completes and data uploading stops. The trigger can then rearm, or remain unarmed until you click the Arm Trigger button.

To select the target application signals to upload and configure how uploads are triggered, see “Configure Signal Data Uploading” on page 28-52.

Configure Signal Data Uploading

Clicking the Signal & Triggering button of the External Mode Control Panel opens the External Signal & Triggering dialog box.
The External Signal & Triggering dialog box displays a list of blocks and subsystems in your model that support external mode signal uploading. For information on which types of blocks are external mode compatible, see “Blocks and Subsystems Compatible with External Mode” on page 28-62.

In the External Signal & Triggering dialog box, you can select the signals that are collected from the target system and viewed in external mode. You can also select a trigger signal, which triggers uploading of data based on meeting certain signal conditions, and define the triggering conditions.

**Default Trigger Options**

The preceding figure shows the default settings of the External Signal & Triggering dialog box. The default operation of the External Signal & Triggering dialog box simplifies...
monitoring the target application. If you use the default settings, you do not need to 
preconfigure signals and triggers. You start the target application and connect the 
Simulink engine to it. External mode compatible blocks are selected and the trigger is 
armed. Signal uploading begins immediately upon connection to the target application.

The default configuration of trigger options is:

- **Select all:** on
- **Source:** manual
- **Mode:** normal
- **Duration:** 1000
- **Delay:** 0
- **Arm when connecting to target:** on

### Select Signals to Upload

External mode compatible blocks in your model appear in the **Signal selection** list of the 
External Signal & Triggering dialog box. You use this list to select signals that you want 
to view. In the **Selected** column, an X appears for each selected block.

The **Select all** check box selects all signals. By default, **Select all** is selected.

If **Select all** is cleared, you can select or clear individual signals using the **on** and **off** 
options. To select a signal, click its list entry and select the **on** option. To clear a signal, 
click its list entry and select the **off** option.

The **Clear all** button clears all signals.

### Configure Trigger Options

As described in “Role of Trigger in Signal Data Uploading” on page 28-52, signal data 
uploading depends on a trigger. The trigger defines conditions that must be met for 
uploading to begin. Also, the trigger must be armed for data uploading to begin. When 
the trigger is armed and trigger conditions are met, the trigger fires and uploading 
begins. When data has been collected for a defined duration, the trigger event completes 
and data uploading stops.

To control when and how signal data is collected (uploaded) from the target system, 
configure the following **Trigger options** in the External Signal & Triggering dialog box.
• **Source**: manual or signal. Controls whether a button or a signal triggers data uploading.

Selecting manual directs external mode to use the **Arm Trigger** button on the External Mode Control Panel as the trigger to start uploading data. When you click **Arm Trigger**, data uploading begins.

Selecting signal directs external mode to use a trigger signal as the trigger to start uploading data. When the trigger signal satisfies trigger conditions (that is, the signal crosses the trigger level in the specified direction), a trigger event occurs. (Specify trigger conditions in the **Trigger signal** section.) If the trigger is armed, external mode monitors for the occurrence of a trigger event. When a trigger event occurs, data uploading begins.

• **Mode**: normal or one-shot. Controls whether the trigger rearms after a trigger event completes.

In normal mode, external mode automatically rearms the trigger after each trigger event. The next data upload begins when the trigger fires.

In one-shot mode, external mode collects only one buffer of data each time you arm the trigger.

For more information on the **Mode** setting, see “Configure Host Archiving of Target Application Signal Data” on page 28-59.

• **Duration**: Specifies the number of base rate steps for which external mode uploads data after a trigger event (default is 1000). For example, if **Duration** is set to 1000, and the base (fastest) rate of the model is one second:

- For a signal sampled at the base rate, one second (1.0 Hz), external mode collects 1000 contiguous samples during a trigger event.
- For a signal sampled at two seconds (0.5 Hz), external mode collects 500 samples during a trigger event.

• **Delay**: Specifies a delay to be applied to data collection. The delay represents the amount of time that elapses between a trigger event and the start of data collection. The delay is expressed in base rate steps. It can be positive or negative (default is 0). A negative delay corresponds to pretriggering. When the delay is negative, data from the time preceding the trigger event is collected and uploaded.

• **Arm when connecting to target**: Selected or cleared. Whether a button or a signal triggers data uploading (as defined by **Source**), the trigger must be armed to allow data uploading to begin.
If you select this option, connecting to the target arms the trigger.

- If the trigger **Source** is **manual**, data uploading begins immediately.
- If the trigger **Source** is **signal**, monitoring of the trigger signal begins immediately. Data uploading begins when the trigger signal satisfies trigger conditions (as defined in the **Trigger signal** section).

If you clear **Arm when connecting to target**, manually arm the trigger by clicking the **Arm Trigger** button on the External Mode Control Panel.

When simulating in external mode, each rate in the model creates a buffer on the target. Each entry in the buffer is big enough to hold all of the data required of every signal in that rate for one time step (time plus data plus external mode indices identifying the signal). The number of entries in the circular buffer is determined by the external mode trigger **Duration** parameter (**ExtModeTrigDuration**). The memory allocated on the target for buffering signals is proportional to the **Duration** and the number of signals uploading. The **Duration** also provides an indication of the number of base rate steps with log data after a trigger event in external mode.

The **Duration** value specifies the number of contiguous points of data to be collected in each buffer of data. You should enter a **Duration** value equal to the number of continuous sample points that you need to collect rather than relying on a series of buffers to be continuous. If you enter a value less than the total number of sample points, you may lose sample points during the time spent transferring values from the data buffer to the MATLAB workspace. The Simulink software maintains point continuity only within one buffer. Between buffers, because of transfer time, some samples may be omitted.

The **Duration** value can affect the **Limit data points to last** value of Scope and To Workspace blocks. The number of sample points that the blocks save to the MATLAB workspace is the smaller of the two values. To set the number of sample points that the blocks save, clear **Limit data points to last**. Then, use **Duration** to specify the number of sample points saved.

**Select Trigger Signal**

You can designate one signal as a trigger signal. To select a trigger signal, from the **Source** menu in the **Trigger options** section, select **signal**. This action enables the parameters in the **Trigger signal** section. Then, select a signal in the **Signal selection** list, and click the **Trigger Signal** button.
When you select a signal to be a trigger, a T appears in the **Trigger** column of the **Signal selection** list. In the next figure, the **Scope A** signal is the trigger. **Scope B** is also selected for viewing, as indicated by the X in the **Selected** column.

After selecting the trigger signal, you can use the **Trigger signal** section to define the trigger conditions and set the trigger signal **Port** and **Element** parameters.

**Set Trigger Conditions**

Use the **Trigger signal** section of the External Signal & Triggering dialog box to set trigger conditions and attributes. **Trigger signal** parameters are enabled only when the trigger parameter **Source** is set to **signal** in the **Trigger options** section.

By default, any element of the first input port of a specified trigger block can cause the trigger to fire (that is, Port 1, any element). You can modify this behavior by adjusting the
**Port** and **Element** values in the **Trigger signal** section. The **Port** field accepts a number or the keyword **last**. The **Element** field accepts a number or the keywords **any** or **last**.

In the **Trigger signal** section, you also define the conditions under which a trigger event occurs.

- **Direction**: rising, falling, or either. The direction in which the signal must be traveling when it crosses the threshold value. The default is rising.
- **Level**: A value indicating the threshold the signal must cross in a designated direction to fire the trigger. By default, the level is 0.
- **Hold-off**: Applies only to normal mode. Expressed in base rate steps, **Hold-off** is the time between the termination of one trigger event and the rearming of the trigger.

**Modify Signal and Triggering Options While Connected**

After you configure signal data uploading, and connect Simulink to a running target executable, you can modify signal and triggering options without disconnecting from the target.

If the trigger is armed (for example, if the trigger option **Arm when connecting to the target** is selected, which is the default), the External Signal & Triggering dialog box cannot be modified. To modify signal and triggering options:

1. Open the External Mode Control Panel.
2. Click **Cancel Trigger**. Triggering and display of uploaded data stops.
3. Open the External Signal & Triggering dialog box and modify signal and trigger options as required. For example, in the **Signal selection** section, you can enable or disable a scope, and in the **Trigger options** section, change the trigger **Mode**, for example, from normal to one-shot.
4. Click **Arm Trigger**. Triggering and display of uploaded data resumes, with your modifications.
Configure Host Archiving of Target Application Signal Data

In external mode, you can use the Simulink Scope and To Workspace blocks to archive data to disk.

To understand how the archiving features work, consider the handling of data when archiving is not enabled. There are two cases, one-shot mode and normal mode.

- In one-shot mode, after a trigger event occurs, each selected block writes its data to the workspace, as it would at the end of a simulation. If another one-shot is triggered, the existing workspace data is overwritten.
- In normal mode, external mode automatically rearms the trigger after each trigger event. Consequently, you can think of normal mode as a series of one-shots. Each one-shot in this series, except for the last, is referred to as an intermediate result. Because the trigger can fire at any time, writing intermediate results to the workspace can...
result in unpredictable overwriting of the workspace variables. For this reason, the default behavior is to write only the results from the final one-shot to the workspace. The intermediate results are discarded. If you know that enough time exists between triggers for inspection of the intermediate results, you can override the default behavior by selecting the **Write intermediate results to workspace** option. This option does not protect the workspace data from being overwritten by subsequent triggers.

If you use a Simulink Scope block to archive data to disk, open the Scope parameters dialog box and select the option **Log data to workspace**. The option is required for these reasons:

- The data is first transferred from the scope data buffer to the MATLAB workspace, before being written to a MAT-file.
- The **Variable name** entered in the Scope parameters dialog box is the same as the one in the MATLAB workspace and the MAT-file. Enabling the data to be saved enables a variable named with the **Variable name** parameter to be saved to a MAT-file.

**Note** If you do not select the Scope block option **Log data to workspace**, the MAT-files for data logging are created, but they are empty.

The Enable Data Archiving dialog box supports:

- Folder notes
- File notes
- Automated data archiving

On the External Mode Control Panel, click the **Data Archiving** button to open the Enable Data Archiving dialog box. If your model is connected to the target environment, disconnect it while you configure data archiving. To enable the other controls in the dialog box, select **Enable archiving**.
These operations are supported by the Enable Data Archiving dialog box.

Folder Notes

To add annotations for a collection of related data files in a folder, in the Enable Data Archiving dialog box, click **Edit Directory Note**. The MATLAB editor opens. Place comments that you want saved to a file in the specified folder in this window. By default, the comments are saved to the folder last written to by data archiving.

File Notes

To add annotations for an individual data file, in the Enable Data Archiving dialog box, click **Edit File Note**. A file finder window opens, which by default is set to the last file to which you have written. Selecting a MAT-file opens an edit window. In this window, add or edit comments that you want saved with your individual MAT-file.
Automated Data Archiving

To configure automatic writing of logging results to disk, optionally including intermediate results, use the Enable archiving option and the controls it enables. The dialog box provides the following related controls:

- **Directory**: Specifies the folder in which data is saved. If you select Increment directory when trigger armed, external mode appends a suffix.
- **File**: Specifies the name of the file in which data is saved. If you select Increment file after one-shot, external mode appends a suffix.
- **Increment directory when trigger armed**: Each time that you click the Arm Trigger button, external mode uses a different folder for writing log files. The folders are named incrementally, for example, dirname1, dirname2, and so on.
- **Increment file after one-shot**: New data buffers are saved in incremental files: filename1, filename2, and so on. File incrementing happens automatically in normal mode.
- **Append file suffix to variable names**: Whenever external mode increments file names, each file contains variables with identical names. Selecting Append file suffix to variable names results in each file containing unique variable names. For example, external mode saves a variable named xdata in incremental files (file_1, file_2, and so on) as xdata_1, xdata_2, and so on. This approach supports loading the MAT-files into the workspace and comparing variables at the MATLAB command prompt. Without the unique names, each instance of xdata would overwrite the previous one in the MATLAB workspace.
- **Write intermediate results to workspace**: If you want the Simulink Coder software to write intermediate results to the workspace, select this option.

Blocks and Subsystems Compatible with External Mode

- “Compatible Blocks” on page 28-62
- “Signal Viewing Subsystems” on page 28-63
- “Supported Blocks for Data Archiving” on page 28-65

Compatible Blocks

In external mode, you can use the following types of blocks to receive and view signals uploaded from the target application:
• Floating Scope and Scope blocks
• Spectrum Analyzer and Time Scope blocks from the DSP System Toolbox product
• Display blocks
• To Workspace blocks
• User-written S-Function blocks

An external mode method is built into the S-function API. This method allows user-written blocks to support external mode. See `matlabroot/simulink/include/simstruc.h`.

• XY Graph blocks

You can designate certain subsystems as Signal Viewing Subsystems and use them to receive and view signals uploaded from the target application. See “Signal Viewing Subsystems” on page 28-63 for more information.

You select external mode compatible blocks and subsystems, and arm the trigger, by using the External Signal & Triggering dialog box. By default, such blocks in a model are selected, and a manual trigger is set to be armed when connected to the target application.

### Signal Viewing Subsystems

A Signal Viewing Subsystem is an atomic subsystem that encapsulates processing and viewing of signals received from the target system. A Signal Viewing Subsystem runs only on the host, and does not generate code in the target system. Signal Viewing Subsystems run in normal, accelerator, rapid accelerator, and external simulation modes.

**Note** Signal Viewing Subsystems are inactive if placed inside a SIL or PIL component, such as a top model in SIL or PIL mode, a Model block in SIL or PIL mode, or a SIL or PIL block. However, a SIL or PIL component can feed a Signal Viewing Subsystem running in a supported mode.

Signal Viewing Subsystems are useful in situations where you want to process or condition signals before viewing or logging them, but you do not want to perform these tasks on the target system. By using a Signal Viewing Subsystem, you can generate smaller and more efficient code on the target system.

Like other external mode compatible blocks, Signal Viewing Subsystems are displayed in the External Signal & Triggering dialog box.
To declare a subsystem to be a Signal Viewing Subsystem:

1. In the Block Parameters dialog box, select the **Treat as atomic unit** option.

   For more information on atomic subsystems, see “Control Generation of Subsystem Functions” on page 6-2.

2. To turn the SimViewingDevice property on, use the `set_param` command:

   ```
   set_param('blockname', 'SimViewingDevice','on')
   ```

   'blockname' is the name of the subsystem.

3. Make sure the subsystem meets the following requirements:

   - It must be a pure Sink block. That is, it must not contain Outport blocks or Data Store blocks. It can contain Goto blocks only if the corresponding From blocks are contained within the subsystem boundaries.
   - It must not have continuous states.

The following model, `sink_examp`, contains an atomic subsystem, `theSink`.

![Diagram of theSink subsystem](image)

The subsystem `theSink` applies a gain and an offset to its input signal and displays it on a Scope block.

![Diagram of gain and offset application](image)

If `theSink` is declared as a Signal Viewing Subsystem, the generated target application includes only the code for the Sine Wave block. If `theSink` is selected and armed in the
External Signal & Triggering dialog box, the target application uploads the sine wave signal to `theSink` during simulation. You can then modify the parameters of the blocks within `theSink` and observe the uploaded signal.

If `theSink` were not declared as a Signal Viewing Subsystem, its Gain, Constant, and Sum blocks would run as subsystem code on the target system. The Sine Wave signal would be uploaded to the Simulink engine after being processed by these blocks, and viewed on `sink_examp/theSink/Scope2`. Processing demands on the target system would be increased by the additional signal processing, and by the downloading of changes in block parameters from the host.

**Supported Blocks for Data Archiving**

In external mode, you can use the following types of blocks to archive data to disk:

- Scope blocks
- To Workspace blocks

You configure data archiving by using the Enable Data Archiving dialog box, as described in “Configure Host Archiving of Target Application Signal Data” on page 28-59.

**External Mode Mechanism for Downloading Tunable Parameters**

- “Download Mechanism” on page 28-65
- “Inlined and Tunable Parameters” on page 28-67

Depending on the setting of the Default parameter behavior option when the target application is generated, there are differences in the way parameter updates are handled. “Download Mechanism” on page 28-65 describes the operation of external mode communication with Default parameter behavior set to Tunable. “Inlined and Tunable Parameters” on page 28-67 describes the operation of external mode with Default parameter behavior set to Inlined.

**Download Mechanism**

In external mode, the Simulink engine does not simulate the system represented by the block diagram. By default, when external mode is enabled, the Simulink engine downloads parameters to the target system. After the initial download, the engine remains in a waiting mode until you change parameters in the block diagram or until the engine receives data from the target.
When you change a parameter in the block diagram, the Simulink engine calls the external interface MEX-file, passing new parameter values (along with other information) as arguments. The external interface MEX-file contains code that implements one side of the interprocess communication (IPC) channel. This channel connects the Simulink process (where the MEX-file executes) to the process that is executing the external program. The MEX-file transfers the new parameter values by using this channel to the external program.

The other side of the communication channel is implemented within the external program. This side writes the new parameter values into the target's parameter structure (`model_P`).

The Simulink side initiates the parameter download operation by sending a message containing parameter information to the external program. In the terminology of client/server computing, the Simulink side is the client and the external program is the server. The two processes can be remote, or they can be local. Where the client and server are remote, a protocol such as TCP/IP is used to transfer data. Where the client and server are local, a serial connection or shared memory can be used to transfer data.

The next figure shows this relationship. The Simulink engine calls the external interface MEX-file whenever you change parameters in the block diagram. The MEX-file then downloads the parameters to the external program by using the communication channel.
External Mode Architecture

Inlined and Tunable Parameters

By default, parameters (except those listed in “TCP/IP and Serial External Mode Limitations” on page 28-85) in an external mode program are tunable; that is, you can change them by using the download mechanism described in this section.

If you set Default parameter behavior to Inlined (on the Optimization pane of the Configuration Parameters dialog box), the Simulink Coder code generator embeds the numerical values of model parameters (constants), instead of symbolic parameter names,
in the generated code. Inlining parameters generates smaller and more efficient code. However, inlined parameters, because they effectively become constants, are not tunable.

The Simulink Coder software lets you improve overall efficiency by inlining most parameters, while at the same time retaining the flexibility of run-time tuning for selected parameters that are important to your application. When you inline parameters, you can use Simulink.Parameter objects to remove individual parameters from inlining and declare them to be tunable. In addition, you can use these objects to control how parameters are represented in the generated code.

For more information on tunable parameters, see “Create Tunable Calibration Parameter in the Generated Code” on page 15-122.

**Automatic Parameter Uploading on Host/Target Connection**

Each time the Simulink engine connects to a target application that was generated with **Default parameter behavior** set to Inlined, the target application uploads the current value of its tunable parameters to the host. These values are assigned to the corresponding MATLAB workspace variables. This procedure synchronizes the host and target with respect to parameter values.

Workspace variables required by the model must be initialized at the time of host/target connection. Otherwise the uploading cannot proceed and an error results. Once the connection is made, these variables are updated to reflect the current parameter values on the target system.

Automatic parameter uploading takes place only if the target application was generated with **Default parameter behavior** set to Inlined. “Download Mechanism” on page 28-65 describes the operation of external mode communication with **Default parameter behavior** set to Tunable.

**Choose Communication Protocol for Client and Server**

- “Introduction” on page 28-69
- “Using the TCP/IP Implementation” on page 28-69
- “Using the Serial Implementation” on page 28-72
- “Run the External Program” on page 28-74
- “Implement an External Mode Protocol Layer” on page 28-76
Introduction

The Simulink Coder product provides code to implement both the client and server side of external mode communication using either TCP/IP or serial protocols. You can use the socket-based external mode implementation provided by the Simulink Coder product with the generated code, provided that your target system supports TCP/IP. If not, use or customize the serial transport layer option provided.

A low-level transport layer handles physical transmission of messages. Both the Simulink engine and the model code are independent of this layer. Both the transport layer and code directly interfacing to the transport layer are isolated in separate modules that format, transmit, and receive messages and data packets.

Using the TCP/IP Implementation

You can use TCP/IP-based client/server implementation of external mode with real-time programs on The Open Group UNIX or PC systems. For help in customizing external mode transport layers, see “Create a Transport Layer for TCP/IP or Serial External Mode Communication” on page 28-90.

To use Simulink external mode over TCP/IP:

• Make sure that the external interface MEX-file for your target's TCP/IP transport is specified.

Targets provided by MathWorks specify the name of the external interface MEX-file in\matlabroot/toolbox/simulink/simulink/extmode_transports.m. The name of the interface appears as uneditable text in the External mode configuration section of the Interface pane of the Configuration Parameters dialog box. The TCP/IP default is ext_comm.

To specify a TCP/IP transport for a custom target, you must add an entry of the following form to an sl_customization.m file on the MATLAB path:

```
function sl_customization(cm)
  cm.ExtModeTransports.add('stf.tlc', 'transport', 'mexfile', 'Level1');
%end function
```

• **stf.tlc** is the name of the system target file for which you are registering the transport (for example, 'mytarget.tlc')

• **transport** is the transport name to display in the Transport layer menu on the Interface pane of the Configuration Parameters dialog box (for example, 'tcpip')
• *mexfile* is the name of the transport's associated external interface MEX-file (for example, 'ext_comm')

You can specify multiple targets and/or transports with additional `cm.ExtModeTransports.add` lines, for example:

```matlab
function sl_customization(cm)
    cm.ExtModeTransports.add('mytarget.tlc', 'tcpip', 'ext_comm', 'Level1');
    cm.ExtModeTransports.add('mytarget.tlc', 'serial', ...
        'ext_serial_win32_comm', 'Level1');
%end function
```

• Be sure that the template makefile is configured to link the source files for the TCP/IP server code and that it defines the compiler flags when building the generated code.

• Build the external program.

• Run the external program.

• Set the Simulink model to external mode and connect to the target.

The next figure shows the structure of the TCP/IP-based implementation.
TCP/IP-Based Client/Server Implementation for External Mode

MEX-File Optional Arguments for TCP/IP Transport

In the External Target Interface dialog box, you can specify optional arguments that are passed to the external mode interface MEX-file for communicating with executing targets.

- Target network name: the network name of the computer running the external program. By default, this is the computer on which the Simulink product is running, for example, 'myComputer'. You can also use the IP address, for example, '148.27.151.12'.
- Verbosity level: controls the level of detail of the information displayed during the data transfer. The value is either 0 or 1 and has the following meaning:
0 — No information
1 — Detailed information

- TCP/IP server port number: The default value is 17725. You can change the port number to a value between 256 and 65535 to avoid a port conflict.

The arguments are positional and must be specified in the following order:

```
<TargetNetworkName> <VerbosityLevel> <ServerPortNumber>
```

For example, if you want to specify the verbosity level (the second argument), then you must also specify the target network name (the first argument). Arguments can be delimited by white space or commas. For example:

```
'148.27.151.12' 1 30000
```

You can specify command-line options to the external program when you launch it. See “Run the External Program” on page 28-74.

**Using the Serial Implementation**

Controlling host/target communication on a serial channel is similar to controlling host/target communication on a TCP/IP channel.

To use Simulink external mode over a serial channel, you must:

- Make sure that the external interface MEX-file for your target's serial transport is specified.

Targets provided by MathWorks specify the name of the external interface MEX-file in `matlabroot/toolbox/simulink/simulink/extmode_transports.m`. The name of the interface appears as uneditable text in the **External mode configuration** section of the **Interface** pane of the Configuration Parameters dialog box. The serial default is `serial`.

To specify a serial transport for a custom target, you must add an entry of the following form to an `sl_customization.m` file on the MATLAB path:

```matlab
function sl_customization(cm)
    cm.ExtModeTransports.add('stf.tlc', 'transport', 'mexfile', 'Level1');
%end function
```

- `stf.tlc` is the name of the system target file for which you are registering the transport (for example, 'mytarget.tlc')
• **transport** is the transport name to display in the **Transport layer** menu on the **Interface** pane of the Configuration Parameters dialog box (for example, 'serial')

• **mexfile** is the name of the transport's associated external interface MEX-file (for example, 'ext_serial_win32_comm')

You can specify multiple targets and/or transports with additional **cm.ExtModeTransports.add** lines, for example:

```matlab
function sl_customization(cm)
    cm.ExtModeTransports.add('mytarget.tlc', 'tcpip', 'ext_comm', 'Level1');
    cm.ExtModeTransports.add('mytarget.tlc', 'serial', ...
        'ext_serial_win32_comm', 'Level1');
%end function
```

• Be sure that the template makefile is configured to link the source files for the serial server code and that it defines the compiler flags when building the generated code.

• Build the external program.

• Run the external program.

• Set the Simulink model to external mode and connect to the target.

**MEX-File Optional Arguments for Serial Transport**

In the **MEX-file arguments** field of the **Interface** pane of the Configuration Parameters dialog box, you can specify arguments that are passed to the external mode interface MEX-file for communicating with the executing targets. For serial transport, the optional arguments to **ext_serial_win32_comm** are as follows:

• Verbosity level: This argument controls the level of detail of the information displayed during data transfer. The value of this argument is:
  - 0 (no information), or
  - 1 (detailed information)

• Serial port ID: The port ID of the host, specified as an integer or character vector. For example, specify the port ID of a USB to serial converter as '/dev/ttyusb0'. Simulink Coder prefixes integer port IDs with '\COM' on Windows and by '/dev/ttyS' on Unix.

When you start the target application using a serial connection, you must specify the port ID to use to connect it to the host. Do this by including the `-port` command-line option. For example:

```bash
mytarget.exe -port 2 -w
```
• Baud rate: Specify an integer value. The default value is 57600.

The MEX-file options arguments are positional and must be specified in the following order:

\[<\text{VerbosityLevel}> \ <\text{SerialPortID}> \ <\text{BaudRate}>\]

For example, if you want to specify the serial port ID (the second argument), then you must also specify the verbosity level (the first argument). Arguments can be delimited by white space or commas. For example:

\[1 \ '/dev/ttyusb0' \ 57600\]

When you launch the external program, you can specify command-line options.

**Run the External Program**

Before you can use the Simulink product in external mode, the external program must be running.

If the target application is executing on the same machine as the host and communication is through a loopback serial cable, the target's port ID must differ from that of the host (as specified in the MEX-file arguments edit field).

To run the external program, you type a command of the form:

\[\text{model} \ -opt1 \ ... \ -optN\]

\[\text{model}\] is the name of the external program and \[-opt1 \ ... \ -optN\] are options. (See “Command-Line Options for the External Program” on page 28-75.) In the examples in this section, the name of the external program is \text{ext_example}.

**Running the External Program in the Windows Environment**

In the Windows environment, you can run the external programs in either of the following ways:

• Open a Command Prompt window. At the command prompt, type the name of the target executable, followed by possible options, such as:

\[\text{ext_example} \ -tf \ inf \ -w\]

• Alternatively, you can launch the target executable from the MATLAB Command Window. The command must be preceded by an exclamation point (!) and followed by an ampersand (&), as in the following example:
!ext_example -tf inf -w &

The ampersand (&) causes the operating system to spawn another process to run the target executable. If you do not include the ampersand, the program still runs, but you cannot enter commands at the MATLAB command prompt or manually terminate the executable.

**Running the External Program in the UNIX Environment**

In the UNIX environment, you can run the external programs in either of the following ways:

- Open an **Xterm** window. At the command prompt, type the name of the target executable, followed by possible options, such as:

  .ext_example -tf inf -w

- Alternatively, you can launch the target executable from the MATLAB Command Window. You must run it in the background so that you can still access the Simulink environment. The command must be preceded by an exclamation point (!), dot slash (./ indicating the current directory), and followed by an ampersand (&), as in the following example:

  !./ext_example -tf inf -w &

The ampersand (&) causes the operating system to spawn another process to run the target executable.

**Command-Line Options for the External Program**

External mode target executables generated by the Simulink Coder code generator support the following command-line options:

- **-tf n**

  The -tf option overrides the stop time set in the Simulink model. The argument n specifies the number of seconds the program will run. The value inf directs the model to run indefinitely. In this case, the model code runs until the target application receives a stop message from the Simulink engine.

  The following example sets the stop time to 10 seconds.

  ext_example -tf 10
When integer-only ERT targets are built and executed in external mode, the stop time parameter (-tf) is interpreted by the target as the number of base rate ticks rather than the number of seconds to execute.

- **-w**

Instructs the target application to enter a wait state until it receives a message from the host. At this point, the target is running, but not executing the model code. The start message is sent when you select **Start Real-Time Code** from the **Simulation** menu or click the **Start Real-Time Code** button in the External Mode Control Panel.

Use the `-w` option if you want to view target application execution data from time step 0, or if you want to modify parameters before the target application begins execution of model code.

- **-port n**

Specifies the TCP/IP port number or the serial port ID, n, for the target application. The port number of the target application must match that of the host for TCP/IP transport. The port number depends on the type of transport.

  - For TCP/IP transport: Port number is an integer between 256 and 65535, with the default value being 17725.
  - For serial transport: Port ID is an integer or a character vector. For example, specify the port ID of a USB to serial converter as `/dev/ttyusb0`

- **-baud r**

Specified as an integer, this option is only available for serial transport.

**Implement an External Mode Protocol Layer**

If you want to implement your own transport layer for external mode communication, you must modify certain code modules provided by the Simulink Coder product and create a new external interface MEX-file. See “Create a Transport Layer for TCP/IP or Serial External Mode Communication” on page 28-90.

**Use External Mode Programmatically**

You can run external mode simulations from the MATLAB command line or programmatically in scripts. Use the `get_param` and `set_param` commands to retrieve and set the values of model simulation command-line parameters, such as
SimulationMode and SimulationCommand, and external mode command-line parameters, such as ExtModeCommand and ExtModeTrigType.

The following model simulation commands assume that a Simulink model is open and that you have loaded a target application to which the model will connect using external mode.

1. Change the Simulink model to external mode:
   ```
   set_param(gcs,'SimulationMode','external')
   ```

2. Connect the open model to the loaded target application:
   ```
   set_param(gcs,'SimulationCommand','connect')
   ```

3. Start running the target application:
   ```
   set_param(gcs,'SimulationCommand','start')
   ```

4. Stop running the target application:
   ```
   set_param(gcs,'SimulationCommand','stop')
   ```

5. Disconnect the target application from the model:
   ```
   set_param(gcs,'SimulationCommand','disconnect')
   ```

To tune a workspace parameter, change its value at the command prompt. If the workspace parameter is a Simulink.Parameter object, assign the new value to the Value property.

```matlab
myVariable = 5.23;
myParamObj.Value = 5.23;
```

To download the workspace parameter in external mode, you update the model diagram. The following model simulation command initiates a model update:

```
set_param(gcs,'SimulationCommand','update')
```

To trigger or cancel data uploading to scopes, use the ExtModeCommand values armFloating and cancelFloating, or armWired and cancelWired. For example, to trigger and then cancel data uploading to wired (nonfloating) scopes:

```
set_param(gcs,'ExtModeCommand','armWired')
set_param(gcs,'ExtModeCommand','cancelWired')
```

The next table lists external mode command-line parameters that you can use in get_param and set_param commands. The table provides brief descriptions, valid
values (bold type highlights defaults), and a mapping to External Mode dialog box equivalents. For external mode parameters that are equivalent to Interface pane options in the Configuration Parameters dialog box, see “Model Configuration Parameters: Code Generation Interface”.

28-78
## External Mode Command-Line Parameters

<table>
<thead>
<tr>
<th>Parameter and Values</th>
<th>Dialog Box Equivalent</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ExtModeAddSuffixToVar off, on</td>
<td>Enable Data Archiving: Append file suffix to variable names check box</td>
<td>Increment variable names for each incremented filename.</td>
</tr>
<tr>
<td>ExtModeArchiveDirName character vector</td>
<td>Enable Data Archiving: Directory text field</td>
<td>Save data in specified folder.</td>
</tr>
<tr>
<td>ExtModeArchiveFileName character vector</td>
<td>Enable Data Archiving: File text field</td>
<td>Save data in specified file.</td>
</tr>
<tr>
<td>ExtModeArchiveMode character vector - off, on</td>
<td>Enable Data Archiving: Enable archiving check box</td>
<td>Activate automated data archiving features.</td>
</tr>
<tr>
<td>ExtModeArmWhenConnect off, on</td>
<td>External Signal &amp; Triggering: Arm when connecting to target check box</td>
<td>Arm the trigger as soon as the Simulink Coder software connects to the target.</td>
</tr>
<tr>
<td>ExtModeAutoIncOneShot off, on</td>
<td>Enable Data Archiving: Increment file after one-shot check box</td>
<td>Save new data buffers in incremental files.</td>
</tr>
<tr>
<td>ExtModeAutoUpdateStatusClock (Microsoft Windows platforms only) off, on</td>
<td>Not available</td>
<td>Continuously upload and display target time on the model window status bar.</td>
</tr>
<tr>
<td>ExtModeBatchMode off, on</td>
<td>External Mode Control Panel: Batch download check box</td>
<td>Enable or disable downloading of parameters in batch mode.</td>
</tr>
<tr>
<td>ExtModeChangesPending off, on</td>
<td>Not available</td>
<td>When ExtModeBatchMode is enabled, indicates whether parameters remain in the queue of parameters to be downloaded to the target.</td>
</tr>
<tr>
<td>Parameter and Values</td>
<td>Dialog Box Equivalent</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ExtModeCommand</td>
<td></td>
<td>Issue an external mode command to the target application.</td>
</tr>
</tbody>
</table>
| _character vector_ - armFloating, armWired, cancelFloating, cancelWired | • armFloating and cancelFloating are equivalent to selecting and clearing External Mode Control Panel check box  
  _Floating scope > Enable data uploading_  
  • armWired and cancelWired are equivalent to External Mode Control Panel buttons _Arm Trigger_ and _Cancel Trigger_ |                                                                                                  |
<p>| ExtModeConnected              |                                          | Indicate the state of the connection with the target application.                              |
| <em>off, on</em>                     | External Mode Control Panel: <em>Connect/Disconnect</em> button                                |                                                                                                  |
| ExtModeEnableFloating         |                                          | Enable or disable the arming and canceling of triggers when a connection is established with floating scopes. |
| <em>off, on</em>                     | External Mode Control Panel: <em>Enable data uploading</em> check box                         |                                                                                                  |
| ExtModeIncDirWhenArm          |                                          | Write log files to incremental folders each time the trigger is armed.                         |
| <em>off, on</em>                     | Enable Data Archiving: <em>Increment directory when trigger armed</em> check box               |                                                                                                  |
| ExtModeLogAll                 |                                          | Upload available signals from the target to the host.                                          |
| <em>off, on</em>                     | External Signal &amp; Triggering: <em>Select all</em> check box                                    |                                                                                                  |</p>
<table>
<thead>
<tr>
<th>Parameter and Values</th>
<th>Dialog Box Equivalent</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ExtModeParamChangesPending</strong></td>
<td>off, on</td>
<td><strong>Not available</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>When the Simulink Coder software is connected to the target and ExtModeBatchMode is enabled, indicates whether parameters remain in the queue of parameters to be downloaded to the target. More efficient than ExtModeChangesPending, because it checks for a connection to the target.</td>
</tr>
<tr>
<td><strong>ExtModeSkipDownloadWhenConnected</strong></td>
<td>off, on</td>
<td><strong>Not available</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Connect to the target application without downloading parameters.</td>
</tr>
<tr>
<td><strong>ExtModeTrigDelay</strong></td>
<td>integer (0)</td>
<td><strong>External Signal &amp; Triggering:</strong> &lt;Delay&gt; text field</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify the amount of time (expressed in base rate steps) that elapses between a trigger occurrence and the start of data collection.</td>
</tr>
<tr>
<td><strong>ExtModeTrigDirection</strong></td>
<td>character vector - rising, falling, either</td>
<td><strong>External Signal &amp; Triggering:</strong> &lt;Direction&gt; menu</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify the direction in which the signal must be traveling when it crosses the threshold value.</td>
</tr>
<tr>
<td><strong>ExtModeTrigDuration</strong></td>
<td>integer (1000)</td>
<td><strong>External Signal &amp; Triggering:</strong> &lt;Duration&gt; text field</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify the number of base rate steps for which external mode is to log data after a trigger event.</td>
</tr>
<tr>
<td><strong>ExtModeTrigDurationFloating</strong></td>
<td>character vector - integer (auto)</td>
<td><strong>External Mode Control Panel:</strong> &lt;Duration&gt; text field</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify the duration for floating scopes. If auto is specified, the value of ExtModeTrigDuration is used.</td>
</tr>
<tr>
<td>Parameter and Values</td>
<td>Dialog Box Equivalent</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------------------</td>
<td>----------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ExtModeTrigElement</td>
<td>External Signal &amp; Triggering:</td>
<td>Specify the elements of the input port of the specified trigger block that can cause the trigger to fire.</td>
</tr>
<tr>
<td>character vector - integer, any, last</td>
<td>Element text field</td>
<td></td>
</tr>
<tr>
<td>ExtModeTrigHoldOff</td>
<td>External Signal &amp; Triggering:</td>
<td>Specify the base rate steps between when a trigger event terminates and the trigger is rearmed.</td>
</tr>
<tr>
<td>integer (0)</td>
<td>Hold-off text field</td>
<td></td>
</tr>
<tr>
<td>ExtModeTrigLevel</td>
<td>External Signal &amp; Triggering:</td>
<td>Specify the threshold value the trigger signal must cross to fire the trigger.</td>
</tr>
<tr>
<td>integer (0)</td>
<td>Level text field</td>
<td></td>
</tr>
<tr>
<td>ExtModeTrigMode</td>
<td>External Signal &amp; Triggering:</td>
<td>Specify whether the trigger is to rearm automatically after each trigger event or whether only one buffer of data is to be collected each time the trigger is armed.</td>
</tr>
<tr>
<td>character vector - normal, oneshot</td>
<td>Mode menu</td>
<td></td>
</tr>
<tr>
<td>ExtModeTrigPort</td>
<td>External Signal &amp; Triggering:</td>
<td>Specify the input port of the specified trigger block for which elements can cause the trigger to fire.</td>
</tr>
<tr>
<td>character vector - integer (1), last</td>
<td>Port text field</td>
<td></td>
</tr>
<tr>
<td>ExtModeTrigType</td>
<td>External Signal &amp; Triggering:</td>
<td>Specify whether to start logging data when the trigger is armed or when a specified trigger signal satisfies trigger conditions.</td>
</tr>
<tr>
<td>character vector - manual, signal</td>
<td>Source menu</td>
<td></td>
</tr>
<tr>
<td>ExtModeUploadStatus</td>
<td>Not available</td>
<td>Return the status of the external mode upload mechanism — inactive, armed, or uploading.</td>
</tr>
<tr>
<td>character vector - inactive, armed, uploading</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ExtModeWriteAllDataToWs</td>
<td>Enable Data Archiving: Write</td>
<td>Write intermediate results to the workspace.</td>
</tr>
<tr>
<td>off, on</td>
<td>intermediate results to workspace</td>
<td></td>
</tr>
<tr>
<td></td>
<td>check box</td>
<td></td>
</tr>
</tbody>
</table>
Animate Stateflow Charts in External Mode

If you have Stateflow, you can animate a chart in external mode. In external mode, you can animate states in a chart, and view test point signals in a floating scope or signal viewer.

- “Animate States During Simulation in External Mode” on page 28-83
- “View Test Point Data in Floating Scopes and Signal Viewers” on page 28-84

Animate States During Simulation in External Mode

To animate states in a chart in external mode:

1. Load the chart you want to animate to the target machine.
2. Open the Model Configuration Parameters dialog box.
3. In the left Select pane, select Code Generation > Interface.
4. In the Data exchange interface section, select External mode and click OK.
5. In the Simulink Editor, select Code > External Mode Control Panel.
6. In the External Mode Control Panel dialog box, click Signal & Triggering.
7. In the External Signal & Triggering dialog box, set these parameters.

<table>
<thead>
<tr>
<th>In:</th>
<th>Select:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal selection pane</td>
<td>Chart you want to animate</td>
</tr>
<tr>
<td>Trigger pane</td>
<td>Arm when connecting to target check box</td>
</tr>
<tr>
<td>Trigger pane</td>
<td>normal from drop-down menu in Mode field</td>
</tr>
</tbody>
</table>

8. Build the model to generate an executable file.
9. Start the target in the background. At the MATLAB prompt, type:

   \!model_name.exe -w &

   For example, if the name of your model is my_control_sys, enter this command:

   \!my_control_sys.exe -w &

   -w allows the target code to wait for the Simulink model connection.
10. In the Model Editor, select Simulation > Mode > External, and then select Simulation > Connect to Target.
11 Start simulation. The chart highlights states as they execute.

View Test Point Data in Floating Scopes and Signal Viewers

When you simulate a chart in external mode, you can designate chart data of local scope to be test points and view the test point data in floating scopes and signal viewers.

To view test point data during simulation in external mode:

1 Open the Model Explorer and for each data you want to view, follow these steps:
   a In the middle Contents pane, select the state or local data of interest.
   b In the right Dialog pane, select the Logging tab and select Test point check box.

2 From a floating scope or signal viewer, click the signal selection button:

   ![Signal Selector button]

   The Signal Selector dialog box opens.

3 In the Signal Selector Model hierarchy pane, select the chart.

4 In the Signal Selector List contents menu, select Testpointed/Logged signals only and then select the signals you want to view.

5 Simulate the model in external mode as described in “Animate States During Simulation in External Mode” on page 28-83.

   The scope or viewer displays the values of the test point signals as the simulation runs.

For more information, see “Behavior of Scopes and Viewers with Rapid Accelerator Mode” (Simulink).
## TCP/IP and Serial External Mode Limitations

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing parameters</td>
<td>In general, you cannot change a parameter if doing so results in a change in the structure of the model. For example, you cannot change</td>
</tr>
<tr>
<td></td>
<td>• The number of states, inputs, or outputs of a block</td>
</tr>
<tr>
<td></td>
<td>• The sample time or the number of sample times</td>
</tr>
<tr>
<td></td>
<td>• The integration algorithm for continuous systems</td>
</tr>
<tr>
<td></td>
<td>• The name of the model or of a block</td>
</tr>
<tr>
<td></td>
<td>• The parameters to the Fcn block</td>
</tr>
<tr>
<td></td>
<td>If you make these changes to the block diagram, then you must rebuild the program with newly generated code.</td>
</tr>
<tr>
<td></td>
<td>You can change parameters in transfer function and state space representation blocks in specific ways:</td>
</tr>
<tr>
<td></td>
<td>• The parameters (numerator and denominator polynomials) for the Transfer Fcn (continuous and discrete) and Discrete Filter blocks can be changed (as long as the number of states does not change).</td>
</tr>
<tr>
<td></td>
<td>• Zero entries in the State-Space and Zero Pole (both continuous and discrete) blocks in the user-specified or computed parameters (that is, the A, B, C, and D matrices obtained by a zero-pole to state-space transformation) cannot be changed once external simulation is started.</td>
</tr>
<tr>
<td></td>
<td>• In the State-Space block, if you specify the matrices in the controllable canonical realization, then all changes to the A, B, C, D matrices that preserve this realization and the dimensions of the matrices are allowed.</td>
</tr>
<tr>
<td></td>
<td>If the Simulink block diagram does not match the external program, Simulink produces an error stating that the checksums do not match. The checksums take into account the top models, but not referenced models. Use the updated block diagram to rebuild the target application.</td>
</tr>
<tr>
<td>Feature</td>
<td>Details</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mixing 32-bit and 64-bit</td>
<td>When you use external mode, the machine running the Simulink product and the machine running the target executable must have matching bit architectures, either 32-bit or 64-bit. The Simulink Coder software varies a model's checksum based on whether it is configured for a 32-bit or 64-bit platform. If you attempt to connect from a 32-bit machine to a 64-bit machine or vice versa, the external mode connection fails.</td>
</tr>
<tr>
<td>architectures</td>
<td></td>
</tr>
<tr>
<td>Uploading data</td>
<td>Uploading of data values for fixed-point or enumerated types to workspace parameters is not supported.</td>
</tr>
<tr>
<td>Uploading variable-size signals</td>
<td>Uploading of variable-size signals is not supported for these targets:</td>
</tr>
<tr>
<td></td>
<td>• Simulink Real-Time</td>
</tr>
<tr>
<td></td>
<td>• Texas Instruments™ C2000™</td>
</tr>
<tr>
<td>Signal value display in</td>
<td>Graphical display of signal values in models (described in “Displaying Signal Values in Model Diagrams” (Simulink)) is not supported. For example, you cannot use the Data Display in Simulation menu selections Show Value Labels When Hovering, Toggle Value Labels When Clicked, and Show Value Label of Selected Port.</td>
</tr>
<tr>
<td>simulation</td>
<td></td>
</tr>
<tr>
<td>Tunable structure parameters</td>
<td>Uploading or downloading of tunable structure parameters is not supported.</td>
</tr>
<tr>
<td>Feature</td>
<td>Details</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Pure integer code</td>
<td>Pure integer code is supported. If you do not specify -tf finalTime in the execution command, the target application runs the generated model code indefinitely, ignoring StopTime. If you specify -tf finalTime in the execution command:</td>
</tr>
<tr>
<td></td>
<td>• The finalTime value represents base rate clock ticks, not seconds.</td>
</tr>
<tr>
<td></td>
<td>• The maximum value for finalTime, in ticks, is MAX_int32_T.</td>
</tr>
<tr>
<td></td>
<td>• When the 16-bit or 32-bit tick counter overflows, the simulation time in Scope blocks returns to zero.</td>
</tr>
<tr>
<td>Archiving data</td>
<td>For archiving data to disk, Scope and To Workspace blocks are supported. However, other scopes are not supported for data archiving. For example, you cannot use Floating Scope blocks or Signal and Scope Manager viewer objects to archive data.</td>
</tr>
<tr>
<td>Scopes in referenced models</td>
<td>In a model hierarchy, if the top model simulates in external mode and a referenced model simulates in normal or accelerator mode, scopes in the referenced model are not displayed.</td>
</tr>
<tr>
<td></td>
<td>However, if the top model is changed to simulate in normal mode, the behavior of scopes in the referenced models differs between normal and accelerator mode. Scopes in a referenced model simulating in normal mode are displayed, while scopes in a referenced model simulating in accelerator mode are not displayed.</td>
</tr>
<tr>
<td>Simulation start time</td>
<td>Nonzero simulation start times are not supported. In the Configuration Parameters dialog box, Solver pane, leave Start time set to the default value of 0.0.</td>
</tr>
<tr>
<td>File-scoped data</td>
<td>File-scoped data are not supported, for example, data items to which you apply the built-in custom storage class, FileScope. File-scoped data are not externally accessible.</td>
</tr>
<tr>
<td>Feature</td>
<td>Details</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>Signals with custom storage classes</td>
<td>Uploading of signals with custom storage classes (CSC) is not supported.</td>
</tr>
<tr>
<td>Use of printf Statements</td>
<td>You can use printf calls to display error and information messages from the target application. For some target hardware, the use of printf statements can increase the external mode binary file size. To disable printf calls, specify the preprocessor macro definition <code>EXTMODE_DISABLEPRINTF</code> for your target application compiler.</td>
</tr>
</tbody>
</table>
| Command-line arguments | You can use command-line arguments for running target applications. These limitations apply:  
- Parsing of the command-line arguments requires the `sscanf` function, which increases the program size for some target hardware.  
- Some target applications do not accept command-line arguments.  
If your target hardware does not support the parsing of command-line arguments, specify the preprocessor macro definition `EXTMODE_DISABLE_ARGS_PROCESSING=1` for your target application compiler.  
To replace the `-w` option, you can use this command to specify that the target application enters and stays in a wait state until it receives a Connect message from Simulink:  
```  
set_param(modelName, 'OnTargetWaitForStart', 'on');  
```
| Row-major code generation | Code generated with the row-major format is not supported. |
See Also

More About

- “External Mode Simulation with XCP Communication” on page 28-8
- “Create a Transport Layer for TCP/IP or Serial External Mode Communication” on page 28-90
Create a Transport Layer for TCP/IP or Serial External Mode Communication

In this section...

| “Design of External Mode” on page 28-90 |
| “External Mode Communications Overview” on page 28-93 |
| “External Mode Source Files” on page 28-94 |
| “Implement a Custom Transport Layer” on page 28-98 |

This section helps you to connect your custom target by using external mode using your own low-level communications layer. The topics include:

- An overview of the design and operation of external mode
- A description of external mode source files
- Guidelines for modifying the external mode source files and building an executable to handle the tasks of the default `ext_comm` MEX-file

This section assumes that you are familiar with the execution of Simulink Coder programs, and with the basic operation of external mode.

Design of External Mode

External mode communication between the Simulink engine and a target system is based on a client/server architecture. The client (the Simulink engine) transmits messages requesting the server (target) to accept parameter changes or to upload signal data. The server responds by executing the request.

A low-level transport layer handles physical transmission of messages. Both the Simulink engine and the model code are independent of this layer. Both the transport layer and code directly interfacing to the transport layer are isolated in separate modules that format, transmit, and receive messages and data packets.

This design makes it possible for different targets to use different transport layers. The GRT, ERT, and RSim targets support host/target communication by using TCP/IP and RS-232 (serial) communication. The Simulink Desktop Real-Time target supports shared memory communication. The Wind River Systems Tornado® target supports TCP/IP only.
The Simulink Coder product provides full source code for both the client and server-side external mode modules, as used by the GRT, ERT, Rapid Simulation, and Tornado targets, and the Simulink Desktop Real-Time and Simulink Real-Time products. The main client-side module is `ext_comm.c`. The main server-side module is `ext_svr.c`.

These two modules call the specified transport layer through the following source files.

### Built-In Transport Layer Implementations

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Client or Server?</th>
<th>Source Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP</td>
<td>Client (host)</td>
<td>• <code>matlabroot/toolbox/coder/simulinkcoder_core/ext_mode/host/common/rtiostream_interface.c</code>&lt;br&gt;• <code>matlabroot/rtw/c/src/rtiostream/rtiostreamtcpip/rtiostream_tcpip.c</code></td>
</tr>
<tr>
<td></td>
<td>Server (target)</td>
<td>• <code>matlabroot/rtw/c/src/ext_mode/common/rtiostream_interface.c</code>&lt;br&gt;• <code>matlabroot/rtw/c/src/rtiostream/rtiostreamtcpip/rtiostream_tcpip.c</code></td>
</tr>
<tr>
<td>Serial</td>
<td>Client (host)</td>
<td>• <code>matlabroot/toolbox/coder/simulinkcoder_core/ext_mode/host/serial/ext_serial_transport.c</code>&lt;br&gt;• <code>matlabroot/rtw/c/src/rtiostream/rtiostreamserial/rtiostream_serial.c</code></td>
</tr>
<tr>
<td></td>
<td>Server (target)</td>
<td>• <code>matlabroot/rtw/c/src/ext_mode/serial/ext_svr_serial_transport.c</code>&lt;br&gt;• <code>matlabroot/rtw/c/src/rtiostream/rtiostreamserial/rtiostream_serial.c</code></td>
</tr>
</tbody>
</table>

For serial communication, the modules `ext_serial_transport.c` and `rtiostream_serial.c` implement the client-side transport functions and the modules `ext_svr_serial_transport.c` and `rtiostream_serial.c` implement the corresponding server-side functions. For TCP/IP communication, the modules `rtiostream_interface.c` and `rtiostream_tcpip.c` implement both client-side and server-side functions. You can edit copies of these files (but do not modify the originals). You can support external mode using your own low-level communications layer by creating similar files using the following templates:
The file `rtiostream_interface.c` is an interface between the external mode protocol and an `rtiostream` communications channel. For more details on implementing an `rtiostream` communications channel, see “Communications `rtiostream` API” (Embedded Coder). Implement your `rtiostream` communications channel by using the documented interface to avoid having to make changes to the file `rtiostream_interface.c` or other external mode related files.

**Note** Do not modify working source files. Use the templates provided in the `/custom` or `/rtiostream` folder as starting points, guided by the comments within them.

You need only provide code that implements low-level communications. You need not be concerned with issues such as data conversions between host and target, or with the formatting of messages. The Simulink Coder software handles these functions.

On the client (Simulink engine) side, communications are handled by `ext_comm` (for TCP/IP) and `ext_serial_win32_comm` (for serial) MEX-files.

On the server (target) side, external mode modules are linked into the target executable. This takes place automatically if the **External mode** code generation option is selected at code generation time, based on the **External mode transport** option selected in the target code generation options dialog box. These modules, called from the main program and the model execution engine, are independent of the generated model code.

The general procedure for implementing your own client-side low-level transport protocol is as follows:

1. Edit the template `rtiostream_tcpip.c` to replace low-level communication calls with your own communication calls.
2. Generate a MEX-file executable for your custom transport.
3. Register your new transport layer with the Simulink software, so that the transport can be selected for a model using the **Interface** pane of the Configuration Parameters dialog box.
For more details, see “Create a Custom Client (Host) Transport Protocol” on page 28-99.

The general procedure for implementing your own server-side low-level transport protocol is as follows:

1. Edit the template rtiostream_tcppip.c to replace low-level communication calls with your own communication calls. Typically this involves writing or integrating device drivers for your target hardware.

2. Modify template makefiles to support the new transport.

For more details, see “Create a Custom Server (Target) Transport Protocol” on page 28-102.

**External Mode Communications Overview**

This section gives a high-level overview of how a Simulink Coder generated program communicates with Simulink external mode. This description is based on the TCP/IP version of external mode that ships with the Simulink Coder product.

For communication to take place, both the server (target) program and the Simulink software must be executing. This does not mean that the model code in the server system must be executing. The server can be waiting for the Simulink engine to issue a command to start model execution.

The client and server communicate by using bidirectional sockets carrying packets. Packets consist either of messages (commands, parameter downloads, and responses) or data (signal uploads).

If the target application was invoked with the -w command-line option, the program enters a wait state until it receives a message from the host. Otherwise, the program begins execution of the model. While the target application is in a wait state, the Simulink engine can download parameters to the target and configure data uploading.

When the user chooses the Connect to Target option from the Simulation menu, the host initiates a handshake by sending an EXT_CONNECT message. The server responds with information about itself. This information includes:

- Checksums. The host uses model checksums to determine that the target code is an exact representation of the current Simulink model.
- Data format information. The host uses this information when formatting data to be downloaded, or interpreting data that has been uploaded.
At this point, host and server are connected. The server is either executing the model or in the wait state. (In the latter case, the user can begin model execution by selecting **Start Real-Time Code** from the **Simulation** menu.)

During model execution, the message server runs as a background task. This task receives and processes messages such as parameter downloads.

Data uploading comprises both foreground execution and background servicing of the signal packets. As the target computes model outputs, it also copies signal values into data upload buffers. This occurs as part of the task associated with each task identifier (tid). Therefore, data collection occurs in the foreground. Transmission of the collected data, however, occurs as a background task. The background task sends the data in the collection buffers to the Simulink engine by using data packets.

The host initiates most exchanges as messages. The target usually sends a response confirming that it has received and processed the message. Examples of messages and commands are:

- Connection message / connection response
- Start target simulation / start response
- Parameter download / parameter download response
- Arm trigger for data uploading / arm trigger response
- Terminate target simulation / target shutdown response

Model execution terminates when the model reaches its final time, when the host sends a terminate command, or when a Stop Simulation block terminates execution. On termination, the server informs the host that model execution has stopped, and shuts down its socket. The host also shuts down its socket, and exits external mode.

**External Mode Source Files**

- “Client (Host) MEX-file Interface Source Files” on page 28-94
- “Server (Target) Source Files” on page 28-96
- “Other Files in the Server Folder” on page 28-98

**Client (Host) MEX-file Interface Source Files**

The source files for the MEX-file interface component are located in the folder `matlabroot/toolbox/coder/simulinkcoder_core/ext_mode/host (open)`, except as noted:
• common/ext_comm.c

This file is the core of external mode communication. It acts as a relay station between the target and the Simulink engine. ext_comm.c communicates to the Simulink engine by using a shared data structure, ExternalSim. It communicates to the target by using calls to the transport layer.

Tasks carried out by ext_comm.c include establishment of a connection with the target, downloading of parameters, and termination of the connection with the target.

• common/rtiostream_interface.c

This file is an interface between the external mode protocol and an rtiostream communications channel. For more details on implementing an rtiostream communications channel, see “Communications rtiostream API” (Embedded Coder). Implement your rtiostream communications channel using the documented interface to avoid having to change the file rtiostream_interface.c or other external mode related files.

• matlabroot/rtw/c/src/rtiostream/rtiostreamtcpip/rtiostream_tcpip.c

This file implements required TCP/IP transport layer functions. The version of rtiostream_tcpip.c shipped with the Simulink Coder software uses TCP/IP functions including recv(), send(), and socket().

• matlabroot/rtw/c/src/rtiostream/rtiostreamserial/rtiostream_serial.c

This file implements required serial transport layer functions. The version of rtiostream_serial.c shipped with the Simulink Coder software uses serial functions including ReadFile(), WriteFile(), and CreateFile().

• serial/ext_serial_transport.c

This file implements required serial transport layer functions. ext_serial_transport.c includes ext_serial_utils.c, which is located in matlabroot/rtw/c/src/ext_mode/serial (open) and contains functions common to client and server sides.

• common/ext_main.c

This file is a MEX-file wrapper for external mode. ext_main.c interfaces to the Simulink engine by using the standard mexFunction call. (See the mexFunction reference page and “MATLAB API for Other Languages” (MATLAB) for more
ext_main.c contains a function dispatcher, esGetAction, that sends requests from the Simulink engine to ext_comm.c.

- common/ext_convert.c and ext_convert.h

This file contains functions used for converting data from host to target formats (and vice versa). Functions include byte-swapping (big to little-endian), conversion from non-IEEE floats to IEEE doubles, and other conversions. These functions are called both by ext_comm.c and directly by the Simulink engine (by using function pointers).

**Note** You do not need to customize ext_convert to implement a custom transport layer. However, you might want to customize ext_convert for the intended target. For example, if the target represents the float data type in Texas Instruments format, ext_convert must be modified to perform a Texas Instruments to IEEE conversion.

- common/extsim.h

This file defines the ExternalSim data structure and access macros. This structure is used for communication between the Simulink engine and ext_comm.c.

- common/extutil.h

This file contains only conditionals for compilation of the assert macro.

- common/ext_transport.h

This file defines functions that must be implemented by the transport layer.

**Server (Target) Source Files**

These files are linked into the model.exe executable. They are located within matlabroot/rtw/c/src/ext_mode (open) except as noted.

- common/ext_svr.c

ext_svr.c is analogous to ext_comm.c on the host, but generally is responsible for more tasks. It acts as a relay station between the host and the generated code. Like ext_comm.c, ext_svr.c carries out tasks such as establishing and terminating connection with the host. ext_svr.c also contains the background task functions that either write downloaded parameters to the target model, or extract data from the target data buffers and send it back to the host.

- common/rtiostream_interface.c
This file is an interface between the external mode protocol and an rtiostream communications channel. For more details on implementing an rtiostream communications channel, see “Communications rtiostream API” (Embedded Coder). Implement your rtiostream communications channel by using the documented interface to avoid having to change the file rtiostream_interface.c or other external mode related files.

- `matlabroot/rtw/c/src/rtiostream/rtiostreamtcpip/rtiostream_tcpip.c`

  This file implements required TCP/IP transport layer functions. The version of rtiostream_tcpip.c shipped with the Simulink Coder software uses TCP/IP functions including `recv()`, `send()`, and `socket()`.

- `matlabroot/rtw/c/src/rtiostream/rtiostreamserial/rtiostream_serial.c`

  This file implements required serial transport layer functions. The version of rtiostream_serial.c shipped with the software uses serial functions including `ReadFile()`, `WriteFile()`, and `CreateFile()`.

- `matlabroot/rtw/c/src/rtiostream.h`

  This file defines the `rtIOStream*` functions implemented in rtiostream_tcpip.c.

- `serial/ext_svr_serial_transport.c`

  This file implements required serial transport layer functions.
  ext_svr_serial_transport.c includes serial/ext_serial_utils.c, which contains functions common to client and server sides.

- `common/updown.c`

  updown.c handles the details of interacting with the target model. During parameter downloads, updown.c does the work of installing the new parameters into the model’s parameter vector. For data uploading, updown.c contains the functions that extract data from the model’s blockio vector and write the data to the upload buffers.
  updown.c provides services both to ext_svr.c and to the model code (for example, grt_main.c). It contains code that is called by using the background tasks of ext_svr.c as well as code that is called as part of the higher priority model execution.

- `matlabroot/rtw/c/src/dt_info.h` (included by generated model build file model.h)
These files contain data type transition information that allows access to multi-data type structures across different computer architectures. This information is used in data conversions between host and target formats.

- **common/updown_util.h**
  
  This file contains only conditionals for compilation of the `assert` macro.

- **common/ext_svr_transport.h**
  
  This file defines the Ext* functions that must be implemented by the server (target) transport layer.

### Other Files in the Server Folder

- **common/ext_share.h**
  
  Contains message code definitions and other definitions required by both the host and target modules.

- **serial/ext_serial-utils.c**
  
  Contains functions and data structures for communication, MEX link, and generated code required by both the host and target modules of the transport layer for serial protocols.

  - The serial transport implementation includes the additional files
    - **serial/ext_serial_pkt.c** and **ext_serial_pkt.h**
    - **serial/ext_serial_port.h**

### Implement a Custom Transport Layer

- “Requirements for Custom Transport Layers” on page 28-99
- “Create a Custom Client (Host) Transport Protocol” on page 28-99
- “MATLAB Commands to Rebuild ext_comm and ext_serial_win32 MEX-Files” on page 28-100
- “Register a Custom Client (Host) Transport Protocol” on page 28-101
- “Create a Custom Server (Target) Transport Protocol” on page 28-102
- “Serial Receive Buffer Smaller than 64 Bytes” on page 28-104
Requirements for Custom Transport Layers

- By default, ext_svr.c and updown.c use malloc to allocate buffers in target memory for messages, data collection, and other purposes, although there is also an option to preallocate static memory. If your target uses another memory allocation scheme, you must modify these modules.
- The target is assumed to support both int32_T and uint32_T data types.

Create a Custom Client (Host) Transport Protocol

To implement the client (host) side of your low-level transport protocol,

1. Edit the template file `matlabroot/rtw/c/src/rtiostream/rtiostreamtcpip/rtiostream_tcpip.c` to replace low-level communication calls with your own communication calls.
   
   a. Copy and rename the file to `rtiostream_name.c` (replacing `name` with a name meaningful to you).

   b. Replace the functions `rtIostreamOpen`, `rtIostreamClose`, `rtIostreamSend`, and `rtIostreamRecv` with functions (of the same name) that call your low-level communication primitives. These functions are called from other external mode modules via `rtiostream_interface.c`. For more information, see “Communications rtiostream API” (Embedded Coder).

   c. Build your `rtiostream` implementation into a shared library that exports the `rtIostreamOpen`, `rtIostreamClose`, `rtIostreamRecv` and `rtIostreamSend` functions.

2. Build the customized MEX-file executable using the MATLAB `mex` function. See “MATLAB Commands to Rebuild ext_comm and ext_serial_win32 MEX-Files” on page 28-100 for examples of `mex` invocations.

   Do not replace the existing `ext_comm` MEX-file if you want to preserve its existing function. Instead, use the `-output` option to name the resulting executable (for example, `mex -output ext_myrtiostream_comm ... builds ext_myrtiostream_comm.mexext`, on Windows platforms).

3. Register your new client transport layer with the Simulink software, so that the transport can be selected for a model using the Interface pane of the Configuration Parameters dialog box. For details, see “Register a Custom Client (Host) Transport Protocol” on page 28-101.
Sample commands for rebuilding external mode MEX-files are listed in “MATLAB Commands to Rebuild ext_comm and ext_serial_win32 MEX-Files” on page 28-100.

### MATLAB Commands to Rebuild ext_comm and ext_serial_win32 MEX-Files

The following table lists the commands for building the standard ext_comm and ext_serial_win32 modules on PC and UNIX platforms.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows, TCP/IP</td>
<td><code>&gt;&gt; cd (matlabroot)</code>&lt;br&gt;<code>&gt;&gt; mex toolbox\coder\simulinkcoder_core\ext_mode\host\common\ext_comm.c ...</code>&lt;br&gt;<code>toolbox\coder\simulinkcoder_core\ext_mode\host\common\ext_convert.c ...</code>&lt;br&gt;<code>toolbox\coder\simulinkcoder_core\ext_mode\host\common\rtiostream_interface.c ...</code>&lt;br&gt;<code>toolbox\coder\simulinkcoder_core\ext_mode\host\common\ext_util.c ...&lt;br&gt;</code>-Irtw\c\src -Irtw\c\src\rtiostream\utils ...<code>&lt;br&gt;</code>-Irtw\c\src\ext_mode\common ...<code>&lt;br&gt;</code>-Itoolbox\coder\simulinkcoder_core\ext_mode\host\common ...<code>&lt;br&gt;</code>-Itoolbox\coder\simulinkcoder_core\ext_mode\host\common\include ...<code>&lt;br&gt;</code>-lmwrtiostreamutils -lsl_services ...<code>&lt;br&gt;</code>-DEXTMODE_TCPIP_TRANSPORT ...<code>&lt;br&gt;</code>-DSL_EXT_DLL -output toolbox\coder\simulinkcoder_core\ext_comm`</td>
</tr>
<tr>
<td>Linux, TCP/IP</td>
<td>Use the Windows commands, with these changes:&lt;br&gt;• Change -DSL_EXT_DLL to -DSL_EXT_SO.&lt;br&gt;• Change -lsl_services to -lmwsl_services.&lt;br&gt;• Replace back slashes with forward slashes.</td>
</tr>
<tr>
<td>Mac, TCP/IP</td>
<td>Use the Windows commands, with these changes:&lt;br&gt;• Change -DSL_EXT_DLL to -DSL_EXT_DYLIB.&lt;br&gt;• Change -lsl_services to -lmwsl_services.&lt;br&gt;• Replace back slashes with forward slashes.</td>
</tr>
</tbody>
</table>
### Platform | Commands
---|---
Windows, serial | ```
>> cd (matlabroot)
>> mex toolbox\coder\simulinkcoder_core\ext_mode\host\common\ext_comm.c ...
toolbox\coder\simulinkcoder_core\ext_mode\host\common\ext_convert.c ...
toolbox\coder\simulinkcoder_core\ext_mode\host\serial\ext_serial_transport.c ...
toolbox\coder\simulinkcoder_core\ext_mode\host\serial\ext_serial_pkt.c ...
toolbox\coder\simulinkcoder_core\ext_mode\host\serial\rtiostream_serial_interface.c ...
toolbox\coder\simulinkcoder_core\ext_mode\host\common\ext_util.c ...
-Irtw\c\src -Irtw\c\src\rtiostream\utils ...
-Irtw\c\src\ext_mode\common ...
-Irtw\c\src\ext_mode\serial ...
-Itoolbox\coder\simulinkcoder_core\ext_mode\host\common ...
-Itoolbox\coder\simulinkcoder_core\ext_mode\host\common\include ...
-lmwrtiostreamutils -lsl_services ...
-DEXTMODE_SERIAL_TRANSPORT -DSL_EXT_DLL ...
-output toolbox\coder\simulinkcoder_core\ext_serial_win32_comm
```  
**Note** The `rtiostream_interface.c` function defines `RTISTREAM_SHARED_LIB` as `libmwrtiostreamserial` and dynamically loads the MathWorks serial `rtiostream` shared library. Modify this file if you need to load a different `rtiostream` shared library.

Linux, serial | Use the Windows commands, with these changes:
- Change `-DSL_EXT_DLL` to `-DSL_EXT_SO`.
- Change `-lsl_services` to `-lmwsl_services`.
- Replace back slashes with forward slashes.

Mac, serial | Use the Windows commands, with these changes:
- Change `-DSL_EXT_DLL` to `-DSL_EXT_DYLIB`.
- Change `-lsl_services` to `-lmwsl_services`.
- Replace back slashes with forward slashes.

**Note** `mex` requires a compiler supported by the MATLAB API. See the `mex` reference page and “MATLAB API for Other Languages” (MATLAB) for more information about the `mex` function.

### Register a Custom Client (Host) Transport Protocol
To register a custom client transport protocol with the Simulink software, you must add an entry of the following form to an `sl_customization.m` file on the MATLAB path:
function sl_customization(cm)
    cm.ExtModeTransports.add('stf.tlc', 'transport', 'mexfile', 'Level1');
% -- end of sl_customization

where

- **stf.tlc** is the name of the system target file for which the transport will be registered (for example, 'grt.tlc')
- **transport** is the transport name to display in the **Transport layer** menu on the **Interface** pane of the Configuration Parameters dialog box (for example, 'mytcpip')
- **mexfile** is the name of the transport's associated external interface MEX-file (for example, 'ext_mytcpip_comm')

You can specify multiple targets and/or transports with additional `cm.ExtModeTransports.add` lines, for example:

```matlab
function sl_customization(cm)
    cm.ExtModeTransports.add('grt.tlc', 'mytcpip', 'ext_mytcpip_comm', 'Level1');
    cm.ExtModeTransports.add('ert.tlc', 'mytcpip', 'ext_mytcpip_comm', 'Level1');
% -- end of sl_customization
```

If you place the `sl_customization.m` file containing the transport registration information on the MATLAB path, your custom client transport protocol will be registered with each subsequent Simulink session. The name of the transport will appear in the **Transport layer** menu on the **Interface** pane of the Configuration Parameters dialog box. When you select the transport for your model, the name of the associated external interface MEX-file will appear in the noneditable **MEX-file name** field, as shown in the following figure.

![Figure: Custom Server (Target) Transport Protocol](image)

### Create a Custom Server (Target) Transport Protocol

The `rtIOStream*` function prototypes in `matlabroot/rtw/c/src/rtiostream.h` define the calling interface for both the server (target) and client (host) side transport layer functions.
The TCP/IP implementations are in `matlabroot/rtw/c/src/rtiostream/rtiostreamtcpip/rtiostream_tcip.c`.

The serial implementations are in `matlabroot/rtw/c/src/rtiostream/rtiostreamserial/rtiostream_serial.c`.

**Note** The Ext* function prototypes in `matlabroot/rtw/c/src/ext_mode/common/ext_svr_transport.h` are implemented in `matlabroot/rtw/c/src/ext_mode/common/rtiostream_interface.c` or `matlabroot/rtw/c/src/ext_mode/serial/rtiostream_serial_interface.c`. In most cases you will not need to modify `rtiostream_interface.c` or `rtiostream_serial_interface.c` for your custom TCP/IP or serial transport layer.

To implement the server (target) side of your low-level TCP/IP or serial transport protocol:

1. Edit the template `matlabroot/rtw/c/src/rtiostream/rtiostreamtcpip/rtiostream_tcip.c` or `matlabroot/rtw/c/src/rtiostream/rtiostreamserial/rtiostream_serial.c` to replace low-level communication calls with your own communication calls.
   
   a. Copy and rename the file to `rtiostream_name.c` (replacing `name` with a name meaningful to you).
   
   b. Replace the functions `rtIOStreamOpen`, `rtIOStreamClose`, `rtIOStreamSend`, and `rtIOStreamRecv` with functions (of the same name) that call your low-level communication drivers.

   You must implement the functions defined in `rtiostream.h`, and your implementations must conform to the prototypes defined in that file. Refer to the original `rtiostream_tcip.c` or `rtiostream_serial.c` for guidance.

2. Incorporate the external mode source files for your transport layer into the model build process. Use a build process mechanism such as a post code generation command or a before_make hook function to make the transport files available to the build process. For more information on the build process mechanisms, see “Customize Post-Code-Generation Build Processing” on page 37-14, “Customize Build Process with STF_make_rtw_hook File” on page 37-50, and “Customize Build Process with sl_customization.m” on page 37-55.

For example:
• Add the file created in the previous step to the build information:
  
  `path/rtiostream_name.c`

• For TCP/IP, add the following file to the build information:
  
  `matlabroot/rtw/c/src/ext_mode/common/rtiostream_interface.c`

• For serial, add the following files to the build information:
  
  `matlabroot/rtw/c/src/ext_mode/serial/ext_serial_pkt.c`
  `matlabroot/rtw/c/src/ext_mode/serial/rtiostream_serial_interface.c`
  `matlabroot/rtw/c/src/ext_mode/serial/ext_svr_serial_transport.c`

**Note** For external mode, check that `rtIOStreamRecv` is not a blocking implementation. Otherwise, it might cause the external mode server to block until the host sends data through the `comm` layer.

### Serial Receive Buffer Smaller than 64 Bytes

For serial communication, if the serial receive buffer of your target is smaller than 64 bytes:

1. Update the following macro with the actual target buffer size:
   
   ```
   #define TARGET_SERIAL_RECEIVE_BUFFER_SIZE 64
   ```

   Implement the change in the following files:
   
   `matlabroot/rtw/c/src/ext_mode/serial/ext_serial_utils.c`
   `matlabroot/toolbox/coder/simulinkcoder_core/ext_mode/host/serial/ext_serial_utils.c`

2. Run the command to rebuild the `ext_serial_win32` MEX-file. See “MATLAB Commands to Rebuild `ext_comm` and `ext_serial_win32` MEX-Files” on page 28-100.

### See Also

**Related Examples**

- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
- “External Mode Simulation with TCP/IP or Serial Communication” on page 28-36
• “Host-Target Communication with External Mode Simulation” on page 28-2
• “Customize XCP Slave Software” on page 28-22
Logging in Simulink Coder
Log Program Execution Results

Multiple techniques are available by which a program generated by the Simulink Coder software can save data to a MAT-file for analysis. A generated executable can save system states, outputs, and simulation time at each model execution time step. The data is written to a MAT-file, named (by default) model.mat, where model is the name of your model. See “Log Data for Analysis” on page 29-2 for a data logging tutorial.

**Note** Data logging is available only for system target files that have access to a file system. In addition, only the RSim target executables are capable of accessing MATLAB workspace data.

For MAT-file logging limitations, see the configuration parameter “MAT-file logging”.

Log Data for Analysis

- “Set Up and Configure Model” on page 29-2
- “Data Logging During Simulation” on page 29-3
- “Data Logging from Generated Code” on page 29-7

Set Up and Configure Model

This example shows how data generated by a copy of the model slexAircraftExample is logged to the file myAircraftExample.mat. Refer to “Build Process Workflow for Real-Time Systems” on page 27-32 for instructions on setting up a copy of slexAircraftExample as myAircraftExample in a working folder if you have not done so already.

**Note** When you configure the code generator to produce code that includes support for data logging during execution, the code generator can include text for block names in the block paths included in the log file. If the text includes characters that are unrepresented in the character set encoding for the model, the code generator replaces the characters with XML escape sequences. For example, the code generator replaces the Japanese full-width Katakana letter ‘𤯽’ with the escape sequence &#x30A2; . For more information, see “Internationalization and Code Generation” on page 20-2.
To configure data logging, open the Configuration Parameters dialog box and select the Data Import/Export pane. The process is the same as configuring a Simulink model to save output to the MATLAB workspace. For each workspace return variable you define and enable, the Simulink Coder software defines a parallel MAT-file variable. For example, if you save simulation time to the variable tout, your generated program logs the same data to a variable named rt_tout. You can change the prefix rt_ to a suffix (_rt), or eliminate it entirely. You do this by setting Configuration Parameters > Code Generation > Interface > Advanced parameters > MAT-file variable name modifier.

Simulink lets you log signal data from anywhere in a model. In the Simulink Editor, select the signals that you want to log and then in the Simulation Data Inspector button drop-down, select Log Selected Signals. However, the Simulink Coder software does not use this method of signal logging in generated code. To log signals in generated code, you must either use the Data Import/Export options described below or include To File or To Workspace blocks in your model.

**Note** If you enable MAT-file and signal logging (through the Data Import/Export pane) and select signals for logging (through the Simulink Editor), you see the following warning when you build the model:

Warning: MAT-file logging does not support signal logging. When your model code executes, the signal logging variable 'rt_logsout' will not be saved to the MAT-file.

To avoid this warning, clear the Data Import/Export > Signal logging check box.

In this example, you modify the myAircraftExample model so that the generated program saves the simulation time and system outputs to the file myAircraftExample.mat. Then you load the data into the base workspace and plot simulation time against one of the outputs. The myAircraftExample model should be configured as described in “Build Process Workflow for Real-Time Systems” on page 27-32.

**Data Logging During Simulation**

To use the data logging feature:

1. Open the myAircraftExample model if it is not already open.
2. Open the Configuration Parameters dialog box by selecting Simulation > Model Configuration Parameters from the model window.
3 Select the **Data Import/Export** pane. The **Data Import/Export** pane lets you specify which output data is to be saved to the workspace and what variable names to use for it.

4 Set **Format** to **Structure with time**. When you select this format, Simulink saves the model states and outputs in structures that have their names specified in the **Save to workspace or file** area. By default, the structures are `xout` for states and `yout` for output. The structure used to save output has two top-level fields: `time` and `signals`. The `time` field contains a vector of simulation times and `signals` contains an array of substructures, each of which corresponds to a model output port.

5 Select the **Output** option. This tells Simulink to save output signal data during simulation as a variable named `yout`. Selecting **Output** enables the code generator to create code that logs the root Output block (`alpha`, `rad`) to a MAT-file.

6 Set **Decimation** to 1.

7 If other options are enabled, clear them. The figure below shows how the dialog box should appear.
8 Click **Apply** and **OK** to register your changes and close the dialog box.
9 Save the model.
10 In the model window, double-click the scope symbol next to the Aircraft Dynamics Model block, then run the model by choosing **Simulation** > **Run** in the model window. The resulting scope display is shown below.
11 Verify that the simulation time and outputs have been saved to the base workspace in MAT-files. At the MATLAB prompt, type:

```matlab
whos yout
```

Simulink displays:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Bytes</th>
<th>Class</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>yout</td>
<td>1x1</td>
<td>10756</td>
<td>struct</td>
<td></td>
</tr>
</tbody>
</table>

12 Verify that `alpha, rad` was logged by plotting simulation time versus that variable. In the Command Window, type:

```matlab
plot(yout.time,yout.signals.values)
```

The resulting plot is shown below.
Data Logging from Generated Code

In the second part of this example, you build and run a Simulink Coder executable of the myAircraftExample model that outputs a MAT-file containing the simulation time and output you previously examined. Even though you have already generated code for the myAircraftExample model, you must now regenerate that code because you have changed the model by enabling data logging. The steps below explain this procedure.

To avoid overwriting workspace data with data from simulation runs, the code generator modifies identifiers for variables logged by Simulink. You can control these modifications.

1. Set Configuration Parameters > Code Generation > Interface > Advanced parameters > MAT-file variable name modifier to _rt. This adds the suffix _rt to each variable that you selected to be logged in the first part of this example.

2. Click Apply and OK to register your changes and close the dialog box.

3. Save the model.

4. Build an executable.

5. When the build concludes, run the executable with the command:

   ```bash
   !myAircraftExample
   ```

6. The program now produces two message lines, indicating that the MAT-file has been written.
** starting the model **
** created myAircraftExample.mat **

7 Load the MAT-file data created by the executable and look at the workspace variables from simulation and the generated program by typing:

```matlab
tload myAircraftExample.mat
whos yout*
```

Simulink displays:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Bytes</th>
<th>Class</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>yout</td>
<td>1x1</td>
<td>10756</td>
<td>struct</td>
<td></td>
</tr>
<tr>
<td>yout_rt</td>
<td>1x1</td>
<td>10756</td>
<td>struct</td>
<td></td>
</tr>
</tbody>
</table>

Note the size and bytes of the structures resulting from the simulation run and generated code are the same.

8 Plot the generated code output by entering the following command in the Command Window:

```matlab
plot(yout_rt.time,yout_rt.signals.values)
```

The plot should be identical to the plot that you produced in the previous part of this example.
**Tip** For UNIX platforms, run the executable in the Command Window with the syntax `!./executable_name`. If preferred, run the executable from an OS shell with the syntax `./executable_name`. For more information, see “Run External Commands, Scripts, and Programs” (MATLAB).

## Configure State, Time, and Output Logging

The Data Import/Export pane enables a generated program to save system states, outputs, and simulation time at each model execution time step. The data is written to a MAT-file, named (by default) `model.mat`.

Before using this data logging feature, you should learn how to configure a Simulink model to return output to the MATLAB workspace. This is discussed in “Export Simulation Data” (Simulink).

For each workspace return variable that you define and enable, the code generator defines a MAT-file variable. For example, if your model saves simulation time to the workspace variable `tout`, your generated program logs the same data to a variable named (by default) `rt_tout`.

The code generated by the code generator logs the following data:

- **Root Outport blocks**
  
  The default MAT-file variable name for system outputs is `rt_yout`.

  The sort order of the `rt_yout` array is based on the port number of the Outport block, starting with 1.

- **Continuous and discrete states in the model**

  The default MAT-file variable name for system states is `rt_xout`.

- **Simulation time**

  The default MAT-file variable name for simulation time is `rt_tout`.

- “Override Default MAT-File Variable Names” on page 29-9
- “Override Default MAT-File Name or Buffer Size” on page 29-10

### Override Default MAT-File Variable Names

By default, the code generation software prefixes the text `rt_` to the variable names for system outputs, states, and simulation time to form MAT-file variable names. To change
this prefix for a model, select a prefix (rt_), a suffix (_rt), or no modifier (none) for Configuration Parameters > Code Generation > Interface > Advanced parameters > MAT-file variable name modifier. Other system target files might not support this parameter.

Override Default MAT-File Name or Buffer Size

You can specify compiler options to override the following MAT-file attributes in generated code:

<table>
<thead>
<tr>
<th>MAT-File Attribute</th>
<th>Default</th>
<th>Compiler Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>model.mat</td>
<td>-DSAVEFILE=filename</td>
</tr>
<tr>
<td>Size of data logging buffer</td>
<td>1024 bytes</td>
<td>-DDEFAULT_BUFFER_SIZE=n</td>
</tr>
</tbody>
</table>

**Note** Valid option syntax can vary among compilers. For example, Microsoft Visual C++ compilers typically accept /DSAVEFILE=filename as well as -DSAVEFILE=filename.

For a template makefile (TMF) based target, append the compiler option to the **Make command** field on the **Code Generation** pane of the Configuration Parameters dialog box. For example:

```
Make command:                           make_rtw OPTS="-DSAVEFILE=myCodeLog.mat"
```

For a toolchain-based target such as GRT or ERT, add the compiler option to the **Build configuration** settings on the **Code Generation** pane of the Configuration Parameters dialog box. Set **Build configuration** to **Specify**, and add the compiler option to the **C Compiler** row of the **Tool/Options** table. For example:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>C Compiler</td>
<td>$(cflags) $(CVARSFLAG) $(CFLAGS_ADDITIONAL) -DSAVEFILE=myCodeLog.mat /Od /Oy-</td>
</tr>
</tbody>
</table>

To add the compiler option to a custom toolchain, you can modify and reregister the custom toolchain using the procedures shown in the example “Adding a Custom Toolchain” (MATLAB Coder). For example, to add the compiler option to the MATLAB source file for the custom toolchain, you could define myCompilerOpts as follows:

```matlab
optimsOffOpts   = {'/c /Od'};
optimsOnOpts     = {'/c /O2'};
```
cCompilerOpts = '$(cflags) $(CVARSFLAG) $(CFLAGS_ADDITIONAL)';
cppCompilerOpts = '$(cflags) $(CVARSFLAG) $(CPPFLAGS_ADDITIONAL)';
myCompilerOpts = {' -DSAVEFILE=myCodeLog.mat '};
...

Then you can add `myCompilerOpts` to the flags for each configuration and compiler to which it applies, for example:

```matlab
cfg = tc.getBuildConfiguration('Faster Builds');
cfg.setOption('C Compiler', horzcat(cCompilerOpts, myCompilerOpts, optimsOffOpts));
```

As shown in “Adding a Custom Toolchain” (MATLAB Coder), after modifying the custom toolchain, you save the configuration to a MAT-file and refresh the target registry.

**Log Data with Scope and To Workspace Blocks**

The code generated by the code generator also logs data from these sources:

- Scope blocks that have the **Log data to workspace** parameter enabled

  You must specify the variable name and data format in each Scope block's dialog box.
- To Workspace blocks in the model

  You must specify the variable name and data format in each To Workspace block's dialog box.

The variables are written to `model.mat`, along with variables logged from the **Workspace I/O** pane.

**Log Data with To File Blocks**

You can also log data to a To File block. The generated program creates a separate MAT-file (distinct from `model.mat`) for each To File block in the model. The file contains the block time and input variable(s). You must specify the filename, variable names, decimation, and sample time in the To File block dialog box.

**Note** Models referenced by Model blocks do not perform data logging in that context except for states, which you can include in the state logged for top models. Code generated by the Simulink Coder software for referenced models does not perform data logging to MAT-files.
Data Logging Differences Between Single- and Multitasking

When logging data in single-tasking and multitasking systems, you will notice differences in the logging of

- Noncontinuous root Outport blocks
- Discrete states

In multitasking mode, the logging of states and outputs is done after the first task execution (and not at the end of the first time step). In single-tasking mode, the code generated by the build procedure logs states and outputs after the first time step.

See Data Logging in Single-Tasking and Multitasking Model Execution on page 16-16 for more details on the differences between single-tasking and multitasking data logging.

**Note** The rapid simulation target (RSim) provides enhanced logging options. See “Accelerate, Refine, and Test Hybrid Dynamic System on Host Computer by Using RSim System Target File” on page 24-2 for more information.

See Also

Related Examples

- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Data Interchange Using the C API in Simulink Coder

- “Exchange Data Between Generated and External Code Using C API” on page 30-2
- “Use C API to Access Model Signals and States” on page 30-24
- “Use C API to Access Model Parameters” on page 30-30
Exchange Data Between Generated and External Code Using C API

Some Simulink Coder applications must interact with signals, states, root-level inputs/outputs, or parameters in the generated code for a model. For example, calibration applications monitor and modify parameters. Signal monitoring or data logging applications interface with signal, state, and root-level input/output data. Using the Simulink Coder C API, you can build target applications that log signals, states, and root-level inputs/outputs, monitor signals, states, and root-level inputs/outputs, and tune parameters, while the generated code executes.

The C API minimizes its memory footprint by sharing information common to signals, states, root-level inputs/outputs, and parameters in smaller structures. Signal, state, root-level input/output, and parameter structures include an index into the structure map, allowing multiple signals, states, root-level inputs/outputs, or parameters to share data.

To get started with an example, see “Use C API to Access Model Signals and States” on page 30-24 or “Use C API to Access Model Parameters” on page 30-30.

In this section...

| “Generated C API Files” on page 30-2 |
| “Generate C API Files” on page 30-3 |
| “Description of C API Files” on page 30-5 |
| “Generate C API Data Definition File for Exchanging Data with a Target System” on page 30-20 |
| “C API Limitations” on page 30-22 |

Generated C API Files

When you configure a model to use the C API, the Simulink Coder code generator generates two additional files, `model_capi.c` (or `.cpp`) and `model_capi.h`, where `model` is the name of the model. The code generator places the two C API files in the build folder, based on settings in the Configuration Parameters dialog box. The C API source code file contains information about global block output signals, states, root-level inputs/outputs, and global parameters defined in the generated code model source code. The C API header file is an interface header file between the model source code and the generated C API. You can use the information in these C API files to create your application. Among the files generated are those shown in the next figure.
Generate C API Files

To generate C API files for your model:

1. Select the C API interface for your model. There are two ways to select the C API interface for your model, as described in the following sections.
   - “Select C API with Configuration Parameters Dialog” on page 30-4
   - “Select C API from the Command Line” on page 30-4

2. Generate code for your model.

After generating code, you can examine the files `model_capi.c` (or `.cpp`) and `model_capi.h` in the model build folder.

---

**Note** When you configure the code generator to produce code that includes support for the C API interface and data logging, the code generator can include text for block names in the block paths logged to C API files `model_capi.c` (or `.cpp`) and `model_capi.h`. If the text includes characters that are unrepresented in the character set encoding for the model, the code generator replaces the characters with XML escape sequences. For example, the code generator replaces the Japanese full-width Katakana letter ｱ with the escape sequence `\&#x30A2;`. For more information, see “Internationalization and Code Generation” on page 20-2.
Select C API with Configuration Parameters Dialog

1. Open your model, and open the Configuration Parameters dialog box.

2. In the **Code Generation > Interface** pane, in the **Data exchange interface** subgroup, select one or more C API options. Based on the options you select, support for accessing signals, parameters, states, and root-level I/O will appear in the C API generated code.

   - If you want to generate C API code for global block output signals, select **Generate C API for: signals**.
   - If you want to generate C API code for global block parameters, select **Generate C API for: parameters**.
   - If you want to generate C API code for discrete and continuous states, select **Generate C API for: states**.
   - If you want to generate C API code for root-level inputs and outputs, select **Generate C API for: root-level I/O**.

Select C API from the Command Line

From the MATLAB command line, you can use the `set_param` function to select or clear the C API check boxes on the **Interface** pane of the Configuration Parameters dialog box. At the MATLAB command line, enter one or more of the following commands, where `modelname` is the name of your model.

To select **Generate C API for: signals**, enter:

```
set_param('modelname','RTWCAPISignals','on')
```

To clear **Generate C API for: signals**, enter:

```
set_param('modelname','RTWCAPISignals','off')
```

To select **Generate C API for: parameters**, enter:

```
set_param('modelname','RTWCAPIParams','on')
```

To clear **Generate C API for: parameters**, enter:

```
set_param('modelname','RTWCAPIParams','off')
```

To select **Generate C API for: states**, enter:

```
set_param('modelname','RTWCAPIStates','on')
```
To clear **Generate C API for: states**, enter:

```c
set_param('modelname','RTWCAPISates','off')
```

To select **Generate C API for: root-level I/O**, enter:

```c
set_param('modelname','RTWCAPIRootIO','on')
```

To clear **Generate C API for: root-level I/O**, enter:

```c
set_param('modelname','RTWCAPIRootIO','off')
```

**Description of C API Files**

- “About C API Files” on page 30-5
- “Structure Arrays Generated in C API Files” on page 30-8
- “Generate Example C API Files” on page 30-9
- “C API Signals” on page 30-11
- “C API States” on page 30-14
- “C API Root-Level Inputs and Outputs” on page 30-15
- “C API Parameters” on page 30-16
- “Map C API Data Structures to rtModel” on page 30-18

**About C API Files**

The `model_capi.c` (or `.cpp`) file provides external applications with a consistent interface to model data. Depending on your configuration settings, the data could be a signal, state, root-level input or output, or parameter. In this document, the term data item refers to either a signal, a state, a root-level input or output, or a parameter. The C API uses structures that provide an interface to the data item properties. The interface packages the properties of each data item in a data structure. If the model contains multiple data items, the interface generates an array of data structures. The members of a data structure map to data properties.

To interface with data items, an application requires the following properties for each data item:

- Name
- Block path
- Port number (for signals and root-level inputs/outputs only)
- Address
- Data type information: native data type, data size, complexity, and other attributes
- Dimensions information: number of rows, number of columns, and data orientation (scalar, vector, matrix, or n-dimensional)
- Fixed-point information: slope, bias, scale type, word length, exponent, and other attributes
- Sample-time information (for signals, states, and root-level inputs/outputs only): sample time, task identifier, frames

As illustrated in the next figure, the properties of data item A, for example, are located in data structure DS_A. The properties of data item B are located in data structure DS_B.

Some property values can be unique to each data item, and there are some property values that several data items can share in common. Name, for example, has a unique value for each data item. The interface places the unique property values directly in the structure for the data item. The name value of data item A is in DS_A, and the name value of data item B is in DS_B.

But data type could be a property whose value several data items have in common. The ability of some data items to share a property allows the C API to have a reuse feature. In this case, the interface places only an index value in DS_A and an index value in DS_B. These indices point to a different data structure, DS_C, that contains the actual data type value. The next figure shows this scheme with more detail.
The figure shows three signals. `signal1` and `signal2` share the same data type, `double`. Instead of specifying this data type value in each signal data structure, the interface provides only an index value, 0, in the structure. "double" is described by entry 0 in the `rtDataTypeMap` array, which is referenced by both signals. Additionally, property values can be shared between signals, states, root-level inputs/outputs, and
parameters, so states, root-level inputs/outputs, and parameters also might reference the
double entry in the rtDataTypeMap array. This reuse of information reduces the
memory size of the generated interface.

Structure Arrays Generated in C API Files

As with data type, the interface maps other common properties (such as address,
dimension, fixed-point scaling, and sample time) into separate structures and provides an
index in the structure for the data item. For a complete list of structure definitions, refer
to the file matlabroot/rtw/c/src/rtw_capi.h. This file also describes each member
in a structure. The structure arrays generated in the model_capi.c (or .cpp) file are of
structure types defined in the rtw_capi.h file. Here is a brief description of the
structure arrays generated in model_capi.c (or .cpp):

- **rtBlockSignals** is an array of structures that contains information about global
  block output signals in the model. Each element in the array is of type struct
  rtwCAPI_Signals. The members of this structure provide the signal name, block
  path, block port number, address, and indices to the data type, dimension, fixed-point,
  and sample-time structure arrays.

- **rtBlockParameters** is an array of structures that contains information about the
  tunable block parameters in the model by block name and parameter name. Each
  element in the array is of type struct rtwCAPI_BlockParameters. The members
  of this structure provide the parameter name, block path, address, and indices to data
  type, dimension, and fixed-point structure arrays.

- **rtBlockStates** is an array of structures that contains information about discrete and
  continuous states in the model. Each element in the array is of type struct
  rtwCAPI_States. The members of this structure provide the state name, block path,
  type (continuous or discrete), and indices to the address, data type, dimension, fixed-
  point, and sample-time structure arrays.

- **rtRootInputs** is an array of structures that contains information about root-level
  inputs in the model. Each element in the array is of type struct rtwCAPI_Signals.
  The members of this structure provide the root-level input name, block path, block
  port number, address, and indices to the data type, dimension, fixed-point, and sample-
  time structure arrays.

- **rtRootOutputs** is an array of structures that contains information about root-level
  outputs in the model. Each element in the array is of type struct
  rtwCAPI_Signals. The members of this structure provide the root-level output
  name, block path, block port number, address, and indices to the data type, dimension,
  fixed-point, and sample-time structure arrays.
rtModelParameters is an array of structures that contains information about workplace variables that one or more blocks or Stateflow charts in the model reference as block parameters. Each element in the array is of data type rtwCAPI_ModelParameters. The members of this structure provide the variable name, address, and indices to data type, dimension, and fixed-point structure arrays.

rtDataAddrMap is an array of base addresses of signals, states, root-level inputs/outputs, and parameters that appear in the rtBlockSignals, rtBlockParameters, rtBlockStates, and rtModelParameters arrays. Each element of the rtDataAddrMap array is a pointer to void (void*).

rtDataTypeMap is an array of structures that contains information about the various data types in the model. Each element of this array is of type struct rtwCAPI_DataTypeMap. The members of this structure provide the data type name, size of the data type, and information on whether or not the data is complex.

rtDimensionMap is an array of structures that contains information about the various data dimensions in the model. Each element of this array is of type struct rtwCAPI_DimensionMap. The members of this structure provide information on the number of dimensions in the data, the orientation of the data (whether it is scalar, vector, or a matrix), and the actual dimensions of the data.

rtFixPtMap is an array of structures that contains fixed-point information about the signals, states, root-level inputs/outputs, and parameters. Each element of this array is of type struct rtwCAPI_FixPtMap. The members of this structure provide information about the data scaling, bias, exponent, and whether or not the fixed-point data is signed. If the model does not have fixed-point data (signal, state, root-level input/output, or parameter), the Simulink Coder software assigns NULL or zero values to the elements of the rtFixPtMap array.

rtSampleTimeMap is an array of structures that contains sampling information about the global signals, states, and root-level inputs/outputs in the model. (This array does not contain information about parameters.) Each element of this array is of type struct rtwCAPI_SampleTimeMap. The members of this structure provide information about the sample period, offset, and whether or not the data is frame-based or sample-based.

Generate Example C API Files

Subtopics “C API Signals” on page 30-11, “C API States” on page 30-14, “C API Root-Level Inputs and Outputs” on page 30-15, and “C API Parameters” on page 30-16 discuss generated C API structures using the example model rtwdemo_capi. To generate code from the example model, do the following:
1 Open the model by clicking the `rtwdemo_capi` link above or by typing `rtwdemo_capi` on the MATLAB command line.

2 If you want to generate C API structures for root-level inputs/outputs in `rtwdemo_capi`, open the Configuration Parameters dialog box, go to the Code Generation > Interface pane, and select Generate C API for: root-level I/O.

**Note** The setting of Generate C API for: root-level I/O must match between the top model and the referenced model. If you modify the option, save the top model and the referenced model to the same writable work folder.

3 Generate code for the model by double-clicking Generate Code Using Simulink Coder.

**Note** The C API code examples in the next subtopics are generated with C as the target language.

This model has three global block output signals that will appear in C API generated code:

- `top_sig1`, which is a test point at the output of the Gain1 block in the top model
- `sig2_eg`, which appears in the top model and is defined in the base workspace as a Simulink.Signal object having storage class ExportedGlobal
- `bot_sig1`, which appears in the referenced model `rtwdemo_capi_bot` and is defined as a Simulink.Signal object having storage class Model default

The model also has two discrete states that will appear in the C API generated code:

- `top_state`, which is defined for the Delay1 block in the top model
- `bot_state`, which is defined for the Discrete Filter block in the referenced model

The model has root-level inputs/outputs that will appear in the C API generated code if you select the option Generate C API for: root-level I/O:

- Four root-level inputs, In1 through In4
- Six root-level outputs, Out1 through Out6

Additionally, the model has five global block parameters that will appear in C API generated code:
• Kp (top model Gain1 block and referenced model Gain2 block share)
• Ki (referenced model Gain3 block)
• p1 (lookup table lu1d)
• p2 (lookup table lu2d)
• p3 (lookup table lu3d)

**C API Signals**

The `rtwCAPI_Signals` structure captures signal information including the signal name, address, block path, output port number, data type information, dimensions information, fixed-point information, and sample-time information.

Here is the section of code in `rtwdemo_capi_capi.c` that provides information on C API signals for the top model in `rtwdemo_capi`:

```c
/* Block output signal information */
static const rtwCAPI_Signals rtBlockSignals[] = {
    /* addrMapIndex, sysNum, blockPath, *
    * signalName, portNumber, dataTypeIndex, dimIndex, fxpIndex, sTimeIndex *
    */
    { 0, 0, "rtwdemo_capi/Gain1", "top_sig1", 0, 0, 0, 0, 0 },
    { 1, 0, "rtwdemo_capi/lu2d", "sig2_eg", 0, 0, 1, 0, 0 },
    { 0, 0, (NULL), (NULL), 0, 0, 0, 0, 0 }
};
```

**Note** To better understand the code, read the comments in the file. For example, notice the comment that begins on the third line in the preceding code. This comment lists the members of the `rtwCAPI_Signals` structure, in order. This tells you the order in which the assigned values for each member appear for a signal. In this example, the comment tells you that `signalName` is the fourth member of the structure. The following lines describe the first signal:

```c
{ 0, 0, "rtwdemo_capi/Gain1", "top_sig1", 0, 0, 0, 0, 0 },
```

From these lines you infer that the name of the first signal is `top_sig1`. 

---

30-11
Each array element, except the last, describes one output port for a block signal. The final array element is a sentinel, with all elements set to null values. For example, examine the second signal, described by the following code:

\{ 1, 0, "rtwdemo_capi/lu2d", \\
    "sig2_eg", 0, 0, 1, 0, 0 \},

This signal, named \textit{sig2_eg}, is the output signal of the first port of the block \textit{rtwdemo_capi/lu2d}. (This port is the first port because the zero-based index for \textit{portNumber} displayed on the second line is assigned the value 0.)

The address of this signal is given by \textit{addrMapIndex}, which, in this example, is displayed on the first line as 1. This provides an index into the \textit{rtDataAddrMap} array, found later in \textit{rtwdemo_capi_capi.c}:

\begin{verbatim}
/* Declare Data Addresses statically */
static void* rtDataAddrMap[] = {
    &rtwdemo_capi_B.top_sig1,            /* 0: Signal */
    &sig2_eg[0],                         /* 1: Signal */
    &rtwdemo_capi_DWork.top_state,       /* 2: Discrete State */
    &rtP Ki,
    &rtP Kp,
    &rtP p1[0],                          /* 5: Model Parameter */
    &rtP p2[0],                          /* 6: Model Parameter */
    &rtP p3[0],                          /* 7: Model Parameter */
};
\end{verbatim}

The index of 1 points to the second element in the \textit{rtDataAddrMap} array. From the \textit{rtDataAddrMap} array, you can infer that the address of this signal is \&\textit{sig2_eg}[0].

This level of indirection supports multiple code instances of the same model. For multiple instances, the signal information remains constant, except for the address. In this case, the model is a single instance. Therefore, the \textit{rtDataAddrMap} is declared statically. If you choose to generate reusable code, an initialize function is generated that initializes the addresses dynamically per instance. For details on generating reusable code, see “Configure Code Generation for Model Entry-Point Functions” on page 16-2 and see “Configure Code Reuse Support” (Embedded Coder).

The \textit{dataTypeIndex} provides an index into the \textit{rtDataTypeMap} array, found later in \textit{rtwdemo_capi_capi.c}, indicating the data type of the signal:

\begin{verbatim}
/* Data Type Map - use dataTypeMapIndex to access this structure */
static const rtwCAPI_DataTypeMap rtDataTypeMap[] = {
    /* cName, mwName, numElements, elemMapIndex, dataSize, slDataId, *
    * isComplex, isPointer */
    { "double", "real_T", 0, 0, sizeof(real_T), SS_DOUBLE, 0, 0 }
};
\end{verbatim}
Because the index is 0 for sig2_eg, the index points to the first structure element in the array. You can infer that the data type of the signal is double. The value of isComplex is 0, indicating that the signal is not complex. Rather than providing the data type information directly in the `rtwCAPI_Signals` structure, a level of indirection is introduced. The indirection allows multiple signals that share the same data type to point to one map structure, saving memory for each signal.

The `dimIndex` (dimensions index) provides an index into the `rtDimensionMap` array, found later in `rtwdemo_capi_capi.c`, indicating the dimensions of the signal. Because this index is 1 for sig2_eg, the index points to the second element in the `rtDimensionMap` array:

```c
/* Dimension Map - use dimensionMapIndex to access elements of this structure*/
static const rtwCAPI_DimensionMap rtDimensionMap[] = {
    /* dataOrientation, dimArrayIndex, numDims, vardimsIndex */
    { rtwCAPI_SCALAR, 0, 2, 0 },
    { rtwCAPI_VECTOR, 2, 2, 0 },
    ...
};
```

From this structure, you can infer that this is a nonscalar signal having a dimension of 2. The `dimArrayIndex` value, 2, provides an index into `rtDimensionArray`, found later in `rtwdemo_capi_capi.c`:

```c
/* Dimension Array- use dimArrayIndex to access elements of this array */
static const uint_T rtDimensionArray[] = {
    1, /* 0 */
    1, /* 1 */
    2, /* 2 */
    ...
};
```

The `fxpIndex` (fixed-point index) provides an index into the `rtFixPtMap` array, found later in `rtwdemo_capi_capi.c`, indicating fixed-point information about the signal. Your code can use the scaling information to compute the real-world value of the signal, using the equation \( V = SQ + B \), where \( V \) is “real-world” (that is, base-10) value, \( S \) is user-specified slope, \( Q \) is “quantized fixed-point value” or “stored integer,” and \( B \) is user-specified bias. For details, see “Scaling” (Fixed-Point Designer).

Because this index is 0 for sig2_eg, the signal does not have fixed-point information. A fixed-point map index of zero means that the signal does not have fixed-point information.

The `sTimeIndex` (sample-time index) provides the index to the `rtSampleTimeMap` array, found later in `rtwdemo_capi_capi.c`, indicating task information about the signal. If you log multirate signals or conditionally executed signals, the sampling information can be useful.
Note model_capi.c (or .cpp) includes rtw_capi.h. A source file that references the rtBlockSignals array also must include rtw_capi.h.

C API States

The rtwCAPI_States structure captures state information including the state name, address, block path, type (continuous or discrete), data type information, dimensions information, fixed-point information, and sample-time information.

Here is the section of code in rtwdemo_capi_capi.c that provides information on C API states for the top model in rtwdemo_capi:

```c
/* Block states information */
static const rtwCAPI_States rtBlockStates[] = {
    /* addrMapIndex, contStateStartIndex, blockPath,
       * stateName, pathAlias, dWorkIndex, dataTypeIndex, dimIndex,
       * fixPtIdx, sTimeIndex, isContinuous
       */
    { 2, -1, "rtwdemo_capi/Delay1",
       "top_state", ",", 0, 0, 0, 0, 0, 0 },
    { 0, -1, (NULL), (NULL), (NULL), 0, 0, 0, 0, 0, 0 },
};
```

Each array element, except the last, describes a state in the model. The final array element is a sentinel, with all elements set to null values. In this example, the C API code for the top model displays one state:

```c
    { 2, -1, "rtwdemo_capi/Delay1",
       "top_state", ",", 0, 0, 0, 0, 0, 0 },
```

This state, named top_state, is defined for the block rtwdemo_capi/Delay1. The value of isContinuous is zero, indicating that the state is discrete rather than continuous. The other fields correspond to the like-named signal equivalents described in “C API Signals” on page 30-11, as follows:

- The address of the signal is given by addrMapIndex, which, in this example, is 2. This is an index into the rtDataAddrMap array, found later in rtwdemo_capi_capi.c. Because the index is zero based, 2 corresponds to the third element in rtDataAddrMap, which is &rtwdemo_capi_DWork.top_state.
- The dataTypeIndex provides an index into the rtDataTypeMap array, found later in rtwdemo_capi_capi.c, indicating the data type of the parameter. The value 0 corresponds to a double, noncomplex parameter.
• The `dimIndex` (dimensions index) provides an index into the `rtDimensionMap` array, found later in `rtwdemo_capi_capi.c`. The value 0 corresponds to the first entry, which is `{ rtwCAPI_SCALAR, 0, 2, 0 }.

• The `fixPtIndex` (fixed-point index) provides an index into the `rtFixPtMap` array, found later in `rtwdemo_capi_capi.c`, indicating fixed-point information about the parameter. As with the corresponding signal attribute, a fixed-point map index of zero means that the parameter does not have fixed-point information.

**C API Root-Level Inputs and Outputs**

The `rtwCAPI_Signals` structure captures root-level input/output information including the input/output name, address, block path, port number, data type information, dimensions information, fixed-point information, and sample-time information. (This structure also is used for block output signals, as previously described in “C API Signals” on page 30-11.)

Here is the section of code in `rtwdemo_capi_capi.c` that provides information on C API root-level inputs/outputs for the top model in `rtwdemo_capi`:

```c
/* Root Inputs information */
static const rtwCAPI_Signals rtRootInputs[] = {
    /* addrMapIndex, sysNum, blockPath, *
     * signalName, portNumber, dataTypeIndex, dimIndex, fxpIndex, sTimeIndex *
     */
    { 3, 0, "rtwdemo_capi/In1",
       "", 1, 0, 0, 0, 0 },
    { 4, 0, "rtwdemo_capi/In2",
       "", 2, 0, 0, 0, 0 },
    { 5, 0, "rtwdemo_capi/In3",
       "", 3, 0, 0, 0, 0 },
    { 6, 0, "rtwdemo_capi/In4",
       "", 4, 0, 0, 0, 0 },
    { 0, 0, (NULL), (NULL), 0, 0, 0, 0 },
};

/* Root Outputs information */
static const rtwCAPI_Signals rtRootOutputs[] = {
    /* addrMapIndex, sysNum, blockPath, *
     * signalName, portNumber, dataTypeIndex, dimIndex, fxpIndex, sTimeIndex *
     */
    { 7, 0, "rtwdemo_capi/Out1",
       "", 1, 0, 0, 0, 0 },
```
{ 8, 0, "rtwdemo_capi/Out2",
   "", 2, 0, 0, 0, 0 },

{ 9, 0, "rtwdemo_capi/Out3",
   "", 3, 0, 0, 0, 0 },

{ 10, 0, "rtwdemo_capi/Out4",
   "", 4, 0, 0, 0, 0 },

{ 11, 0, "rtwdemo_capi/Out5",
   "sig2_eg", 5, 0, 1, 0, 0 },

{ 12, 0, "rtwdemo_capi/Out6",
   "", 6, 0, 1, 0, 0 },

{ 0, 0, (NULL), (NULL), 0, 0, 0, 0 }
};

For information about interpreting the values in the rtwCAPI_Signals structure, see the previous section “C API Signals” on page 30-11.

C API Parameters

The rtwCAPI_BlockParameters and rtwCAPI_ModelParameters structures capture parameter information including the parameter name, block path (for block parameters), address, data type information, dimensions information, and fixed-point information.

The rtModelParameters array contains entries for workspace variables that are referenced as tunable Simulink block parameters or Stateflow data of machine scope. For example, tunable parameters include Simulink.Parameter objects that use a storage class other than Auto. The Simulink Coder software assigns its elements only NULL or zero values in the absence of such data.

The setting that you select for the model configuration parameter Default parameter behavior determines how information is generated into the rtBlockParameters array in model_capi.c (or .cpp).

- If you set Default parameter behavior to Tunable, the rtBlockParameters array contains an entry for every modifiable parameter of every block in the model. However, if you use a MATLAB variable or a tunable parameter to specify a block parameter, the block parameter does not appear in rtBlockParameters. Instead, the variable or tunable parameter appears in rtModelParameters.
- If you set Default parameter behavior to Inlined, the rtBlockParameters array is empty. The Simulink Coder software assigns its elements only NULL or zero values.
The last member of each array is a sentinel, with all elements set to null values.

Here is the \texttt{rtBlockParameters} array that is generated by default in \texttt{rtwdemo_capi_capi.c}:

```c
/* Individual block tuning is not valid when inline parameters is */
/* selected. An empty map is produced to provide a consistent */
/* interface independent of inlining parameters. */

static const rtwCAPI_BlockParameters rtBlockParameters[] = {
    /* addrMapIndex, blockPath, */
    /* paramName, dataTypeIndex, dimIndex, fixPtIdx */
    { 0, (NULL), (NULL), 0, 0, 0 },
};
```

In this example, only the final, sentinel array element is generated, with all members of the structure \texttt{rtwCAPI\_BlockParameters} set to NULL and zero values. This is because \textbf{Default parameter behavior} is set to \texttt{Inlined} by default for the \texttt{rtwdemo\_capi} example model. If you set \textbf{Default parameter behavior} to \texttt{Tunable}, the block parameters are generated in the \texttt{rtwCAPI\_BlockParameters} structure. However, MATLAB variables and tunable parameters appear in the \texttt{rtwCAPI\_ModelParameters} structure.

Here is the \texttt{rtModelParameters} array that is generated by default in \texttt{rtwdemo\_capi\_capi.c}:

```c
/* Tunable variable parameters */
static const rtwCAPI_ModelParameters rtModelParameters[] = {
    /* addrMapIndex, varName, dataTypeIndex, dimIndex, fixPtIndex */
    { 2, TARGET\_STRING("Ki"), 0, 0, 0 },
    { 3, TARGET\_STRING("Kp"), 0, 0, 0 },
    { 4, TARGET\_STRING("p1"), 0, 2, 0 },
    { 5, TARGET\_STRING("p2"), 0, 3, 0 },
    { 6, TARGET\_STRING("p3"), 0, 4, 0 },
    { 0, (NULL), 0, 0, 0 }
};
```

In this example, the \texttt{rtModelParameters} array contains entries for each variable that is referenced as a tunable Simulink block parameter.
For example, the `varName` (variable name) of the fourth parameter is `p2`. The other fields correspond to the like-named signal equivalents described in “C API Signals” on page 30-11, as follows:

- The address of the fourth parameter is given by `addrMapIndex`, which, in this example, is 5. This is an index into the `rtDataAddrMap` array, found later in `rtwdemo_capi_capi.c`. Because the index is zero based, 5 corresponds to the sixth element in `rtDataAddrMap`, which is `rtP_p2`.
- The `dataTypeIndex` provides an index into the `rtDataTypeMap` array, found later in `rtwdemo_capi_capi.c`, indicating the data type of the parameter. The value 0 corresponds to a double, noncomplex parameter.
- The `dimIndex` (dimensions index) provides an index into the `rtDimensionMap` array, found later in `rtwdemo_capi_capi.c`. The value 3 corresponds to the fourth entry, which is `{ rtwCAPI_MATRIX_COL_MAJOR, 6, 2, 0 }.
- The `fixPtIndex` (fixed-point index) provides an index into the `rtFixPtMap` array, found later in `rtwdemo_capi_capi.c`, indicating fixed-point information about the parameter. As with the corresponding signal attribute, a fixed-point map index of zero means that the parameter does not have fixed-point information.

For more information about tunable parameter storage in the generated code, see “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50.

**Map C API Data Structures to rtModel**

The real-time model data structure encapsulates model data and associated information that describes the model fully. When you select the C API feature and generate code, the Simulink Coder code generator adds another member to the real-time model data structure generated in `model.h`:

```c
/*
 * DataMapInfo:
 * The following substructure contains information regarding
 * structures generated in the model's C API.
 */
struct {
    rtwCAPI_ModelMappingInfo mmi;
} DataMapInfo;
```

This member defines `mmi` (for model mapping information) of type `struct rtwCAPI_ModelMappingInfo`. The structure is located in `matlabroot/rtw/c/src/rtw_modelmap.h`. The `mmi` substructure defines the interface between the model and the
C API files. More specifically, members of mmi map the real-time model data structure to the structures in `model_capi.c` (or `.cpp`).

Initializing values of mmi members to the arrays accomplishes the mapping, as shown in “Map Model to C API Arrays of Structures” on page 30-20. Each member points to one of the arrays of structures in the generated C API file. For example, the address of the `rtBlockSignals` array of structures is allocated to the first member of the mmi substructure in `model.c` (or `.cpp`), using the following code in the `rtw_modelmap.h` file:

```c
/* signals */
struct {
    rtwCAPI_Signals const *signals;       /* Signals Array */
    uint_T                numSignals;     /* Num Signals   */
    rtwCAPI_Signals const *rootInputs;    /* Root Inputs array */
    uint_T               numRootInputs;  /* Num Root Inputs  */
    rtwCAPI_Signals const *rootOutputs;   /* Root Outputs array */
    uint_T               numRootOutputs;/* Num Root Outputs  */
} Signals;
```

The model initialize function in `model.c` (or `.cpp`) performs the initializing by calling the C API initialize function. For example, the following code is generated in the model initialize function for example model `rtwdemo_capi`:

```c
/* Initialize DataMapInfo substructure containing ModelMap for C API */
rtwdemo_capi_InitializeDataMapInfo(rtwdemo_capi_M);
```
Map Model to C API Arrays of Structures

**Note** This figure lists the arrays in the order that their structures appear in `rtw_modelmap.h`, which differs slightly from their generated order in `model_capi.c`.

Generate C API Data Definition File for Exchanging Data with a Target System

This model illustrates the target-based C API for interfacing signals, parameters, and states in the generated code.
Open Example Model

Open the example model `rtwdemo_capi`.

```matlab
open_system('rtwdemo_capi');
```

This model illustrates the target-based C API for interfacing signals, parameters and states in the generated code. The C API is useful for real-time interaction with the data, without having to stop execution or recompile the generated code. Typically, a client/server protocol is set up from a host to a target using serial, TCP/IP, or dual-port memory connection. The purpose of this example is not the client/server protocol. Rather, this model shows the necessary data interface required by the C client/server programs.

You can enable the C API by selecting one or more C API options on the "Code Generation > Interface" pane of the Configuration Parameters dialog box. Any signal or parameter or state with an addressable storage class is placed in the C API data structure in `<model>_capi.c`. Note that signals, states and parameters in the referenced model can be accessed using C-API. So make sure that C-API is enabled for the referenced model.

The C API is useful for real-time interaction with application data, without having to stop execution or recompile the generated code. Typically, a client/server protocol is set up from a host to a target using serial, TCP/IP, or dual-port memory connection. The purpose
of this example is not the client/server protocol. Rather, this model shows the necessary
data interface required by the C client/server programs.

You enable the C API by selecting one or more C API options on the **Code Generation > Interface** pane of the Configuration Parameters dialog box. Any signal or parameter or state with an addressable storage class is placed in the C API data structure in `model_capi.c`. Note that signals, states, and parameters in the referenced model can be accessed using C API. So make sure that C API is enabled for the referenced model.

**C API Limitations**

The C API feature has the following limitations.

- The C API does not support the following values for the **CodeFormat** TLC variable:
  - S-Function
  - Accelerator_S-Function (for accelerated simulation)
- For ERT-based targets, the C API requires that support for floating-point code be enabled.
- Local block output signals are not supported.
- Local Stateflow parameters are not supported.
- The following custom storage class objects are not supported:
  - Objects without the package `csc_registration` file
  - Grouped custom storage classes
  - Objects defined by using macros
  - `BitField` objects
  - `FileScope` objects
- Customized data placement is disabled when you are using the C API. The interface looks for global data declaration in `model.h` and `model_private.h`. Declarations placed in any other file by customized data placement result in code that does not compile.

**Note** Custom Storage Class objects work in code generation, only if you use the ERT system target file and clear the model configuration parameter **Ignore custom storage classes**.
See Also

Related Examples

• “Access Signal, State, and Parameter Data During Execution” on page 15-7
• “How Generated Code Exchanges Data with an Environment” on page 15-33
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Use C API to Access Model Signals and States

This example helps you get started writing application code to interact with model signals and states. To get started writing application code to interact with model parameters, see “Use C API to Access Model Parameters” on page 30-30.

The C API provides you with the flexibility of writing your own application code to interact with model signals, states, root-level inputs/outputs, and parameters. Your target-based application code is compiled with the Simulink Coder generated code into an executable. The target-based application code accesses the C API structure arrays in model_capi.c (or .cpp). You might have host-based code that interacts with your target-based application code. Or, you might have other target-based code that interacts with your target-based application code. The files rtw_modelmap.h and rtw_capi.h, located in matlabroot/rtw/c/src (open), provide macros for accessing the structures in these arrays and their members.

Here is an example application that logs global signals and states in a model to a text file. This code is intended as a starting point for accessing signal and state addresses. You can extend the code to perform signal logging and monitoring, state logging and monitoring, or both.

This example uses the following macro and function interfaces:

- **rtmGetDataMapInfo** macro

  Accesses the model mapping information (MMI) substructure of the real-time model structure. In the following macro call, rtM is the pointer to the real-time model structure in model.c (or .cpp):

  
  rtwCAPI_ModelMappingInfo* mmi = &(rtmGetDataMapInfo(rtM).mmi);

- **rtmGetTPtr** macro

  Accesses the absolute time information for the base rate from the timing substructure of the real-time model structure. In the following macro call, rtM is the pointer to the real-time model structure in model.c (or .cpp):

  
  rtmGetTPtr(rtM)

- Custom functions capi_StartLogging, capi_UpdateLogging, and capi_TerminateLogging, provided via the files rtwdemo_capi_datalog.h and rtwdemo_capi_datalog.c. These files are located in matlabroot/toolbox/rtw/rtwdemos (open).
• `capi_StartLogging` initializes signal and state logging.
• `capi_UpdateLogging` logs a signal and state value at each time step.
• `capi_TerminateLogging` terminates signal and state logging and writes the logged values to a text file.

You can integrate these custom functions into generated model code using one or more of the following methods:

• **Code Generation > Custom Code** pane of the Configuration Parameters dialog box
  • Custom Code library blocks
  • TLC custom code functions

This tutorial uses the **Code Generation > Custom Code** pane and the System Outputs block from the Custom Code library to insert calls to the custom functions into `model.c` (or `.cpp`), as follows:

• `capi_StartLogging` is called in the `model_initialize` function.
• `capi_UpdateLogging` is called in the `model_step` function.
• `capi_TerminateLogging` is called in the `model_terminate` function.

The following excerpts of generated code from `model.c` (rearranged to reflect their order of execution) show how the function interfaces are used.

```c
void rtwdemo_capi_initialize(void)
{
  /* user code (Initialize function Body) */

  /* C API Custom Logging Function: Start Signal and State logging via C API.
   * capi_StartLogging: Function prototype in rtwdemo_capi_datalog.h
   */
  {
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_capi_M).mmi);
    printf("** Started state/signal logging via C API **\n");
    capi_StartLogging(MMI, MAX_DATA_POINTS);
  }
  ...
}

/* Model step function */
void rtwdemo_capi_step(void)
{
  /* user code (Output function Trailer) */

  /* System '<Root>' */
```
The following procedure illustrates how you can use the C API macro and function interfaces to log global signals and states in a model to a text file.

1. At the MATLAB command line, enter `rtwdemo_capi` to open the example model.
2. Save the top model `rtwdemo_capi` and the referenced model `rtwdemo_capi_bot` to the same writable work folder.
3. Open the Configuration Parameters dialog box.
4. If you are licensed for Embedded Coder software and you want to use the `ert.tlc` system target file instead of the default `grt.tlc`, go to the Code Generation pane and use the System target file parameter to select an `ert.tlc` system target file. Make sure that you also select `ert.tlc` for the referenced model `rtwdemo_capi_bot`.
5. In the top model, go to the Code Generation > Interface pane. Confirm these model configuration parameter settings:
   a. Select Generate C API for signals, Generate C API for states, and Generate C API for parameters.
   b. If you are using the `ert.tlc` system target file, select Support complex numbers
   c. Select MAT-file logging.
   d. Click Apply.
   e. Update configuration parameter settings in the referenced model, `rtwdemo_capi_bot`, to match changes you made in the top model.
Use the Custom Code pane to embed your custom application code in the generated code. Select the Custom Code pane, and then click Include directories. The Include directories input field is displayed.

In the Include directories field, type `matlabroot/toolbox/rtw/rtwdemos`, where `matlabroot` represents the root of your MATLAB installation folder. (If you are specifying a Windows path that contains a space, place the text inside double quotes.)

In the Additional Build Information subpane, click Source files, and type `rtwdemo_capi_datalog.c`.

In the Include custom C code in generated subpane, click Source file, and type or copy and paste the following include statement:

```c
#include "rtwdemo_capi_datalog.h"
```

In the Initialize function field, type or copy and paste the following application code:

```c
/* C API Custom Logging Function: Start Signal and State logging via C API.
 * capi_StartLogging: Function prototype in rtwdemo_capi_datalog.h
 */
{
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_capi_M).mmi);
    printf("** Started state/signal logging via C API **\n");
    capi_StartLogging(MMI, MAX_DATA_POINTS);
}
```

Note If you renamed the top model `rtwdemo_capi`, update the name `rtwdemo_capi_M` in the application code to reflect the new model name.

In the Terminate function field, type or copy and paste the following application code:

```c
/* C API Custom Logging Function: Dump Signal and State buffers into a text file.
 * capi_TerminateLogging: Function prototype in rtwdemo_capi_datalog.h
 */
{
```
capi_TerminateLogging("rtwdemo_capi_ModelLog.txt");
printf("*** Finished state/signal logging. Created rtwdemo_capi_ModelLog.txt **\n");
}

Click **Apply**.

12 In the MATLAB Command Window, enter `custcode` to open the Simulink Coder Custom Code library. At the top level of the `rtwdemo_capi` model, add a System Outputs block.

13 Double-click the System Outputs block to open the System Outputs Function Custom Code dialog box. In the **System Outputs Function Exit Code** field, type or copy and paste the following application code:

```c
/* C API Custom Logging Function: Update Signal and State logging buffers.
 * capi_UpdateLogging: Function prototype in rtwdemo_capi_datalog.h
 */
{
    rtwCAPI_ModelMappingInfo *MMI = &(rtmGetDataMapInfo(rtwdemo_capi_M).mmi);
    capi_UpdateLogging(MMI, rtmGetTPtr(rtwdemo_capi_M));
}
```

**Note** If you renamed the top model `rtwdemo_capi`, update two instances of the name `rtwdemo_capi_M` in the application code to reflect the new model name.

Click **OK**.

14 On the **Code Generation** pane, verify that the **Generate code only** check box is cleared.

Build the model and generate an executable program. For example, on a Windows system, the build generates the executable file `rtwdemo_capi.exe` in your current working folder.

15 In the MATLAB Command Window, enter the command `!rtwdemo_capi` to run the executable file. During execution, signals and states are logged using the C API and then written to the text file `rtwdemo_capi_ModelLog.txt` in your current working folder.

```bash
>> !rtwdemo_capi
** starting the model **
** Started state/signal logging via C API **
** Logging 2 signal(s) and 1 state(s). In this demo, only scalar named signals/states are logged **
** Finished state/signal logging. Created rtwdemo_capi_ModelLog.txt **
```

16 Examine the text file in the MATLAB editor or other text editor. Here is an excerpt of the signal and state logging output.
******** Signal Log File ********

Number of Signals Logged: 2
Number of points (time steps) logged: 51

<table>
<thead>
<tr>
<th>Time</th>
<th>bot_sig1 (Referenced Model)</th>
<th>top_sig1</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>70</td>
<td>4</td>
</tr>
<tr>
<td>0.2</td>
<td>70</td>
<td>4</td>
</tr>
<tr>
<td>0.4</td>
<td>70</td>
<td>4</td>
</tr>
<tr>
<td>0.6</td>
<td>70</td>
<td>4</td>
</tr>
<tr>
<td>0.8</td>
<td>70</td>
<td>4</td>
</tr>
<tr>
<td>1</td>
<td>70</td>
<td>4</td>
</tr>
<tr>
<td>1.2</td>
<td>70</td>
<td>4</td>
</tr>
<tr>
<td>1.4</td>
<td>70</td>
<td>4</td>
</tr>
<tr>
<td>1.6</td>
<td>70</td>
<td>4</td>
</tr>
<tr>
<td>1.8</td>
<td>70</td>
<td>4</td>
</tr>
<tr>
<td>2</td>
<td>70</td>
<td>4</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

******** State Log File ********

Number of States Logged: 1
Number of points (time steps) logged: 51

<table>
<thead>
<tr>
<th>Time</th>
<th>bot_state (Referenced Model)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0.2</td>
<td>70</td>
</tr>
<tr>
<td>0.4</td>
<td>35</td>
</tr>
<tr>
<td>0.6</td>
<td>52.5</td>
</tr>
<tr>
<td>0.8</td>
<td>43.75</td>
</tr>
<tr>
<td>1</td>
<td>48.13</td>
</tr>
<tr>
<td>1.2</td>
<td>45.94</td>
</tr>
<tr>
<td>1.4</td>
<td>47.03</td>
</tr>
<tr>
<td>1.6</td>
<td>46.48</td>
</tr>
<tr>
<td>1.8</td>
<td>46.76</td>
</tr>
<tr>
<td>2</td>
<td>46.62</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
</tbody>
</table>

See Also

**Related Examples**

- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Use C API to Access Model Parameters

This example helps you get started writing application code to interact with model parameters. To get started writing application code to interact with model signals and states, see “Use C API to Access Model Signals and States” on page 30-24.

The C API provides you with the flexibility of writing your own application code to interact with model signals, states, root-level inputs/outputs, and parameters. Your target-based application code is compiled with generated code into an executable program. The target-based application code accesses the C API structure arrays in `model_capi.c` (or `.cpp`). You might have host-based code that interacts with your target-based application code. Or, you might have other target-based code that interacts with your target-based application code. The files `rtw_modelmap.h` and `rtw_capi.h`, located in `matlabroot/rtw/c/src` (open), provide macros for accessing the structures in these arrays and their members.

Here is an example application that prints the parameter values of tunable parameters in a model to the standard output. This code is intended as a starting point for accessing parameter addresses. You can extend the code to perform parameter tuning. The application:

- Uses the `rtmGetDataMapInfo` macro to access the mapping information in the `mmi` substructure of the real-time model structure

  ```c
  rtwCAPI_ModelMappingInfo* mmi = &(rtmGetDataMapInfo(rtM).mmi);
  ```

  where `rtM` is the pointer to the real-time model structure in `model.c` (or `.cpp`).

- Uses `rtwCAPI_GetNumModelParameters` to get the number of model parameters in mapped C API:

  ```c
  uint_T nModelParams = rtwCAPI_GetNumModelParameters(mmi);
  ```

- Uses `rtwCAPI_GetModelParameters` to access the array of model parameter structures mapped in C API:

  ```c
  rtwCAPI_ModelParameters* capiModelParams = \
  rtwCAPI_GetModelParameters(mmi);
  ```

- Loops over the `capiModelParams` array to access individual parameter structures. A call to the function `capi_PrintModelParameter` displays the value of the parameter.

The example application code is provided below:
```c
/* Get CAPI Mapping structure from Real-Time Model structure */
rtwCAPI_ModelMappingInfo* capiMap = \
&(rtmGetDataMapInfo(rtwdemo_capi_M).mmi);

/* Get number of Model Parameters from capiMap */
uint_T nModelParams = rtwCAPI_GetNumModelParameters(capiMap);
printf("Number of Model Parameters: %d\n", nModelParams);

/* If the model has Model Parameters, print them using the 
application capi_PrintModelParameter */
if (nModelParams == 0) {
    printf("No Tunable Model Parameters in the model \n");
} else {
    unsigned int idx;
    for (idx=0; idx < nModelParams; idx++) {
        /* call print utility function */
        capi_PrintModelParameter(capiMap, idx);
    }
}
```

The print utility function is located in `matlabroot/rtw/c/src/rtw_capi_examples.c`. This file contains utility functions for accessing the C API structures.

To become familiar with the example code, try building a model that displays the tunable block parameters and MATLAB variables. You can use `rtwdemo_capi`, the C API example model. The following steps apply to both `grt.tlc` and `ert.tlc` system target files, unless otherwise indicated.

1. At the MATLAB command line, enter `rtwdemo_capi` to open the example model.
2. Save the top model `rtwdemo_capi` and the referenced model `rtwdemo_capi_bot` to the same writable work folder.
3. If you are licensed for Embedded Coder software and you want to use the `ert.tlc` system target tile instead of the default `grt.tlc`, go to the Code Generation pane of the Configuration Parameters dialog box and use the System target file parameter to select an `ert.tlc` system target file. Make sure that you also select `ert.tlc` for the referenced model `rtwdemo_capi_bot`.
4. Confirm these model configuration parameter settings:
a Select Generate C API for parameters.
b If you are using the ert.tlc system target file, select Support complex numbers.
c Select MAT-file logging.
d Click Apply.
e Update configuration parameter settings in the referenced model, rtwdemo_capi_bot, to match changes you made in the top model.

Use the Custom Code pane to embed your custom application code in the generated code. Select the Custom Code pane, and then click Initialize function. The Initialize function input field is displayed.

In the Initialize function input field, type or copy and paste the example application code shown above step 1. This embeds the application code in the model_initialize function.

**Note** If you renamed the top model rtwdemo_capi, update the name rtwdemo_capi_M in the application code to reflect the new model name.

Click Include directories, and type matlabroot/rtw/c/src, where matlabroot represents the root of your MATLAB installation folder. (If you are specifying a Windows path that contains a space, place the text inside double quotes.)

In the Additional Build Information subpane, click Source files, and type rtw_capi_examples.c.
Click **Apply**.

9 On the **Code Generation** pane, verify that the **Generate code only** check box is **cleared**.

Build the model and generate an executable program. For example, on a Windows system, the build generates the executable file `rtwdemo_capi.exe` in your current working folder.

10 In the MATLAB Command Window, enter `!rtwdemo_capi` to run the executable file. Running the program displays parameter information in the Command Window.

```
>> !rtwdemo_capi

** starting the model **
Number of Model Parameters: 5
Ki =
   7
Kp =
   4
p1 =
   0.15
   0.36
   0.81
p2 =
   0.09   0.75   0.57
```
\[
p3 = \\
\text{ans}(::,1) = \\
0.23 \ 0.82 \ 0.04 \ 0.64 \\
0.35 \ 0.01 \ 0.16 \ 0.73 \\
\text{ans}(::,2) = \\
0.64 \ 0.54 \ 0.74 \ 0.68 \\
0.45 \ 0.29 \ 0.18 \ 0.18 \\
\]

See Also

Related Examples

- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
ASAP2 Data Measurement and Calibration in Simulink Coder
Export ASAP2 File for Data Measurement and Calibration

The ASAM MCD-2 MC standard, also known as ASAP2, is a data definition standard proposed by the Association for Standardization of Automation and Measuring Systems (ASAM). ASAP2 is a non-object-oriented description of the data used for measurement, calibration, and diagnostic systems. For more information on ASAM and the ASAM MCD-2 MC (ASAP2) standard, see the ASAM Web site at https://www.asam.net.

The code generator lets you export an ASAP2 file containing information about your model during the code generation process.

You can run an interactive example of ASAP2 file generation. To open the example at the MATLAB command prompt, enter the following command:

rtwdemo_asap2

**Note** Simulink Coder support for ASAP2 file generation is version-neutral. By default, the software generates ASAP2 version 1.31 format, but the generated model information is generally compatible with all ASAP2 versions. ASAP2 file generation also is neutral with respect to the specific needs of ASAP2 measurement and calibration tools. The software provides customization APIs that you can use to customize ASAP2 file generation to generate any ASAP2 version and to meet the specific needs of your ASAP2 tools.

---

**In this section...**

“What You Should Know” on page 31-3
“Targets Supporting ASAP2” on page 31-3
“Define ASAP2 Information” on page 31-3
“Generate an ASAP2 File” on page 31-9
“Structure of the ASAP2 File” on page 31-12
“Create a Host-Based ASAM-ASAP2 Data Definition File for Data Measurement and Calibration” on page 31-13
What You Should Know

To make use of ASAP2 file generation, you should become familiar with the following topics:

- ASAM and the ASAP2 standard and terminology. See the ASAM Web site at https://www.asam.net.
- Simulink data objects. Data objects are used to supply information not contained in the model. For an overview, see “Data Objects” (Simulink).
- Storage and representation of signals and parameters in generated code. See “Data Access for Prototyping and Debugging”.
- If you are licensed for Embedded Coder, see also the Embedded Coder topic “Data Representation and Access” (Embedded Coder).

Targets Supporting ASAP2

ASAP2 file generation is available to all code generator system target file configurations. For example,

- Generic Real-Time Target (grt.tlc) lets you generate an ASAP2 file as part of the code generation and build process.
- Embedded Coder (ert.tlc) system target file selections also let you generate an ASAP2 file as part of the code generation and build process.
- ASAM-ASAP2 Data Definition Target (asap2.tlc) lets you generate only an ASAP2 file, without building an executable program.

Procedures for generating ASAP2 files by using these target configurations are given in “Generate an ASAP2 File” on page 31-9.

Define ASAP2 Information

- “Define ASAP2 Information for Parameters and Signals” on page 31-4
- “Memory Address Attribute” on page 31-5
- “Automatic ECU Address Replacement for ASAP2 Files (Embedded Coder)” on page 31-6
- “Define ASAP2 Information for Lookup Tables” on page 31-7
Define ASAP2 Information for Parameters and Signals

The ASAP2 file generation process requires information about parameters and signals in your model. Some of this information is contained in the model itself. You must supply the rest by using Simulink data objects in a workspace or data dictionary. In some cases, the use of workspace objects is optional.

You can use the Model Data Editor and built-in Simulink data objects to provide the information. For example, you can use Simulink.Signal objects to provide MEASUREMENT information and Simulink.Parameter objects to provide CHARACTERISTIC information. Also, you can use data objects from data classes that are derived from Simulink.Signal and Simulink.Parameter to provide the information. For information about data objects, see “Data Objects” (Simulink). For information about the Model Data Editor, see “Configure Data Properties by Using the Model Data Editor” (Simulink).

The following table contains the minimum set of data attributes required for ASAP2 file generation. Some data attributes are defined in the model; others are supplied in the properties of objects. For attributes that are defined in Simulink.Signal or Simulink.Parameter objects, the table gives the associated property name.

<table>
<thead>
<tr>
<th>Data Attribute</th>
<th>Defined In</th>
<th>Property Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (symbol)</td>
<td>Model and data object</td>
<td>Inherited from the handle of the data object to which parameter or signal name resolves</td>
</tr>
<tr>
<td>Description</td>
<td>Data object</td>
<td>Description</td>
</tr>
<tr>
<td>Data type</td>
<td>Model or data object</td>
<td>DataType</td>
</tr>
<tr>
<td>Scaling (if fixed-point data type)</td>
<td>Model or data object</td>
<td>DataType</td>
</tr>
<tr>
<td>Minimum allowable value</td>
<td>Model or data object</td>
<td>Min</td>
</tr>
<tr>
<td>Maximum allowable value</td>
<td>Model or data object</td>
<td>Max</td>
</tr>
<tr>
<td>Unit</td>
<td>Model or data object</td>
<td>Unit</td>
</tr>
<tr>
<td>Memory address (optional)</td>
<td>Model or data object</td>
<td>MemoryAddress_ASAP2 (optional; see “Memory Address Attribute” on page 31-5.)</td>
</tr>
</tbody>
</table>
**Memory Address Attribute**

If the memory address attribute is unknown before code generation, the code generator inserts ECU Address placeholder text in the generated ASAP2 file. You can substitute an actual address for the placeholder by postprocessing the generated file. See the file `matlabroot/toolbox/rtw/targets/asap2/asap2/asap2post.m` for an example. `asap2post.m` parses through the linker map file that you provide and replaces the ECU Address placeholders in the ASAP2 file with the actual memory addresses. Since linker map files vary from compiler to compiler, you might need to modify the regular expression code in `asap2post.m` to match the format of the linker map you use.

**Note** If Embedded Coder is licensed and installed on your system, and if you are generating Executable and Linkable Format (ELF) or Program Database (PDB) files for your embedded target, you can use the `rtw.asap2SetAddress` function to automate ECU address replacement. For more information, see “Automatic ECU Address Replacement for ASAP2 Files (Embedded Coder)” on page 31-6.

If the memory address attribute is known before code generation, it can be defined in the data item or data object. By default, the `MemoryAddress_ASAP2` property does not exist in the `Simulink.Signal` or `Simulink.Parameter` data object classes. If you want to add the attribute, add a property called `MemoryAddress_ASAP2` to a custom class that is a subclass of the `Simulink` or ASAP2 class. For information on subclassing Simulink data classes, see “Define Data Classes” (Simulink).

**Note** In previous releases, for ASAP2 file generation, you had to define objects explicitly as `ASAP2.Signal` and `ASAP2.Parameter`. This is no longer a limitation. As explained above, you can use built-in Simulink objects for generating an ASAP2 file. If you have been using an earlier release, you can continue to use the ASAP2 objects. If one of these ASAP2 objects was created in the previous release, and you use it in this release, the MATLAB Command Window displays a warning the first time the objects are loaded.

The following table indicates the Simulink object properties that have replaced the ASAP2 object properties of the previous release:
Differences Between ASAP2 and Simulink Parameter and Signal Object Properties

<table>
<thead>
<tr>
<th>ASAP2 Object Properties (Previous)</th>
<th>Simulink Object Properties (Current)</th>
</tr>
</thead>
<tbody>
<tr>
<td>LONGID_ASAP2</td>
<td>Description</td>
</tr>
<tr>
<td>PhysicalMin_ASAP2</td>
<td>Min</td>
</tr>
<tr>
<td>PhysicalMax_ASAP2</td>
<td>Max</td>
</tr>
<tr>
<td>Units_ASAP2</td>
<td>Unit</td>
</tr>
</tbody>
</table>

Automatic ECU Address Replacement for ASAP2 Files (Embedded Coder)

If Embedded Coder is licensed and installed on your system, and if you are generating Executable and Linkable Format (ELF) or Program Database (PDB) files for your embedded target, you can use the `rtw.asap2SetAddress` function to automate the replacement of ECU Address placeholder memory address values with actual addresses in the generated ASAP2 file.

If the memory address attribute is unknown before code generation, the code generator inserts ECU Address placeholder text in the generated ASAP2 file, as shown in the example below.

```
/begin CHARACTERISTIC
  /* Name            */ Ki
  /* Long Identifier */ ""
  /* Type            */ VALUE
  /* ECU Address     */ @ECU_Address@Ki@
```

To substitute actual addresses for the ECU Address placeholders, process the generated ASAP2 file using the `rtw.asap2SetAddress` function. The general syntax is as follows:

```
rtw.asap2SetAddress(ASAP2File, InfoFile)
```

The arguments are character vectors specifying the name of the generated ASAP2 file and the name of the generated executable ELF file, PDB file from Microsoft toolchain, or DWARF debug information files for the model. When called, `rtw.asap2SetAddress` extracts the actual ECU address from the specified ELF, PDB, or DWARF file and replaces the placeholder in the ASAP2 file with the actual address, for example:

```
/begin CHARACTERISTIC
  /* Name            */ Ki
  /* Long Identifier */ ""
```
/* Type            */ VALUE
/* ECU Address     */ 0x40009E60

Define ASAP2 Information for Lookup Tables

Simulink Coder software generates ASAP2 descriptions for lookup table data and its breakpoints. The software represents 1-D table data as CURVE information, 2-D table data as MAP information, and breakpoints as AXIS_DESCR and AXIS_PTS information. You can model lookup tables using one of the following Simulink Lookup Table blocks:

- Direct Lookup Table (n-D) — 1 and 2 dimensions
- Interpolation Using Prelookup — 1 and 2 dimensions
- 1-D Lookup Table
- 2-D Lookup Table
- n-D Lookup Table — 1 and 2 dimensions

The software supports the following types of lookup table breakpoints (axis points):

<table>
<thead>
<tr>
<th>Breakpoint Type</th>
<th>Generates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tunable and shared among multiple table axes (common axis)</td>
<td>COM_AXIS</td>
</tr>
<tr>
<td>Fixed and nontunable (fixed axis)</td>
<td>One of these variants of FIX_AXIS:</td>
</tr>
<tr>
<td></td>
<td>• FIX_AXIS_PAR if breakpoints are integers with equidistant spacing and the equidistant spacing is a power of two</td>
</tr>
<tr>
<td></td>
<td>• FIX_AXIS_PAR_DIST if breakpoints are integers with equidistant spacing</td>
</tr>
<tr>
<td></td>
<td>• FIX_AXIS_PAR_LIST if breakpoints are integers with non-equidistant spacing</td>
</tr>
<tr>
<td>Tunable but not shared among multiple tables (standard axis)</td>
<td>STD_AXIS</td>
</tr>
</tbody>
</table>

When you configure the blocks for ASAP2 code generation:

- For table data, use a Simulink.Parameter data object with a non-Auto storage class.
• For tunable breakpoint data that is shared among multiple table axes (COM_AXIS), use a Simulink.Parameter data object with a non-Auto storage class.

• For fixed, nontunable breakpoint data (FIX_AXIS), use workspace variables or arrays specified in the block parameters dialog box. The breakpoints should be stored as integers in the code, so the data type should be a built-in integer type (int8, int16, int32, uint8, uint16, or uint32), a fixed-point data type, or an equivalent alias type.

• For tunable breakpoint data that is not shared among multiple tables (STD_AXIS):
  1. Create a Simulink.Bus object to define the struct packaging (names and order of the fields). The fields of the parameter structure must correspond to the lookup table data and each axis of the lookup table block. For example, in an n-D Lookup Table block with 2 dimensions, the structure must contain only three fields. This bus object describes the record layout for the lookup characteristic.
  2. Create a Simulink.Parameter object to represent a tunable parameter.
  3. Create table and axis values.
  4. Optionally, specify the Units, Minimum, and Maximum properties for the parameter object. The properties will be applied to table data only.

Here is an example of an n-D Lookup Table record generated into an ASAP2 file in Standard Axis format:

/begin CHARACTERISTIC
/* Name */   STDAxisParam
...          
/* Record Layout */   Lookup1D_X_WORD_Y_FLOAT32_IEEE
...          
begin AXIS_DESCR
/* Description of X-Axis Points */
/* Axis Type */   STD_AXIS
...          
/end AXIS_DESCR
/begin RECORD_LAYOUT  Lookup1D X WORD Y_FLOAT32_IEEE
   AXIS_PTS X 1 WORD INDEX INCR DIRECT
   FNC_VALUES 2 FLOAT32_IEEE COLUMN_DIR DIRECT
/end RECORD_LAYOUT
The example model `rtwdemo_asap2` illustrates ASAP2 file generation for Lookup Table blocks, including both tunable (COM_AXIS) and fixed (FIX_AXIS) lookup table breakpoints.

### Generate an ASAP2 File

- “About Generating ASAP2 Files” on page 31-9
- “Use GRT or ERT System Target File” on page 31-9
- “Use the ASAM-ASAP2 Data Definition Target” on page 31-10
- “Generate ASAP2 Files for Referenced Models” on page 31-11
- “Merge ASAP2 Files for Top and Referenced Models” on page 31-11

### About Generating ASAP2 Files

You can generate an ASAP2 file from your model in one of the following ways:

- Use the Generic Real-Time Target or a Embedded Coder target to generate an ASAP2 file as part of the code generation and build process.
- Use the ASAM-ASAP2 Data Definition Target to generate only an ASAP2 file, without building an executable.

This section discusses how to generate an ASAP2 file by using the targets that have built-in ASAP2 support. For an example, see the ASAP2 example model `rtwdemo_asap2`.

### Use GRT or ERT System Target File

The procedure for generating the ASAP2 data definition for a model using the Generic Real-Time Target or Embedded Coder system target file is as follows:

1. Use the Model Data Editor (View > Model Data Editor) to apply storage classes to signals, block states, and block parameters as described in “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82. Use signal and state names to refer to corresponding MEASUREMENT records and parameter object names to refer to CHARACTERISTIC records.

Use any storage class or custom storage class other than Auto, FileScope, or, if you set the default storage class of the corresponding data category to Default in the Code Mapping Editor (the default setting), Model default. For example, using ExportedGlobal configures the data item as an unstructured global variable in the generated code.
The data item is not represented in the ASAP2 file if any of the following conditions exist:

- You apply one of the storage classes Auto, FileScope, or Default (through Model default).
- You apply a custom storage class that causes the code generator to generate a macro or non-addressable variable.

2 Use the Model Data Editor to configure the remaining properties as desired for each data item.

3 On the Code Generation pane, click Browse to open the System Target File Browser. In the browser, select grt.tlc or an ERT based target file and click OK.

4 On the Code Generation > Interface pane, in the Data exchange interface subgroup, select ASAP2 interface.

5 Select the Generate code only check box on the Code Generation pane.

6 Click Apply.

7 Build the model.

The code generator writes the ASAP2 file to the build folder. By default, the file is named model.a2l, where model is the name of the model. The ASAP2 setup file controls the ASAP2 file name. For details, see “Customize Generated ASAP2 File” on page 38-2.

Use the ASAM-ASAP2 Data Definition Target

The procedure for generating the ASAP2 data definition for a model using the ASAM-ASAP2 Data Definition Target is as follows:

1 Use the Model Data Editor (View > Model Data Editor) to apply storage classes to signals, block states, and block parameters as described in “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82. Use signal and state names to refer to corresponding MEASUREMENT records and parameter object names to refer to CHARACTERISTIC records.

Use any storage class or custom storage class other than Auto, FileScope, or, if you set the default storage class of the corresponding data category to Default in the Code Mapping Editor (the default setting), Model default. For example, using ExportedGlobal configures the data item as an unstructured global variable in the generated code.
**Note** The data item is not represented in the ASAP2 file if any of the following conditions exist:

- You apply one of the storage classes Auto, FileScope, or Default (through Model default).
- You apply a custom storage class that causes the code generator to generate a macro or non-addressable variable.

2. Use the Model Data Editor to configure the remaining properties as desired for each data item.

3. On the **Code Generation** pane, click **Browse** to open the System Target File Browser. In the browser, select `asap2.tlc` and click **OK**.

4. Select the **Generate code only** check box on the **Code Generation** pane.

5. Click **Apply**.

6. Build the model.

The Simulink Coder code generator writes the ASAP2 file to the build folder. By default, the file is named `model.a2l`, where `model` is the name of the model. The ASAP2 setup file controls the ASAP2 file name. For details, see “Customize Generated ASAP2 File” on page 38-2.

### Generate ASAP2 Files for Referenced Models

The build process can generate an ASAP2 file for each referenced model in a model reference hierarchy. In the generated ASAP2 file, MEASUREMENT records represent signals and states inside the referenced model.

To generate ASAP2 files for referenced models, select ASAP2 file generation for the top model and for each referenced model in the reference hierarchy. For example, if you are using the Generic Real-Time Target or an Embedded Coder target, follow the procedure described in “Use GRT or ERT System Target File” on page 31-9 for the top model and each referenced model.

### Merge ASAP2 Files for Top and Referenced Models

Use function `rtw.asap2MergeMdlRefs` to merge the ASAP2 files generated for top and referenced models. The function has the following syntax:

```
[status,info] = rtw.asap2MergeMdlRefs(topModelName, asap2FileName)
```
• `topModelName` is the name of the model containing one or more referenced models.
• `asap2FileName` is the name you specify for the merged ASAP2 file.
• *Optional:* `status` returns false (logical 0) if the merge completes and true (logical 1) otherwise.
• *Optional:* `info` returns additional information about merge failure if `status` is true. Otherwise, it returns an empty character vector.

Consider the following example.

```matlab
[status,info] = rtw.asap2MergeMdlRefs('myTopMdl','merged.a2l')
```

This command merges the ASAP2 files generated for the top model `myTopMdl` and its referenced models in the file `merged.a2l`.

The example model `rtwdemo_asap2` includes an example of merging ASAP2 files.

### Structure of the ASAP2 File

The following table outlines the basic structure of the ASAP2 file and describes the Target Language Compiler (TLC) functions and files used to create each part of the file:

- Static parts of the ASAP2 file are shown in **bold**.
- Function calls are indicated by `%<FunctionName()>`.

<table>
<thead>
<tr>
<th>File Section</th>
<th>Contents of asap2main.tlc</th>
<th>TLC File Containing Function Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>File header</td>
<td><code>%&lt;ASAP2UserFcnWriteFileHead()&gt;</code></td>
<td>asap2userlib.tlc</td>
</tr>
<tr>
<td><code>/begin PROJECT &quot;&quot;</code></td>
<td><code>/begin PROJECT &quot;%&lt;ASAP2ProjectName&gt;&quot;</code></td>
<td>asap2setup.tlc</td>
</tr>
<tr>
<td><code>/begin HEADER &quot;&quot;</code></td>
<td><code>/begin HEADER&quot;%&lt;ASAP2HeaderName&gt;&quot;</code></td>
<td>asap2setup.tlc</td>
</tr>
<tr>
<td>HEADER contents</td>
<td><code>%&lt;ASAP2UserFcnWriteHeader()&gt;</code></td>
<td>asap2setup.tlc</td>
</tr>
<tr>
<td><code>/end HEADER</code></td>
<td><code>/end HEADER</code></td>
<td>asap2userlib.tlc</td>
</tr>
<tr>
<td><code>/begin MODULE &quot;&quot;</code></td>
<td><code>/begin MODULE &quot;%&lt;ASAP2ModuleName&gt;&quot;</code>}</td>
<td>asap2setup.tlc</td>
</tr>
<tr>
<td>MODULE contents:</td>
<td><code>%&lt;ASAP2UserFcnWriteHardwareInterface()&gt;</code></td>
<td>asap2userlib.tlc</td>
</tr>
</tbody>
</table>
- A2ML               |                                                                                          |                                                                 |
- MOD_PAR            |                                                                                          |                                                                 |
- MOD_COMMON         |                                                                                          |                                                                 |
- ...               |                                                                                          |                                                                 |
<table>
<thead>
<tr>
<th>File Section</th>
<th>Contents of asap2main.tlc</th>
<th>TLC File Containing Function Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model-dependent MODULE contents:</td>
<td>%&lt;SLibASAP2WriteDynamicContents()&gt; Calls user-defined functions:</td>
<td>asap2lib.tlc</td>
</tr>
<tr>
<td>- RECORD_LAYOUT</td>
<td>...WriteRecordLayout_TemplateName()</td>
<td>user/templates/...</td>
</tr>
<tr>
<td>- CHARACTERISTIC</td>
<td>...WriteCharacteristic_TemplateName()</td>
<td></td>
</tr>
<tr>
<td>- ParameterGroups</td>
<td>...WriteCharacteristic_Scalar()</td>
<td></td>
</tr>
<tr>
<td>- ModelParameters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- MEASUREMENT</td>
<td>...WriteMeasurement()</td>
<td>asap2userlib.tlc</td>
</tr>
<tr>
<td>- ExternalInputs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- BlockOutputs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- COMPU_METHOD</td>
<td>...WriteCompuMethod()</td>
<td>asap2userlib.tlc</td>
</tr>
<tr>
<td>/end MODULE</td>
<td>/end MODULE</td>
<td></td>
</tr>
<tr>
<td>File footer/tail</td>
<td>%&lt;ASAP2UserFcnWriteFileTail()&gt;</td>
<td>asap2userlib.tlc</td>
</tr>
</tbody>
</table>

### Create a Host-Based ASAM-ASAP2 Data Definition File for Data Measurement and Calibration

This model shows ASAP2 data export. ASAP2 is a data definition standard proposed by the Association for Standardization of Automation and Measuring Systems (ASAM).

#### Open Example Model

Open the example model `rtwdemo_asap2`.

```matlab
open_system('rtwdemo_asap2');
```
ASAP2 is a non-object-oriented description of the data used for measurement, calibration, and diagnostics systems. For more information on ASAM and the ASAP2 standard, see the ASAM Web site: http://www.asam.de.

ASAP2 data definition is achieved with Simulink® data objects and test point signals. Using the Target Language Compiler (TLC), you can create highly customized solutions for your application. See the Simulink Coder® documentation for details on ASAP2 file generation.

You can configure ASAP2 file generation from "Code Generation > Interface > ASAP2 interface" in the Configuration Parameters dialog box.
You can configure ASAP2 file generation by selecting **ASAP2 interface** on the **Code Generation > Interface** pane of the Configuration Parameters dialog box.

**See Also**

**Related Examples**

- “Create Tunable Calibration Parameter in the Generated Code” on page 15-122
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Direct Memory Access to Generated Code for Simulink Coder
Access Memory in Generated Code Using Global Data Map

Simulink Coder provides a Target Language Compiler (TLC) function library that lets you create a global data map record. The global data map record, when generated, is added to the CompiledModel structure in the model.rtw file. The global data map record is a database containing information required for accessing memory in the generated code, including

- Signals (Block I/O)
- Parameters
- Data type work vectors (DWork)
- External inputs
- External outputs

Use of the global data map requires knowledge of the Target Language Compiler and of the structure of the model.rtw file. See “Target Language Compiler Overview” for information on these topics.

The TLC functions that are required to generate and access the global data map record are contained in matlabroot/rtw/c/tlc/mw/globalmaplib.tlc. The comments in the source code fully document the global data map structures and the library functions.

The global data map structures and functions might be modified or enhanced in future releases.

See Also

Related Examples

- “How Generated Code Exchanges Data with an Environment” on page 15-33
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Performance
Optimizations for Generated Code in Simulink Coder

- “Increase Code Generation Speed” on page 33-3
- “Control Compiler Optimizations” on page 33-6
- “Optimization Tools and Techniques” on page 33-7
- “Control Memory Allocation for Time Counters” on page 33-11
- “Execution Profiling for Generated Code” on page 33-12
- “Optimize Generated Code by Combining Multiple for Constructs” on page 33-14
- “Subnormal Number Performance” on page 33-18
- “Remove Code From Floating-Point to Integer Conversions That Wraps Out-of-Range Values” on page 33-23
- “Remove Code That Maps NaN to Integer Zero” on page 33-26
- “Disable Nonfinite Checks or Inlining for Math Functions” on page 33-30
- “Fold Expressions” on page 33-36
- “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 33-41
- “Inline Invariant Signals” on page 33-44
- “Inline Numeric Values of Block Parameters” on page 33-48
- “Configure Loop Unrolling Threshold” on page 33-54
- “Use memcopy Function to Optimize Generated Code for Vector Assignments” on page 33-57
- “Generate Target Optimizations Within Algorithm Code” on page 33-61
- “Remove Code for Blocks That Have No Effect on Computational Results” on page 33-63
- “Eliminate Dead Code Paths in Generated Code” on page 33-66
- “Floating-Point Multiplication to Handle a Net Slope Correction” on page 33-69
- “Use Conditional Input Branch Execution” on page 33-72
• “Optimize Generated Code for Complex Signals” on page 33-78
• “Speed Up Linear Algebra in Code Generated from a MATLAB Function Block” on page 33-81
• “Speed Up Matrix Operations in Code Generated from a MATLAB Function Block” on page 33-85
• “Speed Up Fast Fourier Transforms in Code Generated from a MATLAB Function Block” on page 33-90
• “Synchronize Multithreaded FFTW Planning in Code Generated from a MATLAB Function Block” on page 33-94
• “Control Memory Allocation for Variable-Size Arrays in a MATLAB Function Block” on page 33-99
• “Optimize Memory Usage for Time Counters” on page 33-102
• “Optimize Generated Code Using Boolean Data for Logical Signals” on page 33-109
• “Reduce Memory Usage for Boolean and State Configuration Variables” on page 33-112
• “Customize Stack Space Allocation” on page 33-113
• “Optimize Generated Code Using memset Function” on page 33-115
• “Vector Operation Optimization” on page 33-119
• “Enable and Reuse Local Block Outputs in Generated Code” on page 33-122
Increase Code Generation Speed

In this section...

| “Build a Model in Increments” on page 33-3 |
| “Build Large Model Reference Hierarchies in Parallel” on page 33-3 |
| “Minimize Memory Requirements During Code Generation” on page 33-4 |
| “Generate Only Code” on page 33-5 |
| “No Creation of a Code Generation Report” on page 33-5 |

The amount of time it takes to generate code for a model depends on the size and configuration settings of the model. For instance, if you are working with a large model, it can take awhile to generate code. To decrease the amount of time for code generation of a model, try one or more of the following methods:

- Build a model in increments
- Build large model reference hierarchies in parallel
- Minimize memory requirements during code generation
- Generate only code
- Disable the creation of a code generation report

**Build a Model in Increments**

You can use the `rtwbuild` command to build a model and generate code. By default, when rebuilding a model, `rtwbuild` provides an incremental model build, which only rebuilds a model or submodels that have changed since the most recent model build. Incremental model build saves code generation time. Use the `Rebuild` parameter on the **Model Referencing** pane to change the method that Simulink uses to determine when to rebuild code for referenced models. For more information on the `Rebuild` parameter, see “Rebuild” (Simulink).

**Build Large Model Reference Hierarchies in Parallel**

In a parallel computing environment, whenever conditions allow, you can increase the speed of code generation and compilation by building models containing large model reference hierarchies in parallel. For example, if you have Parallel Computing Toolbox software, you can distribute code generation and compilation for each referenced model.
across the cores of a multicore host computer. If you have MATLAB Distributed Computing Server software, you can distribute code generation and compilation for each referenced model across remote workers in your MATLAB Distributed Computing Server configuration.

The performance gain realized by using parallel builds for referenced models depends on several factors, including:

- How many models can be built in parallel for a given model referencing hierarchy
- The size of the referenced models
- Parallel computing resources such as the number of local and remote workers available
- The hardware attributes of the local and remote machines (amount of RAM, number of cores, and so on)

For more information, see “Reduce Build Time for Referenced Models” on page 27-48.

**Minimize Memory Requirements During Code Generation**

Models that have large amounts of parameter and constant data (such as lookup tables) can tax memory resources and slow code generation. The code generator copies this data to the `model.rtw` file. The `model.rtw` file is a partial representation of the model that the Target Language Compiler parses to transform block computations, parameters, signals, and constant data into a high-level language (for example, C). The Target Language Compiler (TLC) is an integral part of the code generator. The code generator copies parameters and data into `model.rtw`, whether they originate in the model or come from variables or objects in a workspace.

You can improve code generation speed by specifying the maximum number of elements that data vectors can have for the code generator to copy this data to `model.rtw`. When a data vector exceeds the specified size, the code generator places a reference key in `model.rtw`. The TLC uses this key to access the data from Simulink and format it into the generated code. Reference keys result in maintaining only one copy of large data vectors in memory.

The default value above which the code generator uses reference keys in place of actual data values is 10 elements. You can verify this value. In the Command Window, type the following command:

```matlab
get_param(0, 'RTWDataReferencesMinSize')
```
To set the threshold to a different value, in the Command Window, type the following `set_param` function:

```matlab
set_param(0, 'RTWDataReferencesMinSize', <size>)
```

Provide an integer value for `size` that specifies the number of data elements above which the code generator uses reference keys in place of actual data values.

**Generate Only Code**

You can increase code generation speed by specifying that the build process generate code and a makefile, but not invoke the make command. When the code generator invokes the make command, the build process takes longer because the code generator generates code, compiles code, and creates an executable file.

On the **Code Generation** pane in the Model Configuration Parameters dialog box, you can specify that the build process generate only code by selecting the **Generate code only** parameter. You can specify that the code generation process build a makefile by selecting the **Configuration Parameters > Code Generation > Build process > Makefile configuration > Generate makefile** parameter.

**No Creation of a Code Generation Report**

You can speed up code generation by not generating a code generation report as a part of the build process. To disable the creation of a code generation report, on the **Code Generation > Report** pane, clear the **Create code generation report** parameter. After the build process, you can generate a code generation report by doing this procedure, “Generate Code Generation Report After Build Process” on page 22-7.

**See Also**

**Related Examples**

- “Enable parallel model reference builds” (Simulink)
- “MATLAB worker initialization for builds” (Simulink)
- “Reduce Build Time for Referenced Models” on page 27-48
Control Compiler Optimizations

To control compiler optimizations for a makefile build at the GUI level, use the Compiler optimization level parameter. The Compiler optimization level parameter provides

- Target-independent values Optimizations on (faster runs) and Optimizations off (faster builds), which allow you to easily toggle compiler optimizations on and off during code development
- The value Custom for entering custom compiler optimization flags at the Simulink GUI level, rather than editing compiler flags into template makefiles (TMFs) or supplying compiler flags to build process make commands

The default setting is Optimizations off (faster builds). Selecting the value Custom enables the Custom compiler optimization flags field, in which you can enter custom compiler optimization flags (for example, -O2).

**Note** If you specify compiler options for your makefile build using OPT_OPTS, MEX_OPTS (except MEX_OPTS="-v"), or MEX_OPT_FILE, the value of Compiler optimization level is ignored and a warning is issued about the ignored parameter.

For more information about the Compiler optimization level parameter and its values, see “Compiler optimization level” and “Custom compiler optimization flags”.

See Also

Related Examples

- “Template Makefiles and Make Options” on page 27-26
- “Configure a System Target File” on page 19-2
- “Support Compiler Optimization Level Control” on page 39-96
Use the Model Advisor to Optimize a Model for Code Generation

You can use the Model Advisor to analyze a model for code generation and identify aspects of your model that impede production deployment or limit code efficiency. You can select from a set of checks to run on a model's current configuration. The Model Advisor analyzes the model and generates check results providing suggestions for improvements in each area. Most Model Advisor diagnostics do not require the model to be in a compiled state; those that do are noted.

Before running the Model Advisor, select the target you plan to use for code generation. The Model Advisor works most effectively with ERT and ERT-based system target files.

Use the following examples to investigate optimizing models for code generation using the Model Advisor:

- rtwdemo_advisor1
- rtwdemo_advisor2
- rtwdemo_advisor3

**Note** Example models rtwdemo_advisor2 and rtwdemo_advisor3 require Stateflow and Fixed-Point Designer software.

For more information on using the Model Advisor, see “Run Model Checks” (Simulink). For more information about the checks, see “Simulink Coder Checks”.

Design Tips for Optimizing Generated Code for Stateflow Objects

Do Not Access Machine-Parented Data In a Graphical Function

This restriction prevents long parameter lists from appearing in the code generated for a graphical function. You can access local data that resides in the same chart as the graphical function. For more information, see “Reuse Logic Patterns by Defining Graphical Functions” (Stateflow).
Be Explicit About the Inline Option of a Graphical Function

When you use a graphical function in a Stateflow chart, select Inline or Function for the property **Function Inline Option**. Otherwise, the code generated for a graphical function may not appear as you want. For more information, see “Specify Graphical Function Properties” (Stateflow).

Avoid Using Multiple Edge-Triggered Events in Stateflow Charts

When you use a bus object, you reduce the number of parameters in the parameter list of a generated function. This guideline also applies to output signals of a chart. For more information, see “Define Stateflow Structures” (Stateflow).

Combine Input Signals of a Chart Into a Single Bus Object

When you use a bus object, you reduce the number of parameters in the parameter list of a generated function. This guideline also applies to output signals of a chart. For more information, see “Define Stateflow Structures” (Stateflow).

Use Charts with Discrete Sample Times

The code generated for discrete charts that are not inside a triggered or enabled subsystem uses integer counters to track time instead of Simulink provided time. This allows for more efficient code generation in terms of overhead and memory, as well as enabling this code for use in Software-in-the-Loop(SIL) and Processor-in-the-Loop(PIL) simulation modes.

Additional Optimization Techniques

You can apply the following techniques to optimize a model for code generation:

- For Embedded Coder users, if your application uses only integer arithmetic, clear the **Support floating-point numbers** parameter in the **Software environment** section of the **Interface** pane so that the generated code contains no floating-point data or operations. When this parameter is cleared, an error is raised if noninteger data or expressions are encountered during code generation. The error message reports the offending blocks and parameters.
- Disable the **Configuration Parameters > Code Generation > Interface > Advanced parameters > MAT-file logging** parameter. Deselecting this parameter eliminates extra code and memory usage for initializing, updating, and cleaning-up
logging variables. In addition, the code generated to support MAT-file logging invokes `malloc`, which can be undesirable for your application.

- Use the Upgrade Advisor to upgrade older models (saved by prior versions or the current version) to use current features. For details, see “Model Upgrades” (Simulink).
- Before building, set optimization flags for the compiler (for example, `-O2` for `gcc`, `-Ot` for the Microsoft Visual C++ compiler).
- Directly inline C/C++ S-functions into the generated code by writing a TLC file for the S-function. For more information, see “Accelerate Simulation, Reuse Code, or Protect Intellectual Property by Using S-Function Target” on page 24-59 and see “Inline C MEX S-Functions”.
- Use a Simulink data type other than `double` when possible. The available data types are `Boolean`, signed and unsigned 8-, 16-, and 32-bit integers, and 32- and 64-bit floats (a `double` is a 64-bit float). For more information, see “About Data Types in Simulink” (Simulink). For a block-by-block summary, click `showblockdatatypetable` or type the command in the Command Window.
- For tunable block parameters that you configure to store in memory in the generated code, you can match parameter data types with signal data types to eliminate unnecessary typecasts and C shifts. Where possible, store parameter values in small integer data types. See “Parameter Data Types in the Generated Code” on page 15-157.
- Remove repeated values in lookup table data.
- Use the Merge block to merge the output of signals wherever possible. This block is particularly helpful when you need to control the execution of function-call subsystems with a Stateflow chart. The following model shows an example of how to use the Merge block.
When more than one signal connected to a Merge block has a non-Auto storage class, all non-Auto signals connected to that block must be identically labeled and have the same storage class. When Merge blocks connect directly to one another, these rules apply to the signals connected to any of the Merge blocks in the group.

**See Also**

**Related Examples**

- “Increase Code Generation Speed” on page 33-3
- “Execution Profiling for Generated Code” on page 33-12
- “Model Configuration Parameters: Code Generation Optimization”
- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Control Memory Allocation for Time Counters

The **Application lifespan (days)** parameter lets you control the allocation of memory for absolute and elapsed time counters. Such counters exist in the code for blocks that use absolute or elapsed time. For a list of such blocks, see “Absolute Time Limitations” on page 3-12.

The size of the time counters in generated code is 8, 16, 32, or 64 bits. The size is set automatically to the minimum that can accommodate the duration value specified by Application lifespan (days) given the step size specified in the Configuration Parameters Solver pane. To minimize the amount of RAM used by time counters, specify the smallest lifespan possible and the largest step size possible.

An application runs to its specified lifespan. It may be able to run longer. For example, running a model with a step size of one millisecond (0.001 seconds) for one day requires a 32-bit timer, which could continue running without overflow for 49 days more.

To maximize application lifespan, specify Application lifespan (days) as inf. This value allocates 64 bits (two uint32 words) for each timer. Using 64 bits to store timing data would allow a model with a step size of 0.001 microsecond (10E-09 seconds) to run for more than 500 years, which would rarely be required. 64-bit counters do not violate the usual code generator length limitation of 32 bits because the value of a time counter does not provide the value of a signal, state, or parameter.

See Also

“Application lifespan (days)” (Simulink)

Related Examples

- “Absolute and Elapsed Time Computation” on page 3-2
- “Timers in Asynchronous Tasks” on page 5-42
Execution Profiling for Generated Code

Use code execution profiling to:

- Determine whether the generated code meets execution time requirements for real-time deployment on your target hardware.
- Identify code sections that require performance improvements.

The following tasks represent a general workflow that uses code execution profiling:

1. With the Simulink model, design and optimize your algorithm.
2. Configure the model for code execution profiling, and generate code.
3. Execute generated code on target. For example, you can:
   - Run a software-in-the-loop (SIL) simulation on your development computer.
   - Run a processor-in-the-loop (PIL) simulation using a target support package or custom PIL target.
   - Perform real-time execution with Simulink Real-Time or a target support package.
4. Analyze performance through code execution profiling plots and reports. For example, check that the algorithm code satisfies execution time requirements for real-time deployment:
   - If the algorithm code easily meets the requirements, consider enhancing your algorithm to exploit available processing power.
   - If the code cannot be executed in real time, look for ways to reduce execution time.

   Identify the tasks that require the most time. For these tasks, investigate whether trade-offs between functionality and speed are possible.

   If your target is a multicore processor, distribute the execution of algorithm code across available cores.
5. If required, refine the model and return to step 2.

To find information about code execution profiling with Simulink products, use the following table.
<table>
<thead>
<tr>
<th>Target</th>
<th>Execution Feature</th>
<th>Type of Profiling</th>
<th>Relevant Products</th>
<th>See</th>
</tr>
</thead>
</table>
| Development computer | Model configured for concurrent execution | Execution time | Simulink Coder | “Optimize and Deploy on a Multicore Target” (Simulink)  
| | | | | “Concurrent Execution Models” (Simulink) |
| Development computer | Software-in-the-loop (SIL) | Execution time | Embedded Coder | “Code Execution Profiling with SIL and PIL” (Embedded Coder)  
| | | | | “View and Compare Code Execution Times” (Embedded Coder)  
| | | | | “Analyze Code Execution Data” (Embedded Coder) |
| Embedded hardware or instruction set simulator | Processor-in-the-loop (PIL) | Execution time | Embedded Coder | “Code Execution Profiling with SIL and PIL” (Embedded Coder)  
| | | | | “View and Compare Code Execution Times” (Embedded Coder)  
| | | | | “Analyze Code Execution Data” (Embedded Coder) |
| Simulink Real-Time | Real-time execution | Execution time | Simulink Coder, Simulink Real-Time | “Execution Profiling for Real-Time Applications” (Simulink Real-Time) |

**See Also**

**Related Examples**
- “Optimization Tools and Techniques” on page 33-7
- “SIL and PIL Simulations” (Embedded Coder)
Optimize Generated Code by Combining Multiple for Constructs

This example shows how the code generator combines for loops. The generated code uses for constructs to represent a variety of modeling patterns, such as a matrix signal or Iterator blocks. Using data dependency analysis, the code generator combines for constructs to reduce static code size and runtime branching.

The benefits of optimizing for loops are:

- Reducing ROM and RAM consumption.
- Increasing execution speed.

for Loop Modeling Patterns

In the model, rtwdemo_forloop, the Switch block and MATLAB Function block represent for constructs. In the In1 Block Parameters dialog box, the Port dimensions parameter is set to 10.
Generate Code

In the model, there are no data dependencies across the for loop iterations. Therefore, the code generator combines all for loops into one loop. Build the model and view the generated code.

```c
/* Model step function */
void rtwdemo_forloop_step(void)
{
    int32_T k;

    /* MATLAB Function: '<Root>/Accum' */
```
/* MATLAB Function 'Accum': '<S1>:1' */
/* '<S1>:1:3' */
/* '<S1>:1:4' */
rtwdemo_forloop_Y.Out1 = 0.0;

/* '<S1>:1:5' */
for (k = 0; k < 10; k++) {
    /* Switch: '<Root>/Switch' incorporates:
      * Gain: '<Root>/G1'
      * Gain: '<Root>/G3'
      * Inport: '<Root>/In1'
      * Sum: '<Root>/Sum1'
      * Sum: '<Root>/Sum2'
      * UnitDelay: '<Root>/Delay'
    */
    if (3.0 * rtwdemo_forloop_U.In1[k] >= 0.0) {
        rtwdemo_forloop_DW.Delay_DSTATE[k] = rtwdemo_forloop_U.In1[k] -
        rtwdemo_forloop_DW.Delay_DSTATE[k];
    } else {
        rtwdemo_forloop_DW.Delay_DSTATE[k] = (rtwdemo_forloop_DW.Delay_DSTATE[k] -
        rtwdemo_forloop_U.In1[k]) * 5.0;
    }
    /* End of Switch: '<Root>/Switch' */

    /* MATLAB Function: '<Root>/Accum' */
    /* '<S1>:1:5' */
    /* '<S1>:1:6' */
    rtwdemo_forloop_Y.Out1 += (1.0 + (real_T)k) +
    rtwdemo_forloop_DW.Delay_DSTATE[k];
}

Close the model.

### See Also

### Related Examples
- “Optimization Tools and Techniques” on page 33-7
- “Configure Loop Unrolling Threshold” on page 33-54
See Also

- “For Loop” (Embedded Coder)
Subnormal Number Performance

Subnormal numbers, formerly known as denormal numbers in floating-point literature, fill the underflow gap around zero in floating-point arithmetic. Subnormal values are a special category of floating-point values that are too close to 0.0 to be represented as a normalized value. The leading significand (mantissa) of a subnormal number is zero. When adding and subtracting floating-point numbers, subnormal numbers prevent underflow.

Using subnormal numbers provides precision beyond the normal representation by using leading zeros in the significand to represent smaller values after the representation reaches the minimum exponent. As the value approaches 0.0, you trade off precision for extended range. Subnormal numbers are useful if your application requires extra range.

However, in a real-time system, using subnormal numbers can dramatically increase execution latency, resulting in excessive design margins and real-time overruns. If the simulation or generated code performs calculations that produce or consume subnormal numbers, the execution of these calculations can be up to 50 times slower than similar calculations on normal numbers. The actual simulation or code execution time for subnormal number calculations depends on your computer operating environment. Typically, for desktop processors, the execution time for subnormal number calculations is five times slower than similar calculations on normal numbers.

To minimize the possibility of execution slowdowns or overruns due to subnormal number calculation latency, do one of the following:

- In your model, manually flush to zero any incoming or computed subnormal values at inputs and key operations, such as washouts and filters. For an example, see “Flush Subnormal Numbers to Zero” on page 33-20.

To detect a subnormal value for a single precision, 32-bit floating-point number:

1. Find the smallest normalized number on a MATLAB host. In the Command Window, type:

   ```
   >> SmallestNormalSingle = realmin('single')
   ```

   In the C language, `FLT_MIN`, defined in `float.h`, is equivalent to `realmin('single')`.

2. Look for values in range:

   ```
   0 < fabsf(x) < SmallestNormalSingle
   ```
To detect a subnormal value for a double precision, 64-bit floating-point number:

1. Find the smallest normalized number on a MATLAB host. In the Command Window, type:

   ```
   >> SmallestNormalDouble = realmin('double')
   ```

   In the C language, `DBL_MIN`, defined in `float.h`, is equivalent to `realmin('double')`.

2. To detect a subnormal value, look for values in this range:

   ```
   0 < \text{fabs}(x) < \text{SmallestNormalDouble}
   ```

   • On your processor, set flush-to-zero mode or, with your compiler, specify an option to disable subnormal numbers. Flush-to-zero modes treat a subnormal number as 0 when it is an input to a floating-point operation. Underflow exceptions do not occur in flush-to-zero mode.

   For example, in Intel® processors, the flush-to-zero (FTZ) and denormals-are-zero (DAZ) flags in the MXCSR register control floating-point calculations. For the gcc compiler on Linux, `-ffast-math` sets abrupt underflow (FTZ), flush-to-zero, while `-O3 -ffast-math` reverts to gradual underflow, using subnormal numbers.

For more information, see the IEEE Standard 754, *IEEE Standard for Floating-Point Arithmetic*.

**Simulation Time With and Without Subnormal Numbers**

This model shows how using subnormal numbers increases simulation time by ~5 times.

Open the model `ex_subnormal`. The Gain is set to subnormal value `realmin('double')/2`.

![Diagram of the simulation model](image)
To run a simulation, in the Command Window, type `for k=1:5, tic; sim('ex_subnormal'); toc,end`. Observe the elapsed times for simulation using subnormals, similar to the following:

```matlab
>> for k=1:5, tic; sim('ex_subnormal'); toc,end
Elapsed time is 9.909326 seconds.
Elapsed time is 9.617966 seconds.
Elapsed time is 9.797183 seconds.
Elapsed time is 9.702397 seconds.
Elapsed time is 9.893946 seconds.
```

Set the Gain to a number, 2, that is not a subnormal value:

```matlab
>> set_param('ex_subnormal/Gain', 'Gain', '2');
```

To run a simulation, in the Command Window, type `for k=1:5, tic; sim('ex_subnormal'); toc,end`. Observe elapsed times for simulations that do not use subnormal values, similar to the following:

```matlab
>> for k=1:5, tic; sim('ex_subnormal'); toc,end
Elapsed time is 2.045123 seconds.
Elapsed time is 1.796598 seconds.
Elapsed time is 1.758458 seconds.
Elapsed time is 1.721721 seconds.
Elapsed time is 1.780569 seconds.
```

**Flush Subnormal Numbers to Zero**

This example shows how to flush single precision subnormal numbers to zero.

1. Open the model `ex_flush_to_zero`:
• **Repeating Sequence Stair** generates a sequence of numbers from two raised to the power of 0 through two raised to the power of -165. The sequence approaches zero.

• **ConditionRealScalar** flushes subnormal single precision values that are less than `realmin('single')` to zero.

MATLAB function block `log2` generates the base 2 logarithm of the **Repeating Sequence Stair** output. Specifically, `log2` generates the numbers 0 through -165.

2. On the **Simulation > Stepping Options** pane:
   
   • Select **Enable stepping back**.
3 Select **Pause simulation when time reaches** and enter 121.

3 In the model window, run the simulation. The simulation pauses at T=121. The displayed values:

- ConditionRealScalar output approaches zero.
- Repeating Sequence Stair output approaches zero.

4 Step the simulation forward to T=127. ConditionRealScalar flushes the subnormal value output from Repeating Sequence Stair to zero.

5 Continue stepping the simulation forward. ConditionRealScalar flushes the subnormal single precision values output from Repeating Sequence Stair to zero. When T=150, the output of Repeating Sequence Stair is itself zero.

### See Also

### Related Examples

- “Data Types Supported by Simulink” (Simulink)
- “Numerical Consistency of Model and Generated Code Simulation Results” on page 35-2
- “Specify Single-Precision Data Type for Embedded Application” on page 15-112
Remove Code From Floating-Point to Integer Conversions That Wraps Out-of-Range Values

This example shows how to remove code for out-of-range floating-point to integer conversions. Without this code, there might be a mismatch between simulation and code generation results. Standard C does not define the behavior of out-of-range floating-point to integer conversions, while these conversions are well-defined during simulation. In Standard C and during simulation, floating-point to integer conversions are well-defined for input values in the range of the output type.

If the input values in your application are in the range of the output type, remove code for out-of-range floating-point to integer conversions. Removing this code reduces the size and increases the speed of the generated code.

Example Model

In this model, a Data Type Conversion block converts an input signal from a double to a uint8. A uint8 can support values from 0 to 255. If the input signal has a value outside of this range, an out-of-range conversion occurs. In this example, the model is named conversion_ex.

1 Use Inport, Outport, and Data Type Conversion blocks to create the example model.
2 Open the Inport Block Parameters dialog box and select the Signal Attributes tab. For the Data Type parameter, select double.
3 Open the Data Type Conversion dialog box. For the **Output data type** parameter, select `uint8`.

4 For the signal feeding into the Data Type Conversion block, open the Signal Properties dialog box. Enter the name `U`. On the **Code Generation** tab, for the **Storage Class** parameter, select `ImportedExtern`.

5 For the signal leaving the Data Type Conversion block, open the Signal Properties dialog box. Enter the name `Y`. On the **Code Generation** tab, for the **Storage Class** parameter, select `ImportedExtern`.

### Generate Code Without Optimization

1 Open the Model Configuration Parameters dialog box. On the **Solver** pane, for the **Type** parameter, select **Fixed-step**.

2 On the **Code Generation > Report** pane, select **Create code generation report**.

3 On the **Code Generation** pane, select **Generate code only**, and then, in the model window, press **Ctrl+B**. When code generation is complete, an HTML code generation report opens.

4 In the Code Generation report, select the `conversion_ex.c` file and view the model step function. The code generator applies the `fmod` function to handle out-of-range-results.

```c
/* Model step function */
void conversion_ex_step(void)
{
    real_T tmp;

    /* DataTypeConversion:
        '<Root>/Data Type Conversion' incorporates:
        Inport: '<>/In1'
    */
    tmp = floor(U);
    if (rtIsNaN(tmp) || rtIsInf(tmp)) {
        tmp = 0.0;
    } else {
        tmp = fmod(tmp, 256.0);
    }

    Y = (uint8_T)
        (tmp < 0.0 ?
         (int32_T)
(uint8_T) -(int8_T)
(uint8_T) -tmp :
(int32_T)
(uint8_T) tmp);

Generate Code with Optimization

1 Open the Configuration Parameters dialog box. On the Optimization pane, select **Remove code from floating-point to integer conversions that wraps out-of-range values**. Generate code.

2 In the code generation report, select the conversion_ex.c file and view the model step function. The generated code does not contain code that protects against out-of-range values.

```c
/* Model step function */
void conversion_ex_step(void)
{
    /* DataTypeConversion: '<Root>/Data Type Conversion' incorporates:
    * Inport: '<Root>/In1'
    */
    Y = (uint8_T)U;
}
```

The generated code is more efficient without this protective code, but it is possible that the execution of generated code does not produce the same results as simulation for values not in the range of 0 to 255.

See Also
“Remove code from floating-point to integer conversions that wraps out-of-range values”

Related Examples
• “hisl_0053: Configuration Parameters > Code Generation > Optimization > Remove code from floating-point to integer conversions that wraps out-of-range values” (Simulink)
• “Optimization Tools and Techniques” on page 33-7
• “Remove Code That Maps NaN to Integer Zero” on page 33-26
Remove Code That Maps NaN to Integer Zero

This example shows how to remove code that maps NaN to integer zero. For floating-point to integer conversions involving saturation, Simulink converts NaN to integer zero during simulation. If your model contains an input value of NaN, you can specify that the code generator produce code that maps NaN to zero. Without this code, there is a mismatch between simulation and code generation results because in Standard C, every condition involving NaN evaluates to false.

If there are no input values of NaN in your application, you can remove code that maps NaN to integer zero. Removing this code reduces the size and increases the speed of the generated code.

Example Model

In this model, a Data Type Conversion block converts an input signal from a double to a uint8. In this example, the model is named conversion_ex.

1. Use Inport, Outport, and Data Type Conversion blocks to create the example model.
2. Open the Inport Block Parameters dialog box and click the Signal Attributes tab. For the Data Type parameter, select double.
3. Open the Data Type Conversion dialog box. For the Output data type parameter, select uint8.
4 Select **Saturate on integer overflow**. Selecting this parameter specifies that an out-of-range signal value equals either the minimum or maximum value that the data type can represent.

5 For the signal feeding into the Data Type Conversion block, open the Signal Properties dialog box. Enter a name of U. On the **Code Generation** tab, for the **Storage Class** parameter, select **ImportedExtern**.

6 For the signal leaving the Data Type Conversion block, open the Signal Properties dialog box. Enter a name of Y. On the **Code Generation** tab, for the **Storage Class** parameter, select **ImportedExtern**.

**Generate Code**

1 Set the **Configuration Parameters** > **Solver** > **Solver options** > **Type** parameter to **Fixed-step**.

2 Disable the **Configuration Parameters** > **Optimization** > **Advanced parameters** > **Remove code from floating-point to integer conversions with saturation that maps NaN to zero** parameter.

3 Enable the **Configuration Parameters** > **Code Generation** > **Report** > **Create code generation report** parameter.

4 Enable the **Configuration Parameters** > **Code Generation** > **Build process** > **Generate code only** parameter. Then, in the model window, press Ctrl+B. When code generation is complete, an HTML code generation report opens.

5 In the Code Generation report, select the `nan_int_ex.c` file and view the model step function. For an input value of NaN, there is agreement between the generated code and simulation because NaN maps to integer zero.

```c
/* Model step function */
void nan_int_ex_step(void)
{
    /* DataTypeConversion: '<Root>/Data Type Conversion' incorporates:
     *  Inport: '<Root>/In1'
     */
    if (U < 256.0) {
        if (U >= 0.0) {
            Y = (uint8_T)U;
        } else {
            Y = 0U;
        }
    } else if (U >= 256.0) {
```
\[ Y = \text{MAX}_{\text{uint8}_T}; \]
\[ } \text{ else } \{ \]
\[ Y = 0U; \]
\[ } \]

**Generate Code with Optimization**

1. Enable the **Configuration Parameters > Optimization > Code generation > Integer and fixed-point > Remove code from floating-point to integer conversions that wraps out-of-range values** parameter. Generate code.

2. In the Code Generation report, select the `nan_int_ex.c` section and view the model step function. The generated code maps \text{NaN} to 255 and not integer zero. The generated code is more efficient without the extra code that maps \text{NaN} to integer zero, but the execution of the generated code does not produce the same results as simulation for \text{NaN} values.

```c
/* Model step function */
void nan_int_ex_step(void)
{
    /* DataTypeConversion: '<Root>/Data Type Conversion' incorporates:
*   Inport: '<Root>/In1'
*/
    if (U < 256.0) {
        if (U >= 0.0) {
            Y = (uint8_T)U;
        } else {
            Y = 0U;
        }
    } else {
        Y = \text{MAX}_{\text{uint8}_T};
    }

    /* End of DataTypeConversion: '<Root>/Data Type Conversion' */
}
```

**See Also**

“Remove code from floating-point to integer conversions with saturation that maps \text{NaN} to zero”
Related Examples

- “Optimization Tools and Techniques” on page 33-7
- “Remove Code From Floating-Point to Integer Conversions That Wraps Out-of-Range Values” on page 33-23
Disable Nonfinite Checks or Inlining for Math Functions

When the code generator produces code for math functions:

- If the model option **Support non-finite numbers** is selected, nonfinite number checking is generated uniformly for math functions, without the ability to specify that nonfinite number checking should be generated for some functions, but not for others.
- By default, inlining is applied uniformly for math functions, without the ability to specify that inlining should be generated for some functions, while invocations should be generated for others.

You can use code replacement library (CRL) customization entries to:

- Selectively disable nonfinite checks for math functions. This can improve the execution speed of the generated code.
- Selectively disable inlining of math functions. This can increase code readability and decrease code size.

The functions for which these customizations are supported include the following:

- Floating-point only: `atan2`, `copysign`, `fix`, `hypot`, `log`, `log10`, `round`, `sincos`, and `sqrt`
- Floating-point and integer: `abs`, `max`, `min`, `mod`, `rem`, `saturate`, and `sign`

The general workflow for disabling nonfinite number checking and/or inlining is as follows:

1. If you can disable nonfinite number checking for a particular math function, or if you want to disable inlining for a particular math function and instead generate a function invocation, you can copy the following MATLAB function code into a MATLAB file with an `.m` file name extension, for example, `crl_table_customization.m`.

   ```matlab
   function hTable = crl_table_customization
   % Create an instance of the Code Replacement Library table for controlling
   % function intrinsic inlining and nonfinite support
   hTable = RTW.TflTable;
   % Inline - true (if function needs to be inline)
   % false (if function should not be inlined)
   % SNF (support nonfinite) - ENABLE (if non-finite checking should be performed)
   % DISABLE (if non-finite checking should NOT be performed)
   ```
registerCustomizationEntry(hTable, 100, 2, 'atan2', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 2, 'atan2', 'single', 'single', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'sincos', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'sincos', 'single', 'single', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'abs', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'abs', 'single', 'single', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'abs', 'int32', 'int32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'abs', 'int16', 'int16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'abs', 'int8', 'int8', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'abs', 'integer', 'integer', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'abs', 'uint32', 'uint32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'abs', 'uint16', 'uint16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'abs', 'uint8', 'uint8', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 2, 'hypot', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 2, 'hypot', 'single', 'single', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'log', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'log', 'single', 'single', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'log10', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 1, 'log10', 'single', 'single', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 2, 'min', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, 100, 2, 'min', 'single', 'single', true, 'UNSPECIFIED');
100, 2, 'min', 'int32', 'int32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'min', 'int16', 'int16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'min', 'int8', 'int8', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'min', 'uint32', 'uint32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'min', 'uint16', 'uint16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'min', 'uint8', 'uint8', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'min', 'integer', 'integer', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'max', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'max', 'single', 'single', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'max', 'int32', 'int32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'max', 'int16', 'int16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'max', 'int8', 'int8', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'max', 'uint32', 'uint32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'max', 'uint16', 'uint16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'max', 'uint8', 'uint8', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'mod', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'mod', 'single', 'single', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'mod', 'int32', 'int32', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'mod', 'int16', 'int16', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'mod', 'int8', 'int8', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'mod', 'uint32', 'uint32', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'mod', 'uint16', 'uint16', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'mod', 'uint8', 'uint8', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'single', 'single', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'int32', 'int32', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'int16', 'int16', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'int8', 'int8', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'uint32', 'uint32', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'uint16', 'uint16', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'uint8', 'uint8', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'int32', 'int32', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'int16', 'int16', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'int8', 'int8', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'uint32', 'uint32', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'uint16', 'uint16', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 2, 'rem', 'uint8', 'uint8', false, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
100, 1, 'round', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'round', 'single', 'single', false, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
100, 3, 'saturate', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 3, 'saturate', 'single', 'single', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 3, 'saturate', 'int32', 'int32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 3, 'saturate', 'int16', 'int16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 3, 'saturate', 'int8', 'int8', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 3, 'saturate', 'uint32', 'uint32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 3, 'saturate', 'uint16', 'uint16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 3, 'saturate', 'uint8', 'uint8', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 3, 'saturate', 'integer', 'integer', true, 'UNSPECIFIED');

registerCustomizationEntry(hTable, ...
100, 1, 'sign', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'sign', 'single', 'single', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'sign', 'int32', 'integer', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'sign', 'int16', 'integer', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'sign', 'int8', 'integer', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'sign', 'uint32', 'uint32', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'sign', 'uint16', 'uint16', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'sign', 'uint8', 'uint8', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'sign', 'integer', 'integer', true, 'UNSPECIFIED');
To reduce the size of the file, you can delete the registerCustomizationEntry lines for functions for which the default nonfinite number checking and inlining behavior is acceptable.

For each remaining entry,

- Set the Inline argument to true if the function should be inlined or false if it should not be inlined.
- Set the SNF argument to ENABLE if nonfinite checking should be generated, DISABLE if nonfinite checking should not be generated, or UNSPECIFIED to accept the default behavior based on the model option settings.

Save the file.

Optionally, perform a quick check of the syntactic validity of the customization table entries by invoking the table definition file at the MATLAB command line (>> tbl = crl_table_customization). Fix syntax errors that are flagged.

Optionally, view the customization table entries in the Code Replacement Viewer (>> crviewer(crl_table_customization)). For more information about viewing code replacement tables, see “Choose a Code Replacement Library” on page 23-8.

To register these changes and make them appear in the Code replacement library drop-down list located on the Code Generation > Interface pane of the Configuration Parameters dialog box, first copy the following MATLAB function code into an instance of the file rtwTargetInfo.m.

```
registerCustomizationEntry(hTable, ...
100, 1, 'sqrt', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'sqrt', 'single', 'single', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'fix', 'double', 'double', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'fix', 'single', 'single', false, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'copysign', 'double', 'double', true, 'UNSPECIFIED');
registerCustomizationEntry(hTable, ...
100, 1, 'copysign', 'single', 'single', true, 'UNSPECIFIED');
```

**Note** For the example below, specify the argument 'RTW' if a GRT target is selected for your model, otherwise omit the argument.
You can edit the Name field to specify the library name that appears in the Code replacement library drop-down list. Also, the file name in the TableList field must match the name of the file you created in step 1.

To register your changes, with both of the MATLAB files you created present in the MATLAB path, enter the following command at the MATLAB command line:

```
sl_refresh_customizations
```

7 Create or open a model that generates function code corresponding to one of the math functions for which you specified a change in nonfinite number checking or inlining behavior.

8 Open the Configuration Parameters dialog box, go to the Code Generation > Interface pane, and use the Code replacement library drop-down list to select the code replacement entry you registered in step 6, for example, CRL Customization Example.

9 Generate code for the model and examine the generated code to verify that the math functions are generated as expected.
Fold Expressions

Expression folding optimizes code to minimize the computation of intermediate results at block outputs and the storage of such results in temporary buffers or variables. When expression folding is on, the code generator collapses (folds) block computations into a single expression, instead of generating separate code statements and storage declarations for each block in a model. Most Simulink blocks support expression folding.

Expression folding improves the efficiency of generated code, frequently achieving results that compare favorably to hand-optimized code. In many cases, entire groups of model computations fold into a single, highly optimized line of code.

Example Model

```matlab
model = 'rtwdemo_slexprfold';
open_system(model);
```
Generate Code

Expression folding is available only when the **Signal storage reuse** parameter is set to on because expression folding operates only on expressions involving local variables. The **Signal storage reuse** and **Eliminate superfluous local variables (expression folding)** parameters are on by default. Clear the **Eliminate superfluous local variables (expression folding)** parameter or enter the following command in the MATLAB Command Window to turn the parameter off:

```matlab
set_param(model, 'ExpressionFolding','off');
```

Create a temporary folder for the build and inspection process.
currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.

rtwbuild(model)

### Starting build procedure for model: rtwdemo_slexprfold
### Successful completion of build procedure for model: rtwdemo_slexprfold

With expression folding off, in the rtwdemo_slexprfold.c file, there are separate code statements before and in the Switch block operation.

cfile = fullfile(cgDir,'rtwdemo_slexprfold_grt_rtw','rtwdemo_slexprfold.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_slexprfold_step(void)
{
    boolean_T rtb_LogicalOperator;
    boolean_T rtb_RelationalOperator;
    real_T rtb_Gain;

    /* RelationalOperator: '<Root>/Relational Operator1' incorporates:
    *  Constant: '<Root>/Constant'
    *  Inport: '<Root>/In2'
    */
    rtb_LogicalOperator = (rtwdemo_slexprfold_P.UPPER >= rtwdemo_slexprfold_U.In2);

    /* RelationalOperator: '<Root>/Relational Operator' incorporates:
    *  Constant: '<Root>/Constant1'
    *  Inport: '<Root>/In2'
    */
    rtb_RelationalOperator = (rtwdemo_slexprfold_U.In2 <=
                           rtwdemo_slexprfold_P.LOWER);

    /* Logic: '<Root>/Logical Operator' */
    rtb_LogicalOperator = (rtb_LogicalOperator || rtb_RelationalOperator);

    /* Switch: '<Root>/Switch' */
    if (rtb_LogicalOperator) {
        /* Gain: '<Root>/Gain' incorporates:
    *  Inport: '<Root>/In1'
    */
rtb_Gain = 2.0 * rtwdemo_slexprfold_U.In1;

/* Lookup n-D: '<Root>/Look-Up Table' */
rtwdemo_slexprfold_Y.Out1 = look1_binlx(rtb_Gain,
   rtwdemo_slexprfold_P.T1Break, rtwdemo_slexprfold_P.T1Data, 10U);
} else {
   /* Lookup n-D: '<Root>/Look-Up Table (2-D)' incorporates:
   * Inport: '<Root>/In3'
   * Inport: '<Root>/In4'
   */
   rtwdemo_slexprfold_Y.Out1 = look2_binlx(rtwdemo_slexprfold_U.In3,
      rtwdemo_slexprfold_U.In4, rtwdemo_slexprfold_P.T2Break,
      rtwdemo_slexprfold_P.T2Break, rtwdemo_slexprfold_P.T2Data,
      rtCP_LookUpTable2D_maxIndex, 3U);
}

/* End of Switch: '<Root>/Switch' */
}

**Generate Code with Optimization**

Enter the following command to turn expression folding on:

```
set_param(model, 'ExpressionFolding','on');
```

Build the model.

```c
rtwbuild(model);
```

### Starting build procedure for model: rtwdemo_slexprfold
### Successful completion of build procedure for model: rtwdemo_slexprfold

The following is a portion of rtwdemo_slexprfold.c. In the optimized code, the code generator folds all computations into the Switch block operation.

```
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_slexprfold_step(void)
{
   /* Switch: '<Root>/Switch' incorporates:
   * Constant: '<Root>/Constant'
   * Constant: '<Root>/Constant1'
   * Inport: '<Root>/In2'
```
if ((rtwdemo_slexprfold_P.UPPER >= rtwdemo_slexprfold_U.In2) ||
    (rtwdemo_slexprfold_U.In2 <= rtwdemo_slexprfold_P.LOWER)) {
    /* Outport: '<Root>/Out1' incorporates:
    * Gain: '<Root>/Gain'
    * Inport: '<Root>/In1'
    * Lookup_n-D: '<Root>/Look-Up Table'
    */
    rtwdemo_slexprfold_Y.Out1 = look1_binlx(2.0 * rtwdemo_slexprfold_U.In1,
                                             rtwdemo_slexprfold_P.T1Break, rtwdemo_slexprfold_P.T1Data, 10U);
} else {
    /* Outport: '<Root>/Out1' incorporates:
    * Inport: '<Root>/In3'
    * Inport: '<Root>/In4'
    * Lookup_n-D: '<Root>/Look-Up Table (2-D)'
    */
    rtwdemo_slexprfold_Y.Out1 = look2_binlx(rtwdemo_slexprfold_U.In3,
                                             rtwdemo_slexprfold_U.In4, rtwdemo_slexprfold_P.T2Break,
                                             rtwdemo_slexprfold_P.T2Break, rtwdemo_slexprfold_P.T2Data,
                                             rtCP_LookUpTable2D_maxIndex, 3U);
}

/* End of Switch: '<Root>/Switch' */

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

For an example in which code expressions are expression folded between Simulink and Stateflow, open this model rtwdemo_sfexprfold.
Minimize Computations and Storage for Intermediate Results at Block Outputs

Expression Folding

Expression folding optimizes code to minimize the computation of intermediate results at block outputs and the storage of such results in temporary buffers or variables. When expression folding is on, the code generator collapses (folds) block computations into a single expression, instead of generating separate code statements and storage declarations for each block in the model. Most Simulink blocks support expression folding.

Expression folding improves the efficiency of generated code, frequently achieving results that compare favorably to hand-optimized code. In many cases, entire groups of model computations fold into a single, highly optimized line of code.

You can use expression folding in your own inlined S-function blocks. For more information, see “S-Functions That Support Expression Folding” on page 14-79.

Example Model

![Diagram of a model with input and output blocks]
**Generate Code**

With expression folding off, in the explfld.c file, the code generator generates this code.

```c
/* Model step function */
void exprfld_step(void)
{
    /* Gain: '<Root>/Gain' incorporates:
     * Inport: '<Root>/In1'
     */
    exprfld_B.S1 = exprfld_P.Gain_Gain * exprfld_U.i1;

    /* Gain: '<Root>/Gain1' incorporates:
     * Inport: '<Root>/In2'
     */
    exprfld_B.S2 = exprfld_P.Gain1_Gain * exprfld_U.i2;

    /* Outport: '<Root>/Out1' incorporates:
     * Product: '<Root>/Product'
     */
    exprfld_Y.Out1 = exprfld_B.S1 * exprfld_B.S2;
}
```

There are separate code statements for both Gain blocks. Before final output, these code statements compute temporary results for the Gain blocks.

**Enable Optimization**

Expression folding is on by default. To see if expression folding is on for an existing model:

1. Expression folding is available only when the Configuration Parameters > Signal storage reuse parameter is selected because expression folding operates only on expressions involving local variables. Enable the Signal storage reuse parameter.

2. When you select Signal storage reuse, the Enable local block outputs, Reuse local block outputs, and Eliminate superfluous local variables (expression folding) parameters are all on by default.
Generate Code with Optimization

With expression folding, the code generator generates a single-line output computation, as shown in the expfld.c file. The generated comments document the block parameters that appear in the expression.

```c
/* Model step function */
void exprfld_step(void)
{
    /* Outport: '<Root>/Out1' incorporates:
     *  Gain: '<Root>/Gain'
     *  Gain: '<Root>/Gain1'
     *  Inport: '<Root>/In1'
     *  Inport: '<Root>/In2'
     *  Product: '<Root>/Product'
     */
    exprfld_Y.Out1 =
        exprfld_P.Gain_Gain * 
        exprfld_U.i1 * 
        (exprfld_P.Gain1_Gain * exprfld_U.i2);
}
```

For an example of expression folding in the context of a more complex model, click rtwdemo_slexprfold, or at the command prompt, type:

```bash
rtwdemo_slexprfold
```

For more information, see “Enable and Reuse Local Block Outputs in Generated Code” on page 33-122

See Also

“Signal storage reuse” (Simulink) | “Reuse local block outputs” | “Enable local block outputs” | “Eliminate superfluous local variables (Expression folding)”

Related Examples

- “Optimization Tools and Techniques” on page 33-7
- “Apply Storage Classes to Individual Signal, State, and Parameter Data Elements” on page 15-82


**Inline Invariant Signals**

You can optimize the generated code by selecting **Inline invariant signals** on the **Optimization** pane. The generated code uses the numerical values of the invariant signals instead of their symbolic names.

An invariant signal is a block output signal that does not change during Simulink simulation. For example, the signal $S3$ is an invariant signal. An invariant signal is not the same as an invariant constant. The two constants (1 and 2) and the gain value of 3 are invariant constants. To inline invariant constants, set **Default parameter behavior** to **Inlined**.

![Diagram of Simulink model](image)

**Optimize Generated Code Using Inline Invariant Signals**

This example shows how to use inline invariant signals to optimize the generated code. This optimization transforms symbolic names of invariant signals into constant values.

The **InlineInvariantSignals** optimization:

- Reduces ROM and RAM consumption.
- Improves execution speed.

**Example Model**

Consider the model `matlab:rtwdemo_inline_invariant_signals`.

```matlab
model = 'rtwdemo_inline_invariant_signals';
open_system(model);
```
Generate Code

Create a temporary folder (in your system temporary folder) for the build and inspection process.

```matlab
currentDir = pwd;
 [~,cgDir] = rtwdemodir();
```

Build the model using Simulink Coder.

```matlab
rtwbuild(model)
```

### Starting build procedure for model: rtwdemo_inline_invariant_signals
### Successful completion of build procedure for model: rtwdemo_inline_invariant_signals

View the generated code without the optimization. These lines of code are in rtwdemo_inline_invariant_signals.c.

```matlab
cfile = fullfile(cgDir,'rtwdemo_inline_invariant_signals_grt_rtw','rtwdemo_inline_invariant_signals.c');
rtwdemodbtype(cfile,'/* Output and update for atomic system', 1, 0);
```

```c
/* Output and update for atomic system: '<Root>/InlinedConstFcn' */
void rtwdemo_inline__InlinedConstFcn(int32_T rtu_In1,
    B_InlinedConstFcn_rtwdemo_inl_T *localB, const ConstB_InlinedConstFcn rtwdem_T *localC)
{
    /* Product: '<S1>/Product' */
    localB->Product = rtu_In1 * localC->Sum_p;
}
```
**Enable Optimization**

1. Open the Configuration Parameters dialog box.
2. On the **Optimization** pane, select **Inline Invariant Signals**.

Alternatively, you can use the command-line API to enable the optimization:

```
set_param(model, 'InlineInvariantSignals', 'on');
```

**Generate Code with Optimization**

The generated code uses the numerical values of the folded constants instead of creating an additional structure (rtwdemo_inline_invariant_ConstB).

Build the model using Simulink Coder.

```
rtwbuild(model)
```

```bash
### Starting build procedure for model: rtwdemo_inline_invariant_signals
### Successful completion of build procedure for model: rtwdemo_inline_invariant_signals
```

View the generated code with the optimization. These lines of code are in `rtwdemo_minmax.c`.

```
rtwdemodbtype(cfile,...
    '/* Output and update for atomic system', '/* Model output', 1, 0);

/* Output and update for atomic system: '<Root>/InlinedConstFcn' */
void rtwdemo_inline__InlinedConstFcn(int32_T rtu_In1,
    B_InlinedConstFcn_rtwdemo_inl_T *localB)
{
    /* Product: '<S1>/Product' */
    localB->Product = rtu_In1 << 5;
}
```

Close the model and code generation report.
bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Inline invariant signals”

Related Examples
•  “Optimization Tools and Techniques” on page 33-7
•  “Inline Numeric Values of Block Parameters” on page 33-48
Inline Numeric Values of Block Parameters

This example shows how to optimize the generated code by inlining the numeric values of block parameters. Block parameters include the Gain parameter of a Gain block and the table data and breakpoint sets of an n-D Lookup Table block.

This optimization determines whether numeric block parameters occupy global memory in the generated code. The optimization can:

- Improve execution speed.
- Reduce RAM and ROM consumption.

Explore Example Model

Open the example model rtwdemo_paraminline and configure it to show the generated names of blocks.

```matlab
load_system('rtwdemo_paraminline')
set_param('rtwdemo_paraminline','HideAutomaticNames','off')
open_system('rtwdemo_paraminline')
```
The model contains blocks that have these numeric parameters:

- The **Gain** parameters of the Gain blocks
- The **Constant value** parameters of the Constant blocks
- The table data and breakpoint sets of the n-D Lookup Table blocks

The output of the block G2, and the outputs of blocks upstream of G2, change only if you tune the values of the block parameters during simulation or during code execution. When you update the model diagram, these blocks and signal lines appear magenta in color.

Several blocks use `Simulink.Parameter` objects in the base workspace to set the values of their parameters. The parameter objects all use the storage class `Auto`, which means that you can configure the generated code to inline the parameter values.

**Generate Code Without Optimization**

Create a temporary folder for the build and inspection process.

```plaintext
currentDir = pwd;
 [~,cgDir] = rtwdemodir();
```

Disable the optimization by setting **Configuration Parameters > Default parameter behavior** to Tunable.

```plaintext
set_param('rtwdemo_paraminline','DefaultParameterBehavior','Tunable')
```

Generate code from the model.

```plaintext
rtwbuild('rtwdemo_paraminline')
```

### Starting build procedure for model: rtwdemo_paraminline
### Successful completion of build procedure for model: rtwdemo_paraminline

In the code generation report, view the source file `rtwdemo_paraminline_data.c`. The code defines a global structure that contains the block parameter values. Each block parameter in the model, such as a lookup table array, breakpoint set, or gain, appears as a field of the structure.

```plaintext
cfile = fullfile(...
cgDir,'rtwdemo_paraminline_grt_rtw','rtwdemo_paraminline_data.c');
rtwdemodbtype(cfile,'/* Block parameters (default storage) */', '{', 1, 1);
```
/* Block parameters (default storage) */

P_rtwdemo_paraminline_T rtwdemo_paraminline_P = {
/* Variable: MAX_LIFT
   * Referenced by: '<Root>/Constant'
   */
   10.0,

/* Variable: SLIDER_POS
   * Referenced by: '<Root>/Constant1'
   */
   0.0,

/* Variable: T1Break
   * Referenced by: '<Root>/1D Lookup'
   */
   { -5.0, -4.0, -3.0, -2.0, -1.0, 0.0, 1.0, 2.0, 3.0, 4.0, 5.0 },

/* Variable: T1Data
   * Referenced by: '<Root>/1D Lookup'
   */
   { -1.0, -0.99, -0.98, -0.96, -0.76, 0.0, 0.76, 0.96, 0.98, 0.99, 1.0 },

/* Variable: T2Break
   * Referenced by: '<Root>/2D Lookup'
   */
   { 1.0, 2.0, 3.0 },

/* Variable: T2Data
   * Referenced by: '<Root>/2D Lookup'
   */
   { 4.0, 16.0, 10.0, 5.0, 19.0, 18.0, 6.0, 20.0, 23.0 },

/* Expression: 2
   * Referenced by: '<Root>/G1'
   */
   2.0,

/* Expression: -2
   * Referenced by: '<Root>/G2'
   */
   -2.0,

/* Computed Parameter: uDLookup_maxIndex */
You can tune the structure fields during code execution because they occupy global memory. However, at each step of the generated algorithm, the code must calculate the output of each block, including the outputs of the block G2 and the upstream blocks. View the algorithm in the model step function in the file rtwdemo_paraminline.c.

cfile = fullfile(cgDir,'rtwdemo_paraminline_grt_rtw','rtwdemo_paraminline.c');
rtwdemodbtype(...
cfile,'/* Model step function */','/* Model initialize function */',1,0);

/* Model step function */
void rtwdemo_paraminline_step(void)
{
    /* Outport: '<Root>/Out1' incorporates:
      * Constant: '<Root>/Constant'
      * Constant: '<Root>/Constant1'
      * Gain: '<Root>/G1'
      * Gain: '<Root>/G2'
      * Inport: '<Root>/In1'
      * Lookup_n-D: '<Root>/1D Lookup'
      * Lookup_n-D: '<Root>/2D Lookup'
      * Sum: '<Root>/Sum'
    */
    rtwdemo_paraminline_Y.Out1 = rtwdemo_paraminline_P.G1_Gain * rtwdemo_paraminline_U.In1 + rtwdemo_paraminline_P.G2_Gain * look2_binlx
    (rtwdemo_paraminline_P.MAX_LIFT, look1_binlx
    (rtwdemo_paraminline_P.SLIDER_POS, rtwdemo_paraminline_P.T1Break,
    rtwdemo_paraminline_P.T1Data, 10U), rtwdemo_paraminline_P.T2Break,
    rtwdemo_paraminline_P.T2Break, rtwdemo_paraminline_P.T2Data,
    rtwdemo_paraminline_P.uDLookup_maxIndex, 3U);
}

Generate Code with Optimization

Set Default parameter behavior to Inlined.

set_param('rtwdemo_paraminline','DefaultParameterBehavior','Inlined')

Generate code from the model.
rtwbuild('rtwdemo_paraminline')

### Starting build procedure for model: rtwdemo_paraminline
### Successful completion of build procedure for model: rtwdemo_paraminline

In the code generation report, view the algorithm in the file rtwdemo_paraminline.c.

rtwdemodbtype(...
    cfile,'/* Model step function */','/* Model initialize function */',1,0);

/* Model step function */
void rtwdemo_paraminline_step(void)
{
    /* Outport: '<Root>/Out1' incorporates:
     *  Gain: '<Root>/G1'
     *  Inport: '<Root>/In1'
     *  Sum: '<Root>/Sum'
     */
    rtwdemo_paraminline_Y.Out1 = 2.0 * rtwdemo_paraminline_U.In1 + 150.0;
}

The code does not allocate memory for block parameters or for parameter objects that use the storage class Auto. Instead, the code generator uses the parameter values from the model, and from the parameter objects, to calculate and inline the constant output of the block G2, 150.0. The generator also inlines the value of the **Gain** parameter of the Gain block G1, 2.0.

With the optimization, the generated code leaves out computationally expensive algorithmic code for blocks such as the lookup tables. The optimized code calculates the output of a block only if the output can change during execution. For this model, only the outputs of the Inport block In1, the Gain block G1, and the Sum block can change.

Close the model and the code generation report.

bdclose('rtwdemo_paraminline')
rtdemoclean;
cd(currentDir)

**Preserve Block Parameter Tunability**

When you set **Default parameter behavior** to Inlined, you can preserve block parameter tunability by creating Simulink.Parameter objects for individual parameters. You can configure each object to appear in the code as a tunable field of the

33-52
global parameter structure or as an individual global variable. You can change parameter values during code execution and interface the generated code with your own handwritten code. For more information, see “Create Tunable Calibration Parameter in the Generated Code” on page 15-122.

**Inline Invariant Signals**

You can select the Inline invariant signals code generation option (which also places constant values in the generated code) only when you set Default parameter behavior to Inlined. See “Inline Invariant Signals” on page 33-44.

**See Also**

“Default parameter behavior”

**Related Examples**

- “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Configure Loop Unrolling Threshold

The Loop unrolling threshold parameter on the Optimization pane determines when a wide signal or parameter should be wrapped into a for loop and when it should be generated as a separate statement for each element of the signal. The default threshold value is 5.

For example, consider the model below:

![Model diagram](image)

The gain parameter of the Gain block is the vector myGainVec.

Assume that the loop unrolling threshold value is set to the default, 5.

If myGainVec is declared as

```plaintext
myGainVec = [1:10];
```

an array of 10 elements, myGainVec_P.Gain_Gain[], is declared within the Parameters model data structure. The size of the gain array exceeds the loop unrolling threshold. Therefore, the code generated for the Gain block iterates over the array in a for loop, as shown in the following code:
{  
    int32_T i1;
    /* Gain: '<Root>/Gain' */
    for(i1=0; i1<10; i1++) {
        myGainVec_B.Gain_f[i1] = rtb_foo * myGainVec_P.Gain_Gain[i1];
    }
}

If myGainVec is declared as

myGainVec = [1:3];

an array of three elements, myGainVec_P.Gain_Gain[], is declared within the Parameters data structure. The size of the gain array is below the loop unrolling threshold. The generated code consists of inline references to each element of the array, as in the code below.

    /* Gain: '<Root>/Gain' */
    myGainVec_B.Gain_f[0] = rtb_foo * myGainVec_P.Gain_Gain[0];
    myGainVec_B.Gain_f[1] = rtb_foo * myGainVec_P.Gain_Gain[1];

See “Explore Variable Names and Loop Rolling” for more information on loop rolling.

**Note** When a model includes Stateflow charts or MATLAB Function blocks, you can apply a set of Stateflow optimizations on the **Optimization** pane. The settings you select for the Stateflow options also apply to MATLAB Function blocks in the model. This is because the MATLAB Function blocks and Stateflow charts are built on top of the same technology and share a code base. You do not need a Stateflow license to use MATLAB Function blocks.

**See Also**
“Loop unrolling threshold”

**Related Examples**
- “Optimization Tools and Techniques” on page 33-7
- “Optimize Generated Code by Combining Multiple for Constructs” on page 33-14
• “For Loop” (Embedded Coder)
Use memcpy Function to Optimize Generated Code for Vector Assignments

You can use the **Use memcpy for vector assignment** parameter to optimize generated code for vector assignments by replacing `for` loops with `memcpy` function calls. The `memcpy` function is more efficient than `for`-loop controlled element assignment for large data sets. This optimization improves execution speed.

Selecting the **Use memcpy for vector assignment** parameter enables the associated parameter **Memcpy threshold (bytes)**, which allows you to specify the minimum array size in bytes for which `memcpy` function calls should replace `for` loops in the generated code. For more information, see “Use memcpy for vector assignment” and “Memcpy threshold (bytes)”. In considering whether to use this optimization,

- Verify that your target supports the `memcpy` function.
- Determine whether your model uses signal vector assignments (such as `Y=expression`) to move large amounts of data, for example, using the Selector block.

To apply this optimization,

1. Consider first generating code without this optimization and measuring its execution speed, to establish a baseline for evaluating the optimized assignment.
2. Select **Use memcpy for vector assignment** and examine the setting of **Memcpy threshold (bytes)**, which by default specifies 64 bytes as the minimum array size for which `memcpy` function calls replace `for` loops. Based on the array sizes used in your application's signal vector assignments, and target environment considerations that might bear on the threshold selection, accept the default or specify another array size.
3. Generate code, and measure its execution speed against your baseline or previous iterations. Iterate on steps 2 and 3 until you achieve an optimal result.

**Note** The `memcpy` optimization may not occur under certain conditions, including when other optimizations have a higher precedence than the `memcpy` optimization, or when the
generated code is originating from Target Language Compiler (TLC) code, such as a TLC file associated with an S-function block.

**Note** If you are licensed for Embedded Coder software, you can use a code replacement library (CRL) to provide your own custom implementation of the `memcpy` function to be used in generated model code. For more information, see “Memory Function Code Replacement” (Embedded Coder).

**Example Model**

To examine the result of using the **Use memcpy for vector assignment** parameter on the generated vector assignment code, create a model that generates signal vector assignments. For example,

1. Use In, Out, and Selector blocks to create the following model.

![Selector block diagram](image)

2. Open Model Explorer and configure the **Signal Attributes** for the In1 and In2 source blocks. For each, set **Port dimensions** to \([1, 100]\), and set **Data type** to `int32`. Apply the changes and save the model. In this example, the model has the name `vectorassign`.

3. For each Selector block, set the **Index** parameter to 1:50. Set the **Input port size** parameter to 100.
Generate Code

1 The **Use memcpy for vector assignment** parameter is on by default. To turn off the parameter, go to the **Optimization** pane and clear the **Use memcpy for vector assignment** parameter.

2 Go to the **Code Generation > Report** pane of the Configuration Parameters dialog box and select the **Create code generation report**. Then go to the **Code Generation** pane, select the **Generate code only** option, and generate code for the model. When code generation completes, the HTML code generation report is displayed.

3 In the HTML code generation report, click the **vectorassign.c** section and inspect the model step function. Notice that the vector assignments are implemented using for loops.

```c
/* Model step function */
void vectorassign_step(void)
{
    int32_T i;
    for (i = 0; i < 50; i++) {
        /* Outport: '<Root>/Out1' incorporates:
         *  Inport: '<Root>/In1'
         */
        vectorassign_Y.Out1[i] = vectorassign_U.In1[i];

        /* Outport: '<Root>/Out2' incorporates:
         *  Inport: '<Root>/In2'
         */
        vectorassign_Y.Out2[i] = vectorassign_U.In2[i];
    }
}
```

Generate Code with Optimization

1 Go to the **Optimization** pane of the Configuration Parameters dialog box and select the **Use memcpy for vector assignment** option. Leave the **Memcpy threshold (bytes)** option at its default setting of 64. Apply the changes and regenerate code for the model. When code generation completes, the HTML code generation report again is displayed.

2 In the HTML code generation report, click the **vectorassign.c** section and inspect the model output function. Notice that the vector assignments now are implemented using memcpy function calls.

```c
/* Model step function */
void vectorassign_step(void)
{
```
/* Outport: '{Root}/Out1' incorporates:
 *  Inport: '{Root}/In1'
 */
memcpy(&vectorassign_Y.Out1[0], &vectorassign_U.In1[0], 50U * sizeof(real_T));

/* Outport: '{Root}/Out2' incorporates:
 *  Inport: '{Root}/In2'
 */
memcpy(&vectorassign_Y.Out2[0], &vectorassign_U.In2[0], 50U * sizeof(real_T));
}

See Also
“Use memcpy for vector assignment”

Related Examples
•  “Optimization Tools and Techniques” on page 33-7
•  “Vector Operation Optimization” on page 33-119
•  “Convert Data Copies to Pointer Assignments” (Embedded Coder)
Generate Target Optimizations Within Algorithm Code

Some application components are hardware-specific and cannot simulate on a host system. For example, consider a component that includes pragmas and assembly code for enabling hardware instructions for saturate on add operations or a Fast Fourier Transform (FFT) function.

The following table lists integration options to customize generated algorithm code with target-specific optimizations.

**Note** Solutions marked with *EC only* require an Embedded Coder license.

<table>
<thead>
<tr>
<th>If...</th>
<th>Then...</th>
<th>For More Information, See</th>
</tr>
</thead>
<tbody>
<tr>
<td>You want to optimize the execution speed and memory of the model code by replacing default math functions and operators with target-specific code</td>
<td><em>EC only</em>—Implement function and operator replacements by using the Code Replacement Tool, code replacement library (CRL) API, and Code Replacement Viewer to create, examine, validate, and register hardware-specific replacement tables</td>
<td>“Optimize Generated Code By Developing and Using Code Replacement Libraries - Simulink®” (Embedded Coder)</td>
</tr>
</tbody>
</table>
| You want to control how code generation technology declares, stores, and represents signals, tunable parameters, block states, and data objects in generated code | *EC only*—Design (create) and apply custom storage classes | • rtwdemo_cscpredef  
• rtwdemo_importstruct  
• rtwdemo_advsc  
• “Apply Custom Storage Classes to Individual Signal, State, and Parameter Data Elements” (Embedded Coder) |
**Note** To simulate an algorithm that includes target-specific elements in a host environment, you must create code that is equivalent to the target code and can run in the host environment.
Remove Code for Blocks That Have No Effect on Computational Results

This example shows how the code generator optimizes generated code by removing code that has no effect on computational results. This optimization:

• Increases execution speed.
• Reduces ROM consumption.

Example

In the model rtwdemo_blockreduction, a Gain block of value 1.0 is in between Inport and Outport blocks.

```matlab
model = 'rtwdemo_blockreduction';
open_system(model);
```

Generate Code

Create a temporary folder for the build and inspection process.

```matlab
currentDir=pwd;
 [~,cgDir]=rtwdemodir();

Build the model.

```matlab
set_param(model,'BlockReduction','off');
rtwbuild(model)
```

### Starting build procedure for model: rtwdemo_blockreduction
### Successful completion of build procedure for model: rtwdemo_blockreduction
Here is the code from `rtwdemo_blockreduction.c`.

```c
void rtwdemo_blockreduction_step(void)
{
    rtwdemo_blockreduction_Y.Out1 = 1.0 * rtwdemo_blockreduction_U.In1;
}
```

**Enable Optimization**

1. Open the Configuration Parameters dialog box.
2. Select **Block reduction**. This optimization is on by default.

Alternately, use the command-line API to enable the optimization.

```matlab
set_param(model,'BlockReduction','on');
```

**Generate Code with Optimization**

```matlab
rtwbuild(model)
```

### Starting build procedure for model: rtwdemo_blockreduction
### Successful completion of build procedure for model: rtwdemo_blockreduction

Here is the optimized code from `rtwdemo_blockreduction.c`.

```c
void rtwdemo_blockreduction_step(void)
{
    rtwdemo_blockreduction_Y.Out1 = 1.0 * rtwdemo_blockreduction_U.In1;
}
```
Because multiplying the input signal by a value of 1.0 does not impact computational results, the code generator excludes the Gain block from the generated code. Close the model and clean up.

```matlab
bdclose(model)
rtwdemoclean;
cd(currentDir)
```

**See Also**

“Block reduction” (Simulink)

**Related Examples**

- “Optimization Tools and Techniques” on page 33-7
- “Inline Numeric Values of Block Parameters” on page 33-48
- “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 33-41
Eliminate Dead Code Paths in Generated Code

This example shows how the code generator eliminates dead (that is, unused) code paths from generated code. This optimization increases execution speed and conserves ROM and RAM consumption.

**Example**

In the model `rtwdemo_deadpathElim`, the signal leaving the Sum block divides into two separate code paths. The top path is not a dead code path. If the user disables the Assertion block, the bottom path becomes a dead code path.

```matlab
model = 'rtwdemo_deadpathElim';
open_system(model);
```

![Diagram of model rtwdemo_deadpathElim](image)

**Generate Code with an Enabled Assertion Block**

1. For the Assertion block, open the block parameters dialog box.
2. Select the **Enable assertion** box. Alternatively, use the command-line API to enable the Assertion block.

```matlab
set_param([model '/Assert1'], 'Enabled', 'on');
```

Create a temporary folder for the build and inspection process.

```matlab
currentDir = pwd;
[-,cgDir] = rtwdemodir();
```

Build the model.

```matlab
rtwbuild(model)
### Starting build procedure for model: rtwdemo_deadpathElim
### Successful completion of build procedure for model: rtwdemo_deadpathElim
```
Because the Assertion block is enabled, these lines of `rtwdemo_deadpathElim.c` include code for the Gain and Assertion blocks.

```c
void rtwdemo_deadpathElim_step(void)
{
    /* Sum: '<Root>/Sum1' incorporates:
       *  Constant: '<Root>/Constant1'
       *  Inport: '<Root>/In1'
    */
    rtwdemo_deadpathElim_Y.Out1 = rtwdemo_deadpathElim_U.In1 + 1.0;

    /* Assertion: '<Root>/Assert1' incorporates:
       *  Gain: '<Root>/G1'
    */
    utAssert(2.0 * rtwdemo_deadpathElim_Y.Out1 != 0.0);
}
```

### Generate Code with a Disabled Assertion Block

Disable the Assertion block to generate a dead code path. The code generator detects the dead code path and eliminates it from the generated code.

1. For the Assertion block, open the Block Parameters dialog box.
2. Deselect the **Enable assertion** box.

Alternatively, use the command-line API to disable the Assertion block.

```matlab
set_param([model '/Assert1'], 'Enabled', 'off');
```

Build the model.

```matlab
rtwbuild(model)
```

Because the Assertion block is disabled, these lines of `rtwdemo_deadpathElim.c` do not include code for the Gain and Assertion blocks.

```c
rtwdemodbttype(cfile,'/* Model step', '/* Model initialize function */', 0, 1);
```
void rtwdemo_deadpathElim_step(void)
{
    /* Outport: '<Root>/Out1' incorporates:
       * Constant: '<Root>/Constant1'
       * Inport: '<Root>/In1'
       * Sum: '<Root>/Sum1'
    */
    rtwdemo_deadpathElim_Y.Out1 = rtwdemo_deadpathElim_U.In1 + 1.0;
}

Close the model and clean-up.

bdclose(model)
rtwdemoclean;
cd(currentDir)

For another example of how the code generator eliminates dead code paths in the generated code, see rtwdemo_deadpath.

See Also

Related Examples
  •  “Optimization Tools and Techniques” on page 33-7
  •  “Remove Code for Blocks That Have No Effect on Computational Results” on page 33-63
Floating-Point Multiplication to Handle a Net Slope Correction

This example shows how to use floating-point multiplication to handle a net slope correction. When converting floating-point data types to fixed-point data types in the generated code, a net slope correction is one method of scaling fixed-point data types. Scaling the fixed-point data types avoids overflow conditions and minimizes quantization errors.

For processors that support efficient multiplication, using floating-point multiplication to handle a net slope correction improves code efficiency. If the net slope correction has a value that is not a power of two, using division improves precision.

Note: This example requires a Fixed-Point Designer™ license.

Example

In the model rtwdemo_float_mul_for_net_slope_correction, a Convert block converts an input signal from a floating-point data type to a fixed-point data type. The net slope correction has a value of 3.

```matlab
model = 'rtwdemo_float_mul_for_net_slope_correction';
open_system(model);
```

Generate Code

Create a temporary folder for the build and inspection process.

```matlab
currentDir = pwd;
[~,cgDir] = rtwdemodir();

Build the model.
```
rtwbuild(model)

### Starting build procedure for model: rtwdemo_float_mul_for_net_slope_correction
### Successful completion of build procedure for model: rtwdemo_float_mul_for_net_slope_correction

In these lines of `rtwdemo_float_mul_for_net_slope_correction.c` code, the code generator divides the input signal by `3.0F`.

cfile = fullfile(cgDir,'rtwdemo_float_mul_for_net_slope_correction_ert_rtw',...  'rtwdemo_float_mul_for_net_slope_correction.c');
rtwedemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_float_mul_for_net_slope_correction_step(void)
{
    /* Outport: '<Root>/Output' incorporates:
     *  DataTypeConversion: '<Root>/Data Type Conversion'
     *  Inport: '<Root>/Input'
     */
    rtY.Output = (int16_T)(real32_T)floor((real_T)(rtU.Input / 3.0F));
}

Enable Optimization

1. Open the Configuration Parameters dialog box.
2. On the Math and Data Types pane, select **Use floating-point multiplication to handle net slope corrections**. This optimization is on by default.

Alternatively, you can use the command-line API to enable the optimization.

set_param(model, 'UseFloatMulNetSlope', 'on');

Generate Code with Optimization

rtwbuild(model)

### Starting build procedure for model: rtwdemo_float_mul_for_net_slope_correction
### Successful completion of build procedure for model: rtwdemo_float_mul_for_net_slope_correction

In the optimized code, the code generator multiplies the input signal by the reciprocal of `3.0F`, that is `0.333333343F`.

rtwedemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);
/* Model step function */
void rtwdemo_float_mul_for_net_slope_correction_step(void)
{
    /* Outport: '<Root>/Output' incorporates:
     *  DataTypeConversion: '<Root>/Data Type Conversion'
     *  Inport: '<Root>/Input'
     */
    rtY.Output = (int16_T)(real32_T)floor((real_T)(rtU.Input * 0.333333343F));
}

Close the model and the code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Use floating-point multiplication to handle net slope corrections” (Simulink)

Related Examples
- “Optimization Tools and Techniques” on page 33-7
- “Remove Code From Floating-Point to Integer Conversions That Wraps Out-of-Range Values” on page 33-23
- “Subnormal Number Performance” on page 33-18
Use Conditional Input Branch Execution

This example shows how to optimize the generated code for a model that contains Switch and Multiport Switch blocks. When you select the model configuration parameter **Conditional input branch execution**, Simulink executes only blocks that compute the control input and data input that the control input selects. This optimization improves execution speed.

**Example Model**

In this example, switch paths are conditionally executed. If Switch1 control input is true, Switch1 executes blocks grouped in the Switch1:Path1 branch. If Switch1 control input is false, Switch1 executes blocks grouped in the Switch1:Path2 branch. If Switch1 executes blocks in the Switch1:Path2 branch and Switch2 control input is true, Switch2 executes blocks in the Switch2:Path1 branch. If Switch2 control input is false, Switch2 executes blocks in the Switch2:Path2 branch. The pseudo code shows this logic.

```matlab
model='rtwdemo_condinput';
open_system(model);
```
This model shows conditional input branch execution performed by Simulink and Simulink Coder. Conditional input branch execution improves simulation and code generation execution performance. In this example, switch paths are conditionally executed. That is, if Switch1’s control input is true, Switch1 executes blocks grouped in the "Switch1:Path1" branch. Otherwise, it executes blocks grouped in the "Switch1:Path2" branch. If blocks in "Switch1:Path2" are executed, Switch2 executes the "Switch2:Path1" branch if its control input is true. Otherwise, it executes the "Switch2:Path2" branch. This logic is illustrated by the pseudo code above.
Generate Code

The Conditional input branch execution parameter is on by default. Enter the following command-line API to turn off the parameter.

```
set_param(model, 'ConditionallyExecuteInputs', 'off');
```

Create a temporary folder for the build and inspection process.

```
currentDir=pwd;
[~,cgDir]=rtwdemodir();
```

Build the model.

```
rtwbuild(model)
```

### Starting build procedure for model: rtwdemo_condinput
### Successful completion of build procedure for model: rtwdemo_condinput

View the generated code without the optimization. These lines of code are in the rtwdemo_condinput.c file.

```
cfile = fullfile(cgDir,'rtwdemo_condinput_grt_rtw','rtwdemo_condinput.c');
rtwdemodbtype(cfile,'/* Model step', '/* Model initialize', 1, 0);

/* Model step function */
void rtwdemo_condinput_step(void)
{
    /* Switch: '<Root>/ Switch2' incorporates:
     *  Constant: '<Root>/ C_10'
     *  Constant: '<Root>/C_5'
     *  Gain: '<Root>/ G3'
     *  Inport: '<Root>/input'
     *  RelationalOperator: '<Root>/Relational Operator'
     *  Sum: '<Root>/ Sum'
    */
    if (rtwdemo_condinput_U.input >= -5.0) {
        rtwdemo_condinput_Y.output = 3.0 * rtwdemo_condinput_U.input;
    } else {
        rtwdemo_condinput_Y.output = rtwdemo_condinput_U.input + -10.0;
    }

    /* End of Switch: '<Root>/ Switch2' */
The generated code contains an if-else statement for the Switch1 block and an if statement for the Switch2 block. Therefore, the generated code for Switch1:Path2 executes even if the if statement for Switch1:Path1 evaluates to true.

Enable Optimization

1. Open the Configuration Parameters dialog box.
2. Select the Conditional input branch execution parameter. Alternatively, you can use the command-line API to enable the optimization.

```matlab
set_param(model, 'ConditionallyExecuteInputs', 'on');
```

Generate Code with Optimization

```matlab
rtwbuild(model)
cfile = fullfile(cgDir, 'rtwdemo_condinput_grt_rtw', 'rtwdemo_condinput.c');
rtwdemodbtype(cfile, '/* Model step', '/* Model initialize', 1, 0);
```
if (rtwdemo_condinput_U.input >= 5.0) {
    rtwdemo_condinput_Y.output = rtwdemo_condinput_U.input + 10.0;
} else if (rtwdemo_condinput_U.input >= -5.0) {
    rtwdemo_condinput_Y.output = 3.0 * rtwdemo_condinput_U.input;
} else {
    rtwdemo_condinput_Y.output = rtwdemo_condinput_U.input + -10.0;
}

The generated code contains one if statement. The generated code for Switch1:Path2 only executes if the if statement evaluates to false.

**Close Model and Code Generation Report**

bdclose(model)
rtwdemoclean;
cd(currentDir)

**See Also**

“Conditional input branch execution” (Simulink) | Multiport Switch | Switch
Related Examples

- “Optimization Tools and Techniques” on page 33-7
- “Eliminate Dead Code Paths in Generated Code” on page 33-66
Optimize Generated Code for Complex Signals

This example shows how Simulink Coder handles complex signals efficiently. To view the data types of the signals, update the model using Simulation > Update Diagram. Complex signals are represented as structures in generated code. Simulink Coder performs various optimizations on these structures. For example:

- **Expression Folding**: Gain and Sum operations on the complex signal are folded into a single expression.
- **For-loop fusion**: Two separate for-loops, one for the complex signal and one for noncomplex signal, are combined into a single for-loop.
- **Inlined block parameters**: The value of Gain block "pi" is inlined in the expression of the complex Gain-Sum.

Because of optimizations such as these, the code generated for complex and noncomplex signals is equally efficient.

**Example Model**

```matlab
model='rtwdemo_complex';
open_system(model);
```
This model shows how Simulink Coder handles complex signals efficiently. To view the data types of the signals, update the model using Simulation > Update Diagram. Complex signals are represented as structures in generated code. Simulink Coder performs various optimizations on these structures. For example,

- Expression folding: Gain and Sum operations on the complex signal are folded into a single expression.
- For-loop fusion: Two separate for-loops, one for the complex signal and one for the noncomplex signal, are combined into a single for-loop.
- Inlined block parameters: The value of Gain block "pi" is inlined in the expression of the complex Gain-Sum.

Because of optimizations such as these, the code generated for complex and noncomplex signals is equally efficient.

See Also

Related Examples

- “Optimization Tools and Techniques” on page 33-7
• “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 33-41
• “Disable Nonfinite Checks or Inlining for Math Functions” on page 33-30
Speed Up Linear Algebra in Code Generated from a MATLAB Function Block

To improve the execution speed of code generated for certain linear algebra functions in a MATLAB Function block, specify that the code generator produce LAPACK calls. LAPACK is a software library for numerical linear algebra. The code generator uses the LAPACKE C interface to LAPACK. If you specify that you want to generate LAPACK calls, and the input arrays for the linear algebra functions meet certain criteria, the code generator produces the LAPACK calls. Otherwise, the code generator produces code for the linear algebra functions.

The code generator uses the LAPACK library that you specify. Specify a LAPACK library that is optimized for your execution environment. See www.netlib.org/lapack/faq.html#_what_and_where_are_the_lapack_vendors_implementations.

Specify LAPACK Library

To generate LAPACK calls, you must have access to a LAPACK callback class. A LAPACK callback class specifies the LAPACK library and LAPACKE header file for the LAPACK calls. To indicate that you want to generate LAPACK calls and that you want to use a specific LAPACK library, specify the name of the LAPACK callback class. In the Configuration Parameters dialog box, set Custom LAPACK library callback to the name of the callback class, for example, useMyLAPACK.

Write LAPACK Callback Class

To specify the locations of a particular LAPACK library and LAPACKE header file, write a LAPACK callback class. Share the callback class with others who want to use this LAPACK library for LAPACK calls in generated code.

The callback class must derive from the abstract class coder.LAPACKCallback. Use this example callback class as a template.

```matlab
classdef useMyLAPACK < coder.LAPACKCallback
    methods (Static)
        function hn = getHeaderFilename()
            hn = 'mylapacke_custom.h';
        end
        function updateBuildInfo(buildInfo, buildctx)
            % Update build information
        end
    end
end
```
You must provide the `getHeaderFilename` and `updateBuildInfo` methods. The `getHeaderFilename` method returns the LAPACKE header file name. In the example callback class, replace `mylapacke_custom.h` with the name of your LAPACKE header file. The `updateBuildInfo` method provides the information required for the build process to link to the LAPACK library. Use code like the code in the template to specify the location of header files and the full path name of the LAPACK library. In the example callback class, replace `mylapack` with the name of your LAPACK library.

If your compiler supports only complex data types that are represented as structures, include these lines in the `updateBuildInfo` method.

```matlab
define defines('HAVE_LAPACK_CONFIG_H')
define defines('LAPACK_COMPLEX_STRUCTURE')
```

### Generate LAPACK Calls by Specifying a LAPACK Callback Class

This example shows how to generate code that calls LAPACK functions in a specific LAPACK library. For this example, assume that the LAPACK callback class `useMyLAPACK` specifies the LAPACK library that you want.

1. Create a Simulink model.
2. Add a MATLAB Function block to the model.
3. In the MATLAB Function block, add code that calls a linear algebra function. For example, add the function `mysvd` that calls the MATLAB function `svd`.

```matlab
function s = mysvd(A)
    #codegen
    s = svd(A);
end
```
4. Add a Constant block to the left of the MATLAB Function block. Set the value to `zeros(500)`.
5 Add an Outport block to the right of the MATLAB Function block.
6 Connect the blocks.

7 Set the Configuration Parameters > Code Generation > Advanced parameters > Custom LAPACK library callback parameter to useMyLAPACK.

The callback class must be on the MATLAB path.

8 Build the model.

If the input to mysvd is large enough, the code generator produces a LAPACK call for svd. An example of a call to the LAPACK library function for svd is:

```matlab
info_t = LAPACKE_dgesvd( ... 
    LAPACK_COL_MAJOR, 'N', 'N', (lapack_int)500, ...
    (lapack_int)500, &A[0], (lapack_int)500, &S[0], ...
    NULL, (lapack_int)1, NULL,(lapack_int)1, &superb[0]);
```

**Locate LAPACK Library in Execution Environment**

The LAPACK library must be available in your execution environment. If your LAPACK library is shared, use environment variables or linker options to specify the location of the LAPACK library.

- On a Windows platform, modify the PATH environment variable.
- On a Linux platform, modify the LD_LIBRARY_PATH environment variable or use the rpath linker option.
- On a macOS platform, modify the DYLD_LIBRARY_PATH environment variable or use the rpath linker option.

To specify the rpath linker option, you can use the build information addLinkFlags method in the updateBuildInfo method of your coder.LAPACKCallback class. For example, for a GCC compiler:

```matlab
buildInfo.addLinkFlags(sprintf('-Wl,-rpath,"%s"',libPath));
```
See Also
coder.LAPACKCallback

More About
• “LAPACK Calls for Linear Algebra in a MATLAB Function Block” (Simulink)

External Websites
• www.netlib.org/lapack
• www.netlib.org/lapack/
  faq.html#_what_and_where_are_the_lapack_vendors_implementations
Speed Up Matrix Operations in Code Generated from a MATLAB Function Block

To improve the execution speed of code generated for certain low-level vector and matrix operations (such as matrix multiplication) in a MATLAB Function block, specify that you want the code generator to produce BLAS calls. BLAS is a software library for low-level vector and matrix computations that has several highly optimized machine-specific implementations. The code generator uses the CBLAS C interface to BLAS. If you specify that you want to generate BLAS calls, and the input arrays for the matrix functions meet certain criteria, the code generator produces the BLAS calls. Otherwise, the code generator produces code for the matrix functions.

The code generator uses the BLAS library that you specify. Specify a BLAS library that is optimized for your execution environment.

Specify BLAS Library

To produce BLAS calls in generated code, you must have access to a BLAS callback class. A BLAS callback class specifies the BLAS library, the CBLAS header file, certain C data types the particular CBLAS interface uses and the compiler and linker options for the build process.

To indicate that you want to generate BLAS calls and use a specific BLAS library, specify the name of the BLAS callback class. In the Configuration Parameters dialog box, set **Custom BLAS library callback** to the name of the callback class.

Write BLAS Callback Class

To generate calls to a specific BLAS library in the generated code, write a BLAS callback class. Share the callback class with others who want to use this BLAS library for BLAS calls in standalone code.

The callback class must derive from the abstract class `coder.BLASCallback`. This example is an implementation of the callback class `mklcallback` for integration with the Intel MKL BLAS library on a Windows platform.

```matlab
classdef mklcallback < coder.BLASCallback
    methods (Static)
        function updateBuildInfo(buildInfo, ~)
```
libPath = fullfile(pwd,'mkl','WIN','lib','intel64');
libPriority = '';
libPreCompiled = true;
libLinkOnly = true;
libs = {'mkl_intel_ilp64.lib' 'mkl_intel_thread.lib' 'mkl_core.lib'};
buildInfo.addLinkObjects(libs, libPath, libPriority, libPreCompiled, libLinkOnly);
buildInfo.addLinkObjects('libiomp5md.lib',fullfile(matlabroot,'bin','win64'), libPriority, libPreCompiled, libLinkOnly);
buildInfo.addIncludePaths(fullfile(pwd,'mkl','WIN','include'));
buildInfo.addDefines('-DMKL_ILP64');
end
function headerName = getHeaderFilename()
    headerName = 'mkl_cblas.h';
end
function intTypeName = getBLASIntTypeName()
    intTypeName = 'MKL_INT';
end
end

You must provide the getHeaderFilename, getBLASIntTypeName, and updateBuildInfo methods. The getHeaderFilename method returns the CBLAS header file name. If you are using a different BLAS library, replace mkl_cblas.h with the name of your CBLAS header file. The getBLASIntTypeName method returns the name of the integer data type that your CBLAS interface uses. If you are using a different BLAS library, replace MKL_INT with the name of the integer data type specific to your CBLAS interface. The updateBuildInfo method provides the information required for the build process to link to the BLAS library. Use code that is like the code in the example callback class to specify the location of header file, the full path name of the BLAS library, and the compiler and linker options. If you use the Intel MKL BLAS library, use the link line advisor to see which libraries and compiler options are recommended for your use case.

There are three other methods that are already implemented in coder.BLASCallback. These methods are getBLASDoubleComplexTypeName, getBLASSingleComplexTypeName, and useEnumNameRatherThanTypedef. By default, your callback class inherits these implementations from coder.BLASCallback. In certain situations, you must override these methods with your own definitions when you define your callback class.

The getBLASDoubleComplexTypeName method returns the type used for double-precision complex variables in the generated code. If your BLAS library takes a type other than double* and void* for double-precision complex array arguments, include this method in your callback class definition.
function doubleComplexTypeName = getBLASDoubleComplexTypeName()
doubleComplexTypeName = 'my_double_complex_type';
end

Replace my_double_complex_type with the type that your BLAS library takes for double-precision complex array arguments.

The getBLASSingleComplexTypeName method returns the type used for single-precision complex variables in the generated code. If your BLAS library takes a type other than float* and void* for single-precision complex array arguments, include this method in your callback class definition.

function singleComplexTypeName = getBLASSingleComplexTypeName()
doubleComplexTypeName = 'my_single_complex_type';
end

Replace my_single_complex_type with the type that your BLAS library takes for single-precision complex array arguments.

The useEnumNameRatherThanTypedef method returns false by default. If types for enumerations in your BLAS library include the enum keyword, redefine this method to return true in your callback class definition.

function p = useEnumNameRatherThanTypedef()
p = true;
end

An excerpt from generated C source code that includes the enum keyword is:

genenum CBLAS_SIDE t;
genenum CBLAS_UPLO b_t;
double temp;
genenum CBLAS_TRANSPOSE c_t;
genenum CBLAS_DIAG d_t;

**Generate BLAS Calls by Specifying a BLAS Callback Class**

This example shows how to generate code that calls BLAS functions in a specific BLAS library. The BLAS callback class useMyBLAS specifies the BLAS library that you want to use in this example.

1. Create a Simulink model.
2. Add a MATLAB Function block to the model.
3 In the MATLAB Function block, add code that calls a function for a basic matrix operation. For example, add the function `myMultiply` that multiplies two matrices `A` and `B`.

```matlab
function C = myMultiply(A,B) %#codegen
C = A*B;
end
```

4 Add two Constant blocks to the left of the MATLAB Function block. Set their values to `zeros(1000)`.

5 Add an Outport block to the right of the MATLAB Function block.

6 Connect the blocks.

7 In the Configuration Parameters dialog box, set **Custom BLAS library callback** to the name of the callback class `useMyBLAS`.

The callback class must be on the MATLAB path.

8 Build the model.

If `A` and `B` are large enough, the code generator produces a BLAS call for the matrix multiplication function.

**Locate BLAS Library in Execution Environment**

The BLAS library must be available in your execution environment. If your BLAS library is shared, use environment variables or linker options to specify the location of the BLAS library.

- On a Windows platform, modify the PATH environment variable.
- On a Linux platform, modify the LD_LIBRARY_PATH environment variable or use the `rpath` linker option.
- On a macOS platform, modify the DYLD_LIBRARY_PATH environment variable or use the `rpath` linker option.
To specify the rpath linker option, use the build information `addLinkFlags` method in the `updateBuildInfo` method of your BLAS callback class. For example, for a GCC compiler:

```cpp
buildInfo.addLinkFlags(sprintf('-Wl,-rpath,"%s"',libPath));
```

**Usage Notes and Limitations for OpenBLAS Library**

If you generate code that includes calls to the OpenBLAS library functions, follow these guidelines and restrictions:

- If you generate C++ code that includes calls to OpenBLAS library functions, compiling it with the `-pedantic` option produces warnings. To disable the `-pedantic` compiler option, include these lines in the `updateBuildInfo` method:

```cpp
if ctx.getTargetLang() == 'C++'
    buildInfo.addCompileFlags('-Wno-pedantic');
end
```

- OpenBLAS does not support the C89/C90 standard.

**See Also**

coder.BLASCallback

**More About**

- “BLAS Calls for Matrix Operations in a MATLAB Function Block” (Simulink)

**External Websites**

- http://www.netlib.org/blas/
- http://www.netlib.org/blas/faq.html#_5_a_id_are_optimized_blas_libraries_available_where_can_i_find_vendor_supp

33-89
Speed Up Fast Fourier Transforms in Code Generated from a MATLAB Function Block

This example shows how to generate calls to a specific installed FFTW library. For more information about FFTW, see www.fftw.org.

When you simulate a model that includes a MATLAB Function block that calls MATLAB fast Fourier transform (FFT) functions, the simulation software uses the library that MATLAB uses for FFT algorithms. If you generate C/C++ code for this model, by default, the code generator produces code for the FFT algorithms instead of producing FFT library calls. To increase the speed of fast Fourier transforms in generated code, specify that the code generator produce calls to a specific installed FFTW library.

The code generator produces FFTW library calls when all of these conditions are true:

- A MATLAB Function block calls one of these MATLAB functions: `fft`, `fft2`, `fftn`, `ifft`, `ifft2`, or `ifftn`.
- You generate C/C++ code from a model that includes the MATLAB Function block.
- You have access to an FFTW library installation, version 3.2 or later.
- You specify the FFTW library installation in an FFT library callback class that derives from `coder.fftw.StandaloneFFTW3Interface`.
- You set the `Custom FFT library callback` configuration parameter to the name of the callback class.

Install an FFTW Library

If you do not have access to an installed FFTW library, version 3.2 or later, then you must install one.

For a Linux platform or a Mac platform, consider using a package manager to install the FFTW library.

For a Windows platform, in addition to .dll files, you must have .lib import libraries, as described in the Windows installation notes on the FFTW website.

See the installation instructions for your platform on the FFTW website.
**Write FFT Callback Class**

To specify your installation of the FFTW library, write an FFT callback class. Share the callback class with others who want to use this FFTW library for FFTW calls.

The callback class must derive from the abstract class `coder.fftw.StandaloneFFTW3Interface`. Use this example callback class as a template.

```matlab
% copyright 2017 The MathWorks, Inc.
classdef useMyFFTW < coder.fftw.StandaloneFFTW3Interface

methods (Static)
    function th = getNumThreads
        coder.inline('always');
        th = int32(coder.const(1));
    end

    function updateBuildInfo(buildInfo, ctx)
        fftwLocation = '/usr/lib/fftw';
        includePath = fullfile(fftwLocation, 'include');
        buildInfo.addIncludePaths(includePath);
        libPath = fullfile(fftwLocation, 'lib');

        % Double
        libName1 = 'libfftw3-3';
        [~, libExt] = ctx.getStdLibInfo();
        libName1 = [libName1 libExt];
        addLinkObjects(buildInfo, libName1, libPath, 1000, true, true);

        % Single
        libName2 = 'libfftw3f-3';
        [~, libExt] = ctx.getStdLibInfo();
        libName2 = [libName2 libExt];
        addLinkObjects(buildInfo, libName2, libPath, 1000, true, true);
    end
end
end
```

Implement the `updateBuildInfo` and `getNumThreads` methods. In the `updateBuildInfo` method, set `fftwLocation` to the full path for your installation of the library. Set `includePath` to the full path of the folder that contains `fftw3.h`. Set `libPath` to the full path of the folder that contains the library files. If your FFTW installation uses multiple threads, modify the `getNumThreads` method to return the number of threads that you want to use.

Optionally, you can implement these methods:
• `getPlanMethod` to specify the FFTW planning method. See `coder.fftw.StandaloneFFTW3Interface`.

• `lock` and `unlock` to synchronize multithreaded access to the FFTW planning process. See “Synchronize Multithreaded FFTW Planning in Code Generated from a MATLAB Function Block” on page 33-94.

Generate FFTW Calls by Specifying an FFT Callback Class

1. Create a Simulink model.
2. Add a MATLAB Function block to the model.
3. In the MATLAB Function block, add code that calls a MATLAB FFT function. For example, add the function `myfft` that calls the MATLAB function `fft`.

   ```matlab
   function y = myfft()
   t = 0:1/50:10-1/50;
   x = sin(2*pi*15*t) + sin(2*pi*20*t);
   y = fft(x);
   end
   ```

4. Connect the blocks.

5. Indicate that the code generator produce calls to the FFTW library specified in the FFT library callback class `useMyFFTW`. In the Configuration Parameters dialog box, set Custom FFT library callback to `useMyFFTW`.

   The callback class must be on the MATLAB path.

6. Build the model.

Locate FFTW Library in Execution Environment

The FFTW library must be available in your execution environment. If the FFTW library is shared, use environment variables or linker options to specify the location of the library.

• On a Windows platform, modify the PATH environment variable.

• On a Linux platform, modify the LD_LIBRARY_PATH environment variable or use the rpath linker option.
• On a macOS platform, modify the DYLD_LIBRARY_PATH environment variable or use the rpath linker option.

To specify the rpath linker option, you can use the build information addLinkFlags method in the updateBuildInfo method of your coder.fftw.StandaloneFFTW3Interface class. For example, for a GCC compiler:

```c
buildInfo.addLinkFlags(sprintf('-Wl,-rpath,"%s"',libPath));
```

**See Also**

coder.fftw.StandaloneFFTW3Interface

**More About**

• “Synchronize Multithreaded FFTW Planning in Code Generated from a MATLAB Function Block” on page 33-94

**External Websites**

• www.fftw.org
Synchronize Multithreaded FFTW Planning in Code Generated from a MATLAB Function Block

This example shows how to generate code that synchronizes multithreaded access to the FFTW planning process for FFTW library calls in code generated from a MATLAB Function block.

The code generator produces FFTW library calls when all of these conditions are true:

- A MATLAB Function block calls one of these functions: `fft`, `fft2`, `fftn`, `ifft`, `ifft2`, or `iifftn`.
- You generate C/C++ code for a model that includes the MATLAB Function block.
- You have access to an FFTW library installation, version 3.2 or later.
- You specify the FFTW library installation in an FFT library callback class that derives from `coder.fftw.StandaloneFFTW3Interface`.
- You set the Custom FFT library callback configuration parameter to the name of the callback class.

If you integrate the code that contains the FFTW calls with external code that runs on multiple threads, then you must prevent concurrent access to the FFTW planning process. In your FFT library callback class, implement the `lock` and `unlock` methods. You must also provide C code that manages a lock or mutex. Many libraries, such as OpenMP, pthreads, and the C++ standard library (C++ 11 and later), provide locks. This example shows how to implement the lock and unlock methods and provide supporting C code. To manage a lock, this example uses the OpenMP library.

**Prerequisites**

Before you start, for the basic workflow for generating FFTW library calls for fast Fourier transforms in a MATLAB Function block, see “Speed Up Fast Fourier Transforms in Code Generated from a MATLAB Function Block” on page 33-90.

You must have:

- Access to an installed FFTW library.
- A compiler that supports the OpenMP library. To use a different library, such as pthreads, modify the supporting C code accordingly.
Create a Model with a MATLAB Function Block That Calls an FFT Function

1. Create a Simulink model and add a MATLAB Function block to it.
2. Add this code to the MATLAB Function block.

```matlab
function y = mycustomfft()

    t = 0:1/50:10-1/50;
    x = sin(2*pi*15*t) + sin(2*pi*20*t);
    y = fft(x);
    for k = 1:100
        y = y + ifft(x+k);
    end

end
```

3. Add an outport block and connect it to the MATLAB Function block.

Write Supporting C Code

Write C functions that initialize, set, and unset a lock. This example uses the OpenMP library to manage the lock. For a different library, modify the code accordingly.

- Create a file `mylock.c` that contains this C code:

```c
#include "mylock.h"
#include "omp.h"

static omp_nest_lock_t lockVar;

void mylockInitialize(void)
{
    omp_init_nest_lock(&lockVar);
}

void mylock(void)
```

Synchronize Multithreaded FFTW Planning in Code Generated from a MATLAB Function Block
```{omp_set_nest_lock(&lockVar);
}

void myunlock(void)
{
  omp_unset_nest_lock(&lockVar);
}

• Create a header file mylock.h that contains:

```c
#ifndef MYLOCK_H
#define MYLOCK_H

void mylock_initialize(void);
void mylock(void);
void myunlock(void);

#endif
```

### Create an FFT Library Callback Class

Write an FFT callback class `myfftcb` that:

- Specifies the FFTW library.
- Implements `lock` and `unlock` methods that call the supporting C code to control access to the FFTW planning.

Use this class as a template. Replace `fftwLocation` with the location of your FFTW library installation.

```matlab
classdef myfftcb < coder.fftw.StandaloneFFTW3Interface

  methods (Static)
  function th = getNumThreads
coder.inline('always');
  th = int32(coder.const(1));
  end

  function lock()
coder.cinclude('mylock.h', 'InAllSourceFiles', true);
coder.inline('always');
coder.ceval('mylock');
  end
```
function unlock()
    coder.cincludedefile ('mylock.h', 'InAllSourceFiles', true);
coder.inlinedefile('always');
coder.cevaldefile('myunlock');
end

function updateBuildInfo(buildInfo, ctx)
    fftwLocation = '\usr\lib\fftw';
    includePath = fullfile(fftwLocation, 'include');
    buildInfo.addIncludePaths(includePath);
    libPath = fullfile(fftwLocation, 'lib');

    % Double
    libName1 = 'libfftw3-3';
    [~, libExt] = ctx.getStdLibInfo();
    libName1 = [libName1 libExt];
    addLinkObjects(buildInfo, libName1, libPath, 1000, true, true);

    % Single
    libName2 = 'libfftw3f-3';
    [~, libExt] = ctx.getStdLibInfo();
    libName2 = [libName2 libExt];
    addLinkObjects(buildInfo, libName2, libPath, 1000, true, true);
end
end
end

Configure Code Generation Parameters and Build the Model

Configure code generation to use the FFTW callback class and the C code called by
the lock and unlock methods. Configure code generation to generate a call to
mylock_initialize in the initialization code.

In the Configuration Parameters dialog box:

• Set Custom FFT library callback to myfftcb.
• In Code Generation > Custom Code, under Additional build information, set
  Source files to mylock.c.
• In Code Generation > Custom Code, under Insert custom C code in
generated, set Initialize function to mylock_initialize();.
2  Build the model.

See Also

coder.fftw.StandaloneFFTW3Interface

More About

•  “Speed Up Fast Fourier Transforms in Code Generated from a MATLAB Function Block” on page 33-90

External Websites

•  www.fftw.org
Control Memory Allocation for Variable-Size Arrays in a MATLAB Function Block

Dynamic memory allocation allocates memory on the heap as needed at run time, instead of allocating memory statically on the stack. You can use dynamic memory allocation for arrays inside a MATLAB Function block.

You cannot use dynamic memory allocation for:

- Input and output signals. Variable-size input and output signals must have an upper bound.
- Parameters or global variables. Parameters and global variables must be fixed-size.
- Fields of bus arrays. Bus arrays cannot have variable-size fields.
- Discrete state properties of System objects associated with a MATLAB System block.

Dynamic memory allocation is beneficial when:

- You do not know the upper bound of an array.
- You do not want to allocate memory on the stack for large arrays.

Dynamic memory allocation and the freeing of this memory can result in slower execution of the generated code. To control the use of dynamic memory allocation for variable-size arrays in a MATLAB Function block, you can:

- Provide upper bounds for variable-size arrays on page 33-99.
- Disable dynamic memory allocation for MATLAB Function blocks on page 33-100.
- Modify the dynamic memory allocation threshold on page 33-100.

Provide Upper Bounds for Variable-Size Arrays

For an unbounded variable-size array, the code generator allocates memory dynamically on the heap. For a bounded variable-size array, if the size, in bytes, is less than the dynamic memory allocation threshold, the code generator allocates memory statically on the stack. To avoid dynamic memory allocation, provide upper bounds for the array dimensions so that the size of the array, in bytes, is less than the dynamic memory allocation threshold. See “Specify Upper Bounds for Variable-Size Arrays” (Simulink).
Disable Dynamic Memory Allocation for MATLAB Function Blocks

By default, dynamic memory allocation for MATLAB Function blocks is enabled for GRT-based targets and disabled for ERT-based targets. To change the setting, in the Configuration Parameters dialog box, clear or select **Dynamic memory allocation in MATLAB Function blocks**.

If you disable dynamic memory allocation, you must provide upper bounds for variable-size arrays.

Modify the Dynamic Memory Allocation Threshold

Instead of disabling dynamic memory allocation for all variable-size arrays, you can use the dynamic memory allocation threshold to specify when the code generator uses dynamic memory allocation.

Use the dynamic memory allocation threshold to:

- Disable dynamic memory allocation for smaller arrays. For smaller arrays, static memory allocation can speed up generated code. However, static memory allocation can lead to unused storage space. You can decide that the unused storage space is not a significant consideration for smaller arrays.
- Enable dynamic memory allocation for larger arrays. For larger arrays, when you use dynamic memory allocation, you can significantly reduce storage requirements.

The default value of the dynamic memory allocation threshold is 64 kilobytes. To change the threshold, in the Configuration Parameters dialog box, set the **Dynamic memory allocation threshold in MATLAB Function blocks** parameter.

To use dynamic memory allocation for all variable-size arrays, set the threshold to 0.

See Also

More About

- “Code Generation for Variable-Size Arrays” (Simulink)
- “Specify Upper Bounds for Variable-Size Arrays” (Simulink)
• “Use Dynamic Memory Allocation for Variable-Size Arrays in a MATLAB Function Block” (Simulink)
Optimize Memory Usage for Time Counters

This example shows how to optimize the amount of memory that the code generator allocates for time counters. The example optimizes the memory that stores elapsed time, the interval of time between two events.

The code generator represents time counters as unsigned integers. The word size of time counters is based on the setting of the model configuration parameter **Application lifespan (days)**, which specifies the expected maximum duration of time the application runs. You can use this parameter to prevent time counter overflows. The default size is 64 bits.

The number of bits that a time counter uses depends on the setting of the **Application lifespan (days)** parameter. For example, if a time counter increments at a rate of 1 kHz, to avoid an overflow, the counter has the following number of bits:

- Lifespan < 0.25 sec: 8 bits
- Lifespan < 1 min: 16 bits
- Lifespan < 49 days: 32 bits
- Lifespan > 50 days: 64 bits

A 64-bit time counter does not overflow for 590 million years.

**Open Example Model**

Open the example model `rtwdemo_abstime`. 
The model consists of three subsystems SS1, SS2, and SS3. On the **Math and Data Types** pane, the **Application lifespan (days)** parameter is set to the default, which is inf.
The three subsystems contain a discrete-time integrator that requires elapsed time as input to compute its output value. The subsystems vary as follows:

- **SS1** - Clocked at 1 kHz. Does not require a time counter. **Sample time type** parameter for trigger port is set to periodic. Elapsed time is inlined as 0.001.
- **SS2** - Clocked at 100 Hz. Requires a time counter. Based on a lifespan of 1 day, a 32-bit counter stores the elapsed time.
- **SS3** - Clocked at 0.5 Hz. Requires a time counter. Based on a lifespan of 1 day, a 16-bit counter stores the elapsed time.

**Simulate the Model**

Simulate the model. By default, the model is configured to show sample times in different colors. Discrete sample times for the three subsystems appear red, green, and blue. Triggered subsystems are blue-green.

**Generate Code and Report**

1. Create a temporary folder for the build and inspection process.

2. Configure the model for the code generator to use the GRT system target file and a lifespan of \( \text{inf} \) days.

3. Build the model.

```bash
### Starting build procedure for model: rtwdemo_abstime
### Successful completion of build procedure for model: rtwdemo_abstime
```

**Review Generated Code**

Open the generated source file `rtwdemo_abstime.c`.

```c
struct tag_RTM_rtwdemo_abstime_T {
    const char_T *errorStatus;

    /*
     * Timing:
     * The following substructure contains information regarding
     * the timing information for the model.
     */
    struct {
        uint32_T clockTick1;
    }
```
```c
uint32_T clockTickH1;
uint32_T clockTick2;
uint32_T clockTickH2;
struct {
    uint16_T TID[3];
    uint16_T cLimit[3];
} TaskCounters;
} Timing;

/* Block states (default storage) */
extern DW_rtwdemo_abstime_T rtwdemo_abstime_DW;

/* External inputs (root inport signals with default storage) */
extern ExtU_rtwdemo_abstime_T rtwdemo_abstime_U;

/* External outputs (root outports fed by signals with default storage) */
extern ExtY_rtwdemo_abstime_T rtwdemo_abstime_Y;

/* Model entry point functions */
extern void rtwdemo_abstime_initialize(void);
extern void rtwdemo_abstime_step(int_T tid);
extern void rtwdemo_abstime_terminate(void);

/* Real-time Model object */
extern RT_MODEL_rtwdemo_abstime_T *const rtwdemo_abstime_M;

/*-
   * The generated code includes comments that allow you to trace directly
   * back to the appropriate location in the model. The basic format
   * is <system>/block_name, where system is the system number (uniquely
   * assigned by Simulink) and block_name is the name of the block.
   *
   * Use the MATLAB hilite_system command to trace the generated code back
   * to the model. For example,
   *
   * hilite_system('<S3>') - opens system 3
   * hilite_system('<S3>/Kp') - opens and selects block Kp which resides in S3
   *
   * Here is the system hierarchy for this model
   *
   * '<Root>' : 'rtwdemo_abstime'
   * '<S1>' : 'rtwdemo_abstime_SS1'
   * '<S2>' : 'rtwdemo_abstime_SS2'
   */
```
Four 32-bit unsigned integers, clockTick1, clockTickH1, clockTick2, and clockTickH2 are counters for storing the elapsed time of subsystems SS2 and SS3.

**Enable Optimization and Regenerate Code**

1. Reconfigure the model to set the lifespan to 1 day.

2. Build the model.

   ```
   ### Starting build procedure for model: rtwdemo_abstime
   ### Successful completion of build procedure for model: rtwdemo_abstime
   ```

**Review the Regenerated Code**

```c
struct tag_RTM_rtwdemo_abstime_T {
    const char_T *errorStatus;

    /*
    * Timing:
    * The following substructure contains information regarding
    * the timing information for the model.
    */
    struct {
        uint32_T clockTick1;
        uint16_T clockTick2;
        struct {
            uint16_T TID[3];
            uint16_T cLimit[3];
        } TaskCounters;
    } Timing;

    /* Block states (default storage) */
    extern DW_rtwdemo_abstime_T rtwdemo_abstime_DW;

    /* External inputs (root inport signals with default storage) */
    extern ExtU_rtwdemo_abstime_T rtwdemo_abstime_U;

    /* External outputs (root outports fed by signals with default storage) */
    extern ExtY_rtwdemo_abstime_T rtwdemo_abstime_Y;
};
```
/* Model entry point functions */
extern void rtwdemo_abstime_initialize(void);
extern void rtwdemo_abstime_step(int_T tid);
extern void rtwdemo_abstime_terminate(void);

/* Real-time Model object */
extern RT_MODEL_rtwdemo_abstime_T *const rtwdemo_abstime_M;

/*
 * The generated code includes comments that allow you to trace directly
 * back to the appropriate location in the model. The basic format
 * is &lt;system&gt;/block_name, where system is the system number (uniquely
 * assigned by Simulink) and block_name is the name of the block.
 *
 * Use the MATLAB hilite_system command to trace the generated code back
 * to the model. For example,
 *
 * hilite_system('&lt;S3&gt;') - opens system 3
 * hilite_system('&lt;S3&gt;/Kp') - opens and selects block Kp which resides in S3
 *
 * Here is the system hierarchy for this model
 *
 * '&lt;Root&gt;' : 'rtwdemo_abstime'
 * '&lt;S1&gt;' : 'rtwdemo_abstime/SS1'
 * '&lt;S2&gt;' : 'rtwdemo_abstime/SS2'
 * '&lt;S3&gt;' : 'rtwdemo_abstime/SS3'
 */
#endif                                 /* RTW_HEADER_rtwdemo_abstime_h_ */

The new setting for the Application lifespan (days) parameter instructs the code
generator to set aside less memory for the time counters. The regenerated code includes:

- 32-bit unsigned integer, clockTick1, for storing the elapsed time of the task for SS2
- 16-bit unsigned integer, clockTick2, for storing the elapsed time of the task for SS3

Related Information

- “Model Configuration Parameters: Code Generation Optimization”
- “Timers in Asynchronous Tasks” on page 5-42
• “Time-Based Scheduling and Code Generation” on page 4-2

See Also

More About
• “Optimization Tools and Techniques” on page 33-7
• “Control Memory Allocation for Time Counters” on page 33-11
• “Access Timers Programmatically” on page 3-5
• “Generate Code for an Elapsed Time Counter” on page 3-9
• “Absolute Time Limitations” on page 3-12
Optimize Generated Code Using Boolean Data for Logical Signals

Optimize generated code by storing logical signals as Boolean data. When you select the model configuration parameter **Implement logic signals as Boolean data (vs. double)**, blocks that generate logic signals output Boolean signals.

The optimization:

- Reduces the ROM and RAM consumption.
- Improves execution speed.

**Example Model**

Consider the model `rtwdemo_logicalAsBoolean`. The outputs of the Relational Operator, Logical Operator and HitCrossing blocks are double, even though they represent logical data.

```matlab
model = 'rtwdemo_logicalAsBoolean';
open_system(model);
```

![Diagram of logical operators]

Copyright 1994-2012 The MathWorks, Inc.
Generate Code

Create a temporary folder (in your system temporary folder) for the build and inspection process.

```matlab
currentDir = pwd;
 [~, cgDir] = rtwdemodir();
```

Build the model.

```matlab
rtwbuild(model)
```

### Starting build procedure for model: rtwdemo_logicalAsBoolean
### Successful completion of build procedure for model: rtwdemo_logicalAsBoolean

View the generated code without the optimization. These lines of code are in `rtwdemo_logicalAsBoolean.h`.

```matlab
hfile = fullfile(cgDir,'rtwdemo_logicalAsBoolean_ert_rtw','rtwdemo_logicalAsBoolean.h');
rtwdemodbtype(hfile,'/* External outputs','/* Parameters (default storage) */',1,0);
```

```c
/* External outputs (root outports fed by signals with default storage) */
typedef struct {
    real_T Out1; /* '<Root>/Out1' */
    real_T Out2; /* '<Root>/Out2' */
    real_T Out3; /* '<Root>/Out3' */
} ExtY_rtwdemo_logicalAsBoolean_T;
```

Enable Optimization

1. Open the Configuration Parameters dialog box.
2. Select the **Implement logic signals as Boolean data (vs. double)** parameter.

Alternatively, you can use the command-line API to enable the optimization:

```matlab
set_param(model,'BooleanDataType','on');
```

Generate Code with Optimization

The generated code stores the logical signal output as Boolean data.

Build the model.
rtwbuild(model)

### Starting build procedure for model: rtwdemo_logicalAsBoolean
### Successful completion of build procedure for model: rtwdemo_logicalAsBoolean

View the generated code with the optimization. These lines of code are in rtwdemo_logicalAsBoolean.h.

rtwdemodbtype(hfile,'/* External outputs','/* Parameters (default storage) */',1,0);

/* External outputs (root outports fed by signals with default storage) */
typedef struct {
    boolean_T Out1; /* '<Root>/Out1' */
    boolean_T Out2; /* '<Root>/Out2' */
    boolean_T Out3; /* '<Root>/Out3' */
} ExtY_rtwdemo_logicalAsBoolean_T;

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also
“Implement logic signals as Boolean data (vs. double)” (Simulink)

Related Examples
- “Optimization Tools and Techniques” on page 33-7
- “Data Types Supported by Simulink” (Simulink)
- “Use Conditional Input Branch Execution” on page 33-72
- “Bitfields” (Embedded Coder)
Reduce Memory Usage for Boolean and State Configuration Variables

1. Open the Model Configuration Parameters dialog box.
2. In the Model Configuration Parameters dialog box, select the Optimization pane.
3. Choose from these options:
   - **Use bitsets for storing state configuration** — Reduces the amount of memory that stores state configuration variables. However, it can increase the amount of memory that stores target code if the target processor does not include instructions for manipulating bitsets.
   - **Use bitsets for storing Boolean data** — Reduces the amount of memory that stores Boolean variables. However, it can increase the amount of memory that stores target code if the target processor does not include instructions for manipulating bitsets.

**Note** You cannot use bitsets when you generate code for these cases:

- An external mode simulation
- A target that specifies an explicit structure alignment

---

**See Also**

“Use bitsets for storing state configuration” | “Use bitsets for storing Boolean data”

**Related Examples**

- “Optimization Tools and Techniques” on page 33-7
- “Optimize Generated Code Using Boolean Data for Logical Signals” on page 33-109
- “Bitfields” (Embedded Coder)
Customize Stack Space Allocation

Your application might be constrained by limited memory. Controlling the maximum allowable size for the stack is one way to modify whether data is defined as local or global in the generated code. You can limit the use of stack space by specifying a positive integer value for the “Maximum stack size (bytes)” parameter, on the Optimization pane of the Configuration parameter dialog box. Specifying the maximum allowable stack size provides control over the number of local and global variables in the generated code. Specifically, lowering the maximum stack size might generate more variables into global structures. The number of local and global variables help determine the required amount of stack space for execution of the generated code.

The default setting for “Maximum stack size (bytes)” is Inherit from target. In this case, the value of the maximum stack size is the smaller value of the following: the default value set by the code generator (200,000 bytes) or the value of the TLC variable MaxStackSize found in the system target file (ert.tlc).

To specify a smaller stack size for your application, select the Specify a value option of the Maximum stack size (bytes) parameter and enter a positive integer value. To specify a smaller stack size at the command line, use:

```
set_param(model_name, 'MaxStackSize', 65000);
```

**Note** For overall executable stack usage metrics, you might want to do a target-specific measurement, such as using runtime (empirical) analysis or static (code path) analysis with object code.

It is recommended that you use the Maximum stack size (bytes) parameter to control stack space allocation instead of modifying the TLC variable, MaxStackSize, in the system target file. However, a target author might want to set the TLC variable, MaxStackSize, for a target. To set MaxStackSize, use assign statements in the system target file (ert.tlc), as in the following example.

```
%assign MaxStackSize = 4096
```

Write your %assign statements in the Configure RTW code generation settings section of the system target file. The %assign statement is described in “Target Language Compiler”.

33-113
See Also
“Maximum stack size (bytes)”

Related Examples
• “Optimization Tools and Techniques” on page 33-7
• “Enable and Reuse Local Block Outputs in Generated Code” on page 33-122
• “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 33-41
• “Inline Numeric Values of Block Parameters” on page 33-48
Optimize Generated Code Using memset Function

This example shows how to optimize the generated code by using the memset function to clear the internal storage. When you select the model configuration parameter Use memset to initialize floats and doubles to 0.0, the memset function clears internal storage, regardless of type, to the integer bit pattern 0 (that is, all bits are off).

If your compiler and target CPU both represent floating-point zero with the integer bit pattern 0, consider setting this parameter to gain execution and ROM efficiency.

NOTE: The command-line values are the reverse of the settings values. 'on' in the command line corresponds to clearing the setting. 'off' in the command line corresponds to selecting the setting.

This optimization:
• Reduces ROM consumption.
• Improves execution speed.

Example Model

Consider the model matlab:rtwdemo_memset.

```matlab
model = 'rtwdemo_memset';
open_system(model);
```

Generate Code

The code generator uses a loop to initialize the Constant block values.

Create a temporary folder (in your system temporary folder) for the build and inspection process.
currentDir = pwd;
[~, cgDir] = rtwdemodir();

Build the model.

rtwbuild(model)

### Starting build procedure for model: rtwdemo_memset
### Successful completion of build procedure for model: rtwdemo_memset

View the generated code without the optimization. These lines of code are in rtwdemo_memset.c.

cfile = fullfile(cgDir,'rtwdemo_memset_grt_rtw','rtwdemo_memset.c');
rtwdemodbtype(cfile,'/* Model initialize function */', ...
    '/* Model terminate function */',1,0);

/* Model initialize function */
void rtwdemo_memset_initialize(void)
{
    /* Registration code */

    /* initialize error status */
    rtmSetErrorStatus(rtwdemo_memset_M, (NULL));

    /* external outputs */
    {
        int32_T i;
        for (i = 0; i < 50; i++) {
            rtwdemo_memset_Y.Out1[i] = 0.0;
        }
    }

    {
        int32_T i;
        /* ConstCode for Outport: '<Root>/Out1' */
        for (i = 0; i < 50; i++) {
            rtwdemo_memset_Y.Out1[i] = 56.0;
        }
        /* End of ConstCode for Outport: '<Root>/Out1' */
    }
}
Enable Optimization

1. Open the Configuration Parameters dialog box.
2. Clear the Use memset to initialize floats and doubles to 0.0 parameter. Alternatively, you can use the command-line API to enable the optimization:

   set_param(model, 'InitFltsAndDblsToZero', 'off');

Generate Code with Optimization

The code generator uses the memset function to initialize the Constant block values.

Build the model.

rtwbuild(model)

### Starting build procedure for model: rtwdemo_memset
### Successful completion of build procedure for model: rtwdemo_memset

View the generated code with the optimization. These lines of code are in rtwdemo_memset.c.

rtwmoddbtype(cfile, /* Model initialize function */,'
   /* Model terminate function */',1,0);

/* Model initialize function */
void rtwdemo_memset_initialize(void)
{
  /* Registration code */

  /* initialize error status */
  rtmSetErrorStatus(rtwdemo_memset_M, (NULL));

  /* external outputs */
  (void) memset(&rtwdemo_memset_Y.Out1[0], 0,
    50U*sizeof(real_T));

  {
    int32_T i;

    /* ConstCode for Outport: '<Root>/Out1' */
    for (i = 0; i < 50; i++) {
      rtwdemo_memset_Y.Out1[i] = 56.0;
    }
Close the model and the code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

**See Also**

“Use memset to initialize floats and doubles to 0.0”

**Related Examples**

-  “Optimization Tools and Techniques” on page 33-7
-  “Use memcpy Function to Optimize Generated Code for Vector Assignments” on page 33-57
-  “Vector Operation Optimization” on page 33-119
-  “Remove Initialization Code” (Embedded Coder)
Vector Operation Optimization

This example shows how Simulink® Coder™ optimizes generated code by setting block output that generates vectors to scalars, for blocks such as the Mux, Sum, Gain, and Bus. This optimization reduces stack memory by replacing temporary local arrays with local variables.

Example Model

In the model, rtwdemo_VectorOptimization, the output of Gain blocks G1 and G2 are the vector signals tmp1 and tmp2. These vectors have a width of 10.

```matlab
model = 'rtwdemo_VectorOptimization';
open_system(model);
set_param(model, 'SimulationCommand', 'update')
```

Generate Code

Create a temporary folder (in your system temporary folder) for the build and inspection process.

```matlab
currentDir = pwd;
 [~,cgDir] = rtwdemodir();

Build the model.

twbuild(model)
```
### Starting build procedure for model: rtwdemo_VectorOptimization
### Successful completion of build procedure for model: rtwdemo_VectorOptimization

The optimized code is in *rtwdemo_VectorOptimization.c*. The signals *tmp1* and *tmp2* are the local variables *rtb_tmp1* and *rtb_tmp2*.

```c
const char* cfile = fullfile(cgDir,"rtwdemo_VectorOptimization_grt_rtw","rtwdemo_VectorOptimization.c");
rtwdemodbtype(cfile,"/* Model step", /* Model initialize", 1, 0);

/* Model step function */
void rtwdemo_VectorOptimization_step(void)
{
    int32_T i;
    real_T rtb_tmp2;
    real_T rtb_tmp1;
    real_T rtb_Sum3;
    for (i = 0; i < 10; i++) {
        /* Gain: '<Root>/G2' incorporates:
         *  UnitDelay: '<Root>/X2'
         */
        rtb_tmp2 = 0.3 * rtwdemo_VectorOptimization_DW.X2_DSTATE[i];

        /* Gain: '<Root>/G1' incorporates:
         *  UnitDelay: '<Root>/X1'
         */
        rtb_tmp1 = 0.2 * rtwdemo_VectorOptimization_DW.X1_DSTATE[i];

        /* Sum: '<Root>/Sum3' incorporates:
         *  Gain: '<Root>/G3'
         *  Inport: '<Root>/In2'
         *  Sum: '<Root>/Sum1'
         *  Sum: '<Root>/Sum2'
         *  UnitDelay: '<Root>/X3'
         */
        rtb_Sum3 = ((rtwdemo_VectorOptimization_U.In2[i] - 0.4 * rtwdemo_VectorOptimization_DW.X3_DSTATE[i]) - rtb_tmp2) - rtb_tmp1;

        /* Outport: '<Root>/Out2' */
        rtwdemo_VectorOptimization_Y.Out2[i] = rtb_Sum3;

        /* Update for UnitDelay: '<Root>/X3' */
        rtwdemo_VectorOptimization_DW.X3_DSTATE[i] = rtb_tmp2;
    }
}
```

---

**Optimizations for Generated Code in Simulink Coder**
/* Update for UnitDelay: '<Root>/X2' */
rtwdemo_VectorOptimization_DW.X2_DSTATE[i] = rtb_tmp1;

/* Update for UnitDelay: '<Root>/X1' */
rtwdemo_VectorOptimization_DW.X1_DSTATE[i] = rtb_Sum3;
}

Close the model and code generation report.

bdclose(model)
rtwdemoclean;
cd(currentDir)

See Also

Related Examples

• “Optimization Tools and Techniques” on page 33-7
• “Minimize Computations and Storage for Intermediate Results at Block Outputs” on page 33-41
• “Use memcpy Function to Optimize Generated Code for Vector Assignments” on page 33-57
Enable and Reuse Local Block Outputs in Generated Code

This example shows how to specify block output as local variables. The code generator can potentially reuse these local variables in the generated code. Declaring block output as local variables conserves ROM consumption. Reusing local variables conserves RAM consumption, reduces data copies, and increases execution speed.

Example Model

1 Use Inport, Outport, Gain, and Switch blocks to create the following model. In this example, the model is named local_variable_ex.

2 For G2, open the Gain Block Parameters dialog box. Enter a value of 2.

3 For G1, enter a value of 3.

4 For the Switch block, open the Block Parameters dialog box. For the Criteria for passing first input parameter, select u2>=Threshold.
Generate Code Without Optimization

1. Open the Model Configuration Parameters dialog box. Select the Solver pane. For the Type parameter, select Fixed-step.

2. Clear the Configuration Parameters > Signal storage reuse parameter.


4. Select the Code Generation pane. Select Generate code only, and then, in the model window, press Ctrl+B. When code generation is complete, an HTML code generation report appears.

5. In the code generation report, select the local_variable_ex.c section and view the model step function. The Gain block outputs are the global variables local_variable_ex_B.G2 and local_variable_ex_B.G1.

   /* Model step function */
   void local_variable_ex_step(void)
   {
     /* Switch: '<Root>/Switch' incorporates:
       * Inport: '<Root>/In1'
     */
     if (local_variable_ex_U.In1 >= 0.0) {
       /* Gain: '<Root>/G2' */
       local_variable_ex_B.G2 = 2.0 * local_variable_ex_U.In1;

       /* Outport: '<Root>/Out1' */
       local_variable_ex_Y.Out1 = local_variable_ex_B.G2;
     } else {
       /* Gain: '<Root>/G1' */
       local_variable_ex_B.G1 = 3.0 * local_variable_ex_U.In1;

       /* Outport: '<Root>/Out1' */
       local_variable_ex_Y.Out1 = local_variable_ex_B.G1;
     }

     /* End of Switch: '<Root>/Switch' */

Enable Local Block Outputs and Generate Code

1. Select the Configuration Parameters > Signal Storage Reuse parameter. The Signal Storage Reuse enables the following optimization parameters:
• Enable local block outputs
• Reuse local block outputs
• Eliminate superfluous local variables (expression folding)

2 Clear **Reuse local block outputs** and **Eliminate superfluous local variables (expression folding).**

3 Generate code and view the model step function. There are three local variables in the model step function because you selected the optimization parameter **Enable Local Block Outputs.** The local variables *rtb_G2* and *rtb_G1* hold the outputs of the Gain blocks. The local variable *rtb_Switch* holds the output of the Switch block.

```c
/* Model step function */
void local_variable_ex_step(void)
{
    real_T rtb_Switch;
    real_T rtb_G2;
    real_T rtb_G1;

    /* Switch: '<Root>/Switch' incorporates:
     * Inport: '<Root>/In1'
     */
    if (local_variable_ex_U.In1 >= 0.0) {
        /* Gain: '<Root>/G2' */
        rtb_G2 = 2.0 * local_variable_ex_U.In1;
        rtb_Switch = rtb_G2;
    } else {
        /* Gain: '<Root>/G1' */
        rtb_G1 = 3.0 * local_variable_ex_U.In1;
        rtb_Switch = rtb_G1;
    }

    /* End of Switch: '<Root>/Switch' */

    /* Outport: '<Root>/Out1' */
    local_variable_ex_Y.Out1 = rtb_Switch;
}
```

**Reuse Local Block Outputs and Generate Code**

1 Select the **Configuration Parameters > Reuse local block outputs** parameter.

2 Generate code. In the `local_variable_ex.c` section, view the model step function. There is one local variable, *rtb_G2*, that the code generator uses three times.
/* Model step function */
void local_variable_ex_step(void)
{
    real_T rtb_G2;

    /* Switch: '<Root>/Switch' incorporates:
       * Inport: '<Root>/In1'
    */
    if (local_variable_ex_U.In1 >= 0.0) {
        /* Gain: '<Root>/G2' */
        rtb_G2 = 2.0 * local_variable_ex_U.In1;
    } else {
        /* Gain: '<Root>/G1' */
        rtb_G2 = 3.0 * local_variable_ex_U.In1;
    }

    /* End of Switch: '<Root>/Switch' */

    /* Outport: '<Root>/Out1' */
    local_variable_ex_Y.Out1 = rtb_G2;
}

The extra temporary variable rtb_Switch and the associated data copy is not in the generated code.

**See Also**

"Enable local block outputs"

**Related Examples**

- "Optimization Tools and Techniques" on page 33-7
- "Customize Stack Space Allocation" on page 33-113
- "How Generated Code Stores Internal Signal, State, and Parameter Data" on page 15-50
Verification
Simulation and Code Comparison in Simulink Coder
Simulation and Code Comparison

In this section...

“Configure Signal Data for Logging” on page 34-2
“Log Simulation Data” on page 34-3
“Run Executable and Load Data” on page 34-5
“Visualize and Compare Results” on page 34-6
“Compare States for Simulation and Code Generation” on page 34-8

This example shows how to verify the answers computed by code generated from the `slexAircraftExample` model. It shows how to capture and compare two sets of output data. Simulating the model produces one set of output data. Executing the generated code produces a second set of output data.

**Note** To obtain a valid comparison between model output and the generated code, use the same **Solver selection** and **Step size** for the simulation run and the build process.

**Configure Signal Data for Logging**

Configure the model for logging and recording signal data.

1. Make sure that `slexAircraftExample` is closed. Clear the base workspace to eliminate the results of previous simulation runs. In the Command Window, type:

   ```
   clear
   ```

   The clear operation clears variables created during previous simulations and all workspace variables, some of which are standard variables that the `slexAircraftExample` model requires.

2. In the Command Window, enter `slexAircraftExample` to open the model.

3. In the model window, choose **File > Save As**, navigate to the working folder, and save a copy of the `slexAircraftExample` model as `myAircraftExample`.

4. Set up your model to log signal data for signals: `Stick`, `alpha`, `rad`, and `q`, `rad/ sec`. For each signal:

   a. Right-click the signal. From the context menu, select **Properties**.
In the Signal Properties dialog box, select **Log signal data**.

In the **Logging name** section, from the drop-down list, select **Custom**.

In the text field, enter the logging name for the corresponding signal.

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>Logging Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stick</td>
<td>Stick_input</td>
</tr>
<tr>
<td>alpha, rad</td>
<td>Alpha</td>
</tr>
<tr>
<td>q, rad/sec</td>
<td>Pitch_rate</td>
</tr>
</tbody>
</table>

Click **Apply** and **OK**.

For more information, see “Export Signal Data Using Signal Logging” (Simulink).

5. Select **Simulation > Model Configuration Parameters** to open the Configuration Parameters dialog box.

6. Select the **Solver** pane and in the **Solver selection** section, specify the **Type** parameter as **Fixed-step**.

7. On the **Data Import/Export** pane:
   - Specify the **Format** parameter as **Structure with time**.
   - Clear the **States** parameter check box.
   - Select the **Signal logging** parameter.
   - Select the **Record logged workspace data in Simulation Data Inspector** parameter to enable logged signal data to send to the Simulation Data Inspector after the simulation is finished.

8. Save the model.

Proceed to “Log Simulation Data” on page 34-3.

**Log Simulation Data**

Run the simulation, log the signal data, and view the data in the Simulation Data Inspector.

1. Run the model. When the simulation is done, on the Simulink Editor toolbar, the **Simulation Data Inspector** button is highlighted to indicate that new simulation output is available in the Simulation Data Inspector.
2 Click the **Simulation Data Inspector** button to open the Simulation Data Inspector.

3 Group the signals:
   a On the **Visualize** tab, click **Group Signals**.
   b In the Group Signals dialog box, select **Data Hierarchy** from the **Then By** list.
   c Click **OK**.

4 Click the **logout** expander to view the logged signals.

5 Click the **Format** tab.

6 Click the **Subplots** button and select 3x1 to show three subplots.

7 For each signal:
   a Click the top subplot. A blue border indicates the plot selection.
   b Select the check box next to the **Alpha** signal name. The signal data appears in the subplot.
   c Plot the **Pitch_rate** signal in the middle subplot.
   d Plot the **Stick_input** signal in the bottom subplot.
Proceed to “Run Executable and Load Data” on page 34-5.

## Run Executable and Load Data

You must rebuild and run the `myAircraftExample` executable to obtain a valid data file because you have modified the model.

1. Select **Simulation > Model Configuration Parameters** to open the Configuration Parameters dialog box.
2. Select the **Code Generation > Interface** pane.
3. Set the **MAT-file variable name modifier** parameter to `rt_`. `rt_` is prefixed to each variable that you selected for logging in the first part of this example.
4. Click **Apply** and **OK**.
5. Save the model.
6. On the Simulink Editor toolbar, click the **Build Model** button to generate code.
7. When the build is finished, run the standalone program from the Command Window.

`!myAircraftExample`
The executing program writes the following messages to the Command Window.

```
** starting the model **
** created myAircraftExample.mat **
```

8 Load the data file `myAircraftExample.mat`.

```matlab
load myAircraftExample
```

**Tip** For UNIX platforms, run the executable in the Command Window with the syntax `!./executable_name`. If preferred, run the executable from an OS shell with the syntax `./executable_name`. For more information, see “Run External Commands, Scripts, and Programs” (MATLAB).

Proceed to “Visualize and Compare Results” on page 34-6.

**Visualize and Compare Results**

When you follow the example sequence that began in “Configure Signal Data for Logging” on page 34-2, you obtain data from a Simulink run of the model and from a run of the program generated from the model.

1 To view the execution output for `alpha, rad`, import the data into the Simulation Data Inspector.

   a On the Simulation Data Inspector **Visualize** tab, click the **Import** button to open the Import dialog.

   b Specify **Import from** as **Base workspace**.

   c Specify **Import to** as **New run**.

   d To the left of **Signal Name**, click the check mark to clear the check boxes.

   e Select the check box for the `alpha, rad` data where the **Time Series Root** is `rt_yout`.

   f Click **Import**.
The selected data is now under **Run 2: Imported_Data**.

2 View a plot of the executed data.

   a Click the `rt_yout` expander.
   b Click the top subplot and select the check box next to the `alpha, rad` signal name. The signal data appears in the top subplot.

   The `alpha, rad` signal from Run 1 and Run 2 overlap in the subplot because the signals are equivalent.
It is possible to see a very small difference between simulation and code generation results. A slight difference can be caused by many factors, including:

- Different compiler optimizations
- Statement ordering
- Run-time libraries

For example, a function call such as \( \sin(2.0) \) can return a slightly different value depending on which C library you use. Such variations can also cause differences between your results and these results.

**Compare States for Simulation and Code Generation**

The order in which Simulink logs states during simulation is different than the order in which Simulink Coder logs states during code generation. If you want to compare states between simulation and code generation, sort the states by block name.

For example, by default, Simulink exports state data to the MATLAB variable, `xout`. Simulink Coder exports state data to the variable `rt_xout`. To sort the state data for these variables, enter the following commands in the MATLAB Command Window:
[~,idx1]=sort({xout.signals.blockName});
xout_sorted=[xout.signals(idx1).values];
[~,idx2]=sort({rt_xout.signals.blockName});
rt_xout_sorted=[rt_xout.signals(idx2).values];

You can confirm that the logging order is the same between code generation and simulation by entering the following command in the MATLAB Command Window:

isequal(xout_sorted, rt_xout_sorted)

See Also

Related Examples

- “Log Program Execution Results” on page 29-2
Numerical Consistency between Model and Generated Code
Numerical Consistency of Model and Generated Code Simulation Results

In this section...

“Numerical Consistency” on page 35-2
“Numerical Consistency in Complex Systems” on page 35-3
“Reasons for Block-Level Numerical Differences” on page 35-5

Numerical Consistency

In the Model-Based Design workflow (Simulink Code Inspector), you use MathWorks products to generate code for numerical applications that employ fixed-point and floating-point arithmetic.

• To develop models, you use MATLAB, Simulink, and Stateflow.
• To generate source code, you use Simulink Coder and Embedded Coder.
• To test numerical equivalence between your model and generated code, you compare model and generated code simulation results. For example, normal mode simulation results compared with software-in-the-loop (SIL) simulation results.

The results from the model and generated code simulations are numerically consistent if:

• In fixed-point applications, the results agree in a bit-wise comparison.
• In floating-point applications, the results agree with an error tolerance that you specify.

Use the Simulation Data Inspector to compare results. To determine whether discrepancies exist or are significant, you can specify absolute and relative tolerance values:

• For fixed-point applications, you can specify an absolute tolerance of zero.
• For floating-point applications, you can specify tolerance with respect to a reference value or signal. The choice of reference depends on your application. Consider these examples:
  • An algorithm that solves a linear algebraic equation by iterative, feed-forward error calculations. You can specify tolerance with respect to `eps`.
A Proportional-Integral-Derivative (PID) controller for a closed-loop system. For transient behavior, you can specify tolerance with criteria from a standard. For steady-state behavior, you can specify tolerance with reference to the PID controller characteristics.

Programmatically, you can specify absolute and relative tolerance values through the `absTol` and `relTol` properties of the `Simulink.sdi.Signal` object.

**Numerical Consistency in Complex Systems**

For complex systems, numerical differences between model and generated code simulations can be a result of block-level differences propagating through the system. If you observe numerical differences at the system level:

1. Identify blocks for which block-level numerical differences exceed the error tolerance.
2. Investigate each identified block.

Consider the following plant-controller model.
- T produces reference or test signals.
- C is the controller component. The controller output is the plant input. C can be a Model block that comprises multiple Model blocks.
- P is the plant component. The plant output is subtracted from the reference signal to produce the controller input.

To test numerical equivalence between the model controller and the generated code version:

1. Run the model in normal mode, and, using the Simulation Data Inspector, record the output of C.
2. Specify SIL mode for C. Rerun the simulation, recording the output of C.
3. Using the Simulation Data Inspector, compare normal and SIL mode outputs with reference to your specified error tolerance.
If the Simulation Data Inspector comparison indicates a match, the model and generated code results are numerically consistent.

If the normal and SIL mode outputs do not match:

1. Within C, enable signal logging for block outputs.
2. Run the model in normal mode.
3. Rerun the simulation with C in SIL mode.
4. Using the Simulation Data Inspector, compare the logged output signals with reference to your specified error tolerance. See “Compare Simulation Data” (Simulink).
5. Identify blocks for which normal and SIL mode output differences exceed the error tolerance.
6. Analyze each identified block and look for the cause. For example, the generated code might use a different math library than MATLAB.

**Note** If the comparison of a large number of signals is required, you can automate the workflow with Simulink Test. See “Code Generation Verification Workflow with Simulink Test” (Simulink Test).

### Reasons for Block-Level Numerical Differences

In fixed-point and floating-point application development, there are factors that can affect numerical agreement between block-level results from model and generated code simulations.

Some factors can affect both fixed-point and floating-point applications. For example, the use of:

- Code generation optimization.
- Custom code.
- Code replacement library entries whose results differ from MATLAB results.
- Code replacement libraries that implement different algorithms.

Other factors affect only floating-point applications. For example:

- Numerical soundness of algorithm.
• Algorithm sensitivity to input.
• Closed loop and open loop behavior.

References


See Also

eps

Related Examples

• “Inspect and Analyze Simulation Results” (Simulink)
• “Code Generation Verification Workflow with Simulink Test” (Simulink Test)
• “Differences Between Generated Code and MATLAB Code” (Simulink)
• “Code Replacement” (Embedded Coder)
• “Types of In-the-Loop Testing in the V-Model” (Embedded Coder)
• MATLAB Function
• “SIL and PIL Limitations” (Embedded Coder)
Supported Hardware
Embedded Targets
Simulink Coder Supported Hardware

Simulink Coder generates ANSI/ISO C and C++ code that can be compiled and executed on any processor by manually integrating the generated code with the RTOS, I/O devices, and build tools for your processor.

Simulink Coder provides support packages that help to automate integration, execution, and verification of generated code for the processors and devices in this table.

<table>
<thead>
<tr>
<th>Support Package</th>
<th>Vendor</th>
<th>Earliest Release Available</th>
<th>Last Release Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARM Cortex-Based VEX Microcontroller</td>
<td>VEX® Robotics</td>
<td>R2016a</td>
<td>Current</td>
</tr>
<tr>
<td>BeagleBone Blue Hardware</td>
<td>BeagleBone®</td>
<td>R2017b</td>
<td>Current</td>
</tr>
<tr>
<td>NXP FRDM-K64F Board</td>
<td>NXP™</td>
<td>R2016b</td>
<td>Current</td>
</tr>
<tr>
<td>NXP FRDM-KL25Z Board</td>
<td>NXP</td>
<td>R2016b</td>
<td>Current</td>
</tr>
<tr>
<td>STMicroelectronics Nucleo Boards</td>
<td>STMicroelectronics®</td>
<td>R2016b</td>
<td>Current</td>
</tr>
<tr>
<td>VEX EDR V5 Robot Brain</td>
<td>VEX Robotics</td>
<td>R2018b</td>
<td>Current</td>
</tr>
</tbody>
</table>

For a complete list of hardware support packages, see Hardware Support.
Customization
Build Process Integration in Simulink Coder

- “Control Build Process Compiling and Linking” on page 37-2
- “Cross-Compile Code Generated on Microsoft Windows” on page 37-4
- “Control Library Location and Naming During Build” on page 37-7
- “Recompile Precompiled Libraries” on page 37-13
- “Customize Post-Code-Generation Build Processing” on page 37-14
- “Configure Generated Code with TLC” on page 37-21
- “Use makecfg to Customize Generated Makefiles for S-Functions” on page 37-24
- “Use rtwmakecfg.m API to Customize Generated Makefiles” on page 37-26
- “Register Custom Toolchain and Build Executable” on page 37-31
- “Customize Build Process with STF_make_rtw_hook File” on page 37-50
- “Customize Build Process with sl_customization.m” on page 37-55
- “Replace STF_rtw_info_hook Supplied Target Data” on page 37-60
Control Build Process Compiling and Linking

After generating code for a model, the build process determines whether to compile and link an executable program. Various factors guide this determination:

- **Generate code only** option
  
  When you select this option, the code generator produces code for the model, including a makefile.

- **Generate makefile** option
  
  When you clear this option, the code generator does not produce a makefile for the model. You must specify post code generation processing, including compilation and linking, as a user-defined command, as explained in “Customize Post-Code-Generation Build Processing” on page 37-14.

- Makefile-only target
  
  The Microsoft Visual C++ Project Makefile versions of the grt and Embedded Coder target configurations generate a Visual C++ project makefile (model.mak). To build an executable, you must open model.mak in the Visual C++ IDE and compile and link the model code.

- HOST template makefile variable
  
  The template makefile variable HOST identifies the type of system upon which your executable is intended to run. The variable can be set to one of three possible values: PC, UNIX, or ANY.

  By default, HOST is set to UNIX in template makefiles designed for use with The Open Group UNIX platforms (such as grt_unix.tmf), and to PC in the template makefiles designed for use with development systems for the PC (such as grt_vc.tmf).

  If the Simulink software is running on the same type of system as the system specified by the HOST variable, then the executable is built. Otherwise,

  - If HOST = ANY, an executable is still built. This option is useful when you want to cross-compile a program for a system other than the one that the Simulink software is running on.
  
  - Otherwise, processing stops after generating the model code and the makefile; the following message is displayed on the MATLAB command line.

    ### Make will not be invoked - template makefile is for a different host

    ```matlab
    >>> Make will not be invoked - template makefile is for a different host
    ```
• **TGT_FCN_LIB** template makefile variable

The template makefile variable **TGT_FCN_LIB** specifies compiler command-line options. The line in the makefile is `TGT_FCN_LIB = |>TGT_FCN_LIB<|`. Use this token in a makefile conditional statement to specify a standard math library as a compiler option. Possible `|>TGT_FCN_LIB<|` token values are:

<table>
<thead>
<tr>
<th>Value</th>
<th>Generates Calls To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of custom CRL</td>
<td>ISO®/IEC 9899:1990 C (ANSI_C) standard math library</td>
</tr>
<tr>
<td>GNU</td>
<td>GNU extensions to the ISO/IEC 9899:1999 C standard math library</td>
</tr>
</tbody>
</table>
Cross-Compile Code Generated on Microsoft Windows

To generate code with the code generator on a Microsoft Windows system but compile the generated code on a different supported platform, you can do so by modifying your TMF and model configuration parameters. For example, you would need to follow this process if you develop applications with the MATLAB and Simulink products on a Windows system, but you run your generated code on a Linux system.

To set up a cross-compilation development environment, do the following (here a Linux system is the destination platform):

1. On your Windows system, copy the UNIX TMF for your target to a local folder. This folder is your working folder for initiating code generation. For example, you could copy the file `matlabroot/rtw/c/grt/grt_unix.tmf` to `D:/work/my_grt_unix.tmf`.

2. Make the following changes to your copy of the TMF:
   - Add the following line near the `SYS_TARGET_FILE` = line:
     ```
     MAKEFILE_FILESEP = /
     ```
   - Search for the line `ifeq ($(OPT_OPTS),$(DEFAULT_OPT_OPTS))' and, for each occurrence, remove the conditional logic and retain only the 'else' code. That is, remove everything from the 'if' to the 'else', inclusive, and the closing 'endif'. Only the lines from the 'else' portion remain. This logic forces the run-time libraries to build for a Linux system.

3. Open your model and make the following changes in the Code Generation pane of the Configuration Parameters dialog box:
   - Specify the name of your new TMF in the “Template makefile” text box (for example, `my_grt_unix.tmf`).
   - Select Generate code only and click Apply.

4. Generate the code.

5. If the build folder (folder from which the model was built) is not already Linux accessible, copy it to a Linux accessible path. For example, if your build folder for the generated code was `D:\work\mymodel_grt_rtw`, copy that entire folder tree to a path such as `/home/user/mymodel_grt_rtw`.

6. If the MATLAB folder tree on the Windows system is Linux accessible, skip this step. Otherwise, copy the include and source folders to a Linux accessible drive partition, for example, `/home/user/myinstall`. These folders appear in the makefile after

37-4
ADD_INCLUDES = and can be found by searching for $(MATLAB_ROOT). Paths that contain $(MATLAB_ROOT) must be copied. Here is an example list (your list varies depending on your model):

$(MATLAB_ROOT)/rtw/c/grt
$(MATLAB_ROOT)/extern/include
$(MATLAB_ROOT)/simulink/include
$(MATLAB_ROOT)/rtw/c/src
$(MATLAB_ROOT)/rtw/c/tools

Also, paths containing $(MATLAB_ROOT) in the build rules (lines with %.o :) must be copied. For example, based on the build rule

%.o : $(MATLAB_ROOT)/rtw/c/src/ext_mode/tcpip/%.c

copy the following folder:

$(MATLAB_ROOT)/rtw/c/src/ext_mode/tcpip

**Note** The path hierarchy relative to the MATLAB root must be maintained. For example, c:\MATLAB\rtw\c\tools\* would be copied to /home/user/mlroot/rtw/c/tools/.*

For some blocksets, it is easiest to copy a higher-level folder that includes the subfolders listed in the makefile. For example, the DSP System Toolbox product requires the following folders to be copied:

$(MATLAB_ROOT)/toolbox/dspblks
$(MATLAB_ROOT)/toolbox/rtw/dspblks

### 7

Make the following changes to the generated makefile:

- Set both MATLAB_ROOT and ALT_MATLAB_ROOT equal to the Linux accessible path to *matlabroot* (for example, home/user/myinstall).
- Set COMPUTER to the computer value for your platform, such as GLNX86. Enter `help computer` in the MATLAB Command Window for a list of computer values.
- In the ADD_INCLUDES list, change the build folder (designating the location of the generated code on the Windows system) and parent folders to Linux accessible include folders. For example, change D:\work\mymodel_grt_rtw\ to /home/user/mymodel_grt_rtw.

Also, if *matlabroot* is a UNC path, such as \my-server\myapps\matlab, replace the hard-coded MATLAB root with $(MATLAB_ROOT).
From a Linux shell, compile the code you generated on the Windows system. You can compile by running the generated `model.bat` file or by typing the make command line as it appears in the `.bat` file.

**Note** If errors occur during makefile execution, you can run the `dos2unix` utility on the makefile (for example, `dos2unix mymodel.mk`).

### See Also

### Related Examples

- Use packNGo to Relocate Code to Another Development Environment
Control Library Location and Naming During Build

When you generate precompiled, non-precompiled, and model reference libraries, you can control the library location and library name by using configuration parameters. These parameters control values in generated makefiles during model builds:

- For build processes that use the toolchain approach, control the generated library location by using the `TargetPreCompLibLocation` configuration parameter.
- For build processes that use the template makefile approach, control the generated library location by using the `TargetPreCompLibLocation` configuration parameter and control the generated library name by using the `TargetLibSuffix` configuration parameter.

Library Control Parameters

Use the library control parameters to:

- Specify the location of precompiled libraries, such as blockset libraries or the Simulink Coder block library. Typically, a target has cross-compiled versions of these libraries and places them in a target-specific folder.
- Control the suffix applied to library file names (for example, `_target.a` or `_target.lib`).

Targets can set the parameters inside the system target file (STF) select callback. For example:

```matlab
function mytarget_select_callback_handler(varargin)
    hDig=varargin{1};
    hSrc=varargin{2};
    slConfigUISetVal(hDig, hSrc, 'TargetPreCompLibLocation',...'
c:\mytarget\precomplibs');
    slConfigUISetVal(hDig, hSrc, 'TargetLibSuffix',...'
_target.library');
```

The TMF has corresponding expansion tokens:

```
|>EXPAND_LIBRARY_LOCATION<|
|>EXPAND_LIBRARY_SUFFIX<|
```

Alternatively, you can use a call to the `set_param` function. For example:

```matlab
set_param(model,'TargetPreCompLibLocation',...'
c:\mytarget\precomplibs');
```
Note If your model contains referenced models, you can use the make option USE_MDLREF_LIBPATHS to control whether libraries used by the referenced models are copied to the build folder of the parent model. For more information, see “Control the Location of Model Reference Libraries” on page 37-10.

**Identify Library File Type for Toolchain Approach**

The toolchain approach for model builds does not use the value of the TargetLibSuffix configuration parameter to select the library file name suffix and extension.

With the toolchain approach, the final binary name is composed of the modelname, the compilername, and the extension provided by the build tool description in the toolchain definition:

\[
\text{model\_compilername.\text{extension}}
\]

You can identify the static library file name extension from the build tool description in the toolchain definition. To get this information for the default toolchain, use this procedure:

1. Get the default toolchain name. For example, enter:
   ```python
tc_name = coder.make.getDefaultToolchain()
   ```
2. Get the default toolchain handle. For example, enter:
   ```python
tc = coder.make.getToolchainInfoFromRegistry(tc_name)
   ```
3. Get the handle to the toolchain object. For example, enter:
   ```python
tool_archiver = tc.getBuildTool('Archiver');
   ```
4. Get the extension. For example, enter:
   ```python
   ext_archiver = tool_archiver.getFileExtension('Static Library');
   ```

Note If you do not set the TargetLibSuffix parameter, template makefile and toolchain approaches produce the same static library file name extension. See “Customize Library File Suffix and File Type” on page 7-27.

**Specify the Location of Precompiled Libraries**

Use the TargetPreCompLibLocation configuration parameter to:
• Override the precompiled library location specified in the `rtwmakecfg.m` file (see “Use `rtwmakecfg.m` API to Customize Generated Makefiles” on page 37-26 for details)

• Precompile and distribute target-specific versions of product libraries (for example, the DSP System Toolbox product)

For a precompiled library, such as a blockset library or the Simulink Coder block library, the location specified in `rtwmakecfg.m` is typically a location specific to the blockset or the Simulink Coder product. The code generator expects that the library exists in this location and links against the library during builds.

For some applications, such as custom targets, it is preferable to locate the precompiled libraries in a target-specific or other alternate location rather than in the location specified in `rtwmakecfg.m`. For a custom target, the code generator expects that the target-specific cross-compiler creates the library, and you place the library in the target-specific location. Compile and place libraries supported by the target in the target-specific location, so they can be used during the build process.

You can set up the `TargetPreCompLibLocation` parameter in its select callback. The path that you specify for the parameter must be a fully qualified, absolute path to the library location. Relative paths are not supported. For example:

```
slConfigUISetVal(hDlg, hSrc, 'TargetPreCompLibLocation',...  
'c:\mytarget\precomplibs');
```

Alternatively, you set the parameter with a call to the `set_param` function. For example:

```
set_param(model,'TargetPreCompLibLocation',...  
'c:\mytarget\precomplibs');
```

During makefile generation, the build process replaces the tokens with the location from the `rtwmakecfg.m` file. For example, if the library name in the `rtwmakecfg.m` file is `rtwlib`, the template makefile build approach expands the token from:

```
LIBS += |>EXPAND_LIBRARY_LOCATION<|\|>EXPAND_LIBRARY_NAME<\|_target.library
```

to:

```
LIBS += c:\mytarget\precomplibs\rtwlib_target.library
```

By default, `TargetPreCompLibLocation` is an empty character vector. The build process uses the location in `rtwmakecfg.m` for the token replacement.
Control the Location of Model Reference Libraries

On platforms other than the Apple Macintosh platform, when building a model that uses referenced models, the default build process includes:

- Copy libraries that the referenced models use to the build folder of the parent model.
- Assign the file names of the libraries to MODELREF_LINK_LIBS in the generated makefile.

For example, if a model includes a referenced model sub, the build process assigns the library name sub_rtwlib.lib to MODELREF_LINK_LIBS. The build process copies the library file to the build folder of the parent model. This definition is then used in the final link line, which links the library into the final product (usually an executable). This technique minimizes the length of the link line.

On the Macintosh platform, and optionally on other platforms, the build process includes:

- No copying of libraries that the referenced models use to the build folder of the parent model.
- Assign the relative paths and file names of the libraries to MODELREF_LINK_LIBS in the generated makefile.

When using this technique, the build process assigns a relative path such as ../slprj/grt/sub/sub_rtwlib.lib to MODELREF_LINK_LIBS. The build process uses the path to gain access to the library file at link time.

To change to the nondefault behavior on platforms other than the Macintosh platform, select the Configuration Parameters > Code Generation > Make command field. Enter:

```
make_rtw USE_MDLREF_LIBPATHS=1
```

If you specify other Make command arguments, such as OPTS="-g", the order in which you specify the multiple arguments does not matter.

To return to the default behavior, set USE_MDLREF_LIBPATHS to 0, or remove it.

Control the Suffix Applied to Library File Names

With the template makefile approach for model builds, use the TargetLibSuffix configuration parameter to control the suffix applied to library names (for example,
\_target.lib or \_target.a). The specified suffix scheme must include a period (\). You can apply TargetLibSuffix to the following libraries:

- Libraries on which a target depends, as specified in the rtwmakecfg.m API. You can use TargetLibSuffix to change the suffix of both precompiled and non-precompiled libraries configured from the rtwmakecfg API. For details, see “Use rtwmakecfg.m API to Customize Generated Makefiles” on page 37-26.

In this case, a target can set the parameter in its select callback. For example:

\texttt{slConfigUISetVal(hDlg, hSrc, 'TargetLibSuffix',...}
\texttt{'\_target.library');}

Alternatively, you can use a call to the \texttt{set_param} function. For example:

\texttt{set_param(model,'TargetLibSuffix','\_target.library');}

During the TMF-to-makefile conversion, the build process replaces the token | >EXPAND\_LIBRARY\_SUFFIX< | with the specified suffix. For example, if the library name specified in the rtwmakecfg.m file is 'rtwlib', the TMF expands from:

\begin{verbatim}
LIBS += | >EXPAND\_LIBRARY\_LOCATION< \| >EXPAND\_LIBRARY\_NAME< \|
| >EXPAND\_LIBRARY\_SUFFIX< |
\end{verbatim}

to:

\begin{verbatim}
LIBS += c:\mytarget\precomplibs\rtwlib\target.library
\end{verbatim}

By default, TargetLibSuffix is set to an empty character vector. In this case, the build process replaces the token | >EXPAND\_LIBRARY\_SUFFIX< | with an empty character vector.

- Shared utility library and the model libraries created with model reference. For these cases, associated makefile variables do not require the | >EXPAND\_LIBRARY\_SUFFIX< | token. Instead, the build process includes TargetLibSuffix implicitly. For example, for a top model named topmodel with referenced models named refmodel1 and refmodel2, the TMF of the top model is expanded from:

\begin{verbatim}
SHARED\_LIB = | >SHARED\_LIB< |
MODELLIB = | >MODELLIB< |
MODELREF\_LINK\_LIBS = | >MODELREF\_LINK\_LIBS< |
\end{verbatim}

to:

\begin{verbatim}
SHARED\_LIB = \ 
..\slprj\ert\_sharedutils\rtwshared\target.library
MODELLIB = topmodellib\_target.library
\end{verbatim}
MODELREF_LINK_LIBS = \\
refmodel1_rtwlib_target.library refmodel2_rtwlib_target.library

By default, the TargetLibSuffix parameter is an empty character vector. In this case, the build process chooses a default suffix for these three tokens using a file extension of .lib on Windows hosts and .a on UNIX hosts. (For model reference libraries, the default suffix also includes _rtwlib.) For example, on a Windows host, the expanded makefile values are:

```
SHARED_LIB = ..\slprj\ert\sharedutils\rtwshared.lib
MODEL_LIB = topmodellib.lib
MODELREF_LINK_LIBS = refmodel1_rtwlib.lib refmodel2_rtwlib.lib
```
Recompile Precompiled Libraries

You can recompile precompiled libraries included as part of the code generator, such as rtwlib or dsplib, by using a supplied MATLAB function, rtw_precompile_libs. You can consider recompiling precompiled libraries to customize compiler settings for various platforms or environments. For details on using rtw_precompile_libs, see “Precompile S-Function Libraries” on page 26-60.
Customize Post-Code-Generation Build Processing

The code generator provides a set of tools, including a build information object, you can use to customize build processing that occurs after code generation. You can use such customizations for target development or the integration of third-party tools into your application development environment.

Workflow for Setting Up Customizations

The following figure and the steps that follow show the general workflow for setting up post-code-generation customizations.

1. Program the post code generation command on page 37-15.
2. Define the post code generation command on page 37-16.
3  Suppress makefile generation on page 37-20, if applicable.
4  Build the model.
5  Modify the command and rebuild the model until the build results are acceptable.

**Build Information Object**

At the start of a model build, the build process logs the following build option and dependency information to a temporary build information object:

- Compiler options
- Preprocessor identifier definitions
- Linker options
- Source files and paths
- Include files and paths
- Precompiled external libraries

You can retrieve information from and add information to this object by using an extensive set of functions. For a list of available functions and detailed function descriptions, see “Build Process Customization”. “Program a Post Code Generation Command” on page 37-15 explains how to use the functions to control post code generation build processing.

**Program a Post Code Generation Command**

For certain applications, you could want to control aspects of the build process after the code generation. For example, you can use this approach if you develop your own target, or you want to apply an analysis tool to the generated code before continuing with the build process. You can apply this level of control to the build process by programming and then defining a post code generation command.

A post code generation command is a MATLAB language file that typically calls functions that get data from or add data to the build information object of the model. You can program the command as a script or function.
If you program the command as a:

<table>
<thead>
<tr>
<th>Script</th>
<th>Then the:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Script can gain access to the model name and the build information directly</td>
</tr>
<tr>
<td>Function</td>
<td>Function can pass the model name and the build information as arguments</td>
</tr>
</tbody>
</table>

If your post code generation command calls user-defined functions, make sure that the functions are on the MATLAB path. If the build process cannot find a function you use in your command, the build process errors out.

You can then call a combination of build information functions, as listed in “Build Process Customization”, to customize the post code generation build processing of the model.

The following example shows a fragment of a post code generation command that gets the file names and paths of the source and include files generated for a model for analysis.

```matlab
function analyzegencode(buildInfo)
% Get the names and paths of source and include files
% generated for the model and then analyze them.

% BuildInfo - build information for my model.

% Define cell array to hold data.
MyBuildInfo={};

% Get source file information.
MyBuildInfo.srcfiles=getSourceFiles(buildInfo, true, true);
MyBuildInfo.srcpaths=getSourcePaths(buildInfo, true);

% Get include (header) file information.
MyBuildInfo.incfiles=getIncludeFiles(buildInfo, true, true);
MyBuildInfo.incpaths=getIncludePaths(buildInfo, true);

% Analyze generated code.
```

### Define a Post Code Generation Command

After you program a post code generation command, inform the build process that the command exists and to add it to the build processing of the model. Define the command with the PostCodeGenCommand model configuration parameter. When you define a post
code generation command, the build process evaluates the command after generating and writing the generated code to disk and before generating a makefile.

As the following syntax lines show, the arguments that you specify when setting the configuration parameter varies depending on whether you program the command as a script, function, or set of functions.

**Note** When defining the command as a function, you can specify an arbitrary number of input arguments. To pass the name and build information of the model to the function, specify identifiers `modelName` and `buildInfo` as arguments.

**Script**

```matlab
set_param(model, 'PostCodeGenCommand', ...
'pcgScriptName');
```

**Function**

```matlab
set_param(model, 'PostCodeGenCommand', ...
'pcgFunctionName(modelName)');
```

**Multiple Functions**

```matlab
pcgFunctions= ...
'pcgFunction1Name(modelName)';...
pcgFunction2Name(buildInfo);
set_param(model, 'PostCodeGenCommand', ...
'pcgFunctions');
```

The following call to `set_param` defines `PostCodeGenCommand` to evaluate the function `analyzecodegen`.

```matlab
set_param(model, 'PostCodeGenCommand', ...
'analyzecodegen(buildInfo)');
```

**Customize Build Process with PostCodeGenCommand and Relocate Generated Code to an External Environment**

This example shows how to use the Build Information API and the **Post Code Generation Command** parameter, `PostCodeGenCommand`.

The `PostCodeGenCommand` parameter value is `rtwdemo_buildinfo_data`. This value directs the build process to invoke the function after code generation.
The example also demonstrates how to use the `rtwmakecfg.m` API.

For more information, click on the documentation links in the model.

**Open Example Model**

Open the example model `rtwdemo_buildinfo`.

```matlab
open_system('rtwdemo_buildinfo');
```

**Generate Code from Model**

Double-click on the **Generate Code Using Simulink Coder** button to generate code for the GRT target.

Or, if Embedded Coder is installed, double-click on the **Generate Code Using Embedded Coder** button to generate code for the ERT target.
The build process generates a BuildInfo.html file to document the build information object.

**Examine the Build Process Customizations and Output**

Use the links in the model to examine the build process customizations and the post code generation query of the build information object.

To view the BuildInfo.html file in a Web browser, click on **Open BuildInfo.html**.

The example uses the PostCodeGenCommand parameter of the model to generate the html file from the build information object. The file provides hyperlinks to open the source files (generated code) from the model. To view the PostCodeGenCommand parameter value, type:

```
get_param('rtwdemo_buildinfo','PostCodeGenCommand');
```

This value indicates a function to execute in the **Post Code Gen Command** stage.

```
rtwdemo_buildinfo_data(buildInfo);
```

To study how the example uses the rtwmakecfg API, click on **Open rtwmakecfg.m** or type:

```
edit rtwmakecfg.m;
```

To study the API for the buildInfo.mat object, click on **Open rtwdemo_buildinfo_data.m** or type:

```
edit rtwdemo_buildinfo_data.m;
```

The buildInfo.mat object is available at:

```
rtwdemo_<target>_rtw\buildInfo.mat
```

At the end of the rtwdemo_buildinfo_data.m post code generation function, the function invokes `packNGo` to package the source and objects identified in the buildInfo object for relocation.

**Further Study Topics**

- “Build Process Customization”
- “Customize Post-Code-Generation Build Processing” on page 37-14
Suppress Makefile Generation

The code generator lets you suppress makefile generation during the build process. For example, you can use this support when you integrate tools into the build process that do not use makefiles.

To instruct the code generator not to produce a makefile, do one of the following:

- Clear the **Generate makefile** option on the **Code Generation** pane of the Configuration Parameters dialog box.
- Set the value of the configuration parameter **GenerateMakefile** to off.

When you suppress makefile generation,

- You cannot explicitly specify a make command or template makefile.
- Specify your own instructions for a post code generation processing, including compilation and linking, in a post code generation command as explained in “Program a Post Code Generation Command” on page 37-15 and “Define a Post Code Generation Command” on page 37-16.
Configure Generated Code with TLC

You can use the Target Language Compiler (TLC) to fine-tune your generated code. TLC supports extended code generation variables and options in addition to parameters available on the Code Generation pane on the Configuration Parameters dialog box. There are two ways to set TLC variables and options, as described in this section.

**Note** Do not customize TLC files in the folder `matlabroot/rtw/c/tlc` even though the capability exists to do so. It is possible that such TLC customizations are not applied during the code generation process. Such customizations can lead to unpredictable results.

Assigning Target Language Compiler Variables

The `%assign` statement lets you assign a value to a TLC variable, as in:

```%
assign MaxStackSize = 4096
%
```

This assignment is also known as creating a *parameter name/parameter value pair*.

For a description of the `%assign` statement, see “Target Language Compiler Directives”. Write your `%assign` statements in the Configure RTW code generation settings section of the system target file.

The following table lists the code generation variables you can set with the `%assign` statement.
## Target Language Compiler Optional Variables

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MaxStackSize=N</td>
<td>When the <strong>Enable local block outputs</strong> check box is selected, the total allocation size of local variables that are declared by block outputs in the model cannot exceed MaxStackSize (in bytes). MaxStackSize can be a positive integer. If the total size of local block output variables exceeds this maximum, the remaining block output variables are allocated in global, rather than local, memory. The default value for MaxStackSize is rtInf, that is, unlimited stack size.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Local variables in the generated code from sources other than local block outputs, such as from a Stateflow diagram or MATLAB Function block, and stack usage from sources such as function calls and context switching are not included in the MaxStackSize calculation. For overall executable stack usage metrics, do a target-specific measurement by using run-time (empirical) analysis or static (code path) analysis with object code.</td>
</tr>
<tr>
<td>MaxStackVariableSize=N</td>
<td>When the <strong>Enable local block outputs</strong> check box is selected, this selection limits the size of a local block output variable declared in the code to N bytes, where N&gt;0. A variable whose size exceeds MaxStackVariableSize is allocated in global, rather than local, memory. The default is 4096.</td>
</tr>
<tr>
<td>WarnNonSaturatedBlocks=value</td>
<td>Flag to control display of overflow warnings for blocks that have saturation capability, but have it turned off (not selected) in their dialog box. Options include:</td>
</tr>
<tr>
<td></td>
<td>• 0 — Warning is not displayed.</td>
</tr>
<tr>
<td></td>
<td>• 1 — Displays one warning for the model during code generation</td>
</tr>
<tr>
<td></td>
<td>• 2 — Displays one warning that contains a list of offending blocks</td>
</tr>
</tbody>
</table>
Set Target Language Compiler Options

You can specify TLC command-line options for code generation using the model parameter TLC0ptions in a set_param function call. For information about these options, see “Specify TLC for Code Generation” on page 27-24 and “Configure TLC”.

See Also

Related Examples

• “Target Language Compiler Directives”
Use makecfg to Customize Generated Makefiles for S-Functions

With the toolchain and template makefile approach for building code, you can customize generated makefiles for S-functions. Through the customization, you can specify additional items for the S-function build process:

- Source files and folders
- Include files and folders
- Library names
- Preprocessor macro definitions
- Compiler flags
- Link objects

1 To customize the generated makefile:

   - For all S-functions in the build folder on page 27-32, create a makecfg.m file.
   - For a specific S-function in the build folder, create a specificSFunction_makecfg.m file.

2 In the file that you create, use RTW.BuildInfo functions to specify additional items for the S-function build process. For example, you can use:

   - addCompileFlags to specify compiler options.
   - addDefines to specify preprocessor macro definitions.

3 Save the created file in the build folder.

After code generation, in the build folder, the code generator searches for makecfg.m and specificSFunction_makecfg.m files. If the files are present in the build folder, the code generator uses these files to customize the generated makefile, model.mk.

For example, consider a build folder that contains signalConvert.mexa64 (S-function binary file) and signalConvert.tlc (inlined S-function implementation) after the TLC phase of the build process. The S-function requires an additional source code file, filterV1.c, which is located in anotherFolder. You can create a file, signalConvert_makecfg.m, that uses RTW.BuildInfo functions to specify filterV1.c for the build process.

function signalConvert_makecfg(objBuildInfo)
absolute = fullfile('$(START_DIR)', 'anotherFolder');

addIncludePaths(objBuildInfo, absolute);
addSourcePaths(objBuildInfo, absolute);
addSourceFiles(objBuildInfo,'filterV1.c');

See Also

Related Examples

• “Build Process Workflow for Real-Time Systems” on page 27-32
• “Choose Build Approach and Configure Build Process” on page 27-14
• “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7
• “Use rtwmakecfg.m API to Customize Generated Makefiles” on page 37-26
Use rtwmakecfg.m API to Customize Generated Makefiles

Both the toolchain approach and the template makefile approach for builds let you add the following items to generated makefiles:

- Source folders
- Include folders
- Library names
- Module objects

About the rtwmakecfg Function

Using an rtwmakecfg function, you add this information to the makefile during the build operation for S-functions. The rtwmakecfg function is useful when specifying added sources and libraries to build a model that contains one or more of your S-function blocks.

To add information pertaining to an S-function to the makefile:

1. Create the MATLAB language rtwmakecfg function in the rtwmakecfg.m file. The code generator associates this file with your S-function based on its folder location. “Create the rtwmakecfg Function” on page 37-26 describes the requirements for the rtwmakecfg function and the data it returns.

2. If you are using the template makefile approach, modify the TMF of your target such that it supports macro expansion for the information that the rtwmakecfg function returns. “Modify the Template Makefile for rtwmakecfg” on page 37-29 describes the required modifications. If you are using the toolchain approach, the information that the rtwmakecfg function returns is used by the generated makefile; no further configuration is required.

After the TLC phase of the build process, when generating a makefile, the code generator searches for an rtwmakecfg.m file in the folder that contains the S-function MEX file. If it finds the file, the build process calls the rtwmakecfg function.

Create the rtwmakecfg Function

Create the rtwmakecfg.m file containing the rtwmakecfg function in the same folder as your S-function component (a MEX-file with a platform-dependent extension, such
as `.mexext` on Microsoft Windows systems). The function must return a structured array that contains these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>makeInfo.includePath</code></td>
<td>A cell array that specifies additional include folder names, organized as a row vector. The build process expands the folder names into include instructions in the generated makefile.</td>
</tr>
<tr>
<td><code>makeInfo.sourcePath</code></td>
<td>A cell array that specifies additional source folder names, organized as a row vector. Include the folder names of files entered into the <strong>S-function modules</strong> field on the S-Function Block Parameters dialog box or into the <code>SFunctionModules</code> parameter of the block if they are not in the same folder as the S-function. The build process expands the folder names into make rules in the generated makefile.</td>
</tr>
<tr>
<td><code>makeInfo.sources</code></td>
<td>A cell array that specifies additional source file names (C or C++), organized as a row vector. Do not include the name of the S-function or any files entered into the <strong>S-function modules</strong> field on the S-Function Block Parameters dialog box or into the <code>SFunctionModules</code> parameter of the block. The build process expands the file names into make variables that contain the source files. Specify only file names (with extension). Specify path information with the <code>sourcePath</code> field.</td>
</tr>
<tr>
<td><code>makeInfo.linkLibsObjs</code></td>
<td>A cell array that specifies additional, fully qualified paths to object or library files against which the generated code links. The build process does not compile the specified objects and libraries. However, it includes them when linking the final executable. This inclusion can be useful for incorporating libraries that you do not want the build process to recompile or for which the source files are not available. You can also use this element to integrate source files from languages other than C and C++. This integration is possible if you first create a C compatible object file or library outside of the build process.</td>
</tr>
</tbody>
</table>
Field | Description
---|---
makeInfo.precompile | A Boolean flag that indicates whether the libraries specified in the `rtwmakecfg.m` file exist in a specified location (precompile==1) or if you must create the libraries in the build folder during the build process (precompile==0).

makeInfo.library | A structure array that specifies additional run-time libraries and module objects, organized as a row vector. The build process expands the information into make rules in the generated makefile. For a list of the library fields, see the next table.

The `makeInfo.library` field consists of the following elements.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>makeInfo.library(n).Name</code></td>
<td>A character array that specifies the name of the library (without an extension).</td>
</tr>
<tr>
<td><code>makeInfo.library(n).Location</code></td>
<td>A character array that specifies the folder in which the library is located when precompiled. For more information, see the description of <code>makeInfo.precompile</code> in the preceding table. A target can use the <code>TargetPreCompLibLocation</code> parameter to override this value. See “Specify the Location of Precompiled Libraries” on page 37-8.</td>
</tr>
<tr>
<td><code>makeInfo.library(n).Modules</code></td>
<td>A cell array that specifies the C or C++ source file base names (without an extension) that comprise the library. Do not include the file extension. The makefile appends the object extension.</td>
</tr>
</tbody>
</table>

**Note** The `makeInfo.library` field must fully specify each library and how to build it. The modules list in the `makeInfo.library(n).Modules` element cannot be empty. To specify a link-only library, use the `makeInfo.linkLibsObjs` field instead.

**Example:**

```markdown
disp(['Running rtwmakecfg from folder: ',pwd]);
makeInfo.includePath = { fullfile(pwd, 'somedir2') };
makeInfo.sourcePath = {fullfile(pwd, 'somedir2'), fullfile(pwd, 'somedir3')};
makeInfo.sources = {'src1.c', 'src2.cpp'};
```
Note  If a path that you specify in the `rtwmakecfg.m` API contains spaces, the build process does not convert the path to its non-space equivalent. If the build environments you intend to support do not support spaces in paths, refer to “Enable Build Process for Folder Names with Spaces” on page 21-70.

**Modify the Template Makefile for `rtwmakecfg`**

To expand the information that an `rtwmakecfg` function generates, modify the following sections in the TMF of your target:

- Include Path
- C Flags and/or Additional Libraries
- Rules

It is possible that these TMF code examples do not apply to your make utility. For additional examples, see the GRT or ERT TMFs located in `matlabroot/rtw/c/grt` (open) or `matlabroot/rtw/c/ert` (open).

**Add Folder Names to the Makefile Include Path**

The following TMF code example adds folder names to the include path in the generated makefile:

```plaintext
ADD_INCLUDES = \
|>START_EXPAND_INCLUDES|   -I|>EXPAND_DIR_NAME<| \
|>END_EXPAND_INCLUDES|
```

Also, the `ADD_INCLUDES` macro must be added to the `INCLUDES` line.

```plaintext
INCLUDES = -I -I.. $(ADD_INCLUDES) $(USER_INCLUDES)
```

**Add Library Names to the Makefile**

The following TMF code example adds library names to the generated makefile.

```plaintext
LIBS = 
|>START_PRECOMP_LIBRARIES|
```
For more information, see “Control Library Location and Naming During Build” on page 37-7.

Add Rules to the Makefile

The TMF code example adds rules to the generated makefile.

LIBS += |>EXPAND_LIBRARY_NAME<|.a |>END_PRECOMP_LIBRARIES<|
|>START_EXPAND_LIBRARIES<|
LIBS += |>EXPAND_LIBRARY_NAME<|.a |>END_EXPAND_LIBRARIES<|

$(BLD)/%.o: |>EXPAND_DIR_NAME<|/%.c $(SRC)/$(MAKEFILE) rtw_proj.tmw
  @$(BLANK)
  @echo ### |>EXPAND_DIR_NAME<|\$*.c
  $(CC) $(CFLAGS) $(APP_CFLAGS) -o $(BLD)$(DIRCHAR)$*.o \\
  |>EXPAND_DIR_NAME<|$(DIRCHAR)$*.c > $(BLD)$(DIRCHAR)$*.lst
|>END_EXPAND_RULES<|

|>START_EXPAND_LIBRARIES<|MODULES_|>EXPAND_LIBRARY_NAME<| = |
|>START_EXPAND_MODULES<| |>EXPAND_MODULE_NAME<|.o |
|>END_EXPAND_MODULES<|

|>EXPAND_LIBRARY_NAME<|.a : $(MAKEFILE) rtw_proj.tmw
$(MODULES_|>EXPAND_LIBRARY_NAME<|:%.o=$(BLD)/%.o)
  @$(BLANK)
  @echo ### Creating @
  $(AR) -r @ $(MODULES_|>EXPAND_LIBRARY_NAME<|:%.o=$(BLD)/%.o)
|>END_EXPAND_LIBRARIES<|

|>START_PRECOMP_LIBRARIES<|MODULES_|>EXPAND_LIBRARY_NAME<| = |
|>START_EXPAND_MODULES<| |>EXPAND_MODULE_NAME<|.o |
|>END_EXPAND_MODULES<|

|>EXPAND_LIBRARY_NAME<|.a : $(MAKEFILE) rtw_proj.tmw
$(MODULES_|>EXPAND_LIBRARY_NAME<|:%.o=$(BLD)/%.o)
  @$(BLANK)
  @echo ### Creating @
  $(AR) -r @ $(MODULES_|>EXPAND_LIBRARY_NAME<|:%.o=$(BLD)/%.o)
|>END_PRECOMP_LIBRARIES<|
Register Custom Toolchain and Build Executable

This example shows how to register and use a toolchain to build an executable. This example uses the Intel® compiler. However, the concepts and programming interface apply for other toolchains. Once you register a toolchain, you can configure a model such that the code generator uses that toolchain to build an executable for the model.

**Toolchain**

A toolchain is a collection of tools required to compile, link, download, and run code on a specified platform. A toolchain consists of multiple tools, such as a compiler, linker, and archiver. You can configure the tools in a toolchain with multiple options and group tool specifications into types of configurations.

**Create a New Folder and Copy Relevant Files**

The following code creates a folder in your current working folder (pwd). The new folder contains files for this example. If you do not want to affect the current folder, or cannot generate files in this folder, change your working folder before invoking the command.

```matlab
copyfile(fullfile(matlabroot,'toolbox','rtw','rtwdemos','toolchain_demo'),'toolchain_demo','f')
cd toolchain_demo
```

**Open a Model**

Open the `rtwdemo_counter` model. By default, this model is configured to use the Generic Real-Time Target (GRT) configuration and the toolchain approach for building an executable. The capability demonstrated in this example is available for models configured to use the Toolchain approach.

```matlab
model = 'rtwdemo_counter';
open_system(model)
```
Choose a Toolchain

In the model window, click Simulation > Model Configuration Parameters to open the Configuration Parameters dialog box. Select Code Generation. The Toolchain settings section contains parameters for configuring a toolchain. From the Toolchain drop-down list, select the toolchain installed on your development system for building an executable from the code generated from your model.

By default, the Faster Runs build configuration is selected. Click Show settings to see the toolchain flags specified for building the generated code. Choose a build configuration based on your current application development goal.

Close the Configuration Parameters dialog box.

Create a ToolchainInfo Object

This example shows how you can register a custom toolchain and add it as a selectable Toolchain option.
The first step to registering a custom toolchain is to create a ToolchainInfo object that contains information about the toolchain. Methods are available to set toolchain specifications. You can share a ToolchainInfo object across installations.

Open the toolchain definition file for an Intel compiler. This file creates a ToolchainInfo object that contains information about the Intel toolchain on a 64-bit Windows® platform.

```
et edit intel_tc
type intel_tc

function tc = intel_tc
%INTEL_TC Creates an Intel v14 ToolchainInfo object.
% This file can be used as a template to define other toolchains on Windows.

% Copyright 2012-2016 The MathWorks, Inc.

tc = coder.make.ToolchainInfo('BuildArtifact', 'nmake makefile');
tc.Name = 'Intel v14 | nmake makefile (64-bit Windows)';
tc.Platform = 'win64';
tc.SupportedVersion = '14';

% ------------------------------
% Setup
% ------------------------------
% Below we are using %ICPP_COMPILER14% as root folder where Intel Compiler is installed.
% You can either set an environment variable or give full path to the
% compilervars.bat file
	tc.ShellSetup{1} = 'call %ICPP_COMPILER14%\bin\compilervars.bat intel64';

% ------------------------------
% Macros
% ------------------------------

tc.addMacro('MW_EXTERNLIB_DIR',  
            ['$MATLAB_ROOT\extern\lib\' tc.Platform '\microsoft']);
tc.addMacro('MW_LIB_DIR',        
            ['$MATLAB_ROOT\lib\' tc.Platform]);
tc.addMacro('CFLAGS_ADDITIONAL', 
            '-D_CRT_SECURE_NO_WARNINGS');
tc.addMacro('CPPFLAGS_ADDITIONAL', 
            '-EHs -D_CRT_SECURE_NO_WARNINGS');
tc.addMacro('LIBS_TOOLCHAIN',    
            '$(conlibs)');
tc.addMacro('CVARSFLAG',         
            '');
```
tc.addIntrinsicMacros({'ldebug', 'conflags', 'cflags'});

% ------------------------------
% C Compiler
% ------------------------------

tool = tc.getBuildTool('C Compiler');

tool.setName( 'Intel C Compiler');
tool.setCommand( 'icl');
tool.setPath( '');

tool.setDirective( 'IncludeSearchPath', '-I');
tool.setDirective( 'PreprocessorDefine', '-D');
tool.setDirective( 'OutputFlag', '-Fo');
tool.setDirective( 'Debug', '-Zi');

tool.setFileExtension( 'Source', '.c');
tool.setFileExtension( 'Header', '.h');
tool.setFileExtension( 'Object', '.obj');

tool.setCommandPattern('|>TOOL<| |>TOOL_OPTIONS<| |>OUTPUT_FLAG<||>OUTPUT<|');

% ------------------------------
% C++ Compiler
% ------------------------------

tool = tc.getBuildTool('C++ Compiler');

tool.setName( 'Intel C++ Compiler');
tool.setCommand( 'icl');
tool.setPath( '');

tool.setDirective( 'IncludeSearchPath', '-I');
tool.setDirective( 'PreprocessorDefine', '-D');
tool.setDirective( 'OutputFlag', '-Fo');
tool.setDirective( 'Debug', '-Zi');

tool.setFileExtension( 'Source', '.cpp');
tool.setFileExtension( 'Header', '.hpp');
tool.setFileExtension( 'Object', '.obj');

tool.setCommandPattern('|>TOOL<| |>TOOL_OPTIONS<| |>OUTPUT_FLAG<||>OUTPUT<|');
tool = tc.getBuildTool('Linker');

tool.setName('Intel C/C++ Linker');
tool.setCommand('xilink');
tool.setPath('');

tool.setDirective('Library', '-L');
tool.setDirective('LibrarySearchPath', '-I');
tool.setDirective('OutputFlag', '-out:');
tool.setDirective('Debug', '');

tool.setFileExtension('Executable', '.exe');
tool.setFileExtension('Shared Library', '.dll');

tool.setCommandPattern('|>TOOL<| |>TOOL_OPTIONS<| |>OUTPUT_FLAG<||>OUTPUT<|');

% ----------------------------------
% C++ Linker
% ----------------------------------

tool = tc.getBuildTool('C++ Linker');


tool.setCommand('xilink');
tool.setPath('');

tool.setDirective('Library', '-L');
tool.setDirective('LibrarySearchPath', '-I');
tool.setDirective('OutputFlag', '-out:');
tool.setDirective('Debug', '');

tool.setFileExtension('Executable', '.exe');
tool.setFileExtension('Shared Library', '.dll');


}
tool = tc.getBuildTool('Archiver');

    tool.setName(               'Intel C/C++ Archiver');
    tool.setCommand(            'xilib');
    tool.setPath(               '');
    tool.setDirective(          'OutputFlag',         '-out:');
    tool.setFileExtension(      'Static Library',      '.lib');
    tool.setCommandPattern('|>TOOL<| |>TOOL_OPTIONS<| |>OUTPUT_FLAG<||>OUTPUT<|');

% ------------------------------
% Builder
% ------------------------------

    tc.setBuilderApplication(tc.Platform);

% --------------------------------------------
% BUILD CONFIGURATIONS
% --------------------------------------------

optimsOffOpts    = {'/c /Od'};
optimsOnOpts     = {'/c /O2'};
cCompilerOpts    = '$(cflags) $(CVARSFLAG) $(CFLAGS_ADDITIONAL)';
cppCompilerOpts  = '$(cflags) $(CVARSFLAG) $(CPPFLAGS_ADDITIONAL)';
linkerOpts       = {'$(ldebug) $(conflags) $(LIBS_TOOLCHAIN)'};
sharedLinkerOpts = horzcat(linkerOpts, '-dll -def:$DEF_FILE');
archiverOpts     = {'/nologo'};

% Get the debug flag per build tool
debugFlag.CCompiler   = '$(CDEBUG)';
debugFlag.CppCompiler = '$(CPPDEBUG)';
debugFlag.Linker      = '$(LDDEBUG)';
debugFlag.CppLinker   = '$(CPPLDDEBUG)';
debugFlag.Archiver    = '$(ARDEBUG)';

% Set the toolchain flags for 'Faster Builds' build configuration

    cfg = tc.getBuildConfiguration('Faster Builds');
    cfg.setOption( 'C Compiler',                                   horzcat(cCompilerOpts,   optimsOffOpts));
    cfg.setOption( 'C++ Compiler',                                horzcat(cppCompilerOpts, optimsOffOpts));
    cfg.setOption( 'Linker',                                       linkerOpts);
    cfg.setOption( 'C++ Linker',                                   linkerOpts);
    cfg.setOption( 'Shared Library Linker',                      sharedLinkerOpts);
    cfg.setOption( 'Archiver',                                    archiverOpts);
% Set the toolchain flags for 'Faster Runs' build configuration

cfg = tc.getBuildConfiguration('Faster Runs');
cfg.setOption( 'C Compiler',          horzcat(cCompilerOpts,   optimsOnOpts));
cfg.setOption( 'C++ Compiler',        horzcat(cppCompilerOpts, optimsOnOpts));
cfg.setOption( 'Linker',              linkerOpts);
cfg.setOption( 'C++ Linker',          linkerOpts);
cfg.setOption( 'Shared Library Linker', sharedLinkerOpts);
cfg.setOption( 'Archiver',            archiverOpts);

% Set the toolchain flags for 'Debug' build configuration

cfg = tc.getBuildConfiguration('Debug');
cfg.setOption( 'C Compiler',          horzcat(cCompilerOpts,   optimsOffOpts, debugFlag.CCompiler));
cfg.setOption( 'C++ Compiler',        horzcat(cppCompilerOpts, optimsOffOpts, debugFlag.CppCompiler));
cfg.setOption( 'Linker',              horzcat(linkerOpts, debugFlag.Linker));
cfg.setOption( 'C++ Linker',          horzcat(linkerOpts, debugFlag.CppLinker));
cfg.setOption( 'Shared Library Linker', horzcat(sharedLinkerOpts, debugFlag.Linker));
cfg.setOption( 'Archiver',            horzcat(archiverOpts,   debugFlag.Archiver));

tc.setBuildConfigurationOption('all', 'Download',      '');
tc.setBuildConfigurationOption('all', 'Execute',       '');
tc.setBuildConfigurationOption('all', 'Make Tool',     '-f $(MAKEFILE)');

You can display the errors and warnings in the diagnostics messages pane from builds generated by custom compilers. For more information, see “Diagnostic Message Pane” (Simulink).

Run the toolchain definition file to generate the ToolchainInfo object.

tc = intel_tc;

Save the ToolchainInfo object tc to a MAT file.

save intel_tc tc

Register the Custom Toolchain

After you create the ToolchainInfo object for the new toolchain, register it. Register a toolchain in RTW.TargetRegistry. To register the toolchain, write an rtwTargetInfo.m file. Then, add that file to the MATLAB path so the system loads it automatically.

type rtwTargetInfo
function rtwTargetInfo(tr)
%RTWTARGETINFO Registration file for custom toolchains.

% Copyright 2012-2016 The MathWorks, Inc.

tr.registerTargetInfo(@loc_createToolchain);

end

% --------------------------------------------------------------------
% Create the ToolchainInfoRegistry entries
% --------------------------------------------------------------------
function config = loc_createToolchain

config(1) = coder.make.ToolchainInfoRegistry;
config(1).Name = 'Intel v14 | nmake makefile (64-bit Windows)';
config(1).FileName = fullfile(fileparts(mfilename('fullpath')), 'intel_tc.mat');
config(1).TargetHWDeviceType = {'*'};
config(1).Platform = {computer('arch')};

end

Reset the TargetRegistry to use the new rtwTargetInfo.m file.

RTW.TargetRegistry.getInstance('reset');

Choose the Custom Toolchain

Reopen the Configuration Parameters dialog box. Click Toolchain. You should see the new toolchain in the list. Select the Intel v14 toolchain.

Programmatically, you can accomplish the same task with the following commands:

```matlab
cs = getActiveConfigSet(model);
set_param(cs, 'Toolchain', tc.Name)
```

Verify your selection.

toolchain = get_param(cs, 'Toolchain')

toolchain =

'Intel v14 | nmake makefile (64-bit Windows)'}
Build the Model Using the Custom Toolchain

You can now build the model with the new custom toolchain.

Note: If you do not have the Intel toolchain installed, you can use the following command to generate the code and makefile only.

```matlab
set_param(cs, 'GenCodeOnly', 'on')
```

Build the model to generate the code and makefile that uses the new toolchain.

```matlab
rtwbuild(model)
```

### Starting build procedure for model: rtwdemo_counter
### Successful completion of code generation for model: rtwdemo_counter

Obtain the build directory information.

```matlab
dirInfo = RTW.getBuildDir(model);
```

Examine the generated makefile.

```matlab
type(fullfile(dirInfo.BuildDirectory, [model '.mk']))
```

```
###########################################################################
## Makefile generated for Simulink model 'rtwdemo_counter'.
##
## Makefile     : rtwdemo_counter.mk
## Generated on : Fri Jul 20 12:32:35 2018
## MATLAB Coder version: 4.1 (R2018b)
##
## Build Info:
##
## Final product: $(RELATIVE_PATH_TO_ANCHOR)\rtwdemo_counter.exe
## Product type : executable
## Build type   : Top-Level Standalone Executable
##
# Macro Descriptions:
```

---

37-39
# PRODUCT_NAME            Name of the system to build
# MAKEFILE                Name of this makefile
# COMPUTER                Computer type. See the MATLAB "computer" command.
# COMPILER_COMMAND_FILE   Compiler command listing model reference header paths
# CMD_FILE                Command file

PRODUCT_NAME              = rtwdemo_counter
MAKEFILE                  = rtwdemo_counter.mk
COMPUTER                  = PCWIN64
MATLAB_ROOT               = X:\13\BZGXTF~L.SB\matlab
MATLAB_BIN                = X:\13\BZGXTF~L.SB\matlab\bin
MATLAB_ARCH_BIN           = $(MATLAB_BIN)\win64
MASTER_ANCHOR_DIR         =
START_DIR                 = H:\Documents\MATLAB\examples\simulinkcoder-ex70798435\toolchain_demo
ARCH                      = win64
SOLVER                    =
SOLVER_OBJ                =
CLASSIC_INTERFACE         = 0
TGT_FCN_LIB               = None
MODEL_HAS_DYNAMICALLY_LOADED_SFCNS = 0
RELATIVE_PATH_TO_ANCHOR   =..
COMPILER_COMMAND_FILE     = rtwdemo_counter_comp.rsp
CMD_FILE                  = rtwdemo_counter.rsp
C_STANDARD_OPTS           =
CPP_STANDARD_OPTS         =

###########################################################################
## TOOLCHAIN SPECIFICATIONS
###########################################################################

# Toolchain Name:           Intel v14 | nmake makefile (64-bit Windows)
# Supported Version(s):     14
# ToolchainInfo Version:    R2018b
# Specification Revision:   1.0
#
#-------------------------------------------
# Macros assumed to be defined elsewhere
#-------------------------------------------

# ldebug
# conflags
# cflags
#
#--------
# MACROS
#
MW_EXTERNLIB_DIR = $(MATLAB_ROOT)\extern\lib\win64\microsoft
MW_LIB_DIR = $(MATLAB_ROOT)\lib\win64
CFLAGS_ADDITIONAL = $ (MATLAB_ROOT) \lib \w in 64
CPPFLAGS_ADDITIONAL = -D_CRT_SECURE_NO_WARNINGS
LIBS_TOOLCHAIN = $(conlibs)

TOOLCHAIN_SRCS =
TOOLCHAIN_INCS =
TOOLCHAIN_LIBS =

#------------------------
# BUILD TOOL COMMANDS
#------------------------

# C Compiler: Intel C Compiler
CC = icl

# Linker: Intel C/C++ Linker
LD = xilink

# C++ Compiler: Intel C++ Compiler
CPP = icl

# C++ Linker: Intel C/C++ Linker
CPP_LD = xilink

# Archiver: Intel C/C++ Archiver
AR = xilib

# MEX Tool: MEX Tool
MEX_PATH = $(MATLAB_ARCH_BIN)
MEX = "$(MEX_PATH)\mex"

# Download: Download
DOWNLOAD =

# Execute: Execute
EXECUTE = $(PRODUCT)

# Builder: NMAKE Utility
MAKE = nmake
# Directives/Utilities

CDEBUG              = -Zi
C_OUTPUT_FLAG       = -Fo
LDDEBUG             =
OUTPUT_FLAG         = -out:
CPPDEBUG            = -Zi
CPP_OUTPUT_FLAG     = -Fo
CPPLDDEBUG          =
OUTPUT_FLAG         = -out:
ARDEBUG             =
STATICLIB_OUTPUT_FLAG = -out:
MEX_DEBUG           = -g
RM                  = @del
ECHO                = @echo
MV                  = @ren
RUN                 = @cmd /C

# "Faster Builds" Build Configuration

ARFLAGS              = /nologo
CFLAGS               = $(cflags) $(CVARSFLAG) $(CFLAGS_ADDITIONAL) \ 
                       /c /Od
CPPFLAGS             = $(cflags) $(CVARSFLAG) $(CPPFLAGS_ADDITIONAL) \ 
                       /c /Od
CPP_LDFLAGS          = $(ldebug) $(conflags) $(LIBS_TOOLCHAIN)
CPP_SHAREDLIB_LDFLAGS =
DOWNLOAD_FLAGS       =
EXECUTE_FLAGS        =
LDFLAGS              = $(ldebug) $(conflags) $(LIBS_TOOLCHAIN)
MEX_CPPFLAGS         =
MEX_CPPLDFLAGS       =
MEX_CFLAGS           =
MEX_LDFLAGS          =
MAKE_FLAGS           = -f $(MAKEFILE)
SHAREDLIB_LDFLAGS    = $(ldebug) $(conflags) $(LIBS_TOOLCHAIN) \ 
                       -dll -def:$(_DEF_FILE)
# File extensions

H_EXT = .h
OBJ_EXT = .obj
C_EXT = .c
EXE_EXT = .exe
SHAREDLIB_EXT = .dll
HPP_EXT = .hpp
OBJ_EXT = .obj
CPP_EXT = .cpp
EXE_EXT = .exe
SHAREDLIB_EXT = .dll
STATICLIB_EXT = .lib
MEX_EXT = .mexw64
MAKE_EXT = .mk

# Output Info

PRODUCT = $(RELATIVE_PATH_TO_ANCHOR)\rtwdemo_counter.exe
PRODUCT_TYPE = "executable"
BUILD_TYPE = "Top-Level Standalone Executable"

# Include Paths

INCLUDES_BUILDINFO = ...
INCLUDES = $(INCLUDES_BUILDINFO)

# Defines

DEFINES_BUILD_ARGS = -DCLASSIC_INTERFACE=0 -DALLOCATIONFCN=0 -DTERMFCN=0 -DONESTEPFCN=1 -DMAT_FILE=0 -DMULTI_INSTANCE_CODE=0 -DINTEGER_CODE=0 -DMT=0
DEFINES_IMPLIED = -DTID01EQ=0
DEFINES_STANDARD = -DMODEL=rtwdemo_counter -DNUMST=1 -DNCSTATES=0 -DHAVESTDIO -DMODEL_HAS_DYNAMICALLY_LOADED_SFCNS=0
DEFINES = $(DEFINES_BUILD_ARGS) $(DEFINES_IMPLIED) $(DEFINES_STANDARD)
SRCS = $(START_DIR)\rtwdemo_counter_ert_rtw\rtwdemo_counter.c
MAIN_SRC = $(START_DIR)\rtwdemo_counter_ert_rtw\ert_main.c
ALL_SRCS = $(SRCS) $(MAIN_SRC)

OBJS = rtwdemo_counter.obj
MAIN_OBJ = ert_main.obj
ALL_OBJS = $(OBJS) $(MAIN_OBJ)

PREBUILT_OBJS =

LIBS =

SYSTEM_LIBS =

# ADDITIONAL TOOLCHAIN FLAGS
#-----------------------------
# C Compiler

CFLAGS_BASIC = $(DEFINES) @$(COMPILER_COMMAND_FILE)

CFLAGS = $(CFLAGS) $(CFLAGS_BASIC)

# C++ Compiler

CPPFLAGS_BASIC = $(DEFINES) @$(COMPILER_COMMAND_FILE)

CPPFLAGS = $(CPPFLAGS) $(CPPFLAGS_BASIC)

###########################################################################
## INLINED COMMANDS
###########################################################################

###########################################################################
## PHONY TARGETS
###########################################################################

.PHONY : all build buildobj clean info prebuild download execute set_environment_variables

all : build
    @cmd /C "@echo ### Successfully generated all binary outputs."

build : set_environment_variables prebuild $(PRODUCT)

buildobj : set_environment_variables prebuild $(OBJS) $(PREBUILT_OBJS)
    @cmd /C "@echo ### Successfully generated all binary outputs."

prebuild :

download : build

eexecute : download
@cmd /C "@echo ### Invoking postbuild tool "Execute" ..."
$(EXECUTE) $(EXECUTE_FLAGS)
@cmd /C "@echo ### Done invoking postbuild tool."

set_environment_variables :
  @set INCLUDE=$(INCLUDES);$(INCLUDE)
  @set LIB=$(LIB)

### FINAL TARGET

# Create a standalone executable

$(PRODUCT) : $(OBJS) $(PREBUILT_OBJS) $(MAIN_OBJ)
  @cmd /C "@echo ### Creating standalone executable "$(PRODUCT)" ..."
  $(LD) $(LDFLAGS) -out:$(PRODUCT) @$(CMD_FILE) $(SYSTEM_LIBS) $(TOOLCHAIN_LIBS)
  @cmd /C "@echo ### Created: $(PRODUCT)"

### INTERMEDIATE TARGETS

# SOURCE-TO-OBJECT

.c.obj :
  $(CC) $(CFLAGS) -Fo"$@" "$<"

cpp.obj :
  $(CPP) $(CPPFLAGS) -Fo"$@" "$<"

{$(RELATIVE_PATH TO_ANCHOR)}.c.obj :
  $(CC) $(CFLAGS) -Fo"$@" "$<"
Register Custom Toolchain and Build Executable

### DEPENDENCIES

```
$(ALL_OBJS) : rtw_proj.tmw $(MAKEFILE)
```
Once the build process is finished, and you had Intel compilers installed, you can run the generated executable.

if ispc
    system([model ' .exe'])
else

37-48
system(model)
end

**Restore**

You can optionally remove the folder you created earlier.

```
cd ..
```

```
rmdir('toolchain_demo', 's')
```

Reset the TargetRegistry to remove the toolchain that you registered above.

```
RTW.TargetRegistry.getInstance('reset');
```

Close the model.

```
close_system(model, 0)
```

Clear the variables introduced in the workspace.

```
clear INC K LIMIT RESET model tc cs toolchain
```
Customize Build Process with STF_make_rtw_hook File

The build process lets you supply optional custom code in hook methods that are executed at specified points in the code generation and make process. You can use hook methods to add target-specific actions to the build process.

**STF_make_rtw_hook File**

You can modify hook methods in a file generically referred to as *STF_make_rtw_hook.m*, where *STF* is the name of a system target file, such as ert or mytarget. This file implements a function, *STF_make_rtw_hook*, that dispatches to a specific action, depending on the `hookMethod` argument passed in.

The build process calls *STF_make_rtw_hook*, passing in the `hookMethod` argument and other arguments. You implement only those hook methods that your build process requires.

If your model contains reference models, you can implement an *STF_make_rtw_hook.m* for each reference model as required. The build process calls each *STF_make_rtw_hook* for reference models, processing these files recursively (in dependency order).

**Conventions for Using the STF_make_rtw_hook File**

For the build process to call the *STF_make_rtw_hook*, check that the following conditions are met:

- The *STF_make_rtw_hook.m* file is on the MATLAB path.
- The file name is the name of your system target file (STF), appended to the text _make_rtw_hook.m_. For example, if you generate code with a custom system target file mytarget.tlc, name your hook file mytarget_make_rtw_hook.m, and name the hook function implemented within the file mytarget_make_rtw_hook.
- The hook function implemented in the file uses the function prototype described in “STF_make_rtw_hook.m Function Prototype and Arguments” on page 37-50.

**STF_make_rtw_hook.m Function Prototype and Arguments**

The function prototype for *STF_make_rtw_hook* is:

```
function STF_make_rtw_hook(hookMethod, modelName, rtwRoot, templateMakefile, buildOpts, buildArgs, buildInfo)
```

37-50
The arguments are defined as:

- **hookMethod**: Character vector specifying the stage of build process from which the `STF_make_rtw_hook` function is called. The following flowchart summarizes the build process, highlighting the hook points. Valid values for `hookMethod` are 'entry', 'before_tlc', 'after_tlc', 'before_make', 'after_make', 'exit', and 'error'. The `STF_make_rtw_hook` function dispatches to the relevant code with a `switch` statement.
• **modelName**: Character vector specifying the name of the model. Valid at all stages of the build process.

• **rtwRoot**: Reserved.

• **templateMakefile**: Name of template makefile.

• **buildOpts**: A MATLAB structure containing the fields described in the following list. Valid for the 'before_make', 'after_make', and 'exit' stages only. The buildOpts fields include:
  
  • **modules**: Character vector specifying a list of additional files to compile.
  
  • **codeFormat**: Character vector specifying the value of the CodeFormat TLC variable for the target. (ERT-based targets must use the 'Embedded-C' value for the CodeFormat TLC variable and use the corresponding 'ert.tlc' value in the rtwgensettings.DerivedFrom field.)

  • **noninlinedSFcns**: Cell array specifying a list of noninlined S-functions in the model.

  • **compilerEnvVal**: Character vector specifying the compiler environment variable value (for example, C:\Applications\Microsoft Visual).

  • **buildArgs**: Character vector containing the argument to make_rtw. When you invoke the build process, buildArgs is copied from the argument following "make_rtw" in the Configuration Parameters + Code Generation + Make command field.

  For example, the following make arguments from the Make command field

  ```
  make_rtw VAR1=0 VAR2=4
  ```

  generate the following:

  ```
  % make -f untitled.mk VAR1=0 VAR2=4
  ```

  The buildArgs argument does not apply for toolchain approach builds because these builds do not allow adding make arguments to the make_rtw call. On the compiler command line, to provide custom definitions (for example, VAR1=0 VAR2=4) that apply for both TMF approach and toolchain approach builds, use the Configuration Parameters > Code Generation > Custom Code > Defines field.

• **buildInfo**: The MATLAB structure that contains the model build information fields. Valid for the 'after_tlc', 'before_make', 'after_make', and 'exit' stages only. For information about these fields and functions to access them, see “Build Process Customization”.

37-52
Applications for STF_make_rtw_hook.m

Here are some examples of how to apply the STF_make_rtw_hook.m hook methods.

In general, you can use the 'entry' hook to initialize the build process, for example, to change or validate settings before code is generated. One application for the 'entry' hook is to rerun the auto-configuration script that initially ran at target selection time to compare model parameters before and after the script executes, for validation purposes.

The other hook points, 'before_tlc', 'after_tlc', 'before_make', 'after_make', 'exit', and 'error' are useful for interfacing with external tool chains, source control tools, and other environment tools.

For example, you could use the STF_make_rtw_hook.m file at a stage after 'entry' to obtain the path to the build folder. At the 'exit' stage, you could then locate generated code files within the build folder and check them into your version control system. You can use 'error' to clean up static or global data used by the hook function when an error occurs during code generation or the build process.

Note The build process temporarily changes the MATLAB working folder to the build folder for stages 'before_make', 'after_make', 'exit', and 'error'. Your STF_make_rtw_hook.m file must not make incorrect assumptions about the location of the build folder. At a point after the 'entry' stage, you can obtain the path to the build folder. In the following MATLAB code example, the build folder path is returned as a character vector to the variable buildDirPath.

buildDirPath = rtwprivate('get_makertwsettings',gcs,'BuildDirectory');

Note Any change to model configuration within STF_make_rtw_hook.m file (including switching Variants) might lead to unexpected results in code generation.

Control Code Regeneration Using STF_make_rtw_hook.m

When you rebuild a model, by default, the build process performs checks to determine whether changes to the model or relevant settings require regeneration of the top model code. (For details on the criteria, see “Control Regeneration of Top Model Code” on page 27-46.) If the checks determine that top model code generation is required, the build process fully regenerates and compiles the model code. If the checks indicate that the top
model generated code is current with respect to the model, and model settings do not require full regeneration, the build process omits regeneration of the top model code.

Regardless of whether the top model code is regenerated, the build process subsequently calls the build process hooks, including `STF_make_rtw_hook` functions and the post code generation command. The following mechanisms allow you to perform actions related to code regeneration in the `STF_make_rtw_hook` functions:

- To force code regeneration, use the following function call from the 'entry' hook:
  ```
  rtw.targetNeedsCodeGen('set', true);
  ```
- In hooks from 'before_tlc' through 'exit', the `buildOpts` structure passed to the hook has a Boolean field `codeWasUpToDate`. The field is set to `true` if model code was up to date and code was not regenerated, or `false` if code was not up to date and code was regenerated. You can customize hook actions based on the value of this field. For example:

  ```
  case 'before_tlc'
    if buildOpts.codeWasUpToDate
      %Perform hook actions for up to date model
    else
      %Perform hook actions for full code generation
    end
  ```

**Use STF_make_rtw_hook.m for Your Build Procedure**

To create a custom `STF_make_rtw_hook` hook file for your build procedure, copy and edit the example `ert_make_rtw_hook.m` file, which is located in the folder `matlabroot/toolbox/coder/embeddedcoder` (open), as follows:

1. Copy `ert_make_rtw_hook.m` to a folder in the MATLAB path. Rename it in accordance with the naming conventions described in “Conventions for Using the STF_make_rtw_hook File” on page 37-50. For example, to use it with the GRT target `grt.tlc`, rename it to `grt_make_rtw_hook.m`.
2. Rename the `ert_make_rtw_hook` function within the file to match the file name.
3. Implement the hooks that you require by adding code to case statements within the `switch hookMethod` statement.
Customize Build Process with sl_customization.m

The Simulink customization file `sl_customization.m` is a mechanism that allows you to use MATLAB to customize the build process interface. The Simulink software reads the `sl_customization.m` file, if present on the MATLAB path, when it starts and the customizations specified in the file are applied to the Simulink session. For more information on the `sl_customization.m` customization file, see “Registering Customizations” (Simulink).

**The sl_customization.m File**

The `sl_customization.m` file can be used to register installation-specific hook functions to be invoked during the build process. The hook functions that you register through `sl_customization.m` complement System Target File (STF) hooks (described in “Customize Build Process with STF_make_rtw_hook File” on page 37-50) and post-code generation commands (described in “Customize Post-Code-Generation Build Processing” on page 37-14).

The following figure shows the relationship between installation-level hooks and the other available mechanisms for customizing the build process.
Start build process

Simulink Coder verification

Entry
STF 'entry' hook
Installation 'entry' hook

Before TLC
STF 'before_tlc' hook
Installation 'before_tlc' hook

After TLC
STF 'after_tlc' hook
Installation 'after_tlc' hook

Before Make
STF 'before_make' hook
Installation 'before_make' hook

After Make
STF 'after_make' hook
Installation 'after_make' hook

Exit
STF 'exit' hook
Installation 'exit' hook

End build process

Post code generation command
Register Build Process Hook Functions Using sl_customization.m

To register installation-level hook functions that are invoked during the build process, you create a MATLAB function called sl_customization.m and include it on the MATLAB path of the Simulink installation that you want to customize. The sl_customization function accepts one argument: a handle to a customization manager object. For example,

```matlab
function sl_customization(cm)
```

As a starting point for your customizations, the sl_customization function must first get the default (factory) customizations, using the following assignment statement:

```matlab
hObj = cm.RTWBuildCustomizer;
```

You then invoke methods to register your customizations. The customization manager object includes the following method for registering build process hook customizations:

- `addUserHook(hObj, hookType, hook)`

  Registers the MATLAB hook script or function specified by `hook` for the build process stage represented by `hookType`. The valid values for `hookType` are 'entry', 'before_tlc', 'after_tlc', 'before_make', 'after_make', and 'exit'.

Use this method to register installation-specific hook functions in your instance of the sl_customization function.

The Simulink software reads the sl_customization.m file when it starts. If you subsequently change the file, you must restart the Simulink session or enter the following command in the Command Window to enable the changes:

```matlab
sl_refresh_customizations
```

Variables Available for sl_customization.m Hook Functions

The following variables are available for sl_customization.m hook functions to use:

- `modelName` — The name of the Simulink model (valid for all stages)
- `dependencyObject` — An object containing the dependencies of the generated code (valid only for the 'after_make' stage)

A hook script can directly access the valid variables. A hook function can pass the valid variables as arguments to the function. For example:
Example of Build Process Customization with sl_customization.m

The sl_customization.m file shown in the example, sl_customization.m for Build Process Customizations, uses the addUserHook method to specify installation-specific build process hooks to be invoked at the 'entry' and 'after_tlc' stages of the build process. For the hook function source code, see the CustomRTWEntryHook.m and CustomRTWPostProcessHook.m examples.

**Example 37.1. sl_customization.m for Build Process Customizations**

```matlab
function sl_customization(cm)
    % Register user customizations

    % Get default (factory) customizations
    hObj = cm.RTWBuildCustomizer;

    % Register build process hooks
    hObj.addUserHook('entry', 'CustomRTWEntryHook(modelName);');
    hObj.addUserHook('after_tlc', 'CustomRTWPostProcessHook(modelName);');

end
```

**Example 37.2. CustomRTWEntryHook.m**

```matlab
function [str, status] = CustomRTWEntryHook(modelName)
    str = sprintf('Custom entry hook for model ''%s.'',modelName);
    disp(str)
    status = 1;
end
```

**Example 37.3. CustomRTWPostProcessHook.m**

```matlab
function [str, status] = CustomRTWPostProcessHook(modelName)
    str = sprintf('Custom post process hook for model ''%s.'',modelName);
    disp(str)
    status = 1;
end
```

If you include the above three files on the MATLAB path of the Simulink installation that you want to customize, the coded hook function messages appear in the displayed output for builds. For example, if you open the ERT-based model rtwdemo_udt, open the Code Generation pane of the Configuration Parameters dialog box, and press Ctrl+B to initiate a build, the following messages are displayed:

```plaintext
>> rtwdemo_udt

### Starting build procedure for model: rtwdemo_udt
```
Custom entry hook for model 'rtwdemo_udt.'
Custom post process hook for model 'rtwdemo_udt.'
### Successful completion of build procedure for model: rtwdemo_udt
>>
Replace STF_rtw_info_hook Supplied Target Data

Prior to MATLAB Release 14, custom targets supplied target-specific information with a hook file (referred to as STF_rtw_info_hook.m). The STF_rtw_info_hook specified properties such as word sizes for integer data types (for example, char, short, int, and long), and C implementation-specific properties of the custom target.

The STF_rtw_info_hook mechanism has been replaced by the Hardware Implementation pane of the Configuration Parameters dialog box. Using this dialog box, you can specify properties that were formerly specified in your STF_rtw_info_hook file.

For backward compatibility, existing STF_rtw_info_hook files are available. However, you should convert your target and models to use of the Hardware Implementation pane. See “Configure Production and Test Hardware” on page 10-3.
Run-Time Data Interface Extensions in Simulink Coder
Customize Generated ASAP2 File

<table>
<thead>
<tr>
<th>In this section…</th>
</tr>
</thead>
<tbody>
<tr>
<td>“About ASAP2 File Customization” on page 38-2</td>
</tr>
<tr>
<td>“ASAP2 File Structure on the MATLAB Path” on page 38-2</td>
</tr>
<tr>
<td>“Customize the Contents of the ASAP2 File” on page 38-3</td>
</tr>
<tr>
<td>“ASAP2 Templates” on page 38-4</td>
</tr>
<tr>
<td>“Customize Computation Method Names” on page 38-6</td>
</tr>
<tr>
<td>“Suppress Computation Methods for FIX_AXIS” on page 38-7</td>
</tr>
</tbody>
</table>

**About ASAP2 File Customization**

The Embedded Coder product provides a number of Target Language Compiler (TLC) files to enable you to customize the ASAP2 file generated from a Simulink model.

**ASAP2 File Structure on the MATLAB Path**

The ASAP2 related files are organized within the folders identified below:

- TLC files for generating ASAP2 file

  The `matlabroot/rtw/c/tlc/mw` (open) folder contains TLC files that generate ASAP2 files, `asamlib.tlc`, `asap2lib.tlc`, `asap2main.tlc`, and `asap2grouplib.tlc`. These files are included by the selected System target file. (See “Targets Supporting ASAP2” on page 31-3.)

- ASAP2 target files

  The `matlabroot/toolbox/rtw/targets/asap2/asap2` (open) folder contains the ASAP2 system target file and other control files.

- Customizable TLC files

  The `matlabroot/toolbox/rtw/targets/asap2/asap2/user` (open) folder contains files that you can modify to customize the content of your ASAP2 files.

- ASAP2 templates

  The `matlabroot/toolbox/rtw/targets/asap2/asap2/user/templates` (open) folder contains templates that define each type of CHARACTERISTIC in the ASAP2 file.
Customize the Contents of the ASAP2 File

The ASAP2 related TLC files enable you to customize the appearance of the ASAP2 file generated from a Simulink model. Most customization is done by modifying or adding to the files contained in the `matlabroot/toolbox/rtw/targets/asap2/asap2/user` (open) folder. This section refers to this folder as the `asap2/user` folder.

The user-customizable files provided are divided into two groups:

- The *static* files define the parts of the ASAP2 file that are related to the environment in which the generated code is used. They describe information specific to the user or project. The static files are not model dependent.
- The *dynamic* files define the parts of the ASAP2 file that are generated based on the structure of the source model.

The procedure for customizing the ASAP2 file is as follows:

1. Make a copy of the `asap2/user` folder before making modifications.
2. Remove the old `asap2/user` folder from the MATLAB path, or add the new `asap2/user` folder to the MATLAB path above the old folder. The MATLAB session uses the ASAP2 setup file, `asap2setup.tlc`, in the new folder.

   `asap2setup.tlc` specifies the folders and files to include in the TLC path during the ASAP2 file generation process. Modify `asap2setup.tlc` to control the folders and folders included in the TLC path.

3. Modify the static parts of the ASAP2 file. These include
   - Project and header symbols, which are specified in `asap2setup.tlc`
   - Static sections of the file, such as file header and tail, `A2ML`, `MOD_COMMON`, and so on. These are specified in `asap2userlib.tlc`.
   - Specify the appearance of the dynamic contents of the ASAP2 file by modifying the existing ASAP2 templates or by defining new ASAP2 templates. Sections of the ASAP2 file affected include

     `RECORD_LAYOUT`: modify parts of the ASAP2 template files.

     `CHARACTERISTIC`: modify parts of the ASAP2 template files. For more information on modifying the appearance of `CHARACTERISTIC` records, see “ASAP2 Templates” on page 38-4.
• MEASUREMENT: These are specified in asap2userlib.tlc.
• COMPU_METHOD: These are specified in asap2userlib.tlc.

ASAP2 Templates

The appearance of CHARACTERISTIC records in the ASAP2 file is controlled using a different template for each type of CHARACTERISTIC. The asap2/user folder contains template definition files for scalars, 1-D Lookup Table blocks and 2-D Lookup Table blocks. You can modify these template definition files, or you can create additional templates as required.

The procedure for creating a new ASAP2 template is as follows:

1. Create a template definition file. See “Create Template Definition Files” on page 38-4.
2. Include the template definition file in the TLC path. The path is specified in the ASAP2 setup file, asap2setup.tlc.

Create Template Definition Files

This section describes the components that make up an ASAP2 template definition file. This description is in the form of code examples from asap2lookup1d.tlc, the template definition file for the Lookup1D template. This template corresponds to the Lookup1D parameter group.

Note When creating a new template, use the corresponding parameter group name in place of Lookup1D in the code shown.

Template Registration Function

The input argument is the name of the parameter group associated with this template:

%<LibASAP2RegisterTemplate("Lookup1D")>

RECORD_LAYOUT Name Definition Function

Record layout names (aliases) can be arbitrarily specified for each data type. This function is used by the other components of this file.

%function ASAP2UserFcnRecordLayoutAlias_Lookup1D(dtId) void
%switch dtId

38-4
Function to Write RECORD_LAYOUT Definitions

This function writes RECORD_LAYOUT definitions associated with this template. The function is called by the built-in functions involved in the ASAP2 file generation process. The function name must be defined as shown, with the template name after the underscore:

%function ASAP2UserFcnWriteRecordLayout_Lookup1D() Output
   /begin RECORD_LAYOUT
   %<ASAP2UserFcnRecordLayoutAlias_Lookup1D(tSS_UINT8)>
   ...
   /end   RECORD_LAYOUT
%endfunction

Function to Write the CHARACTERISTIC

This function writes the CHARACTERISTIC associated with this template. The function is called by the built-in functions involved in the ASAP2 file generation process. The function name must be defined as shown, with the template name after the underscore.

The input argument to this function is a pointer to a parameter group record. The example shown is for a Lookup1D parameter group that has two members. The references to the associated x and y data records are obtained from the parameter group record as shown.

This function calls a number of built-in functions to obtain the required information. For example, LibASAP2GetSymbol returns the symbol (name) for the specified data record:

%function ASAP2UserFcnWriteCharacteristic_Lookup1D(paramGroup) Output
   %assign xParam = paramGroup.Member[0].Reference
   %assign yParam = paramGroup.Member[1].Reference
   %assign dtId = LibASAP2GetDataTypeId(xParam)
   /begin CHARACTERISTIC
   /* Name */              %<LibASAP2GetSymbol(xParam)>
   /* Long identifier */   "%<LibASAP2GetLongID(xParam)>
   ...
...
Customize Computation Method Names

In generated ASAP2 files, computation methods translate the electronic control unit (ECU) internal representation of measurement and calibration quantities into a physical model oriented representation. Simulink Coder software provides the ability to customize the names of computation methods. You can provide names that are more intuitive, enhancing ASAP2 file readability, or names that meet organizational requirements.

To customize computation method names, use the MATLAB function `getCompuMethodName`, which is defined in `matlabroot/toolbox/rtw/targets/asap2/asap2/user/getCompuMethodName.m`.

The `getCompuMethodName` function constructs a computation method name. The function prototype is

```matlab
cmName = getCompuMethodName(dataTypeName, cmUnits)
```

where `dataTypeName` is the name of the data type associated with the computation method, `cmUnits` is the units as specified in the Unit property of a `Simulink.Parameter` or `Simulink.Signal` object (for example, rpm or m/s), and `cmName` returns the constructed computation method name.

The default constructed name returned by the function has the format

```matlab
<localPrefix><datatype>_<cmUnits>
```

where

- `<localPrefix>` is a local prefix, CM_, defined in `matlabroot/toolbox/rtw/targets/asap2/asap2/user/getCompuMethodName.m`.
- `<datatype>` and `<cmUnits>` are the arguments you specified to the `getCompuMethodName` function.

Additionally, in the generated ASAP2 file, the constructed name is prefixed with `<ASAP2CompuMethodName_Prefix>`, a model prefix defined in `matlabroot/toolbox/rtw/targets/asap2/asap2/user/asap2setup.tlc`.

For example, if you call the `getCompuMethodName` function with the `dataTypeName` argument 'int16' and the `cmUnits` argument 'm/s', and generate an ASAP2 file for a
model named `myModel`, the computation method name would appear in the generated file as follows:

```
/begin COMPU_METHOD
  /* Name of CompuMethod */  myModel_CM_int16_m_s
  /* Units */ "m/s"
  ...
/end COMPU_METHOD
```

### Suppress Computation Methods for FIX_AXIS

Versions 1.51 and later of the ASAP2 specification state that for certain cases of lookup table axis descriptions (integer data type and no doc units), a computation method is not required and the Conversion Method parameter must be set to the value `NO_COMPU_METHOD`. You can control whether or not computation methods are suppressed when not required using the Target Language Compiler (TLC) option `ASAP2GenNoCompuMethod`. This TLC option is disabled by default. If you enable the option, ASAP2 file generation does not generate computation methods for lookup table axis descriptions when not required, and instead generates the value `NO_COMPU_METHOD`. For example:

```
/begin CHARACTERISTIC
  /* Name */
  lul1d_fix_axisTable_data
  ...
/begin AXIS_DESCR
  ...
    /* Conversion Method */
    NO_COMPU_METHOD
  ...
/end CHARACTERISTIC
```

The `ASAP2GenNoCompuMethod` option is defined in `matlabroot/toolbox/rtw/targets/asap2/asap2/user/asap2setup.tlc`.

### See Also

### Related Examples
- “How Generated Code Exchanges Data with an Environment” on page 15-33
• “How Generated Code Stores Internal Signal, State, and Parameter Data” on page 15-50
Custom Target Development in Simulink Coder

- “About Embedded Target Development” on page 39-2
- “Sample Custom Targets” on page 39-9
- “Target Development Folders, Files, and Builds” on page 39-11
- “Customize System Target Files” on page 39-28
- “Customize Template Makefiles” on page 39-62
- “Custom Target Optional Features” on page 39-80
- “Support Toolchain Approach with Custom Target” on page 39-82
- “Support Model Referencing” on page 39-84
- “Support Compiler Optimization Level Control” on page 39-96
- “Support C Function Prototype Control” on page 39-98
- “Support C++ Class Interface Control” on page 39-100
- “Support Concurrent Execution of Multiple Tasks” on page 39-102
- “Interface to Development Tools” on page 39-104
- “Device Drivers” on page 39-114
About Embedded Target Development

Target files bundled with the code generator are suitable for many different applications and development environments. Third-party targets provide additional versatility. In addition, you have the option of implementing a custom target.

To implement a target based on the ARM® Cortex®-A or ARM Cortex-M processor, install the corresponding support package and see the Target SDK: Embedded Coder Support Package for ARM Cortex-A Processors, “Develop a Target” (Embedded Coder Support Package for ARM Cortex-A Processors) or Embedded Coder Support Package for ARM Cortex-M Processors, “Develop a Target” (Embedded Coder Support Package for ARM Cortex-M Processors). Otherwise, use these functions and topics.

Custom Targets

You might want to implement a custom target for one of the following reasons:

• To enable end users to generate executable production code for a specific CPU or development board, using a specific development environment (compiler/linker/debugger).
• To support I/O devices on the target hardware by incorporating custom device driver blocks into your models.
• To configure the build process for a special compiler (such as a cross-compiler for an embedded microcontroller or DSP board) or development/debugging environment.

The code generator provides a point of departure for the creation of custom embedded targets, for the basic purposes above. This manual covers the tasks and techniques you need to implement a custom embedded target.

Types of Targets

The following sections describe several types of targets intended for different use cases

• “About Target Types” on page 39-3
• “Rapid Prototyping Targets” on page 39-3
• “Production Targets” on page 39-3
• “Verifying Targets With SIL and PIL Simulation” on page 39-4
About Target Types

There is a progression of capabilities from baseline or rapid prototyping targets to production targets. Initially, you might want to implement a rapid prototyping target. Later, you can enhance the target to be more full-featured. For example, you might want to add support for software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulation at some point for verifying your embedded target. The target types are not mutually exclusive. An embedded target can support more than one of these use cases, or additional uses not outlined here.

The discussion of target types is followed by “Recommended Features for Embedded Targets” on page 39-4, which contains a suggested list of features and general guidelines for embedded target development.

Rapid Prototyping Targets

A rapid prototyping target or baseline target offers a starting point for targeting a production processor. A rapid prototyping target integrates coded generator software with one or more popular cross-development environments (compiler/linker/debugger tool chains). A rapid prototyping target provides a starting point from which you can customize the target for application needs.

Target files provided for this type of target should be readable, easy to understand, and fully commented and documented. Specific attention should be paid to the interface to the intended cross-development environment. This interface should be implemented using the preferred approach for that particular development system. For example, some development environments use traditional make utilities, while others are based on project-file builds that can be automated under control of the code generator.

When you use a rapid prototyping target, you need to include your own device driver and legacy code and modify linker memory maps to suit your needs. You should be familiar with the targeted development system.

Production Targets

A production target supports embedded application development for a production processor. It includes the capability to create program executables that interact immediately with the external world. In general, ease of use is more important than simplicity or readability of generated code files, because it is assumed that you do not want or need to modify the files.
Desirable features for a production target include:

- Significant I/O driver support, provided out of the box
- Easy downloading of generated standalone executable programs with third-party debuggers
- User-controlled placement of an executable in FLASH or RAM memory
- Support for code visibility and tuning on target hardware

**Verifying Targets With SIL and PIL Simulation**

You can use software-in-the-loop (SIL) or processor-in-the-loop (PIL) simulation to verify generated code and validate the target compiler/processor environment.

You can use SIL and PIL simulation modes to verify automatically generated code by comparing the results with a normal mode simulation. With SIL, you can easily verify the behavior of production-intent source code on your host computer; however, it is generally not possible to verify exactly the same code that will subsequently be compiled for your target hardware because the code must be compiled for your host platform (i.e. a different compiler and different processor architecture than the target). With PIL simulation, you can verify exactly the same code that you intend to deploy in production, and you can run the code either on real target hardware or on an instruction set simulator.

For examples describing how to run processor-in-the-loop testing to verify a custom target, see “Sample Custom Targets” on page 39-9.

For more information on SIL and PIL simulation, see “SIL and PIL Simulations” (Embedded Coder).

**HIL Simulation**

A specialized use case is the generation of executables intended for use in hardware-in-the-loop (HIL) simulations. In a HIL simulation, parts of a pure simulation are gradually replaced with hardware components as components are refined and fabricated. HIL simulation offers an efficient design process that eliminates costly iterations of part fabrication.

**Recommended Features for Embedded Targets**

- “Basic Target Features” on page 39-5
Basic Target Features

- You can base targets on the generic real-time (GRT) target or the Embedded Real-Time (ERT) target that is included in the Embedded Coder product.

If your target is based on the ERT target, it should use 'Embedded-C' value for the CodeFormat TLC variable, and it should inherit the options defined in the ERT target's system target file with the following lines in the TLC file:

```tcl
%% Assign code format
%assign CodeFormat = "Embedded-C"
%%------------------------------
/%
   BEGIN_RTW_OPTIONS
      rtwgensettings.DerivedFrom = 'ert.tlc';
   END_RTW_OPTIONS
%/ 
%%------------------------------
```

By following these recommendations, your target has the production code generation capabilities of the ERT target.

See “Customize System Target Files” on page 39-28 for further details on the inheritance mechanism, setting the CodeFormat, and other details.

- The most fundamental requirement for an embedded target is that it generate a real-time executable from a model or subsystem. Typically, an embedded target generates a timer interrupt-based, bareboard executable (although targets can be developed for an operating system environment as well).

Your target should support code generator concepts of single-tasking and mult-tasking solver modes for model execution. Tasking support is available with the ERT target, but you should thoroughly understand how it works before implementing an ERT-based target.

For information on timer interrupt-based execution, see “Absolute and Elapsed Time Computation” on page 3-2 and “Asynchronous Events” on page 5-2.

- You should generate the target executable's main program module, rather than using a static main module (such as the static rt_main.c or rt_cppclass_main.cpp module provided with the software). A generated main.c or .cpp can be made much
more readable and more efficient, since it omits preprocessor checks and other extra code.

For information on generated and static main program modules, see “Deploy Generated Standalone Executable Programs To Target Hardware” (Embedded Coder).

- Follow the guidelines in “Folder and File Naming Conventions” on page 39-11.

**Integration with Target Development Environments**

- Most cross-development systems run under a Microsoft Windows PC host. Your target should support the Windows operating system as the host environment.

  Some cross-development systems support one or more versions of The Open Group UNIX platforms, allowing for UNIX host support as well.

- Your embedded target must support at least one embedded development environment. The interface to the development environment can take one of several forms. The toolchain approach and template makefile approach generate standard makefiles to work with your development environment. For general information about these build approaches, see “Choose Build Approach and Configure Build Process” on page 27-14. For detailed information about the structure of template makefiles, see “Customize Template Makefiles” on page 39-62.

  It is important to consider the license requirements and restrictions of the development environment vendor. You may need to modify files provided by the vendor and ship them as part of the embedded target.

  See “Interface to Development Tools” on page 39-104 for further information.

**Observing Execution of Target Code**

- Your target should support a mechanism you can use to observe the target code as it runs in real time (outside of a debugger).

  You can use the rtiostream API to implement a communication channel to enable exchange of data between different processes. For an example of creating a communication channel for target connectivity, see “Create a Target Communication Channel for Processor-In-The-Loop (PIL) Simulation” (Embedded Coder). This rtiostream communication channel is required to enable processor-in-the-loop (PIL) on a new target. See “Communications rtiostream API” (Embedded Coder).

  One industry-standard approach is to use the CAN bus, with an ASAP2 file and CAN Calibration Protocol (CCP). There are several host-based graphical front-end tools
available that connect to a CCP-enabled target and provide data viewing and parameter tuning. Supporting these tools requires implementation of CAN hardware drivers and CCP protocol for the target, as well as ASAP2 file generation. Your target can leverage the ASAP2 support provided with the code generator.

Another option is to support Simulink external mode simulation. For more information, see the “Host-Target Communication with External Mode Simulation” on page 28-2.

**Deployment and Hardware Issues**

- Device driver support is an important issue in the design of an embedded target. Device drivers are Simulink blocks that support either hardware I/O capabilities of the target CPU, or I/O features of the development board.

If you are developing a rapid prototyping target, consider providing minimal driver support, on the assumption that end users develop their own drivers. If you are developing a production target, you should provide full driver support.

See “Device Drivers” on page 39-114.

- Automatic download of generated code to the target hardware makes a target easier to use. Typically a debugger utility is used; if the chosen debugger supports command script files, this can be straightforward to implement. “STF_make_rtw_hook.m” on page 39-20 describes a mechanism to execute code from the build process. You can use this mechanism to make `system()` calls to invoke utilities such as a debugger. You can invoke other simple downloading utilities in a similar fashion.

If your development system supports COM automation, you can control the download process by that mechanism. Using COM automation is discussed in “Interface to Development Tools” on page 39-104.

- Executables that are mapped to RAM memory are typical. You can provide optional support for FLASH or RAM placement of the executable by using your target's code generation options. To support this capability, you might need multiple linker command files, multiple debugger scripts, and possibly multiple makefiles or project files. Also include the ability to automatically switch between these files, depending on the RAM/FLASH option value.

- Select a popular, widely available evaluation or prototype board for your target processor. Consider enclosed and ruggedized versions of the target board. Also consider board level support for the various on-chip I/O capabilities of the target CPU, and the availability of development systems that support the selected board.
See Also

More About

- “Sample Custom Targets” on page 39-9
- “Target Development Folders, Files, and Builds” on page 39-11
- “Customize System Target Files” on page 39-28
- “Customize Template Makefiles” on page 39-62
- “Custom Target Optional Features” on page 39-80
- “Support Toolchain Approach with Custom Target” on page 39-82
- “Support Model Referencing” on page 39-84
- “Support Compiler Optimization Level Control” on page 39-96
- “Support C Function Prototype Control” on page 39-98
- “Support C++ Class Interface Control” on page 39-100
- “Support Concurrent Execution of Multiple Tasks” on page 39-102
- “Interface to Development Tools” on page 39-104
- “Device Drivers” on page 39-114
Sample Custom Targets

There are technical solutions on the MathWorks Web site that you can use as a starting point to create your own target solution. The solutions provide guides to the following tasks for creating custom targets:

- Methods of embedding code onto a custom processor
- Creating a system target file
- Customizing the makefile and main file
- Adding compiler, chip, and board specific information
- Integrating legacy code and device drivers
- Creating blocks and libraries
- Implementing processor-in-the-loop (PIL) testing.

1 Start by downloading the embedded targets development guide zip file from this web page:

Is there an example guide on developing an embedded target...?

The zip file provides example files and a guide to developing a custom embedded target. The guide is divided into two parts, one on creating a generic custom target and another on creating a target for the Freescale™ S12X processor using the Cosmic Compiler.

Read the example guide along with this document to understand the tasks for developing embedded targets.

2 For more detailed example files for specific processors, see:

- Is there an example Freescale S12X target... using the Cosmic Compiler?
- Is there an example Freescale S12X target... using the CodeWarrior Compiler?

These example kits contain example models, code generation files, and instruction guides on generating and testing code for the processor. The Cosmic example illustrates the use of the target connectivity API for processor-in-the-loop (PIL) testing. The CodeWarrior example does not have PIL but shows CAN Calibration Protocol (CCP) and Simulink external mode.

The intent of the example kits is to provide working examples that you can use as a base to create your own target solution. The intent is not to provide a full featured
and maintained Embedded Target product like those provided by MathWorks or third-party products, as listed on the Embedded Coder Hardware Support Web page.

You can watch videos showing overviews of both the example kits at the following links:

- www.mathworks.com/videos/programming-the-freescale-s12x-target-68811.html

For another example target for the ARM9 (STR9) processor, see Is there an example ARM9 (STR9) target... using the GNU ARM Compiler and Hitex STR9-comStick?.

If you have questions on specific targets, please email mytarget@mathworks.com.

The example kits and this document describe Embedded Coder features such as customized system target files and processor-in-the-loop testing, but you can study the examples as a starting point for use with Simulink Coder targets.

**See Also**

**More About**

- “About Embedded Target Development” on page 39-2
- “Customize System Target Files” on page 39-28
- “Customize Template Makefiles” on page 39-62
- “Custom Target Optional Features” on page 39-80
- “Support Toolchain Approach with Custom Target” on page 39-82
- “Interface to Development Tools” on page 39-104
- “Device Drivers” on page 39-114
Target Development Folders, Files, and Builds

Target development mechanics work with a number of folder and file types. The following topics provide the information to develop custom targets, configure folder usage, and use custom targets in the build process.

Folder and File Naming Conventions

You can use a single folder for your custom target files, or if desired you can use subfolders, for example containing files associated with specific development environments or tools.

For a custom target implementation, the recommended folder and file naming conventions are

- Use only lowercase in folder names, filenames, and extensions.
- Do not embed spaces in folder names. Spaces in folder names cause errors with many third-party development environments.
- Include desired folders in the MATLAB path.
- Do not place your custom target folder anywhere in the MATLAB folder tree (that is, in or under the `matlabroot` folder). If you place your folder under `matlabroot` you risk losing your work if you install a new MATLAB version (or reinstall the current version).

The following sections explain how to organize your target folders and files and add them to your MATLAB path. They also provide high-level descriptions of the files.

In this document, `mytarget` is a placeholder name that represents folders and files that use the target's name. The names `dev_tool1`, `dev_tool2`, and so on represent subfolders containing files associated with development environments or tools. This document describes an example structure where the folder `mytarget` contains subfolders for `mytarget`, `blocks`, `dev_tool1`, `dev_tool2`. The top level folder `mytarget` is the target root folder.

Components of a Custom Target

- “Overview” on page 39-12
- “Code Components” on page 39-12
- “Control Files” on page 39-14
Overview

The components of a custom target are files located in a hierarchy of folders. The top-level folder in this structure is called the target root folder. The target root folder and its contents are named, organized, and located on the MATLAB path according to conventions described in “Folder and File Naming Conventions” on page 39-11.

The components of a custom target include

- Code components: C source code that supervises and supports execution of generated model code.
- Control files:
  - A system target file (STF) to control the code generation process.
  - File(s) to control the building of an executable from the generated code. In a traditional make-based environment, a template makefile (TMF) generates a makefile for this purpose. Another approach is to generate project files in support of a modern integrated development environment (IDE) such as the Freescale Semiconductor CodeWarrior IDE.
  - Hook files: Optional TLC and MATLAB program files that can be invoked at well-defined stages of the build process. Hook files let you customize the build process and communicate information between various phases of the process.
  - Other target files: Files that let you integrate your target into the MATLAB environment. For example, you can provide an info.xml file to make your target block libraries and examples available from a MATLAB session.

The next sections introduce key concepts and terminology you need to know to develop each component. References to more detailed information sources are provided.

Code Components

An executable program containing code generated from a Simulink model consists of a number of code modules and data structures. These fall into two categories.

Application Components

Application components are those which are specific to a particular model; they implement the functions represented by the blocks in the model. Application components are not specific to the target. Application components include

- Modules generated from the model
• User-written blocks (S-functions)
• Parameters of the model that are visible, and can be interfaced to, external code

**Execution Support Files**

A number of code modules and data structures, referred to collectively as the *execution support files*, are responsible for managing and supporting the execution of the generated program. The execution support files modules are not automatically generated. Depending on the requirements of your target, you must implement certain parts of the execution support files. Execution Support Files summarizes the execution support files.

<table>
<thead>
<tr>
<th>You Provide...</th>
<th>The Code Generator Provides...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customized main program</td>
<td>Generic main program</td>
</tr>
<tr>
<td>Timer interrupt handler to run model</td>
<td>Execution engine and integration solver (called by timer interrupt handler)</td>
</tr>
<tr>
<td>Other interrupt handlers</td>
<td>Example interrupt handlers (Asynchronous Interrupt blocks)</td>
</tr>
<tr>
<td>Device drivers</td>
<td>Example device drivers</td>
</tr>
<tr>
<td>Data logging, parameter tuning, signal monitoring, and external mode support</td>
<td>Data logging, parameter tuning, signal monitoring, and external mode APIs</td>
</tr>
</tbody>
</table>

**User-Written Execution Support Files**

The code generator provides most of the execution support files. Depending on the requirements of your target, you must implement some or all of the following elements:

• A timer *interrupt service routine* (ISR). The timer runs at the program's base sample rate. The timer ISR is responsible for operations that must be completed within a single clock period, such as computing the current output sample. The timer ISR usually calls the `rt_OneStep` function.

  If you are targeting a real-time operating system (RTOS), your generated code usually executes under control of the timing and task management mechanisms provided by the RTOS. In this case, you may not have to implement a timer ISR.

• The *main program*. Your main program initializes the blocks in the model, installs the timer ISR, and executes a background task or loop. The timer periodically interrupts
the main loop. If the main program is designed to run for a finite amount of time, it is also responsible for cleanup operations — such as memory deallocation and masking the timer interrupt — before terminating the program.

If you are targeting a real-time operating system (RTOS), your main program most likely spawns tasks (corresponding to the sample rates used in the model) whose execution is timed and controlled by the RTOS.

Your main program typically is based on a generated or static main program. For details on the structure of the execution support files, code execution, and guidelines for customizing main programs, see “Deploy Generated Standalone Executable Programs To Target Hardware” (Embedded Coder).

• **Device drivers.** Drivers communicate with I/O devices on your target hardware. In production code, device drivers are normally implemented as inlined S-functions.

• **Other interrupt handlers.** If your models need to support asynchronous events, such as hardware generated interrupts and asynchronous read and write operations, you must supply interrupt handlers. The Interrupt Templates library provides examples.

• **Data logging, parameter tuning, signal monitoring, and external mode support.** It is atypical to implement rapid prototyping features such as external mode support in an embedded target. However, it is possible to support these features by using standard code generator APIs. See “Data Exchange Interfaces” for details.

**Control Files**

The code generation and build process is directed by a number of TLC and MATLAB files collectively called control files. This section introduces and summarizes the main control files.

**Top-Level Control File (make_rtw)**

The build process is initiated when you press Ctrl+B. At this point, the build process parses the Make command field of the Code Generation pane of the Configuration Parameters dialog box, expecting to find the name of a MATLAB command that controls the build process (as well as optional arguments to that command). The default command is make_rtw, and the default top-level control file for the build process is make_rtw.m.

**Note** make_rtw is an internal MATLAB command used by the build process. Normally, target developers do not need detailed knowledge of how make_rtw works. (The details for target developers are described in “Target Development and the Build Process” on
You should not invoke `make_rtw` directly from MATLAB code, and you should not customize `make_rtw.m`.

The `make_rtw.m` file contains the logic required to execute your target-specific control files, including a number of hook points for execution of your custom code. `make_rtw` does the following:

- Passes optional arguments in to the build process
- Performs required preprocessing before code generation
- Executes the STF to perform code generation (and optional HTML report generation)
- Processes the TMF to generate a makefile
- Invokes a make utility to execute the makefile and build an executable
- Performs required post-processing (such as generating calibration data files or downloading the generated executable to the target)

**System Target File (STF)**

The Target Language Compiler (TLC) generates target-specific C or C++ code from a partial description of your Simulink block diagram (`model.rtw`). The Target Language Compiler reads `model.rtw` and executes a program consisting of several target files (`.tlc` files.) The STF, at the top level of this program, controls the code generation process. The output of this process is a number of source files, which are fed to your development system's make utility.

You need to create a customized STF to set code generation parameters for your target. You should copy, rename, and modify the standard ERT system target file (`matlabroot/rtw/c/ert/ert.tlc`).

The detailed structure of the STF is described in “Customize System Target Files” on page 39-28.

**Note** The STF selects whether the target supports the toolchain approach or template makefile approach for code generation. See “Customize System Target Files” on page 39-28.
Template Makefile (TMF)

A TMF provides information about your model and your development system. The build process uses this information to create a makefile (.mk file) that builds an executable program.

Some targets implement more than one TMF, in order to support multiple development environments (for example, two or more cross-compilers) or multiple modes of code generation (for example, generating a binary executable versus generating a project file for your compiler).

The Embedded Coder software provides a large number of TMFs suitable for different types of development computer systems. These TMFs are located in `matlabroot/rtw/c/ert` (open). The standard TMFs are described in “Template Makefiles and Make Options” on page 27-26.

The detailed structure of the TMF is described in “Customize Template Makefiles” on page 39-62.

Note The STF selects whether the target supports the toolchain approach or template makefile approach for code generation. See “Customize System Target Files” on page 39-28.

Hook Files

The build process allows you to supply optional hook files that are executed at specified points in the code generation and make process. You can use hook files to add target-specific actions to the build process.

The hook files must follow well-defined naming and location requirements. “Folder and File Naming Conventions” on page 39-11 describes these requirements.

Key Folders Under Target Root (mytarget)

- “Target Root Folder (mytarget)” on page 39-17
- “Target Folder (mytarget/mytarget)” on page 39-17
- “Target Block Folder (mytarget/blocks)” on page 39-17
- “Development Tools Folder (mytarget/dev_tool1, mytarget/dev_tool2)” on page 39-18
• “Target Source Code Folder (mytarget/src)” on page 39-19

**Target Root Folder (mytarget)**

This folder contains the key subfolders for the target (see “Folder and File Naming Conventions” on page 39-11). You can also locate miscellaneous files (such as a readme file) in the target root folder. The following sections describe required and optional subfolders and their contents.

**Target Folder (mytarget/mytarget)**

This folder contains files that are central to the target, such as the system target file (STF) and template makefile (TMF). “Key Files in Target Folder (mytarget/mytarget)” on page 39-19 summarizes the files that should be stored in mytarget/mytarget, and provides pointers to detailed information about these files.

**Note** mytarget/mytarget should be on the MATLAB path.

**Target Block Folder (mytarget/blocks)**

If your target includes device drivers or other blocks, locate the block implementation files in this folder. mytarget/blocks contains

- Compiled block MEX-files
- Source code for the blocks
- TLC inlining files for the blocks
- Library models for the blocks (if you provide your blocks in one or more libraries)

**Note** mytarget/blocks should be on the MATLAB path.

You can also store example models and supporting files in mytarget/blocks. Alternatively, you can create a mytarget/mytargetdemos folder, which should also be on the MATLAB path.

To display your blocks in the standard Simulink Library Browser and/or integrate your example models into the MATLAB session environment, you can create the files described below and store them in mytarget/blocks.
mytarget/blocks/slblocks.m

This file allows a group of blocks to be integrated into the Simulink Library and Simulink Library Browser.

Example 39.1. Example slblocks.m File

```matlab
function blkStruct = slblocks
% Information for "Blocksets and Toolboxes" subsystem
blkStruct.Name = sprintf('Embedded Target\n for MYTARGET');
blkStruct.OpenFcns = 'mytargetlib';
blkStruct.MaskDisplay = 'disp(''MYTARGET'');

% Information for Simulink Library Browser
Browser(1).Library = 'mytargetlib';
Browser(1).Name = 'Embedded Target for MYTARGET';
Browser(1).IsFlat = 1;% Is this library "flat" (i.e. no subsystems)?

blkStruct.Browser = Browser;
```

mytarget/blocks/demos.xml

This file provides information about the components, organization, and location of example models. MATLAB software uses this information to place the example in the MATLAB session environment.

Example 39.2. Example demos.xml File

```xml
<?xml version="1.0" encoding="utf-8"?>
<demos>
  <name>Embedded Target for MYTARGET</name>
  <type>simulink</type>
  <icon>$toolbox/matlab/icons/boardicon.gif</icon>
  <description source = "file">mytarget_overview.html</description>

  <demosection>
    <label>Multirate model</label>
    <demoitem>
      <label>MYTARGET demo</label>
      <file>mytarget_overview.html</file>
      <callback>mytarget_model</callback>
    </demoitem>
  </demosection>
</demos>
```

Development Tools Folder (mytarget/dev_tool1, mytarget/dev_tool2)

These folders contain files associated with specific development environments or tools (dev_tool1, dev_tool2, etc.). Normally, your target supports at least one such development environment and invokes its compiler, linker, and other utilities during the
build process. mytarget/dev_tool1 includes linker command files, startup code, hook functions, and other files required to support this process.

For each development environment, you should provide a separate folder.

**Target Source Code Folder (mytarget/src)**

This folder is optional. If the complexity of your target requires it, you can use mytarget/src to store common source code and configuration code (such as boot and startup code).

**Key Files in Target Folder (mytarget/mytarget)**

- “Introduction” on page 39-19
- “mytarget.tlc” on page 39-19
- “mytarget.tmf” on page 39-20
- “mytarget_genfiles.tlc” on page 39-20
- “mytarget_main.c” on page 39-20
- “STF_make_rtw_hook.m” on page 39-20
- “STF_rtw_info_hook.m (obsolete)” on page 39-21
- “info.xml” on page 39-21
- “mytarget_overview.html” on page 39-21

**Introduction**

The target folder mytarget/mytarget contains key files in your target implementation. These include the system target file, template makefile, main program module, and optional M and TLC hook files that let you add target-specific actions to the build process. The following sections describe the key target folder files.

**mytarget.tlc**

mytarget.tlc is the system target file (STF). Functions of the STF include

- Making the target visible in the System Target File Browser
- Definition of code generation options for the target (inherited and target-specific)
- Providing an entry point for the top-level control of the TLC code generation process

You should base your STF on ert.tlc, the STF provided by Embedded Coder software.
“Customize System Target Files” on page 39-28 gives detailed information on the structure of the STF, and also gives instructions on how to customize an STF to

- Display your target in the System Target File Browser
- Add your own target options to the Configuration Parameters dialog box
- Tailor the code generation and build process to the requirements of your target

**mytarget.tmf**

mytarget.tmf is the template makefile for building an executable for your target.

For basic information on the structure and operation of template makefiles, see “Customize Template Makefiles” on page 39-62.

If your target development environment requires automation of a modern integrated development environment (IDE) rather than use of a traditional make utility, see “Interface to Development Tools” on page 39-104.

**mytarget_genfiles.tlc**

This file is optional. mytarget_genfiles.tlc is useful as a central file from which to invoke target-specific TLC files that generate additional files as part of your target build process. For example, your target may create sub-makefiles or project files for a development environment, or command scripts for a debugger to do automatic downloads. See “Using mytarget_genfiles.tlc” on page 39-45 for details.

**mytarget_main.c**

A main program module is required for your target. To provide a main module, you can either

- Modify the rt_main.c or rt_cppclass_main.cpp module provided by the software
- Generate mytarget_main.c or .cpp during the build process

For a description of the operation of main programs, see “Deploy Generated Standalone Executable Programs To Target Hardware” (Embedded Coder). The section also contains guidelines for generating and modifying a main program module.

**STF_make_rtw_hook.m**

STF_make_rtw_hook.m is an optional hook file that you can use to invoke target-specific functions or executables at specified points in the build process. STF_make_rtw_hook.m
implements a function that dispatches to a specific action depending on the method argument that is passed into it.

“Customize Build Process with STF_make_rtw_hook File” on page 37-50 describes the operation of the $STF_{\text{make\_rtw\_hook.m}}$ hook file in detail.

**STF_rtw_info_hook.m (obsolete)**

Prior to Release 14, custom targets supplied target-specific information with a hook file (referred to as $STF_{\text{rtw\_info\_hook.m}}$). The $STF_{\text{rtw\_info\_hook}}$ specified properties such as word sizes for integer data types (for example, char, short, int, and long), and C implementation-specific properties of the custom target.

The $STF_{\text{rtw\_info\_hook}}$ mechanism has been replaced by the Hardware Implementation pane of the Configuration Parameters dialog box. Using this dialog box, you can specify the properties that were formerly specified in your $STF_{\text{rtw\_info\_hook}}$ file.

For backward compatibility, existing $STF_{\text{rtw\_info\_hook}}$ files are still available. However, you should convert your target and models to use the Hardware Implementation pane. See “Configure Run-Time Environment Options” on page 10-2.

**info.xml**

This file provides information to MATLAB software that specifies where to display the target toolbox in the MATLAB session environment. For more information, see “Display Custom Documentation” (MATLAB).

**mytarget_overview.html**

By convention, this file serves as home page for the target examples.

The `<description>` field in demos.xml should point to mytarget_overview.html (see “mytarget/blocks/demos.xml” on page 39-18).

**Example mytarget_overview.html File**

```html
<html><head><title>Embedded Target for MYTARGET</title></head><body>
<p style="color:#990000; font-weight:bold; font-size:x-large">Embedded Target for MYTARGET Example Model</p>

This example provides a simple model that allows you to generate an executable for a supported target board. You can then download and run the executable and set breakpoints to study and monitor the execution behavior.</body>
```
Additional Files for Externally Developed Targets

- “Introduction” on page 39-22
- “mytarget/mytarget/mytarget_setup.m” on page 39-22
- “mytarget/mytarget/doc” on page 39-22

Introduction

If you are developing an embedded target that is not installed into the MATLAB tree, you should provide a target setup script and target documentation within mytarget/mytarget, for the convenience of your users. The following sections describe the required materials and where to place them.

mytarget/mytarget/mytarget_setup.m

This file script adds paths for your target to the MATLAB path. Your documentation should instruct users to run the script when installing the target.

You should include a call to the MATLAB function `savepath` in your `mytarget_setup.m` script. This function saves the added paths, so users need to run `mytarget_setup.m` only once.

The following code is an example `mytarget_setup.m` file.

```matlab
function mytarget_setup()
    curpath = pwd;
    tgtpath = curpath(1:end-length('\mytarget'));
    addpath(fullfile(tgtpath, 'mytarget'));
    addpath(fullfile(tgtpath, 'dev_tool1'));
    addpath(fullfile(tgtpath, 'blocks'));
    addpath(fullfile(tgtpath, 'mytargetdemos'));
    savepath;
    disp('MYTARGET Target Path Setup Complete.');
end
```

mytarget/mytarget/doc

You should put the documentation related to your target in the folder mytarget/mytarget/doc.
Target Development and the Build Process

- “About the Build Process” on page 39-23
- “Build Process Phases and Information Passing” on page 39-23
- “Additional Information Passing Techniques” on page 39-24

About the Build Process

To develop an embedded target, you need a thorough understanding of the build process. Your embedded target uses the build process and may require you to modify or customize the process. A general overview of code generation and the build process is given in “Code Generation” and “Build Process”.

This section supplements that overview with a description of the build process as customized by the Embedded Coder software. The emphasis is on points in the process where customization hooks are available and on passing information between different phases of the process.

This section concludes with “Additional Information Passing Techniques” on page 39-24, describing assorted tips and tricks for passing information during the build process.

Build Process Phases and Information Passing

It is important to understand where (and when) the build process obtains required information. Sources of information include

- The model.rtw file, which provides information about the generating model. The information in model.rtw is available to target TLC files.
- The code generation panes of the Configuration Parameters dialog box. Options (both general and target-specific) are provided through check boxes, menus, and edit fields. You can associate options with TLC variables in the rtwoptions data structure. Use the Configuration Parameters > Code Generation > Custom Code > Additional build information > Defines field to define makefile tokens.
- The selected toolchain (for toolchain approach builds) or selected template makefile.tmf (for template makefile approach builds); these generate the model-specific makefile.
- Environment variables on the host computer. Environment variables provide additional information about installed development tools.
- Other target-specific files such as target-related TLC files, linker command files, or project files.
It is also important to understand the several phases of the build process and how to pass information between the phases. The build process comprises several high-level phases:

- Execution of the top-level file (`slbuild.m` or `rtwbuild.m`) to sequence through the build process for a target
- Conversion of the model into the TLC input file (`model.rtw`)
- Generation of the target code by the TLC compiler
- Compilation of the generated code with `make` or other utilities
- Transmission of the final generated executable to the target hardware with a debugger or download utility

It is helpful to think of each phase of the process as a different “environment” that maintains its own data. These environments include:

- MATLAB code execution environment (MATLAB)
- Simulink
- Target Language Compiler execution environment
- `makefile`
- Development environments such as an IDE or debugger

In each environment, you might get information from the various sources mentioned above. For example, during the TLC phase, execute MATLAB file might execute to obtain information from the MATLAB environment. Also, a given phase may generate information for a subsequent phase.

See “Key Files in Target Folder (mytarget/mytarget)” on page 39-19 for details on the available MATLAB file and TLC hooks for information passing, with code examples.

**Additional Information Passing Techniques**

This section describes a number of useful techniques for passing information among different phases of the build process.

**tlcvariable Field in rtwoptions Structure**

Parameters on the code generation panes of the Configuration Parameters dialog box can be associated with a TLC variable, and specified in the `tlcvariable` field of the option’s entry in the `rtwoptions` structure. The variable value is passed on the command line when TLC is invoked. This provides a way to make code generation parameters and their values available in the TLC phase.
See “System Target File Structure” on page 39-29 for further information.

**makevariable Field in rtwoptions Structure**

You can associate code generation parameters with a template makefile token, that you specify in the `makevariable` field of the option's entry in the `rtwoptions` structure. If a token of the same name as the `makevariable` name exists in the TMF, the token is updated with the option value when the final makefile is created. If the token does not exist in the TMF, the `makevariable` is passed in on the command line when make is invoked. Thus, in either case, the `makevariable` is available to the makefile.

See “System Target File Structure” on page 39-29 for further information.

**Accessing Host Environment Variables**

You can access host shell environment variables at the MATLAB command line by entering the `getenv` command. For example:

```matlab
getenv ('MSDEVDIR')
```

```plaintext
ans =
D:\Applications\Microsoft Visual Studio\Common\MSDev98
```

To access the same information from TLC, use the `FEVAL` directive to invoke `getenv`.

```matlab
%assign eVar = FEVAL("getenv","<varname>")
```

**Supplying Development Environment Information to Your Template Makefile**

An embedded target must tie the build process to target-specific development tools installed on a host computer. For the make process to run these tools, the TMF must be able to determine the name of the tools, the path to the compiler, linker, and other utilities, and possibly the host operating system environment variable settings.

Require the end user to modify the target TMF. The user enters path information (such as the location of a compiler executable), and possibly host operating system environment variables, as make variables. This allows the TMF to be tailored to specific needs.

**Using MATLAB Application Data**

Application data provides a way for applications to save and retrieve data stored with the GUI. This technique enables you to create what is essentially a user-defined property for an object, and use this property to store data for use in the build process. If you are
unfamiliar with this technique for creating graphical user interfaces, see “Store Data as Application Data” (MATLAB).

The following code examples illustrates the use of application data to pass information to TLC.

This file, tlc2appdata.m, stores the data passed in as application data under the name passed in (appDataName).

```matlab
function k = tlc2appdata(appDataName,data)
    disp([mfilename,': ',appDataName,' ', data]);
    setappdata(0,appDataName,data);
    k = 0;  % TLC expects a return value for FEVAL.
```

The following sample TLC file uses the FEVAL directive to invoke tlc2appdata.m to store arbitrary application data, under the name z80.

```tcl
%% test.tlc

%assign myApp = "z80"
%assign myData = "314159"
%assign dummy = FEVAL("tlc2appdata",myApp,myData)
```

To test this technique:

1. Create the tlc2appdata.m file as shown. Check that tlc2appdata.m is stored in a folder on the MATLAB path.
2. Create the TLC file as shown. Save it as test.tlc.
3. Enter the following command at the MATLAB prompt to execute the TLC file:
   ```matlab
tlc test.tlc
```
4. Get the application data at the MATLAB prompt:
   ```matlab
k = getappdata(0,'z80')
```
   The function returns the value 314159.
5. Enter the following command.
   ```matlab
who
```

Note that application data is not stored in the MATLAB workspace. Also observe that the z80 data is not visible. Using application data in this way has the advantage that
it does not clutter the MATLAB workspace. Also, it helps prevent you from accidentally deleting your data, since it is not stored directly in your workspace.

A real-world use of application data might be to collect information from the `model.rtw` file and store it for use later in the build process.

**Adding Block-Specific Information to the Makefile**

The `rtwmakecfg` mechanism provides a method for inlined S-functions such as driver blocks to add information to the makefile. This mechanism is described in “Use `rtwmakecfg.m` API to Customize Generated Makefiles” on page 37-26.

**See Also**

**More About**

- “About Embedded Target Development” on page 39-2
Customize System Target Files

This section provides information on the structure of the STF, guidelines for customizing an STF, and a basic tutorial that helps you get a skeletal STF up and running.

Control Code Generation With the System Target File

The system target file (STF) exerts overall control of the code generation stage of the build process. The STF also lets you control the presentation of your target to the end user. The STF provides

- Definitions of variables that are fundamental to the build process, such as the value for the CodeFormat TLC variable
- The main entry point to the top-level TLC program that generates code
- Target information for display in the System Target File Browser
- A mechanism for defining target-specific code generation options (and other parameters related to the build process) and for displaying them in the Configuration Parameters dialog box
- A mechanism for inheriting options from another target (such as the Embedded Real-Time (ERT) target)

Note that, although the STF is a Target Language Compiler (TLC) file, it contains embedded MATLAB code. Before creating or modifying an STF, you should acquire a working knowledge of TLC and of the MATLAB language. “Target Language Compiler” and “Scripts vs. Functions” (MATLAB) describe the features and syntax of both the TLC and MATLAB languages.

While reading this section, you may want to refer to the STFs provided with the code generator. Most of these files are stored in the target-specific folders under matlabroot/rtw/c (open). Additional STFs are stored under matlabroot/toolbox/rtw/targets (open).

System Target File Naming and Location Conventions

An STF must be located in a folder on the MATLAB path for the target to be displayed in the System Target File Browser and invoked in the build process. Follow the location and naming conventions for STFs and related target files given in “Folder and File Naming Conventions” on page 39-11.
System Target File Structure

- “Overview” on page 39-29
- “Header Comments” on page 39-30
- “TLC Configuration Variables” on page 39-32
- “TLC Program Entry Point and Related %includes” on page 39-33
- “RTW_OPTIONS Section” on page 39-34
- “rtwgensettings Structure” on page 39-34
- “Additional Code Generation Options” on page 39-36
- “Model Reference Considerations” on page 39-36

Overview

This section is a guide to the structure and contents of an STF. The following listing shows the general structure of an STF. Note that this is not a complete code listing of an STF. The listing consists of excerpts from each of the sections that make up an STF.

```system_tfile
%%----------------------------
%% Header Comments Section
%%----------------------------
%% SYSTLC: Example Real-Time Target
%% TMF: my_target.tmf MAKE: make_rtw EXTMODE: ext_comm
%% Initial comments contain directives for STF Browser.
%% Documentation, date, copyright, and other info may follow.
...
%selectfile NULL_FILE
...
%%----------------------------
%% TLC Configuration Variables Section
%%----------------------------
%% Assign code format, language, target type.
%%
%%assign CodeFormat = "Embedded-C"
%assign TargetType = "RT"
%assign Language = "C"
%%----------------------------
%% TLC Program Entry Point
%%----------------------------
%% Call entry point function.
%include "codegenentry.tlc"
%%----------------------------
%% (OPTIONAL) Generate Files for Build Process
%include "mytarget_genfiles.tlc"
```
%% RTW_OPTIONS Section
%----------------------------------------%
BEGIN_RTW_OPTIONS
% Define rtwoptions structure array. This array defines target-specific
% code generation variables, and controls how they are displayed.
rtwoptions(1).prompt = 'example code generation options';
...
rtwoptions(6).prompt = 'Show eliminated blocks';
rtwoptions(6).type = 'Checkbox';
...
%----------------------------------------%
% Configure RTW code generation settings %
%----------------------------------------%
%
%-----------------------------
% rtwgensettings Structure
%-----------------------------
% Define suffix text for naming build folder here.
rtwgensettings.BuildDirSuffix = '_mytarget_rtw'
% Callback compatibility declaration
rtwgensettings.Version = '1';
%
% (OPTIONAL) target inheritance declaration
rtwgensettings.DerivedFrom = 'ert.tlc';
% (OPTIONAL) other rtwGenSettings fields...
...
_END_RTW_OPTIONS
%/  
%-----------------------------
% targetComponentClass - MATHWORKS INTERNAL USE ONLY
% REMOVE NEXT SECTION FROM USER_DEFINED CUSTOM TARGETS
%-----------------------------
/%
BEGIN_CONFIGSET_TARGET_COMPONENT
  targetComponentClass = 'Simulink.ERTTargetCC';
  END_CONFIGSET_TARGET_COMPONENT
%
If you are creating a custom target based on an existing STF, you must remove the
targetComponentClass section (bounded by the directives
BEGIN_CONFIGSET_TARGET_COMPONENT and END_CONFIGSET_TARGET_COMPONENT).
This section is reserved for the use of targets developed internally by MathWorks.

Header Comments

These lines at the head of the file are formatted as TLC comments. They provide required
information to the System Target File Browser and to the build process. Note that you
must place the browser comments at the head of the file, before other comments or TLC
statements.
The presence of the comments enables the code generator to detect STFs. When the System Target File Browser is opened, the code generator scans the MATLAB path for TLC files that have formatted header comments. The comments contain the following directives:

- SYSTLC: The descriptor that appears in the browser.
- TMF: Name of the template makefile (TMF) to use during build process. When the target is selected, this filename is displayed in the “Template makefile” field of the Code Generation pane of the Configuration Parameters dialog box.
- MAKE: make command to use during build process. When the target is selected, this command is displayed in the Make command field of the Code Generation pane of the ConfigurationParameters dialog box.
- EXTMODE: Name of external mode interface file (if any) associated with your target. If your target does not support external mode, use no_ext_comm.

The following header comments are from `matlabroot/rtw/c/ert/ert.tlc`.

```
%% SYSTLC: Embedded Coder TMF: ert_default_tmf MAKE: make_rtw 
%% EXTMODE: ext_comm
%% SYSTLC: Create Visual C/C++ Solution File for Embedded Coder
%% TMF: RTW.MSVCBuild MAKE: make_rtw EXTMODE: ext_comm
```

**Note**

- Limitation: Each comment can only contain a maximum of two lines, as shown in the preceding example.
- If you do not specify the TMF or EXTMODE fields in the system target file, the file is still valid. To change the values for the parameters Template makefile (TemplateMakefile) and External mode (ExtMode), you can instead use the callback function specified by `rtwgensettings.SelectCallback`.

Note that you can specify more than one group of directives in the header comments. Each such group is displayed as a different target configuration in the System Target File Browser. In the above example, the first two lines of code specify the default configuration of the ERT target. The next two lines specify a configuration that creates and builds a Microsoft Visual C++ Solution (.sln) file. The figure below shows how these configurations appear in the System Target File Browser.
See “Create a Custom Target Configuration” on page 39-48 for an example of customized header comments.

**TLC Configuration Variables**

This section of the STF assigns global TLC variables that relate to the overall code generation process.

For an embedded target, in most cases you should simply use the global TLC variable settings used by the ERT target (ert.tlc). It is especially important that your STF use the 'Embedded-C' value for the CodeFormat TLC variable and uses the corresponding rtwgensettings.DerivedFrom = 'ert.tlc' in the RTW_OPTIONS section of the TLC file. Verify that values are assigned to the following variables:

- **CodeFormat**: The CodeFormat TLC variable selects generated code features. The 'Embedded-C' value for this variable is used by the ERT target. Your ERT-based target should specify 'Embedded-C' as the value for CodeFormat. This selection is designed for production code, minimal memory usage, static memory allocation, and a simplified interface to generated code.

  For information on other values for the CodeFormat TLC variable, see “Compare System Target File Support Across Products” on page 19-21.

- **Language**: The only valid value is C, which enables support for C or C++ code generation as specified by the configuration parameter TargetLang.

- **TargetType**: The code generator defines the preprocessor symbols RT and NRT to distinguish simulation code from real-time code. These symbols are used in conditional compilation. The TargetType variable determines whether RT or NRT is defined.
Most targets are intended to generate real-time code. They assign `TargetType` as follows.

```%
assign TargetType = "RT"
```

Some targets, such as the model reference simulation target, accelerated simulation target, RSim target, and S-function target, generate code for use in nonreal time only. Such targets assign `TargetType` as follows.

```%
assign TargetType = "NRT"
```

**TLC Program Entry Point and Related %includes**

The code generation process normally begins with `codegenentry.tlc`. The STF invokes `codegenentry.tlc` as follows.

```%
include "codegenentry.tlc"
```

**Note** `codegenentry.tlc` and the lower-level TLC files assume that `CodeFormat`, `TargetType`, and `Language` have been assigned. Set these variables before including `codegenentry.tlc`.

If you need to implement target-specific code generation features, you should include the TLC file `mytarget_genfiles.tlc` in your STF. This file provides a mechanism for executing custom TLC code before and after invoking `codegenentry.tlc`. For information on this mechanism, see

- “Using `mytarget_genfiles.tlc`” on page 39-45 for an example of custom TLC code for execution after the main code generation entry point.
- “Target Development and the Build Process” on page 39-23 for general information on the build process, and for information on other build process customization hooks.

Another way to customize the code generation process is to call lower-level functions (normally invoked by `codegenentry.tlc`) directly, and include your own TLC functions at each stage of the process. This approach should be taken with caution. See “TLC Files” for more information.

The lower-level functions called by `codegenentry.tlc` are

- `genmap.tlc`: maps block names to corresponding language-specific block target files.
- **commonsetup.tlc**: sets up global variables.
- **commonentry.tlc**: starts the process of generating code.

**RTW_OPTIONS Section**

The RTW_OPTIONS section is bounded by the directives:

```%
   BEGIN_RTW_OPTIONS
   .
   .
   END_RTW_OPTIONS
%/
```

The first part of the RTW_OPTIONS section defines an array of rtwoptions structures. This structure is discussed in “Using rtwoptions to Display Custom Target Options” on page 39-37.

The second part of the RTW_OPTIONS section defines rtwgensettings, a structure defining the build folder name and other settings for the code generation process. See “rtwgensettings Structure” on page 39-34 for information about rtwgensettings.

**rtwgensettings Structure**

The final part of the STF defines the rtwgensettings structure. This structure stores information that is written to the `model.rtw` file and used by the build process. The rtwgensettings fields of most interest to target developers are

- **rtwgensettings.Version**: Use this property to enable rtwoptions callbacks and to use the Callback API in rtwgensettings.SelectCallback.

**Note** To use callbacks, you must set:

```matlab
rtwgensettings.Version = '1';
```

Add the statement above to the **Configure RTW code generation settings** section of the system target file.
• **rtwgensettings.DerivedFrom**: This structure field defines the system target file from which options are to be inherited. See “Inheriting Target Options” on page 39-44.

• **rtwgensettings.SelectCallback**: This structure field specifies a SelectCallback function. You must set rtwgensettings.Version = '1'; or your callback will be ignored. SelectCallback is associated with the target rather than with any of its individual options. The SelectCallback function is triggered when the user selects a target with the System Target File browser.

The SelectCallback function is useful for setting up (or disabling) configuration parameters specific to the target.

The following code installs a SelectCallback function:

```matlab
rtwgensettings.SelectCallback = 'my_select_callback_handler(hDlg,hSrc)';
```

The arguments to the SelectCallback function (hDlg, hSrc) are handles to private data used by the callback API functions.

**Note** If you have developed a custom target and you want it to be compatible with model referencing, you must implement a SelectCallback function to declare model reference compatibility. See “Support Model Referencing” on page 39-84.

• **rtwgensettings.ActivateCallback**: this property specifies an ActivateCallback function. The ActivateCallback function is triggered when the active configuration set of the model changes. This could happen during model loading, and also when the user changes the active configuration set.

The following code installs an ActivateCallback function:

```matlab
rtwgensettings.ActivateCallback = 'my_activate_callback_handler(hDlg,hSrc)';
```

The arguments to the ActivateCallback function (hDlg, hSrc) are handles to private data used by the callback API functions.

• **rtwgensettings.PostApplyCallback**: this property specifies a PostApplyCallback function. The PostApplyCallback function is triggered when the user clicks the **Apply** or **OK** button after editing options in the Configuration Parameters dialog box. The PostApplyCallback function is called after the changes have been applied to the configuration set.

The following code installs a PostApplyCallback function:

```matlab
rtwgensettings.PostApplyCallback = 'my_postapply_callback_handler(hDlg,hSrc)';
```
The arguments to the `PostApplyCallback` function (hDlg, hSrc) are handles to private data used by the callback API functions.

- `rtwgensettings.BuildDirSuffix`: Most targets define a folder name suffix that identifies build folders created by the target. The build process appends the suffix defined in the `rtwgensettings.BuildDirSuffix` field to the model name to form the name of the build folder. For example, if you define `rtwgensettings.BuildDirSuffix` as follows:

  ```matlab
  rtwgensettings.BuildDirSuffix = '_mytarget_rtw'
  ```

  the build folders are named `model_mytarget_rtw`.

**Additional Code Generation Options**

“Configure Generated Code with TLC” on page 37-21 describes additional TLC code generation variables. End users of a target can assign these variables by entering a MATLAB command of the form

```matlab
set_param(modelName,'TLCOptions','-aVariable=val');
```

(For more information, see “Specify TLC for Code Generation” on page 27-24.)

However, the preferred approach is to assign these variables in the STF using statements of the form:

```matlab
%assign Variable = val
```

For readability, we recommend that you add such assignments in the section of the STF after the comment `Configure RTW code generation settings`.

**Model Reference Considerations**

See “Support Model Referencing” on page 39-84 for important information on STF and other modifications you may need to make to support the code generator model referencing features.

**Define and Display Custom Target Options**

- “Using `rtwoptions` to Display Custom Target Options” on page 39-37
- “Example System Target File With Customized `rtwoptions`” on page 39-42
- “Inheriting Target Options” on page 39-44
Using rtwoptions to Display Custom Target Options

You control the options to display in the **Code Generation** pane of the Configuration Parameters dialog box by customizing the `rtwoptions` structure in your system target file.

The fields of the `rtwoptions` structure define variables and associated user interface elements to be displayed in the Configuration Parameters dialog box. Using the `rtwoptions` structure array, you can define target-specific options displayed in the dialog box and organize options into categories. You can also write callback functions to specify how these options are processed.

When the **Code Generation** pane opens, the `rtwoptions` structure array is scanned and the listed options are displayed. Each option is represented by an assigned user interface element (check box, edit field, menu, or push button), which displays the current option value.

The user interface elements can be in an enabled or disabled (grayed-out) state. If an option is enabled, the user can change the option value.

You can also use the `rtwoptions` structure array to define special NonUI elements that cause callback functions to be executed, but that are not displayed in the **Code Generation** pane. See “NonUI Elements” on page 39-42 for details.

The elements of the `rtwoptions` structure array are organized into groups. Each group of items begins with a header element of type `Category`. The default field of a `Category` header must contain a count of the remaining elements in the category.

The `Category` header is followed by options to be displayed on the **Code Generation** pane. The header in each category is followed by one or more option definition elements.

Each category of target options corresponds to options listed under **Code Generation** in the Configuration Parameters dialog box.

The table `rtwoptions` Structure Fields Summary summarizes the fields of the `rtwoptions` structure.

**Example rtwoptions Structure**

The following `rtwoptions` structure is excerpted from an example system target file, `matlabroot/toolbox/rtw/rtwdemos/rtwoptions_demo/usertarget.tlc`. The code defines an `rtwoptions` structure array. The default field of the first (header) element is set to 4, indicating the number of elements that follow the header.
The first element adds a **userPreferred target options (I)** pane under **Code Generation** in the Configuration Parameters dialog box. The pane displays the options defined in `rtwoptions(2)`, `rtwoptions(3)`, `rtwoptions(4)`, and `rtwoptions(5)`. 

...
If you want to define a large number of options, you can define multiple Category groups within a single system target file.

Note the rtwoptions structure and callbacks are written in MATLAB code, although they are embedded in a TLC file. To verify the syntax of your rtwoptions structure definitions and code, you can execute the commands at the MATLAB prompt by copying and pasting them to the MATLAB Command Window.

To learn more about usertarget.tlc and the example callback files provided with it, see “Example System Target File With Customized rtwoptions” on page 39-42. For more examples of target-specific rtwoptions definitions, see the target.tlc files under matlabroot/rtw/c (open).
rtwoptions Structure Fields Summary lists the fields of the rtwoptions structure.
## rtwoptions Structure Fields Summary

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>callback</td>
<td>For examples of callback usage, see “Example System Target File With Customized rtwoptions” on page 39-42.</td>
</tr>
<tr>
<td>closecallback (obsolete)</td>
<td>Do not use closecallback. Use rtwgensettings.PostApplyCallback instead (see “rtwgensettings Structure” on page 39-34). closecallback is ignored.</td>
</tr>
<tr>
<td></td>
<td>For examples of callback usage, see “Example System Target File With Customized rtwoptions” on page 39-42.</td>
</tr>
<tr>
<td>default</td>
<td>Default value of the option (empty if the type is Pushbutton).</td>
</tr>
<tr>
<td>enable</td>
<td>Must be 'on' or 'off'. If 'on', the option is displayed as an enabled item; otherwise, as a disabled item.</td>
</tr>
<tr>
<td>makevariable</td>
<td>Template makefile token (if any) associated with the option. The makevariable is expanded during processing of the template makefile. See “Template Makefile Tokens” on page 39-62.</td>
</tr>
<tr>
<td>modelReferenceParameter-Check</td>
<td>Specifies whether the option must have the same value in a referenced model and its parent model. If this field is unspecified or has the value 'on' the option values must be same. If the field is specified and has the value 'off' the option values can differ. See “Controlling Configuration Option Value Agreement” on page 39-89.</td>
</tr>
<tr>
<td>NonUI</td>
<td>Element that is not displayed, but is used to invoke a close or open callback. See “NonUI Elements” on page 39-42.</td>
</tr>
<tr>
<td>opencallback (obsolete)</td>
<td>Do not use opencallback. Use rtwgensettings.SelectCallback instead (see “rtwgensettings Structure” on page 39-34).</td>
</tr>
<tr>
<td></td>
<td>For examples of callback usage, see “Example System Target File With Customized rtwoptions” on page 39-42.</td>
</tr>
</tbody>
</table>
### Field Name Description

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>popupstrings</td>
<td>If type is Popup, popupstrings defines the items in the menu. Items are delimited by the &quot;</td>
</tr>
<tr>
<td>prompt</td>
<td>Label for the option.</td>
</tr>
<tr>
<td>tlcvariable</td>
<td>Name of TLC variable associated with the option.</td>
</tr>
<tr>
<td>tooltip</td>
<td>Help text displayed when mouse is over the item.</td>
</tr>
<tr>
<td>type</td>
<td>Type of element: Checkbox, Edit, NonUI, Popup, Pushbutton, or Category.</td>
</tr>
</tbody>
</table>

### NonUI Elements

Elements of the rtwoptions array that have type NonUI exist solely to invoke callbacks. A NonUI element is not displayed in the Configuration Parameters dialog box. You can use a NonUI element if you want to execute a callback that is not associated with a user interface element, when the dialog box opens or closes. See the next section, “Example System Target File With Customized rtwoptions” on page 39-42 for an example.

### Note

The default value of an element of type NonUI or Edit determines the set of values allowed for that element.

- If the default value is '0' or '1':
  - For type NonUI, the element stores a Boolean value.
  - For type Edit, the element stores a value of type int32.
- If the default value contains an integer other than '0' or '1', the element stores a value of type int32.
- If the default value does not contain an integer, the element is evaluated as a character vector.

### Example System Target File With Customized rtwoptions

A working system target file, with MATLAB file callback functions, has been provided as an example of how to use the rtwoptions structure to display and process custom
options on the **Code Generation** pane. The examples are compatible with the callback API.

The example target files are in the folder (open):

```
matlabroot/toolbox/rtw/rtwdemos/rtwoptions_demo
```

The example target files include:

- **usertarget.tlc**: The example system target file. This file illustrates how to define custom menus, check boxes, and edit fields. The file also illustrates the use of callbacks.
- **usertargetcallback.m**: A MATLAB file callback invoked by a menu.

Refer to the example files while reading this section. The example system target file, **usertarget.tlc**: illustrates the use of rtwoptions to display the following custom target options:

- The **Execution Mode** menu.
- The **Log Execution Time** check box.
- The **Real-Time Interrupt Source** menu. The menu executes a callback defined in an external file, **usertargetcallback.m**. The TLC variable associated with the menu is passed in to the callback, which displays the menu's current value.
- The edit field **Signal Logging Buffer Size in Doubles**.

Try studying the example code while interacting with the example target options in the Configuration Parameters dialog box. To interact with the example target file,

1. Make `matlabroot/toolbox/rtw/rtwdemos/rtwoptions_demo` (open) your working folder.
2. Open a model of your choice.
3. Open the Configuration Parameters dialog box and select the **Code Generation** pane.
4. Click **Browse**. The System Target File Browser opens. Select **usertarget.tlc**. Then click **OK**.
5. Observe that the **Code Generation** pane contains a custom sub-tab: **userPreferred target options** (I).
6. As you interact with the options in this category and open and close the Configuration Parameters dialog box, observe the messages displayed in the MATLAB.
Command Window. These messages are printed from code in the STF, or from callbacks invoked from the STF.

**Inheriting Target Options**

`ert.tlc` provides a basic set of Embedded Coder code generation options. If your target is based on `ert.tlc`, your STF should normally inherit the options defined in ERT.

Use the `rtwgensettings.DerivedFrom` field in the `rtwgensettings` structure to define the system target file from which options are to be inherited. You should convert your custom target to use this mechanism as follows.

Set the `rtwgensettings.DerivedFrom` field value as in the following example:

```
rtwgensettings.DerivedFrom = 'stf.tlc';
```

where `stf` is the name of the system target file from which options are to be inherited. For example:

```
rtwgensettings.DerivedFrom = 'ert.tlc';
```

When the Configuration Parameters dialog box executes this line of code, it includes the options from `stf.tlc` automatically. If `stf.tlc` is a MathWorks internal system target file that has been converted to a new layout, the dialog box displays the inherited options using the new layout.

**Handling Unsupported Options**

If your target does not support all of the options inherited from `ert.tlc`, you should detect unsupported option settings and display a warning or error message. In some cases, if a user has selected an option your target does not support, you may need to abort the build process. For example, if your target does not support the **Generate an example main program** option, the build process should not be allowed to proceed if that option is selected.

Even though your target may not support all inherited ERT options, it is required that the ERT options are retained in the **Code Generation** pane of the Configuration Parameters dialog box. Do not simply remove unsupported options from the `rtwoptions` structure in the STF. Options must be in the dialog box to be scanned by the code generator when it performs optimizations.

For example, you may want to prevent users from turning off the **Single output/update function** option. It may seem reasonable to remove this option from the dialog box and
simply assign the TLC variable `CombineOutputUpdateFcns` to `on`. However, if the option is not included in the dialog box, the code generator assumes that output and update functions are *not* to be combined. Less efficient code is generated as a result.

**Tips and Techniques for Customizing Your STF**

- “Introduction” on page 39-45
- “Required and Recommended %includes” on page 39-45
- “Handling Aliases for Target Option Values” on page 39-46
- “Supporting Multiple Development Environments” on page 39-48

**Introduction**

The following sections include information on techniques for customizing your STF, including

- How to invoke custom TLC code from your STF
- Approaches to supporting multiple development environments

**Required and Recommended %includes**

If you need to implement target-specific code generation features, we recommend that your STF include the TLC file `mytarget_genfiles.tlc`.

Once your STF has set up the required TLC environment, you must include `codegenentry.tlc` to start the standard code generation process.

`mytarget_genfiles.tlc` provides a mechanism for executing custom TLC code after the main code generation entry point. See “Using `mytarget_genfiles.tlc`” on page 39-45.

**Using `mytarget_genfiles.tlc`**

`mytarget_genfiles.tlc` (optional) is useful as a central file from which to invoke target-specific TLC files that generate additional files as part of your target build process. For example, your target may create sub-makefiles or project files for a development environment, or command scripts for a debugger to do automatic downloads.

The build process can then invoke these generated files either directly from the make process, or after the executable is created. This is done with the `STF_make_rtw_hook.m` mechanism, as described in “Customize Build Process with `STF_make_rtw_hook.m` File” on page 37-50.
The following TLC code shows an example mytarget_genfiles.tlc file.

```tcl
%selectfile NULL_FILE
%assign ModelName = CompiledModel.Name
%
%% Create Debugger script
%assign model_script_file = "%<ModelName>.cfg"
%assign script_file = "debugger_script_template.tlc"

%if RTWVerbose
  %selectfile STDOUT
  ### Creating %<model_script_file>
  %selectfile NULL_FILE
%endif

%include "%<script_file>"
%openfile bld_file = "%<model_script_file>"
%<CreateDebuggerScript()>
%closefile bld_file
```

**Handling Aliases for Target Option Values**

This section describes utility functions that can be used to detect and resolve alias values or legacy values when testing user-specified values for the target device type (ProdHWDeviceType) and the code replacement library (CodeReplacementLibrary).

**RTW.isHWDeviceTypeEq**

To test if two target device type values represent the same hardware device, invoke the following function:

```tcl
result = RTW.isHWDeviceTypeEq(type1,type2)
```

where `type1` and `type2` are character vectors containing target device type values or aliases.

The `RTW.isHWDeviceTypeEq` function returns true if `type1` and `type2` are character vectors representing the same hardware device. For example, the following call returns true:

```tcl
RTW.isHWDeviceTypeEq('Specified','Generic->Custom')
```
For a description of the target device type option `ProdHWDeviceType`, see the command-line information for the **Hardware Implementation** pane parameters “Device vendor” (Simulink) and “Device type” (Simulink).

**RTW.resolveHWDeviceType**

To return the device type value for a hardware device, given a value that might be an alias or legacy value, invoke the following function:

```matlab
result = RTW.resolveHWDeviceType(type)
```

where `type` is a character vector containing a target device type value or alias.

The `RTW.resolveHWDeviceType` function returns the device type value of the device. For example, the following calls both return `'Generic->Custom'`:

```matlab
RTW.resolveHWDeviceType('Specified')
RTW.resolveHWDeviceType('Generic->Custom')
```

For a description of the target device type option `ProdHWDeviceType`, see the command-line information for the **Hardware Implementation** pane parameters “Device vendor” (Simulink) and “Device type” (Simulink).

**RTW.isTflEq**

To test if two code replacement library (CRL) names represent the same CRL, invoke the following function:

```matlab
result = RTW.isTflEq(name1, name2)
```

where `name1` and `name2` are character vectors containing CRL values or aliases.

The `RTW.isTflEq` function returns true if `name1` and `name2` are character vectors representing the same code replacement library. For example, the following call returns true:

```matlab
RTW.isTflEq('GNU','GNU C99 extensions')
```

For a description of the `CodeReplacementLibrary` parameter, see “Code replacement library”.

**RTW.resolveTflName**

To return the CRL value for a code replacement library, given a value that might be an alias or legacy value, invoke the following function:
result = RTW.resolveTflName(name)

where name is a character vector containing a CRL value or alias.

The RTW.resolveTflName function returns the value of the referenced code replacement library. For example, the following calls both return `'GNU C99 extensions'`:

RTW.resolveTflName('GNU')
RTW.resolveTflName('GNU C99 extensions')

For a description of the CodeReplacementLibrary parameter, see “Code replacement library”.

**Supporting Multiple Development Environments**

Your target may require support for multiple development environments (for example, two or more cross-compilers) or multiple modes of code generation (for example, generating a binary executable versus generating a project file for your compiler).

One approach to this requirement is to implement multiple STFs. Each STF invokes a template makefile for the development environment. This amounts to providing two separate targets.

**Create a Custom Target Configuration**

- “Introduction” on page 39-48
- “my_ert_target Overview” on page 39-49
- “Creating Target Folders” on page 39-51
- “Create ERT-Based, Toolchain Compliant STF” on page 39-52
- “Create ERT-Based TMF” on page 39-58
- “Create Test Model and S-Function” on page 39-58
- “Verify Target Operation” on page 39-59

**Introduction**

This tutorial can supplement the example target guides described in “Sample Custom Targets” on page 39-9. For an introduction and example files, try the example targets first.
This tutorial guided you through the process of creating an ERT-based target, my_ert_target. This exercise illustrates several tasks, which are typical for creating a custom target:

- Setting up target folders and modifying the MATLAB path.
- Making modifications to a standard STF and TMF such that the custom target is visible in the System Target File Browser, inherits ERT options, displays target-specific options, and generates code with the default host-based compiler.
- Testing the build process with the custom target, using a simple model that incorporates an inlined S-function.

During this exercise, you implement an operational, but skeletal, ERT-based target. This target can be useful as a starting point in a complete implementation of a custom embedded target.

**my_ert_target Overview**

In the following sections, you create a skeletal target, my_ert_target. The target inherits and supports the standard options of the ERT target and displays additional target-specific options in the Configuration Parameters dialog box (see “Target-Specific Options for my_ert_target” on page 39-50).
Target-Specific Options for my_ert_target

my_ert_target supports a toolchain-based build, generating code and executables that run on the host system. my_ert_target uses the lcc compiler on a Microsoft Windows platform. The chosen compiler is readily available and is distributed with the code generator. On a Microsoft Windows platform, if you use a different compiler, you can set up lcc temporarily as your default compiler through the following MATLAB command:

```
mex -setup
```

The software displays links for supported compilers that are installed on your computer. Click the lcc link.
**Note** On Linux systems, make sure that you have an installed C compiler. If so, you can use Linux folder syntax to complete this exercise.

`my_ert_target` can also support template makefile-based builds. For more information about using this target with the template makefile approach, see “Create ERT-Based TMF” on page 39-58.

You can test `my_ert_target` with a model that is compatible with the ERT target (see “Configure a System Target File” (Embedded Coder)). Generated programs operate identically to ERT generated programs.

To simplify the testing of your target, test with `targetmodel`, a very simple fixed-step model (see “Create Test Model and S-Function” on page 39-58). The S-Function block in `targetmodel` uses the source code from the `timestwo` example, and generates fully inlined code. See “S-Function Examples” (Simulink) and “Inline S-Functions with TLC” for further discussion of the `timestwo` example S-function.

**Creating Target Folders**

Create folders to store the target files and add them to the MATLAB path, following the recommended conventions (see “Folder and File Naming Conventions” on page 39-11). You also create a folder to store the test model, S-function, and generated code.

This example assumes that your target and model folders are located within the folder `c:/work`. Do not place your target and model folders within the MATLAB folder tree (that is, in or under the `matlabroot` folder).

To create the folders and make them accessible:

1. Create a target root folder, `my_ert_target`. From the MATLAB Command Window on a Windows platform, enter:
   ```
   cd c:/work
   mkdir my_ert_target
   ```

2. Within the target root folder, create a subfolder to store your target files.
   ```
   mkdir my_ert_target/my_ert_target
   ```

3. Add these folders to your MATLAB path.
   ```
   addpath c:/work/my_ert_target
   addpath c:/work/my_ert_target/my_ert_target
   ```

4. Create a folder, `my_targetmodel`, to store the test model, S-function, and generated code.
mkdir my_targetmodel

Create ERT-Based, Toolchain Compliant STF

Create an STF for your target by copying and modifying the standard STF for the ERT target. Then, validate the STF by viewing the new target in the System Target File Browser and in the Configuration Parameters dialog box.

Editing the STF

To edit the STF, use these steps:

1. Change your working folder to the folder you created in “Creating Target Folders” on page 39-51.
   
   ```
   cd c:/work/my_ert_target/my_ert_target
   ```

2. Place a copy of `matlabroot/rtw/c/ert/ert.tlc` in `c:/work/my_ert_target/my_ert_target` and rename it to `my_ert_target.tlc`. The file `ert.tlc` is the STF for the ERT target.

3. Open `my_ert_target.tlc` in a text editor of your choice.

4. Customize the STF, replacing the header comment lines with directives that make your STF visible in the System Target File Browser and define the associated TMF, make command, and external mode interface file (if any). For more information about these directives, see “Header Comments” on page 39-30.

Replace the header comments in `my_ert_target.tlc` with the following header comments.

```
%% SYSTLC: My ERT-based Target TMF: my_ert_target_lcc.tmf MAKE: make_rtw \
%% EXTMODE: no_ext_comm
```

5. The file `my_ert_target.tlc` inherits the standard ERT options, using the mechanism described in “Inheriting Target Options” on page 39-44. Therefore, the existing `rtwoptions` structure definition is superfluous. Edit the `RTW_OPTIONS` section such that it includes only the following code.

```
/%
  BEGIN_RTW_OPTIONS

  rtwgensettings.BuildDirSuffix = '_ert_rtw';

END_RTW_OPTIONS
/%
```
Delete the code after the end of the RTW_OPTIONS section, which is delimited by the directives BEGIN_CONFIGSET_TARGET_COMPONENT and END_CONFIGSET_TARGET_COMPONENT. This code is for use only by internal MathWorks developers.

Modify the build folder suffix in the rtwgenSettings structure in accordance with the conventions described in “rtwgensettings Structure” on page 39-34. To set the suffix to a character vector for the _my_ert_target custom target, change the line

```matlab
rtwgensettings.BuildDirSuffix = '_ert_rtw'
```

to

```matlab
rtwgensettings.BuildDirSuffix = '_my_ert_target_rtw'
```

Modify the rtwgenSettings structure to inherit options from the ERT target and declare Release 14 or later compatibility as described in “rtwgensettings Structure” on page 39-34. Add the following code to the rtwgenSettings definition:

```matlab
rtwgensettings.DerivedFrom = 'ert.tlc';
rtwgensettings.Version = '1';
```

Add an rtwoptions structure that defines a target-specific options category with three check boxes just after the BEGIN_RTW_OPTIONS directive. The following code shows the complete RTW_OPTIONS section, including the previous rtwgenSettings changes.

```matlab
/perl

\% BEGIN_RTW_OPTIONS
rtwoptions(1).prompt = 'My Target Options';
rtwoptions(1).type = 'Category';
rtwoptions(1).enable = 'on';
rtwoptions(1).default = 3; % number of items under this category
rtwoptions(1).popupstrings = '';
rtwoptions(1).tlcvariable = '';
rtwoptions(1).tooltip = '';
rtwoptions(1).callback = '';
rtwoptions(1).makevariable = '';
rtwoptions(2).prompt = 'Demo option 1';
rtwoptions(2).type = 'Checkbox';
rtwoptions(2).default = 'off';
rtwoptions(2).tlcvariable = 'DummyOpt1';
rtwoptions(2).makevariable = '';
rtwoptions(2).tooltip = ['Demo option1 (non-functional)'];
rtwoptions(2).callback = '';
```

% Customize System Target Files

39-53
rtwoptions(3).prompt         = 'Demo option 2';
rtwoptions(3).type           = 'Checkbox';
rtwoptions(3).default        = 'off';
rtwoptions(3).tlcvariable    = 'DummyOpt2';
rtwoptions(3).makevariable   = '';
rtwoptions(3).tooltip        = ['Demo option2 (non-functional)'];
rtwoptions(3).callback       = '';

rtwoptions(4).prompt         = 'Demo option 3';
rtwoptions(4).type           = 'Checkbox';
rtwoptions(4).default        = 'off';
rtwoptions(4).tlcvariable    = 'DummyOpt3';
rtwoptions(4).makevariable   = '';
rtwoptions(4).tooltip        = ['Demo option3 (non-functional)'];
rtwoptions(4).callback       = '';

%----------------------------------------%
% Configure RTW code generation settings %
%----------------------------------------%

rtwgensettings.BuildDirSuffix = '_my_ert_target_rtw';
rtwgensettings.DerivedFrom    = 'ert.tlc';
rtwgensettings.Version        = '1';
rtwgensettings.SelectCallback = 'enableToolchainCompliant(hSrc, hDlg)';
%SelectCallback provides toolchain approach support, but requires custom function
%Omit this SelectCallback if using the template makefile approach

END_RTW_OPTIONS
%/  

10  Save your changes to my_ert_target.tlc and close the file.

Create ToolchainCompliant Function

To enable builds using the toolchain approach, you create a function that corresponds to
the SelectCallback near the end of the custom STF. This function sets properties for
toolchain compliance.

function enableToolchainCompliant(hSrc, hDlg)
    hCS = hSrc.getConfigSet();

    % The following parameters enable toolchain compliance.
    slConfigUISetVal(hDlg, hSrc, 'UseToolchainInfoCompliant', 'on');
    hCS.setProp('GenerateMakefile','on');

    % The following parameters are not required for toolchain compliance.
    % But, it is recommended practice to set these default values and
    % disable the parameters (as shown).
    hCS.setProp('RTWCompilerOptimization','off');
    hCS.setProp('MakeCommand','make_rtw');
    hCS.setPropEnabled('RTWCompilerOptimization',false);
    hCS.setPropEnabled('MakeCommand',false);
end
Note If you are using the template makefile approach, omit calling the function enabling toolchain-compliance from your STF file. Instead, use the information in “Create ERT-Based TMF” on page 39-58.

Viewing the STF

At this point, you can verify that the target inherits and displays ERT options as follows:

1. Create a new model.
2. Open the Model Explorer or the Configuration Parameters dialog box.
3. Select the Code Generation pane.
4. Click Browse to open the System Target File browser.
5. In the file browser, scroll through the list of targets to find the new target, my_ert_target.tlc. (This step assumes that your MATLAB path contains c:/work/my_ert_target/my_ert_target, as previously set in “Creating Target Folders” on page 39-51.)
6. Select My ERT-based Target and click OK.

7. The Code Generation pane now shows that the model is configured for the my_ert_target.tlc target. The System target file, Language, Toolchain, and Build configuration fields should appear:
Select the **My Target Options** pane. The target displays the three check box options defined in the `rtwoptions` structure.
9  Select the **Code Generation** pane and reopen the System Target File Browser.

10 Select the Embedded Coder target (*ert.tlc*). The target displays the standard ERT options.

11 Close the model. You do not need to save it.

The STF for the skeletal target is complete. If you are using the toolchain approach, you are ready to invoke the build process for your target.

If you prefer to use the template makefile approach, the reference to a TMF, *my_ert_target_lcc.tmf*, in the STF header comments prevents you from invoking the build process for your target until the TMF file is in place. First, you must create a *my_ert_target_lcc.tmf* file.
Create ERT-Based TMF

If you are using the toolchain makefile approach with a toolchain compliant custom target, omit the steps that apply to the template makefile approach. (Skip this section.)

If you are using the templated makefile approach, follow the steps applying to TMF and omit calling the function enabling toolchain-compliance from your STF file, which is described in “Create ERT-Based, Toolchain Compliant STF” on page 39-52.

Create a TMF for your target by copying and modifying the standard ERT TMF for the LCC compiler:

1. Make sure that your working folder is still set to the target file folder you created previously in “Creating Target Folders” on page 39-51.

   c:/work/my_ert_target/my_ert_target

2. Place a copy of \texttt{matlabroot/rtw/c/ert/ert\_lcc.tmf} in \texttt{c:/work/my_ert_target/my_ert_target} and rename it \texttt{my\_ert\_target\_lcc.tmf}. The file \texttt{ert\_lcc.tmf} is the ERT compiler-specific template makefile for the LCC compiler.

3. Open \texttt{my\_ert\_target\_lcc.tmf} in a text editor.

4. Change the \texttt{SYS\_TARGET\_FILE} parameter so that the file reference for your .tlc file is generated in the make file. Change the line

   \begin{verbatim}
   SYS\_TARGET\_FILE = any
   \end{verbatim}

   to

   \begin{verbatim}
   SYS\_TARGET\_FILE = my\_ert\_target.tlc
   \end{verbatim}

5. Save changes to \texttt{my\_ert\_target\_lcc.tmf} and close the file.

Your target can now generate code and build a host-based executable. In the next sections, you create a test model and test the build process using \texttt{my\_ert\_target}.

Create Test Model and S-Function

In this section, you build a simple test model for later use in code generation:

1. Set your working folder to \texttt{c:/work/my\_targetmodel}.

   \begin{verbatim}
   cd c:/work/my\_targetmodel
   \end{verbatim}

   For the remainder of this tutorial, \texttt{my\_targetmodel} is assumed to be the working folder. Your target writes the output files of the code generation process into a build
folder within the working folder. When inlined code is generated for the \texttt{timestwo} S-function, the build process looks for the TLC implementation of the S-function in the working folder.

2. Copy the following C and TLC files for the \texttt{timestwo} S-function to your working folder:

   - \texttt{matlabroot/toolbox/simulink/simdemos/simfeatures/src/timestwo.c}
   - \texttt{matlabroot/toolbox/simulink/simdemos/simfeatures/tlc_c/timestwo.tlc}

3. Build the \texttt{timestwo} MEX-file in \texttt{c:/work/my_targetmodel}.

   \texttt{mex timestwo.c}

4. Create the following model, using an S-Function block from the Simulink User-Defined Functions library. Save the model in your working folder as \texttt{targetmodel}.

   ![Diagram](image)

5. Double-click the S-Function block to open the Block Parameters dialog box. Enter the S-function name \texttt{timestwo}. Click \texttt{OK}. The block is now bound to the \texttt{timestwo} MEX-file.

6. Open Model Explorer or the Configuration Parameters dialog box and select the Solv...}

7. Set the solver Type to fixed-step and click \texttt{Apply}.

8. Save the model.

9. Open the scope and run a simulation. Verify that the \texttt{timestwo} S-function multiplies its input by 2.0.

Keep the \texttt{targetmodel} model open for use in the next section, in which you generate code using the test model.

\textbf{Verify Target Operation}

In this section you configure \texttt{targetmodel} for the \texttt{my_ert_target} custom target, and use the target to generate code and build an executable:
Open the Configuration Parameters dialog box and select the Code Generation pane.

Click Browse to open the System Target File Browser.

In the Browser, select My ERT-based Target and click OK.

The Configuration Parameters dialog box now displays the Code Generation pane for my_ert_target.

Select the Code Generation > Report pane and select the Create code generation report option.

Click Apply and save the model. The model is configured for my_ert_target.

Build the model. If the build succeeds, the MATLAB Command Window displays the message below.

```plaintext
### Created executable: ../targetmodel.exe
### Successful completion of build procedure for model: targetmodel
```

Your working folder contains the targetmodel.exe file and the build folder, targetmodel_my_ert_target_rtw, which contains generated code and other files. The working folder also contains an slprj folder, used internally by the build process.

The code generator also creates and displays a code generation report.

To view the generated model code, go to the code generation report window. In the Contents pane, click the targetmodel.c link.

In targetmodel.c, locate the model step function, targetmodel_step. Observe the following code.

```c
/* S-Function Block: <Root>/S-Function */
/* Multiply input by two */
targetmodel_B.SFunction = targetmodel_B.SineWave * 2.0;
```

The presence of this code confirms that the my_ert_target custom target has generated an inlined output computation for the S-Function block in the model.

See Also

More About

- “About Embedded Target Development” on page 39-2
• “Support Toolchain Approach with Custom Target” on page 39-82
• “Support Model Referencing” on page 39-84
• “Support Compiler Optimization Level Control” on page 39-96
• “Support C Function Prototype Control” on page 39-98
• “Support C++ Class Interface Control” on page 39-100
• “Support Concurrent Execution of Multiple Tasks” on page 39-102
Customize Template Makefiles

To configure or customize a template makefile (TMF), you should be familiar with how the `make` command works and how it processes makefiles. You should also understand makefile build rules. For information on these topics, refer to the documentation provided with the make utility you use.

Template Makefiles and Tokens

TMFs are made up of statements containing tokens. The build process expands tokens and creates a makefile, `model.mk`. TMFs are designed to generate makefiles for specific compilers on specific platforms. The generated `model.mk` file is tailored to compile and link code generated from your model, using commands specific to your development system.

Creation of `model.mk`

Template Makefile Tokens

The `make_rtw` command (or a different command provided with some targets) directs the process of generating `model.mk`. The `make_rtw` command processes the TMF specified on the Code Generation pane of the Configuration Parameters dialog box. `make_rtw` copies the TMF, line by line, expanding each token encountered. Template Makefile Tokens Expanded by `make_rtw` lists the tokens and their expansions.

These tokens are used in several ways by the expanded makefile:

- To control the conditional behavior in the makefile. The conditionals are used to control the source file lists, library names, target to be built, and other build-related information.
• To provide the macro definitions for compiling the files, for example, -DINTEGER_CODE=1.
## Template Makefile Tokens Expanded by make_rtw

<table>
<thead>
<tr>
<th>Token</th>
<th>Expansion</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General purpose</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>&gt;ADDITIONAL_LDFLAGS&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;ALT_MATLAB_BIN&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;ALT_MATLAB_ROOT&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;BUILDDARGS&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;COMBINE_OUTPUT_UPDATE_FCNS&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;COMPUTER&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;EXPAND_LIBRARY_LOCATION&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;EXPAND_LIBRARY_NAME&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;EXPAND_LIBRARY_SUFFIX&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;EXT_MODE&lt;</td>
</tr>
<tr>
<td><strong>Token</strong></td>
<td><strong>Expansion</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>`</td>
<td>&gt;EXTMODE_TRANSPORT&lt;</td>
</tr>
<tr>
<td>`</td>
<td>&gt;EXTMODE_STATIC&lt;</td>
</tr>
<tr>
<td>`</td>
<td>&gt;EXTMODE_STATIC_SIZE&lt;</td>
</tr>
<tr>
<td>`</td>
<td>&gt;GENERATE_ERT_S_FUNCTION&lt;</td>
</tr>
<tr>
<td>`</td>
<td>&gt;INCLUDE_MDL_TERMINATE_FCN&lt;</td>
</tr>
<tr>
<td>`</td>
<td>&gt;INTEGER_CODE&lt;</td>
</tr>
<tr>
<td>`</td>
<td>MAKEFILE_NAME&lt;</td>
</tr>
<tr>
<td>`</td>
<td>MAT_FILE&lt;</td>
</tr>
<tr>
<td>`</td>
<td>MATLAB_BIN&lt;</td>
</tr>
<tr>
<td>`</td>
<td>MATLAB_ROOT&lt;</td>
</tr>
<tr>
<td>`</td>
<td>MEM_ALLOC&lt;</td>
</tr>
<tr>
<td>Token</td>
<td>Expansion</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
</tr>
<tr>
<td>\texttt{\textgreater MEXEXT\textless}</td>
<td>MEX-file extension. See the MATLAB \texttt{mexext} command.</td>
</tr>
<tr>
<td>\texttt{\textgreater MODEL_MODULES\textless}</td>
<td>Additional generated source modules. For example, you can split a large model into two files, \texttt{model.c} and \texttt{model1.c}. In this case, this token expands to \texttt{model1.c}.</td>
</tr>
<tr>
<td>\texttt{\textgreater MODEL_MODULES_OBJ\textless}</td>
<td>Object filenames (\texttt{.obj}) corresponding to additional generated source modules.</td>
</tr>
<tr>
<td>\texttt{\textgreater MODEL_NAME\textless}</td>
<td>Name of the Simulink block diagram currently being built.</td>
</tr>
<tr>
<td>\texttt{\textgreater MULTITASKING\textless}</td>
<td>True (1) if solver mode is multitasking, otherwise False (0).</td>
</tr>
<tr>
<td>\texttt{\textgreater NCSTATES\textless}</td>
<td>Number of continuous states.</td>
</tr>
<tr>
<td>\texttt{\textgreater NUMST\textless}</td>
<td>Number of sample times in the model.</td>
</tr>
<tr>
<td>\texttt{\textgreater RELEASE_VERSION\textless}</td>
<td>The MATLAB release version.</td>
</tr>
<tr>
<td>\texttt{\textgreater S_FUNCTIONS\textless}</td>
<td>List of noninlined S-function sources.</td>
</tr>
<tr>
<td>\texttt{\textgreater S_FUNCTIONS_LIB\textless}</td>
<td>List of S-function libraries available for linking.</td>
</tr>
<tr>
<td>\texttt{\textgreater S_FUNCTIONS_OBJ\textless}</td>
<td>Object (\texttt{.obj}) file list corresponding to noninlined S-function sources.</td>
</tr>
<tr>
<td>\texttt{\textgreater SOLVER\textless}</td>
<td>Solver source filename, for example, \texttt{ode3.c}.</td>
</tr>
<tr>
<td>\texttt{\textgreater SOLVER_OBJ\textless}</td>
<td>Solver object (\texttt{.obj}) filename, for example, \texttt{ode3.obj}.</td>
</tr>
<tr>
<td>\texttt{\textgreater TARGET_LANG_EXT\textless}</td>
<td>\texttt{c} when the \texttt{Language} selection is C, \texttt{cpp} when the \texttt{Language} selection is C++. Used in the makefile to control the extension on generated source files.</td>
</tr>
<tr>
<td>Token</td>
<td>Expansion</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>&gt;TGT_FCN_LIB&lt;</td>
</tr>
<tr>
<td>Value</td>
<td>Generates Calls To</td>
</tr>
<tr>
<td>Name of custom CRL</td>
<td>ISO®/IEC 9899:1990 C (ANSI_C) standard math library</td>
</tr>
<tr>
<td>GNU</td>
<td>GNU extensions to the ISO/IEC 9899:1999 C standard math library</td>
</tr>
<tr>
<td></td>
<td>&gt;TID01EQ&lt;</td>
</tr>
</tbody>
</table>

**S-function and build information support**

**Note** For examples of the tokens in this section, see “Modify the Template Makefile for rtwmakecfg” on page 37-29.

<table>
<thead>
<tr>
<th>Token</th>
<th>Expansion</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&gt;START_EXPAND_INCLUDES&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;EXPAND_DIR_NAME&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;END_EXPAND_INCLUDES&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;START_EXPAND_LIBRARIES&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;EXPAND_LIBRARY_NAME&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;END_EXPAND_LIBRARIES&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;START_EXPAND_MODULES&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;EXPAND_MODULE_NAME&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;END_EXPAND_MODULES&lt;</td>
</tr>
<tr>
<td>Token</td>
<td>Expansion</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
</tr>
<tr>
<td></td>
<td>&gt;START_EXPAND_RULES&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;EXPAND_DIR_NAME&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;END_EXPAND_RULES&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;START_PRECOMP_LIBRARIES&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;EXPAND_LIBRARY_NAME&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;END_PRECOMP_LIBRARIES&lt;</td>
</tr>
</tbody>
</table>

**Model reference support**

**Note** For examples of the tokens in this section, see “Providing Model Referencing Support in the TMF” on page 39-85.

<table>
<thead>
<tr>
<th>Token</th>
<th>Expansion</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&gt;MASTER_ANCHOR_DIR&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;MODELLIB&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;MODELREFS&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;MODELREF_LINK_LIBS&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;MODELREF_LINK_RSPFILE_NAME&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;MODELREF_TARGET_TYPE&lt;</td>
</tr>
<tr>
<td></td>
<td>• NONE: Standalone model or top model referencing other models</td>
</tr>
<tr>
<td></td>
<td>• RTW: Model reference target build</td>
</tr>
<tr>
<td></td>
<td>• SIM: Model reference simulation target build</td>
</tr>
<tr>
<td></td>
<td>&gt;RELATIVE_PATH_TO_ANCHOR&lt;</td>
</tr>
<tr>
<td></td>
<td>&gt;START_DIR&lt;</td>
</tr>
<tr>
<td>Token</td>
<td>Expansion</td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
</tr>
<tr>
<td>&gt;START_MDLREFINC_EXPAND_INCLUDES&lt;</td>
<td>List of include paths for models referenced by the top model.</td>
</tr>
<tr>
<td>&gt;MODELREF_INC_PATH&lt;</td>
<td></td>
</tr>
<tr>
<td>&gt;END_MDLREFINC_EXPAND_INCLUDES&lt;</td>
<td></td>
</tr>
<tr>
<td>&gt;SHARED_BIN_DIR&lt;</td>
<td>Folder for the library file built from the shared source files.</td>
</tr>
<tr>
<td>&gt;SHARED_LIB&lt;</td>
<td>Library file built from the shared source files, including the path to the library folder.</td>
</tr>
<tr>
<td>&gt;SHARED_SRC&lt;</td>
<td>Shared source files specification, including the path to the shared utilities folder.</td>
</tr>
<tr>
<td>&gt;SHARED_SRC_DIR&lt;</td>
<td>Folder for shared source files.</td>
</tr>
</tbody>
</table>

These tokens are expanded by substitution of parameter values known to the build process. For example, if the source model contains blocks with two different sample times, the TMF statement

NUMST = \>NUMST< |

expands to the following in model.mk.

NUMST = 2

In addition to the above, make_rtw expands tokens from other sources:

- Target-specific tokens defined in the target options of the Configuration Parameters dialog box
- Structures in the rtwoptions section of the system target file. Structures in the rtwoptions structure array that contain the field makevariable are expanded.

The following example is extracted from matlabroot/rtw/c/grt/grt.tlc. The section starting with BEGIN_RTW_OPTIONS contains MATLAB code that sets up rtwoptions. The following directive causes the \>EXT_MODE< | token to be expanded to 1 (on) or 0 (off), depending on how you set the external mode options.

rtwoptions(2).makevariable = 'EXT_MODE'
Invoke the make Utility

- “make Command” on page 39-70
- “make Utility Versions” on page 39-70

make Command

After creating model.mk from your TMF, the build process invokes a make command. To invoke make, the build process issues this command.

makecommand -f model.mk

makecommand is defined by the MAKECMD macro in your target's TMF (see “Structure of the Template Makefile” on page 39-71). You can specify additional options to make in the Make command field of the Code Generation pane. (See the sections “Specify a Make Command” on page 27-22 and “Template Makefiles and Make Options” on page 27-26.)

For example, specifying OPT_OPTS=-O2 in the Make command field causes make_rtw to generate the following make command.

makecommand -f model.mk OPT_OPTS=-O2

A comment at the top of the TMF specifies the available make command options. If these options do not provide you with enough flexibility, you can configure your own TMF.

make Utility Versions

The make utility lets you control nearly every aspect of building your real-time program. There are several different versions of make available. The code generator provides the Free Software Foundation GNU make for both UNIX5 and PC platforms in platform-specific subfolders under

matlabroot/bin

It is possible to use other versions of make with the code generator, although GNU Make is recommended. To be compatible with the code generator, verify that your version of make supports the following command format.

makecommand -f model.mk

5. UNIX is a registered trademark of The Open Group in the United States and other countries.
Structure of the Template Makefile

A TMF has multiple sections, including the following:

- **Abstract** — Describes what the makefile targets. Here is a representative abstract from the GRT TMFs in `matlabroot/rtw/c/grt` (open):

```
# File    : grt_lcc.tmf
#
# Abstract:
#   Template makefile for building a PC-based stand-alone generic real-time
#   version of Simulink model using generated C code and LCC compiler
#   Version 2.4.
#
# This makefile attempts to conform to the guidelines specified in the
# IEEE Std 1003.2-1992 (POSIX) standard. It is designed to be used
# with GNU Make (gmake) which is located in matlabroot/bin/win32.
#
# Note that this template is automatically customized by the build
# procedure to create "<model>.mk"
#
# The following defines can be used to modify the behavior of the
# build:
#   OPT_OPTS - Optimization options. Default is none. To enable
#               debugging specify as OPT_OPTS=-g4.
#   OPTS - User specific compile options.
#   USER_SRCS - Additional user sources, such as files needed by
#               S-functions.
#   USER_INCLUDES - Additional include paths
#                  (i.e. USER_INCLUDES="-Iwhere-ever -Iwhere-ever2")
#                  (For Lcc, have a '/' as file seperator before the
#                  file name instead of a '\'.
#                  i.e., d:\work\proj1/myfile.c - reqd for 'gmake')
#
# This template makefile is designed to be used with a system target
# file that contains 'rtwsettings.BuildDirSuffix'. See grt.tlc.
```

- **Macros read by make_rtw section** — Defines macros that tell `make_rtw` how to process the TMF. Here is a representative macro read by `make_rtw` section from the GRT TMFs in `matlabroot/rtw/c/grt` (open):

```
# --- Macros read by make_rtw ---
#
# The following macros are read by the build procedure:
#
# MAKECMD - The command that invokes the make utility
# HOST - The platform (for example, PC) for which this TMF is written
# SHELL - An operating system shell command
# (for example, cmd) for the platform
# BUILD - The flag that indicates whether to invoke make from the build procedure
```
# SYS_TARGET_FILE - Name of system target file.

MAKECMD = "%MATLAB\bin\win32\gmake"
HOST = PC
SHELL = cmd
BUILD = yes
SYS_TARGET_FILE = grt.tlc
BUILD_SUCCESS = ### Created
COMPILER_TOOLCHAIN = lcc

MAKEFILE_FILESEP = /

The macros in this section might include:

- **MAKECMD** — Specifies the command used to invoke the make utility. For example, if MAKECMD = mymake, then the make command invoked is
  
  `mymake -f model.mk`

- **HOST** — Specifies the platform targeted by this TMF. This can be PC, UNIX, `computer_name` (see the MATLAB `computer` command), or ANY.

- **SHELL** — Specifies an operating system shell command for the platform. For Windows, this can be cmd.

- **BUILD** — Instructs make_rtw whether or not it should invoke make from the build procedure. Specify yes or no.

- **SYS_TARGET_FILE** — Specifies the name of the system target file or the value any. This is used for consistency checking by make_rtw to verify the system target file specified in the Target selection panel of the Code Generation pane of the Configuration Parameters dialog box. If you specify any, you can use the TMF with any system target file.

- **BUILD_SUCCESS** — Optional macro that specifies the build success message to be displayed for make completion on the PC. For example,

  `BUILD_SUCCESS = ### Successful creation of
  
  The BUILD_SUCCESS macro, if used, replaces the standard build success message found in the TMFs distributed with the bundled code generator targets (such as GRT):

  `@echo ### Created executable $(MODEL).exe`

Your TMF must include either the standard build success message, or use the BUILD_SUCCESS macro. For an example of the use of BUILD_SUCCESS, see `matlabroot/rtw/c/grt/grt_lcc.tmf` or the code example above this list of macros.
• **BUILD_ERROR** — Optional macro that specifies the build error message to be displayed when an error is encountered during the make procedure. For example,

```
BUILD_ERROR = ['Error while building ', modelName]
```

• **VERBOSE_BUILD_OFF_TREATMENT = PRINT_OUTPUT_ALWAYS** — Optional macro to include if you want the makefile output to be displayed regardless of the setting of the **Verbose build** option in the **Code Generation > Debug** pane.

• **COMPILER_TOOL_CHAIN** — For builds on Windows systems, specifies which compiler setup file — located in `matlabroot/toolbox/rtw/rtw` (open) — to use:

  - `lcc` selects `setup_for_lcc.m`
  - `vc` selects `setup_for_visual.m`
  - `vcx64` selects `setup_for_visual_x64.m`
  - `default` selects `setup_for_default.m`

For builds on UNIX systems, specify `unix`. Other values are flagged as unknown and `make_rtw` uses `setup_for_default.m`.

*Note* Do not omit **COMPILER_TOOL_CHAIN** or leave it unspecified in your TMF. If your compiler is not the host compiler, specify **COMPILER_TOOL_CHAIN = default**.

• **DOWNLOAD** — An optional macro that you can specify as yes or no. If specified as yes (and **BUILD**=yes), then `make` is invoked a second time with the download target.

```
make -f model.mk download
```

• **DOWNLOAD_SUCCESS** — An optional macro that you can use to specify the download success message to be used when looking for a completed download. For example,

```
DOWNLOAD_SUCCESS = ### Downloaded
```

• **DOWNLOAD_ERROR** — An optional macro that you can use to specify the download error message to be displayed when an error is encountered during the download. For example,

```
DOWNLOAD_ERROR = ['Error while downloading ', modelName]
```
• **Tokens expanded by make_rtw section** — Defines the tokens that make_rtw expands. Here is a brief excerpt from a representative Tokens expanded by make_rtw section from the GRT TMFs in `matlabroot/rtw/c/grt` (open):

```plaintext
#---------------------- Tokens expanded by make_rtw ----------------------------
# The following tokens, when wrapped with "|>" and "<|" are expanded by the
# build procedure.
#
#  MODEL_NAME          - Name of the Simulink block diagram
#  MODEL_MODULES       - Any additional generated source modules
#  MAKEFILE_NAME       - Name of makefile created from template makefile <model>.mk
#  MATLAB_ROOT         - Path to where MATLAB is installed.
...

MODEL = |>MODEL_NAME<|
MODULES = |>MODEL_MODULES<|
MAKEFILE = |>MAKEFILE_NAME<|
MATLAB_ROOT = |>MATLAB_ROOT<|
...
```

For more information about TMF tokens, see Template Makefile Tokens Expanded by make_rtw.

• Subsequent sections vary based on compiler, host, and target. Some common sections include Model and reference models, External mode, Tool Specifications or Tool Definitions, Include Path, C Flags, Additional Libraries, and Source Files.

• **Rules section** — Contains the make rules used in building an executable from the generated source code. The build rules are typically specific to your version of make. The Rules section might be followed by related sections such as Dependencies.

### Customize and Create Template Makefiles

- “Introduction” on page 39-75
- “Setting Up a Template Makefile” on page 39-75
- “Using Macros and Pattern Matching Expressions in a Template Makefile” on page 39-75
- “Customizing Generated Makefiles with rtwmakecfg” on page 39-77
- “Supporting Continuous Time in Custom Targets” on page 39-78
- “Model Reference Considerations” on page 39-79
**Introduction**

This section describes the mechanics of setting up a custom template makefile (TMF) and incorporating it into the build process. It also discusses techniques for modifying a TMF and MATLAB file mechanisms associated with the TMF.

Before creating a custom TMF, you should read “Folder and File Naming Conventions” on page 39-11 to understand the folder structure and MATLAB path requirements for custom targets.

**Setting Up a Template Makefile**

To customize or create a new TMF, you should copy an existing GRT or ERT TMF from one of the following locations:

- \texttt{matlabroot/rtw/c/grt} (open)
- \texttt{matlabroot/rtw/c/ert} (open)

Place the copy in the same folder as the associated system target file (STF). Usually, this is the \texttt{mytarget/mytarget} folder within the target folder structure. Then, rename your TMF (for example, \texttt{mytarget.tmf}) and modify it.

To allow the build process to locate and select your TMF, you must provide information in the STF file header (see “System Target File Structure” on page 39-29). For a target that implements a single TMF, the standard way to specify the TMF to be used in the build process is to use the TMF directive of the STF file header.

\texttt{TMF: mytarget.tmf}

**Using Macros and Pattern Matching Expressions in a Template Makefile**

This section shows, through an example, how to use macros and file-pattern-matching expressions in a TMF to generate commands in the \texttt{model.mk} file.

The make utility processes the \texttt{model.mk} makefile and generates a set of commands based upon dependency rules defined in \texttt{model.mk}. After \texttt{make} generates the set of commands for building or rebuilding \texttt{test}, \texttt{make} executes them.

For example, to build a program called \texttt{test}, \texttt{make} must link the object files. However, if the object files don't exist or are out of date, \texttt{make} must compile the source code. Thus there is a dependency between source and object files.
Each version of `make` differs slightly in its features and how rules are defined. For example, consider a program called `test` that gets created from two sources, `file1.c` and `file2.c`. Using most versions of `make`, the dependency rules would be

```bash
test: file1.o file2.o
    cc -o test file1.o file2.o

file1.o: file1.c
    cc -c file1.c

file2.o: file2.c
    cc -c file2.c
```

In this example, a UNIX⁶ environment is assumed. In a PC environment the file extensions and compile and link commands are different.

In processing the first rule

```bash
test: file1.o file2.o
```

`make` sees that to build `test`, it needs to build `file1.o` and `file2.o`. To build `file1.o`, `make` processes the rule

```bash
file1.o: file1.c
    cc -c file1.c
```

If `file1.o` doesn't exist, or if `file1.o` is older than `file1.c`, `make` compiles `file1.c`.

The format of TMFs follows the above example. Our TMFs use additional features of `make` such as macros and file-pattern-matching expressions. In most versions of `make`, a macro is defined with

```
MACRO_NAME = value
```

References to macros are made with `$(MACRO_NAME)`. When `make` sees this form of expression, it substitutes `value` for `$(MACRO_NAME)`.

You can use pattern matching expressions to make the dependency rules more general. For example, using GNU⁷ Make, you could replace the two “`file1.o: file1.c`” and “`file2.o: file2.c`” rules with the single rule

```
%.o : %.c
    cc -c $<
```

---

⁶ UNIX is a registered trademark of The Open Group in the United States and other countries.
⁷ GNU is a registered trademark of the Free Software Foundation.
Note that $<$ in the previous example is a special macro that equates to the dependency file (that is, file1.c or file2.c). Thus, using macros and the "%" pattern matching character, the previous example can be reduced to

```
SRCS = file1.c file2.c
OBJS = $(SRCS:.c=.o)
```

test: $(OBJS)
    cc -o $@ $(OBJS)

%.o : %.c
    cc -c $<
```

Note that the $@ macro above is another special macro that equates to the name of the current dependency target, in this case test.

This example generates the list of objects (OBJS) from the list of sources (SRCS) by using the text substitution feature for macro expansion. It replaces the source file extension (for example, .c) with the object file extension (.o). This example also generalized the build rule for the program, test, to use the special "$@" macro.

**Customizing Generated Makefiles with rtwmakecfg**

TMFs provide tokens that let you add the following items to generated makefiles:

- Source folders
- Include folders
- Run-time library names
- Run-time module objects

S-functions can add this information to the makefile by using an rtwmakecfg.m file function. This function is particularly useful when building a model that contains one or more of your S-Function blocks, such as device driver blocks.

To add information pertaining to an S-function to the makefile,

1. Create the function rtwmakecfg in file rtwmakecfg.m. The code generator associates this file with your S-function based on its folder location.
2. Modify your target's TMF such that it supports macro expansion for the information returned by rtwmakecfg functions.

After the TLC phase of the build process, when generating a makefile from the TMF, the build process searches for an rtwmakecfg.m file in the folder that contains the S-
function component. If it finds the file, the build process calls the rtwmakecfg function. For more information, see “Use rtwmakecfg.m API to Customize Generated Makefiles” on page 37-26.

**Supporting Continuous Time in Custom Targets**

If you want your custom ERT-based target to support continuous time, you must update your template makefile (TMF) and the static main program module (for example, mytarget_main.c) for your target.

**Template Makefile Modifications**

Add the NCSTATES token expansion after the NUMST token expansion, as follows:

```plaintext
NUMST = |NUMST<|
NCSTATES = |NCSTATES<|
```

In addition, add NCSTATES to the CPP_REQ_DEFINES macro, as in the following example:

```plaintext
CPP_REQ_DEFINES = -DMODEL=$(MODEL) -DNUMST=$(NUMST) -DNCSTATES=$(NCSTATES) \ -DMAT_FILE=$(MAT_FILE) -DINTEGER_CODE=$(INTEGER_CODE) \ -DONESTEPFCN=$(ONESTEPFCN) -DTERMFCN=$(TERMFCN) \ -DHAVESTDIO -DMULTI_INSTANCE_CODE=$(MULTI_INSTANCE_CODE) \ -DTID01EQ=$(TID01EQ)
```

**Modifications to Main Program Module**

The main program module defines a static main function that manages task scheduling for the supported tasking modes of single- and multiple-rate models. NUMST (the number of sample times in the model) determines whether the main function calls multirate or single-rate code. However, when a model uses continuous time, do not rely on NUMST directly.

When the model has continuous time and the flag TID01EQ is true, both continuous time and the fastest discrete time are treated as one rate in generated code. The code associated with the fastest discrete rate is guarded by a major time step check. When the model has only two rates, and TID01EQ is true, the generated code has a single-rate call interface.

To support models that have continuous time, update the static main module to take TID01EQ into account, as follows:

```plaintext
1. Before NUMST is referenced in the file, add the following code:
```
```c
#if defined(TID01EQ) && TID01EQ == 1 && NCSTATES == 0
#define DISC_NUMST (NUMST - 1)
#else
#define DISC_NUMST NUMST
#endif
```

2 Replace instances of `NUMST` in the file by `DISC_NUMST`.

**Model Reference Considerations**

See “Support Model Referencing” on page 39-84 for important information on TMF modifications you may need to make to support the code generator model referencing features.

**Note** If you are using a TMF without the variables `SHARED_SRC` or `MODELREFS`, the file might have been used with a previous release of Simulink software. If you want your TMF to support model referencing, add either variable `SHARED_SRC` or `MODELREFS` to the make file.

**See Also**

**More About**

- “About Embedded Target Development” on page 39-2
- “Sample Custom Targets” on page 39-9
- “Customize System Target Files” on page 39-28
- “Custom Target Optional Features” on page 39-80
- “Support Toolchain Approach with Custom Target” on page 39-82
Custom Target Optional Features

This section describes how to configure a custom embedded target to support these optional features.

<table>
<thead>
<tr>
<th>To ...</th>
<th>Use Target Configuration Parameters ...</th>
<th>For more information, see ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicate a custom target is toolchain-compliant</td>
<td>UseToolchainInfoCompliant GenerateMakefile</td>
<td>“Support Toolchain Approach with Custom Target” on page 39-82</td>
</tr>
<tr>
<td>Build a model that includes referenced models and uses a custom target</td>
<td>ModelReferenceCompliant ParmdlRefBuildCompliant (parallel build support)</td>
<td>“Support Model Referencing” on page 39-84</td>
</tr>
<tr>
<td>Control the compiler optimization level building generated code for a custom target</td>
<td>CompOptLevelCompliant</td>
<td>“Support Compiler Optimization Level Control” on page 39-96</td>
</tr>
<tr>
<td>Control C function prototypes of initialize and step functions that are generated for a model that uses a custom target</td>
<td>ModelStepFunctionPrototypeCompliant (ERT only)</td>
<td>“Support C Function Prototype Control” on page 39-98</td>
</tr>
<tr>
<td>Control C++ class interfaces that are generated for a model that uses a custom target</td>
<td>CPPClassGenCompliant (ERT only)</td>
<td>“Support C++ Class Interface Control” on page 39-100</td>
</tr>
<tr>
<td>Enable concurrent execution of multiple tasks on a multicore platform for a model that uses a custom target</td>
<td>ConcurrentExecutionCompliant</td>
<td>“Support Concurrent Execution of Multiple Tasks” on page 39-102</td>
</tr>
</tbody>
</table>

The required configuration changes are modifications to your system target file (STF), and in some cases also modifications to your template makefile (TMF) or your custom static main program.
The API for STF callbacks provides a function `SelectCallback` for use in STFs. `SelectCallback` is associated with the target rather than with its individual options. If you implement a `SelectCallback` function for a target, it is triggered whenever the user selects the target in the System Target File Browser.

The API provides the functions `slConfigUIGetVal`, `slConfigUISetEnabled`, and `slConfigUISetVal` for controlling custom target configuration options from a user-written `SelectCallback` function. (For function descriptions and examples, see the function reference pages.)

The general requirements for supporting one of the optional features include:

- To support model referencing or compiler optimization level control, the target must be derived from the GRT or the ERT target. To support C function prototype control or C++ class interface control, the target must be derived from the ERT target.
- The system target file (STF) must declare feature compliance by including one of the target configuration parameters listed above in a `SelectCallback` function call.
- Additional changes such as TMF modifications or static main program modifications may be required, depending on the feature. See the detailed steps in the subsections for individual features.

For an example that shows how to configure custom target optional features, see “Customize System Target Files” on page 39-28.

**See Also**

**More About**

- “About Embedded Target Development” on page 39-2
- “Sample Custom Targets” on page 39-9
- “Support Toolchain Approach with Custom Target” on page 39-82
- “Support Model Referencing” on page 39-84
- “Support Compiler Optimization Level Control” on page 39-96
- “Support C Function Prototype Control” on page 39-98
- “Support C++ Class Interface Control” on page 39-100
- “Support Concurrent Execution of Multiple Tasks” on page 39-102
Support Toolchain Approach with Custom Target

This section describes how to configure a custom system target file to support builds with the toolchain approach.

In the Configuration Parameters dialog box, on the Code Generation pane of, you can present either the build controls for the toolchain approach or the template makefile approach. The model parameters that contribute to determining which build controls appear include these parameters.

<table>
<thead>
<tr>
<th>Model Parameter</th>
<th>Value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>UseToolchainInfoCompliant</td>
<td>on</td>
<td>For toolchain approach, set this parameter to 'on'. For TMF approach, set this parameter to 'off'.</td>
</tr>
<tr>
<td>GenerateMakefile</td>
<td>on</td>
<td>For toolchain approach, set this parameter to 'on'.</td>
</tr>
</tbody>
</table>

When the dialog box detects that the selected target has these properties, the dialog box recognizes the target as toolchain-compliant and displays the build controls for the toolchain approach.

Because the custom target file cannot set these properties directly, use a SelectCallback function in the custom target file to set the properties. The SelectCallback function call in the RTW_OPTION section of the TLC file can take the form:

```matlab
rtwgensettings.SelectCallback = 'enableToolchainCompliant(hSrc, hDlg)';
```

A corresponding callback function can contain:

```matlab
function enableToolchainCompliant(hSrc, hDlg)
    hCS = hSrc.getConfigSet();

    % The following parameters enable toolchain compliance.
    slConfigUISetVal(hDlg, hSrc, 'UseToolchainInfoCompliant', 'on');
    hCS.setProp('GenerateMakefile','on');

    % The following parameters are not required for toolchain compliance.
    % But, it is recommended practice to set these default values and
    % disable the parameters (as shown).
    hCS.setProp('RTWCompilerOptimization','off');
    hCS.setProp('MakeCommand','make_rtw');
    hCS.setPropEnabled('RTWCompilerOptimization',false);
```
When you select your custom target, the configuration parameters dialog box displays the toolchain approach build controls. For an example, see “Create a Custom Target Configuration” on page 39-48.

For an example that shows how to configure custom target optional features, see “Customize System Target Files” on page 39-28.

See Also

More About

• “Customize System Target Files” on page 39-28
• “Support Model Referencing” on page 39-84
• “Support Compiler Optimization Level Control” on page 39-96
• “Support C Function Prototype Control” on page 39-98
• “Support C++ Class Interface Control” on page 39-100
• “Support Concurrent Execution of Multiple Tasks” on page 39-102
Support Model Referencing

This section describes how to configure a custom embedded target to support model referencing. Without the described modifications, you will not be able to use the custom target when building a model that includes referenced models. If you do not intend to use referenced models with your target, you can skip this section. If you later find that you need to use referenced models, you can upgrade your target then.

About Model Referencing with a Custom Target

The requirements for supporting model referencing are as follows:

- The target must be derived from the GRT target or the ERT target.
- The system target file (STF) must declare model reference compliance, as described in “Declaring Model Referencing Compliance” on page 39-85.
- The template makefile (TMF) must define some entities that support model referencing, as described in “Providing Model Referencing Support in the TMF” on page 39-85.
- The TMF must support using the Shared Utilities folder, as described in “Supporting the Shared Utilities Folder” on page 39-89.

Optionally, you can provide additional capabilities that support model referencing:

- You can configure a target to support parallel builds for large model reference hierarchies (see “Reduce Build Time for Referenced Models” on page 27-48). To do this, you must modify the STF and TMF for parallel builds as described in “Declaring Model Referencing Compliance” on page 39-85 and “Providing Model Referencing Support in the TMF” on page 39-85.
- If your target supports parallel builds for large model reference hierarchies, you can additionally set up automatic verification of MATLAB Distributed Computing Server workers, as described in “Verifying Worker Configuration for Parallel Builds of Model Reference Hierarchies (Optional)” on page 39-93.
- You can modify hook files to handle referenced models differently than top models to prevent resource conflicts, as described in “Preventing Resource Conflicts (Optional)” on page 39-95.

See “Model Reference Basics” (Simulink) for information about model referencing in Simulink models, and “Generate Code for Referenced Models” on page 7-4 for information about model referencing in generated code.
For an example that shows how to configure custom target optional features, see “Customize System Target Files” on page 39-28.

**Declaring Model Referencing Compliance**

To declare model reference compliance for your target, you must implement a callback function that sets the `ModelReferenceCompliant` flag, and then install the callback function in the `SelectCallback` field of the `rtwgensettings` structure in your STF. The callback function is triggered whenever the user selects the target in the System Target File Browser. For example, the following STF code installs a `SelectCallback` function named `custom_select_callback_handler`:

```matlab
rtwgensettings.SelectCallback = 'custom_select_callback_handler(hDlg,hSrc)';
```

The arguments to the `SelectCallback` function (`hDlg`, `hSrc`) are handles to private data used by the callback API functions. These handles are restricted to use in STF callback functions. They should be passed in without alteration.

Your callback function should set the `ModelReferenceCompliant` flag as follows:

```matlab
slConfigUISetVal(hDlg,hSrc,'ModelReferenceCompliant','on');
slConfigUISetEnabled(hDlg,hSrc,'ModelReferenceCompliant',false);
```

If you might use the target to build models containing large model reference hierarchies, consider configuring the target to support parallel builds, as discussed in “Reduce Build Time for Referenced Models” on page 27-48.

To configure a target for parallel builds, your callback function must also set the `ParMdlRefBuildCompliant` flag as follows:

```matlab
slConfigUISetVal(hDlg,hSrc,'ParMdlRefBuildCompliant','on');
slConfigUISetEnabled(hDlg,hSrc,'ParMdlRefBuildCompliant',false);
```

For more information about the STF callback API, see the `slConfigUIGetVal`, `slConfigUISetEnabled`, and `slConfigUISetVal` function reference pages.

**Providing Model Referencing Support in the TMF**

Do the following to configure the template makefile (TMF) to support model referencing:

1. Add the following make variables and tokens to be expanded when the makefile is generated:

   ```
   MODELREFS = |>MODELREFS<|
   MODELLIB = |>MODELLIB<|
   ```
The following code excerpt shows how makefile tokens are expanded for a referenced model.

```
MODELREFS =
MODELLIB = engine3200cc_rtwlib.a
MODELREF_LINK_LIBS =
MODELREF_LINK_RSPFILE =
MODELREF_INC_PATH =
RELATIVE_PATH_TO_ANCHOR = ../../..
MODELREF_TARGET_TYPE = RTW
```

The following code excerpt shows how makefile tokens are expanded for the top model that references the referenced model.

```
MODELREFS = engine3200cc transmission
MODELLIB = archlib.a
MODELREF_LINK_LIBS = engine3200cc_rtwlib.a transmission_rtwlib.a
MODELREF_LINK_RSPFILE =
MODELREF_INC_PATH = -I../slprj/ert/engine3200cc -I../slprj/ert/transmission
RELATIVE_PATH_TO_ANCHOR = ..
MODELREF_TARGET_TYPE = NONE
```

<table>
<thead>
<tr>
<th>Token</th>
<th>Expands to</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODELREFS for the top model</td>
<td>List of referenced model names.</td>
</tr>
<tr>
<td>MODELLIB</td>
<td>Name of the library generated for the model.</td>
</tr>
<tr>
<td>MODELREF_LINK_LIBS token for the top model</td>
<td>List of referenced model libraries that the top model links against.</td>
</tr>
<tr>
<td>MODELREF_LINK_RSPFILE token for the top model</td>
<td>Name of a response file that the top model links against. This token is valid only for build environments that support linker response files. For an example of its use, see <code>matlabroot/rtw/c/grt/grt_vc.tmf</code>.</td>
</tr>
<tr>
<td>MODELREF_INC_PATH token for the top model</td>
<td>Include path to the referenced models.</td>
</tr>
</tbody>
</table>
Token | Expands to
---|---
RELATIVE_PATH_TO_ANCHOR | Relative path, from the location of the generated makefile, to the MATLAB working folder.
MODELREF_TARGET_TYPE | Signifies the type of target being built. Possible values are
- None: Standalone model or top model referencing other models
- RTW: Model reference target build
- SIM: Model reference simulation target build

If you are configuring your target to support parallel builds, as discussed in “Reduce Build Time for Referenced Models” on page 27-48, you must also add the following token definitions to your TMF:

```
START_DIR = |START_DIR<|
MASTER_ANCHOR_DIR = |MASTER_ANCHOR_DIR<|
```

<table>
<thead>
<tr>
<th>Token</th>
<th>Expands to</th>
</tr>
</thead>
<tbody>
<tr>
<td>START_DIR</td>
<td>Current work folder (pwd) at the time the build started.</td>
</tr>
<tr>
<td>MASTER_ANCHOR_DIR</td>
<td>Current work folder (pwd) at the time the build started.</td>
</tr>
</tbody>
</table>

2. Add RELATIVE_PATH_TO_ANCHOR and MODELREF_INC_PATH include paths to the overall INCLUDES variable.

```
INCLUDES = -I. -I$(RELATIVE_PATH_TO_ANCHOR) $(ADD_INCLUDES) $(USER_INCLUDES) $(MODELREF_INC_PATH) $(SHARED_INCLUDES)
```

3. Change the SRCS variable in your TMF so that it initially lists only common modules. Additional modules are then appended conditionally, as described in the next step. For example, change

```
SRCS = $(MODEL).c $(MODULES) ert_main.c $(ADD_SRCS) $(EXT_SRC)
```

to

```
SRCS = $(MODULES) $(S_FUNCTIONS)
```
Create variables to define the final target of the makefile. You can remove variables that may have existed for defining the final target. For example, remove

```
PROGRAM   = ../$ (MODEL)
```

and replace it with

```
ifeq ($ (MODELREF_TARGET_TYPE), NONE)
   # Top model for RTW
   PRODUCT     = $(RELATIVE_PATH_TO_ANCHOR)/$(MODEL)
   BIN_SETTING = $(LD) $(LDFLAGS) -o $(PRODUCT) $(SYSLIBS)
   BUILD_PRODUCT_TYPE = "executable"
   # ERT based targets
   SRCS += $(MODEL).c ert_main.c $(EXT_SRC)
   # GRT based targets
   # SRCS += $(MODEL).c grt_main.c rt_sim.c $(EXT_SRC) $(SOLVER)
else
   # sub-model for RTW
   PRODUCT = $(MODELLIB)
   BUILD_PRODUCT_TYPE = "library"
endif
```

Create rules for the final target of the makefile (replace existing final target rules). For example:

```
ifeq ($ (MODELREF_TARGET_TYPE), NONE)
   # Top model for RTW
   $(PRODUCT) : $(OBJS) $(SHARED_LIB) $(LIBS) $(MODELREF_LINK_LIBS)
   $(BIN_SETTING) $(LINK_OBJS) $(MODELREF_LINK_LIBS)
   $(SHARED_LIB) $(LIBS)
   @echo "### Created $(BUILD_PRODUCT_TYPE): $ @"
else
   # sub-model for RTW
   $(PRODUCT) : $(OBJS) $(SHARED_LIB) $(LIBS)
   @rm - f $(MODELLIB)
   $(ar) ruvs $(MODELLIB) $(LINK_OBJS)
   @echo "### Created $(MODELLIB)"
   @echo "### Created $(BUILD_PRODUCT_TYPE): $ @"
endif
```

Create a rule to allow referenced models to compile files that reside in the MATLAB working folder (pwd).

```
%.o : $(RELATIVE_PATH_TO_ANCHOR)/%.c
   $(CC) - c $(CFLAGS) $ <
```

**Note** If you are using a TMF without the variables `SHARED_SRC` or `MODELREFS`, the file might have been used with a previous release of Simulink software. If you want your TMF to support model referencing, add either variable `SHARED_SRC` or `MODELREFS` to the make file.
Controlling Configuration Option Value Agreement

By default, the value of a configuration option defined in the system target file for a TLC-based custom target must be the same in any referenced model and its parent model. To relax this requirement, include the modelReferenceParameterCheck field in the rtwoptions structure element that defines the configuration option, and set the value of the field to 'off'. For example:

```plaintext
rtwoptions(2).prompt         = 'My Custom Parameter';
rtwoptions(2).type           = 'Checkbox';
rtwoptions(2).default        = 'on';
rtwoptions(2).modelReferenceParameterCheck  = 'on';
rtwoptions(2).tlcvariable    = 'mytlcvariable';
...
```

The configuration option My Custom Parameter can differ in a referenced model and its parent model. See “Customize System Target Files” on page 39-28 for information about TLC-based system target files, and rtwoptions Structure Fields Summary for a list of rtwoptions fields.

Supporting the Shared Utilities Folder

- “Overview” on page 39-89
- “Implementing Shared Utilities Folder Support” on page 39-91

Overview

The makefile used by the build process must support compiling and creating libraries, and so on, from the locations in which the code is generated. Therefore, you need to update your makefile and the model reference build process to support the shared utilities location. The Shared code placement options have the following requirements:

- Auto
  - Standalone model build — Build files go to the build folder; makefile is not updated.
  - Referenced model or top model build — Use shared utilities folder; makefile requires full model reference support.

- Shared location
  - Standalone model build — Use shared utilities folder; makefile requires shared location support.
• Referenced model or top model build — Use shared utilities folder; makefile requires full model reference support.

The shared utilities folder (slprj/target/_sharedutils) typically stores generated utility code that is common between a top model and the models it references. You can also force the build process to use a shared utilities folder for a standalone model. See “Manage Build Process Folders” on page 21-37 for details.

If you want your target to support compilation of code generated in the shared utilities folder, several updates to your template makefile (TMF) are required. Support for Model Reference builds requires the shared utilities folder. See the preceding sections to learn about additional updates for supporting Model Reference builds.

The exact syntax of the changes can vary due to differences in the make utility and compiler/archiver tools used by your target. The examples below are based on the GNU make utility. You can find the following updated TMF examples for GNU and Microsoft Visual C++ make utilities in the GRT and ERT target folders:

• GRT: matlabroot/rtw/c/grt (open)
  • grt_lcc.tmf
  • grt_vc.tmf
  • grt_unix.tmf
• ERT: matlabroot/rtw/c/ert (open)
  • ert_lcc.tmf
  • ert_vcx64.tmf
  • ert_unix.tmf

Use the GRT or ERT examples as a guide to the location, within the TMF, of the changes and additions described below.

Note The ERT-based TMFs contain extra code to handle generation of ERT S-functions and Model Reference simulation targets. Your target does not need to handle these cases.

---

8. GNU is a registered trademark of the Free Software Foundation.
Implementing Shared Utilities Folder Support

Make the following changes to your TMF to support the shared utilities folder:

1. Add the following make variables and tokens to be expanded when the makefile is generated:

   ```
   SHARED_SRC      = |>SHARED_SRC<|
   SHARED_SRC_DIR  = |>SHARED_SRC_DIR<|
   SHARED_BIN_DIR  = |>SHARED_BIN_DIR<|
   SHARED_LIB      = |>SHARED_LIB<|
   
   SHARED_SRC specifies the shared utilities folder location and the source files in it. A typical expansion in a makefile is
   
   SHARED_SRC = ../slprj/ert/_sharedutils/*.c
   
   SHARED_LIB specifies the library file built from the shared source files, as in the following expansion.
   
   SHARED_LIB = ../slprj/ert/_sharedutils/rtwshared.lib
   
   SHARED_SRC_DIR and SHARED_BIN_DIR allow specification of separate folders for shared source files and the library compiled from the source files. In the current release, the TMFs use the same path, as in the following expansions.
   
   SHARED_SRC_DIR = ../slprj/ert/_sharedutils
   SHARED_BIN_DIR = ../slprj/ert/_sharedutils
   ```

2. Set the `SHARED_INCLUDES` variable according to whether shared utilities are in use. Then append it to the overall `INCLUDES` variable.

   ```
   SHARED_INCLUDES =
   ifndef (SHARED_SRC_DIR,)
   SHARED_INCLUDES = -I$(SHARED_SRC_DIR)
   endif
   
   INCLUDES = -I, $(ADD_INCLUDES) \
              $(USER_INCLUDES) $(SHARED_INCLUDES)
   ```

3. Update the `SHARED_SRC` variable to list shared files explicitly.

   ```
   SHARED_SRC := $(wildcard $(SHARED_SRC))
   ```

4. Create a `SHARED_OBJS` variable based on `SHARED_SRC`.

   ```
   SHARED_OBJS = $(addsuffix .o, $(basename $(SHARED_SRC)))
   ```
Create an `OPTS` (options) variable for compilation of shared utilities.

```
SHARED_OUTPUT_OPTS = -o $@
```

Provide a rule to compile the shared utility source files.

```
$(SHARED_OPTS) : $(SHARED_BIN_DIR)/%.o : $(SHARED_SRC_DIR)/%.c
   $(CC) -c $(CFLAGS) $(SHARED_OUTPUT_OPTS) $<
```

Provide a rule to create a library of the shared utilities. The following example is based on UNIX\(^9\).

```
$(SHARED_LIB) : $(SHARED_OPTS)
   @echo "### Creating $@"
   ar r $@ $(SHARED_OPTS)
   @echo "### Created $@"
```

**Note** Depending on your make utility, you may be able to combine Steps 6 and 7 into one rule. For example, `gmake` (used with `ert_unix.tmf`) uses:

```
$(SHARED_LIB) : $(SHARED_SRC)
   @echo "### Creating $@"
   cd $(SHARED_BIN_DIR); $(CC) -c $(CFLAGS) $(GCC_WALL_FLAG_MAX) $(notdir $?)
   ar ruvs $@ $(SHARED_OPTS)
   @echo "### $@ Created"
```

See this and other examples in the files `ert_vcx64.tmf`, `ert_lcc.tmf`, and `ert_unix.tmf` located at `matlabroot/rtw/c/ert` (open).

Add `SHARED_LIB` to the rule that creates the final executable.

```
$(PROGRAM) : $(OBJS) $(LIBS) $(SHARED_LIB)
   $(LD) $(LDFLAGS) -o $@ $(LINK_OBJS) $(LIBS)
   $(SHARED_LIB) $(SYSLIBS)
   @echo "### Created executable: $(MODEL)"
```

Remove explicit references to `rt_nonfinite.c` from your TMF. For example, change

```
ADD_SRCS = $(RTWLOG) rt_nonfinite.c
```

to

```
ADD_SRCS = $(RTWLOG)
```

---

\(^9\) UNIX is a registered trademark of The Open Group in the United States and other countries.
Note If your target interfaces to a development environment that is not makefile based, you must make equivalent changes to provide information to your target compilation environment.

Verifying Worker Configuration for Parallel Builds of Model Reference Hierarchies (Optional)

If your target supports parallel builds for large model reference hierarchies, you can additionally set up automatic verification of MATLAB Distributed Computing Server workers. This addresses the possibility that parallel workers might have different configurations, some of which might not be compatible with a specific target build. For example, the required compiler might not be installed on a worker system.

The code generator provides a programming interface that you can use to automatically check the configuration of parallel workers. If parallel workers are not set up as expected, take action, such as reverting to sequential builds or throwing an error.

To set up automatic verification of workers, you must define a parallel configuration check function named `STF_par_cfg_chk`, where `STF` designates your system target file name. For example, the parallel configuration check function for `ert.tlc` is `ert_par_cfg_chk`.

The general syntax for the function is:

```matlab
function varargout = STF_par_cfg_chk(action,varargin)
```

The number of output and input arguments vary according to the `action` specified, and according to the types of information you choose to coordinate between the client and the workers. The function should support the following general sequence of parallel configuration setup calls, differentiated by the first argument passed in:

<table>
<thead>
<tr>
<th>Call Syntax</th>
<th>Called on</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>cfg = STF_par_cfg_chk('getPreferredCfg');</code></td>
<td>Client</td>
<td>Return a structure representing the preferred configuration for MATLAB Distributed Computing Server workers.</td>
</tr>
</tbody>
</table>
### Call Syntax

<table>
<thead>
<tr>
<th>Call Syntax</th>
<th>Called on:</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>[tf, cfg] = STF_par_cfg_chk ('getWorkerCfg', cfg);</code></td>
<td>Workers</td>
<td>Each worker is passed the MATLAB Distributed Computing Server client’s preferred configuration. Return true if the worker can support the preferred configuration; otherwise return false along with a structure representing a configuration the worker can support. Information returned by each worker is added to a cell array of configurations.</td>
</tr>
<tr>
<td><code>[tf, cfg] = STF_par_cfg_chk ('getCommonCfg', cfgs);</code></td>
<td>Client</td>
<td>The client is passed the cell array of worker configurations. If a usable common configuration exists, return true, and return the common configuration to set for all systems. If a common configuration cannot be established, return false or take some action, such as reverting to sequential builds or throwing an error.</td>
</tr>
<tr>
<td><code>tf = STF_par_cfg_chk ('setCommonCfg', cfg);</code></td>
<td>Workers and client</td>
<td>Each system is passed the common configuration to use. Set up the common configuration and, if successful, return true. If errors or issues occur, return false or take some action, such as reverting to sequential builds or throwing an error.</td>
</tr>
<tr>
<td><code>STF_par_cfg_chk ('clearCfg');</code></td>
<td>Workers and client</td>
<td>Clean up after completion of the parallel build.</td>
</tr>
</tbody>
</table>

The parallel configuration check functions for MathWorks provided targets are implemented as wrapper functions that call a function named `parallelMdlRefHostConfigCheckFcn`. For example, see the ERT parallel configuration check function in the file `matlabroot/toolbox/rtw/rtw/ert_par_cfg_chk.m`, and the function it calls in the file `matlabroot/toolbox/simulink/simulink/+Simulink/parallelMdlRefHostConfigCheckFcn.m`. The `parallelMdlRefHostConfigCheckFcn` function tries to establish a common compiler across the MATLAB Distributed Computing Server client and workers.

For more information about parallel builds, see “Reduce Build Time for Referenced Models” on page 27-48.
Preventing Resource Conflicts (Optional)

Hook files are optional TLC and MATLAB program files that are invoked at well-defined stages of the build process. Hook files let you customize the build process and communicate information between various phases of the process.

If you are adapting your custom target for code generation compatibility with model reference features, consider adding checks to your hook files for handling referenced models differently than top models to prevent resource conflicts.

For example, consider adding the following check to your STF_make_rtw_hook.m file:

```matlab
% Check if this is a referenced model
mdlRefTargetType = get_param(codeGenModelName, 'ModelReferenceTargetType');
isNotModelRefTarget = strcmp(mdlRefTargetType, 'NONE'); % NONE, SIM, or RTW
if isNotModelRefTarget
    % code that is specific to the top model
else
    % code that is specific to the referenced model
end
```

You may need to do a similar check in your TLC code.

```matlab
%if !IsModelReferenceTarget()
    %% code that is specific to the top model
%else
    %% code that is specific to the referenced model
%endif
```

See Also

More About

- “About Embedded Target Development” on page 39-2
- “Sample Custom Targets” on page 39-9
- “Customize System Target Files” on page 39-28
Support Compiler Optimization Level Control

This section describes how to configure a custom embedded target to support compiler optimization level control. Without the described modifications, you cannot use the Configuration Parameters > Code Generation > Build process > Compiler optimization level parameter to control the compiler optimization level for building generated code. For more information about compiler optimization level control, see “Compiler optimization level”.

About Compiler Optimization Level Control and Custom Targets

The requirements for supporting compiler optimization level control are as follows:

- The target must be derived from the GRT target or the ERT target.
- The system target file (STF) must declare compiler optimization level control compliance, as described in “Declaring Compiler Optimization Level Control Compliance” on page 39-96.
- The target makefile must honor the setting for Compiler optimization level, as described in “Providing Compiler Optimization Level Control Support in the Target Makefile” on page 39-97.

For an example that shows how to configure custom target optional features, see “Customize System Target Files” on page 39-28.

Declaring Compiler Optimization Level Control Compliance

To declare compiler optimization level control compliance for your target, you must implement a callback function that sets the CompOptLevelCompliant flag, and then install the callback function in the SelectCallback field of the rtwgensettings structure in your STF. The callback function is triggered whenever the user selects the target in the System Target File Browser. For example, the following STF code installs a SelectCallback function named custom_select_callback_handler:

```plaintext
rtwgensettings.SelectCallback = 'custom_select_callback_handler(hDlg,hSrc)';
```

The arguments to the SelectCallback function (hDlg, hSrc) are handles to private data used by the callback API functions. These handles are restricted to use in STF callback functions. They should be passed in without alteration.
Your callback function should set the `CompOptLevelCompliant` flag as follows:

```matlab
slConfigUISetVal(hDlg,hSrc,'CompOptLevelCompliant','on');
slConfigUISetEnabled(hDlg,hSrc,'CompOptLevelCompliant',false);
```

For more information about the STF callback API, see the `slConfigUIGetVal`, `slConfigUISetEnabled`, and `slConfigUISetVal` function reference pages.

When the `CompOptLevelCompliant` target configuration parameter is set to on, the **Compiler optimization level** parameter is displayed in the **Code Generation** pane of the Configuration Parameters dialog box for your model.

### Providing Compiler Optimization Level Control Support in the Target Makefile

As part of supporting compiler optimization level control for your target, you must modify the target makefile to honor the setting for **Compiler optimization level**. Use a GRT or ERT target provided by MathWorks as a model for making the modifications.

### See Also

**More About**

- “About Embedded Target Development” on page 39-2
- “Sample Custom Targets” on page 39-9
- “Customize System Target Files” on page 39-28
Support C Function Prototype Control

This section describes how to configure a custom embedded target to support function prototype control. Without the described modifications, you will not be able to use available interfaces for customizing entry-point function interfaces. For more information, see “Customize Generated C Function Interfaces” (Embedded Coder).

About C Function Prototype Control and Custom Targets

The requirements for supporting C function prototype control are as follows:

• The target must be derived from the ERT target.
• The system target file (STF) must declare C function prototype control compliance, as described in “Declaring C Function Prototype Control Compliance” on page 39-98.
• If your target uses a custom static main program, and if a nondefault function prototype control configuration is associated with a model, the static main program must call the function prototype controlled initialize and step functions, as described in “Providing C Function Prototype Control Support in the Custom Static Main Program” on page 39-99.

For an example that shows how to configure custom target optional features, see “Customize System Target Files” on page 39-28.

Declaring C Function Prototype Control Compliance

To declare C function prototype control compliance for your target, you must implement a callback function that sets the ModelStepFunctionPrototypeControlCompliant flag, and then install the callback function in the SelectCallback field of the rtwgensettings structure in your STF. The callback function is triggered whenever the user selects the target in the System Target File Browser. For example, the following STF code installs a SelectCallback function named custom_select_callback_handler:

```matlab
rtwgensettings.SelectCallback = 'custom_select_callback_handler(hDlg,hSrc)';
```

The arguments to the SelectCallback function (hDlg, hSrc) are handles to private data used by the callback API functions. These handles are restricted to use in STF callback functions. They should be passed in without alteration.

Your callback function should set the ModelStepFunctionPrototypeControlCompliant flag as follows:
For more information about the STF callback API, see the `slConfigUIGetVal`, `slConfigUISetEnabled`, and `slConfigUISetVal` function reference pages.

When the `ModelStepFunctionPrototypeControlCompliant` target configuration parameter is set to `on`, you can use the Configure C Step Function Interface dialog box to control the function prototype of the base-rate step function generated for a rate-based model.

### Providing C Function Prototype Control Support in the Custom Static Main Program

If your target uses a custom static main program, and if a nondefault function prototype control configuration is associated with a model, you must update the static main program to call the function prototype controlled initialize and step functions. You can do this in either of the following ways:

1. Manually adapt your static main program to declare model data and call the function prototype controlled initialize and step functions.

2. Generate your main program using Generate an example main program on the Templates pane of the Configuration Parameters dialog box. The generated main program declares model data and calls the function prototype controlled initialize and step function.

### See Also

### More About

- “About Embedded Target Development” on page 39-2
- “Sample Custom Targets” on page 39-9
- “Customize System Target Files” on page 39-28
Support C++ Class Interface Control

This section describes how to configure a custom embedded target to support C++ class interface control. Without the described modifications, you will not be able to use C++ class code interface packaging and the Configure C++ Class Interface button on the Interface pane of the Configuration Parameters dialog box to generate and configure C++ class interfaces to model code. For more information about C++ class interface control, see “Customize Generated C++ Class Interfaces” (Embedded Coder).

About C++ Class Interface Control and Custom Targets

The requirements for supporting C++ class interface control are as follows:

- The target must be derived from the ERT target.
- The system target file (STF) must declare C++ class interface control compliance, as described in “Declaring C++ Class Interface Control Compliance” on page 39-100.

For an example that shows how to configure custom target optional features, see “Customize System Target Files” on page 39-28.

Declaring C++ Class Interface Control Compliance

To declare C++ class interface control compliance for your target, you must implement a callback function that sets the CPPClassGenCompliant flag, and then install the callback function in the SelectCallback field of the rtwgensettings structure in your STF. The callback function is triggered whenever the user selects the target in the System Target File Browser. For example, the following STF code installs a SelectCallback function named custom_select_callback_handler:

```matlab
rtwgensettings.SelectCallback = 'custom_select_callback_handler(hDlg,hSrc)';
```

The arguments to the SelectCallback function (hDlg, hSrc) are handles to private data used by the callback API functions. These handles are restricted to use in STF callback functions. They should be passed in without alteration.

Your callback function should set the CPPClassGenCompliant flag as follows:

```matlab
slConfigUISetVal(hDlg,hSrc,'CPPClassGenCompliant','on');
slConfigUISetEnabled(hDlg,hSrc,'CPPClassGenCompliant',false);
```

For more information about the STF callback API, see the slConfigUIGetVal, slConfigUISetEnabled, and slConfigUISetVal function reference pages.
When the CPPClassGenCompliant target configuration parameter is set to on, you can use the C++ class code interface packaging and the Configure C++ Class Interface button on the Interface pane of the Configuration Parameters dialog box to generate and configure C++ class interfaces to model code.

Providing C++ Class Interface Control Support in the Custom Static Main Program

Selecting C++ class code interface packaging for your model turns on the model option Generate an example main program. With this option on, code generation generates an example main program, ert_main.cpp. The generated example main program declares model data and calls the C++ class interface configured model step method, and illustrates how the generated code can be deployed.

To customize the build process and disable generation and inclusion of an example main program, see the setTargetProvidesMain function. Disabling example main generation permits including a custom main program.

See Also

More About

- “About Embedded Target Development” on page 39-2
- “Sample Custom Targets” on page 39-9
- “Customize System Target Files” on page 39-28
Support Concurrent Execution of Multiple Tasks

If a custom embedded target must support concurrent execution of multiple tasks on a multicore platform, the target must declare support for concurrent execution by setting the target configuration option `ConcurrentExecutionCompliant`. Otherwise, you will not be able to configure a multicore target model for concurrent execution.

If `ConcurrentExecutionCompliant` is not already configured for your custom target, you can set the option in the following ways:

- Include the following code directly in your system target file (mytarget.tlc):

  ```
  rtwgensettings.SelectCallback = 'slConfigUISetVal(hDlg,hSrc,...
  'ConcurrentExecutionCompliant','on');';
  rtwgensettings.ActivateCallback = 'slConfigUISetVal(hDlg,hSrc,...
  'ConcurrentExecutionCompliant','on');';
  ```

- Implement a callback function that sets the `ConcurrentExecutionCompliant` option, and then install the callback function in the `SelectCallback` field of the `rtwgensettings` structure in your STF. The callback function is triggered whenever the user selects the target in the System Target File Browser. For example, the following STF code installs a `SelectCallback` function named `custom_select_callback_handler`:

  ```
  rtwgensettings.SelectCallback = 'custom_select_callback_handler(hDlg,hSrc)';
  ```

  The arguments to the `SelectCallback` function (hDlg, hSrc) are handles to private data used by the callback API functions. These handles are restricted to use in STF callback functions. They should be passed in without alteration.

  Your callback function should set the `ConcurrentExecutionCompliant` option as follows:

  ```
  slConfigUISetVal(hDlg,hSrc,'ConcurrentExecutionCompliant','on');
  slConfigUISetEnabled(hDlg,hSrc,'ConcurrentExecutionCompliant',false);
  ```

  For more information about the STF callback API, see the `slConfigUIGetVal`, `slConfigUISetEnabled`, and `slConfigUISetVal` function reference pages.

When the `ConcurrentExecutionCompliant` target configuration option is set to 'on', you can select the custom target and configure your multicore target model for concurrent execution.

For an example that shows how to configure custom target optional features, see “Customize System Target Files” on page 39-28.
See Also

More About

- “About Embedded Target Development” on page 39-2
- “Sample Custom Targets” on page 39-9
- “Customize System Target Files” on page 39-28
Interface to Development Tools

Unless you are developing a target purely for code generation purposes, you will want your embedded target to support a complete build process. A full post-code generation build process includes

• Compilation of generated code
• Linking of compiled code and runtime libraries into an executable program module (or some intermediate representation of the executable code, such as S-Rec format)
• Downloading the executable to target hardware with a debugger or other utility
• Initiating execution of the downloaded program

Supporting a complete build process is inherently a complex task, because it involves interfacing to cross-development tools and utilities that are external to the code generator.

If your development tools can be controlled with traditional makefiles and a make utility such as gmake, it may be relatively simple for you to adapt existing target files (such as the ert.tlc and ert.tmf files provided by the Embedded Coder software) to your requirements. This approach is discussed in “Template Makefile Approach” on page 39-104.

About Interfacing to Development Tools

Automating your build process through a modern integrated development environment (IDE) presents a different set of challenges. Each IDE has its own way of representing the set of source files and libraries for a project and for specifying build arguments. Interfacing to an IDE may require generation of specialized file formats required by the IDE (for example, project files) and, and also may require the use of inter-application communication (IAC) techniques to run the IDE. One such approach to build automation is discussed in “Interface to an Integrated Development Environment” on page 39-105.

Template Makefile Approach

A template makefile provides information about your model and your development system. The build process uses this information to create a makefile (.mk file) to build an executable program. The code generator provides a number of template makefiles suitable for development computer compilers, such as LCC (ert_lcc.tmf) and Microsoft Visual C++ (ert_vcx64.tmf).
Adapting one of the existing template makefiles to your cross-compiler's make utility may require little more than copying and renaming the template makefile in accordance with the conventions of your project.

If you need to make more extensive modifications, you need to understand template makefiles in detail. For a detailed description of the structure of template makefiles and of the tokens used in template makefiles, see “Customize Template Makefiles” on page 39-62.

The following topics supplement the basic template makefile information:

- “Supporting Multiple Development Environments” on page 39-48
- “Supplying Development Environment Information to Your Template Makefile” on page 39-25

**Interface to an Integrated Development Environment**

This section describes techniques that have been used to integrate embedded targets with integrated development environment (IDEs), including

- How to generate a header file containing directives to define variables (and their values) required by a non-makefile based build.

- Some problems and solutions specific to interfacing embedded targets with the Freescale Semiconductor CodeWarrior IDE. The examples provided should help you to deal with similar interfacing problems with your particular IDE.

- “Generating a CPP_REQ_DEFINES Header File” on page 39-105
- “Interfacing to the Freescale CodeWarrior IDE” on page 39-106

**Generating a CPP_REQ_DEFINES Header File**

In template makefiles, the token CPP_REQ_DEFINES is expanded and replaced with a list of parameter settings entered with various dialog boxes. This variable often contains information such as MODEL (name of generating model), NUMST (number of sample times in the model), MT (model is multitasking or not), and numerous other parameters (see “Template Makefiles and Tokens” on page 39-62).

The makefile mechanism handles the CPP_REQ_DEFINES token automatically. If your target requires use of a project file, rather than the traditional makefile approach, you can generate a header file containing directives to define these variables and provide their values.
The following TLC file, gen_rtw_req_defines.tlc, provides an example. The code generates a C header file, cpp_req_defines.h. The information required to generate each #define directive is derived either from information in the model.rtw file (e.g., CompiledModel.NumSynchronousSampleTimes), or from make variables from the rtwoptions structure (for example, PurelyIntegerCode).

```
%% File: gen_rtw_req_defines_h.tlc
%openfile CPP_DEFINES = "cpp_req_defines.h"
#ifndef _CPP_REQ_DEFINES_
#define _CPP_REQ_DEFINES_
#define MODEL %<CompiledModel.Name>
#define ERT 1
#define NUMST %<CompiledModel.NumSynchronousSampleTimes>
#define TID01EQ %<CompiledModel.FixedStepOpts.TID01EQ>
%%
%if CompiledModel.FixedStepOpts.SolverMode == "MultiTasking"
#define MT 1
#define MULTITASKING 1
%else
#define MT 0
#define MULTITASKING 0
%endif
%%
#define MAT_FILE 0
#define INTEGER_CODE %<PurelyIntegerCode>
#define ONESTEPFCN %<CombineOutputUpdateFcns>
#define TERMFCN %<IncludeMdlTerminateFcn>
%%
#define MULTI_INSTANCE_CODE 0
#define HAVESTDIO 0
%endif
%closefile CPP_DEFINES
```

Interfacing to the Freescale CodeWarrior IDE

Interfacing an embedded target's build process to the CodeWarrior IDE requires that two problems must be dealt with:

- The build process must generate a CodeWarrior compatible project file. This problem, and a solution, is discussed in “XML Project Import” on page 39-107. The solution described is applicable to ASCII project file formats.
- During code generation, the target must automate a CodeWarrior session that opens a project file and builds an executable. This task is described in “Build Process
Automation” on page 39-110. The solution described is applicable to IDEs that can be controlled with Microsoft Component Object Model (COM) automation.

**XML Project Import**

This section illustrates how to use the Target Language Compiler (TLC) to generate an eXtensible Markup Language (XML) file, suitable for import into the CodeWarrior IDE, that contains information about the source code generated by an embedded target.

The choice of XML format is dictated by the fact that the CodeWarrior IDE supports project export and import with XML files. As of this writing, native CodeWarrior project files are in a proprietary binary format.

Note that if your target needs to support some other compiler's project file format, you can apply the techniques shown here to other ASCII file formats (see “Generating a CPP_REQ_DEFINES Header File” on page 39-105).

To illustrate the basic concept, consider a hypothetical XML file exported from a CodeWarrior stationery project. The following is a partial listing:

```
<target>
  <settings>
    ...
  </settings>
  <file><name>foo.c</name>
  </file>
    ...
  <file><name>foobar.c</name>
  </file>
  <fileref><name>foo.c</name>
  </fileref>
    ...
  <fileref><name>foobar.c</name>
  </fileref>
</target>
```

Insert this XML code into an `%openfile/%closefile` block within a TLC file, `test.tlc`, as shown below.

```
%% test.tlc
%% This code will generate a file model_project.xml, where model is the generating model name specified in
%% the CompiledModel.Name field of the model.rtw file.
%openfile XMLFileContents = %<CompiledModel.Name>_project.xml
```
<target>
  <settings>
    ...
  </settings>
  <file><name>%<CompiledModel.Name>.c</name></file>
  ...
  <file><name>foobar.c</name></file>
  <fileref><name>%<CompiledModel.Name>.c</name></fileref>
  ...
  <fileref><name>foobar.c</name></fileref>
</target>
%closefile XMLFileContents
%selectfile NULL_FILE

Note the use of the TLC token CompiledModel.Name. The token is resolved and the resulting filename is included in the output stream. You can specify other information, such as paths and libraries, in the output stream by specifying other tokens defined in model.rtw. For example, System.Name may be defined as <Root>/Subsystem1.

Now suppose that test.tlc is invoked during a target's build process, where the generating model is mymodel. This should be done after the codegenentry statement. For example, test.tlc could be included directly in the system target file:

%include "codegenentry.tlc"
%include "test.tlc"

Alternatively, the %include "test.tlc" directive could be inserted into the mytarget_genfiles.tlc hook file, if present.

TLC tokens such as

<file><name>%<CompiledModel.Name>.c</name></file>

are expanded, with the CompiledModel record in the mymodel.rtw file, as in

<file><name>mymodel.c</name></file>

test.tlc generates an XML file, file model_project.xml, from a model. model_project.xml contains references to generated code files. model_project.xml can be imported into the CodeWarrior IDE as a project.
The following flowchart summarizes this process.

proj.mcp: CodeWarrior project binary stationery file

*Code Warrior (manual): Export to XML.*

proj.xml: XML project file

*Text editor (manual): Add TLC tokens to generate references to model files, MATLAB and other paths, and other settings. Embed the XML code marked with tokens in openfile/closefile block. Save as proj_gen.tlc.*

proj_gen.tlc: TLC file for generating XML file

*TLC: During code generation, expand TLC tokens and generate XML project file, model_project.xml.*

model_project.xml: Generated XML project file with generated file references and target-specific information

*Code Warrior (manual or with script): Import from XML.*

model_project.mcp: CodeWarrior project binary file

*Code Warrior (manual or with script): Build project as indicated in "Build Process Automation".
**Note** This process has drawbacks. First, manually editing an XML file exported from a CodeWarrior stationery project can be a laborious task, involving modification of a few dozen lines embedded within several thousand lines of XML code. Second, if you make changes to the CodeWarrior project after importing the generated XML file, the XML file must be exported and manually edited once again.

**Build Process Automation**

An application that supports COM automation can control other applications that include a COM interface. Using MATLAB COM automation functions, a MATLAB file can command a COM-compatible development system to execute tasks required by the build process.

The MATLAB COM automation functions described in this section are documented in “Call COM Objects” (MATLAB).

For information about automation commands supported by the CodeWarrior IDE, see your CodeWarrior documentation.

COM automation is used by some embedded targets to automate the CodeWarrior IDE to execute tasks such as:

- Opening a new CodeWarrior session
- Configure a project
- Loading a CodeWarrior project file
- Removing object code from the project
- Building or rebuilding the project
- Debug an application

COM technology automates certain repetitive tasks and allows the user to interact directly with the external application. For example, when the end user of the embedded targets capability initiates a build, the target quickly invokes CodeWarrior actions and leaves a project built and ready to run with the IDE.

**Example COM Automation Functions**

The functions below use the MATLAB `actxserver` command to invoke COM functions for controlling the CodeWarrior IDE from a MATLAB file:
• **CreateCWComObject**: Create a COM connection to the CodeWarrior IDE.
• **OpenCW**: Open the CodeWarrior IDE without opening a project.
• **OpenMCP**: Open the CodeWarrior project file (.mcp file) specified by the input argument.
• **BuildCW**: Open the specified .mcp file, remove object code, and build project.

These functions are examples; they do not constitute a full implementation of a COM automation interface. If your target creates the project file during code generation, the top-level **BuildCW** function should be called after the code generation process is completed. Normally **BuildCW** would be called from the exit method of your **STF_make_rtw_hook.m** file (see “STF_make_rtw_hook.m” on page 39-20).

In the code examples, the variable **in_qualifiedMCP** is assumed to store a fully qualified path to a CodeWarrior project file (for example, path, filename, and extension). For example:

```
in_qualifiedMCP = 'd:\work\myproject.mcp';
```

In actual practice, your code is responsible for determining the conventions used for the project filename and location. One simple convention would be to default to a project file **model.mcp**, located in your target's build folder.

```matlab
%======================================================================
% Function: CreateCWComObject
% Abstract: Creates the COM connection to CodeWarrior
% function ICodeWarriorApp = CreateCWComObject
% vprint([mfilename ': creating CW com object']);
%try
%   ICodeWarriorApp = actxserver('CodeWarrior.CodeWarriorApp');
catch
%   error(["Error creating COM connection to ' ComObj ...
%       '. Verify that CodeWarrior is installed. Verify COM access to
CodeWarrior outside of MATLAB."]);
end
return;
%======================================================================
% Function: OpenCW
% Abstract: Opens CodeWarrior without opening a project. Returns the
% handle ICodeWarriorApp.
% function ICodeWarriorApp = OpenCW()
%   ICodeWarriorApp = CreateCWComObject;
%   CloseAll;
%   OpenMCP(in_qualifiedMCP);
```
% Function: OpenMCP
% Abstract: open an MCP project file

function OpenMCP(in_qualifiedMCP)
    % Argument checking. This method requires valid project file.
    if ~exist(in_qualifiedMCP)
        error([mfilename ': Missing or empty project file argument']);
    end
    if isempty(in_qualifiedMCP)
        error([mfilename ': Missing or empty project file argument']);
    end
    ICodeWarriorApp = CreateCWComObject;
    vprint([mfilename ': Importing']);
    try
        invoke(ICodeWarriorApp.Application,...
            'OpenProject', in_qualifiedMCP,...
            1,0,0);
    catch
        error(['Error using COM connection to import project. ' ...
            'Verify that CodeWarrior is installed. Verify COM access to
            CodeWarrior outside of MATLAB.']);
    end

% Function: BuildCW
% Abstract: Opens CodeWarrior.
%           Opens the specified CodeWarrior project.
%           Deletes objects.
%           Builds.

function ICodeWarriorApp = BuildCW(in_qualifiedMCP)
    % ICodeWarriorApp = BuildCW;
    ICodeWarriorApp = CreateCWComObject;
    CloseAll;
    OpenMCP(in_qualifiedMCP);
    try
        invoke(ICodeWarriorApp.DefaultProject,'RemoveObjectCode', 0, 1);
    catch
        error(['Error using COM connection to remove objects of current project. ' ...
            'Verify that CodeWarrior is installed. Verify COM access to
            CodeWarrior outside of MATLAB.']);
    end
    try
        invoke(ICodeWarriorApp.DefaultProject,'BuildAndWaitToComplete');
    catch
        error(['Error using COM connection to build current project. ' ...
            'Verify that CodeWarrior is installed. Verify COM access to
            CodeWarrior outside of MATLAB.']);
    end
See Also

More About

- “About Embedded Target Development” on page 39-2
- “Sample Custom Targets” on page 39-9
- “Customize System Target Files” on page 39-28
Device Drivers

Device drivers that communicate with target hardware are essential to many real-time development projects.

You can integrate existing C (or C++) device driver functions into Simulink models by using the Legacy Code Tool. When you use the code generator to generate code from a model, the Legacy Code Tool can insert a call to your C function into the generated code. For details, see “Import Calls to External Code into Generated Code with Legacy Code Tool” on page 14-7 and “Integrate C Functions into Simulink Models with Legacy Code Tool” (Simulink).

See Also

More About

• “About Embedded Target Development” on page 39-2
• “Sample Custom Targets” on page 39-9
• “Customize System Target Files” on page 39-28